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This article assumes that you've already signed up for Power BI service and added some data.

When you open the Power BI service, you'll see a dashboard displayed. Dashboards are something that
differentiates Power BI service from Power BI Desktop.

The main features of your Power BI service UI are the following:

1. navigation pane (left nav)
2. canvas (in this case, dashboard with tiles)
3. Q&A question box
4. icon buttons, including help and feedback
5. dashboard title (navigation path, aka breadcrumbs)
6. Office 365 app launcher
7. Power BI home button
8. Labeled icon buttons

We'll dig into these later, but first let's review some Power BI concepts.

Or, you might want to watch this video first before reading the rest of this article. In the video, Will
reviews the basic concepts and gives a tour of Power BI service.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-basic-concepts.md


Power BI concepts

Workspaces

Datasets

The 4 major building blocks of Power BI are: dashboards, reports, workbooks, and datasets. And they're
all organized into workspaces. It's important to understand workspaces before we dig into the 4 building
blocks, so let's start there.

Workspaces are containers for dashboards, reports, workbooks, and datasets in Power BI. There are two
types of workspaces: *My workspace and app workspaces. So what is an app? A Power BI app is a
collection of dashboards and reports built to deliver key metrics for your organization. Apps are
interactive but can't be edited

My workspace is the personal workspace for any Power BI customer to work with their content. Only
you have access to your My workspace. If you want to share any of your content, you have several
choices: create an app workspace where you bundle content into an app and make it available to
others in your organization, or create an app workspace and give colleagues access to that workspace
so you can share and collaborate.
App workspaces are used to collaborate and share content with colleagues. They are also the places
where you create, publish, and manage apps for your organization. Think of them as staging areas and
containers for the content that will make up a Power BI app. You can add colleagues to your app
workspaces and collaborate on dashboards, reports, workbooks, and datasets. All app workspace
members need Power BI Pro licenses, but app consumers (the colleagues who have access to the
apps) don't necessarily need Pro licenses.

To learn more, see the Share your work section of the Table of contents, starting with How should I
collaborate and share dashboards and reports

Now on to the Power BI building blocks. You can't have dashboards or reports without data (well, you can
have empty dashboards and empty reports, but they're not very useful until they have data), so let's start
with datasets.

A dataset is a collection of data that you import or connect to. Power BI lets you connect to and import all
sorts of datasets and bring all of it together in one place.

Datasets are associated with workspaces and a single dataset can be part of many workspaces. When you
open a workspace, the associated datasets are listed under the Datasets tab. Each listed dataset
represents a single source of data, for example, an Excel workbook on OneDrive, or an on-premises SSAS
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Reports

tabular dataset, or a Salesforce dataset. There are many different data sources supported, and we’re
adding new ones all the time. See the list of dataset types that can be used with Power BI.

In the example below, I've selected the "Sales and marketing" app workspace and clicked the tab for
Datasets.

ONE dataset...

can be used over and over in one or in many workspaces.
can be used in many different reports.
Visualizations from that one dataset can display on many different dashboards.

To connect to or import a dataset, select Get Data (at the bottom of the left navigation) or select +
Create > Dataset (in the upper right corner). Follow the instructions to connect to or import the specific
source and add the dataset to the active workspace. New datasets are marked with a yellow asterisk. The
work you do in Power BI does not change the underlying dataset.

If you're part of an app workspace, datasets added by one workspace member are available to the other
workspace members.

Datasets can be refreshed, renamed, explored, and removed. Use a dataset to create a report from scratch
or by running quick insights. To see which reports and dashboards are already using a dataset, select
View related. To explore a dataset, select it. What you're actually doing is opening the dataset in the
report editor where you can really start digging into the data and creating visualizations. So, let's move
on to the next topic -- reports.

Power BI Premium - what is it?
Get data for Power BI
Sample datasets for Power BI

A Power BI report is one or more pages of visualizations (charts and graphs like line charts, pie charts,
treemaps, and many many more). Visualizations are also called visuals. All of the visualizations in a
report come from a single dataset. Reports can be created from scratch within Power BI, can be imported
with dashboards that colleagues share with you, or can be created when you connect to datasets from
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Excel, Power BI Desktop, databases, SaaS applications and apps. For example, when you connect to an
Excel workbook that contains Power View sheets, Power BI creates a report based on those sheets. And
when you connect to an SaaS application, Power BI imports a pre-built report.

There are 2 modes to view and interact with reports: Reading view and Editing view. Only the person who
created the report, co-owners, and those granted permission, have access to all of the exploring,
designing, building, and sharing capabilities of Editing View for that report. And the people they share
the report with can explore and interact with the report using Reading View.

When you open a workspace, the associated reports are listed under the Reports tab. Each listed report
represents one or more pages of visualizations based on only one of the underlying datasets. To open a
report, simply select it.

When you open an app, you'll be presented with a dashboard. To access an underlying report, select a
dashboard tile (more on these later) that was pinned from a report. Keep in mind that not all tiles are
pinned from reports, so you may have to click a few tiles to find a report.

By default, the report opens in Reading view. Just select Edit report to open it in Editing view (if you have
the necessary permissions).

In the example below, I've selected the "Sales and marketing" app workspace and clicked the tab for
Reports.

ONE report...

is contained in a single workspace
can be associated with multiple dashboards within that workspace (tiles pinned from that one report
can appear on multiple dashboards).
can be created using data from one dataset. (the slight exception to this is that Power BI Desktop
can combine more than 1 dataset into a single report and that report can be imported into Power
BI)

Reports in Power BI service and Power BI Desktop
Reports in Power BI mobile apps



Dashboards

NOTENOTE

Dig deeperDig deeper

Workbooks

A dashboard is something you create in Power BI service or something a colleague creates in Power BI
service and shares with you. It is a single canvas that contains zero or more tiles and widgets. Each tile
pinned from a report or from Q&A displays a single visualization that was created from a dataset and
pinned to the dashboard. Entire report pages can also be pinned to a dashboard as a single tile. There are
many ways to add tiles to your dashboard; too many to be covered in this overview topic. To learn more,
see Dashboard tiles in Power BI.

Why do people create dashboards? Here are just some of the reasons:

to see, in one glance, all the information needed to make decisions
to monitor the most-important information about your business
to ensure all colleagues are on the same page, viewing and using the same information
to monitor the health of a business or product or business unit or marketing campaign, etc.
to create a personalized view of a larger dashboard -- all the metrics that matter to you

When you open a workspace, the associated dashboards are listed under the Dashboards tab. To open a
dashboard, simply select it. When you open an app, you'll be presented with a dashboard. Each
dashboard represents a customized view of some subset of the underlying dataset(s). If you own the
dashboard, you'll also have edit access to the underlying dataset(s) and reports. If the dashboard was
shared with you, you'll be able to interact with the dashboard and any underlying reports, but will not be
able to save any changes.

There are many different ways that you, or a colleague, can share a dashboar. Power BI Pro is required for
sharing a dashboard and may be required for viewing a shared dashboard.

Pinning and tiles are covered in more detail below under the heading "Dashboard with tiles."

ONE dashboard...

is associated with a single workspace
can display visualizations from many different datasets
can display visualizations from many different reports
can display visualizations pinned from other tools (e.g., Excel)

Create a new blank dashboard and then get some data .
Duplicate a dashboard
Create a phone view of a dashboard

https://docs.microsoft.com/en-us/power-bi/service-dashboard-create
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My Workspace

1. 1. Navigation paneNavigation pane (left nav) (left nav)

Workbooks are a special type of dataset. If you've read the Datasets section above, you know almost all
you need to know about workbooks. But you may be wondering why sometimes Power BI classifies an
Excel workbook as a Dataset and other times as a Workbook.

When you use Get data with Excel files, you have the option to Import or Connect to the file. When you
choose Connect, your workbook will appear in Power BI just like it would in Excel Online. But, unlike Excel
Online, you’ll have some great features to help you pin elements from your worksheets right to your
dashboards.

You can’t edit your workbook in Power BI. But if you need to make some changes, you can click Edit, and
then choose to edit your workbook in Excel Online or open it in Excel on your computer. Any changes you
make are saved to the workbook on OneDrive.

Get data from Excel workbook files
Publish to Power BI from Excel

We've covered workspaces and building blocks. Let's take another look at the Power BI interface and
review the pieces that make up the landing page for Power BI service.

Use the navigation pane to locate and move between your workspaces and the Power BI building blocks:
dashboards, reports, workbooks, and datasets.



2. 2. CanvasCanvas

Select Get Data to add datasets, reports, and dashboards to Power BI.

Expand and collapse the navbar with this icon .
Open or manage your favorite content by selecting Favorites.
View and open your most-recently visited content by selecting Recent
View, open, or delete an app by selecting Apps.
Did a colleague share content with you? Select Shared with me to search and sort that content to
find what you need.
Display and open your workspaces by selectig Workspaces.

Single-click

an icon or heading to open in content view
an arrowright (>) to open a flyout menu for Favorites, Recent, and Workspaces.
a chevron icon () to display the My Workspace scrollable list of dashboards, reports, workbooks, and
datasets.
a dataset to explore it

Because we've opened a dashboard, the canvas area displays visualization tiles. If, for example, we had
opened the report editor, the canvas area would display a report page.

Dashboards are composed of tiles. Tiles are created in report Editing view, Q&A, other dashboards, and
can be pinned from Excel, SSRS, and more. A special type of tile called a widget is added directly onto the
dashboard. The tiles that appear on a dashboard were specifically put there by a report creator/owner.
The act of adding a tile to a dashboard is called pinning.



3. 3. Q&A question boxQ&A question box

4. 4. Icon buttonsIcon buttons

5. 5. Dashboard titleDashboard title (navigation path aka breadcrumbs) (navigation path aka breadcrumbs)

6. 6. Office 365 app launcherOffice 365 app launcher

For more information, see Dashboards (above).

One way to explore your data is to ask a question and let Power BI Q&A give you an answer, in the form
of a visualization. Q&A can be used to add content to a dashboard or report.

Q&A looks for an answer in the dataset(s) connected to the dashboard. A connected dataset is one that
has at least one tile pinned to that dashboard.

As soon as you start to type your question, Q&A takes you to the Q&A page. As you type, Q&A helps you
ask the right question and find the best answer with rephrasings, autofill, suggestions, and more. When
you have a visualization (answer) you like, pin it to your dashboard. For more information, see Q&A in
Power BI.

The icons in the upper right corner are your resource for settings, notifications, downloads, getting help,
and providing feedback to the Power BI team. Select the double arrow to open the dashboard in Full
screen mode.

It's not always easy to figure out which workspace and dashboard are active, so Power BI creates a
navigation path for you. In this example we see the workspace (My workspace) and the dashboard title
(Retail Analysis Sample). If we opened a report, the name of the report would be appended to the end of
the navigation path. Each section of the path is an active hyperlink.

Notice the "C" icon after the dashboard title. This dashboard has a data classification tag of "confidential."
The tag identifies the sensitivity and security level of the data. If your Admin has turned on data
classifcation, every dashboard will have a default tag set. Dashboard owners should change the tag to
match their dashboard's proper security level.

With the app launcher, all your Office 365 apps are easily available with one click. From here you can



7. 7. Power BI homePower BI home

8. 8. Labeled icon buttonsLabeled icon buttons

Next steps

quickly launch your email, documents, calendar, and more.

Selecting this opens your featured dashboard (if you've set one), otherwise it opens the last dashboard
you viewed.

This area of the screen contains additional options for interacting with the content (in this case, with the
dashboard). Besides the labeled icons you can see, selecting the ellipses reveals options for duplicating,
printing, refreshing the dashboard and more.

Get started with Power BI
Navigation: Getting around in Power BI service Power BI videos
Report editor - take a tour

More questions? Try asking the Power BI Community

http://community.powerbi.com/
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TIPTIP

This tutorial helps you get started with Power BI service. For an understanding of how Power BI
service fits in with the other Power BI offerings, we highly recommend that you start by reading What
is Power BI.

Power BI service has a free version and a Pro version. No matter which version you're using, if you
already have an account, open a browser and type app.powerbi.com to open Power BI service. If
you're a new user, we recommend starting at www.powerbi.com instead. From here you can learn
more about Power BI before logging in to the service. When you're ready to try it out, select the Sign
up free link that you'll see in the upper right corner. If your administrator has already enabled Power
BI for you, don't use the Sign up free button, but instead go directly to app.powerbi.com.

If you're looking for help with Power BI Desktop, see Get started with Desktop. If you're looking for
help with Power BI mobile, see Power BI apps for mobile devices.

Prefer a free self-paced training course instead? Enroll in our Analyzing and Visualizing Data course on EdX.

Visit our playlist on YouTube. A good video to start with is Introduction to Power BI service:

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-get-started.md
file:///W:/soyp-o-7bf22bb1/powerbi-docs/.tmp/guided-learning/gettingstarted.yml#step-1
http://aka.ms/edxpbi
https://www.youtube.com/playlist?list=PL1N57mwBHtN0JFoKSR0n-tBkUJHeMP2cP


Step 1: Get data

Microsoft Power BI helps you stay up to date with the information that matters to you. With Power BI
service, dashboards help you keep a finger on the pulse of your business. Your dashboards display
tiles that you can click to open reports for exploring further. Connect to multiple datasets to bring all
of the relevant data together in one place. Need help understanding the building blocks that make up
Power BI? See Power BI - Basic Concepts.

If you have important data in Excel or CSV files, you can create a Power BI dashboard to stay
informed anywhere and share insights with others. Do you have a subscription to a SaaS application
like Salesforce? Get a head start by connecting to Salesforce to automatically create a dashboard
from that data, or check out all the other SaaS apps you can connect to. If you are part of an
organization, see if any apps have been published for you.

Read about all the other ways to get data for Power BI.

Here's an example of getting data from a CSV file. Want to follow along with this tutorial? Download
this sample CSV file.

1. Sign in to Power BI. Don’t have an account? No worries, you can sign up for free.
2. Power BI opens in your browser. Select Get Data at the bottom of the left navigation bar.

3. Select Files.

4. Browse to the file on your computer, and choose Open. If you saved it in OneDrive for
Business, select that option. If you saved it locally, select Local file.

http://go.microsoft.com/fwlink/?LinkID=521962
http://www.powerbi.com/


5. For this tutorial we're going to select Import to add the Excel file as a dataset that we can then
use to create reports and dashboards. If you select Upload, the entire Excel workbook is
uploaded to Power BI where you can open and edit it in Excel online.

6. When your dataset is ready, select View dataset to open it in the report editor.

Since we haven't yet created any visualizations, the report canvas will be blank.



Step 2: Start exploring your dataset

7. Take a look at the top menubar and notice that there is an option for Reading view. Since you
have an option for Reading view, that means you are currently in Editing view.

While in Editing view you can create and modify your reports because you are the owner of
the report; you are a creator. When you share your report with colleagues, they'll only be able
to interact with the report in Reading view; they are consumers. Learn more about Reading
view and Editing view.

A great way to get familiar with the report editor is to take a tour

Now that you've connected to data, start exploring. When you've found something interesting, you
can create a dashboard to monitor it and see how it changes over time. Let's see how that works.

1. In the report editor, we'll use the Fields pane on the right side of the page to build a
visualization. Select the checkbox beside Gross Sales and Date.



2. Power BI analyzes the data and creates a visualization. If you selected Date first, you'll see a
table. If you selected Gross Sales first, you'll see a chart. Switch to a different way of displaying
your data. Let's see this data as a line chart. Select the line chart icon (also known as a
template) from the Visualizations pane.

3. This looks interesting, so let's pin it to a dashboard. Hover over the visualization and select the
Pin icon. When you pin this visualization, it is stored on your dashboard and kept up-to-date
so you can track the latest value at a glance.



4. Because this is a new report, you'll be prompted to save it before you can pin a visualization to
a dashboard. Give your report a name (e.g., Sales over time) and select Save and Continue.

5. Let's pin the line chart to new dashboard and name it "Financial sample for tutorial".

a. Select Pin.

A Success message (near the top right corner) lets you know the visualization was
added, as a tile, to your dashboard.

6. Select Go to dashboard to see the line chart pinned, as a tile, to your brand new dashboard.
Make your dashboard even better by adding more visualization tiles and renaming, resizing,
linking, and repositioning tiles.

Select the new tile on your dashboard to return to the report any time. Power BI returns you to
the report editor in Reading view. To switch back to Editing view, select Edit report from the
top menubar. Once in Editing view, continue exploring and pinning tiles.



Step 3: Continue the exploration with Q&A (natural language
querying)

Next steps

1. For a quick exploration of your data, try asking a question in the Q&A box. The Q&A question
box is located at the top of your dashboard (Ask a question about your data) and in the top
menubar in your report (Ask a question). For example, try typing "what segment had the
most revenue".

2. Q&A searches for an answer and presents it in the form of a visualization. Select the pin icon 

 to show this visualization on your dashboard too.

3. Pin the visualization to the "Financial Sample for tutorial" dashboard.

4. Return to your dashboard where you'll see the new tile.



Stay in touch with Power BIStay in touch with Power BI

Ready to try more? Here are some great ways to explore Power BI.

Connect to another dataset.
Share your dashboard with your colleagues.
Read tips for designing dashboards.
View your dashboards with a Power BI app on a mobile device

Not quite ready to jump right in? Start with these topics designed to help you feel comfortable with
Power BI.

Learn how reports, datasets, dashboards, and tiles all fit together
Visit our Power BI Guided Learning site and take a few (very short) courses
Watch some Power BI videos
See what samples we have available for you to use

Follow @MSPowerBI on Twitter
Subscribe to our YouTube video channel
Watch our Power BI Getting Started webinars on demand
Not sure where to go for help? See our 10 tips for getting help page

More questions? Try asking the Power BI Community

https://docs.microsoft.com/en-us/power-bi/guided-learning/index
https://twitter.com/mspowerbi
https://www.youtube.com/channel/UCy--PYvwBwAeuYaR8JLmrfg
http://community.powerbi.com/


Signing up for Power BI as an individual
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You have a few options

NOTENOTE

What you need to sign up

What email address can be used with Power BI?What email address can be used with Power BI?

Learn how to sign up for Power BI and begin using it for your personal report and visualization needs.

Power BI can be your personal report and visualization tool, and can also serve as the analytics and decision
engine behind group projects, divisions, or entire corporations.

This article will walk you through your options on how to sign up and begin using the Power BI service. For
information on the differences between Power BI Free and Pro, see Power BI Free vs Pro.

As an individual you have several options to sign up and begin using Power BI. You can choose to sign up for
free or you can purchase a Power BI Pro subscription. If you sign up for a free account, once you are in the
service, you can opt into a free 60 day trial of Power BI Pro.

If you are part of an existing organization, that uses Office 365, you can still sign up for a free account. Your IT
Admin also has some options to purchase Power BI Pro and assign licenses. For more information about what
options are available as an IT Admin, see Purchasing Power BI Pro.

If you are in an organization, individual sign up may be disabled. See Individual Sign up has been turned off for more
information if you get an error indicating it has been turned off.

In order to sign up for Power BI, you need aa work email address. A personal email address won't work with the
Power BI service.

   

Power BI requires that you use a work, or school, email address to sign up. Power BI does not support email
addresses provided by consumer email services or telecommunication providers. This includes outlook.com,
hotmail.com, gmail.com and others.

If you try to sign up with a personal email address, you will get a message indicating to use a work or school

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-self-service-signup-for-power-bi.md


NOTENOTE

Which one do you need?

Signing up for Power BI (free) as an individual

NOTENOTE

email address.

Power BI does not support self-service sign-up for .gov or .mil addresses at this time. Please contact your Office 365
admin.

You can determine which one you need by reviewing what comes with each license type. Free users have most of
the functionality of the services with the exception of sharing and collaboration features. Power BI Pro users can
make use of all features in the service, but is not free. If you don't have a need to share any content, Free may be
the route for you. You can learn more on the Power BI Pricing page.

The remainder of this article will look at how to sign up for each option.

The quickest way to sign up for Power BI is to sign up for a Power BI (free) account. There is no cost to this
account, and it allows you to use many of the features available in the service.

If you receive a message that we already know you, try navigating to https://app.powerbi.com and signing in.

To sign up for Power BI, you can do the following.

1. Browse to powerbi.com.
2. Select Start Free or Sign up free.

3. On the get started page, select Try Free > under Power BI.

https://powerbi.microsoft.com//pricing/
https://app.powerbi.com
https://powerbi.microsoft.com


What this looks like within the serviceWhat this looks like within the service

What if you're already part of an existing organization?What if you're already part of an existing organization?

6. Select the link within the email to verify your email address. This will bring you back into the sign up flow. You
may need to supply some additional information about yourself.

7. You will then be taken to https://app.powerbi.com and you can begin using Power BI as a free user.

4. Enter the email address you are signing up with, and then select Sign up. Be sure your email address is
allowed for sign up. For more information about what email address you can use, see What email address
can be used with Power BI.

5. You will get a message indicating to check your email.

When you are in the service, you can verify that you have a free account by going to the gear icon and selecting
Manage personal storage.

If your account is part of an existing organization, you will get a message asking you to sign in with that account.
Select Continue and sign in with your Office 365 login.

https://app.powerbi.com


 In-service Power BI Pro 60-day trial

NOTENOTE

You will then see a message asking you to select Start.

After you have signed up for your free account, you can optionally choose to try Pro free for 60 days. You will
have access to all of the Pro features for the duration of the trial. Power BI Pro has all the features of the free
version of Power BI, and additional sharing and collaboration features. For more information, see Power BI
Pricing. To try a 60-day free trial of Power BI Pro, sign into Power BI, and try one of these Power BI Pro features:

Create an app worksapce
Share a dashboard

When you try any of these features, you will be prompted to start your free trial. You can also choose to make
use of it by going to the gear icon and selecting Manage personal storage. Then select Try Pro for free on the
right.

Then you can select Start trial.

Users taking advantage of this in-product Power BI Pro trial do not appear in the Office 365 admin portal as Power BI Pro
Trial users (they appear as Power BI free users). They will, however, show up as Power BI Pro Trial users in the manage
storage page in Power BI.

https://powerbi.microsoft.com/pricing
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NOTENOTE

What this looks like within the serviceWhat this looks like within the service

What if you want the full Power BI Pro?

Troubleshooting

SYMPTOM / ERROR MESSAGE CAUSE AND WORKAROUND

Personal email addresses (e.g. nancy@gmail.com) You
receive a message like the following during signup: 

You entered a personal email address: Please enter your
work email address so we can securely store your
company's data. 

or 

That looks like a personal email address. Enter your work
address so we can connect you with others in your
company. And don’t worry. We won’t share your address
with anyone.

Power BI does not support email addresses provided by
consumer email services or telecommunications providers. 

To complete signup, try again using an email address
assigned by your work or school. 

If you still can't sign up and are willing to complete a more
advanced setup process, you can register for a new Office
365 trial subscription and use that email address to sign up.

If you are an IT Administrator wishing to acquire and deploy Power BI trial licenses to multiple users in your organization
without having individual users accept trial terms individually, you can sign up for a Power BI Pro subscription trial. You will
need to be an Office 365 Global or Billing Admin or create a new tenant to sign up for an admin trial. For more
information, see Purchasing Power BI Pro.

With the availability of Power BI Premium, and the changes to the Power BI Free offering on June 1, 2017, you may be
eligible for an Extended Pro Trial. For more information, see Extended Pro Trial activation.

When you are in the service, you can verify that you have a Pro trial account by going to the gear* icon and
selecting **Manage personal storage.

There is not a way to get the Power BI Pro license as an individual. You will need to speak to your IT Admin to
purchase and assign the license to your account. For more information, see Purchasing Power BI Pro.

In many cases, registering for Power BI can be achieved by following the simple self-service signup process listed
above. However, there are several reasons why you may not be able to complete self-service signup. The table
below summarizes some of the most common reasons you may not be able to complete signup and ways you
can workaround these issues.

https://portal.office.com/Signup/MainSignup15.aspx?OfferId=d59682f3-3e3b-4686-9c00-7c7c1c736085&dl=POWER_BI_PRO


Self-service signup disabled You receive a message like
the following during signup: 

We can't finish signing you up. Your IT department has
turned off signup for Microsoft Power BI. Contact them to
complete signup. 

or 

That looks like a personal email address. Enter your work
address so we can connect you with others in your
company. And don’t worry. We won’t share your address
with anyone.

Your organization’s IT administrator has disabled self-service
signup for Power BI. 

To complete signup, contact your IT administrator and ask
them to follow the instructions on the page below to allow
existing users to sign up for Power BI and to allow new users
to join your existing tenant. 

You may also experience this problem if you signed up for
Office 365 through a partner. Learn more 

Power BI in Your Organization

Email address is not an Office 365 ID You receive a
message like the following during signup: 

We can't find you at contoso.com. Do you use a different ID
at work or school? 

Try signing in with that, and if it doesn't work, contact your
IT department.

Your organization uses IDs to sign in to Office 365 and other
Microsoft services that are different than your email address.
For example, your email address might be
Nancy.Smith@contoso.com but your ID is
nancys@contoso.com. 

To complete signup, use the ID that your organization has
assigned to for signing in to Office 365 or other Microsoft
services. If you don't know what this is, contact your IT
administrator. 

If you still can't sign up and are able to complete a more
advanced setup process, you can register for a new Office
365 trial subscription and use that email address to sign up.

SYMPTOM / ERROR MESSAGE CAUSE AND WORKAROUND

Next steps
Power BI (free) in your organization
Purchasing Power BI Pro
Power BI Service agreement for individual users
Power BI Premium - what is it?
Power BI Premium whitepaper

More questions? Try asking the Power BI Community

https://support.office.com/en-ca/article/Power-BI-in-your-Organization-d7941332-8aec-4e5e-87e8-92073ce73dc5#BKMK_HowCanIAllowO365Tenant
https://powerbi.microsoft.com/terms-of-service/
https://aka.ms/pbipremiumwhitepaper
http://community.powerbi.com/


Power BI Free vs Pro
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Free vs Pro comparison

FREE PRO

Connect to 70+ data sources

Publish to Web

Peer-to-peer sharing

Export to PowerPoint, Excel, CSV

Enterprise distribution

Apps

Email subscriptions

Embed APIs and controls

Collaboration

App workspaces

Analyze in Excel, analyze in Power BI
Desktop

Next steps

Every user within Power BI is either Free or Pro. It is helpful to understand the differences between these two
types of users.

All users in the service are either Free or Pro. The main difference between a Free or Pro user is centered around
sharing and collaboration. Only Pro users can publish content to app workspaces, consume apps without
Premium capacity, share dashboards and subscribe to dashbaords and reports. Free users can now connect to all
data sources through all connectivity options such as DirectQuery, live connection and the use of the data
gateway.

If an app is published, and the app workspace it is for is assigned to Premium capacity, Free users can consume
those apps.

Here is a list of features supported by user type.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-free-vs-pro.md


If you are interested in learning more about Power BI Premium, see Power BI Premium - what is it?.

To get started with Power BI by signing up, see Signing up for Power BI as an individual.

More questions? Try asking the Power BI Community

https://community.powerbi.com/
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Files

Data is at the heart of Power BI. Whenever you’re exploring data, creating charts and dashboards, asking
questions with Q&A, all of those visualizations and answers you see are really getting their underlying
data from a dataset. But where does that dataset come from? Well, from a data source.

In this article, we’re going to go over the different types of data sources you can connect to from the
Power BI service. Keep in-mind, there are many other types of data sources you can get data from, too.
But those might require first using Power BI Desktop or Excel’s advanced data query and modeling
features. We’ll go into more about that later. For now, let’s look at the different types of data sources you
can connect to right from your Power BI service site.

You can get data from any of these data sources in Power BI by clicking My Workspace > Get Data.

Excel (.xlsx, xlxm) – Excel is unique in that a workbook can have both data you’ve entered into worksheets
yourself, and you can query and load data from external data sources by using Power Query (Get &
Transform in Excel 2016) or Power Pivot. You can import data that is in tables in worksheets (the data
must be in a table), or import data that is loaded into a data model. To learn more, see Get data from
Excel.

Power BI Desktop (.pbix) - You can use Power BI Desktop to query and load data from external data
sources, extend your data model with measures and relationships, and create reports. You can import
your Power BI Desktop file into your Power BI site. Power BI Desktop is best for more advanced users who
have a good understanding of their data sources, data query and transformation, and data modeling
concepts. To learn more, see Connect to data in Power BI Desktop.

Comma Separated Value (.csv) - Files are simple text files with rows of data. Each row can contain one
or more values, each separated by a comma. For example, a .csv containing name and address data can
have a number of rows where each row has values for first name, last name, street address, city, state, and
so on. You cannot import data into a .csv file, but many applications, like Excel, can save simple table data
as a .csv file.

For other file types like XML Table (.xml) or text (.txt) files, you can use Get & Transform to query,

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-get-data.md


Content packs

Databases

What if my data comes from a different source?

transform, and load that data into an Excel or Power BI Desktop file first. You can then import the Excel or
Power BI Desktop file into Power BI.

Where you store your files makes a big difference, too. OneDrive for Business provides the greatest
amount of flexibility and integration with Power BI. If you keep your files on your local drive, that’s ok, but
if you need to refresh your data, a few extra steps are involved. More details are provided in the linked
articles.

Content packs contain all of the data and reports you need already prepared for you. In Power BI, there
are two types of content packs; those from services like Google Analytics, Marketo, or Salesforce, and
those created and shared by other users in your organization.

Services – There are literally dozens of services with content packs for Power BI, and more are being
added all the time. Most services require you to have an account. To learn more, see Connect to services.

Organizational – If you and other users in your organization have a Power BI Pro account, you can
create, share, and use content packs. To learn more, see Organizational content packs.

Databases in the Cloud – From the Power BI service, you can connect live to Azure SQL Database, Azure
SQL Data Warehouse, Spark on Azure HD Insight, and SQL Server Analysis Services using DirectQuery.
Connections from Power BI to these databases are live, that is, when you’ve connected to say an Azure
SQL Database, and you begin exploring its data by creating reports in Power BI, anytime you slice your
data or add another field to a visualization, a query is made right to the database. To learn more, see
Azure and Power BI.

Databases on-premises – From the Power BI service, you can connect directly to SQL Server Analysis
Services Tabular model databases. A Power BI Enterprise gateway is required. If you’re unsure how to
connect to your organization’s tabular model database, check with your administrator or IT department.
To learn more, see SQL Server Analysis Tabular data in Power BI.

For other types of databases in your organization, you’ll need to first use Power BI Desktop or Excel to
connect to, query, and load data into a data model. You can then import your file into Power BI where a
dataset is created. If you setup scheduled refresh, Power BI will use connection information from the file
along with refresh settings you configure to connect directly to the datasource and query for updates.
Those updates are then loaded into the dataset in Power BI. To learn more, see Connect to data in Power
BI Desktop.



Some more details

Data refreshData refresh

There are literally hundreds of different data sources you can use with Power BI. But regardless of where
you get your data from, that data has to be in a format the Power BI service can use to create reports and
dashboards, answer questions with Q & A, and so on.

Some data sources already have their data in a format ready for the Power BI service, like content packs
from service providers like Google Analytics, and Twilio. SQL Server Analysis Services Tabular model
databases are ready, too. And you can connect live to databases in the cloud like Azure SQL Database and
Spark on HDInsight.

In other cases, it might be necessary to query and load the data you want into a file. For example, let’s say
you have logistics data in a data warehouse database on a server in your organization. In the Power BI
service, you cannot connect directly to that database and begin exploring its data (unless it is a tabular
model database). You can, however, use Power BI Desktop or Excel to query and load that logistics data
into a data model you then save as a file. You can then import that file into Power BI where a dataset is
created.

You’re probably thinking “But that logistics data on that database changes every day. How do I make sure
my dataset in Power BI is refreshed?” Connection information from the Power BI Desktop or Excel file is
imported into the dataset along with the data. If you setup scheduled refresh or do a manual refresh on
the dataset, Power BI will use the connection information from the dataset, along with a couple other
settings, to connect directly to the database, query for updates, and load those updates into the dataset. A
Power BI gateway will likely be required to secure any data transfer between your on-premises server and
Power BI. Any visualizations in reports and dashboards are refreshed automatically.

You see, just because you cannot connect to your data source right from the Power BI service doesn’t
mean you can’t get that data into Power BI. It just might take a few more steps and maybe some help
from your IT department. See Data sources in Power BI Desktop to learn more.

You’ll see the terms dataset and data source used a lot in Power BI. They’re often use synonymously, but
they really are two different things, albeit related.

A dataset is automatically created in Power BI when you use Get Data to connect to and import data from
a content pack, file, or you connect to a live data source. A dataset contains information about the data
source, data source credentials, and in many cases, a sub-set of data copied from the data source. In most
cases, when you create visualizations in reports and dashboards, you’re looking at data in the dataset.

A data source is where the data in a dataset really comes from. For example, an online service like Google
Analytics or QuickBooks, a database in the cloud like Azure SQL Database, or a database or file on a local
computer or server in your own organization.

If you save your files on your local drive, or a drive somewhere in your organization, a Power BI gateway
might be required in-order to refresh the dataset in Power BI. And, the computer where the file is saved
must be on when a refresh happens. You can also re-import your file, or use Publish from Excel or Power
BI Desktop, but those are not automated processes.

If you save your files on OneDrive for Business or SharePoint – Team Sites, and then connect to or import
them into Power BI, your dataset, reports, and dashboard will always be up-to-date. Because both
OneDrive and Power BI are in the cloud, Power BI can connect directly to your saved file, about once every
hour, and check for updates. If any are found, the dataset and any visualizations are refreshed
automatically.

Content packs from services are automatically updated. In most cases, once a day. You can manually
refresh, but whether or not you’ll see any updated data will depend on the service provider. Content



Considerations and Limitations

packs from others in your organization will depend on the data sources used and how the person who
created the content pack setup refresh.

Azure SQL Database, Azure SQL Data Warehouse, and Spark on Azure HDInsight are unique in that they
are data sources in the Cloud. Because the Power BI service is also in the cloud, Power BI can connect to
them live, using DirectQuery. What you see in Power BI is always in-sync and there’s no need to setup
refresh.

SQL Server Analysis Services is unique in that when you connect to it from Power BI, it’s a live connection
just like an Azure database in the cloud, but the database itself is on a server in your organization. This
type of connection requires a Power BI gateway, which is usually configured by an IT department.

Data refresh is a super important part of Power BI, and much too deep to cover here. If you want to get a
thorough understanding, be sure to checkout Data Refresh in Power BI.

For all data sources used in the Power BI service, the following considerations and limitations apply. There
are other limitations that apply to specific features, but the following list apply to the Power BI service
overall:

Dataset size limit - there is a 1 GB limit for each dataset in the Power BI service.
Row limit - the maximum number of rows in your dataset (when not using DirectQuery) is 2 billion,
with three of those rows reserved (resulting in a usable maximum of 1,999,999,997 rows); the
maximum number of rows when using DirectQuery is 1 million rows.
Column limit - the maximum number of columns allowed in a dataset, across all tables in the dataset,
is 16,000 columns. This applies to the Power BI service and to datasets used in Power BI Desktop.
Power BI uses an internal row number column per table included in the dataset, which means the
maximum number of columns is 16,000 minus one for each table used in the dataset.
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The left navigation pane

ACTION NEW (CURRENT) PATH

Favorite a dashboard or report Workspace > Dashboards or Workspace > Reports and select
the star icon to turn it yellow

Favorite an app Select Apps from left navpane and select star next to app
name

View a list of your favorites Select Favorites from left navpane

View a list of recently-visited dashboards and reports Select Recent from left navpane

View a list dashboards that have been shared with you Select Shared with me from left navpane

Share a dashboard Open dashboard and select Share or create and publish an
app

Delete a dashboard My workspace > Dashboards > trashcan icon

Delete a report My workspace > Reports > trashcan icon

Delete a dataset My workspace > Datasets > ... > Delete

Quick reference guide

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-the-new-power-bi-experience.md


Open a dashboard Workspace > Dashboards > and select the name of the
dashboard

Open a report Workspace > Reports > and select the name of the report

Open a dataset Workspace > Datasets > and select the name of the dataset

Create a dashboard From the top navbar select Create > Dashboard

Create a report From the top navbar select Create > Report

Create a dataset From the top navbar select Create > Dataset

Create an app Workspaces > Create app workspace

View a list of all the dashboards, reports, and datasets that
you own

Workspaces > My workspace

ACTION NEW (CURRENT) PATH

Common tasks

View content (dashboards, reports, workbooks, datasets, workspaces,
apps)

Watch Amanda take you on a tour of the Power BI service navigation experience. Then follow the step-by-step
instructions below the video to explore for yourself.

Let's start by looking at how the basic content (dashboards, reports, datasets, workbooks) is organized. Before this,
all of your content was listed in the left navigation pane. Now, you still have that option, but the default is to
display by content type within the context of a workspace. Select a workspace from the left navigation pane (left
navpane) and the tabs for the associated content (dashboards, reports, workbooks, datasets) fill the Power BI
canvas to the right.

If you have Power BI Free, you'll only see one workspace -- My Workspace.



Favorite dashboards, reports, and appsFavorite dashboards, reports, and apps
Favorites lets you quickly access content that is most important to you.

1. With the dashboard or report open, select Favorite from the upper right corner.

Favorite changes to Unfavorite and the star icon becomes yellow.

2. For an app, select Apps from the left navpane, hover over the app and choose the star to set it as a favorite.

3. To display a list of all the content that you have added as favorites, in the left navpane, select the arrow to
the right of Favorites. Because the left navpane is a permanent feature of Power BI service, you have access
to this list from anywhere in Power BI service.

From here you can select a dashboard, report, or app to open it.

4. To open the Favorites pane, in the left navpane, select Favorites or select the Favorites icon .



RecentsRecents

From here you can open, find the content, unfavorite, or share content with colleagues.

5. Another way to mark either a dashboard or report as a favorite is from the Dashboards or Reports
workspace tab. Just open the workspace to display the content view, and select the star icon to the left of the
name.

To learn more, see Favorites

Quickly get to the content that you’ve most recently accessed by visiting the Recents pane. This includes content
from across all of your workspaces.

Similar to Favorites, you can quickly access your recents from anywhere in Power BI service by selecting the arrow
next to Recents in the left navpane.

To learn more, see Recents in Power BI



AppsApps

Shared with meShared with me

Working with workspacesWorking with workspaces

My WorkspaceMy Workspace

An app is a collection of dashboards and reports built to deliver key metrics, all in one place. You can have apps
internal to your organization, and also apps for external services such as Google Analytics and Microsoft Dynamics
CRM.

To learn more, see App workspaces (below) and What are Power BI apps.

Shared with me is the location for all content that colleagues have shared with you. Filter by dashboard owner,
use the search field to find what’s relevant, and sort the items by date. And for shared content you visit frequently,
it's even easier to favorite it right from the Shared with me view.

To learn more, see Shared with me

Next in the left nav is workspaces. Workspaces can be thought of as containers for Power BI content. There are two
types of workspaces: My Workspace and App workspaces.

If you are not a member of an app workspace or an admin, you may not see any app workspaces in your left nav.
And if you are a Power BI Free customer, you will not see any app workspaces.

My Workspace stores all the content that you own. Think of it as your personal sandbox or work area for your
own content. You can share content from My Workspace with colleagues. Within My Workspace, your content is
organized into 4 tabs: Dashboards, Reports, Workbooks, and Datasets.



App workspacesApp workspaces

Search and sort contentSearch and sort content

Apps and app workspaces are a feature of Power BI Pro. If you are someone who authors dashboards and reports
for others, you'll use app workspaces to do this. An app workspace is the place where you'll create the app, so to
create an app, you'll first need to create the app workspace. They’re the evolution of group workspaces – staging
areas and containers for the content in the app. You and your colleagues can collaborate on dashboards, reports,
and other content that you plan to distribute to a wider audience, or even your entire organization.

To learn more, visit Create and distribute an app in Power BI.

As with My Workspace, your content is organized into 4 tabs: Dashboards, Reports, Workbooks, and Datasets.

Switch workspaces by selecting Workspaces in the left navpane.

The content view makes it easier to search, filter and sort your content. To search for a dashboard, report or
workbook, type in the search area. Power BI filters to only the content that has your search string as part of the
name.



Next steps

You can also sort the content by name or owner.

To learn more, see Power BI navigation: search, sort, filter

Power BI service Basic concepts

Have questions or feedback? Visit the Power BI community forum

http://community.powerbi.com/t5/Navigation-Preview-Forum/bd-p/NavigationPreview


10 tips for getting help with your Power BI questions
11/15/2017 • 3 min to read • Edit Online

1 Use a search engine

2 Check the Power BI documentation

3 Read the Power BI blog for the latest news

4 Try Twitter

5 Watch videos on YouTube

6 Attend training

Do you ever get frustrated using Power BI, or struggle because you can't get answers to your Power BI questions
when you need them -- i.e. "just-in-time"? 

Here are 10 tips that Power BI experts (including people who work on the product at Microsoft) commonly follow
to find answers to their Power BI questions.

Experts who need answers for Power BI often use search. Want to find a DAX formula for a common business
calculation? You can find this on the internet. Bookmark where you find the best answers. Create a folder for
yourself on tips and answers you find. 

The Power BI team is continually updating and improving the Power BI documentation and training. You can find
great content including recordings of webinars, white papers, guided learning, and links to blog posts on all the
latest features.

The Power BI team explains all the new features in their regular Power BI blog posts. Find out what's new in
everything from Power BI Desktop to the Power BI mobile apps. Make a habit of returning often to see what's new:
Take a few minutes each week to scan the blogs. You never know when you'll benefit from that bit of information
you noticed months ago.

Lots of Power BI customers and experts are on Twitter. Ask your question in a tweet. Add the hashtags #powerbi
and #powerbihelp so the people who know will see your tweet.

Do videos fit your learning style better? Power BI has two sets you'll be interested in:

A good place to start is the Analyze and Visualize data with Power BI playlist.
Then try the Power BI channel for a much bigger selection.
If you have more experience with Power BI, the Guy in a Cube YouTube channel might be a better fit for you.

The training options available to you are nearly endless, from in-person lab training to short videos.

Guided learning on the Power BI site.
Free Power BI webinars, live and on-demand, on the Power BI site.

You can find additional options online, such as:

edX.org offers a free course, Analyzing and Visualizing Data with Power BI.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-tips-for-finding-help.md
https://powerbi.microsoft.com/blog/
https://www.youtube.com/playlist?list=PL1N57mwBHtN0JFoKSR0n-tBkUJHeMP2cP
https://www.youtube.com/user/mspowerbi/videos
https://www.youtube.com/channel/UCFp1vaKzpfvoGai0vE5VJ0w
file:///W:/soyp-o-7bf22bb1/powerbi-docs/.tmp/guided-learning/gettingstarted.yml#step-1
https://www.edx.org/course/analyzing-visualizing-data-power-bi-microsoft-dat207x-4


7 Ask or search in the Power BI community

8 Join or create a Power BI user group

9 Check the service status

10 Just try it

Next steps

Lynda.com offers has courses such as Power BI Pro Essential Training.
Look for in-person "Dashboard in a Day" training sessions.

Ask questions and find answers in the Power BI community. BI experts around the world are active in the
community. Make sure to benefit from their knowledge by using this resource.

Join a Power BI user group and ask your group for help in answering your questions. Or you start your own user
group and create a community of people who help each other out, focused on your needs: in your area, for your
data, in your time zone.

If you're having an issue with the service, it may be that the service itself is having issues. Check the Support page
for any reports.

If all else fails, the final tip is to observe the system. Often, people ask what capabilities Power BI has. You can often
answer this type of question by going into the Power BI service or Power BI Desktop, looking at the options in the
user interface, and then trying to use them.

For example, say you're wondering if you can share dashboards with a security group. To answer that question, go
to the sharing dialog box and try adding a security group. Either way, you'll have your answer after this test.

Get started with Power BI
Try asking the Power BI Community
Still have an issue? Please visit the Power BI support page

https://www.lynda.com/Power-BI-tutorials/Power-BI-Pro-Essential-Training/485820-2.html
http://community.powerbi.com
https://community.powerbi.com/t5/Power-BI-User-Groups/ct-p/Groups
https://powerbi.microsoft.com/support/
http://community.powerbi.com/
https://powerbi.microsoft.com/support/


Navigation: searching, finding, and sorting content in
Power BI service
12/20/2017 • 1 min to read • Edit Online

NOTENOTE

Navigation within workspaces

Searching and sorting in workspaces

There are many ways to navigate your content in Power BI service. The content is organized within workspaces by
type: dashboards, reports, workbooks, and datasets. And the content is also organized by usage: favorites, recent,
apps, shared with me, and featured. These different pathways into your content allow you to quickly find what you
need in Power BI service.

This article applies to Power BI service (app.powerbi.com) and not to Power BI Desktop.

Power BI service separates your workspace content by type: dashboards, reports, workbooks, and datasets. You'll
see this organization when you select a workspace. In this example, the app workspace is named "Sales and
marketing app sample" and it contains 2 dashboards, 6 reports, 1 workbook, and 5 datasets.

A workspace has four content tabs: Dashboards, Reports, Workbooks, and Datasets. Each of these tabs contains a
search field and a sort button. When you're starting out with Power BI service, you might not find these helpful
because you'll have only one or two items per tab. However, over time you may may end up with long lists of
content. Use searching and sorting to easily find what you need.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-navigation-search-filter-sort.md


Navigation using the left navbar

Enter a search term to find a match on the current screen

Select the sort button to display options for the current page. The options are to sort by name or by owner.

The left navbar classifies your content in ways that make it even easier to find what you need, quickly.

Content that you create for your own use is available in My workspace, content that you create and share with a
group is available in an Apps workspace, content that is shared with you is available in Shared with me, and your
last-viewed content is available in Recent.



Considerations and troubleshooting

Next steps

Additionally, you can tag content as favorite and featured. Pick the one dashboard that you expect to view most
often, and set it as your featured dashboard. Each time you open Power BI service, this is the dashboard that will
display first. Do you have a number of dashboards and apps that you visit often? By setting them as favorites,
they'll always be available from your left navbar.

.

For datasets, Sort by is not available by owner.

Power BI - Basic Concepts

More questions? Try the Power BI Community

http://community.powerbi.com/


View related content in Power BI service
1/8/2018 • 3 min to read • Edit Online

NOTENOTE

View related content for a dashboard

The Related content pane shows you how your Power BI service content -- dashboards, reports, and datasets --
are interconnected. And it gets better, from this pane you can perform common task such as refreshing, renaming,
generating insights, and so much more. Select a related report or dashboard, and it opens in your Power BI
workspace.

As you've probably already discovered, reports are built on datasets, report visualizations are then pinned to
dashboards, and dashboard visuals link back to reports. But how do you know which dashboards are hosting
visualizations from your Marketing report? And how do you locate those dashboards? Is your Procurement
dashboard using visualizations from more than one dataset? If so, what are they named and how can you open and
edit them? Is your HR dataset being used in any reports or dashboards at all or can it be moved without causing
any broken links? Questions like these can all be answered on the Related content pane. Not only does the pane
display the related content, it also allows you take action on the content and easily navigate between the related
content.

The related content feature does not work for streaming datasets.

Watch Will view related content for a dashboard. Then follow the step-by-step instructions below the video to try it
out yourself with the Procurement Analysis sample dataset.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-related-content.md


You'll need at least view permissions to a dashboard to open the Related content pane. In this example we're
using the Procurement Analysis sample.

Method 1

In a workspace, select the Dashboards tab and then select the View related icon  .

Method 2

With a dashboard open, select  from the top menubar.

The Related content pane opens. It shows all the reports that have visualizations pinned to the dashboard and
their associated datasets. For this dashboard, there are visualizations pinned from 3 different reports and those
reports are based on 3 different datasets.

From here, you can take direct action on the related content. For example, select a report name to open it. For a
listed report, select an icon to analyze in Excel, rename, or get insights. For a dataset, select an icon to create a new
report, refresh, rename, analyze in Excel, get insights, or open the Settings window for the dataset.



View related content for a report

View related content for a dataset

You'll need at least view permissions to a report to open the Related content pane. In this example we're using
the Procurement Analysis sample.

Method 1

In a workspace, select the Reports tab and then select the View related icon  .

Method 2

Open the report in Reading view and select  from the top menubar.

The Related content pane opens. It shows the associated dataset and all dashboards that have at least one tile
pinned from the report. For this report, there are visualizations pinned to 2 different dashboards.

From here, you can take direct action on the related content. For example, select a dashboard name to open it. For
any dashboard in the list, select an icon to share the dashoard with others or to open the Settings window for the
dashboard. For the dataset, select an icon to create a new report, refresh, rename, analyze in Excel, get insights, or
open the Settings window for the dataset.

You'll need at least view permissions to a dataset to open the Related content pane. In this example we're using
the Procurement Analysis sample.

In a workspace, select the Datasets tab and locate the View related icon  .

Select the icon to open the Related content pane.



Limitations and troubleshooting

Next steps

From here, you can take direct action on the related content. For example, select a dashboard or report name to
open it. For any dashboard in the list, select an icon to share the dashoard with others or to open the Settings
window for the dashboard. For a report, select an icon to analyze in Excel, rename, or get insights.

If your browser doesn't have enough space, you won't see an option for View related but you will still see the

View related icon  . Select the icon to open the Related content pane.
To open Related content for a report, you need to be in Reading view.
Related content is not available in Power BI Desktop.
The Related content feature does not work for streaming datasets.

Get started with Power BI service
More questions? Try the Power BI Community

http://community.powerbi.com/


Extended Pro Trial activation
1/30/2018 • 5 min to read • Edit Online

Beginning on June 1, 2017, all eligible users will be able to opt-in to the Extended Pro Trial for the Power BI
service.

As part of the May 3, 2017 Power BI Premium announcement, Microsoft communicated changes to the free
Power BI service effective June 1,2017. These changes include extending access to all data sources, higher
workspace storage limits, and higher refresh and streaming rates to the Free service, making it equivalent to
Power BI Pro.

Also announced was that sharing and collaboration features will be exclusive to Power BI Pro users, including
peer-to-peer dashboard sharing, group workspaces (now called app workspaces), export to PowerPoint and
analyze in Excel with Power BI apps. Export to CSV/Excel and PowerPoint were identified in the May 3
communication as a capability limited to Power BI Pro, but after receiving feedback from the broad user
community the strategy has evolved to make the capability available to users of the Free service as well.

Beginning June 1, 2017 existing users of the Free service who have been active within the past year (on or before
May 2, 2017) will be eligible for a free, 12-month extended trial of Power BI Pro. The offer will let users take
advantage of the full capabilities of Power BI Pro for the next year as a sign of appreciation to the community and
to provide users with time to adjust to the changes.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-extended-pro-trial.md
https://powerbi.microsoft.com/blog/microsoft-accelerates-modern-bi-adoption-with-power-bi-premium/


Eligibility for Extended Pro Trial

NOTENOTE

How to activate

NOTENOTE

On June 1, 2017 eligible users will receive a notification when they sign into the service letting them know the
changes have gone into effect with a prompt to register for the Extended Power BI Pro trial offer. A user’s IT admin
does not control the in-product notifications, nor does the IT admin have the ability to register for the extended
Power BI Pro trial on behalf of a user. Each eligible user must individually take action to complete this process.

Users can opt to register for the offer at any time during the 12-month period, but the Extended Pro trial will
conclude for all users on May 31, 2018 regardless of when they accept the offer. At this time users will have the
option to purchase Power BI Pro or be converted to the Free version of Power BI, without the sharing and
collaboration capabilities, if they elect not to take action and purchase Power BI Pro.

No changes are being made to Power BI Pro. These users are not impacted and will not receive notifications when
signing into the service on June 1, 2017 or after. Users who decline the extended Power BI Pro trial offer or are
ineligible for the offer will continue using the Free version of Power BI without the sharing and collaboration
capabilities. They can register at any time for a standard 60-day Power BI Pro trial by visiting the Power BI website.

Your account must meet the following requirements in order to be eligible for the Extended Pro Trial offer.

Power BI Free users active between May 3, 2016 and May 2, 2017 are eligible for an Extended Pro Trial.
Users that have previously used or are currently on the 60-day in-product Pro trial are still eligible for the
Extended Pro Trial.

Users that have licenses assigned from the Power BI Pro or Power BI Pro Trial subscriptions, within Office 365, are excluded
from this offer.

There are two ways to activate the Extended Pro Trial. The first is when you sign into Power BI. If you had
dismissed that, you will also see an option within the notification area.

The in product communications are not controlled by the admin and will go out to eligible users.

https://powerbi.microsoft.com/get-started/


Experience at sign inExperience at sign in

Activation at a later dateActivation at a later date

After activation

When you sign in to the Power BI service, and are eligible, you will get a pop-up notice. Selecting Activate Trial
will begin the Extended Pro Trial. No further action will be needed.

You will then have the ability to access all existing shared dashboards and reports for the duration of the trial.

If you selected Not Now, the Extended Pro Trial can be activated any time until the end of the trial period on May
31, 2018.

If you dismissed the pop-up by selecting Not Now, the Extended Pro Trial can be activated any time until the end
of the trial period on May 31, 2018. This can be done in the Notification center.

Within the notification center, you will see a notification regarding the Extended Pro Trial. The notification will be
available until the user dismisses it.

Within the notification, you can select Activate Trial to begin the trial. No further action will be needed.

You will then have the ability to access all existing shared dashboards and reports for the duration of the trial.

After activation, you will see how many days are left in your trial in the top right.



Frequently Asked Questions

NOTENOTE

Next steps

You can review the terms within the Extended Pro Trial offer terms and conditions. The Extended Pro Trial runs
through May 31, 2018 for all eligible users.

What happens to new users who signed up after May 3, 2017?

Users who signed up to Power BI Free on or after May 3, 2017 are not eligible for the Extended Pro Trial. However,
they are eligible for the standard 60-day Pro Trial.

How do I find out who in my organization is eligible for the Extended Pro Trial?

While there is not a direct way to discover this, you can view the Azure Active Directory Integrated Applications
report for Power BI to see who are active users within your organization within the last 30 days. This may give you
an idea of who may be eligible. For more information, see Find Power BI users that have signed in.

Those active users in the eligibility period, and who are on free licenses, will receive the pop-up notification.

The Azure AD report does not indicate if a user is Free or Pro within Power BI. It only reports which users have signed in to
Power BI and when they logged in. If a user is listed in this report, it does not necessarily mean that they are eligible for the
Extended Pro Trial.

Can admins restrict a user from activating the Extended Pro Trial?

No. Admins do not have a way to restrict users from activating the Extended Pro Trial or the in-service 60 day trial
of Power BI Pro.

Extended Pro Trial offer terms and conditions
Power BI Service agreement for individual users
Power BI Premium announcement
Find Power BI users that have signed in

More questions? Try asking the Power BI Community

https://aka.ms/power-bi-trial
https://aka.ms/power-bi-trial
https://powerbi.microsoft.com/terms-of-service/
https://aka.ms/pbipremium-announcement
https://community.powerbi.com/


Opt-in for Power BI preview features
12/20/2017 • 1 min to read • Edit Online

What are preview features?

TIPTIP

Find previews and turn them on (and off)

As we make improvements to Power BI, we'll release some new functionality as preview features. Preview features
can be turned on and off, giving you the opportunity to try them out.

Have questions or feedback? Visit the Power BI community forum.

3. Select the On radio button, or mark the checkbox, to try out the new experience. Then select Apply.
4. To turn preview features off, follow steps 1-3 above, and in step 3, choose Off, or remove the checkmark, and

select Apply.

1. Open your Settings menu by selecting the gear icon in the top right corner of your Power BI screen and
choosing Settings.

.

2. Select the General tab. If previews exist, you'll either see an option for Preview features or you'll see a
preview feature listed on the left. In this example, there is a preview listed for ArcGIS Maps.

Have questions or feedback? Visit the Power BI community forum.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-preview-features.md
http://community.powerbi.com/t5/Navigation-Preview-Forum/bd-p/NavigationPreview
http://community.powerbi.com/t5/Navigation-Preview-Forum/bd-p/NavigationPreview


Frequently asked questions about Power BI
1/3/2018 • 7 min to read • Edit Online

What is Microsoft Power BI?

What’s the difference between Power BI and Power BI Pro?

How much does Power BI cost?

What if I have questions about Power BI Premium?

Are users who signed up after May 3, 2017 eligible for the Extended
Pro Trial?

How do I find out who in my organization is eligible for the Extended
Pro Trial?

NOTENOTE

If you have other questions, try asking the Power BI Community.
Still have an issue? Please visit the Power BI support page.

Power BI is a cloud-based business analytics service that enables anyone to visualize and analyze data with greater
speed, efficiency, and understanding. It connects users to a broad range of data through easy-to-use dashboards,
interactive reports, and compelling visualizations that bring data to life.

Power BI provides all sorts of features to help you get started exploring data in a whole new way. Power BI Pro
provides all of the same great features in Power BI, plus additional features like more storage capacity, scheduling
data refresh more frequent than daily, live data sources with full interactivity, groups, and more. Learn more about
the differences between Power BI Pro and the free Power BI.

Power BI Desktop are free. There is a 60-day free trial available for Power BI Pro. Read about pricing at Power BI
pricing.

For questions related to Power BI Premium, see Power BI Premium FAQ.

Users who signed up to Power BI (free) on or after May 3, 2017 are not eligible for the Extended Pro Trial. However,
they are eligible for the standard 60-day Pro Trial.

While there is not a direct way to discover this, you can view the Azure Active Directory Integrated Applications
report for Power BI to see who are active users within your organization. Those active users in the eligibility period,
and who are on free licenses, will receive the pop-up notification. For more information, see Find Power BI users
that have signed in.

The Azure AD report does not indicate if a user is Free of Pro within Power BI. It only reports which users have signed in to
Power BI and when they logged in. If a user is listed in this report, it does not necessarily mean that they are eligible for the
Extended Pro Trial.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-frequently-asked-questions.md
http://community.powerbi.com/
https://powerbi.microsoft.com/support/
https://powerbi.microsoft.com/
https://powerbi.microsoft.com/pricing
https://powerbi.microsoft.com/pricing


What is Power BI Desktop?

What do I need to use Power BI?

NOTENOTE

Why do I have to sign up with my work email?

Which work email addresses are supported?

Is government, academic and non-profit pricing available for Power BI?

Is Power BI available on-premises?

On-premises data gatewayOn-premises data gateway

Power BI Report ServerPower BI Report Server

Power BI mobile appsPower BI mobile apps

Power BI Desktop is a free desktop application you can install right on your own computer. Power BI Desktop works
cohesively with the Power BI service by providing advanced data exploration, shaping, modeling, and report
creation with highly interactive visualizations. You can save your work to a file, and publish your data and reports
right to your Power BI site to share with others.

Just a Web browser and work email address.

Work email addresses ending in .gov and .mil aren’t currently supported.

Power BI does not support email addresses provided by consumer email services or telecommunications providers.
Learn more about the Power BI self-service sign-up process.

Work email addresses ending in .edu and .org are supported.

Those ending in .gov and .mil aren’t currently supported.

Yes, non-profit pricing is available when purchasing directly from Microsoft. You can learn more and sign up
through the Microsoft Product Donation site. Government and academic pricing is offered through the
MOSP/Direct, EA, and Open licensing programs. Government pricing is also available in syndication. Power BI is not
yet available for the US Government Community Cloud (GCC).

The Power BI service https://powerbi.com isn't available as a private, internal cloud service. However, you have
three other options for viewing and working with data on premises.

With Power BI and Power BI Desktop, you can securely connect to your own on-premises data sources. With the
on-premises data gateway, you can connect live to your on-premises SQL Server Analysis Services server, and
other data sources. You can also set scheduled refresh with a centralized gateway. If a gateway is not available, you
can refresh data from on-premises data sources using the Power BI Gateway - Personal.

Power BI Report Server is a solution that you deploy on your own premises for creating, publishing, and managing
reports, then delivering them to different users in different ways: in a web browser, on their mobile device, or as an
email in their in-box. Read more about Power BI Report Server.

You can also view on-premises Power BI reports, Reporting Services mobile reports, and KPIs with the Power BI
mobile apps.

https://powerbi.microsoft.com/designer
https://www.microsoft.com/about/philanthropies/product-donations/products/powerbi/
https://powerbi.com


Does Power BI support mobile devices?

What data sources can I connect to?

What are content packs?

What do I need to install in order to use Power BI?

Am I limited to one copy of Power BI Desktop for my entire company?

Where do I get started with Power BI?

Yes. Power BI has native apps for Android phones and tablets, iOS devices, and Windows 10 devices. Download one
of the Power BI mobile apps from its respective store:

Apple App Store
Google Play
Windows Store

The list of data sources for Power BI is extensive, but it can be grouped into the following:

Data from Excel and Power BI Desktop files.
Content packs for services, with ready-made dashboards, reports, and datasets for services such as Salesforce. In
addition to establishing a data connection, Power BI provides pre-built dashboards and reports for each of these
services.
Connectors to databases and other datasets such as Azure SQL Database and SQL Server Analysis Services
tabular data.

Read more about getting data in Power BI.

Content packs for services are pre-built solutions for popular services as part of the Power BI experience. A
subscriber to a supported service can quickly connect to their account from Power BI and see their data through
live dashboards and interactive reports that have been pre-built for them. We’ve released content packs for popular
services such as Salesforce.com, Marketo, and Adobe Analytics. Read more about connecting to services with
content packs.

Organizational content packs provide users, BI professionals, and system integrators the tools to build their own
content packs to share purpose-built dashboards, reports, and datasets within their organization.

To use the Power BI service for free, you just need a Web browser and email.

To explore data and create reports in Power BI Desktop, download Power BI Desktop for free.

You can download the Power BI mobile apps from their respective stores, also for free:

App Store
Google Play
Windows Store

Power BI Desktop’s Software License Terms say "You may install and use one copy of the software on your
premises." This does not limit you to one copy of Power BI Desktop for the entire company. Each individual user at
the company may install and use one copy on their premises.

The following resources are available to help get your started:

Power BI Blog

https://powerbi.microsoft.com/mobile
http://go.microsoft.com/fwlink/?LinkId=526218
http://go.microsoft.com/fwlink/?LinkID=544867&clcid=0x409
http://go.microsoft.com/fwlink/?LinkId=526478
http://powerbi.microsoft.com/designer
http://go.microsoft.com/fwlink/?LinkId=526218
http://go.microsoft.com/fwlink/?LinkID=544867&clcid=0x409
http://go.microsoft.com/fwlink/?LinkId=526478
http://blogs.msdn.com/b/powerbi/


What browsers does Power BI support?

What regions and languages does Power BI support?

How can I buy Power BI Pro in my country?

What happens if my Power BI Pro license expires?

Does Power BI meet national, regional, and industry-specific
compliance requirements?

Where can I learn more about security?

What has happened to the Power BI for Office 365 experience?

How do I undo in Power BI?

Next steps

Webinars
Getting started videos on our YouTube Channel
Get started with Power BI article
Join our community and ask questions
See 10 tips for getting help for more suggestions

Here's a complete list of supported browsers for Power BI.

Here's a complete list of regions and languages supported by Power BI.

You can purchase Power BI Pro licenses directly or chat with a representative at www.powerbi.com.

You can also find a Microsoft Partner to help you with your Power BI implementation.

There is a 30-day grace period after a Power BI Pro license expires.

Power BI Pro has the same subscription lifecycle as Office 365. For more information, see What happens to my data
and access when my Office 365 for business subscription ends?

Learn more about Power BI compliance, at the Microsoft Trust Center.

Learn more about Power BI security, privacy and compliance in this Power BI Security whitepaper and our Power BI
security support article.

The Power BI for Office 365 experience has been deprecated.

Like many other Microsoft services and software, Power BI provides an easy way to undo your last command.

To undo your last action, or last few actions, press CTRL+Z.

More questions? Try asking the Power BI Community
Still have an issue? Please visit the Power BI support page

https://www.youtube.com/user/mspowerbi
https://community.powerbi.com/
http://www.powerbi.com
https://partner.microsoft.com/
https://support.office.com/en-us/article/What-happens-to-my-data-and-access-when-my-Office-365-for-business-subscription-ends-4436582f-211a-45ec-b72e-33647f97d8a3
http://go.microsoft.com/fwlink/?LinkId=785324
http://go.microsoft.com/fwlink/?LinkId=829185
http://community.powerbi.com/
https://powerbi.microsoft.com/support/


What's new in the Power BI service
1/19/2018 • 30 min to read • Edit Online

September 2017

Previous months (2017)
August 2017August 2017

July 2017July 2017

June 2017June 2017

April and May 2017April and May 2017

Check this page for known issues and recently released features in the Power BI Service. For related "What's
New" information, see:

What's new in Power BI Desktop
What's new in the mobile apps for Power BI
Power BI team blog

You can also check out the YouTube channels for information about "What's new" and features.

Microsoft Power BI (YouTube)
Guy in a Cube (YouTube)

Share dashboards to free users with Premium.
Allocate capacities to suit your business needs with v-core pooling.
Instantly scale-up or scale-down capacities with one click.
PubNub block to easily push data into REST APIs
Improved load performance for usage metrics.

Know your audience with per-user usage metrics.
Get started with Power BI service apps for online services.
Connect to IBM Netezza with the on-premises data gateway through both import and DirectQuery
connectivity modes.
Dynamic RLS now supported for Power BI Embedded.
Advanced filtering API now added for the 1.7 release of custom visuals API.

Support for email subscriptions on dashboards.
Inspect and diagnose why the loading time is poor for dashboards using the Performance Inspector.
Snowflake and SAP BusinessWarehouse DirectQuery now supported for on-premises data gateway.
New APIs to manage data refresh in Power BI service.

Power BI Premium made generally available.
Multiple API improvements to automate scheduled refresh, clone and rebind reports, update gateway
bindings, and much, much more
Relative links in Power BI apps from dashboard tiles to other dashboards and reports.
Impala connector generally available on Power BI Desktop.
Extend visual capabilities of Power BI with interactive R custom visuals.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-whats-new.md
https://powerbi.microsoft.com/blog/
https://www.youtube.com/channel/UCy--PYvwBwAeuYaR8JLmrfg
https://www.youtube.com/channel/UCFp1vaKzpfvoGai0vE5VJ0w
https://www.pubnub.com/docs/blocks-catalog/power-bi-realtime-dashboards
https://powerbi.microsoft.com/blog/introducing-per-user-usage-metrics-know-your-audience-and-amplify-your-impact/
https://github.com/Microsoft/powerbi-visuals-sampleslicer/blob/master/doc/UsingAdvancedFilterAPI.md
https://powerbi.microsoft.com/blog/announcing-data-refresh-apis-in-the-power-bi-service/
https://powerbi.microsoft.com/blog/power-bi-premium-generally-available/
https://powerbi.microsoft.com/blog/announcing-data-refresh-apis-in-the-power-bi-service/
https://github.com/Azure-Samples/powerbi-powershell/blob/master/rebindReport.ps1
https://msdn.microsoft.com/library/mt784650.aspx
https://powerbi.microsoft.com/blog/power-bi-desktop-june-feature-summary/#impala
https://powerbi.microsoft.com/blog/interactive-r-custom-visuals-support-is-here/


March 2017March 2017

February 2017February 2017

January 2017January 2017

2016
November 2016November 2016

October 2016October 2016

Measure and magnify your impact with usage metrics for dashboard and report creators.
Connect to PostgreSQL with the on-premises data gateway.
Power BI SharePoint Web Part made available for all users.
Connect Power BI to any data source using the Data Connector SDK.
Navigate to reports with multiple URL filter parameters.
Preview: Use Power BI Apps to widely distribute your dashboards and reports to large audiences.

Fine-tune how Power BI used in your organization with granular admin controls.
Get more done in less time with the View Related Content pane.
Improved troubleshooting messages for DAX queries.
Exercise more control over your datasets with custom cache refresh schedules.
Connect to Amazon Redshift.
Browse Power BI custom visuals in the Office Store.
Preview: Subscribe to report pages to stay on top of your data.
Use the Azure AD Content Pack to learn more about how your employees and partners are using Azure AD.

Navigation Preview improvements – more easily switch between workspaces, and take action on content
within the current workspace.
Embed Power BI dashboards into your custom application.
Preview: Integrate Power BI reports in SharePoint Online.

Administer Power BI using the Power BI admin role.
Power BI audit logs in the Office 365 auditing portal are globally available.
Version 1.4 of developer tools and custom visuals APIs released.
Real-time streaming feature set released to general availability.
Push data to Power BI using Microsoft Flow without writing a line of code.
Preview: Subscribe to report pages to stay on top of your data.
Use the Azure AD Content Pack to learn more about how your employees and partners are using Azure AD.

Preview: Try out the new navigation for the Power BI service, powerbi.com
Preview: Export a Power BI report to PowerPoint.
Preview: Download Power BI reports (PBIX files) from the Power BI service so you can edit them in Power BI
Desktop.
Create a liquid fill gauge, a circle gauge that represents a percentage value with animated liquid waves.
Explore your Jira project-management data with this Power BI content pack
Explore your Insightcentr data with this Power BI content pack
Create infographics quickly with the infographic designer custom visual
Private preview: Azure Stream Analytics outputs Power BI streaming datasets, with which you can create
streaming tiles.
Preview: Add ESRI ArcGIS Maps Visualizations to your reports and dashboards

Take advantage of Power BI integration with the new Microsoft Teams.

https://powerbi.microsoft.com/blog/data-connectors-developer-preview/
https://powerbi.microsoft.com/blog/distribute-to-large-audiences-with-power-bi-apps/
https://powerbi.microsoft.com/blog/announcing-granular-tenant-settings-in-power-bi/
https://powerbi.microsoft.com/blog/announcing-the-view-related-content-pane-navigation-made-even-easier/preview/
https://powerbi.microsoft.com/blog/power-bi-service-march-feature-summary/#DAXtroubleshooting
https://powerbi.microsoft.com/blog/announcing-custom-cache-refresh-schedules-in-the-power-bi-service/
https://powerbi.microsoft.com/blog/announcing-support-for-amazon-redshift-reports-in-the-power-bi-service/
https://powerbi.microsoft.com/blog/custom-visuals-now-available-in-the-office-store/
https://powerbi.microsoft.com/blog/introducing-email-subscriptions-in-power-bi-stay-informed-when-it-matters/
https://powerbi.microsoft.com/blog/power-bi-service-february-feature-summary/
https://powerbi.microsoft.com/blog/embed-dashboard/
https://powerbi.microsoft.com/blog/integrate-power-bi-reports-in-sharepoint-online/
https://powerbi.microsoft.com/blog/power-bi-service-january-feature-summary/#pbiadminrole
https://powerbi.microsoft.com/blog/power-bi-service-january-feature-summary/#auditlogs
https://powerbi.microsoft.com/blog/new-apis-available-for-custom-visuals-developers/
https://powerbi.microsoft.com/blog/announcing-general-availability-of-power-bi-real-time-streaming-datasets/
https://powerbi.microsoft.com/blog/push-rows-to-a-power-bi-streaming-dataset-without-writing-any-code-using-microsoft-flow/
https://powerbi.microsoft.com/blog/introducing-email-subscriptions-in-power-bi-stay-informed-when-it-matters/
https://powerbi.microsoft.com/blog/announcing-the-new-power-bi-navigation-preview/
https://powerbi.microsoft.com/blog/export-power-bi-report-to-powerpoint-preview/
https://powerbi.microsoft.com/blog/announcing-preview-of-download-power-bi-desktop-files-from-the-web/
https://powerbi.microsoft.com/blog/visual-awesomeness-unlocked-liquid-fill-gauge/
https://powerbi.microsoft.com/blog/explore-your-jira-data-with-power-bi/
https://powerbi.microsoft.com/blog/explore-your-insightcentr-data-with-power-bi/
https://powerbi.microsoft.com/blog/quickly-create-infographics-with-the-infographic-designer-custom-visual-for-power-bi/
https://powerbi.microsoft.com/blog/announcing-private-preview-of-azure-stream-analytics-outputting-to-power-bi-streaming-datasets/
https://powerbi.microsoft.com/blog/arcgis-maps-for-powerbi-available-in-powerbi-service/
https://powerbi.microsoft.com/blog/power-bi-teams-up-with-microsoft-teams/


July 2016July 2016

June 2016June 2016

May 2016May 2016

Design R visualizations in Power BI without understanding R.
Preview: With Azure Analysis Services, BI professionals can create BI semantic models based on data that
resides in the cloud or on premises, to provide business users with a simplified view of their data.
The new Power BI Service Administrator Role can be assigned to users who should have access to the Power
BI Admin Portal but not other Office 365 administrative access.
Explore your MYOB Advanced data with Power BI.
How a non-administrator can review the Power BI audit log
Display text columns as ToolTips.

RLS graduates from preview

Row Level Security (RLS) lets you restrict data access based on who is accessing it. Recently we streamlined
the process of configuring RLS by exposing roles and rules in Power BI Desktop. Today, we are happy to
announce that RLS is now generally available for all Power BI Pro users.

Data classification

You can now tag your dashboards with classifications defined by your company's IT department, raising
awareness of those viewing your dashboards about what level of security should be used.

Analyze your on-premises data in Excel

Analyze in Excel feature has expanded to support on-premises datasets. We establish a secure and direct
connection to your on-premises dataset that enables you to analyze it in Excel. We also introduced a setting
for admins to turn off the Analyze in Excel feature for on-premises sources.

For all the details, visit the Power BI team blog

Quick Insights

Quick Insights work with Complex Filters: We are happy to announce that Quick Insights scoped to a single
tile now understand complex filters.

For all the details, visit the Power BI Team blog

Get Data

File size limit increase to 1 GB: We increased the file size limit for both Excel workbooks and Power BI
Desktop files to 1 GB.
Find SSAS servers set up with the Enterprise gateway and other gateway updates: Now when you set up an
Enterprise gateway, users in your company will be able to access these servers in the Power BI service
through the Get Data page. We also added support for refreshing datasets that include data from SAP
Business Warehouse Server using the gateway and creating UPN mapping rules when you are using
Analysis Services with the gateway.

Row-level security (RLS)

Azure Active Directory (AAD) group support: Users can now assign AAD groups (security groups and
distribution lists) to a role. This makes it easier to assign roles to a large group of users at once.
Test your RLS roles with reports backed by the data with RLS in place: We added a feature to our RLS
preview that lets you test your dataset as a specific role. This will make sure the role works as you expect
before any users get their hands on your dashboard.
Define and apply RLS to cloud models based on direct queries: You can now create and apply RLS rules for

https://powerbi.microsoft.com/blog/r-powered-custom-visuals/
https://powerbi.microsoft.com/blog/introducing-azure-analysis-services/
https://powerbi.microsoft.com/blog/making-it-easier-to-administer-power-bi/
https://powerbi.microsoft.com/blog/explore-your-myob-advanced-data-with-power-bi/
https://powerbi.microsoft.com/blog/tech-tip-thursday-power-bi-auditing-for-a-non-administrator/
https://powerbi.microsoft.com/blog/tech-tip-thursday-displaying-text-columns-in-tool-tips/
https://powerbi.microsoft.com/blog/power-bi-july-update-for-service-and-mobile/
https://powerbi.microsoft.com/blog/smarter-auto-generated-insights-with-complex-filters/


direct query data sources.

Dashboards

Favorite dashboards: To help you reach the dashboards you go to most, we added a way to favorite those
dashboard and make them easily accessible from all your workspaces.

Analyze in Excel

Improved download experience: Easily download updates to the Analyze in Excel feature through a new
dialog experience.
Support for RLS: Once you set up RLS, the rules you apply to the data now flow through when a user
analyzes the data in Excel.
Improved error messaging for on-premises Analysis Services databases: Previously, if you selected Analyze
in Excel for an unsupported data source, you wouldn't get an error message until after you downloaded the
ODC file and tried to connect to Power BI. Now as soon as you select Analyze in Excel for a data source we
don't support, you'll see a message letting you know we don't yet support that data source.

For all the details, visit the Power BI Team blog

Power BI Q&A support for SQL Server 2016 Analysis Services tabular models: We are pleased to announce
improvements to the Power BI Q&A user experience and the start of the public preview for Power BI Q&A
for enterprise gateway connected data sources - starting with support for SQL Server 2016 Analysis Services
tabular models. For all the details, see the blog post
Local File Support for Excel Reports: You can now upload your Excel files from your local drive or other
storage services and use that Excel Report just as you would in Excel Online with the added benefits of Power
BI. For all the details, see the blog post

April 28, 2016

Quick Insights on Dashboard Tiles: When viewing a tile in Focus mode, click Get Insights to search the tile
and its related data for correlations, outliers, trends, seasonality, change points in trends, and major factors
automatically, within seconds.

For all the details, visit the Power BI Team blog

April 26, 2016

Narratives for Power BI: As you interact with your data and visualizations, this custom visual dynamically
delivers insights in narrative form, just like you'd expect an analyst would write. This visual is fueled by
Narrative Science Quill.

For all the details, visit the Power BI Team blog

April 16, 2016

Microsoft Trust Center: Power BI joined the Microsoft Trust Center, a single source for documenting
compliance certifications for Microsoft products. Power BI's certifications include ISO 27001, ISO 27018, EU
Model Clauses, HIPAA BAA, and UK G-Cloud.

For all the details, visit the Power BI Team blog

April 14, 2016

Enterprise

ExpressRoute: use to establish a private, managed connection to Power BI.
Content pack support for RLS (Preview): If RLS is defined for those dashboards and reports that are
distributed as part of a content pack, then the security rules will be respected for those content packs.

https://powerbi.microsoft.com/blog/power-bi-service-may-update-file-size-increase-to-1-gb/
https://powerbi.microsoft.com/blog/power-bi-q-a-for-enterprise-gateway-connected-data-sources-now-available-in-public-preview/
https://powerbi.microsoft.com/blog/powerbi-upload-excel-reports-from-local-files/
https://powerbi.microsoft.com/blog/find-more-insights-in-your-dashboards-with-quick-insights/
https://www.narrativescience.com/quill
https://powerbi.microsoft.com/blog/get-natural-language-narratives-in-power-bi-reports/
https://powerbi.microsoft.com/blog/power-bi-added-to-microsoft-trust-center/


Dashboards

Vimeo video tile: From the dashboard, add a tile that contains an embedded Vimeo player.

Analyze in Excel

Analyze in Excel available to all users: the ability to access your Power BI data models in Excel has been
extended to all users; free and Pro.
Improved multi-user account experience: if you have more than 1 Power BI user account, it's now easier to
sign-in.

For all the details, visit the Power BI Team blog

March 31, 2016 Lots of updates announced at the Microsoft Data Insights Summit.

Dashboards

Featured dashboard: makes it easier to reach the dashboard you care about most.
Filter dashboard list: show all, show content you created, show content shared with you.

Enterprise features

Admin usage reporting: added a usage report to the Power BI admin center.
Row-level security: this is a Preview feature that allows you to set permissions on Power BI datasets.
Disable exporting data: users in your tenant will no longer be able to export tile and visual data to a .csv file.

Q&A

Auto complete for "is": Q&A will suggest values if you type column name followed by "is".

Mobile

KPIs on your Apple watch: monitor your KPI and card tiles without having to open Power BI app.

Excel

Analyze in Excel: connect your Power BI data model to Excel and do your analysis inside of Excel instead of
Power BI.

Other

Power BI in Australia: now anyone in Australia, individual or through an organization, can go to
powerbi.microsoft.com and sign up for Power BI.
Language settings: override the automatic language detection and set the language for Power BI.

For all the details, visit the Power BI Team blog

March 11, 2016

This month we made some updates to dashboards, Quick Insights, and Q&A.

Dashboards

Full Screen mode: print without having to exit Full Screen mode first
Full Screen mode: expand your tiles to fill the entire canvas and remove excess white space by selecting Fit
to Width
Use Tile Flow to automatically align your tiles to the top left corner of the canvas.

Quick Insights

The Trend and Correlaction insights now have trend lines to make it easier to see patterns in the data.

https://powerbi.microsoft.com/blog/power-bi-service-april-update-expressroute-for-power-bi/
https://powerbi.microsoft.com/blog/power-bi-service-march-update-part-two/


Q&A

You can now specify Gauge and Area charts in Q&A
Improved auto-complete for Q&A - as soon as you type just a few characters, Q&A begins auto completing
and suggesting visuals for you.

For all the details, visit the Power BI Team blog

February 10, 2016

Today we released a long list of top-requested features. Read the blog post.

Sharing

Share with users outside your organization
Request access to a dashboard

Admin Portal

Easy user management with a link to the O365 Admin Center
Ability to disable publish to web
Prevent users from publishing content packs to the entire org
Ability to disable sharing content to external users

Quick Insights

Quick Insights when you publish Power BI Desktop files

Dashboard

Add Web content to your dashboard (via Widget)
Add video content to your dashboard (via Widget)
Zoom on dashboards

Connectivity

Connect to files on your team SharePoint site through a URL

For all the details, visit the Power BI Team blog

January 28, 2016

Updates to reports and visualizations:

Add borders to visuals
Add background images to pages and Cartesian chart plot areas

Performance Improvements for report rendering, cross-highlight, etc.

Regardless of the browser version being used, a significant Performance improvement can be noticed by
users when loading reports, switching between pages, cross-highlighting data across visuals, etc. with this
new update.

January 6, 2016

The Power BI team has been busy over the holiday break. For all the details, visit the Power BI Team blog

Dashboards

Export tile data
Add an image or text box widget to dashboards

https://powerbi.microsoft.com/blog/power-bi-service-march-update/
https://powerbi.microsoft.com/blog/power-bi-february-service-update/
https://powerbi.microsoft.com/blog/power-bi-february-service-update/
https://powerbi.microsoft.com/blog/power-bi-updates-this-week-new-report-authoring-capabilities/#borders
https://powerbi.microsoft.com/blog/power-bi-updates-this-week-new-report-authoring-capabilities/#background
http://blogs.msdn.com/b/powerbi/archive/2016/01/06/power-bi-service-update-0106.aspx


2015

Print dashboards
Refresh time on tiles
Tooltips on dashboard tiles

Collaboration

Shared dashboard notification
Contact owner of a shared or organizational dashboard

Reports

Print current report page
Export report visual data

Connectivity

Connect to files on SharePoint team sites

Excel Reports

Open Excel reports in Excel desktop
Pin Excel charts
Format improvements for Excel tiles

Other

Power BI in Brazil
Hebrew and Arabic support

For all the details, visit the Power BI Team blog

December 16, 2015

Lots of updates this week, most apply to Power BI Desktop but several significant updates to report authoring
and visualizations as well. The Power BI Team Blog contains full descriptions and even a video describing the
updates.

Download Power BI Desktop

R visuals integration in Desktop (Preview feature)

Updates to the report authoring formatting pane and ribbon:

1. Format data labels per category series
2. Change number of decimal places showed in visuals
3. Change text size in visuals
4. Ability to lay out visuals accurately: alignment, distribute, size, position (requires Power BI Desktop for

authoring)
5. Set styles across multiple visuals through Format Painter (requires Power BI Desktop for authoring)
Enhancements to visualizations:

1. visuals cue for sort state in Table visual
2. new visual: Stacked Area chart
3. smart tooltips for Area and Line charts on hover
4. ability to create Reference line/region for a Cartesian visual
5. improved data labels for pie and scatter chart

http://blogs.msdn.com/b/powerbi/archive/2016/01/06/power-bi-service-update-0106.aspx
http://blogs.msdn.com/b/powerbi/archive/2015/12/16/more-power-bi-feature-updates-power-bi-desktop-december-update-and-new-power-bi-service-features.aspx
https://powerbi.microsoft.com/desktop?WT.mc_id=Blog_Desktop_Update


Desktop will suggest table to table relationships when trying to create 2 tables which are not related.
Desktop optimized Home ribbon layout.
Desktop data modeling updates in Relationships View:

1. zooming slider
2. fit zoom to
3. reset layout
4. ability to zoom in using Ctrl-Mouse selection rectangle
Desktop data connectivity enhancements

1. SSAS Multidimensional support - Hierarchies support (Preview Feature)
2. Stripe Connector
3. Smartsheet Connector
4. “Enter Data”: Paste or enter data to create a table
5. DirectQuery Improvements: Support for all data types of T-SQL and SAP HANA, resulting in

Performance improvements.
6. ODBC Connector: Support for selecting User/System DSNs
7. CSV Connector: Ability to specify Column Delimiter in the Source dialog

For all the details, including a video demonstrating many of these updates, visit the Power BI Blog.

December 10, 2015

Pin report pages to dashboard
Refresh dashboard tiles
Use images in slicers
Change interactions between report visuals

For all the details, visit the Power BI Blog.

December 8, 2015

QR codes in Power BI

December 3, 2015

Automatically discover trends and uncover patterns in a dataset with Quick Insights: video or article
Visualize your VMob data in Power BI
Power BI integration with Cortana
Preview of Power BI gateway for enterprise
Introducting a new content pack: Search Analytics from Bing on Power BI dashboards
New Developer-focused enhancements: Two new APIs and easier app registration

November 24, 2015

Pin Excel ranges to dashboards
Chromeless full screen mode for dashboards and reports
Know where your data is stored
Improved loading of on-premises reports
Share dashboards directly to another user's workspace
Improved Google Analytics connector experience
Close your power bi account

For all the details, visit the Power BI Blog

http://blogs.msdn.com/b/powerbi/archive/2015/12/16/more-power-bi-feature-updates-power-bi-desktop-december-update-and-new-power-bi-service-features.aspx
http://blogs.msdn.com/b/powerbi/archive/2015/12/10/power-bi-weekly-service-update-1210.aspx
http://blogs.msdn.com/b/powerbi/archive/2015/12/08/bridge-the-gap-between-your-physical-world-and-your-bi-using-qr-codes.aspx
http://blogs.msdn.com/b/powerbi/archive/2015/12/02/power-bi-updates-from-browser-to-desktop-and-new-automated-insights-mf.aspx
http://blogs.msdn.com/b/powerbi/archive/2015/11/25/visualize-your-vmob-data-in-power-bi.aspx
http://blogs.msdn.com/b/powerbi/archive/2015/12/01/announcing-power-bi-integration-with-cortana-and-new-ways-to-quickly-find-insights-in-your-data.aspx
http://blogs.msdn.com/b/powerbi/archive/2015/12/02/announcing-preview-of-power-bi-gateway-for-enterprise-deployments.aspx
http://blogs.msdn.com/b/powerbi/archive/2015/12/02/search-analytics-from-bing-on-your-power-bi-dashboards.aspx
http://blogs.msdn.com/b/powerbi/archive/2015/12/02/power-bi-for-developers-reports-api-and-a-simple-app-registration-experience.aspx
http://blogs.msdn.com/b/powerbi/archive/2015/11/24/power-bi-weekly-service-update-1124.aspx


November 18, 2015

Create a duplicate dashboard
Freely position dashboard tiles
Improved navigation for full screen view
Better experience when inviting peers from your organization to Power BI groups
Improved error messages for tiles

For all the details, visit the Power BI Blog

November 11, 2015

New site for Power BI documentation, localized
Improved load time for reports
Update organizational content packs with report-only changes
Power BI health status in Office 365 Admin Portal
KPIs and images in tables, matrices, and cards

For all the details, visit the Power BI Blog

November 3, 2015

Guided Power BI purchase experience.
Individuals can buy Power BI Pro.
Duplicate report page.

For all the details, visit the Power BI Blog

October 28, 2015

Share dashboards with Active Directory Security groups
People picker
Sharing with a large number of email addresses
Collapse navigation pane through an URL parameterized

For all the details, visit the Power BI Blog

October 20, 2015

Read-only members in Power BI groups
Featured questions in Q&A
Full screen pop-out mode for report visualizations

For all the details, visit the Power BI blog

October 13, 2015

Full screen mode to display your dashboards and reports on big screen TVs
'Fit to screen’ support in full screen mode to display your entire dashboard in the available space
In-focus mode to get more details on dashboard tiles
Ability to view last update time for each tile
Ability to view the source for each tile
Planview Enterprise is an end-to-end portfolio and resource management solution that connects strategy to
execution, improving decision-making across the enterprise. The Planview Enterprise content pack for Power
BI allows you to visualize your resource and work management data in an entirely new way. Simply sign in
with your credentials and begin to interactively explore your portfolio investment spend, budget status, and

http://blogs.msdn.com/b/powerbi/archive/2015/11/17/power-bi-weekly-service-update-1117.aspx
http://blogs.msdn.com/b/powerbi/archive/2015/11/11/power-bi-weekly-service-update-1110.aspx
http://blogs.msdn.com/b/powerbi/archive/2015/11/03/power-bi-weekly-service-update-1103.aspx
http://blogs.msdn.com/b/powerbi/archive/2015/10/28/power-bi-weekly-service-update-1027.aspx
http://blogs.msdn.com/b/powerbi/archive/2015/10/20/power-bi-weekly-service-update-1020.aspx


how well your projects align with strategic priorities.

View our blog and online documentation to learn more.

October 6, 2015

With Power BI Q&A, you can explore your data using simple, intuitive questions and receive answers in the
form of interactive charts and graphs. With this release, we have added a feature to help you get started with
Power BI Q&A, even when you do not know anything about the data. To get started with this, navigate to any
dashboard and click the “How to ask” link near the Q&A question box. Power BI presents you with a number
of suggestions based on your data.
Two weeks ago, we introduced support for inserting shapes into the report canvas in Power BI Desktop. This
week, we are happy to announce that you can now add shapes to your report canvas when you are
authoring and/or editing reports in the Power BI web app.
We have added the option to turn off email notification when you share a dashboard. Simply uncheck the
“Send email notification to recipients” check box in the Power BI share dialog. You will be presented with a
URL – copy and share this URL to your colleagues to give them access to the dashboard.
Microsoft Dynamics NAV is a business management solution for small to medium organizations. It offers
customers a full solution for their business with greater control over their financials and business processes.
The Power BI content pack provides out-of-box reports for Dynamics NAV users, such as sales and profit,
opportunities pipeline, profitability and more. These metrics are organized on a dashboard that can be fully
customized, allowing you to easily connect and immediately start exploring your data.

Check out the blog and online documentation for more information.

September 29, 2015

With this week’s service update, when creating new reports you can now choose from multiple page sizes as
well as define your own page size. This controls the size and aspect ratio of each page in the report.
We added additional visual formatting support for images and bubble charts. You can lock the aspect while
resizing images to avoid image distortion and scatter chart bubbles can be configured to be filled or not.
Today, Power BI will send sharing invites to an alternate email address. When a dashboard is shared with
you, we will send the sharing invite link both to your original email address and to your alternate email
address (if you have it configured).
Power BI is available to all customers including those on the Dedicated on Multitenant (DonMT) O365
architecture. You will be using Power BI as a shared service in multi-tenant mode. In most cases, you can
register for Power BI by following the simple self-service-signup process – just enter your work email
address, enter your name and password to get started. If you are the tenant administrator, you can assign
licenses to your users using the instructions here.
Azure Audit Logs allows you to view control-plane operational logs in your Azure subscription. The Power BI
Azure Audit Logs content pack can help you easily analyze and visualize the wealth of information contained
in these logs. The content pack allows you to connect to your data and begin to discover insights with the
out-of-the box dashboard and reports. Read our blog and online documentationfor more information.

Learn more in our blog.

September 22, 2015

Have more flexibility on your dashboard to customize your dashboards with additional tile sizes, ranging
from 1x1 to 5x5.
You can now share (and un-share) a dashboard from your group space exactly the way you would do it in
your own space. Once colleagues accept your sharing invitation, the shared dashboard (and their associated
reports) will be added in their own space with read-only permission.
We added 5 additional industry related samples to Power BI: Customer Profitability, Human Resources,
Opportunity Analysis, Procurement Analysis, and Sales and Marketing Sample.

http://blogs.msdn.com/b/powerbi/archive/2015/10/13/power-bi-weekly-service-update-1013.aspx
http://blogs.msdn.com/b/powerbi/archive/2015/10/06/power-bi-service-weekly-update-10-06.aspx
https://powerbi.microsoft.com/
http://go.microsoft.com/fwlink/?LinkId=627174
http://blogs.msdn.com/b/powerbi/archive/2015/09/30/monitor-azure-audit-logs-with-power-bi.aspx
http://blogs.msdn.com/b/powerbi/archive/2015/09/30/power-bi-weekly-service-update-0929.aspx


Stripe is an advanced payment platform for online businesses. From start-ups to Fortune 500 companies,
thousands of businesses use Stripe to accept payments in over 130 currencies, from anyone in the world. By
connecting Power BI with your existing Stripe account, you’ll be able to use the Power BI Stripe content pack
to monitor, explore, and visualize your Stripe activity.

Learn more in our blog.

September 15, 2015

You can now choose which dashboard you want to pin your visual to! You can choose the target dashboard
from your existing dashboards, or even create a new dashboard and pin the visual to it in one shot.
Additionally, you can control your visual colors in the dashboard. If your report is using a different theme
from the dashboard theme, you can control whether the visual retains current theme, or uses the default
dashboard theme to achieve consistency across visuals from various sources.
You can now simply pin the tile from one dashboard to another, the same way you would pin a report visual
to a dashboard.
If your 60-day Power BI Pro trial period is close to expiration, you can contact us to request an extension to
your trial. If approved, your trial will be extended for another 60 days.
comScore Digital Analytix is an online solution that provides insights into your user base through the best of
analytics and audience demographics. With the Power BI comScore content pack, you can quickly connect
and begin gaining insights into your web analytics data. This content pack includes an out-of-the box
dashboard, a set of reports, and a curated data set to help you explore and drill into your data. Learn more
about the content pack in our blog and help topic.

September 8, 2015

Friendly Hyperlinks now allow you to provide links for your users without needing to display the entire URL
in the textbox.
Drill Support has been added to Power BI Reports. You can create a Drill path that enables users to navigate
from one level of data to related data.
Two new Industry Related Samples, It Spend Analysis and Supplier Quality Analysis, have been added under
the samples section of the Get Data experience. These samples are great examples of how you can use your
data to create insightful reports and dashboards.
We have a new content pack for tyGraph, which allows you to easily gain deeper insights into your Yammer
data. The content pack includes a dashboard, a set of reports and a curated dataset to explore and provide
insights such as the Measure of Active Engagement (The MAE Score) and content consumption metrics such
as File Views and File Downloads. Learn more on our blog and help topic.

September 1, 2015

Webtrends helps companies make sense of their customer data to drive digital marketing success. Users
have the ability to observe, analyze and deliver insights on the visitor journey across web, social, mobile and
SharePoint channels. With the release of the Webtrends content pack, users will now have the ability to use
Power BI to monitor, analyze, and visualize their Webtrends analytics data. The Webtrends content pack for
Power BI help page has more information.
Getting started with Q&A is even simpler. The moment you put your cursor inside the Q&A text box, we
instantly display a list of questions and key metrics that are relevant to your data. In the drop down, by
default, you will see the questions for tiles already pinned to the dashboard as well as an entry for each table
you have in your dataset.
The dynamic canvas size we display by default renders all our report items with optimal dimensions for the
browser window size. If you want to lock in the aspect ratio, or want to fit your report in a different way, we
now support another three options for you:Fit to Page, Fit to Width, and Actual Size.
We also Increased the limit on the number of datasets and reports you can have. You can now have up to
200 datasets and 200 reports for each dataset in your Power BI account.

http://blogs.msdn.com/b/powerbi/archive/2015/09/22/power-bi-weekly-service-update-0922.aspx
http://go.microsoft.com/fwlink/?LinkID=624573&clcid=0x409now
http://blogs.msdn.com/b/powerbi/archive/2015/09/16/visualize-and-explore-your-comscore-data-with-power-bi.aspx
http://blogs.msdn.com/b/powerbi/archive/2015/09/09/analyze-and-monitor-your-tygraph-data-with-power-bi.aspx
http://blogs.msdn.com/b/powerbi/archive/2015/09/01/visualize-and-explore-your-webtrends-data-in-power-bi.aspx


August 25, 2015

Now you can use Power BI to monitor, explore and visualize your Adobe Analytics data. With an out-of-box
content pack, you can connect and discover insights from your data immediately. To learn more, visit the
Adobe Analytics content pack for Power BI help page.

August 18, 2015

Azure Mobile Engagement is an app analytics service that allows developers to track their application’s
performance helping them increase retention and app usage. Using the Power BI Azure Mobile Engagement
content pack you can quickly connect to an out-of-box dashboard, a set of reports and a curated data set, and
instantly get insights into how well your app is doing. Please see the Azure Mobile Engagement content pack
for Power BI help page for more information.

August 11, 2015

Mandrill is an email infrastructure service developed by MailChimp that lets you analyze your email
campaigns from a wide variety of information. With the Power BI Mandrill content pack, you can quickly
connect to your Mandrill data and immediately gain insights into your newsletter or marketing campaign.
For additional details on how to get started, please see the Mandrill content pack for Power BI help page.

August 4, 2015

Power BI now offers Circuit ID users the ability to track and monitor all their Circuit ID cloud communications
services, empowering them to make the right business decisions. For additional details on how to get started,
please see the Circuit ID content pack for Power BI help page.
Today we’ve released an enhancement to the Share Dashboard feature to make it even easier to use. If your
organization uses Office 365 for email, you can now share to an email distribution group just the same way
you would send an email in Outlook. Just enter the address of the distribution group and click Share. All
members of the distribution group will receive an email invitation to view the dashboard.

July 28, 2015

We’re excited to announce that this week’s update to Power BI now offers database performance tracking
with the SQL Sentry content pack. This content pack includes a dashboard and reports that help you monitor
the SQL Server deployments you track using the SQL Sentry Cloud. For additional details on how to get
started, please see the SQL Sentry content pack for Power BI help page.

July 24, 2015

We're excited to announce our "general availability" (GA) release of Power BI. You can continue to use the
free version of Power BI, or sign up for Power BI Pro. As part of the GA release, we are offering some great
new features:
A new visualization and report creation experience: The new reporting canvas has a larger selection of
visualizations, more control over formatting of titles, legends, axes, colors, backgrounds, and more.
Power BI groups: groups offer a powerful collaborative experience built on Office 365 groups.
Organizational content packs: Power BI makes creating dashboards and reports extremely simple, and now
users can publish this content to the organizational content gallery.
Bring in whole Excel files: You can bring any Excel workbook stored on OneDrive for Business into Power BI
and view the entire workbook, exactly as you would in Excel Online.
Bring in CSV files: Just like Excel or Power BI Desktop file, a comma-separated values text (CSV) file can also
be a dataset for your Power BI dashboards and reports.
Replace Excel, Power BI Desktop, and CSV files: you can upload an updated version of a file to Power BI and it
will replace the existing dataset. All the reports and dashboards that are connected to this dataset now
automatically use the new version.

http://blogs.msdn.com/b/powerbi/archive/2015/08/25/exploring-your-adobe-analytics-data-in-power-bi.aspx
http://blogs.msdn.com/b/powerbi/archive/2015/08/17/monitor-and-analyze-your-azure-mobile-engagement-data-in-power-bi.aspx
http://blogs.msdn.com/b/powerbi/archive/2015/08/12/explore-and-analyze-your-mandrill-data-in-power-bi.aspx
http://blogs.msdn.com/b/powerbi/archive/2015/08/04/circuit-id-data-with-power-bi.aspx
http://blogs.msdn.com/b/powerbi/archive/2015/08/04/easier-dashboard-sharing-with-distribution-groups.aspx
http://blogs.msdn.com/b/powerbi/archive/2015/07/28/monitoring-your-sql-sentry-data-with-power-bi.aspx


We’re excited to announce that this week’s update to Power BI now offers work item tracking in the Visual
Studio Online content pack. This update includes a new dashboard, report and an updated data set offering
insights on your work items in addition to important metrics about your Git repository, pull requests, and
version control content included in the initial version. For additional details on how to get started, please see
the Visual Studio Online content pack for Power BI help page.

July 14, 2015

Acumatica Cloud ERP delivers a suite of fully integrated business management applications such as
Financials, Distribution, CRM and Project Accounting, powered by a robust and flexible platform. With the
Power BI Acumatica content pack, you can quickly connect and immediately gain insights into your
opportunity data. This content includes an out-of-box dashboard, a set of reports and a curated dataset to
explore and provide details such as your total won opportunities by date. Read more here.
Azure HDInsight now offers a fully managed Spark service. This capability allows for scenarios such as
iterative machine learning and interactive data analysis. Power BI allows you to directly connect to the data in
Spark on HDInsight offering simple and live exploration. Read our help doc for more information.
Office 365 navigation and application launcher integration. With a single click, you can now navigate to all of
your Office 365 applications.
Specifying a custom URL that users navigate to when they click a tile. You now have the ability to control
exactly where users go: a specific report, another dashboard, an SSRS report, or an external website.
Visibility and management of the storage you are consuming in Power BI
Configuring the visual and fields displayed in Q&A

July 7, 2015

One of the most awaited and requested feature is now available in Power BI. Starting today, in Power BI you
can refresh datasets connecting to your on-premises sources such as SQL Server. You can refresh a dataset
that has been created from a Power BI Designer file or an Excel workbook with data imported into the
workbook using Power Query or Power Pivot.

June 30, 2015

We released a new Power BI UserVoice content pack that can help you monitor and visualize your UserVoice
data and immediately gain insights into it with the ready-to-use dashboard and report.

June 23, 2015

Power BI Desktop files can be refreshed (scheduled refresh & refresh now) when uploaded to the Power BI
service.
We are releasing the biggest visual change to Power BI since December: a cleaner and simpler experience to
Get Data. When you click on Get Data, you are now presented a single screen with a set of categories to
choose from. This will make it even easier to find the content that matters to you.
Azure SQL Data Warehouse offers elastic scale and massive parallel processing. With the limited public
preview announced today, Power BI allows you to directly connect to the data stored in your Azure SQL Data
Warehouse offering simple and dynamic exploration. After creating a connection to your data warehouse,
queries are generated in real time and sent back to the source as you explore the data. This removes the
need to create and upload a custom data model and offers interactive exploration of your data.

June 16, 2015

SweetIQ lets you to easily track your local listings by providing location and review data from your local
search ecosystem. Power BI allows you to analyze and monitor that data, by offering out of box content built
from your SweetIQ data. For additional details on how to get started, please see the SweetIQ content pack for
Power BI help page.

http://blogs.msdn.com/b/powerbi/archive/2015/07/22/monitoring-your-visual-studio-online-work-items-with-power-bi.aspx
http://blogs.msdn.com/b/powerbi/archive/2015/07/13/analyze-and-explore-your-acumatica-cloud-erp-data-with-power-bi.aspx
http://blogs.msdn.com/b/powerbi/archive/2015/07/14/visualize-big-data-with-power-bi-and-spark-for-azure-hdinsight.aspx
http://blogs.msdn.com/b/powerbi/archive/2015/07/15/new-capabilities-added-to-power-bi.aspx#launcher
http://blogs.msdn.com/b/powerbi/archive/2015/07/15/new-capabilities-added-to-power-bi.aspx#url
http://blogs.msdn.com/b/powerbi/archive/2015/07/15/new-capabilities-added-to-power-bi.aspx#storage
http://blogs.msdn.com/b/powerbi/archive/2015/07/15/new-capabilities-added-to-power-bi.aspx#visual
http://blogs.msdn.com/b/powerbi/archive/2015/07/07/refresh-for-on-premises-sources-is-here.aspx
http://blogs.msdn.com/b/powerbi/archive/2015/07/01/monitor-and-visualize-your-uservoice-data-with-power-bi.aspx
http://blogs.msdn.com/b/powerbi/archive/2015/06/22/announcing-refresh-support-for-power-bi-designer-files-in-the-power-bi-service.aspx
http://blogs.msdn.com/b/powerbi/archive/2015/06/23/the-new-get-data-experience.aspx
http://blogs.msdn.com/b/powerbi/archive/2015/06/24/exploring-azure-sql-data-warehouse-with-power-bi.aspx
http://blogs.msdn.com/b/powerbi/archive/2015/06/16/analyze-and-monitor-your-sweetiq-data-with-power-bi.aspx


June 9, 2015

Power BI allows you to monitor and explore that data using the MailChimp APIs, offering a set of out-of-box
content for your analytics. The dashboard, reports and dataset curated for the MailChimp scenario allow you
to easily access data such as Top Campaigns of Total Opens by Day of Week. For additional details on how to
get started, please see the MailChimp content pack for Power BI documentation.

June 2, 2015

Now tracking important statistics about your apps is easy with Power BI and the appFigures content pack.
For additional details on how to connect and get started, see the documentation for appFigures content pack
for Power BI.

May 28, 2015

Get quick insights into your QuickBooks Online account data using our content pack. For additional details
on how to connect and get started, see the QuickBooks Online content pack for Power BI documentation.

May 13, 2015

With the latest update to Power BI, you can connect to the data logged by SQL Database Auditing with a
set of out of box reports and a customized dashboard. This content pack makes it easy to find suspicious
events, unusual activity, and trends, based on a dataset that has been created for your reporting. Learn more
in the blog post and documentation.
You can connect directly to data stored in your Azure SQL Database. We dynamically generate and send
down queries to the source, allowing you to create interactive reports directly over your database. You can
read the blog post and documentation for more information.

May 7, 2015

We updated our look to a new modern design, a look that is fresh and distinctive while keeping your focus
on what matters: your data and your insights.

April 28, 2015

Power BI is now available in 44 languages. Read our blog post to see the full list.

April 23, 2015

You can now visualize and explore your Microsoft Dynamics Marketing data with our new content pack!
You can read our blog post and documentation for more information.

April 15, 2015

You can now visualize and explore your Google Analytics data with our new content pack! With the Google
Analytics content pack you will get a dashboard, report and dataset that allow you to gain insights into the
usage of your site in the last 6 months. You can read our blog post and documentation for more information.
You can now pin all cards expect those containing KPIs and Images from Q&A and reports
You can now use cards in Q&A by using the phrase 'as card' at the end of your query

March 31, 2015

**GitHub **dashboards have new visuals that focus on community building, improved calculations, and
improved layout
**SendGrid **dashboards have new visuals and a new layout to help you find better insights
You can now use** treemaps in Q&A** by using the phrase 'as treemap' at the end of your query
You can now pin treemaps from Q&A and reports
Lots of bug fixes!

http://blogs.msdn.com/b/powerbi/archive/2015/06/09/user-power-bi-to-monitor-and-visualize-your-mailchimp-data.aspx
http://blogs.msdn.com/b/powerbi/archive/2015/06/02/explore-and-analyze-your-appfigures-data-with-power-bi.aspx
http://blogs.msdn.com/b/powerbi/archive/2015/05/28/get-quick-insights-into-your-quickbooks-online-account-data.aspx
http://blogs.msdn.com/b/powerbi/archive/2015/05/14/monitor-your-azure-sql-database-auditing-activity-with-power-bi.aspx
http://blogs.msdn.com/b/powerbi/archive/2015/05/13/using-power-bi-to-visualize-and-explore-azure-sql-databases.aspx
http://blogs.msdn.com/b/powerbi/archive/2015/04/28/power-bi-preview-now-available-in-your-language.aspx
http://blogs.msdn.com/b/powerbi/archive/2015/04/23/monitor-and-explore-your-microsoft-dynamics-marketing-data-with-power-bi.aspx
http://blogs.msdn.com/b/powerbi/archive/2015/04/15/visualize-and-explore-your-google-analytics-data-with-power-bi.aspx


2014

Next steps

February 25, 2015

Bug fixes and improvements to user experience and reliability.

January 26, 2015

Service usability and reliability has been improved through various bug fixes.

December 11, 2014

Reliability of refresh with OneDrive has been improved. Some situations where workbooks were not
refreshing from OneDrive have been resolved.

Get started with Power BI

More questions? Try asking the Power BI Community

http://community.powerbi.com/


Microsoft Flow and Power BI
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Create a flow that is triggered by a Power BI data alert
PrerequisitesPrerequisites

Create a flow that uses Power BI - from a template

Microsoft Flow is a SaaS offering for automating workflows across the growing number of applications and SaaS
services that business users rely on. With Flow you can automate tasks by integrating your favorite apps and
services (including Power BI) to get notifications, synchronize files, collect data, and more. Repetitive tasks become
easy with workflow automation.

Get started using Flow now.

Watch Sirui create a Flow that sends a detailed email to colleagues when a Power BI alert is triggered. Then follow
the step-by-step instructions below the video to try it out yourself.

This tutorial will show you how to create two different flows; one from a template and one from scratch. To follow
along, create a data alert in Power BI, create a free Slack account, and sign up for Microsoft Flow (it's free!).

In this task we'll use a template to create a simple flow that is triggered by a Power BI data alert (notification).

1. Sign in to Microsoft Flow (flow.microsoft.com).
2. Select My flows.

3. Select Create from template.

4. Use the Search box to find Power BI templates and select Send an e-mail to any audience when a Power
BI data alert is triggered > Continue.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-flow-integration.md
https://flow.microsoft.com/en-us/documentation/getting-started
https://flow.microsoft.com/documentation/getting-started
https://flow.microsoft.com/en-us/#home-signup


Build the flowBuild the flow
This template has one trigger (Power BI data alert for new Olympic medals for Ireland) and one action (send an
email). As you select a field, Flow displays dynamic content that you can include. In this example we'll included the
tile value and the tile URL in the message body.

1. From the trigger dropdown, select a Power BI data alert. Select New medal for Ireland. To learn how to
create an alert, see Data alerts in Power BI.

2. Enter one or more valid email addresses and then select Edit (shown below) or Add dynamic content.



3. Flow creates a title and message for you which you can keep or modify. All the values you set when you
created the alert in Power BI are available for your use -- just place your cursor and select from the grey
highlighted area.

4. For example, if you created an alert title in Power BI of We won another medal, you can select Alert title
to add that text to your email Subject field.

And, you can accept the default Email body or create your own. The example above contains a few
modifications to the message.

5. When you're done, select Create flow or Save flow. The flow is created and evaluated. Flow lets you know
if it finds errors.

6. If errors are found, select Edit flow to fix them, otherwise, select Done to run the new flow.



Create a Flow that uses Power BI - from scratch (blank)

Build your flowBuild your flow

7. When the data alert is triggered, an email will be sent to the addresses you indicated.

In this task we'll create a simple flow from scratch that is triggered by a Power BI data alert (notification).

1. Sign in to Microsoft Flow.

3. Use the Search box to find a Power BI trigger and select Power BI - when a data driven alert is triggered.

2. Select My flows > Create from blank.

1. From the dropdown, select the name of your alert. To learn how to create an alert, see Data alerts in Power
BI.

2. Select New step > Add an action.

3. Search for Outlook and select Create event.



Next steps

4. Fill in the event fields. As you select a field, Flow displays dynamic content that you can include.

5. Selet Create flow when done. Flow saves and evaluates the flow. If there are no errors, select Done to run
this flow. The new flow is added to your My flows page.

6. When the flow is triggered by your Power BI data alert, you'll receive an Outlook event notification similar to
this one.

Get started with Microsoft Flow
Set data alerts in Power BI service

https://flow.microsoft.com/en-us/documentation/getting-started/


Set data alerts on your iphone
Set data alerts in the Power BI mobile app for Windows 10
More questions? Try the Power BI Community

http://community.powerbi.com/


Power BI for US Government customers
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Features of Power BI US Government

Connectivity between Government and Public Azure Cloud services

The Power BI service has a version available for United States Government customers as part of the Office 365
US Government Community subscriptions. The Power BI service version discussed in this article is specifically
designed for US Government customers, and is separate and different from the commercial version of the Power
BI service.

The following sections describe the features available to the US Government version of the Power BI service,
clarifies some of the limitations, lists Frequently Asked Questions (FAQ) and answers (including how to sign up),
and provides links for more information.

It's important to note that Power BI US Government is only available as a Pro license, and is not available as a
Free license. Certain features of the Power BI service are available in the Power BI US Government version of the
service.

The following features are available to Power BI US Government customers, as they apply to Pro license
functionality:

Create and view dashboards and reports
Data capacity limits
Scheduled data refresh
Refreshable team dashboards
Active Directory groups for sharing and managing access control
Import data and reports from Excel, CSV, and Power BI Desktop files
Data Management Gateway
All data is encrypted in both Azure SQL and Blob Storage for Power BI
Connect to services with content packs

Azure is distributed among multiple clouds. Be default, tenants are allowed to open firewall rules to a cloud-specific
instance, but cross-cloud networking is different and requires opening specific firewall rules to communicate
between services. If you are a Power BI customer and you have existing SQL instances in the public cloud which
you need to access, you must open specific firewall rules in SQL to the Azure Government Cloud IP space, for the
following datacenters:

USGov Iowa
USGov Virginia

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-govus-overview.md


Limitations of Power BI US Government

Frequently Asked Questions (FAQ) for the US Government version of
the Power BI service

USGov Texas
USGov Arizona

In the public cloud the IP spaces are available, but for the government cloud, you must open an Azure Support
ticket to request the IP ranges for the above listed datacenters.

Some of the features that are available in the commercial version of the Power BI service are not available in the
Power BI service for US Government customers. The Power BI team is actively working on making these features
available to US Government customers, and will update this article when these features become available.

Power BI US Government is only available as a Pro license. Any references to Power BI (Free) licenses in an
admin portal (or as users) are running in a commercial Power BI service cloud.
Auditing - auditing is not available through the Office 365 Security and Compliance portal.
Power BI content in Cortana - Power BI results will not show up in Cortana search results, which includes
results for your Power BI content (dashboards, reports, apps) as well as results that show Cortana-optimized
report pages for specific keywords.

If you have Power BI Free licenses assigned to your account, those accounts are running in a commercial version
of the Power BI service, and are not part of the Power BI US Government offering. For those Free accounts, you
may encounter the following issues:

Gateway, Mobile, and Desktop can’t authenticate
You cannot access Azure commercial data sources
PBIX files must be manually uploaded from commercial
Power BI mobile apps are not available

To resolve issues, please contact your account representative.

The following questions (and answers) are provided to help you quickly get information you need about the
service.

Question: How do I migrate my commercial Power BI data to the Power BI service for US Government?

Answer: Your admin must create a new instance of Power BI under a separate, US Government-specific
subscription. You can then replicate your commercial data in the Power BI service for US Government, remove
your commercial license, and associate your existing domain to the new US Government-specific service.

Question: Why can't I connect to a specific content pack?

Answer: You need to ensure your subscription is enabled before connecting to that content pack.

Question: I'm interested in getting Power BI for my US Government organization. How do I get started?

Answer: Signing up (often called onboarding) might differ based on your existing license and subscription. See the
Sign Up for Power BI US Government article for more information.

Question: Is the URL for connecting to Power BI for US Government different than the commercial Power BI
URL?

Answer: Yes, the URLs are different. The following table shows each URL:



COMMERCIAL VERSION URL US GOVERNMENT VERSION URL

https://app.powerbi.com/ https://app.powerbigov.us

Next steps
There are all sorts of things you can do with Power BI. For more information and learning, including an article that
shows you how to sign up for the service, check out the following resources:

Sign up for Power BI for US Government
Power BI US Government Demo
Guided Learning for Power BI
Get started with the Power BI service
Getting started with Power BI Desktop

https://app.powerbi.com/
https://app.powerbigov.us
https://channel9.msdn.com/Blogs/Azure/Cognitive-Services-HDInsight-and-Power-BI-on-Azure-Government
file:///W:/soyp-o-7bf22bb1/powerbi-docs/.tmp/guided-learning/gettingstarted.yml#step-1


Enroll your US Government organization in the
Power BI service
1/25/2018 • 5 min to read • Edit Online

NOTENOTE

Select the right sign-up process for your US Government organization

The Power BI service has a version available for United States Government customers as part of the Office 365
US Government Community subscriptions. The Power BI service version discussed in this article is specifically
designed for US Government customers, and is separate and different from the commercial version of the Power
BI service.

For more information about the Power BI service for US Government, including its features and limitations, check
out Power BI for United States Government customers - Overview.

This article is intended for administrators who have authority to sign up their US Government organization for Power BI. If
you are an end-user, contact your administrator about getting a subscription to Power BI for US Government.

Your US Government organization might be new to the Office Government Cloud, or might already have a
subscription. The following sections detail the sign-up steps based on where you are with the Office Government
Cloud and Power BI, and are different based on your existing subscription.

Once you have signed up for Power BI US Government some features may not work until your sales or support

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-govus-signup.md


US Government organizations that are new Office Cloud customersUS Government organizations that are new Office Cloud customers

NOTENOTE

Existing Office Government Cloud customersExisting Office Government Cloud customers

NOTENOTE

Additional Signup Information

Direct Power BI Trial to Pro Customer OnboardingDirect Power BI Trial to Pro Customer Onboarding

representative completes your onboarding process. To find out about these features see the Power BI for United
States Government customers - Overview. To complete the onboarding process to enable these features, contact
your sales or support representative.

If your organization is a new Office Government Cloud customer, follow these steps:

These steps should be performed by the portal administrator.

1. Go to https://products.office.com/en-us/government/office-365-web-services-for-government. >[!NOTE] >If
you don't want to sign up for Office Government Cloud at this time, please reach out to your sales
representative.

2. Select Office G3 and complete the form for an Office trial
3. Once you are an Office Cloud customer continue on with the steps below for "Existing Office Government

Cloud customers"

If your organization is an existing Office Government Cloud customer, but you don't have a Power BI
subscription (Free or otherwise), follow these steps:

These steps should be performed by the portal administrator.

1. Log in to your existing Office Government Cloud account and go to the admin portal
2. Select Billing.
3. Select Purchase Service.
4. Select the Power BI Pro Government Option and choose between Try and Buy Now
5. Complete your order

7. Log in to the Power BI service for US Government customers at https://app.powerbigov.us

6. Assign users to the account.

The below is additional information for signing up for Power BI US Government in various licensing migration
cases.

Click and follow through the Billing > Purchase Service > Power BI Pro Gov and select purchase and not Trial
Fill in the necessary and get the licenses
Remove the Power BI Pro Trial or remove the old licenses and Assign the new ones to the users
Log in to https://app.powerbigov.us

https://products.office.com/en-us/government/office-365-web-services-for-government
https://app.powerbigov.us
https://app.powerbigov.us


Reseller Power BI Trial to Pro Customer OnboardingReseller Power BI Trial to Pro Customer Onboarding

Whitelisting InstructionsWhitelisting Instructions

Mixed Free and Pro licenses in US Government tenantsMixed Free and Pro licenses in US Government tenants

Go to Billing > Subscriptions and select Power BI Pro for Government subscription. There you will see:

Available
Assigned
Assign to users links
If you still have the Trial assigned:

Click on Assigned under the Trial subscription and remove the users you want to add to paid
Go to the Paid subscription and assign those users

Whitelisting is a process that the Power BI engineering team uses to move customers from the commercial cloud
environment into the secure, Government cloud environment. This ensures that features available in the US
Government cloud work as expected. All existing (or new) US Government customers that purchase US
Government Power BI services for the first time must initiate the following whitelisting process. The process must
be done prior to setup or migration to US Government Power BI services.

To have your tenant whitelisted for the US Government cloud, fill out a support ticket that makes the request, from
the following link. Note that only administrators can make this request:

Whitelisting online support request
Make sure you include the domain to be whitelisted, and the email for the Microsoft representative who is
working with you on the process.

The process for whitelisting takes approximately three weeks, during which the Power BI engineering team makes
appropriate changes to ensure your tenant operates properly in the US Government cloud.

Customers migrating from Power BI Free licenses to Power BI US Government (and by definition, migrating to
the associated Pro license features described earlier in this article) will encounter the issues described in the
following section of this article, until their tenant is whitelisted by the Power BI engineering team.

If you have both Free and US Government Pro licenses in your tenant, both Free and (US Government) Pro licenses
remain present, but one or the other license types will not work properly. If your tenant successfully goes through
the whitelisting process, then the following occurs:

Any Free license users will no longer be able to log in to Power BI using Power BI Desktop, and will experience
functionality gaps described in the following section.
All clients assigned to US Government Pro licenses will work as expected, including use of gateways, Power BI
Desktop, and Mobile apps.

When using a mix of Free and Pro licenses in a US Government tenant, and going through the whitelisting process,
the following can be expected:

Before *whitelisting*:

Users with Free licenses are running in commercial cloud
Pro US Government licenses show up in the portal, and the administrator can assign those licenses to users.
Pro US Government users will not lose data from their Free licenses once the admin assigns a US
Government Pro license. The assigned users have access Power BI Pro features for US Government
customers, but the following bullet list functionality gaps will exist until the tenant is successfully whitelisted:

Gateway, Mobile, and Power BI Desktop can’t authenticate
You cannot access Azure commercial data sources
PBIX files must be manually uploaded from the commercial Power BI service

https://powerbi.microsoft.com/clouds/


Next steps

Power BI mobile apps are not available

After *whitelisting*:

Free users running in the commercial Power BI service can continue to run, but the they will stop authenticating
as expected.
Pro users running in the US Government cloud can use the Power BI for US Government customers service
as expected.

To identifying users in your tenant that are running the Free license of Power BI, administrators can run the
licensing report, after which Free license users show up as Power BI Standard.

There are all sorts of things you can do with Power BI. For more information and learning, including an article that
shows you how to sign up for the service, check out the following resources:

Overview of Power BI for US Government
Guided Learning for Power BI
Get started with the Power BI service
Getting started with Power BI Desktop

file:///W:/soyp-o-7bf22bb1/powerbi-docs/.tmp/guided-learning/gettingstarted.yml#step-1


Frequently Asked Questions for Power BI for
Germany Cloud customers
12/6/2017 • 3 min to read • Edit Online

The Power BI service has a version available for European Union/European Free Trade Agreement (EU/EFTA)
customers, often referred to as Microsoft Cloud Deutschland (MCD). The Power BI service version discussed in
this article is specific to EU/EFTA customers, and is separate and different from the commercial version of the
Power BI service, or Power BI services provided to government customers.

The following questions and answers provide important information for Power BI Pro Service in Microsoft Cloud
Deutschland (MCD), which is the Power BI service cloud specifically provided for EU/EFTA customers.

1. What is the Power BI service for Germany Cloud?

The Power BI service for EU/EFTA customers, also referred to as Microsoft Cloud Deutschland (MCD), is an
EU/EFTA compliant cloud with the Power BI service delivered from German datacenters. All customer data in
the Power BI service for EU/EFTA cloud is stored at rest in Germany with T-Systems working as the
independent German data trustee, and with physical and logical access to data controlled by German law.
The Power BI service for EU/EFTA cloud requires a distinct and separate account from the commercial
version of the Power BI service. Learn more about Microsoft Cloud Deutschland here.

2. Where can I find pricing and sign up information for the Power BI Germany Cloud?

You can find lots of information on the Power BI Germany Cloud home page, including pricing information.
On that page you can also find a link to sign up for Power BI Pro service 30-Day trial with 25 user licenses.
As part of trial sign up, you have an option to purchase or add additional licenses as needed. We also offer
Enterprise Agreement (EA), Government, and non-profit pricing. Please reach to your Microsoft customer
representative for more details.

3. I have a Germany Cloud tenant as part of Azure Germany and/or Office 365 Germany subscriptions.
Can I use the existing tenant to sign up for Power BI Germany?

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-govde-faq.md
https://www.microsoft.com/trustcenter/cloudservices/nationalcloud
https://powerbi.microsoft.com/power-bi-germany/


ENDPOINT NAME AND/OR USAGE
POWER BI SERVICE FOR GERMANY CLOUD
URL

EQUIVALENT URL IN PUBLIC CLOUD (FOR
CROSS-REFERENCE)

Home Page, Sign Up and Sign In https://powerbi.microsoft.com/power-
bi-germany/

https://powerbi.microsoft.com/

Power BI Service direct sign in https://app.powerbi.de/?
noSignUpCheck=1

https://app.powerbi.com/?
noSignUpCheck=1

Service API https://api.powerbi.de/ https://api.powerbi.com/

Office Portal for user license
management, service health status and
support requests by administrators

https://portal.office.de/ https://portal.office.com/

AAD Authority Uri https://login.microsoftonline.de/commo
n/oauth2/authorize/

https://login.microsoftonline.com/comm
on/oauth2/authorize/

Yes. As part of the sign up process, you'll have an option to login with an existing Germany Cloud tenant
administrator account, and add the Power BI Pro service licenses to your existing tenant in the Germany
Cloud. Please note that Germany Cloud tenants and user accounts are different from the Power BI service for
Germany cloud.

4. Is there a free service in the Power BI service for Germany cloud?

No. We don't offer free license versions in the Power BI service for Germany cloud. However, we encourage
you to sign up for Power BI free offering in our public cloud if your business needs are met with the Power
BI free offering.

5. Can I use Power BI Desktop, Power BI Mobile, on-premises data gateway and Publisher for Excel
with the Power BI service for Germany cloud?

Yes. We've updated our Power BI client products to seamlessly work with the Power BI service for Germany
cloud. Please login with your Power BI service for Germany cloud account to start using the same client
products with Power BI service for Germany cloud. You can download the latest version of client products
from the following locations:

Power BI Desktop
Power BI Mobile
On-premises data gateway
Power BI Publisher for Excel

6. Are there any feature limitations of the Power BI service for Germany cloud?

The following service features are currently not available in Power BI service for Germany cloud:

Publish to Web
ArcGIS maps by Esri
Power BI Embedded (separate metered ISV licensing, will be offered through Microsoft Azure Germany in
the future)

7. Where can I find the Power BI service for Germany cloud specific configuration information for
use and integration in my applications?

We updated our SaaS Embedding developer samples with Germany and other Power BI clouds specific
configuration information. Please look at the Cloud Configs folder in samples for cloud specific
configuration end points. The following table lists various configuration end points for the Power BI service
for Germany cloud (and Public Cloud for cross-reference).

https://powerbi.microsoft.com/get-started/
https://powerbi.microsoft.com/desktop/
https://powerbi.microsoft.com/mobile/
https://powerbi.microsoft.com/gateway/
https://powerbi.microsoft.com/excel-dashboard-publisher/
https://azure.microsoft.com/overview/clouds/germany/
https://github.com/Microsoft/PowerBI-Developer-Samples
https://powerbi.microsoft.com/power-bi-germany/
https://powerbi.microsoft.com/
https://app.powerbi.de/?noSignUpCheck=1
https://app.powerbi.com/?noSignUpCheck=1
https://api.powerbi.de/
https://api.powerbi.com/
https://portal.office.de/
https://portal.office.com/
https://login.microsoftonline.de/common/oauth2/authorize/
https://login.microsoftonline.com/common/oauth2/authorize/


Power BI Service Resource Uri https://analysis.cloudapi.de/powerbi/api https://analysis.windows.net/powerbi/ap
i

Custom Visuals Library https://app.powerbi.de/visuals/ https://app.powerbi.com/visuals/

Register an Application for Power BI
(For Embedded)

https://app.powerbi.de/apps https://app.powerbi.com/apps

Azure Portal (For Embedded) https://portal.microsoftazure.de/ https://portal.azure.com/

Community https://community.powerbi.com/ https://community.powerbi.com/

ENDPOINT NAME AND/OR USAGE
POWER BI SERVICE FOR GERMANY CLOUD
URL

EQUIVALENT URL IN PUBLIC CLOUD (FOR
CROSS-REFERENCE)

Next stepsNext steps
There are all sorts of things you can do with Power BI. For more information and learning, including an article that
shows you how to sign up for the service, check out the following resources:

Guided Learning for Power BI
Get started with the Power BI service
Getting started with Power BI Desktop

https://analysis.cloudapi.de/powerbi/api
https://analysis.windows.net/powerbi/api
https://app.powerbi.de/visuals/
https://app.powerbi.com/visuals/
https://app.powerbi.de/apps
https://app.powerbi.com/apps
https://portal.microsoftazure.de/
https://portal.azure.com/
https://community.powerbi.com/
https://community.powerbi.com/
file:///W:/soyp-o-7bf22bb1/powerbi-docs/.tmp/guided-learning/gettingstarted.yml#step-1


Get started with third party apps
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Power BI App permissions

Revoke third party app permissions

With Power BI, you can use an app built by a company or individual other than Microsoft. For example, you might
use a third party app which integrates Power BI tiles into a custom built web application. When you use a third
party app, you will be asked to grant that application certain permissions to your Power BI account and resources. It
is important that you only grant permissions to applications that you know and trust. Permissions to an application
can be revoked at any time. See Revoke third party app permissions.

Here are the types of access an application can request.

View all Dashboards

This permission gives an application the ability to view all dashboards you have access to. This includes
dashboards that you own, have gotten from content packs, and have been shared to you and are in
groups that you belong to. The application cannot make any modifications to the dashboard. Among
other things, this permission can be used by an application to embed your dashboard content into its
experiences.

View all Reports

This permission gives an application the ability to view all reports you have access to. This includes
reports that you own, have gotten from content packs, and are in groups that you belong to. Part of
viewing the report, means that the application can also see the data within it. The application cannot
make any modifications to the reports themselves. Among other things, this permission can be used by
an application to embed your report content into its experiences.

View all Datasets

This permission gives an application the ability to list all datasets that you have access to. This includes
datasets that you own, have gotten from content packs, and are in groups that you belong to. An
application can see the names of all your datasets as well as their structure including table and column
names. This permission gives rights to read the data in a dataset. The permission does not give the
application rights to add or make changes to a dataset.

Read and Write all Datasets

This permission gives an application the ability to list all datasets that you have access to. This includes
datasets that you own, have gotten from content packs, and are in groups that you belong to. An
application can see the names of all your datasets as well as their structure including table and column
names. This permission gives rights to read and write the data in a dataset. The application can also
create new datasets, or make modifications to existing ones. This is commonly used by an application to
send to data directly to Power BI.

View user's Groups

This permission gives the application the ability to list all groups that you are a member of. It can use this
permission along with some of the other permissions listed to view or update content for that particular
group. The application cannot make modifications to the group itself.

 

You revoke permissions for a third party app by going to the Office 365 My Apps site.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-power-bi-get-started-third-party-apps.md


On the Office 365 My apps site, here's how to revoke third party permissions:

1. Go to Office 365 My Apps site.
2. On the My apps page, locate the third party app.
3. Hover over the app tile, click the (...) button, and click Remove.

https://portal.office.com/myapps


Supported browsers for Power BI
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Next stepsNext steps

Power BI runs in these browsers:

Microsoft Edge
Internet Explorer 11
Chrome desktop latest version
Safari Mac latest version
Firefox desktop latest version

These browsers are supported on all platforms where they're available.

Get started with Power BI
Try asking the Power BI Community
Still have an issue? Please visit the Power BI support page

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-browser-support.md
http://community.powerbi.com/
https://powerbi.microsoft.com/support/


Supported languages and countries/regions for
Power BI
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Countries and regions where Power BI is available

Languages for the Power BI service

This article provides lists of supported languages and countries/regions for the Power BI service, Power BI Desktop,
and Power BI documentation.

For a list of countries and regions where Power BI is available, see the international availability list.

The Power BI service (in the browser) is available in the following 42 languages:

Arabic
Basque - Basque
Bulgarian - Български
Catalan - català
Chinese (Simplified) - 中文(简体)
Chinese (Traditional) - 中文(繁體)
Croatian - hrvatski
Czech - čeština
Danish - dansk
Dutch - Nederlands
English - English
Estonian - eesti
Finnish - suomi
French - français
Galician - galego
German - Deutsch
Greek - Ελληνικά
Hebrew
Hindi - िहंदी
Hungarian - magyar
Indonesian - Bahasa Indonesia
Italian - italiano
Japanese - 日本語
Kazakh - Қазақ
Korean - 한국어
Latvian - latviešu
Lithuanian - lietuvių
Malay - Bahasa Melayu
Norwegian (Bokmål) - norsk (bokmål)
Polish - Polski

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/supported-languages-countries-regions.md
https://products.office.com/business/international-availability


What's translatedWhat's translated

Choose your language in the Power BI serviceChoose your language in the Power BI service

Choose your language in the browserChoose your language in the browser

Internet Explorer (version 11)Internet Explorer (version 11)

Google Chrome (version 42)Google Chrome (version 42)

Portuguese (Brazil) - Português
Portuguese (Portugal) - português
Romanian - română
Russian - Русский
Serbian (Cyrillic) - српски
Serbian (Latin) - srpski
Slovak - slovenčina
Slovenian - slovenski
Spanish - español
Swedish - svenska
Thai - ไทย
Turkish - Türkçe
Ukrainian - українська
Vietnamese - Tiếng Việt

Menus, buttons, messages, and other elements of the experience are translated into your language, making it
easier to navigate and interact with Power BI.

At this time, a few features are available in English only:

Dashboards and reports that Power BI creates for you when you connect to services such as Microsoft
Dynamics CRM, Google Analytics, Salesforce, and so on. (You can still create your own dashboards and reports
in your own language.)
Exploring your data with Q&A.

Stay tuned as we work to bring additional features to other languages.

1. In the Power BI service, select the Settings icon  > Settings.
2. On the General tab > Language.
3. Select your language > Apply.

Power BI detects your language based on the language preferences on your computer. The way you access and
change these preferences may vary depending on your operating system and browser. Here's how to access these
preferences from Internet Explorer and Google Chrome.

2. Click Internet Options.
3. In the Internet Options dialog, on the General tab under Appearance, click the Languages button.

1. Click the Tools button in the top-right corner of your browser window:

1. Click the menu button in the top-right corner of your browser window:



  

Choose the language or locale of Power BI Desktop

Choose a language for Power BI Desktop installed from the Windows StoreChoose a language for Power BI Desktop installed from the Windows Store

2. Click Settings.
3. Click Show advanced settings.
4. Under Languages, click the Language and input settings button.
5. Click Add, select a language, and click OK.

The new language is at the end of the list.

6. Drag the new language to the top of the list, and click Display Google Chrome in this language.

You may need to close and reopen your browser to see the change.

You have two ways of getting Power BI Desktop: You can download it, or install it from the Windows Store.

When you install Power BI Desktop from the Windows Store, it installs all the languages and shows the
language that corresponds to the Windows default language.
When you download Power BI Desktop, you choose the language when you download it.
You can also choose a locale to be used when importing data for a specific report.

1. Install Power BI Desktop from the Windows Store.
2. To change the language, on your computer search for Windows Settings.
3. Select Time & language.

http://aka.ms/pbidesktopstore


  Choose a language when you download Power BI DesktopChoose a language when you download Power BI Desktop

Choose the locale for importing data into Power BI DesktopChoose the locale for importing data into Power BI Desktop

4. Select Region & language, select a language, and select Set as default.

The next time you start Power BI Desktop it will use the language you set as the default.

The language you choose for Power BI Desktop affects the display format of numbers and dates in reports.

Select a language when you download Power BI Desktop.

To change the language in Power BI Desktop, go back to the download page and download it in a different
language.

Whether you download Power BI Desktop or install it from the Windows Store, you can choose a locale for a
specific report to be something other than the locale in your version of Power BI Desktop. This changes the way
data is interpreted when it’s imported from your data source, for example whether "3/4/2017" is interpreted as 3rd
April or March 4th.

1. In Power BI Desktop, go to File > Options and settings > Options.
2. Under Current file, select Regional Settings.
3. In the Locale box, select a different locale.

https://powerbi.microsoft.com/desktop


Choose the language for the model in Power BI DesktopChoose the language for the model in Power BI Desktop

4. Select OK.

Besides setting the language for the Power BI Desktop application, you can also set the model language. The model
language affects chiefly two things:

How we compare and sort strings. For example, because Turkish has two of the letter i, depending on the
collation of your database, the two can end up in different orders when sorting.
The language Power BI Desktop uses when creating hidden date tables from date fields. For example, fields are
called Month/Monat/Mois, etc.

Here's how to set the model language.

1. In Power BI Desktop, go to File > Options and settings > Options.
2. Under Global, select Regional Settings.
3. In the Model language box, select a different language.



Languages for the help documentation

Next steps

Help is localized in these 10 languages:

Chinese (Simplified) - 中文(简体)
Chinese (Traditional) - 中文(繁體)
French - français
German - Deutsch
Italian - italiano
Japanese - 日本語
Korean - 한국어
Portuguese (Brazil) - Português
Russian - Русский
Spanish - español

Are you using one of the Power BI mobile apps? See Supported languages in the Power BI mobile apps for
details.
Questions? Try asking the Power BI Community.
Still have an issue? Please visit the Power BI support page.

http://community.powerbi.com/
https://powerbi.microsoft.com/support/
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Usage guidelines for the Power BI sample Excel workbooks

Say you're new to Power BI and want to try it out but don't have any data. Or maybe you have a dataset, but
because you don't understand (yet) how Power BI works, you worry that you might somehow damage your
dataset?

No need to stress out! obviEnce (www.obvience.com) and Microsoft have created samples for you to use until
you feel more comfortable with Power BI. The data is anonymized and represents different industries: finance,
HR, sales, and more. And as you read through our online documentation you'll discover tutorials and examples
that use these same samples which means that you'll be able to follow along.

Each of these samples is available in several formats: as a content pack, as an individual Excel workbook, and as
a .pbix file. If you don't know what these things are, or how to get your hands on them -- don't worry. We'll
explain it all later in this article. And for each sample we've created a tour which is a type of article that tells the
story behind the sample and walks you through different scenarios. One scenario might be answering
questions for your manager, another might be looking for competitive insights, or creating reports and
dashboards to share, or explaining a business shift.

But before we get started, please read through these legal guidelines for using the samples. When you're done
we'll introduce the samples and show you how to use them.

Please read this information before using the Power BI samples.

©2015 Microsoft Corporation. All rights reserved. The documents and workbooks are provided "as-is."
Information and views expressed in the workbooks, including URL and other Internet Web site references, may
change without notice. You bear the risk of using it. Some examples are for illustration only and are fictitious.
No real association is intended or inferred. Microsoft makes no warranties, express or implied, with respect to
the information provided here.

The workbooks do not provide you with any legal rights to any intellectual property in any Microsoft product.
You may copy and use this workbook for your internal, reference purposes.

The workbooks and related data are provided by obviEnce. www.obvience.com

ObviEnce is an ISV and an Intellectual Property (IP) Incubator focused on Microsoft Business Intelligence.
ObviEnce works closely with Microsoft to develop best practices and thought leadership for jump-starting and

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/sample-datasets.md
http://www.obvience.com/
http://www.obvience.com


Available samples

Customer Profitability sample Customer Profitability sample 

Human Resources sample Human Resources sample 

IT Spend Analysis sample IT Spend Analysis sample 

Opportunity Analysis sample Opportunity Analysis sample 

Procurement Analysis sample Procurement Analysis sample 

Retail Analysis sample Retail Analysis sample 

deploying Microsoft Business Intelligence solutions.

The workbooks and data are property of obviEnce, LLC and have been shared solely for the purpose of
demonstrating Power BI functionality with industry sample data.

Any uses of the workbooks and/or data must include the above attribution (that is also on the Info worksheet
included with each workbook). The workbook and any visualizations must be accompanied by the following
copyright notice: obviEnce ©.

By clicking any of the links below to download the Excel workbook files or .pbix files, you are agreeing to the
terms above.

Eight samples are available for you to use. Each one represents a different industry.

Take a tour of the Customer Profitability sample

This industry sample analyzes a CFO's key metrics for her executives, products, and customers. You can
investigate what factors impact the company's profitability.

Take a tour of the HR sample

This industry sample focuses on the hiring strategy for a company by analyzing new hires, active employees,
and employees who've left. By exploring the data, you can find trends in voluntary separations and biases in the
hiring strategy.

Take a tour of the IT Spend Analysis sample

In this industry sample we analyze the planned vs. actual costs of the IT department of a company. This
comparison helps us understand how well the company planned for the year and investigate areas with huge
deviations from the plan. The company in this example goes through a yearly planning cycle, and then
quarterly it produces a new Latest Estimate (LE) to help analyze changes in IT spend over the fiscal year.

Take a tour of the Opportunity Analysis sample

This industry sample explores a software company's sales channel. Sales managers monitor their direct and
partner sales channels by tracking opportunities and revenue by region, deal size, and channel.

Take a tour of the Procurement Analysis sample

This industry sample analyzes a CFO's key metrics for her executives, products, and customers. You can
investigate what factors impact the company's profitability



Sales and Marketing sample Sales and Marketing sample 

Supplier Quality sample Supplier Quality sample 

How to get the samples

The Power BI samples as content packs

Get and open a sample content pack in Power BI serviceGet and open a sample content pack in Power BI service

Take a tour of the Retail Analysis sample

This industry sample analyzes retail sales data of items sold across multiple stores and districts. The metrics
compare this year's performance to last year's in these areas: sales, units, gross margin, and variance, as well as
new store analysis.

Take a tour of the Sales and Marketing sample

This industry sample analyzes a manufacturing company, VanArsdel Ltd. It allows the Chief Marketing Officer
to watch the industry and the market share for VanArsdel. By exploring the sample, you can find the company's
market share, product volume, sales, and sentiment.

Take a tour of the Supplier Quality sample

This industry sample focuses on one of the typical supply chain challenges — supplier quality analysis. Two
primary metrics are at play in this analysis: total number of defects and the total downtime that these defects
caused. This sample has two main objectives: understand who the best and worst suppliers are, with respect to
quality, and identify which plants do a better job finding and rejecting defects, to minimize downtime.

Now you know what's available. Time to learn how to get ahold of these samples.

As you read above, the samples are available in several formats: content packs, Excel workbooks, and .pbix files.
We'll describe how to use each of these, starting with content packs.

Content packs are the only sample format that is available from within Power BI; you don't have to leave Power
BI to find them. A content pack is essentially a bundle of one or more dashboard, dataset, and report that
someone creates and that can be used with Power BI service. People create content packs to share with
colleagues. Each of the Power BI sample content packs contains a dataset, report, and dashboard. Content packs
are not available for Power BI Desktop. If you'd like to learn more about content packs, read Intro to content
packs in Power BI.

1. Open Power BI service (app.powerbi.com) and log in.
2. In the bottom left corner select Get data.

3. On the Get Data page that appears, select the Samples icon.

4. Select one of the samples to open a description of that sample. Then choose Connect.



The Power BI samples as Excel files

5. Power BI imports the content pack and adds a new dashboard, report, and dataset to your current
workspace. The new content is marked with a yellow asterisk. Use the samples to take Power BI for a test
run.

Now that you have data, you're on your way. Try out some of our tutorials using the sample content packs or
just open Power BI service and explore.

Each of the sample content packs is also available as an Excel workbook. The Excel workbooks are designed to
be used with Power BI service.

1. Download the files individually using the links below, or download a zip file of all the sample files. If
you're an advanced user, you might want to download the Excel workbooks to explore or edit the data
models.

Retail Analysis Sample
Supplier Quality Analysis Sample
Human Resources Sample
Customer Profitability Sample
Opportunity Tracking Sample
IT Spend Analysis Sample
Procurement Analysis Sample
Sales and Marketing Sample

2. Save the downloaded file. Where you save the file makes a difference.

 Local - If you save your file to a local drive on your computer or another location in your
organization, from Power BI, you can import your file into Power BI. Your file will actually remain on
your local drive, so the whole file isn’t really imported into Power BI. What really happens is a new
dataset is created in your Power BI site and data, and in some cases the data model, are loaded into
the dataset. If your file has any reports, those will appear in your Power BI site under Reports.

 OneDrive - Business – If you have OneDrive for Business and you sign into it with the same
account you sign into Power BI with, this is by-far the most effective way to keep your work in Excel,
Power BI, or a .CSV file in-sync with your dataset, reports, and dashboards in Power BI. Because both
Power BI and OneDrive are in the cloud, Power BI connects to your file on OneDrive about every
hour. If any changes are found, your dataset, reports, and dashboards are automatically updated in
Power BI.

 OneDrive - Personal – If you save your files to your own OneDrive account, you’ll get many

http://go.microsoft.com/fwlink/?LinkId=535020
http://go.microsoft.com/fwlink/?LinkId=529778
http://go.microsoft.com/fwlink/?LinkId=529779
http://go.microsoft.com/fwlink/?LinkId=529780
http://go.microsoft.com/fwlink/?LinkId=529781
http://go.microsoft.com/fwlink/?LinkId=529782
http://go.microsoft.com/fwlink/?LinkId=529783
http://go.microsoft.com/fwlink/?LinkId=529784
http://go.microsoft.com/fwlink/?LinkId=529785


TIPTIP

of the same benefits as you would with OneDrive for Business. The biggest difference is when you
first connect to your file (using Get Data > Files > OneDrive – Personal) you’ll need to sign in to your
OneDrive with your Microsoft account, which is usually different from what you use to sign in to
Power BI. When signing in with your OneDrive with your Microsoft account, be sure to select the
Keep me signed in option. This way, Power BI will be able to connect to your file about every hour
and make sure your dataset in Power BI is in-sync.

 SharePoint Team-Sites Saving your Power BI files to SharePoint – Team Sites is much the
same as saving to OneDrive for Business. The biggest difference is how you connect to the file from
Power BI. You can specify a URL or connect to the root folder.

3. Open Power BI service (app.powerbi.com) and log in.

At this point you may want to create a new dashboard and name it after the file you plan on importing.
Otherwise, when you import the Excel dataset, Power BI won't create a new dashboard named after the sample
but instead will add a tile to the dashboard that you currently have open. Selecting that tile will take you to the
dataset's report. This isn't a major big deal as you can always create a new dashboard later, but starting with a
new dashboard saves you a step or two.

4. In the bottom left corner select Get data.

5. On the Get Data page that appears, select Files > Get.

6. Navigate to the location where you downloaded and saved the sample.

7. Select the file, in this case Procurement Analysis Sample.xlsx which was saved on OneDrive for
Business, and choose Connect.



(Optional) Take a look at the Excel samples from inside Excel itself(Optional) Take a look at the Excel samples from inside Excel itself

9. If you select Import, Power BI imports the sample workbook and adds it as a new dataset named
Procurement Analysis Sample. If the workbook has any Power View sheets, tables or ranges, or a data
model, Power BI also creates a report (with the same name). And if you don't already have a dashboard
open, Power BI creates a new dashboard. (If you had a dashboard open when you clicked Get Data, you'll
see a new blank tile on that dashboard. Clicking that tile will take you to the report for the dataset you just
added). The new content is named after the sample and is marked with a yellow asterisk.

8. Choose whether to import the data or to bring the workbook into Power BI and see it exactly as it is in
Excel online.

10. When the Your dataset is ready! screen appears, select View dataset or Get Quick Insights or simply
use your Power BI left navbar to locate and open the associated report or dashboard.

Want to understand how the data in an Excel workbook gets converted to Power BI datasets and reports?
Opening the Excel samples in Excel and exploring the worksheets provides some of the answers.

When you first open a sample workbook in Excel, you may see two warnings. The first says the workbook is
in Protected View. Select Enable Editing. The second may say that the workbook has external data
connections. Select Enable Content.
Each workbook contains several sheets. Because these Excel samples all have at least one Power View



The Power BI samples as .pbix files

Next steps

The Info tab provides information about obviEnce, the company that created the sample.

sheet with visualizations, when you import the Excel file into Power BI you'll end up with a dataset and a
report.

You may need to enable the Power View add-in.

So where's the actual data? It's in the Power Pivot data model. To see the data, on the PowerPivot tab,
select Manage Data Model.

Don't see the PowerPivot tab? Enable the Power Pivot add-in.

Each of the sample content packs is also available as Power BI .pbix file. The .pbix files are designed to be used
with Power BI Desktop.

2. Save the downloaded file.

4. Select the .pbix file to open it in Desktop.

1. Download the files individually using the links below.

Retail Analysis Sample
Supplier Quality Analysis Sample
Human Resources Sample
Customer Profitability Sample
Opportunity Tracking Sample
IT Spend Analysis Sample
Procurement Analysis Sample
Sales and Marketing Sample

3. From Desktop, select File > Open and navigate to the location where you saved the sample .pbix.

Power BI basic concepts

Tutorial: Connect to the Power BI samples

Data sources for Power BI

More questions? Try the Power BI Community

https://support.office.com/article/Create-a-Power-View-sheet-in-Excel-2013-B23D768D-7586-47FE-97BD-89B80967A405#__toc328591957
https://support.office.com/article/Start-Power-Pivot-in-Microsoft-Excel-2013-add-in-A891A66D-36E3-43FC-81E8-FC4798F39EA8
http://download.microsoft.com/download/9/6/D/96DDC2FF-2568-491D-AAFA-AFDD6F763AE3/Retail Analysis Sample PBIX.pbix
http://download.microsoft.com/download/8/C/6/8C661638-C102-4C04-992E-9EA56A5D319B/Supplier-Quality-Analysis-Sample-PBIX.pbix
http://download.microsoft.com/download/6/9/5/69503155-05A5-483E-829A-F7B5F3DD5D27/Human Resources Sample PBIX.pbix
http://download.microsoft.com/download/6/A/9/6A93FD6E-CBA5-40BD-B42E-4DCAE8CDD059/Customer Profitability Sample PBIX.pbix
http://download.microsoft.com/download/9/1/5/915ABCFA-7125-4D85-A7BD-05645BD95BD8/Opportunity Analysis Sample PBIX.pbix
http://download.microsoft.com/download/E/9/8/E98CEB6D-CEBB-41CF-BA2B-1A1D61B27D87/IT Spend Analysis Sample PBIX.pbix
http://download.microsoft.com/download/D/5/3/D5390069-F723-413B-8D27-5888500516EB/Procurement Analysis Sample PBIX.pbix
http://download.microsoft.com/download/9/7/6/9767913A-29DB-40CF-8944-9AC2BC940C53/Sales and Marketing Sample PBIX.pbix
http://community.powerbi.com/


The Power BI samples, a tutorial
1/26/2018 • 5 min to read • Edit Online

PrerequisitesPrerequisites

About this tutorial

Samples and Power BI service

We recommend starting with the article Sample datasets for Power BI. In that article you'll learn all about the
samples; how to get them, where to save them, how to use them, and some of the stories each sample can tell.
Then, when you have a grasp of the basics, come back to this Tutorial.

The samples are available for Power BI service and Power BI Desktop. To follow along, we'll be using the Retail
analysis sample.

The Retail Analysis sample content pack used in this tutorial consists of a dashboard, report, and dataset. To
familiarize yourself with this particular content pack and its scenario, you may want to take a tour of the Retail
Analysis sample before you begin.

This tutorial teaches you how to

import a sample content pack, add it to Power BI service, and open the contents. A content pack is a type of
sample where the dataset is bundled with a dashboard and report.
open a sample .pbix file in Power BI Desktop.

1. Open and sign in to Power BI Service (app.powerbi.com).
2. Select Get Data at the bottom of the left navigation pane. If you don't see Get Data, expand the nav pane

by selecting .

3. Select Samples.

4. Select the Retail Analysis Sample, and choose Connect.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/sample-tutorial-connect-to-the-samples.md


What exactly was imported?
With the sample content packs, when you select Connect, Power BI is actually bringing in a copy of that content
pack and storing it for you in the cloud. Because the person who created the content pack included a dataset, a
report, and a dashboard -- that's what you get when you click Connect.

1. Power BI creates the new dashboard and lists it on your Dashboards tab. The yellow asterisk lets you know
it's new.

2. Open the Reports tab. Here you'll see a new report named Retail Analysis Sample.

And check out the Datasets tab. There's a new dataset as well.



Explore your new content

TIPTIP

Now explore the dashboard, dataset, and report on your own. There are many different ways to navigate to your
dashboards, reports, and datasets, and just one of those many ways is described below.

Want a little hand-holding first? Try the Tour of the Retail Analysis sample for a step-by-step walkthrough of this sample.

1. Navigate back to your Dashboards tab and select the Retail Analysis Sample dashboard to open it.

2. The dashboard opens. It has a variety of visualization tiles.

3. Select one of the tiles to open the underlying report. In this example, we'll select the area chart (outlined in
pink in the previous image). The report opens to the page that contains that area chart.



NOTENOTE
If the tile had been created using Power BI Q&A, the Q&A page would've opened instead. If the tile was pinned from
Excel, Excel Online would've opened inside of Power BI.

4. Back on your Datasets tab, you have several options for exploring your dataset. You won't be able to open
it and see all the rows and columns (as you can in Power BI Desktop or Excel). When someone shares a
content pack with colleagues, they typically want to share the insights, not give their colleagues direct
access to the data. But that doesn't mean you can't explore the dataset.

One way of exploring the dataset is by creating your own visualizations and reports from scratch.

Select the chart icon  to open the dataset in report editing mode.



Samples and Power BI Desktop

Another way of exploring the dataset is to run Quick Insights. Select the ellipses (...) and choose Get
insights. When the insights are ready, select View insights.

When you first open the sample PBIX file, is displays in Report view where you can explore, create, and modify any
number of report pages with visualizations. Report view provides pretty much the same design experience as a
report’s Editing view in the Power BI service. You can move visualizations around, copy and paste, merge, etc.

The difference between them is when using Power BI Desktop, you can work with your queries and model your
data to make sure your data supports the best insights in your reports. You can then save your Power BI Desktop
file wherever you like, whether it's your local drive or to the cloud.

1. Open the Retail Analysis sample .pbix file in Power BI Desktop.

2. The file opens in Report view. Notice the 4 tabs at the bottom of the report editor? That means that there
are 4 pages in this report, and the "New Stores" page is currently selected.

http://download.microsoft.com/download/9/6/D/96DDC2FF-2568-491D-AAFA-AFDD6F763AE3/Retail Analysis Sample PBIX.pbix


What exactly was imported?

Explore your new content

Next steps

.

3. For a deep dive into the report editor, see Take a tour of the report editor

When you open the sample PBIX file in Desktop, Power BI is actually bringing in a copy of that data and storing it
for you in the cloud. From Desktop you have access to the report and the underlying dataset. When the data is
loaded, Power BI Desktop will attempt to find and create relationships for you.

1. Switch to Data view by selecting the table icon  .

Data View helps you inspect, explore, and understand data in your Power BI Desktop model. It's different
from how you view tables, columns, and data in Query Editor. With Data View, you’re looking at your data
after it has been loaded into the model.

When you’re modeling your data, sometimes you want to see what’s actually in a table or column without
creating a visual on the report canvas, often right down to the row level. This is especially true when you’re
creating measures and calculated columns, or you need to identify a data type or data category.

2. Switch to Relationships view by selecting the icon  .

Relationship view shows all of the tables, columns, and relationships in your model. From here you can
view, change, and create relationships.

Now explore the dataset, relationships, and report on your own. For help getting started, visit the Desktop Getting
Started Guide.

Power BI basic concepts



Samples for Power BI service

Data sources for Power BI

More questions? Try the Power BI Community

http://community.powerbi.com/


Download the Financial Sample workbook for Power
BI
11/15/2017 • 1 min to read • Edit Online

Next stepsNext steps

Need some data to try with Power BI service? We have a simple Excel workbook of sample financial data available
for download. Here's how to download it:

Financial sample Excel workbook: download the sample directly.

This workbook has one table of data of sales and profit data by market segment and country/region.

Get Data

How to import Excel data

Other data you can try with Power BI -- Sample datasets and content packs

More questions? Try the Power BI Community

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/sample-financial-download.md
http://go.microsoft.com/fwlink/?LinkID=521962
http://community.powerbi.com/


Supplier Quality Analysis sample for Power BI: Take a
tour
1/24/2018 • 6 min to read • Edit Online

A brief overview of the Supplier Quality Analysis sample

Prerequisites

Get the content pack for this sampleGet the content pack for this sample

This industry sample dashboard and underlying report focus on one of the typical supply chain challenges —
supplier quality analysis. Two primary metrics are at play in this analysis: total number of defects and the total
downtime that these defects caused. This sample has two main objectives:

Understand who the best and worst suppliers are, with respect to quality
Identify which plants do a better job finding and rejecting defects, to minimize downtime

This sample is part of a series that illustrates how you can use Power BI with business-oriented data, reports, and
dashboards. This is real data from obviEnce (www.obvience.com) that has been anonymized.

Before you can use the sample, you must first download it as a content pack, .pbix file, or Excel workbook.

1. Open the Power BI service (app.powerbi.com) and log in.
2. In the bottom left corner select Get data.

3. On the Get Data page that appears, select the Samples icon.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/sample-supplier-quality.md
http://www.obvience.com/


Get the .pbix file for this sampleGet the .pbix file for this sample

Get the Excel workbook for this sampleGet the Excel workbook for this sample

Downtime caused by defective materials

4. Select the Supplier Quality Analysis Sample, then choose Connect.

5. Power BI imports the content pack and adds a new dashboard, report, and dataset to your current
workspace. The new content is marked with a yellow asterisk.

Alternatively, you can download the sample as a .pbix file, which is designed for use with Power BI Desktop.

Supplier Quality Analysis Sample

You can also download just the dataset (Excel workbook) for this sample. The workbook contains Power View
sheets that you can view and modify. To see the raw data select Power Pivot > Manage.

Let’s analyze the downtime caused by defective materials and see which vendors are responsible.

1. On the dashboard, select the Total Defect Quantity number tile or the Total Downtime Minutes number
tile.

http://download.microsoft.com/download/8/C/6/8C661638-C102-4C04-992E-9EA56A5D319B/Supplier-Quality-Analysis-Sample-PBIX.pbix
http://go.microsoft.com/fwlink/?LinkId=529779


Which are the worst suppliers?Which are the worst suppliers?

2. Looking at the Total Downtime Minutes line in the Defects and Downtime (min) by Material Type combo
chart, we see corrugate materials cause the most downtime.

4. Select individual plants in the map to see which vendor or material is responsible for the downtime at that
plant.

The “Supplier Quality Analysis Sample” report opens to the “Downtime Analysis” page. Notice we have 33M
total defective pieces, and the total downtime caused by these defective pieces is 77K minutes. Some
materials have fewer defective pieces but they can cause a huge delay resulting in larger downtime. Let’s
explore them on the report page.

3. Select the Corrugate column in the same combo chart to see which plants are impacted most by this defect
and which vendor is responsible.

We want to find the worst eight suppliers and determine what percentage of the downtime they are responsible
for creating. We can do this by changing the Downtime (min) by Vendor area chart to a treemap.

1. On page 3 of the report, “Downtime Analysis,” select Edit Report in the upper-left corner.
2. Select the Downtime (min) by Vendor area chart, and in the Visualizations pane select Treemap.

The treemap automatically puts the Vendor field as the Group.



Comparing plantsComparing plants

3. Select Supplier Quality Analysis Sample in the top navigation bar to go back to the dashboard.

From this tree map, we can see the top eight vendors are the eight blocks on the left of the tree map. We can
also see they account for about 50% of all downtime minutes.

Now let’s explore which plant does a better job managing defective material, resulting in less downtime.

1. Select the Total Defect Reports by Plant, Defect Type map tile.

The report opens to the “Supplier Quality” page.

2. In the map legend, select the Impact circle.

Notice in the bubble chart that Logistics is the most troubled category – it’s the largest in terms of total
defect quantity, total defect reports, and total downtime minutes. Let’s explore this category more.



Which material type is best managed?

4. Select Supplier Quality Analysis Sample in the top navigation bar to return to your active workspace.

3. Select the Logistics bubble in the bubble chart and observe the plants in Springfield, IL and Naperville, IL.
Naperville seems to be doing a much better job of managing defective supplies as it has a high number of
rejects and few impacts, compared to Springfield’s large number for impacts.

The best managed material type is the one with lowest downtime or no impact, regardless of defect quantity.

In the dashboard, look at the Total Defect Quantity by Material Type, Defect Type tile.

Notice that Raw Materials have a lot of total defects, but most of the defects are either rejected or have no impact.

Let’s verify that raw materials don’t cause a lot of downtime, despite high defect quantity.

In the dashboard, look at the Total Defect Qty, Total Downtime Minutes by Material Type tile.



Compare defects to downtime by yearCompare defects to downtime by year

Apparently raw materials are well managed: they have more defects, but lower total downtime minutes.

1. Select the Total Defect Reports by Plant, Defect Type map tile to open the report to the first report page,
Supplier Quality.

3. Do more defects translate into more downtime? We can ask questions in the Q&A box to find out.
4. Select Supplier Quality Analysis Sample in the top navigation bar to go back to the dashboard.

2. Notice that Defect Qty is higher in 2014 than in 2013.

5. Since we know Raw Materials have the highest number of defects, in the question box, type “show material
types, year and total defect qty”.

There were many more raw materials defects in 2014 than in 2013.



Compare defects to downtime month to monthCompare defects to downtime month to month

6. Now change the question to “show material types, year and total downtime minutes”.

Raw materials downtime was about the same in 2013 and 2014, even though there were many more raw
materials defects in 2014.

It turns out more raw materials defects in 2014 didn’t lead to much more raw materials downtime in 2014.

Let’s look at another dashboard tile related to total defective quantity.

1. Select the back arrow  in the upper-left corner above the question box to get back to the dashboard.

Looking more closely at the Total Defect Quantity by Month, Year tile shows that the first half of 2014
had a similar number of defects as 2013, but in the second half of 2014, the number of defects jumped
significantly.



Next steps: Connect to your data

3. To pin this chart to your dashboard, select the pin icon  to the right of the question box.
4. To explore the outlier months, check out the downtime minutes during Oct by material type, plant location,

category, etc. by asking questions such as "total downtime minutes in October by plant".

5. Select the back arrow  in the upper-left corner above the question box to get back to the dashboard.

Let’s see if this increase in defect quantity led to an equal increase in downtime minutes.

2. In the question box, type “total downtime minutes by month and year as a line chart”.

We do see a jump in downtime minutes during June and Oct, but other than that, the jump in the number of
defects didn’t result in significantly more downtime. This shows we’re managing defects well.

This is a safe environment to play in. You can always choose not to save your changes. But if you do save them, you
can always go to Get Data for a new copy of this sample.

We hope this tour has shown how Power BI dashboards, Q&A, and reports can provide insights into supplier



quality data. Now it’s your turn — connect to your own data. With Power BI you can connect to a wide variety of
data sources. Learn more about getting started with Power BI.



IT Spend Analysis sample for Power BI: Take a tour
1/24/2018 • 5 min to read • Edit Online

Overview of the IT Spend Analysis sample

Prerequisites

Get the content pack for this sampleGet the content pack for this sample

The IT Spend Analysis content pack (dashboard, report, and dataset) analyze the planned vs. actual costs of an IT
department. This comparison helps us understand how well the company planned for the year and investigate
areas with huge deviations from the plan. The company in this example goes through a yearly planning cycle, and
then quarterly it produces a new Latest Estimate (LE) to help analyze changes in IT spend over the fiscal year.

This sample is part of a series that illustrates how you can use Power BI with business-oriented data, reports and
dashboards. This is real data from obviEnce (http://obvience.com/) that has been anonymized.

Before you can use the sample, you must first download it as a content pack, .pbix file, or Excel workbook.

1. Open the Power BI service (app.powerbi.com) and log in.
2. In the bottom left corner select Get data.

3. On the Get Data page that appears, select the Samples icon.

4. Select the IT Spend Analysis Sample, then choose Connect.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/sample-it-spend.md
http://obvience.com/


Get the .pbix file for this sampleGet the .pbix file for this sample

Get the Excel workbook for this sampleGet the Excel workbook for this sample

The IT Spend Analysis Sample dashboard

“YTD IT Spend Trend Analysis” page

5. Power BI imports the content pack and adds a new dashboard, report, and dataset to your current
workspace. The new content is marked with a yellow asterisk.

Alternatively, you can download the sample as a .pbix file, which is designed for use with Power BI Desktop.

IT Spend Analysis Sample

You can also download just the dataset (Excel workbook) for this sample. The workbook contains Power View
sheets that you can view and modify. To see the raw data select Power Pivot > Manage.

The two numbers tiles on the dashboard, the Var Plan % and Variance Latest Estimate % Quarter 3, give us an
overview of how well we are doing against plan and against the Latest Qtr estimate (LE3 = Latest Estimate Quarter
3). Overall we are about 6% off the plan. Let’s explore the cause of this variance – when, where, and which
category?

Selecting the Var Plan % by Sales Region dashboard tile takes you to the “IT Spend Trend Analysis” page of the
IT Spend Analysis Sample report. We see at a glance that we have positive variance in US and Europe and negative
variance in Canada, Latin America, and Australia. US had about 6% +LE variance and Australia has about 7% -LE
variance.

But just looking at this chart and drawing conclusions can be misleading. We need to look at actual dollar amounts
to put things in perspective.

http://download.microsoft.com/download/E/9/8/E98CEB6D-CEBB-41CF-BA2B-1A1D61B27D87/IT Spend Analysis Sample PBIX.pbix
http://go.microsoft.com/fwlink/?LinkId=529783


Ask questions of the data

“YTD Spend by Cost Elements” page

1. Select Aus and NZ  in the Var Plan % by Sales Region chart, and observe Var Plan by IT Area chart.

2. Now select USA. You get the idea — Australia is a really small part of our overall spend as compared to US.

So we narrowed it down to the USA, now what? Let’s explore which category in the USA is causing the
variance.

1. Select IT Spend Analysis Sample in the top navigation bar to return to the Dashboards.
2. In the question box, type “show IT areas, var plan % and var le3 % bar chart”.

In the first IT area, Infrastructure, the percentage has changed drastically between the initial variance plan
and the variance plan latest estimate.

Go back to the dashboard and look at the Var Plan %, Var LE3% dashboard tile.



“Plan Variance Analysis” page

Infrastructure jumps out with huge positive variance to plan.

1. Click this tile to go to the “YTD Spend by Cost Elements” page of the IT Spend Analysis Sample report.

3. Click the name of each Cost Element Group in the slicer to find the cost element with a large variance.

2. Click the Infrastructure bar in the “Var Plan % and Var LE3 % by IT Area” chart in the lower left, and
observe the variance to plan in the "Var Plan % by Sales Region" to the left.

4. With Other selected, click Infrastructure in the IT Area and click the sub areas in the IT Sub Area slicer to
find the sub area with the largest variance.

We see a huge variance in Networking.

Apparently the company decided to give its employees phone services as a benefit but this move was not
planned for.

Still in the report, click the "Plan Variance Analysis" tab on the bottom of the report to go to page 3 of the report.

In the “Var Plan, and Var Plan % by Business Area” combo chart on the left, click the Infrastructure column to
highlight infrastructure values in the rest of the page.



Edit the report

Next steps: Connect to your data

Notice on the “Var plan% by Month and Business Area” chart that infrastructure started to have a positive variance
around February and then it keeps increasing. Also, notice how the variance to plan value for infrastructure varies
by country, compared to the value for all business areas. Use the “IT Area” and “IT Sub Areas” slicers on the right to
filter the values in the rest of the page rather than highlighting them. Click the different IT Areas on the right to
explore the data in another way. You can also click IT Sub Areas and see the variance at that level.

Click Edit Report in the upper-left corner and explore in Editing View.

See how the pages are made – the fields in each chart, filters on the pages
Add pages and charts based on the same data
Change the visualization type for each chart
Pin them to your dashboard

This is a safe environment to play in. You can always choose not to save your changes. But if you do save them,
you can always go to Get Data for a new copy of this sample.

We hope this tour has shown how Power BI dashboards, Q&A, and reports can provide insights into IT spend data.
Now it is your turn — connect to your own data. With Power BI you can connect to a wide variety of data sources.
Learn more about getting started with Power BI.



Sales and Marketing sample for Power BI: Take a tour
1/24/2018 • 7 min to read • Edit Online

Overview of the Sales and Marketing sample

Prerequisites

Get the content pack for this sampleGet the content pack for this sample

The Sales and Marketing Sample contains a dashboard and report for a fictitious manufacturing company
named VanArsdel Ltd. This dashboard was created by the VanArsdel Chief Marketing Officer (CMO) to keep an eye
on the industry and his company’s market share, product volume, sales, and sentiment.

VanArsdel has many competitors but is the market leader in its industry. The CMO wants to increase market share
and discover growth opportunities. But, for some reason, VanArsdel’s market share has started to decline, with
significant dips in June.

This sample is part of a series that illustrates how you can use Power BI with business-oriented data, reports and
dashboards. This is real data from obviEnce (www.obvience.com) that has been anonymized.

Before you can use the sample, you must first download it as a content pack, .pbix file, or Excel workbook.

1. Open the Power BI service (app.powerbi.com) and log in.
2. In the bottom left corner select Get data.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/sample-sales-and-marketing.md


Get the .pbix file for this sampleGet the .pbix file for this sample

Get the Excel workbook for this sampleGet the Excel workbook for this sample

What is our dashboard telling us?

3. On the Get Data page that appears, select the Samples icon.

4. Select the Sales and Marketing Sample, then choose Connect.

5. Power BI imports the content pack and adds a new dashboard, report, and dataset to your current
workspace. The new content is marked with a yellow asterisk.

Alternatively, you can download the sample as a .pbix file, which is designed for use with Power BI Desktop.

Sales and Marketing Sample

You can also download just the dataset (Excel workbook) for this sample. The workbook contains Power View
sheets that you can view and modify. To see the raw data select Power Pivot > Manage.

Let’s start our tour at the dashboard and look at the tiles the CMO has chosen to pin. We see information about our
market share, sales, and sentiment. And we see that data broken down by region, time, and competition.

The number tiles down the left column show industry sales volume this past year (50K), market share (32.86%),
sales volume (16K), sentiment score (68), sentiment gap (4), and total units sold (1M).
The top line chart shows how our market share fluctuates over time. Our market share really drops in June.
Also, our R12M (Rolling 12 Months) share which was increasing for a while, is starting to stall.
Our biggest competitor is Aliqui (evident in the middle column chart tile.)
Most of our business is in the East and Central regions.
The line chart at the bottom shows that our dip in June is not seasonal – none of our competitors show the
same trend.
The two “Total Units” tiles show units sold, by segment and by region/manufacturer. The largest market
segment for our industry are Productivity and Convenience.

http://download.microsoft.com/download/9/7/6/9767913A-29DB-40CF-8944-9AC2BC940C53/Sales and Marketing Sample PBIX.pbix
http://go.microsoft.com/fwlink/?LinkId=529785


Use Q&A to dig a little deeperUse Q&A to dig a little deeper
Which segments drive our sales? Does it match the industry trend?Which segments drive our sales? Does it match the industry trend?

What does total unit market share look like for category (versus region)?What does total unit market share look like for category (versus region)?

1. Select the “Total Units Overall by Segment” tile which will open Q&A.

3. Our share in the Moderation and Convenience categories is very high; these are the segments where we
compete.

4. Navigate back to the dashboard by selecting the dashboard name in the top navbar (breadcrumbs).

2. Type for VanArsdel at the end of the existing query. Q&A interprets the question and displays an updated
chart with the answer. Our product volume comes from Convenience and Moderation.

1. Notice the “Total Units YTD by Manufacturer, Region” tile. I wonder how the total unit market share looks by
category?



Our report has 4 pagesOur report has 4 pages
Page 1 of our report focuses on VanArsdel’s market share.Page 1 of our report focuses on VanArsdel’s market share.

2. In the question box at the top of the dashboard, type the question total units by manufacturer and category
for 2014 as a treemap. Notice how the visualization updates as you type the question. 

3. To compare the findings, pin the chart to your dashboard. Very interesting; in 2014 VanArsdel only sold
products that fall into the Urban category.

4. Navigate back to the dashboard.

Dashboards are also an entry point into reports. If a tile was created from an underlying report, clicking that tile
opens the report.

On our dashboard, the R12M (Rolling 12 Months) line shows that our market share is no longer increasing over
time, it’s even declining a bit. And why do we have a big market share dip in June? To investigate further, click this
visualization to open the underlying report.



Page 3 of our report focuses on Sentiment.Page 3 of our report focuses on Sentiment.

1. Look at the “Total Units by Month and isVanArsdel” column chart at the bottom. The black column represents
VanArsdel (our products) and green is our competition. The drop in June 2014 that VanArsdel experienced is
not experienced by the competition.

3. In “Total Units by Month and isVanArsdel”, select the black “Yes” in the legend to cross-filter the page by
VanArsdel. Notice that we don’t compete in the Productivity segment.

4. Select the black “Yes” again to remove the filter.
5. Take a look at the line chart. It shows our monthly market share and 12 month rolling market shares. Rolling 12

months data help in smoothing out monthly fluctuations and shows the long term trends. Select Convenience
and then Moderation in the bar chart to see how much fluctuation in market share there is for each segment.
The Moderation segment shows much more fluctuation in market share than the Convenience segment.

2. The “Total Category Volume by Segment” bar chart in the middle on the right, is filtered to show
VanArsdel’s top 2 segments. Take a look at how this filter was created:

a. Expand the Filters pane on the right.
b. Click to select the visualization.
c. Under Visual Level Filters, notice that Segment is filtered to include only Convenience and Moderation.
d. Modify the filter by selecting Segment to expand that section and then checking Productivity to add that
segment as well.

We’re still looking to find out why our market share dipped so low in June. Let’s check Sentiment.



Page 2 of our report focuses on YTD Category TrendPage 2 of our report focuses on YTD Category Trend

Page 4 of our report focuses on competitive product analysis.Page 4 of our report focuses on competitive product analysis.

Tweets, Facebook, blogs, articles, etc. contribute to sentiment which is shown in the two line charts. The sentiment
chart in the top left shows that sentiment for our products were pretty much neutral up until February. Then a big
drop started in February and bottomed out in June. What happened to cause this drop in sentiment? We need to
look at external sources. In February, several articles and blog posts rated VanArsdel’s customer service the worst
in the industry. This bad press had a direct correlation to customer sentiment and sales. VanArsdel worked hard to
improve customer service and customers and the industry took note. In July positive sentiment started to rise and
then reached an all-time high in the 60s. This uptick in sentiment can be seen reflected in “Total Units by Month” on
pages 1 and 3. Perhaps this partially explains our market share dips for June?

Sentiment gap would be another area to explore: which districts have the highest sentiment gap, how can
management capitalize on this, and discover ways to replicate it in other districts.

Of all the companies in this category, VanArsdel is the largest and our biggest competitors are Natura, Aliqui,
and Pirium. We’ll keep our eyes on them.
Aliqui is growing, but product volume compared to us is still low.
The treemap shows VanArsdel in green. In the East, customers prefer our competition, in Central we’re doing
OK, and our share in the East is our lowest.
Geography has an impact on units sold. East is the dominant region for most manufacturers and VanArsdel has
a strong presence in the Central region as well.
On the chart “Total Units YTD Var % by Month and Manufacturer” in the bottom right– we have positive
variance and that is a good sign, we are doing better than last year but so is another competitor, Aliqui.



Next steps: Connect to your data

The bottom left chart shows all the category segments except for VanArsdel’s two strongest segments. Filtering
by category by clicking on the bars helps identify potential expansion areas for VanArsdel. The Extreme and
Productivity segments are growing faster than others.
But we don’t compete in these segments. If we want to move into these areas, we can use our data to see which
segments are popular in which regions. We can further investigate questions like which region is growing faster
and who would be our biggest competitor in that segment.
Remember our market share dip in June? June is a huge month for the Productivity segment – a segment we
don’t compete in at all. This could help explain our market share dip in June.

By filtering the visualizations by VanArsdel, by segment, by month, and by region, we can discover growth
opportunities for VanArsdel.

This is a safe environment to play in. You can always choose not to save your changes. But if you do save them, you
can always go to Get Data for a new copy of this sample.

We hope this tour has shown how Power BI dashboards, Q&A, and reports can provide insights into sales and
marketing data. Now it’s your turn — connect to your own data. With Power BI you can connect to a wide variety of
data sources. Learn more about getting started with Power BI.



Customer Profitability sample for Power BI: Take a
tour
1/26/2018 • 9 min to read • Edit Online

Overview of the Customer Profitability sample

Prerequisites

Get the content pack for this sampleGet the content pack for this sample

The “Customer Profitability Sample” content pack contains a dashboard, report, and dataset for a company that
manufactures marketing materials. This dashboard was created by a CFO to see key metrics about her 5 business
unit managers (aka executives), products, customers, and gross margins (GM). At a glance she can see what factors
are impacting profitability.

<<<<<<< HEAD 

This sample is part of a series that illustrates how you can use Power BI with business-oriented data, reports and
dashboards. This is real data from obviEnce (www.obvience.com) that has been anonymized. The data is available
in several formats: content pack/app, Excel workbook, or .pbix Power BI Desktop file. See Sample datasets.

Want to follow along? This tutorial uses Power BI service and the "Customer Profitability" sample content pack.
Because the report experiences are so similar, you can also follow along using Power BI Desktop and the sample
PBIX file. Instructions for connecting to the content pack and the PBIX file are below.

1. Open the Power BI service (app.powerbi.com) and log in.
2. In the bottom left corner select Get data.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/sample-customer-profitability.md
http://www.obvience.com/


Get the .pbix file for this sampleGet the .pbix file for this sample

Get the Excel workbook for this sampleGet the Excel workbook for this sample

If you want to dig into the datasource for this sample, it's
also available as an (Excel workbook). The workbook
contains Power View sheets that you can view and modify.
To see the raw data, select Power Pivot > ManagePower Pivot > Manage.

PrerequisitesPrerequisites

3. On the Get Data page that appears, select the Samples icon.

4. Select the Customer Profitability Sample, then choose Connect.

5. Power BI imports the content pack and adds a new dashboard, report, and dataset to your current
workspace. The new content is marked with a yellow asterisk. Use the samples to take Power BI for a test
run.

Alternatively, you can download the sample as a .pbix file, which is designed for use with Power BI Desktop.
Customer Profitability Sample

This sample is part of a series that illustrates how you can use Power BI with business-oriented data, reports and
dashboards. This is real data from obviEnce (www.obvience.com) that has been anonymized. The data is available
in several formats: content pack/app, Excel workbook, or .pbix Power BI Desktop file. See Sample datasets.

Want to follow along? In the Power BI service, go to Get Data > Samples > Customer Profitability > Connect
to get your own copy of the sample.

def2c8e086d65b6a3fb92247175730746226ae3e

http://download.microsoft.com/download/6/A/9/6A93FD6E-CBA5-40BD-B42E-4DCAE8CDD059/Customer>> Profitability Sample PBIX.pbix
http://go.microsoft.com/fwlink/?LinkId=529781
http://www.obvience.com/
https://powerbi.com


What is our dashboard telling us?

Company-wide dashboard tilesCompany-wide dashboard tiles

Under My Workspace, find the dashboard for the Customer Profitability sample:

1. Open the dashboard in Power BI service. The dashboard tiles give our CFO a view of the high-level company
metrics important to her. When she sees something interesting, she can select a tile to dig into the data.

2. Review the tiles on the left side of the dashboard.



Manager-specific dashboard tilesManager-specific dashboard tiles

Our company gross margin is 42.5%.
We have 80 customers.
We sell 5 different products.
We had our lowest revenue variance% to budget in February, followed by our highest in March.
Most of our revenue comes from the East and North regions. Gross margin has never exceeded budget, with
ER-0 and MA-0 requiring some further investigation.
Total revenue for the year is close to budget.

The tiles on the right side of the dashboard provide a team scorecard. The CFO needs to keep track of her
managers and these tiles give her a high level overview of profit – using GM%. If the GM% trend is unexpected for
any manager, then she can investigate further.



Explore the dashboard's underlying data

Open the Excel Online data sourceOpen the Excel Online data source

All executives, except Carlos, have already exceeded their target sales. But Carlos' actual sales are the highest.
Annelie’s GM% is the lowest, but we see a steady increase since March.
Valery, on the other hand, has seen her GM% drop significantly.
And Andrew had a volatile year.

This dashboard has tiles that link to a report and to an Excel workbook.

Two tiles on this dashboard, "Target vs Actual" and "Year Over Year Revenue Growth" were pinned from an Excel
workbook. So when you select either of these tiles, Power BI opens the data source -- in this case, Excel Online.



Open the underlying Power BI reportOpen the underlying Power BI report

Team Scorecard pageTeam Scorecard page

1. Select either of the tiles that were pinned from Excel. Excel Online opens within Power BI service.
2. Notice that the workbook has 3 tabs's worth of data. Open "Revenue".
3. Let's look into why Carlos hasn't hit his target yet.

a. From the "Executive" slider, select Carlos Grilo.
b. The first PivotTable tells us that Carlos' revenue for his top Product, Primus, is down 152% from last year.
And the YoY chart shows that for most months he's below budget.

4. Continue exploring, and if you find something interesting, select Pin  from the upper-right corner to
pin it to a dashboard.

5. Use your browser's back arrow to return to the dashboard.

The majority of the tiles on the Customer Profitability sample dashboard were pinned from the underlying
Customer Profitability sample report.

1. Select one of these tiles to open the report in Reading view.

2. The report has 3 pages. Each tab at the bottom of the report represents a page.

"Team Scorecard" focuses on the performance of the 5 managers and their "books of business."
"Industry Margin Analysis" provides a way to analyze our profitability compared to what's going on in
our entire industry.
"Executive Scorecard" provides a view of each of our managers formatted for viewing in Cortana.



Let’s look at two of the team members in detail and see what insights can be gained. In the slicer on the left, select
Andrew's name to filter the report page to display only data about Andrew.

For a quick KPI, look at Andrew’s Revenue Status - he is green. He’s performing well.
The “Revenue Var % to Budget by Month” Area chart shows that except for a dip in February, Andrew is doing
pretty well overall. His dominant region is East and he handles 49 customers and 5 (out of 7) products. His
GM% isn’t the highest or lowest.
The “RevenueTY and Revenue Var % to Budget by Month” shows a steady even profit story.But when you filter
by clicking on the square for Central in the region treemap, you discover that Andrew has revenue only in
March and only in Indiana. Is this intentional or is this something that needs looking into?

Now on to Valery. In the slicer, select Valery’s name to filter the report page to display only data about her.

Notice the red KPI for RevenueTY Status. This definitely needs further investigation.
Her revenue variance also paints a worrying picture – she is not meeting her revenue margins.



Industry Margin AnalysisIndustry Margin Analysis

Executive ScorecardExecutive Scorecard

Dig into the data by asking questions with Q&A

Valery has only 9 customers, handles only 2 products and works almost-exclusively with customers in the north.
This specialization could explain wide fluctuations in her metrics.
Selecting the North square in the treemap shows that Valery’s gross margin in the North is consistent with her
overall margin.
Selecting the other Region squares tells an interesting story: her GM% ranges from 23% to 79% and her
revenue numbers, in all regions except North, are extremely seasonal.

Continue digging to find out why Valery’s area is not performing well. Look at regions, the other business units,
and the next page in the report – “Industry Margin Analysis.”

This report page provides a different slice of the data. It looks at gross margin for the entire industry, broken down
by segment. The CFO uses this page to compare company and business unit metrics to industry metrics to help her
explain trends and profitability. You might wonder why the “Gross Margin by Month and Executive Name” area
chart is on this page, since it is team-specific. Having it here lets us filter the page by business unit manager.

How does profitability vary by industry? How do the products and customers break down by industry? Select one
or more industries from the top left. (Start from the CPG industry) To clear the filter, select the eraser icon.

On the bubble chart, the CFO looks for the largest bubbles since these are the ones that have the biggest impact on
revenue. Filtering the page by manager by clicking on their names in the area chart makes it easy to see each
manager’s impact by industry segment.

Andrew's area of influence spans many different industry segments with widely varying GM% (most on the
positive side) and Var%.
Annelie's chart is similar, except that she concentrates on only a handful of industry segments with a focus on
the Federal segment and a focus on Gladius product.
Carlos has a clear focus on the Services segment, with good profit. He's greatly improved variance % for the
High Tech segment and a new segment for him, Industrial, performed exceptionally well compared to budget.
Tina works with a handful of segments and has the highest GM%, but the mostly small size of her bubbles
shows that her impact on the company's bottom line is minimal.
Valery, who is responsible for only one product, works in only 5 industry segments. Her industry influence is
seasonal, but always produces a large bubble, indicating a significant impact on the company’s bottom line.
Does industry explain her negative performance?

This page is formatted as an Answer Card for Cortana. To learn more, see create Answer Cards for Cortana



Dig deeper by adding filtersDig deeper by adding filters

For our analysis, it would be helpful to determine which industry generates the most revenue for Valery. Let’s use
Q&A.

1. Open the report in Editing view by selecting Edit report. Editing view is only available if you "own" the
report; this is sometimes referred to as creator mode. If, instead, this report had been shared with you, you
wouldn't be able to open it in Editing view.

2. From the top menubar, select Ask a question to open the Q&A question box.

3. Type total revenue by industry for Valery. Notice how the visualization updates as you type the question.

Distribution is the biggest revenue area for Valery.

Let's take a look at the Distribution industry.

1. Open the "Industry Margin Analysis" report page.
2. Without selecting any visualizations on the report page, expand the filter pane on the right (if it isn't already

expanded). The Filters pane should display only Page level filters.



4. The "Gross margin by Month and Executive Name" area chart tells us that only Valery and Tina have customers
in this industry and Valery only worked with this industry from June to November.

5. Select Tina  and then Valery in the "Gross Margin by Month and Executive" area chart legend. Notice Tina's
portion of "Total Revenue by Product" is really small compared to Valery.

3. Locate the filter for Industry and select the arrow to expand the list. Let's add a page filter for the
Distribution industry. First, clear all selections by clearing the Select All checkbox. Then select only
Distribution.

6. To see actual revenue, use Q&A to ask total revenue by executive for distribution by scenario.



Next steps: Connect to your data

We can similarly explore other industries and even add customers to our visuals to understand causes for
Valery's performance.

This is a safe environment to play in. You can always choose not to save your changes. But if you do save them, you
can always go to Get Data for a new copy of this sample.

You can also download just the dataset (Excel workbook) for this sample.

We hope this tour has shown how Power BI dashboards, Q&A, and reports can provide insights into customer data.
Now it is your turn — connect to your own data. With Power BI you can connect to a wide variety of data sources.
Learn more about getting started with Power BI.

Back to Samples in Power BI

http://go.microsoft.com/fwlink/?LinkId=529781


Human Resources sample for Power BI: Take a tour
1/24/2018 • 6 min to read • Edit Online

Overview of the Human Resources sample

Prerequisites

Get the content pack for this sampleGet the content pack for this sample

The HR department has the same reporting model across different companies, even when they differ by industry or
size. This sample looks at new hires, active employees, and employees who left and tries to uncover any trends in
the hiring strategy. Our main objectives are to understand:

Who we hire
Biases in our hiring strategy
Trends in voluntary separations

This sample is part of a series that illustrates how you can use Power BI with business-oriented data, reports, and
dashboards. This is real data from obviEnce (www.obvience.com) that has been anonymized. The data is available
in several formats: content pack/app, Excel workbook, or .pbix Power BI Desktop file. To learn more, see Sample
datasets.

Before you can use the sample, you must first download it as a content pack, .pbix file, or Excel workbook.

1. Open the Power BI service (app.powerbi.com) and log in.
2. In the bottom left corner select Get data.

3. On the Get Data page that appears, select the Samples icon.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/sample-human-resources.md
http://www.obvience.com/


Get the .pbix file for this sampleGet the .pbix file for this sample

Get the Excel workbook for this sampleGet the Excel workbook for this sample

New hires

4. Select the Human Resources Sample, then choose Connect.

5. Power BI imports the content pack and adds a new dashboard, report, and dataset to your current
workspace. The new content is marked with a yellow asterisk.

Alternatively, you can download the sample as a .pbix file, which is designed for use with Power BI Desktop.

Human Resources Sample

You can also download just the dataset (Excel workbook) for this sample. The workbook contains Power View
sheets that you can view and modify. To see the raw data select Power Pivot > Manage.

Let’s explore new hires first.

1. In your workspace, select the Dashboards tab, and open the Human Resources dashboard.
2. On the dashboard, select the New Hire Count, New Hires Same Period Last Year, Actives YoY %

Change By Month tile.

http://download.microsoft.com/download/6/9/5/69503155-05A5-483E-829A-F7B5F3DD5D27/Human Resources Sample PBIX.pbix
http://go.microsoft.com/fwlink/?LinkId=529780


The Human Resources Sample report opens to the New Hires page.

Notice the following:

The New Hire Count, New Hires SPLY and Actives YoY % Change by Month combo chart shows we hired
more people every month this year compared to last year — significantly more people in some months.
In the combo chart New Hire Count and Active Employee Count by Region and Ethnicity, notice we’re
hiring fewer people in the East region.
The New Hires YoY Var by Age Group waterfall chart shows we’re hiring mainly younger people. This may be
due to the mainly part-time nature of the jobs.
The New Hire Count by Gender pie chart shows a pretty even split.

Can you find more insights; for example, a region where the gender split is not even? Select different age groups
and genders in the charts to explore the relationships between age, gender, region, and ethnicity group.

Select the name of the dashboard from the top navbar to return to the dashboard.



Compare current active and former employees

Reasons for separation

Let’s explore data for current active employees and employees who no longer work for the company.

On the dashboard, select the Active Employee Count by Age Group tile.

The Human Resources Sample report opens to the Active Employees vs. Separations page.

Items of interest:

Combo charts on the left show year-over-year change for active employees and separates. We have more
actives this year due to rapid hiring, but also more separates than last year.
In August we had more separates compared to other months. Select the different age groups, genders, or
regions to see if you can find any outliers.
Looking at the pie charts, we notice we have a pretty even split in our active employees by gender and age
groups. Select different age groups to see the gender split differs by age. Do we have an even split by gender in
every age group?

Let’s look at the report in Editing View. Select Edit report in the upper-left corner.

Change the pie charts to show Separates data instead of Actives.

1. Select the Active Employee Count by Age Group pie chart.
2. In Fields, select the arrow next to Employees to expand the Employees table. Clear the check box next to

Active Employee Count to remove that field.
3. Select the check box next to Separation Count in the Employees table to add it to the Values box in the field

well.
4. Back on the report canvas, select the Voluntary bar in the Separation Count by Separation Reason bar

chart. This highlights those who left voluntarily in the other visuals in the report.



Bad hires

6. You can follow the same steps for the Active Employee Count by Gender pie chart too, changing it to
separations instead of active employees. Look at the voluntary separation data by gender to see if you find any
other insights.

7. Click Power BI in the top navigation bar to return to the dashboard. You can save the changes you’ve made to
the report or not.

5. Click the 50+ slice of the Separation Count by Age Group pie chart.

Look at the Separations by Reason line chart in the lower-right corner. This chart is filtered to show
voluntary separations.

Notice the trend in the 50+ age group? During the latter part of the year more employees over age 50 are
leaving voluntarily. This would be an area to investigate further with more data.

The last area to explore is bad hires. Bad hires are defined as employees who didn’t last for more than 60 days.
We’re hiring rapidly. Are we hiring good candidates?

1. Select the Bad Hires as % of Actives by Age Group dashboard tile. This opens the report to page 3, “Bad
Hires”.



Asking a question in the Q&A box

2. Select the Northwest check box in the Region slicer on the left and the Male slice in the Bad Hire Count by
Gender donut chart. Look at other charts on the “Bad Hires” page. More male bad hires than females and lot of
Group A bad hires. 

3. Looking at the Bad Hires by Gender donut chart and clicking through the Region slicer we notice that East is
the only region with more female than male bad hires.

4. Select the name of the dashboard from the top navbar to return to the dashboard.

The Q&A question box is where you type a question using natural language. Q&A recognizes the words you type
and figures out where in your dataset to find the answer.

1. Click in the Q&A question box. Notice before you even start typing, the Q&A box contains suggestions:



Next steps: Connect to your data

2. You can pick one of those suggestions, or type: show age group, gender and bad hires SPLY where
region is east.

Notice most of the female bad hires are under 30.

This is a safe environment to play in. You can always choose not to save your changes. If you do save them, you can
always go to Get Data for a new copy of this sample.

We hope this tour has shown how Power BI dashboards, Q&A, and reports can provide insights into human



resources data. Now it is your turn — connect to your own data. With Power BI you can connect to a wide variety of
data sources. Learn more about getting started with Power BI.



Opportunity Analysis sample for Power BI: Take a
tour
1/24/2018 • 5 min to read • Edit Online

Overview of the Opportunity Analysis sample
The Opportunity Analysis Sample contains a dashboard (and associated report) for a software company that has
2 sales channels: direct and partner. The Sales Manager created this dashboard to track opportunities and revenue
by region, deal size, and channel.

The Sales Manager relies on two measures of revenue:

Revenue – this is a salesperson’s estimate of what he believes the revenue will be.
Factored Revenue – this is calculated as Revenue X Probability% and is generally accepted as being a
more-accurate predictor of actual sales revenue. Probability is determined by the deal’s current Sales Stage.

Lead – 10%
Qualify – 20%
Solution – 40%
Proposal – 60%
Finalize – 80%

This sample is part of a series that illustrates how you can use Power BI with business-oriented data, reports and
dashboards. This is real data from obviEnce (www.obvience.com) that has been anonymized.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/sample-opportunity-analysis.md
http://www.obvience.com/


Prerequisites

Get the content pack for this sampleGet the content pack for this sample

Get the .pbix file for this sampleGet the .pbix file for this sample

Get the Excel workbook for this sampleGet the Excel workbook for this sample

What is our dashboard telling us?

Before you can use the sample, you must first download it as a content pack, .pbix file, or Excel workbook.

1. Open the Power BI service (app.powerbi.com) and log in.
2. In the bottom left corner select Get data.

3. On the Get Data page that appears, select the Samples icon.

4. Select the Opportunity Analysis Sample, then choose Connect.

5. Power BI imports the content pack and adds a new dashboard, report, and dataset to your current
workspace. The new content is marked with a yellow asterisk.

Alternatively, you can download the sample as a .pbix file, which is designed for use with Power BI Desktop.

Opportunity Analysis Sample

You can also download just the dataset (Excel workbook) for this sample. The workbook contains Power View
sheets that you can view and modify. To see the raw data select Power Pivot > Manage.

Our Sales Manager has created a dashboard to track those metrics most important to her. When she sees
something interesting, she can select a tile to dig into the data.

1. Company revenue is $2 billion and factored revenue is $461 million.
2. Opportunity count and revenue follow a familiar funnel pattern, with totals decreasing each subsequent stage.
3. Most of our opportunities are in the East region.

http://download.microsoft.com/download/9/1/5/915ABCFA-7125-4D85-A7BD-05645BD95BD8/Opportunity Analysis Sample PBIX.pbix
http://go.microsoft.com/fwlink/?LinkId=529782


Explore the pages in the report
Page 1 of our report is titled “Opportunity Count Overview.”Page 1 of our report is titled “Opportunity Count Overview.”

Page 2 of our report is titled “Revenue Overview.”Page 2 of our report is titled “Revenue Overview.”

4. The large opportunities generate more revenue than the medium or small opportunities.
5. Partner large deals generate more revenue: $8M on average versus $6M for direst sales.

Since the effort to land a deal is the same whether the deal is classified as large, medium, or small; our company
should dig into the data to learn more about large opportunities.

Select the Opportunity Count by Partner Driven and Sales Stage tile to open page 1 of the report.

East is our biggest region in terms of opportunity counts.
On the pie chart, select each region one at a time to filter the page. For each region, partners are pursuing
significantly more large opportunities.
The Opportunity Count by Partner Driven and Opportunity Size column chart clearly shows that most of the
large opportunities are partner-driven and more of the small and medium opportunities are not partner-driven.
Select each Sales Stage in the bar chart in the bottom left to see the difference in regional count and notice that
even though East is our biggest region in terms of counts, in the Solution, Proposal and Finalize stages all 3
regions have comparable counts. This means we close a higher percent of deals in Central and West.

This page takes a similar look at the data but using a revenue perspective instead of count.



Page 3 of our report is titled "Region Stage Counts"Page 3 of our report is titled "Region Stage Counts"

Page 4 of our report is titled “Upcoming Opportunities”Page 4 of our report is titled “Upcoming Opportunities”

East is our biggest region not only in opportunity count but in revenue also.
Filtering by Partner driven (select Yes in the legend in the top right) reveals revenue of $1.5B and $294M.
Compare this to $644B and $166M for non-partner driven revenue.
Average revenue for large accounts is larger (8M) if the opportunity is partner driven as compared to 6M for
non-partner driven business.
For partner driven business, average revenue for large opportunities is almost double that of medium sized
opportunities (4M).
Average revenue for small and medium businesses is comparable for both partner driven and non-partner
driven business.

Clearly our partners are doing a better job selling to customers. It might make sense to funnel more deals through
our partners.

This page looks at similar data but breaks it down by region and stage.

Filtering by East (select East in the pie chart) reveals that the opportunities in the east are split almost equal
between partner driven and non-partner driven.
Large opportunities are most common in the central region, small opportunities are most common in the east
region, and medium opportunities are most common in the west region.

Again, we’re looking at similar factors, but this time from a date/time perspective.



Next steps: Connect to your data

Our CFO uses this page to manage workload. By looking at the revenue opportunities by sales stage and month,
she can plan appropriately.

Average revenue for the Finalize stage is the highest. Closing these deals is a top priority.
Filtering by month (by selecting the month name in the left slicer) shows that January has a high proportion of
large deals in the Finalize stage with factored revenue of $75M. February, on the other hand, has mostly
medium deals in Solution and Proposal stage.
In general, the factored revenue numbers fluctuate based on sales stage, number of opportunities, and deal size.
Add filters (using the filter pane on the right) for these factors to discover further insights.

This is a safe environment to play in. You can always choose not to save your changes. But if you do save them, you
can always go to Get Data for a new copy of this sample.

We hope this tour has shown how Power BI dashboards, Q&A, and reports can provide insights into opportunity
tracking data. Now it’s your turn — connect to your own data. With Power BI you can connect to a wide variety of
data sources. Learn more about getting started with Power BI.

Download samples



Procurement Analysis sample for Power BI: Take a
tour
1/24/2018 • 4 min to read • Edit Online

Overview of the Procurement Analysis sample

Prerequisites

Get the content pack for this sampleGet the content pack for this sample

This industry sample dashboard and underlying report analyze a manufacturing company’s spending on vendors
by category and location. In the sample, we explore these areas:

Who the top vendors are
What categories we spend most on
Which vendors give us the highest discount and when

This sample is part of a series that illustrates how you can use Power BI with business-oriented data, reports and
dashboards. This is real data from obviEnce (www.obvience.com) that has been anonymized.

Before you can use the sample, you must first download it as a content pack, .pbix file, or Excel workbook.

1. Open the Power BI service (app.powerbi.com) and log in.
2. In the bottom left corner select Get data.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/sample-procurement.md
http://www.obvience.com/


Get the .pbix file for this sampleGet the .pbix file for this sample

Get the Excel workbook for this sampleGet the Excel workbook for this sample

Spending trends

3. On the Get Data page that appears, select the Samples icon.

4. Select the Procurement Analysis Sample, then choose Connect.

5. Power BI imports the content pack and adds a new dashboard, report, and dataset to your current
workspace. The new content is marked with a yellow asterisk.

Alternatively, you can download the sample as a .pbix file, which is designed for use with Power BI Desktop.

Procurement Analysis Sample

You can also download just the dataset (Excel workbook) for this sample. The workbook contains Power View
sheets that you can view and modify. To see the raw data select Power Pivot > Manage.

Let’s first look for trends in spending by category and location.

1. From your workspace, open the Dashboards tab and select the Procurement Analysis dashboard.
2. Select the dashboard tile Total Invoice by Country/Region. It opens to the "Spend Overview" page of the

“Procurement Analysis Sample” report.

http://download.microsoft.com/download/D/5/3/D5390069-F723-413B-8D27-5888500516EB/Procurement Analysis Sample PBIX.pbix
http://go.microsoft.com/fwlink/?LinkId=529784


Spending in Mexico

Notice a few things:

In the Total Invoice by Month and Category line chart: The Direct category has pretty consistent spending,
Logistics has a peak in December, and Other has a spike in February.
In the Total Invoice by Country/Region map: Most of our spending is in the USA.
In the Total Invoice by Sub Category column chart: Hardware and Indirect Goods & Services are the
biggest spend categories.
In the Total Invoice by Tier bar chart: Most of our business is done with our Tier 1 (top 10) vendors. This helps
in managing vendor relationships better.

Let’s explore the spending areas in Mexico.

1. In the pie chart, select the Mexico bubble in the map. Notice that in the “Total Invoice by Sub Category”
column chart, most of it is in the Indirect Goods & Services sub category.

2. Drill down into the Indirect Goods & Services column:

Select the drill-down arrow  in the upper-right corner of the chart.
Select the Indirect Goods & Services column.



Evaluate different cities

Vendor discounts

3. Select the up arrow on the upper-left corner of the chart to drill back up .
4. Select the arrow again to turn drill down off.
5. Select Power BI in the top navigation bar to return to your workspace.

By far the biggest spend in this category overall is Sales & Marketing.

Select Mexico in the map again.

The biggest spend in this category in Mexico is Maintenance & Repair.

We can use highlighting to evaluate different cities.

1. Select the dashboard tile Total Invoice, Discount % By Month. The report opens to the “Discount Analysis”
page.

2. Select the different cities in the Total Invoice by City treemap, to see how they compare. Almost all of
Miami’s invoices are from Tier 1 vendors.



Discount by monthDiscount by month

Discount by cityDiscount by city

Let’s also explore the discounts available from vendors, and the time periods when we get most discounts.

Specifically, these questions:

Are discounts different month by month, or are discounts the same every month?
Do some cities get more discounts than others?

Looking at the Total Invoice and Discount % by Month combo chart, we see that February is the busiest
month, and September the least busy month. Now look at the discount percent during these months. Note that
when volume goes up, the discount shrinks, and when volume is low, the discount goes up. The more we need the
discount, the worse deal we get.

Another area to explore is discount by city. Select each city in the treemap and see how the other charts change.

St. Louis, MO had a big spike in total invoice in February and a big dip in discount savings in April.
Mexico City, Mexico has the highest discount % (11.05%) and Atlanta, GA has the smallest (0.08%).



Edit the reportEdit the report

Next steps: Connect to your data

Select Edit report in the upper-left corner and explore in Editing View.

See how the pages are made
Add pages and charts based on the same data
Change the visualization type for a chart – for example, change the treemap to a donut chart
Pin them to your dashboard

This is a safe environment to play in. You can always choose not to save your changes. If you do save them, you
can always go to Get Data for a new copy of this sample.

We hope this tour has shown how Power BI dashboards and reports can provide insights into procurement data.
Now it’s your turn — connect to your own data. With Power BI you can connect to a wide variety of data sources.
Learn more about getting started with Power BI.



Retail Analysis sample for Power BI: Take a tour
1/24/2018 • 4 min to read • Edit Online

Prerequisites

Get the content pack for this sampleGet the content pack for this sample

This industry sample dashboard and underlying report analyze retail sales data of items sold across multiple
stores and districts. The metrics compare this year’s performance to last year’s in these areas: sales, units, gross
margin, and variance, as well as new store analysis. This is real data from obviEnce (www.obvience.com) that has
been anonymized.

Before you can use the sample, you must first download it as a content pack, .pbix file, or Excel workbook.

1. Open the Power BI service (app.powerbi.com) and log in.
2. In the bottom left corner select Get data.

3. On the Get Data page that appears, select the Samples icon.

4. Select the Retail Analysis Sample, then choose Connect.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/sample-retail-analysis.md
http://www.obvience.com


Get the .pbix file for this sampleGet the .pbix file for this sample

Get the Excel workbook for this sampleGet the Excel workbook for this sample

Start on the dashboard and open the report

5. Power BI imports the content pack and adds a new dashboard, report, and dataset to your current
workspace. The new content is marked with a yellow asterisk.

Alternatively, you can download the sample as a .pbix file, which is designed for use with Power BI Desktop.

Retail Analysis Sample

You can also download just the dataset (Excel workbook) for this sample. The workbook contains Power View
sheets that you can view and modify. To see the raw data select Power Pivot > Manage.

1. On the dashboard, select the "Total Stores" tile:

This takes you to the "Store Sales Overview" page in the report. You see we have 104 total stores, 10 of
them new. We have two chains, Fashions Direct and Lindseys. Fashions Direct stores are larger on average.

2. In the pie chart, select Fashions Direct.

http://download.microsoft.com/download/9/6/D/96DDC2FF-2568-491D-AAFA-AFDD6F763AE3/Retail Analysis Sample PBIX.pbix
http://go.microsoft.com/fwlink/?LinkId=529778


3. Select individual bubbles or other charts to see cross highlighting, revealing the impact of your selections.

Notice the result in the bubble chart:

FD-01 district has the highest Average Sales per Square Foot, FD-02 has the lowest Variance in Sales
compared to last year, FD-03 and FD-04 are worst performers overall.

4. To return to the dashboard, select its name from the top navbar (breadcrumbs).

5. On the dashboard, select the tile that has "This Year’s Sales."

This is equivalent to typing "This year sales" in the question box.

You see this screen:



Review a tile created with Power BI Q&A
Let’s get more specific.

1. Add “this year sales by district” onto the question. Observe the result: It automatically put the answer in a
bar chart and suggests other phrases:



Dive deeper into the data

3. Play around with more questions and see what kind of results you get.
4. When you’re ready, return to the dashboard.

2. Now change the question to “this year sales by zip and chain”.

Notice how it answers the question as you type with the appropriate charts.

Now let's explore on a more detailed level, looking at the districts' performances.

1. On the dashboard, select the tile comparing this year's sales to last year’s.



Notice the large variability on Variance % to last year, with Jan, Apr, and Jul being particularly bad months.

Let’s see if we can narrow down where the issues might be.

2. Select the bubble chart, and choose 020-Mens.

Observe the men's category wasn't as severely affected in April as the business overall, but January and
July were still problem months.

3. Now, select the 010-Womens’ bubble.



Try out the slicer

4. Select the bubble again to clear the filter.

Notice the women's category performed much worse than business overall across all months, and much
worse in almost every month compared to the previous year.

Let’s look at how specific districts are doing.

1. Select Allan Guinot in the slicer on the top left.

Note that Allan’s district outperformed Last Year in March and June.

2. Now, while Allan is still selected, select the Women’s bubble.



What is our data telling us about sales growth this year?

3. Explore the other district managers and categories – what other insights can you find?
4. When you are ready – return to the dashboard.

Note that for the Women’s category, his district never met last year’s volume.

The last area we want to explore is our growth – new stores opened this year.

1. Select the 'Stores Opened This Year’ tile.

As evident from the tile – more Fashions Direct stores than Lindseys stores opened this year.

2. Observe the 'Sales Per Sq Ft by Name' chart:

There is quite a bit of difference in Average Sales per SQF across the new stores.

3. Click on the Fashions Direct legend item in the top right chart. Notice, even for the same chain, the best



Connect to your data

Next steps

4. Click Winchester Fashions Direct in the slicer and observe the line chart. The first sales numbers were reported
in February.

5. Click on Cincinnati 2 Fashions Direct in the slicer and you will see in the line chart that it was opened in June
and it seems to be the worst performing store.

6. As before, explore by clicking on other bars, lines and bubbles throughout the charts and see what insights you
can discover.

store (Winchester Fashions Direct) significantly outperforms the worst store (Cincinnati 2 Fashions Direct)
$21.22 vs $12.86 respectively.

This is a safe environment to play in. You can always choose not to save your changes. But if you do save them,
you can always go to Get Data for a new copy of this sample.

We hope this tour has shown how Power BI dashboards, Q&A, and reports can provide insights into retail data.
Now it’s your turn — connect to your own data. With Power BI you can connect to a wide variety of data sources.
Learn more about getting started with Power BI.

Download the Retail Analysis sample content pack
Download the Excel workbook for this Power BI sample
Get data (for Power BI)
Power BI - Basic Concepts
More questions? Try the Power BI Community

http://go.microsoft.com/fwlink/?LinkId=529778
http://community.powerbi.com/


Favorite dashboards, reports, and apps in Power BI
service
1/10/2018 • 1 min to read • Edit Online

NOTENOTE

Add a dashboard or report as a favorite

When you make content a favorite, you'll be able to access it from all of your workspaces. Favorites are typically
the content that you visit most often.

This topic applies to Power BI service, and not to Power BI Desktop.

You can also select a single dashboard as a featured dashboard in Power BI service.

Watch Amanda add favorites to her workspace, then follow the step-by-step instructions below the video to try it
out yourself.

1. Open a dashboard or report that you use often. Even content that has been shared with you can be a favorite.

2. From the upper right corner of Power BI service, select Favorite or the star  icon.

You can also favorite a dashboard or report from your workspace Dashboards or Reports content view
tab.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-dashboard-favorite.md


Add an app as a favorite

Working with favorites

1. From the left navpane, select Apps.

2. Hover over an app to display more detail. Select the star  icon to set as a favorite.

1. To acccess your favorites, from any workspace, select the flyout arrow to the right of Favorites. From here
you can select a favorite to open it. Only five favorites are listed (alphabetically). If you have more than five,
select See all to open the favorites screen (see #2, below).

2. To see all the content that you have added as favorites, in the left navpane, select Favorites or the

Favorites  icon.



Unfavorite content

Next steps

From here you can take action: open, identify owners, and even share with your colleagues.

No longer use a report as often as you used to? You can unfavorite it. When you unfavorite content, it is removed
from your Favorites list but not from Power BI.

2. Select the yellow star next to the content to unfavorite.

1. In the left navigation pane, select Favorites to open the Favorites screen.

NOTE: You can also unfavorite a dashboard, report, or app itself. Just open and de-select the yellow icon.

Get Started with Power BI

Power BI - Basic Concepts

More questions? Try the Power BI Community

http://community.powerbi.com/


Printing from Power BI service
12/7/2017 • 2 min to read • Edit Online

NOTENOTE

Print a dashboard

Print an entire dashboard, a dashboard tile, a report page, or a report visual from Power BI service. Reports can
only be printed one page at a time -- you can't print the entire report at once.

Printing is only available in Power BI service and not Power BI Desktop.

Watch Amanda print from her dashboard and report. Then follow the step-by-step instructions below the video to
try it out yourself.

1. Open the dashboard that you'd like to print.

NOTENOTE

2. In the top right corner, select the ellipses (...) and choose Print dashboard.

3. The Print window for your browser opens. Choose the settings and print destination, and select Print.

The print dialog you see will depend on which browser you are using.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-print.md


Print a dashboard tile

Print a report page

2. Open the tile in full screen mode by selecting the full screen icon  from the top navbar.

NOTENOTE

1. Open the tile in Focus mode by selecting the ellipses and choosing the Focus icon .

3. Hover over the tile to reveal the Options menu.

4. Select the Print icon  .

The print dialog you see will depend on which browser you are using.

Reports can be printed one page at a time.

1. Open the report in either Reading View or Editing View.
2. Select File > Print to print the current report page.



Print a report visual

Considerations and troubleshooting

Next steps

NOTENOTE

3. The Print window for your browser opens.

The print dialog you see will depend on which browser you are using.

1. Open the visual in Focus mode by hovering over the tile and selecting the Focus icon  from the top-right
corner.

2. Follow steps 2-3 under Print a report page above.

Q: I cannot find the Print button.
A: If you are using Power BI Desktop, printing is not supported. Printing only works in Power BI service.
Q: I cannot print all the report pages at once.
A: That is correct. Report pages can only be printed one page at a time.
Q: I cannot print to PDF.
A: You will only see this option if you've already configured the PDF driver in your browser.
Q: What I see when I select Print doesn't match what you're showing me here.
A: The Print screens vary by browser and software version.
Q: My printout isn't scaled correctly. My dashboard doesn't fit on the page. Other scaling and orientation
questions.
A: We cannot guarantee that the printed copy will be exactly the same as it appears in Power BI service. Things
like scaling, margins, visual details, orientation, and size are not controlled by Power BI. For help with issues like
this, refer to the documentation for your specific browser.

Share dashboards and reports with colleagues and others

More questions? Try the Power BI Community

http://community.powerbi.com/


RecentRecent content in Power BI service
12/7/2017 • 1 min to read • Edit Online

What is recent content

Display recent content

Recent content is the last items you visited, up to a maximum of 20 items. These include: dashboards, reports, apps,
and workbooks across all of your workspaces.

Watch Amanda demonstrate how Recent content lists are populated, then follow the step-by-step instructions
below the video to try it out yourself.

To see your five most-recently visited items, from the left navigation, select the arrow to the right of Recent. From
here you can select recent content to open it. Only the five most-recent items are listed.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-recent.md


Next steps

If you have more than five recently-visited items, select See all to open the Recent screen (see below). You can also
select Recent, or the Recent  icon, from the left nav.

From here you can interact with the content as you would on the individual Dashboards, Reports, and
Workbooks tabs, and on the Apps screen.

Power BI service Apps

More questions? Try the Power BI Community

http://community.powerbi.com/


Subscribe to a Power BI report or dashboard
1/25/2018 • 6 min to read • Edit Online

NOTENOTE

Requirements

Subscribe to a dashboard

It's never been easier to stay up-to-date on your most important dashboards and reports. Subscribe to report
pages and dashboards that matter most to you, and Power BI will email a snapshot to your inbox. You tell Power BI
how often you want to receive the emails: from once a day to once a week. The email and snapshot will use the
language set in Power BI Settings. If no language is defined, Power BI uses the current browser language.

To see or set your language preference, select the cog icon  > Settings > General > Language.

Subscriptions can only be created in Power BI service. When you receive the email it will include a link to "go to
report/dashboard". On mobile devices with Power BI apps installed, selecting this link launches the app (as opposed to the
default action of opening the report or dashboard on the Power BI website).

Watch Sirui set up an email subscription for a report. Then follow the step-by-step instructions below the video to
try it out yourself.

Creating a subscription is a Power BI Pro feature and you must have view or edit permissions to the content
(dashboard or report).

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-report-subscribe.md


1. Open the dashboard.

2. From the top menubar, select Subscribe or select the envelope icon .

3. Use the yellow slider to turn the subscription on and off. Setting the slider to Off will not delete the
subscription. To delete the subscription, select the trashcan icon.

4. Select Save and close to save the subscription. You will receive an email snapshot of the dashboard each
time any of the underlying datasets change. If the dashboard refreshes more than once a day, you will only
receive the email snapshot after the first refresh.



Subscribe to a report page

TIPTIP
Want to see the email right away? Trigger an email by refreshing one of the datasets associated with the dashboard.
(If you don't have edit permissions to the dataset, you will have to ask someone who has those permissions to do
this for you.) To find out which datasets are being used to create the dashboard, from the dashboard, select the

View related icon  to open Related content and then select the refresh icon .

1. Open the report in Reading view.
2. From the top menubar, select Subscribe.



3. You can subscribe to one report page at a time. Select the particular report page from the dropdown.

Continue to add report pages.

4. Use the yellow slider to turn the subscription for each page on and off. Setting the slider to Off will not
delete the subscription. To delete the subscription, select the trashcan icon.

5. Select Save and close to save the subscription. You will receive an email snapshot of each report page
when the report is refreshed. If the report doesn't refresh, you will not receive a snapshot email that day. If
the report refreshes more than once a day, you will only receive the email snapshot after the first refresh.



How the email schedule for reports is determined

DIRECTQUERY LIVE CONNECT
SCHEDULED REFRESH
(IMPORT)

EXCEL FILE IN
ONEDRIVE/SHAREPOIN
T ONLINE

How often does the
report/dashboard
get refreshed?

Every 15m Power BI checks every
15 minutes, and if the
dataset has changed,
the report is
refreshed.

User selects none,
daily, or weekly. Daily
can be up to 8 times
a day. Weekly is
actually a weekly
schedule that the user
creates and sets
refresh for as few as
once a week and as
often as daily.

Once every hour

How much control
does the user have
over the
subscription email
schedule?

Options are: daily or
weekly

No options: users is
sent an email if the
report refreshes, but
no more than once
per day.

If the refresh schedule
is daily, options are
daily and weekly. If
the refresh schedule is
weekly only option is
weekly.

No options: user is
sent an email
whenever the dataset
is updated, but no
more than once per
day.

Manage your subscriptions

TIPTIP
Want to see the email right away? Trigger an email by opening your dataset and selecting Refresh now. If you don’t
have edit permissions to the dataset, you will have to ask someone who has those permissions to do this for you.

The following table describes how frequently you will receive an email. It all depends on the connection method of
the dataset upon which the dashboard or report is based (DirectQuery, Live connection, imported to Power BI, or
Excel file in OneDrive or SharePoint Online) and on the subscription options available and selected (daily, weekly,
or none).

There are 2 paths to the screen for managing your subscriptions. The first is by selecting Manage all
subscriptions from the Subscribe to emails dialog (see step 3 above). The second is by selecting the Power BI
cog icon  from the top menubar and choosing Settings.



Considerations and troubleshooting

The particular subscriptions displayed will depend on which workspace is currently active. To see all of your
subscriptions at once for all workspaces, be sure that My Workspace is active. For help understanding
workspaces, see Workspaces in Power BI.

A subscription will end if the Pro license expires, the dashboard or report is deleted by the owner, the user account
used to create the subscription is deleted.

At the current time, subscribe is not available for dashboards or reports that come from content packs or Power
BI apps. But there is a workaround...make a copy of the report/dashboard and add subscriptions to that version
instead.
Report page subscriptions are tied to the name of the report page. If you subscribe to a report page, and
rename it, you will have to re-create your subscription
For email subscriptions on live connection datasets, you will only get emails when the data changes. So, if a
refresh occurs but no data changes, Power BI will not send you an email.
Email subscriptions do not support most custom visuals. The one exception is those custom visuals that have
been certified.
Email subscriptions are sent with the report's default filter and slicer states. Any changes to the defaults that
you make before subscribing will not show up in the email.
E-mail subscriptions are not yet supported on reports pages created by the Power BI Desktop live connect to
service feature.
For dashboards subscriptions specifically, certain types of tiles are not yet supported. These include: streaming
tiles, video tiles, custom web content tiles.
If you share a dashboard with a colleague outside of your tenant, they will not be able to subscribe to the
dashboard or its associated report pages. So if you are aaron@xyz.com, you can share with anyone@ABC.com.



Next steps

But anyone@ABC.com cannot subscribe to the shared content.
Subscriptions may fail on dashboards or reports with extremely large images due to email size limits.
Power BI automatically pauses refresh on datasets associated with dashboards and reports that have not been
visited in more than 2 months. However, if you add a subscription to a dashboard or report, it will not be
paused even if it goes unvisited.
If you are not receiving the subscription emails, ensure that your User Principal Name (UPN) is able to receive
emails. The Power BI team is working on relaxing this requirement, so stay tuned.
Sent reports and dashboards use your Power BI language setting. The default language is English. To see or set
your language preference, select the cog icon  > Settings > General > Language.

More questions? Try asking the Power BI Community
Read the blog post

https://community.powerbi.com/t5/Issues/No-Mail-from-Cloud-Service/idc-p/205918#M10163
http://community.powerbi.com/
https://powerbi.microsoft.com/blog/introducing-dashboard-email-subscriptions-a-360-degree-view-of-your-business-in-your-inbox-every-day/


Rename almost anything in Power BI service
12/20/2017 • 2 min to read • Edit Online

CONTENT TYPE I'M THE AUTHOR OR CREATOR SHARED WITH ME

Dashboard in a workspace Yes No

Report in a workspace Yes No

Workbook in a workspace Yes No

Dataset in a workspace Yes No

App workspace Yes, if you are the owner or have
Admin permissions

No

Published apps Not from the App screen, but the app
name can be changed from the app
workspace and re-published with a new
name if you have Admin permissions

No

App content (dashboard, report,
workbook, dataset)

Not from the App screen, but the app's
content can be renamed from the app
workspace and re-published with a new
name if you have Admin permissions

No

Content in Shared with me No No

Rename a dashboard, report, or workbook

This article teaches you how to rename a dashboard, report, report page, workbook, dataset, app, and workspace
in Power BI service.

Can I change the name?

1. Start in a workspace and select the Dashboards, Reports, or Workbooks tab. Hover over the item to

rename, and select the gear icon . If there is no gear icon, you do not have permissions to rename.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-rename.md


Rename a dataset

2. On the Settings page, type the new name and select Save.

1. Start in a workspace and select the Datasets tab.



Rename an App workspace

NOTENOTE

2. Hover over the item to rename, select the ellipses (...), and choose Rename.

The options in the dropdown will vary.

3. On the Settings page, type a new name and select Save.

Anyone with Admin permissions can rename an app workspace.

1. Start in the workspace you'd like to rename.
2. In the top-right corner, select the ellipses (...) and choose Edit workspace. If you don't see this option, then

you don't have permissions to rename this workspace.



Rename a page in a report

Considerations and troubleshooting

3. Type a new workspace name and select Save.

Don't like the name of a page in your Power BI report? A new name is just a click away. Pages can be renamed in
report Editing view .

1. Open the report in Editing View.

3. Open the report page that you'd like to rename by selecting the tab.

2. Locate the report page tabs at the bottom of the Power BI window.

4. Double-click the name on the tab to highlight it.

5. Type a new report page name and select ENTER.

If the item to be renamed has been shared with you, or is part of a content pack, you won't see the gear icon
and you won't have access to Settings.



On the Datasets tab, if you don't see the ellipses (...), expand your browser window.

More questions? Try the Power BI Community

http://community.powerbi.com/


Full screen mode in Power BI
12/7/2017 • 2 min to read • Edit Online

What is full screen mode?

Dashboards and report pages in full screen mode

Display your content (dashboards, report pages, tiles, and visualizations) without the distraction of menus and
navigation bars. You get an unadulterated, full view of your content at a glance, all the time. This is sometimes
referred to as TV Mode. The functionality available in full screen mode varies by content.

Some uses for full screen mode are:

presenting your dashboard, tile, visual, or report at a meeting or conference
displaying in an office on a dedicated large screen or projector
viewing on a small screen
reviewing in locked mode -- you can touch the screen or mouse over tiles without opening the underlying
report or dashboard

NOTE: Full screen mode is different from Focus (pop out) mode.

Watch Amanda open and navigate her dashboard in full screen mode and then apply some URL parameters to
control the default display. Then follow the step-by-step instructions below the video to try it out yourself.

1. From the Power BI menu bar above your dashboard or report, select the full screen icon  . Your
dashboard canvas or report page fills the entire screen. The example below is a dashboard.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-fullscreen-mode.md


2. In full screen mode, you have several menu options. To reveal the menu, just move your mouse or cursor.

Menu for dashboards

Menu for report pages

Use the Back button to navigate to the previous page in your browser. If the previous page was a Power BI
page, it too will display in full screen mode. Full screen mode will persist until you exit out.

Use this button to print your dashboard or report page in full screen mode.

Use the Fit to screen button to display your dashboard at the largest size possible without resorting to
scrollbars.

Sometimes you don't care about scrollbars, but want the dashboard to fill the entire width of the available
space. Select the Fit to width button.



Visualizations and dashboard tiles in full screen mode

In full screen reports, use these arrows to move between the pages in the report.

3. To exit full screen mode, select the Exit full screen icon.

1. To display dashboard tiles and report visualizations in full screen mode, you must start with that tile or
visualization already in Focus mode.

2. Then, select the Full screen icon  for that tile or visual. The tile or visual will display full screen without
menus or navigation bars.



Next steps
Dashboards in Power BI
Focus mode

More questions? Try the Power BI Community

http://community.powerbi.com/


Delete almost anything in Power BI service
1/10/2018 • 4 min to read • Edit Online

Delete a dashboard

To delete a dashboardTo delete a dashboard

Delete a report

To delete a reportTo delete a report

This article teaches you how to delete a dashboard, report, workbook, dataset, app, visualization, and workspace in
Power BI service.

Dashboards can be removed. Removing the dashboard does not delete the underlying dataset or any reports
associated with that dashboard.

If you are the owner of the dashboard, you can remove it. If you've shared the dashboard with colleagues,
removing the dashboard from your Power BI workspace will remove the dashboard from their Power BI
workspaces.
If a dashboard is shared with you and you no longer want to see it, you can remove it. Removing a dashboard
does not remove it from anyone else's Power BI workspace.
If a dashboard is part of an organizational content pack, the only way to remove it is to remove the associated
dataset.

1. In your workspace, select the Dashboards tab.

2. Locate the dashboard to delete and select the Delete icon .

Don't worry, deleting a report does not delete the dataset that the report is based on. And any visualizations that
you pinned from the report are also safe -- they remain on the dashboard until you delete them individually.

1. In your workspace, select the Reports tab.

2. Locate the report to delete and select the Delete icon .

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-delete.md


Delete a workbook

To delete a workbookTo delete a workbook

Delete a dataset

NOTENOTE

3. Confirm the deletion.

If the report is part of a content pack, you will not be able to delete it using this method. See Remove your
connection to an organizational content pack.

Workooks can be removed. However, removing a workbook also removes all reports and dashboard tiles that
contain data from this workbook.

If the workbook is stored on OneDrive for Business, deleting it from Power BI does not delete it from OneDrive.

1. In your workspace, select the Workbooks tab.

2. Locate the workbook to delete and select the Delete  icon.

3. Confirm the deletion.

Datasets can be deleted. However, deleting a dataset also deletes all reports and dashboard tiles that contain data
from that dataset.



To delete a datasetTo delete a dataset

Delete an app workspace

WARNINGWARNING

To delete an app workspace - if you are an AdminTo delete an app workspace - if you are an Admin

If a dataset is part of one or more organizational content packs, the only way to delete it is to remove it from the
content packs where it's being used, wait for it to be processed, and then try deleting it again.

1. In your workspace, select the Datasets tab.
2. Locate the dataset to delete and select the ellipses (...).

3. From the dropdown, select Delete.

4. Confirm the deletion.

When you create an app workspace, you create an Office 365 group. And when you delete an app workspace you delete
that Office365 group. What this means is that the group will also be deleted from other O365 products like SharePoint and
Microsoft Teams.

As the app workspace author, you can delete it. When you delete it, the associated app is also deleted for all group
members and removed from your AppSource if you had published the app to your entire organization. Deleting
an app workspace is different from leaving an app workspace.

1. From the left nav, select Workspaces



To remove an app workspace from your listTo remove an app workspace from your list

IMPORTANTIMPORTANT

2. Select the ellipses (...) to the right of the workspace to be deleted and choose Edit workspace.

3. In the Edit workspace window, select Delete workspace > Delete.

If you no longer want to be a member of an app workspace, you can leave it and it will be removed from your list.
Leaving a workspace leaves it in place for all other workspace members.

If you are the only Admin for the app workspace, Power BI will not allow you to leave.

1. Start in the app workspace you'd like to remove.
2. In the top-right corner, select the ellipses (...) and choose Leave workspace > Leave.



Delete or remove an App

Remove an app from your app list pageRemove an app from your app list page

Considerations and troubleshooting

NOTENOTE
The options you see in the dropdown depend on whether you are an Admin or Member of that app workspace.

Apps can be easily removed from your apps list page. But only an app Admin can permanently delete an app.

Deleting an app from your app list page does not delete the app for other members.

1. In your left nav, select Apps to open the apps list page.

2. Hover over the app to delete, and select the Delete  icon.

If you remove an app accidentally, you have several options for getting it back. You can ask the app creator
to re-send it, you can find the original email with the link to the app, you can check your Notifications center
to see if the notification for that app is still listed, or you can check your organization's AppSource.

This article covered how to delete the major building blocks of Power BI service. But there are more things that
you can delete in Power BI.

Remove your Featured dashboard
Remove (unfavorite) a dashboard
Delete a report page
Delete a dashboard tile
Delete a report visualization



More questions? Try the Power BI Community

http://community.powerbi.com/


Display a dashboard tile or report visual in focus
mode
12/7/2017 • 1 min to read • Edit Online

What is focus mode?

NOTENOTE

Focus mode for dashboard tiles

Focus mode lets you expand (pop out) a dashboard tile or report visual to see more detail. While in focus mode,
you can view and modify filters that were applied when this visual was created.

Focus is different from full screen mode.

1. Hover over the tile visualization, select the ellipses (...) and choose Open in focus mode 

.

1. The tile opens and fills the entire report canvas.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-focus-mode.md


Focus mode for report visualizations

2. Expand the Filters pane to see all filters applied to this visual.

3. Explore further by modifying the filters and, if you discover something interesting, pin the visual to a
dashboard.

4. Leave focus mode and return to the dashboard by selecting < Exit focus mode (in the top left corner of
the visual).

1. Hover over the report visualization and select the focus mode icon .



2. The visualization opens and fills the entire canvas.

2. Explore further by modifying the filters and, if you discover something interesting, pin the visual to a
dashboard.

1. Expand the Filters pane to see all filters applied to this visual.

3. Leave focus mode and return to the report by selecting Back to report (in the top left corner of the
visual).



Go from focus mode to full screen mode

Considerations and troubleshooting

Once in focus mode, the tile or visual can then be viewed in full screen (TV mode.) Full screen mode displays
without the distraction of menus and navigation buttons.

When using focus mode with a visualization in a report, you'll be able to view and modify all filters: Visual
level, Page level and Report level.
When using focus mode with a visualization on a dashboard, you'll be able to view and modify only the Visual
level filter.

More questions? Try the Power BI Community

http://community.powerbi.com/


Power BI Premium - what is it?
1/30/2018 • 4 min to read • Edit Online

Power BI Premium provides resources dedicated to running the Power BI service for your organization or
team, giving you more dependable performance and larger data volumes. Premium also enables widespread
distribution of content without requiring you to purchase per-user licenses for viewers.

You can take advantage of Power BI Premium by assigning workspaces to a Premium capacity. Premium
capacity is a dedicated resource for your organization. For workspaces that are not assigned to a premium
capacity, these will be in a shared capacity.

Shared capacity is the experience you are used to with Power BI, where your workloads run on computational
resources shared by other customers. In shared capacity, more limits are placed on individual users to ensure
quality of the experience for all users.

1. Items within a Premium capacity

Accessing app workspaces (as members or admins) and publishing apps requires a Power BI Pro
license.
App readers can be Power BI Pro or free users.
Sharing requires a Power BI Pro license but recipients can be Power BI Pro or free users.
Whether they have a Power BI Pro or free license, dashboard recipients can set data alerts.
REST APIs for embedding utilize a service account, with a Power BI Pro license, rather than a user.

2. My workspace in Shared capacity

Sharing requires a Pro license. Recipients also need Pro licenses.
3. App workspaces in Shared capacity

Any app usage requires Pro licenses.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-premium.md


Capacity tiers

SHARED CAPACITY POWER BI PREMIUM CAPACITY

Refresh rate 8/day Not restricted

Isolation with dedicated hardware

Enterprise Distribution to all users

Apps

Embedded API and controls

Publish Power BI reports on-
premises

Premium capacityPremium capacity

There are two types of capacity within Power BI. Shared capacity and Power BI Premium capacity. Here is a
look at what the differences are between them.

1

2

 Free user consumption in apps includes viewing content in web and mobile, using Q&A, Quick Insights,
Cortana, export to CSV, Excel and PowerPoint.
 Future enhancements coming to Power BI Premium post GA.

1

2

To start using a Power BI Premium capacity, you need to assign a workspace to a capacity. For more
information on how to assign a workspace to a premium capacity, see Manage Power BI Premium.

When a workspace is backed by premium capacity, you enjoy the benefits of Power BI Premium.

Scheduled refreshes: users prior were limited to 8x a day when scheduling refreshes with imported
models. This limitation is lifted for datasets in Premium workspaces. This does not apply to the scheduled
cache refresh settings for DirectQuery. Those remain the same between Premium and Shared capacities.
Isolation with dedicated hardware – by nature of shared capacity, the performance of your reports and
dashboards may be impacted by the resource demands of other workloads in the capacity, despite our
safeguards against it. Conversely, Premium provides more consistent, dependable performance for your
workloads by isolating it from unrelated workloads.

If an app is backed by premium capacity (i.e. it was published from an app workspace that is currently



Shared capacityShared capacity

Premium capacity nodesPremium capacity nodes

CAPACITY
NODE

TOTAL CORES
(BACKEND +
FRONTEND)

BACKEND
CORES

FRONTEND
CORES

DIRECTQUERY
/LIVE
CONNECTION
LIMITS

MAX PAGE
RENDERS AT
PEAK HOUR AVAILABILITY

EM1 (month
to month)

1 v-core .5 cores,
2.5GB RAM

.5 cores 3.75 per
second

150-300 Available

EM2 (month
to month)

2 v-cores 1 core, 5GB
RAM

1 core 7.5 per
second

301-600 Available

EM3 (month
to month)

4 v-cores 2 cores,
10GB RAM

2 cores 601-1,200 Available

P1 8 v-cores 4 cores,
25GB RAM

4 cores 30 per
second

1,201-2,400 Available
(month to
month is also
available)

P2 16 v-cores 8 cores,
50GB RAM

8 cores 60 per
second

2,401-4,800 Available

P3 32 v-cores 16 cores,
100GB RAM

16 cores 120 per
second

4,801-9600 Available

Power BI Report Server

assigned to Premium), the published app can then be used by any user in your organization regardless of the
license they are assigned. This means that even Power BI Free users can use those published apps.

By default, your workspace will be in shared capacity. This includes your personal My workspace along with
App workspaces. A Shared capacity is the experience you are used to with Power BI, where your workloads
run on computational resources shared by other customers.

  

Power BI Premium is available in node configurations with different v-core capacities. For more information
about specific SKU offereings and cost, see Power BI pricing. A cost calculator is also available. For information
regarding embedded analytics capacity planning, see Planning a Power BI Enterprise Deployment whitepaper.

P nodes can be used for embedded or service deployments
EM nodes can be used for embedded deployments only
EM1 and EM2
Links in this table only operate properly for users who are Office 365 global admins - others receive a 404
error.

The frontend cores are responsible for the web service, dashboard and report document management,
access rights management, scheduling, APIs, uploads and downloads, and generally for everything that
relates to the user experience.
The backend cores are responsible for the heavy lifting: query processing, cache management, running R
servers, data refresh, natural language processing, real-time feeds, and server-side rendering of reports
and images. With the backend cores, a certain amount of memory is reserved as well. Having sufficient
memory becomes especially important when dealing with large data models or with a large number of
active datasets.

Power BI Premium includes the right to run Power BI Report Server on-premises. For more infomation, see

https://powerbi.microsoft.com/pricing/
https://powerbi.microsoft.com/calculator/
https://aka.ms/pbienterprisedeploy
https://portal.office.com/SubscriptionDetails?OfferId=4004702D-749C-4F74-BF47-3048F1833780&adminportal=1
https://portal.office.com/SubscriptionDetails?OfferId=4004702D-749C-4F74-BF47-3048F1833780&adminportal=1
https://portal.office.com/SubscriptionDetails?OfferId=4004702D-749C-4F74-BF47-3048F1833780&adminportal=1
https://portal.office.com/SubscriptionDetails?OfferId=b3ec5615-cc11-48de-967d-8d79f7cb0af1&adminportal=1
https://portal.office.com/SubscriptionDetails?OfferId=E4C8EDD3-74A1-4D42-A738-C647972FBE81&adminportal=1
https://portal.office.com/SubscriptionDetails?OfferId=062F2AA7-B4BC-4B0E-980F-2072102D8605&adminportal=1
https://portal.office.com/SubscriptionDetails?OfferId=40c7d673-375c-42a1-84ca-f993a524fed0&adminportal=1


Next steps

Get started with Power BI Report Server.

Power BI Premium FAQ
Power BI Premium release notes
How to purchase Power BI Premium
Managing Power BI Premium
Microsoft Power BI Premium whitepaper
Planning a Power BI Enterprise Deployment whitepaper
Administering Power BI in your organization

More questions? Try asking the Power BI Community

https://aka.ms/pbipremiumwhitepaper
https://aka.ms/pbienterprisedeploy
https://community.powerbi.com/


How to purchase Power BI Premium
1/30/2018 • 3 min to read • Edit Online

IMPORTANTIMPORTANT

Create a new tenant with Power BI Premium P1

Learn how to purchase Power BI Premium capacity for your organization.

You can purchase a Power BI Premium capacity node through the Office 365 Admin center. You can also have any
combination of Premium capacity SKUs (P1 through P3) within your organization. They provide different resource
capabilities.

For more information about what Power BI Premium is, see Power BI Premium - what is it?. To see the current
pricing for Power BI, see the Power BI pricing page. You can also plan your costs for Power BI Premium by using
the Power BI Premium calculator.

Authors of content will still need a Power BI Pro license, even if you purchase Power BI Premium.

If you don't have an existing tenant and want to create one, you can purchase Power BI Premium at the same time.
The following link will walk you through the process of creating a new tenant for use with Office 365 and allow
you to purchase Power BI Premium. You will need to purchase a Power BI Pro license for a user after the tenant is
created. When you create your tenant, you will automatically be the Global Admin for that tenant.

To make this purchase, see Power BI Premium P1 offer.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-admin-premium-purchase.md
https://powerbi.microsoft.com/pricing/
https://powerbi.microsoft.com/calculator/
https://signup.microsoft.com/Signup?OfferId=b3ec5615-cc11-48de-967d-8d79f7cb0af1


Purchase a Power BI Premium capacity for an existing organization
If you have an existing organization, you need to be either a Global admin or a Billing admin, to purchase
subscriptions and licenses. For more information, see About Office 365 admin roles.

To purchase a Premium capacity, you will need to do the following.

2. Select Billing > Purchase services.
3. Under Other plans, look for Power BI Premium offerings. This will list as P1 through P3, EM3 and P1 (month

to month).

1. From within the Power BI service, select the Office 365 app picker > Admin. Alternatively, you can
browse to the Office 365 Admin center. You can get there by going to https://portal.office.com and
selecting Admin.

4. Hover over the ellipsis (...) and then select Buy now.

https://support.office.com/article/About-Office-365-admin-roles-da585eea-f576-4f55-a1e0-87090b6aaa9d
https://portal.office.com


DIRECT PURCHASE LINKS

EM3 (month-to-month) SKU

P1 SKU

P1 (month-to-month) SKU

P2 SKU

P3 SKU

5. Follow the steps to complete the purchase.

You can also select the following links to take you directly to the purchase pages of those items. For more
information about these SKUs, see Power BI Premium - what is it?.

In order to pucharse a Power BI Premium SKU, you must be a Global or Billing admin within your tenant.
Selecting the links below will produce an error if you are not an admin.

After you have completed the purchase, the Purchase services screen will show that the item is purchased and
active.

You can now manage this capacity within the Power BI admin center. For more information, see Manage Power BI

https://portal.office.com/commerce/completeorder.aspx?OfferId=4004702D-749C-4F74-BF47-3048F1833780&adminportal=1
https://portal.office.com/commerce/completeorder.aspx?OfferId=b3ec5615-cc11-48de-967d-8d79f7cb0af1&adminportal=1
https://portal.office.com/commerce/completeorder.aspx?OfferId=E4C8EDD3-74A1-4D42-A738-C647972FBE81&adminportal=1
https://portal.office.com/commerce/completeorder.aspx?OfferId=062F2AA7-B4BC-4B0E-980F-2072102D8605&adminportal=1
https://portal.office.com/commerce/completeorder.aspx?OfferId=40c7d673-375c-42a1-84ca-f993a524fed0&adminportal=1


Purchase more capacities

Cancel your subscription

Premium.

When you are in the Premium settings section of the Power BI Admin portal, if you are an admin, you will see a
Purchase more button. This button will take you to the Office 365 portal. Once you are in the Office 365 Admin
center, you can do the following.

1. Select Billing > Purchase services.
2. Find the Power BI Premium item you want to purchase more of under Other plans.

IMPORTANTIMPORTANT

3. Hover over the ellipsis (...) and then select Change license quantity.

4. Change the number of instances that you want to have for this item. Then select Submit when finished.

Selecting Submit will cause charges to be made to the credit card on file.

The Purchase services page will then indicate the number of instances you have. Within the Power BI admin
portal, under Capacity settings, the available v-cores reflects the new capacity purchased.

You can now manage this capacity within the Power BI admin center. For more information, see Manage Power BI
Premium.

You can cancel your subscription from within the Office 365 admin center. To cancel your Premium subscription,
do the following.



Next steps

1. Browse to the Office 365 admin center.
2. Select Billing > Subscriptions.
3. Select your Power BI Premium subscription from the list.

5. The Cancel subscription page will indicate whether or not you are responsible for an early termination fee.
This page will also let you know when the data will be deleted for the subscription.

6. Read through the information, and if you want to proceed, select Cancel subscription.

4. In the More actions dropdown, select Cancel subscription.

Power BI pricing page
Power BI Premium calculator
Power BI Premium - what is it?
Manage Power BI Premium
Power BI Premium FAQ
Power BI Premium release notes
Microsoft Power BI Premium whitepaper

https://support.office.com/article/early-termination-fees-6487d4de-401a-466f-8bc3-c0beb5cc40d3
https://powerbi.microsoft.com/pricing/
https://powerbi.microsoft.com/calculator/
https://aka.ms/pbipremiumwhitepaper


Planning a Power BI Enterprise Deployment whitepaper
Power BI admin portal
Administering Power BI in your Organization

More questions? Try asking the Power BI Community

https://aka.ms/pbienterprisedeploy
http://community.powerbi.com/


Manage capacities within Power BI Premium and
Power BI Embedded
1/30/2018 • 9 min to read • Edit Online

What is capacity?

Learn how you can manage Power BI Premium and Power BI Embedded capacities which provides dedicated
resources for your content.

Capacity is the heard of the Power BI Premium and Power BI Embedded offerings.

Capacity is the set of resources reserved for the exclusive use by you. Having capacity allows you to publish
dashboards, reports, and datasets to users throughout your organization without having to purchase licenses for
them. It also guarantees dependable, consistent performance for the contents hosted in capacity.

Capacity is all transparent to your end users. They will continue to use Power BI or your application as usual. They
don't have to be aware that some (or all) of the content is hosted in your dedicated capacity. For your users,
everything works exactly as before.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-admin-premium-manage.md


 

Purchase capacity

Capacity admins

NOTENOTE

Managing capacity

1. Items within a Premium capacity

Accessing app workspaces (as members or admins) and publishing apps requires a Power BI Pro
license.
App readers can be Power BI Pro or free users.
Sharing requires a Power BI Pro license but recipients can be Power BI Pro or free users.
Whether they have a Power BI Pro or free license, dashboard recipients can set data alerts.
REST APIs for embedding utilize a service account, with a Power BI Pro license, rather than a user.

2. My workspace in Shared capacity

Sharing requires a Pro license. Recipients also need Pro licenses.
3. App workspaces in Shared capacity

Any app usage requires Pro licenses.

For more information, see What is Power BI Premium?.

To take advantage of dedicated capacity, you will need to purchase a subscription for Power BI Premium within
the Office 365 admin center or create a Power BI Embedded resource within the Microsoft Azure portal. For more
information, see the following:

Power BI Premium: How to purchase Power BI Premium
Power BI Embedded: Coming soon.

When you purchase Power BI Premium SKUs, your tenant will receive the corresponding number of v-cores for
use in running capacities. For example, purchasing a Power BI Premium P3 SKU provides the tenant with 32 v-
cores.

Capacity admins, for Power BI Embedded capacity, are defined within the Microsoft Azure portal.

When you are assigned as a capacity admin to a capacity, you have full control over the capacity and its
administrative features. From the Power BI admin portal, you can add more capacity admins (Power BI Premium
only) or give users capacity assignment permissions. You can bulk assign workspaces to a capacity and view
usage metrics on a capacity.

Each capacity has its own admins. Defining a capacity admin to one capacity does not give them access to all
capacities within your organization. Capacity admins do not have access to all Power BI admin areas by default
such as usage metrics, audit logs or tenant settings. Capacities admins also do not have permissions to set up
new capacities or change the SKU of existing capacities. Only Global admins or Power BI service administrators
have access to those items.

All Office 365 Global admins and Power BI admins are automatically capacity admins of both Power BI Premium
capacity and Power BI Embedded capacity.

After you have purchased capacity nodes within Office 365, you will then need to set up a new capacity. This is
done through the Power BI admin portal. Within the admin portal, you will see a section called Capacity settings.



Setting up a new capacity (Power BI Premium)Setting up a new capacity (Power BI Premium)

This is where you will manage Power BI Premium capacities for your organization.

Selecting Capacity settings will take you to the capacity management screen defaulting to Power BI Premium.

The number of v-cores will reflect the amount used and the amount available to create capacities with. The
amount of v-cores available to your organization is based on the Premium SKUs that you have purchased. For
example, purchasing a P3 and a P2 would result in 48 available cores – 32 from the P3 and 16 from the P2.

If you have available v-cores, setup your new capacity by doing the following.

1. Select Set up new capacity.
2. Give your capacity a name.
3. Define who the capacity admin is for this capacity.

Capacity admins do not have to be a Power BI admin or an Office 365 Global admin. For more information,
see Power BI Premium capacity admins

4. Select your capacity size. Available options are dependent on how many available v-cores you have. You
can't select an option that is larger than what you have available.



Capacity settingsCapacity settings

5. Select Set up.

Capacity admins, as well as Power BI admins and Office 365 Global Admins, will then see the capacity listed
within the admin portal.

Within the Premium capacity management screen, you can select the gear icon (settings) under actions. This
will allow you to rename or delete a capacity. It will also indicate who the service admins are, the SKU/size of the
capacity and what region the capacity is in.



NOTENOTE

Change capacity size (Power BI Premium)Change capacity size (Power BI Premium)

Power BI Embedded capacity settings are managed within the Microsoft Azure portal.

Power BI admins and Office 365 Global admins change Power BI Premium capacity size by selecting Change
capacity size. Capacity admins who are not a Power BI admin or Office 365 Global admin will not have this
option.

The Change capacity size screen lets you upgrade or downgrade your capacity size if you have the available
resources. Administrators are free to create, resize and delete nodes, so long as they have the requisite number of
v-cores.

P SKUs cannot be down graded to EM SKUs. You can hover over disabled options which provide an explanation.



Capacity assignmentCapacity assignment

User permissionsUser permissions

NOTENOTE

You can manage a capacity by selecting the name of the capacity. This will take you to the capacity management
screen.

If no workspaces have been assigned to the capacity, you will see a message allowing you to Assign workspaces.

You can assign additional Capacity admins for Power BI Premium capacities. As well as assign users that will
have capacity assignment permissions. Users that have assignment permissions can assign an app workspace
to the capacity if they are an admin of that workspace. They can also assign their personal My Workspace to the
capacity. Users with assignment permissions will not have access to the admin portal.

For Power BI Embedded capacity, capacity admins are assigned within the Microsoft Azure portal.



Usage measurements (Power BI Premium)

METRIC DESCRIPTION

CPU CPU usage of your cores.

Memory Represents the memory pressure of your backend cores.
Specifically, this is a metric of how often models are evicted
from memory due to memory pressure from usage of
multiple models.

DQ/s * We limit the total number of DirectQuery and live
connection queries per second.
* The limits are 30/s for P1, 60/s for P2 and 120/s for P3.
* DirectQuery and live connection queries count equally to
the above throttle. For example, if you have 15 DirectQueries
and 15 live connections in a second, you hit your throttle.
* This applies equally to on-premises and cloud connections.

For each capacity, you will be able to use usage measurements for CPU, memory and Direct Query. Each KPI has
three indications, Good (green), Marginal (yellow) and Critical (red). We suggest monitoring these metrics to
ensure that your users see good performance while using Premium content.

Power BI Embedded capacity usage is monitored within the Azure portal.

When these metrics are marginal/critical, your users may see degradation of report and refresh performance,
especially during peak load times.

Metrics reflect utilization over the past week, and are designed to count instances when the capacity is
overloaded, and is therefore providing less-than-optimal performance for your users.



Assign a workspace to a capacity

Capacity management in admin portalCapacity management in admin portal

App workspace settingsApp workspace settings

Each occurrence of utilization over 80% should be considered a potential case of performance degradation. Too
many cases is a good indicator of significant performance problems for users.

There are a few ways that a workspace could be assigned to a capacity.

Capacity admins, along with Power BI admins and Office 365 global admins, can bulk assign workspaces within
the premium capacity management section of the admin portal. When you manage a capacity, you will see a
Workspaces section that allows you to assign workspaces.

1. Select Assign workspaces. This is listed in multiple places and will all perform the same task.

SELECTION DESCRIPTION

The entire organization's workspaces Assigning the entire organization's workspaces to
Premium capacity will assign all App Workspaces and My
Workspaces, in your organization, to this Premium
capacity. In addition, all current and future users will have
the permission to reassign individual workspaces to this
capacity.

Specific workspaces by user When you assign workspaces by user, or group, all the
workspaces owned by those users are assigned to
Premium capacity, including the user's personal
workspace. Said users automatically get workspace
assignment permissions.
This includes workspaces already assigned to a different
capacity.

3. Select Apply.

2. Select either The entire organization's workspaces or Specific workspaces by user.

This option does not allow you to assign specific workspaces to a capacity.

You can also assign an app workspace to a Premium capacity from the settings of that workspace. To assign an
app workspace to a premium capacity, do the following.

To move a workspace into capacity, you must have admin permissions to that workspace, and also capacity
assignment permissions to that capacity. Notice that workspace admins can always remove a workspace from
Premium capacity.

1. Edit an app workspace by selecting the ellipsis (...) and selecting Edit workspace.



What Premium looks like for users

Power BI Report Server product key)

2. Within Edit workspace, expand Advanced.
3. If you have been given capacity assignment permissions to any capacity, you will have the option to turn

Premium on for this workspace.

5. Select Save.

4. Select the capacity that you want to assign this App workspace to.

Once saved, the workspace, and all its contents, will be moved into Premium capacity without any experience
interruption for end users.

For the most part, users will not even need to know they are in a Premium capacity. Their dashboards and reports
will just work. As a visual hint, you will see a diamond icon next to workspaces that are in a Premium capacity.

Within the Capacity settings tab of the Power BI admin portal, you will have access to your Power BI Report
Server product key. This will only be available for Global Admins or users assigned the Power BI service
administrator role and if you have purchase a Power BI Premium SKU.



Next steps

Selecting Power BI Report Server key will display a dialog contain your product key. You can copy it and use it
with the installation.

For more information, see Install Power BI Report Server.

Share published apps with Free users when you assign the workspace to a Premium capacity. For more
information, see Create and distribute an app in Power BI.

More questions? Try asking the Power BI Community

http://community.powerbi.com/


Power BI Premium support for large datasets
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Best practices

SKU SIZE OF .PBIX

P1 < 3 GB

P2 < 6 GB

P3 up to 10 GB

Next steps

Power BI Premium supports uploads of Power BI Desktop (.pbix) files that are up to 10 GB in size. To use a large
dataset, publish it to a workspace that is assigned to Premium capacity.

This section describes best practices for working with large datasets.

Large models can be very resource-intensive on your capacity; we recommend at least a P1 SKU for any
models larger than 1 GB. The following table describes recommended SKUs for various .pbix sizes:

Your .pbix files represent data in a highly compressed state. The data will likely expand several times when
loaded in memory, and from there it may expand several more times during data refresh.

Scheduled refresh of large datasets can take a long time and be very resource-intensive. Accordingly, do not
schedule too many overlapping refreshes. Notice also that the timeout for scheduled refresh jobs has been doubled
to four hours for all datasets in this capacity.

The initial report load of large datasets can take a long time if it has been a while since the last time the
dataset was used, because the model is loaded into memory of your Premium capacity. A loading bar for longer-
loading reports displays the load progress.

If you remove the workspace from Premium capacity, the model and all associated reports and dashboards
will not work.

While the per-query memory and time constraints are much higher in Premium capacity, it is highly
recommended you use filters and slicers to limit visuals to display only what is necessary.

Power BI Premium - what is it?
Power BI Premium release notes
Microsoft Power BI Premium whitepaper
Planning a Power BI Enterprise Deployment whitepaper
Extended Pro Trial activation

More questions? Try asking the Power BI Community

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-premium-large-datasets.md
https://aka.ms/pbipremiumwhitepaper
https://aka.ms/pbienterprisedeploy
https://community.powerbi.com/
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Power BI Premium

Browse a list of frequently asked questions and answers about the Power BI Premium offering.

If you have other questions, try asking the Power BI Community.
Still have an issue? Please visit the Power BI support page.

Or click the Contact Me icon  in the lower-right corner of this browser window.

What is Power BI Premium?
Power BI Premium is a new capacity-based offering that includes:

Flexibility to publish reports broadly across an enterprise, without requiring recipients to be licensed
individually per user.
Greater scale and performance from dedicated capacity in the Power BI service.
The ability to maintain BI assets on-premises with Power BI Report Server.
One API surface, a consistent set of capabilities and access to the latest features for embedded analytics.

What does Power BI Premium do? How does it work?
Power BI Premium consists of capacity in the Power BI service exclusively allocated to each organization and
supported by dedicated hardware fully managed by Microsoft. Organizations can choose to apply their dedicated
capacity broadly, or allocate it to assigned workspaces based on the number of users, workload needs or other
factors—and scale up or down as requirements change.

How is Power BI Pro different than Power BI Premium? Why is Power BI Premium necessary?
Power BI Premium is a capacity-based license, while Power BI Pro is a user-based license.

Power BI Premium consists of capacity in the Power BI service exclusively allocated to each organization and
supported by dedicated hardware fully managed by Microsoft—removing restrictions on dataset sizes and refresh
rates, and supporting isolation due to the dedicated hardware. Power BI Premium also provides the flexibility to
publish reports broadly across an enterprise, without requiring recipients to be licensed individually per user.

Power BI Pro is for those users publishing reports, sharing dashboards, collaborating with colleagues in
workspaces and engaging in other related activities – such as the ability to:

Edit and save customized views
Create personal dashboards (pin to new dashboard)
Analyze data in Excel or Power BI Desktop
Share with Excel Web App support
Share dashboards and collaborate with Office 365 Groups
Integrate content with Microsoft Teams

Do I need Power BI Pro to use Power BI Premium?
Yes. Power BI Pro is required to publish reports, share dashboards, collaborate with colleagues in workspaces and
engage in other related activities.

How much will Power BI Premium cost? How many SKUs will you make available?
Power BI Premium can be purchased based on the number of virtual cores. You can see prices at the Power BI
pricing page. For more information on nodes and v-cores, see the Microsoft Power BI Premium whitepaper. Also

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-premium-faq.md
http://community.powerbi.com/
https://powerbi.microsoft.com/support/
https://powerbi.microsoft.com/pricing/
https://aka.ms/pbipremiumwhitepaper


SCENARIO 1 SCENARIO 2 SCENARIO 3 SCENARIO 4

An organization /
department wants every
employee to have self-
service BI and collaborate
with each other – sharing
dashboards, performing ad
hoc analysis, and publishing
reports

An organization /
department has a
combination of users who
require self-service BI and
collaboration as well as users
who only need to consume
BI content

An organization /
department has users who
require self-service BI and
collaboration as well as the
requirement to keep reports
on-premises

A finance department is
actively working to analyze
several large datasets in
advance of an earnings
announcement and requires
unthrottled and isolated
capacity to manage the
workloads

use this calculator to get an estimate of how much Premium capacity you may need.

What do you mean by "capacity"?
"Capacity" refers to a named capacity provisioned by an admin through the Power BI Premium capacity admin
portal. A capacity is a grouping of one or more nodes. See the Microsoft Power BI Premium whitepaper for more
information.

How is Power BI Premium billed?
Power BI Premium is billed monthly with an annual commitment.

How will I buy Power BI Premium?
Power BI Premium is available as an add-on to Power BI Pro in the O365 admin center. For more information, see
How to purchase Power BI Premium. You can also contact your Microsoft representative for more information.

How do I know how much Power BI Premium capacity I need to purchase?
Use this cost calculator to estimate how much Power BI Premium capacity you may need.

When will Power BI Premium be available? Will it be available simultaneously across all geographies?
Power BI Premium will be generally available in late Q2 of 2017 for all geographies currently supported by the
Power BI service.

Will Power BI Premium meet certification and regulatory compliance at the time of release? What
about national clouds?
Power BI Premium will be generally available in late Q2 of 2017 for all geographies currently supported by the
Power BI service. National clouds—specifically Germany, China and the U.S. government—are planned to be
available in Q3 of 2017. Power BI’s certification and regulatory compliance standards will apply to Power BI
Premium at the time of general availability.

Is Power BI Premium available with Office 365 E5?
Power BI Premium is available as an add-on to Power BI Pro. Office 365 E5 includes Power BI Pro. E5 customers
can purchase Premium as an add-on to their existing Pro licenses.

Can you outline a scenario of how Power BI Pro and Power BI Premium work to cover an organization
for Modern BI?
The follow examples outline how customers can meet their BI needs using a combination of Power BI Pro + Power
BI Premium.

https://powerbi.microsoft.com/calculator/
https://aka.ms/pbipremiumwhitepaper
https://powerbi.microsoft.com/calculator/


Solution:

1. Power BI Pro for every
user

2. Look to expand the
opportunity adding Power
BI Premium – see the
additional scenarios

Solution:

1. Power BI Pro for users
requiring self-service BI and
collaboration

2. Add Power BI Premium to
be able to distribute BI
content to users who only
need to consume

Solution:

1. Power BI Pro for users
requiring self-service BI and
collaboration

2. Add Power BI Premium to
be able to publish reports
on-premises – and move to
the cloud at their own pace

Solution:

1. Power BI Pro for every
user in the finance
department

2. Add Power BI Premium
for the dedicated resources
– in the cloud – to be used
exclusively by the finance
team providing larger scale
and greater performance

SCENARIO 1 SCENARIO 2 SCENARIO 3 SCENARIO 4

What is Power BI Report Server? Does this mean you’re making Power BI available on-premises?
Power BI Report Server is available as part of Power BI Premium and compatible with SQL Server Reporting
Services reports, allowing the deployment and distribution of interactive Power BI reports, and paginated reports,
on-premises within the boundaries of an organization’s firewall. Organizations can choose Power BI in the cloud,
or elect to keep reports on-premises with Power BI Report Server and move to the cloud at their pace.

Power BI capabilities such as real-time dashboards, natural language query, and others in the Power BI service are
not available as part of Power BI Report Server.

For more information about Power BI Report Server, see Get started with Power BI Report Server.

Is Power BI Report Server the feature Microsoft made available as the Power BI Reports for SSRS
technical preview? Why is this now part of Power BI when it appeared to be a feature of SQL?
Power BI Report Server is available as part of Power BI Premium and compatible with SQL Server Reporting
Services reports, allowing the deployment and distribution of interactive Power BI reports, and paginated reports,
on-premises within the boundaries of an organization’s firewall.

The announcement of Power BI Premium is the first time we’ve disclosed how this functionality will be brought to
market.

For more information about Power BI Report Server, see Get started with Power BI Report Server.

What are Power BI Apps?
We are evolving content packs into Power BI apps to improve how users discover and explore insights at
enterprise scale. Available today, Power BI apps offer a simplified way of deploying dashboards and reports to
specific people, groups or an entire organization. Business users can easily install these apps and navigate them
with ease, centralizing content in one place and updating automatically.

For more information about Apps, see What are apps in Power BI?.

Are you making changes to Power BI Pro, Power BI Free, Power BI Desktop, et al. as part of the Power BI
Premium rollout?
Today we’re also simplifying the distinction between Power BI Pro and the free service. We’ve received feedback
that while the free service is intended for personal use and Power BI Pro enables collaboration, functional
differences between them have created confusion for users. Going forward, we will improve the free service to
have the same functionality as Power BI Pro, but will limit sharing and collaboration features to only Power BI Pro
users.

Users of the free Power BI service will benefit from access to all data sources, increased workspace storage limits,
and higher refresh and streaming rates. These changes will be effective June 1, 2017, and you can read more at
Self-service sign up for Power BI. Power BI Desktop remains available for free.

For information regarding the Extended Pro Trial offering, see Extended Pro Trial activation.



Power BI Free

Power BI Pro

What capabilities are being added to the free service?
Beginning June 1, 2017, the free service will have capabilities equivalent to Power BI Pro, except for sharing,
enterprise distribution, and collaboration. This includes the same 10 GB workspace limit, up to 8 daily scheduled
refreshes for datasets, and maximum 1M/hour streaming data rate. We’re also including access to all data sources,
including those available through the on-premises data gateway.

Which Power BI Pro capabilities are not available with the free service?
Peer-to-peer dashboard sharing, app workspaces (previously referred to as group workspaces), Analyze in Excel
and Power BI Apps (unless backed by Premium capacity) are capabilities limited to Power BI Pro.

When will these changes go into effect?
Changes to the free service will go into effect on June 1, 2017.

How will impacted users of the free service be notified of these changes?
Active users of the free service impacted by the changes on June 1, 2017 will receive an email communication
from Microsoft, as well as notifications when they sign into the Power BI service beginning May 3, 2017.

Existing users of the free service who have been active within the past year can take advantage of the free, 12-
month extended trial of Power BI Pro. The offer will deliver the full capabilities of Power BI Pro to ensure users
have the appropriate time to adjust how you use the service. For information regarding the Extended Pro Trial
offering, see Extended Pro Trial activation.

Will users lose access to their content (dashboards, reports) at that time?
No. They will not lose access to any content they’ve uploaded to the Power BI service. Content shared with others
may no longer be accessible by recipients on June 1, 2017. Likewise, at that time they may no longer have access
to content others have shared with them.

Existing users of the free service who have been active within the past year can take advantage of the free, 12-
month extended trial of Power BI Pro. The offer will deliver the full capabilities of Power BI Pro to ensure users
have the appropriate time to adjust how you use the service. For information regarding the Extended Pro Trial
offering, see Extended Pro Trial activation.

How do users know if they’re eligible for the extended Power BI Pro trial?
Please refer to the Extended Pro Trial terms and conditions.

For information regarding the Extended Pro Trial offering, see Extended Pro Trial activation.

What should users do if they’re not eligible for the extended Power BI Pro trial?
Sign up for a standard 60-day Power BI Pro trial here.

Does the introduction of Power BI Premium change the capabilities of the free service?
Users of the free service with access to dedicated capacity in Power BI Premium will have the ability to receive
content distributed to them by Power BI Pro users via published Apps.

What is changing with Power BI Pro?
No changes are coming to Power BI Pro.

What about Office – is Power BI Pro still included in Office 365 E5?
Yes. Power BI Pro will continue to be included in Office 365 E5.

Do I have the option to return my Power BI Pro licenses if I want to switch to Power BI Premium?
No. Power BI Premium is an add-on to Power BI Pro; therefore Premium requires Pro licenses.

Why is Power BI Pro necessary? Shouldn’t I just buy Power BI Premium?

https://aka.ms/power-bi-trial
https://app.powerbi.com/signupredirect?pbi_source=web


Power BI Embedded

LICENSING AGREEMENT AVAILABILITY OF POWER BI EMBEDDED

Enterprise Agreement Until expiration of existing agreement

Direct and CSP One year from General Availability of Power BI Premium

Power BI Desktop

Power BI Premium is a capacity-based license, while Power BI Pro is a user-based license intended for quick, easy-
to-use self-service analytics for users requiring collaboration, dashboard sharing, ad hoc analysis, and report
publishing – such as the ability to:

Edit and save customized views
Create personal dashboards (pin to new dashboard)
Analyze data in Excel or Power BI Desktop
Share and view Excel workbooks with Excel Web App support
Share dashboards and collaborate with Office 365 Groups
Integrate content with Microsoft Teams

What’s changed with Power BI Embedded?
As part of Power BI Premium we are converging Power BI Embedded with the Power BI service to deliver one API
surface, a consistent set of capabilities and access to the latest features. Moving forward we encourage those
interested in embedding Power BI in their apps to start with Power BI Desktop and move to deployment with
Power BI Premium.

What are the benefits of Power BI Premium for embedding analytics in apps?
Power BI Premium is a capacity-based offering that runs on dedicated hardware and is fully managed by Microsoft
as part of the Power BI service. When you think about your application development lifecycle, Power BI Premium
will offer new benefits like flexible and predictable costs, improved content management for developers and the
full availability of Power BI capabilities for embedded scenarios.

Do I need to migrate my existing app built on Power BI Embedded?
Power BI Embedded will continue to be available for existing apps per the following schedule:

Yes, you should start thinking about migrating your embedded analytics solution to Power BI Premium. For more
information, see How to migrate Power BI Embedded workspace collection content to Power BI.

How do I migrate my existing app built on Power BI Embedded?
Refer to the migration documentation for guidance on migrating apps.

Is Microsoft going back on its commitment to Power BI Embedded Free?
Under the previous model, we offered a limited number of sessions for developing and testing. In the new
scenario, customers will continue having options available to them to start developing and testing for free in their
way to be production ready. Customers will benefit from a 2-month Power BI Pro trial to get started with dev &
test. Power BI Desktop, the data exploration and report authoring tool, will continue to be available for free.

Is Power BI Embedded still an Azure Service? Where will I purchase, provision and manage Power BI
Embedded?
Power BI Embedded is converging with Power BI service and therefore it will be purchased, provisioned and
managed as such moving forward. For more information, see Embedding with Power BI.

What changes are you making to Power BI Desktop?
No changes are being made to Power BI Desktop.



Power BI Report Server

Next steps

Why is Power BI Report Server included in Power BI Premium rather than being sold as a separate
product?
Power BI Premium introduces the ability to maintain BI assets on-premises with Power BI Report Server. Power BI
Report Server is an on-premises server that allows the deployment and distribution of interactive Power BI
reports, and paginated reports, completely within the boundaries of the organization’s firewall. With Power BI
Premium the same number of virtual cores an organization provisions in the cloud can also be deployed on-
premises through Power BI Report Server, without the need to split the capacity. Organizations can choose Power
BI in the cloud, or elect to keep reports on-premises with Power BI Report Server and move to the cloud at their
pace.

For more information, see Get started with Power BI Report Server.

How can customers get access to Power BI Report Server?
Power BI Report Server is available through Power BI Premium or as a benefit for customers with SQL Server EE
with SA. Contact your Microsoft representative for more information.

Why is Power BI Report Server not available as benefit for SQL Server Standard or Enterprise Edition
customers?
Power BI Report Server is available to SQL Server customers with EE + SA licenses or for purchase through Power
BI Premium. Power BI is a SaaS service, and Power BI Report Server will follow the same subscription-based
delivery model.

Power BI Premium - what is it?
Power BI Premium release notes
Microsoft Power BI Premium whitepaper
Planning a Power BI Enterprise Deployment whitepaper
Extended Pro Trial activation

More questions? Try asking the Power BI Community

https://aka.ms/pbipremiumwhitepaper
https://aka.ms/pbienterprisedeploy
https://community.powerbi.com/


Power BI Premium release notes
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Next steps

These are the release notes for Power BI Premium, a dedicated capacity giving your organization or team more
dependable performance, larger data volumes, and the ability to distribute content without per-user licenses for
viewers.

Users with Power BI Free licenses can now view dashboards shared with them from Premium workspaces in
the Power BI service.
Capacity admins now automatically get capacity assignment permissions.
Dynamic row-level security (RLS) is now available for embedded use cases. For more information, see Row-
level security (RLS) with embedded analytics.
Distributing Power BI apps to users in other AAD tenants using powerbi.com is not yet supported. We are
working on enabling this.
Users of the Personal Gateway must upgrade to the latest version in order to continue refreshing their data in
Premium workspaces.
Imported datasets greater than 1 GB are not supported in Premium capacity at initial release. We are working
on enabling this.
Users must log in at least once to the Power BI service before they can be assigned as capacity admins or given
workspace assignment permissions.
You may see transient cases where you achieve more Direct Query/live connection queries per second than
what is included in your capacity SKU. You shouldn't rely on throughput above what is included in your
capacity SKU.

Power BI Premium FAQ
How to purchase Power BI Premium
Managing Power BI Premium
Microsoft Power BI Premium whitepaper
Administering Power BI in your organization

More questions? Try asking the Power BI Community

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-premium-release-notes.md
https://aka.ms/pbipremiumwhitepaper
https://community.powerbi.com/


Connect to the services you use with Power BI
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Get started

You can connect to a number of services you use to run your business, such as Salesforce, Microsoft Dynamics,
and Google Analytics. Power BI starts by using your credentials to connect to the service, and then creates a
Power BI app with a dashboard and a set of Power BI reports that automatically show your data and provide
visual insights about your business.

Log in to Power BI to view all of the services you can connect to. The Power BI team adds new services regularly.

After you install the app, you can view the dashboard and reports in the Power BI service (https://powerbi.com),
and in the Power BI mobile apps.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-connect-to-services.md
https://app.powerbi.com/getdata/services
https://powerbi.com


View the dashboard and reports

1. Select Apps in the left navigation pane > select Get apps in the upper-right corner.

2. In AppSource, select the Apps tab, and search for the service you want.

When the import is complete, the new app appears on the Apps page.

1. Select Apps in the left navigation pane > select the app.

2. You can ask a question by typing in the Q&A box, or click a tile to open the underlying report.



What's included

Troubleshooting

You can filter and highlight the data in the report, but you can't save your changes.

After connecting to a service, you see a newly created app with a dashboard, reports, and dataset. The data from
the service is focused on a specific scenario and may not include all the information from the service. The data is
scheduled to refresh automatically once per day. You can control the schedule by selecting the dataset.

You can also use Power BI Desktop to connect to some services, such as Google Analytics, and create your own
customized dashboards and reports.

For more details on connecting to specific services, please refer to the individual help pages.

Empty tiles
While Power BI is first connecting to the service, you may see an empty set of tiles on your dashboard. If you still
see an empty dashboard after 2 hours, it's likely the connection failed. If you didn't see an error message with
information on correcting the issue, please file a support ticket.

Select the question mark icon (?) in the upper-right corner > Get help.



Suggesting services

Next steps

Missing information
The dashboard and reports include content from the service focused on a specific scenario and do not include all
the information from the service. If there's a specific metric that you're not seeing in the content pack, please add
an idea on the Power BI Support page.

Do you use a service you'd like to suggest for a Power BI app? Go to the Power BI Support page and let us know.

Do you have a service you'd like to build an app for? Submit your nomination and select "Publish a Power BI
Content Pack" to get started.

What are apps in Power BI?
Get data in Power BI
More questions? Try asking the Power BI Community

https://support.powerbi.com/forums/265200-power-bi
https://support.powerbi.com/forums/265200-power-bi
https://azure.microsoft.com/marketplace/programs/certified/apply/
http://community.powerbi.com/


Connect to Adobe Analytics with Power BI
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How to connect

Connecting to Adobe Analytics through Power BI starts by connecting to your Adobe Analytics Marketing Cloud
account. You get an app with a Power BI dashboard and a set of Power BI reports that provide insights about your
site traffic and user dimensions. The data is refreshed automatically once per day. You can interact with the
dashboard and reports, but you can't save changes.

Connect to Adobe Analytics or read more about the Adobe Analytics integration with Power BI.

1. Select Apps in the left navigation pane > select Get apps in the upper-right corner.

2. In AppSource, select the Apps tab, and search for the service you want.

1. Select Adobe Analytics > Get.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-connect-to-adobe-analytics.md
https://app.powerbi.com/getdata/services/adobe-analytics
https://powerbi.microsoft.com/integrations/adobe-analytics


2. Power BI connects to a specific Adobe Analytics Company and Report Suite ID (not the Report Suite name).
See details on finding those parameters below.

3. For Authentication Method, select oAuth2 > Sign In. When prompted, enter your Adobe Analytics
credentials.



4. Click Accept to allow Power BI to access your Adobe Analytics data.



View the Adobe Analytics dashboard and reports

  ![Adobe Analytics dashboard](media/service-connect-to-adobe-analytics/dashboard.png)

What now?What now?

5. After you approve, the import process begins automatically.

When the import is complete, the new app will appear on the Apps page.

2. You can ask a question by typing in the Q&A box, or click a tile to open the underlying report.

1. Select Apps in the left navigation pane > select the app.



What's included

TABLE NAME COLUMN DETAILS

Products elements= "product" (top 25) 
metrics="cartadditions", "cartremovals", "carts", "cartviews",
"checkouts", "revenue", "units"

Browsers elements= "browser" (top 25)
metrics="bounces", "bouncerate", "visitors", "visits",
"uniquevisitors", "totaltimespent", "pageviews"

Pages elements= "page" (top 25)
metrics="cartadditions", "cartremovals", "carts", "cartviews",
"checkouts", "revenue", "units", "visits", "uniquevisitors",
"pageviews", "bounces", "bouncerate", "totaltimespent"

JavaScript Enabled elements= "javascriptenabled”, “browser” (top 25)

Mobile OS elements= "mobileos"(top 25)
metrics="bounces", "bouncerate", "visitors", "visits",
"uniquevisitors", "totaltimespent", "cartadditions",
"cartremovals", "checkouts", "revenue", "units", "pageviews"

Search Engines Keywords elements= "searchengine" "searchenginekeyword"
metrics="bounces", "bouncerate", "visitors", "visits", "entries",
"uniquevisitors", "totaltimespent", "cartadditions",
"cartremovals", "carts", "cartviews", "checkouts", "revenue",
"units", "pageviews"

Search Engine to Products elements= "searchengine", "product"
metrics="bounces", "bouncerate", "visitors", "visits", "entries",
"uniquevisitors", "totaltimespent", "cartadditions",
"cartremovals", "carts", "cartviews", "checkouts", "revenue",
"units", "pageviews"

Referring Pages elements= "referrer" (top 15), “page" (top 10)
metrics="bounces", "bouncerate", "visitors", "visits", "entries",
"uniquevisitors", "totaltimespent", "cartadditions",
"cartremovals", "carts", "cartviews", "checkouts", "revenue",
"units", "pageviews"

Geocountry Pages elements= "geocountry" (Top 20), "page"
metrics="bounces", "bouncerate", "visitors", "visits", "entries",
"uniquevisitors", "totaltimespent", "cartadditions",
"cartremovals", "carts", "cartviews", "checkouts", "revenue",
"units", "pageviews"

Try asking a question in the Q&A box at the top of the dashboard.
Select a tile to open the underlying report.
You can filter and highlight the data in the report, but you can't save your changes.
Your dataset is scheduled to refreshed daily. You can change the refresh schedule or try refreshing it on
demand using Refresh Now.

Power BI uses the Adobe Analytics Report API to define and run reports for the following tables:



Geocountry Product elements= "geocountry" (Top 20), "product"
metrics="bounces", "bouncerate", "visitors", "visits", "entries",
"uniquevisitors", "totaltimespent", "cartadditions",
"cartremovals", "carts", "cartviews", "checkouts", "revenue",
"units"

Country and Region Lookup elements= "geocountry" (Top 200)
metrics="bounces", "bouncerate", "visitors", "visits", "entries",
"uniquevisitors", "totaltimespent", "cartadditions",
"cartremovals", "carts", "cartviews", "checkouts", "revenue",
"units"

Language elements= "language", "browser" (Top 25)
metrics="bounces", "bouncerate", "visitors", "visits",
"uniquevisitors", "totaltimespent", "pageviews", "cartadditions",
"cartremovals", "checkouts", "carts", "cartviews"

Search Engines Look Up elements= "searchengine" (top 100)
metrics="bounces", "bouncerate", "visitors", "visits", "entries",
"uniquevisitors", "totaltimespent", "cartadditions",
"cartremovals", "carts", "cartviews", "checkouts", "revenue",
"units"

Browser Lookup elements= "browser" (top 25)

TABLE NAME COLUMN DETAILS

System requirements

Finding parameters

Access to Adobe Analytics is required, including access to the correct parameters as described below.

 

Company

The Company value can be found in the top right of your account once you're signed in. The value is case and
spacing sensitive. Enter it exactly as you see in your account.

Report Suite ID

The Suite ID is created when the Report Suite is created. You can contact your administrator to identify the ID value.
Note that this is not the Report Suite name.

From Adobe documentation:

http://www.adobe.com/marketing-cloud/web-analytics.html
https://marketing.adobe.com/resources/help/en_US/reference/new_report_suite.html


Troubleshooting

Next steps

If you're seeing an error after providing your credentials indicating you do not have permissions, please confirm
with your admin that you have access to the Adobe Analytics API. Also confirm the Adobe ID provided is linked to
your Marketing Cloud Organization (associated to an Adobe Analytics company).

If you've successfully passed the credentials screen before encountering an error, it's possible the reports are
taking too long to complete. A common error is in the form "Failed to get data from the Adobe Analytics report.
Contents included "referrer, page", approximate duration was xx seconds". Please review the "What's included"
section and compare to the size of your Adobe instance. Unfortunately there isn't a way to work around this
timeout today. However, we're considering updates to better support larger instances, please provide feedback to
the Power BI team at https://ideas.powerbi.com

What are apps in Power BI?
Get data in Power BI
More questions? Try asking the Power BI Community

https://ideas.powerbi.com
http://community.powerbi.com/


Connect to Azure Audit Logs with Power BI
1/19/2018 • 1 min to read • Edit Online

How to connect

With the Azure Audit Logs content pack you can analyze and visualize the information stored in the audit logs.
Power BI retrieves your data, builds an out-of-the box dashboard, and creates reports based on that data.

Connect to the Azure Audit Logs content pack or read more about the Azure Audit Logs integration with Power BI.

1. Select Get Data at the bottom of the left navigation pane.

2. In the Services box, select Get.

3. Select Azure Audit Logs > Get.

4. When prompted, enter your Azure Subscription ID. See details on finding your subscription ID below.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-connect-to-azure-audit-logs.md
https://app.powerbi.com/getdata/services/azure-audit-logs
https://powerbi.microsoft.com/integrations/azure-audit-logs


5. For Authentication Method, select oAuth2 > Sign In.

6. Enter your account credentials to finish the sign in process.



System requirements

Finding parameters

7. Power BI will retrieve your Azure Audit Log data and create a ready-to-use dashboard and report.

What now?

Try asking a question in the Q&A box at the top of the dashboard
Change the tiles in the dashboard.
Select a tile to open the underlying report.
While your dataset will be schedule to refreshed daily, you can change the refresh schedule or try refreshing it
on demand using Refresh Now

The Azure Audit logs content pack requires access to Audit Logs in the Azure Portal. More details here.

 

There are two easy ways to find your Subscription Id.

https://azure.microsoft.com/en-us/documentation/articles/insights-debugging-with-events/


Troubleshooting

Next steps

1. From https://portal.azure.com -> Browse -> Subscriptions -> Subscription Id
2. From https://manage.windowsazure.com -> Settings -> Subscription Id

Your subscription ID will be long set of numbers and characters, similar to the example in Step #4 above.

If you're seeing a credentials error or an error trying to refresh due to invalid credentials, please try deleting all
instances of the Azure Audit logs content pack and reconnecting.

Get started with Power BI
Power BI - Basic Concepts

https://portal.azure.com
https://manage.windowsazure.com


Connect to Google Analytics with Power BI
11/15/2017 • 2 min to read • Edit Online

How to connect

Connecting to Google Analytics through Power BI starts by connecting to your Google Analytics account. You will
get a Power BI dashboard and a set of Power BI reports that provide insights about your site traffic and user
dimensions. You can interact with the dashboard and reports, but you can't save changes. The data will be
refreshed automatically once per day.

Connect to Google Analytics for Power BI. Read more about the Google Analytics integration with Power BI.

You can create customized dashboards and reports by starting from the Google Analytics connector in Power BI
Desktop. Just connect with your Google Analytics account and create your custom reports, which you can publish
to the Power BI service.

1. Select Apps in the left navigation pane > select Get apps in the upper-right corner.

2. In AppSource, select the Apps tab, and search for the service you want.

1. Select Google Analytics > Get.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-connect-to-google-analytics.md
https://app.powerbi.com/getdata/services/google-analytics
https://powerbi.microsoft.com/integrations/google-analytics


2. When prompted, enter your Google Analytics credentials. Select oAuth 2 as the Authentication Mechanism
and click Sign In. Follow the Google authentication flow, which may include 2-factor authentication if you
have it configured.

3. Click Accept to allow Power BI to access your Google Analytics data.



View the Google Analytics dashboard and reports

5. Click Connect to begin the import process.

4. Power BI connects to a specific Google Analytics View. Select the account name, property name and view
name you’d like to connect to. This information can be found in your Google Analytics account, either in the
top left or on the Home tab. See details below.

When the import is complete, the new app will appear on the Apps page.

1. Select Apps in the left navigation pane > select the app.



  ![](media/service-connect-to-google-analytics/googleanalytics2.png)

What now?What now?

System requirements

Troubleshooting

NOTENOTE

2. You can ask a question by typing in the Q&A box, or click a tile to open the underlying report.

Try asking a question in the Q&A box at the top of the dashboard.
Select a tile to open the underlying report.
You can filter and highlight the data in the report, but you can't save your changes.
Your dataset is scheduled to refreshed daily. You can change the refresh schedule or try refreshing it on
demand using Refresh Now.

To connect from Power BI, you need to have a Google Analytics account. Other Google accounts that do not have a
Google Analytics account connected to it will see an authentication error.

Credentials If you have multiple Google accounts, please use an incognito or an in-private broswer window
during connection to ensure the correct account is used.

If you're getting an error indicating your credentials are invalid however you were able to sign into Google, please
confirm you have a Google Analytics account.

Parameters Unique names are currently required for the parameters. If you see an error indicating the value you
selected is duplicated, please select another value or change the names in Google Analytics to make them unique.
We're actively working to improve this.

Parameters are case-sensitive. Enter them exactly as they appear in your Google Analytics account.

https://www.google.com/analytics/
https://www.google.com/analytics/


Next steps

Still having issues? Open a support ticket to reach the Power BI team:

While in the Power BI app, select the question mark > Contact Support.
From the Power BI Support site (where you're reading this article), select Contact Support on the right side of
the page.

What are apps in Power BI?
Get data in Power BI
More questions? Try asking the Power BI Community

http://community.powerbi.com/


Connect to Marketo with Power BI
1/19/2018 • 3 min to read • Edit Online

How to connect

The Power BI content pack for Marketo allows you to gain insights into your Marketo account with data around
Leads and their activities.Creating this connection retrieves your data and automatically provides a dashboard and
related reports based on that data.

Connect to the Marketo content pack for Power BI.

1. Select Get Data at the bottom of the left navigation pane.

2. In the Services box, select Get.

3. Select Marketo > Get.

4. Enter the Marketo REST endpoint supplied to you by Marketo or your Marketo admin, and select Next.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-connect-to-marketo.md
https://app.powerbi.com/getdata/services/marketo


Read more about the Marketo REST endpoint: http://developers.marketo.com/documentation/rest/endpoint-
url/ .

5. Using the Basic Authentication Method, enter the Client ID as the Username and the Client Secret as the
Password. Client ID and Client Secret are available in Marketo or from your marketo admin
(http://developers.marketo.com/documentation/rest/custom-service/).

This gives the *Marketo for Power BI *content pack access to your Marketo analytics data and allows you to
analyze the data in Power BI. The data is refreshed once a day.

6. Once connected to your Marketo account, a dashboard with all your data is loaded:

http://developers.marketo.com/documentation/rest/endpoint-url/
http://developers.marketo.com/documentation/rest/custom-service/
https://powerbi.microsoft.com/integrations/marketo


What's included

TABLE NAME DESCRIPTION

EmailActivities Data about email sent to leads/contacts, with details about
devices, categories, bounced count and percentage, clicked
count and percentage, opened count and percentage, and
program name. The Email Activities as shown in Power BI is an
absolute email deliverability report, it does not apply any
additional logic to the data. You might see some different
results between the Marketo client and Power BI because of
this.

ProgramActivites Data on programs that have had a change a Status. This
includes details such as: Reason, Success, Program acquisition
count and percentage, and Program success count and
percentage.

WebPageActivities Data from user web page visits, including search agent, User
agent, web page and hour of day.

Datetable Dates from today and the past year. Allows you to analyze
your Marketo data by date.

What now?

Try asking a question in the Q&A box at the top of the dashboard
Change the tiles in the dashboard.
Select a tile to open the underlying report.
While your dataset will be schedule to refreshed daily, you can change the refresh schedule or try refreshing it
on demand using Refresh Now

The following data is available from Marketo in Power BI where the activity occurred between today and one year
ago:



Leads Lead information like company, revenue size, number of
employees, country, industry, Lead score and Lead status. The
leads are retrieved based on their presence in the email,
program, and webpage activities data.

TABLE NAME DESCRIPTION

System requirements

DATA TYPE NUMBER OF ROWS API CALLS

Leads information 15,000 50

Mail activities 150,000 1,000

Program activities 15,000 100

Web activities 150,000 1,000

Program changes 7,500 50

Total API Calls 2,200

Next steps

All dates are in UTC. Depending on which time zone your account is in, dates my vary (similar as is seen in the
Marketo client)

The Marketo account you use for connecting has permission to access leads and activities.
Sufficient API calls available to connect to the data. Marketo has an API for each account. When the limit is
reached, you won't be able to load data into Power BI.

API Limit Details

Importing data from Marketo uses Marketo APIs. Every customer of Marketo has a total limit of 10,000 API calls per
day that are shared between all applications that use the Marketo APIs. You may use the APIs for other integrations
as well as the Power BI integration. For more information on the APIs see:
http://developers.marketo.com/documentation/rest/.

The amount of API calls Power BI makes to Marketo depends on the amount of data in your Marketo account.
Power BI imports all Leads and Activities for the last year. Here is an example of data from Marketo and the amount
of API calls that are used by Power BI when importing:

Get started with Power BI

Get Data for Power BI

Power BI blog: Monitor and analyze your Marketo data with Power BI

http://developers.marketo.com/documentation/rest/
http://blogs.msdn.com/b/powerbi/archive/2015/03/19/monitor-and-analyze-your-marketo-data-with-power-bi.aspx


Connect to Salesforce with Power BI
1/19/2018 • 2 min to read • Edit Online

How to Connect

With Power BI, you can easily connect to your Salesforce.com account. Creating this connection retrieves your data
and automatically provides a dashboard and related reports based on your data.

Connect to the Salesforce content pack for Power BI or read more about the Salesforce integration with Power BI.

1. Select Get Data at the bottom of the left navigation pane.

2. In the Services box, select Get.

3. Click Salesforce and select Get.

4. Select Sign In to initiate the login flow.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-connect-to-salesforce.md
https://app.powerbi.com/getdata/services/salesforce
https://powerbi.microsoft.com/integrations/salesforce


5. When prompted, enter your Salesforce credentials. Click Allow so Power BI can access your basic Salesforce
information and data.

6. Configure what you'd like to import into Power BI using the dropdown option:

Dashboard

Select a predefined dashboard based on a persona (such as Sales Manager). These dashboards bring
in a specific set of standard data from Salesforce and will not include custom fields.



Reports

Select one or more custom reports from your Salesforce account. These reports will match your views
in Salesforce and can include data from custom fields or objects.

If you don't see any reports, add or create them in your Salesforce account and try connecting again.

7. Click Connect to begin the import process. During the import you see a notification showing the import is
in progress. When the import is complete, you see a dashboard, report, and dataset for your Salesforce data
listed in the navigation pane on the left.



System requirements

Troubleshooting

Next steps

You can change this dashboard to display your data any way you want. You can ask questions with Q&A - Or click
a tile to open the underlying report and change the tiles in the dashboard.

What now?

Try asking a question in the Q&A box at the top of the dashboard
Change the tiles in the dashboard
Select a tile to open the underlying report
While your dataset will be schedule to refreshed daily, you can change the refresh schedule or try refreshing it
on demand using Refresh Now

Connected with a production Salesforce account that has API access enabled
Permission granted to the Power BI app during log-in
The account has sufficient API calls available to pull and refresh the data
A valid authentication token is required for refresh. Ensure you have 5 or less Salesforce data sets imported, as
Salesforce has a limit of 5 authentication tokens per application

If you encounter any errors, please review the requirements above. Also note the ability to login into a custom or
sandbox domain is not currently supported.

Get Started with Power BI

Get Data



Connect to Acumatica with Power BI
1/19/2018 • 2 min to read • Edit Online

NOTENOTE

How to connect

The Power BI Acumatica content pack allows to you quickly gain insights into your opportunity data. Power BI
retrieves your data, including opportunities, accounts, and customers, then builds a default dashboard and related
reports based on that data.

Connect to the Acumatica content pack or read more about the Acumatica integration with Power BI.

This content pack requires Acumatica v5.2 or higher.

1. Select Get Data at the bottom of the left navigation pane.

2. In the Services box, select Get.

3. Select Acumatica > Get.

4. Enter your Acumatica OData endpoint. An OData endpoint allows an external system to request data from

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-connect-to-acumatica.md
https://app.powerbi.com/getdata/services/acumatica
https://powerbi.microsoft.com/integrations/acumatica


Acumatica. Acumatica OData endpoint is formatted as follows and should us HTTPS:

https://[sitedomain]/odata/[companyname]

The Company Name is only required if you have a multi-company deployment. More information about
finding this parameter in your Acumatica account is included below.

5. For Authentication Method, select Basic. Enter your username and password from your Acumatica account,
then click Sign In.



6. After Power BI imports the data you will see a new dashboard, report, and dataset in the left navigation
pane. New items are marked with a yellow asterisk * which disappears once selected, chosing the dashboard
will show a similar layout to the one below:



System requirements

Finding parameters

https://[sitedomain]/odata/[companyname]

What now?

Try asking a question in the Q&A box at the top of the dashboard
Change the tiles in the dashboard.
Select a tile to open the underlying report.
While your dataset will be schedule to refreshed daily, you can change the refresh schedule or try refreshing it
on demand using Refresh Now

This content pack requires Acumatica v5.2 or higher, please confirm the version with your Acumatica admin.

Acumatica OData Endpoint

The Acumatica OData endpoint is formatted as follows and should us HTTPS:

The Application Site Domain can be found in your browser’s address bar when you’re signed into Acumatica. In the
example below, the site domain is “https://pbi.acumatica.com” so the OData endpoint to provide would be
“https://pbi.acumatica.com/odata”.

The Company Name is only required if you have a multi-company deployment. You can find this information from
your Acumatica sign in page.

https://pbi.acumatica.xn--com-9o0a
https://pbi.acumatica.com/odata?


Troubleshooting

https://<application site domain>/odata/<company name>

Next steps

If you’re not able to login, verify the Acumatica OData endpoint you provided is formatted correctly.

If you're having trouble connecting, please confirm with your admin your version of Acumatica. This content pack
requires version 5.2 or later.

Get started in Power BI

Get data in Power BI



Connect to Alpine Metrics Sales Predictions with
Power BI
1/19/2018 • 1 min to read • Edit Online

How to connect

Alpine Metrics provides state of the art Predictive Sales Process Optimization in the cloud and on demand for sales
organizations large and small. The Alpine Metrics Sales Predictions content pack for Power BI includes metrics such
as potential and predicted sales and risks, allowing you deeper insight into the future of your business.

Connect to the Alpine Metrics Sales Predictions content pack for Power BI.

1. Select Get Data at the bottom of the left navigation pane.

2. In the Services box, select Get.

3. Select AlpineMetrics Sales Predictions, then select Get.

4. Select OAuth 2 and then Sign In. When prompted, provide your AlpineMetrics credentials.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-connect-to-alpine-metrics.md
https://app.powerbi.com/getdata/services/alpine-metrics


5. Once connected, a dashboard, report and dataset will automatically be loaded. When completed, the tiles will
update with data from your account.



What's included

- Account    
- Business    
- Country    
- Industry    
- Opportunity  
- Person  
- Prediction    
- Prediction History    
- Product  
- Region    

System requirements

Next steps

What now?

Try asking a question in the Q&A box at the top of the dashboard
Change the tiles in the dashboard.
Select a tile to open the underlying report.
While your dataset will be schedule to refreshed daily, you can change the refresh schedule or try refreshing it
on demand using Refresh Now

The content pack includes data from the following tables:

An Alpine Metrics account with permissions to the above tables is required in order to instantiate this content pack.

Get started with Power BI



Power BI - Basic Concepts



Connect to appFigures with Power BI
1/19/2018 • 2 min to read • Edit Online

How to connect

Tracking important statistics about your apps is easy with Power BI and the appFigures content pack. Power BI
retrieves your data, including app sales, downloads, and ad statistics, then builds a default dashboard and related
reports based on that data.

Connect to the appFigures content pack or read more about the appFigures integration with Power BI.

1. Select Get Data at the bottom of the left navigation pane.

2. In the Services box, select Get.

3. Select appFigures > Get.

4. For Authentication Method, select oAuth2 > Sign In. When prompted, enter your appFigures credentials
and follow the appFigures authentication process.

The first time you connect, Power BI prompts you to allow read-only access to your account. Select Allow to
begin the import process. This can take a few minutes depending on the volume of data in your account.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-connect-to-appfigures.md
https://app.powerbi.com/getdata/services/appfigures
https://powerbi.microsoft.com/integrations/appfigures


5. After Power BI imports the data you will see a new dashboard, report, and dataset in the left navigation
pane. New items are marked with a yellow asterisk *:

6. Select the appFigures dashboard. This is the default dashboard that Power BI creates to display your data.
You can modify this dashboard to display your data in any way you want.



What's included

TABLE NAME DESCRIPTION

Countries This table provides country name information.

Dates This table contains dates from today back to the earliest
PublishDate of apps that are Active and Visible in your
appFigures account.

Events This table contains download, sales, and ad information for
each app, by country, on a daily basis. Note that both app and
in-app purchase information is all in this single table—you can
use the Type column to differentiate.

Inapps This table contains data about the different types of In-App
Purchases that are associated with Active, Visible apps on your
appFigures account.

Products This table contains data about the different apps that are
Active and Visible on your appFigures account.

Troubleshooting

What now?

Try asking a question in the Q&A box at the top of the dashboard
Change the tiles in the dashboard.
Select a tile to open the underlying report.
While your dataset will be schedule to refreshed daily, you can change the refresh schedule or try refreshing it
on demand using Refresh Now

The following data is available from appFigures in Power BI.

If data from some of your apps is not showing up in Power BI, check to make sure that those apps are Visible and



Next steps

Active on the apps tab of the appFigures site.

Get started in Power BI
Get data in Power BI



Connect to Application Insights with Power BI
1/24/2018 • 1 min to read • Edit Online

NOTENOTE

How to connect

Use Power BI to create powerful custom dashboards from Application Insights telemetry. Envision your app
telemetry in new ways. Combine metrics from multiple apps or component services onto one dashboard. This first
release of the Power BI content pack for Application Insights includes widgets for common usage-related metrics
such as active users, page view, sessions, browser and OS version, and geographic distribution of users in a map.

Connect to the Application Insights content pack for Power BI.

Access to the Application Insights overview blade for your application in the Azure Preview Portal is required to connect.
More details on requirements below.

1. Select Get Data at the bottom of the left navigation pane.

2. In the Services box, select Get.

3. Select Application Insights > Get.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-connect-to-application-insights.md
https://azure.microsoft.com/documentation/articles/app-insights-overview/
https://app.powerbi.com/getdata/services/application-insights


4. Provide the details of the application you want to connect to, including Application Insights Resource
Name, Resource Group, and Subscription ID. See Finding your Application Insights parameters below for
more details.

5. Select Sign In and follow the screens to connect.



What's included

6. The import process begins automatically. When complete, a notification is shown and a new dashboard,
report, and dataset appear in the Navigation Pane marked with an asterisk. Select the dashboard to view
your imported data.

What now?

Try asking a question in the Q&A box at the top of the dashboard
Change the tiles in the dashboard.
Select a tile to open the underlying report.
While your dataset will be schedule to refreshed daily, you can change the refresh schedule or try refreshing it
on demand using Refresh Now

The Application Insights content pack includes the following tables and metrics:



 ´´´
- ApplicationDetails  
- UniqueUsersLast7Days   
- UniqueUsersLast30Days   
- UniqueUsersDailyLast30Days  
- UniqueUsersByCountryLast7Days  
- UniqueUsersByCountryLast30Days   
- PageViewsDailyLast30Days   
- SessionsLast7Days   
- SessionsLast30Days  
- PageViewsByBrowserVersionDailyLast30Days   
- UniqueUsersByOperatingSystemLast7Days   
- UniqueUsersByOperatingSystemLast30Days    
- SessionsDailyLast30Days   
- SessionsByCountryLast7Days   
- SessionsByCountryLast30Days   
- PageViewsByCountryDailyLast30Days  

Finding parameters

´´´

 

Your Resource Name, Resource Group and Subscription ID can all be found in the Azure Portal. Selecting the Name
will open a detailed view and you can use the Essentials drop-down to find all the values you need.

Copy and paste these into the fields into Power BI:



Next steps
Get started in Power BI

Get data in Power BI



Connect to AT Internet Bridge with Power BI
1/19/2018 • 1 min to read • Edit Online

How to connect

AT Internet helps you to extract immediate value from your data using its unified digital analytics platform, the
Analytics Suite. The AT Internet Bridge content pack for Power BI includes data around visits, sources, localization
and devices for your site.

Connect to the AT Internet Bridge content pack for Power BI.

1. Select Get Data at the bottom of the left navigation pane.

2. In the Services box, select Get.

3. Select AT Internet Bridge > Get.

4. Specify the AT Internet Website Number you'd like to connect to.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-connect-to-at-internet.md
https://app.powerbi.com/getdata/services/at-internet-bridge


5. Select Basic as the Authentication Mechanism, provide your AT Internet username and password, and click
Sign In.

6. Click Connect to begin the import process. When complete, a new dashboard, report and model will appear



What's included

- Conversion  
- Devices  
- Localization  
- Sources  
- Global Visits  

Next steps

in the Navigation Pane. Select the dashboard to view your imported data.

What now?

Try asking a question in the Q&A box at the top of the dashboard
Change the tiles in the dashboard.
Select a tile to open the underlying report.
While your dataset will be schedule to refreshed daily, you can change the refresh schedule or try refreshing it
on demand using Refresh Now

This content pack contains data from the last 45 days in the following tables:

Get started with Power BI

Power BI - Basic Concepts



Connect to Azure Mobile Engagement with Power BI
1/19/2018 • 1 min to read • Edit Online

How to connect

The Power BI Azure Mobile Engagement content pack allows to you quickly gain insights into your app data.

Connect to the Azure Mobile Engagement content pack for Power BI.

1. Select Get Data at the bottom of the left navigation pane.

2. In the Services box, select Get.

3. Select Azure Mobile Engagement > Get.

4. Specify your App Collection and App Name. This information can be found in your Azure Mobile
Engagement account.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-connect-to-azure-mobile.md
https://app.powerbi.com/groups/me/getdata/services/azme


5. For Authentication Method, provide your Key then click Sign In.

6. After Power BI imports the data you will see a new dashboard, report, and dataset in the left navigation
pane. New items are marked with a yellow asterisk * which disappears once selected:



Next steps

What now?

Try asking a question in the Q&A box at the top of the dashboard
Change the tiles in the dashboard.
Select a tile to open the underlying report.
While your dataset will be schedule to refreshed daily, you can change the refresh schedule or try refreshing it
on demand using Refresh Now

Get started in Power BI

Get data in Power BI



Connect to Microsoft Azure Consumption Insights
with Power BI
1/19/2018 • 2 min to read • Edit Online

How to connect

Explore and monitor your Microsoft Azure consumption data in Power BI with the Power BI content pack. The data
will be refreshed automatically once per day.

Connect to the Microsoft Azure Consumption Insights content pack for Power BI.

1. Select Get Data at the bottom of the left navigation pane.

2. In the Services box, select Get.

3. Select Microsoft Azure Consumption Insights > Get.

4. Provide the number months of data you want to import and your Azure Enterprise enrollment number. See
details on finding these parameters below.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-connect-to-azure-consumption-insights.md
https://app.powerbi.com/getdata/services/azureconsumption


5. Provide your Access key to connect. The key for your enrollment can be found in your Azure EA Portal.

6. The import process will begin automatically. When complete, a new dashboard, report and model will
appear in the Navigation Pane. Select the dashboard to view your imported data.



What's included

System Requirements

Finding parameters

What now?

Try asking a question in the Q&A box at the top of the dashboard
Change the tiles in the dashboard.
Select a tile to open the underlying report.
While your dataset will be schedule to refreshed daily, you can change the refresh schedule or try refreshing it
on demand using Refresh Now

The Microsoft Azure Consumption Insights content pack includes monthly reporting data for the range of months
that you provide during the connection flow. The range is a moving window, so the dates included will update as
the dataset refreshes.

The content pack requires access to the Enterprise features within the Azure Portal.

 

Power BI reporting is available for EA Direct, Partner and Indirect Customers who are able to view billing
information. Please read below for details about finding each of the values the connection flow expects.

Number of Months

This should be a number between 1-36 representing the number of months of data (from today) you'd like to
import.

Enrollment Number



Next steps

This is your Azure Enterprise enrollment number which can be found on the home screen of the Azure
Enterprise Portal under “Enrollment Detail”.

Access Key

Your key can be found in the Azure Enterprise portal, under "Download Usage" > "API Access Key"

Additional Help

For additional help setting up the Azure Enterprise Power BI Pack, log in to the Azure Enterprise Portal to view
the API Help File under “Help” and additional instructions under Reports -> Download Usage -> API Access Key.

Get started in Power BI

Get data in Power BI

https://ea.azure.com/


Connect to Azure Search with Power BI
1/19/2018 • 1 min to read • Edit Online

How to connect

Azure Search Traffic Analytics allows you to monitor and understand the traffic to your Azure Search service. The
Azure Search content pack for Power BI provides detailed insights on your Search data, including Search, Indexing,
Service Stats and Latency from the last 30 days. More details can be found in the Azure blog post.

Connect to the Azure Search content pack for Power BI.

1. Select Get Data at the bottom of the left navigation pane.

2. In the Services box, select Get.

3. Select Azure Search > Get.

4. Provide the name of the table storage account your Azure Search analysis is stored.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-connect-to-azure-search.md
https://azure.microsoft.com/en-us/blog/analyzing-your-azure-search-traffic/
https://app.powerbi.com/getdata/services/azure-search


5. Select Key as the Authentication Mechanism and provide your storage account key. Click Sign In and to
begin the loading process.

6. Once the loading is complete, a new dashboard, report and model will appear in the Navigation Pane. Select
the dashboard to view your imported data.



System requirements

Troubleshooting

Next steps

What now?

Try asking a question in the Q&A box at the top of the dashboard
Change the tiles in the dashboard.
Select a tile to open the underlying report.
While your dataset will be schedule to refreshed daily, you can change the refresh schedule or try refreshing it
on demand using Refresh Now

The Azure Search content pack requires Azure Search Traffic Analytics to be enabled on the account.

Ensure the storage account name is correctly provided along with the full access key. The storage account name
should correspond to the account configured with Azure Search Traffic Analytics.

Get started with Power BI



Power BI - Basic Concepts



Connect to Azure Security Center with Power BI
1/19/2018 • 2 min to read • Edit Online

How to connect

Get insights into your Azure workload security by connecting your Azure Security Data with Power BI. Power BI
automatically creates a dashboard and report on top of your Azure Security Center data enabling you to analyze
and explore the data.

Connect to the Azure Security Center content pack for Power BI.

1. Select Get Data at the bottom of the left navigation pane.

2. In the Services box, select Get.

3. Select Azure Security Center > Get.

4. Specify your Subscription ID. See details on finding those parameters below.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-connect-to-azure-security-center.md
https://app.powerbi.com/getdata/services/azure-security-center


5. For Authentication Method, select oAuth2 > Sign In. When prompted, enter your Azure credentials.

6. After approving, the import process will begin automatically. When complete, a new dashboard, report and
model will appear in the Navigation Pane. Select the dashboard to view your imported data.



What's included

System requirements

Finding parameters

Troubleshooting

What now?

Try asking a question in the Q&A box at the top of the dashboard
Change the tiles in the dashboard.
Select a tile to open the underlying report.
While your dataset will be schedule to refreshed daily, you can change the refresh schedule or try refreshing it
on demand using Refresh Now

The content pack includes insights around resource security stat, alert analysis and prevention analysis.

This content pack requires access to a subscription ID with Azure Security Center enabled. See more details in the
Azure Security Center in the Azure Portal.

The content pack also requires the user to connect with an organizational account (not a personal account).

 

There are two easy ways to find your Subscription Id.

1. From https://portal.azure.com -> Browse -> Subscriptions -> Subscription Id
2. From https://manage.windowsazure.com -> Settings -> Subscription Id

Your subscription ID will be long set of numbers and characters, similar to the example in Step #4 above.

The data may take some time to load depending on the size of your account. If you hit an error during login, please
confirm your parameters and the account has Azure Security Center enabled.

If the content pack loads but doesn't show any data, please confirm you're connecting with an organizational
account. Although personal accounts are supported by Azure Security Center, the API (and therefore the content
pack) does not return the expected values if the user connects with a non-organizational account. Please provide

https://portal.azure.com/#blade/Microsoft_Azure_Security/SecurityDashboardStartBladeV2
https://portal.azure.com
https://manage.windowsazure.com


Next steps

access to an organizational account and try connecting again.

Get started in Power BI

Get data in Power BI



Connect to Bing with Power BI
11/15/2017 • 1 min to read • Edit Online

NOTENOTE

NOTENOTE

The Bing content pack will allow you to view analytics around Internet search activity for a term of your choice.

Connect to the Bing content pack for Power BI.

Bing tiles will automatically update approximately every ~5 minutes and the only tile that can be selected is the News tile,
which will take you to the corresponding news article.

Tiles from the Bing content pack do not render in the mobile applications. We’re working to resolve this issue.

1. Select Get Data at the bottom of the left navigation pane.

2. In the Services box, select Get.

3. Select Bing > Get.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-connect-to-bing.md
https://app.powerbi.com/groups/me/getdata/services/bing


4. In the parameters dialog, enter the search term you want to track and hit Add.

5. On the left you’ll see a new entry in your list of dashboards, named with Bing and the search term you
provided. Note there is no dataset or report associated with this dashboard. The tiles may take some time to
load but once completed you’ll see a layout similar to the below.



Once the loading has completed, you can start exploring your data, including pinning tiles from this dashboard to
other dashboards in your account.



Connect to Circuit ID with Power BI
1/19/2018 • 1 min to read • Edit Online

How to connect

Analyzing your communication data from Circuit ID is easy with Power BI. Power BI retrieves your data, then builds
a default dashboard and related reports based on that data. After you have created the connection, you can explore
your data and customize the dashboard to meet your needs. Data is automatically refreshed every day.

Connect to the Circuit ID content pack for Power BI.

1. Select Get Data at the bottom of the left navigation pane.

2. In the Services box, select Get.

3. Select Circuit ID > Get.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-connect-to-circuit-id.md
https://app.powerbi.com/getdata/services/circuitid


Next steps

4. For Authentication Method, select Basic and provide your username and password. Then hit Sign In.

5. After Power BI imports the data you will see a new dashboard, report, and dataset in the left navigation
pane. New items are marked with a yellow asterisk.

What now?

Try asking a question in the Q&A box at the top of the dashboard
Change the tiles in the dashboard.
Select a tile to open the underlying report.
While your dataset will be schedule to refreshed daily, you can change the refresh schedule or try refreshing it
on demand using Refresh Now



Get started with Power BI

Get Data for Power BI



Connect to ClickDimensions with Power BI
1/19/2018 • 1 min to read • Edit Online

How to connect

The ClickDimensions content pack for Power BI allows users to utilize ClickDimensions marketing data in Power BI,
giving management teams further insight into the success of their sales and marketing efforts. Visualize and
analyze email interactions, web visits and form submissions in Power BI dashboards and reports.

Connect to the ClickDimensions content pack for Power BI.

1. Select Get Data at the bottom of the left navigation pane.

2. In the Services box, select Get.

3. Select ClickDimensions > Get.

4. Provide the location of your data center (US, EU or AU) and select Next.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-connect-to-clickdimensions.md
https://app.powerbi.com/getdata/services/click-dimensions


5. For Authentication Method, select Basic > Sign In. When prompted, enter your ClickDimensions
credentials. See details in finding those parameters below

6. After approving, the import process will begin automatically. When complete, a new dashboard, report and
model will appear in the Navigation Pane. Select the dashboard to view your imported data.



System requirements

Finding parameters

What now?

Try asking a question in the Q&A box at the top of the dashboard
Change the tiles in the dashboard.
Select a tile to open the underlying report.
While your dataset will be schedule to refreshed daily, you can change the refresh schedule or try refreshing it
on demand using Refresh Now

To connect to the Power BI content pack, you must provide the data center corresponding to your account and log
in with your ClickDimensions account. If you're unsure which data center to provide, please check with your admin.

 

The Account Key is found within CRM Settings > ClickDimensions Settings. Copy the Account Key from within
ClickDimensions Settings and paste it into the User name field.



Next steps

Copy the Power BI Token from within ClickDimensions Settings and paste it into the Password field. The Power BI
Token is found within CRM Settings > ClickDimensions Settings.

Get started in Power BI

Get data in Power BI



Connect to comScore Digital Analytix with Power BI
1/19/2018 • 1 min to read • Edit Online

NOTENOTE

How to connect

Visual and explore your comScore Digital Analytix data in Power BI with the Power BI content pack. The data will be
refreshed automatically once per day.

Connect to the comScore content pack for Power BI.

To connect to the content pack you need a comScore DAx user account and have comScore API access. More details below.

1. Select Get Data at the bottom of the left navigation pane.

2. In the Services box, select Get.

3. Select comScore Digital Analytix > Get.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-connect-to-connect-to.md
https://app.powerbi.com/getdata/services/comscore


4. Provide the datacenter, comScore Client ID and Site you’d like to connect to. For more details on how to find
these values, please see Finding your comScore Parameters below.

5. Provide your comScore username and password to connect. See details on finding this value below.



System requirements

Finding parameters

6. The import process will begin automatically. When complete, a new dashboard, report and model will appear in
the Navigation Pane. Select the dashboard to view your imported data.

What now?

Try asking a question in the Q&A box at the top of the dashboard
Change the tiles in the dashboard.
Select a tile to open the underlying report.
While your dataset will be schedule to refreshed daily, you can change the refresh schedule or try refreshing it
on demand using Refresh Now

 

A comScore DAx user account and access to the comScore DAx API is required to connect. Please contact your
comScore DAx admin to confirm your account.

 

Details on how to find each of your comScore parameters is below.

Data Center

The data center you connect to is determined by the URL you navigate to in comScore.

If you use https://dax.comscore.com, enter “US”, if you use https://dax.comscore.eu, enter “EU”.

Client

https://dax.comscore.com
https://dax.comscore.eu


Next steps

The Client is the same one you provide when signing into comScore DAx.

Site

The comScore site determines which site you’d like to see the data from. You can find the list of sites from your
comScore account.

Get started in Power BI

Get data in Power BI



Connect to GitHub with Power BI
1/19/2018 • 3 min to read • Edit Online

NOTENOTE

How to connect

The GitHub content pack for Power BI allows you to gain insights into a GitHub repository (also known as repo)
with data around contributions, issues, pull requests and active users.

Connect to the GitHub content pack or read more about the GitHub integration with Power BI.

The content pack requires the GitHub account to have access to the repo. More details on requirements below.

1. Select Get Data at the bottom of the left navigation pane.

2. In the Services box, select Get.

3. Select GitHub > Get.

4. Enter the repository name and repository owner of the repo. See details on finding these parameters below.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-connect-to-github.md
https://app.powerbi.com/getdata/services/github
https://powerbi.microsoft.com/integrations/github


5. Enter your GitHub credentials (this step might be skipped if you are already signed in with your browser).
6. For Authentication Method, select oAuth2 > Sign In.
7. Follow the Github authentication screens. Grant the GitHub for Power BI content pack permission to the

GitHub data.

This connects Power BI with GitHub and allows Power BI to connect to the data. The data is refreshed once a
day.

8. After you connect to your repo, Power BI imports the data. You see a new GitHub dashboard, report, and
dataset in the left navigation pane. New items are marked with a yellow asterisk *.

https://powerbi.microsoft.com/integrations/github


What's included

TABLE NAME DESCRIPTION

Contributions The contributions table gives the total additions, deletions and
commits authored by the contributor aggregated per week.
The top 100 contributors are included.

Issues List all issues for the selected repo and it contains calculations
like total and average time to close an issue, Total open issues,
Total closed issues. This table will be empty when there are no
issues in the repo.

Pull requests This table contains all the Pull Requests for the repo and who
pulled the request. It also contains calculations around how
many open, closed and total pull requests, how long it took to
pull the requests and how long the average pull request took.
This table will be empty when there are no issues in the repo.

Users This table provides a list of GitHub users or contributors who
have made contributions, filed issues or solved Pull requests
for the repo selected.

Milestones It has all the Milestones for the selected repo.

DateTable This tables contains dates from today and for years in the past
that allow you to analyze your GitHub data by date.

What now?

Try asking a question in the Q&A box at the top of the dashboard
Change the tiles in the dashboard.
Select a tile to open the underlying report.
While your dataset will be schedule to refreshed daily, you can change the refresh schedule or try refreshing it
on demand using Refresh Now

The following data is available from GitHub in Power BI:



ContributionPunchCard This table can be used as a contribution punch card for the
selected repo. It shows commits by day of week and hour of
day. This table is not connected to other tables in the model.

RepoDetails This table provides details for the repo selected.

TABLE NAME DESCRIPTION

System requirements

De-authorize Power BIDe-authorize Power BI

Finding parameters

<https://github.com/Azure/azure-sdk-for-php> .

Troubleshooting

Next steps

The GitHub account that has access to the repo.
Permission granted to the Power BI for GitHub app during first login. See details below on revoking access.
Sufficient API calls available to pull and refresh the data.

To de-authorize Power BI from being connected to your GitHub repo you can Revoke access in GitHub. For more
details see this GitHub help topic.

 

You can determine the owner and repository by looking at the repository in GitHub itself:

The first part "Azure" is the owner and the second part "azure-sdk-for-php" is the repository itself. You see these
same two items in the URL of the repository:

If necessary, you can verify your GitHub credentials.

1. In another browser window, go to the GitHub web site and log in to GitHub. You can see you’re logged in, in the
upper-right corner of the GitHub site.

2. In GitHub, navigate to the URL of the repo you plan to access in Power BI. For example:
https://github.com/dotnet/corefx.

3. Back in Power BI, try connecting to GitHub. In the Configure GitHub dialog box, use the names of the repo and
repo owner for that same repo.

Get started with Power BI
Get data

https://help.github.com/articles/keeping-your-ssh-keys-and-application-access-tokens-safe/#reviewing-your-authorized-applications-oauth
https://github.com/dotnet/corefx


Connect to Insightly with Power BI
1/19/2018 • 2 min to read • Edit Online

How to connect

Visualize and share your Insightly CRM data in Power BI with the Insightly content pack. Connect to Power BI using
your Insightly API key to view and build reports and dashboards from your CRM data. With Power BI, you can
analyze your data in new ways, create powerful graphs and charts, and display contacts, leads, and organizations on
a map.

Connect to the Insightly content pack for Power BI.

1. Select Get Data at the bottom of the left navigation pane.

2. In the Services box, select Get.

3. Select Insightly > Get.

4. Select Key as the Authentication type and provide your Insight API Key then select Sign In. See details on
finding this below.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-connect-to-insightly.md
https://app.powerbi.com/getdata/services/insightly


5. After approving, the import process will begin automatically. When complete, a new dashboard, report and
model will appear in the Navigation Pane. Select the dashboard to view your imported data.

What now?

Try asking a question in the Q&A box at the top of the dashboard
Change the tiles in the dashboard.
Select a tile to open the underlying report.
While your dataset will be schedule to refreshed daily, you can change the refresh schedule or try refreshing it
on demand using Refresh Now



What's included

TABLES

Contacts Opportunities Pipeline Stages Task Complete Date

Custom Fields Opportunity Close Date Project Complete Date Tasks

Events Opportunity Forecast Date Projects Teams/Members

Leads Organizations Tags Users

System requirements

Finding parameters

The content pack includes the following tables with fields from the corresponding records:

Many tables and reports also include unique calculated fields, such as:

Tables with “grouped” opportunity forecast close dates, opportunity actual close dates, project completion dates,
and task completion dates for analysis by month, quarter, or year.
A weighted value field for opportunities (opportunity value * probability of winning).
Average and total duration fields for tasks, based on start and completed dates.
Reports with calculated fields for opportunity win rate (count of won/count of total opportunities) and win rate
value (value of won/value of total opportunities).

An Insightly account with access to the Insightly API is required. Visibility permissions will be based on the API key
used to establish the connection to Power BI. Any Insightly records visible to you will also be visible in the Power BI
reports and dashboards that you share with others.

 

API Key

To copy your API key from Insightly, select User Settings from the Insightly profile menu and scroll down. This
string of characters will be used to connect your data to Power BI.



Troubleshooting

Next steps

Your data is imported via the Insightly API, which includes a daily limit based on your Insightly subscription plan
level. The limits are listed in the Rate Limiting/Throttling Requests section of our API documentation:
https://api.insight.ly/v2.2/Help#!/Overview/Introduction#ratelimit

The provided reports use default fields from Insightly and may not include your customizations. Edit the report to
view all the available fields.

Get started in Power BI

Get data in Power BI



Connect to IntelliBoard with Power BI
1/19/2018 • 1 min to read • Edit Online

How to connect

IntelliBoard offers simplified access to your Moodle learning management system data through reporting services.
The IntelliBoard content pack for Power BI offers additional analytics, including metrics on your courses, registered
users, overall performance, and your LMS activity.

Connect to the IntelliBoard content pack for Power BI.

1. Select Get Data at the bottom of the left navigation pane.

2. In the Services box, select Get.

3. Select IntelliBoard, then select Get.

4. Select OAuth 2 and then Sign In. When prompted, provide your IntelliBoard credentials.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-connect-to-intelliboard.md
https://app.powerbi.com/getdata/services/intelliboard


5. Once connected, a dashboard, report and dataset will automatically be loaded. When completed, the tiles will
update with data from your IntelliBoard account.



What's included

- Activity  
- Agents  
- Auth  
- Countries  
- CoursesProgress  
- Enrollments
- Lang  
- Platform  
- Totals  
- UsersProgress    

System requirements

Next steps

What now?

Try asking a question in the Q&A box at the top of the dashboard
Change the tiles in the dashboard.
Select a tile to open the underlying report.
While your dataset will be schedule to refreshed daily, you can change the refresh schedule or try refreshing it
on demand using Refresh Now

The content pack includes data from the following tables:

An IntelliBoard account with permissions to the above tables is required in order to instantiate this content pack.

Get started with Power BI

Power BI - Basic Concepts



Connect to Lithium with Power BI
1/19/2018 • 1 min to read • Edit Online

NOTENOTE

How to connect

Lithium builds trusted relationships between the world's best brands and their customers, helping people get
answers and share their experiences. By connecting the Lithium content pack to Power BI, you can measure key
metrics about your online community to help drive sales, reduce service costs and increase loyalty.

Connect to the Lithium content pack for Power BI.

The Power BI content pack uses the Lithium API. Excessive calls to the API may result in additional charges from Lithium,
please confirm with your Lithium administrator.

1. Select Get Data at the bottom of the left navigation pane.

2. In the Services box, select Get.

3. Select Lithium > Get.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-connect-to-lithium.md
https://app.powerbi.com/getdata/services/lithium


4. Provide the URL of your Lithium community. It will be in the form of https://community.yoursite.com.

5. When prompted, enter your Lithium credentials. Select oAuth 2 as the Authentication Mechanism and click
Sign In and follow the Lithium authentication flow.

https://community.yoursite.com


6. Once the login flow is completed the import process will begin. When complete, a new dashboard, report
and model will appear in the Navigation Pane. Select the dashboard to view your imported data.

What now?

Try asking a question in the Q&A box at the top of the dashboard
Change the tiles in the dashboard.
Select a tile to open the underlying report.



System requirements

Next steps

While your dataset will be schedule to refreshed daily, you can change the refresh schedule or try refreshing it
on demand using Refresh Now

The Lithium content pack requires a Lithium community v15.9 or greater. Please check with your Lithium admin to
confirm.

Get started with Power BI

Power BI - Basic Concepts



Connect to MailChimp with Power BI
1/19/2018 • 1 min to read • Edit Online

How to connect

The Power BI content pack pulls data from your MailChimp account and generates a dashboard, a set of reports
and a dataset to allow you to explore your data. Pull in analytics to create MailChimp dashboards and quickly
identify trends within your campaigns, reports, and individual subscribers. The data is set to refresh daily ensuring
the data you're monitoring is up to date.

Connect to the MailChimp content pack for Power BI.

1. Select Get Data at the bottom of the left navigation pane.

2. In the Services box, select Get.

3. Select MailChimp > Get.

4. For Authentication Method, select oAuth2 > Sign In.

When prompted, enter your MailChimp credentials and follow the authentication process.

The first time you connect you will be prompted to allow Power BI read-only access to your account. Select

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-connect-to-mailchimp.md
https://powerbi.microsoft.com/integrations/mailchimp
https://app.powerbi.com/getdata/services/mailchimp


Allow to begin the import process, which can take a few minutes depending on the volume of data in your
account.

5. After Power BI imports the data you will see a new dashboard, report, and dataset in the left navigation
pane. This is the default dashboard that Power BI created to display your data. You can modify this
dashboard to display your data in any way you want.

What now?

Try asking a question in the Q&A box at the top of the dashboard



Next steps

Change the tiles in the dashboard.
Select a tile to open the underlying report.
While your dataset will be schedule to refreshed daily, you can change the refresh schedule or try refreshing it
on demand using Refresh Now

Get started with Power BI

Power BI - Basic Concepts



Connect to Mandrill with Power BI
1/19/2018 • 1 min to read • Edit Online

How to connect

The Power BI content pack pulls data from your Mandrill account and generates a dashboard, a set of reports and a
dataset to allow you to explore your data. Use Mandrill's analytics to quickly gain insights into your newsletter or
marketing campaign. The data is set to refresh daily ensuring the data you're monitoring is up to date.

Connect to the Mandrill content pack for Power BI.

1. Select Get Data at the bottom of the left navigation pane.

2. In the Services box, select Get.

3. Select Mandrill > Get.

4. For Authentication Method, select Key and provide your API key. You can find the key on the Settings

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-connect-to-mandrill.md
http://app.powerbi.com/getdata/services/mandrill


tab of the Mandrill dashboard. Select Sign In to begin the import process, which can take a few minutes
depending on the volume of data in your account.

5. After Power BI imports the data you will see a new dashboard, report, and dataset in the left navigation
pane. This is the default dashboard that Power BI created to display your data.

What now?

Try asking a question in the Q&A box at the top of the dashboard
Change the tiles in the dashboard.
Select a tile to open the underlying report.



Next steps

While your dataset will be schedule to refreshed daily, you can change the refresh schedule or try refreshing it
on demand using Refresh Now

Get started with Power BI

Power BI - Basic Concepts



Connect to Microsoft Azure Enterprise with Power BI
1/19/2018 • 2 min to read • Edit Online

How to connect

Explore and monitor your Microsoft Azure Enterprise data in Power BI with the Power BI content pack. The data will
be refreshed automatically once per day.

Connect to the Microsoft Azure Enterprise content pack for Power BI.

1. Select Get Data at the bottom of the left navigation pane.

2. In the Services box, select Get.

3. Select Microsoft Azure Enterprise > Get.

4. Provide the Azure Environment URL, the number months of data you want to import and your Azure

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-connect-to-azure-enterprise.md
https://app.powerbi.com/getdata/services/azure-enterprise


Enterprise enrollment number. Your Azure Environment URL will be https://ea.azure.com  or 
https://ea.windowsazure.cn . See details on finding these parameters below.

5. Provide your Access key to connect. The key for your enrollment can be found in your Azure EA Portal.

6. The import process will begin automatically. When complete, a new dashboard, report and model will
appear in the Navigation Pane. Select the dashboard to view your imported data.



What's included

System Requirements

Finding parameters

What now?

Try asking a question in the Q&A box at the top of the dashboard
Change the tiles in the dashboard.
Select a tile to open the underlying report.
While your dataset will be schedule to refreshed daily, you can change the refresh schedule or try refreshing it
on demand using Refresh Now

The Azure Enterprise content pack includes monthly reporting data for the range of months that you provide
during the connection flow. The range is a moving window, so the dates included will update as the dataset
refreshes.

The content pack requires access to the Enterprise features within the Azure Portal.

 

Power BI reporting is available for EA Direct, Partner and Indirect Customers who are able to view billing
information. Please read below for details about finding each of the values the connection flow expects.

Azure Environment URL

This value is typically https://ea.azure.com, however you can check the URL once you sign in to confirm.

https://ea.azure.com


Number of Months

This should be a number between 1-36 representing the number of months of data (from today) you'd like to
import.

Enrollment Number

This is your Azure Enterprise enrollment number which can be found on the home screen of the Azure
Enterprise Portal under “Enrollment Detail”.

Access Key

Your key can be found in the Azure Enterprise portal, under "Download Usage" > "API Access Key"

Additional Help

For additional help setting up the Azure Enterprise Power BI Pack, log in to the Azure Enterprise Portal to view
the API Help File under “Help” and additional instructions under Reports -> Download Usage -> API Access Key.

https://ea.azure.com/


Next steps
Get started in Power BI

Get data in Power BI



Connect to Microsoft Dynamics AX content pack with
Power BI
1/19/2018 • 1 min to read • Edit Online

How to connect

Microsoft Dynamics AX has three Power BI content packs targeted at different business users. The Financial
Performance content pack, designed specifically for CFOs, provides access to insights about your organization’s
financial performance. The Retail Channel Performance content pack is targeted for channel managers focuses on
sales performance to predict trends and uncover insights by drawing directly from Retail & Commerce data. The
Cost Management is designed for COOs and CFOs and provides details on operation performance.

Connect to the Microsoft Dynamics AX Retail Channel Performance, the Financial Performance or the Cost
Management content pack for Power BI.

1. Select Get Data at the bottom of the left navigation pane.

2. In the Services box, select Get.

3. Select one of the Dynamics AX content packs and choose Get.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-connect-to-microsoft-dynamics-ax.md
https://app.powerbi.com/getdata/services/dynamics-ax-retail-channel-performance
https://app.powerbi.com/getdata/services/dynamics-ax-financial-performance
https://app.powerbi.com/getdata/services/dynamics-ax-cost-management


4. Specify the URL of your Dynamics AX 7 environment. See details on finding those parameters below.

5. For Authentication Method, select oAuth2 > Sign In. When prompted, enter your Dynamics AX
credentials.



6. After approving, the import process will begin automatically. When complete, a new dashboard, report and
model will appear in the Navigation Pane. Select the dashboard to view your imported data.



What's included

System requirements

Finding parameters

Troubleshooting

Next steps

What now?

Try asking a question in the Q&A box at the top of the dashboard
Change the tiles in the dashboard.
Select a tile to open the underlying report.
While your dataset will be schedule to refreshed daily, you can change the refresh schedule or try refreshing it
on demand using Refresh Now

The content pack uses the Dynamics AX 7 OData feed to import data related to Retail Channel, Financial, and Cost
Management performance respectively.

This content pack requires a Dynamics AX 7 environment URL and the user should have access to the OData feed.

 The Dynamics AX 7 environment URL can be found in the browser when the user signs in. Just copy the URL of the
root Dynamics AX environment into the Power BI dialog.

The data may take some time to load depending on the size of your instance. If you're seeing empty reports within
Power BI, please confirm you have access to the OData tables required for the reports.

Get started in Power BI

Get data in Power BI



Connect to Microsoft Dynamics CRM with Power BI
11/9/2017 • 6 min to read • Edit Online

How to connect

Microsoft Dynamics CRM Online for Power BI allows you to easily access and analyze your data. Power BI uses the
OData feed to create a descriptive model, with all the entities and measures needed such as Accounts, Activities,
Opportunities, Product, Leads, Users and more. After you install the app, you can view the dashboard and reports in
the Power BI service (https://powerbi.com), and in the Power BI mobile apps.

Connect to Dynamics CRM Online Sales Manager or Service Manager. Read more about Dynamics CRM Online
integration with Power BI.

This connection requires Microsoft Dynamics CRM Online 2016 or later. More details on requirements below.

1. Select Apps in the left navigation pane > select Get apps in the upper-right corner.

2. In AppSource, select the Apps tab, and search for the service you want.

1. Select Microsoft Dynamics CRM Sales Manager or Microsoft Dynamics CRM Service Manager and
click Connect.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-connect-to-microsoft-dynamics-crm.md
https://powerbi.com
https://msit.powerbi.com/groups/me/getdata/services/dynamics-crm-sales-manager
https://msit.powerbi.com/groups/me/getdata/services/dynamics-crm-customer-service
https://powerbi.microsoft.com/integrations/microsoft-dynamicscrm


2. Provide the Service URL associated with your account. This will be in the form 
https://company.crm.dynamics.com , see more details below.

3. When prompted, provide your credentials (this step might be skipped if you are already signed in with your
browser). For Authentication Method, enter oAuth2 and click Sign In:



View the Microsoft Dynamics CRM dashboard and reports

4. After connecting, you'll see a dashboard customized for a Sales Manager or Service Manager, populated
with your own data:

When the import is complete, the new app will appear on the Apps page.

1. Select Apps in the left navigation pane > select the app.



What now?What now?

What's included

Sales ManagerSales Manager

2. You can ask a question by typing in the Q&A box, or click a tile to open the underlying report.

Try asking a question in the Q&A box at the top of the dashboard.
Select a tile to open the underlying report.
You can filter and highlight the data in the report, but you can't save your changes.
Your dataset is scheduled to refreshed daily. You can change the refresh schedule or try refreshing it on demand
using Refresh Now.

The sections below detail what's included for the Sales Manager and Service Manager personas.

Note that data in addition is limited based on the security role assigned to the Dynamics CRM Online user.

The dashboard and reports are meant to provide operational reporting on near term data with focus on a team or
group. Each query is limited to retrieve a maximum of 100K records from Dynamics CRM Online. If this limit is
exceeded due to high volume of data in your organization, provisioning will fail as data refresh Dynamics CRM
online will be terminated. If your account is too large, consider connecting through the Power BI Desktop to build a
custom solution.

 

The dashboard and reports contain key metrics such as:

Won Revenue
Win Rate
Open Revenue
Lost revenue
Expected Revenue
Average Deal Size and more.

They also contain key charts such as:

Won and Lost Revenue Trend, Won Revenue Vs Estimated Revenue Trend
Won Revenue by various dimensions such as Industry, Region, Territory
Sales Leaders By Revenue, Activities,



CRM ENTITY FILTERS APPLIED

Account All accounts which have related opportunities that have been
modified in the last 365 days.

Activity All activities modified in the last 90 days 
[modifiedon] > today - 90 days

Business Unit All business units which are not disabled 
[isdisabled] = false

Lead All leads modified in the last 180 days 
[modifiedon] > today - 180 days

Opportunity All opportunities modified in last 365 days 
[modifiedon] > today - 365 days

Opportunity Product All opportunity products modified in last 365 days 
[modifiedon] > today - 365 days

Product All active products 
[statecode] <> 1

Territory All territories

User All active users and not delegated admins 
[isdisabled] = false and [accessmode] <> 4

Service ManagerService Manager

Top Accounts, Top Won/Lost Deals,
New Leads Trend, Sales Pipeline and more.

These metrics and charts help to understand your sales organization performance and analyze sales pipeline across
your sales team.

Following table lists the CRM entities available for thsi service and also gives details on the filters applied to each of
the entity records.

 

These dashboard and reports contain key metrics such as:

CSAT Percentage
SLA Met percentage
Escalated Cases Percentage
Average Handling Time
Total Resolved Cases
Total Active Cases
Number of Times KB Article Used in cases and more.

They also contains key charts such as:

Case Volume Trends for Incoming Cases, Resolved Cases, Escalated Cases
Case Volume by various dimensions such as Origin, Location, Priority, Type
Leaders by CSAT percentage, SLA met percentage, Activities, Resolved cases
Most Used and Most viewed KB Articles and more.
  These metrics and charts help to understand your support organization performance and analyze active cases



CRM ENTITY FILTERS APPLIED

Account All accounts which have related cases that have been modified
in the last 90 days.

Activity All activities modified in the last 90 days 
[modifiedon] > today - 90 days

Case All cases modified in the last 90 days 
[modifiedon] > today - 90 days

Case Resolution Activity All case resolution activities modified in the last 90 days 
[modifiedon] > today - 90 days

Contact All contacts which have related cases that have been modified
in the last 90 days.

Knowledge Article All latest version of knowledge articles 
[islatestversion] = true

Knowledge Article Incident All knowledge article incidents which are modified in the last
90 days 
[modifiedon] > today - 90 days

Queue All active queues 
[statecode] = 0

Queue Item All case related queue items created on the past 365 days 
[createdon] > today - 365 days and 
[objecttypecode] = 112

User All active users 
[isdisabled] = false

System requirements

Finding parameters

workload across your service team and service queues.

Following table lists the CRM entities available for this service, as well as details on the filters applied to each of the
entity records.

 

A valid Dynamics CRM Online 2016 or later instance (Power BI won't work with an on-premises CRM version). If
you do not have 2016 or later:
An administrator must enable the OData endpoint in the site settings.
An account with less than 100k records in any of the tables. Note if the account has access to more than 100k
records the import will fail.

 

The address of the instance can be found in the URL bar of your browser. It typically has the format: 
https://[instance_name].crm.dynamics.com .

Power BI only supports Dynamics CRM 2016 endpoints. The connection will not work with earlier versions of CRM
Online. Use Power BI Desktop to connect directly to your account.



Troubleshooting

Next steps

If you're having trouble connecting, confirm:

you're providing the correct instance URL (check with your admin)
the instance is CRM Online 2016
the OData endpoint is enabled

Also, try connecting directly in Power BI Desktop, with the OData URL 
https://[instance_name].crm.dynamics.com/api/data/v8.0/ .

If you confirm you have Dynamics CRM Online 2016 but you're still hitting issues connecting, contact your CRM
Admin to confirm you have all available updates.

If you do not have CRM Online 2016 or later, use the Power BI Desktop to connect directly to your account.

If you see an error "Data refresh failed as query exceeded the maximum limit of 100000 records," consider
connecting directly from the Power BI Desktop or leveraging the CRM solution template.

What are apps in Power BI?
Get data in Power BI
More questions? Try asking the Power BI Community

http://community.powerbi.com/


Connect to Microsoft Dynamics Marketing with
Power BI
1/19/2018 • 2 min to read • Edit Online

NOTENOTE

How to connect

The Microsoft Dynamics Marketing content pack for Power BI allows you to easily access and analyze your data
from Dynamics Marketing. The content pack uses a descriptive model on top of the OData feed, with all the entities
and measures needed such as Programs, Campaigns, Marketing Contacts and Companies, Leads, Lead Interactions
and Lead Scoring, Email Marketing Messages and Web Sites, behavioral observations, budgets, financial
transactions, performance KPIs, and many more.

Connect to Dynamics Marketing content pack for Power BI.

You need to specify a valid OData URL for a Dynamics Marketing instance (the content pack will not work with an on-
premises CRM version). See additional requirements below.

1. Select Get Data at the bottom of the left navigation pane.

2. In the Services box, select Get.

3. Select Microsoft Dynamics Marketing > Get.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-connect-to-microsoft-dynamics-marketing.md
https://app.powerbi.com/getdata/services/microsoft-dynamics-marketing


4. Provide the OData URL associated with your account. This will be in the form
"https://[instance_name].marketing.dynamics.com/analytics."

5. When prompted, provide your credentials (this step might be skipped if you are already signed in with your
browser). For Authentication Method, enter oAuth2 and click Sign In:

6. After connecting, you'll see a Dynamics Marketing dashboard, populated with your own data. The yellow
asterisks mark the new items in the left navigation pane.



System requirements

Troubleshooting

What now?

Try asking a question in the Q&A box at the top of the dashboard
Change the tiles in the dashboard.
Select a tile to open the underlying report.
While your dataset will be schedule to refreshed daily, you can change the refresh schedule or try refreshing it
on demand using Refresh Now

You need to specify a valid OData URL for a Dynamics Marketing instance (the content pack will not work with
an on-premises CRM version).
An administrator must enable the OData endpoint in the site settings. The address of the OData endpoint can be
found by navigating to Home > Settings > Site Settings in the section Organization Data Service. The
OData URL has the format: https://[instance_name].marketing.dynamics.com/analytics
The user account/identity that you use to access Microsoft Dynamics Marketing must be the same as the one
you are signed up for using with Power BI. When logging into Microsoft Dynamics Marketing, you will be auto-
signed in with the same identity you are using for Power BI. If you wish to sign into Microsoft Dynamics
Marketing with a different account, please register as a Power BI user using that other account. We hope to
resolve this issue in an upcoming release.

If you see a "Login failed" message when trying to connect to your Dynamics CRM acount, confirm that you're
signing into Power BI with the same account you would use to access the CRM Online OData feed. Try logging into
the feed in your browser as well, to test it there.

Ask your admin to confirm the correct OData URL, and that the OData endpoint is enabled.



Next steps

Check the version of Dynamics Marketing you're using - there were additional fixes made in 18.0 and 18.1, if
you're still hitting issues and are on an older version, you may considered upgrading.

If you're still having issues, open a support ticket to reach the Power BI team:

While in the Power BI app, select the question mark > Contact Support.
From the Power BI Support site (where you're reading this article), select Contact Support on the right side of
the page.

Get Data for Power BI

Get Started with Power BI



Connect to Microsoft Dynamics NAV with Power BI
11/9/2017 • 3 min to read • Edit Online

How to connect

Getting insights into your Microsoft Dynamics NAV data is easy with Power BI. Power BI retrieves your data, both
Sales and Financial, then builds an app with a dashboard and reports based on that data. Power BI needs your
permissions to the tables where data is retrieved from, in this case sales and finance data. More details on
requirements below. After you install the app, you can view the dashboard and reports in the Power BI service
(https://powerbi.com), and in the Power BI mobile apps.

Connect to the Microsoft Dynamics NAV for Power BI or read more about the Dynamics NAV integration with
Power BI.

1. Select Apps in the left navigation pane > select Get apps in the upper-right corner.

2. In AppSource, select the Apps tab, and search for the service you want.

1. Select Microsoft Dynamics NAV, then select Get.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-connect-to-microsoft-dynamics-nav.md
https://powerbi.com
https://app.powerbi.com/getdata/services/microsoft-dynamics-nav
https://powerbi.microsoft.com/integrations/microsoft-dynamics-nav


2. When prompted, enter your Microsoft Dynamics NAV OData URL. The URL should match the following
pattern:

https//instance.navserver.com:7048/DynamicsNAV90_Instance1/OData/Company('CRONUS%20International%20Ltd.')

"instance.navserver.com" with your NAV Server name
"DynamicsNAV90_Instance1" with your NAV Server Instance name
"Company('CRONUS%20International%20Ltd.')" with your NAV Company name

An easy way to obtain this URL is in Dynamics NAV to go to Web Services, find the powerbifinance
web service and copy the OData URL, but leaving out the “/powerbifinance” from the URL string.

3. Select Basic and enter your Microsoft Dynamics NAV credentials.



View the dashboard and reports

4. Power BI will retrieve your Microsoft Dynamics NAV data and create a ready-to-use dashboard and report for
you.

You need admin credentials (or at least permissions to sales and finance data) for your Microsoft Dynamics
NAV account. Only Basic (Username and Password) authentication is currently supported.

When the import is complete, the new app will appear on the Apps page.

1. Select Apps in the left navigation pane > select the app.



What now?What now?

What's included

System requirements

Troubleshooting

2. You can ask a question by typing in the Q&A box, or click a tile to open the underlying report.

Try asking a question in the Q&A box at the top of the dashboard.
Select a tile to open the underlying report.
You can filter and highlight the data in the report, but you can't save your changes.
Your dataset is scheduled to refreshed daily. You can change the refresh schedule or try refreshing it on demand
using Refresh Now.

The dashboard and reports contain data from the following tables (case sensitive):

ItemSalesAndProfit
ItemSalesByCustomer
powerbifinance
SalesDashboard
SalesOpportunities
SalesOrdersBySalesPerson
TopCustomerOverview

To import your Microsoft Dynamics NAV data into Power BI, you need to have permissions to the sales and finance
data tables where data is retrieved from (listed above). The tables are also required to have some data, empty tables
will currently fail to import.

Power BI uses Microsoft Dynamics NAV's web services to retrieve your data. If you have a lot of data in your
Microsoft Dynamics NAV instance, a suggestion to minimize the impact on your web service usage is to change the
refresh frequency depending on your needs. Another suggestion is to have one admin create the app and share it
instead of having every admin create their own.

"Parameter validation failed, please make sure all parameters are valid"



Next steps

If you see this error after typing your Microsoft Dynamics NAV URL. Make sure the following requirements are
satisfied:

Make sure all the letters are lower case.
Make sure the URL is in 'https'.
Make sure there are no trailing forward slash at the end of the URL.

The URL follows exactly this pattern:

https//instance.navserver.com:7048/DynamicsNAV90_Instance1/OData/Company('CRONUS%20International%20Ltd.')

"instance.navserver.com" with your NAV Server name
"DynamicsNAV90_Instance1" with your NAV Server Instance name
"Company('CRONUS%20International%20Ltd.')" with your NAV Company name

"Login failed"
If you get a "login failed" error after using your Microsoft Dynamics NAV credentials to login, then you may be
hitting one of the following issues:

The account you are using doesn't have permissions to retrieve the Microsoft Dynamics NAV data from your
account. Verify it is an admin account and try again.
The Dynamics NAV instance you're trying to connect to doesn't have a valid SSL certificate. In this case you'll see
a more detailed error message ("unable to establish trusted SSL relationship"). Note that self-signed certs are
not supported.

"Oops"
If you see an "Oops" error dialog after you pass the authentication dialog box, Power BI is running into an issue
while loading the data.

Verify the URL follows the pattern specified above. A common mistake is to specify:

https//instance.navserver.com:7048/DynamicsNAV90\_Instance1/OData

However, you need to include the 'Company('CRONUS%20International%20Ltd.')' section with your NAV
Company name:

https//instance.navserver.com:7048/DynamicsNAV90\_Instance1/OData/Company('CRONUS%20International%20Ltd.')

What are apps in Power BI?
Get data in Power BI
More questions? Try asking the Power BI Community

http://community.powerbi.com/


Connect to Office365Mon with Power BI
1/19/2018 • 1 min to read • Edit Online

NOTENOTE

How to connect

Analyzing your Office 365 outages and health performance data is easy with Power BI and the Office365Mon
content pack. Power BI retrieves your data, including outages and health probes, then builds an out-of-box
dashboard and reports based on that data.

Connect to the Office365Mon content pack for Power BI.

An Office365Mon admin account is required to connect and load the Power BI content pack.

1. Select Get Data at the bottom of the left navigation pane.

2. In the Services box, select Get.

3. Select Office365Mon > Get.

4. For Authentication Method, select oAuth2 > Sign In.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-connect-to-office365mon.md
https://app.powerbi.com/groups/me/getdata/services/office365mon


When prompted, enter your Office365Mon admin credentials and follow the authentication process.

5. After Power BI imports the data you will see a new dashboard, report, and dataset in the left navigation pane.
New items are marked with a yellow asterisk *, select the Office365Mon entry.



Troubleshooting

Next steps

What now?

Try asking a question in the Q&A box at the top of the dashboard
Change the tiles in the dashboard.
Select a tile to open the underlying report.
While your dataset will be schedule to refreshed daily, you can change the refresh schedule or try refreshing it
on demand using Refresh Now

If you get a "login failed" error after using your Office365Mon subscription credentials to login, then the account
you are using doesn't have permissions to retrieve the Office365Mon data from your account. Verify it is an admin
account and try again.

Get started with Power BI

Get Data for Power BI



Connect to Planview Enterprise with Power BI
1/19/2018 • 1 min to read • Edit Online

NOTENOTE

How to connect

With the Planview Enterprise content pack, you can visualize your resource and work management data in entirely
new ways directly in Power BI. Use your Planview Enterprise sign-in credentials to interactively see your portfolio
investment spend, understand where you are over and under budget, and know how well your projects align with
your corporate strategic priorities. You can also extend the out-of-the box dashboard and reports to get the insights
that are most important to you.

Connect to the Planview Enterprise content pack in Power BI

To import your Planview Enterprise data into Power BI, you must be a Planview Enterprise user with the Reporting Portal
Viewer feature enabled on your role. See additional requirements below.

3. On the Power BI page, select Planview Enterprise, then select Get:

1. Select Get Data at the bottom of the left navigation pane.

2. In the Services box, select Get.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-connect-to-planview.md
https://app.powerbi.com/getdata/services/planview-enterprise


4. In the Planview Enterprise URL text box, enter the URL for the Planview Enterprise server you want to use. In the
Planview Enterprise Database text box, enter the name of the Planview Enterprise database, then click Next.

5. On the Authentication Method list, select Basic if it is not already selected. Enter the Username and Password
for your account and select Sign In.



6. On the left pane, select Planview Enterprise from the list of dashboards.
Power BI imports Planview Enterprise data into the dashboard. Note that the data may take some time to load.

What now?

Try asking a question in the Q&A box at the top of the dashboard
Change the tiles in the dashboard.
Select a tile to open the underlying report.
While your dataset will be schedule to refreshed daily, you can change the refresh schedule or try refreshing it
on demand using Refresh Now



System requirements

Next steps:

To import your Planview Enterprise data into Power BI, you must be a Planview Enterprise user with the Reporting
Portal Viewer feature enabled on your role. See additional requirements below.

This procedure assumes you have already signed in to the Microsoft Power BI home page with a Power BI account.
If you do not have a Power BI account, create a new free Power BI account on the Power BI home page, and then
click Get Data.

Get started with Power BI

Get Data for Power BI



Connect to Prevedere with Power BI
1/19/2018 • 1 min to read • Edit Online

NOTENOTE

How to connect

Gain access to exclusive and critical financial information to confidently and proactively drive your business
forward.

Connect to the Prevedere content pack for Power BI.

If you are not an existing Prevedere user, please use the sample key to try it out.

1. Select Get Data at the bottom of the left navigation pane.

2. In the Services box, select Get.

3. Select Prevedere and then Get.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-connect-to-prevedere.md
https://app.powerbi.com/getdata/services/prevedere
https://prevederepowerbiconnector.azurewebsites.net/static/learnmore.html


4. For Authentication Method, select Key and enter your Prevedere API key.

5. Select Sign in to begin the import process. When complete, a new dashboard, report and model will appear
in the Navigation Pane. Select the dashboard to view your imported data.



What's included

System requirements

Finding parameters

Troubleshooting

Next steps

What now?

Try asking a question in the Q&A box at the top of the dashboard
Change the tiles in the dashboard.
Select a tile to open the underlying report.
While your dataset will be schedule to refreshed daily, you can change the refresh schedule or try refreshing it
on demand using Refresh Now

The content pack gains insights on your retail forecasts, forecast models, leading indicators, and more.

This content pack requires access to a Prevedere API key or the sample key (see below).

 Existing customers can access their data using their API key. If you are not yet a customer, you can see a sample of
the data and analyses using the sample key.

The data may take some time to load depending on the size of your instance.

Get started in Power BI

Get data in Power BI

https://prevederepowerbiconnector.azurewebsites.net/static/learnmore.html


Connect to Project Online with Power BI
1/19/2018 • 1 min to read • Edit Online

How to connect

Microsoft Project Online is a flexible online solution for project portfolio management (PPM) and everyday work.
Project Online enables organizations to get started, prioritize project portfolio investments and deliver the intended
business value. The Project Online content pack for Power BI allows you to explore your project data with out-of-
box metrics such as portfolio status and project compliance.

Connect to the Project Online content pack for Power BI.

1. Select Get Data at the bottom of the left navigation pane.

2. In the Services box, select Get.

3. Select Microsoft Project Online > Get.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-connect-to-project-online.md
https://app.powerbi.com/getdata/services/project-online


4. In the Project Web App URL text box, enter the URL for the Project Web Add (PWA) you want to connect to
and hit Next. Note this may differ from the example if you have a custom domain.

5. For Authentication Method, select oAuth2 > Sign In. When prompted, enter your Project Online credentials
and follow the authentication process.

6. You’ll see a notification indicating your data is loading. Depending on the size of your account this may take
some time. After Power BI imports the data you will see a new dashboard, report, and dataset in the left
navigation pane. This is the default dashboard that Power BI created to display your data. You can modify



Next steps

this dashboard to display your data in any way you want.

What now?

Try asking a question in the Q&A box at the top of the dashboard
Change the tiles in the dashboard.
Select a tile to open the underlying report.
While your dataset will be schedule to refreshed daily, you can change the refresh schedule or try refreshing it
on demand using Refresh Now

Get started in Power BI

Get data in Power BI



Connect to Project "Madeira" with Power BI
1/24/2018 • 4 min to read • Edit Online

NOTENOTE

How to connect

Getting insights into your Project “Madeira” data is easy with Power BI and the Project “Madeira” content pack.
Power BI retrieves your data, both Sales and Financial data then builds an out-of-box dashboard and reports based
on that data. Connect to the Project "Madeira" for Power BI or read more about the Project "Madeira" integration
with Power BI.

This content pack requires permissions to the tables where data is retrieved from, in this case sales and finance data. More
details on requirements below.

Connect to the Project "Madeira" Analytics content pack for Power BI.

1. Select Get Data at the bottom of the left navigation pane.

2. In the Services box, select Get.

3. Select Project "Madeira", then select Get.

4. When prompted, enter your Project “Madeira” URL. The URL needs to follow the following pattern exactly

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-connect-to-project-madeira.md
https://app.powerbi.com/getdata/services/project-madeira


NOTENOTE

https://mycronusus.projectmadeira.com:7048/NAV/OData/Company('CRONUS%20US') with your Project
“Madeira” company name. Note that there is no trailing slash at the end, and the connection is must be https.
See details on finding this URL below.

5. When prompted, select Basic as the Authentication Method, enter your Project “Madeira” email address as
the username, and then enter the web service access key for your Project “Madeira” account as the
password. If you are already signed in to Project “Madeira” in your browser, you may not be prompted for
credentials. See details on generating this access key below.

You must be a superuser in Project “Madeira”.

https://mycronusus.projectmadeira.com:7048/NAV/OData/Company('CRONUS US


System requirements

6. Once connected, a dashboard, report and dataset will automatically be loaded. When completed, the tiles will
update with data from your account.

What now?

Try asking a question in the Q&A box at the top of the dashboard
Change the tiles in the dashboard.
Select a tile to open the underlying report.
While your dataset will be schedule to refreshed daily, you can change the refresh schedule or try refreshing it
on demand using Refresh Now

 

To import your Project “Madeira” data into Power BI, you need to have permissions to the sales and finance data
tables where data is retrieved from. All the tables (case sensitive) required for the content pack include:



´´´ 
- ItemSalesAndProfit  
- ItemSalesByCustomer  
- powerbifinance  
- SalesDashboard  
- SalesOpportunities  
- SalesOrdersBySalesPerson  
- TopCustomerOverview  
´´´ 

Finding Parameters

Troubleshooting

  

Getting the right URL An easy way to obtain this URL is in Project “Madeira” to go to Web Services, find the
powerbifinance web service and copy the Odata URL (use right-click and Copy Shortcut), but leaving out the
“/powerbifinance…” part from the URL string.

Web Service Access Keys In order to use data from Project "Madeira", you will need to create a web service access
key for your user account. In Project “Madeira”, search for the Users page, and then open the card for your user
account. Here you can generate a new web services access key and copy it to the Password field in the Power BI
connection page.

When you start using Web Service Access Keys you will have to use in going forward, so select OK to the message
that pops up. When Creating the key you can select if it expires at a specific date or not.

When you choose OK, a key is created, so you can copy it copy it to the Password field in the Power BI connection
page.

The Power BI dashboard relies on the published web services that are listed above, and it will show data from the



- The URL follows exactly this pattern 
https://*mycronusus*.projectmadeira.com:7048/NAV/OData/Company('*CRONUS%20US*')  
- Delete any text after the company name in parenthesis  
- Make sure there are no trailing forward slash at the end of the URL.  
- Make sure the URL is uses a secure connection as indicated by the URL starting with https.  

- The account you are using does not have permissions to read the Project “Madeira” data from your account. 
Verify your user account in Project "Madeira", and make sure that you have used the right web service access 
key as the password, and then try again.  
- The Project "Madeira" instance that you are trying to connect to does not have a valid SSL certificate. In 
this case you'll see a more detailed error message ("unable to establish trusted SSL relationship"). Note that 
self-signed certs are not supported.  

Next steps

demonstration company or your own company if you import data from your current finance solution. However, if
something goes wrong, this section provides a workaround for the most typical issues.

**"Parameter validation failed, please make sure all parameters are valid" ** If you see this error after you enter
your Project “Madeira” URL, make sure the following requirements are satisfied:

"Login failed" If you get a "login failed" error when you log in to the dashboard, using your Project “Madeira”
credentials, then this can be caused by one of the following issues:

"Oops" If you see an "Oops" error dialog after you pass the authentication dialog, this is most frequently caused by
a problem connecting to the data for the content pack. Verify that the URL follows the pattern that was specified
earlier:
https://mycronusus.projectmadeira.com:7048/NAV/OData/Company('CRONUS%20US')

A common mistake is to specify the full URL for a specific web service:
https://mycronusus.projectmadeira.com:7048/NAV/OData/Company('CRONUS%20US')/powerbifinance

Or you might have forgotten to specify the company name:
https://mycronusus.projectmadeira.com:7048/NAV/OData/

Get started with Power BI

Power BI - Basic Concepts



Connect to Projectplace by Planview with Power BI
1/19/2018 • 1 min to read • Edit Online

NOTENOTE

How to connect

With the Projectplace by Planview content pack, you can visualize your collaborative project data in entirely new
ways directly in Power BI. Use your Projectplace sign-in credentials to interactively view key project statistics, find
out who your most active and productive team members are, and identify at-risk cards and activities across
projects in your Projectplace account. You can also extend the out-of-the box dashboard and reports to get the
insights that are most important to you.

Connect to the Projectplace content pack in Power BI

To import your Projectplace data into Power BI, you must be a Projectplace user. See additional requirements below.

1. Select Get Data at the bottom of the left navigation pane.

2. In the Services box, select Get.

3. On the Power BI page, select Projectplace by Planview, then select Get:

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-connect-to-projectplace.md
https://app.powerbi.com/getdata/services/projectplace


4. In the OData Feed URL text box, enter the URL for the Projectplace OData feed you want to use, as shown in
the following image:

5. On the Authentication Method list, select OAuth if it is not already selected. Hit Sign In and follow the login
flow.



System requirements

6. On the left pane, select Projectplace from the list of dashboards. Power BI imports Projectplace data into
the dashboard. Note that the data may take some time to load.

The dashboard contains tiles that display data from your Projectplace database. The following image shows
an example of the default Projectplace dashboard in Power BI.

What now?

Try asking a question in the Q&A box at the top of the dashboard
Change the tiles in the dashboard.
Select a tile to open the underlying report.
While your dataset will be schedule to refreshed daily, you can change the refresh schedule or try refreshing it
on demand using Refresh Now



Next steps

To import your Projectplace data into Power BI, you must be a Projectplace user. This procedure assumes you have
already signed in to the Microsoft Power BI home page with a Power BI account. If you do not have a Power BI
account, create a new free Power BI account on the Power BI home page, and then click Get Data.

Get started with Power BI

Power BI - Basic Concepts



Connect to QuickBooks Online with Power BI
1/19/2018 • 2 min to read • Edit Online

NOTENOTE

How to connect

When you connect to your QuickBooks Online data from Power BI you immediately get a Power BI dashboard and
Power BI reports that provide insights about your business cash flow, profitability, customers, and more. Use the
dashboard and reports as they are, or customize them to highlight the information you care most about. The data
is refreshed automatically once a day.

Connect to the QuickBooks Online content pack for Power BI.

To import your QuickBooks Online data into Power BI, you need to be an admin on your QuickBooks Online account and
sign in with your admin account credentials.

1. Select Get Data at the bottom of the left navigation pane.

2. In the Services box, select Get.

3. Select QuickBooks Online, then select Get.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-connect-to-quickbooks-online.md
https://dxt.powerbi.com/getdata/services/quickbooks-online


4. Select oAuth2 for Authentication Method and select Sign In.
5. When prompted, enter your QuickBooks Online credentials and follow the QuickBooks Online authentication

process. If you are already signed in to QuickBooks Online in your browser, you may not be prompted for
credentials. >[!NOTE] >You need admin credentials for your QuickBooks Online account.

6. Select the company you would like to connect to Power BI in the next screen.

7. Select Authorize in the next screen to begin the import process. This can take a few minutes depending on
the size of your company data.

After Power BI imports the data, you see a new dashboard, report, and dataset in the left navigation pane.
New items are marked with a yellow asterisk *.



Troubleshooting

8. Select the QuickBooks Online dashboard. This is the dashboard Power BI created automatically to display
your imported data. You can modify this dashboard to display your data any way you want.

What now?

Try asking a question in the Q&A box at the top of the dashboard
Change the tiles in the dashboard.
Select a tile to open the underlying report.
While your dataset will be schedule to refreshed daily, you can change the refresh schedule or try refreshing it
on demand using Refresh Now

“Oops! An error has occurred"



Next steps

If you get this message after selecting Authorize:

“Oops! An error has occurred." Please close this window and try again.

The application has already been subscribed to by another user for this company. Please contact [admin email] to
make changes to this subscription.”

... this means another admin in your company has already connected to your company data with Power BI. Ask that
admin to share the dashboard with you. Currently, only one admin user can connect a particular QuickBooks
Online company dataset to Power BI. After Power BI creates the dashboard, the admin can shared it with multiple
colleagues on the same Power BI tenants.

"This app is not set up to allow connections from your country"

Currently Power BI only supports US editions of QuickBooks Online.

Get started with Power BI

Power BI - Basic Concepts



Connect to SendGrid with Power BI
1/19/2018 • 1 min to read • Edit Online

How to connect

The Power BI content pack for SendGrid allows you to extract insights and statistics from your SendGrid account.
Using the SendGrid content pack you can visualize your SendGrid statistics in a dashboard.

Connect to the SendGrid content pack for Power BI.

1. Select Get Data at the bottom of the left navigation pane.

2. In the Services box, select Get.

3. Select the SendGrid content pack and click Get.

4. When prompted, provide your SendGrid user name and password. Select Sign In.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-connect-to-sendgrid.md
https://app.powerbi.com/getdata/services/sendgrid


What's included

5. After Power BI imports the data, you see a new dashboard, report, and dataset in the left navigation pane,
populated with your email statistics for the past 90 days. New items are marked with a yellow asterisk *.

What now?

Try asking a question in the Q&A box at the top of the dashboard
Change the tiles in the dashboard.
Select a tile to open the underlying report.
While your dataset will be schedule to refreshed daily, you can change the refresh schedule or try refreshing it
on demand using Refresh Now

The following metrics are available in the SendGrid dashboard:

Overall email statistics - Requests, Delivered, Bounced, Spam Blocked, Spam Report, etc.
Email statistics by category
Email statistics by geography
Email statistics by ISP
Email statistics by device, client, browser



Next steps
Get started with Power BI

Get Data



Connect to ServiceNow with Power BI for incident
reporting
1/19/2018 • 1 min to read • Edit Online

How to connect

ServiceNow offers multiple products and solutions including business, operations and IT management to improve
your business. This content pack includes multiple reports and insights on your open, recently resolved and
recently closed incidents.

Connect to the Power BI content pack for ServiceNow Incidents.

1. Select Get Data at the bottom of the left navigation pane.

2. In the Services box, select Get.

3. Select ServiceNow Incidents > Get.

4. Provide the URL of your ServiceNow instance and the range of days/records to bring in. Note as soon as one
limit is hit the import will stop.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-connect-to-servicenow.md
https://app.powerbi.com/getdata/services/servicenow


5. When prompted, enter your ServiceNow Basic credentials. Note single sign on is not supported today, more
details on the system requirements below.

6. Once the login flow is completed the import process will begin. When complete, a new dashboard, report
and model will appear in the Navigation Pane. Select the dashboard to view your imported data.



System requirements

Troubleshooting

Next steps

What now?

Try asking a question in the Q&A box at the top of the dashboard
Change the tiles in the dashboard.
Select a tile to open the underlying report.
While your dataset will be schedule to refreshed daily, you can change the refresh schedule or try refreshing it
on demand using Refresh Now

To connect you will need:

An account that can access yourorganization.service-now.com with Basic authentication (Single Sign-On is not
supported in this version)
The account must have rest_service role and read access to incident table

If you're hitting a credential error during load, please review the access requirements above. If you have the correct
permissions and are still hitting issues, please work with your ServiceNow admin to ensure you have any additional
permissions that may be required for your custom instance.

If you're seeing long load times, please review the number of incidents and number of days you specified during
connection and consider reducing it.

Get started with Power BI

Power BI - Basic Concepts



Connect to Smartsheet with Power BI
1/19/2018 • 1 min to read • Edit Online

NOTENOTE

How to connect

Smartsheet offers an easy platform for collaboration and file sharing. The Smartsheet content pack for Power BI
provides a dashboard, reports and dataset that shows an overview of your Smartsheet account. You can also use
the Power BI Desktop to connect directly to individual sheets in your account.

Connect to the Smartsheet content pack for Power BI.

Smartsheet admin account is preferred to connect and load the Power BI content pack as it has additional access.

1. Select Get Data at the bottom of the left navigation pane.

2. In the Services box, select Get.

3. Select Smartsheet > Get.

4. For Authentication Method, select oAuth2 > Sign In.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-connect-to-smartsheet.md
https://app.powerbi.com/groups/me/getdata/services/smartsheet


When prompted, enter your Smartsheet credentials and follow the authentication process.

5. After Power BI imports the data you will see a new dashboard, report, and dataset in the left navigation pane.
New items are marked with a yellow asterisk *, select the Smartsheet entry.



What's included

Next steps:

What now?

Try asking a question in the Q&A box at the top of the dashboard
Change the tiles in the dashboard.
Select a tile to open the underlying report.
While your dataset will be schedule to refreshed daily, you can change the refresh schedule or try refreshing it
on demand using Refresh Now

The Smartsheet content pack for Power BI includes an overview of your Smartsheet account, such as the number of
workspaces, reports and sheets you have, when they're modified etc. Admin users will also see some information
around the users in their system, such as top sheet creators.

To connect directly to individual sheets in your account, you can use the Smartsheet connector in the Power BI
Desktop.

Get started with Power BI

Get Data for Power BI



Connect to SparkPost with Power BI
1/19/2018 • 1 min to read • Edit Online

How to connect

The Power BI content pack for SparkPost allows you to extract valuable datasets from your SparkPost account all
into one insightful dashboard. Using the SparkPost content pack you can visualize your overall email statistics,
including domains, campaigns, and engagement by ISP.

Connect to the SparkPost content pack for Power BI.

1. Select Get Data at the bottom of the left navigation pane.

2. In the Services box, select Get.

3. Select the SparkPost content pack and click Get.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-connect-to-sparkpost.md
https://app.powerbi.com/getdata/services/spark-post


4. When prompted, provide your SparkPost API key and select Sign In. See details on finding this parameters
below.

5. Your data will start to load, depending on the size of you account this may take some time. After Power BI
imports the data, you’ll see the default dashboard, report, and dataset in the left navigation pane, populated
with your email statistics for the past 90 days. New items are marked with a yellow asterisk *.

What now?

Try asking a question in the Q&A box at the top of the dashboard



What's included

Finding parameters

Change the tiles in the dashboard.
Select a tile to open the underlying report.
While your dataset will be schedule to refreshed daily, you can change the refresh schedule or try refreshing it
on demand using Refresh Now

The SparkPost content pack for Power BI includes information including unique clicks, accepted rates, bounce rates,
delayed rates, rejection rates and more.

 

The content pack uses an API key to connect your SparkPost account to Power BI. You can find your API key in your
account under Account > API & SMTP (more details here). We suggest using an API key with permissions for 
Message Events: Read-only and Metrics: Read-only

https://support.sparkpost.com/customer/portal/articles/1933377-create-api-keys


SQL Database Auditing content pack for Power BI
1/19/2018 • 1 min to read • Edit Online

NOTENOTE

How to connect

The Power BI content pack for Azure SQL Database Auditing allows you to understand your database activity and
gain insight into discrepancies and anomalies that could indicate business concerns or suspected security
violations.

Connect to the SQL Database Auditing content pack for Power BI.

The content pack imports data from all tables that contain “AuditLogs” in their name and append it to a single data model
table named “AuditLogs”. The last 250k events will be included and the data will be refreshed daily.

1. Select Get Data at the bottom of the left navigation pane.

2. In the Services box, select Get.

3. Select SQL Database Auditing > Get.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-connect-to-azure-sql-database-auditing.md
http://azure.microsoft.com/documentation/articles/sql-database-auditing-get-started/
https://app.powerbi.com/getdata/services/sql-db-auditing


IMPORTANTIMPORTANT

4. In the Connect to Sql Database Auditing window:

Enter the Azure Table Storage account name or URL where your logs are stored.

Enter the name of the SQL server that you are interested in. Enter “*” to load audit logs for all servers.

Enter the name of the SQL database that you are interested in. Enter “*” to load audit logs for all
databases.

Enter the name of the Azure table that contains the logs you are interested. Enter “*” to load audit
logs from all tables that contain “AuditLogs” in their name.

For performance reasons it is advisable to always specify an explicit table name even if all audit logs are stored in a
single table.

Enter the start date of audit logs you are interested in. Enter “*” to load audit logs without a lower
time limit, or “1d” to load audit logs from the last day.

Enter the end date of audit logs you are interested in. Enter “*” to load audit logs without an upper
time limit.

5. For Authentication Method, select Key, enter your** Account Key** > Sign In.



Next steps

6. After Power BI imports the data, you see a new dashboard, report, and dataset in the left navigation pane.
New items are marked with a yellow asterisk *.

What now?

Try asking a question in the Q&A box at the top of the dashboard
Change the tiles in the dashboard.
Select a tile to open the underlying report.
While your dataset will be schedule to refreshed daily, you can change the refresh schedule or try refreshing it
on demand using Refresh Now

Get data for Power BI Get started with Power BI



Connect to SQL Sentry with Power BI
1/19/2018 • 2 min to read • Edit Online

NOTENOTE

How to connect

Analyzing your performance data collected by SQL Sentry is easy with Power BI. Power BI retrieves your data, then
builds a default dashboard and related reports based on that data.

Connect to the SQL Sentry content pack for Power BI.

Access to a SQL Sentry account you use for connecting to http://cloud.sqlsentry.com and a Database ID you will monitor is
required to connect. Instructions for where to find the Database ID are below.

1. Select Get Data at the bottom of the left navigation pane.

2. In the Services box, select Get.

3. Select SQL Sentry > Get.

4. Provide the Database ID of the database you’d like to monitor in Power BI. See more details on finding this

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-connect-to-sql-sentry.md
https://app.powerbi.com/groups/me/getdata/services/sql-sentry
http://cloud.sqlsentry.com


below.

5. For Authentication Method, select oAuth2 > Sign In.

When prompted, enter your cloud.sqlsentry.com credentials and follow the SQL Sentry authentication
process.

The first time you connect, Power BI prompts you to allow read-only access to your account. Select Grant to
begin the import process. The import process can take a few minutes depending on the volume of data in
your account.

6. After Power BI imports the data you will see a new dashboard, report, and dataset in the left navigation
pane. New items are marked with a yellow asterisk *:



What's included

TABLE NAME DESCRIPTION

Connection This table provides information about your SQL Sentry defined
connections.

Date This table contains dates from today back to the earliest date
from which performance data was collected and retained.

Downtime This table contains information related to your downtime and
uptime for each server that is monitored in your environment.

Memory Usage This table contains data about how much memory is available
or free in each of your servers.

Server This table contains records for each server in your
environment.

7. Select the SQL Sentry dashboard.

This is the default dashboard that Power BI creates to display your data. You can modify this dashboard to
display your data in any way you want.

What now?

Try asking a question in the Q&A box at the top of the dashboard
Change the tiles in the dashboard.
Select a tile to open the underlying report.
While your dataset will be schedule to refreshed daily, you can change the refresh schedule or try refreshing it
on demand using Refresh Now

The following data is available from SQL Sentry in Power BI :



Server Health This table contains data for all the events generated by
custom conditions in your environment, including severity and
count.

TABLE NAME DESCRIPTION

Finding Parameters

![](media/service-connect-to-sql-sentry/database2.png)

![](media/service-connect-to-sql-sentry/database.png)

Troubleshooting

Next steps

 

The Database ID can be found by logging into https://cloud.sqlsentry.com in a new web browser window. The
Database ID is listed on the main overview page:

The Database ID is also shown on the Database Details screen:

If data from some of your apps is not showing up in Power BI, check to make sure that you are using the correct
Database ID and that you have the authority to view the data.

If you are not the owner if the SQL Sentry database that is being synchronized to https://cloud.sqlsentry.com,
please contact your administrator to make sure you have rights to view the collected data.

Get started with Power BI

Get Data for Power BI

https://cloud.sqlsentry.com
https://cloud.sqlsentry.com


Connect to Stripe with Power BI
1/19/2018 • 1 min to read • Edit Online

How to connect

Visual and explore your Stripe data in Power BI with the Power BI content pack. The Power BI Stripe content pack
pulls in data about your Customers, Charges, Events and Invoices. The data includes the most recent ten thousand
events and five thousand charges over the last 30 days. The content will be refreshed automatically once per day at
a schedule you control.

Connect to the Stripe content pack for Power BI.

1. Select Get Data at the bottom of the left navigation pane.

2. In the Services box, select Get.

3. Select Stripe > Get.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-connect-to-stripe.md
https://app.powerbi.com/getdata/services/stripe


4. Provide your Stripe API key to connect.

5. The import process will begin automatically. When complete, a new dashboard, report and model will
appear in the Navigation Pane, marked with an asterisk. Select the dashboard to view your imported data.

What now?

Try asking a question in the Q&A box at the top of the dashboard
Change the tiles in the dashboard.
Select a tile to open the underlying report.
While your dataset will be schedule to refreshed daily, you can change the refresh schedule or try refreshing it
on demand using Refresh Now

https://dashboard.stripe.com/account/apikeys


Next steps
Get started with Power BI

Get Data for Power BI



Connect to SweetIQ with Power BI
1/19/2018 • 1 min to read • Edit Online

How to connect

The Power BI content pack pulls data from your SweetIQ account and generates set of out of box content allowing
you to easily explore your data. Use the SweetIQ content pack to analyze data about your locations, listings, ratings
and reviews. The data is set to refresh daily ensuring the data you're monitoring is up to date.

Connect to the SweetIQ content pack for Power BI.

1. In the navigation pane on the left, click Get Data.

2. Select SweetIQ and click Get.

3. Provide your SweetIQ Client ID. This is typically an alpha-numeric value. For more details on finding this
value, see below.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-connect-to-sweetiq.md
https://app.powerbi.com/groups/me/getdata/services/sweetiq


4. Select Key authentication type and provide your Sweet IQ API Key. This is typically an alpha-numeric value.
For more details on finding this value, see below.

5. Power BI will start loading your data, which may take some time depending on the size of data in your
account. Once the load has completed, you'll see a new dashboard, report and dataset in the left navigation
pane.



Finding parameters

Next steps

What now?

Try asking a question in the Q&A box at the top of the dashboard
Change the tiles in the dashboard.
Select a tile to open the underlying report.
While your dataset will be schedule to refreshed daily, you can change the refresh schedule or try refreshing it
on demand using Refresh Now

The Client ID and API key for this content pack is not the same as your SweetIQ username and password.

Select a Client ID for one of the clients your account has access to. You can find the list of clients under "Client
Management" in your SweetIQ account.

Talk to your administrator for your API key, to access the data for specific client.

Get started with Power BI

Get Data for Power BI



Connect to Troux for Power BI
1/19/2018 • 1 min to read • Edit Online

How to connect

With the Troux content pack, you can visualize your Enterprise Architecture repository in entirely new ways directly
in Power BI. The content pack offers a set of insights on your business capabilities, the applications that deliver
those capabilities, and the technologies that support those applications that can be fully customized using Power BI.

Connect to the Troux content pack for Power BI.

1. Select Get Data at the bottom of the left navigation pane.

2. In the Services box, select Get.

3. Select Troux > Get.

4. Specify your Troux OData URL. See details on finding those parameters below.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-connect-to-troux.md
https://app.powerbi.com/getdata/services/troux


5. For Authentication Method, select Basic and provide your username and password (case sensitive), then
select Sign In.

6. After approving, the import process will begin automatically. When complete, a new dashboard, report and
model will appear in the Navigation Pane. Select the dashboard to view your imported data.



System requirements

Finding parameters

Troubleshooting

Next steps

What now?

Try asking a question in the Q&A box at the top of the dashboard
Change the tiles in the dashboard.
Select a tile to open the underlying report.
While your dataset will be schedule to refreshed daily, you can change the refresh schedule or try refreshing it
on demand using Refresh Now

Access to the Troux OData feed and Troux 9.5.1 or higher is required.

 

Your Customer Care team can provide your unique Troux OData feed URL to you

If you are seeing a timeout error after providing credentials, try connecting again.

Get started in Power BI

Get data in Power BI



Connect to Twilio with Power BI
1/19/2018 • 2 min to read • Edit Online

How to connect

The Microsoft Twilio content pack for Power BI allows you to pull your data into Power BI and creates an out of box
Twilio dashboard and report that shows insights on your data. You can also create your custom reports and
dashboard on the dataset Power BI creates. The data will be refreshed once a day so you are always looking at the
latest data.

Connect to the Twilio content pack for Power BI.

1. Select Get Data at the bottom of the left navigation pane.

2. In the Services box, select Get.

3. Select Twilio > Get.

4. For Authentication Method, select oAuth2 > Sign In. When prompted provide your Twilio credentials and
authorize the Power BI application to access your data.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-connect-to-twilio.md
https://powerbi.microsoft.com/integrations/twilio
https://app.powerbi.com/getdata/services/twilio


5. This will begin importing data from your Twilio account, and you will have your dashboard populated with
your calls and messages usage for the past 30 days.

What now?

Try asking a question in the Q&A box at the top of the dashboard
Change the tiles in the dashboard.
Select a tile to open the underlying report.
While your dataset will be schedule to refreshed daily, you can change the refresh schedule or try refreshing it
on demand using Refresh Now



What's included

    All Time Calls Count  
    All Time Calls Duration  
    All Time Calls Price  
    All Time Messages Price  
    All Time Messages Count  
    All Time Count of Phone Numbers  
    All Time Price of Phone Numbers  
    All Time Twilio Client Calls Price  
    All Time Twilio Client Calls Duration  
    All Time Twilio Client Calls Count  
    All Time Total Price  
    All Time Inbound Calls Price  
    All Time Inbound Calls Duration  
    All Time Inbound Calls Count  
    All Time Outbound Calls Price  
    All Time Outbound Calls Duration  
    All Time Outbound Calls Count  
    This Month Calls Price  
    This Month Calls Duration  
    This Month Calls Count  
    This Month Messages Count  
    This Month Messages Price  
    This Month Count of Phone Numbers  
    This Month Price of Phone Numbers  
    This Month Twilio Client Calls Price  
    This Month Twilio Client Calls Duration  
    This Month Twilio Client Calls Count  
    This Month Total Price  
    This Month Inbound Calls Price  
    This Month Inbound Calls Duration  
    This Month Inbound Calls Count  
    This Month Outbound Calls Price  
    This Month Outbound Calls Duration  
    This Month Outbound Calls Count  
    This Month Inbound Messages Price  
    This Month Inbound Messages Count  
    This Month Outbound Messages Price  
    This Month Outbound Messages Count

Troubleshooting

Next steps

The details for all calls and messages transactions for the last 30 days. You can do all sorts of analysis and
aggregation on this data.

A set of already aggregated stats that you may want to keep an eye on. This set includes:

If you have a very large amount of data in the past 30 days (hundreds of thousands of transactions), the data
retrieval step might fail. We are aware of the problem and working on solving it. Meanwhile, if you hit this issue
please use the support link at the top of your Power BI page to let us know and we'll contact you for further
investigations.

Get started in Power BI

Get data in Power BI



Connect to tyGraph with Power BI
1/19/2018 • 3 min to read • Edit Online

How to connect

Visualize and explore your tyGraph data in Power BI with the Power BI content pack. Start by connecting to your
tyGraph account and loading the dashboard, reports and dataset. The out of box content includes insights such as
the Measure of Active Engagement (MAE score) and Top Contributors. Customize it further to highlight the
information you care most about. The data will be refreshed automatically according to a schedule that you set.

Connect to tyGraph for Power BI.

1. Select Get Data at the bottom of the left navigation pane.

2. In the Services box, select Get.

3. Select tyGraph > Get.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-connect-to-tygraph.md
https://app.powerbi.com/getdata/services/tygraph


4. Specify the groups and time range you'd like to connect to, otherwise specify "All" to bring in all the data.
Note the date format that's expected (YYYY/MM/DD). See details on finding the parameters below.

5. Provide your tyGraph key to connect. See details on finding this value below.

If you are a Yammer Verified Admin
Your API key is sent to you in an email when your tyGraph account is successfully created. If you can no
longer find your key, you can request a new one by sending an email to support@unlimitedviz.com. If you
do not yet have a tyGraph account, you can start a trial at http://www.tygraph.com/.

If you are not a Yammer Verified Admin

The tyGraph content pack requires a tyGraph account created by a Yammer verified administrator. Once
created, supplemental keys can be issued to users within the same organization. If your verified admin has
not yet created a tyGraph account, contact them to have them do so. If they have, you can request a key by
sending an email to support@unlimitedviz.com.

http://www.tygraph.com/
mailto:support@unlimitedviz.com


6. After successful authentication, the import process will begin automatically. When complete, a new
dashboard, report and model will appear in the Navigation Pane. Select the dashboard to view your
imported data.

What now?



Finding parameters

Example: 2427647,946595,1154464

Example: 2013/10/29

Example: 2014/10/20

Next steps

Try asking a question in the Q&A box at the top of the dashboard
Change the tiles in the dashboard.
Select a tile to open the underlying report.
While your dataset will be schedule to refreshed daily, you can change the refresh schedule or try refreshing it
on demand using Refresh Now

 

You can bring in data on all the groups you have access to, or you can choose to specify a subset. You can also
create a subset of data by date. You can create multiple tyGraph dashboards to monitor specific sets of groups
and/or dates. Details on these parameters are below.

Groups

The tyGraph API can filter data by specific group ID. These are provided to the content pack in a comma separated
list.

You can Identify the group ID for a particular group in Yammer by navigating to the feed for the group, and
examining the URL.

In the above example, the Yammer Group ID is 4054844

From Date

The From Date allows you to restrict the earliest value for the data returned. Only data created on or after this date
will be loaded into the content pack. The format of the From Date is YYYY/MM/DD.

In the above example, all data from on or after October 29, 2013 will be loaded into the content pack.

To Date The To Date allows you to restrict the latest value for the data returned. It can be used in conjunction with
the From Date to load data from a range of dates. Only data created on or before this date will be loaded into the
content pack. The format of the To Date is YYYY/MM/DD.

In the above example, all data from on or prior to October 20, 2014 will be loaded into the content pack.

Get started in Power BI



Get data in Power BI



Connect to UserVoice with Power BI
1/19/2018 • 2 min to read • Edit Online

NOTENOTE

How to connect

Tracking and exploring your UserVoice data is easy with Power BI and the UserVoice content pack. Power BI
retrieves your data, including tickets, suggestions and satisfaction ratings, then builds an out-of-box dashboard and
reports based on that data.

Connect to the UserVoice content pack for Power BI.

An admin account is required to connect to the Power BI content pack. The content pack also leverages the UserVoice API
and will contribute usage towards the UserVoice limits. More details below.

1. Select Get Data at the bottom of the left navigation pane.

2. In the Services box, select Get.

3. Select UserVoice, then select Get.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-connect-to-uservoice.md
https://app.powerbi.com/getdata/services/uservoice


NOTENOTE

NOTENOTE

4. When prompted, enter your UserVoice URL. The URL needs to follow the following pattern exactly
https://fabrikam.uservoice.com replacing "fabrikam" with your product or service name.

There is no trailing slash at the end and the connection is in https.

5. When prompted, enter your UserVoice credentials and follow the UserVoice authentication process. If you
are already signed in to UserVoice in your browser, you may not be prompted for credentials. Grant the
Power BI application access to your data by clicking "Allow Access".

You need admin credentials for your UserVoice account.

6. Power BI will retrieve your UserVoice data and create a ready-to-use dashboard and report for you. Power BI
will retrieve the following data: all your suggestions, all your open tickets, all tickets created in the last 30
days including closed ones and all the user satisfaction ratings.

https://fabrikam.uservoice.com


Troubleshooting

What now?

Try asking a question in the Q&A box at the top of the dashboard
Change the tiles in the dashboard.
Select a tile to open the underlying report.
While your dataset will be schedule to refreshed daily, you can change the refresh schedule or try refreshing it
on demand using Refresh Now

"Parameter validation failed, please make sure all parameters are valid"

If you see this error after typing your UserVoice URL. Make sure the following requirements are satisfied:

The URL follows exactly this pattern "https://fabrikam.uservoice.com" replacing "fabrikam" with your correct
UserVoice URL prefix.
Make sure all the letters are lower case.
Make sure the URL is in 'https'.
Make sure there are no trailing forward slash at the end of the URL.

"Login failed"

If you get a "login failed" error after using your UserVoice credentials to login, then the account you are using
doesn't have permissions to retrieve the UserVoice data from your account. Verify it is an admin account and try
again.

"Oops something went wrong"

If you get this error message while the data is being loaded, make sure your UserVoice account hasn't exceeded its
monthly APIs usage quota. If all looks good, try connecting again. If the problem persists, please contact Power BI
support at https://community.powerbi.com.

https://fabrikam.uservoice.com
https://community.powerbi.com/


Next steps

Other

The Power BI UserVoice content pack uses UserVoice's APIs to retrieve your data. Make sure you monitor your API
usage so that you don't exceed your limit. If you have a lot of data in your UserVoice account, a suggestion to
minimize the impact on your API usage is to change the refresh frequency from the current default which is once a
day to only refresh on weekdays or every other day depending on your needs. Another suggestion is to have one
admin create the content pack and share it with the rest of the team instead of having every admin in your
organization create their own putting extra unnecessary load on the APIs

Get started in Power BI

Get data in Power BI



Connect to VMob with Power BI
1/19/2018 • 1 min to read • Edit Online

How to connect

Tracking and exploring your VMob data is easy with Power BI and the VMob content pack. Power BI will retrieve the
following data: User Statistics for all time and in the last 30 days, Retail KPI for the last 30 days and Campaign
Performance for the last 30 days.

Connect to the VMob content pack for Power BI.

1. Select Get Data at the bottom of the left navigation pane.

2. In the Services box, select Get.

3. Select VMob > Get.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-connect-to-vmob.md
https://app.powerbi.com/getdata/services/vmob


4. When prompted, enter your VMob URL and click on the Next button. This URL is provided by VMob
separately.

5. Choose Basic option in the Authentication method dropdown, enter your VMob username and password
and click on Sign In button.

6. The import process will begin automatically and Power BI will retrieve your VMob data to create a ready-to-
use dashboard and report for you.



Next steps

What now?

Try asking a question in the Q&A box at the top of the dashboard
Change the tiles in the dashboard.
Select a tile to open the underlying report.
While your dataset will be schedule to refreshed daily, you can change the refresh schedule or try refreshing it
on demand using Refresh Now

Get started in Power BI

Get data in Power BI



Connect to Webtrends with Power BI
1/19/2018 • 2 min to read • Edit Online

How to connect

The Webtrends content pack for Power BI includes a variety of out of box metrics such total page views and visits
by traffic source. Visualizing your Webtrends data in Power BI starts by connecting to your Webtrends account. You
can use the dashboard and reports provided, or customize them to highlight the information you care most about.
The data will be refreshed automatically once per day.

Connect to the Webtrends content pack for Power BI.

1. Select Get Data at the bottom of the left navigation pane.

2. In the Services box, select Get.

3. Select Webtrends > Get.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-connect-to-webtrends.md
https://app.powerbi.com/getdata/services/webtrends


4. The content pack connects to a specific Webtrends profile ID. See details on finding this parameter below.

5. Provide your Webtrends credentials to connect. Note that the username field expects your account and
username. See details below.

6. After approving, the import process will begin automatically. When complete, a new dashboard, report and
model will appear in the Navigation Pane. Select the dashboard to view your imported data.



What's included

REPORT NAME REPORT ID

Key Metrics

On-Site Searches 34awBVEP0P6

Exit Pages 7FshY8eP0P6

Next Pages CTd5rpeP0P6

Previous Pages aSdOeaUgnP6

Site Pages oOEWQj3sUo6

Onsite Ads Clickthroughs 41df19b6d9f

Cities aUuHskcP0P6

Countries JHWXJNcP0P6

Visitors xPcmTDDP0P6

What now?

Try asking a question in the Q&A box at the top of the dashboard
Change the tiles in the dashboard.
Select a tile to open the underlying report.
While your dataset will be schedule to refreshed daily, you can change the refresh schedule or try refreshing it
on demand using Refresh Now

   The Webtrends content pack pulls data from the following reports:



Visit Duration U5KAyqdP0P6

Search Phrases IKYEDxIP0P6

Traffic Sources JmttAoIP0P6

Search Engines yGz3gAGP0P6

Entry Pages i6LrkNVRUo6

REPORT NAME REPORT ID

NOTENOTE

- Sessions = Visits  
- New Users = New Visitors  
- Views per Session = Page Views per Visit  
- Avg Daily User Duration = Avg Time on Site per Visitor  

System requirements

Finding parameters

For SharePoint profiles, the metric names may be a little different than what's show in the Webtrends UI. The following
mapping is done to maintain consistency between SharePoint and Web profiles:

The content pack requires access to a Webtrends profile with the correct set of reports enabled.

   

Your Webtrends Profile ID can be found in the URL after you've selected a profile:

Your credentials are the same as what you enter when you sign into Webtrends, however we expect your account
and username in the same line, separated by a backslash:



Troubleshooting

Next steps

You may hit an issue while the content pack is loading, after you've provided your credentials. If you see the "Oops"
message during the loading, please review the troubleshooting suggestions below. If you're still having issues
please file a support ticket at https://support.powerbi.com

1. The correct Profile ID is being used, see the Finding Parameters for more details.
2. The user has access to the reports listed in the "What's included" section

Get started with Power BI
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https://support.powerbi.com


Connect to Windows Dev Center with Power BI
1/19/2018 • 1 min to read • Edit Online

How to connect

Explore and monitor your Windows Dev Center app analytics data in Power BI with the Power BI content pack. The
data will be refreshed automatically once per day.

Connect to the Windows Dev Center content pack for Power BI.

1. Select Get Data at the bottom of the left navigation pane.

2. In the Services box, select Get.

3. Select Windows Dev Center > Get.

4. Enter the application ID of an app you own and click Next. See details on finding those parameters below.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-connect-to-windows-dev-center.md
https://app.powerbi.com/getdata/services/devcenter


5. For Authentication Method, select oAuth2 > Sign In. When prompted, enter your Azure Active Directory
credentials associated with your Windows Dev Center account (more details in System Requirements).



6. After approving, the import process will begin automatically. When complete, a new dashboard, report and
model will appear in the Navigation Pane. Select the dashboard to view your imported data and choose a tile
to navigate to the underlying reports.



What's included

System requirements

Finding parameters

Next steps

What now?

Try asking a question in the Q&A box at the top of the dashboard
Change the tiles in the dashboard.
Select a tile to open the underlying report.
While your dataset will be schedule to refreshed daily, you can change the refresh schedule or try refreshing it
on demand using Refresh Now

The Dev Center Power BI content pack includes analytics data for your app and IAP acquisitions, ratings, reviews
and app health. Data is limited to the last 3 months. and is a moving window, so the dates included will update as
the dataset refreshes.

 

This content pack requires at least one at least one app published to the Windows Store and a Windows Dev Center
account (more details here).

 

You can find the application ID for an app by going to the App identity page under App management.

The application ID is on the end of your URL for Windows 10 Store, https://www.microsoft.com/store/apps/
{applicationId}

Get started in Power BI
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https://msdn.microsoft.com/windows/uwp/publish/manage-account-users
https://www.microsoft.com/store/apps/


Connect to Xero with Power BI
1/19/2018 • 3 min to read • Edit Online

How to connect

Xero is easy to use online accounting software that’s designed specifically for small businesses. Create compelling
visualizations based on your Xero financials with this Power BI content pack. Your default dashboard includes many
small business metrics like cash position, revenue vs. expenses, profit loss trend, debtor days and return on
investment.

Connect to the Xero content pack for Power BI or learn more about the Xero and Power BI integration.

1. Select Get Data at the bottom of the left navigation pane.

2. In the Services box, select Get.

3. Select Xero > Get.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-connect-to-xero.md
https://app.powerbi.com/getdata/services/xero
https://help.xero.com/Power-BI


4. Enter a nickname for the organisation associated with your Xero account. Anything will do, this is mostly to
help users with multiple Xero organizations keep them all straight. See details on below.

5. For Authentication Method and select OAuth, when prompted sign into your Xero account and select the
organisation to connect to. Once the login completes, select Sign In to start the loading process.



6. After approving, the import process will begin automatically. When complete, a new dashboard, report and
model will appear in the Navigation Pane. Select the dashboard to view your imported data.

What now?

Try asking a question in the Q&A box at the top of the dashboard
Change the tiles in the dashboard.
Select a tile to open the underlying report.



What's included

AREA DASHBOARD TILES REPORT

Cash Daily cash flow 
Cash in 
Cash out 
Closing balance by account 
Closing balance today

Bank Accounts

Customer Invoiced sales 
Invoiced sales by customer 
Invoiced sales growth trend 
Invoices due 
Outstanding receivables 
Overdue receivables

Customer 
Inventory

Supplier Billed purchases 
Billed purchases by supplier 
Billed purchases growth trend 
Bills due 
Outstanding payables 
Overdue payables

Suppliers 
Inventory

Inventory Monthly sales amount by product Inventory

Profit and loss Monthly profit and loss 
Net profit this fiscal year 
Net profit this month 
Top expense accounts

Profit and Loss

Balance sheet Total assets 
Total liabilities 
Equity

Balance Sheet

Health Current ratio 
Gross profit percentage 
Return on total assets 
Total liabilities to equity ratio

Health 
Glossary and Technical Notes

While your dataset will be schedule to refreshed daily, you can change the refresh schedule or try refreshing it
on demand using Refresh Now

The content pack dashboard includes tiles and metrics that cover a variety of areas, with corresponding reports to
learn more:

The dataset also includes the following tables to customize your reports and dashboards:

Addresses
Alerts
Bank Statement Daily Balance
Bank Statements
Contacts
Expense Claims
Invoice Line Items
Invoices



System requirements

Finding parameters

Troubleshooting

Next steps

Items
Month End
Organisation
Trial Balance
Xero Accounts

The following roles are required to access the Xero content pack: "Standard + Reports" or "Advisor".

 

Provide a name for your organisation to track in Power BI. This allows you to connect to multiple different
organisations. Note that you cannot connect to the same organisation multiple times, as it will affect the scheduled
refresh.

Xero users must have the following roles to access the Xero content pack for Power BI: "Standard + Reports" or
"Advisor". The content pack relies on the user-based permissions to access reporting data through Power BI.
If you receieve a failure after loading for some time, verify how long it took to see that error message. Note that
the access token provided by Xero is only valid for 30min so accounts with more data than can be loaded in that
timeframe will fail. We're actively working to improve this.
During the load the tiles on the dashboard will be in a generic loading state. This is not expected to change until
the full load completes. If you receive a notification that your load completed but the tiles are still loading, try
refreshing the dashboard tiles using the ... in the top right of your dashboard.
If your content pack fails to refresh, please check if you have connected to the same organisation more than
once in Power BI. Xero only allows a single active connection to an organisation and you may see an error
indicating your credentials are invalid if you connect to the same one more than once.
For issues connecting the Xero content pack for Power BI like error messages or very slow load times, first clear
the cache / cookies and restart the browser, then reconnect to Power BI.

For other issues, please file a ticket at http://support.powerbi.com if the issue persists.

Get started in Power BI

Get data in Power BI

http://support.powerbi.com


Connect to Zendesk with Power BI
1/19/2018 • 2 min to read • Edit Online

NOTENOTE

How to connect

The Zendesk content pack offers a Power BI dashboard and a set of Power BI reports that provide insights about
your ticket volumes and agent performance. You can use the dashboard and reports provided, or customize them
to highlight the information you care most about. The data will be refreshed automatically once a day.

Connect to the Zendesk content pack or read more about the Zendesk integration with Power BI.

A Zendesk Admin account is required to connect. More details on requirements below.

1. Select Get Data at the bottom of the left navigation pane.

2. In the Services box, select Get.

3. Select Zendesk > Get.

4. Provide the URL associated with your account. This will be in the form https://company.zendesk.com, see

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-connect-to-zendesk.md
https://app.powerbi.com/getdata/services/zendesk
https://powerbi.microsoft.com/integrations/zendesk
https://company.zendesk.com


NOTENOTE

details on finding these parameters below.

5. When prompted, enter your Zendesk credentials. Select oAuth 2 as the Authentication Mechanism and click
Sign In. Follow the Zendesk authentication flow. (If you are already signed in to Zendesk in your browser,
you may not be prompted for credentials.)

This content pack requires you connect with a Zendesk Admin account.

6. Click Allow to allow Power BI to access your Zendesk data.



7. Click Connect to begin the import process. After Power BI imports the data, you see a new dashboard,
report, and dataset in the left navigation pane. New items are marked with a yellow asterisk *.

What now?

Try asking a question in the Q&A box at the top of the dashboard
Change the tiles in the dashboard.
Select a tile to open the underlying report.
While your dataset will be schedule to refreshed daily, you can change the refresh schedule or try refreshing it
on demand using Refresh Now



What's included

System requirements

Finding parameters

Troubleshooting

Next steps

The Power BI content pack includes data on the following:

Users (end users and agents)
Organizations
Groups
Tickets

There's also a set of measures that have been calculated, such as Average Wait Time and Tickets Solved in the Last
7 days. A full list is included in the content pack.

 

A Zendesk Administrator account is required to access the Zendesk content pack. If you're an agent or an end user
and are interested in viewing your Zendesk data, please add a suggestion and review the Zendesk connector in the
Power BI Desktop.

 

Your Zendesk URL will be the same as the URL you use to sign into your Zendesk account. If you're not sure of your
Zendesk URL, you can use the Zendesk login help.

If you are having issues connecting, please check your Zendesk URL and confirm you're using an Zendesk
administrator account.

Get started with Power BI
Get data

https://www.zendesk.com/login/


Connect to Ziosk Survey Analytics with Power BI
1/19/2018 • 1 min to read • Edit Online

How to connect

Ziosk Survey Analytics content pack for Power BI offers restaurants with Ziosk tablets unparalleled access to
insights provided by Ziosk survey data, including segmentation by day, location, employee, and more.

Connect to the Ziosk Survey Analytics content pack for Power BI.

1. Select Get Data at the bottom of the left navigation pane.

2. In the Services box, select Get.

3. Select Ziosk Survey Analytics, then select Get.

4. Select OAuth 2 and then Sign In. When prompted, provide your Ziosk credentials.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-connect-to-ziosk.md
https://app.powerbi.com/getdata/services/ziosk-survey-analytics


5. Once connected, a dashboard, report and dataset will automatically be loaded. When completed, the tiles will
update with data from your Ziosk account.



What's included

- Alcohol Category  
- Appetizer Category  
- CommentKeywords  
- Date  
- Daypart  
- Dessert Category  
- FreeForm  
- Kids Category  
- Messages  
- Premium Content Category  
- Question  
- Store  
- Surveys  
- Weekday  

System requirements

Next steps

What now?

Try asking a question in the Q&A box at the top of the dashboard
Change the tiles in the dashboard.
Select a tile to open the underlying report.
While your dataset will be schedule to refreshed daily, you can change the refresh schedule or try refreshing it
on demand using Refresh Now

The content pack includes data from the following tables:

A Ziosk account with permissions to the above tables is required in order to instantiate this content pack.

Get started with Power BI
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Connect to Zuora with Power BI
1/19/2018 • 3 min to read • Edit Online

How to connect

Zuora for Power BI allows you to visualize important revenue, billing, and subscription data. Use the default
dashboard and reports to analyze usage trends, track billings and payments, and monitor recurring revenue, or
customize them to meet your own unique dashboard and reporting needs.

Connect to the Zuora for Power BI.

1. Select Get Data at the bottom of the left navigation pane.

2. In the Services box, select Get.

3. Select Zuora > Get.

4. Specify your Zuora URL. This is typically "https://www.zuora.com", see details on finding those parameters

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-connect-to-zuora.md
https://app.powerbi.com/getdata/services/Zuora
https://www.zuora.com


below.

5. For Authentication Method, select Basic and provide your username and password (case sensitive), then
select Sign In.

6. After approving, the import process will begin automatically. When complete, a new dashboard, report and
model will appear in the Navigation Pane. Select the dashboard to view your imported data.



What's included

TABLES

Account InvoiceItemAdjustment Refund

AccountingCode Payment RevenueSchedule

AccountingPeriod PaymentMethod RevenueScheduleItem

BillTo Product Subscription

DateDim ProductRatePlan TaxationItem

Invoice ProductRatePlanCharge Usage

InvoiceAdjustment RatePlan

InvoiceItem RatePlanCharge

What now?

Try asking a question in the Q&A box at the top of the dashboard
Change the tiles in the dashboard.
Select a tile to open the underlying report.
While your dataset will be schedule to refreshed daily, you can change the refresh schedule or try refreshing it
on demand using Refresh Now

The content pack uses the Zuora AQUA API to pull in the following tables:

It also includes these calculated measures:



MEASURE DESCRIPTION PSEUDO-CALCULATION

Account: Payments Total payment amounts in a time
period, based on payment effective
date.

SUM (Payment.Amount) 
WHERE
Payment.EffectiveDate =<
TimePeriod.EndDate
AND Payment.EffectiveDate >=
TimePeriod.StartDate

Account: Refunds Total refund amounts in a time period,
based on refund refund date. Amount is
reported as a negative number.

-1*SUM(Refund.Amount)
WHERE
Refund.RefundDate =<
TimePeriod.EndDate
AND Refund.RefundDate >=
TimePeriod.StartDate

Account: Net Payments Account Payments plus Account
Refunds in a time period.

Account.Payments + Account.Refunds

Account: Active Accounts The count of accounts that were active
in a time period. Subscriptions must
have started before (or on) time period
start date.

COUNT (Account.AccountNumber)
WHERE
Subscription.Status != "Expired"
AND Subscription.Status != "Draft"
AND Subscription.SubscriptionStartDate
<= TimePeriod.StartDate
AND (Subscription.SubscriptionEndDate
> TimePeriod.StartDate
OR
Subscription.SubscriptionEndDate =
null) –evergreen subscription

Account: Average Recurring Revenue Gross MRR per active account in a time
period.

Gross MRR / Account.ActiveAccounts

Account: Cancelled Subscriptions The count of accounts that cancelled a
subscription in a time period.

COUNT (Account.AccountNumber)
WHERE
Subscription.Status = "Cancelled"
AND Subscription.SubscriptionStartDate
<= TimePeriod.StartDate
AND Subscription.CancelledDate >=
TimePeriod.StartDate

Account: Payment Errors Total value of payment errors. SUM (Payment.Amount)
WHERE
Payment.Status = "Error"

Revenue Schedule Item: Recognized
Revenue

Total recognized revenue in an
accounting period.

SUM (RevenueScheduleItem.Amount)
WHERE
AccountingPeriod.StartDate =
TimePeriod.StartDate

Subscription: New Subscriptions Count of new subscriptions in a time
period.

COUNT (Subscription.ID)
WHERE
Subscription.Version = "1"
AND Subscription.CreatedDate <=
TimePeriod.EndDate
AND Subscription.CreatedDate >=
TimePeriod.StartDate



Invoice: Invoice Items Total invoice item charge amounts in a
time period.

SUM (InvoiceItem.ChargeAmount)
WHERE
Invoice.Status = "Posted"
AND Invoice.InvoiceDate <=
TimePeriod.EndDate
AND Invoice.InvoiceDate >=
TimePeriod.StartDate

Invoice: Taxation Items Total taxation item tax amounts in a
time period.

SUM (TaxationItem.TaxAmount)
WHERE
Invoice.Status = "Posted"
AND Invoice.InvoiceDate <=
TimePeriod.EndDate
AND Invoice.InvoiceDate >=
TimePeriod.StartDate

Invoice: Invoice Item Adjustments Total invoice item adjustment amounts
in a time period.

SUM (InvoiceItemAdjustment.Amount) 
WHERE
Invoice.Status = "Posted"
AND
InvoiceItemAdjustment.AdjustmentDate
<= TimePeriod.EndDate
AND
InvoiceItemAdjustment.AdjustmentDate
>= TimePeriod.StartDate

Invoice: Invoice Adjustments Total invoice adjustment amounts in a
time period.

SUM (InvoiceAdjustment.Amount) 
WHERE
Invoice.Status = "Posted"
AND
InvoiceAdjustment.AdjustmentDate <=
TimePeriod.EndDate
AND
InvoiceAdjustment.AdjustmentDate >=
TimePeriod.StartDate

Invoice: Net Billings Sum of invoice items, taxation items,
invoice item adjustments, and invoice
adjustments in a time period.

Invoice.InvoiceItems +
Invoice.TaxationItems +
Invoice.InvoiceItemAdjustments +
Invoice.InvoiceAdjustments

Invoice: Invoice Aging Balance Sum of posted invoice balances. SUM (Invoice.Balance) 
WHERE
Invoice.Status = "Posted"

Invoice: Gross Billings Sum of invoice item charge amounts for
posted invoices in a time period.

SUM (InvoiceItem.ChargeAmount) 
WHERE
Invoice.Status = "Posted"
AND Invoice.InvoiceDate <=
TimePeriod.EndDate
AND Invoice.InvoiceDate >=
TimePeriod.StartDate

MEASURE DESCRIPTION PSEUDO-CALCULATION



Invoice: Total Adjustments Sum of processed invoice adjustments
and invoice item adjustments associated
with posted invoices.

SUM (InvoiceAdjustment.Amount) 
WHERE
Invoice.Status = "Posted"
AND InvoiceAdjustment.Status =
"Processed"
+
SUM (InvoiceItemAdjustment.Amount) 
WHERE
Invoice.Status = "Posted"
AND invoiceItemAdjustment.Status =
"Processed"

Rate Plan Charge: Gross MRR Sum of monthly recurring revenue from
subscriptions in a time period.

SUM (RatePlanCharge.MRR) 
WHERE
Subscription.Status != "Expired"
AND Subscription.Status != "Draft"
AND RatePlanCharge.EffectiveStartDate
<= TimePeriod.StartDate
AND RatePlanCharge.EffectiveEndDate
> TimePeriod.StartDate
OR RatePlanCharge.EffectiveEndDate =
null --evergreen subscription

MEASURE DESCRIPTION PSEUDO-CALCULATION

System requirements

Finding parameters

Troubleshooting

Next steps

Access to the Zuora API is required.

 

Provide the URL you typically sign into to access your Zuora data. The valid options are:

https://www.zuora.com
https://www.apisandbox.zuora.com
The URL corresponding to your serivce instance

The Zuora content pack pulls in many different aspects of your Zuora account. If you don't use certain features you
may see correpesonding tiles/reports empty. If you have any issues loading, please contact Power BI Support.

Get started in Power BI

Get data in Power BI

https://www.zuora.com
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Dashboards in Power BI service
1/19/2018 • 4 min to read • Edit Online

NOTENOTE

A Power BI dashboard is a single page, often called a canvas, that uses visualizations to tell a story. Because it is
limited to one page, a well-designed dashboard contains only the most-important elements of that story.

The visualizations you see on the dashboard are called tiles and are pinned to the dashboard from reports. If
you're new to Power BI, you can get a good foundation by reading Power BI basic concepts.

Dashboards are a feature of Power BI service and are not available in Power BI Desktop. Dashboards can't be created on
mobile devices but they can be viewed and shared.

The visualizations on a dashboard come from reports and each report is based on one dataset. In fact, one way
to think of a dashboard is as an entryway into the underlying reports and datasets. Selecting a visualization takes
you to the report (and dataset) that was used to create it.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-dashboards.md


Advantages of dashboards

Dashboards versus reports

CAPABILITY DASHBOARDS REPORTS

Pages One page One or more pages

Data sources One or more reports and one or more
datasets per dashboard

A single dataset per report

Available in Power BI Desktop No Yes, can create and view reports in
Desktop

Pinning Can pin existing visualizations (tiles)
only from current dashboard to your
other dashboards

Can pin visualizations (as tiles) to any
of your dashboards. Can pin entire
report pages to any of your
dashboards.

Subscribe Can't subscribe to a dashboard Can subscribe to report pages

Filtering Can't filter or slice Many different ways to filter, highlight,
and slice

Set alerts Can create alerts to email you when
certain conditions are met

No

Feature Can set one dashboard as your
"featured" dashboard

Cannot create a featured report

Natural language queries Available from dashboard Not available from reports

Can change visualization type No. In fact, if a report owner changes
the visualization type in the report, the
pinned visualization on the dashboard
does not update

Yes

Can see underlying dataset tables and
fields

No. Can export data but can't see
tables and fields in the dashboard
itself.

Yes. Can see dataset tables and fields
and values.

Can create visualizations Limited to adding widgets to
dashboard using "Add tile"

Can create many different types of
visuals, add custom visuals, edit visuals
and more with Editing permissions

Dashboards are a wonderful way to monitor your business, to look for answers, and to see all of your most-
important metrics at a glance. The visualizations on a dashboard may come from one underlying dataset or
many, and from one underlying report or many. A dashboard combines on-premises and cloud-born data,
providing a consolidated view regardless of where the data lives.

A dashboard isn't just a pretty picture; it's highly interactive and highly customizable and the tiles update as the
underlying data changes.

Reports are often confused with dashboards since they too are canvases filled with visualizations. But there are
some major differences.



Customization Can do things with the visualizations
(tiles) like move and arrange, resize,
add links, rename, delete, and display
full screen. But the data and
visualizations themselves are read-
only.

In Reading view you can publish,
embed, filter,export, download as .pbix,
view related content, generate QR
codes, analyze in Excel, and more. In
Editing view you can do everything
mentioned so far and so much more.

CAPABILITY DASHBOARDS REPORTS

Dashboard creators and dashboard consumers

If you will be creating and sharing dashboardsIf you will be creating and sharing dashboards

If you will be receiving and consuming dashboardsIf you will be receiving and consuming dashboards

TIPTIP

Next steps

Depending on your role, you may be someone who creates dashboards for your own use or to share with
colleagues. You want to learn how to create and share dashboards. Or, you may be someone who receives
dashboards from others. You want to learn how to understand and interact with the dashboard.

Here are some topics, by role, to help you get started.

Power BI Pro is required for both sharing a dashboard and viewing a shared dashboard.

Use one of our samples to create a dashboard from a report.
Learn about dashboard tiles and all the different ways to pin them to a dashboard.
Help your dashboard consumers by creating dashboards that work well with Q&A natural language queries
and with Quick insights.
Discover all the different ways you can share a dashboard with colleagues.

Get comfortable with dashboards by taking a tour of one of our sample dashboards.
Learn about dashboard tiles and what will happen when you select one.
Don't like the look of a dashboard? You can resize, move, and rename the tiles.
Want to track an individual dashboard tile and receive an email when it reaches a certain threshold? Create
alerts on tiles.
Have fun asking your dashboard questions. Learn how to use Power BI Q&A to ask a question about your
data and get the answer in the form of a visualization.

If you didn’t find what you’re looking for here, use the Table of Contents to the left.

Get Started with Power BI
Power BI - Basic Concepts
Power BI Premium - what is it?

More questions? Try asking the Power BI Community

https://docs.microsoft.com/en-us/power-bi/service-dashboard-create
http://community.powerbi.com/


Create a copy of a dashboard in Power BI service
1/23/2018 • 1 min to read • Edit Online

There are many different reasons to make a copy of a dashboard. Maybe you want to make changes and test its
performance against the original; or create slightly different versions to distribute by colleague, region, or team.
Perhaps a colleague admires your dashboard design and wants to use it for reporting out to her managers. Another
reason would be if you have a new database with the same data structure and data types and want to reuse the
dashboard you've already created -- this too can be done but would require some work in Power BI Desktop.

Dashboards are created (and copied) using Power BI service and can be viewed in Power BI mobile and Power BI
Embedded. Dashboards are not available in Power BI Desktop.

To make a copy of a dashboard, you must be the dashboard creator. Dashboards that have been shared with you as
an app cannot be duplicated.

1. Open the dashboard.
2. From the top-right corner, select the ellipses (...) and choose Duplicate dashboard.

3. Give the dashboard a name and select Duplicate.

4. The new dashboard is saved in the same workspace as the original.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-dashboard-copy.md


Next steps

5. Open the new dashboard and edit as needed. Here are some things you might want to do next:
a. Move, rename, resize or even delete tiles.
b. Edit tile details and hyperlinks by selecting the tile ellipses (...) and choosing Edit details.
c. Add new tiles from the dashboard menubar (Add tile)
d. Pin new tiles from Q&A or from reports.
e. Rename the dashboard, turn Q&A on or off, and set the tile flow from the dashboard Settings pane. (select
the dashboard ellipses (...) dropdown and choose Settings)
f. Share your dashboard directly with colleagues or as part of a Power BI app.

Tips for designing a great dashboard

More questions? Try the Power BI Community

http://community.powerbi.com/


Create a copy of a dashboard in Power BI service
1/23/2018 • 1 min to read • Edit Online

There are many different reasons to make a copy of a dashboard. Maybe you want to make changes and test its
performance against the original; or create slightly different versions to distribute by colleague, region, or team.
Perhaps a colleague admires your dashboard design and wants to use it for reporting out to her managers.
Another reason would be if you have a new database with the same data structure and data types and want to
reuse the dashboard you've already created -- this too can be done but would require some work in Power BI
Desktop.

Dashboards are created (and copied) using Power BI service and can be viewed in Power BI mobile and Power BI
Embedded. Dashboards are not available in Power BI Desktop.

To make a copy of a dashboard, you must be the dashboard creator. Dashboards that have been shared with you
as an app cannot be duplicated.

1. Open the dashboard.
2. From the top-right corner, select the ellipses (...) and choose Duplicate dashboard.

3. Give the dashboard a name and select Duplicate.

4. The new dashboard is saved in the same workspace as the original.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-dashboard-copy.md


Next steps

5. Open the new dashboard and edit as needed. Here are some things you might want to do next:
a. Move, rename, resize or even delete tiles.
b. Edit tile details and hyperlinks by selecting the tile ellipses (...) and choosing Edit details.
c. Add new tiles from the dashboard menubar (Add tile)
d. Pin new tiles from Q&A or from reports.
e. Rename the dashboard, turn Q&A on or off, and set the tile flow from the dashboard Settings pane.
(select the dashboard ellipses (...) dropdown and choose Settings)
f. Share your dashboard directly with colleagues or as part of a Power BI app.

Tips for designing a great dashboard

More questions? Try the Power BI Community

http://community.powerbi.com/


Dashboard tiles in Power BI
1/3/2018 • 3 min to read • Edit Online

Dashboard tiles

NOTENOTE

Pin a tile from...

Dashboards and dashboard tiles are a feature of Power BI service, not Power BI Desktop. While
dashboards tiles cannot be created or pinned in Power BI mobile, they can be viewed and shared.
And, in Power BI mobile, you can add pictures to your dashboard with your iPhone app.

A tile is a snapshot of your data, pinned to the dashboard. A tile can be created from a report,
dataset, dashboard, from the Q&A box, Excel, and from SQL Server Reporting Services (SSRS),
and more. This screenshot shows many different tiles pinned to a dashboard.

Besides pinning, standalone tiles can be created directly on the dashboard using Add tile.
Standalone tiles include: text boxes, images, videos, streaming data, and web content.

Need help understanding the building blocks that make up Power BI? See Power BI - Basic
Concepts.

If the original visualization used to create the tile changes, the tile doesn't change. For example, if you
pinned a line chart from a report and then you changed the line chart to a bar chart, the dashboard tile
continues to show a line chart. The data refreshes, but the visualization type does not.

There are many different ways to add (pin) a tile to a dashboard. Tiles can be pinned from:

Power BI Q&A
a report
another dashboard
Excel workbook on OneDrive for Business
Power BI Publisher for Excel
Quick Insights
SSRS

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-dashboard-tiles.md
https://msdn.microsoft.com/library/mt604784.aspx


Interacting with tiles on a dashboard
Move and resize a tileMove and resize a tile

Hover over a tile to change the appearance and behaviorHover over a tile to change the appearance and behavior

And standalone tiles for images, text boxes, videos, streaming data, and web content can be
created directly on the dashboard using Add tile.

Grab a tile and move it around on the dashboard. Hover and select the handle  to resize the
tile.

1. Hover over the tile to display the ellipses.

2. Select the ellipses to open the tile action menu.

From here you can:

Open the report that was used to create this tile 

Open the worksheet that was used to create this tile 

View in focus mode 

Export the data used in the tile 

Edit title and subtitle, add a hyperlink, display last refresh time 

Run insights 

Pin the tile to another dashboard 



Select (click) a tileSelect (click) a tile

NOTENOTE

Considerations and troubleshooting

Next steps

3. To close the action menu, select a blank area in the canvas.
Remove the tile 

When you select a tile, what happens next depends on how the tile was created and if it has a
custom link. If it has a custom link, selecting the tile takes you to that link. Otherwise, selecting the
tile takes you to the report, Excel Online workbook, SSRS report that is on-premises, or Q&A
question that was used to create the tile.

The exception to this is video tiles created directly on the dashbaord using Add tile. Selecting a video tile
(that was created this way) causes the video to play right there on the dashboard.

If the report that was used to create the visualization was not saved, then selecting the tile
produces no action.
If the tile was created from a workbook in Excel Online, and you do not have at least Read
permissions for that workbook, selecting the tile will not open the workbook in Excel Online.
For tiles created directly on the dashboard using Add tile, if a custom hyperlink has been set,
selecting the title, subtitle, and or tile will open that URL. Otherwise, by default, selecting one
of these tiles created directly on the dashboard for an image, web code, or text box produces
no action.
If you don't have permission to the report within SSRS, selecting a tile created from SSRS will
produce a page indicating you don't have access (rsAccessDenied).
If you don't have access to the network where the SSRS server is located, selecting a tile
created from SSRS will product a page that will indicate it cannot locate the server (HTTP 404).
Your device needs to have network access to the report server to view the report.
If the original visualization used to create the tile changes, the tile doesn't change. For
example, if you pinned a line chart from a report and then you change the line chart to a bar
chart, the dashboard tile continues to show a line chart. The data refreshes, but the
visualization type does not.

Create a Card (big number tile) for your dashboard

Dashboards in Power BI

Data refresh

Power BI - Basic Concepts

Export a tile to Power Point

Pin Reporting Services items to Power BI Dashboards

More questions? Try the Power BI Community

http://blogs.msdn.com/b/powerbidev/archive/2015/09/28/integrating-power-bi-tiles-into-office-documents.aspx
https://msdn.microsoft.com/library/mt604784.aspx
http://community.powerbi.com/


Pin a tile to a Power BI dashboard from a report
12/20/2017 • 2 min to read • Edit Online

Pinning tiles from a report

Pin a tile from a report

One way to add a new dashboard tile is from within a Power BI report. In fact, you can add many new tiles from a
report. Each of these tiles, when clicked, is a link back into the report.

And entire report pages can be pinned to a dashboard. This is also known as pinning a live tile. Live because you
can interact with the tile on the dashboard and because, unlike individual visualization tiles, changes made in the
report are synced with the dashboard. Read more about this below.

You can't pin tiles from reports that have been shared with you or from Power BI Desktop.

TIP: Some visualizations use background images. Pinning may not work if the background image is too
large. Try reducing the image size or using image compression.

Watch Amanda create a dashboard by pinning visuals and images from a Power BI report.

Now create your own dashboard using one of the Power BI sample reports.

1. Hover over the visualization you want to pin, and select the pin  icon. Power BI opens the Pin to
dashboard screen.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-dashboard-pin-tile-from-report.md


Pin an entire report page

Next steps

3. In some cases, the item you are pinning may have a theme already applied. For example, visuals pinned from
an Excel workbook. If so, select which theme to apply to the tile.

5. From the navigation pane, select the dashboard with the new tile. Select the tile to jump back into the report.
Or, edit the tile display and behavior.

2. Decide whether to pin to an existing dashboard or new dashboard.

Existing dashboard: select the name of the dashboard from the dropdown. Dashboards that have been
shared with you will not appear in the dropdown.
New dashboard: type the name of the new dashboard.

4. Select Pin.

A Success message (near the top right corner) lets you know the visualization was added, as a tile, to your
dashboard.

Another option is to pin an entire report page to a dashboard. This is an easy way to pin more than one
visualization at a time. Also, when you pin an entire page, the tiles are live; you can interact with them right there
on the dashboard. And changes you make to any of the visualizations back in the report editor, like adding a filter
or changing the fields used in the chart, are reflected in the dashboard tile as well.

For more information, see Pin an entire report page

Dashboards in Power BI

Dashboard tiles in Power BI

Reports in Power BI

Data refresh in Power BI

Power BI Basic Concepts

More questions? Try the Power BI Community

http://community.powerbi.com/


Pin a tile from one dashboard to another dashboard
12/20/2017 • 1 min to read • Edit Online

NOTENOTE

Pin a tile to another dashboard

One way to add a new dashboard tile is by copying it from another dashboard. Each of these tiles, when clicked, is
a link back to where it was created -- either in Q&A or a report.

You cannot pin tiles from shared dashboards.

1. Get data. This example uses the IT Spend Analysis sample.
2. Open a dashboard.
3. Hover over the tile you want to pin, select the ellipses (...) and choose Pin tile.

4. Pin the tile to an existing dashboard or to a new dashboard.

Existing dashboard: select the name of the dashboard from the dropdown.
New dashboard: type the name of the new dashboard.

5. Select Pin. A Success message (near the top right corner) lets you know the visualization was added, as a
tile, to the selected dashboard.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-pin-tile-to-another-dashboard.md


Next steps

6. Select Go to dashboard to see the pinned tile. There, you can rename, resize, link, and move the pinned
visualization.

Tiles in Power BI
Dashboards in Power BI
More questions? Try the Power BI Community

http://community.powerbi.com/


Pin a tile to a Power BI dashboard from Excel
1/24/2018 • 3 min to read • Edit Online

Connect your Excel workbook from OneDrive for Business to Power BI

Before you can pin a tile from your Excel workbook, you'll connect that workbook to Power BI service
(app.powerbi.com). Connecting a workbook essentially brings a linked read-only version of that workbook into
Power BI service and allows you to pin ranges to dahboards. You can even pin an entire worksheet to a dashboard.
If a workbook has been shared with you, you'll have the ability to view the tiles pinned by the owner, but not
create any dashboard tiles yourself.

For in-depth information about how Excel and Power BI work together, see Get data from Excel workbook files.

Watch Will demonstrate several ways to import data from, and connect to, Excel workbooks.

When you choose Connect, your workbook will appear in Power BI just like it would in Excel Online. But, unlike
Excel Online, you’ll have some great features to help you pin elements from your worksheets right to your
dashboards.

You can’t edit your workbook in Power BI. But if you need to make some changes, you can select the pencil icon
from the Workbooks tab of your workspace, and then choose to edit your workbook in Excel Online or open it in
Excel on your computer. Any changes you make are saved to the workbook on OneDrive.

1. Upload your workbook to your OneDrive for Business.
2. From Power BI, connect to that workbook by selecting Get Data > Files > OneDrive - Business and

nagivating to the location where you saved the Excel file. Select the file and choose Connect > Connect.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-dashboard-pin-tile-from-excel.md
http://go.microsoft.com/fwlink/?LinkID=521962


Pin a range of cells to a dashboard

3. In Power BI, the workbook is added to the Workbooks tab of your workspace. The  icon indicates this is
an Excel workbook and a yellow asterisk indicates it's new.

1. Open the workbook in Power BI by selecting the workbook name.

Changes you make to the workbook in Power BI are not saved and do not affect the original workbook on
OneDrive for Business. If you sort, filter, or change values in Power BI, those changes cannot be saved or
pinned. If you need to make changes that will be saved, select Edit from the upper-right corner to open it
for editing in Excel Online or Excel. Changes made this way may take a few minutes to update the tiles on
the dashboards.

One way to add a new dashboard tile is from within an Excel workbook in Power BI. Ranges can be pinned from
Excel workbooks that have been saved in your OneDrive for Business or another group-shared document library.
The ranges can contain data, charts, tables, PivotTables, PivotCharts, and other Excel parts.

1. Highlight the cells that you'd like to pin to a dashboard.



Pin an entire table or pivot chart to a dashboard

2. Select the pin  icon.

5. Select Go to dashboard. From here you can rename, resize, link, and move the pinned visualization. By default,
selecting the pinned tile opens the workbook in Power BI.

3. Pin the tile to an existing dashboard or to a new dashboard.

Existing dashboard: select the name of the dashboard from the dropdown.
New dashboard: type the name of the new dashboard.

4. Select Pin. A Success message (near the top right corner) lets you know the range was added, as a tile, to
your dashboard.

Follow the steps above except instead of selecting a range of cells, select an entire table or pivot table.

To pin a table, select the entire range of the table and be sure to include the headers. To pin a pivot table, be sure
to include every visible part of the pivot table, including filters if used.



View the workbook linked to the tile

Considerations and troubleshooting

Next steps

A tile created from a table or pivot table will show the entire table. If you add/remove/filter rows or columns in the
original workbook, they will also be added/removed/filtered in the tile.

Selecting a workbook tile opens the linked workbook in Power BI. Since the workbook file is located on the
owner’s OneDrive for Business, viewing the workbook requires you have Read permissions for the workbook. If
you do not have permission, you will receive an error message.

Unsupported features: Power BI uses Excel Services to retrieve the workbook tiles. Therefore, since some features
from Excel are not supported in Excel Services REST API, they will not be seen on tiles in Power BI. For example:
Sparklines, icon set conditional formatting, and time slicers. For a full list of unsupported features see Unsupported
Features in Excel Services REST API

Share a dashboard that has links to an Excel workbook

Get data from Excel workbooks

More questions? Try the Power BI Community

http://msdn.microsoft.com/library/office/ff394477.aspx
http://community.powerbi.com/


Power BI publisher for Excel
12/6/2017 • 7 min to read • Edit Online

Download and install

With Microsoft Power BI publisher for Excel, you can take snapshots of your most important insights in Excel,
like PivotTables, charts, and ranges and pin them to dashboards in Power BI.

What can you pin? Just about anything in an Excel worksheet. You can select a range of cells from a simple sheet or
table, a PivotTable or PivotChart, illustrations and images, text.

What you can't pin: you cannot pin 3D Maps or visualizations in Power View sheets. There are also some elements
you can pin, but it wouldn't make much sense to, like a Slicer or Timeline filter.

When you pin an element from Excel, a new tile is added to a new or existing dashboard in Power BI. The new tile is
a snapshot, so it's not dynamic but you can still update it. For example, if you make a change to a PivotTable or
chart you've already pinned, the dashboard tile in Power BI isn't updated automatically, but you can still update
your pinned elements by using Pin Manager. You'll learn more about Pin Manager in the following sections.

Power BI publisher for Excel is an add-in you can download and install on desktop versions of Microsoft Excel 2007
and later.

Download Power BI publisher for Excel

Once you have the publisher installed, you'll see a new Power BI ribbon in Excel, where you can sign in (or sign
out) of Power BI, pin elements to dashboards, and manage elements you've already pinned.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/publisher-for-excel.md
http://go.microsoft.com/fwlink/?LinkId=715729


Pin a range to a dashboard

The Power BI publisher for Excel add-in is enabled by default, but if for some reason you don't see the Power BI
ribbon tab in Excel, you'll need to enable it. Click File > Options > Add-ins > COM Add-ins. Select Microsoft
Power BI Publisher for Excel.

You can select any range of cells from your worksheet, and pin a snapshot of that range to an existing or a new
dashboard in Power BI. You can pin the same snapshot to multiple dashboards, too.

To begin, you need to make sure you're signed in to Power BI.

1. Select Profile from the Power BI ribbon tab in Excel. If you're already signed in to Power BI, you'll see a
dialog that shows which account you're currently signed in with. If that's the account you want to use, great
- go to the next set of steps to pin your range. Select Sign out if you want to use a different Power BI
account. If you're not signed in, go to the next step (Step 2).

2. If you're not signed in, select the Sign In link that appears when you select Profile from the Power BI
ribbon tab in Excel, in the Connect to Power BI dialog type in the email address of the Power BI account
you want to use, then select Sign In.



Once you're signed in, follow these steps to pin a range to a dashboard:

1. In Excel, select the Power BI ribbon tab to see the Pin ribbon button.
2. Select a range from your Excel workbook.
3. Click the Pin button from the Power BI ribbon to show the Pin to dashboard dialog. If you're not already

signed into Power BI, you'll be prompted to do so. Select a workspace from the Workspace dropdown list. If
you want to pin to your own dashboard, verify My Workspace is selected. If you want to pin to a dashboard in
a group workspace, select the group from the drop-down list.

4. Choose whether you want to pin to an existing dashboard or create a new dashboard.
5. Click Okay to pin your selection to the dashboard.
6. In Pin to dashboard, select an existing dashboard in the workspace or create a new one, and then click the

Ok button.



Pin a Chart to a dashboard

Manage pinned elements

Just click on the chart, and then click Pin .

With Pin Manager, you can update (refresh) a pinned element's associated tile in Power BI. You can also remove
the pin between an element you've already pinned to dashboards in Power BI.



Connect to data in Power BI

How to connect to Power BI data in ExcelHow to connect to Power BI data in Excel

To update tiles in your dashboard, in Pin Manager select one or more elements and then select Update.

To remove the mapping between a pinned element in Excel and the associated tile in a dashboard, remove
Remove. When you select Remove, you're not removing the element from your worksheet in Excel or deleting the
associated tile in the dashboard. You are removing the pin, or mapping, between them. The removed element will
no longer appear in Pin Manager. If you pin the element again, it will appear as a new tile.

To remove a pinned element (a tile) from a dashboard, you'll need to do that in Power BI. In the tile you want to

delete, select the Open menu icon  and then select Delete tile .

Beginning with the July 2016 release of Power BI publisher for Excel (including the current release, linked to
above), you can connect directly to data in the Power BI service and analyze that data in Excel using PivotTables and
PivotCharts. This features makes it easy to use Power BI data and Excel together to analyze data that's most
important to you.

Improvements include the following:

Any drivers required to connect to data in Power BI are automatically updated with each release - no need to
install or manage those drivers yourself.
You no longer need to download .odc files to create the connections - Power BI publisher for Excel creates
the connections automatically when you select which report or dataset you want to use.
Now you can create multiple connections and PivotTables in the same workbook
Errors are improved and specific to Power BI publisher for Excel, rather than using default Excel messages

To connect to Power BI data using Power BI publisher for Excel, follow these easy steps:

1. Make sure you're signed in to Power BI. The steps describing how to sign in (or to sign in with a different
account) are provided earlier in this article.

2. Once you're signed in to Power BI with the account you want to use, select Connect to Data from the
Power BI ribbon tab in Excel.



3. Excel connects to Power BI using an HTTPS connection and presents the Connect to data in Power BI
dialog, where you can select the workspace from which you want to select your data (1, in the image below),
which type of data you want to connect to, either a report or a dataset (2), and a drop down (3) that allows
you to select which available report or dataset to which to connect.

4. When you make your choices and select Connect from the Connect to data in Power BI dialog, Excel
prepares a PivotTable and displays the PivotTable Fields pane, where you can select fields from your
connected Power BI data, and create tables or charts that help you analyze the data.



If you don't have any data in Power BI, Excel detects that and offers to create sample data for you to connect to and
try.

There are a few things to consider in this release of Power BI publisher for Excel:

Shared data - Data that has been shared with you, but isn't directly visible to you in Power BI, is not available in
Connect to Data.
SSAS on-premises - If the dataset you select originates from an on-premises SQL Server Analysis Services
(SSAS) and the dataset in Power BI uses DirectQuery to access the data, Power BI publisher for Excel
connects to that data through the on-premises network connection, and does not go through Power BI to
connect to that data. As such, any user trying to connect to such datasets must be connected to the on-premises
network, and is authenticated for access to that data using the authentication method employed by the Analysis



Related Articles

Services instance where the data is stored.
Required drivers - Power BI publisher for Excel installs all the necessary drivers for this feature to work, and
does so automatically. Among those automatically installed drivers is the Excel OLE DB driver for Analysis
Services; if that driver is removed by the user (or for any other reason), the connection to Power BI data will not
work.
Dataset must have measures - The dataset must have model measures defined in order for Excel to treat the
measures as values in PivotTables, and to correctly analyze the data. Learn more about measures.
Support for Groups - Datasets shared with people outside the specified group are not supported, and cannot
be connected to.
Free versus Pro subscriptions - Activities associated with groups are not supported for free users of Power BI,
and thus won't see any datasets or reports shared with a group in their own workspace.
Shared reports or datasets - Reports or datasets that were shared with you cannot be connected to.
Using Tables instead of Data models - Datasets and reports that are created by importing only tables from
Excel (without a data model) are not supported at this time, and cannot be connected to.

Once you've created compelling charts or other visuals such as a range of data, you can easily pin those to a
dashboard in Power BI, as described earlier in this article.

There are many ways to use Excel and Power BI together, and get the best out of both. Take a look at the following
articles for more information.

Analyze in Excel
Analyze in Excel troubleshooting



Pin a tile to a dashboard from Q&A
1/19/2018 • 2 min to read • Edit Online

How to pin a tile from Q&A
Q&A is the Power BI ad hoc reporting tool. Need to find a particular insight? Ask a question about your data, and
receive an answer in the form of a visualization.

In this How-to, we'll use Power BI service (app.powerbi.com) to open a dashboard, ask a question using natural
language to create a visualization, and pin that visualization to a dashboard. Dashboards are not available in
Power BI Desktop. For information on using Q&A with other Power BI tools and content, see the Power BI Q&A
overview.

To follow along, open the Retail Analysis sample dashboard.

1. Open a dashboard that has at least one tile pinned from a report. When you ask a question, Power BI looks for
the answer in any dataset that has a tile pinned to that dashboard. To learn more, see get data.

2. In the question box at the top of your dashboard, start typing what you want to know about your data.

3. For example, as you type "last year sales by month and territory"...

the question box gives you suggestions.

4. To add the chart to your dashboard as a tile, select the pin  on the top-right side of the canvas. If the
dashboard has been shared with you, you won't be able to pin any visualizations.

5. Pin the tile to an existing dashboard or to a new dashboard.

Existing dashboard: select the name of the dashboard from the dropdown. Your choices will be limited
to only those dashboards within the current workspace.
New dashboard: type the name of the new dashboard and it will be added to your current workspace.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-dashboard-pin-tile-from-q-and-a.md


Considerations and troubleshooting

Next steps

6. Select Pin.

A success message (near the top-right corner) lets you know the visualization was added, as a tile, to your
dashboard.

7. Select Go to dashboard to see the new tile. There, you can rename, resize, add a hyperlink, reposition the
tile, and more on your dashboard.

When you start typing a question, Q&A immediately begins searching for the best answer from all datasets
associated with the current dashboard. The "current dashboard" is the dashboard listed in the top
navigation bar. For example, this question is being asked in the Retail Analysis Sample dashboard that is
part of the mihart app workspace.

How does Q&A know which datasets to use? Q&A has access to all datasets that have at least one
visualization pinned to that dashboard.

Don't see the question box? Check with your Power BI administrator. The administrator has the ability to
disable Q&A.

Rename, resize, add a hyperlink, reposition the tile, and more
Display your dashboard tile in Focus mode
Back to Q&A in Power BI
More questions? Try the Power BI Community

http://community.powerbi.com/


Pin an entire report page, as a live tile, to a Power BI
dashboard
1/24/2018 • 1 min to read • Edit Online

NOTENOTE

Pin a report page

Another way to add a new dashboard tile is by pinning an entire report page. This is an easy way to pin more than
one visualization at a time. Also, when you pin an entire page, the tiles are live; you can interact with them right
there on the dashboard. And changes you make to any of the visualizations back in the report editor, like adding a
filter or changing the fields used in the chart, are reflected in the dashboard tile as well.

Pinning live tiles from reports to dashboards is only available in Power BI service (app.powerbi.com).

You can't pin tiles from reports that are shared with you.

Watch Amanda pin a live report page to a dashboard and then follow the step-by-step instructions below the video
to try it yourself.

1. Open a report in Editing view.
2. With no visualizations selected, from the menubar, select Pin Live Page.

3. Pin the tile to an existing dashboard or to a new dashboard. Notice the highlighted text: Pin live page
enables changes to reports to appear in the dashboard tile when the page is refreshed.

Existing dashboard: select the name of the dashboard from the dropdown. Dashboards that have been
shared with you will not appear in the dropdown.
New dashboard: type the name of the new dashboard.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-dashboard-pin-live-tile-from-report.md


Open the dashboard to see the pinned live tile

Next steps

4. Select Pin live. A Success message (near the top right corner) lets you know the page was added, as a tile, to
your dashboard.

1. From the navigation pane, select the dashboard with the new live tile. There, you can do things like rename,
resize, link, and move the pinned report page.

2. Interact with the live tile. In the screenshot below, selecting a bar on the column chart has cross-filtered and
cross-highlighted the other visualizations on the tile.

Dashboards in Power BI

More questions? Try the Power BI Community

http://community.powerbi.com/


Display the Power BI dashboards that have been
shared with me
1/8/2018 • 1 min to read • Edit Online

Shared with me

Actions available from the Shared with me screen

When a colleague shares a dashboard with you, its title is added to your Shared with me list. The dashboard is
only available from Shared with me and not available from a workspace or from Apps.

Watch Amanda explain the Shared with me content list and demonstrate how to navigate and filter the list. Then
follow the step-by-step instructions below the video to try it out yourself. For you to view dashboards shared with
you, you need to have a Power BI Pro license. Read What is Power BI Premium? for details.

You'll have many options for interacting with the dashboard and underlying report, depending on the permissions
the owner gives you. These include being able to make copies of the dashboard, open the report in Reading view,
and re-share with other colleagues.

Select the star icon to Favorite a dashboard.

Remove a dashboard 

Some dashboards can be re-shared 
Additionally, if your lists of dashboards gets long, use the search field and sorting to find what you need.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-shared-with-me.md


Filter shared dashboards by owner

Next steps

NOTENOTE

Select the name of a dashboard to open it and explore. Once you've opened the shared dashboard you can use
Q&A to ask questions about the underlying data or select a tile to open and interact with the report in Reading
view.

For information about EGRC classifications, select the classification button or visit Dashboard data classification .

The content in the Shared with me screen can be further filtered by content owner. For example, if I select
Amanda, I see only the dashboard that Amanda has shared with me.

Power BI - Basic Concepts
Power BI Premium - what is it?

More questions? Try asking the Power BI Community

http://community.powerbi.com/


Usage metrics for dashboards and reports
1/23/2018 • 10 min to read • Edit Online

NOTENOTE

Why are usage metrics important to me?

PrerequisitesPrerequisites

If you create dashboards and reports, usage metrics help you understand their impact. When you run either
dashboard usage metrics or report usage metrics, you discover how those dashboards and reports are being used
throughout your organization; what is being used, by whom, and for what purpose.

Usage metrics will track usage of reports that are embedded in SharePoint Online. They will also track embedding of
dashboards and reports via both the “user owns credentials” and “app owns credentials” flow. Usage metrics will not track
usage of reports embedding via publish to web.

These usage metrics reports are read-only. However, you can personalize a usage metrics report by using "Save as."
This creates a brand new dataset and converts the read-only report to a full-featured Power BI report that you can
edit. Not only does the personalized report contain metrics for the selected dashboard or report, but by removing
the default filter, you now have access to usage metrics for all dashboards or all reports in the selected workspace.

Knowing how your content is being used helps you demonstrate your impact and prioritize your efforts. Your usage
metrics may show that one of your reports is used daily by a huge segment of the organization and it may show
that a dashboard you created isn't being viewed at all. This type of feedback is invaluable in guiding your work
efforts.

Running usage metrics reports is only available in Power BI service. However, if you save a usage metrics report or
pin it to a dashboard, you will be able to open and interact with that report on mobile devices.

The usage metrics feature captures usage information from all users, both Free and Pro. However, a Pro license
is required to run and access the usage metrics data.
Usage metrics are provided on dashboards or reports in the selected workspace. To access usage metrics for a

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-usage-metrics.md


About the Usage Metrics report

Open a Usage Metrics report for a dashboard or report

particular dashboard or report, you must:
• Have edit access to that dashboard or report
• Have a Pro license

When you select Usage metrics or the icon , Power BI generates a pre-built report with usage metrics for that
content for the last 90 days. The report looks similar to the Power BI reports you're already familiar with, but it's
designed to be informational -- not interactive. You’ll be able to slice based on how your end users received access,
whether they were accessing via the web or mobile app, etc. As your dashboards and reports evolve, so too will the
usage metrics report, which updates every day with new data.

Usage metrics reports won't show up in Recent, Workspaces, Favorites, or other content lists. They cannot be
added to an app. If you pin a tile from a usage metrics report to a dashboard, that dashboard cannot be added to an
app or content pack.

To dig down into the report data, or to build your own reports against the dataset, use Save as (see Save the Usage
Metrics report as a full-featured Power BI report.

1. Start in the workspace that contains the dashboard or report.
2. From either the workspace content list or from the dashboard or report itself, select the icon for Usage

metrics .

3. The first time you do this, Power BI creates the usage metrics report and lets you know when it's ready.



What metrics are reported?
METRIC DASHBOARD REPORT DESCRIPTION

Distribution method slicer yes yes How users got access to the
content. There are 3 possible
methods: users can access
the dashboard or report by
being members of an app
workspace, by having the
content shared with them, or
by installing a content
pack/app. Note that views
through an app are counted
as "content pack."

Platforms slicer yes yes Was the dashboard or report
accessed via the Power BI
service (powerbi.com) or a
mobile device? Mobile
includes all our iOS, Android,
and Windows apps.

Report page slicer no yes If the report has more than
1 page, slice the report by
the page(s) that was viewed.
If you see a list option for
"Blank," that means a report
page was recently added
(within 24 hours the actual
name of the new page will
appear in the slicer list)
and/or report pages have
been deleted. "Blank"
captures these types of
situations.

4. To open the results, select View usage metrics.

Usage metrics will be a powerful ally as you work to deploy and maintain Power BI dashboards and reports.
Wondering which pages of your report are most useful, and which ones you should phase out? Slice by
Report page to find out. Wondering if you should build a mobile layout for your dashboard? Slice by
Platforms to discover how many users are accessing your content via the mobile apps vs. via web browser.

5. Optionally, hover over a visualization and select the pin icon to add the visualization to a dashboard. Or, from
the top menubar, select Pin Live Page to add the entire page to a dashboard. From the dashboard you can
monitor the usage metrics more-easily or share them with others.

NOTE: If you pin a tile from a usage metrics report to a dashboard, that dashboard cannot be added to
an app or content pack.



Views per day yes yes Total number of views per
day - a view is defined as a
user loading a report page
or dashboard.

Unique viewers per day yes yes Number of different users
who viewed the dashboard
or report (based on the AAD
user account).

Views per user yes yes Number of views in the past
90 days, broken down by
individual users.

Shares per day yes no Number of times the
dashboard was shared with
another user or group.

Total views yes yes Number of views in the past
90 days.

Total viewers yes yes Number of unique viewers in
the past 90 days.

Total shares yes no Number of times the
dashboard or report was
shared in the past 90 days.

Total in organization yes yes Count of all dashboards or
reports in the entire
organization which had at
least one view in the past 90
days. Used to calculate rank.

Rank: Total views yes yes For total views of all
dashboards or reports in the
organization over the past
90 days, where does this
dashboard or report rank.

Rank: Total shares yes no For total shares of all
dashboards in the
organization over the past
90 days, where does this
dashboard or report rank.

METRIC DASHBOARD REPORT DESCRIPTION

Dashboard Usage Metrics reportDashboard Usage Metrics report



Report Usage Metrics reportReport Usage Metrics report

Save the Usage Metrics report as a full-featured Power BI report
(personalize)

Use Save as to convert the usage metrics report to a full-featured Power BI report that can be customized and
shared. Once you’ve created a personalized copy, you’ll get full access to the underlying dataset, allowing you to
customize the usage metrics report to your specific needs. You can even use Power BI Desktop to build custom



What is created when using "Save as"?What is created when using "Save as"?

Create a copy of the usage report using "Save as"Create a copy of the usage report using "Save as"

usage metrics reports using the live connection to Power BI service feature.

Better yet, the underlying dataset includes the usage details for all dashboards or reports in the workspace. This
opens up yet another world of possibilities. You could, for example, create a report which compares all dashboards
in your workspace based on usage. Or, you could create a usage metrics dashboard for your Power BI app by
aggregating usage across all the content distributed within that app. See remove the Page level filter below.

When Power BI creates the full-featured report, it also creates a new dataset made up of all the dashboards or
all the reports contained in the current workspace that have been accessed in the last 90 days. For example,
say you have a workspace named "Sales" and it contains three dashboards and two reports, and you create a usage
metrics report on the "Northeast" dashboard. And then you use Save as to personalize and convert it to a full-
featured report. The dataset for that new report contains the usage metrics not only for that one dashboard named
"Northeast" but for all three dashboards in the "Sales" workspace. By default, the report will display data for the
"Northeast" dashboard and you'll need to remove a filter (single click) to display data for all three dashboards.

When you create a copy using "Save as" (personalize), Power BI converts the read-only pre-built report to a full-
featured report. At first glance, it looks exactly the same. However, you can now open the report in Editing view, add
new visualizations, filters, and pages, modify or delete existing visualizations, and so much more. Power BI saves the
brand new report and dataset in the current workspace. In the example below, the current workspace is mihart.

1. From the pre-built usage metrics report, select File > Save As. Power BI converts the usage metrics report
into a full-featured Power BI report. This is called a personalized usage metrics report. The personalized
usage report and dataset are saved in the current workspace which is named *mihart.

2. Open the report in Editing view and interact with it as you would with any other Power BI report. For
example, add new pages and build new visualizations, add filters, format the fonts and colors, etc.

3. Alternately, start with the new dataset and build a report from scratch.

https://powerbi.microsoft.com/blog/connecting-to-datasets-in-the-power-bi-service-from-desktop


Remove the filter to see Remove the filter to see allall the usage metrics data in the workspace the usage metrics data in the workspace

4. The new report is saved in the current workspace (mihart) and also added to the Recent content list.

To see the metrics for all the dashboards or for all the reports in the workspace, you'll have to remove a filter. By
default, the personalized report is filtered to display metrics for only the dashboard or report that was used to
create it.

If, for example, you used the dashboard named "European sales" to create this new personalized report, only usage
data from the "European sales" dashboard will display. To remove the filter, and enable data from all the
dashboards in that workspace:

1. Open the personalized report in Editing view.

2. In the Filters pane, locate the Report level filters bucket and remove the filter by selecting the "x".

Now your personalized report displays metrics for the entire workspace.



Admin controls for usage metrics - for Power BI administrators

Considerations and limitations

Usage metrics reports are a feature that the Power BI or Office 365 administrator can turn on or off. Administrators
have granular control over which users have access to usage metrics; they are On by default for all users in the
organization.

1. Open the Admin portal by selecting the gear icon in the top-right-corner of Power BI service and choosing
Admin portal.

2. From the Admin portal, select Tenant settings and choose Usage metrics for content creators.

3. Enable (or disable) usage metrics and select Apply.

When disabling usage metrics for their entire organization, admins can use the delete all existing usage metrics
content option to delete all existing reports and dashboard tiles that were built using the usage metrics reports and
datasets. This option removes all access to usage metrics data for all users in the organization who may already be
using it. Be careful, because deleting existing usage metrics content is irreversible.



Next steps

Q: I can't run usage metrics on a dashboard or report
A: You can only see usage metrics for content you own or have permissions to edit.

Q: Will usage metrics capture views from embedded dashboards and reports?
A: Usage metrics currently does not support capturing usage for embedded dashboards and reports, including the
user owns data flow, the app owns data flow and the publish to web flow. In those cases, we recommend using
existing web analytics platforms to track usage for the hosting app or portal.

Q: I can't run usage metrics on any content at all.
A1: Admins can turn off this feature for their organization. Contact your Admin to see if this is the case.
A2: Usage metrics is a Power BI Pro feature.

Q: The data doesn't seem up-to-date. For example, distribution methods don't show up, report pages are missing,
etc.
A: It can take up to 24 hours for data to update.

Q: There are four reports in the workspace but the usage metrics report only displays 3.
A: The usage metrics report only includes reports (or dashboards) that have been accessed in the past 90 days. If a
report (or dashboard) does not show up, likely it hasn't been used in more than 90 days.

Favorite a dashboard

More questions? Try the Power BI Community

http://community.powerbi.com/


Data alerts in Power BI service
12/20/2017 • 3 min to read • Edit Online

WARNINGWARNING

Set data alerts in Power BI service

Set alerts to notify you when data in your dashboards changes beyond limits you set.

Alerts can only be set on tiles pinned from report visuals, and only on gauges, KPIs and cards. Alerts can be set
on visuals created from streaming datasets that have been pinned from a report to a dashboard, but cannot be
set on streaming tiles created directly on the dashboard using Add tile > Custom streaming data.

Only you can see the alerts you set, even if you share your dashboard. Data alerts are fully synchronized across
platforms; set and view data alerts in the Power BI mobile apps and in the Power BI service. They are not
available for Power BI Desktop. Alerts can even be automated and integrated with Microsoft Flow - try it out
yourself.

Data-driven alert notifications provide information about your data. If you view your Power BI data on a mobile device and
that device gets stolen, we recommend using the Power BI service to turn off all data-driven alert rules.

Watch Amanda add some alerts to tiles on her dashboard. Then follow the step-by-step instructions below the
video to try it out yourself.

This example uses a card tile from the Retail Analysis sample dashboard.

1. Start on a dashboard. From a dashboard gauge, KPI, or card tile, select the ellipses.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-set-data-alerts.md
https://flow.microsoft.com


5. Select Save.

2. Select the bell icon  to add one or more alerts for Total stores.

3. To start, select + Add alert rule, ensure the slider is set to On, and give your alert a title. Titles help you
easily recognize your alerts.

4. Scroll down and enter the alert details. In this example we'll create an alert that notifies us once a day if
the number of total stores goes above 100. Alerts will appear in our Notification center. And we'll have
Power BI send us an email as well.



Receiving alerts
When the data being tracked reaches one of the thresholds you've set, several things will happen. First, Power BI
checks to see if it's been more than an hour or more than 24 hours (depending on the option you selected) since
the last alert was sent. As long as the data is past the threshold, you'll get an alert.

Next, Power BI sends an alert to your notification center and, optionally, in email. Each alert contains a direct link
to your data. Select the link to see the relevant tile where you can explore, share, and learn more.

1. If you've set the alert to send you an email, you'll find something like this in your Inbox.

2. Power BI adds a message to your Notification center and adds a new alert icon to the applicable tile.

3. Open your Notification center to see the alert details.



Managing alerts

From the tile itselfFrom the tile itself

From the Power BI settings menuFrom the Power BI settings menu

NOTENOTE
Alerts only work on data that is refreshed. When data refreshes, Power BI looks to see if an alert is set for that
data. If the data has reached an alert threshold, an alert is triggered.

There are many ways to manage your alerts: From the dashboard tile itself, from the Power BI Settings menu, on
an individual tile in the Power BI mobile app on the iPhone or in the Power BI mobile app for Windows 10.

1. If you need to change or remove an alert for a tile, re-open the Manage alerts window by selecting the

bell icon . All the alerts that you've set for that tile are displayed.

.

2. To modify an alert, select the arrow to the left of the alert name.

.

3. To delete an alert, select the trashcan to the right of the alert name.

1. Select the gear icon from the Power BI menubar.

.

2. Under Settings select Alerts.



Tips and troubleshooting

Next steps

3. From here you can turn alerts on and off, open the Manage alerts window to make changes, or delete the
alert.

Alerts are currently not supported for Bing tiles, or card tiles with date/time measures.
Alerts only work with numeric data types.
Alerts only work on data that is refreshed. They do not work on static data.
Alerts will only work on streaming datasets if you build a KPI/card/gauge report visual and then pin that
visual to the dashboard.

Create a Microsoft Flow that includes a data alert
Set data alerts on your mobile device
Get started with Power BI
More questions? Try asking the Power BI Community

http://community.powerbi.com/


Power BI Notifications
1/3/2018 • 1 min to read • Edit Online

The Notification Center is a sequential feed of information related to your Power BI experience. Open it to see
messages about new dashboards that have been shared with you, changes to your Group space, information about
Power BI events and meetings, alerts you've set, and more. You can set alerts in the Power BI service and also in the
Power BI mobile apps.

Watch Amanda review notifications she's received, manage her notifications, and respond to them. Then follow the
instructions below the video to try it out yourself.

1. When you log in to Power BI, any new notifications that were sent to you while you were offline are added
to your feed. If you do have new notifications, Power BI displays a yellow bubble with the number of new
items.

2. In the Power BI menubar, select the Notifications icon.

3. Notifications are displayed with the most-recent on top and unread messages highlighted. Notifications are
retained for 90 days, unless you delete them sooner or reach the maximum limit of 100.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-notification-center.md


Next stepsNext steps

4. To dismiss a notification, select the X icon.

Data alerts in Power BI service
Create a Microsoft Flow that is triggered by a Power BI data alert
Set data alerts in the iPhone app (Power BI for iOS)
Set data alerts in the Power BI mobile app for Windows 10
More questions? Try the Power BI Community

http://community.powerbi.com/


Add image, text, video, and more to your dashboard
12/20/2017 • 4 min to read • Edit Online

Add tile
The Add tile control lets you directly add an image, text box, video, streaming data, or web code to your
dashboard.

1. Select Add tile from the top menu bar. Depending on space limitations, you may see only the plus 
sign.

2. Select which type of tile to add: Image, Text box, Video, Web content, or Custom streaming data.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-dashboard-add-widget.md


Add an image
Say you want your company logo on your dashboard, or some other image. You'll need to save the image file
online and link to it. Make sure special credentials aren't required to access the image file. For example, OneDrive
and SharePoint require authentication, so images stored there can't be added to a dashboard this way.

1. Select Image > Next.
2. Add image information to the Add image tile window.



Add a text box or dashboard heading

to display a title above the image, select Display title and subtitle and type a title and/or subtitle.
enter the image URL
to make the tile a hyperlink, select Set custom link and enter the URL. When colleagues click this
image or title, they'll be taken to this URL.
Select Apply. On the dashboard, resize and move the image as needed.

1. Select Text box > Next.

NOTE: To add a dashboard heading, type your heading in the text box and increase the font.

2. Format the text box:



Add a video

to display a title above the text box, select Display title and subtitle and type a title and/or subtitle.
enter and format content for the text box.
Optionally, set a custom link for the title. A custom link can be an external site or a dashboard or
report in your workspace. However, in this example we've added hyperlinks within the text box
itself, so will leave Set custom link unchecked.

3. Select Apply. On the dashboard, resize and move the text box as needed.

When you add a YouTube or Vimeo video tile to your dashboard, the video plays right on your dashboard.

1. Select Video > Next.
2. Add video information to the Add video tile pane.



Add streaming data

3. Select the video tile to play the video.
4. Select the subtitle to visit the playlist on YouTube.

to display a title and subtitle at the top of the video tile, select Display title and subtitle and type a title
and/or subtitle. In this example, we'll add a subtitle and then turn it into a hyperlink back to the entire
playlist on YouTube.
enter the URL for the video
Add a hyperlink for the title and subtitle. Perhaps after your colleagues watch the embedded video
you'd like them to view the entire playlist on YouTube -- add a link to your playlist here.
Select Apply. On the dashboard, resize and move the video tile as needed.



Add web content
Paste or type in any HTML content. Power BI adds it, as a tile, to your dashboard. Enter the embed code by hand
or copy/paste from sites such as Twitter, YouTube, embed.ly, and more.

1. Select Web content > Next.
2. Add information to the Add web content tile pane.

to display a title above the tile, select Display title and subtitle and type a title and/or subtitle.
enter the embed code. In this example we're copying and pasting a Twitter feed.

3. Select Apply. On the dashboard, resize and move the web content tile as needed.



Tips for embedding web content

Edit a tile

<iframe src="https://xyz.com">

<iframe width="560" height="315"
src="https://www.youtube.com/embed/Cle_rKBpZ28" frameborder="0"
 allowfullscreen></iframe>

<iframe width="100%" height="100%"
src="https://www.youtube.com/embed/Cle_rKBpZ28" frameborder="0"
 allowfullscreen></iframe>

<blockquote class="twitter-tweet" data-partner="tweetdeck">
<p lang="en" dir="ltr">Listen to
<a href="https://twitter.com/GuyInACube">@GuyInACube</a> talk to
us about making videos about Microsoft Business Intelligence
platform
<a href="https://t.co/TmRgalz7tv">https://t.co/TmRgalz7tv </a>
<a href="https://twitter.com/hashtag/analytics?src=hash">
#analytics</a></p>&mdash; AFTK Podcast (@aftkpodcast) <a
href="https://twitter.com/aftkpodcast/status/693465456531771392">
January 30, 2016</a></blockquote> <script async src="//platform.twitter.com/widgets.js" charset="utf-
8"></script>

For iframes, use a secure source. If you enter your iframe embed code and get a blank tile, check to see if
you're using http for the iframe source. If so, change it to https.

Edit width and height information. This embed code embeds a video and sets the video player to 560 x
315 pixels. This size will not change as you resize the tile.

If you'd like the player to resize to fit the tile size, set width and height to 100%.

This code embeds a tweet and retains, as separate links on the dashboard, links for the AFK podcast,
@GuyInACube's Twitter page, Follow, #analytics, reply, retweet, and like. Selecting the tile itself
takes you to the podcast on Twitter.

To make changes to a tile...



Considerations and troubleshooting

Next steps

1. Hover over the top right corner of the tile and select the ellipses.

2. Select the edit icon to re-open the Tile details pane and make changes.

To make it easier to move the tile on your dashboard, add a title and/or subtitle.
If you'd like to embed some content from a website, but the website doesn't give you embed code to copy
and paste, check out embed.ly for help generating the embed code.

Dashboard tiles

More questions? Try the Power BI Community.

http://community.powerbi.com/


Edit or remove a dashboard tile
1/23/2018 • 3 min to read • Edit Online

Dashboard owners versus dashboard consumers

Create a new visualization and pin it to the dashboard

When you create or own a dashboard, you have many options for changing the look and default
behavior of the tiles on that dashboard. Use the settings and strategies below to design the
dashboard consuming experience for your colleagues. Will selecting a tile open the underlying
report, a custom URL, or a different dashboard? Maybe you'll add a tile that displays a video or
streaming data? And you might even want to create a tile that has interactive slicers. As a creator
you have many options.

This article covers the following.

Create a visualization and pin it to a dashboard
Move a tile
Resize a tile
Rename a tile
Add a hyperlink to a tile
Pin a tile to a different dashboard

TIPTIP

PrerequisitesPrerequisites

Delete a tile

To change the visualization shown on the tile itself, delete the tile and add a new dashboard tile.

1. To follow along, open Power BI service (not Power BI Desktop) and download the IT
Spend Analysis sample. When the "Success" message appears, select Go to
dashboard

 

1. From the IT Spend Analysis dashboard, select the "Amount" tile to open the report.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-dashboard-edit-tile.md


Move the tile

Resize the tile

2. Open the report in Editing view by selecting Edit report from the top menubar.

3. Add a new report page by selecting the plus sign (+) at the bottom of the report.

4. From the FIELDS pane, select Fact > Amount and Business Area > Business Area.

5. From the VISUALIZATIONS pane, select the Donut chart icon to convert the visualization to
a Donut chart.

6. Select the pin icon and pin the Donut chart to the IT Spend Analysis sample dashboard.

7. When the "Success"message appears, select Go to dashboard. You will be prompted to
save your changes. Select Save.

 

On the dashboard, locate the new tile. Select and hold the tile to drag it to a new location on the
dashboard canvas.

 

You can make tiles many different sizes -- from 1x1 tile units up to 5x5. Select and drag the
handle (in the bottom right corner) to resize the tile.



The ellipses (...) menu
1. Select the ellipses (...) in the upper-right corner of the tile.

2. Hover over the "Account" tile and select the ellipses to display the options. The options
available will vary by tile type. For example, the options available for a live tile are different
from options available for a standard visualization tile. Also, if a dashboard has been
shared with you (you are not the owner), you will have fewer options.

3. Select Edit details to open the "Tile details" window.

Change the title and default behavior of the tile. For example, you may decide that when a
consumer selects a tile, instead of opening the report that was used to create that tile, a
new dashboard displays instead.



Rename the tileRename the tile

Change the default hyperlinkChange the default hyperlink

 

At the top of the "Tile details" window, change Title to Amount spent.

     

By default, selecting a tile usually takes you to the report where the tile was created or to Q&A (if
the tile was created in Q&A). To link to a webpage, another dashboard or report (in the same
workspace), an SSRS report, or other online content - add a custom link.

1. Under the Functionality heading, select Set custom link.

2. Select Link to a dashboard or report in the current workspace and then select from
the dropdown. In this example I've selected the Human Resources sample dashboard. If
you don't have this sample already in your workspace, you can add it and come back to
this step, or you can select a different dashboard.

3. Select Apply.

4. The new title displays on the tile. And, when you select the tile, Power BI opens the Human
Resources dashboard.



Pin the tile to a different dashboardPin the tile to a different dashboard

Delete the tileDelete the tile

Next steps

 

1. From the ellipses dropdown menu, select Pin tile  .

3. Select Pin.

2. Decide whether to pin a duplicate of this tile to an existing dashboard or to a new
dashboard.

 

1. To permanently remove a tile from a dashboard, select Delete tile  from the ellipses
dropdown menu.

2. Deleting a tile does not delete the underlying visualization. Open the underlying report by
selecting the "Amount" tile. Open the last page in your report to see that the original
visualization has not been deleted from the report.

Dashboard tiles in Power BI

Dashboards in Power BI

Power BI - Basic Concepts

More questions? Try the Power BI Community

http://community.powerbi.com/


Tips for designing a great Power BI dashboard
1/3/2018 • 4 min to read • Edit Online

TIPTIP

Consider your audienceConsider your audience

Tell a story and keep it to one screenTell a story and keep it to one screen

Make use of full screen modeMake use of full screen mode

Make the most important information biggestMake the most important information biggest

Put the most important information in the upper cornerPut the most important information in the upper corner

Now that you've created a dashboard and added some tiles, think about how to make your dashboard not just
pretty, but also functional. In general, that means making the most important information stand out, and making it
clean and uncluttered.

Here are a few tips.

Many of the design principles for reports apply to dashboards as well. Read our whitepaper Best design principles for reports
and visualizations.

What are the key metrics that will help them make decisions? How will the dashboard be used? What learned or
cultural assumptions may affect design choices? What information does your audience need to be successful?

Keep in mind that the dashboard is an overview, a single place to monitor the current state of the data. The
dashboard is based on underlying reports and datasets, and those can contain loads of details. Your readers can
drill into the reports from your dashboard. So don't put the detail on the dashboard unless that's what your
readers need to monitor.

Where is the dashboard going to be displayed? If it will be on a large monitor, you can put more content on it. If
readers will view it on their tablets, then fewer tiles will be more readable.

Because dashboards are meant to show important information at a glance, having all the tiles on one screen is
best. Can you avoid scroll bars on your dashboard?

Is the dashboard too cluttered? Remove all but essential information that can be easily read and interpreted.

Display your dashboard in full screen without distractions.

If the text and visualizations on your dashboard are all the same size, your readers will have a hard time focusing
on what's most important. For example, card visualizations are a good way to display an important number
prominently:

But be sure to provide context.

Read about creating a tile with just a number.

Most people read from top to bottom, so put the highest level of detail at the top and show more detail as you

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-dashboards-design-tips.md


Use the right visualization for the data and format it for easy readingUse the right visualization for the data and format it for easy reading

Learning More about Best Practice Dashboard Design

Next steps

move in the direction the audience uses for reading (left-to-right, right-to-left).

Avoid visualization variety for the sake of variety. Visualizations should paint a picture and be easy to "read" and
interpret. For some data and visualizations, a simple graphic visualization is enough. But other data may call for a
more-complex visualization - be sure to make use of titles and labels and other customization to help the reader.

Choose appropriate data visualizations. Be careful using charts that distort reality i.e. 3-D charts. Keep in mind
that it is difficult for the human brain to interpret circular shapes. Pie charts, donut charts, gauges and other
circular chart types may look pretty but they are not a data visualization best practice.
Be consistent with chart scales on axes, chart dimension ordering and also the colors used for dimension values
within charts.
Be sure to encode quantitative data nicely. Don’t exceed three or four numerals when displaying numbers.
Display measures to one or two numerals left of the decimal point and scale for thousands or millions i.e. 3.4
million not 3,400,000.
Don’t mix levels of precision and time. Make sure that time frames are well understood. Don’t have one chart
that has last month next to filtered charts from a specific month of the year.
Don’t mix big and small measures on the same scale, such as on a line or bar chart. For example one measure
can be in the millions and the other measure in the thousands. With such a large scale, it would be difficult to
see the differences of the measure that is in the thousands. If you need to mix, choose a visualization that
allows the use of a second axis.
Don’t clutter your charts with data labels that are not needed. The values in bar charts are usually well
understood without displaying the actual number.
Pay attention to how charts are sorted. If you want to draw attention to the highest or lowest number, sort by
the measure. If you want people to be able to quickly find a particular category within many other categories,
sort by the axis.
Pie charts are best if they have fewer than eight categories. Because you can't compare values side by side, it’s
harder to compare values in a pie chart than in bar and column charts. Pie charts can be good for viewing part-
to-whole relationships rather than for comparing the parts. And Gauge charts are great for displaying the
current status in the context of a goal.

For more visualization-specific guidance, see Visualization types in Power BI.

To master the art of excellent dashboard design, consider learning basic Gestalt Principles of visual perception and
how to clearly communicate actionable information in context. Luckily, there is a plethora of resources already
widely available and sprinkled within our blogs. A few of our favorite books include:

Information Dashboard Design by Stephen Few
Show Me the Numbers by Stephen Few
Now You See It by Stephen Few
Envisioning Information by Edward Tufte
Advanced Presentations by Design by Andrew Abela

Dashboards in Power BI
Power BI - Basic Concepts
More questions? Try the Power BI Community

http://blogs.msdn.com/b/microsoft_business_intelligence1/archive/2012/10/08/best-practices-in-data-visualization.aspx
http://community.powerbi.com/


Automatically generate data insights with Power BI
1/8/2018 • 2 min to read • Edit Online

Run quick insights on a dataset

Have a new dataset and not quite sure where to start? Need to build a dashboard quickly? Want to look for
insights you may have missed?

Run quick insights to generate interesting interactive visualizations based on your data. Quick insights can be
run on an entire dataset (quick insights) or on a specific dashboard tile (scoped insights). You can even run
insights on an insight!

NOTE: Insights do not work with DirectQuery - they only works with data uploaded to Power BI.

The insights feature is built on a growing set of advanced analytical algorithms developed in conjunction with
Microsoft Research that we’ll continue to use to allow more people to find insights in their data in new and
intuitive ways.

Watch Amanda run quick insights on a dataset, open an insight in Focus mode, pin one of these insights as a tile
on her dashboard, and then get insights for a dashboard tile.

Now it's your turn. Explore insights using the Supplier Quality Analysis sample.

1. From the Datasets tab, select the ellipses (...) and choose Get insights.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-insights.md


Interact with the insight cards

2. Power BI uses various algorithms to search for trends in your dataset.

3. Within seconds, your insights are ready. Select View insights to display visualizations.

NOTE: Some datasets can't generate insights because the data isn't statistically significant. To learn
more, see Optimize your data for insights.

4. The visualizations display in a special Quick Insights canvas with up to 32 separate insight cards. Each
card has a chart or graph plus a short description.

1. Hover over a card and select the pin icon to add the visualization to a dashboard.
2. Hover over a card, select the ellipses (...) and choose View insights. This opens the insight fullscreen.



3. In Focus mode you can:

Pin the insight card to a dashboard by selecting the pin  icon or Pin visual.

Filter the visualizations. To display the filters, in the top right corner, select the arrow to expand the
Filters pane.

Run insights on the card itself. This is often referred to as scoped insights. In the top-right corner,

select the lightbulb icon  or Get insights.

The insight displays on the left and new cards, based solely on the data in that single insight,
display along the right.



Run insights on a dashboard tile

Next steps

4. To return to the original insights canvas, in the top-left corner, select Exit Focus mode.

Instead of searching for insights against an entire dataset, narrow your search to the data used to create a single
dashboard tile. This too is often referred to as scoped insights.

1. Open a dashboard.

3. Does one insight pique your interest? Select that insight card to dig further. The selected insight appears on
the left and new insight cards, based solely on the data in that single insight, display along the right.

4. Continue digging into your data, and when you find an interesting insight, pin it to your dashboard by
selecting Pin visual from the top-right corner.

2. Hover over a tile. select the ellipses (...), and choose View insights. The tile opens in Focus mode with the
insights cards displayed along the right.



If you own a dataset, optimize it for Quick Insights

Learn about the types of Quick Insights available

More questions? Try the Power BI Community

http://community.powerbi.com/


Types of insights supported by Power BI
12/20/2017 • 1 min to read • Edit Online

How does Insights work?

What types of insights can we find?

Category outliers (top/bottom)

Change points in a time series

Power BI quickly searches different subsets of your dataset while applying a set of sophisticated algorithms to
discover potentially-interesting insights. Power BI scans as much of a dataset as possible in an allotted amount of
time.

You can run insights against a dataset or dashboard tile.

These are some of the algorithms we use:

Highlights cases where, for a measure in the model, one or two members of a dimension have much larger values
than other members of the dimension.

Highlights when there are significant changes in trends in a time series of data.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-insight-types.md


Correlation

Low Variance

Majority (Major factors)

Detects cases where multiple measures show a correlation between each other when plotted against a dimension
in the dataset.

Detects cases where data points are not far from the mean.



Overall trends in time series

Seasonality in time series

Finds cases where a majority of a total value can be attributed to a single factor when broken down by another
dimension.

Detects upward or downward trends in time series data.

Finds periodic patterns in time series data, such as weekly, monthly, or yearly seasonality.



Steady share

Time series outliers

Next steps

Highlights cases where there is a parent-child correlation between the share of a child value in relation to the
overall value of the parent across a continuous variable.

For data across a time series, detects when there are specific dates or times with values significantly different than
the other date/time values.

Power BI insights

If you own a dataset, optimize it for insights

More questions? Try the Power BI Community

http://community.powerbi.com/


Optimize your data for Power BI Quick Insights
12/7/2017 • 1 min to read • Edit Online

Next stepsNext steps

Want to improve quick insights results? If you are a datasest owner, try these:

Hide or unhide columns in your dataset. Power BI quick insights doesn't search hidden columns. So hide
duplicate or unnecessary columns and unhide interesting columns.
Use a mix of data types such as names, times, dates, and numbers.
Avoid (or hide) columns with duplicate information. This takes valuable time away from searching for
meaningful patterns. For example, one column with state names spelled out and another column with state
name abbreviations.
Do you get an error message stating that your data isn't statistically significant? This can happen with models
that are very simple, or that don't have much data, or that don't have date or numeric columns. To generate
insights, your dataset needs to have at least one dimension and one measure.

Power BI quick insights

More questions? Try the Power BI Community

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-insights-optimize.md
http://community.powerbi.com/


Featured dashboards in Power BI service
12/20/2017 • 1 min to read • Edit Online

Create a Featured dashboard

NOTENOTE

To set a dashboard as To set a dashboard as featuredfeatured

Many of us have one dashboard that we visit more than any others. It might be the dashboard we use to run our
business, or it might be a dashboard that contains an aggregation of tiles from many different dashboards and
reports.

When you select a dashboard as featured, each time you open Power BI service, it will open with that dashboard
displayed.

You can also select a few dashboards and set them as favorites. See Dashboard favorites.

This topic applies to Power BI service, and not to Power BI Desktop.

If you haven't yet set a featured dashboard, Power BI will open to the last dashboard you used.

Watch Amanda create a featured dashboard and then follow the instructions below the video to try it out yourself.

1. Open the dashboard that you'd like to set as Featured.

2. In the top navbar, you'll either see Set as featured or just the featured  icon. Select either one.

3. Confirm your selection.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-dashboard-featured.md


  Change the featured dashboard

Remove the featured dashboard

Next steps

Of course, if you change your mind later you can set a new dashboard as the featured dashboard.

1. Follow steps 1 and 2 from above.

2. Select Set as featured. Un-featuring a dashboard does not remove it from your workspace.

If you decide that you don't want any dashboard to be designated as featured, here's how to un-feature a
dashboard.

1. Open the currently-featured dashboard.
2. In the top menubar, select Disable featured.

Now Power BI will open to the last dashboard you used.

Favorite a dashboard

More questions? Try the Power BI Community

http://community.powerbi.com/


Create a view of a Power BI dashboard optimized for
mobile phones
11/9/2017 • 1 min to read • Edit Online

NOTENOTE

Create a phone view of a dashboard

When you view dashboards in the Power BI mobile app on a phone, you notice the dashboard tiles are laid out
one after another, all the same size. In the Power BI service, you can create a customized view of any dashboard
that you own, specifically for phones.

When you turn the phone sideways, then you see the dashboard as it's laid out in the service, not as you designed
it for the phone.

As you edit the phone view, anyone viewing the dashboard on a phone can see the changes you make in real time. For
example, if you unpin all tiles on the dashboard phone view, the dashboard on the phone will suddenly have no tiles.

1. In the Power BI service, open a dashboard.
2. Select the arrow next to Web view in the upper-right corner > select Phone view.

If you aren't the dashboard owner, you won't see this option.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-create-dashboard-mobile-phone-view.md


The phone dashboard edit view opens. Here you can unpin, resize, and rearrange tiles to fit the phone view.
The web version of the dashboard doesn't change.

3. Select a tile to drag, resize, or unpin it. You notice the other tiles move out of the way as you drag a tile.

The unpinned tiles go in the Unpinned tiles pane, where they stay unless you add them back.



Next steps

4. If you change your mind, select Reset tiles to put them back in the size and order they were before.

Just opening Phone Edit view in the Power BI service slightly changes the size and shape of the tiles on a
phone. So to return the dashboard to its exact state before you opened it in Phone Edit view, select Reset
tiles.

5. When you're satisfied with the phone dashboard layout, select the arrow next to Phone view in the upper-
right corner > select Web view.

Power BI saves the phone layout automatically.

Create reports optimized for the Power BI phone apps
Create responsive visuals optimized for any size
More questions? Try asking the Power BI Community

http://community.powerbi.com/


Create a QR code for a tile in Power BI to use in the
mobile apps
11/9/2017 • 1 min to read • Edit Online

Create a QR code for a tile

Print the QR code

QR codes in Power BI can connect anything in the real world directly to related BI information — no navigation or
search needed.

You can create a QR code in the Power BI service for tiles in any dashboard, even in dashboards you can't edit.
Then place the QR code in a key location. For example, you could paste it in an email, or print it out and paste it in
a specific location.

Colleagues you've shared the dashboard with can scan the QR code for access to the tile, right from their mobile
device. They can use either the QR code scanner located in the Power BI app, or any other QR scanner installed on
their device. .

1. Open a dashboard in the Power BI service.

2. Select the ellipsis (...) in the top-right corner of the tile and select Focus mode .
3. Select the ellipsis (...) in the top-right corner and select Generate QR code.

4. A dialog box with the QR code appears.

5. From here you can scan the QR code or download and save it so you can:

Add it to an email or other document, or
Print it and place it in a specific location.

Power BI generates the QR code as a JPG file, ready to print.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-create-qr-code-for-tile.md


Next steps

TIPTIP

2. Print the file at 100% or “actual size”.
3. Cut out the QR code and glue it to a place relevant to the tile.

1. Select Download, then open the JPG file on a computer connected to a printer.

The JPG file has the same name as the tile. For example, "Opportunity Count - by Month, Sales Stage.jpg".

Connect to Power BI data from the real world with the mobile apps
Scan a Power BI QR code from your mobile device
Create a QR code for a report
Questions? Try asking the Power BI Community

http://community.powerbi.com/


Add an image to a Power BI dashboard
12/20/2017 • 1 min to read • Edit Online

There are several ways to add a standalone image to a dashboard: one way is to pin an image from a report to a
dashboard and another way is to add it directly onto the dashboard using Add tile. For more information, visit
these articles:

Add dashboard tiles directly from a Power BI dashboard.
Pin images from a Power BI report.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-dashboard-add-image.md


Dashboard data classification
11/15/2017 • 3 min to read • Edit Online

Data classification tags

Every dashboard is different, and depending on the data source you are connecting to, you will likely find that you
and the colleagues you share with will need to take different precautions depending on the sensitivity of the data.
Some dashboards should never be shared with those outside your company or printed out, while others can be
shared freely. By using dashboard data classification, you will be able to raise awareness with those viewing your
dashboards about what level of security should be used. You can tag your dashboards with classifications defined
by your company’s IT department, so everyone viewing the content will have the same level of understanding
around the sensitivity of the data.

Data classification tags show up next to the dashboard name, letting anyone viewing it know the level of security
that should be applied to the dashboard and the data it contains.

It will also show up next to the dashboard tile in your Favorites list.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-data-classification.md


NOTENOTE

Setting a dashboard’s classification

When you hover over the tag, you will see the full name of the classification.

Admins can also set an URL for a tag to provide additional information.

Depending the classification settings set by your admin, some classification types may not show as a tag on the dashboard.
If you are a dashboard owner, you can always check your dashboard classification type under the dashboard settings.

If data classification is turned on for your company, all dashboards start out with a default classification type, but
as a dashboard owner, you can change the classification to match your dashboards security level.

To change the classification type, do the following.

1. Go to the dashboard settings by selecting the ellipsis next to the dashboard name and select Settings.

2. Under Dashboard settings, you will be able to see the current classification for your dashboard and use the
drop down to change the classification type.



Working with data classification tags as an admin

3. Select Apply when finished.

After you apply the change, anyone you shared with will see the update the next time they reload the dashboard.

Data classification is set up by the global admin for your organization. To turn data classification on, do the
following.

1. Select the Settings gear and select Admin Portal.

2. Switch Data classification for dashboards and reports to on within the Tenant settings tab.



Once turned on, you will be presented with a form to create the various classifications in your organization.

Each classification has a name and a shorthand which will appear on the dashboard. For each classification, you
can decide if the shorthand tag will appear on the dashboard or not by selecting Show tag. If you decide not to
show the classification type on the dashboard, the owner will still be able to see the type by checking the
dashboard settings. Additionally, you can optionally add a URL that contains more information about your



NOTENOTE

organization’s classification guidelines and usage requirements.

The last thing you need to decide is which classification type will be the default.

Once you fill in the form with your classification types, select Apply to save the changes.

At this point, all dashboards will be assigned the default classification, and dashboard owners will now be able to
update the classification type to the one appropriate for her content. You can return here in the future to add or
remove classification types or change the default.

There are a few important things to remember when you come back to make changes:

If you turn data classification off, none of the tags are remembered. You will need to start over if you decide to turn it
back on later.
If you remove a classification type, any dashboards assigned the removed classification type will be assigned back to the
default until the owner goes and sets it again.
If you change the default, all dashboards that weren’t already assigned a classification type by the owner will change to
the new default.



Q&A in Power BI service and Power BI
Desktop
1/19/2018 • 4 min to read • Edit Online

What is Q&A?

Q&A for consumers

Sometimes the fastest way to get an answer from your data is to ask a question using natural
language. For example, "what were total sales last year." Use Q&A to explore your data using
intuitive, natural language capabilities and receive answers in the form of charts and graphs. Q&A
is different from a search engine -- Q&A only provides results about the data in Power BI.

This article is the jumping off point for all things Q&A. Select a link below to learn how Q&A
works in Power BI service (dashboards and reports), Power BI Desktop (reports), Power BI
Embedded, and Power BI mobile.

Asking the question is just the beginning. Have fun traveling through your data refining or
expanding your question, uncovering trust-worthy new information, zeroing in on details and
zooming out for a broader view. You’ll be delighted by the insights and discoveries you make.

The experience is truly interactive…and fast! Powered by an in-memory storage, response is
almost instantaneous.

When a colleague shares a dashboard with you, you'll find the Q&A question box on the
dashboard in Power BI service (app.powerbi.com), at the bottom of the dashboard in Power BI
mobile, and above the visualization in Power BI Embedded. Unless the owner has given you edit
permissions, you'll be able to use Q&A to explore data but won't be able to save any visualizations
created with Q&A.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/power-bi-q-and-a.md


Q&A for creators

How does Q&A know how to answer questions?
Which datasets does Q&A use?Which datasets does Q&A use?

Which visualization does Q&A use?Which visualization does Q&A use?

If you're a creator of Power BI reports or have edit permissions to a dataset, you'll find the Q&A
question box on the dashboard in Power BI service, and on each report page in Power BI service
and Power BI Desktop. Any visualization you create using Q&A can be saved to a dashboard and
saved in a report.

In addition to using Q&A to explore their data, creators and dataset owners can improve the Q&A
experience for consumers by modifying their datasets, adding featured questions, and enabling
and disabling Q&A for on-premises live connection datasets. In Embedded scenarios, developers
can choose between 2 modes: interactive and result only.

How does Q&A know how to answer data-specific questions? It relies on the names of the tables,
columns, and calculated fields in the underlying dataset. So what you (or the dataset owner) call
things is important!

For example, suppose you had an Excel table named “Sales”, with columns titled “Product”,
“Month”, “Units Sold”, “Gross Sales”, and “Profit”. You could ask questions about any of those
entities. You could ask "show sales, "total profit by month", "sort products by units sold", and more.

Q&A can answer questions that are based on how your dataset is organized. How would this work
for data in Salesforce? When you connect to your salesforce.com account, Power BI generates a
dashboard automatically. Before you start asking questions with Q&A, take a look at the data
displayed in the dashboard visualizations and also at the data displayed in the Q&A dropdown.

If the visualizations' axis labels and values include "sales", "account", "month", and
"opportunities", then you can confidently ask questions such as: "Which account has the
highest opportunity, or show sales by month as a bar chart."
If the dropdown includes "salesperson", "state", and "year", then you can confidently ask
questions such as: "which salesperson had the lowest sales in Florida in 2013."

If you have website performance data in Google Analytics, you could ask Q&A about time spent
on a web page, number of unique page visits, and user engagement rates. Or, if you’re querying
demographic data, you might ask questions about age and household income by location.

Q&A picks the best visualization based on the data being displayed. Sometimes data in the
underlying dataset(s) is defined as a certain type or category and this helps Q&A know how to
display it. For example, if data is defined as a date type, it is more likely to be displayed as a line



For more details about Power BI Q&A

chart. Data that is categorized as a city is more likely to be displayed as a map.

You can also tell Q&A which visualization to use by adding it to your question. But keep in mind
that it may not always be possible for Q&A to display the data in the visualization type you
requested.

For information about keywords that Q&A recognizes, see Tips for asking questions.

Overview: How to use Q&A in Power BI dashboards and reports: Step by step instructions for
using Q&A and an overview of how it all works.

Microsoft Power BI mobile app For iOS on iPads, iPhones, and iPod Touch devices.

Microsoft Power BI Embedded Incorporate Q&A into an application.

Tips for asking questions in Q&A: Learn how to talk to Q&A to get the best possible results.

Add featured questions to your datasets and Q&A will suggest these questions to your colleagues.

Enable Q&A for your on-premises datasets If you need a gateway to connect to the dataset, use
Power BI settings to turn Q&A on and off.

Tutorial: Use Q&A with the Retail Sales sample n Power BI service: Use Q&A in a realistic industry
tutorial.

Make your data work well with Q&A: Are you the person creating datasets and data models? Then
this topic is for you.

More questions? Try the Power BI Community

http://community.powerbi.com/


Quickly find and view your Power BI data using
Cortana for Power BI
1/19/2018 • 5 min to read • Edit Online

Preview the new Cortana dashboard search experience for Windows 10

NOTENOTE

Cortana for Power BI documentation

How do Cortana and Power BI work together?

Use Cortana across your Windows 10 devices to get instant answers to your important business questions. By
integrating with Power BI, Cortana can retrieve key information directly from Power BI dashboards and reports. All
it takes is Windows 10 November 2015 version or later, Cortana, Power BI, and access to at least one dataset.

For a while now you've been able to use Cortana to retrieve certain types of report pages. Now we've added a new
experience -- the ability to also retrieve dashboards. Try it out and please send us feedback . Eventually the new
experience will be extended to include Cortana search for reports as well. One of the key benefits of the new
experience is that you don't need to do anything special to set it up -- no enabling Cortana or configuring Windows
10 -- it just works.

If it doesn't "just work," see the Troubleshooting article for help.

 Microsof t 's Azure Search ServiceThe underlying technology is using . This search service provides extra capabilities such as smart ranking, error
correction, and auto complete.

Both Cortana experiences will exist side-by-side.

We have 4 documents that guide you through setting up and using Cortana for Power BI. This series of articles will
take you through the steps to

Article 1 (this article): understand how Cortana and Power BI work together

Article 2: search Power BI reports: Enable the Cortana - Power BI - Windows integration

Article 3: search Power BI reports: create special Cortana answer cards

Article 4: Troubleshoot issues

When you use Cortana to ask a question, Power BI can be one of the places Cortana looks for answers. In Power BI,
Cortana can find rich data-driven answers from Power BI reports (that contain a special type of report page called a
Cortana answer card) and from Power BI dashboards.

If Cortana finds a match, it displays the name of the dashboard or report page right there in your Cortana screen.
The dashboard or report page can be opened in Power BI. Report pages can also be explored right in Cortana -
they're interactive.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-cortana-intro.md
mailto:pbicortanasg@microsoft.com


Cortana and Dashboards (the Cortana and Dashboards (the new experiencenew experience))

Cortana and ReportsCortana and Reports

Cortana can find answers in dashboards that you own and dashboards that have been shared with you. Ask
Cortana questions using titles, keywords, owner names, workspace names, app names, and more.

Your question must have at least 2 words for Cortana to find an answer. So if you search on a dashboard that has a
one-word name (Marketing) add the word "show" or "Power BI" or ""to your question, as in "show Marketing" and
"michele hart sample".

If your dashboard has a title with more than one word, Cortana will only return that dashboard if your search
matches at least two of the words or if your dashboard matches one of the words plus the owner name. For a
dashboard named "Customer Profitability Sample":

"show me customer" will not return a Power BI dashboard result.
"utterances such as "show me customer profitability", "customer p", "customer s", "profitability sample",
"michele hart sample", "show customer profitability sample", and "show me customer p" will return a Power BI
result.
Adding the word "powerbi" counts as one of the 2 required words, so "powerbi sample" will return a Power
BI result.

Cortana can find answers in reports that have pages designed specifically for display by Cortana. Simply ask



NOTENOTE

Using Cortana to get answers from Power BI

questions using the title or keywords from one of these specialty report pages.

The underlying technology for reports is using Microsoft's Power BI Q&A.

When you ask a question in Cortana, Power BI answers from report pages designed specifically for Cortana.
Potential answers are determined by Cortana on the fly directly from the Cortana answer cards already created in
Power BI. To further explore an answer, simply open a result in Power BI.

Before Cortana can look for answers in your Power BI reports, you'll need to enable this feature using the Power BI service
and set up Windows to communicate with Power BI.

NOTENOTE

1. Start in Cortana. There are many different ways to open Cortana: select the Cortana icon in the taskbar
(pictured below), use voice commands, or tap the search icon on your Windows mobile device.

2. Once Cortana is ready, type or speak your question into the Cortana search bar. Cortana displays the
available results. If there is a Power BI dashboard that matches the question, it shows up under Best match
or Power BI.

At the current time, only English is supported.

3. Select the dashboard to open it in Cortana.



You can change the layout by editing the phone view of the dashboard.

4. From Cortana you also have the options to open the dashboard in Power BI service or Power Bi mobile.
Open the dashboard in Power BI service by selecting Open on web.

5. Now let's use Cortana to search for a report. We'll need to know of a report that has a page with a Cortana
answer card . In this example, a report named "Cortana-New-Stores" has a Cortana answer card page
named "cortana stores".

Type or speak your question into the Cortana search bar. Cortana displays the available results. If there is a
Power BI report page that matches the question, it shows up under Best match or Power BI. And in this
example the .pbix file (and backup) that I used to create the answer card also displays -- under Documents.



6. Select the Cortana stores report page to display it in the Cortana window.

Remember, an answer card is a special type of Power BI report page that was created by a dataset owner.
For more information, see Create a Cortana answer card.

7. But that's not all. Interact with the visualizations on the answer card as you would in Power BI.

For example, select an element on one visualization to cross-filter and highlight the other
visualizations on the answer card.



Or, use natural language to filter the results instead. For example, ask "Cortana stores for Lindseys"
and see the card filtered to only show data for the Lindseys chain.

8. Continue exploring. Scroll to the bottom of the Cortana window and select Open in Power BI.



Considerations and troubleshooting

Next steps

9. The report page opens in Power BI.

Cortana will not have access to any Cortana cards that have not been enabled for Power BI.
Still can't get Cortana to work with Power BI? Try the Cortana troubleshooter.
Cortana for Power BI is currently only available in English.
Cortana for Power BI is only available on Windows mobile devices.

More questions? Try the Power BI Community

Enable the Cortana - Power BI - Windows integration for reports

http://community.powerbi.com/


Get started with Power BI Q&A (Quickstart)
1/19/2018 • 2 min to read • Edit Online

Use Power BI Q&A with the Retail Analysis sample

Method 1: using the report editor

Sometimes the fastest way to get an answer from your data is to ask a question using natural language. In this
quickstart we'll look at 2 different ways of creating the same visualization: first, building it in a report and, second,
asking a question with Q&A. We'll use Power BI service, but the process is almost identical using Power BI Desktop.

To follow along, you must use a report that you can edit, so we'll use one of the samples available with Power BI.

1. From your Power BI workspace, select Get Data > Samples > Retail Analysis Sample > Connect.

2. The dashboard contains an area chart tile for "Last Year Sales and This Year Sales." Select this tile.

If this tile was created with Q&A, selecting the tile will open Q&A.
But this tile was created in a report, so the report opens to the page that contains this visualization.

3. Open the report in Editing View by selecting Edit Report. If you are not an owner of a report, you will not
have the option to open the report in Editing view.

4. Select the area chart and review the settings in the Fields pane. The report creator built this chart by
selecting these 3 values (Time > FiscalMonth, Sales > This Year Sales, Sales >Last Year Sales >Value)
and organizing them in the Axis and Values wells.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/power-bi-visualization-introduction-to-q-and-a.md


Method 2: using Q&A
How would we go about creating this same line chart using Q&A?

1. Navigate back to the Retail Analysis Sample dashboard.
2. Using natural language, type something like this into the question box:

what were this year sales and last year sales by month as area chart

As you type your question, Q&A picks the best visualization to display your answer; and the visualization
changes dynamically as you modify the question. Also, Q&A helps you format your question with
suggestions, auto-complete, and spelling corrections.

When you finish typing your question, the result is the exact same chart that we saw in the report. But
creating it this way was much faster!



Next steps

3. Similar to working with reports, within Q&A you have access to the Visualizations, Filters and Fields panes.
Open these panes to further explore and modify your visual.

4. To pin the chart to your dashboard, select the pin icon .

Q&A in Power BI

Make your data work well with Q&A in Power BI

More questions? Try the Power BI Community

http://community.powerbi.com/


Tutorial: How to use Q&A to create visualizations and
build reports
1/19/2018 • 5 min to read • Edit Online

Part 1: Use Q&A on a dashboard in Power BI service
(app.powerbi.com)

The Q&A overview introduced you to Power BI Q&A and made the distinction between consumers (have
dashboards and reports shared with them) and creators (own the underlying reports and datasets). The first part
of this tutorial is designed primarily for people consuming dashboards using Power BI service. And the second
part is designed for people creating reports using either Power BI service or Power BI Desktop. Q&A and Power BI
mobile and Q&A with Power BI Embedded are covered in separate articles.

Q&A is interactive and even fun, and, more often than not, one question will lead to many others as the
visualizations reveal interesting paths to pursue. Watch Amanda demonstrate using Q&A to create visualizations,
dig into those visuals, and pin them to dashboards.

A dashboard contains tiles pinned from one or more datasets, so you can ask questions about any of the data
contained in any of those datasets. To see what reports and datasets were used to create the dashboard, select
View related from the menubar.

The Q&A question box is located in the upper-left corner of your dashboard, and this is where you type your
question using natural language. Q&A recognizes the words you type and figures out where (which dataset) to
find the answer. Q&A also helps you form your question with auto-completion, restatement, and other textual and
visual aids.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/power-bi-tutorial-q-and-a.md


The answer to your question is displayed as an interactive visualization and updates as you modify the question.

1. Open a dashboard and place your cursor in the question box. Even before you start typing, Q&A displays a
new screen with suggestions to help you form your question. You'll see the names of the tables in the
underlying dataset(s) and may even see complete questions listed if the dataset owner has created featured
questions,

You can always choose one of these questions as a starting point and continue to refine the question to find
the specific answer you are looking for. Or, use a table name to help you word a new question.

2. Select from the dataset options or begin typing your own question and select from the dropdown
suggestions.



TIPTIP

3. As you type a question, Q&A picks the best visualization to display your answer; and the visualization
changes dynamically as you modify the question.

4. When you type a question, Power BI looks for the best answer using any dataset that has a tile on that
dashboard. If all the tiles are from datasetA, then your answer will come from datasetA. If there are tiles
from datasetA and datasetB, then Q&A will search for the best answer from those 2 datasets.

So be careful, if you only have one tile from datasetA and you remove it from your dashboard, Q&A will no longer
have access to datasetA.

5. When you're happy with the result, pin the visualization to a dashboard by selecting the pin icon in the top
right corner. If the dashboard has been shared with you, or is part of an app, you won't be able to pin.



Part 2: Use Q&A in a report in Power BI service or Power BI Desktop
Use Q&A to explore your dataset and to add visualizations to the report and to dashboards. A report is based on a
single dataset and may be completely blank or contain pages full of visualizations. But just because a report is
blank, doesn't mean there isn't any data for you to explore -- the dataset is linked to the report and is waiting for
you to explore and create visualizations. To see which dataset is being used to create a report, open the report in
Power BI service Reading view and select View related from the menubar.

In order to use Q&A in reports, you must have edit permissions for the report and underlying dataset. In the Q&A
Overview topic we referred to this as a creator scenario. So if you are, instead, consuming a report that has been
shared with you, Q&A will not be available.

1. Open a report in Editing view (Power BI service) or Report view (Power BI Desktop) and select Ask a
question from the menubar.

Desktop

Service

2. A Q&A question box displays on your report canvas. In the example below, the question box displays on top
of another visualization. This is fine, but it might be better to add a blank page to the report before asking a
question.



3. Place your cursor in the question box. As you type, Q&A displays suggestions to help you form your
question.

4. As you type a question, Q&A picks the best visualization to display your answer; and the visualization
changes dynamically as you modify the question.

5. When you have the visualization you like, select ENTER. To save the visualization with the report, select File
> Save.

6. Interact with the new visualization. It doesn't matter how you created the visualization -- all the same
interactivity, formatting, and features are available.



Tell Q&A which visualization to use.

Considerations and troubleshooting

Next steps

If you've created the visualization in Power BI service, you can even pin it to a dashboard.

With Q&A, not only can you ask your data to speak for itself, you can tell Power BI how to display the answer. Just
add "as a " to the end of your question. For example, "show inventory volume by plant as a map" and "show total
inventory as a card". Try it for yourself.

If you've connected to a dataset using a live connection or gateway, Q&A needs to be enabled for that
dataset.

You've opened a report and don't see the Q&A option. If you're using Power BI service, make sure the
report is open in Editing view. If you can't open Editing view it means you don't have edit permissions for
that report and won't be able to use Q&A with that specific report.

Back to Q&A in Power BI
Tutorial: Use Q&A with the Retail Sales sample
Tips for asking questions in Q&A
Prepare a workbook for Q&A
Prepare an on-premises dataset for Q&A Pin a tile to the dashboard from Q&A



Enable Q&A for live connections
1/19/2018 • 3 min to read • Edit Online

What is on-premises data gateway? What is a live connection?

Q&A for on-premises data gateway datasets

Enable Q&A

Datasets in Power BI can be imported into Power BI or you can create a live connection to them. Live connection
datasets are often referred to as "on-premises". The live connections are managed using a gateway and data and
inquiries are sent back and forth using live queries.

If you'd like to use Q&A with datasets you access through a gateway, you'll need to enable them first.

Once enabled, Power BI creates an index of your data source and uploads a subset of that data to Power BI to
enable asking questions. It may take several minutes to create the initial index and Power BI maintains and
updates the index automatically as your data changes. Using Q&A with these datasets behaves the same as with
data published to Power BI. The full set of features available in the Q&A experience is supported in both cases,
including using the data source with Cortana.

As you ask questions in Power BI, Q&A determines the best visual to construct or report sheet to use to answer
your question using an index of your dataset. After determining the best potential answer, Q&A uses DirectQuery
to fetch live data from the data source via the gateway to populate charts and graphs. This ensures Power BI Q&A
results always show the most up-to-date data directly from the underlying data source.

Since Power BI Q&A uses the text and schema values from your data source to determine how to query the
underlying model for answers, searches for specific new or deleted text values (such as asking for a customer
name related to a newly added text record) rely on the index being up-to-date with the latest values. Power BI
automatically keeps the text and schema index up to date within a 60 minute window of changes.

For more information, see:

What is the on-premises data gateway?
Introduction to Power BI Q&A

Once you have the data gateway set up, connect to your data from Power BI. Either create a dashboard using your
on-premises data, or upload a .pbix file that uses on-premises data. You may also already have on-premises data
in dashboards, reports, and datasets that have been shared with you.

1. In the upper-right corner of Power BI, select the cog icon  and choose Settings.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-q-and-a-direct-query.md


What data is cached and how is privacy protected?

2. Select datasets and choose the dataset to enable for Q&A.

3. Expand Q&A and Cortana, select the checkbox for Turn on Q&A for this dataset and choose Apply.



Considerations and troubleshooting

Next steps

When you enable Q&A for your on-premises data, a subset of your data is cached in the service. This is done to
ensure that Q&A works with a reasonable performance. Power BI excludes values longer than 24 characters from
caching. The cache is deleted within a few hours when you disable Q&A by unchecking Turn on Q&A for this
dataset, or when you delete your dataset.

During the Preview phase of this feature, there are several limitations:

Initially the feature is only available for SQL Server 2016 Analysis Services Tabular data sources. The feature is
optimized to work with tabular data. Some functionality is available for multi-dimensional data sources, but the
full Q&A experience is not yet supported for multi-dimensional. Additional data sources supported by the on-
premises data gateway will be rolled out over time.
Full support for row level security defined in SQL Server Analysis Services is not available initially in the public
preview. While asking questions in Q&A, the “auto-complete” of questions while typing can show string values
a user does not have access to. However, RLS defined in the model is respected for report and chart visuals so
no underlying numerical data can be exposed. Options to control this behavior will be released in coming
updates.
Live connections are only supported with the on-premises data gateway. As a result, this cannot be used with
the personal gateway.

On-premises data gateway
Manage your data source - Analysis Services
Power BI - Basic Concepts
Power BI Q&A Overview

More questions? Try asking the Power BI Community

http://community.powerbi.com/


How to make your Excel data work well with Q&A in
Power BI
1/19/2018 • 2 min to read • Edit Online

How Q&A works with ExcelHow Q&A works with Excel

Prepare an Excel dataset for Q&APrepare an Excel dataset for Q&A

Next steps

If you are a person who creates data models or builds Excel workbooks that will be used with Power BI, read on...

In Power BI, Q&A can search structured data and choose the right visualization for your question -- that's what
makes it a compelling tool to use.

Q&A can work on any uploaded Excel file that has tables, ranges, or contains a PowerPivot model, but the more
optimizations and data cleaning you do, the more robust Q&A performance is. If you plan on sharing reports and
dashboards based on your dataset, you'll want your colleagues to have an easy time asking questions and getting
quality answers.

Q&A has a set of core natural language understanding abilities that work across your data. It has context-
dependent keyword search for your Excel table, column, and calculated field names. It also has built-in knowledge
for how to filter, sort, aggregate, group, and display data.

For example, in an Excel table named “Sales”, with columns “Product”, “Month”, “Units Sold”, “Gross Sales”, and
“Profit”, you could ask questions about any of those entities. You could ask to show sales, total profit by month,
sort products by units sold, and many others. Read more about the kinds of questions you can ask, and
visualization types you can specify in a Q&A query.

Q&A relies on the names of tables, columns, and calculated fields to answer data-specific questions, meaning
what you call entities in your workbook is important!

Here are some tips for making the most of Q&A in your workbook.

Make sure your data is in an Excel table. Here's how to create an Excel table.
Make sure the names of your tables, columns, and calculated field make sense in natural speech.

For example, if you have a table with sales data, call the table “Sales”. Column names like “Year”, “Product”,
“Sales Rep”, and “Amount” will work well with Q&A.

If your workbook has a Power Pivot data model, you can do even more optimizations. Read more about
Demystifying Power BI Q&A part 2 from our in-house team of natural language experts.

Open the dataset in Power BI Desktop and create new columns, create calculated measures, concatenate
fields to create unique values, classify data by type (e.g., dates, strings, geography, images, URLs), and more.

Back to Q&A in Power BI
Prepare on-premises datasets for Q&A
Q&A quickstart
Get data (for Power BI)

More questions? Try the Power BI Community

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-prepare-data-for-q-and-a.md
https://support.office.com/article/Create-an-Excel-table-in-a-worksheet-e81aa349-b006-4f8a-9806-5af9df0ac664?ui=en-US&rs=en-US&ad=US
http://blogs.msdn.com/b/powerbi/archive/2014/02/27/demystifying-power-bi-q-amp-a-part-2.aspx
http://community.powerbi.com/


Enable Cortana to access Power BI reports (and their
underlying datasets)
12/20/2017 • 3 min to read • Edit Online

NOTENOTE

Use Power BI service to enable Cortana to access report pages in
Power BI

You've read the Introduction to Cortana and Power BI (if not, you might want to read that first and then come
back). And now you want to try it out yourself. Before you can ask natural language questions in Cortana and find
answers from data stored in Power BI reports, there are a few requirements. Specifically, you'll need to do the
following.

If you are trying out the Cortana and Power BI dashboard preview, you can skip the rest of this article. There are no setup
requirements for Cortana to be able to search your Power BI dashboards.

In Power BI service

enable one or more datasets for Cortana (reports are built on top of datasets, so Cortana needs access to those
datasets)

In Microsoft Windows

Check that you are running Windows 10 version 1511 or later
Make sure that Power BI and Windows can "talk" to each other. This means connecting your account to
Windows.

Enabling reports in Power BI to be accessed by Cortana is a simple process. In fact all you have to do is enable the
report's underlying dataset by selecting “Enable Cortana to access this dataset”. After that, any user who has
access to the dataset in Power BI, via regular Power BI sharing, apps, and content pack features, will be able to get
answers from the report in Cortana in Windows 10.

You'll need to sign in to Power BI service (not Power BI Desktop) and repeat these steps for each dataset that you
want Cortana to be able to access.

1. Determine which dataset(s) to enable. From the report content list, select the report you'd like Cortana to

access and choose the View related icon  .

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-cortana-enable.md


 Add your Power BI credentials to Windows

NOTENOTE

2. The dataset associated with this report is Contoso Sales.

3. To the right of the dataset name, select the ellipses (...) > Settings.

4. Select Q&A and Cortana > Allow Cortana to access this dataset > Apply.

In this example, we're enabling Cortana on the Contoso Sales dataset.

When a new dataset or Cortana answer card is added to Power BI and enabled for Cortana, it can take up to 30
minutes for results to begin appearing. Logging in and out of Windows 10, or otherwise restarting the Cortana
process in Windows 10, will allow new content to appear immediately.

If you enable a dataset for Cortana, and that dataset is part of a content pack or app you own, you will need to re-
publish for your colleagues to also be able to use it with Cortana.

You'll need to be running Windows 10 version 1511 or higher.

1. Determine which Windows 10 version you are running. Open Settings.



Next steps

Then select System > About. Towards the bottom of the screen you'll see Windows specifications >
Version

If you have Windows 10 version 1511 (Windows 10 November 2015 Update) up until 1607, add your
work or school account and Microsoft account (complete steps 2 and 3 below).
If you have Windows 10 version 1607 (Windows 10 July 2016 update) or later, add your work or school
account (complete only step 2 below).

2. Add your work or school account for Cortana.

Open Settings > Accounts.

Scroll to the bottom and select Add a work or school account. Or, from the Accounts page selet
Access work or school >Connect.

Cortana will use this work or school account to check Power BI for potential answers to your questions in Cortana.

Create Cortana answer cards in Power BI

Troubleshoot Cortana and Power BI integration issues



More questions? Try the Power BI Community

http://community.powerbi.com/


Create featured questions for Power BI Q&A
1/19/2018 • 1 min to read • Edit Online

NOTENOTE

If you own a dataset, you can add your own featured questions to that dataset. And Power BI Q&A will show those
questions to colleagues who use (consume) your dataset. Featured questions give your colleagues ideas about the
types of questions they can ask about the dataset. The featured questions you add are up to you -- add popular
questions, questions that display interesting results, or questions that may be hard to phrase.

Watch Will add some featured questions to Power BI Q&A and then use those featured questions to explore his
dataset. Then follow the step-by-step instructions below the video to try it out yourself.

Q&A featured questions are available for use in the Microsoft Power BI app for iOS on iPads, iPhones, and iPod Touch
devices and Power BI Desktop Q&A Preview. But creating the questions is only available in Power BI service
(app.powerbi.com).

This article uses the Retail Analysis Sales sample.

1. On the dashboard, select the Q&A question box. Notice that Q&A is already being helpful by displaying a list of
terms that appear in the dataset.

2. To add to this list, select the gear icon in the top right corner of Power BI.

3. Select Settings > Datasets > Retail Analysis sample > Featured Q&A Questions.
4. Select Add a question.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-q-and-a-create-featured-questions.md


5. Type your question in the text box and select Apply. Optionally, add another question by selecting Add a
question.

6. Navigate back to the Power BI dashboard for Retail Analysis Sample, and place your cursor in the Q&A
question box.

7. The new featured question, Sales by territory as a map, is first in the list. Select it.
8. The answer displays as a filled map visualization.



Next stepsNext steps
Q&A in Power BI
Tutorial: Introduction to Power BI Q&A
Power BI - Basic Concepts
More questions? Try the Power BI Community

http://community.powerbi.com/


Tips for asking questions in Power BI Q&A
1/19/2018 • 5 min to read • Edit Online

Words and terminology that Q&A recognizes

NOTENOTE

This list of keywords is not exhaustive. The best way to see if Power BI recognizes a keyword, is to try it out by
typing it in the question box. If the word or term is greyed out, then Power BI does not recognize it, or doesn’t
recognize it in the current context.

The list below uses present tense, but all tenses are recognized in most cases. For example, “is” includes are, was,
were, will be, have, has, had, will have, has got, do, does, did. And “sort” includes sorted and sorting. Also, PowerBI
recognizes and includes singular and plural versions of a word. For example, Power BI recognizes “year” and
“years”.

Q&A is also available in the Microsoft Power BI app for iOS on iPads, iPhones, and iPod Touch devices.

If you are the owner of a dataset, add phrasings and synonyms to improve the Q&A results for your customers.

Aggregates: total, sum, amount, number, quantity, count, average, most, least, fewest, largest, smallest, highest,
biggest, maximum, max, greatest, lowest, littlest, minimum, min

Articles: a, an, the

Blank and Boolean: blank, empty, null, prefixed with “non” or “non-“, empty string, empty text, true, t, false, f

Comparisons: vs, versus, compared to, compared with

Conjunctions: and, or, each of, with, versus, &, and, but, nor, along with, in addition to

Contractions: Q&A recognizes almost all contractions, try it out. Here are a few examples: didn’t, haven’t, he’d,
he’s, isn’t, it’s, she’ll, they’d, weren’t, where’ll, who’s, won’t, wouldn’t.

Dates: Power BI recognizes most date terms (day, week, month, year, quarter, decade, etc…) and dates written in
many different formats (see below). Power BI also recognizes the following keywords: MonthName, Days 1-31,
decade.

Examples: January 3rd of 1995, January 3rd 1995, jan 03 1995, 3 Jan 1995, the 3rd of January, January 1995, 1995
January, 1995-01, 01/1995, names of months.

Relative dates: today, right now, current time, yesterday, tomorrow, the current, next, the coming, last, previous,
ago, before now, sooner than, after, later than, from, at, on, from now, after now, in the future, past, last, previous,
within, in, over, N days ago, N days from now, next, once, twice.

Example: count of orders in the past 6 days.

Equality (Range): in, equal to, =, after, is more than, in, between, before

Examples: Order year is before 2012? Price equals between 10 and 20? Is the age of John greater than 40? Total
sales in 200-300?

Equality (Value): is, equal, equal to, in, of, for, within, is in, is on

Examples: Which products are green? Order date equals 2012. Is the age of John 40? Total sales that is not equal to

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-q-and-a-tips.md


Q&A helps you phrase the question

Combine results from more than one dataset

Don't stop now

200? Order date of 1/1/2016. 10 in price? Green for color? 10 in price?

Names: If a column in the dataset contains the phrase "name" (e.g., EmployeeName), Q&A understands the values
in that column are names and you can ask questions like "which employees are named robert."

Pronouns: he, him, himself, his, she, herself, her, hers, it, itself, its, they, their, them, themselves, theirs, this, these,
that, those

Query commands: sorted, sort by, direction, group, group by, by, show, list, display, give me, name, just, only,
arrange, rank, compare, to, with, against, alphabetically, ascending, descending, order

Range: greater, more, larger, above, over, >, less, smaller, fewer, below, under, <, at least, no less than, >=, at most,
no more than, <=, in, between, in the range of, from, later, earlier, sooner, after, on, at, later than, after, since,
starting with, starting from, ending with

Times: am, pm, o'clock, noon, midnight, hour, minute, second, hh:mm:ss

Examples: 10 pm, 10:35 pm, 10:35:15 pm, 10 oclock, noon, midnight, hour, minute, second.

Top N (order, ranking): top, bottom, highest, lowest, first, last, next, earliest, newest, oldest, latest, most recent, next

Visual types: all visual types native to Power BI. If it's an option in the Visualizations pane, then you can include it
in your question. The exception to this is custom visuals that you've manually added to the Visualization pane.

Example: show districts by month and sales total as bar chart

Wh (relationship, qualified): when, where, which, who, whom, how many, how much, how many times, how
often, how frequently, amount, number, quantity, how long, what

Q&A does its best to ensure that the answer accurately reflects the question being asked. It does this in several
ways. For all of these, you can accept the action in full, in part, or not at all. As you type your question, Q&A:

auto-completes words and questions. It uses various strategies, including auto-completing recognizable words,
popular questions for the underlying workbooks, and previously-used questions that returned valid responses.
If more than one auto-complete option is available, they are presented in a dropdown list.
corrects spelling.
provides a preview of the answer in the form of a visualization. The visualization updates as you type and edit
the question (it doesn't wait for you to press Enter).
auto-suggests replacement terms from the underlying dataset(s) when you move the cursor back in the
question box.
restates the question based on the data in the underlying dataset(s). This helps ensure Q&A understood your
question as Q&A replaces the words you used with synonyms from the underlying dataset(s).
dims words it does not understand.

One of Power BI's most powerful features is the ability to combine data from different datasets. So don't limit your
questions to a single dataset -- ask questions that retrieve data from more than one dataset. For example, if my
dashboard has tiles from the Retail Analysis Sample and a state population dataset, I can ask show count of stores
by state population as bar chart descending.

After Q&A displays your results, keep the conversation going! Use the interactive features of the visualization and
of Q&A to uncover more insights.



Next steps
Back to Q&A in Power BI

Power BI - Basic Concepts

More questions? Try the Power BI Community

http://community.powerbi.com/


Troubleshoot Cortana for Power BI
12/20/2017 • 5 min to read • Edit Online

Why doesn't Cortana find answers from my Power BI reports or
dashboards?

This article is part of a series. If you haven't already, we recommend reading the following three articles.

Article 1: Understand how Cortana and Power BI work together to search for Power BI dashboards and reports

Article 2: For searching reports: enable the Cortana - Power BI - Windows integration

Article 3: For searching reports: create special Cortana answer cards

If you're still having problems getting Cortana to integrate with Power BI, you've come to the right place. Follow
the steps below to diagnose and fix the problem.

1. Do you have a Power BI account? If not, sign up, it's free.

3. Did you use at least 2 words in your search? Cortana needs at least 2 word phrases to find answers in Power BI.
Try adding "show" to the beginning of your question.

5. Do you have access or edit permissions to any reports or dashboards? For reports, ensure the content you are
attempting to search has an answer card. For dashboards, ensure the content you are attempting to search is in
Shared with me, an app workspace, or My workspace. Use the troubleshooting tool for help identifying the
problem.

6. Are you using a mobile device? Currently we only support Power BI and Cortana integration on Windows
mobile devices.

2. Is Cortana working? Do you see the Cortana icon in your taskbar?

When you select it, does Cortana open with a field in which you can type?

4. If your dashboard has a title with more than one word, Cortana will only return that dashboard if your
search matches at least two of the words. For a dashboard named "Sales FY16":

"show sales" will not return a Power BI result.
"show me sales fy16", "sales fy16", "show sales fy16", and "show me sales f" will return a Power BI
result.
Adding the words "powerbi" counts as one of the 2 required words, so "powerbi sales" will return a
Power BI result.

7. Is Cortana configured for English? The current Cortana-Power BI integration only supports English. Open
Cortana and select the cog icon to display Settings. Scroll down to Cortana language and ensure it's set to
one of the English options.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-cortana-troubleshoot.md


Reports only: why doesn't Cortana find answers from my Power BI
reports

Dashboards only: why doesn't Cortana find answers from my Power BI
dashboards

8. Do you have more than 100 reports enabled for Cortana? Cortana only searches up to 100 total. To ensure that
your report is included, move or copy it to your My Workspace because Cortana searches there first.

9. You might just need to give it some time. The first time you type a query the model might be cold. Wait a few
seconds so the data can be loaded into memory, and then try again.

10. For dashboards, it can take up to 24 hours for them to become accessible to Cortana.
11. For reports, when a new dataset or custom answer card is added to Power BI and enabled for Cortana it can

take up to 30 minutes for results to begin appearing in Cortana. Logging in and out of Windows 10, or
otherwise restarting the Cortana process in Windows 10, will allow new report content to appear immediately.

12. Your Power BI Administrator can "opt out". Check with your admin to see if this is the case.

1. If you're looking for answers in reports, do you have any reports with Cortana answer cards? Answer cards
are the only way Cortana can find answers in your Power BI reports. Learn how to create an answer card by
reading Create Cortana answer cards in Power BI service and Power BI Desktop.

2. Are your running Windows version 1511 or later? Find out by opening Windows Settings and selecting
System > About. If not, update your version of Windows.

3. Are your Windows and Power BI accounts connected? This can be confusing. Follow the instructions in Enable
Cortana for Power BI.

4. Have the underlying datasets been enabled for Cortana? Maybe a colleague has shared a dataset that she has
already enabled for Cortana. But, if not, learn how to enable datasets for Cortana yourself. It's quick and easy.

1. Ensure that you are connected to your work account. Power BI needs this connection so that it can
authenticate your access permissions to data. To check that you are connected or if not, to connect your
work account, use the Windows search box to navigate to “Connect to work or school”.



 Try the Cortana troubleshooting tool

Having trouble retrieving answers from a report?Having trouble retrieving answers from a report?

2. Do you have access to Cortana? Select the Windows search box and provide Cortana access permissions to
your information.

Still having trouble? Now is a good time to run the Cortana troubleshooting tool and narrow down the possible
issues.

1. For reports, before running the troubleshooting tool, make sure to set the Page level filters on your Cortana
answer cards to Require single selection. For help doing this see Create Cortana answer cards.

2. Open the troubleshooting tool by adding "/cortana/test" to the end of your Power BI service URL. Your URL
should look similar to this:

app.powerbi.com/cortana/test



3. In the Utterance field, to troubleshoot reports, type the name of a Cortana answer card exactly as it
appears in the Power BI tab.



Having trouble retrieving answers from a dashboard?Having trouble retrieving answers from a dashboard?

Troubleshooting tool known issuesTroubleshooting tool known issues

4. Sometimes, the first time you type something into the Utterance field, nothing happens. Think of it as
priming the system; you're letting the troubleshooting tool know that it's time to turn on. Cut and paste or
retype into the Utterance field again. In this example, the name of our answer card is Cortana stores.
Pasting or typing Cortana stores into the tool produces a single result that displays in the Interpretations
field. Click to see the answer card displayed in the Cortana window -- in this case, Cortana stores.

Because we got a result, we now know that Cortana is enabled in Power BI. That narrows down the problem
to something on the Windows side or the Cortana language setting or having more than 100 datasets
enabled for Cortana.

Looking for a dashboard that has been shared with you? Open Power BI > Shared with me and locate the name
of the dashboard. Then type that name into the Utterances* field.

If the tool doesn’t fetch the results the first time; instead paste the query into the Utterance text box.



The query must be 2 or more words, by design. If your query is too short, add the word "show".
Some query strings with prepositions might not work (e.g. sales by item). Try different query terms that don't
use prepositions and are meaningful/unique.

More questions? Try the Power BI Community

http://community.powerbi.com/


How should I collaborate and share dashboards and
reports in Power BI?
1/25/2018 • 5 min to read • Edit Online

Collaborate with coworkers to create an app

You've created dashboards and reports. Maybe you collaborate on them with your coworkers, too. Then you want
others to have access to them. What's the best way to distribute them?

In this article, we'll compare these options for collaborating and sharing in Power BI:

Collaborating with coworkers to create meaningful reports and dashboards in app workspaces.
Bundling those dashboards and reports into apps and publishing them to a larger group or your whole
organization.
Sharing dashboards or reports with a few people, from the service or the Power BI mobile apps.
Publishing to the web, where anyone can see and interact with them.
Printing.

No matter which option you choose, to share a dashboard you need a Power BI Pro license, or the content needs
to be in a Premium capacity. License requirements vary for the colleagues who view your dashboards, depending
on the option you choose. The following sections spell out details.

Apps in the Power BI service

Say you and your teammates want to publish your Power BI insights to your organization. The best way to do
that is to create an app. An app is a collection of dashboards and reports built to deliver key metrics for your
organization.

To create an app, you need a app workspace, with your teammates as members. Think of the app workspace as a
staging area where you and they can collaborate on your Power BI dashboards and reports. All of you can create
reports in Power BI Desktop and publish those reports to the app workspace, and all of you need Power BI Pro
licenses.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-how-to-collaborate-distribute-dashboards-reports.md


Publish your app to a broad audience

Share dashboards and reports

If you just want to share a finished dashboard with colleagues, don't add them to the app workspace.
Instead, create the dashboard in an app workspace, and publish the app to them.

Say you want to distribute your dashboard to a broad audience. You and your coworkers have created an app
workspace, then created and refined dashboards, reports, and datasets in the app workspace. Now you select the
dashbards and reports you want and publish them as an app — either to members of a security group or
distribution list, or to your whole organization.

Apps are easy to find and install in the Power BI service (https://powerbi.com). You can send your business users
a direct link to the app, or they can search for it in AppSource. If your Power BI administrator give you
permissions, you can install an app automatically in your coworkers' Power BI accounts. Read more about
publishing your apps.

After they install an app, they can view it in their browser or mobile device.

For your users to view your app, either they need to have a Power BI Pro license, too, or the app needs to be
stored in a Power BI Premium capacity. Read What is Power BI Premium? for details.

Let's say you've finalized a dashboard and a report in your own My Workspace or in an app workspace and you
want some other people to have access to it. One way to get it to them is to share it.

https://powerbi.com


Annotate and share from the Power BI mobile apps

You need a Power BI Pro license to share your content, and those you share it with do too, or the content needs to
be in a Premium capacity. When you share a dashboard or report, they can view it and interact with it, but can't
edit it. They see the same data that you see in the dashboard and reports unless row-level security (RLS) is
applied to the underlying dataset. The coworkers you share it with can share with their coworkers, if you allow
them to.

You can share with people outside your organization, too. They can view and interact with the dashboard too, but
can't share it.

More about sharing dashboards and reports from the Power BI service. You can also add a filter to a link and
share a filtered view of your report.

In the Power BI mobile apps for iOS and Android devices, you can annotate a tile, report, or visual and then share
it with anyone via email.

You're sharing a snapshot of the tile, report, or visual, and your recipients see it exactly as it was when you sent
the mail. The mail also contains a link to the dashboard or report. If they have a Power BI Pro license, or the
content is in a Premium capacity, and you've shared the object with them already, they can open it. You can send
snapshots of tiles to anyone — not just coworkers in the same email domain.

More about annotating and sharing tiles, reports, and visuals from the iOS and Android mobile apps.



Publish to the web

Print or save as PDF or other static file

Next steps

You can also share a snapshot of a tile from the Power BI app for Windows 10 devices.

You can publish Power BI reports to the whole Internet by embedding interactive visualizations in blog posts,
websites, social media, and other online communications on any device. Anyone on the Internet can view your
reports, and you have no control over who can see what you've published. They don't need a Power BI license.
Publishing to the web is available only for reports that you can edit. You can't publish reports to the web if they're
shared with you or if they're in an app. More about publishing to the web.

You can print or save as PDF (or other static file format) an entire dashboard, dashboard tile, report page, or
visualization from the Power BI service. Reports can only be printed one page at a time -- you can't print the
entire report at once. More about printing or saving as a static file.

Have feedback? Go to the Power BI Community site with your suggestions.
Share dashboards with coworkers and others
Create and publish an app in Power BI
More questions? Try the Power BI Community.

https://docs.microsoft.com/en-us/power-bi/mobile-share-tile-windows-10-phone-app
https://community.powerbi.com/
http://community.powerbi.com/


Install and use apps with dashboards and reports
in Power BI
1/25/2018 • 2 min to read • Edit Online

Get a new app

Install an app from a direct linkInstall an app from a direct link

In Power BI, apps bring related dashboards and reports together, all in one place. People in your organization
can create and distribute apps with key business information. External services you may already use, such as
Google Analytics and Microsoft Dynamics CRM, also offer Power BI apps.

Apps are easy to find and install in the Power BI service (https://powerbi.com) and on your mobile device.
After you install an app, you don't have to remember the names of a lot of different dashboards because
they're all together in the app, in your browser or on your mobile device.

With apps, whenever the app author releases updates, you automatically see the changes. The author also
controls how often the data is scheduled to refresh, so you don't need to worry about keeping it up to date.

Planning to author an app? See Create and publish apps in Power BI for more information.

You can get apps in a few different ways. The app author can install the app automatically in your Power BI
account, or send you a direct link to an app, or you can search for it in AppSource, where you see all the apps
that you can access. In Power BI on your mobile device, you can only install it from a direct link, and not from
AppSource. If the app author installs the app automatically, you'll see it in your list of apps.

The easiest way to install a new app yourself is to get a direct link from the app author. Power BI creates an
installation link, which the author can send to you.

On your computer

When you click the link in email the Power BI service (https://powerbi.com) opens in a browser. You confirm
you want to install the app and it opens to the app landing page.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-install-use-apps.md
https://powerbi.com
https://powerbi.com


Get the app from Microsoft AppSourceGet the app from Microsoft AppSource

On your iOS or Android mobile device

When you click the link in email on your mobile device, the app installs automatically and opens the app
content list.

You can also find and install any apps that you have access to from Microsoft AppSource.

1. Select Apps  > Get apps.

2. In AppSource under My organization, you can search to narrow the results and find the app you're



Interact with the dashboards and reports in the app

Next steps

3. Select Get it now to add it to your Apps page.

looking for.

Now you can explore the data in the dashboards and reports in the app. You have access to all the standard
Power BI interactions such as filtering, highlighting, sorting, and drilling down. Read about interacting with
reports in Power BI.

You can't save changes you make, but you can always export the data to Excel from a table or other visual in a
report.

Create and publish apps in Power BI
Power BI apps for external services
Questions? Try asking the Power BI Community

http://community.powerbi.com/


Create and publish apps with dashboards and
reports in Power BI
1/25/2018 • 10 min to read • Edit Online

Licenses for appsLicenses for apps

Apps and organizational content packsApps and organizational content packs

Video: Apps and app workspaces

In Power BI, you can create apps to bring related dashboards and reports together, all in one place, and then
publish them to large groups of people in your organization. You can also connect to Power BI apps for
external services such as Google Analytics and Microsoft Dynamics CRM.

Your business users often need multiple Power BI dashboards and reports to run their business. Apps bring
the pieces together so they don't have to remember the names and locations of all these dashboards.

With Power BI apps, now in preview, you can create collections of dashboards and reports and publish these
apps to your whole organization or to specific people or groups. For you as a report creator or admin, apps
make it easier to manage permissions on collections of dashboards.

Business users get your apps in a few different ways. If the Power BI administrator gives you permission, you
can install them automatically in your coworkers' Power BI accounts. Otherwise, they can install your apps
from Microsoft AppSource, or you can send them a direct link. They can easily find and return to your content
because it’s all in one place. They get updates automatically and you can control how frequently the data
refreshes. Read more about the app experience for business users.

As an app creator you need a Power BI Pro license. For your app users, there are two options.

Option 1: All business users need Power BI Pro licenses to view your app.
Option 2: Free users in your organization can view app content if your app resides in a Power BI Premium
capacity. Read What is Power BI Premium? for details.

Apps are the evolution of organizational content packs. If you have organizational content packs already,
they'll continue to work side by side with apps.

Now that you have an overview of apps, let’s talk about app workspaces, where you create apps.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-create-distribute-apps.md


  App workspaces

Create an app workspace

App workspaces are the places where you create apps, so you need to create an app workspace first, before
you create the app. If you’ve ever worked in a group workspace in Power BI, then app workspaces will be
familiar. They’re the evolution of group workspaces – staging areas and containers for the content in the app.

You can add colleagues to these workspaces as members or admins. All app workspace members and admins
need Power BI Pro licenses. In the workspace you can all collaborate on dashboards, reports, and other articles
that you plan to publish to a wider audience, or even to your entire organization.

When the content is ready, you choose which dashboards and reports you want to publish, and then you
publish the app. You can send a direct link to that wider audience, or they can find your app from the Apps tab
by going to Download and explore more apps from AppSource. Those people can’t modify the contents
of the app, but they can interact with it either in the Power BI service, or one of the mobile apps -– filtering,
highlighting, and sorting the data themselves.

1. Start by creating the workspace. Select Workspaces > Create app workspace.

This will be the place to put content that you and your colleagues collaborate on.



2. Give the workspace a name. If the corresponding Workspace ID isn't available, edit it to come up with
a unique ID.

This will be the name of the app, too.

3. You have a few options to set. If you choose Public, anyone in your organization can see what’s in the
workspace. Private, on the other hand, means only members of the workspace can see its contents.

You can't change the Public/Private setting after you've created the group.

4. You can also choose if members can edit or have view-only access.

Only add people to the app workspace so they can edit the content. If they're only going to view the
content, don't add them to the workspace. You can include them when you publish the app.

5. Add email addresses of people you want to have access to the workspace, and select Add. You can’t add
group aliases, just individuals.

6. Decide whether each person is a member or an admin.

Admins can edit the workspace itself, including adding other members. Members can edit the content in
the workspace, unless they have view-only access. Both admins and members can publish the app.

7. Select Save.

Power BI creates the workspace and opens it. It appears in the list of workspaces you’re a member of. Because
you’re an admin, you can select the ellipsis (…) to go back and make changes to it, adding new members or



 Add an image to your app (optional)

changing their permissions.

It’s empty, so now you add content to it. Note that when you first create it, you may need to wait an hour or so
for the workspace to propagate to Office 365.

Adding content is just like adding content to your My Workspace, except the other people in the workspace
can see and work on it, too. A big difference is that when you get done, you can publish the content as an app.
While in the app workspace, you can upload or connect to files, or connect to third-party services, just as you
would in your own My Workspace. For example:

Connect to services such as Microsoft Dynamics CRM, Salesforce, or Google Analytics.
Get data from files such as Excel, CSV, or Power BI Desktop (PBIX) files.

By default, Power BI creates a little colored circle for your app, with the app's initials. But maybe you want to
customize it with an image. To add an image, you need an Exchange Online license.

1. Select Workspaces, select the ellipsis (...) next to the name of the workspace, then Members.

The Office 365 Outlook account for the workspace opens in a new browser window.

2. When you hover over the colored circle in the upper left, it turns into a pencil icon. Select it.

3. Select the pencil icon again, and find the image you want to use.



4. Select Save.

The image replaces the colored circle in the Office 365 Outlook window.

In a few minutes, it will appear in the app in Power BI, too.



  Publish your app
When the dashboards and reports in your app workspace are ready, you publish them as an app. Remember
that you don't have to publish all the reports and dashboards in the workspace. You can just publish the ones
that are ready.

1. In the workspace list view, decide which dashboards and reports you want to include in the app.

If you choose not to publish a report, you see a warning next to the report and its related dashboard.
You can still publish the app, but the related dashboard will be missing the tiles from that report.

2. Select the Publish app button in the upper right to start the process of sharing all the content in that
workspace.

3. On Details, fill in the description to help people find the app. You can set a background color to
personalize it.



4. On Content, you see the content that’s going to be published as part of the app – everything that
you've selected in that workspace. You can also set the app landing page – the dashboard or report
people will see first when they go to your app. You can choose None. Then they’ll land on a list of all
the content in the app.

5. On Access, decide who has access to the app: either everyone in your organization, specific people,
Active Directory security groups. If you have permissions, you can decide to install the app
automatically for the recipients.

6. When you select Finish, you see a message confirming it’s ready to publish. In the success dialog box,
you can copy the URL that’s a direct link to this app and send it to the people you’ve shared it with.



Change your published app

The business users that you've published the app to can find it in a few different ways. If you can install it
automatically, it appears under Apps in their Power BI account. You can send them the direct link to the app, or
they can search for it in Microsoft AppSource, where they see all the apps that they can access. No matter how
they get it, after that whenever they go to Apps, they’ll see this app in their list.

Read more about the app experience for business users.

After you publish your app, you may want to change or update it. It’s easy to update it if you’re an admin or
member of the app workspace.

1. Open the app workspace that corresponds to the app.

2. Open the dashboard or the report. You see that you can make any changes you want.

The app workspace is your staging area, so your changes aren't pushed live to the app until you publish
again. This lets you make changes without affecting the published apps.

3. Go back to the app workspace list of contents and select Update app.



Unpublish an app

Power BI apps FAQ

4. Update Details, Content, and Access, if you need to, then select Update app.

The people you’ve published the app to automatically see the updated version of the app.

Any member of an app workspace can unpublish the app.

In an app workspace, select the ellipsis (...) in the upper-right corner > Unpublish app.

This action uninstalls the app for everyone you've published it to, and they no longer have access to it. It
doesn't delete the app workspace or its contents.



How are app workspaces different from group workspaces?How are app workspaces different from group workspaces?

How are apps different from organizational content packs?How are apps different from organizational content packs?

What about read-only members in groups?What about read-only members in groups?

Next steps

With this release, we have renamed all group workspaces to app workspaces. You can publish an app from any
of these workspaces. The functionality remains on par with group workspaces for the most part. Over the next
few months, we plan on the following enhancements to app workspaces:

Creating app workspaces won't create corresponding entities in Office 365 like group workspaces do. So
you can create any number of app workspaces without worrying about different Office 365 groups being
created behind the scenes (you can still use an Office 365 group’s OneDrive for Business to store your
files).
Today you can add only individuals to the members and admin lists. Soon you'll be able to add multiple AD
security groups or modern groups to these lists to allow for easier management.

Apps are an evolution and simplification of content packs, with a few major differences.

After business users install a content pack, it loses its grouped identity: it's just a list of dashboards and
reports interspersed with other dashboards and reports. Apps, on the other hand, maintain their grouping
and identity even after installation. This makes it easy for business users to continue to navigate to them
over time.
You can create multiple content packs from any workspace, but an app has a 1:1 relationship with its
workspace. We believe this makes apps easier to understand and maintain over the long run. See the
roadmap section of the Power BI blog for more on how we plan to improve this area.
Over time we plan to deprecate organizational content packs, so we recommend you create apps from now
on.

In groups, you could add read-only members who could only view the content. The main problem with this
approach was that you couldn't add security groups as members.

With apps, you can publish a read-only version of your app workspace to large audiences, including security
groups. You can stage your changes to the dashboards and reports in the app without affecting end users. We
recommend using apps this way in the future. Over the long run, we plan to deprecate read-only members of
workspaces as well.

Install and use apps in Power BI
Power BI apps for external services
Questions? Try asking the Power BI Community

http://community.powerbi.com/


Intro to organizational content packs in Power BI
11/9/2017 • 4 min to read • Edit Online

NOTENOTE

NOTENOTE

What is AppSource?

Have you heard about the new apps yet? Apps are the new way to distribute content to large audiences in Power BI. We
recommend using apps instead of organizational content packs or read-only workspaces. Learn more about apps.

Do you regularly distribute reports by email to your team? Try this instead: Package up your dashboards, reports,
Excel workbooks, and datasets and publish them to your team as an organizational content pack. Content packs
you create are easy for your team to find — they are all in AppSource. Because they're part of Power BI, they
leverage all the features of Power BI, including interactive data exploration, new visuals, Q&A, integration with
other data sources, data refresh, and more.

Creating content packs is different from sharing dashboards or collaborating on them in an app workspace. Read
How should I collaborate on and share dashboards and reports? to decide on the best option for your situation.

In AppSource, you can browse or search for content packs published to the entire organization, to distribution or
security groups, and to Office 365 groups you belong to. If you aren't a member of a specific group, you won't
see content packs shared with that group. All members of the group have the same read-only access to the
content pack data, reports, workbooks, and dashboards (unless it's a SQL Server Analysis Services (SSAS) data
source, in which case your privileges are inherited with the data source).

The dashboards, reports, and Excel workbooks are read-only, but you can copy and use the dashboards and
reports as a starting point for creating your own personalized version of the content pack.

Organizational content packs are only available when you and your colleagues have Power BI Pro.

Publishing an organizational content pack adds it to AppSource. This centralized repository makes it easy for
members to browse and discover dashboards, reports, and datasets published for them.

To view AppSource, select Get Data > My Organization > Get.

Read more about finding and opening organizational content packs.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-organizational-content-pack-introduction.md
https://support.office.com/article/Create-a-group-in-Office-365-7124dc4c-1de9-40d4-b096-e8add19209e9


The life cycle of an organizational content pack

Data security

Any Power BI Pro user can create, publish, and access organizational content packs. Only the content pack
creator can modify the workbook and dataset, schedule refresh, and delete it.

The lifecycle looks something like this:

NOTENOTE

2. Nate sends mail to the distribution group, telling them about the new content pack.
3. In Power BI Pro, Jane, a member of the Marketing distribution group, searches for and connects to this

content pack in AppSource. She now has a read-only copy. She knows it's read-only because in the left
Navigation Pane, there is a sharing icon to the left of the dashboard name and report name. And when she
selects the dashboard, a lock icon lets Jane know she is looking at a content pack dashboard.

4. Say she decides to customize it. She now has her own copy of the dashboard and reports. Her work does not
affect the source, the original content pack, or other distribution group members. She is now working on her
own copy of the dashboard and report.

1. In Power BI Pro, Nate creates a content pack and publishes it to the Marketing distribution group. The
refresh settings are inherited with the dataset and can only be changed by Nate.

If Nate creates the content pack from within a Power BI app workspace he belongs to, then even if he leaves the
workspace, others in the Power BI workspace can take over ownership.

5. Nate makes updates to the dashboard and when it's ready, he publishes a new version of the content
pack.

Julio, another distribution group member, didn't customize the original content pack. The new changes
are automatically applied to his version of the content pack.
Jane did customize the content pack. She receives a notification that there's a new version. She can go
to AppSource and get the updated content pack without losing her personalized version. She'll now
have two versions: her personalized version and the updated content pack.

6. Say Nate changes the security settings. Julio and Jane no longer have access to the content. Or say they're
removed from the Marketing distribution group.

Julio didn't customize the original content pack, so the content is automatically removed.
Jane did customize the content pack. The next time she opens the dashboard all tiles from the original
content pack are gone, but tiles she pinned from other reports (that she still has permission to use) still
appear. The associated reports and dataset are no longer available (and don't appear in her left
navigation pane).

7. Or Nate deletes the content pack.

Julio didn't customize the original content pack, so the content is automatically removed.
Jane did customize the content pack. The next time she opens the dashboard all tiles from the original
content pack are gone, but tiles she pinned from other reports still appear. The associated reports and
dataset are no longer available (and don't appear in her left navigation pane).

All distribution group members have the same permissions to the data as the content pack creator. The one
exception to this is SQL Server Analysis Services (SSAS) on-premises tabular datasets. Because the reports and
dashboards are connecting live to the on-premises SSAS model, the credentials of each individual distribution
group member are used to determine the data he or she can access.



Next steps
Create and publish an organizational content pack
Create and distribute an app in Power BI
Power BI - Basic Concepts
More questions? Try the Power BI Community

http://community.powerbi.com/


Create and publish a Power BI organizational content
pack (tutorial)
11/15/2017 • 3 min to read • Edit Online

NOTENOTE

NOTENOTE

Have you heard about the new apps yet? Apps are the new way to distribute content to large audiences in Power BI. We
recommend using apps instead of organizational content packs or read-only workspaces. Learn more about apps.

In this tutorial you create an organizational content pack, give access to a specific group, and publish it to your
organization's content pack library on Power BI.

Creating content packs is different from sharing dashboards or collaborating on them in a group. Read How
should I collaborate on and share dashboards and reports? to decide on the best option for your situation.

Creating an organizational content pack requires a Power BI Pro account for you and your colleagues.

Imagine you're the Release Manager at Contoso and you're getting ready for a new product launch. You've created
a dashboard with reports that you'd like to share with the other employees managing the launch. You want a way
to package up the dashboard and reports as a solution for your colleagues to use.

Want to follow along? In the Power BI service, go to Get Data > Samples > Opportunity Analysis Sample >
Connect to get your own copy.

1. In the left navigation pane, select the Opportunity Analysis Sample dashboard.
2. From the top navigation bar, select the cog icon  > Create content pack.

3. In the Create Content Pack window, enter the following information.

Keep in mind that your organization's content pack library could end up with hundreds of content packs
published for the organization or for groups. Take time to give your content pack a meaningful name, to add
a good description, and to select the right audience. Use words that will make your content pack easy to find
via search.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-organizational-content-pack-create-and-publish.md
https://powerbi.microsoft.com/pricing
https://powerbi.com


TIPTIP

NOTENOTE

a. Select Specific Groups and enter the full email addresses for individuals, Office 365 groups,
distribution groups, or security groups. For example:

salesmgrs@contoso.com; sales@contoso.com

For this tutorial, try using your own or your group's email address.

b. Name the content pack Sales Opportunities.

Consider including the name of the dashboard in the name of the content pack. That way, your colleagues
will find the dashboard more easily after they connect to your content pack.

c. Recommended: Add a description. This helps coworkers more easily find the content packs that they
need. Besides a description, add keywords your coworkers might use to search for this content pack.
Include contact information in case your coworkers have a question or need help.

d. Upload an image or logo to make it easier for group members to find the content pack — it's
faster to scan for an image than it is to find text. We used an image of the Opportunity Count 100%
column chart tile in the screen shot below.

e. Select the Opportunity Analysis Sample dashboard to add it to the content pack. Power BI
automatically adds the associated report and dataset. You can add others, if you want.

Only the dashboards, reports, datasets, and workbooks that you can edit are listed. Thus, any that were
shared with you aren't in the list.

https://support.office.com/article/Create-a-group-in-Office-365-7124dc4c-1de9-40d4-b096-e8add19209e9


Next stepsNext steps

TIPTIP

7. They select Connect, and now they can view and work with your content pack.

NOTENOTE

f. If you have Excel workbooks, you see them under Reports, with an Excel icon. You can add them to
the content pack, too.

If members of the group can't view the Excel workbook, you may need to share the workbook with them in
OneDrive for Business.

4. Select Publish to add the content pack to the group's organizational content pack library.

You see a success message when it publishes successfully.

5. When members of your group go to Get Data > My Organization, they tap in the search box and type
"Sales Opportunities".

6. They see your content pack.

The URL displayed in your browser is an unique address for this content pack. Want to tell your coworkers about this
new content pack? Paste the URL into an email.

Intro to organizational content packs
Manage, update, and delete organizational content packs
Create a group in Power BI
What is OneDrive for Business?

https://support.office.com/en-us/article/Share-documents-or-folders-in-Office-365-1fe37332-0f9a-4719-970e-d2578da4941c
https://support.office.com/en-us/article/What-is-OneDrive-for-Business-187f90af-056f-47c0-9656-cc0ddca7fdc2


More questions? Try the Power BI Community

http://community.powerbi.com/


Share your Power BI dashboards and reports with
coworkers and others
1/24/2018 • 7 min to read • Edit Online

Video: Share a dashboard

Sharing is a good way to give a few people access to your dashboards and reports. Power BI also offers several
other ways to collaborate and distribute dashboards and reports.

With sharing, whether you share content inside or outside your organization, you need a Power BI Pro license.
Your recipients also need Power BI Pro licenses, or the content needs to be in a Premium capacity.

You can share dashboards and reports from most places in the Power BI service: your Favorites, Recent, Shared
with me (if the owner allows it), My Workspace, or other workspaces. When you share a dashboard or report,
those you share it with can view it and interact with it, but can't edit it. They see the same data that you see in
the dashboard or report, unless row-level security (RLS) is applied. The coworkers you share with can also
share with their coworkers, if you allow them to. The people outside your organization can view and interact
with the dashboard or report too, but can't share it.

You can also share a dashboard from any of the Power BI mobile apps. You can share dashboards from the
Power BI service and the Power BI mobile apps, but not from Power BI Desktop.

Watch Amanda share her dashboard with colleagues inside and outside her company. Then follow the step-by-
step instructions below the video to try it out yourself.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-share-dashboards.md


Share a dashboard or report
1. In a list of dashboards or reports, or in an open dashboard or report, select Share .

2. In the top box, enter the full email addresses for individuals, distribution groups, or security groups. You
can't share with dynamic distribution lists.

You can share with people whose addresses are outside your organization, but you'll see a warning.

3. Add a message if you want. It's optional.

4. To let your coworkers share your content with others, check Allow recipients to share your
dashboard/report.

Allowing others to share is called resharing. If you let them, they can reshare from the Power BI service
and the mobile apps, or forward the email invitation to others in your organization. The invitation
expires after one month. People outside your organization can't reshare. As the owner of the content,
you can turn off resharing, or revoke resharing on an individual basis. See Stop sharing or stop others
from sharing, below.

5. Select Share.



Who has access to a dashboard or report you shared?

Power BI sends an email invitation to the individuals but not to groups, with a link to the shared content.
You see a Success notification.

When recipients in your organization click the link, Power BI adds the dashboard or report to their
Shared with me list page. They can select your name to see all the content you've shared with them.

When recipients outside your organization click the link, they see the dashboard or report, but not in the
usual Power BI portal. See Share with people outside your organization below for details.

Sometimes you need to see the people you've shared with, and see who they've shared it with.

1. In the list of dashboards and report, or in the dashboard or report itself, select Share .
2. In the Share dashboard/report dialog box, select Access.



 Stop sharing or stop others from sharing

If you haven't sent the sharing invitation yetIf you haven't sent the sharing invitation yet

If you've already shared the dashboard or reportIf you've already shared the dashboard or report

People outside your organization are listed as Guest.

Only the dashboard or report owner can turn resharing on and off.

Clear the Allow recipients to share your dashboard/report check box at the bottom of the invitation
before you send it.

1. In the list of dashboards and reports, or in the dashboard or report itself, select Share .
2. In the Share dashboard/report dialog box, select Access.

3. Select the ellipsis (...) next to Read and reshare and select:



Share a dashboard or report with people outside your organization

Limitations and considerations

Read to keep that person from sharing with anyone else.
Remove access to keep that person from seeing the shared content at all.

4. In the Remove access dialog box, decide if you want to remove access to related content, too, such as

reports and datasets. If you remove items with a warning icon , it's best to remove related content
because it won't display properly.

When you share with people outside your organization, they get an email with a link to the shared dashboard
or report, and they have to sign in to Power BI to see it. If they don't have a Power BI Pro license, they can sign
up for a license after clicking the link.

After they sign in, they see the shared dashboard or report in its own browser window without the left
navigation pane, not in their usual Power BI portal. They have to bookmark the link to access this dashboard or
rreport in the future.

They can't edit any content in this dashboard or report. They can interact with the charts and change filters or
slicers in the report, but can't save their changes.

Only your direct recipients can see the shared dashboard or report. For example, if you sent the email to
Vicki@contoso.com, only Vicki can see the dashboard. No-one else can see that dashboard, even if they have
the link, and Vicki has to use the same email address to access that dashboard. If she signs up with any other
email address, she won't have access to the dashboard either.

People outside your organization can't see any data at all if role- or row-level security is implemented on on-
premises Analysis Services tabular models.

If you send a link from a Power BI mobile app to people outside your organization, when they click the link the
dashboard opens in a browser, not in the Power BI mobile app.

Things to keep in mind about sharing dashboards and reports:

In general, you and your colleagues see the same data in the dashboard or report. Thus, if you have
permissions to see more data than they do, they'll be able to see all your data in the dashboard or report.
However, if row-level security (RLS) is applied to the dataset underlying a dashboard or report, then the
credentials of every person are used to determine which data they can access.
Everyone you share your dashboard with can see it and interact with the related reports in Reading View.
They can't create reports or save changes to existing reports.
No one can see or download the dataset.
Everyone can manually refresh the data.
If you use Office 365 for email, you can share with members of a distribution group by entering the email
address associated with the distribution group.



Troubleshoot sharing
My dashboard recipients see a lock icon in a tile or a "Permission required" messageMy dashboard recipients see a lock icon in a tile or a "Permission required" message

Coworkers who have the same email domain as you, and coworkers whose domain is different but
registered within the same tenant, can share the dashboard with others. For example, say the domains
contoso.com and contoso2.com are registered in the same tenant. If your email address is
konrads@contoso.com, then both ravali@contoso.com and gustav@contoso2.com can share, as long as
you gave them permission to share.
If your coworkers already have access to a specific dashboard or report, you can send a direct link just by
copying the URL when you're on the dashboard or report. For example: 
https://powerbi.com/dashboards/g12466b5-a452-4e55-8634-xxxxxxxxxxxx

Likewise if your coworkers already have access to a specific dashboard, you can send a direct link to the
underlying report.

The people you share with may see a locked tile in a dashboard, or a "Permission required" message when
they try to view a report.

If so, you need to grant them permission to the underlying dataset. Here's how.

1. Go to the Datasets tab in your content list.

2. Select the ellipsis (...) next to the dataset > Manage permissions.



3. Select Add user.

4. Enter the full email addresses for individuals, distribution groups, or security groups. You can't share
with dynamic distribution lists.



I can't share a dashboard or reportI can't share a dashboard or report

Next steps

5. Select Add.

To share a dashboard or report, you need permission to reshare the underlying content -- any related reports
and datasets. If you see a message saying you can't share, ask the report author to give you re-share
permission for those reports and datasets.

Have feedback? Go to the Power BI Community site with your suggestions.
How should I collaborate on and share dashboards and reports?
Share a filtered Power BI report
Questions? Try the Power BI Community.

https://community.powerbi.com/
http://community.powerbi.com/


Share a filtered Power BI report with your coworkers
1/24/2018 • 1 min to read • Edit Online

Filter and share a report

Sharing is a good way to give a few people access to your dashboards and reports. Power BI also offers several
other ways to collaborate and distribute your reports.

With sharing, you and your recipients need a Power BI Pro license, or the content needs to be in a Premium
capacity. Suggestions? The Power BI team is always interested in your feedback, so go to the Power BI Community
site.

You can share a report with coworkers in the same email domain as you, from most places in the Power BI service:
your Favorites, Recent, Shared with me (if the owner allows it), My Workspace, or other workspaces. When you
share a report, those you share it with can view it and interact with it, but can't edit it. They see the same data that
you see in the report, unless row-level security (RLS) is applied.

What if you want to share a filtered version of a report? Maybe a report that only shows data for a specific city or
salesperson or year. You do this by creating a custom URL.

1. Open the report in Editing view, apply the filter, and save the report.

In this example we're filtering the Retail Analysis sample to show only values where Territory equals NC.

2. Add the following to the end of the report page URL:

?filter=tablename/fieldname eq value

The field must be of type string and neither tablename or fieldname can contain spaces.

In our example, the name of the table is Store, the name of the field is Territory, and the value we want to
filter on is NC:

?filter=Store/Territory eq 'NC'

Your browser adds special characters to represent slashes, spaces, and apostrophes, so you end up with:

app.powerbi.com/groups/me/reports/010ae9ad-a9ab-4904-a7a1-xxxxxxxxxxxx/ReportSection2?

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-share-reports.md
https://community.powerbi.com/


Next steps

filter=Store%252FTerritory%20eq%20%27NC%27

3. Share the report, but clear the Send email notificaton to recipients check box.

4. Send the link with the filter that you created earlier.

Have feedback? Go to the Power BI Community site with your suggestions.
How should I collaborate on and share dashboards and reports?
Share a dashboard
More questions? Try the Power BI Community.

https://community.powerbi.com/
http://community.powerbi.com/


Publish to web from Power BI
1/30/2018 • 9 min to read • Edit Online

WARNINGWARNING

How to use Publish to Web

With Power BI Publish to web, you can easily embed interactive Power BI visualizations online, such as in blog
posts, websites, through emails or social media, on any device.

You can also easily edit, update, refresh or un-share your published visuals.

When you use Publish to web, the report or visual you publish can be viewed by anyone on the Internet. There is no
authentication used when viewing these reports. Only use Publish to web with reports and data that the anyone on the
Internet (unauthenticated members of the public) should be able to see. This includes detail level data that is aggregated in
your reports. Before publishing this report, ensure you have the right to share the data and visualizations publicly. Do not
publish confidential or proprietary information. If in doubt, check your organization's policies before publishing.

Publish to web is available on reports in your personal or group workspaces that you can edit. You cannot use
Publish to web with reports that were shared with you, or reports that rely on row level security to secure the data.
See the Limitations section below for a complete list of cases where Publish to web is not supported. Please
review the Warning earlier in this article before using Publish to web.

You can watch how this feature works in the following short video. Then, follow the steps below to try it yourself.

The following steps describe how to use Publish to web.

1. On a report in your workspace that you can edit, select File > Publish to web.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-publish-to-web.md


2. Review the content on the dialog, and select Create embed code as shown in the following dialog.

3. Review the warning, shown in the following dialog, and confirm that the data is okay to embed in a public
website. If so, select Publish.

4. A dialog appears that provides a link that can be sent in email, embedded in code (such as an iFrame), or
that you can paste directly into your web page or blog.



Tips and Tricks for View modes

VIEW MODE HOW IT LOOKS WHEN EMBEDDED

Fit to page will respect the page height and width of your
report. If you set your page to 'Dynamic' ratios like 16:9 or
4:3 your content will scale to fit within the iFrame you
provided. When embedded in an iFrame, using Fit to page
can result in letterboxing, where a gray background is
shown in areas of the iFrame after the content as scaled to fit
within the iFrame. To minimize letterboxing, set your iFrame
height/width appropriately.

5. If you’ve previously created an embed code for the report, the embed code quickly appears. You can only
create one embed code for each report.

When you embed content within a blog post, you typically need to fit it within a specific size of the screen. You can
also adjust the height and the width in the iFrame tag as needed, but you may also need to ensure your report fits
within the given area of the iFrame, so you also need to set an appropriate View Mode when editing the report.

The following table provides guidance about the View Mode, and how it will appear when embedded.



Actual size will ensure the report preserves its size as set on
the report page. This can result in scrollbars being present in
your iFrame. Set the iFrame height and width to avoid the
scrollbars.

Fit to width ensures the content fits within the horizontal
area for your iFrame. A border will still be shown, but the
content will scale to use all the horizontal space available.

VIEW MODE HOW IT LOOKS WHEN EMBEDDED

Tips and tricks for iFrame height and width

RATIO SIZE DIMENSION (WIDTH X HEIGHT)

16:9 Small 640 x 416 px

16:9 Medium 800 x 506 px

16:9 Large 960 x 596 px

4:3 Small 640 x 536 px

4:3 Medium 800 x 656 px

4:3 Large 960 x 776 px

Managing embed codes

The embed code you receive after you Publish to web will look like the following:

You can edit the width and height manually to ensure it is precisely how you want it to fit onto the page into
which you're embedding it.

To achieve a more perfect fit, you can try adding 56 pixels to the height dimension of the iFrame. This
accomodates the current size of the bottom bar. If your report page uses the Dynamic size, the table below
provides some sizes you can use to achieve a fit without letterboxing.

Once you create a Publish to web embed code, you can manage the codes you create from the Settings menu
of the Power BI service. Managing embed codes includes the ability to remove the destination visual or report for
a code (rendering the embed code unusable), or getting the embed code again.



1. To manage your Publish to web embed codes, open the Settings gear and select Manage embed
codes.

2. The list of embed codes you’ve created appears, as shown in the following image.

3. For each Publish to web embed code in the list, you can either retrieve the embed code, or delete the
embed code and thus make any links to that report or visual no longer work.

4. If you select Delete, you’re asked if you’re sure you want to delete the embed code.



Updates to reports, and data refresh

Data refresh

Custom visuals

Limitations

Tenant setting

After you create your Publish to web embed code and share it, the report is updated with any changes you make.
However, it’s important to know that it can take a while for update to be visible to your users. Updates to a report
or visual take approximately one hour to be reflected in Publish to web embed codes.

When you initially use Publish to web to get an embed code, the embed code link is immediately active and can
be viewed by anyone who opens the link. After the initial Publish to web action, subsequent updates to reports or
visuals to which a Publish to web link points can take approximately one hour to be visible to your users.

To learn more, see the How it works section later in this article. If you need your updates to be immediately
available, you can delete the embed code and create a new one.

Data refreshes are automatically reflected in your embedded report or visual. It can take approximately 1 hour for
refreshed data to be visible from embed codes. You can disable automatic refresh by selecting do not refresh on
the schedule for the dataset used by the report.

Custom visuals are supported in Publish to web. When you use Publish to web, users with whom you share your
published visual do not need to enable custom visuals to view the report.

Publish to web is supported for the vast majority of data sources and reports in the Power BI service, however,
the following are not currently supported or available with Publish to web:

1. Reports using row level security.
2. Reports using Analysis Services Tablular hosted on premises.
3. Reports shared to you directly or through an organizational content pack.
4. Reports in a group in which you are not an edit member.
5. "R" Visuals are not currently supported in Publish to web reports.

Power BI administrators can enable or disable the publish to web feature. They may also restrict access to specific
groups. Your ability to create an embed code changes based on this setting.



FEATURE
ENABLED FOR ENTIRE
ORGANIZATION

DISABLED FOR ENTIRE
ORGANIZATION SPECIFIC SECURITY GROUPS

Publish to web under
report's File menu.

Enabled for all Not visable for all Only visable for authorized
users or groups.

Manage embed codes
under Settings

Enabled for all Enabled for all Enabled for all

* Delete option only for
authorized users or groups.
* Get codes enabled for all.

Embed codes within admin
portal

Status will reflect one of the
following:
* Active
* Not supported
* Blocked

Status will display Disabled Status will reflect one of the
following:
* Active
* Not supported
* Blocked

If a user is not authorized
based on the tenant setting,
status will display as
infringed.

Existing published reports All enabled All disabled Reports continue to render
for all.

Understanding the embed code status column

STATUS DESCRIPTION

Active The report is available for Internet users to view and interact
with.

Blocked The content of the report violates the Power BI Terms of
Service. It has been blocked by Microsoft. Contact support if
you believe the content was blocked in error.

Not supported The report's data set is using row level security, or another
unsupported configuration. See the Limitations section for a
complete list.

Infringed The embed code is outside of the defined tenant policy. This
typically occurs when an embed code was created and then
the publish to web tenant setting was changed to exclude the
user that owns the embed code. If the tenant setting is
disabled, or the user is no longer allowed to create embed
codes, existing embed codes will show the status of
Infringed.

How to report a concern with Publish to web content

When viewing the Manage embed codes page for your Publish to web embed codes, a status column is
provided. Embed codes are active by default, but you may encounter any of the states listed below.

To report a concern related to Publish to web content embedded in a website or blog, use the Flag icon in the
bottom bar, shown in the following image. You’ll be asked to send an email to Microsoft explaining the concern.
Microsoft will evaluate the content based on the Power BI Terms of Service, and take appropriate action.

https://powerbi.microsoft.com/terms-of-service


Licensing and Pricing

How it works (technical details)

To report a concern, select the flag icon in the bottom bar of the Publish to web report you see.

You need to be a Microsoft Power BI user to use Publish to web. The consumers of your report (the readers,
viewers) do not need to be Power BI users.

When you create an embed code using Publish to web, the report is made visible to users on the Internet. It’s
publicly available so you can expect viewers to easily share the report through social media in the future. As users
view the report, either by opening the direct public URL or viewing it embedded in a web page or blog, Power BI
caches the report definition and the results of the queries required to view the report. This approach ensures the
report can be viewed by thousands of concurrent users without any impact on performance.

The cache is long-lived, so if you update the report definition (for example, if you change its View mode) or refresh
the report data, it can take approximately one hour before changes are reflected in the version of the report
viewed by your users. It is therefore recommended that you stage your work ahead of time, and create the
Publish to web embed code only when you’re satisfied with the settings.

More questions? Try the Power BI Community

http://community.powerbi.com/


Embed with report web part in SharePoint Online
1/30/2018 • 4 min to read • Edit Online

Requirements

Embed your report

Get a URL to your reportGet a URL to your report

With Power BI's new report web part for SharePoint Online, you can easily embed interactive Power BI reports in
SharePoint Online pages.

When using the new Embed in SharePoint Online option, the embedded reports are fully secure so you can
easily create secure internal portals.

There are a few requirements in order for Embed in SharePoint Online reports to work.

The Power BI web part for SharePoint Online requires Modern Pages.

In order to embed your report into SharePoint Online, you will first need to get the URL for the report and then use
that URL with the new Power BI web part within SharePoint Online.

1. View the report within the Power BI service.

2. Select the File menu item.

3. Select Embed in SharePoint Online.

4. Copy URL from dialog.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-embed-report-spo.md
https://support.office.com/article/Allow-or-prevent-creation-of-modern-site-pages-by-end-users-c41d9cc8-c5c0-46b4-8b87-ea66abc6e63b


Add the Power BI report to a SharePoint Online pageAdd the Power BI report to a SharePoint Online page

NOTENOTE
You can also use the URL that is displayed in your web browser's address bar when viewing a report. That URL will
contain the report page you are currently viewing. You will need to remove the report section, from the URL, if you
want to use a different page.

1. Open the desired page in SharePoint Online and select Edit.

Or, create a new modern site page by selecting + New within SharePoint Online.

2. Select + and select the Power BI web part.



3. Select Add report.

4. Past the report URL into the property pane. This is the URL you copied from the steps above. The report will
load automatically.

5. Select Publish to make the change visible to your SharePoint Online users.



 Granting access to reports

IMPORTANTIMPORTANT

Allowing Free users access to reports

Web part settings

Embedding a report in SharePoint Online does not automatically give users permission to view the report. The
permissions to view the report are set within the Power BI service.

Make sure to review who can see the report within the Power BI service and grant access to those not listed.

There are two ways to provide access to the report within the Power BI service. If you are using an Office 365 Group
to build your SharePoint Online team site, you list the user as a member of the app workspace within the Power BI
service. This will make sure that users can view the contents of that group. For more information, see Create and
distribute an app in Power BI.

Alternatively, you can grant users access to your report by doing the following.

1. Add a tile from the report to a dashboard.

2. Share the dashboard with the users that need access to the report. For more information, see Share a
dashboard with colleagues and others.

Free users can view reports that are embedded with the Power BI web part for SharePoint Online. You provide
access to free users in the same way you do Pro users as described in Granting access to reports above. The
workspace, where the report is located, also has to be backed by Power BI Premium capacity.

For example, if you have a report, in an app workspace, you would have to assign the app workspace to a Power BI
Premium capacity. You would also need to add the Free user to the list of members of that app workspace.

Below is a description of the settings that can be adjusted for the Power BI web part for SharePoint Online.



PROPERTY DESCRIPTION

Page name Sets the default page that is shown by the web part. Select a
value from the drop down. If no pages are displayed, either
your report has one page, or the URL you pasted contains a
page name. Remove the report section from the URL to select
a specific page.

Display Option to adjust how the report is fit within the SharePoint
Online page.

Show Navigation Pane Shows or hides the page navigation pane.

Show Filter Pane Shows or hides the filter pane.

Multi-factor authentication

NOTENOTE

Reports that do not load

If your Power BI environment requires you to sign-in using multi-factor authentication, you may be asked to sign-in
with a security device to verify your identity. This will occur if you did not sign-in to SharePoint Online using multi-
factor authentication but your Power BI environment requires an account validated by a security device.

Multi-factor authentication is not yet supported with Azure Active Directory 2.0. Users will receive a message saying error. If
the user signs-in again to SharePoint Online using their security device, they may be able to view the report.

Your report may not load within the Power BI web part and may show the following message.

This content isn't available.



Known issues and limitations

Next steps

There are two common reasons for this message.

1. You do not have access to the report.
2. The report was deleted.

You should contact the owner of the SharePoint Online page to help you resolve the issue.

Error: "An error occurred, please try logging out and back in and then revisiting this page.
Correlation id: undefined, http response status: 400, server error code 10001, message: Missing
refresh token"

If you receive this error, please try one of the following.

1. Sign-out of SharePoint and sign back in. Be sure to close all browser windows before signing back in.

2. If your user account requires multi-factor authentication (MFA), ensure you sign-in to SharePoint
using your multi-factor authentication device (phone app, smart card, etc.)

Power BI does not support the same localized languages that SharePoint Online does. As a result, you may
not see proper localization within the embedded report.

You may encounter issues if using Internet Explorer 10. You can look at the browsers support for Power BI
and for Office 365.

Allow or prevent creation of modern site pages by end users
Create and distribute an app in Power BI
Share a dashboard with colleagues and others
Power BI Premium - what is it?

More questions? Try asking the Power BI Community

https://products.office.com/office-system-requirements#Browsers-section
https://support.office.com/article/Allow-or-prevent-creation-of-modern-site-pages-by-end-users-c41d9cc8-c5c0-46b4-8b87-ea66abc6e63b
http://community.powerbi.com/


 

Connect to files stored in OneDrive for your Power BI
app workspace
11/9/2017 • 2 min to read • Edit Online

NOTENOTE

1 Upload files to the OneDrive for Business for your app workspace

After you've created an app workspace in Power BI, you can store your Excel, CSV, and Power BI Desktop files on
the OneDrive for Business for your Power BI app workspace. You can continue updating the files you store in
OneDrive, and those updates are automatically reflected in the Power BI reports and dashboards based on the files.

Adding files to your app workspace is a two-step process:

1. First you upload files to the OneDrive for Business for your app workspace.
2. Then you connect to those files from Power BI.

App workspaces are only available with Power BI Pro.

NOTENOTE

1. In the Power BI service, select the arrow next to Workspaces > select the ellipsis (…) next to your workspace
name.

2. Select Files to open the OneDrive for Business for your app workspace on Office 365.

If you don't see Files on the app workspace menu, select Members to open the OneDrive for Business for your app
workspace. There, select Files. Office 365 sets up a OneDrive storage location for your app's group workspace files.
This process may take some time.

3. Here, you can upload your files to the OneDrive for Business for your app workspace. Select Upload, and
navigate to your files.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-connect-to-files-in-app-workspace-onedrive-for-business.md


 2 Import Excel files as datasets or as Excel Online workbooks

Import or connect to the files in your app workspaceImport or connect to the files in your app workspace

Now that your files are in the OneDrive for Business for your app workspace, you have a choice. You can:

Import the data from the Excel workbook as a dataset, and use the data to build reports and dashboards you can
view in a web browser and on mobile devices.
Or connect to a whole Excel workbook in Power BI and display it exactly as it appears in Excel Online.

1. In Power BI, switch to the app workspace, so the app workspace name is in the top-left corner.
2. Select Get Data at the bottom of the left navigation pane.

3. In the Files box, select Get.

4. Select OneDrive - Your App Workspace Name.

5. Select the file you want > Connect.

This is the point where you decide whether to import the data from the Excel workbook, or connect to the
whole Excel workbooks.

6. Select Import or Connect.



Next steps

7. If you select Import, then the workbook appears on the Datasets tab.

If you select Connect, then the workbook is on the Workbooks tab.

Create apps and app workspaces in Power BI
Import data from Excel workbooks
Connect to whole Excel workbooks
More questions? Try the Power BI Community
Feedback? Visit Power BI Ideas

http://community.powerbi.com/
https://ideas.powerbi.com/forums/265200-power-bi


Collaborate in your Power BI app workspace
1/30/2018 • 2 min to read • Edit Online

Collaborate on Power BI Desktop files in your app workspace

Power BI app workspaces are great places to collaborate with your colleagues on dashboards, reports, and datasets
to create apps. That's what workspaces are designed for -- collaboration. After you finish collaborating on your
dashboards and reports with colleagues, then you package it as an app and distribute it. Read more about creating
apps and app workspaces in Power BI.

Collaboration doesn’t end with workspaces in Power BI. Office 365 offers other group services such as sharing files
on OneDrive for Business, conversations in Exchange, shared calendar and tasks, and so on. Read more about
groups in Office 365.

App workspaces are only available with Power BI Pro.

After you create a Power BI Desktop file, if you publish it to your Power BI app workspace, then everyone in your
workspace can collaborate on it.

1. In Power BI Desktop, select Publish on the Home ribbon, then in the Select a destination box, select your
app workspace.

2. In the Power BI service, select the arrow next to Workspaces > select your app workspace.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-collaborate-power-bi-workspace.md
https://support.office.com/article/Create-a-group-in-Office-365-7124dc4c-1de9-40d4-b096-e8add19209e9


Collaborate in Office 365

3. Select the Reports tab, then select your report.

From here, it's like any other report in Power BI. You and others in your app workspace can modify the
report and save tiles to a dashboard of your choosing.

Collaborating in Office 365 starts from the app workspace in Power BI.

1. In the Power BI service, select the arrow next to Workspaces > select the ellipsis (…) next to your workspace
name.



 Have a group conversation in Office 365

2. From this menu, you can collaborate with your group in a few ways:

Have a group conversation in Office 365.
Schedule an event on the app's group workspace calendar.

The first time you go to your app's group workspace in Office 365, it may take some time. Give it 15 to 30
minutes, then refresh your browser.

1. Select the ellipsis (…) next to your app workspace name > Conversations.

The email and conversation site for your app's group workspace opens in Outlook for Office 365.



Schedule an event on the app's group workspace calendar

2. Read more about group conversations in Outlook for Office 365.

2. Read more about group calendars in Outlook in Office 365.

1. Select the ellipsis (…) next to your app workspace name > Calendar.

This opens the calendar for your app's group workspace in Outlook for Office 365.

https://support.office.com/Article/Have-a-group-conversation-a0482e24-a769-4e39-a5ba-a7c56e828b22
https://support.office.com/Article/Add-edit-and-subscribe-to-group-events-0cf1ad68-1034-4306-b367-d75e9818376a


Manage an app workspace

Next steps

If you’re owner or admin for an app workspace, you can also add or remove workspace members. Read more
about managing your Power BI app workspace.

Create apps and app workspaces in Power BI
More questions? Try the Power BI Community
Feedback? Visit Power BI Ideas

http://community.powerbi.com/
https://ideas.powerbi.com/forums/265200-power-bi


Manage your app workspace in Power BI and Office
365
11/9/2017 • 2 min to read • Edit Online

Edit your app workspace in Power BI

As creator or admin of an app workspace in Power BI or in Office 365, you manage some aspects of the workspace
in Power BI. Other aspects you manage in Office 365.

In Power BI you can:

Add or remove app workspace members, including making a workspace member an admin.
Edit the app workspace name.
Delete the app workspace.

In Office 365 you can:

Add or remove your app workspace's group members, including making a member an admin.
Edit the group name, image, description, and other settings.
See the group email address.
Delete the group.

You need a Power BI Pro license to be an admin or member of an app workspace. Your app users need a Power BI
Pro license, too, unless your app workspace is in a Power BI Premium capacity. Then business users can access
your app with a Power BI free license instead. Read What is Power BI Premium? for details.

NOTENOTE

1. In the Power BI service, select the arrow next to Workspaces > select the ellipsis (…) next to your
workspace name > Edit workspace.

You only see Edit workspace if you’re an app workspace admin.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-manage-app-workspace-in-power-bi-and-office-365.md


Edit Power BI app workspace properties in Office 365

3. Select Save or Cancel.

2. Here you can rename, add or remove members, or delete the app workspace.

1. In the Power BI service, select the arrow next to Workspaces > select the ellipsis (…) next to your
workspace name > Members.

This opens the Outlook for Office 365 group view of your app workspace.

You may need to sign into your corporate account.

2. Tap the ellipsis (…) next to a member's name to make the member an admin or delete the member from the
app workspace.



Add an image and set other workspace properties in the Office 365
group
When you distribute your app from the app workspace, the image you add here will be the image for your app. See
the Add an image to your app section of the article Create and distribute an app in Power BI.

1. In the Outlook for Office 365 view of your app workspace, select the group image to edit group workspace
properties.

2. You can edit the name, description, and language, add an image, and set other properties here.



Next steps

3. Select Save or Discard.

What are apps in Power BI?
Create apps and app workspaces in Power BI
More questions? Try the Power BI Community

http://community.powerbi.com/


Manage, update, and delete organizational content
packs
11/9/2017 • 4 min to read • Edit Online

NOTENOTE

Modify and re-publish an organizational content pack

Republish with new content

Have you heard about the new apps yet? Apps are the new way to distribute content to large audiences in Power BI. We
recommend using apps instead of organizational content packs or read-only workspaces. Learn more about apps.

You can package up and share your dashboards, reports, Excel workbooks, and datasets with your colleagues as
organizational content packs. Your colleagues can use them as-is, or they can create their own copies.

Creating content packs is different from sharing dashboards or collaborating on them in a group. Read How
should I collaborate on and share dashboards and reports? to decide on the best option for your situation.

You can only do some organizational content pack tasks if you're the content pack creator:

Republish.
Restrict or expand access to the content pack.
Set and change scheduled refresh.
Delete the content pack.

If you make changes to the original content pack dashboard, report, or Excel workbook, Power BI prompts you to
republish. Additionally, as the content pack creator, you can update any of the options you selected in the Create
Content Pack window when you were creating the original content pack.

When you make and save a change to the dashboard that you included in a content pack, Power BI reminds you to
update it so others can see the changes. For example, if you pin a new tile or just change the name of the
dashboard.

1. Select View Content Packs in the message.

2. Or select the cog icon in the upper-right corner  and select View Content Pack.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-organizational-content-pack-manage-update-delete.md


Update the audience: expand or restrict access

Refresh an organizational content pack

3. Select Edit.

Notice the warning icon . This lets you know that you've modified the content pack in some way and it
no longer matches what you published.

4. Make any necessary changes in the Update Content Pack window and select Update. A Success message
appears.

For group members who haven't customized the content pack, the update is automatically applied.
Group members who have customized the content pack receive a notification that there is a new version.
They can go to AppSource and get the updated content pack without losing their personalized version.
They'll now have 2 versions: the personalized version and the updated content pack. In the personalized
version, all tiles from the original content pack will be gone. But tiles pinned from other reports will still
render.

Another modification available to content pack creators is expanding and restricting access to the content pack.
Perhaps you published a content pack to a broad audience and you've decided to restrict access to a smaller
group.

1. Select the cog icon  and choose View Content Packs.
2. Select Edit.
3. Make any necessary changes in the Update Content Pack window and select Update. For example, delete

the original distribution group in the Specific Groups field and replace it with a different distribution group
(that has fewer members).

A Success message appears.

For any coworker who isn't part of the new alias:

For group members who haven't customized the content pack, the dashboard and reports associated
with that content pack are no longer available and the content pack doesn't appear in the Navigation
Pane.
For group members who have customized the content pack, the next time they open the customized
dashboard, all tiles from the original content pack will be gone. But tiles pinned from other reports will
still render. The original content pack reports and dataset are no longer available, and the content pack
doesn't appear in the Navigation pane.



Delete an organizational content pack from AppSource

TIPTIP

Next steps

As the content pack creator, you can schedule refresh of the datasets. When you create and upload the content
pack, that refresh schedule is uploaded with the datasets. If you change the refresh schedule, you need to re-
publish the content pack (see above).

You can only delete a content pack from AppSource if you created it.

You can delete your connection to a content pack you didn't create. That doesn't delete the content pack from AppSource.

1. To delete a content pack from AppSource, go to the app workspace where you created the content pack, select
the cog icon  and choose View Content Packs.

2. Select Delete > Delete.

For group members who haven't customized the content pack, the dashboard and reports associated
with that content pack are automatically removed. They're no longer available, and the content pack
doesn't appear in the Navigation Pane.
For group members who have customized the content pack, the next time they open the customized
dashboard, all tiles from the original content pack will be gone. But tiles pinned from other reports will
still render. The original content pack reports and dataset are no longer available, and the content pack
doesn't appear in the Navigation pane.

Introduction to organizational content packs
Create and distribute an app in Power BI
More questions? Try the Power BI Community

http://community.powerbi.com/


Find and connect to an organizational content pack
11/9/2017 • 1 min to read • Edit Online

NOTENOTE

Find an organizational content pack

Connect to an organizational content pack

Changes to the content pack

Next steps

Have you heard about the new apps yet? Apps are the new way to distribute content to large audiences in Power BI. We
recommend using apps instead of organizational content packs or read-only workspaces. Learn more about apps.

When anyone publishes an organizational content pack to your organization, to distribution or security groups, or
to Office 365 groups that you belong to, it appears in AppSource. Browse or search AppSource to find and open
organizational content packs.

Creating content packs is different from sharing dashboards or collaborating on them in a group. Read How should
I collaborate on and share dashboards and reports? to decide on the best option for your situation.

Power BI Pro users can all go to AppSource, which displays content packs shared to their entire organization, to
distribution or security groups, and to Office 365 groups they belong to.

1. From the left Navigation Pane, select Get Data > My Organization > Get.
2. Don't see the content pack you're looking for? Tap in the search box and type keywords:

3. Select a content pack to reveal additional details.

Select Get it now to connect to the the content pack and add it to your active workspace. New dashboards,
reports, Excel workbooks, and datasets are starred with a yellow asterisk.

If the content pack has an Excel workbook, you may see a warning that you don’t have permissions to view the
workbook. If so, ask the content pack owner to share the workbook with you in OneDrive for Business.

The content pack is locked. You can save your own copy of the dashboard and reports.

If the content pack owner changes the content pack, and:

You haven't made a copy The content pack updates automatically.
You have made a copy Your copy won't be updated.

Intro to organizational content packs
Create and distribute an app in Power BI
Questions? Try asking the Power BI Community

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-organizational-content-pack-find-and-open.md
https://support.office.com/article/Create-a-group-in-Office-365-7124dc4c-1de9-40d4-b096-e8add19209e9
https://powerbi.microsoft.com/pricing
https://support.office.com/en-us/article/Share-documents-or-folders-in-Office-365-1fe37332-0f9a-4719-970e-d2578da4941c
http://community.powerbi.com/


Organizational content packs: Copy, refresh, and get
access
11/15/2017 • 1 min to read • Edit Online

NOTENOTE

Create a copy of an organizational content pack

Help! I can no longer access the content pack

Have you heard about the new apps yet? Apps are the new way to distribute content to large audiences in Power BI. You
create apps in app workspaces, which replace groups and group workspaces. We recommend using apps instead of
organizational content packs or read-only workspaces. Learn more about apps.

When an organizational content pack is published, all recipients see the same dashboard, reports, Excel workbooks,
datasets, and data (unless it's a SQL Server Analysis Services (SSAS) data source). Only the content pack creator
can edit and republish the content pack. However, all recipients can save a copy of the content pack that can live
alongside the original.

Creating content packs is different from sharing dashboards or collaborating on them in a group. Read How
should I collaborate on and share dashboards and reports? to decide on the best option for your situation.

Create your own copy of the content pack, not visible to others.

2. Select Save.

1. Select the ellipsis (...) next to the content pack dashboard > Make a copy.

Now you have a copy that you can change. Nobody else will see changes you make.

This can happen for several reasons:

Membership changes: Content packs are published to email distribution groups, security groups, and Power
BI groups based on Office 365. If you are removed from the group, you will no longer have access to the
content pack.
Distribution changes: The content pack creator changes the distribution. For example, if the content pack was
originally published to the entire organization but the creator republished it to a smaller audience, you may no
longer be included.
Security settings changes: If the dashboard and reports connect to on-premises SSAS data sources and
changes are made to the security settings, your permissions to that server may be revoked.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-organizational-content-pack-copy-refresh-access.md
https://support.office.com/article/Create-a-group-in-Office-365-7124dc4c-1de9-40d4-b096-e8add19209e9


How are organizational content packs refreshed?

Next steps

When the content pack is created, the refresh settings are inherited with the dataset. When you create a copy of the
content pack, the new version retains its link to the original dataset and its refresh schedule.

See Manage, update, and delete organizational content packs.

Introduction to organizational content packs
Create a group in Power BI
More questions? Try the Power BI Community

http://community.powerbi.com/


Remove your connection to a Power BI
organizational content pack
11/9/2017 • 1 min to read • Edit Online

Next steps

A coworker created a content pack. You discovered it in AppSource and added it to your Power BI workspace. Now
you don't need it any longer. How do you remove it?

To remove a content pack, you remove its dataset.

In the left navigation pane, select the ellipsis to the right of the dataset and select Remove > Yes.

Removing the dataset also removes all associated reports and dashboards. However, removing your connection to
the content pack doesn't delete the content pack from your organization's AppSource. You can always return to
AppSource and add the content pack back to your workspace. You can only delete a content pack from AppSource
if you're the one who created it.

Introduction to organizational content packs
Create and distribute an app in Power BI
Power BI basic concepts
More questions? Try the Power BI Community

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-organizational-content-pack-disconnect.md
http://community.powerbi.com/


Share a Power BI dashboard that links to an Excel file
in OneDrive
11/15/2017 • 1 min to read • Edit Online

Share a dashboard that contains workbook tiles

NOTENOTE

In Power BI, you can connect to Excel workbooks on OneDrive for Business and pin tiles to a dashboard from that
workbook. When you share that dashboard, or create a content pack that includes that dashboard:

Your colleagues can view the tiles without needing permissions for the workbook itself. So you can create a
content pack and know that your colleagues can see the tiles created from the Excel workbook on OneDrive.
Clicking the tile opens the workbook inside of Power BI. The workbook will only open if your colleagues have at
least read permissions to the workbook on OneDrive for Business.

To share a dashboard that links back to an Excel workbook on OneDrive for Business, see Share a dashboard. The
difference is that you have the option to modify the permissions for the linked Excel workbook before sharing.

1. Enter the email addresses for your colleagues.
2. To enable your colleagues to view the Excel workbook from Power BI, select Go to OneDrive for Business to

set workbook permissions.
3. On OneDrive, modify the permissions as needed.
4. Select Share.

Your colleagues won't be able to pin additional tiles from that workbook, or make changes to the Excel workbook from
Power BI.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-share-dashboard-that-links-to-excel-onedrive.md
https://support.office.com/en-us/article/Share-documents-or-folders-in-Office-365-1fe37332-0f9a-4719-970e-d2578da4941c
https://support.office.com/en-US/article/Share-files-and-folders-and-change-permissions-9fcc2f7d-de0c-4cec-93b0-a82024800c07


Create an organizational content pack with a dashboard that contains
workbook tiles

Share a dashboard from a Power BI workspace

When you publish a content pack you give access to individual colleagues or groups. When you publish a content
pack that contains workbook links, you'll have the option to modify the permissions for the linked Excel workbook
before publishing.

1. In the Create content pack screen, enter email addresses, give the content pack a title and description, and
upload an image.

3. Select Go to OneDrive for Business to set workbook permissions.
4. On OneDrive, modify the permissions as needed.
5. Select Publish.

2. Select the dashboard and/or report that is linked to the Excel workbook on OneDrive for Business.

Sharing a dashboard from a Power BI workspace is similar to sharing a dashboard from your own workspace,
except that the files are located in an Office 365 workspace site, instead of your private OneDrive for Business.
Modify the permissions for the Excel workbook before sharing the dashboard with people outside the workspace.

https://support.office.com/en-US/article/Share-files-and-folders-and-change-permissions-9fcc2f7d-de0c-4cec-93b0-a82024800c07


Next steps
Pin a tile to a Power BI dashboard from Excel
Power BI Basic Concepts
More questions? Try the Power BI Community

http://community.powerbi.com/


Export reports from Power BI to PowerPoint (Preview)
1/25/2018 • 5 min to read • Edit Online

How to export your Power BI report to PowerPoint

With Power BI, you can now publish your report to Microsoft PowerPoint, and easily create a slide deck based on
your Power BI report. When you export to PowerPoint, the following occurs:

Each page in the Power BI report becomes an individual slide in PowerPoint
Each page in the Power BI report is exported as a single high resolution image in PowerPoint
Text boxes in the Power BI report become editable text boxes in PowerPoint
A link is created in PowerPoint that links to the Power BI report

Getting your Power BI report exported into PowerPoint is easy. Just follow the steps outlined in the next section.

In the Power BI service, select the Reports section in the left navigation pane to expand that section, then select
your report to display it on the canvas. You can also select a report from your My Workspace section, or your
Favorites, if the report is in either of those locations.

When the report you want to export to PowerPoint is displayed on the canvas, select File > Export to PowerPoint
(Preview) from the menu bar in the Power BI service, as shown in the following image.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-publish-to-powerpoint.md


You'll see a notification banner in the upper right corner of the Power BI service browser window that the report is
being exported to PowerPoint. This might take a few minutes, and you can continue to work in Power BI while the
report is being exported.

Once complete, the notification banner changes to let you know that the Power BI service has finished the export
process.

Your file is then available where your browser displays downloaded files. In the following image, it's shown as a
download banner along the bottom of the browser window.



Checking out your exported PowerPoint file

NOTENOTE

And that's all there is to it. You can download the file, open it with PowerPoint, and then modify or enhance it just
like you would any other PowerPoint deck.

When you open the PowerPoint file that Power BI exported, you find a few cool and useful elements. Take a look at
the following image, then check out the numbered elements below that describe some of those cool features.

1. The first page of the slide deck includes the name of your report, and a link so that you can View in Power BI
the report on which the slide deck is based.

2. You get some useful information about the report, too, including the last data refresh on which the exported
report is based, and the downloaded at time and date, which is the time and date when the Power BI report was
exported into a PowerPoint file.

3. Each report page is a separate slide, as shown in the left navigation pane.

When you go into an individual slide, you'll notice that each report page is an independent image.

Having one visual for each report page is new behavior. The previous behavior, which provided an independent image for
each visual, is no longer implemented.



Limitations

What you do with your PowerPoint deck from there, or any of the high resolution images, is up to you!

There are a few considerations and limitations to keep in mind when working with the Export to PowerPoint
feature.

R visuals are not currently supported. Any such visuals are exported as a blank image into PowerPoint with an
error message that states the visual is not supported.
Custom visuals that have been certified are supported. For more information on certified custom visuals,
including how to get a custom visual certified, see getting a custom visual certified. Custom visuals that have
not been certified are not supported, and are exported as a blank image into PowerPoint with an error message
that states the visual is not supported.
Certified custom visuals are supported. A certified custom visual has been approved for use with Power BI,
meets certain code requirements, and has passed strict security tests. You can learn more about certified
custom visuals.
Reports with more than 15 report pages can't currently be exported.
The process of exporting the report to PowerPoint may take a few minutes to complete, so please be patient.
Factors that can impact the time required include the structure of the report, and the current load on the Power
BI service.
If the Export to PowerPoint (Preview) menu item isn't available in the Power BI service, it's likely because
your tenant administrator has disabled the feature. Please contact your tenant administrator for details.
Background images will be cropped with the chart's bounding area. It's highly recommended that you remove
background images before exporting to PowerPoint.
In-session interactivity such as highlighting and filtering, drill-down, and so on, are not yet supported when
exporting to PowerPoint. The exported PowerPoint shows the original visuals as they were saved in the report.
Pages in PowerPoint are always created in the standard 9:16 size, regardless of the original page sizes or
dimensions in the Power BI report.
Reports that are owned by a user outside your Power BI tenant domain (such as, a report owned by someone
outside your organization, and shared with you) cannot be published to PowerPoint.
If you share a dashboard with someone outside of your organization (and thereby, a user who is not in your



Next steps

Power BI tenant), that user will not be able to export the shared dashboard's associated reports to PowerPoint.
For example, if you are aaron@contoso.com, you can share with david@cohowinery.com. But
david@cohowinery.com cannot export the associated reports to PowerPoint.
As previously mentioned, each report page is exported as a single image in the PowerPoint file.
The Power BI service uses your Power BI language setting as the language for the PowerPoint export. To see or
set your language preference, select the cog icon  > Settings > General > Language.
The Downloaded at time on the cover slide for the exported PowerPoint file is set to your computer's time
zone at the time of the export.

Analyze in Excel

Excel data in Power BI

Getting a custom visual certified



Reports in Power BI
1/8/2018 • 4 min to read • Edit Online

What is a Power BI report?

Advantages of reports

Dashboards versus reports

CAPABILITY DASHBOARDS REPORTS

Pages One page One or more pages

A Power BI report is a multi-perspective view into a dataset, with visualizations that represent different
findings and insights from that dataset. A report can have a single visualization or pages full of visualizations.
Depending on your job role, you may be someone who creates reports and/or you may be someone who
consumes or uses reports.

This report has 3 pages (or tabs) and we're currently viewing the Store Sales Overview page. On this page are
6 different visualizations and a page title. Visualizations can be pinned to dashboards and when that pinned
visualization is selected, it opens the report it was pinned from.

If you're new to Power BI, you can get a good foundation by reading Power BI basic concepts

Reports are a feature of Power BI service and Power BI Desktop. The experience of working with reports is
almost identical. However, for mobile, you can't create reports but you can view, share, and annotate reports.

Reports are based on a single dataset. The visualizations in a report each represent a nugget of information.
And the visualizations aren't static; you can add and remove data, change visualization types, and apply filters
and slicers as you dig into the data to discover insights and look for answers. Like a dashboard, but more-so, a
report is highly interactive and highly customizable and the visualizations update as the underlying data
changes.

Dashboards are often confused with reports since they too are canvases filled with visualizations. But there are
some major differences.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-reports.md


Data sources One or more reports and one or more
datasets per dashboard

A single dataset per report

Available in Power BI Desktop No Yes, can create and view reports in
Desktop

Pinning Can pin existing visualizations (tiles)
only from current dashboard to your
other dashboards

Can pin visualizations (as tiles) to any
of your dashboards. Can pin entire
report pages to any of your
dashboards.

Subscribe Can't subscribe to a dashboard Can subscribe to report pages

Filtering Can't filter or slice Many different ways to filter,
highlight, and slice

Set alerts Can create alerts to email you when
certain conditions are met

No

Feature Can set one dashboard as your
"featured" dashboard

Cannot create a featured report

Natural language queries Available from dashboard Not available from reports

Can change visualization type No. In fact, if a report owner changes
the visualization type in the report,
the pinned visualization on the
dashboard does not update

Yes

Can see underlying dataset tables and
fields

No. Can export data but can't see
tables and fields in the dashboard
itself.

Yes. Can see dataset tables and fields
and values.

Can create visualizations Limited to adding widgets to
dashboard using "Add tile"

Can create many different types of
visuals, add custom visuals, edit
visuals and more with Editing
permissions

Customization Can do things with the visualizations
(tiles) like move and arrange, resize,
add links, rename, delete, and display
full screen. But the data and
visualizations themselves are read-
only.

In Reading view you can publish,
embed, filter,export, download as
.pbix, view related content, generate
QR codes, analyze in Excel, and more.
In Editing view you can do everything
mentioned so far and so much more.

CAPABILITY DASHBOARDS REPORTS

Report creators and report consumers

If you will be creating and sharing reportsIf you will be creating and sharing reports

Depending on your role, you may be someone who creates reports for your own use or to share with
colleagues. You want to learn how to create and share reports. Or, you may be someone who receives reports
from others. You want to learn how to understand and interact with the reports.

Here are some topics, by role, to help you get started.

Start with a tour of Power BI service so you know where to find reports and report tools.



If you will be receiving and consuming reportsIf you will be receiving and consuming reports

TIPTIP

Next steps

Take a tour of the report editor.
Learn how to create a report from a dataset.
Learn how to use visualization, page, and report-level filters
Discover all the different ways you can share a report with colleagues.

Start with a tour of Power BI service so you know where to find reports and report tools.
Learn how to open a report and all the interaction available in Reading view.
Get comfortable with reports by taking a tour of one of our samples.
Don't need the report any more? You can remove it.
To see which dataset the report is using and which dashboards have tiles pinned from the report, view
related content.

If you didn’t find what you’re looking for here, use the Table of Contents to the left to browse all report topics.

Get Started with Power BI

Power BI - Basic Concepts

More questions? Try the Power BI Community

https://docs.microsoft.com/en-us/power-bi/service-report-open
http://community.powerbi.com/


Create a new Power BI report by importing a dataset
1/26/2018 • 2 min to read • Edit Online

PrerequisitesPrerequisites

Import the dataset

You've read Reports in Power BI and now you want to create your own. There are many different ways to create a
report, and in this article we'll start by creating a very basic report from an Excel dataset. Once you understand the
basics of creating a report, the Next steps at the bottom will direct you to more-advanced report topics.

TIP: To create a report by copying an existing report, see Copy a report

Power BI service (for creating reports using Power BI Desktop, see Desktop report view
Retail Analysis sample dataset

This method of creating a report starts with a dataset and a blank report canvas. To follow along, download the
Retail Analysis sample Excel dataset and save it to OneDrive for Business (preferred) or locally.

1. We'll create the report in a Power BI service workspace, so select an existing workspace or create a new one.

2. From the bottom of the left navpane, select Get data.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-report-create-new.md
http://go.microsoft.com/fwlink/?LinkId=529778


Add a Radial Gauge to the report

3. Select Files and navigate to the location where you saved the Retail Analysis sample.

4. For this exercise, select Import.

5. Once the dataset is imported, select View dataset.

6. Viewing a dataset actually opens the report editor. You'll see a blank canvas and the report editing tools.

TIP: If you're unfamiliar with the report editing canvas, or need a refresher, Take a tour of the report editor
before continuing.

Now that our dataset is imported, let's start answering some questions. Our Chief Marketing Officer (CMO) wants
to know how close we are to meeting this year's sales goals. A Gauge is a good visualization choice for displaying
this type of information.

1. In the Fields pane, select Sales > This Year Sales > Value.



2. Convert the visual to a Gauge by selecting the Gauge template  from the VIsualizations pane.

3. Drag Sales > This Year Sales > Goal to the Target value well. Looks like we're very close to our goal.

4. Now would be a good time to save your report.



Add an area chart and slicer to the report
Our CMO has some additional questions for us to answer. She'd like to know how sales this year compare to last
year. And, she'd like to see the findings by district.

1. First, let's make some room on our canvas. Select the Gauge and move it into the top-right corner. Then grab
and drag one of the corners and make it smaller.

3. Convert the visual to an Area chart by selecting the Area chart template  from the VIsualizations pane.

5. To sort the visualization by time period, select the ellipses and choose Sort by Period.

2. Deselect the gauge. In the Fields pane, select Sales > This Year Sales > Value and select Sales > Last
Year Sales.

4. Select Time > Period to add it to the Axis well.

6. Now let's add the slicer. Select an empty area on the canvas and choose the Slicer  template. This adds



Next steps

an empty slicer to our canvas.

7. From the Fields pane, select District > District. Move and resize the slicer.

8. Use the slicer to look for patterns and insights by District.

Continue exploring your data and adding visualizations. When you find especially interesting insights, pin them to
a dashboard.

Add a new page to the report
Learn how to pin visualizations to a dashboard
More questions? Try the Power BI Community

http://community.powerbi.com/


Create a new report from an existing report
1/8/2018 • 1 min to read • Edit Online

Next Steps:

Maybe you have a report that already connects to your dataset and has some visuals that you'd like to re-use or
modify. Why not simply copy that report as a basis for a new report? To do that:

1. Open a report.

5. Have fun updating and editing your new report.

2. From the File menu, select Save As.

3. Type a name for the new report and select Save.

A Success message lets you know that the new report was saved to your current workspace in Power BI.

4. Open the Reports tab of your workspace and select the new report to open it. Optionally, delete visuals you
don't want to keep, modify other visuals, and add new ones.

Create new visualizations

Delete visualizations you don't need

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/power-bi-report-copy.md
https://docs.microsoft.com/en-us/power-bi/service-report-open




RecentRecent content in Power BI service
12/7/2017 • 1 min to read • Edit Online

What is recent content

Display recent content

Recent content is the last items you visited, up to a maximum of 20 items. These include: dashboards, reports, apps,
and workbooks across all of your workspaces.

Watch Amanda demonstrate how Recent content lists are populated, then follow the step-by-step instructions
below the video to try it out yourself.

To see your five most-recently visited items, from the left navigation, select the arrow to the right of Recent. From
here you can select recent content to open it. Only the five most-recent items are listed.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-recent.md


Next steps

If you have more than five recently-visited items, select See all to open the Recent screen (see below). You can also
select Recent, or the Recent  icon, from the left nav.

From here you can interact with the content as you would on the individual Dashboards, Reports, and
Workbooks tabs, and on the Apps screen.

Power BI service Apps

More questions? Try the Power BI Community

http://community.powerbi.com/


The report editor...Take a tour
1/24/2018 • 6 min to read • Edit Online

Editing reports in Power BI service and Power BI Desktop

The difference between report creators and report consumers

The report editor in Power BI service and the report editor in Power BI Desktop are very similar. The video shows
the report editor in Power BI Desktop and this article shows the report editor in Power BI service.

The ability to create and edit a report is restricted to report owners (aka creators). If you are consuming a report
that has been shared with you, you'll still be able to open and interact with the report in Power BI service Reading
view only, but won't have all the robust and extensive features available to the report creator.

To learn more about report Reading view, see Reading view and Editing view in Power BI service

In Power BI service, the report editor is only available in Editing View. To open a report in Editing view, you must
be a report owner or creator.

The Power BI report editor is made up of 3 sections:

1. Fields, Visualizations, and Filters panes
2. top navigation bars
3. report canvas

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-the-report-editor-take-a-tour.md


1. The report editor panes

There are 3 panes visible when you first open a report: Visualizations, Filters, and Fields. The panes on the left
side, Visualizations and Filters, control what your visualizations look like -- type, colors, filtering, formatting. And
the pane on the right side, Fields, manages the underlying data being used in the visualizations.

The content displayed in the report editor varies by selections you make in the report canvas. For example, when
you select an individual visual,



The Visualizations pane (from top to bottom)

Manage the fields used in your visual.Manage the fields used in your visual.

The top of the Visualization pane identifies the type of
visual in use; in this example, a Clustered column
chart.

The bottom of the Visualization pane (you may have
to scroll down) displays the fields being used in the
visual. This chart is using FiscalMonth,
DistrictManager, and Total Sales Variance. 

The Filters pane (you may have to scroll down)
displays any filters that have been applied. 

The Fields pane lists the tables available and, if you
expand a table's name, the fields that make up that
table. Yellow font lets you know that at least one field
from that table is being used in the visualization.

 To display the formatting pane, for the selected
visualization, select the paint roller icon.

 To display the Analystics pane, select the
magnifying glass icon.

Here is where you select a visualization type. The small pictures are called templates. In the image above, the
Clustered bar chart is selected. If you don't select a visualization type first, but instead start building a visualization
by selecting fields, Power BI will pick the visualization type for you. You can keep Power BI's selection, or change
the type by selecting a different template. Switch as many times as you need to find the visualization type that
best represents your data.

The buckets (sometimes called wells) shown in this pane vary depending on what type of visualization you have



Remove a fieldRemove a field

Format your visualsFormat your visuals

Add analytics to your visualizationsAdd analytics to your visualizations

selected. For example, if you've selected a bar chart, you'll see buckets for: Values, Axis, and Legend. When you
select a field, or drag it onto the canvas, Power BI adds that field to one of the buckets. You can also drag fields
from the Fields list directly into the buckets. Some buckets are limited to certain types of data. For example,
Values won't accept non-numeric fields. So if you drag an employeename field into the Values bucket, Power
BI changes it to count of employeename.

To remove a field from the visualization, select the X to the right of the field name.

For more information, see Add visualizations to a Power BI report

Select the paint roller icon to display the Format pane. The option available depend on the type of visualization
selected.

The formatting possibilities are almost endless. To learn more, explore on your own, or visit these articles:

Customizing visualization title, background and legend
Color formatting
Customizing X-axis and Y-axis properties

Select the magnifying glass icon to display the Analytics pane. The option available depend on the type of
visualization selected.

With the Analytics pane in Power BI service, you can add dynamic reference lines to visualizations, and provide
focus for important trends or insights. To learn more, see Analytics pane in Power BI service or Analytics pane in



The Filters pane

The Fields pane

Power BI Desktop.

Use the Filters pane to view, set, and modify persistent filters to your reports at the page, report, drillthrough, and
visual-level. Yes, you can do ad-hoc filtering on report pages and visuals by selecting elements of the visuals or by
using tools like slicers, but by using the Filters pane the state of the filters is saved with the report.

The Filters pane has one other powerful feature - the ability to filter using a field that is not alrealdy being used
in one of the visuals in your report. Let me explain. When you create a report page, Power BI automatically adds
all the fields you use in your visualizations to the Visual level filters area of the Filters pane. But, if you want to set
a visual, page, drillthrough, or report filter using a field that is not currently used in a visualization, just drag it to
one of the Filters buckets.

For more information, see Add a filter to a report.

The Fields pane displays the tables and fields that exist in your data and are available for you to use to create
visualizations.



What do the field icons mean?What do the field icons mean?

2. The top navigation bar

3. The report canvas

Drag a field onto the page to start a new visualization.
You can also drag a field onto an existing visualization
to add the field to that visualization.

When you add a checkmark next to a field, Power BI
adds that field to the active (or new) visualization. And
it also decides which bucket to place that field into.
For example, should the field be used a legend, axis,or
value? Power BI makes a best-guess and you can
move it from that bucket to another if necessary. 

Either way, each selected field is added to the
Visualizations pane in the report editor.

NOTE: If you're using Power BI Desktop, you'll also have options to show/hide fields, add calculations etc.

∑ Aggregates An aggregate is a numeric value that will be summed or averaged, for example. Aggregates are
imported with the data (defined in the data model your report is based on). For more information, see
Aggregates in Power BI reports.

 Calculated measures (also called calculated fields)
Each calculated field has its own hard-coded formula. You can’t change the calculation, for example, if it’s a
sum, it can only be a sum. For more information, read Understanding measures

 Unique fields
Fields with this icon were imported from Excel and are set to show all values, even if they have duplicates. For
example your data might have two records for people named 'John Smith', and each will be treated as unique
-- they won't be summed.

 Geography fields
Location fields can be used to create map visualizations.

 Hierarchy
Select the arrow to reveal the fields that make up the hierarchy.

The actions available from the top navigation bar are numerous; with new actions being added all the time. For
information about a particular action, use the Power BI Documentation Table of Contents or Search box.

The report canvas is where your work displays. When you use the Fields, Filters, and Visualizations panes to



Next Steps:

create visuals, they are built and displayed on your report canvas. Each tab at the bottom of the canva represents
a page in the report. Select a tab to open that page.

Create a report

Read more about reports in Power BI service, Power BI Desktop, and Power BI mobile.

Power BI - Basic Concepts

More questions? Try the Power BI Community

http://community.powerbi.com/


Add a page to a Power BI report in Power BI service
and Power BI Desktop
12/20/2017 • 1 min to read • Edit Online

Add a new blank page

Duplicate a page

Next steps

No reason to crowd up a report page -- just add a new blank page.

Adding and duplicating report pages require edit permissions to the report. In Power BI service, this means
opening the report in Editing view.

Select the yellow plus icon and then type a new name for the page.

From the top control bar, in Editing view, select the Duplicate this page icon.

Your new page is created and becomes the active page. To rename it, double-click the name on the tab to
highlight it, and type a new name. For more information, see renaming in Power BI service

Read more about reports in Power BI

Power BI - Basic Concepts

More questions? Try the Power BI Community

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/power-bi-report-add-page.md
http://community.powerbi.com/


Add a filter to a Power BI report (in Editing view)
1/8/2018 • 5 min to read • Edit Online

TIPTIP

What is the difference between report filters in Editing View versus
Reading View

NOTENOTE

Visual filters, page filters, drillthrough filters, and report filters

Add a filter to a specific visualization (aka visual filter)

We recommend first reading About filters and highlighting in Power BI reports.

There are two modes for interacting with reports: Reading View and Editing View. And the filtering capabilities
available to you depend on which mode you're in.

In Editing View, you can add report, page, and visual filters. When you save the report, the filters are saved
with it. People looking at the report in Reading View can interact with the filters you added, but not save their
changes.
In Reading View, you can interact with any report, page and visual filters that already exist in the report, but
you won't be able to save your filter changes.

This article describes how to create filters in report Editing View. For more information on filters in Reading VIew, see
interacting with filters in report Reading View.

A page filter applies to all the visuals on the report page. A visual filter applies to a single visual on a report
page. And a report filter applies to all pages in the report.

There are 2 ways to do this:

by filtering a field that is already being used by the visualization
by identifying a field that is not already being used by the visualization, and adding that field directly to the

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/power-bi-report-add-filter.md


By filtering the fields already in the visualizationBy filtering the fields already in the visualization

Visual level filters bucket.

1. Open your report in Editing View.

2. Open the Visualizations and Filters pane and the Fields pane (if they're not already open).

3. Select a visual to make it active. All the fields being used by the visual are identified in the Fields pane and
also listed in the Filters pane, under the Visual level filters heading.

4. At this point we'll add a filter to a field already being used by the visualization.

Scroll down to the Visual level filters area and select the arrow to expand the field you'd like to
filter. In this example we'll filter StoreNumberName



Set either Basic, Advanced, or Top N filtering controls (see How to use report filters). In this
example we'll select Basic filtering and place checkmarks next to numbers 10, 11, 15, and 18.

The visual changes to reflect the new filter. If you save your report with the filter, report readers can
interact with the filter in Reading View, selecting or clearing values.

5. Now let's add a totally new field, as a Visual level filter, to our visualization.

From the Fields pane, select the field you want to add as a new visual level filter, and drag it into the
Visual level filters area. In this example we'll drag District Manager into the Visual level filters
bucket and select only Andrew Ma.



Add a filter to an entire page (aka page view filter)

Notice that District Manager is not added to the visualization itself. The visualization is still
composed of StoreNumberName as the Axis and This Year Sales as the Value.

And, the visualization itself is now filtered to show only Andrew's sales this year for the specified
stores.

1. Open your report in Editing View.
2. Open the Visualizations and Filters pane and the Fields pane (if they're not already open).
3. From the Fields pane, select the field you want to add as a new page level filter, and drag it into the Page

level filters area.
4. Select the values you want to filter and set either Basic or Advanced filtering controls (see How to use

report filters).

All the visualization on the page, impacted by this filter, are re-drawn to reflect the change.



Add a drillthrough filter

Create a drillthrough filterCreate a drillthrough filter

Use the drillthrough filterUse the drillthrough filter

If you save your report with the filter, report readers can interact with the filter in Reading View, selecting or
clearing values.

With drillthrough in Power BI service and Power BI Desktop, you can create a destination report page that focuses
on a specific entity - such as a supplier, or customer, or manufacturer. Now, from the other report pages, users
can right-click on a data point for that entity and drillthrough to the focused page.

To follow along, open the Customer Profitability sample in Editing view. Let's say that you want a page that
focuses on Executive business areas.

1. Add a new page to the report and name it Team Executive. This will be the drillthrough destination page.
2. Add visualizations that track key metrics for the team executives' business areas.
3. Add Executive > Executive Name to the Drillthrough filters well.

Notice that Power BI adds a back arrow to the report page. Selecting the back arrow returns users to the
originating report page -- the page they were on when they opted to drillthrough. The back arrow only
works in Reading view.

Let's see how the drillthrough filter works.

1. Start on the Team Scorecard report page.



Add a filter to an entire report (aka Report filter)

Troubleshooting
Why your visual level filter and page level filter may return different resultsWhy your visual level filter and page level filter may return different results

Next steps

2. Let's say you're Andrew Ma and you want to see the Team Executive report page filtered to just your data.
From the top-left area chart, right click any green data point to open the Drillthrough menu option.

3. Select Drillthrough > Team Executive to drillthrough to the report page named Team Executive. The
page is filtered to show information about the data point from which you right-clicked; in this case Andrew
Ma. Only the field that is in the Drillthrough filters well gets passed through to the drillthrough report
page.

1. Open your report in Editing View.
2. Open the Visualizations and Filters pane and the Fields pane (if they're not already open).
3. From the Fields pane, select the field you want to add as a new report level filter, and drag it into the Report

level filters area.
4. Select the values you want to filter (see How to use report filters).

The visuals on the active page, and on all pages in the report, change to reflect the new filter. If you save your
report with the filter, report readers can interact with the filter in Reading View, selecting or clearing values.

1. Select the back arrow to return to the previous report page.

When you add a visual level filter, Power BI filters on the aggregated results. The default aggregation is Sum, but
you can change the aggregation type.

When you add a page level filter, Power BI filters without aggregating. It does this because a page can have many
visuals which can each utilize different aggregation types. So the filter is applied on each data row.

If you do not see the Fields pane, make sure you're in report Editing view

How to use report filters

Filters and highlighting in reports

Interact with filters and highlighting in report Reading View

Change how report visuals cross-filter and cross-highlight each other



More questions? Try the Power BI Community

http://community.powerbi.com/


Save a report in Power BI service and Power BI
Desktop
1/8/2018 • 1 min to read • Edit Online

TIPTIP

To save a report:To save a report:

Next stepsNext steps

After you make changes to a report in Power BI, you can save it, save it with a new name, or just close it without
saving your changes. Say you open the report, create a visualization, and pin it to your dashboard. If you close it
now without saving your changes, the tile remains on the dashboard, but the visualization isn't saved in the
report. When you click that tile on the dashboard, the report opens, but the visualization doesn't exist in the report.

Pay attention to which workspace is active so you can find the saved report. The report is saved to the active workspace.

1. If you attempt to navigate away from a report, and the report has changes, Power BI will display a prompt.

2. Another way to save the report is to select FILE > Save or Save As. If you are in Reading view you will only
see the option to Save As.

3. If this is a new report (Save), or a new version of an existing report (Save as), give it a descriptive name. The
report will be added to the active workspace.

Read more about reports in Power BI

Power BI - Basic Concepts

More questions? Try the Power BI Community

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-report-save.md
http://community.powerbi.com/


About filters and highlighting in Power BI reports
1/8/2018 • 4 min to read • Edit Online

TIPTIP

Introduction to filters and highlighting in reports using the Filters pane

Filters remove all but the data you want to focus on. Highlighting is not filtering since it does not remove data
but instead highlights a subset of the visible data; the unhighlighted data remains visible but dimmed.

There are a lot of different ways you can filter and highlight reports in Power BI. Putting all of that information in
one article would get confusing, so we've broken it down like this:

Introduction to filters and highlighting (the article you're reading now)
The ways you can create and use filters and highlighting in Editing View/reports that you own. When you have
editing permissions for a report, you can create, modify, and delete filters and highlighting in reports.
The ways you can use filters and highlighting in a report shared with you or in report Reading View. What you
can do is more limited, but Power BI still gives you a wide range of filtering and highlighting options.
A detailed tour of the filter and highlighting controls available in Editing View including an in-depth look at
types of filters (e.g., date and time, numeric, text) and the difference between basic and advanced options.
Now that you've learned how filers and highlighting work by default, learn how to change the way
visualizations on a page filter and highlight each other

How does Power BI knows how data is related? It uses the relationships between the different tables and fields in the
underlying data model to make items on a report page interact with each other.

Filters and highlighting can be applied using the Filters pane or by making selections directly on the report itself
(ad-hoc, see bottom of page). The Filters pane shows the tables and fields used in the report and the filters that
have been applied, if any. The filters are divided up into Page level filters, Report level filters, and Visual level
filters. You'll only see visual level filters if you've selected a visualization on the report canvas.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/power-bi-reports-filters-and-highlighting.md
https://support.office.com/article/Create-a-Data-Model-in-Excel-87e7a54c-87dc-488e-9410-5c75dbcb0f7b?ui=en-US&rs=en-US&ad=US


TIPTIP

Filters in Reading View versus Editing View

The Filters pane in Reading ViewThe Filters pane in Reading View

If the filter has the word All next to it, that means that entire field is being included as a filter. For example, Chain(All) in
the screenshot below tells us that this report page includes data about all the store chains. On the other hand, the report
level filter of FiscalYear is 2013 or 2014 tells us that the report only includes data for the fiscal years of 2013 and 2014.

There are two modes for interacting with reports: Reading view and Editing view. And the filtering capabilities
available to you depend on which mode you're in.

In Editing View, you can add report, page, and visual filters. When you save the report, the filters are saved with
it. People looking at the report in Reading View can interact with the filters you added, but not save their
changes.
In Reading View, you can interact with any page and visual filters that already exist in the report, but you won't
be able to save your filter changes.

If you only have access to a report in Reading View, the Filters pane looks similar to this:

So this page of the report has 6 page level filters and 1 report level filter.

To see if any visual level filters exist, select a visual. In the image below, the bubble chart has 6 filters applied.



The Filters pane in Editing ViewThe Filters pane in Editing View

Ad-hoc filterting and highlighting

In Reading View, explore the data by modifying the existing filters. Learn how in the article Interact with filters in
Reading view

When you have owner permissions for a report and open it in Editing View, you see that Filters is just one of
several editing panes available.

As in Reading View (above) we see that this page of the report has 6 page level filters and 1 report level filter. And
by selecting the bubble chart, we'd see it has 6 visual level filters applied.

But in Editing View, there is so much more that we can do with filters and highlighting. The main difference being
that we can add new filters. Learn how to do this and so much more in the article Add a filter to a report

Select a field on the report canvas to filter and highlight the rest of the page. Select any empty space in the same
visual to remove it. This type of filtering and highlighting is not saved with the report but is fun way to quickly
explore data impacts. To fine-tune how this type of cross-filtering and cross-highlighting works, see Visual
interactions



Next steps
Interact with filters and highlighting (in Reading View)

Add a filter to a report (in Editing View)

Take a tour of report filters

Change how report visuals cross-filter and cross-highlight each other

Read more about reports in Power BI

More questions? Try the Power BI Community

http://community.powerbi.com/


Take a tour of the report Filters pane
1/26/2018 • 5 min to read • Edit Online

Working with filters

Filters in Reading View

This article takes a deep look at the report Filters pane. You'll see the pane in Power BI service Editing View and
Reading View and in Power BI Desktop Report view.

There are many different ways to filter data in Power BI and we recommend first reading About filters and
highlighting.

Reports can be opened in Editing view or Reading view. In Editing View, report owners can add filters to a report
and those filters are saved with the report. People viewing the report in Reading view can interact with the filters,
but cannot save filter changes to the report.

When a report is open in Reading view, the Filters pane displays along the right side of the report canvas. If you
don't see the pane, select the arrow in the top-right corner to expand it.

In this example, we've selected a visual that has 6 filters. The report page also has filters, listed under the Page
level filters heading. There is one Drillthrough filter, and the entire report has a filter too: FiscalYear is 2013 or
2014.

Some of the filters have the word All next to them and this means that all values are being included in the filter.
For example, Chain(All) in the screenshot below tells us that this report page includes data about all the store
chains. On the other hand, the report level filter of FiscalYear is 2013 or 2014 tells us that the report only
includes data for the fiscal years of 2013 and 2014.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/power-bi-how-to-report-filter.md


Filters in Editing View

Anyone viewing this report can interact with these filters.

view the details of the filter by hovering and selecting the arrow next to the filter.

change the filter, for example, change Lindseys to Fashions Direct.

delete the filter by selecting the x next to the filter name.

Deleting a filter removes it from the list but does not delete the data from the report. For example, if you
delete the FiscalYear is 2013 or 2014 filter, fiscal year data will still remain in the report but it will not
longer be filtered to show only 2013 and 2014; it will show all fiscal years the data contains. However,
once you delete the filter, you won't be able to modify it again since it is removed from the list. A better
option is to clear the filter by selecting the eraser icon .

When a report is open in Editing View, the Filters pane displays along the right side of the report canvas in the
bottom half of the Visualization pane. If you don't see the pane, select the arrow in the top-right corner to
expand it.



.

If no visual is selected in the canvas, then the Filters pane displays just the filters that apply to the entire report
page or entire report, and any drillthrough filters (if any have been set). In the example below, no visual is
selected and there are no page level or drillthrough filters but there is a report level filter.

If a visual is selected in the canvas, you will also see the filters that apply to just that visual:



Clear a filter

Add a filter

To display options for a particular filter, select the down arrow next to the filter name. In the example below, the
report level filter is set to 2013 and 2014. And this is an example of basic filtering. To display the advanced
options, select Advanced Filtering.

In either advanced or basic filtering mode, select the eraser icon  to reset the filter.

In Editing view, add a filter to a visual, page, drillthrough, or report by selecting a field from the Fields pane
and dragging it into the appropriate filter well, where you see the words Drag fields here. Once a field
has been added as a filter, fine-tune it using the Basic filtering and Advanced filtering controls (described
below).

Dragging a new field into the Visual level filter area does not add that field to the visual, but it
does allow you to filter the visual with this new field. In the example below, Chain is added as a new filter
to the visual. Notice that simply adding Chain as a filter does not alter the visual until you use the Basic or
Advanced filtering controls.



Types of filters: text field filters
List modeList mode

All the fields that are used to create a visualization are also available as filters. First, select a visual to make
it active. The fields that are being used in the visual are listed in the Visualizations pane (if you are in
Editing view) and in the Filters pane under the Visual level filters heading.

Fine-tune any of these fields using the Basic filtering and Advanced filtering controls (described below).

Ticking a checkbox either selects or deselects the value. The All checkbox can be used to toggle the state of all
checkboxes on or off. The checkboxes represent all the available values for that field. As you adjust the filter, the
restatement updates to reflect your choices.



Advanced modeAdvanced mode

Types of filters: numeric field filters
List modeList mode

Advanced modeAdvanced mode

Note how the restatement now says "is Amarilla or Carretera"

Select Advanced Filtering to switch to advanced mode. Use the dropdown controls and text boxes to identify
which fields to include. By choosing between And and Or, you can build complex filter expressions. Select the
Apply Filter button when you've set the values you want.

If the values are finite, selecting the field name displays a list. See Text field filters > List mode above for help
using checkboxes.

If the values are infinite or represent a range, selecting the field name opens the advanced filter mode. Use the
dropdown and text boxes to specify a range of values that you want to see.

By choosing between And and Or, you can build complex filter expressions. Select the Apply Filter button when



Types of filters: date and time
List modeList mode

Advanced modeAdvanced mode

Next steps

you've set the values you want.

If the values are finite, selecting the field name displays a list. See Text field filters > List mode above for help
using checkboxes.

If the field values represent date or time, you can specify a start/end time when using Date/Time filters.

Filters and highlighting in reports
Interact with filters and highlighting in report Reading View
Create filters in report Editing View
Change how report visuals cross-filter and cross-highlight each other

Read more about reports in Power BI
Power BI - Basic Concepts

More questions? Try the Power BI Community

http://community.powerbi.com/


Analyze in Excel
12/6/2017 • 5 min to read • Edit Online

Requirements

How does it work?

Get started with Analyze in Excel

There are times when you may want to use Excel to view and interact with a dataset that you have Power BI. With
Analyze in Excel, you can do just that, and access PivotTable, chart, and slicer features in Excel based on the
dataset that exists in Power BI.

There are a few requirements for using Analyze in Excel:

Analyze in Excel is supported for Microsoft Excel 2010 SP1 and later.
Excel PivotTables do not support drag-and-drop aggregation of numeric fields. Your dataset in Power BI must
have pre-defined measures.
Some organizations may have Group Policy rules that prevent installing the required Analyze in Excel
updates to Excel. If you’re unable to install the updates, check with your administrator.

When you select Analyze in Excel from the ellipses menu (the ...) associated with a dataset or report in Power
BI, Power BI creates an .ODC file and downloads it from the browser to your computer.

When you open the file in Excel, an empty PivotTable and Fields list appears with the tables, fields, and
measures from the Power BI dataset. You can create PivotTables, charts, and analyze that dataset just as you
would work with a local dataset in Excel.

The .ODC file has an MSOLAP connection string that connects to your dataset in Power BI. When you analyze or
work with the data, Excel queries that dataset in Power BI and returns the results to Excel. If that dataset connects
to a live data source using DirectQuery, Power BI queries the data source and returns the result to Excel.

Analyze in Excel is very useful for datasets and reports that connect to Analysis Services Tabular or
Multidimensional databases, or from Power BI Desktop files or Excel workbooks with data models that have
model measures created using Data Analysis Expressions (DAX).

In Power BI, select the ellipses menu beside a report or dataset (the ... beside the report or dataset name), and
from the menu that appears, select Analyze in Excel.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-analyze-in-excel.md


Install Excel updatesInstall Excel updates

NOTENOTE

Sign in to Power BISign in to Power BI

Users with multiple Power BI accountsUsers with multiple Power BI accounts

When you first use Analyze in Excel, you need to install updates to the Excel libraries. You’ll be prompted to
download and run Excel updates (this initiates installation of the SQL_AS_OLEDDB.msi Windows installer
package). This package installs Microsoft AS OLE DB Provider for SQL Server 2016 RC0 (Preview).

Be sure to check Don’t show this again in the Install Excel updates dialog. You only need to install the update once.

If you do need to install the Excel updates for Analyze in Excel again, you can download the update from the
Download icon in Power BI, as shown in the following image.

Although you’re signed in to Power BI in your browser, the first time you open a new .ODC file in Excel you may
be asked to sign in to Power BI with your Power BI account. This authenticates the connection from Excel to
Power BI.

Some users have multiple Power BI accounts, and those users may encounter a situation where they're logged
into Power BI with one account, but the account that has access to the dataset being used in Analyze in Excel is a
different account. In those situations, you may get a Forbidden error or a sign-in failure when attempting to



Enable data connectionsEnable data connections

NOTENOTE

Analyze away

access a dataset that's being used in an Analyze in Excel workbook.

You'll be provided an opportunity to sign in again, at which time you can sign in with the Power BI account that
has access to the dataset being accessed by Analyze in Excel. You can also select Profile from the Power BI
ribbon tab in Excel, which identifies which account you're currently logged in with, and provides a link that lets
you sign out (and subsequently, sign in with a different account).

In order to analyze your Power BI data in Excel, you are prompted to verify the file name and path for the .odc file,
and then select Enable.

Administrators for Power BI tenants can use the Power BI Admin Portal to disable the use of Analyze in Excel with on-
premises datasets housed in Analysis Services (AS) databases. When that option is disabled, Analyze in Excel is disabled
for AS databases, but continues to be available for use with other datasets.

Now that Excel has opened and you have an empty PivotTable, you're ready to do all sorts of analysis with your
Power BI dataset. Just as with other local workbooks, with Analyze with Excel you can create PivotTables, charts,
add data from other sources, and so on. And of course, you can create different worksheets with all sorts of views
into your data.



NOTENOTE

Save

Share

It's important to know that using Analyze in Excel exposes all detail-level data to any users with permission to the
dataset.

You can save this Power BI dataset connected workbook just like any other workbook. However, you cannot
publish or import the workbook back into Power BI because you can only publish or import workbooks into
Power BI that have data in tables, or that have a data model. Since the new workbook simply has a connection to
the dataset in Power BI, publishing or importing it into Power BI would be going in circles!

Once your workbook is saved, you can share it with other Power BI users in your organization.

When a user with whom you’ve shared your workbook opens the workbook, they’ll see your PivotTables and
data as they appeared when the workbook was last saved, which may not be the latest version of the data. To get
the latest data, users must use the Refresh button on the Data ribbon. And since the workbook is connecting to
a dataset in Power BI, users attempting to refresh the workbook must sign into Power BI and install the Excel
updates the first time they attempt to update using this method.

Since users will need to refresh the dataset, and refresh for external connections is not supported in Excel Online,
it’s recommended that users open the workbook in the desktop version of Excel on their computer.



Visualization interactions in a Power BI report
1/10/2018 • 1 min to read • Edit Online

NOTENOTE

If you have edit permissions for a report, you can use Visual interactions to change how visualizations on a
report page impact each other.

By default, visualizations on a report page can be used to cross-filter and cross-highlight the other visualizations
on the page. For example, selecting a state on a map visualization highlights the column chart and filters the line
chart to display only data that applies to that one state. See About filtering and highlighting. And if you have a
visualization that supports drilling, by default, drilling one visualization has no impact on the other visualizations
on the report page. But both of these default behaviors can be overridden, and interactions set, on a per-
visualization basis.

This article shows you how to use Visual interactions in Power BI service Editing view and in Power BI Desktop.
If a report has been shared with you, you will not be able to change the Visual interactions settings.

The terms cross-filter and cross-highlight are used to distinguish the behavior described here from what happens when
you use the Filters pane to filter and highlight visualizations.

1. Select a visualization to make it active.
2. Display the Visual Interactions options.

In Power BI service, select the dropdown from the report menubar.

In Desktop, select Format > Interactions.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-reports-visual-interactions.md


Next stepsNext steps

3. To turn on the visualization interaction controls, select Edit interactions. Power BI adds cross-filter and
cross-highlight icons to all of the other visualizations on the report page.

4. Determine what impact the selected visualization should have on the others. And, optionally, repeat for all
other visualizations on the report page.

If it should cross-filter the visualization, select the filter icon .

If it should cross-highlight the visualization, select the highlight icon .

If it should have no impact, select the no impact icon .
5. To turn on drilling controls, select Drilling filters other visuals. Now when you drill down (and up) in a

visualization, the other visualizations on the report page change to reflect your current drilling selection.



How to use report filters

Filters and highlighting in reports

Power BI - Basic Concepts

More questions? Try the Power BI Community

http://community.powerbi.com/


Reading View and Editing View in Power BI
service reports
1/19/2018 • 3 min to read • Edit Online

Report Reading view

Report Editing view

Reading view versus Editing view

TASK READING VIEW EDITING VIEW

Reports, as a whole

In Power BI service (not Power BI Desktop) there are two modes for viewing and interacting with reports:
Reading view and Editing view. Reading view is available to all users and is especially designed for data
consumers while Editing view is only available to report creators and owners.

Reading view is your way to explore and interact with the report -- it's a fun and safe way to play with
and get to know your data. Reading view is designed for report consumers; those who open reports from
Apps or who have reports shared with them. Reading view ensures that every single consumer of a
specific report is seeing the same report, the same visualizations, with the same filters applied.
Consumers can interact with the reports, but cannot save changes.

NOTE: In certain circumstances, report consumers may see different data because of row level
security and data permissions.

Editing view is only available to those who created the report or who co-own a report as a member or
admin of an app workspace.

Editing view is designed for report creators. This is where creators import and connect to datasets,
explore the data, and build reports and dashboards. In Editing view creators can dig even deeper into
their data by adding and removing fields, changing visualization type, creating new visualizations, and
adding and deleting visualizations and pages from the report. They can then share the reports they
create with colleagues.

This chart does not list all the report capabilities of Power BI service! It lists only those report tasks that
are not available in both Reading view and Editing view.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-reading-view-and-editing-view.md


Create or edit a report No Yes

Share a report Yes Yes, and can also manage
permissions, including giving others
owner permissions.

Create persistent (permanent)
visual-level, drilthrough, page-level,
and report-level filters from Filters
pane

No Yes

Use report Filters pane Yes, can use the existing filters but
changes aren't saved with the
report.

Yes

Use the report Analytics pane No Yes

Report View options Yes, with some exceptions. Yes, all, including gridlines, snap,
and lock.

Create a refresh schedule No Yes

Subscribe to a report Yes No

Q&A - ask questions in reports No Yes

View Usage metrics Yes, on the report canvas. Yes, in the report list (content view)

View related Yes, on the report canvas. Yes, in the report list (content view)

Save a report Yes, but only using Save as. Yes

Delete a report No Yes

Report pages

Add or rename a report page No Yes

Duplicate a report page No Yes

Delete report page no yes

Working with report
visualizations

Add visualizations to a report No Yes

TASK READING VIEW EDITING VIEW



Add text boxes, and shapes to a
report

No Yes

Use the report Formatting pane No Yes

Set visual interactions No Yes

Show data used to create the
visualization

No Yes

Configure drilling No Yes

Change the visualization being used No Yes

Delete a visualization, text box, or
shape

No Yes

TASK READING VIEW EDITING VIEW

Navigating between Editing view and Reading view

Next stepsNext steps

Remember, only the report creator and owner(s) will be able to open a report in Editing view.

1. By default, a report usually opens in Reading view. You can tell you're in Reading view if you see
an option for Edit report. If Edit report is greyed out, you do not have permissions to open the
report in Editing view.

2. If Edit Report is not greyed out, select it to open the report in Editing view.

The report is now in Editing view and uses the same display settings you last used in Reading
view.

3. To return to Reading view, select Reading view from the top navigation bar.

There are so many ways to interact with a report in Reading view, slicing and dicing your data to discover
insights and get answers to questions. The next topic, Interact with a report in Reading view, describes
some of these in detail.
Back to reports in Power BI
More questions? Try the Power BI Community

http://community.powerbi.com/


Interact with a report in Editing view in Power BI
service
1/8/2018 • 1 min to read • Edit Online

Functionality only available in Editing view

Next steps

Reports can be edited in Power BI service and Power BI Desktop -- if you have owner permissions. Unlike
Desktop, Power BI service has two different modes for interacting with reports -- Reading view for report
consumers and Editing view for report owners and creators. This article tutorial covers Editing view in Power BI
service.

In report Editing view, you have lots of flexibility in both exploring and designing a report. All the Reading view
functionality is available -- plus lots more. Editing view is only available to the person who created the report or
to colleagues who co-own a report as a member or admin of an app workspace.

Take a look at the list of topics under the Reports header in the Table of Contents to the left. It's a long list and
many of the topics cover functionality only available if you have editing permissions for a report. To help you
navigate the Table of Contents, Editing view is required for the following:

Creating, editing, renaming, sharing, and deleting reports.
Adding, renaming, rearranging, and deleting report pages.
Formatting reports.
Adding visualizations, text boxes, and shapes to a report.
Adding visual-level, page-level, and report-level filters and setting visual interactions.
Creating refresh schedules.
Q&A - asking questions in reports
Showing data used to create the visualization
Setting up drillthrough
Duplicating a report page

Back to Reading view and Editing view in Power BI service

More questions? Try the Power BI Community

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-interact-with-a-report-in-editing-view.md
http://community.powerbi.com/


Tips for creating stunning reports
1/24/2018 • 1 min to read • Edit Online

Read the whitepaper: Principles for designing Power BI reports

Watch the Dashboard Makeover webinar

Read and/or watch "How to design visually stunning reports (and
dashboards) in Power BI"

Next steps

Creating and working with reports in Power BI service and in Power BI Desktop is very similar, so most of these
links apply to either.

This paper provides best practices for designing reports in Power BI. Starting with planning, it discusses principles
of design that you can apply to your reports and to the pages and individual visuals that make up that report. Many
of these best practices apply to dashboard design as well.

See Microsoft Principal Program Manager and Power BI dashboard expert Marc Reguera conduct dashboard
makeovers.

Community member Miguel Myers is a Data Scientist as well as a Graphic Designer.

Read the blog
Watch the webinar

Power BI - Basic Concepts

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/power-bi-reports-tips-and-tricks-for-creating.md
https://info.microsoft.com/CO-PowerBI-WBNR-FY16-05May-12-Dashboard-Makeover-Registration.html
https://info.microsoft.com/CO-PowerBI-WBNR-FY16-05May-12-Dashboard-Makeover-Registration.html
https://powerbi.microsoft.com/blog/how-to-design-visually-stunning-reports/
https://info.microsoft.com/CO-PowerBI-WBNR-FY16-04Apr-19-Design-Reports-in-PowerBI-Registration.html


Reports in Power BI

More questions? Try the Power BI Community

http://community.powerbi.com/


Analytics pane in Power BI service
12/20/2017 • 2 min to read • Edit Online

NOTENOTE

Using the Analytics pane

With the Analytics pane in Power BI service, you can add dynamic reference lines to visualizations, and provide
focus for important trends or insights.

The Analytics pane only appears when you select a visual on the report canvas.

With the Analytics pane, you can create the following types of dynamic reference lines (not all lines are available
for all visual types):

X-Axis constant line
Y-Axis constant line
Min line
Max line
Average line
Median line
Percentile line

To view the available dynamic reference lines for a visual, follow these steps:

1. Select or create a visual, then select the Analytics icon from the Visualizations pane.

2. Select the down arrow for the type of line you want to create to expand its options. In this case, we'll select

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-analytics-pane.md


Average Line.

3. To create a new line, select + Add and decide the measure that will be used to create the line. The Measure
dropdown is automatically populated with available data from the selected visualization. Let's use Open
store count.

4. You have all sorts of options for your line, such as color, transparecy, style, and position (relative to the
visual's data elements). If you want to label the line, give it a title and then move the Data label slider to
On. In this case, we'll title the line Avg # Open Stores, and customize a few of the other options as shown
below.



Considerations and troubleshooting

5. Notice the number that appears next to the Average line item in the Analytics pane. That tells you how
many dyanmic lines you currently have on your visual, and of which type. If we add a Constant line as a
store count goal of 9, you can see that the Analytics pane shows that we now also have a Constant line
reference line applied to this visual.

There are all sorts of interesting insights you can highlight by creating dynamic reference lines with the Analytics
pane.

If the visual you've selected can't have dynamic reference lines applied to it (in this case, a Map visual), you'll see
the following when you select the Analytics pane.

The ability to use dynamic reference lines is based on the type of visual being used. The following list shows which
dynamic lines are currently available for which visuals:

Full use of dynamic lines are available on the following visuals:

Area chart
Line chart
Scatter chart
Clustered Column chart
Clustered Bar chart

The following visuals can use only a constant line from the Analytics pane:

Stacked Area
Stacked Bar
Stacked Column
100% Stacked Bar
100% Stacked Column



Next steps

For the following visuals, a trend line is currently the only option:

Non-stacked Line
Clustered Column chart

Lastly, non-Cartesian visuals cannot currently apply dynamic lines from the Analytics pane, such as:

Matrix
Pie chart
Donut
Table

Analytics pane in Power BI Desktop

More questions? Try the Power BI Community

http://community.powerbi.com/


Usage metrics for dashboards and reports
1/23/2018 • 10 min to read • Edit Online

NOTENOTE

Why are usage metrics important to me?

PrerequisitesPrerequisites

If you create dashboards and reports, usage metrics help you understand their impact. When you run either
dashboard usage metrics or report usage metrics, you discover how those dashboards and reports are being used
throughout your organization; what is being used, by whom, and for what purpose.

Usage metrics will track usage of reports that are embedded in SharePoint Online. They will also track embedding of
dashboards and reports via both the “user owns credentials” and “app owns credentials” flow. Usage metrics will not track
usage of reports embedding via publish to web.

These usage metrics reports are read-only. However, you can personalize a usage metrics report by using "Save
as." This creates a brand new dataset and converts the read-only report to a full-featured Power BI report that you
can edit. Not only does the personalized report contain metrics for the selected dashboard or report, but by
removing the default filter, you now have access to usage metrics for all dashboards or all reports in the selected
workspace.

Knowing how your content is being used helps you demonstrate your impact and prioritize your efforts. Your
usage metrics may show that one of your reports is used daily by a huge segment of the organization and it may
show that a dashboard you created isn't being viewed at all. This type of feedback is invaluable in guiding your
work efforts.

Running usage metrics reports is only available in Power BI service. However, if you save a usage metrics report or
pin it to a dashboard, you will be able to open and interact with that report on mobile devices.

The usage metrics feature captures usage information from all users, both Free and Pro. However, a Pro license
is required to run and access the usage metrics data.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-usage-metrics.md


About the Usage Metrics report

Open a Usage Metrics report for a dashboard or report

Usage metrics are provided on dashboards or reports in the selected workspace. To access usage metrics for a
particular dashboard or report, you must:
• Have edit access to that dashboard or report
• Have a Pro license

When you select Usage metrics or the icon , Power BI generates a pre-built report with usage metrics for that
content for the last 90 days. The report looks similar to the Power BI reports you're already familiar with, but it's
designed to be informational -- not interactive. You’ll be able to slice based on how your end users received
access, whether they were accessing via the web or mobile app, etc. As your dashboards and reports evolve, so too
will the usage metrics report, which updates every day with new data.

Usage metrics reports won't show up in Recent, Workspaces, Favorites, or other content lists. They cannot be
added to an app. If you pin a tile from a usage metrics report to a dashboard, that dashboard cannot be added to
an app or content pack.

To dig down into the report data, or to build your own reports against the dataset, use Save as (see Save the
Usage Metrics report as a full-featured Power BI report.

1. Start in the workspace that contains the dashboard or report.
2. From either the workspace content list or from the dashboard or report itself, select the icon for Usage

metrics .

3. The first time you do this, Power BI creates the usage metrics report and lets you know when it's ready.



What metrics are reported?
METRIC DASHBOARD REPORT DESCRIPTION

Distribution method slicer yes yes How users got access to the
content. There are 3 possible
methods: users can access
the dashboard or report by
being members of an app
workspace, by having the
content shared with them,
or by installing a content
pack/app. Note that views
through an app are counted
as "content pack."

Platforms slicer yes yes Was the dashboard or
report accessed via the
Power BI service
(powerbi.com) or a mobile
device? Mobile includes all
our iOS, Android, and
Windows apps.

4. To open the results, select View usage metrics.

Usage metrics will be a powerful ally as you work to deploy and maintain Power BI dashboards and reports.
Wondering which pages of your report are most useful, and which ones you should phase out? Slice by
Report page to find out. Wondering if you should build a mobile layout for your dashboard? Slice by
Platforms to discover how many users are accessing your content via the mobile apps vs. via web browser.

5. Optionally, hover over a visualization and select the pin icon to add the visualization to a dashboard. Or,
from the top menubar, select Pin Live Page to add the entire page to a dashboard. From the dashboard
you can monitor the usage metrics more-easily or share them with others.

NOTE: If you pin a tile from a usage metrics report to a dashboard, that dashboard cannot be added to
an app or content pack.



Report page slicer no yes If the report has more than
1 page, slice the report by
the page(s) that was viewed.
If you see a list option for
"Blank," that means a report
page was recently added
(within 24 hours the actual
name of the new page will
appear in the slicer list)
and/or report pages have
been deleted. "Blank"
captures these types of
situations.

Views per day yes yes Total number of views per
day - a view is defined as a
user loading a report page
or dashboard.

Unique viewers per day yes yes Number of different users
who viewed the dashboard
or report (based on the AAD
user account).

Views per user yes yes Number of views in the past
90 days, broken down by
individual users.

Shares per day yes no Number of times the
dashboard was shared with
another user or group.

Total views yes yes Number of views in the past
90 days.

Total viewers yes yes Number of unique viewers in
the past 90 days.

Total shares yes no Number of times the
dashboard or report was
shared in the past 90 days.

Total in organization yes yes Count of all dashboards or
reports in the entire
organization which had at
least one view in the past 90
days. Used to calculate rank.

Rank: Total views yes yes For total views of all
dashboards or reports in the
organization over the past
90 days, where does this
dashboard or report rank.

METRIC DASHBOARD REPORT DESCRIPTION



Rank: Total shares yes no For total shares of all
dashboards in the
organization over the past
90 days, where does this
dashboard or report rank.

METRIC DASHBOARD REPORT DESCRIPTION

Dashboard Usage Metrics reportDashboard Usage Metrics report

Report Usage Metrics reportReport Usage Metrics report

Save the Usage Metrics report as a full-featured Power BI report
(personalize)



What is created when using "Save as"?What is created when using "Save as"?

Create a copy of the usage report using "Save as"Create a copy of the usage report using "Save as"

Use Save as to convert the usage metrics report to a full-featured Power BI report that can be customized and
shared. Once you’ve created a personalized copy, you’ll get full access to the underlying dataset, allowing you to
customize the usage metrics report to your specific needs. You can even use Power BI Desktop to build custom
usage metrics reports using the live connection to Power BI service feature.

Better yet, the underlying dataset includes the usage details for all dashboards or reports in the workspace. This
opens up yet another world of possibilities. You could, for example, create a report which compares all dashboards
in your workspace based on usage. Or, you could create a usage metrics dashboard for your Power BI app by
aggregating usage across all the content distributed within that app. See remove the Page level filter below.

When Power BI creates the full-featured report, it also creates a new dataset made up of all the dashboards or
all the reports contained in the current workspace that have been accessed in the last 90 days. For example,
say you have a workspace named "Sales" and it contains three dashboards and two reports, and you create a
usage metrics report on the "Northeast" dashboard. And then you use Save as to personalize and convert it to a
full-featured report. The dataset for that new report contains the usage metrics not only for that one dashboard
named "Northeast" but for all three dashboards in the "Sales" workspace. By default, the report will display data
for the "Northeast" dashboard and you'll need to remove a filter (single click) to display data for all three
dashboards.

When you create a copy using "Save as" (personalize), Power BI converts the read-only pre-built report to a full-
featured report. At first glance, it looks exactly the same. However, you can now open the report in Editing view,
add new visualizations, filters, and pages, modify or delete existing visualizations, and so much more. Power BI
saves the brand new report and dataset in the current workspace. In the example below, the current workspace is
mihart.

1. From the pre-built usage metrics report, select File > Save As. Power BI converts the usage metrics report
into a full-featured Power BI report. This is called a personalized usage metrics report. The personalized
usage report and dataset are saved in the current workspace which is named *mihart.

2. Open the report in Editing view and interact with it as you would with any other Power BI report. For
example, add new pages and build new visualizations, add filters, format the fonts and colors, etc.

https://powerbi.microsoft.com/blog/connecting-to-datasets-in-the-power-bi-service-from-desktop


            Remove the filter to see Remove the filter to see allall the usage metrics data in the workspace the usage metrics data in the workspace

3. Alternately, start with the new dataset and build a report from scratch.

4. The new report is saved in the current workspace (mihart) and also added to the Recent content list.

To see the metrics for all the dashboards or for all the reports in the workspace, you'll have to remove a filter. By
default, the personalized report is filtered to display metrics for only the dashboard or report that was used to
create it.

If, for example, you used the dashboard named "European sales" to create this new personalized report, only
usage data from the "European sales" dashboard will display. To remove the filter, and enable data from all the
dashboards in that workspace:

1. Open the personalized report in Editing view.

2. In the Filters pane, locate the Report level filters bucket and remove the filter by selecting the "x".



Admin controls for usage metrics - for Power BI administrators

Now your personalized report displays metrics for the entire workspace.

Usage metrics reports are a feature that the Power BI or Office 365 administrator can turn on or off.
Administrators have granular control over which users have access to usage metrics; they are On by default for all
users in the organization.

1. Open the Admin portal by selecting the gear icon in the top-right-corner of Power BI service and choosing
Admin portal.

2. From the Admin portal, select Tenant settings and choose Usage metrics for content creators.

3. Enable (or disable) usage metrics and select Apply.



Considerations and limitations

Next steps

When disabling usage metrics for their entire organization, admins can use the delete all existing usage
metrics content option to delete all existing reports and dashboard tiles that were built using the usage metrics
reports and datasets. This option removes all access to usage metrics data for all users in the organization who
may already be using it. Be careful, because deleting existing usage metrics content is irreversible.

Q: I can't run usage metrics on a dashboard or report
A: You can only see usage metrics for content you own or have permissions to edit.

Q: Will usage metrics capture views from embedded dashboards and reports?
A: Usage metrics currently does not support capturing usage for embedded dashboards and reports, including the
user owns data flow, the app owns data flow and the publish to web flow. In those cases, we recommend using
existing web analytics platforms to track usage for the hosting app or portal.

Q: I can't run usage metrics on any content at all.
A1: Admins can turn off this feature for their organization. Contact your Admin to see if this is the case.
A2: Usage metrics is a Power BI Pro feature.

Q: The data doesn't seem up-to-date. For example, distribution methods don't show up, report pages are missing,
etc.
A: It can take up to 24 hours for data to update.

Q: There are four reports in the workspace but the usage metrics report only displays 3.
A: The usage metrics report only includes reports (or dashboards) that have been accessed in the past 90 days. If a
report (or dashboard) does not show up, likely it hasn't been used in more than 90 days.

Favorite a dashboard

More questions? Try the Power BI Community

http://community.powerbi.com/


Create a QR code for a report in Power BI to use in
the mobile apps
11/9/2017 • 1 min to read • Edit Online

Create a QR code for a report

Print the QR code

QR codes in Power BI can connect anything in the real world directly to related BI information — no navigation or
search needed.

You can create a QR code in the Power BI service for any report, even for a report you can't edit. Then you place
the QR code in a key location. For example, you could paste it in an email, or print it out and paste it in a specific
location.

Colleagues you've shared the report with can scan the QR code for access to the report, right from their mobile
device. They can use either the QR code scanner located in the Power BI app, or any other QR scanner installed on
their device.

1. Open a report in the Power BI service.
2. Select the ellipsis (...) in the top-right corner and select Generate QR code.

3. A dialog box with the QR code appears.

4. From here you can scan the QR code or download and save it so you can:

Add it to an email or other document, or
Print it and place it in a specific location.

Power BI generates the QR code as a JPG file, ready to print.

1. Select Download, then open the JPG file on a computer connected to a printer.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-create-qr-code-for-report.md


Next steps

TIPTIP

2. Print the file at 100% or “actual size”.
3. Cut out the QR code along its edge and glue it to a place relevant to the report.

The JPG file has the same name as the tile. For example, "Sales and Marketing Sample.jpg".

Connect to Power BI data from the real world with the mobile apps
Scan a Power BI QR code from your mobile device
Create a QR code for a tile
Questions? Try asking the Power BI Community

http://community.powerbi.com/


Aggregates in Power BI visualizations
1/8/2018 • 7 min to read • Edit Online

What is an aggregate?

Types of data

Sometimes you want to mathematically combine values in your data. The mathematical operation could be sum,
average, maximum, count, etc. When you combine values in your data, it is called aggregating. The result of that
mathematical operation is an aggregate.

When Power BI service and Power BI Desktop create visualizations, they may aggregate your data. Often the
aggregate is just what you need, but other times you may want to aggregate the values in a different way. For
example, a sum versus an average. There are several different ways to manage and change the aggregate being
used in a visualization.

First, let's take a look at data types because the type of data determines how, and if, it can be aggregated.

Most datasets have more than one type of data. At the most basic level, the data is either numeric or it is not.
Numeric data can be aggregated using a sum, average, count, minimum, variance, and much more. Even textual
data, often called categorical data, can be aggregated. If you try to aggregate a categorical fields (by placing it in a
numeric only bucket like Values or Tooltips), Power BI will count the occurrences of each category or count the
distinct occurrences of each category. And special types of data, like dates, have a few of their own aggregate
options: earliest, latest, first, and last.

In the example below:

Units Sold and Manufacturing Price are columns that contains numeric data
Segment, Country, Product, Month, and Month Name contain categorical data

When creating a visualization in Power BI, numeric fields will be aggregated (the default is sum) over some
categorical field. For example, "Units Sold by Product, "Units Sold by Month" and "Manufacturing Price by
Segment. Some numeric fields are referred to as measures. It's easy to identify measaures in the Power BI report
editor -- measures are shown with the ∑ symbol in the Fields list. For more information see The report editor... take
a tour.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-aggregates.md


Why don't aggregates work the way I want them to?

Change how a numeric field is aggregated

Working with aggregates in Power BI service can be confusing; maybe you have a numeric field and Power BI
won't let you change the aggregation. Or maybe you have a field, like a year, and you don't want to aggregate it,
you just want to count the number of occurrences.

Most often, the source of the problem is how the field was defined in the dataset. Maybe the field is defined as text
and that explains why it can't be summed or averaged. Unfortunately, only the dataset owner can change the way
a field is categorized. So if you have owner permissions to the dataset, either in Desktop or the program that was
used to create the dataset (e.g., Excel), you can fix this problem. Otherwise, you'll need to contact the dataset owner
for help.

To help you navigate the confusion we have a special section at the end of this article called Considerations and
troubleshooting. If you don't find your answer there, post your question on the Power BI Community forum for a
quick response directly from the Power BI team.

Say you have a chart that sums the units sold for different products, but you'd rather have the average.

1. Create a chart that uses a category and a measure. In this example we're using Units Sold by Product. By
default, Power BI creates a chart that sums the units sold (measure in the Value well) for each product
(category in the Axis well).

2. In the Visualizations pane, right-click the measure, and select the aggregate type you need. In this case,
we're selecting Average. If you don't see the aggregation you need, see "Considerations and
troubleshooting" below.

http://community.powerbi.com


Ways to aggregate your data

NOTENOTE
The options available in the dropdown will vary depending on 1) the field selected and 2) the way that field was
categorized by the dataset owner.

3. Your visualization is now using aggregated by average.

Some of the options that may be available for aggregating a field:

Do Not Summarize. With this option chosen, each value in that field is treated separately and not
summarized. This is often used if you have a numeric ID column that shouldn't be summed.
Sum. This adds all the values in that field up.
Average. Takes an arithmetic mean of the values.
Minimum. Shows the smallest value.
Maximum. Shows the largest value.
Count (Not Blanks). This counts the number of values in that field that are not blank.
Count (Distinct). This counts the number of different values in that field.
Standard deviation.
Variance.
Median. Shows the median (middle) value. This is the value that has the same number of items above and
below. If there are 2 medians, Power BI averages them.

For example, this data:



COUNTRY AMOUNT

USA 100

UK 150

Canada 100

Germany 125

France

Japan 125

Australia 150

Create an aggregate using a category (text) field

Would give the following results:

Do Not Summarize: Each value is shown separately
Sum: 750
Average: 125
Maximum: 150
Minimum: 100
Count (Not Blanks): 6
Count (Distinct): 4
Standard deviation: 20.4124145...
Variance: 416.666...
Median: 125

You can also aggregate a non-numeric field. For example, if you have a product name field, you can add it as a
value and then set it to Count, Distinct count, First, or Last.

1. In this example, we've dragged the Product field into the Values well. The Values well is typically used for
numeric fields. Power BI recognizes that this is a text field, sets the aggregate to Do not summarize, and
presents us with a single-column table.

2. If we change the aggregation from the default Do not summarize to Count (Distinct), Power BI counts
the number of different products. In this case, there are 4.



Considerations and Troubleshooting

3. And if we change the aggregation to Count, Power BI counts the total number. In this case, there are 7
entries for Product.

4. By dragging the same field (in this case Product) into the Values well, and leaving the default aggregation
Do not summarize, Power BI breaks down the count by product.

Q: Why don't I have a Do not summarize option?

A: The field you've selected is likely a calculated measure or advanced measure created in Excel or Power BI
Desktop. Each calculated measure has its own hard-coded formula. You can’t change the aggregation being used.
For example, if it’s a sum, it can only be a sum. In the Fields list, calculated measures are shown with the calculator
symbol.

Q: My field is numeric, why are my only choices Count and Distinct count?

A1: The likely explanation is that the dataset owner has, accidentally or intentionally, not classified the field as a
number. For example, if a dataset has a year field, the dataset owner may categorize that as text because it is more
likely that the year field will be counted (i.e., number of people born in 1974) and not that it will be summed or
averaged. If you are the owner, you can open the dataset in Power BI Desktop and use the Modeling tab to
change the data type.

A2: If the field has a calculator icon, that means it's a calculated measure and each calculated measure has its own
hard-coded formula that can only be changed by a dataset owner. The calculation being used may be a simple
aggregation like an average or sum, but it may also be something more complicated like a "percent of contribution
to parent category" or "running total since start of the year". Power BI isn't going to sum or average the results but
will instead just re-calculate (using the hard-coded formula) for each data point.

A3: Another possibility is that you've dropped the field into a bucket that only allows categorical values. In that
case, your only options will be count and distinct count.

A4: And a third possibility is that you're using the field for an axis. On a bar chart axis, for example, Power BI shows
one bar for each distinct value -- it doesn't aggregate the field values at all.



NOTENOTE
The exception to this rule is scatter charts, which require aggregated values for the X and Y axes.

Q: I have a scatter chart and I want my field to not aggregate. How do I do this?

A: Add the field to the Details bucket and not to the X or Y axes buckets.

Q: When I add a numeric field to a visualization, most of them default to sum but some default to average or count
or some other aggregation. Why isn't the default aggregation always the same?

A: Dataset owners have the option to set the default summarization for each field. If you are a dataset owner,
change the default summarization in the Modeling tab of Power BI Desktop.

Q: I'm a dataset owner and I want to ensure that a field is never aggregated.

A: In Power BI Desktop, in the Modeling tab, set Data type to Text.

Q: I do not see Do not summarize as an option in my dropdown.

A: Try removing the field and adding it back in.

More questions? Try the Power BI Community

http://community.powerbi.com/


Page display settings in a Power BI report
1/8/2018 • 2 min to read • Edit Online

Where to find Page view settings in Power BI service and Power BI
Desktop

In Power BI DesktopIn Power BI Desktop

In Power BI service (app.powerbi.com)In Power BI service (app.powerbi.com)

We understand it is critical to keep your report layout pixel perfect. Sometimes, it can be challenging, because you
and your colleagues view those reports on screens with different aspect ratios and sizes.

The default display view is Fit to page and the default display size is 16:9. If you want to lock in a different aspect
ratio, or want to fit your report in a different way, there are two tools to help you: Page View settings and Page
Size settings.

Page view settings are available in both Power BI service and Power BI Desktop but the interface is a little different.
The two sections below explain where you can find View settings in each Power BI tool.

In Report view, select the View tab to open Page view settings as well as phone layout settings.

In Power BI service, open a report and select View from the upper left menubar.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/power-bi-report-display-settings.md


Page view settings

Page Size settings

Page View settings are available in both Reading view and Editing view. In Editing View, a report owner can assign
page view settings to individual report pages, and those settings are saved with the report. When colleagues open
that report in Reading view, they see the report pages display using the owner's settings. In Reading view
colleagues can change some of the Page view settings, but the changes are not saved when they exit the report.

The first set of Page view settings control the display of your report page relative to the browser window. Choose
between:

Fit to Page (default): contents are scaled to best fit the page
Fit to Width: contents are scaled to fit within the width of the page
Actual Size: contents are displayed at full size

The second set of Page view settings control the positioning of objects on the report canvas

Show gridlines: turn on gridlines to help you position objects on the report canvas
Snap to grid: use with Show gridlines to precisely position and align objects on the report canvas
Lock objects: lock all objects on the canvas so that they cannot be moved or resized
Selection pane: the Selection pane lists all objects on the canvas and you can decide which to show and
which to hide



Next Steps

Page Size settings are only available for report owners. In Power BI service (app.powerbi.com), this means being
able to open the report in Editing view. These settings control the display ratio and actual size (in pixels) of the
report canvas.

4:3 ratio
16:9 ratio (default)
Cortana
Letter
Custom (height and width in pixels)

Learn how to use Page view and Page size settings in your own Power BI reports.

Read more about reports in Power B

Power BI - Basic Concepts

More questions? Try the Power BI Community

http://community.powerbi.com/


Change the size of a report page (Tutorial)
1/26/2018 • 3 min to read • Edit Online

PrerequisitesPrerequisites

First, let's change the page View setting

In the previous article and video you learned about two different ways to control page display in Power BI reports:
View and Page Size. Page view and Page Size are available in both Power BI service and Power BI Desktop, and
look and function amost the same, but for this tutorial we're using Power BI service.

Power BI service
Retail Analysis Sample report

1. Open the report in Reading View or Editing View and select the report tab for New Stores. By default, this
report page is displayed using the Fit to Page setting. In this case, Fit to Page displays the report page
without scrollbars, but some of the detail and titles are too small to read.

2. Make sure that no visualizations are selected on the canvas. Select View and review the display options.

In Reading view you'll see this.

In Editing view you'll see this.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/power-bi-change-report-display-settings.md


3. Let's see how the page looks using the Actual size setting.

Not great, the dashboard now has double scrollbars.

4. Switch to Fit to Width.

Looks better, we now have scrollbars but it's easier to read the detail.



Change the default view for a report page
If you're a report creator, you can change the default view for your report pages. When you share your report with
others, the report pages will open using the view you've set. Report consumers will be able to change the view, but
won't be able to save their changes once they exit out of the report.

1. On the New stores page of the report, switch back to Actual size view.

2. On the District Monthly Sales report page, set View to Fit to width.

3. On the Overview report page, leave the default View setting.

4. Now save the report by selecting File > Save. The next time you open this report, the pages will display
using the new View settings. Let's go see.

5. Select the name of the current workspace from the top navbar to return to that workspace.

6. Select the Reports tab and choose the same report (Retail Analysis Sample).

7. Open each page of the report to see the new settings.



Now, let's explore the page size setting
The page size settings are only available in Editing view, so you must have edit (creator) permissions to the report
to change the page size settings. If you've connected to any of our samples, you'll have creator permissions to
those reports.

1. Open the "District monthly sales" page of the Retail Analysis sample in Editing View.
2. Make sure that no visualizations are selected on the canvas. In the Visualizations pane, select the paint roller

icon .
3. Select Page size > Type to display the page size options.

4. Select Letter. On the canvas, only the contents that fit within 816 x 1056 pixels (Letter size) remain on the
white portion of the canvas.



Use page View and Page Size together

6. Continue exploring the Page Size options.

5. Select Page size 16:9 ratio.

The report page displays using a ratio of 16 wide by 9 high. To see the actual pixel size being used, take a
look at the greyed out Width and Height fields (1280x720). There is a lot of empty space around the report
canvas; this is because we previously set View to "Fit to width".



Use page View and Page Size together to create a report that looks its best when shared with colleagues or
embedded in another application.

In this exercise, you'll create a report page that will display in an application that has space for 500 pixels wide by
750 pixels high.

Remember in the previous step we saw that our report page is currently displaying at 1280 wide by 720 high. So
we know that we'll need to do a lot of resizing and rearranging if we want all of our visuals to fit.

2. Select Page Size > Custom.

1. Resize and move the visuals so that they fit in less than half of the current canvas area.

3. Set Width to 500 and set Height to 750.

4. Tweak the report page so that it looks its best. Switch between View > Actual size and View > Fit to page
to make adjustments.



Next steps
Create reports for Cortana

Back to Page display settings in a Power BI report

More questions? Try the Power BI Community

http://community.powerbi.com/


Reorder pages in a report in Power BI
12/20/2017 • 1 min to read • Edit Online

Next stepsNext steps

In Power BI, a report is made up of one or more pages. Each page has a tab along the bottom. To reorder a report,
simply select and drag the tab to its new location.

Read more about reports in Power BI
Power BI - Basic Concepts
More questions? Try the Power BI Community

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-report-reorder-pages.md
http://community.powerbi.com/


Duplicate a report page in Power BI
12/20/2017 • 1 min to read • Edit Online

Next stepsNext steps

Duplicating a report page requires edit permissions to the report. In Power BI service, this means opening the
report in Editing view.

1. In Power BI, open a report that has at least one page.

2. From the top control bar, select Duplicate this page.

Your new page is created and becomes the active page.

3. Optionally, rename the report page.

More about Visualizations in Power BI reports Add a new page to a report

Power BI - Basic Concepts

More questions? Try the Power BI Community

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/power-bi-report-copy-paste-page.md
http://community.powerbi.com/


Export a report from Power BI service to Desktop
(Preview)
1/26/2018 • 2 min to read • Edit Online

Download the report as a .pbix

In Power BI Desktop, you can export (also referred to as download) a report to Power BI service by saving the
report and selecting Publish. You can also export in the other direction as well, and download a report from Power
BI service to Desktop. The extension for files being exported, in either direction, is .pbix.

There are a few limitations and considerations to keep in mind, which are discussed later in this article.

To download the .pbix file, follow these steps:

1. In Power BI service, open the report you want to download in Editing view.

NOTENOTE

2. From the menubar, select File > Download report.

The report must have been created using Power BI Desktop after November 23, 2016 - and updated since then - to
be able to download the report. If it hasn't, the Download Report menu option in Power BI service is grayed out.

3. While the .pbix file is being created, a status banner displays the progress. When the file is ready, you'll be
asked to open or save the .pbix file. The name of the file matches the title of the report.

You now have the option of opening the .pbix file in either Power BI service (app.powerbi.com) or Power BI
Desktop.

4. To immediately open the report in Desktop, select Open. To save the file to a specific location, select Save >
Save-As. If you haven't already, install Power BI Desktop.

When you open the report in Desktop, you may see a warning message letting you know that some features
available in the Power BI service report may not be available in Desktop.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-export-to-pbix.md
file:///W:/soyp-o-7bf22bb1/powerbi-docs/.tmp/guided-learning/publishingandsharing.yml#step-2


Considerations and troubleshooting

Next steps

5. The report editor in Desktop looks very much like the report editor in Power BI service.

There are a few important considerations and limitations associated with downloading (exporting) a .pbix file from
Power BI service.

To download the file, you must have edit access to the report
The report must have been created using Power BI Desktop and been published to the Power BI service, or
the .pbix must have been uploaded to the service.
Reports must be published or updated after November 23, 2016. Reports published prior to then are not
downloadable.
This feature will not work with reports originally created in the Power BI service, including content packs.
You should always be using the latest version of Power BI Desktop when opening downloaded files.
Downloaded .pbix files may not open in non-current versions of Power BI Desktop.
If your administrator has turned off the ability to export data, this feature will not be visible in the Power BI
service.

View the Guy in a Cube one-minute video about this feature:



Also, here are some additional articles that can help you learn to use Power BI service:

Reports in Power BI
Power BI - Basic Concepts

Once you get Power BI Desktop installed, the following content can help you get up and running quickly:

Getting Started with Power BI Desktop

More questions? Try the Power BI Community

http://community.powerbi.com/


Filter a report using query string parameters in the
URL
1/8/2018 • 3 min to read • Edit Online

Query string parameter syntax for filtering

When you open a report in Power BI service, each page of the report has its own unique URL. To filter that report
page, you could use the Filters pane on the report canvas. Or you could add query string parameters to the URL to
filter the report. Perhaps you have a report you'd like to show colleagues and you want to pre-filter it for them. One
way to do this is to start with the default URL for the report, add the filter parameters to the URL, and then email
them the entire URL.

The syntax is fairly straightforward; start with the report URL, add a question mark, and then add your filter syntax.

URL?filter=Table/Field eq 'value'

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-url-filters.md


Filter on a field

NOTENOTE

NOTENOTE

Filter on multiple fields

Table and Field names are case sensitive, value is not.
Fields that are hidden from report view can still be filtered.
Value has to be enclosed with single quotes.
Field type has to be a number or string
Table and field names cannot have any spaces.

If it's still confusing, continue reading and we'll break it down.

Let’s assume that the URL to our report is the following.

And we see in our map visualization (above) that we have stores in North Carolina.

This example is based on the Retail Analysis sample.

To filter the report to show data only for stores in "NC" (North Carolina), append the URL with the following;

?filter=Store/Territory eq 'NC'

NC is a value stored in the Territory field of the Store table.

Our report is filtered for North Carolina; all the visualizations on the report page show data for only North Carolina.

You can also filter on multiple fields by adding additional parameters to your URL. Let's go back to our original



?filter=Store/Territory eq 'NC'

?filter=Store/Territory eq 'NC' and Store/Chain eq 'Fashions Direct'

Using DAX to filter on multiple valuesUsing DAX to filter on multiple values

Pin a tile from a filtered report

Limitations and troubleshooting

filter parameter.

To filter on additional fields, add an and  and another field in the same format as above. Here is an example.

Another way to filter on multiple fields is by creating a calculated column that concatenates two fields to a single
value. Then you can filter on that value.

For example, we have two fields: Territory and Chain. In Power BI Desktop, create a new Calculated column (Field)
called TerritoryChain. Remember that the Field name cannot have any spaces. Here is the DAX formula for that
column.

TerritoryChain = [Territory] & " - " & [Chain]

Publish the report to Power BI service and then use the URL query string to filter to display data for only Lindseys
stores in NC.

https://app.powerbi.com/groups/me/reports/8d6e300b-696f-498e-b611-41ae03366851/ReportSection3?
filter=Store/TerritoryChain eq 'NC–Lindseys'

Once you've filtered the report using query string parameters, you can pin visualizations from that report to your
dashboard. The tile on the dashboard will display the filtered data and selecting that dashboard tile will open the
report that was used to create it. However, the filtering you did using the URL is not saved with the report and when
the dashboard tile is selected, the report opens in its unfiltered state. This means that the data displayed in the
dashboard tile will not match the data displayed in the report visualization.

There may be some cases where this will be helpful when you'd like to see different results; filtered on the
dashboard and unfiltered in the report.

There are a couple of things to be aware of when using the query string parameters.

https://app.powerbi.com/groups/me/reports/8d6e300b-696f-498e-b611-41ae03366851/ReportSection3?filter=Store/TerritoryChain


Next steps

Query string filtering does not work with Publish to web or Power BI Embedded.
Field type has to be number or string.
Table and field names cannot have any spaces.

Pin a visualization to a dashboard
Try it out -- it's free!

More questions? Try asking the Power BI Community

https://powerbi.com/
http://community.powerbi.com/
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Use filters to limit report visuals to display only what’s needed

Limit visuals on report pages

Optimize your model

DirectQuery and Live connection: understand underlying data source
performance

This article offers guidance for building fast and reliable reports in Power BI.

The more data that a visual needs to display, the slower that visual will be to load. While this principle seems
obvious, it can be easy to forget. For example: suppose you have a large dataset. Atop of that, you build a report
with a table of the table. End users use slicers on the page to get to the rows they wanted – typically they’re only
interested in a few dozen rows.

A common mistake is to have the default view of the table be unfiltered - i.e. all 100M+ rows. The data for these
rows must be loaded into memory and uncompressed at every refresh. This created huge memory loads. The
solution: reduce the max number of items that the table displayed using the “Top N” filter. The max item can be
much larger than what users would need, for example, 10,000. As a result, the end user experience was unchanged,
but memory utilization of the report dropped multiple orders of magnitude, and performance improved
accordingly.

A similar approach to the above is strongly suggested for all visuals on your reports. Ask yourself, is all the data in
this visual needed? Are there ways to filter down the amount of data shown in the visual with minimal impact to
the end user experience? Note that tables in particular can be very expensive.

The above principle applies equally to the number of visuals on a particular report. It is highly recommended that
you limit the number of visuals on a particular report to only what is necessary. Drill-through pages are a great way
to provide additional details without jamming more visuals into the report.

Some best practices:

Tables or columns that are unused should be removed if possible.
Avoid distinct counts on fields with high cardinality – i.e. millions of distinct values.
Take steps to avoid fields with unnecessary precision and high cardinality. For example, you could split highly
unique datetime values into separate columns – e.g. month, year, date, etc. Or, where possible, use rounding on
high-precision fields to decrease cardinality – (e.g. 13.29889 -> 13.3).
Use integers instead of strings, where possible.
Be wary of DAX functions which need to test every row in a table – e.g. RANKX – in the worst case, these
functions can exponentially increase run-time and memory requirements given linear increases in table size.
When connecting to data sources via DirectQuery, consider indexing columns that are commonly filtered or
sliced again – this will greatly improve report responsiveness.

For more guidance on optimizing data sources for DirectQuery, see DirectQuery in SQL Server 2016 Analysis
Services.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/power-bi-reports-performance.md
https://blogs.msdn.microsoft.com/analysisservices/2017/04/06/directquery-in-sql-server-2016-analysis-services-whitepaper/


DirectQuery best practices

DB design guidanceDB design guidance

Modelling guidanceModelling guidance

GeneralGeneral

Understanding dashboards and query caches

NOTENOTE

In the DirectQuery or live connection case, when users visit a Power BI report, Power BI sends queries in real-time
to the underlying data source. Once the data source returns with the query data, then the report is rendered. As a
result, your report performance in these cases depends largely on the performance of the underlying data source.

In these cases, it will be important to understand the performance of your underlying data source. Different data
sources will have different tools for understanding query performance. For example, SQL Server and Azure SQL
provide the Query Store, which captures a history of queries and their runtime statistics.

As a rule of thumb, when deploying Power BI reports built on DirectQuery and live connection, try out what your
end users will do in Power BI Desktop. If the report is slow to load in Power BI Desktop, it will almost certainly be
slow to load in the service for your end users.

The following section describes general best practices for connecting via DirectQuery.

Push calculated columns and measures to the source where possible – the closer they are to the source, the
higher the likelihood of performance.
Optimize! Understand the execution plans for your queries, add indices for commonly filtered columns, etc.

Start in the Power BI Desktop.
Avoid complex queries in Query Editor.
Do not use relative date filtering in the Query Editor.
Keep measures simple initially, and add complexity incrementally.
Avoid relationships on calculated columns and unique identifier columns.
Try setting “Assume Referential Integrity” on relationships – in many cases, this can significantly improve query
performance.

Apply filters first.
Consider switching off interaction between visuals – this will reduce the query load when users cross-highlight.
Limit the number of visuals and the data per visuals, as described above.
Enabling row-level security can result in substantial changes in performance. Be sure to test the different row-
level security roles that your users will assume.
Note that there are query-level time-outs enforced by the service to ensure that long-running queries cannot
monopolize system resources. Queries that take longer than 225 seconds will time out and result in a visual-
level error.

Visuals pinned to dashboards are served by the query cache when the dashboard is loaded. Conversely, when
visiting a report, the queries are made on-the-fly to the data source – either the Power BI service (in the case of
import) or the data source that you specify (in the case of DirectQuery or live connection).

When you pin live report tiles a dashboard, they are not served from the query cache – instead, they behave like reports, and
make queries to back-end cores on the fly.

As the name suggests, retrieving the data from the query cache provides better and more consistent performance
than relying on the data source. One way to take advantage of this functionality is to have dashboards be the first



Understand custom visual performance

Deep-dive into query performance with SQL Profiler and Power BI
Desktop

landing page for your users. Pin often used and highly requested visuals to the dashboards. In this way, dashboards
become a valuable “first line of defense” which provide consistent performance with less load on the capacity.
Users can still click through to the report to dig into the details.

Note that for DirectQuery and live connection, this query cache is updated on a periodic basis by querying the data
source. By default, this happens every hour, though it can be configured in dataset settings. Each query cache
update will send queries to the underlying data source to update the cache. The number of queries generated
depends on the number of visuals pinned to dashboards relying on that data source. Notice that if row-level
security is enabled, queries are generated for each different security context. For example, if you have two different
roles that your users fall into, with two different views of the data, then during query cache refresh, two sets of
queries are generated.

Be sure to put each custom visual through its paces to ensure high performance. Poorly optimized custom visuals
can negatively affect the performance of the entire report.

For a deeper dive into which visuals are taking up the most time and resources, you can connect SQL Profiler to
Power BI Desktop to get all full view of query performance. Instructions as follows:

1. Install SQL Server Profiler and run Power BI Desktop

SQL Server Profiler is available as part of SQL Server Management Studio.

2. Determine the port being used by Power BI Desktop

Run the command prompt or PowerShell with administrator privileges, and use netstat to find the port that
Power BI Desktop is using for analysis:

> netstat -b -n

The output should be a list of applications and their open ports, for example:

TCP [::1]:55786 [::1]:55830 ESTABLISHED

[msmdsrv.exe]

Look for the port used by msmdsrv.exe, and write it for later use. In this case, you could use port 55786.

3. Connect SQL Server Profiler to Power BI Desktop

Start SQL Server Profiler from the Start menu
File > New Trace
Server Type: Analysis Services
Server name: localhost:[port number found above]
At the next screen, select Run
Now the SQL Profiler is live, and actively profiling the queries that Power BI Desktop is sending.
As queries are executed, you can see their respective durations and CPU times – using this information,
you can determine which queries are the bottlenecks.

Through the SQL Profiler, you can identify the queries which are taking up the longest CPU time, which in turn are
likely the performance bottlenecks. The visuals which execute those queries should be then be a focal point of
continued optimization.



Gateway best practices

Network latency

Next steps

The on-premises data gateway is a great tool for connecting the Power BI service with your on-premises data. At
the same time, with poor planning, it can also become a bottleneck for report performance. This is especially true
for DirectQuery/live connection datasets, where all queries and query responses pass through the gateway. The
following are some best practices for ensuring highly performant gateways:

Use the Enterprise mode, as opposed to the personal mode.
Recommended hardware specs for the gateway – 8 CPU cores, 16 GB RAM.
Set up monitoring – set up performance monitoring on the gateway machine understand whether the
gateway is becoming overloaded and becoming a bottleneck. For more information, see Troubleshooting the
on-premises data gateway.
Scale up or scale out – if the gateway is indeed becoming a bottleneck, then consider scaling up (that is,
moving the gateway to a more powerful machine with more CPU and RAM) or scaling out (for example, splitting
out datasets onto different gateways).
Separate import vs. DirectQuery – if scaling out, consider separating the gateways responsible for import vs.
those responsible for DirectQuery.

Network latency can impact report performance by increasing the time required for requests to reach the Power BI
service, and for responses to be delivered. Tenants in Power BI are assigned a specific region. You can view your
tenant’s “home” region by navigating to powerbi.com, selecting ? in the top right and then About Power BI. When
users from a tenant access the Power BI service, their requests are always routed to this region. Once the requests
reach the Power BI service, the service may then send additional requests – e.g. to the underlying data source or the
gateway – which are also subject to network latency.

Tools such as Azure Speed Test can provide an indication of network latency between the client and the Azure
region. In general, to minimize the impact of network latency, strive to keep data sources, gateways, and your
Power BI cluster as close as possible. If network latency is an issue, you can try locating gateways and data sources
closer to your Power BI cluster by placing them on virtual machines.

To further improve network latency, consider using Azure ExpressRoute, which is capable of creating faster, more
reliable network connections between your clients and Azure datacenters.

Planning a Power BI Enterprise Deployment, with all-around guidance on large-scale Power BI deployments
DirectQuery in SQL Server 2016 Analysis Services
[YouTube] Building Fast and Reliable Reports in Power BI
[YouTube] Power BI Enterprise Deployments

http://azurespeedtest.azurewebsites.net/
https://azure.microsoft.com/en-us/services/expressroute/
https://aka.ms/pbienterprisedeploy
https://blogs.msdn.microsoft.com/analysisservices/2017/04/06/directquery-in-sql-server-2016-analysis-services-whitepaper/
https://www.youtube.com/watch?v=GhiJABR7XX0
https://www.youtube.com/watch?v=K-zEWICvICM
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Add a visualization in Power BI

Upload a custom visualization and use it in Power BI

Visualizations (aka visuals) display insights that have been discovered in the data. A Power BI report might have
a single page with one visual or it might have pages full of visuals. In Power BI service, visuals can be pinned
from reports to dashboards.

It's important to make the distinction between report creators and report consumers If you are the person
building or modifying the report, then you are a creator. Creators have edit permissions to the report and its
underlying dataset. In Power BI Desktop, this means you can open the dataset in Data view and create visuals in
Report view. In Power BI service, this means you can open the dataset or report in the report editor in Editing
view. If a report or dashboard has been shared with you, you are a report consumer. You'll be able to view and
interact with the report and its visuals but you won't be able to save changes.

There are many different visual types available directly from the Power BI VISUALIZATIONS pane.

And for even more choices, visit the Microsoft AppSource community site to find and download custom visuals
provided by Microsoft and the community.

If you're new to Power BI, or need a refresher, use the links below to learn the basics of Power BI visualizations.
Alternately, use our Table of Contents (along the left side of this article) to find even more helpful information.

Create visualizations on the pages of your reports. Browse the list of available visualizations and available
visualization tutorials.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/power-bi-report-visualizations.md
https://appsource.microsoft.com
https://appsource.microsoft.com/marketplace/apps?product=power-bi-visuals&page=1


Change the visualization type

Pin the visualization

Next steps

Add a custom visualization that you created yourself or that you found in the Microsoft AppSource community
site. Feeling creative? Dig into our source code and use our developer tools to create a new visualization type
and share it with the community

Try changing the type of visualization to see which works best with your data.

In Power BI service, when you have the visualization the way you want it, you can pin it to a dashboard as a tile.
If you change the visualization being used in the report after you pin it, the tile on the dashboard doesn't
change -- if it was a line chart, it stays a line chart, even if you changed it to a Donut chart in the report.

Visualization types in Power BI Reports in Power BI
Dashboards in Power BI
Power BI - Basic Concepts
More questions? Try the Power BI Community

https://appsource.microsoft.com/marketplace/apps?product=power-bi-visuals
https://docs.microsoft.com/en-us/power-bi/developer/office-store
http://community.powerbi.com/
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Power BI visualizations

List of visualizations available in Power BI

Area charts: Basic (Layered) and StackedArea charts: Basic (Layered) and Stacked

TIPTIP

Bar and column chartsBar and column charts

TIPTIP

We'll be adding new visualizations, stay tuned!

And check out the Microsoft AppSource , where you'll find a growing list of custom visuals you can download
and use in your own dashboards and reports. Feeling creative? Learn how to create and add your own visuals to
this community site.

All of these visualizations can be added to Power BI reports, specified in Q&A, and pinned to dashboards.

The Basic Area chart is based on the line chart with the area between the axis and line filled in.

For more information, see Tutorial: Basic Area chart.

Bar charts are the standard for looking at a specific value across different categories.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/power-bi-visualization-types-for-reports-and-q-and-a.md
https://appsource.microsoft.com/marketplace/apps?product=power-bi-visuals
https://docs.microsoft.com/en-us/power-bi/developer/office-store


Cards: Multi rowCards: Multi row

Cards: Single numberCards: Single number

Combo chartsCombo charts

TIPTIP

Doughnut chartsDoughnut charts

TIPTIP

Funnel chartsFunnel charts

For more information, see Create a Card (big number tile).

A Combo chart combines a column chart and a line chart. Choose from Line and Stacked Column and Line and Clustered
Column.

For more information, see Tutorial: Combo charts in Power BI.

Doughnut charts are similar to Pie charts. They show the relationship of parts to a whole.

For more information, see Tutorial: Doughnut charts in Power BI.



TIPTIP

Gauge chartsGauge charts

TIPTIP

KPIsKPIs

TIPTIP

Line chartsLine charts

Funnels help visualize a process that has stages and items flow sequentially from one stage to the next. Use a funnel when
there is a sequential flow between stages, such as a sales process that starts with leads and ends with purchase fulfillment.

For more information, see Tutorial: Funnel Charts in Power BI.

Displays current status in the context of a goal.

For more information, see Tutorial: Gauge Charts in Power BI.

Displays progress toward a measurable goal.

For more information, see Tutorial: KPIs in Power BI.



TIPTIP

Maps: Basic mapsMaps: Basic maps

TIPTIP

Maps: ArcGIS mapsMaps: ArcGIS maps

Maps: Filled maps (Choropleth)Maps: Filled maps (Choropleth)

Emphasize the overall shape of an entire series of values, usually over time.

Used to associate both categorical and quantitative information with spatial locations.

For more information, see Tips and tricks for map visuals.

For more information, see Tutorial: ArcGIS maps in Power BI.



TIPTIP

MatrixMatrix

Pie chartsPie charts

Scatter and Bubble chartsScatter and Bubble charts

TIPTIP

SlicersSlicers

The more intense the color, the larger the value.

For more information, see Tutorial: Filled Maps in Power BI.

Display relationships between 2 (scatter) or 3 (bubble) quantitative measures -- whether or not, in which order, etc.

For more information, see Tutorial: Scatter charts in Power BI.

For more information, see Tutorial: Slicers in Power BI.



Standalone imagesStandalone images

TablesTables

TIPTIP

Tree MapsTree Maps

TIPTIP

Waterfall chartsWaterfall charts

For more information, see Add an image widget to a dashboard.

Work well with quantitative comparisons among items where there are many categories.

For more information, see Working with tables in Power BI.

For more information, see Tutorial: Treemaps in Power BI.

Are charts of colored rectangles, with size representing value. They can be hierarchical, with rectangles nested within the
main rectangles.



TIPTIP

Tell Q&A which visualization to use

Next steps

Waterfall charts show a running total as values are added or subtracted.

For more information, see Tutorial Waterfall charts in Power BI.

When typing natural language queries with Power BI Q&A, you can specify the visualization type in your query.
For example:

"sales by state as a treemap"

Visualizations in Power BI reports
The right visual reference from sqlbi.com

Reports in Power BI

Power BI - Basic Concepts

More questions? Try the Power BI Community

http://www.sqlbi.com/wp-content/uploads/videotrainings/dashboarddesign/visuals-reference-may2017-A3.pdf
http://community.powerbi.com/


Best design practices for reports and visuals
12/20/2017 • 47 min to read • Edit Online

Introduction

NOTENOTE

A look at the landscape and terminology

Before you build your first visualization…focus on requirements

We’ve released a new and improved navigation and content experience for Power BI, and we’re in the process of
updating all of our documentation. The information and screenshots on this page may not match what you see on
your screen. For more information see Navigating Power BI service.

This paper provides best practices for designing reports in Power BI. Starting with planning, it discusses principles
of design that you can apply to your reports and to the pages and individual visuals that make up that report.
Many of these best practices apply to dashboard design as well.

We hope this paper will be a jumping-off point for you and that you’ll apply what you learn to your own reports
and visualizations and that you’ll continue the conversation on community.powerbi.com. BI report design and
visualization usage is a hot topic right now and there are many thought leaders, bloggers, and websites that look
at this topic in breadth and depth (we’ve listed a few at the end).

The recommendations made in this white paper are guidelines for you to apply when and where it makes sense. For every
principle we describe below, there are usually valid reasons to “break the rule.”

We are overwhelmed by information, not because there is too much, but because we don't know how to tame it. --
Stephen Few

In Power BI, a report can have one or more report pages and all the pages together are collectively referred to as
the report. The basic elements of the report are visuals (aka visualizations), standalone images, and text boxes.
From the individual data points, to the report elements, to the report page itself, there are innumerable formatting
options.

We’ll start at the report planning stage, continue on to basic report design principles, then discuss visual design
principles, and finish with a discussion of best practices for individual visual types.

In-depth guidance and instructions for creating and using Power BI reports is available at powerbi.com > Learn.

Creating a report starts before you build your first visual because a good report needs planning. Know what data
you have to work with and write down the requirements for the report. Ask yourself “What is the business need,
how is this data going to be used, and by whom?” A key question is “what decisions does the reader want to be
able to make based on this report?”

The answer to those questions will drive your design. Every report tells a story. Make sure that story matches the
business need. It may be tempting to add visuals that show dramatic insights, but if those insights don’t match the
business need, then the report won’t be useful – and in fact your users might be distracted by those visuals. Also,
you may find that the information needed to make that decision cannot be gleaned from this data. Can this report
be used to measure what is needed?

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/power-bi-visualization-best-practices.md


Principles of report design

Layout - the report canvasLayout - the report canvas

Reports can be used to monitor, uncover, track, predict, measure, manage, test, and more. If, for example, the
business need is a sales report that measures performance, then you might design a report that looks at current
sales, compares it to previous sales, compares to competitors, and includes some KPIs that trigger alerts. Perhaps
readers can drill down into the sales numbers to see store closures or supply chain issues that may be impacting
sales. Another drilldown might be the ability to look at sales by store, region, product, season, and more.

Know the customers for the report and design a report that uses familiar terminology and provides data at a level
of detail and complexity on par with the customers’ level of knowledge. Have more than one type of customer?
One size doesn’t always fit all; design separate report pages based on expertise and be sure to label each page
clearly so customers can self-identify. Another option is to use slicers so customers can tailor the page to fit them.
Involve the customer in the planning stage and avoid the mistake of building what you think they need. Be
prepared to start over and to iterate.

Once you’ve identified the business need, the customers, and the metrics you’d like to include, the next step is to
pick the right visuals to tell the story and present those visuals in the most-effective way possible. That covers a lot
of ground, and we’ll start with some basic principles of report design.

A report page has limited space and one of the hardest things is to fit all the elements you want into that space –
and still have that information be easily understood. And don’t underplay the value of “pretty.” The key is to find
the balance between pretty and useful.

Let’s take a look at layout, clarity, and aesthetics.

The report canvas has a finite amount of space. If you can’t fit all the elements on a single report page, break the
report up into pages. A report page can be tailored to a specific audience (e.g., HR, IT, Sales, SLT), or to a specific
business question (e.g., How are defects impacting our downtime?, What is our Marketing campaign’s impact on
Sentiment?) or as a progressive story (e.g. first page as overview or attention-grabbing “hook”, 2nd page continues
the data story, 3rd page dives deeper into the story, etc.). If your entire report fits on a single page, great. If it
doesn’t, create separate report pages that logically chunk the content. And don’t forget to give the pages
meaningful and helpful names.

Think about filling an art gallery. You wouldn’t put 50 pieces of artwork into a small room, fill it with chairs and
paint each wall a different color. As the curator, you’d choose just pieces that have a common theme, lay them out
around the room with plenty of space for visitors to move and think, and place informational cards that describes
what they’re looking at. And there’s a reason most modern galleries have plain walls! For this article, we’ll start
with a report example that needs a lot of work. As we apply our best practices and principles of design, our report
will improve.



Alignment, order, and proximityAlignment, order, and proximity

AlignmentAlignment

Figure 1: This ugly report page needs a lot of work

The example above has many space-related (layout) design issues that we’ll discuss below:

alignment, order, and use of proximity
poor use of space and sorting
clutter

The layout of your report elements impacts comprehension and guides the reader through the report page. How
you place and position elements tells a story. The story might be “start here and then look here” or “these 3
elements are related to each other.”

In most cultures, people scan from left to right and top to bottom. Position the most important element in the
top left corner of your report. And organize the rest of the visuals in a way that leads to logical navigation and
comprehension of the information.
Position elements that require the reader to make a choice to the left of the visualizations the choice will impact:
slicers, for example.
Position related elements close to each other; proximity implies the elements are related.
Another way to convey relationships is to add a border or color background around related elements.
Conversely, add a divider to distinguish between different sections of a report.
Use white space to visually chunk sections of the report page.
Fill the report page. If you find that you have a lot of extra white space, make your visualizations larger or make
the canvas smaller.
Be intentional with sizing your report elements. Don’t let space availability dictate the size of a visualization.
Make important elements larger than the others or add a visual element like an arrow to draw attention.
Align the elements on the report page, either symmetrically or intentionally asymmetrically.

Let’s take a closer look at alignment.

Alignment doesn’t mean that that the different components need to be the same size or that you must have the
same number of components on each row of the report. It just means that there is a structure to the page that aids
in navigation and readability.

We can see in our updated report below that the report components are now aligned on the left and right edges
and each report row is aligned horizontally and vertically as well. Our slicers are to the left of the visuals they
impact.



Figure 2: Our ugly report example improved with layout edits

Power BI includes tools to help you align your visuals. In Power BI Desktop, with multiple visuals selected, you can
use the Align and Distribute options on the Visuals ribbon tab to match up the position of visuals.

Figure 3: Align visuals in Power BI Desktop

In Power BI online and Power BI Desktop, you also have precise control over the size and position of visuals
through the General tab on the formatting pane for all visuals:



Fit to the spaceFit to the space

A d j u s t  t h e  p a g e  s i z eA d j u s t  t h e  p a g e  s i z e

Figure 4: Set exact position for your visual

In our example report page (Figure 2), the 2 cards and large border are aligned on the X Position at 200.

Make the best use of the space you have. If you know how the report will be viewed/displayed, design with that in
mind. Reduce empty space to fill the canvas. Do all you can to eliminate the need for scrollbars on individual
visuals. Fill the space without making the visuals seem cramped.

By reducing the page size, individual elements become larger relative to the overall page. Do this by deselecting
any visuals on the page and using the Page Size tab in the formatting pane.

Here is a report page using page size 4:3 and then using 16:9. Notice how the layout suits 16:9 so much better.
There is even enough room to remove the scrollbar from the second visual.

Figure 5a: The report at 4:3 page size



Reduce clutterReduce clutter

Figure 5b: The report at 16:9 page size ratio

Will your report be viewed 4:3, 16:9 or another ratio? On small screens or huge screens? Or on all possible screen
ratios and sizes? Design with this in mind.

Our example report page seems a bit cramped. With no visual selected, open the formatting pane by selecting the
paintroller icon. Expand Page Size and change Height to 900.

Figure 6: Increase page height

A cluttered report page will be hard to understand at-a-glance and may be so overwhelming that readers won’t
even try. Get rid of all report elements that aren’t necessary. Don’t add bells-and-whistles that don’t help
comprehension or navigation. Your report page needs to convey the information as clearly and quickly and
cohesively as it can.

Edward Tufte calls it “data to ink ratio” in his book The Visual Display of Quantitative Information. Basically,
remove anything that isn’t essential.

The clutter you remove will increase the whitespace on your report page and give you more real estate for
applying the best practices we learned about above in the “Alignment, order, and proximity” section.

Here our example is already looking better. We’ve removed lots of clutter and added shapes to group elements
together. The background image is gone, the unnecessary arrow shape and text box are gone, one visual has been
moved to another page in the report, etc. We’ve also lengthened the page size to increase white (yellow?) space.



Tell a story at a glanceTell a story at a glance

Text boxesText boxes

Figure 7: Our ugly report example de-cluttered

The overall test should be that somebody without any prior knowledge can quickly understand the report without
any explanation from anybody. With a quick glance, readers should be able to quickly see what the page is about
and what each chart/table is about.

When readers look at your report, their eyes should be drawn to the element you want them to look at first and
their eyes will then continue left-right-top-down. Change this behavior by adding visual cues like text box labels,
shapes, borders, size, and color.

Sometimes the titles on visualizations aren’t enough to tell the story. Add text boxes to communicate with the
people viewing your reports. Text boxes can describe the report page, a grouping of visuals, or describe an
individual visual. They can explain results or better-define a visual, components in the visual, or relationships
between visuals. Text boxes can be used to draw attention based on different criteria called out in the text box.

In Power BI service, from the top menubar, select Text Box. (In Power BI Desktop, select Text Box from the Insert
area of the ribbon.)

Figure 8: Add a text box

Type in the empty box and then use the controls at the bottom to set font face, size, alignment, and more. Use the
handles to resize the box.



TextText

ShapesShapes

Figure 9: Format the text box

But don’t overdo it! Too much text on a report is distracting and detracting from the visuals. If you find that your
report page requires a ton of text to make it understandable, then start over. Can you pick a different visual that
tells a better story on its own? Can you tweak the visual’s native titles to make it more intelligible?

Create a text style guide and apply it to all pages of your report. Pick just a few font faces, text sizes, and colors.
Apply this style guide to not only textual elements but to the font choices you make within your visualizations (see
Titles and labels that are part of the visualizations, below). Set rules for when you’ll use bold, italics, increased font
size, certain colors, and more. Try to avoid using all capitalization or underlining.

Shapes too can aid navigation and comprehension. Use shapes to group related information together, highlight
important data, and use arrows to direct the eye. Shapes help readers understand where to start and how to
interpret your report. In design terms, this is often referred to as contrast.

Figure 10a: Shapes in Power BI service



ColorColor

BackgroundsBackgrounds

Figure 10b: Shapes in Power BI Desktop

What does our example page look like now? Figure 11 shows a cleaner, less cluttered page with a consistent use of
text faces, fonts, and colors. Our page title in the top-left corner tells us what the page is all about.

Figure 11: Our report example with text guidelines applied and title added

In our example, a report page title was added in the top left corner; the first place readers look. Font size is 28 and
font is Segoe Bold to help it stand out from the rest of the page. Our text style guide calls for no backgrounds,
black titles, legends, and labels and that was applied to all visuals on the page, where possible (the Combo chart
axes and labels are not editable). Additionally:

Cards: Category label set to Off, Title turned On and set to 12pt black centered.
Visual titles: if turned On, set to 12pt and left-aligned.
Slicers: Header set to Off, Title turned On. Leave Items > Text grey and 10pt.
Scatter and column charts: black font for X and Y axes and X and Y axes titles, if used.

Use color for consistency. We’ll talk more about color in Principles of visual design, below. But here we’re referring
to being deliberate in your selection of color so that it doesn’t detract from your readers being able to quickly
understand your report. Too many bright colors barrage the senses. This section is more what not to do with color.

When setting backgrounds for report pages, choose colors that don’t overshadow the report, clash with other



colors on the page, or generally hurt the eyes. Realize that some colors have inherent meaning. For example, in the
US, red in a report is typically interpreted as “bad”.

Figure 12: Set report background

You’re not creating a work of art, but a functional report. Choose a color that improves the readability and
prominence of the report elements.

A study on the use of color and visualizations within Web pages found that higher contrast between colors
increases the speed of comprehension (The effect of text and background colour on visual search of Web pages*
and *Determining Users’ Perception of Web Page Visual Complexity and Aesthetic Characteristics.)

We’ve applied some color best practices to our example report (Figure 20 and 21) below. The most-notable was
that we changed the background color to black. The yellow was too bright and strained our eyes. Also, on the
“Count of athlete name by year and class” chart, the yellow portion of the bars disappeared into the yellow
background. Using a black (or white) background gives us maximum contrast and makes the visuals the focus of
attention.

Here are the additional steps we took to improve the example report:

Page title

When we changed the background to black, our title disappeared because the text box field only allows black font.
To fix this, add a text box title instead. With the text box selected, erase the text and in the Visualizations tab, select
Title and turn it On. Select the arrow to expand the Title options, type Summer Olympic Games into the Title
Text field and select white Font color.

Figure 13: Add a page title

Cards



For the card visuals, open the formatting pane (paint roller icon) and turn Background On. Select white with a
transparency of 0%. Then turn Title On, select Font color white and Background color black.

Slicers

Up to this point the two slicers had different formatting, which doesn't make design sense. For both slicers, change
the background color to aqua. Aqua is a good choice because it is part of the page’s color palette – you can see it in
the filled map, tree map, and column chart.

Figure 14: Change slicer background color

Add a thin white border.

Figure 15: Add a border to the slicer

The grey font is hard to see against the aqua, so change the Items color to white.

Figure 16: Change slicer font color

And, finally, under Title, change Font color to white and add a black Background color.



Figure 17: Format slicer title

Rectangle shape

The rectangle too has disappeared into the black background. To fix this, select the shape and in the Format shape
pane, turn Background On.

Figure 18: Format the shape

Column charts, bubble chart, filled map, and tree map

Add a white background to the remaining visuals on the report page. From the formatting pane, expand the Line
option and set the Line Color to white and Weight to 3.

Figure 19: Add a white background to remaining visualizations
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Figure 20: Report example with color best practices applied (black background)

Figure 21: Report example with color best practices applied (white background)  

Much of what we would consider aesthetics has already been discussed above: things like alignment, color, font
choices, clutter. But there are a few more best practices for report design worth discussing and these deal with the
overall appearance of the report.

Remember that the function of your report is to meet a business need; not to be pretty. But some level of beauty is
required, especially when it comes to first impressions. Nashville consultant Tony Bodoh explains "Emotion fires a
half-second before logic can kick in." Readers will first react at an emotional level to your report page, before they
take more time to dig deeper. If your page looks disorganized, confusing, unprofessional…your reader may never
discover the powerful story it tells.

TDI blogger and TechTarget industry analyst Wayne Eckerson has a great analogy. Designing a report is like
decorating a room. Over time you purchase a vase, a sofa, end table, a painting. Separately you like all of these
elements. But although each individual selection makes sense, collectively the objects clash or compete for



Principles of visual design

Planning – choose the right visualPlanning – choose the right visual

Choose the right measureChoose the right measure

attention.

Concentrate on:

Creating a common theme or look for your report, and apply it to all pages of the report
Using standalone images and other graphics to support and not detract from the real story
And applying all the best practices we discussed up to this point in the article.

We’ve looked at the principles of report design; how to organize the report elements in a way that makes the
report easy to quickly grasp. Now we’ll look at design principles for visuals themselves. And, in the next section,
we’ll dig down into individual visuals and discuss best practices for some of the more commonly-used types.

In this section, we’re going to leave our example report page alone for a while and look at other examples. After
we’ve gone through the principles of visual design, we’ll return to our example report page and apply what we’ve
learned (with step-by-step instructions).

Just as it’s important to plan out your report before you start building, each visual also requires planning. Ask
yourself “what story am I trying to tell with this visual?” And then figure out which visual type will tell the story
best. You could show progress through a sales cycle as a bar chart but wouldn’t a waterfall or funnel chart tell it
better? For help with this, read the last section of this paper “Visual types and best practices” which describes best
practices for some of the more-common types. Don’t be surprised if the first visual type you pick doesn’t end up
being your best option. Try more than one visual type to see which one makes the point best.

Understand the difference between categorical and quantitative data and know which visual types work best with
what type of data. Quantitative data is often referred to as measures and it’s typically numeric. Categorical data is
often referred to as dimensions and can be classified. This is discussed in more depth in “Choose the right
measure”, below.

Avoid the temptation to use fancy or more-complex visual types just to make your report look more impressive.
What you want is the most-simple option for conveying your story. Horizontal bar charts and simple line charts
can convey information quickly. They are familiar and comfortable and most readers can interpret them easily. An
added advantage is that most people read left-to-right and top-to-bottom and these two chart types can therefore
be scanned and comprehended quickly.

Does your visual require scrolling to tell the story? Avoid scrolling if you can. Try applying filters and making use
of hierarchies/drilldown, and if those don’t eliminate the scrollbar, consider choosing a different visual type. If you
can’t escape scrolling, horizontal scrolling is tolerated better than vertical scrolling.

Even when you choose the absolutely-best visual for the story, you might still need help telling the story. That’s
where labels, titles, menus, color, and size come in. We’ll discuss these design elements later in the section titled
“Design elements”.

Is the story your visual telling compelling? Does it matter? Don’t build visuals for the sake of building visuals.
Maybe you thought the data would tell an interesting story, but it doesn’t. Don’t be afraid to start over and look for
a more-interesting story. Or, maybe the story is there but it needs to be measured in a different way.

For example, say you want to measure the success of your sales managers. What measure would you use to do
this? Would you measure that best by looking at total sales or total profit, growth over previous year or
performance against a target goal? Salesperson Sally might have the largest profit, and if you showed total profit
by salesperson in a bar chart, she would look like a rockstar compared to the other salespeople. But if Sally has a
high cost of sales (travel expenses, shipping costs, manufacturing costs, etc.), simply looking at sales doesn’t tell
the best story.



Reflect reality/don’t distort realityReflect reality/don’t distort reality

Design elementsDesign elements

It’s possible to build a visual that distorts the truth. There’s a website where data enthusiasts share “bad” visuals.
And the common theme in the comments is disappointment in the company that created and distributed that
visual. It sends the message that they can’t be trusted.

So create visuals that don’t intentionally distort reality and that aren’t manipulated to tell the story you want them
to tell. Here is an example:

Figure 22: Distorted reality chart

In this example, it appears as if there is a big difference between the 4 companies, and that CorpB is way more
successful than the other 3. But notice that the X axis doesn’t start at zero and that the differences between the
companies is likely within the margin of error. Here’s the same data with an X axis that does start at zero.

Figure 23: Realistic chart

Readers expect and often assume the X axis is starting at zero. If you decide to not start at zero, do so in a way that
doesn’t distort the results and consider adding a visual cue or text box to point out the deviation from the norm.

Once you’ve selected a type and measure and created the visual, it’s time to fine-tune the display for maximum
effectiveness. This section covers:

Layout, space, and size
Text elements: labels, annotations, menus, titles
Sorting
Visual interaction
Color



Tweaking visuals for best use of spaceTweaking visuals for best use of space

If you’re trying to fit multiple charts into a report, maximizing your data-ink ratio will help make the story in your
data stand out. As mentioned above, Edward Tufte coined ‘data-ink’ ratio: the goal is remove as many marks from
a chart as possible without impairing a reader’s ability to interpret the data.

In the first set of charts below, there are redundant axis labels (Jan 2014, Apr 2014 etc.) and titles (“by Date”). The
titles for each chart also require dedicated horizontal space across each chart. By removing the chart titles and
turning on individual axis labels we remove some ink and have better use of the overall space. We can remove the
axis labels for the top two charts to further reduce ink and use more of the space for data.

If there were particular time periods that you wanted to call out, you could draw lines or rectangles behind all the
charts to help draw the eye up and down to aid comparisons.

Figure 24: Before

Figure 25: After

To turn axis titles on and off

Select the visual to make it active and open the Formatting pane. Expand the options for the X-axis or Y-axis and
drag the slider for Title on or off.
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Figure 26: Turn axis titles on and off

To turn axis labels on and off

Select the visual to make it active and open the Formatting pane. Next to X-Axis and Y-Axis are sliders. Drag the
slider to turn axis labels on or off.

Figure 27: Turn axis labels on and off

One scenario where you might turn Y-axis labels off would be if you had Data labels turned on.

To remove visual titles

Select the visual to make it active and open the Formatting pane. Set the slider for Title to Off.

Figure 28: Remove titles from visuals

Consider how your readers will be viewing the report and ensure your visuals and text are large enough and dark
enough to be read. If you have a proportionally-larger visual on the page, readers may assume it’s the most
important. Put enough space between the visuals that your report doesn’t look cluttered and confusing. Align your
visuals to help direct the eyes of your readers.

To resize a visual

Select the visual to make it active. Grab and drag one of the handles to adjust the size.



Titles and labels that are part of the visualizationsTitles and labels that are part of the visualizations

Figure 29: Resize visual

To move a visual

Select the visual to make it active. Select and hold the gripper bar at the top middle of the visual and drag the
visual to its new location.

Figure 30: Move a visual

Ensure titles and labels are readable and self-explanatory. Text in titles and labels must be an optimal size with
colors that stand out (such as black instead of the default grey). Remember our style guide (see "Text" above)?
Limit the number of colors and sizes -- too many different font sizes and colors make the page look busy and
confusing. Consider using the same font color and size for the title of all visuals on a report page and choose the
same alignment for all titles on a report page.

The formatting pane

For each of the formatting adjustments listed below, select the paint roller icon to open the Formatting pane.

Figure 31: Open the Formatting pane

Then select the visual element to adjust and make sure it is set to On. Examples of visual elements are: X-Axis, Y-
Axis, Title, Data labels, and Legend. The example below shows the Title element.



Titles and labels that are not part of the visualizationsTitles and labels that are not part of the visualizations

Figure 32: Format a visual title

Set the text size

Text size can be adjusted for titles and data labels, but not for X or Y axes or legends. For data labels specifically,
play with the Display units and number of Decimal Places until you find the optimal level of detail for displaying
on your report.

Set the text alignment

The choices for title alignment are left, right, and center. Choose one and apply that same setting to all visuals on
the page.

Set the text position

Text position can be adjusted for some Y axes and for the legend. Whichever you choose, do the same for the other
Y axes and any other legend on the page.

Set the title and label length

Adjust the length of titles, axes titles, data labels, and legends. If you decide to display any of these elements,
adjusting the length (along with text size) ensures that nothing is truncated. For Title and Legend, the setting is
Title Text and this is where you type in the actual title that will appear on the visual. For X-Axis and Y-Axis, the
setting is Style and you select from a dropdown. For Data labels, the settings are Display and Decimal. Use the
Display dropdown to select the units of measurement: millions, thousands, none, auto, etc. Use the Decimal field
to tell Power BI how many decimal places to display.

Set the text color

Text color can be adjusted for titles, axes, and data labels.

Earlier in this paper we discussed adding text boxes to report pages. Sometimes the titles on visualizations aren’t
enough to tell the story. Add text boxes to communicate additional information to the readers of your reports.
To keep your report page from looking too confusing or too busy, be consistent in your use of text box fonts, sizes,
colors, and alignment. To make an adjustment to the text in a text box, select the text box to reveal the formatting
menu.
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Chart interaction and interplayChart interaction and interplay

TIPTIP

The use of color in visualsThe use of color in visuals

Figure 33: Format the font used in a text box

A really simple opportunity to provide faster insight is to set the sorting of visuals. For example, sorting bar charts
in descending or ascending order based on the value in the bars enables you to quickly show significant
incremental information without using more real estate.

To sort a chart, select the ellipses (…) in the top right of the chart, select Sort and choose the field you want to sort
by and the direction. For more information, see Change how a visual is sorted.

One of the most compelling feature of Power BI is the ability to edit the way charts interact with each other. By
default, charts are cross-highlighted: when you select a data point, the related data of other charts light up and the
unrelated data dims. You can override this behavior to use any chart as a true filter which saves you real estate on
your page. To do this, select Visual Interactions from the menubar.

Figure 34: Visual interactions

Then, for each visual on the page, decide whether you want the selected visual to filter, highlight, or do nothing.
Not all visuals can be highlighted, and for those the highlight control won't be available. For more information, see
Visual interactions in Power BI.

For readers who’re new to Power BI, this ability to click and interact with reports may not be instantly obvious. Add text
boxes to help them understand what they can click on to find more insights.

Earlier in this paper we talked about the importance of having a plan for how you’re going to use color across a
report. This section will have some overlap but primarily applies to how you use color in individual visuals. And the
same principles apply: use color to tie the report together, add emphasis to important data, and to improve the
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reader’s comprehension of the visual. Too many different colors is distracting and makes it difficult for the reader
to know where to look. Don’t sacrifice comprehension for beauty. Only add color if it improves comprehension.

Know your audience and any inherent color rules. For example, in the United States, green typically means “good” and red
typically means “not good”.

This topic is broken down to cover:

1. Data color
2. Data label color
3. Color for categorical values
4. Color for numerical values

Use colors to highlight interesting data

The simplest way to use color is by changing one or more data point’s color to call attention to it. In this example,
the color changes when the Olympic games moved from a 4-year cycle to a 2-year cycle of alternating Summer
and Winter games.

Figure 35: Use color to tell a story

You can change data point colors from the Data colors tab in the formatting pane. To customize each data point
individually, make sure Show all is set to On.

Figure 36: Set data point colors



NOTENOTE
Power BI applies a default theme to your report visuals. The theme colors have been chosen to provide variety and contrast.
To divert from the default theme palette, select Custom color.

Figure 37: Choose a custom color

In Power BI Desktop, you can even highlight outliers or a section of a line by using a second series:

Figure 38: Using Desktop to plot outliers

Here, values in the ‘Outliers’ series only exist where the average August temperature drops below 60. This was
done by creating a DAX calculated column using this formula:

Outliers = if(Editions[Temp]<60, Editions[Temp], BLANK())

In our example, there were 3 outliers: 1952, 1956, and 2000.

Colors for labels and titles

As you explore all the formatting options available to you, you’ll find many different places to add color to titles
and legends. For example, you can change the color of data labels and axes titles. Proceed with caution. Generally,
you want to use a single color for all visual titles. As with all the guidelines in this paper, there are always situations
and reasons to “break the rules”, but if you do decide to break the rules, do it for a good reason.

Colors for categorical values

Charts with a series typically have a categorical value in the legend. For example, each color in the legend below
represents a different category of Country/Region.



Figure 39: Default colors applied

The colors Power BI uses by default were chosen to provide a good color separation between categorical values so
they are easy to distinguish. Sometimes people change these colors to match their corporate scheme etc. but it can
lead to problems.

Figure 40: Color applied as hues of a single color

By sticking to a single hue and varying the intensity of the color, this visual has introduced a false sense of
ordering between the categories. It implies the darker bubbles are higher or lower on some scale than the lighter
hues. Other than alphabetical, there’s normally no inherent order in this sort of categorical value. To change the
default colors, open the Formatting pane, and select Data colors.

Colors for numerical values

For fields that do have some inherent order and numerical value, you can also color data points by the value. This
can be helpful to show the spread of values across the data, and also allow for two variables to be shown on a
single chart. For example this chart makes it clear that although China has the highest medal count, Japan and
Thailand have participated in more Olympic games.

Figure 41: Color data points by the value

To create this chart, add a value to the Color saturation field and then adjust those colors in the Formatting pane.
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Figure 42: Add a color saturation field

Figure 43: Adjust the colors used for saturation

Color can also be used to emphasize variance around a central value. For example, coloring positive values green
and negative values red. Be aware of cultural differences when assigning colors to positive or negative values; not
all cultures use red for bad and green for good!

Figure 44: Color to emphasize variance around central value  

Now let’s take the visual principles discussed above and apply them to our sample report.

Before



What did we do?What did we do?

Figure 45: Our example report (before)

After

Figure 46: Our example report (after)

1. Slicer: removed blanks from the slicers by adding a page level filter and selecting only gold, silver, bronze.
Changed Selection Controls to Off for Single Select and Select All.

2. Bubble: there are so many items in the legend that they scroll off the screen. Removed the legend and turned
on Category labels instead. Customers can hover over the bubbles to see the details. Shortened the title and
removed “by countryregion” since that seems self-evident. Turned axes labels On for both to make the chart
easier to understand.

3. Filled map: changed the Data colors to make it stand out more. Turned Diverging on and set the Minimum
to pink and the Maximum to red.

4. Tree map: removed filter which was set for only USA. Set the Data labels to 1 decimal place. The visual was
using the Class field which isn’t very useful since it will almost always be 33% (Gold/Silver/Bronze). Selected a
different more-interesting field, gender. Changed Aquatics to blue and Athletics to grey for design.



Visual types and best practices

Line chartsLine charts

Best practicesBest practices

5. Top bar chart: shortened the title, removed data labels, turned legend title off. Changed word order of title to
match the chart below.

6. Bottom bar chart: sorted by year ascending to match chart above. Changed colors to match class. Changed title.
Turned off legend for more space for data. Turned on data labels which won't show up in the report (because
the visual is too small for the labels to be readable) but will show when the visual is opened in Focus mode.
Learn about Focus mode. Added Count of Event (Distinct) to Tooltips so now when you hover over a stacked
column, the tooltips also tell you how many events were contested that year.

7. Visual Interactions: turned off interactions for both cards since I always want them to show total games and
sports.

Power BI provides many visual types natively. To these, add the custom visuals available from Microsoft and from
the Power BI community and total visual options become too numerous to document here. But let’s look at some
of the most-used native visual types.

Line charts are a powerful way to look at data over time. Looking at data in tables doesn’t really take advantage of
the speed in which our eyes spot peaks, valleys, cycles, and patterns.
The example below shows the trends in the number of medals awarded and the number of athletes winning those
medals.

Figure 47: Line charts

When people look at line charts, the first thing they see is the shape of the curve. This means that you need to
have an x-axis that makes the curve meaningful such a time or distribution categories. If you put categorical
fields like product or geography on the x-axis, the line chart will not be interesting as the shape of the curve



would provide no meaningful information.
If you choose to place multiple charts above and below each other like this, to make it easier to compare across
series, line up the X-axis. Use filters to make sure that the same range of values is shown. For example, if you’re
looking at date ranges, ensure they are the same date ranges. For example, 1896 to 2012 on both charts.
Make full use of the space. If it makes sense for your data, set the start and end points for the Y-axis to
eliminate empty space at the top and bottom of your chart and to focus in on the actual data points. To do
this, select the paint roller icon to open the Formatting pane. Expand the Y-Axis area and set the Start and
End points.

Figure 48: Set the start and end points

Another reason to explicitly set the Start and End points is if you’re comparing two or more charts on the
same page using the same Y-axis field. For example, if you’re looking at cumulative event counts, and the
United Kingdom has counts that range from 1 to 70 and Australia has counts that range from 1 to 12, the 2
line charts will display very different Y-axes (Figure x). This makes it difficult to compare at a glance. Instead,
set the charts to use the same Y-axis range (Figure x).

Figure 49:Line charts with different y-axes



Bar/Column ChartsBar/Column Charts

Figure 50:Line charts with matching y-axes

For more information, see:

Customize the X and Y axes
Line charts and irregular intervals
Line charts 101

If line charts are the standard for looking at data over time, bar charts are the standard for looking at a specific
value across different categories. If you sort the bars based on the number, you will instantly see the top values
and distribution. Horizontal bar charts work well with long-ish labels.

http://www.perceptualedge.com/articles/visual_business_intelligence/line_graphs_and_irregular_intervals.pdf
http://www.columnfivemedia.com/data-visualization-101-line-charts
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Figure 51: Horizontal bar chart

Display data labels for values. This makes it easier to identify specific values. To do this, open the Formatting
pane, and set Data labels to On.



Stacked Bar/Column ChartsStacked Bar/Column Charts

The bar chart above is really useful to compare one measure against many at a single point in time. While
the line chart above showed us the trend over time, the bar chart shows us the trend for a single category at a
specific point in time. At a glance, our bar chart shows us Spain has one of the worst unemployment rates in the
world, at 25%.

Figure 52: Turn on data labels

When an entire Bar/Column chart doesn’t fit into the allotted space, Power BI adds scrollbars. When
possible, and if it makes sense, structure the visual and report to show the entire chart so the reader gets an
overview of the entire distribution. Unfortunately this is not possible in our example given the significant
number of countries around the world.

One way to limit the values included is to use a filter. For example, add a Visual level filter that shows the
country only if unemployment rate is above 20%.

Bar/Column charts can be drilled down (and back up again). This is a great way to pack more information
into a visual without taking up more real estate. The example below has a hierarchy for Regions >
Countries. Double-clicking a region bar drills down to the countries that make up that region. For more
information on drill, see Drill down in a visualization.

Figure 53: Drill down

For more details on Bar and Column charts:

Bar charts 101
Data Visualization Catalogue: Bar Chart
Data Visualization Catalogue: Multi-set Bar Chart

http://blog.newscred.com/article/data-visualization-101-bar-charts/3c53044d4add7c31e79a3f80128771f4?page=thankyou
http://www.datavizcatalogue.com/methods/bar_chart.html#.VYV-hY3bLJw
http://www.datavizcatalogue.com/methods/multiset_barchart.html#.VYV_gI3bLJw
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Add another dimension to your bar/column charts by stacking different categories within the bar or column. Now
the chart conveys information about one overall trend (based on height/length) but also shows the influence of the
categories on that trend. The chart below shows the overall growth of Top soccer team revenue above 6 billion in
2014.

Figure 54: Stacked column chart

This stacked column chart shows us that total revenue is growing over time and that the Commercial and the
Broadcasting categories are increasing steadily over time – contributing to overall revenue increase. But this chart
doesn’t make it easy to compare the impact each of the 3 categories has on each other. For example, how does the
growth of Commercial compare to the growth of Broadcasting or Match Day? A better choice for this data, or a
companion visual for this data, would be a line chart.

Figure 55: Convert to a line chart

In this line chart it is easier to see how commercial revenue has grown the most followed by broadcast and match
day.

As with columns/bars, you have the option of horizontal or vertical display. Horizontal is a better choice if you



Combo Bar/Column ChartsCombo Bar/Column Charts

have long labels and vertical if you have time series data.
Avoid stacked Bar/Column charts if you want to show trends and other patterns of change over time. Other
charts, like Line charts, do a much better job.
You can also have the distribution based on total volume or as a % of total.
As Few noted it is difficult to compare the segments of a stacked bar. If the segments were arranged side-by-
side and all grew upwards from the same baseline, it would be easy to compare their heights, but when stacked
upon one another, the task becomes hard. Plus, although it’s fairly easy to see how (revenue) changed from
month to month it is quite difficult to see how (revenue) in the other (categories) changed.
100% Stacked charts are a good choice when using percentages that add up to 100. In the example below,
we see the category distribution by team. The percentages are relative and allows us to, at a glance, see
patterns. For example, Everton’s revenue comes primarily from Broadcasting (over 70%) while PSG only
derives 20% of its revenue from Broadcasting. The choice of a horizontal display makes it easier to fit the
team labels and to see the impact of revenue type.

Figure 56: Horizontal stacked chart

For more information on stacked charts:

Data Visualization Catalogue: Stacked bar graphs
When are 100% stacked bar graphs useful?

In Power BI, you can combine column and line charts into a combo chart. The choices are: Line and Stacked
Column chart and Line and Clustered Column chart. Save valuable canvas space by combining two separate
visuals into one.

The two screenshots below show a before and after. The first page has two separate visuals: a Column chart
showing population over time and a Line chart showing GDP over time. These charts are a good candidate for a
Combo chart because they have the same X-Axis (year) and values (2002 through 2012). Why not combine them
to compare these 2 trends on a single visual? Combining these 2 charts lets you make a quicker comparison of the
data.

The new report page has a single visual: a line and stacked column chart. We could’ve just as easily created a line
and clustered column chart. It’s now easier to look for a relationship between the two trends. We can see that up
until 2008, population and GDP followed a similar trend. But starting in 2009, as population growth flattened, GDP

http://www.datavizcatalogue.com/methods/stacked_bar_graph.html#top
http://www.perceptualedge.com/blog/?p=2239
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was more volatile.

Figure 57: As two separate charts

Figure 58: As a single combo chart

Combo charts work best when both visuals have at least one axis in common.

Watch your axes! Is your Combo chart easy to read and interpret? Or does it use dissimilar ranges and values? For
example, if the scale of the column chart’s Y-Axis is much smaller than the scale of the line chart’s Y-Axis, your
combo chart won’t be meaningful. For example, notice the third line (aqua color) way down at the bottom.



Figure 59: An unsuccessful line chart

So too, your combo chart won’t be meaningful if your column chart and line chart use 2 different measures and
you don’t create dual axes. For example, dollars versus percent. Be sure to include both axes to help the reader
understand the chart and consider adding axes labels as well.

To do this, open the Formatting pane, expand Y-Axis and set Show Secondary to On (if it isn’t already on). This
setting is sometimes difficult to find; expand Y-Axis (Column) and scroll down until you see Show secondary.
Also, set the Y-Axis (Column) Title to On and set the Y-Axis (Line) Title to On.

Figure 60: Show secondary axis

Figure 61: Create a combo chart instead

Take advantage of dual axes. It’s a great way to compare multiple measures with different value ranges. And it’s
a great way to illustrate the correlation between two measures in one visual.



Scatter ChartScatter Chart

Best practicesBest practices

For more information:

Tutorial: Combo chart in Power BI
The danger of dual-scaled Axes in visuals

Sometimes we have many variables that we want to see together, and a scatter chart can be a very useful way to
get an overall picture. Scatter charts display relationships between 2 (Scatter) or 3 (Bubble) quantitative measures.
A scatter chart always has two value axes to show one set of numerical data along a horizontal axis and another set
of numerical values along a vertical axis. The chart displays points at the intersection of an x and y numerical value,
combining these values into single data points. These data points may be distributed evenly or unevenly across the
horizontal axis, depending on the data.

A bubble chart replaces the data points with bubbles, with the bubble size representing an additional dimension of
the data.

The bubble chart below looks at South America and compares GDP per capita (Y-Axis) sum of GDP (X-Axis) and
population by South American country. The size of the bubbles represents total population for that country. Brazil
has the largest population (bubble size) and the largest share of South America’s GDP (it is farthest along on the X-
Axis). But notice that GDP per capita for Uruguay, Chile, and Argentina is higher than Brazil (farther up on the Y-
Axis).

Figure 62: South America GDP and population as a bubble chart

If you add a play axis, you can pretend you are Hans Rosling and tell the story over time
(https://www.youtube.com/watch?v=PbaDBJWCeD4). To add a play axis, drag a datetime field into the Play Axis
well.

Scatter and Bubble charts are great storytellers. But they are not as useful when trying to explore data. This is
what Stephen Few points out in the paragraph below The strength of this approach is when it’s used to tell a
story. When Rosling narrates what’s happening in the chart as the bubbles move around and change in value,

http://www.perceptualedge.com/articles/visual_business_intelligence/dual-scaled_axes.pdf
https://www.youtube.com/watch?v=PbaDBJWCeD4
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pointing to what he wants us to see, the information comes alive. Animated bubble charts, however, are much
less effective for exploring and making sense of data on our own. I doubt that Rosling uses this method to
discover the stories, but only to tell them once they’re known. We can’t attend more than one bubble at once as
they’re moving around, so we’re forced to run the animation over and over to try to get a sense of what’s going
on. We can add trails to selected bubbles, which make it possible to review the full path these bubble have
taken, but if trails are used for more than a few bubbles the chart will quickly become too cluttered. Essentially,
what I’m pointing out is that this is not the best way to display this information for exploration and analysis.

Add X and Y axes labels to help tell the story. Especially with bubble charts, there are many components at play
and labels help readers understand the visual.
Add data labels to make the visual easier to interpret. Especially with bubble charts, when you have many items
in the Legend, it may be difficult to distinguish between similar colors. In the visual above, the legend colors for
Suriname, Columbia, and Ecuador are very similar.
Did you create a scatter chart and see only one data point that aggregates all the values on the X and Y axes?
Or, your chart aggregates all the values along a single horizontal or vertical line? To fix this, add a field to the
Details area to tell Power BI how to group the values. The field must be unique for each point you want to plot.
For help, refer to the Power BI scatter and bubble chart tutorial.

Tree maps can be very useful for giving a good overview of the relative size of different components that make up
a whole -- especially when you can group them by categories. Any time I try to understand a new business, having
a tree map of the main components can be very useful in knowing the overall distribution.

In the first chart below, you can see right away that Brazil makes up approximately half of South America’s GDP
and that Venezuela and Argentina are roughly the same size.

If you want to have broader context and still have an idea of the impact of the top contributing countries, you can
create visual hierarchies with category members (countries) nested inside regions. The second tree map gives us
an idea, first and foremost, of the relative size of the regions and then, within each region, we can see which
individual countries contribute the most. We see that there are three massive regions (Europe, Asia & North
America) and within those we can easily see the top countries/regions.

The main limitation of a tree map is the limited ability to compare the different rectangles beyond the top ones. It
is a good chart for an overview but column and bar chart are probably a better choice to have more precise idea of
the relative size of different components.   For example, the first tree map gives a broad indication of the order of
the GDP size, but it’s hard to identify specific differences between countries, particularly the smaller unlabeled
boxes. For this data, where a single grouping is compared, a bar or column chart might be a better choice.



Other chartsOther charts
Pie or Donut ChartsPie or Donut Charts

Figure 63: South America GDP comparison as a tree map

Here we’ve added another level of data, region, and we can see the overall contribution to GDP by regions, as well
as the relative impact within the regions. Beware that doing this with non-summative measure (such as averages)
that the sum of the details might not represent the actual value at the aggregate level.

Figure 64: GDP by region and country as a tree map

For more information on tree maps, feel free to click on links below.

Treemaps overview
Data Visualization Catalogue: Tree maps

http://www.perceptualedge.com/articles/b-eye/treemaps.pdf
http://www.datavizcatalogue.com/methods/treemap.html#.VYhylI3bL7Y


Radial Gauges & KPIsRadial Gauges & KPIs

Conclusion

Book recommendationsBook recommendations

In general, bar/column/line charts will serve most purposes. It’s well understood that pie and donut charts are
difficult for humans to interpret correctly, and in fact can often distort data. Avoid them where possible. Stephen
Few has an excellent write up on the history and dangers in [Save the Pies for Dessert]
(www.percetualedge.com/articles/08-21-07.pdf

He does explain the one time where pie charts can be useful, when comparing part-to-whole relationships. But
even this is rarely significantly-better than, say, a 100% stacked bar chart.

Another fun article (and animation) about pie charts can be found on the Darkhorse Analytics site.

Or read an opposing point of view, Why Tufte is flat-out wrong about pie charts

Radial gauges seem like a good visual for indicating performance against a target, and they are very popular in
executive dashboards. However, they suffer in two main ways. As with pie charts, it’s difficult to interpret the angle
of the shaded area compared to the full 180 degree arc or target line. It also uses a lot of space to show a single
metric.

A good alternative is a simple KPI visual

KPIs show the value, status, goal, variance from the goal and trend in the same amount of space. The green
coloring turns red if the target isn’t being met and can be yellow if some intermediate target is hit. It’s much
simpler to read and interpret than the gauge.

For more information, see:

Tutorial: Radial gauge charts in Power BI
Tutorial: KPIs in Power BI

Now it’s time for you to put these best practices to the test. Keep in touch and share your own best practices. Don’t
agree with our recommendations or found a great reason to “break the rules?” We’d love to hear about those as
well.

http://www.perceptualedge.com/articles/08-21-07.pdf
http://www.darkhorseanalytics.com/blog/salvaging-the-pie
http://speakingppt.com/2013/03/18/why-tufte-is-flat-out-wrong-about-pie-charts/


There are many good books available today to help teams bone up on visual design techniques. Stephen Few’s
Information Dashboard Design book is a must-read. He delves into greater detail in two other books, Show Me the
Numbers and Now You See It. Few and others have drawn inspiration from Edward R. Tufte, whose book The
Visual Display of Quantitative Information is considered a classic in the field. Tufte has also written Visual
Explanations, Envisioning Information, and Beautiful Evidence. Andy Kirk’s new book Data Visualization: A
Handbook for Data Driven Design is another great option. Some other authors who have been recommended are:
Lachlan James, William McKnight, and Boris Evelson (Forrester), Darkhorse Analytics.

More questions? Try the Power BI Community

http://community.powerbi.com/


Custom visuals in Power BI
11/21/2017 • 3 min to read • Edit Online

Two types of custom visuals

Download or import custom visuals from Microsoft AppSource

Import custom visuals from within Power BIImport custom visuals from within Power BI

When creating or editing a Power BI report, there are many different types of visuals available for you to use.
These visuals display in the Visualizations pane. When you download Power BI Desktop or open Power BI
service (app.powerbi.com), this set of visuals comes "pre-packaged."

But you are not limited to this set of visuals, selecting the ellipses opens up another source of report visuals:
custom visuals.

Custom visuals are created by members of the community and by Microsoft and are hosted on AppSource. These
visuals can be downloaded and added to Power BI reports. All of these custom visuals have been approved by
Microsoft and they behave similar to the pre-packaged visualizations included with Power BI; they can be filtered,
highlighted, edited, shared, etc.

What is AppSource? Simply put, it is the place to find apps, add-ins, and extensions for your Microsoft software.
AppSource connects millions of users of products like Office 365, Azure, Dynamics 365, Cortana, and Power BI to
solutions that help them get work done more efficiently, more insightfully, or more beautifully than before.

The Power BI custom visuals available from AppSource fall into 2 categories: approved and certified. AppSource
approved visuals can be run in browsers, reports, and dashboards. Power BI certified visuals have passed rigorous
testing, and are supported in additional scenarios, such as email subscriptions, and export to PowerPoint.

To see the list of certified custom visuals or to submit your own, see Certified custom visuals.

Are you a Web developer and interested in creating your own visualizations and adding them to AppSource? See
Get started with Developer Tools and learn how to publish custom visuals to AppSource.

You have two options for downloading and importing custom visuals; from within Power BI and from the
AppSource website.

1. Select the ellipses from the bottom of the Visualizations pane.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/power-bi-custom-visuals.md
https://appsource.microsoft.com/marketplace/apps?product=power-bi-visuals
https://appsource.microsoft.com
https://appsource.microsoft.com/marketplace/apps?product=power-bi-visuals


2. From the dropdown, select Import from store.

3. Scroll through the list to find the visual to import.

4. To learn more about one of the visuals, highlight and select it.

5. On the detail page you can view screenshots, videos, detailed description and more.



Download and import custom visuals from Microsoft AppSourceDownload and import custom visuals from Microsoft AppSource

6. Scroll to the bottom to see reviews.

7. Import the custom visual by selecting Add. The icon for the custom visual is added to the bottom of your
Visualizations pane and is now available for use in your report.

1. Start at Microsoft AppSource and select the tab for Apps.

2. This takes you to the Apps results page where you can view top apps in each category, including Power BI
Apps. But we're looking for custom visuals, so let's narrow down the results by selecting Power BI visuals
from the left navigation list.

https://appsource.microsoft.com
https://appsource.microsoft.com/en-us/marketplace/apps


3. AppSource displays a tile for each custom visual. Each tile has a snapshot of the custom visual and gives a
brief description and a download link. To see more details, select the tile.

4. On the detail page you can view screenshots, videos, detailed description and more. Dowload the custom
visual by selecting Get it now and then agreeing to the Terms of use.

5. Select the link to download the custom visual.



The download page also include instructions on how to import the custom visual into Power BI Desktop
and Power BI service.

You can also download a sample report that includes the custom visual and showcases its capabilities.

6. Save the .pbiviz file and then open Power BI.

7. Open the report where you'd like to add the custom visual and from the bottom of the Visualizations
pane select the ellipses > Import from file.

8. Select the custom visual file to add the icon for that custom visual to the bottom of your Visualizations
pane. The custom visual is now available for use in your report.



Considerations and troubleshooting
A custom visual is added to a specific report when imported. If you'd like to use the visual in another
report, you need to import it into that report as well. When a report with a custom visual is saved using the
Save As option, a copy of the custom visual is saved with the new report.

If you don't see a Visualizations pane, that means you do not have edit permissions for the report. You
can only add custom visuals to reports you can edit, not to reports that have been shared with you.

More questions? Try the Power BI Community

http://community.powerbi.com/


Part I, Add visualizations to a Power BI report
(Tutorial)
1/8/2018 • 1 min to read • Edit Online

Open a report and add a new page

Add visualizations to the report

This article gives a quick introduction to creating a visualization in a report. For more-advanced content, please
see Part II. Watch Amanda demonstrate a few different ways to create, edit, and format visuals on the report
canvas. Then try it out yourself using the Sales and Marketing sample to create your own report.

1. Open a report in Editing View. This tutorial uses the Sales and Marketing sample.

3. Add a blank page to the report.

2. If the Fields pane isn't visible, select the arrow icon to open it.

1. Create a visualization by selecting a field from the Fields pane.

Start with a numeric field like Sales > Sales $: Power BI creates a column chart with a single column.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/power-bi-report-add-visualizations-i.md


Start with a category field, such as Name or Product: Power BI creates a Table and adds that field to the
Values well.

Start with a geography field, such as Geo > City. Power BI and Bing Maps create a map visualization.

2. Create a visualization and then change its type. Select Product > Count of Product and Product >
Category to add them to the Values well.



Next steps

3. Change the visualization to a column chart by selecting the column chart icon.

4. When you create visualizations in your report, you can pin them to your dashboard. To pin the

visualization, select the pin icon .

5. Now you can:

Continue on to Part 2: Add visualizations to a Power BI report

Interact with the visualizations in the report.

Do even more with visualizations.

Save your report.

More about Visualizations in Power BI reports.

Reports in Power BI

More questions? Try the Power BI Community

http://community.powerbi.com/


Part 2, Add visualizations to a Power BI report
(Tutorial)
1/24/2018 • 1 min to read • Edit Online

PrerequisitesPrerequisites

Create a new visualization

Open a report and add a new blank page.Open a report and add a new blank page.

Add a visualization that looks at this year's sales compared to last year.Add a visualization that looks at this year's sales compared to last year.

In Part 1, you created a basic visualization by selecting checkboxes next to field names. In Part 2 you'll learn how to
use drag-and-drop and make full use of the Fields and Visualizations panes to create and modify visualizations.

Part 1
Power BI service - visualizations can be added to reports using Power BI service or Power BI Desktop. This
tutorial uses Power BI service.
Retail Analysis sample

In this tutorial we'll dig into our Retail Analysis dataset and create a few key visualizations.

1. Open the workspace where you saved the Retail Analysis sample. Select Retail Analysis Sample to open
the report in Reading View.

2. Select Edit Report to open the report in Editing View.

3. Add a new page by selecting the yellow plus icon at the bottom of the canvas.

1. From the Sales table, select This Year Sales > Value and Last Year Sales. Power BI creates a column
chart. This is somewhat interesting, and you want to dig deeper. What do the sales look like by month?

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/power-bi-report-add-visualizations-ii.md


2. From the Time table, drag Month into the Axis area.

3. Change the visualization to an Area chart. There are many visualization types to choose from - see descriptions
of each, tips for best practices, and tutorials for help deciding which type to use. From the Visualizations pane,
select the Area chart icon.

4. Sort the visualization by selecting the ellipses and choosing Sort by Month.

6. Save the report.

5. Resize the visualization by selecting the visualization, grabbing one of the outline circles and dragging.
Make it wide enough to eliminate the scrollbar and small enough to give us enough room to add another
visualization.



Add a map visualization that looks at sales by locationAdd a map visualization that looks at sales by location
1. From the Store table, select Territory. Power BI recognizes that Territory is a location, and creates a map

visualization.

2. Drag Total Stores into the Size area.

3. Add a legend. To see the data by store name, drag Chain into the Legend area.



Next steps
For more information about the Fields pane, see The report editor... take a tour.
To learn how to filter and highlight your visualizations, see Filters and highlighting in Power BI reports.
More about Visualizations in Power BI reports.
More questions? Try the Power BI Community

http://community.powerbi.com/


Show the data that was used to create the
visualization
1/8/2018 • 1 min to read • Edit Online

Show Data

NOTENOTE

Using Show Data in Power BI service

A Power BI visualization is constructed using data from your datasets. If you're interested in seeing behind-the-
scenes, Power BI lets you display the data that is being used to create the visual. When you select Show Data,
Power BI displays the data below (or next to) the visualization.

You can also export the data that is being used to create the visualization as an .xlsx or .csv file and view it in Excel.
For more information, see Export data from Power BI visualizations.

Show Data and Export Data are both available in Power BI service and Power BI Desktop. However, Power BI Desktop
provides one additional layer of detail; Show Records displays the actual rows from the dataset.

1. In Power BI service, open a report in Reading view or Editing view, and select a visual. In Power BI Desktop,
open Report view.

2. To display the data behind the visual, select Explore > Show data.

3. By default, the data displays below the visual.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-reports-show-data.md


Next stepsNext steps

6. To hide the data, de-select Explore > show data.

4. To change the orientation, select vertical layout  from the top-right corner of the visualization.

5. To export the data to a .csv file, select the ellipses and choose Export data.

For more information on exporting the data to Excel, see Export data from Power BI visualizations.

Export data from Power BI visualizations
Visualizations in Power BI reports
Power BI reports
Power BI - Basic Concepts
More questions? Try the Power BI Community

http://community.powerbi.com/


Export data from visualizations
1/23/2018 • 4 min to read • Edit Online

From a visualization on a Power BI dashboard

If you'd like to see the data that is used to create a visualization, you can display that data in Power BI or export
that data to Excel as an .xlsx or .csv file.

Watch Will export the data from one of the visualizations in his report, save it as an .xlsx file, and open it in Excel.
Then follow the step-by-step instructions below the video to try it out yourself.

3. The data is exported to a .csv file. If the visual is filtered, then the downloaded data will also be filtered.

1. Select the ellipses in the top right corner of the visualization.

2. Choose the Export data icon.

4. Your browser will prompt you to save the file. Once saved, open the .csv file in Excel.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/power-bi-visualization-export-data.md


From a visualization in a report
To follow along, open the Procurement analysis sample report in Editing view. Add a new blank report page. Then
follow the steps below to add an aggregation and a visualization-level filter.

1. Create a new column chart. From the Fields pane, select Location > City and Invoice > Discount
Percent. You may have to move Discount Percent into the Value well.

2. Change the aggregation for Discount Percent from Count to Average. In the Value well, select the arrow
to the right of Discount Percent (it may say Count of Discount Percent), and choose Average.

3. Add a filter to City to remove Atlanta.



Now we're ready to try out both options for exporting data.

4. Select the ellipses in the top right corner of the visualization. Choose Export data.

5. If your visualization has an aggregate (one example would be if you changed Count to average, sum or
minimum), you'll have two options: Summarized data and Underlying data. For help understanding
aggregates, see Aggregates in Power BI.

6. Select Summarized data > Export and choose either .xlsx or .csv. Power BI exports the data. If you have
applied filters to the visualization, the exported data will export as filtered. When you select Export, your
browser prompts you to save the file. Once saved, open the file in Excel.

Summarized data: select this option if you don't have an aggregate or if you do have an aggregate but
don't want to see the complete breakdown. For example, if you have a bar chart showing 4 bars, you will
get 4 rows of data. Summarized data is available as .xlsx and .csv.

In this example, our Excel export shows one total for each city. Since we filtered out Atlanta, it is not
included in the results. The first row of our spreadsheet shows the filters that were used when extracting
the data from Power BI.



Limitations and considerations

WARNINGWARNING

7. Now try selecting Underlying data > Export and choosing .xlsx. Power BI exports the data. If you had
applied filters to the visualization, the exported data will export as filtered. When you select Export, your
browser prompts you to save the file. Once saved, open the file in Excel.

Exporting underlying data allows users to see all the detailed data -- every column in the data. Power BI service
administrators can turn this off for their organization. If you are a dataset owner, you can set proprietary columns to
"hidden" so that they don't show up in the Field list in Desktop or Power BI service.

Underlying data: select this option if your visualization does have an aggregate and you'd like to see all the
underlying details. Basically, selecting Underlying data removes the aggregate. When you select Export, the data
is exported to an .xlsx file and your browser prompts you to save the file. Once saved, open the file in Excel.

In this example, our Excel export shows one row for every single City row in our dataset, and the discount percent
for that single entry. In other words, the data is flattened and not aggregated. The first row of our spreadsheet
shows the filters that were used when extracting the data from Power BI.

The maximum number of rows that can be exported from Power BI Desktop and Power BI service to .csv is
30,000.
The maximum number of rows that can be exported to .xlsx is 150,000.
Export using Underlying data will not work if the data source is an Analysis Services live connection and the
version is older than 2016 and the tables in the model do not have a unique key.
Export using Underlying data will not work if the Show items with no data option is enabled for the
visualization being exported.
When using DirectQuery, the maximum amount of data that can be exported is 16 MB. This may result in
exporting less than the maximum number of rows, especially if there are many columns, data that is difficult to
compress, and other factors that increase file size and decrease number of rows exported.
Power BI only supports export in visuals that use basic aggregates. Export is not available for visuals using
model or report measures.
Custom visuals, and R visuals, are not currently supported.



Next steps

Export data is not available for users outside of your organization who are using a dashboard that has been
shared with them.

Power BI admins have the ability to disable the export of data.

If there is unicode character in the .csv file, the text in Excel may not display properly. Although, opening it
in Notepad will work fine. Examples of unicode characters are currency symbols and foreign words. The
workaround for this is to import the csv into Excel, instead of opening the csv directly. To do this:

1. Open Excel
2. From the Data tab, select Get external data > From text.

Dashboards in Power BI
Reports in Power BI
Power BI - Basic Concepts

More questions? Try asking the Power BI Community

http://community.powerbi.com/


Change the type of visualization in a Power BI report
12/20/2017 • 1 min to read • Edit Online

NOTENOTE

Next stepsNext steps

Try different types of visualizations in Power BI service and Power BI Desktop to see which one illustrates your
data best.

1. Open a report that already has at least one visualization.
2. In the Visualizations pane, select the new visualization type.

You can pin your visualization to your dashboard as a tile.

If you changed the visualization type in the report after you pinned it to your dashboard, the tile does not
automatically update. So, if you pinned the visualization as a line chart and then, in the report, changed it to a bar
chart, the already-pinned version of this data will remain a line chart. Pin the bar chart to see it too on the
dashboard.

More about Visualizations in Power BI reports

Power BI - Basic Concepts

More questions? Try the Power BI Community

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/power-bi-report-change-visualization-type.md
http://community.powerbi.com/


Getting started with color formatting and axis
properties
12/6/2017 • 3 min to read • Edit Online

In Power BI, you can change the color of data series, data points, and even the background of visualizations. You
can also change how the x-axis and y-axis are presented, providing you with full control of how your dashboards
and reports appear.

To get started, select a Report from the My Workspace pane. Then from the top menu area, select Edit Report.

When you’re editing a report and you have a visualization selected, the Visualizations pane appears which lets
you add or change visualizations. Directly below the available visualizations are three icons: the Fields icon (a
stack of bars), the Format icon (a roller brush), and the Analytics icon (a magnifying glass). In the image below
the Fields icon is selected, indicated by a yellow bar below the icon.

When you select Format, the area below the icon displays the color and axis customizations available for the
currently selected visualization.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-getting-started-with-color-formatting-and-axis-properties.md


NOTENOTE

You can customize many elements of each visualization:

Legend
X-axis
Y-axis
Data colors
Data labels
Shapes
Plot area
Title
Background
Lock aspect
Border

You won’t see all these elements with each visualization type. The visualization you select will affect which customizations are
available; for example, you won’t see an X-Axis if you have a pie chart selected because pie charts don’t have an X-axis.

Also note that if you don’t have any visualization selected, Filters appears in place of the icons, which lets you
apply filters to all visualizations on the page.

Let’s show a couple examples: one working with colors, the other changing the properties of an axis. From there,



Working with colors

you should be ready to customize colors, axes, and labels all day long.

Let’s walk through the steps necessary to customize colors on a chart.

1. I select a Clustered Column Chart from the report canvas.
2. Next, I choose the Format icon to show the available customizations.
3. Then I select the small down arrow to the left of the Data Colors customization. This will show how I can

customize the Data Colors, with options that are specific to the visualization I’ve selected.
4. Data Colors expands downward to show its available customizations.

Let’s make some changes. I can select the down arrow next to the color to make changes on each available data
series. I’ll make Cost of living yellow, Weather I’ll turn orange, and Community well-being will be green. The
following screen shows me at the last step, changing Cost of living.



The changes are shown in the image below. Wow, that’s a bright chart. Here are a few useful elements to note
about working with colors. The numbers in the following list are also shown on the following screen, indicating
where these useful elements can be accessed or changed.

1. Don’t like the colors? No problem, just select Revert to default and your selection reverts to the default
settings. You can do that for one color, or for the entire visualization.

2. Want a color you don’t see in the palette? Just select Custom color, and choose from the spectrum.



Changing axis properties

Not crazy about the change you just made? Use CTRL+Z to undo , just like you’re used to doing.

It’s often useful to modify the X-axis or the Y-axis. Similar to working with colors, you can modify an axis by
selecting the down-arrow icon to the left of the axis you want to change, as shown in the following image.



NOTENOTE

Next step

If you want to collapse the X-Axis options, just select the up arrow icon beside X-Axis.

You can remove the X-axis labels entirely, by toggling the radio button beside X-Axis. You can also choose
whether to turn axis titles on or off by selecting the radio button next to Title.

There are all sorts of colors to choose from, and many more customizations you can apply to your Power BI
reports and dashboards.

These color, axis, and related customizations available when the Format icon is selected are also available in Power BI
Desktop.

For more information, see the following article:

Tips and tricks for color formatting in Power BI



Tips and tricks for color formatting in Power BI
12/6/2017 • 5 min to read • Edit Online

Power BI provides many different ways to customize your dashboards and reports. This article details a collection
of tips that can make your Power BI visualizations more compelling, interesting, and customized to your needs.

The following tips are provided. Have another great tip? Great! Send it our way and we’ll see about adding it to this
list.

Change the color of a single data point
Base the colors of a chart on a numeric value
Base the color of data points on a field value
Customize colors used in the color scale
Use diverging color scales
How to undo in Power BI

To make any changes, you must be editing a report: select your Report from the My Workspace pane, then select
Edit Report from the top menu area, as shown in the following image.

When the Visualizations pane appears along the right side of the Report canvas, you’re ready to start
customizing.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-tips-and-tricks-for-color-formatting.md


Change the color of a single data point
Sometimes you want to highlight one particular data point. Perhaps it’s sales figures for the launch of a new
product, or increased quality scores after launching a new program. With Power BI, you can highlight a particular
data point by changing its color.

The following visualization ranks states in terms of cost of living.

Now imagine you want to quickly show where Washington lands in that ranked list, by using color. Here are the
steps:

Expand the Data Colors section. The following appears.



Set Show All to On. This displays the colors for each data element in the visualization. When you hover over the
data points, scrolling is enabled so you can modify any of the data points.

In this case, let’s change Washington to green. We scroll down to Washington and select the down arrow inside
its color box, and the color selection window appears.



Base the colors of a chart on a numeric value

Once selected, the Washington data point is a nice shade of green, and certainly stands out.

Even if you change visualization types, then return, Power BI remembers your selection and keeps Washington
green.

You can change the color of a data point for more than one data element, too. In the following image, Arizona is
red, and Washington is still green.

There are all sorts of things you can do with colors. In the next section, we take a look at gradients.

Charts often benefit from dynamically setting color based on the numeric value of a field. By doing this, you could
show a different value than what’s used to for the size of a bar, and show two values on a single graph. Or you can



Base the color of data points on a value

Customize the colors used in the color scale

use this to highlight data points over (or under) a certain value – perhaps highlighting areas of low profitability.

The following sections demonstrate different ways to base color on a numeric value.

To change color based on a value, drag the field you want to base color on into the Color Saturation area in the
Field pane. In the following image, Profit before tax has been dragged into Color Saturation. As can see that,
although Velo has higher Gross Sales (its column is higher), Amarilla has a larger Profit before tax (its column
has more color saturation).

You can customize colors used in the color scale, too. Expand Data Colors and you see a gradient of colors used
for visualizing your data. By default, the lowest value in your data is mapped to the least saturated color, and the
highest value to the most saturated color.

The color range is shown in a gradient bar that displays the spectrum between Minimum and Maximum color
values, with the Minimum value color on the left, and Maximum value color to the right.

To change the scale to use a different range of colors, select the color drop-down beside Minimum or Maximum,
and select a color. The following image shows the Maximum color changed to black, and the gradient bar shows
the new color spectrum between Minimum and Maximum.



You can also change the way the values map to these colors. In the following image, the colors for Minimum and
Maximum are set to orange and green, respectively.

In this first image, notice how the bars in the chart reflect the gradient shown in the bar; the highest value is green,
the lowest is orange, and each bar between is colored with a shade of the spectrum between green and orange.

Now, let’s see what happens if we provide numeric values in the Minimum and Maximum value boxes, which are
below the Minimum and Maximum color selectors (shown in the following image). Let’s set Minimum to
20,000,000, and set Maximum to 20,000,000.

By setting those values, gradient is no longer applied to values on the chart that are below Minimum or above
Maximum; any bar with a value over Maximum value is colored green, and any bar with a value under
Minimum value is colored red.



Use Diverging color scales

How to undo in Power BI

Feedback

NOTENOTE

Next steps

Sometimes your data may have a naturally diverging scale. For example, a temperate range has a natural center at
freezing point, and a profitability score has a natural mid-point (zero).

To use diverging color scales, slide the Diverging slider to On. When Diverging is turned on, an additional color
selector and value box, both called Center, appear, as shown in the following image.

When the Diverging slider is on, you can set the colors for Minimum, Maximum and Center separately. In the
following image, Center is set to one, so bars with values above one are a gradient shade of green, and bars below
one are shades of red.

Like many other Microsoft services and software, Power BI provides an easy way to undo your last command. For
example, let’s say you change the color of a data point, or a series of data points, and you don’t like the color when
it appears in the visualization. You don’t recall exactly which color it was before, but you know you want that color
back!

To undo your last action, or the last few actions, all you have to do is:

Type CTRL+Z

Do you have a tip you’d like to share? Please send it our way, and we’ll see about including it here.

These color, axis, and related customizations, available when the Format icon is selected, are also available in Power BI
Desktop.

Getting started with color formatting and axis properties



Change how a chart is sorted in a Power BI report
1/23/2018 • 1 min to read • Edit Online

Sorting using other criteria

In a Power BI report, you can sort most visualizations alphabetically by the names of the categories in the chart, or
by the numeric values of each category. For example, this chart is sorted by store name.

It's easy to change the sort from a category (store name) to a value (sales per square feet) instead.

1. Select the ellipses (...) and choose Sort by Sales Per Sq Ft.

2. If necessary, select the sort icon  to change to Descending.

NOTE: Not all visuals can be sorted. For example, the following visuals cannot be sorted: Treemap, Map,
Filled Map, Scatter, Gauge, Card, Multi Row Card, Waterfall.

  

Sometimes, you want to sort your visual using a different field or other criteria. For example, you might want to
sort by month (and not in alphabetical order) or you might want to sort by entire numbers instead of by digit
(example, 0, 1, 9, 20 and not 0, 1, 20, 9).

In some cases, you may be able to sort the visual the way you'd like, for example, by month. But if not, it may be
because the dataset behind the report needs some tweaking. Here are several solutions:

In Power BI Desktop, use the Data Tools Modeling tab to sort by a different column.
In Excel, if you own the dataset, add a new column that concatenates the month name and number. Then

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/power-bi-report-change-sort.md


Next steps

refresh or re-import the dataset to see the new column in the Fields area.
In Excel, ensure that your numerical columns are tagged as "whole number" or "decimal" and not as "text."

More about Visualizations in Power BI reports.

Power BI - Basic Concepts

More questions? Try the Power BI Community

http://community.powerbi.com/


Copy and paste a visualization in Power BI service
and Power BI Desktop
12/20/2017 • 1 min to read • Edit Online

Next stepsNext steps

Copying and pasting a visualization requires edit permissions to the report. In Power BI service, this means opening
the report in Editing View.

1. Open a report that has at least one visualization.

2. Select the visualization and use Ctrl +C to copy, and Ctrl +V to paste.

More about Visualizations in Power BI reports

Power BI - Basic Concepts

More questions? Try the Power BI Community

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/power-bi-visualization-copy-paste.md
http://community.powerbi.com/


Move and resize a visualization in a report in Power
BI service and Power BI Desktop
12/20/2017 • 1 min to read • Edit Online

Open the report

Move the visualization

Resize the visualization

Select Focus mode to see more detail.

Next steps

Only report creators and owners can move and resize visualizations. In Power BI service (app.powerbi.com) this
means opening the report in Editing view.

In Power BI, open a report that has at least one visualization, or create a new visualization.

Select (left-click) any area of the visualization and drag to the new location.

Select the visualization to display the border and click and drag the dark frame handles to resize.

Hover over the visualization and select the Focus mode icon. 

Resize a visualization on a dashboard

Visualizations in Power BI reports

Power BI - Basic Concepts

More questions? Try the Power BI Community

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/power-bi-visualization-move-and-resize.md
http://community.powerbi.com/


Drill down in a visualization in Power BI
1/8/2018 • 4 min to read • Edit Online

Drill down requires a hierarchy

NOTENOTE

Two methods to drill down

NOTENOTE

When a visual has a hierarchy, you can drill down to reveal additional details. For example, you might have a
visualization that looks at Olympic medal count by a hierarchy made up of sport, discipline, and event. By default,
the visualization would show medal count by sport -- gymnastics, skiing, aquatics, etc. But because it has a
hierarchy, selecting one of the visual elements (such as a bar, line, or bubble), would display an increasingly more-
detailed picture. Select the aquatics element to see data for swimming, diving, and water polo. Select the diving
element to see details for springboard, platform, and synchronized diving events.

You can add hierarchies to reports you own but not to those shared with you. Not sure which Power BI
visualizations contain a hierarchy? Hover over a visualization and if you see these drill controls in the top corners,
your visualization has a hierarchy.

    

Dates are an unique type of hierarchy. When you add a date field to a visualization, Power BI automatically adds a
time hierarchy that contains year, quarter, month, and day. For more information see Visual hierarchies and drill-
down behavior or watch the video below.

To learn how to create hierarchies using Power BI Desktop, watch the video How to create and add hierarchies

There are two different way to drill down (and up) in your visualization. Both are described in this article. Both
methods accomplish the same thing, so use whichever one you enjoy most.

To follow along, open the Retail Analysis sample in Power BI service and create a treemap that looks at Total Units This
Year (Values) by Territory, City, PostalCode, and Name (Group).

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/power-bi-visualization-drill-down.md
file:///W:/soyp-o-7bf22bb1/powerbi-docs/.tmp/guided-learning/visualizations.yml#step-18
https://youtu.be/q8WDUAiTGeU


Method 1 for drill down
This method uses the drill icons that appear in the top corners of the visualization itself.

1. In Power BI, open a report in Reading view or Editing view. Drill requires a visualization with a hierarchy.

A hierarchy is shown in the animation below. The visualization has a hierarchy made up of territory, city,
postal code, and city name. Each territory has one or more cities, each city has one or more postal codes,
etc. By default, the visualization displays only the territory data, because Territory appears first in the list.

2. To enable drill down, select the arrow icon in the top right corner of the visualization. When the icon is dark,
drill is enabled. If you don't turn on drill, selecting a visual element (such as a bar or bubble) will cross-filter
the other charts on the report page.

3. To drill down one field at a time, click one of the elements in your visualization, in a bar chart this means
clicking one of the bars and in a treemap, this means clicking one of the leaves. Notice that the title changes
as you drill down and back up again. In this animation it changes from "Total Units This Year by Territory"
to "Total Units This Year by Territory and City" to "Total Units This Year by Territory, City and PostalCode" to
"Total Units This Year by Territory, City, PostalCode, and Name". And to drill back up, select the Drill Up

icon in the top left corner of the visualization as shown below.

4. To drill down all fields at once, select the double arrow in the top left corner of the visualization.

5. To drill back up, select the up arrow in the top left corner of the visualization.



Method 2 for drill down
This method uses the Explore dropdown from the top Power BI menubar.

1. In Power BI, open a report in Reading view or Editing view. Drill requires a visualization with a hierarchy.

A hierarchy is shown in the image below. The visualization has a hierarchy made up of territory, city, postal
code, and city name. Each territory has one or more cities, each city has one or more postal codes, etc. By
default, the visualization displays only the territory data, because Territory appears first in the list.

2. To enable drill down, select a visualization to make it active and from the Power BI top menubar select
Explore > Drill Down. The drill-down icon in the top right corner of the visualization changes to a black

background. 

3. Once enabled, drill down one field at a time by selecting one of the treemap leaves. In this example, I've
selected the territory named NC to see total units sold this year in North Carolina by city.



Considerations and limitations

Next steps

6. To see the data being used to create the visual, select See data. The data is displayed in a pane below the
visual. This pane remains as you continue drilling through the visual. For more information, see Show data
used to create the visual.

4. To drill down all fields at once, select Explore > Show Next Level.

5. To drill back up, select Explore > Drill Up.

If adding a date field to a visualization does not create a hierarchy, it may be that the "date" field is not
actually saved as a date. If you own the dataset, open it in Data view in Power BI Desktop, select the column
that contains the date, and in the Modeling tab change the Data Type to Date or Date/Time. If the report
has been shared with you, contact the owner to request the change.

Visualizations in Power BI reports

Power BI reports

Power BI - Basic Concepts

More questions? Try the Power BI Community

http://community.powerbi.com/


Hyperlinks in tables
1/24/2018 • 2 min to read • Edit Online

To create a hyperlink in a table or matrix using Power BI Desktop

Create a table or matrix hyperlink in Power BI Desktop

For data imported into Power BIFor data imported into Power BI

This topic teaches you how to use Power BI Desktop to create hyperlinks. Then, once created, use either Desktop or
Power BI service to add those hyperlinks to your report tables and matrixes.

NOTE: Hyperlinks in tiles on dashboards and text boxes on dashboards can be created on-the-fly using Power
BI service. Hyperlinks in text boxes in reports can be created on-the-fly using Power BI service and Power BI
Desktop.

Hyperlinks in tables and matrixes can be created in Power BI Desktop, but not from Power BI Service. Hyperlinks
can also be created in Excel Power Pivot before the workbook is imported into Power BI. Both methods are
described below.

The procedure for adding a hyperlink depends on whether you've imported the data or connected to it using
DirectQuery. Both scenarios are described below.

1. If the hyperlink doesn't already exist as a field in your dataset, use Desktop to add it as a custom column.
2. In Data view, select the column and in the Modeling tab choose the dropdown for Data Category.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/power-bi-hyperlinks-in-tables.md


For data connected with DirectQueryFor data connected with DirectQuery

Create a table or matrix hyperlink in Excel Power Pivot

3. Select Web URL.

6. (Optional) Publish the report from Desktop to Power BI service and open the report in Power BI service. The
hyperlinks will work there as well.

4. Switch to Report view and create a table or matrix using the field categorized as a Web URL. The hyperlinks
will be blue and underlined.

5. If you don't want to display a long URL in a table, you can display a hyperlink icon  instead. Note that
you can't display icons in matrixes.

Select the chart to make it active.

Select the paint roller icon  to open the Formatting tab.
Expand Values, locate URL icon and turn it to On.

You won't be able to create a new column in DirectQuery mode. But if your data already contains URLs, you can
turn those into hyperlinks.

1. In Report view, create a table using a field that contains URLs.
2. Select the column, and in the Modeling tab, choose the dropdown for Data Category.
3. Select Web URL. The hyperlinks will be blue and underlined.
4. (Optional) Publish the report from Desktop to Power BI service and open the report in Power BI service. The

hyperlinks will work there as well.

file:///W:/soyp-o-7bf22bb1/powerbi-docs/.tmp/guided-learning/publishingandsharing.yml#step-2
file:///W:/soyp-o-7bf22bb1/powerbi-docs/.tmp/guided-learning/publishingandsharing.yml#step-2


Another way to add hyperlinks to your Power BI tables and matrixes is to create the hyperlinks in the dataset before
you import/connect to that dataset from Power BI. This example uses an Excel workbook.

1. Open the workbook in Excel.

6. From the Power BI service or Power BI Desktop, connect to or import this workbook.

2. Select the PowerPivot tab and then choose Manage.

3. When PowerPivot opens, select the Advanced tab.

4. Place your cursor in the column that contains the URLs that you'd like to turn into hyperlinks in Power BI
tables.

NOTE: The URLS must start with http:// , https:// or www.

5. In the Reporting Properties group, select the Data Category dropdown and choose Web URL.

7. Create a table visualization that includes the URL field.



Considerations and troubleshooting

Next steps

Q: Can I use a custom URL as a hyperlink in a table or matrix?
A: No. You can use a link icon. If you need custom text for your hyperlinks and your list of URLs is short, consider
using a text box instead.

Visualizations in Power BI reports

Power BI - Basic Concepts

More questions? Try the Power BI Community

http://community.powerbi.com/


Add a hyperlink to a text box in a report
12/20/2017 • 1 min to read • Edit Online

To add a hyperlink to a text box in a report

Text boxes can be added to reports, pinned to dashboards from reports, and added directly to dashboards.
Hyperlinks can be added to a text box no matter where it resides. This topic covers text boxes in reports in
Power BI service (not Power BI Desktop).

NOTE: For information on hyperlinks in Power BI tables and matrixes, see Hyperlinks in tables. For information
on adding text boxes to your dashboard, see Add a tile directly from the dashboard .

1. Create a text box and add some text.

3. Select the hyperlink icon  .

2. Highlight existing text, or add new text to use as a hyperlink.

4. Type or paste the URL in the hyperlink field, and select Done.

5. Test the link.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-add-hyperlink-to-text-box.md


To remove the hyperlink but leave the text

Next steps

Select the URL to open the page in a new browser window.

Place your cursor anywhere in the highlighted text to display the URL.

2. Choose Remove.

1. In the text box, select the hyperlink to highlight it,

Text boxes in Power BI reports

Add a text box to a dashboard

More questions? Try the Power BI Community

http://community.powerbi.com/


Histograms
12/6/2017 • 3 min to read • Edit Online

Simple Histograms

Defining buckets to build a histogram

Defining a histogram that supports brushing

There are several ways to build histograms in Power BI. We'll start with the simplest and go from there.

To get started, determine which query has the field you want to build a histogram on. Use the Reference option for
the query to create a new query and name it FieldName Histogram. Use the Group by option in the Transform
ribbon and select the count rows aggregate. Ensure the data type is a number for the resulting aggregate column.
Then you can visualize this data on the reports page. This approach is fast and easy to build, but doesn't work well if
you have many data points and does not allow brushing across visuals.

Determine which query has the field you want to build a histogram on. Use the Reference option for the query to
create a new query and name it FieldName. Now define the buckets with a rule. Use the Add Custom Column
option on the Add Column ribbon and build a custom rule.

Ensure the data type is a number for the resulting aggregate column. Now you can use the group by technique
described in Simple Histograms (earlier in this article) to achieve the histogram. This option handles more data
points but still does not help with brushing.

Brushing is when visuals are linked together so that when a user selects a data point in one visual other visuals on
the report page highlight or filter data points related to the selected data point. Since we're manipulating data at
query time, we will need to create a relationship between tables and ensure we know which detail item relates to
the bucket in the histogram and vice-versa.

Start the process by using the Reference option on the query that has the field you want to build a histogram on.
Name the new query Buckets. For this example let's call the original query Details. Next remove all columns except
the column you'll use as the bucket for the histogram. Now use the Remove Duplicates feature in query, it's on the
right click menu when you select the column, so the remaining values are the unique values in the column. If you
have decimal numbers you can first use the tip for defining buckets to build a histogram to get a manageable set of
buckets. Now, check the data shown in the query preview. If you see blank values or null you'll need to fix those up
before creating a relationship. See "Creating a relationship if my data has null or blank values". Using this approach
can be problematic due to the need to sort. To get the buckets to sort correctly, see "Sorting order: make categories
appear in the order I want".

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-histograms.md


NOTENOTE
It's useful to think about the sort order before building any visuals.

Next step in the process is to define a relationship between the Buckets and Details queries on the buckets column.
In Power BI Desktop, select Manage Relationships in the ribbon. Create a relationship where Buckets is in the left
table and Details in on the right table, and select the field you're using for the histogram.

Last step is to create the histogram. Drag the Bucket field from the Buckets table. Remove the default field from the
resulting column chart. Now from the Details table drag the histogram field into the same visual. In the field well,
change the default aggregate to Count. The result is the histogram. If you create another visual like a treemap from
the Details table, select a data point in treemap to see the histogram highlight and show the histogram for the
selected data point relative to the trend for the entire data set.



Tips and Tricks for Power BI Map visualizations
1/23/2018 • 6 min to read • Edit Online

What is sent to Bing Maps?

Power BI integrates with Bing Maps to provide default map coordinates (a process called geo-coding) so you can
create maps. Together they use algorithms to identify the correct location, but sometimes it's a best guess. If Power
BI tries can't create the map visualization on its own, it enlists the help of Bing Maps.

You, or your administrator, may need to update your firewall to allow access to the URLs Bing uses for geocoding.
Those URLs are:

https://dev.virtualearth.net/REST/V1/Locations
https://platform.bing.com/geo/spatial/v1/public/Geodata
https://www.bing.com/api/maps/mapcontrol

To increase the likelihood of correct geo-coding, use the following tips. The first set of tips is for you to use if you
have access to the dataset itself. The second set of tips is things you can do in Power BI if you don't have access to
the dataset. And the final set is a list of URLs

Power BI service and Power BI Desktop send Bing the geo data it needs to create the map visualization. This may
include the data in the Location, Latitude, and Longitude buckets and geo fields in any of the Report level,
Page level, or Visual level filter buckets. Exactly what is sent varies by map type. To learn more, see Bing Maps
privacy.

For maps (bubble maps), if latitude and longitude are provided then no data is sent to Bing. Otherwise, any data
in the Location (and filter) buckets is sent to Bing.
Filled maps require a field in the Location bucket; even if latitude and longitude are provided. Whatever data
is in the Location, Latitude, or Longitude buckets is sent to Bing.

In the example below, the field Vendor is being used for geo-coding, so all vendor data is sent to Bing. Data
from the Size and Color saturation buckets is not sent to Bing.

In this second example below, the field Territory is being used for geo-coding, so all territory data is sent to
Bing. Data from the Legend and Color saturation buckets is not sent to Bing.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/power-bi-map-tips-and-tricks.md
https://dev.virtualearth.net/REST/V1/Locations
https://platform.bing.com/geo/spatial/v1/public/Geodata
https://www.bing.com/api/maps/mapcontrol
https://go.microsoft.com/fwlink/?LinkID=248686


In the dataset: tips to improve the underlying dataset
If you have access to the dataset that is being used to create the map visualization, there are a few things you can
do to increase the likelihood of correct geo-coding.

1. Categorize geographic fields in Power BI Desktop

In Power BI Desktop, you can ensure fields are correctly geo-coded by setting the Data Category on the data fields.
Select the desired table, go to the Advanced ribbon and then set the Data Category to Address, City, Continent,
Country/Region, County, Postal Code, State or Province. These data categories help Bing correctly encode the
date. To learn more, see Data categorization in Power BI Desktop. If you are live connecting to SQL Server Analysis
Services, you will need to set the data categorization outside of Power BI using SQL Server Data Tools (SSDT).

2. Use more than one location column.
Sometimes, even setting the data categories for mapping isn't enough for Bing to correctly guess your intent.
Some designations are ambiguous because the location exists in multiple countries or regions. For example,
there's a Southampton in England, Pennsylvania, and New York.

Power BI uses Bing's unstructured URL template service to get the latitude and longitude coordinates based on a
set of address values for any country. If your data doesn't contain enough location data, add those columns and
categorize them appropriately.

For example, if you only have a City column, Bing may have a hard time geo-coding. Add additional geo columns
to make the location unambiguous. Sometimes all it takes is adding one more location column to the dataset - in
this case state/province. And don't forget to categorize it properly, see #1 above.

Make sure when each field only has the specific information tied to the categorization. For example, your City
location field should be Southampton, not Southampton, New York. And Address location fields should be 1
Microsoft Way and not 1 Microsoft Way, Redmond, WA.

3. Use specific Latitude and Longitude

Add latitude and longitude values to your dataset. This removes any ambiguity and returns results more quickly.
Latitude and Longitude fields must be in Decimal Number format, which you can set in the data model.

https://docs.microsoft.com/sql/ssdt/download-sql-server-data-tools-ssdt
https://msdn.microsoft.com/library/ff701714.aspx


In Power BI: tips to get better results when using map visualizations

4. Use Place category for columns with full location information

While we encourage you to use geo-hierarchies in your maps, if you must use a single location column with full
geographical information, you can set the data categorization to Place. For example, if the data in your column is
full addresses, such as 1 Microsoft Way, Redmond Washington 98052, this generalized data category will work
best with Bing.

1. Use latitude and longitude fields (if they exist)

In Power BI, if the dataset you are using has fields for longitude and latitude -- use them! Power BI has special
buckets to help make the map data unambiguous. Just drag the field that contains your latitude data into the
Visualizations > Latitude area. And do the same for your longitude data. When you do this, you also need to fill
the Location field when creating your visualizations. Otherwise, the data is aggregated by default, so for example,
the latitude and longitude would be paired at the state level, not the city level.



Use geo-hierarchies so you can drill down to different "levels" of
location
When your dataset already has different levels of location data, you and your colleagues can use Power BI to create
geo-hierarchies. To do this, drag more than one field into the Location bucket. Used together in this way, the fields
become a geo-hierarchy. In the example below we have added geo fields for: Country/Region, State, and City. In
Power BI you and your colleagues can drill up and down using this geo-hierarchy.

When drilling with geo-hierarchies, it is important to know how each drill button works and what gets sent to Bing
Maps.

The drill button on the far right, called Drill Mode  , allows you to select a map Location and drill down into
that specific location one level at a time. For example, if you turn Drill Down on and click North America, you
move down in the hierarchy to the next level -- states in North America. For geo-coding, Power BI sends Bing
Maps country and state data for North America only.

On the left there are 2 other drill options. The first option,  , drills to the next level of the hierarchy for all
locations at once. For example, if you are currently looking at countries and then use this option to move to the
next level, states, Power BI displays state data for all countries. For geo-coding, Power BI sends Bing Maps state
data (no country data) for all locations. This option is useful if each level of your hierarchy is unrelated to the
level above it.
The second option,  , is similar to Drill Down, except that you don't need to click on the map. It expands down
to the next level of the hierarchy remembering the current level’s context. For example, if you are currently
looking at countries and select this icon, you move down in the hierarchy to the next level -- states. For geo-



Next steps

coding, Power BI sends data for each state and its corresponding country to help Bing Maps geocode more
accurately. In most maps, you will use either this option or the Drill Down option on the far right, so you can
send Bing as much information as possible to get accurate location information.

Drill down in a Power BI visualization

Power Bi visualizations

More questions? Try the Power BI Community

http://community.powerbi.com/


Static content in Power BI reports
1/24/2018 • 1 min to read • Edit Online

Add a text box to a report

Text boxes and shapes can be added to reports using Power BI service and Power BI Desktop. In both cases, you
must have editing permissions for the report. If a report has been shared with you, you will not have access to
Editing view.

Watch Will use Power BI Desktop to add static images to a report, and then follow the steps below to try it out
yourself using Power BI service instead.

1. Open a report in Editing view.

2. Place your cursor in any blank area on the report canvas and select Text Box.

3. Type your text into the text box and, optionally, format font, color, and text alignment.

4. To position the text box, select the grey area at the top and drag. And to resize the text box, select and drag
any of the outline handles.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/power-bi-reports-add-text-and-shapes.md
file:///W:/soyp-o-7bf22bb1/powerbi-docs/.tmp/guided-learning/visualizations.yml#step-11


Add a shape to a report

5. With the text box still selected, add additional formatting in the VISUALIZATIONS pane. In this example
we've formatted the background and border. You can also create an exact size and position for a text box.

6. To close the text box, select any blank space on the report canvas.

7. Select the pin icon  to pin the text box to a dashboard.

1. Place your cursor anywhere on the report canvas and select Shapes.

2. From the dropdown, select a shape to add it to your report canvas. Let's add an arrow to direct attention to



Next stepsNext steps

3. To position the shape, select the grey area at the top and drag. And to resize the shape, select and drag any of
the outline handles. As with the text box, you can also create an exact size and position for a shape.

the bubble with the highest total sales variance.

In the Format shape pane, customize your shape. In this example we've created a red arrow with a dark red
border, rotated 90 degrees.

NOTE: Shapes cannot be pinned to a dashboard, except as one of the visuals when you pin a live page.

Add a hyperlink to a text box

Power BI - Basic Concepts

More questions? Try the Power BI Community

http://community.powerbi.com/


ArcGIS maps in Power BI service and Power BI
Desktop by Esri
1/8/2018 • 9 min to read • Edit Online

TIPTIP

TIPTIP

User consent

This tutorial is written from the point of view of a person creating an ArcGIS map. Once a creator shares an ArcGIS
map with a colleague, that colleague can view and interact with the map but not save changes. To learn more about
viewing an ArcGIS map, see Interacting with ArcGIS maps.

The combination of ArcGIS maps and Power BI takes mapping beyond the presentation of points on a map to a
whole new level. Choose from base maps, location types, themes, symbol styles, and reference layers to create
gorgeous informative map visualizations. The combination of authoritative data layers on a map with spatial
analysis conveys a deeper understanding of the data in your visualization.

While you cannot create an ArcGIS maps on a mobile device, you can view and interact with it. See Interacting with
ArcGIS maps.

GIS stands for Geographic Information Science.

The example below uses a dark gray canvas to show regional sales as a heatmap against a demographic layer of
2016 median disposable income. As you'll see as you read on, using ArcGIS maps offers almost limitless enhanced
mapping capability, demographic data, and even-more compelling map visualizations so you can tell your best
story.

Visit esri's page on Power BI to see many examples and read testimonials. And then see esri's ArcGIS Maps for Power BI
Getting Started page.

ArcGIS Maps for Power BI is provided by Esri. Your use of ArcGIS Maps for Power BI is subject by Esri's terms and
privacy policy. Power BI users wishing to use the ArcGIS Maps for Power BI visuals, need to accept the consent
dialog.

Resources

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/power-bi-visualization-arcgis.md
https://docs.microsoft.com/en-us/power-bi/power-bi-visualizations-arcgis
https://docs.microsoft.com/en-us/power-bi/power-bi-visualizations-arcgis
https://www.esri.com/powerbi
https://doc.arcgis.com/en/maps-for-powerbi/get-started/about-maps-for-power-bi.htm
https://www.esri.com


Enable ArcGIS map

Enable the ArcGIS map Enable the ArcGIS map in Power BI service (app.powerbi.com)in Power BI service (app.powerbi.com)

Terms

Privacy Policy

ArcGIS Maps for Power BI product page

ArcGIS maps are currently available in Power BI service, Power BI Desktop, and Power BI mobile. This article
provides instructions for the service and for Desktop.

This tutorial uses the Retail Analysis sample. To enable ArcGIS Maps for Power BI:

1. From the top right section of the menubar, select the cog icon and open Settings

2. Select the ArcGIS Maps for Power BI checkbox. You'll need to restart Power BI after you make the
selection.

3. Open a report in Editing view and select the ArcGIS Maps for Power BI icon from the Visualizations pane.

4. Power BI adds an empty ArcGIS map template to the report canvas.

https://go.microsoft.com/fwlink/?LinkID=826322
https://go.microsoft.com/fwlink/?LinkID=826323
https://www.esri.com/powerbi


Create an ArcGIS map visual
Watch Will create a few different ArcGIS map visualizations and then use the steps below to try it out yourself
using the Retail Analysis sample.

NOTENOTE

2. Convert the visualization to an ArcGIS map by selecting the template from the Visualizations pane .

1. From the Fields pane, drag a data field to the Location or Latitude and/or Longitude buckets. In this
example we're using Store > City.

ArcGIS Maps for Power BI will automatically detect if the fields you've selected are best viewed as a shape or a point
on a map. You can adjust the default in the settings (see below).

3. From the Fields pane, drag a measure to the Size bucket to adjust how the data is shown. In this example



Settings and formatting for ArcGIS maps

Detailed documentation

we're using Sales > Last Year Sales.

To access ArcGIS Maps for Power BI formatting features:

NOTENOTE

2. To return to the report, select Back to Report from the top-left corner of your report canvas.

1. Access additional features by selecting the ellipses in the top right corner of the visualization and choosing
Edit,

The available features display across the top of the visualization. Each feature, when selected, opens a task
pane that provides detailed options.

For more information about the settings and features, see Detailed documentation below.



Features overview
Base MapsBase Maps

Location typeLocation type

Map themeMap theme

Esri provides comprehensive documentation on the feature set of ArcGIS Maps for Power BI.

Four base maps are provided: Dark Gray Canvas, Light Gray Canvas, OpenStreetMap, and Streets. Streets is
ArcGIS's standard base map.

To apply a base map select it in the task pane.

ArgGIS Maps for Power BI automatically detects the best way to show data on the map. It selects from Points or
Boundaries. The Location type options allow you to fine tune these selections.

Boundaries will only work if your data contains standard geographic values. Esri automatically figures out the
shape to show on the map. Standard geographic values include countries, provinces, zip codes, etc. But just like
with GeoCoding, Power BI may not detect the field should be a boundary by default, or it may not have a boundary
for your data.

Four map themes are provided. Location Only and Size themes are automatically chosen based on the fields you

https://go.microsoft.com/fwlink/?LinkID=828772


THEME DESCRIPTION

Location Only Plots data points or filled boundaries on the map based on
the settings in Location Type.

Heat Map Plots an intensity plot of data on the map.

Size Plots data points on the map based that are sized based on
the value in the size bucket in the fields pane.

Clustering Plot the count of data points in regions on the map.

Symbol styleSymbol style

PinsPins

bind to the location and added to the Size bucket in the Power BI Fields pane. We're currently using Size, so let's
change to Heat map.

Symbol styles enable you to fine tune how data is presented on the map. Symbol styles are context sensitive based
on the selected Location type and Map theme. The example below shows Location type set to Size and several
adjustments to transparency, style and size.

Call attention to points on your map by adding pins.

1. Select the Pins tab.
2. Type keywords (such as addresses, places, and point of interest), in the search box and select from the

dropdown. A symbol appears on the map, and the map automatically zooms to the location. Search results



Drive timeDrive time

are saved as location cards in the Pins pane. You can save up to 10 location cards.

3. Power BI adds a pin to that location and you can change the color of the pin.

4. Add and delete pins.

The Drive time pane lets you select a location and then determine what other map features are within a specified
radius or driving time.



Reference LayerReference Layer
Reference layer - DemographicsReference layer - Demographics

TIPTIP

1. Select the Drive time tab and choose the single or multi select tool. Single select the pin for Washington

D.C. 

It's easier to select a location if you zoom in on the map (using the + icon).

2. Let's say you're flying into Washington D.C. for a few days and want to figure out which stores are within a
reasonable driving distance. Change Search area to Radius and Distance to 50 miles and select OK.

3. The radius is shown in purple. Select any location to display its details. Optionally, format the radius by
changing color and outline.

ArcGIS Maps for Power BI provides a selection of demographic layers that help contextualize data from Power BI.

1. Select the Reference layer tab and choose Demographics.
2. Each layer listed has a checkbox. Add a checkmark to add that layer to the map. In this example we've added



Reference layer - ArcGISReference layer - ArcGIS

average household income.

3. Each layer is interactive as well. Just as you can hover over a bubble to see the details, you can click a shaded
area on the map to see the details.

ArcGIS Online provides the ability for organizations to publish public web maps. Additionally, Esri provides a
curated set of web maps through Living Atlas. In the ArcGIS tab, you can search all public web maps or Living Atlas
maps, and add them to the map as reference layers.

1. Select the Reference layer tab and choose ArcGIS.
2. Enter search terms and then select a map layer. In this example we've chosen USA Congressional districts.



Selecting Data points

NOTENOTE

Getting help

3. To see the details, select a shaded area to open the Select from reference layer: Use the reference layer selection
tool to selection boundaries or objects on the reference layer.

ArcGIS Maps for Power BI allows three selection modes.

Change the selection mode using switch:

 Select individual data points.

 Draws a rectangle on the map and selects the contained data points.

 Allows boundaries or polygons within reference layers to be used to select contained data points.

A maximum of 250 data points can be selected at a time.

Esri provides comprehensive documentation on the feature set of ArcGIS Maps for Power BI.

You can ask questions, find the latest information, report issues, and find answers on the Power BI community
thread related to ArcGIS Maps for Power BI.

If you have a suggestion for an improvement, please submit it to Power BI's ideas list.

https://go.microsoft.com/fwlink/?LinkID=828772
https://go.microsoft.com/fwlink/?LinkID=828771
https://ideas.powerbi.com


Managing use of ArcGIS Maps for Power BI within your organization
Power BI provides the ability for users, tenant administrators, and IT administrators to manage whether to use
ArcGIS Maps for Power BI.

User options In Power BI Desktop, users can stop using ArcGIS Maps for Power BI by disabling it on the security
tab in Options. When disabled, ArcGIS Maps will not load by default.

In Power BI service, users can stop using ArcGIS Maps for Power BI by disabling it on the ArcGIS Maps for Power BI
tab in user Settings. When disabled, ArcGIS Maps will not load by default.



ATTRIBUTE VALUE

key Software\Policies\Microsoft\Power BI Desktop</td>

valueName EnableArcGISMaps

Considerations and Limitations

SERVICE/APP AVAILABILITY

Power BI Desktop Yes

Power BI service (PowerBI.com) Yes

Power BI mobile applications Yes

Power BI publish to web No

Power BI Embedded No

Power BI service embedding (PowerBI.com) No

Tenant admin options In PowerBI.com, tenant administrators can prevent all tenant users from using ArcGIS
Maps for Power BI by disabling. When this happens, Power BI will no longer see the ArcGIS Maps for Power BI icon
in the visualizations pane.

IT Administrator options Power BI Desktop supports using Group Policy to disable ArcGIS Maps for Power BI
across an organization's deployed computers.

A value of 1 (decimal) enables ArcGIS Maps for Power BI.

A value of 0 (decimal) disable ArcGIS Maps for Power BI.

ArcGIS Maps for Power BI is available in the following services and applications:

In services or applications where ArcGIS Maps for Power BI is not available, the visualization will show as an empty
visual with the Power BI logo.

When geocoding street addresses, only the first 1500 addresses are geocoded. Geocoding place names or
countries is not subject to the 1500 address limit.



Next steps

Is there any charge for using ArcGIS Maps for Power BI?

The ArcGIS Map for Power BI is available to all Power BI users at no additional cost. It is a component provided by
Esri and your use is subject to the terms and privacy policy provided by Esri as noted earlier in this article.

I'm getting an error message in Power BI Desktop about my cache being full

This is a bug that is being addressed. In the meantime, to clear your cache, please try to delete files at this location:
C:\Users\AppData\Local\Microsoft\Power BI Desktop\CEF and then restart Power BI.

Does ArcGIS Maps for Power BI support Esri Shapefiles?

ArcGIS Maps for Power BI automatically detects standard boundaries like countries/regions, states/provinces, and
zip/postal codes. If you need to provide your own shapes you can do so using the Shape Maps for Power BI
Desktop (Preview).

Can I view my ArcGIS maps offline?

No, Power BI needs network connectivity to display the maps.

Can I connect to my ArcGIS Online account from Power BI?

Not yet. Vote for this idea and we'll send you an email when we start working on this feature.

Interacting with an ArcGIS map that has been shared with you

Blog post announcing availability of ArcGIS maps for Power BI

More questions? Try asking the Power BI Community

https://ideas.powerbi.com/forums/265200-power-bi-ideas/suggestions/9154765-arcgis-geodatabases
https://docs.microsoft.com/en-us/power-bi/power-bi-visualizations-arcgis
https://powerbi.microsoft.com/blog/announcing-arcgis-maps-for-power-bi-by-esri-preview/
http://community.powerbi.com/


Basic Area chart (Tutorial)
1/23/2018 • 2 min to read • Edit Online

When to use a basic area chart

PrerequisitesPrerequisites

Create a basic area chart

The basic area chart (aka layered area chart.) is based on the line chart. The area between axis and line is filled with
colors to indicate volume.

Area charts emphasize the magnitude of change over time, and can be used to draw attention to the total value
across a trend. For example, data that represents profit over time can be plotted in an area chart to emphasize the
total profit.

Basic area charts are a great choice:

to see and compare the volume trend across time series
for individual series representing a physically countable set

Power BI service
Retail Analysis sample

To follow along, sign in to Power BI and select Get Data > Samples > Retail Analysis Sample > Connect and
choose Go to dashboard.

1. From the "Retail Analysis Sample" dashboard, select the Total Stores tile to open the "Retail Analysis Sample"
report.

2. Select Edit Report to open the report in Editing View.
3. Add a new report page bys selecting the yellow plus icon (+) at the bottom of the report.
4. Create an area chart that displays this year's sales and last year's sales by month.

a. From the FIELDS pane, select Sales > Last Year Sales, and This Year Sales > Value.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/power-bi-visualization-basic-area-chart.md


Highlighting and cross-filtering

Considerations and troubleshooting

b. Convert the chart to a basic area chart by selecting the Area chart icon from the VISUALIZATIONS pane.

c. Select Time > Month to add it to the Axis well.

d. To display the chart by month, select the ellipses (top right corner of the visual) and choose Sort by
month.

For information about using the FILTERS pane, see Add a filter to a report.

To highlight one particular area in your chart, select that area or its top border. Unlike other visualization types, if
there are other visualizations on the same page, highlighting a basic area charts does not cross-filter the other
visualizations on the report page. However, area charts are a target for cross-filtering triggered by other
visualizations on the report page. To learn more, see Visual interactions in reports

Basic area charts are not effective for comparing the values due to the occlusion on the layered areas. Power BI
uses transparency to indicate the overlap of areas. However, it only works well with two or three different areas.
When you need to compare trend to more than three measures, try using line charts. When you need to
compare volume to more than three measures, try using treemap.



Next steps
Reports in Power BI
Visualizations in Power BI reports
Power BI - Basic Concepts
More questions? Try the Power BI Community

http://community.powerbi.com/


Combo Chart in Power (Tutorial)
1/24/2018 • 3 min to read • Edit Online

When to use a Combo Chart

PrerequisitesPrerequisites

Create a basic, single-axis, Combo Chart

In Power BI, a combo chart is a single visualization that combines a line chart and a column chart. Combining the 2
charts into one lets you make a quicker comparison of the data.

Combo charts can have one or two Y axes.

Combo charts are a great choice:

when you have a line chart and a column chart with the same X axis.
to compare multiple measures with different value ranges.
to illustrate the correlation between two measures in one visualization.
to check whether one measure meet the target which is defined by another measure
to conserve canvas space.

Combo charts are available in Power BI service and Power BI Desktop. This tutorial uses Power BI service to create
a Combo chart. To follow along, open Power BI service and connect to the "Retail Analysis" sample instructions
below).

Watch Will create a combo chart using the Sales and Marketing sample.

 To create your own combo chart, sign in to Power BI service and select Get Data > Samples > Retail Analysis
Sample > Connect >Go to dashboard.

1. From the "Retail Analysis Sample" dashboard, select the Total Stores tile to open the "Retail Analysis Sample"
report.

2. Select Edit Report to open the report in Editing View.
3. Add a new report page.
4. Create a column chart that displays this year's sales and gross margin by month.

a. From the Fields pane, select Sales > This Year Sales > Value.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/power-bi-visualization-combo-chart.md


Create a combo chart with two axes

b. Drag Sales > Gross Margin This Year to the Value well.

c. Select Time > FiscalMonth to add it to the Axis well.

5. Select the ellipses (...) in the upper-right corner of the visualization, and select Sort by FiscalMonth. You
may have to select it twice to sort ascending or descending.

6. Convert the column chart to a combo chart. With the column chart selected, from the Visualizations pane
select the Line and clustered column chart.

7. From the Fields pane, drag Sales > Last Year Sales to the Line Values bucket.

Your combo chart should look something like this:

In this task, we'll compare gross margin and sales.

1. Create a new line chart that tracks Gross Margin last year % by Month. In January GM% was 35%, peaked
at 45% in April, dropped in July and peaked again in August. Will we see a similar pattern in sales last year
and this year?



2. Add This Year Sales > Value and Last Year Sales to the line chart. The scale of Gross Margin Last Year
% is much smaller than the scale of Sales which makes it difficult to compare.

3. To make the visual easier to read and interpret, convert the line chart to a Line and Stacked Column chart.

4. Drag Gross Margin Last Year % from Column Values into Line Values. Power BI creates two axes, thus
allowing the datasets to be scaled differently; the left measures sales dollars and the right measures
percentage.



Add titles to the axes
1. Select the paint roller icon  to open the Formatting pane.
2. Select the down arrow to expand the Y-axis options.
3. For Y-Axis (Column), set Position to Left, set Title to On, Style to Show title only, and Display as

Millions.

4. Under Y-Axis (Column), scroll down and ensure that Show Secondary is set to On. This displays options
for formatting the line chart portion of the combo chart.



Cross-highlighting and cross-filtering

Next steps

5. For Y-Axis (Line), leave Position as Right, turn Title to On, and set Style to Show title only.

Your combo chart now displays dual axes, both with titles.

6. Optionally, modify the text font, size, and color and set other formatting options to improve the display and
readability of the chart.

From here you might want to:

Add the combo chart as a dashboard tile.
Save the report.

Highlighting a column or line in a combo chart cross-highlights and cross-filters the other visualizations on the
report page... and vice versa. Use visual interactions to change this default behavior.

Overview of visualizations in Power BI reports

Visualization types in Power BI

Power BI - Basic Concepts



More questions? Try the Power BI Community

http://community.powerbi.com/


Customize visualization titles, legends, and
backgrounds (Tutorial)
1/24/2018 • 3 min to read • Edit Online

PrerequisitesPrerequisites

Customize visualization titles in reports

NOTENOTE

In this tutorial you'll learn a few different ways to customize your visualizations. There are so many options for
customizing your visualizations, the best way to learn about them all is by exploring the Formatting pane (select
the paintroller icon). To get you started, this article shows you how to customize a visualization title, legend, and
background.

Not all visualizations can be customized, see the complete list.

Watch Amanda customize visualizations in her report (fast-forward to 4:50 in the video). Then follow the
instructions below the video to try it out yourself with your own data.

Power BI service or Power BI Desktop
Retail Analysis sample

To follow along, sign into Power BI service (app.powerbi.com) and open the Retail Analysis Sample report in
Editing View.

When you pin a visualization to a dashboard, it becomes a dashboard tile. The tiles themselves can also be customized with
new titles and subtitles, hyperlinks, and resized.

1. Navigate to the "New Stores" page of the report and select the "Open Store Count by Open Month..." column
chart.

2. In the Visualizations pane, select the paintroller icon to reveal the formatting options. and select Title to
expand that section.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/power-bi-visualization-customize-title-background-and-legend.md


4. Change Title Text by typing Store count by month opened in the text field.

6. Increase the text size to 12.

3. Turn Title on and off by selecting the On (or Off) slider. For now, leave it On.

5. Change Font color to orange and Background Color to yellow.

Select the dropdown and choose a color from the Theme Colors, Recent Colors, or Custom color.
Select the dropdown to close the color window.

You can always revert to the default colors by selecting Revert to default in the color window.

7. The last customization we'll make to the chart title is to align it in the center of the visualization. The title
position defaults to left-aligned.

At this point in the tutorial, your column chart title should look like something like this:



Customize visualization backgrounds

Customize visualization legends

To revert all the title customization we've done so far, select Revert To Default, at the bottom of the Title
customization pane.

With the same column chart selected, expand the Background options.

1. Turn the background on and off by selecting the On (or Off) slider. For now, leave it On.
2. Change the background color to 74% grey.

Select the dropdown and choose a grey color from the Theme Colors, Recent Colors, or Custom
color.
Change Transparency to 74%.

To revert all the title background customization we've done so far, select Revert To Default, at the bottom
of the Background customization pane.

1. Open the Overview report page and select the "Total Sales Variance by FiscalMonth and District Manager"
chart.

2. In the Visualization tab, select the paintbrush icon to open the formatting pane.
3. Expand Legend options.



Visualization types that can be customized
VISUALIZATION TITLE BACKGROUND LEGEND

area yes yes yes

bar yes yes yes

card yes yes n/a

multi row card yes yes n/a

column yes yes yes

combo yes yes yes

donut yes yes yes

filled map yes yes yes

4. Turn the legend on and off by selecting the On (or Off) slider. For now, leave it On.
5. Move the legend to the left side of the visualization.
6. Add a legend title by toggling Title to On and, in the Legend name field, typing Managers. 

To revert all the legend customization we've done so far, select Revert To Default, at the bottom of the
Legend customization pane.

 



funnel yes yes n/a

gauge yes yes n/a

kpi yes yes n/a

line yes yes yes

map yes yes yes

matrix yes yes n/a

pie yes yes yes

scatter yes yes yes

slicer yes yes n/a

table yes yes n/a

textbox no yes n/a

treemap yes yes yes

waterfall yes yes yes

VISUALIZATION TITLE BACKGROUND LEGEND

Next steps
Customize X-axis and Y-axis
Customize colors and axis properties
Power BI - Basic Concepts
More questions? Try the Power BI Community

http://community.powerbi.com/


Customize X-axis and Y-axis properties (Tutorial)
1/24/2018 • 4 min to read • Edit Online

NOTENOTE

Customizing visualization X-axes in reports

Create a stacked chart visualization

In this tutorial you'll learn many different ways to customize the X-axis and Y-axis of your visuals. Not all visuals
have axes or can be customized; Pie charts, for example, don't have axes. And customization options vary from
visual to visual, too many options to cover in a single article. So we'll take a look at some of the most-used axes
customizations and get you comfortable using the visual formatting tab in the Power BI report canvas.

This page applies to both Power BI service and Power BI Desktop. These customizations, which are available when the

Format (the paint roller icon  ) is selected, are also available in Power BI Desktop.

Watch Amanda customize her X and Y axes and demonstrate the various ways to control concatenation when
using drill-up and drill-down. Then follow the step-by-step instructions below the video to try it out yourself using
the Retail Analysis sample.

Sign in to the Power BI service and open the Retail Analysis Sample report in Editing View. To follow along,
connect to the Retail Analysis sample.

1. Create a new column chart that shows this year's sales and last year's sales value by fiscal month.
2. Convert it to a Stacked column chart.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/power-bi-visualization-customize-x-axis-and-y-axis.md


Customize the X axis
1. In the Visualizations and Filters pane, select Format (the paint roller icon  ) to reveal the customization

options.

4. Format the text color, size, and font. In this example we've set text Color to black, Text Size to 14, and Font to
Arial Black.

5. Turn the X-axis Title On and display the name of the X axis -- in this case, FiscalMonth.
6. Format the title text color, size, and font. In this example we've set Title color to orange, changed Axis title to

Fiscal Month, and set Title text size to 21.

2. Expand the X-Axis options.

3. Turn the X-axis on and off by selecting the On (or Off) slider. For now, leave it On. One reason you might
want to turn off the X-axis is to save space for more data.

7. To sort by FiscalMonth, select the ellipses (...) in the top-right corner of the chart and select Sort By
FiscalMonth.

After all these customizations, your column chart should look something like this:



Customize the Y axis

To revert all the X-axis customization you've done so far, select Revert To Default at the bottom of the X-axis
customization pane.

3. Move the Y-Axis Position to the right.
4. Format the text color, size, and font. In this example we've set text Color to black, Text Size to 14, and Font to

Arial Black.
5. Keep Display units set to Millions and Value decimal places to zero.
6. For this visuaization, having a Y-axis title doesn't improve the visual, so leave Title turned Off.

1. Expand the Y-Axis options.

2. Turn the Y-axis on and off by selecting the On (or Off) slider. For now, leave it On. One reason you might
want to turn off the Y-axis is to save space for more data.



Customizing visualizations with dual Y-axes

Create a chart with two Y-axesCreate a chart with two Y-axes

7. Let's make the gridlines stand out by changing the Color to a dark grey and increasing Stroke to 2.

After all these customizations, your column chart should look something like this:

First you'll create a Combo chart that looks at the impact store count has on sales. This is the same chart that is
created in the Combo chart Tutorial. Then you'll format the dual Y-axes.

1. Create a new line chart that tracks Sales > Gross Margin last year % by Time > FiscalMonth.
2. Sort the visual by month by selecting the ellipses (...) and choosing Sort by Month

[NOTE]: For help sorting by month, see sorting by other criteria

1. In January GM% was 35%, peaked at 45% in April, dropped in July and peaked again in August. Will we see
a similar pattern in sales last year and this year?

2. Add This Year Sales > Value and Last Year Sales to the line chart. The scale of GM% Last Year (the blue
line running along the 0M% gridline) is much smaller than the scale of Sales which makes it difficult to
compare. And the Y-Axis label percentages are ridiculous.



Format the secondary Y-axisFormat the secondary Y-axis

1. To make the visual easier to read and interpret, convert the line chart to a Line and Stacked Column chart.

2. Drag Gross Margin Last Year % from Column Values into Line Values. What we have now is the stacked
column chart we created above plus a line chart. (Optionally, use what you learned above to format the
axes font color and size.)

Power BI creates two axes, thus allowing the datasets to be scaled differently; the left measures dollars and the
right measures percentage.

1. In the Visualizations pane, select the paint roller icon to display the formatting options.
2. Expand the Y-Axis options by selecting the down arrow.
3. Scroll through the list until you find the options for Show secondary. Toggle Show Secondary from Off

to On.



Add titles to both axesAdd titles to both axes

4. (Optional) Customize the two axes. If you switch Position for either the column axis or the line axis, then
the two axes switch sides.



Considerations and troubleshooting

Next steps

With a visualization this complicated, it helps to add axes titles. Titles help your colleagues understand the story
your visualization is telling.

1. Toggle Title to On for Y-Axis (Column) and the Y-Axis (Line).
2. Set Style to Show title only.

3. Your Combo chart now displays dual axes, both with titles.

For more information, see Tips and tricks for color formatting, labeling, and axis properties.

If the X-axis is categorized by the report owner as a date type, the Type option will display and you can select
between continuous or categorical.

More about Visualizations in Power BI reports

Customize titles, backgrounds, and legends

Customize colors and axis properties

Power BI - Basic Concepts

More questions? Try the Power BI Community

http://community.powerbi.com/


Doughnut charts in Power BI (Tutorial)
1/3/2018 • 1 min to read • Edit Online

Create a doughnut chart

Considerations and troubleshooting

A doughnut chart is similar to a pie chart in that it shows the relationship of parts to a whole. The only difference is
that the center is blank and allows space for a label or icon.

These instructions use the Retail Analysis Sample to create a doughnut chart that displays this year's sales by
category. To follow along, download the sample for Power BI service (app.powerbi.com) or Power BI Desktop.

1. Start on a blank report page and select the SalesStage > Sales Stage field. If you're using Power BI service,
make sure you open the report in Editing View.

2. From the Fields pane, select Sales > Last Year Sales.

3. From the Visualizations pane, select the icon for doughnut chart  to convert your bar
chart to a doughnut chart. If Last Year Sales is not in the Values area, drag it there.

4. Select Item > Category to add it to the Legend area.

5. Optionally, adjust the size and color of the chart's text.

The sum of the doughnut chart values must add up to 100%.
Too many categories make it difficult to read and interpret.
Doughnut charts are best used to compare a particular section to the whole, rather than comparing individual
sections with each other.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/power-bi-visualization-doughnut-charts.md


Next steps
Reports in Power BI

Visualization types in Power BI

Visualizations in Power BI reports

Power BI - Basic Concepts

More questions? Try the Power BI Community

http://community.powerbi.com/


Filled maps (choropleths) in Power BI (Tutorial)
1/24/2018 • 3 min to read • Edit Online

What is sent to Bing

When to use a filled map

A filled map uses shading or tinting or patterns to display how a value differs in proportion across a geography or
region. Quickly display these relative differences with shading that ranges from light (less-frequent/lower) to dark
(more-frequent/more).

Power BI integrates with Bing to provide default map coordinates (a process called geo-coding). When you create a
map visualization in Power BI service or Power BI Desktop, the data in the Location, Latitude, and Longitude
buckets (that is being used to create that visualization) is sent to Bing.

You, or your administrator, may need to update your firewall to allow access to the URLs Bing uses for geocoding.
Those URLs are:

https://dev.virtualearth.net/REST/V1/Locations
https://platform.bing.com/geo/spatial/v1/public/Geodata
https://www.bing.com/api/maps/mapcontrol

For more information about the data being sent to Bing, and for tips to increase your geo-coding success, see Tips
and tricks for map visualizations.

Filled maps are a great choice:

to display quantitative information on a map.
to show spatial patterns and relationships.
when your data is standardized.
when working with socioeconomic data.
when defined regions are important.
to get an overview of the distribution across the geographic locations.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/power-bi-visualization-filled-maps-choropleths.md
https://dev.virtualearth.net/REST/V1/Locations
https://platform.bing.com/geo/spatial/v1/public/Geodata
https://www.bing.com/api/maps/mapcontrol


PrerequisitesPrerequisites

Create a basic filled map

Power BI service or Power BI Desktop
Sales and Marketing Sample

To follow along, the tutorial uses Power BI service, not Power BI Desktop.

In this video, Kim creates a basic map and converts it to a filled map.

1. To create your own filled map, download the Sales and Marketing sample by signing in to Power BI and
selecting Get Data > Samples > Sales and Marketing > Connect.

2. When the success message appears, select View dataset.

3. Power BI opens a blank report canvas in Editing View.

4. From the Fields pane, select the Geo > State field.

5. Convert the chart to a filled map. Notice that State is now in the Location well. Bing Maps uses the field in



7. Select SalesFact > Sentiment to add it to the Color saturation well. The field in the Color saturation well
controls the map shading.

8. The filled map is shaded in green, with light green representing the lower sentiment numbers and dark green
representing the higher, more-positive sentiment. Here I've highlighted the state of Wyoming (WY) and see that
Sentiment is very good, 74.

9. Save the report.

the Location well to create the map. The location can be a variety of valid locations: countries, states,
counties, cities, zip codes or other postal codes etc. Bing Maps provides filled map shapes for locations
around the world. Without a valid entry in the Location well, Power BI cannot create the filled map.

6. Filter the map to display only the continental United States.

a. At the bottom of the Visualizations pane, look for the Filters area.

b. Hover over State and click the expand chevron

c. Place a checkmark next to All and remove the checkmark next to AK.



Highlighting and cross-filtering

Considerations and troubleshooting

For information about using the Filters pane, see Add a filter to a report.

Highlighting a Location in a Filled Map cross-filters the other visualizations on the report page... and vice versa.

To follow along, copy and paste your Filled map onto the Sentiment page of the Sales and Marketing report.

1. On the filled map, select a state. This highlights the other visualizations on the page. Selecting Texas, for
example, shows me that Sentiment is 74, Texas is in the Central District #23, and that most of the sales volume
comes from the Moderation and Convenience segments.

2. On the line chart, toggle between No and Yes. This filters the Filled Map to show Sentiment for VanArsdel and
for VanArsdel's competition.

Map data can be ambiguous. For example, there's a Paris, France, but there's also a Paris, Texas. Your geographic
data is probably stored in separate columns – a column for city names, a column for state or province names, etc. –
so Bing may not be able to tell which Paris is which. If your dataset already contains latitude and longitude data,
Power BI has special fields to help make the map data unambiguous. Just drag the field that contains your latitude
data into the Visualizations > Latitude area. And do the same for your longitude data.



Next steps

If you have permissions to edit the dataset in Power BI Desktop, watch this video for help addressing map
ambiguity.

If you do not have access to latitude and longitude data, follow these instructions to update your dataset.

For more help with Map visualizations, see Tips and tricks for map visualizations.

Add the filled map as a dashboard tile (pin the visual)
Add a visualization to a report
Visualization types in Power BI
Change the type of visualization being used
More questions? Try the Power BI Community

https://support.office.com/article/Maps-in-Power-View-8A9B2AF3-A055-4131-A327-85CC835271F7
http://community.powerbi.com/


Funnel charts (Tutorial)
1/23/2018 • 3 min to read • Edit Online

When to use a funnel chart

Working with funnel charts

Create a basic funnel chart

A funnel chart helps you visualize a linear process that has sequential connected stages. For example, a sales funnel
that tracks customers through stages: Lead > Qualified Lead > Prospect > Contract > Close. At a glance, the shape
of the funnel conveys the health of the process you're tracking.

Each funnel stage represents a percentage of the total. So, in most cases, a funnel chart is shaped like a funnel --
with the first stage being the largest, and each subsequent stage smaller than its predecessor. A pear-shaped
funnel is also useful -- it can identify a problem in the process. But typically, the first stage, the "intake" stage, is the
largest.

Funnel charts are a great choice:

when the data is sequential and moves through at least 4 stages.
when the number of "items" in the first stage is expected to be greater than the number in the final stage.
to calculate potential (revenue/sales/deals/etc.) by stages.
to calculate and track conversion and retention rates.
to reveal bottlenecks in a linear process.
to track a shopping cart workflow.
to track the progress and success of click-through advertising/marketing campaigns.

Funnel charts:

Can be pinned from reports and from Q&A.
Can be sorted.
Support multiples.
Can be highlighted and cross-filtered by other visualizations on the same report page.
Can be used to highlight and cross-filter other visualizations on the same report page.

Watch this video to see Will create a Funnel chart using the Sales and Marketing sample.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/power-bi-visualization-funnel-charts.md


Now create your own funnel chart that shows the number of opportunities we have in each of our sales stages.

These instructions use the Opportunity Analysis Sample. To follow along, download the sample for Power BI
service (app.powerbi.com) or Power BI Desktop.

2. Convert the chart to a funnel. Notice that Sales Stage is in the Group well.

1. Start on a blank report page and select the SalesStage > Sales Stage field. If you're using Power BI service,
make sure you open the report in Editing View.

3. From the Fields pane, select Fact > Opportunity Count.

4. Hovering over a bar displays a wealth of information.

The name of the stage
Number of opportunities currently in this stage
Overall conversion rate (% of Lead)
Stage-to-stage (aka Drop Rate) which is the % of the previous stage (in this case, Proposal
Stage/Solution Stage)



Highlighting and cross-filtering

Create a funnel chart in Q&A

5. Add the Funnel as a dashboard tile.
6. Save the report.

For information about using the Filters pane, see Add a filter to a report.

Highlighting a bar in a funnel cross-filters the other visualizations on the report page... and vice versa. To follow
along, add a few more visuals to the report page that contains the funnel chart.

2. To set preferences for how visuals cross-highlight and cross-filter each other, see Visual interactions in Power BI

1. On the funnel, select the Proposal bar. This cross-highlights the other visualizations on the page. Use CTRL
to multi-select.

Open the Opportunity Analysis Sample dashboard, or any other dashboard that has at least one visualization
pinned from the Opportunity Analysis Sample dataset. When you type a question in Q&A, Power BI searches for
answers in all the datasets that are associated with (have tiles pinned to) the selected dashboard. For more
information see, Power BI - basic concepts.

1. On the Opportunity Analysis Sample dashboard, begin typing your question in the Q&A question box.



Next steps

2. Be sure to add "as funnel" so Power BI knows which visualization type you'd prefer.

Visualization types in Power BI

Pin a visualization to a dashboard

Power BI - Basic Concepts

More questions? Try the Power BI Community

http://community.powerbi.com/


KPI visuals (Tutorial)
12/20/2017 • 2 min to read • Edit Online

When to use a KPI

KPI visual requirements

NOTENOTE

How to create a KPI

A Key Performance Indicator (KPI) is a visual cue that communicates the amount of progress made toward a
measurable goal. For more information about KPIs, see Microsoft Developer Network.

KPIs are a great choice:

to measure progress (what am I ahead or behind on?)
to measure distance to a goal (how far ahead or behind am I?)

A Key Performance Indicator (KPI) is based on a specific measure and is designed to help you evaluate the current
value and status of a metric against a defined target. Therefore, a KPI visual requires a base measure that evaluates
to a value and a target measure or value, and a threshold or goal.

Currently, a KPI dataset needs to contain goal values for a KPI. If your dataset doesn't contain one, you can create goals by
adding an Excel sheet with goals to your data model or PBIX file.

To follow along, sign in to Power BI service and select Get Data > Samples > Retail Analysis Sample. We'll
create a KPI that measures the progress we've made toward a sales goal.

Or watch Will show you how to create single metric visuals: gauges, cards, and KPIs.

1. Open the report in Editing view and add a new page.
2. Select Sales > Total Units This Year. This will be the indicator.
3. Add Time > Month. This will be represent the trend.
4. IMPORTANT: Sort the chart by Month. Once you convert the visualization to a KPI, there is no option to sort.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/power-bi-visualization-kpi.md
https://msdn.microsoft.com/library/hh272050


Considerations and troubleshooting

5. Convert the visual to a KPI by selecting the KPI icon from the Visualization pane.

6. Add a goal. Add last years sales as the goal. Drag Total Units Last Year to the Target goals field.

7. Optionally, format the KPI by selecting the paint roller icon to open the Formatting pane.

Indicator - controls the indicator’s display units and decimal places.
Trend axis - when set to On, the trend axis is displayed as the background of the KPI visual.
Goals - when set to On, the visual displays the goal and the distance from the goal as a percentage.
Color coding > Direction - some KPIs are considered better for higher values and some are considered
better for lower values. For example, earnings versus wait time. Typically a higher value of earnings is
better versus a higher value of wait time. Select high is better and, optionally, change the color settings.

8. When you have the KPI as you want it, pin it to a dashboard.

KPIs are also available on your mobile devices – keeping you always connected to your businesses heartbeat.

If your KPI doesn't look like the one above, it may be because you need to sort by month. Since KPIs don't have



Next steps

a sort option, you'll need to sort by month before you convert your visualization to a KPI.

Reports in Power BI

Visualizations in Power BI reports

Power BI - Basic Concepts

More questions? Try the Power BI Community

http://community.powerbi.com/


Radial gauge charts in Power BI (Tutorial)
1/23/2018 • 3 min to read • Edit Online

When to use a radial gauge

PrerequisitesPrerequisites

Create a basic radial gauge

A radial gauge chart has a circular arc and displays a single value that measures progress toward a goal/KPI. The
goal, or target value, is represented by the line (needle). Progress toward that goal is represented by the shading.
And the value that represents that progress is shown in bold inside the arc. All possible values are spread evenly
along the arc, from the minimum (left-most value) to the maximum (right-most value).

In the example below, we are a car retailer, tracking our Sales team's average sales per month. Our goal is 140 and
represented by the black needle. The minimum possible average sales is 0 and we've set the maximum as 200. The
blue shading shows that we're currently averaging approximately 120 sales this month. Luckily, we still have
another week to reach our goal.

Radial gauges are a great choice to:

show progress toward a goal.
represent a percentile measure, like a KPI.
show the health of a single measure.
display information that can be quickly scanned and understood.

Power BI service or Power BI Desktop
Financial sample Excel workbook: download the sample directly.

These instructions use Power BI service. To follow along, sign in to Power BI and open the Excel Financial Sample
file.

Or watch Will show you how to create single metric visuals: gauges, cards, and KPIs.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/power-bi-visualization-radial-gauge-charts.md
http://go.microsoft.com/fwlink/?LinkID=521962


Step 1: Open the Financial Sample Excel fileStep 1: Open the Financial Sample Excel file

Step 2: Create a gauge to track Gross SalesStep 2: Create a gauge to track Gross Sales

1. Download the sample Financial Excel file if you haven't already. Remember where you saved it.

2. Open the file in Power BI service by selecting Get Data > Files and browsing to the location where you
saved the file. Select Import. The Financial Sample is added to your workspace as a dataset.

3. From the Dataset content list, select Financial Sample to open it in Explore mode.

1. In the Fields pane, select Gross Sales.

2. Change the aggregation to Average.



Step 3: Set a target valueStep 3: Set a target value

3. Select the gauge icon  to convert the Column Chart to a gauge.

By default, Power BI creates a Gauge chart where the current value (in this case, Average of Gross Sales) is
assumed to be at the halfway point on the gauge. Since the Average Gross Sales is $182.76K, the start value
(Minimum) is set to 0 and the end value (Maximum) is set to double the current value.

1. Drag COGS to the Target value well.
2. Change the aggregation to Average. Power BI adds a needle to represent our target value of $145.48K.

Notice that we've exceeded our target.



Step 4: Set a maximum valueStep 4: Set a maximum value

Step 5: Save your reportStep 5: Save your report

Use formatting options to manually set Minimum, Maximum, and
Target values

NOTENOTE
You can also manually enter a target value. See "Use formatting options to manually set Minimum, Maximum, and
Target values" below.

In Step 2, Power BI used the Value field to automatically set minimum (start) and maximum (end). But what if you
want to set your own maximum value? Let's say that instead of using double the current value as the maximum
possible value, you want to set it to the highest Gross Sales number in your dataset?

1. Drag Gross Sales from the Fields list to the Maximum Value well.
2. Change the aggregation to Maximum.

The gauge is redrawn with a new end value, 1.21 million in gross sales.

1. Save the report.
2. Add the gauge chart as a dashboard tile.

1. Remove Max of Gross Sales from the Maximum value well.
2. Open the formatting pane by selecting the paint roller icon.



Next steps

6. Optionally, continue formatting your gauge chart.

3. Expand the Gauge axis and enter values for Min and Max.

4. Remove the current target value by removing the checkmark next to COGS.

5. When the Target field appears under Gauge axis, enter a value.

Visualization types in Power BI

Add a visualization to a report

Pin a visualization to a dashboard

Power BI - Basic Concepts

More questions? Try the Power BI Community

http://community.powerbi.com/


Scatter charts and bubble charts in Power BI
(Tutorial)
1/19/2018 • 3 min to read • Edit Online

When to use a scatter chart or bubble chart
Scatter charts are a great choice:Scatter charts are a great choice:

Bubble charts are a great choice:Bubble charts are a great choice:

Create a scatter chart

A scatter chart always has two value axes to show one set of numerical data along a horizontal axis and another set
of numerical values along a vertical axis. The chart displays points at the intersection of an x and y numerical value,
combining these values into single data points. These data points may be distributed evenly or unevenly across the
horizontal axis, depending on the data.

A bubble chart replaces the data points with bubbles, with the bubble size representing an additional dimension of
the data.

You can set the number of data points

to show relationships between 2 (scatter) or 3 (bubble) numerical values.
to plot two groups of numbers as one series of xy coordinates.
instead of a line chart when you want to change the scale of the horizontal axis
to turn the horizontal axis into a logarithmic scale.
to display worksheet data that includes pairs or grouped sets of values. In a scatter chart, you can adjust the
independent scales of the axes to reveal more information about the grouped values.
to show patterns in large sets of data, for example by showing linear or non-linear trends, clusters, and outliers.
to compare large numbers of data points without regard to time. The more data that you include in a scatter
chart, the better the comparisons that you can make.

if your data has 3 data series that each contain a set of values.
to present financial data. Different bubble sizes are useful to visually emphasize specific values.
to use with quadrants.

Watch this video to see Will create a scatter chart and then follow the steps below to create one yourself.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/power-bi-visualization-scatter.md


These instructions use the Retail Analysis Sample. To follow along, download the sample for Power BI service
(app.powerbi.com) or Power BI Desktop.

3. Convert to a scatter chart. In the Visualization pane, select the Scatter chart icon. .

1. Start on a blank report page and select the Sales > Sales Per Sq Ft and Sales > Total Sales Variance %
fields. If you're using Power BI service, make sure you open the report in Editing View.

2. From the Fields pane, select District > District.

4. Drag District from Details to Legend.



Create a bubble chart

We now have a scatter chart that plots Total Sales Variance % along the Y axis, and plots Sales Per Square Feet
along the X axis. The data point colors represent districts. Now let's add a third dimension.

1. From the Fields pane, drag Sales > This Year Sales > Value to the Size area.

2. Hover over a bubble. The size of the bubble reflects the value of This Year Sales.

3. Optionally, format the visualization colors, labels, titles, background, and more.

You can also change the marker shape to diamond, triangle, or square:



NOTENOTE

4. Optionally, to set the number of data points to show in your bubble chart, in the Format section of the
Visualizations pane, expand the General card and adjust the Data Volume. The default is 3500.

Because more data points can mean a longer loading time, if you do choose to publish reports with limits at the
higher end of the scale, make sure to test out your reports across the web and mobile as well to ensure performance
matches your users’ expectations.

5. Optionally, to select the marker shape, expand the Shapes card, then select a marker shape.



Considerations and Troubleshooting
Your scatter chart has only one data pointYour scatter chart has only one data point

Next steps

Does your scatter chart have only one data point that aggregates all the values on the X and Y axes? Or maybe it
aggregates all the values along a single horizontal or vertical line?

Add a field to the Details area to tell Power BI how to group the values. The field must be unique for each point
you want to plot.
Like a simple row number or ID field:

Or if you don’t have that in your data, create a field that concatenates your X and Y values together into something
unique per point:

To create a new field, use the Power BI Desktop Query Editor to add an Index Column to your dataset. Then add
this column to the Details area of your visualization.

Visualization types in Power BI

Try it out -- it's free!

https://powerbi.com/


More questions? Try the Power BI Community

http://community.powerbi.com/


Slicers in Power BI service (Tutorial)
11/15/2017 • 3 min to read • Edit Online

When to use a slicer

Create a slicer

Your VP of Sales wants to be able to look at a number of metrics, for the entire division and for each individual
District Manager. She could create a separate report page for each manager, or she could use a slicer. A slicer
narrows the portion of the dataset shown in the other visualizations on the page. Slicers are an alternate way of
filtering.

Slicers are a great choice in the following situations.

To display commonly-used or important filters on the report canvas for easier access.
To make it easier to see the current filtered state without having to open a drop-down list to find the filtering
details.
When you want to hide columns you don't need but still be able to use them to filter - this makes for narrower,
cleaner tables.
To create more focused reports - since slicers are floating objects you can put them next to the interesting part
of the report you want your users to focus on.

1. Open the Retail Analysis Sample in Editing View and add a new report page.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/power-bi-visualization-slicers.md


Format the slicer

2. From the Fields pane, select District > District Manager.

3. Convert the visualization to a slicer. In the Visualizations pane, select the slicer icon.

1. With the slicer selected, in the Visualizations pane, select the paint roller icon  to display the Format
options.

2. Select General > Outline color and choose dark blue and change the Weight to 6.

3. Under Selection Controls, by default, Select All is Off and Single Select is On. This means that I have to
use the CTRL key to select more than one name at a time. Turn Select All to On and Single Select to Off.



Use the slicer in a report

4. Under Items, increase the text size to 14pt. We want to be sure that our colleagues notice this slicer.

6. Have fun exploring the other options available for slicers.

Notice that the slicer now has a Select All option at the top of the list. Toggle Select All to select all of
the names or to select none of the names.
And you can now select more than one name without having to use the CTRL key.

5. Lastly, set Font color to a dark red. This will distinguish the selected names from the unselected names in
our slicer.

1. Add some additional visualizations to the report page or open the Retail Analysis sample report and select
the District Monthly Sales tab.



2. Slice the report page for Carlos. Notice how the other visualizations update to reflect these selections.

3. Sort the slicer alphabetically by District Manager last name. Select the ellipses (...) in the top right corner of
the slicer and choose District Manager.



Control what effect the slicer has on other visuals on the page

Considerations and troubleshooting slicers in Power BI

Do you want the slicer to only filter some of the visuals on the report page? Use the Visual interactions control to
set this up.

NOTE: If you don't see Visual Interactions, look for its icon instead . If you don't see either, make sure you
are in report Editing view.

1. Select the slicer to make it active and, from the menu bar, choose Visual interactions.

2. Filter controls will appear above all the other visuals on the page. If the slicer should filter a visual, select the
Filter icon. If the slicer should have no effect on the visual, select the None icon.

For more information, see Visual interactions in a Power BI report.

There are a few limitations to using slicers in Power BI, which are the following:

1. Slicers do not support input fields.
2. A single slicer cannot be used across an entire report. A slicer only impacts the current page.



Next steps

3. Slicers cannot be pinned to a dashboard.
4. Drilldown is not supported for slicers.
5. Slicers do not support Visual level filters.

Do you have ideas for how to improve Power BI? Submit an idea.

Add a visualization to a report

Visualization types in Power BI

Power BI - Basic Concepts

Try it out -- it's free!

More questions? Try the Power BI Community

https://ideas.powerbi.com/forums/265200-power-bi-ideas
https://powerbi.com/
http://community.powerbi.com/


Working with tables in Power BI reports and
dashboards (Tutorial)
1/24/2018 • 3 min to read • Edit Online

When to use a table

NOTENOTE

Prerequisites

Create a table

A table is a grid that contains related data in a logical series of rows and columns. It may also contain headers and a
row for totals. Tables work well with quantitative comparisons where you are looking at many values for a single
category. For example, this table displays 5 different measures for Category.

Tables are a great choice:

to see and compare detailed data and exact values (instead of visual representations)
to display data in a tabular format
to display numerical data by categories

If a table has too many values, consider converting it to a matrix and/or using drilldown.

Power BI service or Power BI Desktop
Retail Analysis sample

We'll create the table pictured above to display sales values by item category. To follow along, sign in to Power BI
service and select Get Data > Samples > Retail Analysis Sample > Connect and choose **Go to dashboard.
Creating a visualization requires edit permissions to the dataset and report. Luckily, the Power BI samples are all
editable. If a report has been shared with you, you won't be able to create visualizations in reports.

1. From the left navpane, select Workspaces >My workspace.
2. Select the Datasets tab, and scroll down to the Retail Analysis Sample dataset you just added. Select the

Create report icon.

3. In the report editor, select Item > Category. Power BI automatically creates a table that lists all the

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/power-bi-visualization-tables.md


Format the table

4. Select Sales > Average Unit Price and Sales > Last Year Sales and Sales > This Year Sales and choose all 3
options (Value, Goal, Status).

categories.

5. In the Visualizations pane, locate the Values well and drag-and-drop the values until the order of your chart
columns matches the first image on this page. Your Values well should look like this.

6. Pin the table to the dashboard by selecting the pin icon

There are many many ways to format a table and we'll only cover a few of them here. A great way to learn about

the other formatting options is to open the Formatting pane (paint roller icon ) and explore.

Try formatting the table grid. Here we've added a blue vertical grid, added space to the rows, increased the
outline and text size a bit.



For the column headers we changed the background color, added an outline, and increased the font size.



Conditional formattingConditional formatting

And after some additional formatting, here is our final table. Since there are so many formatting options, the

best way to learn is to start with a plain table, open the Formatting pane  , and start exploring.

One type of formatting is referred to as conditional formatting and is applied to fields in the Values well of the
Visualizations pane in Power BI service or Desktop.

With conditional formatting for tables, you can specify customized cell background colors and font colors based on
cell values, including using gradient colors.

1. In the Visualizations pane in Power BI service or Desktop, select the down-arrow beside the value in the
Values well that you want to format (or right-click the field). You can only manage conditional formatting
for fields in the Values area of the Fields well.

2. Select Background color scales. In the dialog that appears, you can configure the color, as well as the
Minimum and Maximum values. If you select the Diverging box, you can configure an optional Center value
as well.



Let's apply some custom formatting to our Average Unit Price values. Select Diverging, add some colors,
and choose OK.

3. Add a new field to the table that has both positive and negative values. Select Sales > Total Sales
Variance.

4. Add data bar conditional formatting by selecting the down-arrow beside Total Sales Variance and
choosing Conditional formatting > Data bars.

5. In the dialog that appears, set colors for Positive bar, Negative bar, place a checkmark next to Show bar
only, and make any other changes you'd like.



TIPTIP

Adjust the column width of a table

6. To remove conditional formatting from a visualization, just right-click the field again, and select Remove
Conditional Formatting.

When you select OK, data bars replace the numerical values in the table making it easier to scan.

Conditional formatting is also available from the Formatting pane (paintroller icon). Select the value to format and then set
Color scales or Data bars to On to apply the default settings or, to customize the settings, select Advanced controls.

Sometimes Power BI will truncate a column heading in a report and on a dashboard. To show the entire column
name, hover over the space to the right of the heading to reveal the double arrows, select and drag.

More questions? Try the Power BI Community

http://community.powerbi.com/


Treemaps in Power BI (Tutorial)
1/24/2018 • 3 min to read • Edit Online

When to use a treemap

PrerequisitesPrerequisites

Create a basic treemap

Treemaps display hierarchical data as a set of nested rectangles. Each level of the hierarchy is represented by a
colored rectangle (often called a "branch") containing other rectangles ("leaves"). The space inside each rectangle is
allocated based on the quantitative value being measured, with the rectangles arranged in size from top left
(largest) to bottom right (smallest).

For example, if I'm analyzing my sales, I might have top-level rectangles (branches) for the clothing categories:
Urban, Rural, Youth, and Mix. My category rectangles would contain smaller rectangles (leaves) for the clothing
manufacturers within that category, and these smaller rectangles would be sized and shaded based on the number
sold. In the Urban branch above, lots of Maximus clothing was sold, less Natura and Fama, and very little Leo. So,
the Urban branch of my Treemap would have the largest rectangle for Maximus (in the top left corner), slightly-
smaller rectangles for Natura and Fama, lots of other rectangles representing all the other clothing sold, and a tiny
rectangle for Leo. And I could compare the number of items sold across the other clothing categories by comparing
the size and shading of each leaf node; the larger the rectangle and the darker the shading, the higher the value.

Treemaps are a great choice:

to display large amounts of hierarchical data.
when a bar chart can't effectively handle the large number of values.
to show the proportions between each part and the whole.
to show the pattern of the distribution of the measure across each level of categories in the hierarchy.
to show attributes using size and color coding.
to spot patterns, outliers, most-important contributors, and exceptions.

Power BI service or Power BI Desktop
Retail Analysis sample

Want to watch someone else create a treemap first? Skip to 2:10 in this video to watch Amanda create a treemap.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/power-bi-visualization-treemaps.md


Or, create your own treemap. These instructions use the Retail Analysis Sample. To follow along, sign in to Power BI
service (not Desktkop) and select Get Data > Samples > Retail Analysis Sample > Connect > Go to
dashboard. Creating visualizations in a report requires edit permissions to the dataset and report. Luckily, the
Power BI samples are editable. But if someone shares a report with you, you won't be able to add new
visualizations.

1. Select the "Total stores" tile to open the Retail Analysis sample report.
2. Open Editing View and select the Sales > Last Years Sales measure.

3. Convert the chart to a treemap.



4. Drag Item > Category to the Group well. Power BI creates a treemap where the size of the rectangles reflects
total sales and the color represents the category. In essence you've created a hierarchy that visually describes
the relative size of total sales by category. The Mens category has the highest sales and the Hosiery category
has the lowest.

5. Drag Store > Chain to the Details well to complete your treemap. You can now compare last year's sales
by category and chain.



Highlighting and cross-filtering

NOTENOTE

6. Hover over a Chain area to reveal the tooltip for that portion of the Category. For example, hovering over
Lindseys in the 040-Juniors rectangle reveals the tooltip for Lindsey's portion of the Juniors category.

7. Add the treemap as a dashboard tile (pin the visual).
8. Save the report.

Color Saturation and Details cannot be used at the same time.

For information about using the Filters pane, see Add a filter to a report.

Highlighting a Category or Details in a treemap cross-highlights and cross-filters the other visualizations on the
report page... and vice versa. To follow along, either add some visuals to the same page or copy/paste the treemap
to a report page that already has other visuals.

1. On the treemap, select either a Category or a Chain within a Category. This cross-highlights the other
visualizations on the page. Selecting 050-Shoes, for example, shows me that last year's sales for shoes was
$3,640,471 with $2,174,185 of that coming from Fashions Direct.



Next steps

2. In the Last Year Sales by Chain pie chart, selecting the Fashions Direct slice, cross-filters the treemap.

3. To manage how charts cross-highlight and cross-filter each other, see Visualization interactions in a Power
BI report

Pin a visualization to a dashboard
Power BI - Basic Concepts

More questions? Try the Power BI Community

http://community.powerbi.com/


Waterfall charts in Power BI (Tutorial)
1/23/2018 • 2 min to read • Edit Online

When to use a waterfall chart

Create a waterfall chart

A waterfall chart shows a running total as values are added or subtracted. It's useful for understanding how an
initial value (for example, net income) is affected by a series of positive and negative changes.

The columns are color coded so you can quickly tell increases and decreases. The initial and the final value columns
often start on the horizontal axis, while the intermediate values are floating columns. Because of this "look",
waterfall charts are also called bridge charts.

Waterfall charts are a great choice:

when you have changes for the measure across time series or different categories
to audit the major changes contributing to the total value
to plot your company's annual profit by showing various sources of revenue and arrive at the total profit (or
loss).
to illustrate the beginning and the ending headcount for your company in a year
to visualize how much money you make and spend each month, and the running balance for your account.

We'll create a waterfall chart that displays sales variance (estimated sales versus actual sales) by month. To follow
along, sign in to Power BI and select Get Data > Samples > Retail Analysis Sample.

2. From the Fields pane, select Sales > Total Sales Variance. If Total Sales Variance isn't in the Y Axis area,
drag it there.

1. Select the Datasets tab and scroll to the new "Retail Analysis Sample" dataset. Select the Create report icon
to open the dataset in report editing view.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/power-bi-visualization-waterfall-charts.md
https://support.office.com/article/Create-a-waterfall-chart-in-Office-2016-for-Windows-8de1ece4-ff21-4d37-acd7-546f5527f185#BKMK_Float


3. Convert the chart to a Waterfall.

4. Select Time > FiscalMonth to add it to the Category well.

5. Sort the waterfall chart chronologically. From the top-right corner of the chart, select the ellipses (...) and
choose FiscalMonth.

6. Dig in a little more to see what's contributing most to the changes month to month. Drag Store > Territory
to the Breakdown bucket.



7. By default, Power BI adds the top 5 contributors to increases or decreases by month. But we're only
interested in the top 2 contributors. In the Formatting pane, select Breakdown and set Maximum to 2.

A quick review reveals that the territories of Ohio and Pennsylvania are the biggest contributors to
movement, negative and positive, in our waterfall chart.

8. This is an interesting finding. Do Ohio and Pennsylvania have such a significant impact because sales in
these 2 territories are much higher than the other territories? We can check that. Create a map that looks at
sales by territory.



Highlighting and cross-filtering

Next steps

Our map supports our theory. It shows that these 2 territories had the highest value of sales last year
(bubble size) and this year (bubble shading).

For information about using the Filters pane, see Add a filter to a report.

Highlighting a column in a waterfall chart cross-filters the other visualizations on the report page... and vice versa.
However, the Total column does not trigger highlighting or respond to cross-filtering.

Reports in Power BI

Visualization types in Power BI

Visualizations in Power BI reports

Power BI - Basic Concepts

More questions? Try the Power BI Community

http://community.powerbi.com/


Card visualizations
1/3/2018 • 2 min to read • Edit Online

Create a card using the report editor

Sometimes a single number is the most important thing you want to track in your Power BI dashboard or report,
such as total sales, market share year over year, or total opportunities. This type of visualization is called a Card. As
with almost all of the native Power BI visualizations, Cards can be created using the report editor or Q&A.

These instructions use the Retail Analysis Sample. To follow along, download the sample for Power BI service
(app.powerbi.com) or Power BI Desktop.

1. Start on a blank report page and select the Store > Open store count field. If you're using Power BI
service, you'll need to open the report in Editing View.

Power BI creates a column chart with the one number.

2. In the Visualizations pane, select the Card icon.

3. Hover over the card and select the pin icon  to add the visualization to the dashboard.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/power-bi-visualization-card.md


Create a card from the Q&A question box

6. Select Go to dashboard. There, you can edit and move the pinned visualization.

4. Pin the tile to an existing dashboard or to a new dashboard.

Existing dashboard: select the name of the dashboard from the dropdown.
New dashboard: type the name of the new dashboard.

5. Select Pin.

A Success message (near the top right corner) lets you know the visualization was added, as a tile, to your
dashboard.

The Q&A question box is the easiest way to make a Card. The Q&A question box is available in Power BI service
(app.powerbi.com) from a dashboard or report. The steps below describe creating a Card from a Power BI service
dashboard. If you'd like to create a card using Q&A in Power BI Desktop, follow these instructions for the Q&A
preview for Desktop reports.

1. Create a dashboard and get data. This example uses the Opportunity Analysis sample.

2. At the top of your dashboard, start typing what you want to know about your data in the question box.

TIP: From a Power BI service report, in Editing view, select Ask a question from the top menubar. From a
Power BI Desktop report, find some open space in a report and double-click to open a question box.

1. For example, type "number of opportunities" in the question box.

The question box helps you with suggestions and restatements, and finally displays the total number.

https://powerbi.microsoft.com/en-us/blog/power-bi-desktop-december-feature-summary/#QandA


Considerations and troubleshooting

2. Select the pin icon  in the upper-right corner to add the card to a dashboard.

3. Pin the card, as a tile, to an existing dashboard or to a new dashboard.

Existing dashboard: select the name of the dashboard from the dropdown. Your choices will be limited to
only those dashboards withing the current workspace.
New dashboard: type the name of the new dashboard and it will be added to your current workspace.

4. Select Pin.

A Success message (near the upper right corner) lets you know the visualization was added, as a tile, to
your dashboard.

5. Select Go to dashboard to see the new tile. There, you can rename, resize, add a hyperlink, and reposition
the tile, and more on your dashboard.

If you do not see a question box at all, contact your system or tenant administrator.
If you are using Desktop and double-clicking empty space in a report doesn't open Q&A, you may need to
enable it. Select File > Options and Settings > Options > Preview features > Q&A and restart Desktop.



Next steps
Dashboard tiles in Power BI

Dashboards in Power BI

Power BI - Basic Concepts

More questions? Try the Power BI Community

http://community.powerbi.com/


Creating R visuals in the Power BI service
12/6/2017 • 6 min to read • Edit Online

NOTENOTE

The Power BI service supports viewing and interacting with visuals created with R scripts. Visuals created with R
scripts, commonly called R visuals, can present advanced data shaping and analytics such as forecasting, using the
rich analytics and visualization power of R.

The R programming language is among the most widely used programming languages by statisticians, data scientists, and
business analysts. The R language has an open source community that offers over 7,000 add-on packages, as well as widely
used R User Groups. The version of R deployed in the Power BI service is Revolution R Open 3.2.2.

The following image shows a Power BI dashboard with a collection of R visuals used for advanced analytics.

R visuals are created in a Power BI Desktop report, like the report shown in the following image.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-r-visuals.md
https://www.r-project.org/
http://msdsug.microsoft.com/


R scripts security

Once the report is created in Power BI Desktop, you can publish the report containing one or more R visuals to
the Power BI service. R visuals currently can only be created in Power BI Desktop, and then published to the
Power BI service. For more information on creating R visuals, see Create Power BI visuals using R (Power BI
Desktop).

Note that in the service not all of the R packages are supported. See supported packages at the end of this article
for the list of packages currently supported in the Power BI service.

You can download this sample Power BI Desktop file (.pbix file) that contains a few R visuals to see how this works,
and to experiment.

R visuals that are created in Power BI Desktop, and then published to the Power BI service, for the most part
behave like any other visual in the Power BI service; you can interact, filter, slice, and pin them to a dashboard, or
share them with others. For more information about sharing dashboards and visuals, see share a dashboard with
colleagues and others. One difference from other visuals is that R visuals cannot show tool tips and cannot be used
to filter other visuals.

As you can see in the following image, R visuals in the Power BI service, either in dashboards or reports, largely
appear and behave like any other visual, and users don't need to be aware of the underlying R script that created
the visual.

http://download.microsoft.com/download/D/9/A/D9A65269-D1FC-49F8-8EC3-1217E3A4390F/RVisual_correlation_plot_sample SL.pbix


R scripts error experience

Licensing

R visuals are created from R scripts, which could potentially contain code with security or privacy risks.

These risks mainly exist in the authoring phase when the script author run the script on their own computer.

The Power BI service applies a sandbox technology to protect users and the service from security risks.

This sandbox approach imposes some restrictions on the R scripts running in the Power BI service, such as
accessing the Internet, or accessing to other resources that are not required to create the R visual.

When an R script encounters an error, the R visual is not plotted and an error message is displayed. For details on
the error, select See details from the R visual error on the canvas, as shown in the following image.

As another example, the following image shows the error message that appears when an R script failed to run
properly due to a missing R package in Azure.

R visuals require a Power BI Pro license to render in reports, refresh, filter and cross-filter. For more information
about Power BI Pro licenses, and how they differ from free licenses, see Power BI Pro content - what is it?

Free users of Power BI can only consume tiles shared with them. See purchasing Power BI Pro for more
information.

The following table describes R visuals capabilities based on licensing.



Known Limitations
R visuals in the Power BI service have a few limitations:

R visuals support is limited to the packages identified on the following page . There currently is no support for
custom packages.
Data size limitations – data used by the R visual for plotting is limited to 150,000 rows. If more than 150,000
rows are selected, only the top 150,000 rows are used and a message is displayed on the image.
Calculation time limitation – if an R visual calculation exceeds 60 seconds the script times out, resulting in an
error.
R visuals are refreshed upon data updates, filtering, and highlighting. However, the image itself is not interactive
and does not support tool tips.
R visuals respond to highlighting other visuals, but you cannot click on elements in the R visual in order to cross
filter other elements.
R visuals are currently not supported for the Time data type. Please use Date/Time instead.
R Visuals do not display when using Publish to web.
R visuals currently do not print with dashboard and reports printing
R visuals are currently not supported in the DirectQuery mode of Analysis Services
Chinese, Japanese and Korean fonts require all of the additional following steps to work properly in the
Power BI service:

*install.packages("showtext")*

powerbi_rEnableShowTextForCJKLanguages =  1

First, install the R package showtext and all of its dependencies. You can do this by running the
following script:

Next, add the following line at the beginning of the R script:



Overview of R packages

Requirements and Limitations of R packagesRequirements and Limitations of R packages

Supported Packages:Supported Packages:

R packages are collections of R functions, data, and compiled code that are combined in a well-defined format.
When R is installed, it comes with a standard set of packages, and other packages are available for download and
installation. Once installed, an R packages must be loaded into the session to be used. The primary source of free R
packages is CRAN, the Comprehensive R Archive Network.

Power BI Desktop can use any type of R packages without limitation. You can install R packages for use in Power
BI Desktop on your own (using the RStudio IDE, for example).

R visuals in the Power BI service are supported by the packages found in the Supported Packages section found
in this article. If you don't find a package you're interested in among the supported packages list, you can request
the support of the package. See R packages in the Power BI service for information on how to request support.

There are a handful of requirements and limitations for R packages:

The Power BI service, for the most part, supports R packages with free and open-source software licenses such
as GPL-2, GPL-3, MIT+, and so on.
The Power BI service supports packages published in CRAN. The service does not support private or custom R
packages. We encourage users to make their private packages available on CRAN prior to requesting the
package be available in the Power BI service.

For security and privacy reasons, we currently don't support R packages that provide client-server queries over
the World-Wide Web (such as RgoogleMaps) in the service. Networking is blocked for such attempts. See R
packages in the Power BI service for a list of supported and unsupported R packages.
The approval process for including a new R package has a tree of dependencies; some dependencies required to
be installed in the service cannot be supported.

For Power BI Desktop has two variations for R packages:

For R visuals, you can install any package, including custom R packages
For Custom R visuals, only public CRAN packages are supported for auto-installation of the packages

For a long list of supported R packages (and the short list of unsupported packages) please see the following
article:

R packages in the Power BI service

https://cran.r-project.org/web/packages/available_packages_by_name.html
https://www.rstudio.com/


Get data from files
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What does get data from a file really mean?

NOTENOTE

Where your file is saved makes a difference

In Power BI, you can connect to or import data and reports from three types of files.

Microsoft Excel (.xlsx or .xlsm)
Power BI Desktop (.pbix)
Comma Separated Value (.csv)

In Power BI the data you explore comes from a dataset. But in order to have a dataset, you first need to get some
data. For this article, we're going to focus on getting data from files.

To better understand the importance of datasets, and how we get data for them, let’s look at an automobile. Take
a seat in your car and look at the dashboard. That’s a lot like sitting in front of your computer looking at a
dashboard in Power BI. The dashboard shows you all the things your car is doing; how fast the engine is revving,
temperature, what gear you’re in, your speed, etc.

In Power BI, a dataset is like the engine in your car. The dataset provides the data, metrics, and information that’s
displayed in your Power BI dashboard. Of course your engine, or dataset, needs fuel, and in Power BI, that fuel is
data. Your car has a fuel tank that provides gas to the engine. Much the same in Power BI, you need a fuel tank
that has data you can feed to your dataset. In our case, that fuel tank is a Power BI Desktop file, an Excel workbook
file, or a .CSV file.

We can even take it one step further. A fuel tank in a car has to be filled with gas. The gas for our Power BI
Desktop, Excel, or .CSV file is data from another data source. We get data from another data source and put it into
an Excel, Power BI Desktop, or .CSV file. If it's an Excel workbook or .CSV file, we can manually enter rows of data.
Or, we can connect to an external data source to query and load data into our file. Once we have a file with some
data, we can get it into Power BI as a dataset.

Data in Excel workbooks must be in a table, or in the data model, to be imported by Power BI.

Local - If you save your file to a local drive on your computer or another location in your organization, from
Power BI, you can import your file into Power BI. Your file will actually remain on your local drive, so the whole
file isn’t really imported into Power BI. What really happens is a new dataset is created in your Power BI site and
data, and in some cases the data model, are loaded into the dataset. If your file has any reports, those will appear
in your Power BI site under Reports.

OneDrive - Business – If you have OneDrive for Business and you sign into it with the same account you sign
into Power BI with, this is by-far the most effective way to keep your work in Excel Power BI Desktop, or a .CSV file

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-get-data-from-files.md


Ready to get started?

and your dataset, reports, and dashboards in Power BI in-sync. Because both Power BI and OneDrive are in the
cloud, Power BI connects to your file on OneDrive about every hour. If any changes are found, your dataset,
reports, and dashboards are automatically updated in Power BI.

OneDrive - Personal – If you save your files to your own OneDrive account, you’ll get many of the same benefits
as you would with OneDrive for Business. The biggest difference is when you first connect to your file (using Get
Data > Files > OneDrive – Personal) you’ll need to sign in to your OneDrive with your Microsoft account, which is
usually different from what you use to sign in to Power BI. When signing in with your OneDrive with your
Microsoft account, be sure to select the Keep me signed in option. This way, Power BI will be able to connect to
your file about every hour and make sure your dataset in Power BI is in-sync.

SharePoint Team-Sites – Saving your Power BI Desktop files to SharePoint – Team Sites is much the same as
saving to OneDrive for Business. The biggest difference is how you connect to the file from Power BI. You can
specify a URL or connect to the root folder.

See the following articles to learn more about getting your file into Power BI.

Get data from Excel workbook files
Get data from Power BI Desktop files
Get data from Comma Separated Value files



From Excel workbook to stunning report in no time
1/3/2018 • 3 min to read • Edit Online

Prepare your data

Upload your Excel file into Power BI

Your manager wants to see a report on your latest sales figures combined with your last campaign impressions by
the end of the day. But the latest data resides on various third party systems and on files in your laptop. In the past
it’s taken hours to create visuals and format a report. You’re beginning to feel anxious.

No worries. With Power BI, you can create a stunning report in no time.

In this example, we’ll upload an Excel file from a local system, create a new report, and share it with colleagues—all
from within Power BI.

Let’s take a simple Excel file as an example. Before you can load your Excel file into Power BI, you must organize
your data in a flat table. This means that each column contains the same data type--for example, text, date, number,
or currency. You should have a header row, but there should not be any column or row that displays totals.

Next, format your data as a table. In Excel, on the Home tab, in the Styles group, select Format as Table. Select a
table style to apply to your worksheet. Your Excel worksheet is now ready to load into Power BI.

Power BI connects to many data sources, including Excel files that live on your computer. To get started, sign in to
Power BI. If you haven’t signed up, you can do so for free.

You want to create a new dashboard. Open My workspace and select the + Create icon.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-from-excel-to-stunning-report.md
https://powerbi.com


Build your report

Select Dashboard, enter a name, and select Create. The new dashboard displays -- with no data.

At the bottom of the left navigation pane, select Get Data. On the Get Data page, under Import or Connect to Data,
in the Files box, select Get.

On the Files page, select Local File. Navigate to the Excel workbook file on your computer and select it to load into
Power BI. Select Import.

NOTE: To follow along with the rest of this tutorial, use the Financial sample workbook.

After Power BI imports your Excel file, start building your report. When the Your dataset is ready message
appears, select View dataset. Power BI opens in Editing view and displays the report canvas. On the right side are
the Visualizations, Filters, and Fields panes.



Notice that your Excel workbook table data appears in the Fields pane. Under the name of the table, Power BI lists
the column headings as individual fields.

Now you can begin to create visualizations. Your manager wants to see profit over time. In the Fields pane, drag
Profit to the report canvas. Power BI displays a bar chart by default. Next, drag Date to the report canvas. Power BI
updates the bar chart to show profit by date.

TIP: If your chart doesn't look like you expected, check your aggregations. For example, in the Value well, right
click the field you just added and make sure the data is being aggregated the way you'd like it to be. In this
example, we're using Sum.

Your manager wants to know which countries are the most profitable. Impress her with a map visualization. Select
a blank area on your canvas, and from the Fields pane, simply drag over the Country and then Profit fields. Power
BI creates a map visual with bubbles representing the relative profit of each location.



What about displaying a visual showing sales by product and market segment? Easy. In the Fields pane, select the
checkboxes next to the Sales, Product and Segment fields. Power BI creates a bar chart instantly. Change the type of
chart by choosing one of the icons in the Visualizations menu. For instance, change it to a Stacked Bar chart. To sort
the chart, select the ellipses (...) > Sort by.

Pin all of your visuals to your Dashboard. You’re ready to share it with your colleagues.



Share your dashboard
You want to share your dashboard with your manager, Paula. You can share your dashboard and underlying report
with any colleague who has a Power BI account. They can interact with your report, but cannot save changes.

To share your report, at the top of the dashboard, select Share.

Power BI displays the Share Dashboard page. In the top area, enter the email addresses of the recipients. Add a
message in the field below. To allow recipients to share your dashboard with others, select Allow recipients to
share your dashboard. Select Share.



Next steps

Get started with Power BI service
Get started with Power BI Desktop
Power BI - Basic Concepts
More questions? Try the Power BI Community

http://community.powerbi.com/
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What types of workbooks does Power BI support?

Workbooks with ranges or tables of dataWorkbooks with ranges or tables of data

Workbooks with data modelsWorkbooks with data models

NOTENOTE

Workbooks with connections to external data sourcesWorkbooks with connections to external data sources

Workbooks with Power View sheets, PivotTables and chartsWorkbooks with Power View sheets, PivotTables and charts

Data types

Prepare your workbook for Power BI

Microsoft Excel is one of the most widely used business applications around. It’s also one of the most common
ways to get your data into Power BI.

Power BI supports importing or connecting to workbooks created in Excel 2007 and later. Workbooks must be
saved as .xlsx or .xlsm file type and be under 1 GB. Some features described in this article are only available in
later versions of Excel.

If your workbook has simple worksheets with ranges of data, to get the most out of your data in Power BI, be
sure to format those ranges as tables. This way, when creating reports in Power BI, you’ll see named tables and
columns in the Fields pane, making it much easier to visualize your data.

Workbooks can contain a data model with one or more tables of data loaded into it by using linked tables,
Power Query (Get & Transform in Excel 2016), or Power Pivot. Power BI supports all data model properties such
as relationships, measures, hierarchies, and KPIs.

Workbooks with data models cannot be shared across Power BI tenants. For example, a user who logs in to Power BI
using a contoso.com account cannot share an Excel workbook with a user who logs in using a Power BI login account
from woodgrovebank.com.

If you use Excel to connect to an external data source, once your workbook is in Power BI, you can create reports
and dashboards based on data from that connected data source. You can also setup Scheduled Refresh to
automatically connect right to the data source and get updates. You’ll no longer need to refresh manually from
the Data ribbon in Excel. Any visualizations in reports and tiles in dashboards based on data from that data
source are updated automatically. To learn more, see Data refresh in Power BI.

How your PowerView sheets and PivotTables and charts appear, or not appear, in Power BI depends on where
your workbook file is saved and how you choose to get it into Power BI. We'll go into this more below.

Power BI supports the following data types: Whole Number, Decimal Number, Currency, Date, True/False, Text.
Marking data as specific data types in Excel will improve the Power BI experience.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-excel-workbook-files.md


 

Where your workbook file is saved makes a difference

One Excel workbook – two ways to use it

Watch this helpful video to learn more about how to make sure your Excel workbooks are ready for Power BI.

Local - If you save your workbook file to a local drive on your computer or another location in your
organization, from Power BI you can load your file into Power BI. Your file will actually remain on your local
drive, so the whole file isn’t really imported into Power BI. What really happens is a new dataset is created in
Power BI and data and the data model (if any) from the workbook are loaded into the dataset. If your workbook
has any Power View sheets, those will appear in your Power BI site under Reports. Excel 2016 also has the
Publish feature (under the File menu). Using Publish is effectively the same as using Get Data > Files >
Local File from Power BI, but is often easier to update your dataset in Power BI if you’re regularly making
changes to the workbook.

OneDrive - Business – If you have OneDrive for Business and you sign into it with the same account you sign
into Power BI with, this is by-far the most effective way to keep your work in Excel and your dataset, reports,
and dashboards in Power BI in-sync. Because both Power BI and OneDrive are in the cloud, Power BI connects to
your workbook file on OneDrive about every hour. If any changes are found, your dataset, reports, and
dashboards are automatically updated in Power BI. Just like if you saved your workbook to a local drive, you can
also use Publish to update your dataset and reports in Power BI immediately; otherwise Power BI will
automatically synchronize, usually within an hour.

OneDrive - Personal – If you save your workbook files to your own OneDrive account, you’ll get many of the
same benefits as you would with OneDrive for Business. The biggest difference is when you first connect to
your file (using Get Data > Files > OneDrive – Personal) you’ll need to sign in to your OneDrive with your
Microsoft account, which is usually different from what you use to sign in to Power BI. When signing in with
your OneDrive with your Microsoft account, be sure to select the Keep me signed in option. This way, Power BI
will be able to connect to your workbook file about every hour and make sure your dataset and reports in
Power BI are in-sync.

SharePoint Team-Sites – Saving your Power BI Desktop files to SharePoint – Team Sites is much the same as
saving to OneDrive for Business. The biggest difference is how you connect to the file from Power BI. You can
specify a URL or connect to the root folder.

If you save your workbook files to OneDrive, you'll have a couple of ways you can explore your data in Power
BI



 

Import Excel data into Power BIImport Excel data into Power BI

Connect, manage and view Excel in Power BIConnect, manage and view Excel in Power BI

Import or connect to an Excel workbook from Power BI

When you choose Import, any supported data in tables and/or a data model are imported into a new dataset in
Power BI. If you have any Power View sheets, those will be re-created in Power BI as reports.

You can continue editing your workbook. When your changes are saved, they’ll be synchronized with the
dataset in Power BI, usually within about an hour. If you need more immediate gratification, you can just click
Publish again, and your changes are exported right then and there. Any visualizations you have in reports and
dashboards will be updated, too.

Choose this option if you’ve used Get & Transform data or Power Pivot to load data into a data model, or if
your workbook has Power View sheets with visualizations you want to see in Power BI.

In Excel 2016, you can also use Publish > Export. It's pretty much the same thing. To learn more, see Publish to
Power BI from Excel 2016.

When you choose Connect, your workbook will appear in Power BI just like it would in Excel Online. But, unlike
Excel Online, you’ll have some great features to help you pin elements from your worksheets right to your
dashboards.

You can’t edit your workbook in Power BI. But if you need to make some changes, you can click Edit, and then
choose to edit your workbook in Excel Online or open it in Excel on your computer. Any changes you make are
saved to the workbook on OneDrive.

When choosing this way, no dataset is created in Power BI. Your workbook will appear in your Power BI
workspace navigation pane under Reports. Connected workbooks have a special Excel icon.

Choose this option if you only have data in worksheets, or you have ranges, PivotTables and charts you want to
pin to dashboards.

In Excel 2016, you can also use Publish > Upload. It's pretty much the same thing. To learn more, see Publish to
Power BI from Excel 2016.



  Local Excel workbooks

4. If your workbook file is on OneDrive or SharePoint - Team Sites, choose Import or Connect.

1. In Power BI, in the navigation pane, click Get Data.

2. In Files, click Get.

3. Find your file.

You can also use a local Excel file and upload it into Power BI. Simply select Local File from the previous menu,
then navigate to where you have your Excel workbooks saved.

Once selected, choose to Upload your file into Power BI.



Once your workbook is uploaded, you get a notification that the workbook is ready.

Once the workbook is ready, you can find it in the Reports section of Power BI.



Publish from Excel 2016 to your Power BI site

Troubleshooting

Next steps

Using the Publish to Power BI feature in Excel 2016 is effectively the same as using Get Data in Power BI to
import or connect to your file. We won't go into the details here, but you can see Publish to Power BI from Excel
2016 to learn more.

Workbook file too big? Check out Reduce the size of an Excel workbook to view it in Power BI.

Currently, when you choose Import, Power BI only imports data that is part of a named table or a data model.
As a result, if the workbook contains no named tables, Power View sheets, or Excel data models, you might see
this error: "We couldn't find any data in your Excel workbook". This article explains how to fix your
workbook and re-import it.

Explore your data - Once you get data and reports from your file into Power BI, it's time to explore. Just right-
click the new dataset and then click Explore. If you chose to connect to a workbook file on OneDrive in step 4,
your workbook will appear in Reports. When you click on it, it will open in Power BI, just as it would if it were in
Excel Online.

Schedule refresh - If your Excel workbook file connects to external data sources, or you imported from a local
drive, you can setup scheduled refresh to make sure your dataset or report is always up-to-date. In most cases,
setting up scheduled refresh is quite easy to do, but going into the details is outside the scope of this article. See
Data refresh in Power BI to learn more.

Publish to Power BI from Excel 2016

Power BI publisher for Excel

Data refresh in Power BI



Get data from Power BI Desktop files
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Where your file is saved makes a difference

Import or connect to a Power BI Desktop file from Power BI

IMPORTANTIMPORTANT

Power BI Desktop makes business intelligence and reporting easy. Whether you're connecting to a many
different data sources, querying and transforming data, modeling your data, and creating powerful and dynamic
reports, Power BI Desktop makes business intelligence tasks intuitive and fast. If you're not familiar with Power
BI Desktop, check out Getting started with Power BI Desktop.

Once you bring data into Power BI Desktop and create a few reports, it’s time to get your saved file into the
Power BI service.

Local - If you save your file to a local drive on your computer or another location in your organization, you can
import your file or you can publish from Power BI Desktop to get its data and reports into Power BI. Your file will
actually remain on your local drive, so the whole file isn’t really moved into Power BI. What really happens is a new
dataset is created in Power BI and data and the data model from the Power BI Desktop file are loaded into the
dataset. If your file has any reports, those will appear in your Power BI site under Reports.

OneDrive - Business – If you have OneDrive for Business and you sign into it with the same account you sign into
Power BI with, this is by-far the most effective way to keep your work in Power BI Desktop and your dataset,
reports, and dashboards in Power BI in-sync. Because both Power BI and OneDrive are in the cloud, Power BI
connects to your file on OneDrive about every hour. If any changes are found, your dataset, reports, and
dashboards are automatically updated in Power BI.

OneDrive - Personal – If you save your files to your own OneDrive account, you’ll get many of the same benefits
as you would with OneDrive for Business. The biggest difference is when you first connect to your file (using Get
Data > Files > OneDrive – Personal) you’ll need to sign in to your OneDrive with your Microsoft account, which is
usually different from what you use to sign in to Power BI. When signing in with your OneDrive with your
Microsoft account, be sure to select the Keep me signed in option. This way, Power BI will be able to connect to
your file about every hour and make sure your dataset in Power BI is in-sync.

SharePoint Team-Sites – Saving your Power BI Desktop files to SharePoint – Team Sites is much the same as
saving to OneDrive for Business. The biggest difference is how you connect to the file from Power BI. You can
specify a URL or connect to the root folder.

The maximum file size you can import into Power BI is 1 gigabyte.

1. In Power BI, in the navigator pane, click ** Get Data**.

2. In Files, click Get.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-desktop-files.md


Publish a file from Power BI Desktop to your Power BI site

Next steps

3. Find your file. Power BI Desktop files have a .PBIX extension.

Using Publish from Power BI Desktop is effectively the same as using Get Data in Power BI to import your file from
a local drive or connecting to it on OneDrive. Here’s the quick how to, but you can see Publish from Power BI
Desktop to learn more.

1. In Power BI Desktop, click File > Publish > Publish to Power BI, or click Publish on the ribbon.

2. Sign in to Power BI. You'll only need to do this the first time.

When complete, you'll get a link to open your report in your Power BI site.

Explore your data - Once you get data and reports from your file into Power BI, it's time to explore. If your file
already has reports in it, they'll appear in the navigator pane in Reports. If your file just had data, you can create
new reports; just right-click the new dataset and then click Explore.

Refresh external data sources - If your Power BI Desktop file connects to external data sources, you can setup
scheduled refresh to make sure your dataset is always up-to-date. In most cases, setting up scheduled refresh is
quite easy to do, but going into the details is outside the scope of this article. See Data refresh in Power BI to learn
more.



Get data from Comma Separated Value (.CSV) files
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TIPTIP

Where your file is saved makes a difference

Import or connect to a .CSV file

IMPORTANTIMPORTANT

Comma separated value files, often known as a .CSV, are simple text files with rows of data where each value is
separated by a comma. These types of files can contain very large amounts of data within a relatively small file size,
making them an ideal data source for Power BI. You can download a sample .CSV file here.

If you have a .CSV, it’s time to get it into your Power BI site as a dataset where you can begin exploring your data,
create some dashboards, and share your insights with others.

Many organizations output a .CSV with updated data each day. To make sure your dataset in Power BI stays in-sync with
your updated file, be sure the file is saved to OneDrive with the same name.

Local - If you save your .CSV file to a local drive on your computer or another location in your organization, from
Power BI you can import your file into Power BI. Your file will actually remain on your local drive, so the whole file
isn’t really imported into Power BI. What really happens is a new dataset is created in Power BI and data from the
.CSV file is loaded into the dataset.

OneDrive - Business – If you have OneDrive for Business and you sign into it with the same account you sign into
Power BI with, this is by-far the most effective way to keep your .CSV file and your dataset, reports, and dashboards
in Power BI in-sync. Because both Power BI and OneDrive are in the cloud, Power BI connects to your file on
OneDrive about every hour. If any changes are found, your dataset, reports, and dashboards are automatically
updated in Power BI.

OneDrive - Personal – If you save your files to your own OneDrive account, you’ll get many of the same benefits
as you would with OneDrive for Business. The biggest difference is when you first connect to your file (using Get
Data > Files > OneDrive – Personal) you’ll need to sign in to your OneDrive with your Microsoft account, which is
usually different from what you use to sign in to Power BI. When signing into your OneDrive with your Microsoft
account, be sure to select the Keep me signed in option. This way, Power BI will be able to connect to your file about
every hour and make sure your dataset in Power BI is in-sync.

SharePoint Team-Sites – Saving your Power BI Desktop files to SharePoint – Team Sites is much the same as
saving to OneDrive for Business. The biggest difference is how you connect to the file from Power BI. You can
specify a URL or connect to the root folder.

The maximum file size you can import into Power BI is 1 gigabyte.

1. In Power BI, in the navigator pane, click Get Data.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-comma-separated-value-files.md
http://go.microsoft.com/fwlink/?LinkID=619356


Next steps

2. In Files, click Get.

3. Find your file.

Explore your data - Once you get data from your file into Power BI, it's time to explore. Just right-click the new
dataset and then click Explore.

Schedule refresh - If your file is saved to a local drive, you can setup scheduled refresh so your dataset and
reports in Power BI stay up-to-date. To learn more, see Data refresh in Power BI. If your file is saved to OneDrive,
Power BI will automatically synchronize with it about every hour.



Real-time streaming in Power BI
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Types of real-time datasets

Push datasetPush dataset

With Power BI real-time streaming, you can stream data and update dashboards in real-time. Any visual or
dashboard that can be created in Power BI can also be created to display and update real-time data and visuals. The
devices and sources of streaming data can be factory sensors, social media sources, service usage metrics, and
anything else from which time-sensitive data can be collected or transmitted.

This article shows you how to set up real-time streaming dataset in Power BI. But before we get to that, it's
important to understand the types of real-time datasets that are designed to display in tiles (and dashboards), and
how those datasets differ.

There are three types of real-time datasets which are designed for display on real-time dashboards:

Push dataset
Streaming dataset
PubNub streaming dataset

First let's understand how these datasets differ from one another (this section), then we discuss how to push data
into those each of these datasets.

With a push dataset, data is pushed into the Power BI service. When the dataset is created, the Power BI service

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-real-time-streaming.md


Streaming datasetStreaming dataset

PubNub streaming datasetPubNub streaming dataset

Streaming dataset matrixStreaming dataset matrix

automatically creates a new database in the service to store the data. Since there is an underlying database that
continues to store the data as it comes in, reports can be created with the data. These reports and their visuals are
just like any other report visuals, which means you can use all of Power BI’s report building features to create
visuals, including custom visuals, data alerts, pinned dashboard tiles, and more.

Once a report is creating using the push dataset, any of its visuals can be pinned to a dashboard. On that
dashboard, visuals update in real-time whenever the data is updated. Within the service, the dashboard is
triggering a tile refresh every time new data is received.

There are two considerations to note about pinned tiles from a push dataset:

Pinning an entire report using the pin live page option will not result in the data automatically being updated.
Once a visual is pinned to a dashboard, you can use Q&A to ask questions of the push dataset in natural
language. Once you make a Q&A query, you can pin the resulting visual back to the dashboard, and that
dashboard will also update in real-time.

With a streaming dataset, data is also pushed into the Power BI service, with an important difference: Power BI
only stores the data into a temporary cache, which quickly expires. The temporary cache is only used to display
visuals which have some transient sense of history, such as a line chart that has a time window of one hour.

With a streaming dataset, there is no underlying database, so you cannot build report visuals using the data that
flows in from the stream. As such, you cannot make use of report functionality such as filtering, custom visuals, and
other report functions.

The only way to visualize a streaming dataset is to add a tile and use the streaming dataset as a custom streaming
data data source. The custom streaming tiles that are based on a streaming dataset are optimized for quickly
displaying real-time data. There is very little latency between when the data is pushed into the Power BI service and
when the visual is updated, since there’s no need for the data to be entered into or read from a database.

In practice, streaming datasets and their accompanying streaming visuals are best used in situations when it is
critical to minimize the latency between when data is pushed and when it is visualized. In addition, it's best practice
to have the data pushed in a format that can be visualized as-is, without any additional aggregations. Examples of
data that's ready as-is include temperatures, and pre-calculated averages.

With a PubNub streaming dataset, the Power BI web client uses the PubNub SDK to read an existing PubNub data
stream, and no data is stored by the Power BI service.

As with the streaming dataset, with the PubNub streaming dataset there is no underlying database in Power BI,
so you cannot build report visuals against the data that flows in, and cannot take advantage of report functionality
such as filtering, custom visuals, and so on. As such, the PubNub streaming dataset can also only be visualized
by adding a tile to the dashboard, and configuring a PubNub data stream as the source.

Tiles based on a PubNub streaming dataset are optimized for quickly displaying real-time data. Since Power BI is
directly connected to the PubNub data stream, there is very little latency between when the data is pushed into the
Power BI service and when the visual is updated.

The following table (or matrix, if you like) describes the three types of datasets for real-time streaming, and lists
capabilities and limitations of each.



NOTENOTE

Pushing data to datasets

Using Power BI REST APIs to push dataUsing Power BI REST APIs to push data

NOTENOTE

See this MSDN article for information on Push limits on how much data can be pushed in.

The previous section described the three primary types of real-time datasets you can use in real-time streaming,
and how they differ. This section describes how to create and push data into those datasets.

There are three primary ways you can push data into a dataset:

Using the Power BI REST APIs
Using the Streaming Dataset UI
Using Azure Stream Analytics

Let's take a look at each of those approaches in turn.

Power BI REST APIs can be used to create and send data to push datasets and to and streaming datasets. When
you create a dataset using Power BI REST APIs, the defaultMode flag specifies whether the dataset is push or
streaming. If no defaultMode flag is set, the dataset defaults to a push dataset.

If the defaultMode value is set to pushStreaming, the dataset is both a push and streaming dataset, providing the
benefits of both dataset types. The REST API article for Create dataset demonstrates creating a streaming dataset,
and shows the defaultMode flag in action.

When using datasets with the defaultMode flag set to pushStreaming, if a request exceeds the 15Kb size restriction for a
streaming dataset, but is less than the 16MB size restriction of a push dataset, the request will succeed and the data will be
updated in the push dataset. However, any streaming tiles will temporarily fail.

https://msdn.microsoft.com/library/dn950053.aspx
https://msdn.microsoft.com/library/mt203562.aspx


Using the Streaming Dataset UI to push dataUsing the Streaming Dataset UI to push data

Once a dataset is created, use the REST APIs to push data using the Add rows API, as demonstrated in this article.

All requests to REST APIs are secured using Azure AD OAuth.

In the Power BI service, you can create a dataset by selecting the API approach as shown in the following image.

When creating the new streaming dataset, you can select to enable Historic data analysis as shown below, which
has a significant impact.

https://msdn.microsoft.com/library/mt203561.aspx
https://msdn.microsoft.com/library/mt203561.aspx


NOTENOTE

Using Azure Stream Analytics to push dataUsing Azure Stream Analytics to push data

C a u t i o nC a u t i o n

When Historic data analysis is disabled (it is disabled by default), you create a streaming dataset as described
earlier in this article. When Historic data analysis is enabled, the dataset created becomes both a streaming
dataset and a push dataset. This is equivalent to using the Power BI REST APIs to create a dataset with its
defaultMode set to pushStreaming, as described earlier in this article.

For streaming datasets created using the Power BI service UI, as described in the previous paragraph, Azure AD
authentication is not required. In such datasets, the dataset owner receives a URL with a rowkey, which authorizes the
requestor to push data into the dataset with out using an Azure AD OAuth bearer token. Take now, however, that the Azure
AD (AAD) approach still works to push data into the dataset.

You can add Power BI as an output within Azure Stream Analytics (ASA), and then visualize those data streams in
the Power BI service in real time. This section describes technical details about how that process occurs.

Azure Stream Analytics uses the Power BI REST APIs to create its output data stream to Power BI, with defaultMode
set to pushStreaming (see earlier sections in this article for information on defaultMode), which results in a dataset
that can take advantage of both push and streaming. During creation of the dataset, Azure Stream Analytics also
sets the *retentionPolicy flag to basicFIFO; with that setting, the database supporting its push dataset stores
200,000 rows, and after that limit is reached, rows are dropped in a first-in first-out (FIFO) fashion.

If your Azure Stream Analytics query results in very rapid output to Power BI (for example, once or twice per
second), Azure Stream Analytics will begin batching those outputs into a single request. This may cause the request
size to exceed the streaming tile limit. In that case, as mentioned in previous sections, streaming tiles will fail to



Set up your real-time streaming dataset in Power BI

render. In such cases, the best practice is to slow the rate of data output to Power BI; for example, instead of a
maximum value every second, set it to a maximum over 10 seconds.

Now that we've covered the three primary types of datasets for real-time streaming, and the three primary ways
you can push data into a dataset, let's get your real-time streaming dataset working in Power BI.

To get started with real-time streaming, you need to choose one of the two ways that streaming data can be
consumed in Power BI:

tiles with visuals from streaming data
datasets created from streaming data that persist in Power BI

With either option, you'll need to set up Streaming data in Power BI. To do this, in your dashboard (either an
existing dashboard, or a new one) select Add a tile and then select Custom streaming data.

If you don't have streaming data set up yet, don't worry - you can select manage data to get started.



On this page, you can input the endpoint of your streaming dataset if you already have one created (into the text
box). If you don't have a streaming dataset yet, select the plus icon ( + ) in the upper right corner to see the
available options to create a streaming dataset.

When you click on the + icon, you see two options:



Create your streaming dataset with the option you like best

Using the POWER BI REST APIUsing the POWER BI REST API

The next section describes these options, and goes into more detail about how to create a streaming tile or how to
create a dataset from the streaming data source, which you can then use later to build reports.

There are two ways to create a real-time streaming data feed that can be consumed and visualized by Power BI:

Power BI REST API using a real-time streaming endpoint
PubNub

The next sections look at each option in turn.

Power BI REST API - Recent improvements to the Power BI REST API are designed to make real-time streaming



Using PubNubUsing PubNub

easier for developers. When you select API from the New streaming dataset window, you're presented with
entries to provide that enable Power BI to connect to and use your endpoint:

If you want Power BI to store the data that's sent through this data stream, enable Historic data analysis and you'll
be able to do reporting and analysis on the collected data stream. You can also learn more about the API.

Once you successfully create your data stream, you're provided with a REST API URL endpoint, which you
application can call using POST requests to push your data to Power BI streaming data dataset you created.

When making POST requests, you should ensure the request body matches the sample JSON provided by the
Power BI user interface. For example, wrap your JSON objects in an array.

With the integration of PubNub streaming with Power BI, you can use your low-latency PubNub data streams (or
create new ones) and use them in Power BI. When you select PubNub and then select Next, you see the following
window:

https://msdn.microsoft.com/library/dn877544.aspx


WARNINGWARNING

Example of using real time streaming in Power BI

PubNub channels can be secured by using a PubNub Access Manager (PAM) authentication key. This key will be shared with
all users who have access to the dashboard. You can learn more about PubNub access control.

PubNub data streams are often high volume, and are not always suitable in their original form for storage and
historical analysis. To use Power BI for historical analysis of PubNub data, you'll have to aggregate the raw PubNub
stream and send it to Power BI. One way to do that is with Azure Stream Analytics.

Here's a quick example of how real time streaming in Power BI works. You can follow along with this sample to see
for yourself the value of real time streaming.

In this sample, we use a publicly available stream from PubNub. Here are the steps:

1. In the Power BI service, select a dashboard (or create a new one) and select Add tile > Custom Streaming
Data and then select the Next button.

https://www.pubnub.com/docs/web-javascript/pam-security
https://azure.microsoft.com/services/stream-analytics/


2. If you don't have and streaming data sources yet, select the manage data link (just above the Next button),
then select + Add streaming data from the link in the upper-right of the window. Select PubNub and then
select Next.

sub-c-5f1b7c8e-fbee-11e3-aa40-02ee2ddab7fe

pubnub-sensor-network

3. Create a name for your dataset, then paste in the following values into the window that appears, then select
Next:

Subscribe key:

Channel:



4. In the following window, just select the defaults (which are automatically populated), then select Create.



5. Back in your Power BI workspace, create a new dashboard and then add a tile (see above for steps, if you
need them). This time when you create a tile and select Custom Streaming Data, you have a streaming
data set to work with. Go ahead and play around with it. Adding the number fields to line charts, and then
adding other tiles, you can get a real time dashboard that looks like the following:



Questions and answers

Can I use filters on push dataset? How about streaming dataset?Can I use filters on push dataset? How about streaming dataset?

How do I see the latest value on a push dataset? How about streaming dataset?How do I see the latest value on a push dataset? How about streaming dataset?

Can I connect to push or streaming datasets in Power BI Desktop?Can I connect to push or streaming datasets in Power BI Desktop?

Given the previous question, how can I do any modeling on real-time datasets?Given the previous question, how can I do any modeling on real-time datasets?

Give it a try, and play around with the sample dataset. Then go create your own datasets, and stream live data to
Power BI.

Here are some common questions about real-time streaming in Power BI, and answers.

Unfortunately, streaming datasets do not support filtering. For push datasets, you can create a report, filter the
report, and then pin the filtered visuals to a dashboard. However, there is no way to change the filter on the visual
once it's on the dashboard.

Separately, you can pin the live report tile to the dashboard, in which case you can change the filters. However, live
report tiles will not update in real-time as data is pushed in – you'll have to manually update the visual by using the
refresh dashboard tiles option in the More menu.

When applying filters to push datasets with DateTime fields with millisecond precision, equivalence operators are
not supported. However, operators such as greater than (>) or less than (<) do operate properly.

Streaming datasets are designed for displaying the latest data. You can use the Card streaming visual to easily see
latest numeric values. Unfortunately, the card does not support data of type DateTime or Text. For push datasets,
assuming you have a timestamp in the schema, you can try creating a report visual with the last N filter.

Unfortunately, this is not available at this time.

Modeling is not possible on a streaming dataset, since the data is not stored permanently. For a push dataset, you
can use the update dataset/table REST APIs to add measures and relationships. You can get more information from
the Update Table Schema article, and the Dataset properties article.

https://msdn.microsoft.com/library/mt203560.aspx
https://msdn.microsoft.com/library/mt742155.aspx


How can I clear all the values on a push dataset? How about streaming dataset?How can I clear all the values on a push dataset? How about streaming dataset?

I set up an Azure Stream Analytics output to Power BI, but I don’t see it appearing in Power BI – what’s wrong?I set up an Azure Stream Analytics output to Power BI, but I don’t see it appearing in Power BI – what’s wrong?

Next steps

On a push dataset, you can use the delete rows REST API call. Separately, you can also use this handy tool, which is
a wrapper around the REST APIs. There is currently no way to clear data from a streaming dataset, though the data
will clear itself after an hour.

Here’s a checklist you can use to troubleshoot the issue:

1. Restart the Azure Stream Analytics job (jobs created before the streaming GA release will require a restart)
2. Try re-authorizing your Power BI connection in Azure Stream Analytics
3. Which workspace did you specify in the Azure Stream Analytics output? In the Power BI service, are you

checking in that (same) workspace?
4. Does the Azure Stream Analytics query explicitly output to the Power BI output? (using the INTO keyword)
5. Does the Azure Stream Analytics job have data flowing through it? The dataset will only get created when there

is data being transmitted.
6. Can you look into the Azure Stream Analytics logs to see if there are any warnings or errors?

Here are a few links you might find useful when working with real-time streaming in Power BI:

Overview of the Power BI REST API with real-time data
Power BI REST API limitations
REST API article for Create dataset
Add Rows Power BI REST API
Azure Stream Analytics

https://msdn.microsoft.com/library/dn877544.aspx
https://msdn.microsoft.com/library/dn950053.aspx
https://msdn.microsoft.com/library/mt203562.aspx
https://msdn.microsoft.com/library/mt203561.aspx
https://azure.microsoft.com/services/stream-analytics/
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To publish your Excel workbook

Local file publishingLocal file publishing

IMPORTANTIMPORTANT

With Excel 2016, you can publish your Excel workbooks right to your Power BI site, where you can create highly
interactive reports and dashboards based on your workbook’s data. You can then share your insights with others
in your organization.

Before we go any further, there are few things to keep in mind:

Before you can publish to Power BI, your workbook must be saved to OneDrive for Business.
The account you use to sign in to Office, OneDrive for Business, and Power BI must be the same account.
You cannot publish an empty workbook or a workbook that doesn’t have any Power BI supported content.
You cannot publish encrypted or password protected workbooks, or workbooks with Information Protection
Management.
Publishing to Power BI requires modern authentication be enabled (default). If disabled, the Publish option is
not available from the File menu.

In Excel, select File > Publish.

Starting in the February 2017 update, Excel 2016 supports publishing of local Excel files. They do not need to be
saved to OneDrive for Business or SharePoint Online.

Only Excel 2016 with an Office 365 subscription will see the experience to publish with local files. Excel 2016 standalone
installation will still have the "Publish" only behavior which requires the excel workbook be saved to OneDrive for Business
or SharePoint Online.

When you select Publish, you will be able to select the workspace you want to publish to. This can be your
personal or group workspace that you have access to.

you’ll get two options on how to get your workbook into Power BI.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-publish-from-excel.md
https://powerbi.microsoft.com


Publishing from Excel StandalonePublishing from Excel Standalone

Once published, it is kept as a copy in Power BI, separate from teh local file. If you want to update the file in Power
BI, you need to publish the updated version again. You can refresh teh data and set scheduled refresh on the
workbook or the dataset in Power BI.

If your workbook isn’t already saved to OneDrive, you’ll need to save it there first. Select Save to Cloud and
choose a location in OneDrive for Business.

Once your workbook is saved to OneDrive, when you select Publish, you’ll get two options on how to get your
workbook into Power BI.



Upload your workbook to Power BIUpload your workbook to Power BI

Export workbook data to Power BIExport workbook data to Power BI

Publishing

When you choose this option, your workbook will appear in Power BI just like it would in Excel Online. But, unlike
Excel Online, you’ll have some great features to help you pin elements from your worksheets to dashboards.

You can’t edit your workbook in when open in Power BI, but if you need to make some changes, you can select
Edit, and then choose to edit your workbook in Excel Online or open it in Excel on your computer. Any changes
you make are saved to the workbook on OneDrive.

When you upload, no dataset is created in Power BI. Your workbook will appear in Reports, in your workspace
navigation pane. Workbooks uploaded to Power BI have a special Excel icon, identifying them as Excel workbooks
that have been uploaded.

Choose this option if you only have data in worksheets, or you have PivotTables and Charts you want to see in
Power BI. Using Upload from Publish to Power BI in Excel is pretty much the same as using Get Data > File >
OneDrive for Business > Connect, Manage and View Excel in Power BI from Power BI in your browser.

When you choose this option, any supported data in tables and/or a data model are exported into a new dataset in
Power BI. If you have any Power View sheets, those will be re-created in Power BI as reports.

You can continue editing your workbook. When your changes are saved, they’ll be synchronized with the dataset
in Power BI, usually within about an hour. If you need more immediate gratification, you can just select Publish
again, and your changes are exported right then and there. Any visualizations you have in reports and dashboards
will be updated, too.

Choose this option if you’ve used Get & Transform data or Power Pivot to load data into a data model, or if your
workbook has Power View sheets with visualizations you want to see in Power BI.

Using Export from Publish to Power BI in Excel is pretty much the same as using Get Data > File > OneDrive for
Business > Export Excel data into Power BI from Power BI in your browser.

When you choose either option, Excel will sign in to Power BI with your current account, and then publish your
workbook to your Power BI site. Keep an eye on the status bar in Excel. It shows how things are going.



Next steps

When complete, you can go to Power BI right from Excel.

Excel data in Power BI
More questions? Try the Power BI Community

http://community.powerbi.com/


Reduce the size of an Excel workbook to view it in
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What makes core worksheet contents larger than 10 MB

Remove data from worksheets

You can upload any Excel workbook smaller than 1 GB to Power BI. An Excel workbook can have two parts: a Data
Model, and the rest of the report—the core worksheet contents. If the report meets the following size limits, you
can save it to OneDrive for Business, connect to it from Power BI, and view it in Excel Online:

The workbook as a whole can be up to 1 GB.
The core worksheet contents can be up to 10 MB.

Here are some elements that can make the core worksheet contents larger than 10 MB:

Images.
Shaded cells. Remove a cell shading format.
Colored worksheets. Remove a sheet background.
Text boxes.
Clip art.

Consider removing these elements, if possible.

If the report has a Data Model, you have some other options:

Remove data from Excel worksheets, and store it in the Data Model instead. See “Remove data from
worksheets” below for details.
Create a memory-efficient Data Model to reduce the overall size of the report.

To make any of these changes, you need to edit the workbook in Excel.

Read more about file size limits for Excel workbooks in SharePoint Online.

If you import data into Excel from the Power Query tab or the Excel Data tab, the workbook might have the same
data in an Excel table and in the Data Model. Large tables in Excel worksheets may make the core worksheet
contents more than 10 MB. Removing the table in Excel and keeping the data in the Data Model can greatly reduce
the core worksheet contents of the report.

When you import data into Excel, follow these tips:

From the Excel Data tab, if you previously checked Table in the import wizard: Go to Existing Connections
> click the connection > Only create connection. Delete the original table or tables created during the initial
import.
From the Excel Data tab: don’t check Table in the Import Data box.

In Power Query: Clear the Load to worksheet box.

The data is imported only into the Data Model, with no data in Excel worksheets.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/reduce-the-size-of-an-excel-workbook.md
https://support.office.com/article/Add-or-change-the-background-color-of-cells-ac10f131-b847-428f-b656-d65375fb815e
https://support.office.com/en-US/article/add-or-remove-a-sheet-background-3577a762-8450-4556-96a2-cc265abc00a8
https://support.office.com/article/Create-a-memory-efficient-Data-Model-using-Excel-2013-and-the-Power-Pivot-add-in-951c73a9-21c4-46ab-9f5e-14a2833b6a70
https://support.office.com/article/File-size-limits-for-workbooks-in-SharePoint-Online-9e5bc6f8-018f-415a-b890-5452687b325e


Workbook Size Optimizer

Related info

If your workbook contains a data model, you can run the workbook size optimizer to reduce the size of your
workbook. Download Workbook Size Optimizer.

Create a memory-efficient Data Model

Use OneDrive for Business links in Power BI Desktop

https://www.microsoft.com/en-us/download/details.aspx?id=38793
https://support.office.com/article/Create-a-memory-efficient-Data-Model-using-Excel-2013-and-the-Power-Pivot-add-in-951c73a9-21c4-46ab-9f5e-14a2833b6a70
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Using the 'Open in Power BI' button

Connecting through Power BI

Azure SQL Data Warehouse with DirectQuery allows you to create dynamic reports based on data and metrics you
already have in Azure SQL Data Warehouse. With DirectQuery, queries are sent back to your Azure SQL Data
Warehouse in real time as you explore the data. This, combined with the scale of SQL Data Warehouse enables
users to create dynamic reports in minutes against terabytes of data. In addition, the introduction of the Open in
Power BI button allows users to directly connect Power BI to their SQL Data Warehouse without having to
manually specify the information.

When using the SQL Data Warehouse connector:

Specify the fully qualified server name when connecting (see below for details)
Ensure firewall rules for the server are configured to "Allow access to Azure services"
Every action such as selecting a column or adding a filter will directly query the data warehouse
Tiles are set to refresh approximately every 15 minutes and refresh does not need to be scheduled. This can be
adjusted in the Advanced settings when you connect.
Q&A is not available for DirectQuery datasets
schema changes are not picked up automatically

These restrictions and notes may change as we continue to improve the experiences. The step to connect are
detailed below.

The easiest way to move between your SQL Data Warehouse and Power BI is with the Open in Power BI button
within the Azure Preview Portal. This button allows you to seamlessly begin creating new dashboards in Power BI.

1. To get started, navigate to your SQL Data Warehouse instance in the Azure Preview Portal. Please note that SQL
Data Warehouse only have a presence in the Azure Preview portal at this time.

3. If we are not able to sign you in directly or if you do not have a Power BI account, you will need to sign in.
4. You will be directed to the SQL Data Warehouse connection page, with the information from your SQL Data

Warehouse pre-populated. Enter your credentials and hit connect to create a connection.

2. Click the Open in Power BI button

SQL Data Warehouse is also listed on the Power BI Get Data page.

1. Select Get Data at the bottom of the left navigation pane.

2. Within Databases, select Get.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-azure-sql-data-warehouse-with-direct-connect.md


3. Select SQL Data Warehouse > Connect.

4. Enter the necessary information to connect. The Finding Parameters section below shows where this data
can be located in your Azure Portal.



NOTENOTE
The username will be a user that is defined in your Azure SQL Data Warehouse instance.

5. Drill into the dataset by selecting the new tile or the newly created dataset, indicated by the asterisk. This
dataset will have the same name as your database.



Finding Parameter Values

6. You can explore all of the tables and columns. Selecting a column will send a query back to the source,
dynamically creating your visual. Filters will also be translated into queries back to your data warehouse.
These visuals can be saved in a new report and pinned back to your dashboard.

Your fully qualified server name and database name can be found in the Azure Preview Portal. Please note that SQL
Data Warehouse only have a presence in the Azure Preview portal at this time.



Next steps
Get started with Power BI
Get Data for Power BI
Azure SQL Data Warehouse
More questions? Try the Power BI Community

https://azure.microsoft.com/en-us/documentation/services/sql-data-warehouse/
http://community.powerbi.com/
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Power BI Desktop and DirectQuery

Single sign-on

Learn how you can connect directly to Azure SQL Database and create reports that use live data. You can keep your
data at the source and not in Power BI.

With DirectQuery, queries are sent back to your Azure SQL Database as you explore the data in the report view.
This experience is suggested for users who are familiar with the databases and entities they connect to.

Notes:

Specify the fully qualified server name when connecting (see below for more details)
Ensure firewall rules for the database are configured to "Allow access to Azure services"
Every action such as selecting a column or adding a filter will send a query back to the database
Tiles are refreshed every hour (refresh does not need to be scheduled). This can be adjusted in the Advanced
settings when you connect.
Q&A is not available for DirectQuery datasets
Schema changes afre not picked up automatically

These restrictions and notes may change as we continue to improve the experiences. The steps to connect are
detailed below.

In order to connect to Azure SQL Database using DirectQuery, you will need to use Power BI Desktop. This
approach provides additional flexability and capabilities. Reports created using Power BI Desktop can then be
published to the Power BI service. You can learn more about how to connect to Azure SQL Database using
DirectQuery within Power BI Desktop.

After you publish an Azure SQL DirectQuery dataset to the service, you can enable single sign-on (SSO) via Azure
Active Directory (Azure AD) OAuth2 for your end users.

To enable SSO, go to settings for the dataset, open the Data Sources tab, and check the SSO box.

When the SSO option is enabled and your users access reports built atop the data source, Power BI sends their

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-azure-sql-database-with-direct-connect.md
https://msdn.microsoft.com/library/azure/ee621782.aspx


Finding Parameter Values

Next steps

authenticated Azure AD credentials in the queries to the Azure SQL database. This enables Power BI to respect the
security settings that are configured at the data source level.

The SSO option takes affect across all datasets that use this data source. It does not affect the authentication
method used for import scenarios.

Your fully qualified server name and database name can be found in the Azure Portal.

Use DirectQuery in Power BI Desktop



Get started with Power BI
Get Data for Power BI
More questions? Try the Power BI Community

http://community.powerbi.com/
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WARNINGWARNING

Spark on Azure HDInsight with DirectQuery allows you to create dynamic reports based on data and metric you
already have in your Spark cluster. With DirectQuery, queries are sent back to your Azure HDInsight Spark cluster
as you explore the data in the report view. This experience is suggested for users who are familiar with the entities
they connect to.

Automatic tile refresh has been disabled for dashboard tiles built on Spark based datasets. You can select Refresh
Dashboard Tiles to refresh manually. Reports are not impacted and should remain up-to-date.

You can use the following steps to connect to your Spark on Azure HDInsight data source using DirectQuery within
the Power BI service.

1. Select Get Data at the bottom of the left navigation pane.

2. Select Databases & More.

3. Select the Spark on HDInsight connector and choose Connect.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/spark-on-hdinsight-with-direct-connect.md


4. Enter the name of the server you want to connect to, as well as your username and password. The server
is always in the form <clustername>.azurehdinsight.net, see more details about finding these values below.

5. Once connected, you'll see a new dataset with named “SparkDataset”. You can also access the dataset
through the placeholder tile that is created.



Finding your Spark on HDInsight parameters

Limitations

Troubleshooting

6. Drilling into the dataset, you can explore all of the tables and columns in your database. Selecting a column will
send a query back to the source, dynamically creating your visual. These visuals can be saved in a new report,
and pinned back to your dashboard.

The server is always in the form <clustername>.azurehdinsight.net, and can be found in the Azure portal.

The username and password can also be found in the Azure portal.

These restrictions and notes may change as we continue to improve the experiences. Additional documentation can
be found at Use BI tools with Apache Spark on Azure HDInsight

The Power BI service only supports a configuration of Spark 2.0 and HDInsight 3.5.
Every action such as selecting a column or adding a filter will send a query back to the database – before
selecting very large fields, consider choosing an appropriate visual type.
Q&A is not available for DirectQuery datasets.
Schema changes are not picked up automatically.
Power BI supports 16,000 columns across all tables within a dataset. Power BI also includes an internal row
number column per table. This means if you have 100 tables in the dataset, the available number of columns
would be 15,900. Depending on the amount of data you are working with from your Spark data source, you
may encounter this limitation.

If you're hitting issues executing queries against your cluster, verify the application is still running and restart if
necessary.

You can also allocate additional resources within the Azure portal under Configuration > Scale Cluster:

https://azure.microsoft.com/documentation/articles/hdinsight-apache-spark-use-bi-tools/


Next steps
Get started: Create Apache Spark cluster on HDInsight Linux and run interactive queries using Spark SQL
Get started with Power BI
Get Data for Power BI
More questions? Try the Power BI Community

https://azure.microsoft.com/documentation/articles/hdinsight-apache-spark-jupyter-spark-sql
http://community.powerbi.com/


SQL Server Analysis Services live data in Power BI
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IMPORTANTIMPORTANT

To connect to a model from Get data

In Power BI, there are two ways you can connect to a live SQL Server Analysis Services server. In Get data, you can
connect to a SQL Server Analysis Services server, or you can connect to a Power BI Desktop file, or Excel workbook,
that already connects to an Analysis Services server.

In order to connect to a live Analysis Services server, an on-premises data gateway must be installed and configured by
an administrator. For more information, see On-premises data gateway.
When you use the gateway, your data remains on-premises. The reports you create based on that data are saved in the
Power BI service.
Q&A natural language querying is in preview for Analysis Services live connections.

1. In My Workspace, select Get data. You can also change to a group workspace, if one is available.

2. Select Databases & More.

3. Select SQL Server Analysis Services > Connect.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/sql-server-analysis-services-tabular-data.md


Dashboard tiles

Next steps

4. Select a server. If you don't see any servers listed here, it means either a gateway, and data source, are not
configured, or your account is not listed in the Users tab of the data source, in the gateway. Check with your
adminsitrator.

5. Select the model you want to connect to. This could be either Tabular or Multidimensional.

After you connect to the model, it will appear in your Power BI site in My Workspace/Datasets. If you were
swtiched to a group workspace, then the dataset will appear within the group.

If you pin visuals from a report to the dashboard, the pinned tiles are automatically refreshed every 10 minutes. If
the data in your on-premises Analysis Services server is updated, the tiles will get auto-updated after 10 minutes.

On-premises data gateway
Manage Analysis Services data sources
Troubleshooting the on-premises data gateway
More questions? Try the Power BI Community

http://community.powerbi.com/
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Azure SQL Database and Power BIAzure SQL Database and Power BI

Transform, shape, and merge your cloud dataTransform, shape, and merge your cloud data

With Azure services and Power BI, you can turn your data processing efforts into analytics and reports that
provide real-time insights into your business. Whether your data processing is cloud-based or on-premises,
straightforward or complex, single-sourced or massively scaled, warehoused or real-time, Azure and Power BI have
the built-in connectivity and integration to bring your business intelligence efforts to life.

Power BI has a multitude of Azure connections available, and the business intelligence solutions you can create
with those services are as unique as your business. You can connect as few as one Azure data source, or a handful,
then shape and refine your data to build customized reports.

You can start with a straightforward connection to an Azure SQL Database, and create reports to monitor the
progress of your business. Using the Power BI Desktop, you can create reports that identify trends and key
performance indicators that move your business forward.

There's plenty more information for you to learn about Azure SQL Database.

Do you have more complex data, and all sorts of sources? No problem. With Power BI Desktop and Azure
services, connections are just a tap of the Get Data dialog away. Within the same Query you can connect to your
Azure SQL Database, your Azure HDInsight data source, and your Azure Blob Storage (or Azure Table
Storage), then select only the subsets within each that you need, and refine it from there.

You can create different reports for different audiences too, using the same data connections and even the same
Query. Just build a new report page, refine your visualizations for each audience, and watch it keep the business in
the know.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-azure-and-power-bi.md
http://azure.microsoft.com/services/sql-database/


Get complex (and ahead) using Azure Services and Power BIGet complex (and ahead) using Azure Services and Power BI

Connect your app data using Power BI APIsConnect your app data using Power BI APIs

For more information, take a look at the following resources:

Azure SQL Database
Azure HDInsight
Azure Storage (Blob storage and Table storage)

You can expand as much as you need with Azure and Power BI. Harness multi-source data processing, make use of
massive real-time systems, use Stream Analyticsand Event Hubs, and coalesce your varied SaaS services into
business intelligence reports that give your business an edge.

http://azure.microsoft.com/services/sql-database/
http://azure.microsoft.com/services/hdinsight/
http://azure.microsoft.com/services/storage/
http://azure.microsoft.com/services/stream-analytics/
http://azure.microsoft.com/services/event-hubs/


What could you do with Azure and Power BI?What could you do with Azure and Power BI?

You can use Power BI to gain insight on your existing apps, too. With the Power BI API, application developers can
send entire data sets to Power BI programmatically. Need continuous updates? With the Power BI APIs, developers
can send real-time data updates to get started quickly, and then grow into using Azure Stream Analytics when
scale requirements merit doing so.

There's lots of information about Power BI APIs in the Power BI Developer Portal. You can also learn about what
others are doing programmatically with Power BI in the Power BI developer blog. There's also a page dedicated to
getting you started with Power BI development.

There are all sorts of scenarios where Azure and Power BI can be combined - the possibilities and opportunities
are as unique as your business. For more information about Azure services, check out this overview page, which
describes Data Analytics Scenarios using Azure, and learn how to transform your data sources into intelligence
that drives your business ahead.

http://dev.powerbi.com
http://blogs.msdn.com/powerbidev
https://msdn.microsoft.com/library/dn889824.aspx
http://go.microsoft.com/fwlink/?LinkId=535031&clcid=0x409
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Understanding data refresh

Making sure you’re always getting the latest data is often critical in making the right decisions. You’ve
probably already used Get Data in Power BI to connect to and upload some data, created some reports and a
dashboard. Now, you want to make sure your data really is the latest and greatest.

In many cases, you don’t need to do anything at all. Some data, like from a Salesforce or Marketo content pack
is automatically refreshed for you. If your connection makes use of a live connection or DirectQuery, the data
will be update to date. But, in other cases, like with an Excel workbook or Power BI Desktop file that connects to
an external online or on-premises data source, you’ll need to refresh manually or setup a refresh schedule so
Power BI can refresh the data in your reports and dashboards for you.

This article, along with a few others, are meant to help you understand how data refresh in Power BI really
works, whether or not you need to setup a refresh schedule, and what needs to be in-place to refresh your
data successfully.

Before setting up refresh, it’s important to understand what it is you’re refreshing and where you’re getting
your data.

A data source is where the data you explore in your reports and dashboards really comes from; for example,
an online service like Google Analytics or QuickBooks, a database in the cloud like Azure SQL Database, or a
database or file on a local computer or server in your own organization. These are all data sources. The type of
data source determines how data from it is refreshed. We’ll go into refresh for each type of data source a little
later in the What can be refreshed? section.

A dataset is automatically created in Power BI when you use Get Data to connect to and upload data from a
content pack, file, or you connect to a live data source. In Power BI Desktop and Excel 2016, you can also
publish your file right to the Power BI service, which is just like using Get Data.

In each case, a dataset is created and appears in the My Workspace, or Group, containers in the Power BI
service. When you select the ellipse (...) for a dataset, you can explore the data in a report, edit settings, and
setup refresh.

A dataset can get data from one or more data sources. For example, you can use Power BI Desktop to get data
from a SQL Database in your organization, and get other data from an OData feed online. Then, when you
publish the file to Power BI, a single dataset is created, but it will have data sources for both the SQL Database
and the OData feed.

A dataset contains information about the data sources, data source credentials, and in most cases, a sub-set of
data copied from the data source. When you create visualizations in reports and dashboards, you’re looking at

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/refresh-data.md


 Types of refresh

Package refreshPackage refresh

Model/data refreshModel/data refresh

Tile refreshTile refresh

data in the dataset, or in the case of a live connection like Azure SQL Database, the dataset defines the data you
see right from the data source. For a live connection to Analysis Services, the dataset definition comes from
Analysis Services directly.

When you refresh data, you are updating the data in the dataset that is stored in Power BI from your data
source. This refresh is a full refresh and not incremental.

Whenever you refresh data in a dataset, whether by using Refresh Now or by setting up a refresh schedule,
Power BI uses information in the dataset to connect to the data sources defined for it, query for updated data,
and then loads the updated data into the dataset. Any visualizations in your reports or dashboards based on
the data are updated automatically.

Before we go any further, there’s something else that's very important to understand:

Regardless of how often you refresh the dataset, or how often you look at live data, it is the data at the
data source that must be up-to-date first.

Most organizations process their data once a day, usually in the evening. If you schedule refresh for a dataset
created from a Power BI Desktop file that connects to an on-premises database, and your IT department runs
processing on that SQL database once in the evening, then you only need to setup scheduled refresh to run
once-a-day. For example, after processing on the database happens, but before you come into work. Of course,
this isn’t always the case. Power BI provides many ways to connect to data sources that are updated frequently
or even real-time.

There are four main types of refresh that happen within Power BI. Package refresh, model/data refresh, tile
refresh and visual container refresh.

This synchronizes your Power BI Desktop, or Excel, file between the Power BI service and OneDrive, or
SharePoint Online. This does not pull data from the original data source. The dataset in Power BI will only be
updated with what is in the file within OneDrive, or SharePoint Online.

This is referring to refreshing the dataset, within the Power BI service, with data from the original data source.
This is done by either using scheduled refresh, or refresh now. This requires a gateway for on-premises data
sources.

Tile refresh updates the cache for tile visuals, on the dashboard, once data changes. This happens about every
fifteen minutes. You can also force a tile refresh by selecting the ellipsis (...) in the upper right of a dashboard
and selecting Refresh dashboard tiles.



 

Visual container refreshVisual container refresh

What can be refreshed?

NOTENOTE

NOTENOTE

Local files and files on OneDrive or SharePoint Online

For details around common tile refresh errors, see Troubleshooting tile errors.

Refreshing the visual container updates the cached report visuals, within a report, once the data changes.

In Power BI, you’ll typically use Get Data to import data from a file on a local drive, OneDrive or SharePoint
Online, publish a report from Power BI Desktop, or connect directly to a database in the cloud in your own
organization. Just about any data in Power BI can be refreshed, but whether or not you need to depends on
how your dataset was created from and the data sources it connects to. Let’s look at how each of these refresh
data.

Before we go further, here are some important definitions to understand:

Automatic refresh - This means no user configuration is necessary in order for the dataset to be refreshed on
a regular basis. Data refresh settings are configured for you by Power BI. For online service providers, refresh
usually occurs once-a-day. For files loaded from OneDrive, automatic refresh occurs about every hour for data
that does not come from an external data source. While you can configure different schedule refresh settings
and manually refresh, you probably don’t need to.

User configured manual or scheduled refresh – This means you can manually refresh a dataset by using
Refresh Now or setup a refresh schedule by using Schedule Refresh in a dataset’s settings. This type of refresh
is required for Power BI Desktop files and Excel workbooks that connect to external online and on-premises
data sources.

When you configure a time for scheduled refresh, there can be a delay of up to one hour before it begins.

Live/DirectQuery – This means there is a live connection between Power BI and the data source. For on-
premises data sources, Admins will need to have a data source configured within an enterprise gateway, but
user interaction may not be needed.

To enhance performance, dashboards with data connected using DirectQuery are automatically updated. You can also
manually refresh a tile at any time, by using the More menu on the tile.

Data refresh is supported for Power BI Desktop files and Excel workbooks that connect to external online or
on-premises data sources. This will only refresh the data for the dataset within the Power BI service. It will not
update your local file.



Power BI Desktop filePower BI Desktop file

DATA SOURCE AUTOMATIC REFRESH
USER CONFIGURED MANUAL
OR SCHEDULED REFRESH GATEWAY REQUIRED

Get Data (on the ribbon) is
used to connect to and
query data from any listed
online data source.

No Yes No (see below)

Get Data is used to
connect to and explore a
live Analysis Services
database.

Yes No Yes

Get Data is used to
connect to and explore a
supported on-premises
DirectQuery data source.

Yes No Yes

Get Data is used to
connect to and query data
from an Azure SQL
Database, Azure SQL Data
Warehouse, Azure
HDInsight Spark.

Yes Yes No

Get Data is used to
connect to and query data
from any listed on-
premises data source
except for Hadoop file
(HDFS) and Microsoft
Exchange.

No Yes Yes

NOTENOTE

Excel workbookExcel workbook

DATA SOURCE AUTOMATIC REFRESH
USER CONFIGURED MANUAL
OR SCHEDULED REFRESH GATEWAY REQUIRED

Tables of data in a
worksheet not loaded into
the Excel data model.

Yes, hourly
(OneDrive/SharePoint
Online only)

Manual only
(OneDrive/SharePoint
Online only)

No

Keeping your files on OneDrive, or SharePoint Online, and connecting to them from Power BI, provides a great
amount of flexibility. But with all that flexibility, it also makes it one of the most challenging to understand.
Scheduled refresh for files stored in OneDrive, or SharePoint Online, are different from package refresh. You
can learn more in the Types of refresh section.

If you are using the Web.Page function, you do need a gateway if you have republished the dataset or your report
after November 18th, 2016.

For details, see Refresh a dataset created from a Power BI Desktop file on OneDrive.

https://msdn.microsoft.com/library/mt260924.aspx


Tables of data in a
worksheet linked to a table
in the Excel data model
(linked tables).

Yes, hourly
(OneDrive/SharePoint
Online only)

Manual only
(OneDrive/SharePoint
Online only)

No

Power Query* is used to
connect to and query data
from any listed online data
source and load data into
the Excel data model.

No Yes No

Power Query* is used to
connect to and query data
from any listed on-
premises data source
except for Hadoop file
(HDFS) and Microsoft
Exchange and load data
into the Excel data model.

No Yes Yes

Power Pivot is used to
connect to and query data
from any listed online data
source and load data into
the Excel data model.

No Yes No

Power Pivot is used to
connect to and query data
from any listed on-
premises data source and
load data into the Excel
data model.

No Yes Yes

DATA SOURCE AUTOMATIC REFRESH
USER CONFIGURED MANUAL
OR SCHEDULED REFRESH GATEWAY REQUIRED

Comma separated value (.csv) file on OneDrive or SharePoint OnlineComma separated value (.csv) file on OneDrive or SharePoint Online

DATA SOURCE AUTOMATIC REFRESH
USER CONFIGURED MANUAL
OR SCHEDULED REFRESH GATEWAY REQUIRED

Simple comma separated
value

Yes, hourly Manual only No

Content packs

* Power Query is known as Get & Transform Data in Excel 2016.

For more detailed information, see Refresh a dataset created from an Excel workbook on OneDrive.

For more detailed information, see Refresh a dataset created from a comma separated value (.csv) file on
OneDrive.

There are two types of content packs in Power BI:

Content packs from online services: like Adobe Analytics, SalesForce, and Dynamics CRM Online. Datasets
created from online services are refreshed automatically once a day. While it’s probably not necessary, you can
manually refresh or setup a refresh schedule. Because online services are in the cloud, a gateway is not
required.



Content packs from online servicesContent packs from online services

DATA SOURCE AUTOMATIC REFRESH
USER CONFIGURED MANUAL
OR SCHEDULED REFRESH GATEWAY REQUIRED

Online services in Get Data
> Services

Yes Yes No

Organizational content packsOrganizational content packs

Live connections and DirectQuery to on-premises data sources

NOTENOTE

DATA SOURCE LIVE/DIRECTQUERY
USER CONFIGURED MANUAL
OR SCHEDULED REFRESH GATEWAY REQUIRED

Analysis Services Tabular Yes Yes Yes

Analysis Services
Multidimensional

Yes Yes Yes

SQL Server Yes Yes Yes

SAP HANA Yes Yes Yes

Oracle Yes Yes Yes

Teradata Yes Yes Yes

Organizational content packs: created and shared by users in your own organization. Content pack
consumers cannot setup a refresh schedule or manually refresh. Only the content pack creator can setup
refresh for the datasets in the content pack. Refresh settings are inherited with the dataset.

Refresh capabilities for a dataset included within an organization content pack depends on the dataset. See
information above in relation to local files, OneDrive or SharePoint Online.

To learn more, see Introduction to organizational content packs.

With the on-premises data gateway, you can issue queries from Power BI to your on-premises data sources.
When you interact with a visualization, queries are sent from Power BI directly to the database. Updated data is
then returned and visualizations are updated. Because there is a direct connection between Power BI and the
database, there is no need to schedule refresh.

When connecting to a SQL Service Analysis Services (SSAS) data source using a Live connection, unlike
DirectQuery, the Live connection to a SSAS source can run against the cache, even upon loading a report. This
behavior improves load performance for the report. You can request the latest data from the SSAS data source
by using the refresh button. Owners of SSAS data sources can configure the scheduled cache refresh
frequency for the dataset to ensure reports are as up to date as they require.

When you configure a data source with the on-premises data gateway, you can use that data source as the
scheduled refresh option. This would be instead of using the personal gateway.

If your dataset is configured for a live or DirectQuery connection, datasets are refreshed approximately each hour or
when interaction with the data occurs. You can manually adjust the refresh frequency in the Scheduled cache refresh
option in the Power BI service.



Databases in the cloud

To learn more, see On-premises data gateway

With DirectQuery, there is a direct connection between Power BI and the database in the cloud. When you
interact with a visualization, queries are sent from Power BI directly to the database. Updated data is then
returned and visualizations are updated. And, because both the Power BI service and the data source are in the
cloud, there is no need for a Personal Gateway.

If there is no user interaction in a visualization, data is refreshed automatically approximately every hour. You
can change that refresh frequency using the Scheduled cache refresh option, and set the refresh frequency.

To set the frequency, select the gear icon in the upper right corner of the Power BI service, then select
Settings.

The Settings page appears, where you can select the dataset for which you want to adjust the frequency. On
that page, select the Datasets tab along the top.

Select the dataset, and in the right pane you'll see a collection of options for that dataset. For the
DirectQuery/Live connection, you can set the refresh frequency from 15 minutes to weekly using the
associated drop-down menu, as shown in the following image.



DATA SOURCE LIVE/DIRECTQUERY
USER CONFIGURED MANUAL
OR SCHEDULED REFRESH GATEWAY REQUIRED

SQL Azure Data
Warehouse

Yes Yes No

Spark on HDInsight Yes Yes No

Real-time dashboards

DATA SOURCE AUTOMATIC
USER CONFIGURED MANUAL
OR SCHEDULED REFRESH GATEWAY REQUIRED

Custom apps developed
with the Power BI Rest API
or Microsoft Stream
Analytics

Yes, live streaming No No

Configure scheduled refresh

Common data refresh scenarios

Excel workbook with tables of dataExcel workbook with tables of data

To learn more, see Azure and Power BI.

Real-time dashboards use the Microsoft Power BI REST API, or Microsoft Stream Analytics, to make sure the
data is up-to-date. Since real time dashboards do not require users to configure refresh, they are outside the
scope of this article.

To learn more, see Create a real-time dashboard in Power BI.

To learn how to configure scheduled refresh, see Configure scheduled refresh

Sometimes the best way to learn about data refresh in Power BI to look at examples. Here are some of the
more common data refresh scenarios:

You have an Excel workbook with several tables of data, but none of them are loaded into the Excel data
model. You use Get Data to upload the workbook file from your local drive into Power BI, and create a
dashboard. But, now you’ve made some changes to a couple of the workbook’s tables on your local drive, and
you want to update your dashboard in Power BI with the new data.

Unfortunately, refresh is not supported in this scenario. In order to refresh the dataset for your dashboard, you

https://msdn.microsoft.com/library/mt267603.aspx


Excel workbook connects to a SQL database in your companyExcel workbook connects to a SQL database in your company

NOTENOTE

Power BI Desktop file with data from an OData feedPower BI Desktop file with data from an OData feed

Shared content pack from another user in your organizationShared content pack from another user in your organization

will have to re-upload the workbook. However, there’s a really great solution: Put your workbook file on
OneDrive, or SharePoint Online!

When you connect to a file on OneDrive, or SharePoint Online, your reports and dashboards will show data as
it is in the file. In this case, your Excel workbook. Power BI automatically checks the file, about every hour, for
updates. If you make changes to the workbook (stored in OneDrive or SharePoint Online), those changes are
reflected in your dashboard and reports within an hour. You don’t need to setup refresh at all. However, if you
need to see your updates in Power BI immediately, you can manually refresh the dataset by using Refresh
Now.

To learn more, see Excel data in Power BI, or Refresh a dataset created from an Excel workbook on OneDrive.

Let’s say you have an Excel workbook named SalesReport.xlsx on your local computer. Power Query in Excel
was used to connect to a SQL database on a server in your company and query for sales data that is loaded
into the data model. Each morning, you open the workbook and hit Refresh to update your PivotTables.

Now you want to explore your sales data in Power BI, so you use Get Data to connect to and upload the
SalesReport.xlsx workbook from your local drive.

In this case, you can manually refresh the data in the SalesReport.xlsx dataset or setup a refresh schedule.
Because the data really comes from the SQL database in your company, you’ll need to download and install a
gateway. Once you’ve installed and configured the gateway, you’ll need to go into the SalesReport dataset’s
settings and sign in to the data source; but you’ll only have to do this once. You can then setup a refresh
schedule so Power BI automatically connects to the SQL database and gets updated data. Your reports and
dashboards will also be updated automatically.

This will only update the data within the dataset in the Power BI service. Your local file will not be updated as part of the
refresh.

To learn more, see Excel data in Power BI, Power BI Gateway - Personal, On-premises data gateway, Refresh a
dataset created from an Excel workbook on a local drive.

In this case, you use Get Data in Power BI Desktop to connect to and import census data from an OData feed.
You create several reports in Power BI Desktop, then name the file WACensus and save it on a share in your
company. You then publish the file to the Power BI service.

In this case, you can manually refresh the data in the WACensus dataset or setup a refresh schedule. Because
the data in the data source comes from an OData feed online, you do not need to install a gateway, but you
will need to go into the WACensus dataset’s settings and sign in to the OData data source. You can then setup
a refresh schedule so Power BI automatically connects to the OData feed and gets updated data. Your reports
and dashboards will also be updated automatically.

To learn more, see Publish from Power BI Desktop, Refresh a dataset created from a Power BI Desktop file on a
local drive, Refresh a dataset created from a Power BI Desktop file on OneDrive.

You’ve connected to an organizational content pack. It includes a dashboard, several reports, and a dataset.

In this scenario, you cannot setup refresh for the dataset. The data analyst who created the content pack is
responsible for making sure the dataset is refreshed, depending on the data sources used.

If your dashboards and reports from the content pack aren’t updating, you’ll want to talk to the data analyst



Content pack from an online service provider like SalesforceContent pack from an online service provider like Salesforce

Troubleshooting

Next steps

who created the content pack.

To learn more, see Introduction to organizational content packs, Work with organizational content packs.

In Power BI you used Get Data to connect to and import your data from an online service provider like
Salesforce. Well, not much to do here. Your Salesforce data set is automatically scheduled to refresh once a
day.

Like most online service providers, Salesforce updates data once a day, usually at night. You can manually
refresh your Salesforce dataset, or setup a refresh schedule, but it’s not necessary because Power BI will
automatically refresh the dataset and your reports and dashboards will be updated too.

To learn more, see Salesforce content pack for Power BI.

When things go wrong, it’s usually because Power BI can’t sign into data sources, or the dataset connects to an
on-premises data source and the gateway is offline. Make sure Power BI can sign into data sources. If a
password you use to sign into a data source changes, or Power BI gets signed out from a data source, be sure
to try signing into your data sources again in Data Source Credentials.

For more information about troubleshooting, see Tools for troubleshooting refresh issues and
Troubleshooting refresh scenarios.

Tools for troubleshooting refresh issues
Troubleshooting refresh scenarios
Power BI Gateway - Personal
On-premises data gateway

More questions? Try asking the Power BI Community

http://community.powerbi.com/


Configuring scheduled refresh
12/6/2017 • 4 min to read • Edit Online

NOTENOTE

Gateway connection

After two months of inactivity, scheduled refresh on your dataset is paused. See the Schedule refresh section later in this
article for more information.

If your dataset supports scheduled refresh, by using Refresh Now and Schedule Refresh, there are a few
requirements and settings important for refresh to be successful. These are Gateway connection, Data Source
Credentials, and Schedule Refresh. Let’s take a closer look at each.

This will describe the options available for both the Power BI Gateway – Personal and the on-premises data
gateway.

To get to the schedule refresh screen, you can do the following.

1. Select the ellipsis (...) next to a dataset listed under Datasets.
2. Select Schedule Refresh.

You will see different options here depending on whether you have a personal, or enterprise, gateway online and
available.

If no gateway is available, you will see Gateway settings disabled. You will also see a message indicating how to
install the personal gateway.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/refresh-scheduled-refresh.md


Data source credentials
Power BI Gateway - PersonalPower BI Gateway - Personal

NOTENOTE

On-premises data gatewayOn-premises data gateway

If you have a personal gateway configured, it will be available to select, if it is online. It will show offline if it is not
available.

You can also select the enterprise gateway if one is available for you. You will only see an enterprise gateway
available if your account is listed in the Users tab of the data source configured for a given gateway.

If you are using the personal gateway to refresh data, you will need to supply the credentials used to connect to
the back end data source. If you connected to a content pack, from an online service, the credentials you entered to
connect will be carried over for scheduled refresh.

You’re only required to sign in to data sources the first time you use refresh on that dataset. Once entered, those
credentials are retained with the dataset.

For some authentication methods, if the password you use to sign into a data source expires or is changed, you'll need to
change it for the data source in Data Source Credentials too.

When things go wrong, the problem usually has something to do with either the gateway being offline because it
could not sign in to Windows and start the service, or Power BI could not sign in to the data sources in order to
query for updated data. If refresh fails, check the dataset’s settings. If the gateway service is offline, Gateway Status
is where you’ll see the error. If Power BI cannot sign into the data sources, you’ll see an error in Data Source
Credentials.

If you are using the on-premises data gateway to refresh data, you do not need to supply credentials as they are
defined for the data source by the gateway administrator.



 

NOTENOTE

Schedule refresh

NOTENOTE

NOTENOTE

What’s supported?

Power BI Gateway - PersonalPower BI Gateway - Personal

When connecting to on-premises SharePoint for data refresh, Power BI supports only Anonymous, Basic, and Windows
(NTLM/Kerberos) authentication mechanisms. Power BI does not support ADFS or any Forms-Based Authentication
mechanisms for data refresh of on-premises SharePoint data sources.

The scheduled refresh section is where you define the frequency and time slots to refresh the dataset. Some data
sources do not require a gateway present in order to be available to configure. Others will require a gateway.

You must set the Keep your data up to date slider to Yes in order to configure the settings.

The Power BI service targets initiating the refresh of your data within 15 minutes of your scheduled refresh time.

After two months of inactivity, scheduled refresh on your dataset is paused. A dataset is considered inactive when no user
has visited any dashboard or report built on the dataset. At that time, the dataset owner is sent an email indicating the
scheduled refresh is paused, and the refresh schedule for the dataset is displayed as disabled. To resume scheduled refresh,
simply revisit any dashboard or report built on the dataset.

Certain datasets are supported against different gateways for scheduled refresh. Here is a reference to understand
what is available.

Power BI Desktop

All online data sources shown in Power BI Desktop’s Get Data and Query Editor.



NOTENOTE

On-premises data gatewayOn-premises data gateway

DATA SOURCE

Analysis Services Tabular

Analysis Services Multidimensional

SQL Server

SAP HANA

Oracle

Teradata

File

Folder

SharePoint list (on-premises)

Web

OData

IBM DB2

MySQL

Sybase

SAP BW

IBM Informix Database

ODBC

All on-premises data sources shown in Power BI Desktop’s Get Data and Query Editor except for Hadoop file
(HDFS) and Microsoft Exchange.

Excel

In Excel 2016, and later, Power Query is now listed on the Data section of the ribbon, under Get & Transform data.

All online data sources shown in Power Query.
All on-premises data sources shown in Power Query except for Hadoop file (HDFS) and Microsoft Exchange.
All online data sources shown in Power Pivot.*
All on-premises data sources shown in Power Pivot except for Hadoop file (HDFS) and Microsoft Exchange.



Troubleshooting

Next steps

Sometimes refreshing data may not go as expected. Typically this will be an issue connected with a gateway. Take
a look at the gateway troubleshooting articles for tools and known issues.

Troubleshooting the on-premises data gateway

Troubleshooting the Power BI Gateway - Personal

Data refresh in Power BI
Power BI Gateway - Personal
On-premises data gateway
Troubleshooting the on-premises data gateway
Troubleshooting the Power BI Gateway - Personal

More questions? Try asking the Power BI Community

http://community.powerbi.com/


Refresh a dataset created from a Power BI Desktop
file on a local drive
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What’s supported?

Power BI Gateway - PersonalPower BI Gateway - Personal

On-premises data gatewayOn-premises data gateway

DATA SOURCE

Analysis Services Tabular

Analysis Services Multidimensional

SQL Server

SAP HANA

Oracle

Teradata

File

Folder

SharePoint list (on-premises)

Web

OData

IBM DB2

MySQL

Sybase

SAP BW

In Power BI, Refresh Now and Schedule Refresh is supported for datasets created from Power BI Desktop files
imported from a local drive where Get Data/Query Editor is used to connect to and load data from any of the
following data sources:

All online data sources shown in Power BI Desktop’s Get Data and Query Editor.
All on-premises data sources shown in Power BI Desktop’s Get Data and Query Editor except for Hadoop file
(HDFS) and Microsoft Exchange.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/refresh-desktop-file-local-drive.md


IBM Informix Database

ODBC

DATA SOURCE

NOTENOTE

NOTENOTE

How do I schedule refresh?

When things go wrong

A gateway must be installed and running in order for Power BI to connect to on-premises data sources and refresh the
dataset.

You can perform a one-time, manual refresh right in Power BI Desktop by selecting Refresh on the Home ribbon.
When you select Refresh here, the data in the file’s model is refreshed with updated data from the original data
source. This kind of refresh, entirely from within the Power BI Desktop application itself, is different from manual or
scheduled refresh in Power BI, and it’s important to understand the distinction.

When you import your Power BI Desktop file from a local drive, data, along with other information about the
model is loaded into a dataset in the Power BI service. In the Power BI service, not Power BI Desktop, you want to
refresh data in the dataset because that is what your reports, in the Power BI service, are based on. Because the
data sources are external, you can manually refresh the dataset by using Refresh now or you can setup a refresh
schedule by using Schedule Refresh.

When you refresh the dataset, Power BI does not connect to the file on the local drive to query for updated data. It
uses information in the dataset to connect directly to the data sources to query for updated data it then loads into
the dataset.

Refreshed data in the dataset is not synchronized back to the file on the local drive.

When you setup a refresh schedule, Power BI will connect directly to the data sources using connection information
and credentials in the dataset to query for updated data, then load the updated data into the dataset. Any
visualizations in reports and dashboards based on that dataset in the Power BI service are also updated.

For details on how to setup schedule refresh, see Configure Schedule Refresh.

When things go wrong, it’s usually because Power BI can’t sign into data sources, or if the dataset connects to an
on-premises data source, the gateway is offline. Make sure Power BI can sign into data sources. If a password you
use to sign into a data source changes, or Power BI gets signed out from a data source, be sure to try signing into
your data sources again in Data Source Credentials.



Troubleshooting

Be sure to leave the Send refresh failure notification email to me checked. You’ll want to know right away if a
scheduled refresh fails.

Sometimes refreshing data may not go as expected. Typically this will be an issue connected with a gateway. Take a
look at the gateway troubleshooting articles for tools and known issues.

Troubleshooting the on-premises data gateway

Troubleshooting the Power BI Gateway - Personal

More questions? Try asking the Power BI Community

http://community.powerbi.com/


Refresh a dataset stored on OneDrive or SharePoint
Online
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Advantages of storing a Power BI Desktop file on OneDrive or
SharePoint Online

What’s supported?

Power BI Gateway - PersonalPower BI Gateway - Personal

Importing files from OneDrive, or SharePoint Online, into the Power BI service is a great way to make sure the
work you’re doing in Power BI Desktop stays in sync with the Power BI service.

When you store a Power BI Desktop file on OneDrive or SharePoint Online, any data you’ve loaded into your
file’s model is imported into the dataset, and any reports you’ve created in the file are loaded into Reports in the
Power BI serviced. When you make changes to your file on OneDrive or SharePoint Online, such as adding new
measures, changing column names, or editing visualizations, once you save the file those changes will be updated
in the Power BI service too, usually within about an hour.

You can perform a one-time, manual refresh right in Power BI Desktop by selecting Refresh on the Home ribbon.
When you select Refresh here, the data in the file’s model is refreshed with updated data from the original data
source. This kind of refresh, entirely from within the Power BI Desktop application itself, is different from manual or
scheduled refresh in Power BI, and it’s important to understand the distinction.

When you import your Power BI Desktop file from OneDrive, or SharePoint Online, data, along with other
information about the model is loaded into a dataset in Power BI. In the Power BI service, not Power BI Desktop,
you want to refresh data in the dataset because that is what your reports, in the Power BI service, are based on.
Because the data sources are external, you can manually refresh the dataset by using Refresh now or you can
setup a refresh schedule by using Schedule Refresh.

When you refresh the dataset, Power BI does not connect to the file on OneDrive, or SharePoint Online, to query
for updated data. It uses information in the dataset to connect directly to the data sources to query for updated
data it then loads into the dataset. This refreshed data in the dataset is not synchronized back to the file on
OneDrive, or SharePoint Online.

In Power BI, Refresh Now and Schedule Refresh is supported for datasets created from Power BI Desktop files
imported from a local drive where Get Data/Query Editor is used to connect to and load data from any of the
following data sources:

All online data sources shown in Power BI Desktop’s Get Data and Query Editor.
All on-premises data sources shown in Power BI Desktop’s Get Data and Query Editor except for Hadoop file
(HDFS) and Microsoft Exchange.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/refresh-desktop-file-onedrive.md


On-premises data gatewayOn-premises data gateway

DATA SOURCE

Analysis Services Tabular

Analysis Services Multidimensional

SQL Server

SAP HANA

Oracle

Teradata

File

Folder

SharePoint list (on-premises)

Web

OData

IBM DB2

MySQL

Sybase

SAP BW

IBM Informix Database

ODBC

NOTENOTE

OneDrive or OneDrive for Business. What’s the difference?

A gateway must be installed and running in order for Power BI to connect to on-premises data sources and refresh the
dataset.

If you have both a personal OneDrive and OneDrive for Business, it’s recommended you keep any files you want to
import into Power BI in OneDrive for Business. Here’s why: You likely use two different accounts to sign into them.

Connecting to OneDrive for Business in Power BI is typically seamless because the same account you use to sign
into Power BI with is often the same account used to sign into OneDrive for Business. But, with personal OneDrive,
you likely sign in with a different Microsoft account.

When you sign in with your Microsoft account, be sure to select Keep me signed in. Power BI can then synchronize

http://www.microsoft.com/account/default.aspx


How do I schedule refresh?

When things go wrong

Troubleshooting

any updates you make in the file in Power BI Desktop with datasets in Power BI

If you make changes to your file on OneDrive that cannot be synchronized with the dataset or reports in Power BI,
because your Microsoft account credentials might have changed, you’ll need to connect to and import your file
again from your personal OneDrive.

When you setup a refresh schedule, Power BI will connect directly to the data sources using connection
information and credentials in the dataset to query for updated data, then load the updated data into the dataset.
Any visualizations in reports and dashboards based on that dataset in the Power BI service are also updated.

For details on how to setup schedule refresh, see Configure Schedule Refresh.

When things go wrong, it’s usually because Power BI can’t sign into data sources, or if the dataset connects to an
on-premises data source, the gateway is offline. Make sure Power BI can sign into data sources. If a password you
use to sign into a data source changes, or Power BI gets signed out from a data source, be sure to try signing into
your data sources again in Data Source Credentials.

If you’re making changes to the Power BI Desktop file on OneDrive and saving, and those changes aren’t being
reflected in Power BI within an hour or so, it could be because Power BI cannot connect to your OneDrive. Try
connecting to the file on OneDrive again. If you’re prompted to sign in, make sure you select Keep me signed in.
Because Power BI was not able to connect to your OneDrive to synchronize with the file, you’ll need to import your
file again.

Be sure to leave the Send refresh failure notification email to me checked. You’ll want to know right away if a
scheduled refresh fails.

Sometimes refreshing data may not go as expected. Typically this will be an issue connected with a gateway. Take a
look at the gateway troubleshooting articles for tools and known issues.

Troubleshooting the on-premises data gateway

Troubleshooting the Power BI Gateway - Personal

More questions? Try asking the Power BI Community

http://community.powerbi.com/


Refresh a dataset created from an Excel workbook on
a local drive
12/6/2017 • 3 min to read • Edit Online

What’s supported?

Power BI Gateway - PersonalPower BI Gateway - Personal

On-premises data gatewayOn-premises data gateway

DATA SOURCE

Analysis Services Tabular

Analysis Services Multidimensional

SQL Server

SAP HANA

Oracle

Teradata

File

Folder

SharePoint list (on-premises)

Web

OData

IBM DB2

MySQL

Sybase

In Power BI, Refresh Now and Schedule Refresh is supported for datasets created from Excel workbooks imported
from a local drive where Power Query (Get & Transform data in Excel 2016) or Power Pivot is used to connect to
any of the following data sources and load data into the Excel data model:

All online data sources shown in Power Query.
All on-premises data sources shown in Power Query except for Hadoop file (HDFS) and Microsoft Exchange.
All online data sources shown in Power Pivot.*
All on-premises data sources shown in Power Pivot except for Hadoop file (HDFS) and Microsoft Exchange.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/refresh-excel-file-local-drive.md


SAP BW

IBM Informix Database

ODBC

DATA SOURCE

How do I make sure data is loaded to the Excel data model?

NOTENOTE

Notes:

A gateway must be installed and running in order for Power BI to connect to on-premises data sources and
refresh the dataset.
When using Excel 2013, make sure you’ve updated Power Query to the latest version.
Refresh is not supported for Excel workbooks imported from a local drive where data exists only in
worksheets or linked tables. Refresh is supported for worksheet data if it is stored and imported from
OneDrive. To learn more, see Refresh a dataset created from an Excel workbook on OneDrive, or SharePoint
Online.
When you refresh a dataset created from an Excel workbook imported from a local drive, only the data
queried from data sources is refreshed. If you change the structure of the data model in Excel or Power
Pivot; for example, create a new measure or change the name of a column, those changes will not be copied
to the dataset. If you make such changes, you’ll need to re-upload or re-publish the workbook. If you expect
to make regular changes to the structure of your workbook and you want those to be reflected in the
dataset in Power BI without having to re-upload, consider putting your workbook on OneDrive. Power BI
automatically refreshes both the structure and worksheet data from workbooks stored and imported from
OneDrive.

When you use Power Query (Get & Transform data in Excel 2016) to connect to a data source, you have several
options where to load the data. To make sure you load data into the data model, you must select the Add this data
to the Data Model option in the Load To dialog box.

The images here show Excel 2016.

In Navigator, click Load To…

Or, If you click Edit in Navigator, you’ll open the Query Editor. There you can click Close & Load To….

Then in Load To, make sure you select Add this data to the Data Model.



What if I use Get External Data in Power Pivot?What if I use Get External Data in Power Pivot?

How do I schedule refresh?

When things go wrong

IMPORTANTIMPORTANT

Troubleshooting

Next steps

No problem. Whenever you use Power Pivot to connect to and query data from an on-premises or online data
source, the data is automatically loaded to the data model.

When you setup a refresh schedule, Power BI will connect directly to the data sources using connection information
and credentials in the dataset to query for updated data, then load the updated data into the dataset. Any
visualizations in reports and dashboards based on that dataset in the Power BI service are also updated.

For details on how to setup schedule refresh, see Configure Schedule Refresh.

When things go wrong, it’s usually because Power BI can’t sign into data sources, or if the dataset connects to an
on-premises data source, the gateway is offline. Make sure Power BI can sign into data sources. If a password you
use to sign into a data source changes, or Power BI gets signed out from a data source, be sure to try signing into
your data sources again in Data Source Credentials.

Be sure to leave the Send refresh failure notification email to me checked. You’ll want to know right away if a
scheduled refresh fails.

Refresh is not supported for OData feeds connected to and queried from Power Pivot. When using an OData feed as a data
source, use Power Query.

Sometimes refreshing data may not go as expected. Typically this will be an issue connected with a gateway. Take a
look at the gateway troubleshooting articles for tools and known issues.

Troubleshooting the on-premises data gateway

Troubleshooting the Power BI Gateway - Personal



More questions? Try the Power BI Community

http://community.powerbi.com/


Refresh a dataset created from an Excel workbook on
OneDrive, or SharePoint Online
12/6/2017 • 6 min to read • Edit Online

What are the advantages?

What’s supported?

Power BI Gateway - PersonalPower BI Gateway - Personal

On-premises data gatewayOn-premises data gateway

DATA SOURCE

Analysis Services Tabular

Analysis Services Multidimensional

SQL Server

SAP HANA

You can import Excel workbooks that are stored on your local machine, or in cloud storage such as OneDrive for
Business or SharePoint Online. We will look at the advantages of using cloud storage for your excel files. For more
information on how to import Excel files into Power BI, see Get data from Excel workbook files.

Importing files from OneDrive, or SharePoint Online, is a great way to make sure the work you’re doing in Excel
stays in-sync with the Power BI service. Any data you’ve loaded into your file’s model is imported into the dataset
and any reports you’ve created in the file are loaded into Reports in Power BI. If you make changes to your file on
OneDrive, or SharePoint Online, like add new measures, change column names, or edit visualizations, once you
save, those changes will be updated in Power BI too, usually within about an hour.

When you import an Excel workbook from your personal OneDrive, any data in the workbook, like tables in
worksheets and/or data that is loaded into the Excel data model and the structure of the data model, are imported
into a new dataset in Power BI. Any Power View visualizations are re-created in Reports. Power BI automatically
connects to the workbook on OneDrive, or SharePoint Online, about every hour to check for updates. If the
workbook has changed, Power BI will refresh the dataset and reports in the Power BI service.

You can refresh on the dataset in the Power BI service. When you manually refresh, or schedule refresh, on the
dataset, Power BI connects directly to the external data sources to query for updated data it then loads into the
dataset. Refreshing a dataset from within Power BI does not refresh the data in the workbook on OneDrive, or
SharePoint Online.

In Power BI, Refresh Now and Schedule Refresh is supported for datasets created from Power BI Desktop files
imported from a local drive where Get Data/Query Editor is used to connect to and load data from any of the
following data sources:

All online data sources shown in Power BI Desktop’s Get Data and Query Editor.
All on-premises data sources shown in Power BI Desktop’s Get Data and Query Editor except for Hadoop file
(HDFS) and Microsoft Exchange.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/refresh-excel-file-onedrive.md


Oracle

Teradata

File

Folder

SharePoint list (on-premises)

Web

OData

IBM DB2

MySQL

Sybase

SAP BW

IBM Informix Database

ODBC

DATA SOURCE

NOTENOTE

OneDrive or OneDrive for Business. What’s the difference?

A gateway must be installed and running in order for Power BI to connect to on-premises data sources and refresh the
dataset.

If you have both a personal OneDrive and OneDrive for Business, it’s recommended you keep any files you want
to import into Power BI in OneDrive for Business. Here’s why: You likely use two different accounts to sign into
them.

Connecting to OneDrive for Business in Power BI is typically seamless because the same account you use to sign
into Power BI with is often the same account used to sign into OneDrive for Business. But, with personal OneDrive,
you likely sign in with a different Microsoft account.

When you sign in with your Microsoft account, be sure to select Keep me signed in. Power BI can then synchronize
any updates you make in the file in Power BI Desktop with datasets in Power BI

http://www.microsoft.com/account/default.aspx


Options for connecting to Excel file

How do I make sure data is loaded to the Excel data model?

NOTENOTE

If you make changes to your file on OneDrive that cannot be synchronized with the dataset or reports in Power BI,
because your Microsoft account credentials might have changed, you’ll need to connect to and import your file
again from your personal OneDrive.

When you connect to an Excel workbook in OneDrive for Business, or SharePoint Online, you’ll have two options
on how to get what’s in your workbook into Power BI.

Import Excel data into Power BI – When you import an Excel workbook from your OneDrive for Business, or
SharePoint Online, it works as described above.

Connect, Manage, and View Excel in Power BI – When using this option, you create a connection from Power
BI right to your workbook on OneDrive for Business, or SharePoint Online.

When you connect to an Excel workbook this way, a dataset is not created in Power BI. However, the workbook will
appear in the Power BI service under Reports with an Excel icon next to the name. Unlike with Excel Online, when
you connect to your workbook from Power BI, if your workbook has connections to external data sources that load
data into the Excel data model, you can setup a refresh schedule.

When you setup a refresh schedule this way, the only difference is refreshed data goes into the workbook’s data
model on OneDrive, or SharePoint Online, rather than a dataset in Power BI.

When you use Power Query (Get & Transform data in Excel 2016) to connect to a data source, you have several
options where to load the data. To make sure you load data into the data model, you must select the Add this
data to the Data Model option in the Load To dialog box.

The images here show Excel 2016.

In Navigator, click Load To…

Or, If you click Edit in Navigator, you’ll open the Query Editor. There you can click Close & Load To….



What if I use Get External Data in Power Pivot?What if I use Get External Data in Power Pivot?

How do I schedule refresh?

When things go wrong

Important notes

Troubleshooting

Then in Load To, make sure you select Add this data to the Data Model.

No problem. Whenever you use Power Pivot to connect to and query data from an on-premises or online data
source, the data is automatically loaded to the data model.

When you setup a refresh schedule, Power BI will connect directly to the data sources using connection
information and credentials in the dataset to query for updated data, then load the updated data into the dataset.
Any visualizations in reports and dashboards based on that dataset in the Power BI service are also updated.

For details on how to setup schedule refresh, see Configure Schedule Refresh.

When things go wrong, it’s usually because Power BI can’t sign into data sources, or if the dataset connects to an
on-premises data source, the gateway is offline. Make sure Power BI can sign into data sources. If a password you
use to sign into a data source changes, or Power BI gets signed out from a data source, be sure to try signing into
your data sources again in Data Source Credentials.

Be sure to leave the Send refresh failure notification email to me checked. You’ll want to know right away if a
scheduled refresh fails.

* Refresh is not supported for OData feeds connected to and queried from Power Pivot. When using an OData
feed as a data source, use Power Query.



Sometimes refreshing data may not go as expected. Typically this will be an issue connected with a gateway. Take
a look at the gateway troubleshooting articles for tools and known issues.

Troubleshooting the on-premises data gateway

Troubleshooting the Power BI Gateway - Personal

More questions? Try the Power BI Community

http://community.powerbi.com/


Refresh a dataset created from a .CSV file on
OneDrive or SharePoint Online
12/6/2017 • 2 min to read • Edit Online

What are the advantages?

What’s supported?

OneDrive or OneDrive for Business. What’s the difference?

When you connect to a .csv file on OneDrive or SharePoint Online, a dataset is created in Power BI. Data from the
.csv file is then imported into the dataset in Power BI. Power BI then automatically connects to the file and refreshes
any changes with the dataset in Power BI. If you edit the .csv file in OneDrive, or SharePoint Online, once you save,
those changes will appear in Power BI, usually within about an hour. Any visualizations in Power BI based on the
dataset are automatically updated too.

If your files are in a shared folder on OneDrive for Business, or SharePoint Online, other users can work on the
same file. Once saved, any changes made are automatically updated in Power BI, usually within an hour.

Many organizations run processes that automatically query databases for data that is then saved to a .csv file each
day. If the file is stored on OneDrive, or SharePoint Online, and the same file is overwritten each day, as opposed to
a new file with a different name being created each day, you can connect to that file in Power BI. Your dataset that
connects to the file will be synchronized soon after the file on OneDrive, or SharePoint Online, is updated. Any
visualizations based on the dataset are automatically updated too.

Comma separated value files are simple text files, so connections to external data sources and reports are not
supported. You cannot schedule refresh on a dataset created from a comma delimited file. However, when the file
is on OneDrive, or SharePoint Online, Power BI will synchronize any changes to the file with the dataset
automatically about every hour.

If you have both a personal OneDrive and OneDrive for Business, it’s recommended you keep any files you want to
connect to in Power BI on OneDrive for Business. Here’s why: You likely use two different accounts to sign into
them.

Connecting to OneDrive for Business in Power BI is typically seamless because the same account you use to sign
into Power BI with is often the same account used to sign into OneDrive for Business. But, with personal OneDrive,
you likely sign in with a different Microsoft account.

When you sign into your Microsoft account, be sure to select Keep me signed in. Power BI can then synchronize
any updates with datasets in Power BI

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/refresh-csv-file-onedrive.md
http://www.microsoft.com/account/default.aspx


When things go wrong

Next steps

If you make changes to your .csv file on OneDrive that cannot be synchronized with the dataset in Power BI
because your Microsoft account credentials might have changed, you’ll need to connect to the file and import it
again from your personal OneDrive.

If data in the .csv file on OneDrive is changing and those changes aren’t being reflected in Power BI, it’s most likely
because Power BI cannot connect to your OneDrive. Try connecting to the file and importing it again. If you’re
prompted to sign in, make sure you select Keep me signed in.

Tools for troubleshooting refresh issues Troubleshooting refresh scenarios

More questions? Try asking the Power BI Community

https://community.powerbi.com/


Troubleshooting refresh scenarios
1/25/2018 • 3 min to read • Edit Online

NOTENOTE

Refresh using Web connector doesn't work properly

Unsupported data source for refresh

Dashboard doesn't reflect changes after refresh

GatewayNotReachable when setting credentials

Processing Error: The following system error occurred: Type Mismatch

Tile refresh errors

Refresh fails when updating data from sources that use AAD OAuth

Here you can find information regarding different scenarios you may face when refreshing data within the Power
BI service.

If you encounter a scenario that is not listed below, and it is causing you issues, you can ask for further assistance on the
community site, or you can create a support ticket.

If you have a web connector script that's using the Web.Page function, and you have updated your dataset or
report after November 18th, 2016, you need to use a gateway in order for refresh to work properly.

When configuring a dataset, you may get an error indicating the dataset uses an unsupported data source for
refresh. For details, see Troubleshooting unsupported data source for refresh

Please wait about 10-15 minutes for refresh to be reflected in the dashboard tiles. If it is still not showing up, re-
pin the visualization to the dashboard.

You may encounter GatewayNotReachable when trying to set credentials for a data source. This could be the
result of an outdated gateway. Install the latest gateway and try again.

This could be an issue with your M script within your Power BI Desktop file or Excel Workbook. It could also be due
to an out of date Power BI Desktop version.

For a list of errors you may encounter with dashboard tiles, and explanations, see Troubleshooting tile errors.

The Azure Active Director (AAD) OAuth token, used by many different data sources, expires in approximately one
hour. You can run into situations where loading data takes longer than the token expiration (more than one hour),
since the Power BI service waits for up to two hours when loading data. In that situation, the data loading process
can fail with a credentials error.

Data sources that use AAD OAuth include Microsoft Dynamics CRM Online, SharePoint Online (SPO), and
others. If you’re connecting to such data sources, and get a credentials failure when loading data takes more than
an hour, this may be the reason.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/refresh-troubleshooting-refresh-scenarios.md
http://community.powerbi.com/
https://powerbi.microsoft.com/support/
https://msdn.microsoft.com/library/mt260924.aspx


Uncompressed data limits for refresh

Scheduled refresh timeout

Next steps

Microsoft is investigating a solution that allows the data loading process to refresh the token and continue.
However, if your Dynamics CRM Online or SharePoint Online instance (or other AAD OAuth data source) is so
large that it could run into the two-hour data-load threshold, you may experience a data load timeout from the
Power BI service as well.

Also note that, for refresh to work properly, when connecting to a SharePoint Online data source using AAD
OAuth, you must use the same account that you use to sign in to the Power BI service.

The maximum size for datasets imported into the Power BI service is 1 GB. These datasets are heavily
compressed to ensure high performance. In addition, in shared capacity, the service places a limit on the amount
of uncompressed data that is processed during refresh to 10 GB. This limit accounts for the compression, and
therefore is much higher than 1 GB. Datasets in Power BI Premium are not subject to this limit. If refresh in the
Power BI service fails for this reason, please reduce the amount of data being imported to Power BI and try again.

Scheduled refresh for imported datasets timeout after two hours. This timeout is increased to five hours for
datasets in Premium workspaces. If you are encountering this limit, you can consider reducing the size or
complexity of your dataset, or consider breaking the dataset into smaller pieces.

Data Refresh
Troubleshooting the on-premises data gateway
Troubleshooting the Power BI Gateway - Personal

More questions? Try asking the Power BI Community

http://community.powerbi.com/


Disable privacy setting in Power BI Gateway -
Personal
12/21/2017 • 2 min to read • Edit Online

NOTENOTE

NOTENOTE

What is Fast Combine?

Turn on Fast Combine

There is a new version of the personal gateway for Power BI called the on-premises data gateway (personal mode). The
following article describes the previous version of the personal gateway, called Power BI Gateway - Personal, which will be
retired and stop working after July 31, 2017. For information about the new version of the personal gateway, including how
to install the new version, see the On-premises data gateway (personal mode) article. Fast combine is also available in
the new version of the personal gateway, and is described in that article, too.

You may receive the following error based on the privacy settings for your data sources when used with the
personal gateway.

An error occurred while processing the data in the dataset.

[Unable to combine data] <query part>/<…>/<…> is accessing data sources that have privacy levels which
cannot be used together. Please rebuild this data combination.

To work around this error, you can turn on Fast Combine. Fast Combine will ignore the privacy settings allowing
the different data sources to be combined.

Privacy levels are not considered when combining data. This could expose sensitive or confidential data to another data
source when combining data.

To learn more about privacy levels and Fast Combine, you can look at Privacy Levels. By default, the privacy level
will be set to private which could result in the error mentioned above. This is because a setting of private will
isolate the data source from other sources. An example of where this would be a problem would be a
parameterized query getting inputs from another data source.

Turning Fast Combine on will ignore the private setting and allow the execution to occur.

You can use the following steps to enable Fast Combine for your personal gateway. The on-premises data gateway
does not have this setting.

C:\Program Files\Power BI Personal Gateway\1.0\Configurator\Connector

1. Open ConnectorConfig.xml. This may be in one of two locations on your machine. If you are an
administrator on the computer, it will be the following.

If you are not an administrator, the location will be the following.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/refresh-enable-fast-combine.md
https://support.office.com/en-us/article/Privacy-levels-Power-Query-CC3EDE4D-359E-4B28-BC72-9BEE7900B540


Turn off Fast Combine

C:\Users\[username]\AppData\Local\Power BI Personal Gateway\1.0\Configurator\Connector

<EnableFastCombine>true</EnableFastCombine>

3. Exit and re-launch the gateway configuration screen.

2. Add the <EnableFastCombine> element with a value of true to the config file. Adding this element will
turn Fast Combine on.

4. You will see a status letting you know that Fast Combine is enabled.

C:\Program Files\Power BI Personal Gateway\1.0\Configurator\Connector

1. Open ConnectorConfig.xml. This may be in one of two locations on your machine. If you are an
administrator on the computer, it will be the following.

If you are not an administrator, the location will be the following.



Next steps

C:\Users\[username]\AppData\Local\Power BI Personal Gateway\1.0\Configurator\Connector

3. Exit and re-launch the gateway configuration screen.
4. You will no longer see a status telling you know that Fast Combine is enabled.

2. Remove the <EnableFastCombine> element from the config file. Removing this element will turn Fast
Combine off.

On-premises data gateway (personal mode) - the new version of the personal gateway Privacy Levels
Common query tasks in Power BI Desktop
More questions? Try the Power BI Community

https://support.office.com/en-us/article/Privacy-levels-Power-Query-CC3EDE4D-359E-4B28-BC72-9BEE7900B540
http://community.powerbi.com/


Getting started with Power BI gateways
1/25/2018 • 9 min to read • Edit Online

How Power BI gateways work

Welcome to the Getting started with Power BI gateways guide. This short walk-through gets you acquainted
with what a gateway does, how it works, and how to get your own gateway installed, configured, and running.

Gateways can be a technical subject, and since every network and enterprise is different, the complexity of
gateways can be significant. To keep that complexity at bay, let’s start with the basics.

A gateway is software that facilitates access to data that resides on a private, on-premises network, for subsequent
use in a cloud service like Power BI. It’s like a gatekeeper that listens for connection requests, and grants them only
when a users’ requests meet certain criteria (such as whether they’re allowed to use the gateway). This lets
organizations leave databases and warehouses on their on-premises networks, yet securely use subsets of that data
to create compelling reports and dashboards in Power BI.

A gateway also secures access and data by encrypting and compressing all data that passes through it, as well as
any passwords used to connect to data sources. All this sounds straightforward I’m sure, but there are many details
to consider.

Sometimes you want a gateway just for you – maybe you have a big Excel workbook plus three SQL databases with
years of running sales and marketing data, and you want to create a Power BI dashboard that shows those sales
from every angle. You’re the only person who creates reports, it’s your Excel workbook, and only you use those
databases to create Power BI reports. You just need a gateway for your personal use, not to share those data
sources with everyone else.

Other times, you might be in an organization with all sorts of databases from different vendors, including Analysis
Services, SAP, Oracle, IBM, and various other data sources, and you need lots of people to access them, so they can
create multitudes of reports. In this case, you need a gateway that lets you configure access to all those sources, and
then you need to share it with many people in your organization. That’s a different kind of gateway altogether.

Fortunately, Power BI offers two gateways, fitting each of those scenarios well. These two gateway offerings from
Power BI are the following:

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-gateway-getting-started.md


Install the gateway

On-premises data gateway (personal mode) – allows one user to connect to sources, and can’t be shared
with others. Can only be used with Power BI.
On-premises data gateway – allows multiple users to connect to multiple on-premises data sources, and can
be used by Power BI, PowerApps, Flow, and Azure Logic apps, all with a single gateway installation.

Both gateways perform a similar function – they facilitate access to data residing on a private on-premises network,
so that data can be used in cloud-based services like Power BI. The personal gateway can be used by one person
and only by Power BI, the on-premises data gateway can be used by many users, and many services.

There are three parts, or stages, to putting a gateway to work:

Install the gateway
Add users to the gateway (let them use the gateway)
Connect to data sources

In addition, using a gateway lets you do something else that can be important:

Refresh on-premises data, so Power BI reports can be updated with fresh data

Refreshing data means your Power BI dashboards and reports look fresh, and reflect the latest data. So when
someone views a report you created with on-premises data, that report can use show the latest information, even if
you created the report a while ago.

The first part, installing a gateway, is easy. Allowing users to access the gateway is easy too – you just add them in a
dialog within Power BI and they’re good. Connecting to data sources can get complex, because there are so many
data sources and each has its own connection requirements and nuances. And we’ll handle refresh in another
guide, to keep things in this article focused on the gateway.

So let’s take the easy thing first, and walk through installing a gateway.

To install a gateway, open the Power BI service (you can use this link to launch the Power BI service in your
browser, and log on) and log in with your Power BI account. In the Power BI service, select the download icon in
the upper right corner, as shown in the following image, and select Data Gateway.

That takes you to a download page, where you click the Download gateway button to initiate the download.



This screen gives you the ultra-condensed explanation of what a gateway does. It also provides a couple important
warnings – when you install a gateway, it actually runs on the computer on which you perform the installation.
And if that computer is turned off, so is the gateway (so it won’t work when it’s not running). Also, installing on a
computer using a wireless network is not best, so you should use a computer connected to a wired network.

When you’re ready, select Next to continue with the setup.

Here’s where you decide which gateway you’ll install – on-premises gateway, or a personal gateway. In this guide,
we’ll install the On-premises data gateway.



There are a few things to note at this decision point:

Both gateways require 64-bit Windows operating systems.
Gateways can’t be installed on a domain controller.
You can install up to two on-premises data gateways on the same computer, one running in each mode
(personal and standard).
You cannot have more than one gateway running in the same mode on the same computer.
You can install multiple on-premises data gateways on different computers, and manage them all from the
same Power BI gateway management interface (excluding personal, see the following bullet point).
You can only have one personal mode gateway running for each Power BI user. If you install another personal
mode gateway for the same user, even on a different computer, the most recent installation replaces the existing
previous installation.

When we select Next, the gateway installation begins. You need to specify where it will be installed, and the default
location is usually best.

The installation process goes quickly, and you’re provided with a status bar.



Once you’re almost complete, you need to identify the account to use with the gateway. This should be the account
(the username and password) you use to log on to Power BI; the gateway is associated with your Power BI account,
and you configure gateways from within the Power BI service.

You’ll be signed in, as shown in the following image.



Once you’re signed in, you need to create a Recovery key. We’ll discuss those more in depth in another article, but
for now, know that you’ll need it to recover or move your gateway.



When all goes well, you’ll see a window that tells you that your gateway is ready.



Add users to a gateway

That’s it for the installation of an on-premises gateway. As promised, it was a pretty easy process. The next step,
then, is to either add users or add data sources – you can do either first, and add either after your initial
configuration.

The next section describes adding users to the gateway, and after that, we’ll discuss where to go next to add data
sources to the gateway.

Now that we have a gateway installed, we manage the gateway from the Power BI service. To get to the
management screen for gateways, in the Power BI service select the Gear icon in the upper-right corner, then select
Manage gateways.

A page inside the Power BI service canvas appears, where you can manage your gateways. The Gateway Settings
page looks like the following.



If you tap or click on Administrators, you see the following administrators’ management page. Note that this is
just which users can administer the gateway, and that users of the gateway are added (or removed) from each
individual data source, using a different page – which we review in the next few paragraphs.

Once you install and validate (successfully connect to) a data source, it shows up under its associated gateway in
the left side of this Manage gateways screen, as shown in the following image. Notice that in the right pane, there
are two sections you can toggle between: Data Source Settings and Users. The screen directly following is the
Data Source Settings section.



When you select Users, you get a text box into which you can type users from your organization who you want to
grant access to the selected data source. In the following screen, you can see that I’ve added Maggie and Adam.

When you begin typing an email address into the text box, Power BI shows a list of users whose email matches
what you’re typing, enabling you to click the name and add them to the list.

You can also add email groups (aliases) to allow groups of people access, as well as individuals.

Once you select Add, the added members show up in the box, and you can add more if you want. Removing users
is just as easy. Simply check the checkbox next to their name, and then select the Remove button below the box.



Adding data sources

And that’s all there is to it. Remember that you need to add users to each data source to which you want to grant
access. Each data source has a separate list of users, and you must add users to each data source separately.

Of course, to make your gateway useful you’ll want to add data sources. This is where some of the complexity of
Power BI gateways is introduced – there are many different data sources available, and each has its own
requirements (and often, its own required driver).

But before we send you off to another article, here’s a look at how you go about adding a data source. While you’re
in the Manage gateways page of the Power BI service, select the gateway to which you want to add a data
source, and select Add Data Source in the upper-left corner of the page, just above the list of your gateways.

When you do, the Data Source Settings panel appears in the right pane, as shown in the following image. There,
you can name your data source (entered in the Data Source Name text box), and select its type from the Data
Source Type drop-down list.



Next steps

Okay, you now have a gateway installed, and you’re ready to add data sources. Great! See the resources in the
following section for information about data sources, more details about using gateways, and other useful
information.

Using the on-premises data gateway
On-premises data gateway in-depth
On-premises data gateway (personal mode) Troubleshooting the on-premises data gateway

More questions? Try the Power BI Community

http://community.powerbi.com/
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Installation considerations for the on-premises data gateway

Number of usersNumber of users

This article provides guidance and considerations for deploying a data gateway in your network environment. A
gateway is software that facilitates access to data that resides on a private, on-premises network, for subsequent
use in a cloud service like Power BI. This article walks you through the deployment, and provides guidance for, the
on-premises data gateway setup.

For more about on-premises data gateway, including a link to install it, take a look at the blog post.

Before getting too far into the details of installation and deployment, there are a handful of considerations you
should keep in mind. The following sections describe important things to keep in mind.

The number of users consuming a report that's using the gateway is an important metric in deciding where to
install the gateway. Here are some questions to consider:

Are users using these reports at different times of the day?
What types of connections are they using (DirectQuery or Import)?
Are all users using the same report?

If users are all accessing a given report at the same time each day, you'll want to make sure you install the gateway
on a machine that's capable of handling all those requests (see following sections for performance counters and
minimum requirements that can help you determine this).

There is a constraint in Power BI that allows only one gateway per report, so even if a report is based on multiple
data sources, all such data sources must go through a single gateway. However, if a dashboard is based on multiple
reports, you can use a dedicated gateway for each contributing report, and thereby distribute the gateway load
among those multiple reports that contribute to that single dashboard.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-gateway-deployment-guidance.md
https://powerbi.microsoft.com/blog/power-bi-gateways-march-update/


Connection typeConnection type

LocationLocation

Power BI offers two types of connections, DirectQuery and Import. Not all data sources support both connection
types, and many reasons may contribute to choosing one over the other, such as security requirements,
performance, data limits, and data model sizes. You can learn more about connection type and supported data
sources in the list of available data source types section of the On-premises data gateway article.

Depending on which type of connection are use, gateway usage can be different. For example, you should try to
separate DirectQuery data sources from Scheduled Refresh data sources whenever possible (assuming they're
in different reports and can be separated). Doing so prevents the gateway from having thousands of DirectQuery
requests queued up, at the same time as the morning's scheduled refresh of a large size data model that's used for
the company's main dashboard. Here's what to consider for each:

For Scheduled Refresh: depending on your query size and the number of refreshes occurring per day, you can
choose to stay between the recommended minimum hardware requirements or upgrade to a higher
performance machine. If a given query is not folded, transformations occur on the gateway machine, and as
such, the gateway machine benefits from having more available RAM.
For DirectQuery: a query is be sent each time any user opens the report or looks at data. So if you anticipate
more than 1,000 users accessing the data concurrently, you'll want to make sure your computer has robust and
capable hardware components. More CPU cores will result in better throughput for a DirectQuery connection.

The requirements for a machine on which you install an on-premises data gateway are the following:

Minimum:

.NET 4.5 Framework
64-bit version of Windows 7 / Windows Server 2008 R2 (or later)

Recommended:

8 Core CPU
8 GB Memory
64-bit version of Windows 2012 R2 (or later)

The location of the gateway installation can have significant impact on your query performance, so try to make sure
your gateway, data source locations, and the Power BI tenant are as close as possible to each other to minimize
network latency. To determine your Power BI tenant location, in the Power BI service select the ? icon in the upper-
right corner, and then select About Power BI.



Monitoring gatewaysMonitoring gateways

Performance countersPerformance counters

NOTENOTE

LogsLogs

Additional loggingAdditional logging

There are a few tools that you can use to monitor the use and performance of your installed gateways.

There are many performance counters that can be used to evaluate and assess activity occurring on the gateway.
The counters can help you understand whether you have large volume of activities by the specific type, which may
prompt you to deploy a new gateway.

These counters will not capture specific task duration time.

The gateway counter, in addition to your machine's counters, provide you with an idea of how much load your
machine is handling, and can provide an indication of whether the server resource capacity is becoming stretched
or exceeded.

These counters can be accessed from Windows Performance Monitor, and can be consumed by any reporting
tools you use for this purpose. For a detailed walk-through of how to use the gateway performance monitor with
Power BI, take a look at the following community-create blog post.

Monitor on-premises data gateways

Configuration and service logs provide another dimension on what's happening with your gateway. Always check
your gateway logs when your connection is not working as expected, as not all error messages are surfaced on the
Power BI service.

An easy way to view all the log files on your local machine is to use the Export Logs button on the on-premises
data gateway when you re-open the gateway after the initial installation is complete, and then select Diagnostics
> Export Logs.

By default the gateway performs basic logging. If you're investigating gateway issues, and need more information
about query connection details, you can temporarily enable verbose logging to gather additional log information.
To do this, in the installed gateway select Diagnostics > Additional logging.

Enabling this setting likely will increase the log size significantly, based on gateway usage. It's recommended that
once you're done reviewing the logs, you disable Additional logging. It's not recommended to leave this setting

https://insightsquest.com/2016/08/08/monitor-on-premises-data-gateways/


Network configurationNetwork configuration

Forcing HTTPS communication with Azure Service BusForcing HTTPS communication with Azure Service Bus

enabled during normal gateway usage.

The gateway creates an outbound connection to the Azure Service Bus. The gateway communicates on the
following outbound ports:

TCP 443 (default)
5671
5672
9350 thru 9354

The gateway does not require inbound ports. All required ports are listed in the above list.

It is recommended that you whitelist the IP addresses, for your data region, in your firewall. You can download list
of IP addresses, which are found in the Microsoft Azure Datacenter IP list. That list is updated weekly. The gateway
will communicate with Azure Service Bus using the specified IP address, along with the fully qualified domain
name (FQDN). If you're forcing the gateway to communicate using HTTPS, the gateway strictly uses FQDN only,
and no communication will occur using IP addresses.

You can force the gateway to communicate with the Azure Service Bus by using HTTPS, instead of direct TCP.
Doing so will slightly reduce performance. You can also force the gateway to communicate with the Azure Service
Bus by using HTTPS by using the gateway's user interface (beginning with the March 2017 release of the gateway).

To do so, in the gateway select Network, then turn the Azure Service Bus connectivity mode On.

https://www.microsoft.com/download/details.aspx?id=41653


Additional guidanceAdditional guidance

Gateway RecoveryGateway Recovery

AdministratorsAdministrators

This section provides additional guidance for deploying and managing gateways.

Avoid having a single point of failure. If possible, distribute your on-premises data sources across several
gateways; in this case, if one machine becomes unavailable, you'll still be able to refresh portions of your data,
and not lose that functionality completely.
The gateway cannot be installed on a domain controller, so don't plan or try to do so.
Don't install a gateway on a computer that may be turned off, go into the sleep mode, or not be connected to
the Internet (for example, a laptop computer), because the gateway can't run under any of those circumstances.
Avoid installing a gateway on a wireless network, since performance might suffer over a wireless network.

You can recover your existing gateway, or move it to a new machine, using the recovery key. The recovery key is
provided to the user who installs the gateway, and it cannot be changed later. The recovery key is used for both
data encryption and gateway recovery.

To recover your gateway, make sure you're an admin on the gateway, make sure you know the gateway name,
ensure you have the correct recovery key, and that you have a new machine available with similar performance
characteristics.

After you sign in, select the Migrate an existing gateway option. Next, you need to choose the gateway you'd like
to recover or migrate, and finally provide the recovery key and hit configure. Once that step is done, the old
gateway will be replaced by the new gateway, and the new gateway will inherit its name and all data sources
previously configured. All data sources will now go through the new machine, without the need to re-publish
anything. Automatic failover is not yet supported, but it is a feature that the gateway team is actively considering.

You can find a list of gateway administrators in the Power BI service. When signed into the Power BI service,
select Settings (the gear icon) > Manage Gateways > Gateway UI.



Next steps

From there, you can select a gateway and see the list of gateway administrators. The administrators listed can
access, recover, and delete the gateway. They can also add and delete data sources in the gateway. To make sure all
administrators in the organization have access to all gateways in their group, the following is recommended:

Create an AAD security group and add other users to it, then add this security group to the list of the respective
gateway administrators. This ensures that more than one person has access to the gateway in case of a failure,
or when you need to recover or migrate the gateway. This also gives other administrators a view of what
gateways are being used in their groups, and which data sources exist on each gateway.

Configuring proxy settings
Troubleshooting the on-premises data gateway
On-premises data gateway FAQ

More questions? Try the Power BI Community

http://community.powerbi.com/
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Requirements

Limitations of Analysis Services live connectionsLimitations of Analysis Services live connections

SERVER VERSION REQUIRED SKU

2012 SP1 CU4 or later Business Intelligence and Enterprise SKU

2014 Business Intelligence and Enterprise SKU

2016 Standard SKU or higher

The on-premises data gateway acts as a bridge, providing quick and secure data transfer between on-
premises data (data that is not in the cloud) and the Power BI, Microsoft Flow, Logic Apps, and PowerApps
services.

You can use a single gateway with different services at the same time. If you are using Power BI as well as
PowerApps, a single gateway can be used for both. It is dependent on the account you sign in with.

The on-premises data gateway implements data compression, and transport encryption, in all modes.

Minimum Requirements:

.NET 4.6 Framework
64-bit version of Windows 7 / Windows Server 2008 R2 (or later)

Recommended:

8 Core CPU
8 GB Memory
64-bit version of Windows 2012 R2 (or later)

Related Considerations:

The gateway cannot be installed on a domain controller
You shouldn't install a gateway on a computer, such a laptop, that may be turned off, asleep, or not
connected to the Internet because the gateway can't run under any of those circumstances. In addition,
gateway performance might suffer over a wireless network.
Analysis Services is not required to use the gateway. You can use the gateway to connect to an Analysis
Services data source.

You can use a live connection against tabular or multidimensional instances.

Cell level Formatting and translation features are not supported.
Actions and Named Sets are not exposed to Power BI, but you can still connect to multidimensional cubes
that also contain Actions or Named sets and create visuals and reports.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-gateway-onprem.md


List of available data source types

DATA SOURCE LIVE/DIRECTQUERY
USER CONFIGURED MANUAL OR
SCHEDULED REFRESH

Analysis Services Tabular Yes Yes

Analysis Services Multidimensional Yes Yes

File No Yes

Folder No Yes

IBM DB2 No Yes

IBM Informix Database No Yes

Impala Yes Yes

MySQL No Yes

OData No Yes

ODBC No Yes

Oledb No Yes

Oracle Yes Yes

PostgresSQL No Yes

SAP BW Yes Yes

SAP HANA Yes Yes

SharePoint list (on-premises) No Yes

Snowflake Yes Yes

SQL Server Yes Yes

Sybase No Yes

Teradata Yes Yes

Web No Yes

Download and install the on-premises data gateway
To download the gateway, select Data Gateway under the Downloads menu. Download the on-premises
data gateway.

http://go.microsoft.com/fwlink/?LinkID=820925


Install the on-premises data gateway

NOTENOTE

The data gateway installs and runs on your computer. It is best to install the gateway on a machine that can
be left running all the time.

The gateway is supported only on 64-bit Windows operating systems.

For Power BI, the first choice you have to make is the mode of the gateway.

On-premises data gateway: Multiple users can share and reuse a gateway in this mode. This gateway
can be used by Power BI, PowerApps, Flow or Logic Apps. For Power BI, this includes support for both
schedule refresh and DirectQuery
Personal: This is for Power BI only and can be used as an individual without any administrator
configuration. This can only be used for on-demand refresh and schedule refresh. This selection launchs
installation of the personal gateway.

There are a few things to note about insalling either mode of the gateway:

both gateways require 64-bit Windows operating systems
gateways can’t be installed on a domain controller
you can install up to two on-premises data gateways on the same computer, one running in each mode
(personal and standard).
you cannot have more than one gateway running in the same mode on the same computer.
you can install multiple on-premises data gateways on different computers, and manage them all from
the same Power BI gateway management interface (excluding personal, see the following bullet point)
You can only have one Personal mode gateway running for each Power BI user. If you install another
Personal mode gateway for the same user, even on a different computer, the most recent installation
replaces the existing previous installation.



Here are a few things to consider before installing the gateway.

If you are installing on a laptop, and your laptop is turned off, not connected to the internet, or asleep the
gateway won’t work and the data in the cloud service will not be synchronized with your on-premises
data.
If your machine is connected to a wireless network, the gateway may perform more slowly which will
cause it to take longer to synchronize the data in the cloud service with your on-premises data.

Once the gateway is installed, you will need to sign in with your work or school account.

After you are signed in, you will have the option to configure a new gateway, or to migrate, restore, or take
over an existing gateway.



Configure a new gateway

NOTENOTE

1. Enter a name for the gateway
2. Enter a recovery key. This has to be a minimum of 8 characters.
3. Select Configure.

The recovery key will be needed if you ever need to migrate, restore or take over a gateway. Be sure to keep this key
in a safe place.



Migrate, restore or take over an existing gatewayMigrate, restore or take over an existing gateway

On-premises data gateway connectedOn-premises data gateway connected

Install the gateway in personal mode

NOTENOTE

You will need to select the gateway you want to recover and supply the recovery key that was used to first
create the gateway.

Once the gateway is configured, you will be able to make use of it to connect to on-premises data sources.

If the gateway is for Power BI, you will need to add your data sources to the gateway within the Power BI
service. This is done within the Manage gateways area. You can refer to the manage data sources articles
for more information.

For PowerApps, you will need to select a gateway for a defined connection for supported data sources. For
Flow and Logic Apps, this gateway is ready to be used with your on-premises connections.

Personal will only work with Power BI.

After the personal gateway is installed, you will need to launch the Power BI Gateway - Personal
Configuration Wizard.

You will then need to sign into Power BI to register the gateway with the cloud service.



Storing encrypted credentials in the cloud

Sign in account

You will also need to supply the windows user name and password that the windows service will run as. You
can specify a different Windows account from your own. The gateway service will run using this account.

After the installation is complete, you will need to go to your datasets within Power BI and make sure
credentials are entered for your on-premises data sources.

      

When you add a data source to the gateway, you need to provide credentials for that data source. All queries
to the data source will run using these credentials. The credentials are encrypted securely, using asymmetric
encryption so that they cannot be decrypted in the cloud, before they are stored in the cloud. The credentials
are sent to the machine, running the gateway, on-premises where they are decrypted when the data sources
are accessed.

Users will sign in with either a work or school account. This is your organization account. If you signed up for
an Office 365 offering and didn’t supply your actual work email, it may look like
nancy@contoso.onmicrosoft.com. Your account, within a cloud service, is stored within a tenant in Azure
Active Directory (AAD). In most cases, your AAD account’s UPN will match the email address.



   

Windows Service account
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Ports

NOTENOTE

DOMAIN NAMES OUTBOUND PORTS DESCRIPTION

*.download.microsoft.com 80 HTTP used to download the installer.

*.powerbi.com 443 HTTPS

*.analysis.windows.net 443 HTTPS

*.login.windows.net 443 HTTPS

*.servicebus.windows.net 5671-5672 Advanced Message Queuing Protocol
(AMQP)

*.servicebus.windows.net 443, 9350-9354 Listeners on Service Bus Relay over
TCP (requires 443 for Access Control
token acquisition)

*.frontend.clouddatahub.net 443 HTTPS

The on-premises data gateway is configured to use NT SERVICE\PBIEgwService for the Windows service
logon credential. By default, it has the right of Log on as a service. This is in the context of the machine that
you are installing the gateway on.

If you selected personal mode, you configure the Windows service account separately.

This is not the account used to connect to on-premises data sources. This is also not your work or school
account that you sign into cloud services with.

If you encounter issues with your proxy server, due to authentication, you may want to change the Windows
service account to a domain user or managed service account. You can learn how to change the account in
proxy configuration.

The gateway creates an outbound connection to Azure Service Bus. It communicates on outbound ports: TCP
443 (default), 5671, 5672, 9350 thru 9354. The gateway does not require inbound ports. Learn more

It is recommended that you whitelist the IP addresses, for your data region, in your firewall. You can
download the Microsoft Azure Datacenter IP list. This list is updated weekly. The gateway will communicate
with Azure Service Bus using the IP address along with the fully qualified domain name (FQDN). If you are
forcing the gateway to communicate using HTTPS it will strictly use FQDN only, and no communication will
happen using IP addresses.

The IP Addresses listed in the Azure Datacenter IP list are in CIDR notation. For example, 10.0.0.0/24 does not mean
10.0.0.0 thru 10.0.0.24. Learn more about the CIDR notation.

Here is a listing of the fully qualified domain names used by the gateway.

https://azure.microsoft.com/documentation/articles/service-bus-fundamentals-hybrid-solutions/
https://www.microsoft.com/download/details.aspx?id=41653
http://whatismyipaddress.com/cidr


*.core.windows.net 443 HTTPS

login.microsoftonline.com 443 HTTPS

*.msftncsi.com 443 Used to test internet connectivity if
the gateway is unreachable by the
Power BI service.

*.microsoftonline-p.com 443 Used for authentication depending
on configuration.

DOMAIN NAMES OUTBOUND PORTS DESCRIPTION

NOTENOTE

Forcing HTTPS communication with Azure Service Bus

<setting name="ServiceBusSystemConnectivityModeString" serializeAs="String">
    <value>Https</value>
</setting>

Traffic going to visualstudio.com or visualstudioonline.com are for app insights and are not required for the gateway
to function.

You can force the gateway to communicate with Azure Service Bus using HTTPS instead of direct TCP. This
may have an impact on performance. To do so, modify the
Microsoft.PowerBI.DataMovement.Pipeline.GatewayCore.dll.config file by changing the value from 
AutoDetect  to Https , as shown in the code snippet directly following this paragraph. That file is located (by

default) at C:\Program Files\On-premises data gateway.

The value for the ServiceBusSystemConnectivityModeString parameter is case sensitive. Valid values are
AutoDetect and Https.

Alternatively, you can force the gateway to adopt this behavior using the gateway user interface, beginning
with the March 2017 release. In the gateway user interface select Network, then toggle the Azure Service
Bus connectivity mode to On.

https://powerbi.microsoft.com/blog/power-bi-gateways-march-update/


Once changed, when you select Apply (a button that only appears when you make a change), the gateway
Windows service restarts automatically, so the change can take effect.

For future reference, you can restart the gateway Windows service from the user interface dialog by selecting
Service Settings then select Restart Now.



Support for TLS 1.1/1.2

    [HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\.NETFramework\v4.0.30319]"SchUseStrongCrypto"=dword:00000001
    
[HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Microsoft\.NETFramework\v4.0.30319]"SchUseStrongCrypto"=dword:00
000001

NOTENOTE

How to restart the gateway

With the August 2017 update and beyond, the on-premises data gateway uses Transport Layer Security (TLS)
1.1 or 1.2 to communicate with the Power BI service by default. Previous versions of the on-premises data
gateway use TLS 1.0 by default. On March 15th 2018, support for TLS 1.0 will end, including the gateway's
ability to interact with the Power BI service using TLS 1.0, so by then you must upgrade your on-premises
data gateway installations to the August 2017 release or newer to ensure your gateways continue to operate.

It's important to note that TLS 1.0 is still supported by the on-premises data gateway prior to November 1st,
and is used by the gateway as a fallback mechanism. To ensure all gateway traffic uses TLS 1.1 or 1.2 (and to
prevent the use of TLS 1.0 on your gateway), you must add or modify the following registry keys on the
machine running the gateway service:

Adding or modifying these registry keys applies the change to all .NET applications. For information about registry
changes that affect TLS for other applications, see Transport Layer Security (TLS) registry settings.

https://docs.microsoft.com/windows-server/security/tls/tls-registry-settings


 How the gateway works
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Troubleshooting

The gateway runs as a windows service. You can start and stop it like any windows service. There are multiple
ways to do this. Here is how you can do it from the command prompt.

1. On the machine where the gateway is running, launch an admin command prompt.
2. Use the following command to stop the service.

net stop PBIEgwService

3. Use the following command to start the service.

net start PBIEgwService

Let’s first look at what happens when a user interacts with an element connected to an on-premises data
source.

For Power BI, you will need to configure a data source for the gateway.

1. A query will be created by the cloud service, along with the encrypted credentials for the on-premises data
source, and sent to the queue for the gateway to process.

2. The gateway cloud service will analyze the query and will push the request to the Azure Service Bus.
3. The on-premises data gateway polls the Azure Service Bus for pending requests.
4. The gateway gets the query, decrypts the credentials and connects to the data source(s) with those

credentials.
5. The gateway sends the query to the data source for execution.
6. The results are sent from the data source, back to the gateway, and then onto the cloud service. The

service then uses the results.

If you’re having trouble when installing and configuring a gateway, be sure to see Troubleshooting the on-
premises data gateway. If you think you are having an issue with your firewall, see the firewall or proxy

https://azure.microsoft.com/documentation/services/service-bus/
https://azure.microsoft.com/documentation/services/service-bus/


Next steps

section in the troubleshooting article.

If you think you are encountering proxy issues, with the gateway, see Configuring proxy settings for the
Power BI gateways.

Manage your data source - Analysis Services
Manage your data source - SAP HANA
Manage your data source - SQL Server
Manage your data source - Oracle
Manage your data source - Import/Scheduled refresh
On-premises data gateway in-depth
On-premises data gateway (personal mode) - the new version of the personal gateway Configuring proxy
settings for the on-premises data gateway
More questions? Try the Power BI Community

http://community.powerbi.com/
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How the gateway works

NOTENOTE

It's possible for users in your organization to access on-premises data (to which they already have access
authorization), but before those users can connect to your on-premises data source, an on-premises data
gateway needs to be installed and configured. The gateway facilitates quick and secure behind-the-scenes
communication between a user in the cloud, to your on-premises data source, and then back to the cloud.

Installing and configuring a gateway is usually done by an administrator. It may require special knowledge of
your on-premises servers and in some cases may require Server Administrator permissions.

This article doesn’t provide step-by-step guidance on how to install and configure the gateway. For that, be sure
to see On-premises data gateway. This article is meant to provide you with an in-depth understanding of how the
gateway works. We’ll also go into some detail about usernames and security in both Azure Active Directory and
Analysis Services, and how the cloud service uses the e-mail address a user sign in with, the gateway, and Active
Directory to securely connect to and query your on-premises data.

Let’s first look at what happens when a user interacts with an element connected to an on-premises data source.

For Power BI, you will need to configure a data source for the gateway.

1. A query will be created by the cloud service, along with the encrypted credentials for the on-premises data
source, and sent to the queue for the gateway to process.

2. The gateway cloud service will analyze the query and will push the request to the Azure Service Bus.
3. The on-premises data gateway polls the Azure Service Bus for pending requests.
4. The gateway gets the query, decrypts the credentials and connects to the data source(s) with those credentials.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-gateway-onprem-indepth.md
https://azure.microsoft.com/documentation/services/service-bus/
https://azure.microsoft.com/documentation/services/service-bus/


List of available data source types

DATA SOURCE LIVE/DIRECTQUERY
USER CONFIGURED MANUAL OR
SCHEDULED REFRESH

Analysis Services Tabular Yes Yes

Analysis Services Multidimensional Yes Yes

File No Yes

Folder No Yes

IBM DB2 No Yes

IBM Informix Database No Yes

Impala Yes Yes

MySQL No Yes

OData No Yes

ODBC No Yes

Oledb No Yes

Oracle Yes Yes

PostgresSQL No Yes

SAP BW Yes Yes

SAP HANA Yes Yes

SharePoint list (on-premises) No Yes

Snowflake Yes Yes

SQL Server Yes Yes

Sybase No Yes

Teradata Yes Yes

Web No Yes

Sign in account

5. The gateway sends the query to the data source for execution.
6. The results are sent from the data source, back to the gateway, and then onto the cloud service. The service

then uses the results.



Authentication to on-premises data sources

Authentication to a live Analysis Services data source

Role-based security

Row-level security

What about Azure Active Directory?

Users will sign in with either a work or school account. This is your organization account. If you signed up for an
Office 365 offering and didn’t supply your actual work email, it may look like nancy@contoso.onmicrosoft.com.
Your account, within a cloud service, is stored within a tenant in Azure Active Directory (AAD). In most cases, your
AAD account’s UPN will match the email address.

A stored credential will be used to connect to on-premises data sources from the gateway except Analysis
Services. Regardless of the individual user, the gateway uses the stored credential to connect.

Each time a user interacts with Analysis Services, the effective username is passed to the gateway and then onto
your on-premises Analysis Services server. The user principal name (UPN), typically the email address you sign
into the cloud with, is what we will pass to Analysis Services as the effective user. The UPN is passed in the
connection property EffectiveUserName. This email address should match a defined UPN within the local Active
Directory domain. The UPN is a property of an Active Directory account. That Windows account then needs to be
present in an Analysis Services role to have access to the server. The login will not be successful if no match is
found in Active Directory.

Analysis Services can also provide filtering based on this account. The filtering can occur with either role based
security, or row-level security.

Models provide security based on user roles. Roles are defined for a particular model project during authoring in
SQL Server Data Tools – Business Intelligence (SSDT-BI), or after a model is deployed, by using SQL Server
Management Studio (SSMS). Roles contain members by Windows username or by Windows group. Roles define
permissions a user has to query or perform actions on the model. Most users will belong to a role with Read
permissions. Other roles are meant for administrators with permissions to process items, manage database
functions, and manage other roles.

Row-level security is specific to Analysis Services row-level security. Models can provide dynamic, row-level
security. Unlike having at least one role in which users belong to, dynamic security is not required for any tabular
model. At a high-level, dynamic security defines a user’s read access to data right down to a particular row in a
particular table. Similar to roles, dynamic row-level security relies on a user’s Windows username.

A user’s ability to query and view model data are determined first by the roles their Windows user account are a
member of and second, by dynamic row-level security, if configured.

Implementing role and dynamic row-level security in models are beyond the scope of this article. You can learn
more at Roles (SSAS Tabular) and Security Roles (Analysis Services - Multidimensional Data) on MSDN. And, for
the most in-depth understanding of tabular model security, download and read the Securing the Tabular BI
Semantic Model whitepaper.

Microsoft cloud services use Azure Active Directory to take care of authenticating users. Azure Active Directory is
the tenant that contains usernames and security groups. Typically, the email address a user signs in with is the
same as the UPN of the account.

What is my local Active Directory’s role?

https://msdn.microsoft.com/library/hh213165.aspx
https://msdn.microsoft.com/library/ms174840.aspx
https://msdn.microsoft.com/library/jj127437.aspx
https://azure.microsoft.com/documentation/articles/active-directory-whatis/


How do I tell what my UPN is?

whoami /upn

Mapping usernames for Analysis Services data sources

Synchronize an on-premises Active Directory with Azure Active
Directory

For Analysis Services to determine if a user connecting to it belongs to a role with permissions to read data, the
server needs to convert the effective username passed from AAD to the gateway, and onto the Analysis Services
server. The Analysis Services server passes the effective username to a Windows Active Directory domain
controller (DC). The Active Directory DC then validates the effective username is a valid UPN, on a local account,
and returns that user’s Windows username back to the Analysis Services server.

EffectiveUserName cannot be used on a non-domain joined Analysis Services server. The Analysis Services server
must be joined to a domain to avoid any login errors.

You may not know what your UPN is, and you may not be a domain administrator. You can use the following
command from your workstation to find out the UPN for your account.

The result will look similar to an email address, but this is the UPN that is on your local domain account. If you are
using an Analysis Services data source for live connections, this must match what was passed to
EffectiveUserName from the gateway.

Power BI allows for mapping usernames for Analysis Services data sources. You can configure rules to map a
username logged in with Power BI to a name that is passed for EffectiveUserName on the Analysis Services
connection. The map user names feature is a great way to work around when your username in AAD doesn't
match a UPN in your local Active Directory. For example, if your email address is nancy@contoso.onmicrsoft.com,
you could map it to nancy@contoso.com, and that value would be passed to the gateway. You can learn more
about how to map user names.

You would want your local Active Directory accounts to match Azure Active Directory if you are going to be using
Analysis Services live connections. As the UPN has to match between the accounts.

The cloud services only know about accounts within Azure Active Directory. It doesn’t matter if you added an
account in your local Active Directory, if it doesn’t exist in AAD, it cannot be used. There are different ways that
you can match your local Active Directory accounts with Azure Active Directory.

1. You can add accounts manually to Azure Active Directory.

You can create an account on the Azure portal, or within the Office 365 Admin Portal, and the account
name matches the UPN of the local Active Directory account.

2. You can use the Azure AD Connect tool to synchronize local accounts to your Azure Active Directory
tenant.

The Azure AD Connect tool provides options for directory and password synchronization. If you are not a
tenant admin or a local domain administrator, you will need to contact your IT admin to get this
configured.

3. You can configure Active Directory Federation Services (ADFS).

You can associate your ADFS server to your AAD tenant with the Azure AD Connect tool. ADFS makes use
of the directory synchronization discussed above but allows for a single sign-on (SSO) experience. For

https://azure.microsoft.com/documentation/articles/active-directory-aadconnect/
https://azure.microsoft.com/documentation/articles/active-directory-aadconnect/
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Now, this is where the gateway comes in

What to do next?

Where things can go wrong

Sign in account

example, if you are within your work network, when you to a cloud service, and go to sign in, you may not
be prompted to enter a username or password. You will need to discuss with your IT Admin if this is
available for your organization.

Using Azure AD Connect ensures that the UPN will match between AAD and your local Active Directory.

Synchronizing accounts with the Azure AD Connect tool will create new accounts within your AAD tenant.

The gateway acts as a bridge between the cloud and your on-premises server. Data transfer between the cloud
and the gateway is secured through Azure Service Bus. The Service Bus creates a secure channel between the
cloud and your on-premises server through an outbound connection on the gateway. There are no inbound
connections that you need to open on your on-premises firewall.

If you have an Analysis Services data source, you’ll need to install the gateway on a computer joined to the same
forest/domain as your Analysis Services server.

The closer the gateway is to the server, the faster the connection will be. If you can get the gateway on the same
server as the data source, that is best to avoid network latency between the gateway and the server.

After you get the gateway installed, you will want to create data sources for that gateway. You can add data
sources within the Manage gateways screen. For more information, see the manage data sources articles.

Manage your data source - Analysis Services
Manage your data source - SAP HANA
Manage your data source - SQL Server
Manage your data source - Oracle
Manage your data source - Import/Scheduled refresh

Sometimes installing the gateway fails. Or, maybe the gateway seems to install ok, but the service is still unable to
work with it. In many cases, it’s something simple, like the password for the credentials the gateway uses to sign
into the data source.

In other cases, there might be issues with the type of e-mail address users sign in with, or Analysis Services’
inability to resolve an effective username. If you have multiple domains with trusts between them, and your
gateway is in one and Analysis Services in another, this sometimes can cause some problems.

Rather than go into troubleshooting gateway issues here, we’ve put a series of troubleshooting steps into another
article; Troubleshooting the on-premises data gateway. Hopefully, you won’t have any problems. But if you do,
understanding how all of this works and the troubleshooting article should help.

Users will sign in with either a work or school account. This is your organization account. If you signed up for an
Office 365 offering and didn’t supply your actual work email, it may look like nancy@contoso.onmicrosoft.com.
Your account, within a cloud service, is stored within a tenant in Azure Active Directory (AAD). In most cases, your
AAD account’s UPN will match the email address.

https://azure.microsoft.com/documentation/services/service-bus/


Windows Service account

NOTENOTE

Ports

NOTENOTE

DOMAIN NAMES OUTBOUND PORTS DESCRIPTION

*.download.microsoft.com 80 HTTP used to download the installer.

*.powerbi.com 443 HTTPS

*.analysis.windows.net 443 HTTPS

*.login.windows.net 443 HTTPS

*.servicebus.windows.net 5671-5672 Advanced Message Queuing Protocol
(AMQP)

*.servicebus.windows.net 443, 9350-9354 Listeners on Service Bus Relay over TCP
(requires 443 for Access Control token
acquisition)

*.frontend.clouddatahub.net 443 HTTPS

The on-premises data gateway is configured to use NT SERVICE\PBIEgwService for the Windows service logon
credential. By default, it has the right of Log on as a service. This is in the context of the machine that you are
installing the gateway on.

If you selected personal mode, you configure the Windows service account separately.

This is not the account used to connect to on-premises data sources. This is also not your work or school account
that you sign into cloud services with.

If you encounter issues with your proxy server, due to authentication, you may want to change the Windows
service account to a domain user or managed service account. You can learn how to change the account in proxy
configuration.

The gateway creates an outbound connection to Azure Service Bus. It communicates on outbound ports: TCP 443
(default), 5671, 5672, 9350 thru 9354. The gateway does not require inbound ports. Learn more

It is recommended that you whitelist the IP addresses, for your data region, in your firewall. You can download
the Microsoft Azure Datacenter IP list. This list is updated weekly. The gateway will communicate with Azure
Service Bus using the IP address along with the fully qualified domain name (FQDN). If you are forcing the
gateway to communicate using HTTPS it will strictly use FQDN only, and no communication will happen using IP
addresses.

The IP Addresses listed in the Azure Datacenter IP list are in CIDR notation. For example, 10.0.0.0/24 does not mean
10.0.0.0 thru 10.0.0.24. Learn more about the CIDR notation.

Here is a listing of the fully qualified domain names used by the gateway.

https://azure.microsoft.com/documentation/articles/service-bus-fundamentals-hybrid-solutions/
https://www.microsoft.com/download/details.aspx?id=41653
http://whatismyipaddress.com/cidr


*.core.windows.net 443 HTTPS

login.microsoftonline.com 443 HTTPS

*.msftncsi.com 443 Used to test internet connectivity if the
gateway is unreachable by the Power
BI service.

*.microsoftonline-p.com 443 Used for authentication depending on
configuration.

DOMAIN NAMES OUTBOUND PORTS DESCRIPTION

NOTENOTE

Forcing HTTPS communication with Azure Service Bus

<setting name="ServiceBusSystemConnectivityModeString" serializeAs="String">
    <value>Https</value>
</setting>

Traffic going to visualstudio.com or visualstudioonline.com are for app insights and are not required for the gateway to
function.

You can force the gateway to communicate with Azure Service Bus using HTTPS instead of direct TCP. This may
have an impact on performance. To do so, modify the
Microsoft.PowerBI.DataMovement.Pipeline.GatewayCore.dll.config file by changing the value from AutoDetect  to 
Https , as shown in the code snippet directly following this paragraph. That file is located (by default) at

C:\Program Files\On-premises data gateway.

The value for the ServiceBusSystemConnectivityModeString parameter is case sensitive. Valid values are
AutoDetect and Https.

Alternatively, you can force the gateway to adopt this behavior using the gateway user interface, beginning with
the March 2017 release. In the gateway user interface select Network, then toggle the Azure Service Bus
connectivity mode to On.

https://powerbi.microsoft.com/blog/power-bi-gateways-march-update/


Once changed, when you select Apply (a button that only appears when you make a change), the gateway
Windows service restarts automatically, so the change can take effect.

For future reference, you can restart the gateway Windows service from the user interface dialog by selecting
Service Settings then select Restart Now.



Support for TLS 1.1/1.2

    [HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\.NETFramework\v4.0.30319]"SchUseStrongCrypto"=dword:00000001
    
[HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Microsoft\.NETFramework\v4.0.30319]"SchUseStrongCrypto"=dword:000000
01

NOTENOTE

How to restart the gateway

With the August 2017 update and beyond, the on-premises data gateway uses Transport Layer Security (TLS) 1.1
or 1.2 to communicate with the Power BI service by default. Previous versions of the on-premises data gateway
use TLS 1.0 by default. On March 15th 2018, support for TLS 1.0 will end, including the gateway's ability to
interact with the Power BI service using TLS 1.0, so by then you must upgrade your on-premises data gateway
installations to the August 2017 release or newer to ensure your gateways continue to operate.

It's important to note that TLS 1.0 is still supported by the on-premises data gateway prior to November 1st, and
is used by the gateway as a fallback mechanism. To ensure all gateway traffic uses TLS 1.1 or 1.2 (and to prevent
the use of TLS 1.0 on your gateway), you must add or modify the following registry keys on the machine running
the gateway service:

Adding or modifying these registry keys applies the change to all .NET applications. For information about registry changes
that affect TLS for other applications, see Transport Layer Security (TLS) registry settings.

https://docs.microsoft.com/windows-server/security/tls/tls-registry-settings


Next steps

The gateway runs as a windows service. You can start and stop it like any windows service. There are multiple
ways to do this. Here is how you can do it from the command prompt.

1. On the machine where the gateway is running, launch an admin command prompt.
2. Use the following command to stop the service.

net stop PBIEgwService

3. Use the following command to start the service.

net start PBIEgwService

Troubleshooting the on-premises data gateway
Azure Service Bus
Azure AD Connect
More questions? Try the Power BI Community

https://azure.microsoft.com/documentation/services/service-bus/
https://azure.microsoft.com/documentation/articles/active-directory-aadconnect/
http://community.powerbi.com/
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Setting up high availability clusters of gateways

Managing a gateway cluster

You can create high availability clusters of on-premises data gateway installations, to ensure your
organization can access on-premises data resources used in Power BI reports and dashboards. Such clusters allow
gateway administrators to group gateways to avoid single points of failure in accessing on-premises data
resources. This article describes the steps you can take to create a high availability cluster of on-premises data
gateways, and shares best practices when setting them up. High availability gateway clusters require the November
2017 update to on-premises data gateway, or later.

During the on-premises data gateway installation process, you can specify whether the gateway should be added
to an existing gateway cluster.

In order to add a gateway to an existing cluster, you must provide the Recovery key for the primary gateway
instance for the cluster you want the new gateway to join. The primary gateway for the cluster must be running the
gateway update from November 2017 or later.

Once a gateway cluster consists of two or more gateways, all gateway management operations, such as adding a
data source or granting administrative permissions to a gateway, apply to all gateways that are part of the cluster.

When administrators use the Manage gateways menu item, found under the gear icon in the Power BI service,
they see the list of registered clusters or individual gateways, but do not see the individual gateway instances that
are members of the cluster.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-gateway-high-availability-clusters.md


PowerShell support for gateway clusters

COMMAND DESCRIPTION PARAMETERS

Login-OnPremisesDataGateway This command allows a user to log in to
manage his or her on-premises data
gateway clusters. You must run this
command and log in before other high
availability commands can work
properly. Note: the AAD auth token
acquired as part of a Login call is only
valid for 1 hour, after which it expires.
You can re-run the Login command to
acquire a new token.

AAD username and password (provided
as part of the command execution, not
initial invocation)

Get-OnPremisesDataGatewayClusters Retrieves the list of gateway clusters for
the logged in user.

Optionally, you can pass formatting
parameters to this command for better
readability, such as: Format-Table -
AutoSize -Wrap

Get-OnPremisesDataClusterGateways Retrieves the list of gateways within the
specified cluster, as well as additional
information for each gateway
(online/offline status, machine name, so
on)

-ClusterObjectID xyz (where xyz is
replaced with an actual cluster object ID
value, which can be retrieved using the
Get-OnPremisesDataGatewayClusters
command)

All new Scheduled Refresh requests and DirectQuery operations are automatically routed ot the primary instance
of a given gateway cluster. If the primary gateway instance is not online, the request is routed to another gateway
instance in the cluster.

PowerShell scripts are available in the on-premises data gateway installation folder. By default, that folder is
C:\Program Files\On-premises data gateway. You must be using PowerShell version 5 or newer for these scripts to
work properly. The PowerShell scripts let users perform the following operations:

Retrieve the list of gateway clusters available for a user
Retrieve the list of gateway instances registered in a cluster, as well as their online or offline status
Modify the enable/disable status for a gateway instance within a cluster, as well as other gateway properties
Delete a gateway

In order to run the PowerShell commands in the table, you first need to take the following steps: :

1. Open a PowerShell command window, as an Administrator

Set-ExecutionPolicy -ExecutionPolicy Unrestricted -Force

Import-Module .\OnPremisesDataGatewayHAMgmt.psm1

2. Then run the following one-time PowerShell command (this presumes you've never run PowerShell
commands on the current machine):

3. Next, navigate to the on-premises data gateway installation folder in the PowerShell window, and import the
necessary module using the following command:

Once those steps are complete, you can use the commands in the following table to manage your gateway clusters



Set-OnPremisesDataGateway Lets you set property values for a given
gateway within a cluster, including the
ability to Enable/Disable a specific
gateway instance

-ClusterObjectID xyz (xyz should be
replaced with an actual cluster object ID
value, which can be retrieved using the
Get-OnPremisesDataGatewayClusters
command) -GatewayObjectID abc (abc
should be replaced with an actual
gateway object ID value, which can be
retrieved using the Get-
OnPremisesDataClusterGateways
command, given a cluster object ID)

Get-OnPremisesDataGatewayStatus Lets you retrieve the status for a given
gateway instance within a cluster

-ClusterObjectID xyz (xyz should be
replaced with an actual cluster object ID
value, which can be retrieved using the
Get-OnPremisesDataGatewayClusters
command) -GatewayObjectID abc (abc
should be replaced with an actual
gateway object ID value, which can be
retrieved using the Get-
OnPremisesDataClusterGateways
command, given a cluster object ID)

Remove-OnPremisesDataGateway Lets you remove a gateway instance
from a cluster - note that the primary
gateway in the cluster cannot be
removed until all other gateways in the
cluster have been removed.

-ClusterObjectID xyz (xyz should be
replaced with an actual cluster object ID
value, which can be retrieved using the
Get-OnPremisesDataGatewayClusters
command) -GatewayObjectID abc (abc
should be replaced with an actual
gateway object ID value, which can be
retrieved using the Get-
OnPremisesDataClusterGateways
command, given a cluster object ID)

COMMAND DESCRIPTION PARAMETERS

Next steps
Manage your data source - Analysis Services
Manage your data source - SAP HANA
Manage your data source - SQL Server
Manage your data source - Oracle
Manage your data source - Import/Scheduled refresh
On-premises data gateway in-depth
On-premises data gateway (personal mode)
Configuring proxy settings for the on-premises data gateway
Use Kerberos for SSO (single sign-on) from Power BI to on-premises data sources

More questions? Try the Power BI Community

http://community.powerbi.com/
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General
Question: What is the actual Windows service called?
Answer: The gateway is called on-premises data gateway service in Services

Question: What are the requirements for the gateway?
Answer: Take a look at the requirements section of the main gateway article.

Question: What data sources are supported with the gateway?
Answer: See the data sources table in the main gateway article.

Question: Do I need a gateway for cloud data sources like Azure SQL Database?
Answer: No! The service will be able to connect to that data source without a gateway.

Question: Are there any inbound connections to the gateway from the cloud?
Answer: No. The gateway uses outbound connections to Azure Service Bus.

Question: What if I block outbound connections? What do I need to open?
Answer: See the list of ports and hosts that the gateway uses.

Question: Does the gateway have to be installed on the same machine as the data source?
Answer: No. The gateway will connect to the data source using the connection information that was provided.
Think of the gateway as a client application in this sense. It will just need to be able to connect to the server name
that was provided.

Question: What is the latency for running queries to a data source from the gateway? What is the best
architecture?
Answer: It is recommended to have the gateway as close to the data source as possible to avoid network latency. If
you can install the gateway on the actual data source, it will minimize the latency introduced. Consider the data
centers as well. For example, if your service is making use of the West US data center, and you have SQL Server
hosted in an Azure VM, you will want to have the Azure VM in West US as well. This will minimize latency and
avoid egress charges on the Azure VM.

Question: Are there any requirements for network bandwidth?
Answer: It is recommended to have good throughput for your network connection. Every environment is different
and this is also dependent on the amount of data being sent. Using ExpressRoute could help to guarantee a level of
throughput between on-premises and the Azure data centers.

You can use the 3rd party Azure Speed Test app to help gauge what your throughput is.

Question: Can the gateway Windows service run with an Azure Active Directory account?
Answer: No. The Windows service needs to have a valid Windows account. By default it will run with the Service
SID, NT SERVICE\PBIEgwService.

Question: How are results sent back to the cloud?
Answer: This is done by way of the Azure Service Bus. For more information, see how it works.

Question: Where are my credentials stored?
Answer: The credentials you enter for a data source are stored encrypted in the gateway cloud service. The
credentials are decrypted at the gateway on-premises.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-gateway-onprem-faq.md
http://azurespeedtest.azurewebsites.net/


<setting name="ServiceBusSystemConnectivityModeString" serializeAs="String">
    <value>Https</value>
</setting>

High Availability/Disaster Recovery

Troubleshooting

Analysis Services

Question: Can I place the gateway in a perimeter network (also known as DMZ, demilitarized zone, and screened
subnet)?
Answer: The gateway requires connectivity to the data source. If the data source is not accessable in your
perimeter network, the gateway may not be able to connect to it. For example, your SQL Server may not be in your
perimeter network. And, you cannot connect to your SQL Server from the perimeter network. If you placed the
gateway in your perimeter network, it would not be able to reach the SQL Server.

Question: Is it possible to force the gateway to use HTTPS traffic with Azure Service Bus instead of TCP?
Answer: Yes. Although, this will greatly reduce performance. You will want to modify the
Microsoft.PowerBI.DataMovement.Pipeline.GatewayCore.dll.config file. You will want to change the value from 
AutoDetect  to Https . This file is located, by default, at C:\Program Files\On-premises data gateway.

Question: Do I need to whitelist the Azure Datacenter IP list? Where do I get the list?
Answer: If you are blocking outbound IP traffic, you may need to whitelist the Azure Datacenter IP list. Currently,
the gateway will communicate with Azure Service Bus using the IP address in addition to the fully qualified domain
name. The Azure Datacenter IP list is updated weekly. You can download the Microsoft Azure Datacenter IP list.

Question: Are there any plans for enabling high availability scenarios with the gateway?
Answer: Yes, this is an area of active investment for the Power BI team. Please stay tuned to the Power BI blog for
further updates about this feature.

Question: What options are available for disaster recovery?
Answer: You can use the recovery key to restore or move a gateway. When you install the gateway, supply the
recovery key.

Question: What is the benefit of the recovery key?
Answer: It provides a way to migrate or recover your gateway settings. This is also used for disaster recovery.

Question: Where are the gateway logs located?
Answer: See the tools section of the troubleshooting article.

Question: How can I see what queries are being sent to the on-premises data source?
Answer: You can enable query tracing. This will include the queries being sent. Remember to change it back to the
original value when done troubleshooting. Having query tracing enabled will cause the logs to be larger.

You can also look at tools your data source has for tracing queries. For example, for SQL Server and Analysis
Services you can use Extended Events or SQL Profiler.

Question: Can I use msdmpump.dll to create custom effective username mappings for Analysis Services?
Answer: No. This is not supported at this time.

Question: Can I use the gateway to connect to a multidimensional (OLAP) instance.
Answer: Yes! The on-premises data gateway supports live connections to both Analysis Services Tabular and
Multidimensional models.

Question: What if I install the gateway on a computer in a different domain from my on-premises server that uses

https://www.microsoft.com/download/details.aspx?id=41653
https://powerbi.microsoft.com/blog/


Administration

Power BI

Windows authentication?
Answer: No guarantees here. It all depends on the trust relationship between the two domains. If the two different
domains are in a trusted domain model, then the gateway might be able to connect to the Analysis Services server
and the effective user name can be resolved. If not, you may encounter a login failure.

Question: How can I find out what effective username is being passed to my on-premises Analysis Services
server?
Answer: We answer this in the troubleshooting article.

Question: I have 25 databases in Analysis Services, is there a way to have them all enabled for the gateway at
once?
Answer: No. This is on the roadmap, but we don’t have a timeframe.

Question: Can I have more than one admin for a gateway?
Answer: Yes! When you manage a gateway, you can go to the administrator’s tab to add additional admins.

Question: Does the gateway admin need to be an admin on the machine where the gateway is installed?
Answer: No. The gateway admin is used to manage the gateway from within the service.

Question: Can I prevent users in my organization from creating a gateway?
Answer: No. This is on the roadmap, but we don’t have a timeframe.

Question: Can I get usage and statistics information of the gateways in my organization?
Answer: No. This is on the roadmap, but we don’t have a timeframe.

Question: Do I need to upgrade the personal gateway? Answer: No, you can keep using the personal gateway for
Power BI.

Question: How often are tiles in a dashboard, in Power BI, refreshed when connected through the on-premises
data gateway?
Answer: About ten minutes. DirectQuery connections are just that. This doesn’t mean that a tile issues a query to
your on-premises server, and shows new data, every ten minutes.

Question: Can I upload Excel workbooks with Power Pivot data models that connect to on-premises data sources?
Do I need a gateway for this scenario?
Answer: Yes, you can upload the workbook. And, no, you don’t need a gateway. But, because the data will reside in
the Excel data model, reports in Power BI based on the Excel workbook will not be live. In order to refresh reports in
Power BI, you’d have to re-upload an updated workbook each time. Or, use the gateway with scheduled refresh.

Question: If users share dashboards that has a DirectQuery connection, will those other users be able to see the
data even though they might not have the same permissions.
Answer: For a dashboard connected to Analysis Services, users will only see the data they have access to. If the
users do not have the same permissions, they will not be able to see any data. For other data sources, all users will
share the credentials entered by the admin for that data source.

Question: Why can't I connect to my Oracle server?
Answer: You may need to install the Oracle client and configure the tnsnames.ora file with the proper server
information in order to connect to your Oracle server. This is a separate install outside of the gateway. For more
information, see Installing the Oracle Client.

Question: Will the gateway work with ExpressRoute?
Answer: Yes. For more information about ExpressRoute and Power BI, see Power BI and ExpressRoute.



Next steps
On-premises data gateway
On-premises data gateway in-depth
Troubleshooting the on-premises data gateway
More questions? Try the Power BI Community

http://community.powerbi.com/
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NOTENOTE

Features of the on-premises data gateway (personal mode)

You can use on-premises data sources, and create Power BI reports and dashboards, using a gateway. A gateway
is software that facilitates access to data that is stored on a private, on-premises network, then enables you to use
that data in online services like the Power BI service. The on-premises data gateway (personal mode) is a
recently released update to the Power BI gateway that allows individuals to install a gateway on their own
computer, and gain access to on-premises data.

The on-premises data gateway (personal mode) replaces the previously supported version of the personal gateway,
which is called Power BI Gateway - Personal. The previous personal gateway will continue working only until July 31,
2017. See the sections below for information on how to update to the new version.

With the release of the on-premises data gateway (personal mode), a collection of improvements and
features are now available. In the previous version of the personal gateway (which is called Power BI Gateway -
Personal), its implementation imposed some limitations. As with many Power BI products, we listened to
customer needs, requests, and how they used the product. As a result, the on-premises data gateway
(personal mode) has been redesigned from the ground up, and includes the following features and
improvements:

Improved reliability - the new version of the personal gateway has improved reliability over the previous

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-gateway-personal-mode.md


Installing on-premises data gateway (personal mode)

Updating from the previous personal gatewayUpdating from the previous personal gateway

version, due to code and structural software improvements.
Enhanced extensibility - as part of the structural software improvements, additional features can easily be
added to the personal gateway as they become available.
Delete personal gateway from the Power BI service - with the new version, you can now delete your
personal gateway from within the Power BI service.
Configuration and service logs - the new version lets you easily export configuration and service logs to a
.zip file, with a single click.

To install the on-premises data gateway (personal mode) without having the previous version of the gateway
installed, select the gear icon in the Power BI service and select Data Gateway.

You can also download the gateway from this location. You can follow the installation steps, and since the
installation process allows you to install either version of the gateway (the standard gateway, which can be
shared with others, or personal mode), make sure you select on-premises data gateway (personal mode)
when prompted for which version of the gateway you want to install.

If you already have the Power BI Gateway - personal gateway installed, you'll be prompted to install the new
and enhanced version of the personal gateway when you view Datasets under Settings in the Power BI service.

https://go.microsoft.com/fwlink/?LinkId=820925&clcid=0x409
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When you select a dataset, and then select Gateway connection you're notified that the new and enhanced
version of the personal gateway is available. When you do, select Install now.

If you're running the previous version of Power BI Gateway - personal as an elevated process, make sure you start the
new gateway installation process elevated as well, so your dataset credentials can be automatically updated. Otherwise,
you'll have to update dataset credentials manually.

You'll be taken through the update process, after which you'll see that the installation was successful. Don't close
things out yet, there's one last step.



Here's the last step. Once the new personal gateway is installed (and the last installation screen still visible), sign
in to the Power BI service, and wait until you see that the gateway is online, as shown in the following image.



Determining which version of the personal gateway you have installedDetermining which version of the personal gateway you have installed

Using Fast Combine with the personal gateway

Limitations and considerations

If you've updated the personal gateway on the same machine as the previous gateway is installed, your
credentials will update automatically, and all refresh activities will go through the new gateway. If the previous
gateway was installed on a different machine, you'll be asked to update your credentials on certain datasets. In
the previous image, notice the list of datasets in the window; the list will show datasets that might require
updated credentials. Each dataset listed is a direct link that you simply click on to easily update your credentials.

That's it - almost. With the new gateway installed, you no longer need to previous version installed on your
machine, so you should uninstall it. You can do this by searching for Power BI Gateway - personal on your
machine, and uninstalling it.

To determine which version of the personal gateway you currently have installed, you can do the following:

The previous version of the personal gateway is called Power BI Gateway - Personal and uses the Power BI
icon in its installation dialog.
The new version of the personal gateway is called on-premises data gateway (personal mode) and uses
the gateway icon (a cloud with an up-and-down arrow along the bottom).

You can go to Add/Remove Programs and see whether Power BI Gateway - Personal appears on the list, and
if so, you have the previous version of the personal gateway installed.

If you were using Fast Combine with the previous gateway, you'll need to take the following steps to re-enable
Fast Combine to work with the on-premises data gateway (personal mode):

%localappdata%\Microsoft\on-premises data gateway (personal 
mode)\Microsoft.PowerBI.DataMovement.Pipeline.GatewayCore.dll.config

```
<setting name="EnableFastCombine" serializeAs="String">```
<value>true</value>
</setting>
```

3. Once complete, the setting will take effect in approximately one minute. To check that it's working properly, try
an on-demand refresh in the Power BI service to confirm that Fast Combine is working.

1. Using File Explorer, open the following file:

2. At the bottom of the file, add the following text:

There are a few things to consider when using the on-premises data gateway (personal mode), as described
in the following list.

If you're using Windows Hello or a pin to sign in to Windows, you might run into the following error:
The user account you selected does not match the requirements of the application. Please use a
different account.

To remedy that error, select Use a different account and sign in again.

The following data sources are currently not supported for the on-premises data gateway (personal mode):

ADO.NET



Frequently Asked Questions (FAQ)

Next steps

CurrentWorkbook
FTP
HDFS
SAP BusinessObjects
Spark

Support for Spark is planned for the second half of the 2017 calendar year.

Can I run the on-premises data gateway (personal mode) side by side with the on-premises data
gateway (previously known as the Enterprise version of the gateway)?

Answer: Yes, with the new version, both can run simultaneously.
Can I run the on-premises data gateway (personal mode) as a service?

Answer: No. the on-premises data gateway (personal mode) can only run as an application. If you
need to run the gateway as a service and/or in admin mode, you'll need to consider the on-premises
data gateway (previously known as the Enterprise gateway).

How often is the on-premises data gateway (personal mode) updated?

Answer: We plan to update the personal gateway monthly.
Why am I asked to update my credentials?

Answer: Many situations can trigger a request for credentials. The most common is that you've re-
installed the on-premises data gateway (personal mode) on a different machine than your Power
BI - personal gateway. It could also be an issue in the data source, and Power BI failed to perform a test
connection, or a timeout or a system error occurred. You can update your credentials in the Power BI
service by going to the gear icon and selecting Settings then Datasets, and finding the dataset in
question and clicking on update credentials.

How much time will my previous personal gateway be offline during the upgrade?

Answer: Upgrading the personal gateway to the new version should only take few minutes.
What happens if I don't migrate to the new personal gateway by July 31st, 2017?

Answer: If you’re refreshing your reports with the current gateway, your refreshes will stop. The only
way to set up a new refresh schedule will be by installing and configuring the new gateway.

I'm using R script. Is that supported?

Answer: We anticipating adding support for R scripts soon.
Why am I not seeing the message to update my gateway in the Power BI service?

Answer: Most likely, this is because you have one or more datasets that include a data source that is
still currently not supported.

Configuring proxy settings for the Power BI Gateways
More questions? Try the Power BI Community

http://community.powerbi.com/


Troubleshooting the on-premises data gateway
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NOTENOTE

Update to the latest version

Common issues

Authentication to proxy serverAuthentication to proxy server

Your proxy only allows ports 80 and 443 trafficYour proxy only allows ports 80 and 443 traffic

This article discusses some common issues you may encounter when using the on-premises data gateway.

If you encounter an issue that is not listed below, you can ask for further assistance in the following locations.

For Power BI, you can use the communities site or you can create a support ticket.
For PowerApps, you can use the communities site or you can create a support ticket.
For Microsoft Flow, you can use the communities site of you can create a support ticket.
For Logic Apps, you can submit a support ticket through the Azure portal.

A lot of issues can surface when the gateway version is out of date. It is a good general practice to make sure you
are on the latest version. If you haven't updated the gateway for a month, or longer, you may want to consider
installing the latest version of the gateway and see if you can reproduce the issue.

Here are a few common issues and resolutions that have helped a number of customers in environments that
restrict internet access.

Your proxy may require authentication from a domain user account. By default, the gateway uses a Service SID for
the windows service log on user. Changing the log on user to a domain user can help with this. For more
information, see Changing the gateway service account to a domain user.

Some proxies restrict traffic to only ports 80 and 443. By default, communication to Azure Service Bus will occur on
ports other than 443.

You can force the gateway to communicate with Azure Service Bus using HTTPS instead of direct TCP. You will need
to modify the Microsoft.PowerBI.DataMovement.Pipeline.GatewayCore.dll.config file. Change the value from 

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-gateway-onprem-tshoot.md
http://community.powerbi.com/
https://powerbi.microsoft.com/support/
https://aka.ms/powerapps-community
https://powerapps.microsoft.com/support/
https://go.microsoft.com/fwlink/?LinkID=787467
https://go.microsoft.com/fwlink/?LinkID=787479


<setting name="ServiceBusSystemConnectivityModeString" serializeAs="String">
    <value>Https</value>
</setting>

Installation
Error: Failed to add user to group. Error: Failed to add user to group. (-2147463168 (-2147463168 PBIEgwService PBIEgwService Performance Log Users Performance Log Users ))

Configuration
How to restart the gatewayHow to restart the gateway

Error: Failed to create gateway. Please try again.Error: Failed to create gateway. Please try again.

Error: Failed to update gateway details. Error: Failed to update gateway details. Please try again.Please try again.

Error: Power BI service reported local gateway as unreachable. Please restart the gateway and try again.Error: Power BI service reported local gateway as unreachable. Please restart the gateway and try again.

Script error during sign into Power BIScript error during sign into Power BI

Gateway configuration failed with a null reference exceptionGateway configuration failed with a null reference exception

AutoDetect  to Https . This file is located, by default, at C:\Program Files\On-premises data gateway.

You may receive this error if you are trying to install the gateway on a domain controller. Deploying on a domain
controller is not supported. You will need to deploy the gateway on a machine that is not a domain controller.

The gateway runs as a Windows service, so you can start and stop it in multiple ways. For example, you can open a
command prompt with elevated permissions on the machine where the gateway is running and then run either of
these commands:

To stop the service, run this command:

''' net stop PBIEgwService '''

To start the service, run this command:

''' net start PBIEgwService '''

All of the details are available, but the call to the Power BI service returned an error. The error, and an activity id, will
be displayed. This could happen for different reasons. You can collect, and review, the logs, as mentioned below, to
get more details.

This could also be due to proxy configuration issues. The user interface does now allow for proxy configuration. You
can learn more about making proxy configuration changes

Information was received from the Power BI service, to the gateway. The information was passed onto the local
windows service, but it failed to return. Or, a symmetric key generation failed. The inner exception will be displayed
under Show details. You can collect, and review, the logs, as mentioned below, to get more details.

At the end of configuration, the Power BI service will be called again to validate the gateway. The Power BI service
does not report the gateway as live. Restarting the windows service may allow the communication to be successful.
You can collect, and review, the logs, as mentioned below, to get more details.

You may receive a script error when signing into Power BI as part of the on-premises data gateway configuration.
Installing the following security update should resolve the issue. This can be installed via Windows Update.

MS16-051: Security update for Internet Explorer: May 10, 2016 (KB 3154070)

You may encounter an error similar to the following.

https://support.microsoft.com/kb/3154070


    Failed to update gateway details.  Please try again.
    Error updating gateway configuration.

    Microsoft.PowerBI.DataMovement.Pipeline.Diagnostics.CouldNotUpdateGatewayConfigurationException: Error 
updating gateway configuration. ----> System.ArgumentNullException: Value cannot be null.
    Parameter name: serviceSection

Support for TLS 1.1/1.2Support for TLS 1.1/1.2

    [HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\.NETFramework\v4.0.30319]"SchUseStrongCrypto"=dword:00000001
    
[HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Microsoft\.NETFramework\v4.0.30319]"SchUseStrongCrypto"=dword:00000001

NOTENOTE

Data sources
Error: Unable to Connect. Details: "Invalid connection credentials"Error: Unable to Connect. Details: "Invalid connection credentials"

Login failed for user 'username'.

This will include a stack trace, and that stack trace will may include the following.

If you are upgrading from an older gateway, we preserve the config file. There may be a section that is missing.
When the gateway tries to read it, we will get the above null reference exception.

To correct this, do the following.

1. Uninstall the gateway.

 c:\Program Files\on-premises data gateway

3. Reinstall the gateway.
4. Optionally apply the recovery key to restore an existing gateway.

2. Delete the following folder.

With the August 2017 update and beyond, the on-premises data gateway uses Transport Layer Security (TLS) 1.1 or
1.2 to communicate with the Power BI service by default. Previous versions of the on-premises data gateway use
TLS 1.0 by default. On November 1st 2017 support for TLS 1.0 will end, so by then you must upgrade your on-
premises data gateway installations to the August 2017 release or newer to ensure your gateways continue to
operate.

It's important to note that TLS 1.0 is still supported by the on-premises data gateway prior to November 1st, and is
used by the gateway as a fallback mechanism. To ensure all gateway traffic uses TLS 1.1 or 1.2 (and to prevent the
use of TLS 1.0 on your gateway), you must add or modify the following registry keys on the machine running the
gateway service:

Adding or modifying these registry keys applies the change to all .NET applications. For information about registry changes
that affect TLS for other applications, see Transport Layer Security (TLS) registry settings.

Within Show details, it should display the error message received from the data source. For SQL Server, you
should see something like the following.

https://docs.microsoft.com/windows-server/security/tls/tls-registry-settings


Error: Unable to Connect. Details: "Cannot connect to the database"Error: Unable to Connect. Details: "Cannot connect to the database"

Cannot open database "AdventureWorks" requested by the login. The login failed. Login failed for user 
'username'.

Error: Unable to Connect. Details: "Unknown error in data gateway"Error: Unable to Connect. Details: "Unknown error in data gateway"

Error: We encountered an error while trying to connect to Error: We encountered an error while trying to connect to . Details: "We reached the data gateway, but the. Details: "We reached the data gateway, but the
gateway can't access the on-premises data source."gateway can't access the on-premises data source."

The 'CONTOSO\account' value of the 'EffectiveUserName' XML for Analysis property is not valid.

The user name or password is incorrect.

Verify that you have the correct username and password. Also verify that those credentials can successfully connect
to the data source. Make sure the account being used matches the Authentication Method.

We were able to connect to the server, but not to the database supplied. Verify the name of the database, and that
the user credential as the proper permission to access that database.

Within Show details, it should display the error message received from the data source. For SQL Server, you
should see something like the following.

This error could occur for different reasons. Be sure to validate that you can connect to the data source from the
machine hosting the gateway. This could be the result of the server not being accessible.

Within Show details, you will see an error code of DM_GWPipeline_UnknownError.

You can also look in the Event Logs > Applications and Services Logs > on-premises data gateway Service for
more details.

We were unable to connect to the specified data source. Be sure to validate the information provided for that data
source.

Within Show details, you will see an error code of DM_GWPipeline_Gateway_DataSourceAccessError.

If the underlying error message is similar to the following, this means that the account you are using for the data
source is not a server admin for that Analysis Services instance. Learn more

If the underlying error message is similar to the following, it could mean that the service account for Analysis
Services may be missing the token-groups-global-and-universal (TGGAU) directory attribute.

Domains with Pre-Windows 2000 compatibility access will have the TGGAU attribute enabled. However, most
newly created domains will not enable this attribute by default. You can read more about this here.

You can confirm this by doing the following.

1. Connect to the Analysis Services machine within SQL Server Management Studio. Within the Advanced
connection properties, include EffectiveUserName for the user in question and see if this reproduces the error.

 dsacls "CN=John Doe,CN=UserAccounts,DC=contoso,DC=com"

2. You can use the dsacls Active Directory tool to validate whether the attribute is listed. This is tool is normally
found on a domain controller. You will need to know what the distinguished domain name is for the account
and pass that to the tool.

You want to see something similar to the following in the results.

https://docs.microsoft.com/sql/analysis-services/instances/grant-server-admin-rights-to-an-analysis-services-instance
https://msdn.microsoft.com/library/windows/desktop/ms680300.aspx
https://support.microsoft.com/kb/331951


Datasets
Error: There is not enough space for this row.Error: There is not enough space for this row.

Error: The server name provided doesn't match the server name on the SQL Server SSL Certificate.Error: The server name provided doesn't match the server name on the SQL Server SSL Certificate.

I don't see the on-premises data gateway persent when configuring scheduled refresh.I don't see the on-premises data gateway persent when configuring scheduled refresh.

Error: The received uncompressed data on the gateway client has exceeded limit.Error: The received uncompressed data on the gateway client has exceeded limit.

Reports
Report could not access the data source because you do not have access to our data source via an on-premisesReport could not access the data source because you do not have access to our data source via an on-premises
data gateway.data gateway.

     Allow BUILTIN\Windows Authorization Access Group
                                   SPECIAL ACCESS for tokenGroupsGlobalAndUniversal
                                   READ PROPERTY

To correct this issue, you will need to enable TGGAU on account used for the Analysis Services windows service.

Another possibility for user name or password incorrect

This error could also be caused if the Analysis Services server is in a different domain than the users and there is
not a two-way trust established.

You will need to work with your domain administrators to verify the trust relationship between domains.

Unable to see the data gateway data sources in the 'Get Data' experience for Analysis Services from the
Power BI service

Make sure that your account is listed in the Users tab of the data source within the gateway configuration. If you
don't have access to the gateway, check with the administrator of the gateway and ask them to verify. Only
accounts in the Users list will see the data source listed in the Analysis Services list.

This will occur if you have a single row greater than 4 MB in size. You will need to determine what the row is from
your data source and attempt to filter it out or reduce the size for that row.

This can occur when the certificate CN is for the servers fully qualified domain name (FQDN) but you only supplied
the netbios name for the server. This will cause a mismatch for the certificate. To resolve this issue, you will need to
make the server name within the gateway data source, and the PBIX file, to use the FQDN of the server.

This could be because of a few different scenarios.

1. The server and database name don't match between what was entered in Power BI Desktop and the data source
configured for the gateway. These need to be the same values. They are not case sensitive.

2. Your account is not listed in the Users tab of the data source within the gateway configuration. You will need to
get with the administrator of the gateway to be added to that list.

3. Your Power BI Desktop file has multiple data sources within it and not all of those data sources are configured
with the gateway. You will need to have each data source defined with the gateway for the gateway to show up
within Scheduled Refresh.

The exact limitation is 10 GB of uncompressed data per table. If you are hitting this issue, there are good options to
optimize and avoid the issue. In particular, reducing the use of highly repetitive, long string values and instead using
a normalized key or removing the column (if not in use) will help.

This is usually caused by one of the following.

1. The data source information does not match what is in the underlying dataset. The server and database name
need to match between the data source defined for the on-premises data gateway and what you supply within



Error: Data source access error. Please contact the gateway administrator.Error: Data source access error. Please contact the gateway administrator.

Firewall or Proxy

Test-NetConnection -ComputerName watchdog.servicebus.windows.net -Port 9350

NOTENOTE

Power BI Desktop. If you use an IP Address in Power BI Desktop, the data source, for the on-premises data
gateway, needs to use an IP Address as well.

2. There is not a data source available on any gateway within your organization. You can configure the data source
on a new, or existing, on-premises data gateway.

If this report is making use of a live Analysis Services connection, you could be encountering an issue with a value
being passed to EffectiveUserName that is either not valid, or doesn't have permissions on the Analysis Services
machine. Typically, an authentication issue is due to the fact that the value being passed for EffectiveUserName
doesn't match a local user principal name (UPN).

To confirm this, you can do the following.

1. Find the effective username within the gateway logs.

 whoami /upn

2. Once you have the value being passed, validate that it is correct. If it is your user, you can use the following
command from a command prompt to see what the UPN should be. The UPN will look like an email address.

Optionally, you can see what Power BI gets from Azure Active Directory.

1. Browse to https://graphexplorer.cloudapp.net.
2. Select Sign in in the upper right.

 https://graph.windows.net/me?api-version=1.5

4. Look for userPrincipalName.

3. Run the following query. You will see a rather large JSON response.

If your Azure Active Directory UPN doesn't match your local Active Directory UPN, you can use the Map user names
feature to replace it with a valid value. Or you can work with either your tenant admin, or local Active Directory
admin, to get your UPN changed.

For information on providing proxy information for your gateway, see Configuring proxy settings for the Power BI
gateways.

You can test to see if your firewall, or proxy, may be blocking conections by running Test-NetConnection from a
PowerShell prompt. This will test connectivity to the Azure Service Bus. This only tests network connectivity and
doesn't have anything to do with the cloud server service or the gateway. It helps to determine if your machine can
actually get out to the internet.

Test-NetConnection is only available on Windows Server 2012 R2 and later. It is also available on Windows 8.1 and later. On
earlier OS versions, you can use Telnet to test port connectivity.

The results should look similar to the following. The difference will be with TcpTestSucceeded. If
TcpTestSucceeded is not true, then you may be blocked by a firewall.

https://graphexplorer.cloudapp.net
https://technet.microsoft.com/library/dn372891.aspx


ComputerName           : watchdog.servicebus.windows.net
RemoteAddress          : 70.37.104.240
RemotePort             : 5672
InterfaceAlias         : vEthernet (Broadcom NetXtreme Gigabit Ethernet - Virtual Switch)
SourceAddress          : 10.120.60.105
PingSucceeded          : False
PingReplyDetails (RTT) : 0 ms
TcpTestSucceeded       : True

Performance

Performance CountersPerformance Counters

If you want to be exhaustive, substitute the ComputerName and Port values with those listed for ports

The firewall may also be blocking the connections that the Azure Service Bus makes to the Azure data centers. If that
is the case, you will want to whitelist (unblock) the IP addresses for your region for those data centers. You can get a
list of Azure IP addresses here.

You can find the data center region you are in by doing the following:

1. Select the ? in the upper right of the Power BI service.
2. Select About Power BI.
3. Your data region will be listed in Your data is stored in.

If you are still not getting anywhere, you could try getting a network trace using a tool like fiddler or netsh, although
these are advanced collection methods and you may need assistance in analyzing the collected data. You can
contact support for assistance.

There are a number of performance counters that can be used to gauge the activities for the gateway. These can be
helpful to understanding if we have a large load of activity and may need to make a new gateway. These counters
will not reflect how long something takes.

These counters can be access through the Windows Performance Monitor tool.

https://www.microsoft.com/download/details.aspx?id=41653
https://support.microsoft.com


COUNTER TYPE DESCRIPTION

ADO.NET This is used for any DirectQuery connection.

ADOMD This is used for Analysis Services 2014 and earlier.

OLEDB This is used by certain data sources. This includes SAP HANA
and Analysis Service 2016 or later.

Mashup This includes any imported data source. If you are scheduling
refresh or doing an on-demand refresh, it will go through the
mashup engine.

COUNTER DESCRIPTION

# of ADO.NET open connection executed / sec Number of ADO.NET open connection actions executed per
second (succeeded or failed).

# of ADO.NET open connection failed / sec Number of ADO.NET open connections actions failed per
second.

# of ADO.NET queries executed / sec Number of ADO.NET queries executed per second (succeeded
or failed).

# of ADO.NET queries failed / sec Number of ADO.NET failed queries executed per second.

# of ADOMD open connection executed / sec Number of ADOMD open connection actions executed per
second (succeeded or failed).

# of ADOMD open connection failed / sec Number of ADOMD open connection actions failed per
second.

# of ADOMD queries executed / sec Number of ADOMD queries executed per second (succeeded
or failed).

# of ADOMD queries failed / sec Number of ADOMD failed queries executed per second.

There are general groupings of these counters.

Here is a listing of the available performance counters.



# of all open connection executed / sec Number of open connection actions executed per second
(succeeded or failed).

# of all open connection failed / sec Number of failed open connection actions executed per
second.

# of all queries executed / sec Number of queries executed per second (succeeded or failed).

# of items in the ADO.NET connection pool Number of items in the ADO.NET connection pool.

# of items in the OLEDB connection pool Number of items in the OLEDB connection pool.

# of items in the Service Bus pool Number of items in the Service Bus pool.

# of Mashup open connection executed / sec Number of Mashup open connection actions executed per
second (succeeded or failed).

# of Mashup open connection failed / sec Number of Mashup open connection actions failed per second.

# of Mashup queries executed / sec Number of Mashup queries executed per second (succeeded
or failed).

# of Mashup queries failed / sec Number of Mashup failed queries executed per second

# of multiple result set OLEDB queries failed / sec Number of multiple resultset OLEDB failed queries executed
per second.

# of OLEDB multiple resultset queries executed / sec Number of OLEDB multiple resultset queries executed per
second (succeeded or failed).

# of OLEDB open connection executed / sec Number of OLEDB open connection actions executed per
second (succeeded or failed).

# of OLEDB open connection failed / sec Number of OLEDB open connection actions failed per second.

# of OLEDB queries executed / sec Number of OLEDB multiple resultset queries executed per
second (succeeded or failed).

# of OLEDB queries failed / sec Number of OLEDB mutiple resultset failed queries executed
per second.

# of OLEDB single resultset queries executed / sec Number of OLEDB single resultset queries executed per
second (succeeded or failed).

# of queries failed / sec Number of failed queries executed per second.

# of single result set OLEDB queries failed / sec Number of single resultset OLEDB failed queries executed per
second.

COUNTER DESCRIPTION

Reviewing slow performing queries
You may find that response through the gateway is slow. This could be for DirectQuery queries or when refreshing



Microsoft.PowerBI.DataMovement.Pipeline.GatewayCore.dll.configMicrosoft.PowerBI.DataMovement.Pipeline.GatewayCore.dll.config

IMPORTANTIMPORTANT

<setting name="EmitQueryTraces" serializeAs="String">
    <value>True</value>
</setting>

DM.EnterpriseGateway Information: 0 : 2016-09-15T16:09:27.2664967Z DM.EnterpriseGateway    4af2c279-1f91-4c33-
ae5e-b3c863946c41    d1c77e9e-3858-4b21-3e62-1b6eaf28b176    MGEQ    c32f15e3-699c-4360-9e61-2cc03e8c8f4c    
FF59BC20 [DM.GatewayCore] Executing query (timeout=224) "<pi>
SELECT
TOP (1000001) [t0].[ProductCategoryName],[t0].[FiscalYear],SUM([t0].[Amount])
 AS [a0]
FROM
(
(select [$Table].[ProductCategoryName] as [ProductCategoryName],
    [$Table].[ProductSubcategory] as [ProductSubcategory],
    [$Table].[Product] as [Product],
    [$Table].[CustomerKey] as [CustomerKey],
    [$Table].[Region] as [Region],
    [$Table].[Age] as [Age],
    [$Table].[IncomeGroup] as [IncomeGroup],
    [$Table].[CalendarYear] as [CalendarYear],
    [$Table].[FiscalYear] as [FiscalYear],
    [$Table].[Month] as [Month],
    [$Table].[OrderNumber] as [OrderNumber],
    [$Table].[LineNumber] as [LineNumber],
    [$Table].[Quantity] as [Quantity],
    [$Table].[Amount] as [Amount]
from [dbo].[V_CustomerOrders] as [$Table])
)
 AS [t0]
GROUP BY [t0].[ProductCategoryName],[t0].[FiscalYear] </pi>"

Microsoft.PowerBI.DataMovement.Pipeline.GatewayCore.dll.configMicrosoft.PowerBI.DataMovement.Pipeline.GatewayCore.dll.config

your imported dataset. You can enable additional logging to output queries and their timings to help understand
what is performing slow. When you find a long running query, it may require additional modification on your data
source to tune query performance. For example, adjusting indexes for a SQL Server query.

You will need to modify two configuration files to determine the duration of a query.

Within the Microsoft.PowerBI.DataMovement.Pipeline.GatewayCore.dll.config file, change the EmitQueryTraces

value from False  to True . This file is located, by default, at C:\Program Files\On-premises data gateway. Enabling 
EmitQueryTraces  will begin to log queries that are sent from the gateway to a data source.

Enabling EmitQueryTraces could increase the log size significantly depending on gateway usage. Once you are done reviewing
the logs, you will want to set EmitQueryTraces to False. It is not recommended to leave this setting enabled long term.

Example query entry

Within the Microsoft.PowerBI.DataMovement.Pipeline.Diagnostics.dll.config file, change the TraceVerbosity  value
from 4  to 5 . This file is located, by default, at C:\Program Files\On-premises data gateway. Changing this setting
will begin to log verbose entries to the gateway log. This includes entries that show duration.



IMPORTANTIMPORTANT

<setting name="TracingVerbosity" serializeAs="String">
    <value>5</value>
</setting>

Activity TypesActivity Types

ACTIVTY TYPE DESCRIPTION

MGEQ Queries executed over ADO.NET. This includes DirectQuery
data sources.

MGEO Queries executed over OLEDB. This includes SAP HANA and
Analysis Services 2016.

MGEM Queries executed from the Mashup engine. This is used with
imported datasets that use scheduled refresh or refresh on-
demand.

Determine the duration of a queryDetermine the duration of a query

Tools for troubleshooting
Collecting logs from the gateway configuratorCollecting logs from the gateway configurator

Enabling TraceVerbosity to 5  could increase the log size significantly depending on gateway usage. Once you are done
reviewing the logs, you will want to set TraceVerbosity to 4 . It is not recommended to leave this setting enabled long term.

 

To determine the time it took to query the data source, you can do the following.

1. Open the gateway log.
2. Search for an Activity Type to find the query. An example of this would be MGEQ.
3. Make note of the second GUID as this is the request id.

 DM.EnterpriseGateway Verbose: 0 : 2016-09-26T23:08:56.7940067Z DM.EnterpriseGateway    baf40f21-2eb4-
4af1-9c59-0950ef11ec4a    5f99f566-106d-c8ac-c864-c0808c41a606    MGEQ    21f96cc4-7496-bfdd-748c-
b4915cb4b70c    B8DFCF12 [DM.Pipeline.Common.TracingTelemetryService] Event: 
FireActivityCompletedSuccessfullyEvent (duration=5004)

NOTENOTE

4. Continue to search for MGEQ until you find the FireActivityCompletedSuccessfullyEvent entry with the
duration. You can verify the entry has the same request id. Duration will be in milliseconds.

FireActivityCompletedSuccessfullyEvent is a verbose entry. This entry will not be logged unless TraceVerbosity is at
level 5.

 

There are several logs you can collect for the gateway, and you should always start with the logs. The simplest way
to collect logs after installing the gateway is through the user interface. In the On-premises data gateway user
interface, select Diagnostics and then select the Export logs link near the bottom of the page, as shown in the
following image.



%localappdata%\Temp\On-premises_data_gateway_*.log

%localappdata%\Microsoft\On-premises Data Gateway\GatewayConfigurator*.log

C:\Users\PBIEgwService\AppData\Local\Microsoft\On-premises Data Gateway\Gateway*.log

Event LogsEvent Logs

Installer logs

Configuration logs

On-premises data gateway service logs

The On-premises data gateway service event logs are present under Application and Services Logs.



Fiddler TraceFiddler Trace

Refresh HistoryRefresh History

 

Fiddler is a free tool from Telerik that monitors HTTP traffic. You can see the back and forth with the Power BI
service from the client machine. This may show errors and other related information.

When using the gateway for scheduled refresh, Refresh History can help you see what errors have occurred, as
well as provide useful data if you should need to create a support request. You can view both scheduled, as well as
on demand, refreshes. Here is how you can get to the Refresh History.

1. In the Power BI navigation pane, in Datasets, select a dataset > Open Menu > Schedule Refresh.

2. In Settings for... > Schedule Refresh, select Refresh History.

http://www.telerik.com/fiddler


Next steps

For additional information about troubleshooting refresh scenarios, take a look at the Troubleshooting Refresh
Scenarios article.

Configuring proxy settings for the Power BI gateways
On-premises data gateway
On-premises data gateway - in-depth
Manage your data source - Analysis Services
Manage your data source - SAP HANA
Manage your data source - SQL Server
Manage your data source - Import/Scheduled refresh
More questions? Try the Power BI Community

http://community.powerbi.com/


Power BI Gateway - Personal
12/6/2017 • 11 min to read • Edit Online
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Do I need a gateway?

On-premises data sourcesOn-premises data sources

There is a new version of the personal gateway for Power BI called the on-premises data gateway (personal mode). The
following article describes the previous version of the personal gateway, called Power BI Gateway - Personal, which will
be retired and stop working after July 31, 2017. For information about the new version of the personal gateway, including
how to install the new version, see the On-premises data gateway (personal mode) article.

The Power BI Gateway - Personal acts as a bridge, providing quick and secure data transfer between the Power
BI service and on-premises data sources that support refresh. This article is meant to provide you with an in-
depth understanding of how the gateway works and whether or not a gateway is necessary for you. We've also
put together this helpful video about the personal gateway.

It installs and runs as a service on your computer. As a service, it runs using a Windows account you specify
during configuration. In some cases, the Gateway runs as an application. We'll go into more about that later.

When Power BI refreshes data from an on-premises data source, the gateway assures your Power BI account has
the right permissions to connect to and query data from the source.

Data transfer between Power BI and the gateway is secured through Azure Service Bus. The Service Bus creates a
secure channel between the Power BI service and your computer. Because the gateway provides this secure
connection, there’s usually no need to open a port in your firewall.

Before we go into details about the gateway, let’s look at some terms used in Power BI:

A dataset is data uploaded into the Power BI service from an online or on-premises data source. You create a
dataset when you use Get Data to connect to and upload data. Datasets appear in the My Workspace pane of your
Power BI Workspace in your browser. When you create reports and pin tiles to your dashboards, you’re looking at
data from your datasets.

A data source is where the data you upload into a dataset really comes from. It can be just about anything; a
database, Excel worksheet, Web service, etc. With Excel workbooks, you can create a simple worksheet with rows
of data, and that is considered a data source. You can also use Power Query or Power Pivot in Excel to connect to
and query data from both online and on-premises data sources, all in the same workbook. With Power BI
Desktop, you use Get Data to connect to and query data from both online and on-premises data sources.

The personal gateway is installed through the on-premises data gateway. You can download it on the Power BI
Gateway page.

Before you install a gateway, it's important to know whether or not you really need one. It really depends on your
data sources:

A personal gateway is required in order to refresh datasets that get data from a supported on-premises data
source in your organization.

With a gateway, REFRESH NOW and SCHEDULE REFRESH are supported for datasets uploaded from:

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/personal-gateway.md
https://www.youtube.com/watch?v=de58vROLqZI
http://azure.microsoft.com/documentation/services/service-bus/
https://powerbi.microsoft.com/gateway/


Online data sourcesOnline data sources
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Setting up a gateway for the first time

Download and install a gatewayDownload and install a gateway

NOTENOTE

Microsoft Excel 2013 (or later) workbooks where Power Query or Power Pivot is used to connect to and query
data from a supported on-premises data source. All on-premises data sources shown in Get External Data in
Power Query or Power Pivot support refresh except for Hadoop file (HDFS) and Microsoft Exchange.
Microsoft Power BI Desktop files where Get Data is used to connect to and query data from a supported on-
premises data source. All on-premises data sources shown in Get Data support refresh except for Hadoop file
(HDFS) and Microsoft Exchange.

A gateway is only required if you are using the Web.Page function. In other cases, a gateway is not required in
order to refresh datasets that get data only from an online data source.

If you are using the Web.Page function, you only need a gateway if you have republished the dataset or your report after
November 18th, 2016.

REFRESH NOW and SCHEDULE REFRESH are supported without a gateway for datasets uploaded from:

Content packs from online data sources (content packs\services). By default, datasets from content packs are
automatically updated once a day, but you can also refresh manually or setup a refresh schedule.
Microsoft Excel 2013 (or later) workbooks where Power Query or Power Pivot is used to connect to and query
data from an online data source.
Microsoft Power BI Desktop files where Get Data is used to connect to and query data from an online data
source.

Question: What if my Excel workbook or Power BI Desktop file gets data from both online and on-premises data
sources?

Answer: A gateway is required. You will need to install and configure a gateway in order to refresh data from
your on-premises data sources.

Question: What if my Excel workbook just has rows of data I typed in?**

Answer: A gateway is not required. You only need to install and configure a gateway if your workbook uses
Power Query or Power Pivot to query and load data to the data model from a supported on-premises data source

Setting up a gateway for the first time is a three step process:

1. Download and install a gateway
2. Configure the gateway
3. Sign in to data sources in Power BI

Let’s take a closer look at each step.

There is a new version of the personal gateway for Power BI, called the on-premises data gateway (personal mode).
This article describes the previous version of the personal gateway, called Power BI Gateway - Personal, which will be
retired and stop working after July 31, 2017. For information about the new version of the personal gateway, including how
to install the new version, see the On-premises data gateway (personal mode) article.

https://msdn.microsoft.com/library/mt260924.aspx
https://msdn.microsoft.com/library/mt260924.aspx
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Computer typeComputer type
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NOTENOTE

Windows accountWindows account

You’ll be prompted to install a gateway when you click on REFRESH NOW or SCHEDULE REFRESH for a
supported dataset for the first time. Or, to download the gateway, select Data Gateway under the Downloads
menu. Download the on-premises data gateway.

You will want to select Personal Gateway instead of On-premises data gateway to have a gateway that is for
yourself.

There’s really not much to installing a gateway. You’ll select a location to install to, and read and accept the license
agreement just like any other application. There are however some important things to know. In particular, the
type of computer you install the gateway on and the type of account you’re logged in to Windows with on that
computer.

The gateway needs to have access to the data source. If your personal machine cannot connect to the data source, you
may want to consider installing an on-premises data gateway on a machine that does have access to the data source. An
example of this would be SQL Server installed on an virtual machine (VM) hosted in Azure. You personal machine may not
have access to the VM. You could install the on-premises data gateway on the VM instead, and configure the a data source
within the Power BI service.

The type of computer you install the gateway on is important.

The personal gateway is supported only on 64-bit Windows operating systems.

On a laptop computer - In order for a scheduled refresh to occur, the gateway needs to be up and running. Laptop
computers are usually shut down or asleep more than they’re running. If you install your gateway on a laptop, be
sure to set your scheduled refresh times for when the laptop will be running. If it isn’t, the refresh will not be
attempted again until the next scheduled refresh time.

On a desktop computer – Not many issues here. Just make sure the computer and the gateway is running at your
scheduled refresh times. Many desktop computers go to sleep, scheduled refresh cannot occur if it’s asleep.

Once you install a gateway, you won’t have to install another. One gateway will work for any number of
supported datasets. You also don’t have to install the gateway on the same computer you upload your workbook
and Power BI Desktop files from. Here’s an example: Let’s say you have an Excel workbook that connects to a SQL
Server data source in your organization. You used Get Data in Power BI to upload the workbook from your laptop
computer. You also have a desktop computer you leave running all the time, and you’ve installed and configured
a gateway on that computer. In Power BI, you’ve signed in to your data sources, and you’ve setup a refresh
schedule for the dataset. When a scheduled refresh time comes, Power BI makes a secure connection to the
gateway installed on your desktop computer. It then securely connects to the data sources to get updates. For
refresh, there’s no communication with the original workbook you uploaded from your laptop computer.

You can install the personal and enterprise gateways on the same computer.

When you install the gateway, you’ll be logged in to your computer using your Windows account. The type of
permissions your Windows account has will have an effect on how the gateway is installed and how it is run in
Windows.

http://go.microsoft.com/fwlink/?LinkID=820925


WITH ADMINISTRATOR PERMISSIONS WITHOUT ADMINISTRATOR PERMISSIONS

Power BI Gateway - Personal runs
as a

Service Application

Scheduled Refresh As long as your computer and the
gateway service is running, you do not
have to be logged in at the scheduled
refresh time.

You must be logged in to your
computer at the scheduled refresh
time.

Change Windows account password You must change your Password in the
gateway service. If the account
password used by the gateway is no
longer valid, refresh will fail.

The gateway will always run using the
account and password you are
currently logged in with. If you aren’t
logged in to Windows, the gateway will
not be running and refresh will fail.

Configure the gatewayConfigure the gateway

Sign in to data sourcesSign in to data sources

When you’re logged into Windows:

When the Installation Wizard finishes, you’ll be prompted to launch the Configuration Wizard. There’s really not
much to configuring a gateway. You’ll need to sign in to Power BI from the Wizard. This is necessary for the
Wizard to establish a connection with your Power BI account in the Power BI service.

If you’re logged in to Windows with an account with Administrator permissions, you’ll be asked to enter your
Windows account credentials. You can specify a different Windows account, but remember the permissions
determine how the gateway is run. The gateway service will run using this account.

Once the Configuration Wizard finishes and your gateway is up and running, you’ll have to specify an
Authentication type and sign in to each of your dataset’s data sources. You'll complete this step in Power BI.

You only need to specify an authentication type and sign in to a data source once. You sign in from the Manage
Data Sources section in a dataset’s Settings screen. If you have multiple data sources, you’ll have to sign in to
each one. The gateway determines a default Authentication type depending on the data source. In most cases, it’s
Windows authentication; however, in some cases, your data source might require a different authentication type.
If you’re unsure, check with your data source administrator.



Up and running!

Updating your Windows account password

When your gateway is up and running, you can click SCHEDULE REFRESH for a dataset where you’ll see your
dataset’s Settings page.

This page shows:

1. Refresh status – Shows refresh success and next scheduled refresh time.
2. Gateway - Shows whether or not a gateway is installed and online. If a gateway is installed but not online,

Manage Data Sources and Schedule Refresh settings are disabled.
3. Manage Data Sources - Shows data sources the dataset connects to. You can Sign in or change the

authentication type. You’ll only need to Sign in to each data source once.
4. Schedule Refresh – You can configure a refresh schedule settings here. If the gateway isn’t online, these

settings will be disabled.
5. Refresh failure notifications – This option, selected by default, will send an e-mail to you if a scheduled refresh

fails.

If you were logged into your computer with a Windows account with administrator privileges when you installed
your gateway, it runs as a service using the Windows account you specified in the Configuration Wizard. Most
often, this will be the same Windows account you log in to your computer with. When you change your Windows
account password, you’ll also need to change it in the gateway, otherwise the service might not be running and
refresh will fail. To change your Windows account password for the gateway, select the personal gateway icon on



Ports

DOMAIN NAMES OUTBOUND PORTS DESCRIPTION

*.powerbi.com 443 HTTPS

*.analysis.windows.net 443 HTTPS

*.login.windows.net 443 HTTPS

*.servicebus.windows.net 5671-5672 Advanced Message Queuing Protocol
(AMQP)

*.servicebus.windows.net 443, 9350-9354 Listeners on Service Bus Relay over TCP
(requires 443 for Access Control token
acquisition)

*.frontend.clouddatahub.net 443 HTTPS

*.core.windows.net 443 HTTPS

login.microsoftonline.com 443 HTTPS

your Windows Desktop Taskbar, or in Apps.

From here, you can update your password and check your gateway's connection status.

The gateway communicates on outbound ports: TCP 443 (default), 5671, 5672, 9350 thru 9354. The gateway
does not require inbound ports.



login.windows.net 443 HTTPS

DOMAIN NAMES OUTBOUND PORTS DESCRIPTION

Next steps

If you need to white list IP addresses instead of the domains, you can download and use the Microsoft Azure
Datacenter IP ranges list. Download

On-premises data gateway (personal mode) - the new version of the personal gateway Configuring proxy
settings for the Power BI Gateways
Power BI Premium

More questions? Try asking the Power BI Community

https://www.microsoft.com/download/details.aspx?id=41653
http://community.powerbi.com/


Use Kerberos for SSO (single sign-on) from Power BI
to on-premises data sources
1/10/2018 • 10 min to read • Edit Online

Running a query with SSO - steps that occur

NOTENOTE

You can get seamless single sign-on connectivity, enabling Power BI reports and dashboards to update from on-
premises data, by configuring your on-premises data gateway with Kerberos. The on-premises data gateway
facilitates single sign-on (SSO) using DirectQuery, which it uses to connect to on-premises data sources.

The following data sources are currently supported, SQL Server, SAP HANA, and Teradata, all based on Kerberos
Constrained Delegation.

SQL Server
SAP HANA
Teradata

When a user interacts with a DirectQuery report in the Power BI Service, each cross-filter, slice, sorting, and report
editing operation can result in queries executing live against the underlying on-premises data source. When single
sign-on is configured for the data source, queries execute under the identity of the user interacting with Power BI
(that is, through the web experience or Power BI mobile apps). Thereby, each user sees precisely the data for which
they have permissions in the underlying data source – with single sign-on configured, there is no shared data
caching across different users.

A query that runs with SSO consists of three steps, as shown in the following diagram.

SSO for Oracle is not enabled yet, but is under development and coming soon.

Here are additional details about those steps:

1. For each query, the Power BI service includes the user principal name (UPN) when sending a query request to

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-gateway-kerberos-for-sso-pbi-to-on-premises-data.md
https://technet.microsoft.com/library/jj553400.aspx
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Errors from an insufficient Kerberos configuration

the configured gateway.

NOTENOTE

2. The gateway needs to map the Azure Active Directory UPN to a local Active Directory identity.

a. If AAD DirSync (also known as AAD Connect) is configured, then the mapping works automatically in the
gateway.

b. Otherwise, the gateway can look up and map the Azure AD UPN to a local user by performing a lookup
against the local Active Directory domain.

3. The gateway service process impersonates the mapped local user, opens the connection to the underlying
database and sends the query. The gateway does not need to be installed on the same machine as the
database.

The user impersonation and connection to the database is only successful if the gateway service account
is a domain account (or service SID), and if Kerberos constrained delegation was configured for the
database to accept Kerberos tickets from the gateway service account.

Regarding the service sid, if AAD DirSync / Connect is configured and user accounts are synchronized, the gateway
service does not need perform local AD lookups at runtime, and you can use the local Service SID (instead of
requiring a domain account) for the gateway service. The Kerberos constrained delegation configuration steps
outlined in this document are the same (just applied based on the service SID, instead of domain account).

To enable SSO for SAP HANA, you need to ensure the following HANA-specific configurations are met for SAP:

1. Ensure the SAP HANA server is running version 2.00.022* or higher / later.
2. On the gateway machine, install SAP’s latest HANA ODBC driver. The minimum version is HANA ODBC version

2.00.020.00 from August 2017.

The following links to patches and upgrades from SAP may be useful. Note that you must log in to the following resources
using your SAP Support account, and that SAP may change or update these links.

HANA 2 SPS 01 Rev 012.03
HANA 2 SPS 02 Rev 22
HANA 1 SP 12 Rev 122.13

If the underlying database server and gateway are not configured properly for Kerberos Constrained
Delegation, you may receive the following error message:

And the technical details associated with the error message may look like the following:

https://launchpad.support.sap.com/#/notes/2557386
https://launchpad.support.sap.com/#/notes/2547324
https://launchpad.support.sap.com/#/notes/2528439


Preparing for Kerberos Constrained Delegation

Prerequisite 1: Install & configure the on-premises data gatewayPrerequisite 1: Install & configure the on-premises data gateway

Prerequisite 2: Run the gateway Windows service as a domain accountPrerequisite 2: Run the gateway Windows service as a domain account
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Prerequisite 3: Have domain admin rights to configure SPNs (SetSPN) and Kerberos Constrained DelegationPrerequisite 3: Have domain admin rights to configure SPNs (SetSPN) and Kerberos Constrained Delegation
settingssettings

Configuring Kerberos Constrained Delegation for the gateway and

The result is that the because of insufficient Kerberos configuration, the gateway could not impersonate the
originating user properly, and the database connection attempt failed.

Several items must be configured in order for Kerberos Constrained Delegation to work properly, including Service
Principal Names (SPN) and delegation settings on service accounts.

This release of the on-premises data gateway supports an in-place upgrade, as well as settings take-over of
existing gateways.

In a standard installation, the gateway runs as a machine-local service account (specifically, NT
Service\PBIEgwService) such as what's shown in the following image:

To enable Kerberos Constrained Delegation, the gateway must run as a domain account, unless your AAD is
already synchronized with your local Active Directory (using AAD DirSync/Connect). For this account change to
work correctly, you have two options:

If you started with a previous version of the on-premises data gateway, follow precisely all five steps in
sequence (including running the gateway configurator in step 3) described in the following article:

Changing the gateway service account to a domain user
If you already installed the Preview version of the on-premises data gateway, there is a new UI-guided
approach to switch service accounts directly from within the gateway’s configurator. See the Switching
the gateway to a domain account section near the end of this article.

If AAD DirSync / Connect is configured and user accounts are synchronized, the gateway service does not need to perform
local AD lookups at runtime, and you can use the local Service SID (instead of requiring a domain account) for the gateway
service. The Kerberos Constrained Delegation configuration steps outlined in this article are the same as that configuration
(they are simply applied based on the service SID, instead of domain account).

While it is technically possible for a domain administrator to temporarily or permanently allow rights to someone
else to configure SPNs and Kerberos delegation, without requiring domain admin rights, that's not the
recommended approach. In the following section, the configuration steps necessary for Pre-requisite 3 in detail.

https://powerbi.microsoft.com/documentation/powerbi-gateway-proxy/#changing-the-gateway-service-account-to-a-domain-user


data source

Configure an SPN for the gateway service accountConfigure an SPN for the gateway service account

Configure delegation settings on the gateway service accountConfigure delegation settings on the gateway service account

To properly configure the system, we need to configure or validate the following two items:

1. If needed, configure an SPN for the gateway service domain account (if none are created yet).
2. Configure delegation settings on the gateway service domain account.

Note that you must be a domain administrator to perform those two configuration steps.

The following sections describe these steps in turn.

First, determine whether an SPN was already created for the domain account used as the gateway service account,
but following these steps:

1. As a domain administrator, launch Active Directory Users and Computers
2. Right-click on the domain, select Find, and type in the account name of the gateway service account
3. In the search result, right-click on the gateway service account and select Properties.

If the Delegation tab is visible on the Properties dialog, then an SPN was already created and you can
jump ahead to the next subsection about configuring Delegation settings.

If there is no Delegation tab on the Properties dialog, you can manually create an SPN on that account which
adds the Delegation tab (that is the easiest way to configure delegation settings). Creating an SPN can be done
using the setspn tool that comes with Windows (you need domain admin rights to create the SPN).

For example, imagine the gateway service account is “PBIEgwTest\GatewaySvc”, and the machine name with the
gateway service running is called Machine1. To set the SPN for the gateway service account for that machine in
this example, you would run the following command:

With that step completed, we can move on to configuring delegation settings.

The second configuration requirement is the delegation settings on the gateway service account. There are
multiple tools you can use to perform these steps. In this article, we'll use Active Directory Users and
Computers, which is a Microsoft Management Console (MMC) snap-in that you can use to administer and publish
information in the directory, and available on domain controllers by default. You can also enable it through
Windows Feature configuration on other machines.

We need to configure Kerberos Constrained Delegation with protocol transiting. With constrained delegation,
you must be explicit with which services you want to delegate to – for example, only your SQL Server or your SAP
HANA server will accept delegation calls from the gateway service account.

This section assumes you have already configured SPNs for your underlying data sources (such as SQL Server,
SAP HANA, Teradata, so on). To learn how to configure those data source server SPNs, please refer to technical
documentation for the respective database server. You can also look at the blog post that describes What SPN does
your app require?

In the following steps we assume an on-premises environment with two machines: a gateway machine and a
database server (SQL Server database), and for the sake of this example we'll also assume the following settings
and names:

Gateway machine name: PBIEgwTestGW
Gateway service account: PBIEgwTest\GatewaySvc (account display name: Gateway Connector)

https://technet.microsoft.com/library/cc731241.aspx
https://blogs.msdn.microsoft.com/psssql/2010/06/23/my-kerberos-checklist/


SQL Server data source machine name: PBIEgwTestSQL
SQL Server data source service account: PBIEgwTest\SQLService

Given those example names and settings, the configuration steps are the following:

1. With domain administrator rights, launch Active Directory Users and Computers.
2. Right-click on the gateway service account (PBIEgwTest\GatewaySvc) and select Properties.
3. Select the Delegation tab.
4. Select Trust this computer for delegation to specified services only.
5. Select Use any authentication protocol.
6. Under the Services to which this account can present delegated credentials: select Add.
7. In the new dialog, select Users or Computers.
8. Enter the service account for the SQL Server Database service (PBIEgwTest\SQLService) and select OK.
9. Select the SPN that you created for the database server. In our example, the SPN will begin with MSSQLSvc. If

you added both the FQDN and the NetBIOS SPN for your database service, select both. You may only see one.
10. Select OK. You should see the SPN in the list now.
11. Optionally, you can select Expanded to show both the FQDN and NetBIOS SPN in

14. On the gateway machine, run: gpedit.msc

12. The dialog will look similar to the following if you checked Expanded.

13. Select OK.

Finally, on the machine running the gateway service (PBIEgwTestGW in our example), the gateway service
account must be granted the local policy “Impersonate a client after authentication”. You can perform/verify
this with the Local Group Policy Editor (gpedit).

15. Navigate to Local Computer Policy > Computer Configuration > Windows Settings > Security
Settings > Local Policies > User Rights Assignment, as shown in the following image.



Running a Power BI report

17. From the list of policies under User Rights Assignment, select Act as part of the operating system
(SeTcbPrivilege). Ensure that the gateway service account is included in the list of accounts as well.

18. Restart the on-premises data gateway service process.

16. From the list of policies under User Rights Assignment, select Impersonate a client after
authentication.

Right-click and open the Properties for Impersonate a client after authentication and check the list of
accounts. It must include the gateway service account (PBIEgwTest\GatewaySvc).

After all the configuration steps outlined earlier in this article have been completed, you can use the Manage
Gateway page in Power BI to configure the data source, and under its Advanced Settings, enable SSO, then
publish reports and datasets binding to that data source.



Switching the gateway to a domain account

This configuration will work in most cases. However, with Kerberos there can be different configurations
depending on your environment. If the report still won't load, you'll need to contact your domain administrator to
investigate further.

Earlier in this article, we discussed switching the gateway from a local service account to run as a domain account,
using the on-premises data gateway user interface. Here are the steps necessary to do so.

2. Select the Sign-in button on the main page, and sign in with your Power BI account.
3. After sign-in is completed, select the Service Settings tab.

1. Launch the on-premises data gateway configuration tool.

4. Click Change account to start the guided walk-through, as shown in the following figure.



Next steps
For more information about the on-premises data gateway and DirectQuery, check out the following resources:

On-premises data gateway
DirectQuery in Power BI
Data sources supported by DirectQuery
DirectQuery and SAP BW
DirectQuery and SAP HANA



Configuring proxy settings for the on-premises data
gateway
11/22/2017 • 2 min to read • Edit Online

Does your network use a proxy?

Configuration file location and default configuration

On-premises data gatewayOn-premises data gateway

C:\Program Files\On-premises data gateway\enterprisegatewayconfigurator.exe.config

C:\Program Files\On-premises data gateway\Microsoft.PowerBI.EnterpriseGateway.exe.config

Configuring proxy settings

<system.net>
    <defaultProxy useDefaultCredentials="true" />
</system.net>

Your work environment may require that you go through a proxy to access the internet. This could prevent the
on-premises data gateway from connecting to the service.

The following post on superuser.com discusses how you can try to determine if you have a proxy on your
network.

How do I know what proxy server I'm using? (SuperUser.com)

Proxy information is configured within a .NET configuration file. The location, and file names, will be different
depending on the gateway you are using.

There are two main configuration files that are involved with the on-premises data gateway.

Configuration

The first is for the configuration screens that actually configure the gateway. If you are having issues configuring
the gateway, this is the file you will want to look at.

Windows Service

The second is for the actual windows service that interacts with the Power BI service, and handles the requests.

The default proxy configuration is the following.

The default configuration works with Windows authentication. If your proxy uses another form of authentication,
you will need to change the settings. If you are not sure, you should contact your network administrator.

To learn more about the configuration of the proxy elements for .NET configuration files, see defaultProxy
Element (Network Settings).

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-gateway-proxy.md
https://superuser.com/questions/346372/how-do-i-know-what-proxy-server-im-using
https://msdn.microsoft.com/library/kd3cf2ex.aspx


       Changing the gateway service account to a domain user
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Change the on-premises data gateway service accountChange the on-premises data gateway service account

Next steps

When configuring the proxy settings to use default credentials, as explained above, you may encounter
authentication issues with your proxy. This is because the default service account is the Service SID and not an
authenticated domain user. You can change the service account of the gateway to allow proper authentication
with your proxy.

It is recommended that you use a managed service account to avoid having to reset passwords. Learn how to create a
managed service account within Active Directory.

 net stop PBIEgwService

 net start PBIEgwService

3. Start the on-premises data gateway configurator. You can select the windows start button and search for
on-premises data gateway.

4. Sign in to Power BI.

1. Change the Windows service account for the on-premises data gateway service.

The default account for this service is NT SERVICE\PBIEgwService. You will want to change this to a
domain user account within your Active Directory domain. Or, you will want to use a managed service
account to avoid having to change the password.

You will want to change the account on the Log On tab within the properties of the Windows service.

2. Restart the on-premises data gateway service.

From an admin command prompt, issue the following commands.

5. Restore the gateway using your recovery key.

This will allow the new service account to be able to decrypt stored credentials for data sources.

On-premises data gateway (personal mode) Firewall information
More questions? Try the Power BI Community

https://technet.microsoft.com/library/dd548356.aspx
http://community.powerbi.com/
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Download and install the gateway

Limitations of Analysis Services live connections

SERVER VERSION REQUIRED SKU

2012 SP1 CU4 or later Business Intelligence and Enterprise SKU

2014 Business Intelligence and Enterprise SKU

2016 Standard SKU or higher

Once you have installed the on-premises data gateway, you will need to add data sources that can be used with
the gateway. This article will look at how to work with gateways and data sources. You can use the Analysis
Services data source either for scheduled refresh or for live connections.

You can download the gateway from the Power BI service. Select Downloads > Data Gateway, or by going to
the gateway download page.

You can use a live connection against tabular or multidimensional instances.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-gateway-enterprise-manage-ssas.md
https://go.microsoft.com/fwlink/?LinkId=698861


Add a gateway

NOTENOTE

Remove a gateway

Add a data source

Cell level Formatting and translation features are not supported.
Actions and Named Sets are not exposed to Power BI, but you can still connect to multidimensional cubes that
also contain Actions or Named sets and create visuals and reports.

To add a gateway, simply download and install the gateway on a server in your environment. After you have
installed the gateway, it will show in the lists of gateways under Manage gateways.

Manage gateways will not show up until you are the admin of at least one gateway. This can happen either by being
added as an admin or you installing and configuring a gateway.

Removing a gateway will also delete any data sources under that gateway. This will also break any dashboards
and reports that rely on those data sources.

1. Select the gear icon  in the upper-right corner > Manage gateways.
2. Gateway > Remove

You can add a data source by either selecting a gateway and click Add data source, or go to Gateway > Add
data source.

You can then select the Data Source Type from the list. Select Analysis Services if you are connecting to either a
Multidimensional or Tabular server.

https://go.microsoft.com/fwlink/?LinkId=698861


NOTENOTE

You will then want to fill in the information for the data source which includes the Server and the Database.

The Username and Password that you enter will be used by the gateway to connect to the Analysis Services
instance.

The Windows account you enter must have Server Administrator permissions for the instance you are connecting to. If this
account’s password is set to expire, users could get a connection error if the password isn’t updated for the data source.
For more information, see the main on-premises data gateway article to learn more about how credentials are stored.



Advanced settingsAdvanced settings

You can click Add after you have everything filled in. You can now use this data source for scheduled refresh, or
live connections, against an Analysis Services instance that is on premises. You will see Connection Successful if it
succeeded.

You can configure the privacy level for your data source. This controls how data can be mashed up. This is only
used for scheduled refresh. It does not apply to live connections. Learn more

https://support.office.com/article/Privacy-levels-Power-Query-CC3EDE4D-359E-4B28-BC72-9BEE7900B540


       

'Get Data' experience for Analysis Services in Power BI site

Usernames with Analysis Services

How do I tell what my UPN is?How do I tell what my UPN is?

whoami /upn

Map user names

A unique option for Analysis Services is to use Get Data within the Power BI service directly. You can connect to a
live Analysis Services data source that is configured within the gateway without needing Power BI Desktop. Your
account needs to be listed in the Users tab for the data source, under the gateway, for it to show up in the list. To
connect to the data source, you can do the following.

1. Within the Power BI service, select Get Data.
2. Select Databases.
3. Select SQL Server Analysis Services > Connect.
4. Select a data source from the list. Any Analysis Services data source that you have access to will be listed here.
5. Select the model that you want to connect to. Then select Connect.

You will see a dataset show up with the name of the server. You can then select that dataset and begin to create
reports on it. This will be working against live data.

Each time a user interacts with a report connected to Analysis Services, the effective username is passed to the
gateway and then onto your on-premises Analysis Services server. The email address, that you sign into Power BI
with, is what we will pass to Analysis Services as the effective user. This is passed in the connection property
EffectiveUserName. This email address should match a defined UPN within the local Active Directory Domain. The
UPN is a property of an Active Directory account. That Windows account then needs to be present in an Analysis
Services role. If a match cannot be found, in Active Directory, the login will not be successful. Learn more

You can also map your Power BI sign in name with a local directory UPN. Learn more

You may not know what your UPN is, and you may not be a domain administrator. You can use the following
command from your workstation to find out the UPN for your account.

The result will look similar to an email address, but this is the UPN that is on your domain account. If you are
using an Analysis Services data source for live connections, and If this doesn't match the email address you sign
into Power BI with, you may want to look at how to Map user names.

https://msdn.microsoft.com/library/dn140245.aspx#bkmk_auth
https://msdn.microsoft.com/library/ms677605.aspx


Manual user name re-mappingManual user name re-mapping

You can map user names for Analysis Services in two different ways:

1. Manual user re-mapping
2. On-premises Active Directory Property Lookup to remap AAD UPNs to Active Directory users (AD Lookup

mapping)

While it's possible to perform manual mapping using the second approach, doing so would be time consuming
and difficult to maintain; it's especially difficult when pattern matching doesn't suffice--such as when domain
names are different between AAD and on-premises AD, or when user account names are different between AAD
and AD. As such, manual mapping with the second approach is not recommended.

We describe these two approaches, in order, in the following two sections

For Analysis Services data sources, you can configure custom User Principal Name (UPN) rules. This will help you
if your Power BI service login names do not match your local directory UPN. For example, if you sign into Power
BI with john@contoso.com, but your local directory UPN is john@contoso.local, you can configure a mapping rule
to have john@contoso.local passed to Analysis Services.

To get to the UPN Mapping screen, do the following.

1. Go to the gear icon and select Manage Gateways.
2. Expand the gateway that contains the Analysis Services data source. Or, if you haven't created the Analysis

Services data source, you can do that at this point.
3. Select the data source and then select the Users tab.
4. Select Map user names.



NOTENOTE

AD lookup mappingAD lookup mapping

You will then see options to add rules as well as test for a given user.

You may inadvertently change a user that you didn't intend to. For example, if your Replace (original value) is
@contoso.com and your With (New name) is @contoso.local, all users with a sign in that contains @contoso.com will
then be replaced with @contoso.local. Also, if your Replace (Original name) is dave@contoso.com and your With (New
name) is dave@contoso.local, a user with the sign in of v-dave@contoso.com would be sent as v-dave@contoso.local.

To perform on-premises AD property lookup to re-map AAD UPNs to Active Directory users, follow the steps in
this section. To begin with, let's review how this works.

In the Power BI service the following occurs:

For each query by a Power BI AAD user to an on-premises SSAS server, a UPN string is passed along, such as:
firstName.lastName@contoso.com



NOTENOTE

Working with mapping rulesWorking with mapping rules

FIELD DESCRIPTION

Replace (Original name) The email address that you signed into Power BI with.

With (New Name) The value you want to replace it with. The result of the
replacement is what will be passed to the EffectiveUserName
property for the Analysis Services connection.

Any manual UPN user mappings defined in the Power BI data source configuration are still applied before sending the user
name string to the on-premises data gateway.

On the on-premises data gateway with configurable Custom User Mapping, do the following:

1. Find Active Directory to search (automatic, or configurable)
2. Look up the attribute of the AD Person (such as Email) based on incoming UPN string

(“firstName.lastName@contoso.com”) from the Power BI service.
3. If the AD Lookup fails, it attempts to use the passed-along UPN as EffectiveUser to SSAS.
4. If the AD Lookup succeeds, it retrieves UserPrincipalName of that AD Person.
5. It passes the UserPrincipalName email as EffectiveUser to SSAS, such as: Alias@corp.on-prem.contoso

How to configure your gateway to perform the AD Lookup:

1. Download and install the latest gateway
2. In the gateway, you need to change the on-premises data gateway service to run with a domain account

(instead of a local service account – otherwise the AD lookup won’t work properly at runtime). You'll need to
restart the gateway service for the change to take effect. Go to the gateway app on your machine (search for
“on-premises data gateway”). To do this, go to Service settings > Change service account. Make sure you
have the recovery key for this gateway, since you'll need to restore it on the same machine unless you want to
create a new gateway instead.

Microsoft.PowerBI.DataMovement.Pipeline.GatewayCore.dll.config 

5. Restart the on-premises data gateway service for the configuration change to take effect.

3. Navigate to the gateway’s installation folder, C:\Program Files\On-premises data gateway as an
administrator, to ensure that you have write-permissions, and edit the following file:

4. Edit the following two configuration values according to your Active Directory attribute configurations of
your AD users. The configuration values shown below are just examples – you need to specify them based
on your Active Directory configuration.

To create a mapping rule, enter a value for Original name and New Name and then select Add.



Using wildcard (*)Using wildcard (*)

Test a mapping ruleTest a mapping rule

NOTENOTE

Limitations for mapping rulesLimitations for mapping rules

When you select an item in the list, you can choose to re-order it by using the chevron icons, or Delete the
entry.

You can use a wildcard for your Replace (Original name) string. It can only be used on its own and not with any
other string part. This will allow you to take all users and pass a single value to the data source. This is useful
when you want all users in your organization to use the same user in your local environment.

You can validate what an original name will be replaced with by entering a value for Original name and
selecting Test rule.

Rules that are saved will take a few minutes for the service to start using them. Within the browser, the rule will work
immediately.



Remove a data source

Manage administrators

Manage users

NOTENOTE

Mapping is for the specific data source that is being configured. It is not a global settings. If you have multiple
Analysis Services data sources, you will have to map the users for each data source.

Removing a data source will break any dashboards or reports that rely on the given data source.

To remove a data source, go to Data Source > Remove.

On the Administrators tab for the gateway, you can add and remove users (or security groups) that can
administer the gateway.

On the Users tab for the data source, you can add, and remove, users, or security groups, that can use this data
source.

The users list only controls who are allowed to publish reports. The report owners can create dashboards, or content packs,
and share those with other users.



Using the data source
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Using the data source with live connectionsUsing the data source with live connections

Using the data source with scheduled refreshUsing the data source with scheduled refresh

After you have created the data source, it will be available to use with either live connections, or through
scheduled refresh.

Server and database name have to match between Power BI Desktop and the data source within the on-premises data
gateway!

The link between your dataset and the data source within the gateway is based on your server name and
database name. These have to match. For example, if you supply an IP Address for the server name, within Power
BI Desktop, you will need to use the IP Address for the data source within the gateway configuration. If you use
SERVER\INSTANCE, in Power BI Desktop, you will need to use the same within the data source configured for the
gateway.

This is the case for both live connections and scheduled refresh.

You will need to make sure the server and database name matches between Power BI Desktop and the
configured data source for the gateway. You will also need to make sure your user is listed in the Users tab of the
data source in order to publish live connection datasets. The selection, for live connections, occurs within Power BI
Desktop when you first import data.

After you publish, either from Power BI Desktop or Get Data, your reports should start working. It may take
several minutes, after creating the data source within the gateway, for the connection to be usable.

If you are listed in the Users tab of the data source configured within the gateway, and the server and database
name match, you will see the gateway as an option to use with scheduled refresh.



Next steps
On-premises data gateway
On-premises data gateway - in-depth
Troubleshooting the on-premises data gateway
More questions? Try the Power BI Community

http://community.powerbi.com/


Manage your SAP HANA data source
1/25/2018 • 3 min to read • Edit Online

Download and install the gateway

Add a gateway

NOTENOTE

Remove a gateway

Once you have installed the on-premises data gateway, you will need to add data sources that can be used with
the gateway. This article will look at how to work with gateways and data sources. You can use the SAP HANA data
source either for scheduled refresh or for DirectQuery.

You can download the gateway from the Power BI service. Select Downloads > Data Gateway, or by going to
the gateway download page.

To add a Gateway, simply download and install the gateway on a server in your environment. After you have
installed the gateway, it will show in the lists of gateways under Manage gateways.

Manage gateways will not show up until you are the admin of at least one gateway. This can happen either by being
added as an admin or you installing and configuring a gateway.

Removing a gateway will also delete any data sources under that gateway. This will also break any dashboards
and reports that rely on those data sources.

1. Select the gear icon  in the upper-right corner > Manage gateways.
2. Gateway > Remove

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-gateway-enterprise-manage-sap.md
https://go.microsoft.com/fwlink/?LinkId=698861
https://go.microsoft.com/fwlink/?LinkId=698861


Add a data source
You can add a data source by either selecting a gateway and click Add data source, or go to Gateway > Add
data source.

You can then select the Data Source Type from the list.

You will then want to fill in the information for the data source which includes the Server, Username and
Password.



NOTENOTE

Advanced settingsAdvanced settings

All queries to the data source will run using these credentials. For more information, see the main on-premises data gateway
article to learn more about how credentials are stored.

You can click Add after you have everything filled in. You can now use this data source for scheduled refresh, or
DirectQuery, against a SAP HANA server that is on-premises. You will see Connection Successful if it succeeded.

You can configure the privacy level for your data source. This controls how data can be mashed up. This is only
used for scheduled refresh. It does not apply to DirectQuery. Learn more

https://support.office.com/article/Privacy-levels-Power-Query-CC3EDE4D-359E-4B28-BC72-9BEE7900B540


Remove a data source

Manage administrators

Manage users

Removing a data source will break any dashboards or reports that rely on the given data source.

To remove a Data Source, go to the Data Source > Remove.

On the Administrators tab for the gateway, you can add and remove users (or security groups) that can administer
the gateway.

On the Users tab, for the data source, you can add, and remove, users, or security groups, that can use this data
source.



NOTENOTE

Using the data source
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Using the data source with DirectQuery connectionsUsing the data source with DirectQuery connections

Using the data source with scheduled refreshUsing the data source with scheduled refresh

The users list only controls who are allowed to publish reports. The report owners can create dashboards, or content packs,
and share those with other users.

After you have created the data source, it will be available to use with either DirectQuery connections, or through
scheduled refresh.

Server and database name have to match between Power BI Desktop and the data source within the on-premises data
gateway!

The link between your dataset and the data source within the gateway is based on your server name and database
name. These have to match. For example, if you supply an IP Address for the server name, within Power BI
Desktop, you will need to use the IP Address for the data source within the gateway configuration. If you use
SERVER\INSTANCE, in Power BI Desktop, you will need to use the same within the data source configured for the
gateway.

This is the case for both DirectQuery and scheduled refresh.

You will need to make sure the server and database name matches between Power BI Desktop and the configured
data source for the gateway. You will also need to make sure your user is listed in the Users tab of the data source
in order to publish DirectQuery datasets. The selection for DirectQuery occurs within Power BI Desktop when you
first import data. Learn more

After you publish, either from Power BI Desktop or Get Data, your reports should start working. It may take
several minutes, after creating the data source within the gateway, for the connection to be usable.

If you are listed in the Users tab of the data source configured within the gateway, and the server and database
name match, you will see the gateway as an option to use with scheduled refresh.



Next steps
On-premises data gateway
On-premises data gateway - in-depth
Troubleshooting the on-premises data gateway
More questions? Try the Power BI Community

http://community.powerbi.com/
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Download and install the gateway

Add a gateway

NOTENOTE

Remove a gateway

Once you have installed the on-premises data gateway, you can add data sources that can be used with the
gateway. This article will look at how to work with gateways and data sources. You can use the SQL Server data
source either for scheduled refresh or for DirectQuery.

You can download the gateway from the Power BI service. Select Downloads > Data Gateway, or by going to
the gateway download page.

To add a gateway, simply download and install the gateway on a server in your environment. After you have
installed the gateway, it will show in the lists of gateways under Manage gateways.

Manage gateways will not show up until you are the admin of at least one gateway. This occurs when you are added as an
admin to a gateway, or you install and configur a gateway yourself.

Removing a gateway will also delete any data sources under that gateway. This will also break any dashboards
and reports that rely on those data sources.

1. Select the gear icon  in the upper-right corner > Manage gateways.
2. Gateway > Remove

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-gateway-enterprise-manage-sql.md
https://go.microsoft.com/fwlink/?LinkId=698861
https://go.microsoft.com/fwlink/?LinkId=698861


Add a data source

NOTENOTE

You can add a data source by either selecting a gateway and click Add data source, or go to Gateway > Add
data source.

You can then select the Data Source Type from the list.

When using DirectQuery, the gateway only supports SQL Server 2012 SP1 and subsequent versions.

You will then want to fill in the information for the data source which includes the Server and the Database.



NOTENOTE

You will also need to choose an Authentication Method. This can either be Windows or Basic. You would want
to choose Basic if you are going to use SQL Authentication instead of Windows Authentication. Then enter the
credentials that will be used for this data source.

All queries to the data source will run using these credentials, unless Kerberos Single Sign On (SSO) is configured and
enabled for the data source. With SSO, import datasets use the stored credentials, but DirectQuery datasets use the current
Power BI user to execut the queries using SSO. For more information, see the main on-premises data gateway article to
learn more about how credentials are stored, or the article describing how to use Kerberos for SSO (single sign-on) from
Power BI to on-premises data sources.

You can click Add after you have everything filled in. You can now use this data source for scheduled refresh, or
DirectQuery, against a SQL Server that is on-premises. You will see Connection Successful if it succeeded.



Advanced settingsAdvanced settings

Remove a data source

Manage administrators

You can configure the privacy level for your data source. This controls how data can be mashed up. This is only
used for scheduled refresh. It does not apply to DirectQuery. Learn more

Removing a data source will break any dashboards or reports that rely on the given data source.

To remove a Data Source, go to the Data Source > Remove.

On the Administrators tab for the gateway, you can add and remove users (or security groups) that can administer
the gateway.

https://support.office.com/article/Privacy-levels-Power-Query-CC3EDE4D-359E-4B28-BC72-9BEE7900B540


Manage users
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Using the data source
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Using the data source with DirectQuery connectionsUsing the data source with DirectQuery connections

On the Users tab, for the data source, you can add, and remove, users, or security groups, that can use this data
source.

The users list only controls who are allowed to publish reports. The report owners can create dashboards, or content packs,
and share those with other users.

After you have created the data source, it will be available to use with either DirectQuery connections, or through
scheduled refresh.

Server and database name have to match between Power BI Desktop and the data source within the on-premises data
gateway!

The link between your dataset and the data source within the gateway is based on your server name and database
name. These have to match. For example, if you supply an IP Address for the server name, within Power BI
Desktop, you will need to use the IP Address for the data source within the gateway configuration. If you use
SERVER\INSTANCE, in Power BI Desktop, you will need to use the same within the data source configured for the
gateway.

This is the case for both DirectQuery and scheduled refresh.

You will need to make sure the server and database name matches between Power BI Desktop and the
configured data source for the gateway. You will also need to make sure your user is listed in the Users tab of the
data source in order to publish DirectQuery datasets. The selection, for DirectQuery, occurs within Power BI
Desktop when you first import data. Learn more

After you publish, either from Power BI Desktop or Get Data, your reports should start working. It may take
several minutes, after creating the data source within the gateway, for the connection to be usable.



Using the data source with scheduled refreshUsing the data source with scheduled refresh

Next steps

If you are listed in the Users tab of the data source configured within the gateway, and the server and database
name match, you will see the gateway as an option to use with scheduled refresh.

On-premises data gateway
On-premises data gateway - in-depth
Troubleshooting the on-premises data gateway
Use Kerberos for SSO (single sign-on) from Power BI to on-premises data sources.
More questions? Try the Power BI Community

http://community.powerbi.com/
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Download and install the gateway

WARNINGWARNING

Installing the Oracle client

Example tnsnames.ora file entryExample tnsnames.ora file entry

Once you have installed the on-premises data gateway, you will need to add data sources that can be used with
the gateway. This article will look at how to work with gateways and data sources. You can use the Oracle data
source either for scheduled refresh or for DirectQuery.

You can download the gateway from the Power BI service. Select Downloads > Data Gateway, or by going to the
gateway download page.

In order for the gateway to be able to connect to your Oracle server, the Oracle Data Provider for .NET (ODP.NET) needs to
be installed and configured. This is part of the Oracle Data Access Components (ODAC). For more information on how to
download the Oracle provider, see Installing the Oracle Client below.

For 32-bit versions of Power BI Desktop, use the following link to download and install the 32-bit Oracle client:

32-bit Oracle Data Access Components (ODAC) with Oracle Developer Tools for Visual Studio (12.1.0.2.4)

For 64-bit versions of Power BI Desktop, or for the on-premises data gateway, use the following link to download
and install the 64-bit Oracle client:

64-bit ODAC 12.2c Release 1 (12.2.0.1.0) for Windows x64

Once that is installed, you will need to configure your tnsnames.ora file with the proper information for your
database. Power BI Desktop and the gateway will go off of the net_service_name defined in the tnsnames.ora file. If
it isn't configured, you will not be able to connect. The default path for tnsnames.ora is the following: 
[Oracle Home Directory]\Network\Admin\tnsnames.ora . For more information about how to configure tnsnames.ora

files, see Oracle: Local Naming Parameters (tnsnames.ora).

The basic format of an entry in tnsname.ora is the following.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-gateway-onprem-manage-oracle.md
https://go.microsoft.com/fwlink/?LinkId=698861
http://www.oracle.com/technetwork/topics/dotnet/utilsoft-086879.html
http://www.oracle.com/technetwork/database/windows/downloads/index-090165.html
https://docs.oracle.com/cd/B28359_01/network.111/b28317/tnsnames.htm


net_service_name=
 (DESCRIPTION=
   (ADDRESS=(protocol_address_information))
   (CONNECT_DATA=
     (SERVICE_NAME=service_name)))

CONTOSO =
  (DESCRIPTION =
    (ADDRESS = (PROTOCOL = TCP)(HOST = oracleserver.contoso.com)(PORT = 1521))
    (CONNECT_DATA =
      (SERVER = DEDICATED)
      (SERVICE_NAME = CONTOSO)
    )
  )

Add a gateway

NOTENOTE

Remove a gateway

Add a data source

Here is an example of the server and port information filled in.

To add a gateway, simply download and install the gateway on a server in your environment. After you have
installed the gateway, it will show in the lists of gateways under Manage gateways.

Manage gateways will not show up until you are the admin of at least one gateway. This can happen either by being
added as an admin or you installing and configuring a gateway.

Removing a gateway will also delete any data sources under that gateway. This will also break any dashboards and
reports that rely on those data sources.

1. Select the gear icon  in the upper-right corner > Manage gateways.
2. Gateway > Remove

You can add a data source by either selecting a gateway and click Add data source, or go to Gateway > Add data
source.

https://go.microsoft.com/fwlink/?LinkId=698861
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You can then select the Data Source Type from the list.

You will then want to fill in the information for the data source which includes the Server and the Database.

You will also need to choose an Authentication Method. This can either be Windows or Basic. You would want
to choose Basic if you are going to use an account that is created within Oracle instead of Windows
Authentication. Then enter the credentials that will be used for this data source.

All queries to the data source will run using these credentials. For more information, see the main on-premises data gateway
article to learn more about how credentials are stored.



Advanced settingsAdvanced settings

You can click Add after you have everything filled in. You can now use this data source for scheduled refresh, or
DirectQuery, against an Oracle server that is on-premises. You will see Connection Successful if it succeeded.

You can configure the privacy level for your data source. This controls how data can be mashed up. This is only
used for scheduled refresh. It does not apply to DirectQuery. Learn more

https://support.office.com/article/Privacy-levels-Power-Query-CC3EDE4D-359E-4B28-BC72-9BEE7900B540


Remove a data source

Manage administrators

Manage users

NOTENOTE

Removing a data source will break any dashboards or reports that rely on the given data source.

To remove a Data Source, go to the Data Source > Remove.

On the Administrators tab for the gateway, you can add and remove users (or security groups) that can administer
the gateway.

On the Users tab, for the data source, you can add, and remove, users, or security groups, that can use this data
source.

The users list only controls who are allowed to publish reports. The report owners can create dashboards, or content packs,
and share those with other users. Users that are consuming the report or dashboard do not need to be in the users list.



Using the data source

WARNINGWARNING

Using the data source with DirectQuery connectionsUsing the data source with DirectQuery connections

Using the data source with scheduled refreshUsing the data source with scheduled refresh

After you have created the data source, it will be available to use with either DirectQuery connections, or through
scheduled refresh.

Server and database name have to match between Power BI Desktop and the data source within the on-premises data
gateway!

The link between your dataset and the data source within the gateway is based on your server name and database
name. These have to match! For example, if you supply an IP Address for the server name, within Power BI
Desktop, you will need to use the IP Address for the data source within the gateway configuration. This name also
has to match an alias defined within the tnsnames.ora file. For more information about the tnsnames.ora file, see
Installing the Oracle Client.

This is the case for both DirectQuery and scheduled refresh.

You will need to make sure the server and database name matches between Power BI Desktop and the configured
data source for the gateway. You will also need to make sure your user is listed in the Users tab of the data source
in order to publish DirectQuery datasets. The selection, for DirectQuery, occurs within Power BI Desktop when you
first import data. Learn more

After you publish, either from Power BI Desktop or Get Data, your reports should start working. It may take
several minutes, after creating the data source within the gateway, for the connection to be usable.

If you are listed in the Users tab of the data source configured within the gateway, and the server and database
name match, you will see the gateway as an option to use with scheduled refresh.



Troubleshooting

NOTENOTE

Next steps

You may encounter serveral errors from Oracle when the naming syntax is either incorrect or not configured
properly.

ORA-12154: TNS: could not resolve the connect identifier specified
ORA-12514: TNS listener does not currently know of service requested in connect descriptor
ORA-12541: TNS: no listener
ORA-12170: TNS:Connect timeout occurred
ORA-12504: TNS listener was not given the SERVICE_NAME in CONNECT_DATA

These errors could occur if either the Oracle client is not installed, or if it is not configured properly. If it is installed,
you will want to verify the tnsnames.ora file is properly configured and you are using the proper
net_service_name. You will also need to make sure that the net_service_name is the same between the machine
using Power BI Desktop and the machine that is running the gateway. For more information, see Installing the
Oracle Client.

You may also be hitting an issue due to compatability between the Oracle server version and the Oracle client version.
Typically you want these to match.

For additional troubleshooting information relating to the gateway, see Troubleshooting the on-premises data
gateway.

On-premises data gateway
On-premises data gateway - in-depth
Troubleshooting the on-premises data gateway
Power BI Premium

More questions? Try asking the Power BI Community

http://community.powerbi.com/
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Download and install the gateway

Add a gateway

NOTENOTE

Remove a gateway

Once you have installed the on-premises data gateway, you will need to add data sources that can be used with
the gateway. This article will look at how to work with gateways and data sources that are used for scheduled
refresh as opposed to DirectQuery or live connections.

You can download the gateway from the Power BI service. Select Downloads > Data Gateway, or by going to
the gateway download page.

To add a gateway, simply download and install the enterprise gateway on a server in your environment. After you
have installed the gateway, it will show in the lists of gateways under Manage gateways.

Manage gateways will not show up until you are the admin of at least one gateway. This can happen either by being
added as an admin or you installing and configuring a gateway.

Removing a gateway will also delete any data sources under that gateway. This will also break any dashboards
and reports that rely on those data sources.

1. Select the gear icon  in the upper-right corner > Manage gateways.
2. Gateway > Remove

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-gateway-enterprise-manage-scheduled-refresh.md
https://go.microsoft.com/fwlink/?LinkId=698861
https://go.microsoft.com/fwlink/?LinkId=698863


Add a data source
You can add a data source by either selecting a gateway and click Add data source, or go to Gateway > Add
data source.

You can then select the Data Source Type from the list. All of the data sources listed can be used for scheduled
refresh with the enterprise gateway. Analysis Services, SQL Server and SAP HANA can be used for either
scheduled refresh, or DirectQuery/live connections.

You will then want to fill in the information for the data source which includes the source information and
credentials used to access the data source.
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List of available data source types

DATA SOURCE LIVE/DIRECTQUERY
USER CONFIGURED MANUAL OR
SCHEDULED REFRESH

Analysis Services Tabular Yes Yes

Analysis Services Multidimensional Yes Yes

All queries to the data source will run using these credentials. For more information, see the main on-premises data gateway
article to learn more about how credentials are stored.

You can click Add after you have everything filled in. You can now use this data source for scheduled refresh with
your on-premises data. You will see Connection Successful if it succeeded.



File No Yes

Folder No Yes

IBM DB2 No Yes

IBM Informix Database No Yes

Impala Yes Yes

MySQL No Yes

OData No Yes

ODBC No Yes

Oledb No Yes

Oracle Yes Yes

PostgresSQL No Yes

SAP BW Yes Yes

SAP HANA Yes Yes

SharePoint list (on-premises) No Yes

Snowflake Yes Yes

SQL Server Yes Yes

Sybase No Yes

Teradata Yes Yes

Web No Yes

DATA SOURCE LIVE/DIRECTQUERY
USER CONFIGURED MANUAL OR
SCHEDULED REFRESH

Advanced settingsAdvanced settings
You can configure the privacy level for your data source. This controls how data can be mashed up. This is only
used for scheduled refresh. Learn more

https://support.office.com/article/Privacy-levels-Power-Query-CC3EDE4D-359E-4B28-BC72-9BEE7900B540


Remove a data source

Manage administrators

Manage users

Removing a data source will break any dashboards or reports that rely on the given data source.

To remove a Data Source, go to the Data Source > Remove.

On the Administrators tab, for the gateway, you can add, and remove, users that can administer the gateway. You
can only add users at this time. Security groups cannot be added.

On the Users tab, for the data source, you can add, and remove, users, or security groups, that can use this data
source.
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Using the data source for scheduled refresh

NOTENOTE

The users list only controls who are allowed to publish reports. The report owners can create dashboards, or content packs,
and share those with other users.

After you have created the data source, it will be available to use with either DirectQuery connections, or through
scheduled refresh.

Server and database name have to match between Power BI Desktop and the data source within the on-premises data
gateway!

The link between your dataset and the data source within the gateway is based on your server name and database
name. These have to match. For example, if you supply an IP Address for the server name, within Power BI
Desktop, you will need to use the IP Address for the data source within the gateway configuration. If you use
SERVER\INSTANCE, in Power BI Desktop, you will need to use the same within the data source configured for the
gateway.

If you are listed in the Users tab of the data source configured within the gateway, and the server and database
name match, you will see the gateway as an option to use with scheduled refresh.



WARNINGWARNING

Limitations

Next steps

If your dataset contains multiple data sources, each data source must be added within the gateway. If one or more data
sources are not added to the gateway, you will not see the gateway as available for scheduled refresh.

OAuth is not a supported authentication scheme with the on-premises data gateway. You cannot add data
sources that require OAuth. If your dataset has a data source requiring OAuth, you will not be able to use the
gateway for scheduled refresh.

On-premises data gateway
On-premises data gateway - in-depth
Troubleshooting the on-premises data gateway
More questions? Try the Power BI Community

http://community.powerbi.com/
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NOTENOTE

What's in this article

Microsoft Power BI enables users to visualize data, share discoveries, and collaborate in intuitive new ways. To
learn more, see Get started with Power BI.

Administration of Power BI can occur in several locations. Here are two common locations.

Your account needs to be marked as a Global Admin, within Office 365 or Azure Active Directory, or have been assigned
the Power BI service administrator role, to get access to the Power BI admin portal. For more information about the Power
BI service administrator role, see Understanding the Power BI admin role.

Power BI Admin portal
Office 365 Admin Center

For more information regarding the Power BI service administrator role, see Understanding the Power BI admin
role.

Sign up for Power BI

How do users sign up for Power BI?
How do individual users in my organization sign up?
How can I prevent users from joining my existing Office 365 tenant?
How can I allow users to join my existing Office 365 tenant?
How do I verify if I have the block on in the tenant?
How can I prevent my existing users from starting to use Power BI?
How can I allow my existing users to sign up for Power BI?

Administration of Power BI

How will this change the way I manage identities for users in my organization today?
How do we manage Power BI?
What is the process to manage a tenant created by Microsoft for my users?
If I have multiple domains, can I control the Office 365 tenant that users are added to?
How do I remove Power BI for users that already signed up?
How do I know when new users have joined my tenant?
Are there any additional things I should be prepared for?
Is this free? Will I be charged for these licenses?
Where is my Power BI tenant located?
What is the Power BI SLA (Service Level Agreement)?

Security in Power BI

 How does security work in Power BI ?

Does Power BI meet national, regional, and industry-specific compliance requirements?

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-admin-administering-power-bi-in-your-organization.md
https://app.powerbi.com/admin-portal
https://portal.office.com/adminportal/home


  

  

  

Sign up for Power BI
How do users sign up for Power BI?How do users sign up for Power BI?

How do individual users in my organization sign up?How do individual users in my organization sign up?

IMPORTANTIMPORTANT

How can I prevent users from joining my existing Office 365 tenant?How can I prevent users from joining my existing Office 365 tenant?

You can sign up for Power BI through the Power BI web site. You can also sign up through the purchase services
page on the Office 365 admin center. When an administrator signs up for Power BI, they can assign user licenses
to users who should have access.

Additionally, individual users in your organization may be able to sign up for Power BI through the Power BI web
site. When a user in your organization signs up for Power BI, that user is assigned a Power BI license
automatically. Learn more

There are three scenarios that might apply to users in your organization:

Scenario 1: Your organization already has an existing Office 365 environment and the user signing up for Power
BI already has an Office 365 account. In this scenario, if a user already has a work or school account in the tenant
(for example, contoso.com) but does not yet have Power BI, Microsoft will simply activate the plan for that
account, and the user will automatically be notified of how to use the Power BI service.

Scenario 2: Your organization has an existing Office 365 environment and the user signing up for Power BI
doesn’t have an Office 365 account. In this scenario, the user has an email address in your organization’s domain
(for example, contoso.com) but does not yet have an Office 365 account. In this case, the user can sign up for
Power BI and will automatically be given an account. This lets the user access the Power BI service. For example, if
an employee named Nancy uses her work email address (for example, Nancy@contoso.com) to sign up, Microsoft
will automatically add Nancy as a user in Contoso’s Office 365 environment and activate Power BI for that
account.

Scenario 3: Your organization does not have an Office 365 environment connected to your email domain. There
are no administrative actions your organization needs to take to take advantage of Power BI. Users will be added
to a new, cloud-only user directory, and you will have the option to elect to take over as the tenant admin and
manage them.

If your organization has multiple email domains and you prefer all email address extensions to be in the same tenant, add all
email address domains to an Azure Active Directory tenant before any users sign up. There is no automated mechanism to
move users across tenants after they have been created. For more information on this process, see If I have multiple
domains, can I control the Office 365 tenant that users are added to? later in this article and Add your domain to Office 365
online.

There are steps you can take, as an admin, to prevent users from joining your existing Office 365 tenant. If you do
block this, users’ attempts to sign up will fail and they will be directed to contact their organization’s admin. You
do not need to repeat this process if you have already disabled automatic license distribution (e.g. Office 365 for
Education for Students, Faculty, and Staff).

These steps require the use of Windows PowerShell. To get started with Windows PowerShell, see the PowerShell
getting started guide.

To perform the following steps, you must install the latest 64-bit version of the Azure Active Directory Module for
Windows PowerShell.

After you select the link, select Run to run the installer package.

Disable automatic tenant join: Use this Windows PowerShell command to prevent new users from joining a
managed tenant:

https://powerbi.microsoft.com
https://powerbi.microsoft.com
https://support.office.com/article/Add-your-users-and-domain-to-Office-365-6383f56d-3d09-4dcb-9b41-b5f5a5efd611
http://go.microsoft.com/fwlink/p/?LinkID=286814
http://go.microsoft.com/fwlink/p/?LinkID=236297
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How can I allow users to join my existing Office 365 tenant?How can I allow users to join my existing Office 365 tenant?

$msolcred = get-credential
connect-msolservice -credential $msolcred

Set-MsolCompanySettings -AllowEmailVerifiedUsers $true

How do I verify if I have the block on in the tenant?How do I verify if I have the block on in the tenant?

$msolcred = get-credential
connect-msolservice -credential $msolcred

Get-MsolCompanyInformation | fl allow*

How can I prevent my existing users from starting to use Power BI?How can I prevent my existing users from starting to use Power BI?

To disable automatic tenant join for new users:

$msolcred = get-credential connect-msolservice -credential $msolcred

Set-MsolCompanySettings -AllowEmailVerifiedUsers $false

To enable automatic tenant join for new users:

$msolcred = get-credential connect-msolservice -credential $msolcred

Set-MsolCompanySettings -AllowEmailVerifiedUsers $true

This blocking prevents new users in your organization from signing up for Power BI. Users that sign up for Power BI prior to
disabling new signups for your organization will still retain their licenses. See the [How Can I Remove Licenses?] section for
instructions on how you can remove access to Power BI for users that had previously signed up for the service.

To allow users to join your tenant, run the opposite command as described in the question above.

To perform the following steps, you must install the latest 64-bit version of the Azure Active Directory Module for
Windows PowerShell.

Use the following PowerShell script.

To perform the following steps, you must install the latest 64-bit version of the Azure Active Directory Module for
Windows PowerShell.

There are steps you can take, as an admin, to prevent users from signing up for Power BI. If you do block this,
users’ attempts to sign up will fail and they will be directed to contact their organization’s admin. You do not need
to repeat this process if you have already disabled automatic license distribution (e.g. Office 365 for Education for
Students, Faculty, and Staff). Learn more

The AAD setting that controls this is AllowAdHocSubscriptions. Most tenants will have this setting set to true,
which means it is enabled. If you acquired Power BI through a partner, this may be set to false by default, which
means it is disabled.

To perform the following steps, you must install the latest 64-bit version of the Azure Active Directory Module for
Windows PowerShell.

1. You need to first sign into Azure Active Directory using your Office 365 credential. The first line will prompt
you for your credentials. The second line connects to Azure Active Directory.

$msolcred = get-credential connect-msolservice -credential $msolcred

http://go.microsoft.com/fwlink/p/?LinkID=236297
http://go.microsoft.com/fwlink/p/?LinkID=236297
http://go.microsoft.com/fwlink/p/?LinkID=236297
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How can I allow my existing users to sign up for Power BI?How can I allow my existing users to sign up for Power BI?

NOTENOTE

Administration of Power BI
How will this change the way I manage identities for users in my organization today?How will this change the way I manage identities for users in my organization today?

2. Once you are signed in, you can issue the following command to see what your tenant is currently
configured for.

Get-MsolCompanyInformation | fl AllowAdHocSubscriptions

3. You can this command to enable ($true) or disable ($false) AllowAdHocSubscriptions.

Set-MsolCompanySettings -AllowAdHocSubscriptions $true

The AllowAdHocSubscriptions flag is used to control several user capabilities in your organization, including the ability for
users to sign up for the Azure Rights Management Service. Changing this flag will affect all of these capabilities.

To allow your existing users to sign up for Power BI, run the command listed for the above question, but pass true
instead of false.

To perform the following steps, you must install the latest 64-bit version of the Azure Active Directory Module for
Windows PowerShell.

1. You need to first sign into Azure Active Directory using your Office 365 credential. The first line will prompt
you for your credentials. The second line connects to Azure Active Directory.

$msolcred = get-credential connect-msolservice -credential $msolcred

2. Once you are signed in, you can issue the following command to see what your tenant is currently
configured for.

Get-MsolCompanyInformation | fl AllowAdHocSubscriptions

3. You can this command to enable ($true) or disable ($false) AllowAdHocSubscriptions.

Set-MsolCompanySettings -AllowAdHocSubscriptions $true

The AllowAdHocSubscriptions flag is used to control several user capabilities in your organization, including the ability for
users to sign up for the Azure Rights Management Service. Changing this flag will affect all of these capabilities.

If your organization already has an existing Office 365 environment and all users in your organization have Office
365 accounts, identity management will not change.

If your organization already has an existing Office 365 environment but not all users in your organization have
Office 365 accounts, we will create a user in the tenant and assign licenses based on the user’s work, or school,
email address. This means that the number of users you are managing at any particular time will grow as users in
your organization sign up for the service.

If you are managing your directory on-premises, and use Active Directory Federation Services (AD FS), Microsoft
will not add users to your tenant, and users attempting to join your tenant will receive a message to contact their
organization’s admin.

If your organization does not have an Office 365 environment connected to your email domain, there will be no
change in how you manage identity. Users will be added to a new, cloud-only user directory, and you will have the

http://go.microsoft.com/fwlink/p/?LinkID=236297


  

    

  

How do we manage Power BI?How do we manage Power BI?

NOTENOTE

What is the process to manage a tenant created by Microsoft for my users?What is the process to manage a tenant created by Microsoft for my users?

If I have multiple domains, can I control the Office 365 tenant that users are added to?If I have multiple domains, can I control the Office 365 tenant that users are added to?

IMPORTANTIMPORTANT

How do I remove Power BI for users that already signed up?How do I remove Power BI for users that already signed up?

option to elect to take over as the tenant admin and manage them.

Power BI provides an admin portal that allows you to view usage statistics, provides a link to the Office 365 admin
center to manage users and groups, and the ability to control tenant wide settings.

Your account needs to be marked as a Global Admin, within Office 365 or Azure Active Directory, to get access to the
Power BI admin portal.

For more information, see Power BI Admin Portal.

If a tenant was created by Microsoft, you can claim and manage that tenant by following these steps:

1. Join the tenant, by signing up for Power BI, using an email address domain that matches the tenant domain
you want to manage. For example, if Microsoft created the contoso.com tenant, you will need to join the tenant
with an email address ending with @contoso.com.

2. Claim admin control by verifying domain ownership: once you are in the tenant, you can promote yourself
to a Global Admin role by verifying domain ownership. To do so, follow these steps:

a. Go to https://portal.office.com.
b. Select the app launcher icon in the upper-left and choose Admin.

NOTENOTE

c. Read the instructions on the Become the admin page and then choose Yes, I want to be the
admin.

If this option doesn’t appear, there is already an Office 365 administrator in place.

If you do nothing, a tenant will be created for each user email domain and subdomain.

If you want all users to be in the same tenant regardless of their email address extensions:

Create a target tenant ahead of time, or use an existing tenant, and add all the existing domains and
subdomains that you want consolidated within that tenant. Then all the users with email addresses ending in
those domains and subdomains will automatically join the target tenant when they sign up.

There is no supported automated mechanism to move users across tenants once they have been created. To learn about
adding domains to a single Office 365 tenant, see Add your users and domain to Office 365.

If a user signed up for Power BI, but you no longer want them to have access to Power BI, you can remove the
Power BI license for that user.

1. Navigate to the Office 365 admin center.
2. In the left navigation bar, select Users > Active Users.
3. Find the user you want to remove the license for, then select their name > Edit.
4. On the user details page, select Licenses in the left navigation bar.

https://portal.office.com
https://support.office.com/article/Add-your-users-and-domain-to-Office-365-6383f56d-3d09-4dcb-9b41-b5f5a5efd611
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How do I know when new users have joined my tenant?How do I know when new users have joined my tenant?

Are there any additional things I should be prepared for?Are there any additional things I should be prepared for?

Is this free? Will I be charged for these licenses?Is this free? Will I be charged for these licenses?

Where is my Power BI tenant located?Where is my Power BI tenant located?

What is the Power BI SLA?What is the Power BI SLA?

Security in Power BI
Does Power BI meet national, regional, and industry-specific compliance requirements?Does Power BI meet national, regional, and industry-specific compliance requirements?

How does security work in Power BI?How does security work in Power BI?

Next steps

5. Uncheck Power BI (free), or Power BI Pro, depending on what license is applied to their account.
6. Select Save.

You can perform bulk license management to users as well. To do that, select multiple users and select Edit.

Users who have joined your tenant as part of this program are assigned a unique license that you can filter on
within your active user pane in the admin dashboard.

To create this new view, in the Office 365 admin center, go to Users > Active Users, and on the Select a View
menu, select New View. Name your new view, and under Assigned license, select Power BI (free) or Power BI
Pro. You can only have one license selected per view. If you have both Power BI (free) and Power BI Pro licenses
in your organization, you would need to create two views. Once the new view has been created, you will be able to
see all the users in your tenant who have enrolled in this program.

You might experience an increase in password reset requests. For information about this process, see Reset a
user's password.

You can remove a user from your tenant via the standard process in the Office 365 admin center. However, if the
user still has an active email address from your organization, they will be able to rejoin unless you block all users
from joining.

The Power BI (free) licenses are for the free version of Power BI. If you're interested in additional capabilities,
take a look at the Power BI Pro version.

To learn how to find where your Power BI tenant is located, also known as a data region, see Where is my Power
BI tenant located?

For information about the Power BI SLA (Service Level Agreement), consult the Licensing Terms and
Documentation article in the Licensing section of the Microsoft Licensing website.

To learn more about Power BI compliance, see the Microsoft Trust Center.

Power BI is built on the foundation of Office 365, which in turn builds on Azure services like Azure Active
Directory. For an overview of Power BI architecture, see Power BI Security.

Power BI admin portal
Understanding the Power BI admin role
Self-service sign up for Power BI
Power BI (free) in your organization
Purchasing Power BI Pro
Power BI Premium - what is it?

https://support.office.com/article/Reset-a-users-password-7a5d073b-7fae-4aa5-8f96-9ecd041aba9c
http://www.microsoftvolumelicensing.com/DocumentSearch.aspx?Mode=3&DocumentTypeId=37
http://go.microsoft.com/fwlink/?LinkId=785324


How to purchase Power BI Premium
Office 365 user account management
Office 365 group management
Manage your group in Power BI and Office 365
Power BI Premium whitepaper

More questions? Try asking the Power BI Community

https://technet.microsoft.com/library/office-365-user-account-management.aspx
https://support.office.com/Article/Find-help-about-Groups-in-Office-365-7a9b321f-b76a-4d53-b98b-a2b0b7946de1
https://aka.ms/pbipremiumwhitepaper
http://community.powerbi.com/
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Individual sign up versus license assignment

How to get the unlimited license block

Getting free licenses via add subscription within Office 365

This will look at how the Power BI (free) offering can be used within your organization. An organization means that
you have a tenant and can manage users and services within that tenant. As an administrator, you can control
license assignment, or you can allow users to sign up as an individual. We will look at the Power BI (free) license
and how you can control individual sign up.

Users within your organization can gain access to Power BI in two different ways. They can individually sign up for
Power BI, or you can assign a Power BI license to them within the Office 365 admin portal.

Allowing individual sign up reduces the burden, from the organization administrators, by allowing the users that
are interested in Power BI to sign up for free.

For more control, you can block individual sign up and assign Power BI licenses yourself within the Office 365
admin center. This allows you to be specific of who can access what services within your organization. This is also a
great option if you have to deal with auditing and need to know exactly who can use what.

Within the Office 365 admin center, under Billing > Licenses, you may or may not see Power BI (free) with
unlimited licenses.

This block of licenses will show up after the first time someone signs up for Power BI as an individual. During that
process, this license block gets attached to your organization and a license is assigned to the user that is signing
up.

If you are blocking individual user sign up, and no one has signed up, you will not see this license block. You can
either allow individual user sign ups and have one user sign up, or you can get free licenses through the add
subscription Office 365 flow which will be talked about next.

Once the Power BI (free) license block is available, you can assign those licenses to your users. For more
information about how to assign licenses, see Assign licenses to users in Office 365 .

1. Navigate to the Office 365 admin center.
2. On the left navigation pane, select Billing > Subscriptions.
3. Select Add subscriptions + on the right side.
4. Under Other Plans, hover over the ellipse (…) for Power BI (free) and select Buy now.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-admin-service-free-in-your-organization.md
https://support.office.com/article/Assign-or-unassign-licenses-for-Office-365-for-business-997596b5-4173-4627-b915-36abac6786dc
https://portal.office.com/admin/default.aspx


  Enable, or disable, individual user sign up in Azure Active Directory
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6. Enter the needed information in the check out flow.

5. Enter the number of licenses you would like to add and select Check out now or Add to cart.

You can add more at a later date if needed.

There is no purchase when using this approach, although you will need to either enter your credit card information
for billing, or choose to be invoiced.

If you decide later that you want to add more licenses, you can go back to Add subscriptions, and select Change
license quantity for Power BI (free).

You can now assign those licenses to your users. For more information about how to assign licenses, see Assign
licenses to users in Office 365 .

As an administrator, you can choose to enable, or disable, individual user sign ups as part of Azure Active Directory
(AAD). If you know how to leverage the AAD PowerShell commands, you can enable, or disable, ad-hoc
subscriptions yourself. Learn more

https://support.office.com/article/Assign-or-unassign-licenses-for-Office-365-for-business-997596b5-4173-4627-b915-36abac6786dc
https://technet.microsoft.com/library/jj151815.aspx
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Next steps

The AAD setting that controls this is AllowAdHocSubscriptions. Most tenants will have this setting set to true,
which means it is enabled. If you acquired Power BI through a partner, this may be set to false by default, which
means it is disabled.

1. You need to first sign into Azure Active Directory using your Office 365 credential. The first line will prompt
you for your credentials. The second line connects to Azure Active Directory.

$msolcred = get-credential connect-msolservice -credential $msolcred

2. Once you are signed in, you can issue the following command to see what your tenant is currently
configured for.

Get-MsolCompanyInformation | fl AllowAdHocSubscriptions

3. You can this command to enable ($true) or disable ($false) AllowAdHocSubscriptions.

Set-MsolCompanySettings -AllowAdHocSubscriptions $true

This blocking prevents new users in your organization from signing up for Power BI. Users that sign up for Power BI prior to
disabling new signups for your organization will still retain their licenses.

Self-service sign up for Power BI
Purchasing Power BI Pro
Sign up for Power BI (free) with a custom Azure Active Directory tenant
Power BI Premium - what is it?
Power BI Premium whitepaper

More questions? Try asking the Power BI Community

https://aka.ms/pbipremiumwhitepaper
http://community.powerbi.com/
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Pricing

In-service Power BI Pro 60 day trial for individuals

Power BI Pro is for those users publishing reports, sharing dashboards, collaborating with colleagues in
workspaces and engaging in other related activities – such as the ability to:

Analyze data in Excel or Power BI Desktop
Share with Excel Web App support
Share dashboards and collaborate with app workspaces
View shared content
Integrate content with Microsoft Teams

IT Admins have a few options to use Power BI Pro within your organization. You can purchase Power BI Pro
through the Office 365 admin center or through your Microsoft representative or partner. This article will look at
the two trial options available for Power BI Pro, and then how to purchase as an organization.

For more information about Power BI Premium, and how Power BI Pro fits into the Premium offering, see Power
BI Premium - what is it?

For the latest pricing information of Power BI Pro and a table listing of included features, see Power BI Pricing.

After you have signed up for your free account, you can optionally choose to try Pro free for 60 days. You will
have access to all of the Pro features for the duration of the trial. Power BI Pro has all the features of the free
version of Power BI, and additional sharing and collaboration features. For more information, see Power BI
Pricing. To try a 60-day free trial of Power BI Pro, sign into Power BI, and try one of these Power BI Pro features:

Create an app worksapce
Share a dashboard

When you try any of these features, you will be prompted to start your free trial. You can also choose to make
use of it by going to the gear icon and selecting Manage personal storage. Then select Try Pro for free on the
right.

Then you can select Start trial.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-admin-purchasing-power-bi-pro.md
https://powerbi.microsoft.com/pricing/
https://powerbi.microsoft.com/pricing
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What this looks like within the serviceWhat this looks like within the service

Subscription trial in Office 365

NOTENOTE

Users taking advantage of this in-product Power BI Pro trial do not appear in the Office 365 admin portal as Power BI Pro
Trial users (they appear as Power BI free users). They will, however, show up as Power BI Pro Trial users in the manage
storage page in Power BI.

If you are an IT Administrator wishing to acquire and deploy Power BI trial licenses to multiple users in your organization
without having individual users accept trial terms individually, you can sign up for a Power BI Pro subscription trial. You will
need to be an Office 365 Global or Billing Admin or create a new tenant to sign up for an admin trial. For more
information, see Purchasing Power BI Pro.

With the availability of Power BI Premium, and the changes to the Power BI Free offering on June 1, 2017, you may be
eligible for an Extended Pro Trial. For more information, see Extended Pro Trial activation.

When you are in the service, you can verify that you have a Pro trial account by going to the gear* icon and
selecting **Manage personal storage.

You can get Power BI Pro as a trial for your organization. Once you have the subscription, you can assign Power
BI Pro licenses to your users. For more information about how to assign licenses, see Assign licenses to users in
Office 365 .

There is a limit of one organizational trial per tenant. This means that if someone has already applied the Power BI Pro Trial
to your tenant, you cannot do it again. If you need assistance with this, you can contact Office 365 Billing support.

1. Navigate to the Office 365 admin center.
2. On the left navigation pane, select Billing > Subscriptions.
3. Select Add subscriptions + on the right side.
4. Under Other Plans, hover over the ellipse (…) for Power BI Pro and select Start free trial.

https://portal.office.com/Signup/MainSignup15.aspx?OfferId=d59682f3-3e3b-4686-9c00-7c7c1c736085&dl=POWER_BI_PRO
https://support.office.com/article/Assign-or-unassign-licenses-for-Office-365-for-business-997596b5-4173-4627-b915-36abac6786dc
https://support.office.microsoft.com/article/Contact-Office-365-for-business-support-Admin-Help-32a17ca7-6fa0-4870-8a8d-e25ba4ccfd4b?CorrelationId=552bbf37-214f-4202-80cb-b94240dcd671&ui=en-US&rs=en-US&ad=US#BKMK_call_support
https://portal.office.com/admin/default.aspx
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Purchase subscription in Office 365

5. On the confirm your order screen, select Try now.
6. Select Continue on the order receipt.

Under Billing > Subscriptions, you will see Power BI Pro Trial listed with 25 licenses available. This is a one
month trial.

When you are in the service, you can verify that you have a Pro account by going to the gear icon and selecting
Manage personal storage. There will be no indication that this is a trial user.

You can purchase Power BI Pro for your organization through the Office 365 admin center. Once you have the
subscription, you can assign Power BI Pro licenses to your users. For more information about how to assign
licenses, see Assign licenses to users in Office 365 .

1. Navigate to the Office 365 admin center.
2. On the left navigation pane, select Billing > Subscriptions.
3. Select Add subscriptions + on the right side.
4. Under Other Plans, hover over the ellipse (…) for Power BI Pro and select Buy now.

https://support.office.com/article/Assign-or-unassign-licenses-for-Office-365-for-business-997596b5-4173-4627-b915-36abac6786dc
https://portal.office.com/admin/default.aspx
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What this looks like within the serviceWhat this looks like within the service

Grace period

Next steps

NOTENOTE

6. Enter the needed information in the check out flow.

5. Enter the number of licenses you would like to add and select Check out now or Add to cart.

You can add more at a later date if needed.

If you already had the Power BI Pro Trial, it will go directly to the checkout screen asking to input the number of licenses
you want.

Under Billing > Subscriptions, you will see Power BI Pro listed. If you decide later that you want to add more
licenses, you can go back to Add subscriptions, and select Change license quantity.

When you are in the service, you can verify that you have a Pro account by going to the gear icon and selecting
Manage personal storage.

There is a 30-day grace period after a Power BI Pro license expires.

Power BI Pro has the same subscription lifecycle as Office 365. For more information, see What happens to my
data and access when my Office 365 for business subscription ends?

Self-service sign up for Power BI
Power BI (free) in your organization
Extended Pro Trial activation

https://support.office.com/en-us/article/What-happens-to-my-data-and-access-when-my-Office-365-for-business-subscription-ends-4436582f-211a-45ec-b72e-33647f97d8a3


Power BI Premium - what is it?
How to purchase Power BI Premium
Power BI Premium whitepaper

More questions? Try asking the Power BI Community

https://aka.ms/pbipremiumwhitepaper
http://community.powerbi.com/


Governance and deployment approaches
1/30/2018 • 1 min to read • Edit Online

Over the last few decades companies have become increasingly aware of the need to strategically leverage data
assets to profit from market opportunities. Either by performing competitive analysis or by understanding
operational patterns, many organizations now understand they can benefit from having a data strategy as a way to
stay ahead of their competition.

This whitepaper provides a framework for increasing the return on investment related to Power BI as companies
seek to increasingly become more data-savvy.

Business Intelligence practitioners typically define data-savvy companies as those that benefit from the use of
factual information to support decision making. We even describe certain organizations as having a “data culture.”
Whether at the organizational level, or at a departmental level, a data culture can positively alter a company’s
ability to adapt and thrive. Data insights must not always be of enterprise scope to be far-reaching: small
operational insights that can alter day-to-day operations can be transformational as well.

For these companies, there is an understanding that facts – and fact analysis – must drive how business processes
are defined. Team members attempt to seek data, identify patterns, and share findings with others.

This approach can be useful regardless of if the analysis is done over external or internal business factors. It is first
and foremost a perspective, not a process.

Read Power BI Governance and Deployment Approaches to learn about concepts, options and suggestions for
governance within the Power BI ecosystem.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-admin-governance.md
http://go.microsoft.com/fwlink/?LinkId=785915&clcid=0x409
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Power BI Architecture

For a detailed explanation of Power BI security, please download the Power BI Security whitepaper:

The Power BI service is built on Azure, which is Microsoft’s cloud computing infrastructure and platform. The
Power BI service architecture is based on two clusters – the Web Front End (WFE) cluster and the Back End cluster.
The WFE cluster is responsible for initial connection and authentication to the Power BI service, and once
authenticated, the Back End handles all subsequent user interactions. Power BI uses Azure Active Directory (AAD)
to store and manage user identities, and manages the storage of data and metadata using Azure BLOB and Azure
SQL Database, respectively.

Each Power BI deployment consists of two clusters – a Web Front End (WFE) cluster, and a Back End cluster.

The WFE cluster manages the initial connection and authentication process for Power BI, using AAD to
authenticate clients and provide tokens for subsequent client connections to the Power BI service. Power BI also
uses the Azure Traffic Manager (ATM) to direct user traffic to the nearest datacenter, determined by the DNS
record of the client attempting to connect, for the authentication process and to download static content and files.
Power BI uses the Azure Content Delivery Network (CDN) to efficiently distribute the necessary static content
and files to users based on geographical locale.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-admin-power-bi-security.md
http://go.microsoft.com/fwlink/?LinkId=829185
http://go.microsoft.com/fwlink/?LinkId=829185
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Data Storage Security

User Authentication

The Back End cluster is how authenticated clients interact with the Power BI service. The Back End cluster
manages visualizations, user dashboards, datasets, reports, data storage, data connections, data refresh, and other
aspects of interacting with the Power BI service. The Gateway Role acts as a gateway between user requests and
the Power BI service. Users do not interact directly with any roles other than the Gateway Role. Azure API
Management will eventually handle the Gateway Role.

It is imperative to note that only Azure API Management (APIM) and Gateway (GW) roles are accessible through the
public Internet. They provide authentication, authorization, DDoS protection, Throttling, Load Balancing, Routing, and other
capabilities.

Power BI uses two primary repositories for storing and managing data: data that is uploaded from users is
typically sent to Azure BLOB storage, and all metadata as well as artifacts for the system itself are stored in Azure
SQL Database.

The dotted line in the Back End cluster image, above, clarifies the boundary between the only two components
that are accessible by users (left of the dotted line), and roles that are only accessible by the system. When an
authenticated user connects to the Power BI Service, the connection and any request by the client is accepted and
managed by the Gateway Role (eventually to be handled by Azure API Management), which then interacts on
the user’s behalf with the rest of the Power BI Service. For example, when a client attempts to view a dashboard,
the Gateway Role accepts that request then separately sends a request to the Presentation Role to retrieve the
data needed by the browser to render the dashboard.

Power BI uses Azure Active Directory (AAD) to authenticate users who login to the Power BI service, and in turn,
uses the Power BI login credentials whenever a user attempt to resources that require authentication. Users login
to the Power BI service using the email address used to establish their Power BI account; Power BI uses the that
login email as the effective username, which is passed to resources whenever a user attempts to connect to data.
The effective username is then mapped to a User Principal Name (UPN and resolved to the associated Windows
domain account, against which authentication is applied.

For organizations that used work emails for Power BI login (such as david@contoso.com), the effective username

http://azure.microsoft.com/services/active-directory/
https://msdn.microsoft.com/library/windows/desktop/aa380525(v=vs.85).aspx
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to UPN mapping is straightforward. For organizations that did not use work emails for Power BI login (such as
david@contoso.onmicrosoft.com), mapping between AAD and on-premises credentials will require directory
synchronization to work properly.

Platform security for Power BI also includes multi-tenant environment security, networking security, and the ability
to add additional AAD-based security measures.

For more information, please visit the Microsoft Trust Center.

As described earlier in this article, a user’s Power BI login is used by on-premises Active Directory servers to map
to a UPN for credentials. However, it’s important to note that users are responsible for the data they share: if a
user connects to data sources using her credentials, then shares a report (or dashboard, or dataset) based on that
data, users with whom the dashboard is shared are not authenticated against the original data source, and will be
granted access to the report.

An exception is connections to SQL Server Analysis Services using the on-premises data gateway; dashboards
are cached in Power BI, but access to underlying reports or datasets initiate authentication for the user attempting
to access the report (or dataset), and access will only be granted if the user has sufficient credentials to access the
data. For more information, see On-premises data gateway deep dive.

https://technet.microsoft.com/library/jj573653.aspx
https://www.microsoft.com/trustcenter
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Important considerations

Next steps

If you are having problems signing up for Power BI with your work email address, one potential workaround is to
sign up for an Office 365 trial first and then signing up for Power BI. You will be able to use Power BI even after the
Office 365 trial expires.

You cannot use personal email addresses such as @live.com or @gmail.com with Office 365 or Power BI. For more
information, see What email address can be used with Power BI

1. Sign up for an Office 365 trial on the Office 365 web site.
2. When you complete that signup process, you will be given a new sign in name that looks like

you@yourcompany.onmicrosoft.com. This will be the sign in name you will use for Power BI as well.

NOTENOTE

4. That's it! When you're finished, you will be redirected to Power BI.

3. Sign up for Power BI using this link. If you are prompted, sign in using the sign in name and password you
selected for Office 365 in Step 1.

If you already sign into Power BI or Office 365 with an organization login, you may want to use an InPrivate browser
session to log in with the new account you created.

By using this signup method you are creating a new organizational tenant and you will become the administrator
of the tenant. Because sharing in Power BI is only allowed within a single tenant, you will not be able to share with
users outside this tenant. For example, if you create the tenant yourcompany.onmicrosoft.com in Step 2, you will
not be able to share with users at yourcompany.com. You can add new users to your tenant, then share with them,
as described in this help topic.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-admin-signing-up-for-power-bi-with-a-new-office-365-trial.md
https://go.microsoft.com/fwlink/p/?LinkID=403802
https://portal.office.com/Start/Confirm?Sku=a403ebcc-fae0-4ca2-8c8c-7a907fd6c235&ru=https%3A%2F%2Fapp.powerbi.com%3FredirectedFromSignup%3D1%26noSignUpCheck%3D1
https://support.office.com/en-sg/article/Add-users-individually-to-Office-365---Admin-Help-1970f7d6-03b5-442f-b385-5880b9c256ec?ui=en-US&rs=en-SG&ad=SG


Administering Power BI in your organization
Power BI Premium - what is it?

More questions? Try asking the Power BI Community

http://community.powerbi.com/
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How to determine where your Power BI tenant is located

How the data region is selected

Learn where your Power BI tenant is located and how that location is selected. This is important to understand as it
can impact interactions you have with the service.

The find the region your tenant is in, you can do the following.

1. Select the ? within the Power BI service.
2. Select About Power BI.
3. Look for the value next to Your data is stored in. This is the region you are located in.

The data region is based on the country that was selected when the tenant was first created. This applies to sign up
for Office 365 in addition to Powe rBI as this information is shared. If this is a new tenant, when you sign up, you
will see a country drop down.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-admin-where-is-my-tenant-located.md
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This selection is what drives the location of where your data will be stored. Power BI will pick a data region closest
to this selection.

This selection cannot be changed!

More questions? Try the Power BI Community

http://community.powerbi.com/
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Power BI ExpressRoute Exceptions

Overall Exceptions to Power BI and ExpressRouteOverall Exceptions to Power BI and ExpressRoute

With Power BI and ExpressRoute, you can create a private network connection from your organization to Power
BI (or using an ISP’s colocation facility), bypassing the Internet to better secure your sensitive Power BI data and
connections.

ExpressRoute is an Azure service that lets you create private connections between Azure datacenters (where
Power BI resides) and your on-premises infrastructure, or create private connections between Azure datacenters
and your colocation environment.

You can get more information about ExpressRoute or learn how to sign up.

Power BI is supported in Public peering mode, as described in this FAQ.

Power BI is compliant with ExpressRoute, with a few exceptions where Power BI gets or sends data over the public
Internet. These specific exceptions often include static data, such as browser configuration files that are
downloaded from the nearest Content Delivery Network (CDN) node. There are some broad exceptions which
apply to all of Power BI, and there are some service- or feature-specific exceptions, each of which are documented
in the following sections.

An exception to Power BI and ExpressRoute means that the data being transmitted to or from Power BI goes
over the public Internet, rather than being transmitted over the private ExpressRoute link.

The two overall exceptions to Power BI using ExpressRoute are:

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-admin-power-bi-expressroute.md
https://azure.microsoft.com/services/expressroute/
https://azure.microsoft.com/pricing/details/expressroute/
https://docs.microsoft.com/azure/expressroute/expressroute-faqs
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USER ACTIVITY DESTINATION

Landing page (prior to login) maxcdn.bootstrapcdn.com ; ajax.aspnetcdn.com ;
netdna.bootstrapcdn.com ; cdn.optimizely.com;
google-analytics.com

Login *.mktoresp.com ; *.aadcdn.microsoftonline-p.com ;
*.msecnd.com ; *.localytics.com ; ajax.aspnetcdn.com

Dashboard, report, dataset management (includes maps and
geocoding)

*.localytics.com ; *.virtualearth.net ;
platform.bing.com; powerbi.microsoft.com;
c.microsoft.com; app.powerbi.com; *.powerbi.com;
dc.services.visualstudio.com

Support support.powerbi.com ; powerbi.uservoice.com ;
go.microsoft.com

Power BI Desktop and ExpressRoutePower BI Desktop and ExpressRoute

Static files downloaded from the Content Delivery Network (CDN) and websites
Telemetry data sent over the public Internet

Power BI uses multiple Content Delivery Networks (CDNs) or web sites to efficiently distribute the necessary
static content and files to users based on geographical locale through the public Internet. These static files include
product downloads (such as Power BI Desktop, on-premises data gateway, or Power BI Content Packs from
various independent service providers), browser configuration files that are used to initiate and establish any
subsequent connections with Power BI, as well as the initial secure Power BI login page – the actual credentials are
only sent over ExpressRoute.

Certain telemetry data is also sent over the public Internet and over ExpressRoute. Telemetry data includes usage
statistics and similar data, which is transmitted to services that are used to monitor usage and activity.

When a user initiates a connection to the Power BI service (powerbi.com or through Cortana), the Power BI
Landing Page, the login page, and static files that prepare the browser to connect and interact with Power BI are
retrieved from a CDN or websites, which connects over the public Internet.

Once the login is established, subsequent Power BI data interactions occur over ExpressRoute, with the exception
of certain features and services that depend on public Internet data:

Map visuals require connection and data transmission to the Bing Virtual Earth service or the Bing geocoding
service, each of which is established over the public Internet.
Power BI integration with Cortana requires access to Bing over the public Internet.
When custom links are added by a user, such as an image widget or a video, Power BI requests data based on
the link provided by the user, which may or may not use ExpressRoute.
Users can send feedback to Power BI in text (and optionally images) over the User Voice feedback
mechanism, which uses the public Internet for transmission.
The Bing News content provider downloads content from Bing using the public Internet.
When connecting to apps (for example, content packs), users are often required to enter credentials and
settings using pages provided by the SaaS provider. Such pages may or may not use ExpressRoute.

Power BI Desktop is also ExpressRoute compliant, with a few exceptions that are described in the following list:

Update notifications, used to detect whether users have the most recent version of Power BI Desktop, go over
the public Internet.
Certain telemetry data goes over the public Internet.
Map visuals require connection and data transmission to the Bing Virtual Earth service or the Bing



Power BI PaaS and ExpressRoutePower BI PaaS and ExpressRoute

PAAS ACTIVITY ADDITIONAL DESTINATIONS USED

Public embed (telemetry) c1.microsoft.com

Custom visuals (CDN) *.azureedge.net

Power BI Mobile and ExpressRoutePower BI Mobile and ExpressRoute

On-premises data gateway and ExpressRouteOn-premises data gateway and ExpressRoute

geocoding service, each of which is established over the public Internet.
Get Data from several data sources such as Web or third party SaaS providers go over the public Internet.

Power BI offers APIs and other platform-based features that enable developers to create customized Power BI
solutions and apps. The following services, in addition to telemetry and CDN data discussed earlier in this topic, are
used when transmitting Power BI PaaS data over the public Internet:

Some custom visuals are created by third-parties, some are created by Microsoft. These may or may not use
ExpressRoute.

This document does not cover the use of Power BI Mobile apps.

When an on-premises data gateway is used with Power BI, transmissions are ExpressRoute compliant, with the
exception of the user activities documented in the Power BI SaaS Application and ExpressRoute section found
earlier in this topic.



Understanding the Power BI admin role
1/30/2018 • 2 min to read • Edit Online

Using the Office 365 Admin Center to assign a role

Learn how you can use the Power BI admin role within your organization.

The Power BI Service Administrator role can be assigned to users who should have access to the Power BI Admin
Portal without also granting them other Office 365 administrative access. For example, the Global Admin role. It is
meant for those tasked with administering Power BI for their organization.

Office 365 user admins can assign users to be Power BI admins within the Office 365 Admin center, or via
PowerShell script. Once a user is assigned, they'll be able to access the Power BI admin portal. There, they will
have access to tenant-wide usage metrics, and can control tenant-wide usage of Power BI features.

To assign users to the Power BI Administrator role within the Office 365 Admin Center, you can do the following.

1. Browse to the Office 365 Admin Center and select Users > Active Users.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-admin-role.md


2. Select the user that you want to assign the role to.

5. Select Save.

3. Select Edit for roles.

4. Select Customized administrator > Power BI service administrator

You should see Power BI service administrator listed for the role of that user. They will now have access to the
Power BI admin portal.



Using PowerShell to assign a role

Download Azure AD PowerShell moduleDownload Azure AD PowerShell module

Command to add role to memberCommand to add role to member

PS C:\Windows\system32> Get-AzureADDirectoryRole

ObjectId                             DisplayName                        Description
--------                             -----------                        -----------
00f79122-c45d-436d-8d4a-2c0c6ca246bf Power BI Service Administrator     Full access in the Power BI Service.
250d1222-4bc0-4b4b-8466-5d5765d14af9 Helpdesk Administrator             Helpdesk Administrator has access to 
perform..
3ddec257-efdc-423d-9d24-b7cf29e0c86b Directory Synchronization Accounts Directory Synchronization Accounts
50daa576-896c-4bf3-a84e-1d9d1875c7a7 Company Administrator              Company Administrator role has full 
access t..
6a452384-6eb9-4793-8782-f4e7313b4dfd Device Administrators              Device Administrators
9900b7db-35d9-4e56-a8e3-c5026cac3a11 AdHoc License Administrator        Allows access manage AdHoc license.
a3631cce-16ce-47a3-bbe1-79b9774a0570 Directory Readers                  Allows access to various read only 
tasks in ..
f727e2f3-0829-41a7-8c5c-5af83c37f57b Email Verified User Creator        Allows creation of new email verified 
users.

PS C:\Windows\system32> Get-AzureADUser -SearchString 'tim@contoso.com'

ObjectId                             DisplayName UserPrincipalName      UserType
--------                             ----------- -----------------      --------
6a2bfca2-98ba-413a-be61-6e4bbb8b8a4c Tim         tim@contoso.com        Member

PARAMETER DESCRIPTION

ObjectId The Role ObjectId.

RefObjectId The members ObjectId.

Add-AzureADDirectoryRoleMember -ObjectId 00f79122-c45d-436d-8d4a-2c0c6ca246bf -RefObjectId 6a2bfca2-98ba-413a-
be61-6e4bbb8b8a4c

To run the PowerShell command, you must have the Azure Active Directory PowerShell Module installed.

Download Azure Active Directory PowerShell Version 2

Download Azure Active Directory PowerShell Version 1.1.166.0 GA

Azure AD PowerShell v2 Command

You will need to get the ObjectId for the Power BI Service Administrator role. You can run Get-
AzureADDirectoryRole to get the ObjectId

In this case, the role objectid is 00f79122-c45d-436d-8d4a-2c0c6ca246bf.

You will also need to know the users ObjectID. You can find that by running Get-AzureADUser.

To add the member to the role, run Add-AzureADDirectoryRoleMember.

Azure AD PowerShell v1 Command

To add a member to a role using the Azure AD v1 cmdlets, you will want to run the Add-MsolRoleMember
command.

https://github.com/Azure/azure-docs-powershell-azuread/blob/master/Azure AD Cmdlets/AzureAD/index.md
http://connect.microsoft.com/site1164/Downloads/DownloadDetails.aspx?DownloadID=59185
https://docs.microsoft.com/powershell/azuread/v2/get-azureaddirectoryrole
https://docs.microsoft.com/powershell/azuread/v2/get-azureaduser
https://docs.microsoft.com/powershell/azuread/v2/add-azureaddirectoryrolemember
https://docs.microsoft.com/powershell/msonline/v1/add-msolrolemember


Add-MsolRoleMember -RoleMemberEmailAddress "tim@contoso.com" -RoleName "Power BI Service Administrator"

Limitations and considerations

Next steps

The Power BI service administrator role does not provide access to the following.

Ability to modify users and licenses within the Office 365 Admin Center
Access to the audit logs. For more information, see Using auditing within your organization.

Power BI admin portal
Add-AzureADDirectoryRoleMember
Add-MsolRoleMember
Auditing Power BI in your organization
Administering Power BI in your Organization

More questions? Try asking the Power BI Community

https://docs.microsoft.com/powershell/azuread/v2/add-azureaddirectoryrolemember
https://docs.microsoft.com/powershell/msonline/v1/add-msolrolemember
http://community.powerbi.com/
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How to get to the admin portal

The admin portal allows for tenant management of Power BI in your organization. It includes items such as usage
metrics, access to the Office 365 admin center, and settings.

Tenant management of Power BI for your company is done through the Power BI admin portal. The admin portal
is accessible to all users who are Global Admins in Office 365 or have been assigned the Power BI service
administrator role. For more information about the Power BI service administrator role, see Understanding the
Power BI admin role.

All users will see Admin portal under the gear icon. If they are not an admin, they will only see the Premium
settings section, and they will only see the capacities they have rights to manage.

Your account needs to be marked as a Global Admin, within Office 365 or Azure Active Directory, or have been
assigned the Power BI service administrator role, to get access to the Power BI admin portal. For more
information about the Power BI service administrator role, see Understanding the Power BI admin role. To get to
the Power BI admin portal, do the following.

1. Select the settings gear in the top right of the Power BI service.
2. Select Admin Portal.

Within the portal, there are five tabs. These are described below.

Usage metrics
Users
Audit logs
Tenant settings
Premium settings
Embed codes

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-admin-portal.md


 Usage metrics
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The first tab, in the admin portal, is Usage metrics. The usage metrics report gives you the ability to monitor
usage within Power BI for your organization. It also provides the ability to see which users, and groups, are the
most active within Power BI for your organization.

The first time you access the dashboard, or after you visit again after a long period of not viewing the dashboard, you'll
likely see a loading screen while we load the dashboard.

Once the dashboard loads, you will see two sections of tiles. The first section includes usage data for individual
users and the second section has similar information for groups in your organization.

Here’s a breakdown of what you will see in each tile:

Distinct count of all dashboards, reports, and datasets in the user workspace

Most consumed dashboard by number of users who can access it. For example, if you have a dashboard
that you shared with 3 users, and you also added it to a content pack two different users connected to, its
count would be 6 (1 + 3 + 2)



The most popular content users connected to. This would be anything the users could reach through the
Get Data process, so SaaS content packs, Organizational content packs, files or databases.

A view of your top users based on how many dashboards they have, both dashboards they created
themselves and dashboards shared to them.

A view of your top users based on how many reports they have

The second section shows the same type of information, but based on groups. This will let you see which groups
in your organization are most active and what kind of information they are using.

With this information, you will be able to get real insights into how people are using Power BI across your



 

 

 

Users

Audit logs

Tenant settings

organization, and be able to recognize those users, and groups, who are very active in your organization.

The second tab, in the admin portal, is Manage Users. User management, for Power BI, is done in the Office 365
admin center, so this section allows you to quickly reach the area to manage users, admins, and groups within
Office 365.

When you click Go to O365 Admin Center, you go directly to the Office 365 admin center landing page, to
manage the users of your tenant.

The third tab, in the admin portal, is Audit logs. The logs are located within the Office 365 Security &
Compliance center. This section allows you to quickly access that area within Office 365.

For more information about audit logs, see Auditing Power BI in your organization

The third tab, in the admin portal, is Tenant settings. Tenant settings give you more control over what features
are made available to your organization. If you have concerns around sensitive data, some of our features may
not be right for your organization, or you may only want a given feature to be available to a specific group. If this
is the case, you can switch it off in your tenant.
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Disabled for the entire organizationDisabled for the entire organization

Enabled for the entire organizationEnabled for the entire organization

Enabled for a subset of the organizationEnabled for a subset of the organization

It can take up to 10 minutes for the setting to take effect for everyone in your tenant.

Settings can have three states based on the settings that you supplied.

You can disable a feature and make it so users will not be able to use it.

You can enable a feature for the entire organization which will let all users have access to that feature.

You can also enable a feature for a portion of your organization. This can happen in a few different ways. You can
enable it for your entire organization except for a specific group of users.



Export and sharing settings
Share content to external usersShare content to external users

Publish to webPublish to web

You could also enable the feature only for a specific group of users and also disable it for a group of users. This
would make sure that certain users do not have access to the feature even if they are in the allowed group.

Users in the organization can share dashboards with users outside the organization.

Users in the organization can publish reports to the web. Learn more



FEATURE
ENABLED FOR ENTIRE
ORGANIZATION

DISABLED FOR ENTIRE
ORGANIZATION SPECIFIC SECURITY GROUPS

Publish to web under
report's File menu.

Enabled for all Not visable for all Only visable for authorized
users or groups.

Manage embed codes
under Settings

Enabled for all Enabled for all Enabled for all

* Delete option only for
authorized users or groups.
* Get codes enabled for all.

Embed codes within admin
portal

Status will reflect one of the
following:
* Active
* Not supported
* Blocked

Status will display Disabled Status will reflect one of the
following:
* Active
* Not supported
* Blocked

If a user is not authorized
based on the tenant setting,
status will display as
infringed.

Existing published reports All enabled All disabled Reports continue to render
for all.

Export dataExport data
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Export reports as PowerPoint presentationsExport reports as PowerPoint presentations

Users will see different options in the UI based on what the publish to web setting is.

Users in the organization can export data from a tile or visualization. Learn more

Disabling Export Data will also prevent users from using the Analyze in Excel feature, as well as using the Power BI
service live connection.

Users in the organization can export Power BI reports as PowerPoint files. Learn more



Print dashboards and reportsPrint dashboards and reports

Content pack settings
Publish content packs to the entire organizationPublish content packs to the entire organization

Users in the organization can print dashboards and reports. Learn more

Users in the organization can publish content packs to the entire organization.



Create template organizational content packsCreate template organizational content packs

Integration settings
Ask questions about data using CortanaAsk questions about data using Cortana

NOTENOTE

Use Analyze in Excel with on-premises datasetsUse Analyze in Excel with on-premises datasets
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User ArcGIS Maps for Power BI (Preview)User ArcGIS Maps for Power BI (Preview)

Custom visuals settings
Enable custom visuals for the entire organizationEnable custom visuals for the entire organization

Users in the organization can create template content packs that use datasets built on one data source in Power
BI Desktop.

Users in the organization can ask questions about their data using Cortana.

This settings applies to the entire organization and cannot be limited to specific groups.

Users in the organization can use Excel to view and interact with on-premises Power BI datasets. Learn more

Disabling Export Data will also prevent users from using the Analyze in Excel feature.

Users in the organization can use the ArcGIS Maps for Power BI (Preview) visualization provided by Esri. Learn
more

Users in the organization can interact with and share custom visuals. Learn more
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R visuals settings
Interact with an dshare R visualsInteract with an dshare R visuals
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Audit settings
Create audit logs for internal activity auditing and complianceCreate audit logs for internal activity auditing and compliance
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Dashboard settings
Data classification for dashboardsData classification for dashboards
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Developer settings
Embed content in appsEmbed content in apps

Premium settings

This setting applies to the entire organization and cannot be limited to specific groups.

Users in the organization can interact with and share visuals created with R scripts. Learn more

This settings applies to the entire organization and cannot be limited to specific groups.

Users in the organization can use auditing to monitor actions taken in Power BI by other users in the
organization. Learn more

This setting needs to be enabled for audit log entries to be recorded.

This settings applies to the entire organization and cannot be limited to specific groups.

Users in the organization can tag dashboards with classifications indicating dashboard security levels. Learn
more

This settings applies to the entire organization and cannot be limited to specific groups.

Users in the organization can embed Power BI dashboards and reports in Software as a Service (SaaS)
applications. Disabling this setting will prevent users from being able to use the REST APIs to embed Power BI
content within their application.

The Premium settings tab allows you to manage any Power BI Premium capacity that has been purchased for
your organization. All users within your organization will see the Premium settings tab, but will only see contents
within it, if they are assigned as either Capacity admin or a user that has assignment permissions. If a user does
not have any permissions, they will see the following message.



 Embed codes

Next steps

For more information about to manage Premium settings, see Manage Power BI Premium.

As an administrator, you can view the embed codes that are generated for your tenant. You have the actions of
viewing the report and deleting the embed code to revoke it.

Understanding the Power BI admin role
Auditing Power BI in your organization
Manage Power BI Premium
Administering Power BI in your Organization

More questions? Try asking the Power BI Community

http://community.powerbi.com/


Using auditing within your organization
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Requirements

Enabling auditing functionality in the Power BI admin portal

Learn how you can use auditing with Power BI to monitor and investigate actions taken. You can use the Security
and Compliance Center or use PowerShell.

Knowing who is taking what action on which item in your Power BI tenant can be critical in helping your
organization fulfill its requirements, such as meeting regulatory compliance and records management.

You can filter the audit data by date range, user, dashboard, report, dataset and activity type. You can also
download the activities in a csv (comma separated value) file to analyze offline.

The auditing feature in Power BI is in preview and is available in all data regions.

You must meet these requirements to access audit logs:

To access the auditing section of the Office 365 Security & Compliance Center, you must have an Exchange
Online license (included with Office 365 Enterprise E3 and E5 subscriptions).
You must either be a global admin or have an Exchange admin role that provides access to the audit log.

Exchange admin roles are controlled through the Exchange admin center. For more information, see
Permissions in Exchange Online.

If you have access to the audit log but are not a global admin or Power BI Service admin, you will not have
access to the Power BI Admin portal. In this case, you must get a direct link to the Office 365 Security &
Compliance Center.

You will need to enable auditing for your organization in order to work with the reports. You can do this within
the tenant settings of the admin portal.

1. Select the gear icon in the upper right.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-admin-auditing.md
https://technet.microsoft.com/library/jj200692(v=exchg.150).aspx
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Accessing your audit logs

2. Select Admin Portal.

3. Select Tenant settings.

4. Switch on Create audit logs for internal activity auditing and compliance purposes.

5. Select Apply.

Power BI will start logging various activities that your users perform in Power BI. The logs take up to 48 hours to
show up in the O365 Security & Compliance Center. For more information about what activities are logged, see
List of activities audited by Power BI.

To enable auditing for Power BI in your tenant, you need at least one exchange mailbox license in your tenant.

To audit your Power BI logs, you must visit the O365 Security & Compliance Center.

1. Select the gear icon in the upper right.

2. Select Admin Portal.
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Search only Power BI activities

3. Select Audit logs.

4. Select Go to O365 Admin Center.

Alternatively, you can browse to Office 365 | Security & Compliance.

To provide non-administrator accounts with access to the audit log, you will need to assign permissions within the
Exchange Online Admin Center. For example, you could assign a user to an existing role group, such as Organization
Management, or you could create a new role group with the Audit Logs role. For more information, see Permissions in
Exchange Online.

You can restrict results to only Power BI activities by doing the following.

1. On the Audit log search page, select the drop down for Activities under Search.

2. Select PowerBI activities.

https://protection.office.com/#/unifiedauditlog
https://technet.microsoft.com/library/jj200692(v=exchg.150).aspx


Search the audit logs by date
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3. Select anywhere outside of the selection box to close it.

Your searches will now be filtered to only Power BI activities.

You can search the logs by date range using the “Start date” and “End date” field. The last seven days are selected
by default. The date and time are presented in Coordinated Universal Time (UTC) format. The maximum date
range that you can specify is 90 days. An error is displayed if the selected date range is greater than 90 days.

If you're using the maximum date range of 90 days, select the current time for the Start date. Otherwise, you'll receive an
error saying that the start date is earlier than the end date. If you've turned on auditing within the last 90 days, the
maximum date range can't start before the date that auditing was turned on.



Search the audit logs by users

Viewing search results

You can search for audit log entries for activities performed by specific users. To do this, enter one or more user
names in the “Users” field. This would be the username that they sign into Power BI with. It looks like an email
address. Leave this box blank to return entries for all users (and service accounts) in your organization.
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COLUMN DEFINITION

Date The date and time (in UTC format) when the event occurred.

IP address The IP address of the device that was used when the activity
was logged. The IP address is displayed in either an IPv4 or
IPv6 address format.

User The user (or service account) who performed the action that
triggered the event.

Activity The activity performed by the user. This value corresponds to
the activities that you selected in the Activitiesdrop down list.
For an event from the Exchange admin audit log, the value in
this column is an Exchange cmdlet.

Item The object that was created or modified as a result of the
corresponding activity. For example, the file that was viewed
or modified or the user account that was updated. Not all
activities have a value in this column.

Detail Additional detail about an activity. Again, not all activities will
have a value.

NOTENOTE

View the details for an event

PARAMETER OR EVENT DESCRIPTION ADDITIONAL DETAILS

Downloaded Power BI report This activity is logged every time a
report is downloaded

Report Name, Dataset Name

Create report This activity is logged every time a new
report is created.

Report Name, Dataset Name

Once you hit the search button, the search results are loaded and after a few moments they are displayed under
Results. When the search is finished, the number of results found is displayed.

A maximum of 1000 events will be displayed; if more than 1000 events meet the search criteria, the newest 1000 events
are displayed.

The results contain the following information about each event returned by the search.

Select a column header under Results to sort the results. You can sort the results from A to Z or Z to A. Click the Date
header to sort the results from oldest to newest or newest to oldest.

You can view more details about an event by selecting the event record in the list of search results. A details page
is displayed that contains the detailed properties from the event record. The properties that are displayed depend
on the Office 365 service in which the event occurs. To display additional details, select More information.

The following table provides details on that you may see displayed.



Edit Report This activity is logged every time a
report is edited.

Report Name, Dataset Name

Create dataset This activity is logged every time a
dataset is created.

Dataset Name, DataConnectivityMode

Delete Dataset This activity is logged every time a
dataset is deleted.

Dataset Name, DataConnectivityMode

Create Power BI app This acitivity is logged every time a
Power BI app is created

App name, Permissions, Workspace
Name

Install Power BI app This activity is logged every time a
Power AI app installed

App name

Update Power BI app This activity is logged every time a
Power app in updated

App name, Permissions, Workspace
Name

Started Power BI extended trial This activity is logged every time an
user accepts the extended pro trial that
runs until May 31 2018

Analyzed Power BI dataset This activity is logged every time a
Power BI dataset is analyzed in Excel.

Created Power BI gateway This activity is logged every time a new
gateway is created.

Gateway Name, Gateway Type

Deleted Power BI gateway This activity is logged every time a
gateway is deleted.

Gateway Name, Gateway Type

Added Data source to Power BI
gateway

This activity is logged every time a data
source in added to the gateway

Gateway Name, Gateway Type,
Datasource Name, Datasource Type

Removed data source from Power BI
gateway

This activity is logged every time a data
source is removed from a gateway

Gateway Name, Gateway Type,
Datasource Name, Datasource Type

Changed Power BI gateway admins This activity is logged every time the
admins of a gateway are changed
(added/removed)

Gateway Name, Users Added, Users
Removed

Changed Power IB gateway data
source users

This activity is logged every time the
users of a gateway are changed
(added/removed)

Gateway Name, Users Added, Users
Removed

SetScheduledRefresh This activity is logged every time a new
refresh is scheduled for a dataset

Dataset Name, Refresh Frequency (in
minutes)

PARAMETER OR EVENT DESCRIPTION ADDITIONAL DETAILS

Using PowerShell to search
You can use PowerShell to access the audit logs based on your login. This is done by accessing Exchange Online.
Here is an example of a command to pull Power BI audit log entries.
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Set-ExecutionPolicy RemoteSigned

$UserCredential = Get-Credential

$Session = New-PSSession -ConfigurationName Microsoft.Exchange -ConnectionUri 
https://outlook.office365.com/powershell-liveid/ -Credential $UserCredential -Authentication Basic -
AllowRedirection

Import-PSSession $Session
Search-UnifiedAuditLog -StartDate 9/11/2016 -EndDate 9/15/2016 -RecordType PowerBI -ResultSize 1000 | Format-
Table | More

Export the Power BI audit log

Record and user types

List of activities audited by Power BI
ACTIVITY DESCRIPTION ADDITIONAL DETAILS

CreateDashboard This activity is logged every time a new
dashboard is created.

- Dashboard name.

In order to use the New-PSSession command, your account needs to have an Exchange Online license assigned to it and
you need access to the audit log for your tenant.

For more information on connecting to Exchange Online, see Connect to Exchange Online PowerShell.

For more information about parameters and usage of the Search-UnifiedAuditLog command, see Search-
UnifiedAuditLog.

To see an example of using PowerShell to search the audit log and then assign Power BI Pro licenses based on
entries, see Using Power BI audit log and PowerShell to assign Power BI Pro licenses.

You can export the Power BI audit log to a csv file.

1. Select Export results.

2. Select either Save loaded results or Download all results.

Audit log entries will have a RecordType and UserType as part of the details for the entry. All Power BI entries will
have a RecordType of 20.

For a full listing, see Detailed properties in the Office 365 audit log

https://technet.microsoft.com/library/jj984289(v=exchg.160).aspx
https://technet.microsoft.com/library/mt238501(v=exchg.160).aspx
https://powerbi.microsoft.com/blog/using-power-bi-audit-log-and-powershell-to-assign-power-bi-pro-licenses/
https://support.office.com/article/Detailed-properties-in-the-Office-365-audit-log-ce004100-9e7f-443e-942b-9b04098fcfc3


EditDashboard This activity is logged every time a
dashboard is renamed.

- Dashboard name.

DeleteDashboard This activity is logged every time a
dashboard is deleted.

- Dashboard name.

PrintDashboard This event is logged every time that a
dashboard is printed.

- Dashboard name.
- Dataset name

ShareDashboard This activity is logged every time a
dashboard is shared.

- Dashboard name.
-Recipient Email.
- Dataset name.
- Reshare permissions.

ViewDashboard This activity is logged every time a
dashboard is viewed.

- Dashboard name.

ExportTile This event is logged every time data is
exported from a dashboard tile.

- Tile name.
- Dataset name.

DeleteReport This activity is logged every time a
report is deleted.

- Report name.

ExportReport This event is logged every time data is
exported from a report tile.

- Report name.
- Dataset name.

PrintReport This event is logged every time that a
report is printed.

- Report name.
- Dataset name.

PublishToWebReport This event is logged every time that a
report is Published To Web.

- Report Name.
- Dataset name.

ViewReport This activity is logged every time a
report is viewed.

- Report name.

ExploreDataset This event is logged every time you
explore a dataset by selected it.

- Dataset name

DeleteDataset This event is logged every time a
dataset is deleted.

- Dataset name.

CreateOrgApp This activity is logged every time an
organizational content pack is created.

- Organizational Content Pack name.
- Dashbaord names.
- Report names.
- Dataset names.

CreateGroup This activity is fired every time a group
is created.

- Group name.

AddGroupMembers This activity is logged every time a
member is added to a Power BI group
workspace.

- Group name.
- Email addresses.

ACTIVITY DESCRIPTION ADDITIONAL DETAILS



UpdatedAdminFeatureSwitch This event is logged every time an
admin feature switch is changed.

- Switch name.
- New switch state.

OptInForProTrial This event is logged when a user
choses to try Power BI Pro within the
service.

- email address

ACTIVITY DESCRIPTION ADDITIONAL DETAILS

Next steps
Power BI Admin Portal
Power BI Premium - what is it?
Purchasing Power BI Pro
Permissions in Exchange Online
Connect to Exchange Online PowerShell
Search-UnifiedAuditLog
Detailed properties in the Office 365 audit log

More questions? Try asking the Power BI Community

https://technet.microsoft.com/library/jj200692(v=exchg.150).aspx
https://technet.microsoft.com/library/jj984289(v=exchg.160).aspx
https://technet.microsoft.com/library/mt238501(v=exchg.160).aspx
https://support.office.com/article/Detailed-properties-in-the-Office-365-audit-log-ce004100-9e7f-443e-942b-9b04098fcfc3
http://community.powerbi.com/


Distribute Power BI content to external guest users
with Azure AD B2B
1/30/2018 • 2 min to read • Edit Online

NOTENOTE

Invite guest users

Planned invitesPlanned invites

Power BI integrates with Azure Active Directory Business-to-business (Azure AD B2B) to allow secure distribution of
Power BI content to guest users outside the organization, while still maintaining control over the internal data.

This feature is not currently available with the Power BI mobile apps. On a mobile device, you can view Power BI content
shared using Azure AD B2B in a browser.

There are two ways to invite guest users to your Power BI tenant: planned invites or ad-hoc invites. Invitations are
only needed the first time an external user is invited to your organization.

A planned invite is performed within the Microsoft Azure Portal in Azure AD or using PowerShell. This is the option
to use if you know which users must be invited.

Creating the guest users in the Azure AD portal requires that you be a tenant admin.

1. Navigate to the Azure Portal and select Azure Active Directory.

2. Navigate to Users and groups > All users > New guest user.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-admin-azure-ad-b2b.md
https://portal.azure.com


3. Enter the email address and personal message.

4. Select Invite.

To invite more than one guest user, use PowerShell. For more information, see Azure Active Directory B2B
collaboration code and PowerShell samples.

The guest user needs to select Get Started in the email invitation they receive. The guest user is then added to the
tenant.

https://docs.microsoft.com/azure/active-directory/active-directory-b2b-code-samples


Ad-hoc invitesAd-hoc invites
To perform an invite at anytime, add the external user to the access list of an app when publishing it.

The guest user will receive an email indicating the app has been shared with them.



Licensing

Use Power BI PremiumUse Power BI Premium

Assign Power BI Pro license to guest userAssign Power BI Pro license to guest user
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The guest user must sign in with their organization email address. They will be prompted to accept the invitation
after signing in. After sign in, the guest user is redirected to the app content. To return to the app, bookmark the
link, or save the email.

The guest user will need to have the proper licensing in place to view the app that was shared. There are three
options to accomplish this.

Assigning the app workspace to Power BI Premium capacity will allow the guest user to use the app without
requiring a Power BI Pro license. Power BI Premium also allows for apps to take advantage of other capabilities like
increased refresh rates, dedicated capacity and large model sizes.

Assigning a Power BI Pro license to the guest user, within your tenant, allows that guest user to view the content.

A Power BI Pro license from your tenant applies to guest users only when they access content within your tenant.



Guest user brings their own Power BI Pro licenseGuest user brings their own Power BI Pro license

Limitations

Next steps

The guest user already has a Power BI Pro license assigned within their tenant.

External B2B guests are limited to consumption of content only. External B2B guests can view apps, dashboards,
reports, export data and create email subscriptions for dashboards and reports. They can't access workspaces or
publish their own content.
This feature is not currently available with the Power BI mobile apps. On a mobile device, you can view Power BI
content shared using Azure AD B2B in a browser.
Using guest users with Power BI is not supported within sovereign clouds (government).

For more detailed information, including how row-level security works, check out the whitepaper.

For information regarding Azure Active Directory B2B, see What is Azure AD B2B collaboration?

https://aka.ms/powerbi-b2b-whitepaper
https://docs.microsoft.com/azure/active-directory/active-directory-b2b-what-is-azure-ad-b2b


Find Power BI users that have signed in
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Requirements

Using the Azure portal to view sign-ins

If you are a tenant admin, and want to see who has signed into Power BI, you can use the Azure Active Directory
access and usage reports to gain visibility.

You can access the activity report within the new and the classic Azure Active Directory (Azure AD) portals. While
the video above uses the classic portal as an example, this article will highlight the new portal.

This activity report includes both Power BI (Free) and Pro users but does not identify them by which license they have.

The following are requirements to view the sign-in activity report.

Users in the Global Admin, Security Admin or Security Reader role can access the access the data.
Any user (non-admins) can access their own sign-ins.
Your tenant must have an Azure AD Premium license associated with it to see the all up sign-in activity report.

You can use the Azure AD portal to view sign-in activity.

1. Browse to the Azure portal and select Azure Active Directory.
2. Under Activity, select Sign-ins.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-admin-access-usage.md
https://docs.microsoft.com/azure/active-directory/active-directory-reporting-activity-sign-ins
https://docs.microsoft.com/azure/active-directory/active-directory-view-access-usage-reports


Export the data

Download csvDownload csv

PowerShellPowerShell
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3. Filter the application by either Microsoft Power BI or Power BI Gateway and select Apply.

Microsoft Power BI is for sign-in activity related to the service whereas Power BI Gateway are specific
sign-ins for the on-premises data gateway.

You have two options to export the sign-in data. This can be done by either downloading a csv file or you can use
PowerShell.

Within the Activity screen, you can select Download in the toolbar. This will download a csv file for the currently
filtered data.

You can use PowerShell to export the sign-in data. A sample is available within the Azure AD documentation.

For the PowerShell sample to work, be sure to follow the prerequisites to access the Azure AD reporting API.

https://docs.microsoft.com/azure/active-directory/active-directory-reporting-api-sign-in-activity-samples#powershell-script
https://docs.microsoft.com/en-us/azure/active-directory/active-directory-reporting-api-prerequisites


Data retention

Next steps

Sign-in related data can be available for up to 30 days. For more information, see Azure Active Directory report
retention policies.

Sign-in activity reports in the Azure Active Directory portal (New Portal)
View your access and usage reports (Classic Portal)
Sign-in sample PowerShell script
Azure Active Directory report retention policies
Using auditing within your organization
Extended Pro Trial activation

More questions? Try asking the Power BI Community

https://docs.microsoft.com/azure/active-directory/active-directory-reporting-retention
https://docs.microsoft.com/azure/active-directory/active-directory-reporting-activity-sign-ins
https://docs.microsoft.com/azure/active-directory/active-directory-view-access-usage-reports#view-or-download-a-report
https://docs.microsoft.com/azure/active-directory/active-directory-reporting-api-sign-in-activity-samples#powershell-script
https://docs.microsoft.com/azure/active-directory/active-directory-reporting-retention
https://community.powerbi.com/


Row-level security (RLS) with Power BI
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Define roles and rules within Power BI Desktop

Row-level security (RLS) with Power BI can be used to restrict data access for given users. Filters restrict data at
the row level. You can define filters within roles.

You can configure RLS for data models imported into Power BI with Power BI Desktop. You can also configure
RLS on datasets that are using DirectQuery, such as SQL Server. Previously, you were only able to implement RLS
within on-premises Analysis Services models outside of Power BI. For Analysis Services live connections, you
configure Row-level security on the on-premises model. The security option will not show up for live connection
datasets.

You can define roles and rules within Power BI Desktop. When you publish to Power BI, it will also publish the role
definitions.

To define security roles, you can do the following.

NOTENOTE

2. Select the Modeling tab.

1. Import data into your Power BI Desktop report, or configure a DirectQuery connection.

You cannot define roles within Power BI Desktop for Analysis Services live connections. You will need to do that
within the Analysis Services model.

3. Select Manage Roles.

4. Select Create.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-admin-rls.md


5. Provide a name for the role.
6. Select the table that you want to apply a DAX rule.

NOTENOTE

9. Select Save.

7. Enter the DAX expressions. This expression should return a true or false. For example: [Entity ID] = “Value”.

You can use username() within this expression. Be aware that username() will have the format of
DOMAIN\username within Power BI Desktop. Within the Power BI service, it will be in the format of the user's UPN.
Alternatively, you can use userprincipalname() which will always return the user in the format of their user principal
name.

8. After you have created the DAX expression, you can select the check above the expression box to validate
the expression.

You cannot assign users to a role within Power BI Desktop. This is done within the Power BI service. You can
enable dynamic security within Power BI Desktop by making use of the username() or userprincipalname() DAX
functions and having the proper relationships configured.

By default, row-level security filtering uses single-directional filters, regardless of whether the relationships are set
to single direction or bi-directional. You can manually enable bi-directional cross-filter with row-level security by
selecting the relationship and checking the Apply security filter in both directions checkbox. You should check
this box when implementing dynamic row-level security, wherein you provide row-level security based on user
name or login ID.

For more information, see Bidirectional cross-filtering using DirectQuery in Power BI Desktop and the Securing
the Tabular BI Semantic Model technical article.

https://docs.microsoft.com/en-us/sql/analysis-services/supplemental-lesson-implement-dynamic-security-by-using-row-filters
http://download.microsoft.com/download/D/2/0/D20E1C5F-72EA-4505-9F26-FEF9550EFD44/Securing the Tabular BI Semantic Model.docx


  Validating the role within Power BI Desktop

NOTENOTE

Manage security on your model

After you have created your role, you can test the results of the role within Power BI Desktop. To do this, select
View As Roles.

The View as roles dialog allows you to change the view of what you are seeing for that specific user or role. You
will see the roles you have created.

You select the role you created and then select OK to apply that role to what you are viewing. The reports will only
render the data relevant for that role.

You can also select Other user and supply a given user. It is best to supply the User Principal Name (UPN) as that
is what the Power BI service will use. Select OK and the reports will render based on what that user can see.

Within Power BI Desktop, this will only display different results if you are using dynamic security based on your DAX
expressions.

To manage security on your data model, you will want to do the following.

1. Select the ellipse (…) for a dataset.
2. Select Security.



Working with members
Add membersAdd members

Remove membersRemove members

This will take you to the RLS page for you to add members to a role you created in Power BI Desktop. Only the
owners of the dataset will see Security available. If the dataset is in a Group, only Administrators of the group will
see the security option.

You can only create or modify roles within Power BI Desktop.

You can add a member to the role by typing in the email address, or name, of the user, security group or
distribution list you want to add. This member has to be within your organization. You cannot add Groups created
within Power BI.

You can also see how many members are part of the role by the number in parenthesis next to the role name, or
next to Members.

You can remove members by selecting the X next to their name.



Validating the role within the Power BI service

Using the username() or userprincipalname() DAX function

You can validate that the role you defined is working correctly by testing the role.

1. Select the ellipsis (...) next to the role.
2. Select Test data as role

You will then see reports that are available for this role. Dashboards are not presented in this view. In the blue bar
above, you will see what is being applied.

You can test other roles, or combination of roles, by selecting Now viewing as.

You can choose to view data as a specific person, or you can select a combination of available roles to validate
they are working.

To return to normal viewing, select Back to Row-Level Security.

You can take advantage of the DAX functions username() or userprincipalname() within your dataset. You can use
them within expressions in Power BI Desktop. When you publish your model, it will be used within the Power BI
service.



Using RLS with app workspaces in Power BI

WARNINGWARNING

Limitations

Known issues

FAQ

Within Power BI Desktop, username() will return a user in the format of DOMAIN\User and userprincipalname()
will return a user in the format of user@contoso.com.

Within the Power BI service, username() and userprincipalname() will both return the user's User Principal Name
(UPN). This looks similar to an email address.

If you publish your Power BI Desktop report to an app workspace within the Power BI service, the roles will be
applied to read-only members. You will need to indicate that members can only view Power BI content within the
app workspace settings.

If you have configured the app workspace so that members have edit permissions, the RLS roles will not be applied to
them. Users will be able to see all of the data.

Here is a list of the current limitations for row-level security on cloud models.

If you previously had roles/rules defined within the Power BI service, you will need to recreate them within
Power BI Desktop.
You can define RLS only on the datasets created using Power BI Desktop client. If you want to enable RLS for
datasets created with Excel, you will need to convert your files into PBIX files first. Learn more
Only ETL, and DirectQuery connections are supported. Live connections to Analysis Services are handled in the
on-premises model.
Q&A and Cortana is not supported with RLS at this time. You will not see the Q&A input box for dashboards if
all models have RLS configured. This is on the roadmap, but a timeline is not available.
External sharing is not currently supported with datasets that use RLS.
For any given model, the maximum number of Azure AD principals (i.e. individual users or security groups)
that can be assigned to security roles is 1,000. To assign large numbers of users to roles, be sure to assign
security groups, rather than individual users.

There is a known issue where you will receive an error message when trying to publish from Power BI Desktop if
it was previously published. The scenario is as follows.

1. Anna has a dataset that is publised to the Power BI service and has configured RLS.
2. Anna updates the report in Power BI Desktop and re-publishes.
3. Anna will receive an error.

Workaround: Re-publish the Power BI Desktop file from the Power BI service until this issue is resolved. You can
do that by select Get Data > Files.

Question: What if I had previously created roles/rules for a dataset in the Power BI service? Will they still work if I



Next steps

do nothing?
Answer: No. Visuals will not render properly. You will have to re-create the roles/rules within Power BI Desktop
and then published to the Power BI service.

Question: Can I creates these roles for Analysis Services data sources?
Answer: You can if you imported the data into Power BI Desktop. If you are using a live connection, you will not
be able to configure RLS within the Power BI service. This is defined within the Analysis Services model on-
premises.

Question: Can I use RLS to limit the columns or measures accessible by my users?
Answer: No. If a user has access to a particular row of data, they can see all the columns of data for that row.

Question: Does RLS allow me to hide detailed data but give access to data summarized in visuals?
Answer: No, you secure individual rows of data but users can always see either the details or summarized data.

Row-level security (RLS) with Power BI Desktop

More questions? Try asking the Power BI Community

http://community.powerbi.com/


Manage your data storage
1/30/2018 • 3 min to read • Edit Online

Manage items owned by you

Learn how you can manage your individual, or app workspace, data storage to make sure you can continue to
publish reports and datasets.

Users and app workspaces have their own data capacities

Free and Pro users have a maximum 10 GB data storage.
Pro users can create app workspaces, with a maximum 10 GB data storage each.

At the tenant level, total usage can’t exceed 10 GB per Pro user across all Pro users and app workspaces in the
tenant.

Read about other features of the Power BI pricing model.

Included in your data storage are your own datasets and Excel reports, and those that someone has shared with
you. Datasets are any of the data sources you’ve uploaded or connected to, including Power BI Desktop files and
Excel workbooks you’re using. The following are also included in your data capacity.

Excel ranges pinned to dashboard.
Reporting Services on-premises visualizations pinned to a Power BI dashboard.
Uploaded images.

The size of a dashboard that you share will vary depending on what is pinned to it. For example, if you pin items
from two reports that are part of two different datasets, the size will include both datasets.

  

See how much data storage you’re using in your Power BI account, and manage your account.

1. To manage your own storage, go to My Workspace on the left navigation pane.

2. Select the gear icon  in the upper-right corner > Manage personal storage.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-admin-manage-your-data-storage-in-power-bi.md
https://powerbi.microsoft.com/pricing


Manage your app workspace

3. To delete a dataset or report, select the trash can icon .

The top bar shows how much of your storage limit you’ve used.

The datasets and reports are separated onto two tabs:

Owned by Me: These are reports and datasets you’ve uploaded to your Power BI account, including service
datasets such as Salesforce and Dynamics CRM.
Owned by Others: Others have shared these reports and datasets with you.

Keep in mind that you or someone else may have reports and dashboards based on a dataset. If you delete the
dataset, those reports and dashboards won’t work anymore.

1. Select the arrow next to Workspaces > select the name of the app workspace.

2. Select the gear icon  in the upper-right corner > Manage group storage.

The top bar shows how much of the group’s storage limit is used.



Dataset limits

What happens when you hit a limit

NOTENOTE

The datasets and reports are separated onto two tabs:

Owned by Us: These are reports and datasets you or someone else has uploaded to the group’s Power BI
account, including service datasets such as Salesforce and Dynamics CRM. Owned by Others: Others have
shared these reports and datasets with your group.

3. To delete a dataset or report, select the trash can icon .

Any member, with edit permissions, of an app workspace has permissions to delete datasets and reports from the
app workspace.

Keep in mind that you or someone else in the group may have reports and dashboards based on a dataset. If you
delete the dataset, those reports and dashboards won’t work anymore.

There is a 1 GB limit, per dataset, that is imported into Power BI. If you have chosen to keep the Excel experience,
instead of importing the data, you will be limited to 250 MB for the dataset.

When you hit the data capacity limit of what you can do, you will see prompts within the service.

When you select the gear icon , you will see a red bar indicating you are over your data capacity limit.

You will also see this indicated within Manage personal storage.



When you try to perform an action that will hit one of the limits, you will see a prompt indicating you are over the
limit. You will be able to manage your storage to reduce your storage amount and get past the limit.

More questions? Try asking the Power BI Community

http://community.powerbi.com/


Power BI Archived Workspace
1/30/2018 • 3 min to read • Edit Online

Restrictions in your Archived Workspace

Migrating Content in your Archived Workspace

With Power BI, anyone can sign up and start using the service in a few minutes. Later, your organization's IT
department may choose to take over managing Power BI for users in your organization. If this takeover occurs, you
will benefit from central management of users and permissions in your organization and you may be able to take
advantage of streamlined sign-in using the same username and password you use for other services in your
organization.

Any content you created before your IT department started managing Power BI will be placed in a Power BI
Archived Workspace, which is accessible from the left navigation of Power BI. You should start creating new Power
BI content in My Workspace, which is secured and managed by your organization's IT department. Your Archived
Workspace will continue to exist, but there are restrictions on actions you can perform on content in your Archived
Workspace. To remove these restrictions, you will need to migrate the content from your Archived Workspace to
your My Workspace, managed by your IT department.

No content will be deleted from your Archived Workspace. You can continue to get data, create reports and
dashboards, and refresh datasets. Existing users you have shared content with will still be able to view the content
in their Archived Workspace too.

However, there are some restrictions on content in your Archived Workspace:

**OneDrive for Business. ** You will no longer be able to get data or refresh from OneDrive for Business for
datasets in your Archived Workspace. If you try to connect to this source, you will receive a warning.
**Sharing dashboards. ** You can't share dashboards with other users from your Archived Workspace. Any
users that already have access will continue to be able to view shared dashboards by accessing their Archived
Workspace.
**Creating groups. ** You can't create groups in your Archived Workspace.
**Access on Power BI mobile apps. **While you can still view content on the web in your Archived Workspace,
this content will no longer appear in the Power BI mobile apps.

To continue to use Power BI, you should create new content in your My Workspace, managed by your IT
department. You should also plan to migrate any content in your Archived Workspace to your My Workspace. How
you migrate content depends on the kind of content:

**Excel or Power BI Desktop Datasets. ** Migrate these datasets by switching from your Archived Workspace to
My Workspace and re-uploading the Excel or Power BI Desktop file by clicking the "My Data" button. If you set
up scheduled refresh, you will need to reconfigure those settings for the new dataset in My Workspace.
**Other Datasets. ** Switch to My Workspace and then click the Get Data button to reconnect to any other
datasets you created in your Archived Workspace. You may need to re-enter security or connection information.
**Reports. ** Reports that were contained in Excel or Power BI Desktop files or reports installed as part of
content packs will be automatically recreated once you re-upload the corresponding Excel or Power BI Desktop
file or reconnect to the content pack. If you created your own reports through the Power BI service, you will need
to recreate those reports in your My Workspace.
**Dashboards. ** Dashboards installed as part of content packs will be automatically recreated when you
reconnect to the content pack in My Workspace. If you created your own dashboards through the Power BI

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-admin-power-bi-archived-workspace.md
https://app.powerbi.com


service, you will need to recreate those dashboards in your My Workspace.

More questions? Try asking the Power BI Community

http://community.powerbi.com/


 

Unable to add Power BI to Office 365 partner
subscription
1/30/2018 • 2 min to read • Edit Online

Power BI (free)

Your IT department has turned off signup for Microsoft Power BI.

Office 365 allows companies to resell Office 365 bundled and integrated with their own solutions, providing end-
customers with a single point of contact for purchasing, billing, and support.

If you are interested in acquiring Power BI, alongside your Office 365 subscription, we recommend you contact
your partner to do so. If your partner does not offer Power BI, you have different options you can consider.

1. You are able to buy the service from another channel, either directly from Microsoft or another partner. This
option is not available to all customers depending on their relationship with the partner. You can verify this
by going to the Office 365 Admin Portal > Billing > Subscriptions. If you do see Subscriptions, you can
acquire the service from Microsoft directly, or you can also contact a partner that is offering Power BI.

2. If you do not see Subscriptions listed under Billing, you cannot buy from Microsoft directly or another
partner.

If you are not able to purchase Power BI directly, and depending on what type of Power BI subscription you are
interested in, you still have some options.

Power BI (free)

Power BI Pro and Premium

If you are happy with the free offering for Power BI, you can sign up for the free service. By default, individual sign-
ups, also known as ad-hoc subscriptions, are disabled. When you try to sign up for Power BI, you will see a
message indicating that your IT department has turned off sign up for Microsoft Power BI.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-admin-syndication-partner.md


Power BI Pro and Premium

To enable ad-hoc subscriptions, you can contact your partner and request that they turn it on. If you are an
Administrator of your tenant, and know how to leverage Azure Active Directory PowerShell commands, you can
enable ad-hoc subscriptions yourself. Learn more

 $msolcred = get-credential
 connect-msolservice -credential $msolcred

 Set-MsolCompanySettings -AllowAdHocSubscriptions $true

1. You need to first sign into Azure Active Directory using your Office 365 credential. The first line will prompt
you for your credentials. The second line connects to Azure Active Directory.

2. Once you are signed in, you can issue the following command to enable free sign ups.

If you want to buy a subscription to Power BI Pro or Power BI Premium, you will have to work with your partner to
consider what options you have.

Your partner agrees to add Power BI to their portfolio so that you can purchase from them.
Your partner is able to transition you to a model where you can buy Power BI directly from Microsoft or another
partner who offers Power BI.

This video looks at Office 365 syndication and purchasing Power BI:

https://technet.microsoft.com/library/jj151815.aspx


Next steps
Manage Azure AD using Windows PowerShell
Power BI Premium - what is it?

More questions? Try asking the Power BI Community

https://technet.microsoft.com/library/jj151815.aspx
http://community.powerbi.com/


Closing your Power BI Account
1/30/2018 • 1 min to read • Edit Online

Individual Power BI users

If you don't want to use Power BI any longer, you can ask us to close your Power BI account. After your account is
closed, you can no longer sign in to Power BI. Also, any customer data you uploaded, or created, in Power BI is
deleted according to the data retention policy in the Power BI Terms of Service.

You can close your account from the settings screen.

1. Select the gear  in the upper right.
2. Select Settings.

3. General > Close Account

4. Select a reason from the Why are you closing your account? (1) dropdown. You can optionally provide
further information (2). Then select Close account.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-admin-closing-your-account.md


Managed tenant users

5. Confirm that you want to close your account.

6. You will see a confirmation that your account is closed. You will also be given a link to reopen your account.

You will need to contact your tenant admin and ask them to unassign the license from your account.

More questions? Try asking the Power BI Community

http://community.powerbi.com/


Configure mobile apps with Microsoft Intune
1/30/2018 • 6 min to read • Edit Online

General mobile device management configuration

NOTENOTE

Step 1: Get the url for the application

iOSiOS

Microsoft Intune enables organizations to manage devices and applications. The Power BI mobile applications, for
iOS and Android, integrate with Intune to allow you to manage the application on your devices, and to control
security. Through configuration policies, you can control items like requiring an access pin, controlling how data is
handled by the application and even encrypting application data when the app is not in use.

This article is not meant as full configuration guide for Microsoft Intune. If you are just now integrating with Intune,
there are a few things you will want to make sure you have setup. Learn more

Microsoft Intune can co-exist with Mobile Device Management (MDM) within Office 365. Learn more

This article assumes that Intune is configured properly and you have devices enrolled with Intune. If you are co-
existing with MDM, the device will show enrolled within MDM, but is available to manage within Intune.

After your organization has configured Microsoft Intune MAM, if you use the Power BI mobile app on an iOS or Android
device, then background data refresh is turned off. The next time you enter the app, Power BI refreshes the data from the
Power BI service on the web.

Before we create the application within Intune, we need to get the urls for the apps. For iOS, we will get this from
iTunes. For Android, you can get it from the Power BI mobile page.

Save the url, as you will need it when we create the application.

To get the app url for iOS, we will need to get it from iTunes.

1. Open iTunes.
2. Search for Power BI.
3. You should see Microsoft Power BI listed under iPhone Apps and iPad Apps. You can use either, as you will

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-admin-mobile-intune.md
https://technet.microsoft.com/library/jj676587.aspx
https://blogs.technet.microsoft.com/configmgrdogs/2016/01/04/microsoft-intune-co-existence-with-mdm-for-office-365/


https://itunes.apple.com/us/app/microsoft-power-bi/id929738808?mt=8

AndroidAndroid

https://play.google.com/store/apps/details?id=com.microsoft.powerbim

Step 2: Create a mobile application management policy

get the same url.
4. Select the Get drop down and select Copy Link.

It should look similar to the following.

You can get the url to Google Play from the Power BI mobile page. Clicking on the Download from Google Play
icon will take you to the app page. You can copy the URL from the browser address bar. It should look similar to the
following.

The mobile application management policy allows you to enforce items like an access pin. You can create one
within the Intune portal.

You can create the application, or the policy first. The order in which they are added doesn't matter. They will just
need to both exist for the deploy step.

2. Select Add....

1. Select Policy > Configuration Policies.

https://powerbi.microsoft.com/mobile/


Step 3: Create the application

iOSiOS

NOTENOTE

3. Under Software you can select Mobile Application Management for either Android or iOS. To get started
quickly, you can select Create a policy with the recommended settings, or you can create a custom policy.

4. Edit the policy to configure the restrictions you want on the application.

The application is a reference, or package, that is saved into Intune for deployment. We will need to create an
application and reference the app url that we got from either Google Play or iTunes.

You can create the application, or the policy first. The order in which they are added doesn't matter. They will just
need to both exist for the deploy step.

1. Go to the Intune portal and select Apps from the left menu.
2. Select Add App. This will launch the Add Software application.

1. Select Managed iOS App from the App Store from the drop down.

3. Provide a Publisher, Name and Description. You can optionally provide an Icon. The Category is for the
Company Portal app. Once you are done, select Next.

4. You can decide if you want the publish the app as Any (default), iPad or iPhone. By default it will show Any and
will work for both device types. The Power BI app is the same url for both iPhone and iPad. Select Next.

5. Select Upload.

2. Enter the app url, that we got from Step 1, and select Next.

You may not see it show up in the app list until you refresh the page. You can click on Overview and back to Apps to get
the page to reload.



AndroidAndroid

NOTENOTE

Step 4: Deploy the application

1. Select External Link from the drop down.

3. Provide a Publisher, Name and Description. You can optionally provide an Icon. The Category is for the
Company Portal app. Once you are done, select Next.

4. Select Upload.

2. Enter the app url, that we got from Step 1, and select Next.

You may not see it show up in the app list until you refresh the page. You can click on Overview and back to Apps to get
the page to reload.



iOSiOS

AndroidAndroid

After you have added the application, you will need to deploy it so that it is available to your end users. This is the
step where you will bind the policy you created with the app.

2. In the Select Groups screen, you can choose which groups you want to deploy this app to. Select Next.

5. In the VPN Profile screen, you can select a policy if you have one for your organization. It defaults to None.
Select Next.

6. In the Mobile App Configuration screen, you can select an App Configuration Policy if you created one. It
defaults to None. This is not required. Select Finish.

1. On the apps screen, select the app you created. Then select the Manage Deployment... link.

3. In the Deployment Action screen, you can choose how you want to deploy this app. Selecting Available
Install, or Required Install, will make the app available in the Company Portal for users to install on-
demand. After you are done making your selection, select Next.

4. In the Mobile App Management screen, you can select the Mobile App Management policy that we created
in Step 2. It will default to the policy you made, if that is the only iOS policy available. Select Next.

After you have deployed the app, it should show Yes for deployed, in the apps page.

1. On the apps screen, select the app you created. Then select the Manage Deployment... link.



Step 5: Install the application on a device

2. In the Select Groups screen, you can choose which groups you want to deploy this app to. Select Next.
3. In the Deployment Action screen, you can choose how you want to deploy this app. Selecting Available

Install, or Required Install, will make the app available in the Company Portal for users to install on-
demand. After you are done making your selection, select Next.

4. In the Mobile App Management screen, you can select the Mobile App Management policy that we created
in Step 2. It will default to the policy you made, if that is the only Android policy available. Select Finish.

After you have deployed the app, it should show Yes for deployed, in the apps page.

You will install the application through the Company Portal app. If you haven't installed the Company Portal, you
can get it through the app store on either iOS or Android platforms. You will sign into the Company Portal with
your organizational login.

1. Open the Company Portal app.
2. If you don't see the Power BI app listed as a featured app, select Company Apps.



3. Select the Power BI app that you deployed.

4. Select Install.

5. If you are on iOS, it will push the app to you. Select Install on the push dialog.



Next steps

After it is installed, you will see that it is Managed by your company. If you enabled access with a pin, in the
policy, you will see the following.

Configure and deploy mobile application management policies in the Microsoft Intune console
Power BI apps for mobile devices

More questions? Try asking the Power BI Community

https://technet.microsoft.com/library/dn878026.aspx
http://community.powerbi.com/


Power BI for Office 365 is retired
12/6/2017 • 1 min to read • Edit Online

The Admin portal

Next steps

Power BI for Office 365, a previous version of Power BI, has been transitioned to the current version of Power BI.
Users who once used Power BI for Office 365 can use the current version of Power BI. You can learn more about
Power BI.

Access to the Power BI for Office 365 Admin portal is no longer available. Administrators can use the new Admin
portal to manage their organization's Power BI subscription.

For more information, see Power BI admin portal.

Get started with Power BI

Getting started with Power BI Desktop

Administering Power BI in your Organization

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-admin-o365portal-retired.md
https://powerbi.microsoft.com
https://app.powerbi.com/admin-portal


Forgot your password for Power BI?
1/30/2018 • 1 min to read • Edit Online

NOTENOTE

If you've forgotten your password, you can use the following link to request a password reset.

https://passwordreset.microsoftonline.com

If you're told that your account is not enabled for password reset, you'll need to contact your Office 365
administrator. If you're using the free trial, the administrator is the first person in your organization who signed up.

If you are still having issues accessing your account you can try contacting the support team for password resets.
This is not the support number for the Power BI service!

1-800-642-7676

Please note, support is provided during the eastern standard time (EST) time zone. Support is provided during business hours
and currently only supported in English.

More questions? Try asking the Power BI Community

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-admin-forgot-your-password.md
https://passwordreset.microsoftonline.com
http://community.powerbi.com/
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Capturing Additional Diagnostic Information for Power BI

Network Capture - Edge & Internet Explorer

These instructions provide two potential options for manually collecting additional diagnostic information from the
Power BI web client. Only one of these options needs to be followed.

1. Browse to Power BI with Edge or Internet Explorer.
2. Open the Edge developer tools by pressing F12.

5. You can browse within the window and reproduce any problem you may be encountering. You can hide and
show the developer tools window at any time during the session by pressing F12.

3. That will bring up the Developer Tools window:

4. Switch to the Network tab. It will list traffic it has already captured.

6. To stop the capture, you can select the red square on the network tab of the developer tools area.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-admin-capturing-additional-diagnostic-information-for-power-bi.md
https://app.powerbi.com


9. You can provide the HAR file to support for review.

7. Select on the diskette icon to Export as HAR

8. Provide a file name and save the HAR file.

The HAR file will contain all the information about network requests between the browser window and
Power BI. This will include the activity IDs for each request, the precise timestamp for each request, and any
error information returned to the client. This trace will also contain the data used to populate the visuals
shown on the screen.

More questions? Try asking the Power BI Community

http://community.powerbi.com/


Using an alternate Email Address
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Updating through Office 365 personal info page

NOTENOTE

Updating with PowerShell

Set-AzureADUser -ObjectId john@contoso.com -OtherMails "otheremail@somedomain.com"

By default, the email address you used to sign up to Power BI with is used to send you updates about activity in
Power BI. For example, when someone sends you a sharing invitation it will go to this address.

Sometimes you may want these emails delivered to an alternate email address rather than the one you originally
used to sign up for Power BI with.

1. Go to your Office 365 personal info page. If you are prompted to, sign in with the email address and password
you use for Power BI.

NOTENOTE

3. In the Alternate email field, enter the email address you would like Power BI updates to be sent to.

2. Slick the edit link in the Contact details section.

If you do not see an Edit link, this means your email address is managed by your Office 365 administrator and you
will need to contact them to update your email address.

Changing this setting will not affect what email address is used to send service updates, newsletters, and other promotional
communications. Those will always be sent to the email address you originally used when registering for Power BI.

You can alternatively update the alternate email address via PowerShell for Azure Active Directory. This is done
with the Set-AzureADUser command.

For more information, see Azure Active Directory PowerShell Version 2.

More questions? Try the Power BI Community

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-admin-alternate-email-address-for-power-bi.md
https://portal.office.com/account/#personalinfo
https://docs.microsoft.com/powershell/module/azuread/set-azureaduser
https://docs.microsoft.com/powershell/azure/active-directory/install-adv2
http://community.powerbi.com/


Using the same account for Power BI and Azure
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If you are a user of both Power BI and Azure, you may want to use the same login for both services so that you
don't need to type in your password twice.

Power BI signs you in with your organizational account, associated with your work or school email address. Azure
signs you in with either a Microsoft Account or your organizational account.

If you want to use the same login for both Azure and Power BI, be sure to sign in to Azure with your organizational
account.

What if I already sign in to Azure with my Microsoft Account?

You can add your organizational account as a co-administrator in Azure. Here's how:

1. Sign in to the Azure Management Portal. If you are a user in multiple Azure directories, click Subscriptions and
then filter to view only the directory and subscriptions you want to edit.

2. In the navigation pane, click Settings, click Administrators, and then click Add.
3. Enter the email address associated with your organizational account.
4. Select the subscriptions you want to access with your organizational account and then click the check mark.

Next time you sign in to the Azure Management Portal, use your organizational email address.

More questions? Try the Power BI Community

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-admin-how-to-use-the-same-account-as-azure.md
http://manage.windowsazure.com/
http://community.powerbi.com/


Office 365 dedicated customers - known issues
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Groups

iPhone App - sign in with vanity domain leads to error

Power BI is now supported for Office 365 Dedicated customers. If you are an O365 Dedicated customer, you can
sign in with an account from that tenant and use Power BI. There are two known issues currently.

When selecting Members or Calendar in the Group context menu, you will be redirected to the Mail app instead.
Files and Conversations work as expected.

When you sign in, on the iPhone app, using a login with a vanity domain, you may encounter an error.

Sign In error
An unexpected internal error occurred. Please try again.

To work around this issue, sign in with the email address listed when you click on the user icon within the Power BI
service instead of with the vanity domain.

More questions? Try the Power BI Community

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-admin-office-365-dedicated-known-issues.md
http://community.powerbi.com/


Troubleshooting Analyze in Excel
1/25/2018 • 5 min to read • Edit Online

NOTENOTE

Update Excel libraries for the OLE DB provider

There may be times when using Analyze in Excel that you get an unexpected result, or the feature doesn't work as
you expected. This page provides solutions for common issues when using Analyze in Excel.

There's a separate page dedicated to describing and enabling Analyze in Excel.

If you encounter a scenario that is not listed below, and it is causing you issues, you can ask for further assistance on the
community site, or you can create a support ticket.

This article contains the following troubleshooting sections:

Update Excel libraries for the OLE DB provider
Determining whether you need to update your Excel libraries
Connection cannot be made error
Forbidden error
No data models
Token expired error
Unable to access on-premises Analysis services
Can't drag anything to the PivotTable Values area (no measures)

To use Analyze in Excel, your computer must have a current AS OLE DB provider installed. This community post
is a great source to verify your installation of the OLE DB provider, or to download a recent version.

The Excel libraries need to match your version of Windows in terms of its bit-level. If you have 64-bit Windows
installed, you need to install the 64-bit OLE DB provider.

To download the latest Excel libraries, visit Power BI and select the down arrow in the upper right corner of the
Power BI service, then select Analyze in Excel updates.

In the dialog that appears, select Download (preview).

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-troubleshooting-analyze-in-excel.md
http://community.powerbi.com/
https://powerbi.microsoft.com/support/
http://community.powerbi.com/t5/Service/Analyze-in-Excel-Initialization-of-the-data-source-failed/m-p/30837#M8081


Determining whether you need to update your Excel libraries
You can download the most recent version of the Excel OLE DB provider libraries from the links in the previous
section. Once you download the appropriate OLD DB provider library and begin installation, checks are performed
against your current installed version.

If your Excel OLE DB provider client libraries are up to date, you'll be presented with a dialog that looks like the
following:

C:\Users\davidi\Desktop\powerbi-content-pr\articles\media\powerbi-desktop-troubleshooting-analyze-in-excel



Connection cannot be made error

Forbidden error

No data models

Token expired error

Unable to access on-premises Analysis Services

Can't drag anything to the PivotTable Values area (no measures)

Alternatively, if the new version you are installing is newer than the version on your computer, the following dialog
appears:

If you see the dialog prompting you to upgrade, you should continue with the installation to get the most recent
version of the OLE DB provider installed in your computer.

The primary cause for a connection cannot be made error is that your computer's OLE DB provider client libraries
are not current. For information about how to determine the correct update, and for download links, see Update
Excel libraries for the OLE DB provider earlier in this article.

Some users have more than one Power BI account, and when Excel attempts to connect to Power BI using existing
credentials, it may use credentials that do not have access to the dataset or report you want to access.

When this occurs, you may receive an error titled Forbidden, which means you may be signed into Power BI with
credentials that do not have permissions to the dataset. After encountering the forbidden error, when prompted
to enter your credentials, use the credentials that have permission to access the dataset you're trying to use.

If you still run into errors, log into Power BI with the account that has permission, and verify that you can view and
access the dataset in Power BI that you're attempting to access in Excel.

If you encounter an error that states Can't find OLAP cube model, then the dataset you're trying to access has no
data model, and therefore cannot be analyzed in Excel.

If you receive a token expired error, it means you haven't recently used the Analyze in Excel feature on the
computer you're using. Simply re-enter your credentials, or reopen the file, and the error should go away.

If you're trying to access a dataset that has connections to on-premises Analysis Services data, you may receive an
error message. Analyze in Excel does support connecting to datasets and reports on on-premises Analysis
Services with a connection string, as long as your computer is on the same domain as the Analysis Services
server, and your account has access to that Analysis Services server.

When Analyze in Excel connects to an external OLAP model (which is how Excel connects to Power BI), the
PivotTable requires measures to be defined in the external model, since all calculations are performed on the
server. This is different than when you work with a local data source (such as tables in Excel, or when you're

https://support.microsoft.com/kb/234700


Next steps

working with datasets in Power BI Desktop or the Power BI service), in which case the tabular model is available
locally, and you can use implicit measures, which are measures that are generated dynamically and are not stored
in the data model. In these cases, the behavior in Excel is different from the behavior in Power BI Desktop or the
Power BI service: there may be columns in the data that can be treated as measures in Power BI, but can't be used
as values (measures) in Excel.

To address this issue, you have a few options:

1. Create measures in your data model in Power BI Desktop, then publish the data model to the Power BI
service and access that published dataset from Excel.

2. Create measures in your data model from Excel PowerPivot.
3. If you imported data from an Excel workbook that had only tables (and no data model), then you can add the

tables to the data model, then follow the steps in option 2, directly above, to create measures in your data
model.

Once your measures are defined in the model in the Power BI service, you'll be able to use them in the Values area
in Excel PivotTables.

Analyze in Excel

Tutorial: Create your own measures in Power BI Desktop

Measures in PowerPivot

Create a Measure in PowerPivot

Add worksheet data to a Data Model using a linked table

Differences between OLAP and non-OLAP PivotTables in Excel

https://msdn.microsoft.com/library/gg399077.aspx
https://support.office.com/article/Create-a-Measure-in-Power-Pivot-d3cc1495-b4e5-48e7-ba98-163022a71198
https://support.office.com/article/Add-worksheet-data-to-a-Data-Model-using-a-linked-table-d3665fc3-99b0-479d-ba09-a37640f5be42
https://msdn.microsoft.com/library/gg399077.aspx
https://support.office.com/article/Create-a-Measure-in-Power-Pivot-d3cc1495-b4e5-48e7-ba98-163022a71198
https://support.office.com/article/Add-worksheet-data-to-a-Data-Model-using-a-linked-table-d3665fc3-99b0-479d-ba09-a37640f5be42
https://support.microsoft.com/kb/234700
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Update to the latest version

Common issues

Authentication to proxy serverAuthentication to proxy server

Your proxy only allows ports 80 and 443 trafficYour proxy only allows ports 80 and 443 traffic

This article discusses some common issues you may encounter when using the on-premises data
gateway.

If you encounter an issue that is not listed below, you can ask for further assistance in the following locations.

For Power BI, you can use the communities site or you can create a support ticket.
For PowerApps, you can use the communities site or you can create a support ticket.
For Microsoft Flow, you can use the communities site of you can create a support ticket.
For Logic Apps, you can submit a support ticket through the Azure portal.

A lot of issues can surface when the gateway version is out of date. It is a good general practice to make
sure you are on the latest version. If you haven't updated the gateway for a month, or longer, you may want
to consider installing the latest version of the gateway and see if you can reproduce the issue.

Here are a few common issues and resolutions that have helped a number of customers in environments
that restrict internet access.

Your proxy may require authentication from a domain user account. By default, the gateway uses a Service
SID for the windows service log on user. Changing the log on user to a domain user can help with this. For
more information, see Changing the gateway service account to a domain user.

Some proxies restrict traffic to only ports 80 and 443. By default, communication to Azure Service Bus will
occur on ports other than 443.

You can force the gateway to communicate with Azure Service Bus using HTTPS instead of direct TCP. You

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-gateway-onprem-tshoot.md
http://community.powerbi.com/
https://powerbi.microsoft.com/support/
https://aka.ms/powerapps-community
https://powerapps.microsoft.com/support/
https://go.microsoft.com/fwlink/?LinkID=787467
https://go.microsoft.com/fwlink/?LinkID=787479


<setting name="ServiceBusSystemConnectivityModeString" serializeAs="String">
    <value>Https</value>
</setting>

Installation
Error: Failed to add user to group. Error: Failed to add user to group. (-2147463168 (-2147463168 PBIEgwService PBIEgwService Performance Log Users Performance Log Users ))

Configuration
How to restart the gatewayHow to restart the gateway

Error: Failed to create gateway. Please try again.Error: Failed to create gateway. Please try again.

Error: Failed to update gateway details. Error: Failed to update gateway details. Please try again.Please try again.

Error: Power BI service reported local gateway as unreachable. Please restart the gateway and try again.Error: Power BI service reported local gateway as unreachable. Please restart the gateway and try again.

Script error during sign into Power BIScript error during sign into Power BI

will need to modify the Microsoft.PowerBI.DataMovement.Pipeline.GatewayCore.dll.config file. Change the
value from AutoDetect  to Https . This file is located, by default, at C:\Program Files\On-premises data

gateway.

You may receive this error if you are trying to install the gateway on a domain controller. Deploying on a
domain controller is not supported. You will need to deploy the gateway on a machine that is not a domain
controller.

The gateway runs as a Windows service, so you can start and stop it in multiple ways. For example, you can
open a command prompt with elevated permissions on the machine where the gateway is running and then
run either of these commands:

To stop the service, run this command:

''' net stop PBIEgwService '''

To start the service, run this command:

''' net start PBIEgwService '''

All of the details are available, but the call to the Power BI service returned an error. The error, and an
activity id, will be displayed. This could happen for different reasons. You can collect, and review, the logs, as
mentioned below, to get more details.

This could also be due to proxy configuration issues. The user interface does now allow for proxy
configuration. You can learn more about making proxy configuration changes

Information was received from the Power BI service, to the gateway. The information was passed onto the
local windows service, but it failed to return. Or, a symmetric key generation failed. The inner exception will
be displayed under Show details. You can collect, and review, the logs, as mentioned below, to get more
details.

At the end of configuration, the Power BI service will be called again to validate the gateway. The Power BI
service does not report the gateway as live. Restarting the windows service may allow the communication
to be successful. You can collect, and review, the logs, as mentioned below, to get more details.

You may receive a script error when signing into Power BI as part of the on-premises data gateway
configuration. Installing the following security update should resolve the issue. This can be installed via
Windows Update.

MS16-051: Security update for Internet Explorer: May 10, 2016 (KB 3154070)

https://support.microsoft.com/kb/3154070


Gateway configuration failed with a null reference exceptionGateway configuration failed with a null reference exception

    Failed to update gateway details.  Please try again.
    Error updating gateway configuration.

    Microsoft.PowerBI.DataMovement.Pipeline.Diagnostics.CouldNotUpdateGatewayConfigurationException: 
Error updating gateway configuration. ----> System.ArgumentNullException: Value cannot be null.
    Parameter name: serviceSection

Support for TLS 1.1/1.2Support for TLS 1.1/1.2

    [HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\.NETFramework\v4.0.30319]"SchUseStrongCrypto"=dword:00000001
    
[HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Microsoft\.NETFramework\v4.0.30319]"SchUseStrongCrypto"=dword:
00000001

NOTENOTE

Data sources
Error: Unable to Connect. Details: "Invalid connection credentials"Error: Unable to Connect. Details: "Invalid connection credentials"

You may encounter an error similar to the following.

This will include a stack trace, and that stack trace will may include the following.

If you are upgrading from an older gateway, we preserve the config file. There may be a section that is
missing. When the gateway tries to read it, we will get the above null reference exception.

To correct this, do the following.

1. Uninstall the gateway.

 c:\Program Files\on-premises data gateway

3. Reinstall the gateway.
4. Optionally apply the recovery key to restore an existing gateway.

2. Delete the following folder.

With the August 2017 update and beyond, the on-premises data gateway uses Transport Layer Security
(TLS) 1.1 or 1.2 to communicate with the Power BI service by default. Previous versions of the on-premises
data gateway use TLS 1.0 by default. On November 1st 2017 support for TLS 1.0 will end, so by then you
must upgrade your on-premises data gateway installations to the August 2017 release or newer to ensure
your gateways continue to operate.

It's important to note that TLS 1.0 is still supported by the on-premises data gateway prior to November 1st,
and is used by the gateway as a fallback mechanism. To ensure all gateway traffic uses TLS 1.1 or 1.2 (and to
prevent the use of TLS 1.0 on your gateway), you must add or modify the following registry keys on the
machine running the gateway service:

Adding or modifying these registry keys applies the change to all .NET applications. For information about registry
changes that affect TLS for other applications, see Transport Layer Security (TLS) registry settings.

Within Show details, it should display the error message received from the data source. For SQL Server,
you should see something like the following.

https://docs.microsoft.com/windows-server/security/tls/tls-registry-settings


Login failed for user 'username'.

Error: Unable to Connect. Details: "Cannot connect to the database"Error: Unable to Connect. Details: "Cannot connect to the database"

Cannot open database "AdventureWorks" requested by the login. The login failed. Login failed for user 
'username'.

Error: Unable to Connect. Details: "Unknown error in data gateway"Error: Unable to Connect. Details: "Unknown error in data gateway"

Error: We encountered an error while trying to connect to Error: We encountered an error while trying to connect to . Details: "We reached the data gateway, but. Details: "We reached the data gateway, but
the gateway can't access the on-premises data source."the gateway can't access the on-premises data source."

The 'CONTOSO\account' value of the 'EffectiveUserName' XML for Analysis property is not valid.

The user name or password is incorrect.

Verify that you have the correct username and password. Also verify that those credentials can successfully
connect to the data source. Make sure the account being used matches the Authentication Method.

We were able to connect to the server, but not to the database supplied. Verify the name of the database,
and that the user credential as the proper permission to access that database.

Within Show details, it should display the error message received from the data source. For SQL Server,
you should see something like the following.

This error could occur for different reasons. Be sure to validate that you can connect to the data source from
the machine hosting the gateway. This could be the result of the server not being accessible.

Within Show details, you will see an error code of DM_GWPipeline_UnknownError.

You can also look in the Event Logs > Applications and Services Logs > on-premises data gateway
Service for more details.

We were unable to connect to the specified data source. Be sure to validate the information provided for
that data source.

Within Show details, you will see an error code of DM_GWPipeline_Gateway_DataSourceAccessError.

If the underlying error message is similar to the following, this means that the account you are using for the
data source is not a server admin for that Analysis Services instance. Learn more

If the underlying error message is similar to the following, it could mean that the service account for
Analysis Services may be missing the token-groups-global-and-universal (TGGAU) directory attribute.

Domains with Pre-Windows 2000 compatibility access will have the TGGAU attribute enabled. However,
most newly created domains will not enable this attribute by default. You can read more about this here.

You can confirm this by doing the following.

1. Connect to the Analysis Services machine within SQL Server Management Studio. Within the Advanced
connection properties, include EffectiveUserName for the user in question and see if this reproduces the
error.

2. You can use the dsacls Active Directory tool to validate whether the attribute is listed. This is tool is
normally found on a domain controller. You will need to know what the distinguished domain name
is for the account and pass that to the tool.

https://docs.microsoft.com/sql/analysis-services/instances/grant-server-admin-rights-to-an-analysis-services-instance
https://msdn.microsoft.com/library/windows/desktop/ms680300.aspx
https://support.microsoft.com/kb/331951


Datasets
Error: There is not enough space for this row.Error: There is not enough space for this row.

Error: The server name provided doesn't match the server name on the SQL Server SSL Certificate.Error: The server name provided doesn't match the server name on the SQL Server SSL Certificate.

I don't see the on-premises data gateway persent when configuring scheduled refresh.I don't see the on-premises data gateway persent when configuring scheduled refresh.

Error: The received uncompressed data on the gateway client has exceeded limit.Error: The received uncompressed data on the gateway client has exceeded limit.

Reports

 dsacls "CN=John Doe,CN=UserAccounts,DC=contoso,DC=com"

     Allow BUILTIN\Windows Authorization Access Group
                                   SPECIAL ACCESS for tokenGroupsGlobalAndUniversal
                                   READ PROPERTY

You want to see something similar to the following in the results.

To correct this issue, you will need to enable TGGAU on account used for the Analysis Services windows
service.

Another possibility for user name or password incorrect

This error could also be caused if the Analysis Services server is in a different domain than the users and
there is not a two-way trust established.

You will need to work with your domain administrators to verify the trust relationship between domains.

Unable to see the data gateway data sources in the 'Get Data' experience for Analysis Services
from the Power BI service

Make sure that your account is listed in the Users tab of the data source within the gateway configuration. If
you don't have access to the gateway, check with the administrator of the gateway and ask them to verify.
Only accounts in the Users list will see the data source listed in the Analysis Services list.

This will occur if you have a single row greater than 4 MB in size. You will need to determine what the row is
from your data source and attempt to filter it out or reduce the size for that row.

This can occur when the certificate CN is for the servers fully qualified domain name (FQDN) but you only
supplied the netbios name for the server. This will cause a mismatch for the certificate. To resolve this issue,
you will need to make the server name within the gateway data source, and the PBIX file, to use the FQDN of
the server.

This could be because of a few different scenarios.

1. The server and database name don't match between what was entered in Power BI Desktop and the data
source configured for the gateway. These need to be the same values. They are not case sensitive.

2. Your account is not listed in the Users tab of the data source within the gateway configuration. You will
need to get with the administrator of the gateway to be added to that list.

3. Your Power BI Desktop file has multiple data sources within it and not all of those data sources are
configured with the gateway. You will need to have each data source defined with the gateway for the
gateway to show up within Scheduled Refresh.

The exact limitation is 10 GB of uncompressed data per table. If you are hitting this issue, there are good
options to optimize and avoid the issue. In particular, reducing the use of highly repetitive, long string
values and instead using a normalized key or removing the column (if not in use) will help.



    

Report could not access the data source because you do not have access to our data source via an on-Report could not access the data source because you do not have access to our data source via an on-
premises data gateway.premises data gateway.

Error: Data source access error. Please contact the gateway administrator.Error: Data source access error. Please contact the gateway administrator.

Firewall or Proxy

Test-NetConnection -ComputerName watchdog.servicebus.windows.net -Port 9350

This is usually caused by one of the following.

1. The data source information does not match what is in the underlying dataset. The server and database
name need to match between the data source defined for the on-premises data gateway and what you
supply within Power BI Desktop. If you use an IP Address in Power BI Desktop, the data source, for the
on-premises data gateway, needs to use an IP Address as well.

2. There is not a data source available on any gateway within your organization. You can configure the data
source on a new, or existing, on-premises data gateway.

If this report is making use of a live Analysis Services connection, you could be encountering an issue with a
value being passed to EffectiveUserName that is either not valid, or doesn't have permissions on the
Analysis Services machine. Typically, an authentication issue is due to the fact that the value being passed
for EffectiveUserName doesn't match a local user principal name (UPN).

To confirm this, you can do the following.

1. Find the effective username within the gateway logs.

 whoami /upn

2. Once you have the value being passed, validate that it is correct. If it is your user, you can use the
following command from a command prompt to see what the UPN should be. The UPN will look like
an email address.

Optionally, you can see what Power BI gets from Azure Active Directory.

1. Browse to https://graphexplorer.cloudapp.net.
2. Select Sign in in the upper right.

 https://graph.windows.net/me?api-version=1.5

4. Look for userPrincipalName.

3. Run the following query. You will see a rather large JSON response.

If your Azure Active Directory UPN doesn't match your local Active Directory UPN, you can use the Map
user names feature to replace it with a valid value. Or you can work with either your tenant admin, or local
Active Directory admin, to get your UPN changed.

For information on providing proxy information for your gateway, see Configuring proxy settings for the
Power BI gateways.

You can test to see if your firewall, or proxy, may be blocking conections by running Test-NetConnection
from a PowerShell prompt. This will test connectivity to the Azure Service Bus. This only tests network
connectivity and doesn't have anything to do with the cloud server service or the gateway. It helps to
determine if your machine can actually get out to the internet.

https://graphexplorer.cloudapp.net
https://technet.microsoft.com/library/dn372891.aspx
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ComputerName           : watchdog.servicebus.windows.net
RemoteAddress          : 70.37.104.240
RemotePort             : 5672
InterfaceAlias         : vEthernet (Broadcom NetXtreme Gigabit Ethernet - Virtual Switch)
SourceAddress          : 10.120.60.105
PingSucceeded          : False
PingReplyDetails (RTT) : 0 ms
TcpTestSucceeded       : True

Performance

Test-NetConnection is only available on Windows Server 2012 R2 and later. It is also available on Windows 8.1 and
later. On earlier OS versions, you can use Telnet to test port connectivity.

The results should look similar to the following. The difference will be with TcpTestSucceeded. If
TcpTestSucceeded is not true, then you may be blocked by a firewall.

If you want to be exhaustive, substitute the ComputerName and Port values with those listed for ports

The firewall may also be blocking the connections that the Azure Service Bus makes to the Azure data
centers. If that is the case, you will want to whitelist (unblock) the IP addresses for your region for those data
centers. You can get a list of Azure IP addresses here.

You can find the data center region you are in by doing the following:

1. Select the ? in the upper right of the Power BI service.
2. Select About Power BI.
3. Your data region will be listed in Your data is stored in.

If you are still not getting anywhere, you could try getting a network trace using a tool like fiddler or netsh,
although these are advanced collection methods and you may need assistance in analyzing the collected
data. You can contact support for assistance.

https://www.microsoft.com/download/details.aspx?id=41653
https://support.microsoft.com


Performance CountersPerformance Counters

COUNTER TYPE DESCRIPTION

ADO.NET This is used for any DirectQuery connection.

ADOMD This is used for Analysis Services 2014 and earlier.

OLEDB This is used by certain data sources. This includes SAP
HANA and Analysis Service 2016 or later.

Mashup This includes any imported data source. If you are
scheduling refresh or doing an on-demand refresh, it will
go through the mashup engine.

COUNTER DESCRIPTION

# of ADO.NET open connection executed / sec Number of ADO.NET open connection actions executed
per second (succeeded or failed).

There are a number of performance counters that can be used to gauge the activities for the gateway. These
can be helpful to understanding if we have a large load of activity and may need to make a new gateway.
These counters will not reflect how long something takes.

These counters can be access through the Windows Performance Monitor tool.

There are general groupings of these counters.

Here is a listing of the available performance counters.



# of ADO.NET open connection failed / sec Number of ADO.NET open connections actions failed per
second.

# of ADO.NET queries executed / sec Number of ADO.NET queries executed per second
(succeeded or failed).

# of ADO.NET queries failed / sec Number of ADO.NET failed queries executed per second.

# of ADOMD open connection executed / sec Number of ADOMD open connection actions executed per
second (succeeded or failed).

# of ADOMD open connection failed / sec Number of ADOMD open connection actions failed per
second.

# of ADOMD queries executed / sec Number of ADOMD queries executed per second
(succeeded or failed).

# of ADOMD queries failed / sec Number of ADOMD failed queries executed per second.

# of all open connection executed / sec Number of open connection actions executed per second
(succeeded or failed).

# of all open connection failed / sec Number of failed open connection actions executed per
second.

# of all queries executed / sec Number of queries executed per second (succeeded or
failed).

# of items in the ADO.NET connection pool Number of items in the ADO.NET connection pool.

# of items in the OLEDB connection pool Number of items in the OLEDB connection pool.

# of items in the Service Bus pool Number of items in the Service Bus pool.

# of Mashup open connection executed / sec Number of Mashup open connection actions executed per
second (succeeded or failed).

# of Mashup open connection failed / sec Number of Mashup open connection actions failed per
second.

# of Mashup queries executed / sec Number of Mashup queries executed per second
(succeeded or failed).

# of Mashup queries failed / sec Number of Mashup failed queries executed per second

# of multiple result set OLEDB queries failed / sec Number of multiple resultset OLEDB failed queries
executed per second.

# of OLEDB multiple resultset queries executed / sec Number of OLEDB multiple resultset queries executed per
second (succeeded or failed).

# of OLEDB open connection executed / sec Number of OLEDB open connection actions executed per
second (succeeded or failed).

COUNTER DESCRIPTION



# of OLEDB open connection failed / sec Number of OLEDB open connection actions failed per
second.

# of OLEDB queries executed / sec Number of OLEDB multiple resultset queries executed per
second (succeeded or failed).

# of OLEDB queries failed / sec Number of OLEDB mutiple resultset failed queries
executed per second.

# of OLEDB single resultset queries executed / sec Number of OLEDB single resultset queries executed per
second (succeeded or failed).

# of queries failed / sec Number of failed queries executed per second.

# of single result set OLEDB queries failed / sec Number of single resultset OLEDB failed queries executed
per second.

COUNTER DESCRIPTION

Reviewing slow performing queries

Microsoft.PowerBI.DataMovement.Pipeline.GatewayCore.dll.configMicrosoft.PowerBI.DataMovement.Pipeline.GatewayCore.dll.config

IMPORTANTIMPORTANT

<setting name="EmitQueryTraces" serializeAs="String">
    <value>True</value>
</setting>

You may find that response through the gateway is slow. This could be for DirectQuery queries or when
refreshing your imported dataset. You can enable additional logging to output queries and their timings to
help understand what is performing slow. When you find a long running query, it may require additional
modification on your data source to tune query performance. For example, adjusting indexes for a SQL
Server query.

You will need to modify two configuration files to determine the duration of a query.

Within the Microsoft.PowerBI.DataMovement.Pipeline.GatewayCore.dll.config file, change the 
EmitQueryTraces  value from False  to True . This file is located, by default, at C:\Program Files\On-

premises data gateway. Enabling EmitQueryTraces  will begin to log queries that are sent from the gateway
to a data source.

Enabling EmitQueryTraces could increase the log size significantly depending on gateway usage. Once you are done
reviewing the logs, you will want to set EmitQueryTraces to False. It is not recommended to leave this setting
enabled long term.

Example query entry



DM.EnterpriseGateway Information: 0 : 2016-09-15T16:09:27.2664967Z DM.EnterpriseGateway    4af2c279-
1f91-4c33-ae5e-b3c863946c41    d1c77e9e-3858-4b21-3e62-1b6eaf28b176    MGEQ    c32f15e3-699c-4360-9e61-
2cc03e8c8f4c    FF59BC20 [DM.GatewayCore] Executing query (timeout=224) "<pi>
SELECT
TOP (1000001) [t0].[ProductCategoryName],[t0].[FiscalYear],SUM([t0].[Amount])
 AS [a0]
FROM
(
(select [$Table].[ProductCategoryName] as [ProductCategoryName],
    [$Table].[ProductSubcategory] as [ProductSubcategory],
    [$Table].[Product] as [Product],
    [$Table].[CustomerKey] as [CustomerKey],
    [$Table].[Region] as [Region],
    [$Table].[Age] as [Age],
    [$Table].[IncomeGroup] as [IncomeGroup],
    [$Table].[CalendarYear] as [CalendarYear],
    [$Table].[FiscalYear] as [FiscalYear],
    [$Table].[Month] as [Month],
    [$Table].[OrderNumber] as [OrderNumber],
    [$Table].[LineNumber] as [LineNumber],
    [$Table].[Quantity] as [Quantity],
    [$Table].[Amount] as [Amount]
from [dbo].[V_CustomerOrders] as [$Table])
)
 AS [t0]
GROUP BY [t0].[ProductCategoryName],[t0].[FiscalYear] </pi>"

Microsoft.PowerBI.DataMovement.Pipeline.GatewayCore.dll.configMicrosoft.PowerBI.DataMovement.Pipeline.GatewayCore.dll.config

IMPORTANTIMPORTANT

<setting name="TracingVerbosity" serializeAs="String">
    <value>5</value>
</setting>

Activity TypesActivity Types

ACTIVTY TYPE DESCRIPTION

MGEQ Queries executed over ADO.NET. This includes
DirectQuery data sources.

MGEO Queries executed over OLEDB. This includes SAP HANA
and Analysis Services 2016.

MGEM Queries executed from the Mashup engine. This is used
with imported datasets that use scheduled refresh or
refresh on-demand.

Within the Microsoft.PowerBI.DataMovement.Pipeline.Diagnostics.dll.config file, change the TraceVerbosity

value from 4  to 5 . This file is located, by default, at C:\Program Files\On-premises data gateway.
Changing this setting will begin to log verbose entries to the gateway log. This includes entries that show
duration.

Enabling TraceVerbosity to 5  could increase the log size significantly depending on gateway usage. Once you are
done reviewing the logs, you will want to set TraceVerbosity to 4 . It is not recommended to leave this setting
enabled long term.

   



  

Determine the duration of a queryDetermine the duration of a query

Tools for troubleshooting
Collecting logs from the gateway configuratorCollecting logs from the gateway configurator

To determine the time it took to query the data source, you can do the following.

1. Open the gateway log.
2. Search for an Activity Type to find the query. An example of this would be MGEQ.
3. Make note of the second GUID as this is the request id.

 DM.EnterpriseGateway Verbose: 0 : 2016-09-26T23:08:56.7940067Z DM.EnterpriseGateway    baf40f21-
2eb4-4af1-9c59-0950ef11ec4a    5f99f566-106d-c8ac-c864-c0808c41a606    MGEQ    21f96cc4-7496-
bfdd-748c-b4915cb4b70c    B8DFCF12 [DM.Pipeline.Common.TracingTelemetryService] Event: 
FireActivityCompletedSuccessfullyEvent (duration=5004)

NOTENOTE

4. Continue to search for MGEQ until you find the FireActivityCompletedSuccessfullyEvent entry with
the duration. You can verify the entry has the same request id. Duration will be in milliseconds.

FireActivityCompletedSuccessfullyEvent is a verbose entry. This entry will not be logged unless TraceVerbosity
is at level 5.

   

There are several logs you can collect for the gateway, and you should always start with the logs. The
simplest way to collect logs after installing the gateway is through the user interface. In the On-premises
data gateway user interface, select Diagnostics and then select the Export logs link near the bottom of
the page, as shown in the following image.



%localappdata%\Temp\On-premises_data_gateway_*.log

%localappdata%\Microsoft\On-premises Data Gateway\GatewayConfigurator*.log

C:\Users\PBIEgwService\AppData\Local\Microsoft\On-premises Data Gateway\Gateway*.log

Event LogsEvent Logs

Installer logs

Configuration logs

On-premises data gateway service logs

The On-premises data gateway service event logs are present under Application and Services Logs.



Fiddler TraceFiddler Trace

Refresh HistoryRefresh History

   

Fiddler is a free tool from Telerik that monitors HTTP traffic. You can see the back and forth with the Power
BI service from the client machine. This may show errors and other related information.

When using the gateway for scheduled refresh, Refresh History can help you see what errors have
occurred, as well as provide useful data if you should need to create a support request. You can view both
scheduled, as well as on demand, refreshes. Here is how you can get to the Refresh History.

1. In the Power BI navigation pane, in Datasets, select a dataset > Open Menu > Schedule Refresh.

2. In Settings for... > Schedule Refresh, select Refresh History.

http://www.telerik.com/fiddler


Next steps

For additional information about troubleshooting refresh scenarios, take a look at the Troubleshooting
Refresh Scenarios article.

Configuring proxy settings for the Power BI gateways
On-premises data gateway
On-premises data gateway - in-depth
Manage your data source - Analysis Services
Manage your data source - SAP HANA
Manage your data source - SQL Server
Manage your data source - Import/Scheduled refresh
More questions? Try the Power BI Community

http://community.powerbi.com/


Troubleshooting Power BI Gateway - Personal
12/6/2017 • 7 min to read • Edit Online

NOTENOTE

Update to the latest version

Installation

NOTENOTE

Schedule refresh

The following goes through some common issues you may encounter when using the Power BI Gateway -
Personal.

The current version of the gateway for personal use is the On-premises data gateway (personal). Please update your
installation to use that version.

A lot of issues can surface when the gateway version is out of date. It is a good general practice to make sure you
are on the latest version. If you haven't updated the gateway for a month, or longer, you may want to consider
installing the latest version of the gateway and see if you can reproduce the issue.

Personal gateway is 64bit - If your machine is 32bit, you will not be able to install the personal gateway. Your
operating system needs to be 64bit. You will need to install a 64bit version of Windows, or install the personal
gateway on a 64bit machine.

Personal gateway fails to install as a service even though you are a local administrator for the
computer - Installation can fail if the user is in the computer’s local Administrator group, but group policy does
not allow that username to log on as a service. At the moment, ensure the group policy allows a user to log on as
a service. We’re working on a fix for this issue. Learn more

Operation timed out - This is common if the computer (physical machine or VM) on which you’re installing the
personal gateway has a single core processor. Close any applications and turn off any non-essential processes
and try installing again.

Data Management Gateway or Analysis Services Connector cannot be installed on the same computer
as personal gateway - If you already have an Analysis Services Connector or Data Management Gateway
installed, you must first uninstall the Connector or the gateway and then try installing the personal gateway.

If you encounter an issue during installation, the setup logs could provide information to help you resolve the issue. See
Setup Logs for more information.

Proxy configuration You may encounter issues with configuring the personal gateway if your environment
needs the use of a proxy. To learn more about how to configure proxy information, see Configuring proxy
settings for the Power BI Gateways

Error: The credential stored in the cloud is missing.

You could get this error in Settings for <dataset> if you have a scheduled refresh and then uninstalled and re-

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-admin-troubleshooting-power-bi-personal-gateway.md
https://technet.microsoft.com/library/cc739424.aspx


Data sources

NOTENOTE

installed the personal gateway. When you uninstall a personal gateway, data source credentials for a dataset that
has been configured for refresh are removed from the Power BI service.

Solution: In Power BI, go to the refresh settings for a dataset. In Manage Data Sources, for any data source with
an error, click Edit credentials and sign in to the data source again.

Error: The credentials provided for the dataset are invalid. Please update the credentials through a
refresh or in the Data Source Settings dialog to continue.

Solution: If you get a credentials message, it could mean:

Make sure usernames and passwords used to sign into data sources are up to date. In Power BI, go to refresh
settings for the dataset. In Manage Data Sources, click Edit credentials to update the credentials for the data
source.
Mashups between a cloud source and an on-premises source, in a single query, will fail to refresh in the
personal gateway if one of the sources is using OAuth for authentication. An example of this is a mashup
between CRM Online and a local SQL Server. This will fail because CRM Online requires OAuth.

This is a known issue, and being looked at. To work around the problem, have a separate query for the
cloud source and the on-premises source and use a merge or append query to combine them.

Error: Unsupported data source.

Solution: If you get an unsupported data source message in Schedule Refresh settings, it could mean:

The data source is not currently supported for refresh in Power BI.
The Excel workbook does not contain a data model, only worksheet data. Power BI currently only supports
refresh if the uploaded Excel workbook contains a data model. When you import data using Power Query in
Excel, be sure to choose the option to Load data to data model. This ensures data is imported into a data
model.

Error: [Unable to combine data] <query part>/<…>/<…> is accessing data sources that have privacy
levels which cannot be used together. Please rebuild this data combination.

Solution: This error is due to the privacy level restrictions and the types of data sources you are using. Learn
more

Error: Data source error: We cannot convert the value "[Table]" to type Table.

Solution: This error is due to the privacy level restrictions and the types of data sources you are using. Learn
more

Error: There is not enough space for this row.

This will occur if you have a single row greater than 4 MB in size. You will need to determine what the row is
from your data source and attempt to filter it out or reduce the size for that row.

Missing data provider – The personal gateway is 64-bit only. It requires a 64-bit version of the data providers
to be installed on the same computer where the personal gateway is installed. For example, if the data source in
the dataset is Microsoft Access, you must install the 64-bit ACE provider on the same computer where you
installed the personal gateway.

If you have 32 bit Excel, you cannot install a 64-bit ACE provider on the same computer.



Tile refresh

Tools for troubleshooting
Refresh HistoryRefresh History

Windows authentication is not supported for Access database - Power BI currently only supports
anonymous for Access database. We are working on enabling Windows authentication for Access database.

Sign in error when entering credentials for a datasource - If you get an error similar to this when entering
Windows credentials for a data source, you might still be on an older version of the personal gateway. Install the
latest version of Power BI Gateway - Personal.

Error: Sign in error when selecting Windows authentication for a data source using ACE OLEDB - If you
get the following error when entering data source credentials for a data source using ACE OLEDB provider:

Power BI does not currently support Windows authentication for a data source using ACE OLEDB provider.

Solution: To work around this error, you can select Anonymous authentication. For legacy ACE OLEDB provider,
Anonymous credentials are equivalent to Windows credentials.

If you are receiving an error with dashboard tiles refreshing, please refer to the following article.

Troubleshooting tile errors

https://powerbi.microsoft.com/gateway/


Event logsEvent logs

Refresh History can help you see what errors have occurred, as well as provide useful data if you should need to
create a support request. You can view both scheduled, as well as on demand, refreshes. Here is how you can get
to the Refresh History.

1. In the Power BI navigation pane, in Datasets, select a dataset > Open Menu > Schedule Refresh. 

2. In Settings for... > Schedule Refresh, select Refresh History.

There are several event logs that can provide information. The first two, Data Management Gateway and
PowerBIGateway, are present if you are an admin on the machine. If you are not an admin, and you are using
the Personal Gateway, you will see the log entries within the Application log.

The Data Management Gateway and PowerBIGateway logs are present under Application and Services



Fiddler traceFiddler trace

Setup LogsSetup Logs

Logs.

Fiddler is a free tool from Telerik that monitors HTTP traffic. You can see the back and forth with the Power BI
service from the client machine. This may show errors and other related information.

 

If the Personal Gateway, fails to install, you will see a link to show the setup log. This could show you details
about the failure. These are Windows Install logs, or also knows as MSI logs. They can be fairly complex and hard
to read. Typically the resulting error will be at the bottom, but determining the cause of the error is not trivial. It
could be a result of errors in a different log, or be a result of an error higher up in the log.

Alternatively, you can go to your Temp folder (%temp%) and look for files that start with Power_BI_.

http://www.telerik.com/fiddler


NOTENOTE

Next steps

Going to %temp% may take you to a subfolder of temp. The Power_BI_ files will be in the root of the temp directory. You
may need to go up a level or two.

Configuring proxy settings for the Power BI Gateways
Data Refresh
Power BI Gateway - Personal
Troubleshooting tile errors
Troubleshooting the on-premises data gateway
More questions? Try the Power BI Community

http://community.powerbi.com/


Troubleshooting unsupported data source for refresh
12/6/2017 • 1 min to read • Edit Online

    You cannot schedule refresh for this dataset because it gets data from sources that currently don’t 
support refresh.

Find the data source

You may see an error when trying to configured a dataset for scheduled refresh.

This happens when the data source you used, within Power BI Desktop, isn’t supported for refresh. You will need to
find the data source that you are using and compare that against the list of supported data sources at Refresh data
in Power BI.

If you aren’t sure what data source was used, you can find that using the following steps within Power BI Desktop.

1. In Power BI Desktop, make sure you are on the Report pane.

2. Select Edit Queries from the ribbon bar.

3. Select Advanced Editor.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-admin-troubleshoot-unsupported-data-source-for-refresh.md


Next steps

4. Make note of the provider listed for the source. In this example, the provider is ActiveDirectory.

5. Compare the provider with the list of supported data sources found within Refresh data in Power BI. You will
find that Active Directory is not a supported data source for refresh.

Data Refresh
Power BI Gateway - Personal
On-premises data gateway
Troubleshooting the on-premises data gateway
Troubleshooting the Power BI Gateway - Personal

More questions? Try asking the Power BI Community

http://community.powerbi.com/


Troubleshooting scheduled refresh for Azure SQL
Databases in Power BI
1/30/2018 • 1 min to read • Edit Online

For detailed steps on setting up scheduled refresh, be sure to see Refresh data in Power BI.

While setting up scheduled refresh for Azure SQL Database, if you get an error with error code 400 during editing
the credentials, try the following to set up the appropriate firewall rule:

1. Log into your Azure management portal
2. Go to the Azure SQL server you are configuring refresh for
3. Turn on 'Windows Azure Services' in the allowed services section

More questions? Try the Power BI Community

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-admin-troubleshooting-scheduled-refresh-azure-sql-databases.md
http://community.powerbi.com/


Error: We couldn't find any data in your Excel
workbook
12/6/2017 • 1 min to read • Edit Online

NOTENOTE

Quick solution

Details
CauseCause

SolutionSolution

This article applies to Excel 2007 and later.

When you import an Excel workbook into Power BI, you may see the following error:

Error: We couldn't find any data in your Excel workbook. Your data might not be formatted properly. You'll need to
edit your workbook in Excel and then import it again.

1. Edit your workbook in Excel.
2. Select the range of cells that contain your data. The first row should contain your column headers (the column

names).
3. Press Ctrl + T to create a table.
4. Save your workbook.
5. Return to Power BI and import your workbook again, or if you're working in Excel 2016 and you've saved your

workbook to OneDrive for Business, in Excel, click File > Publish.

In Excel, you can create a table out of a range of cells, which makes it easier to sort, filter, and format data.

When you import an Excel workbook, Power BI looks for these tables and imports them into a dataset; if it doesn't
find any tables, you'll see this error message.

NOTENOTE

1. Open your workbook in Excel.

The pictures here are of Excel 2013. If you're using a different version, things may look a little different, but the steps
are the same.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-admin-troubleshoot-excel-workbook-data.md


2. Select the range of cells that contain your data. The first row should contain your column headers (the
column names):

3. In the ribbon on the INSERT tab, click Table. (Or, as a shortcut, press Ctrl + T.)



6. Save your workbook.

4. You'll see the following dialog. Make sure My table has headers is checked, and select OK:

5. Now your data is formatted as a table:

7. Return to Power BI. Select Get Data at the bottom of the left navigation pane.



8. In the Files box, select Get.

9. Import your Excel workbook again. This time, the import should find the table and succeed.

If the import still fails, let us know by clicking **Community **in the help menu:



Troubleshooting tile errors
12/6/2017 • 2 min to read • Edit Online

NOTENOTE

Errors

Below are the common errors you may encounter with tiles along with an explanation.

If you encounter an error that is not listed below, and it is causing you issues, you can ask for further assistance on the
community site, or you can create a support ticket.

Power BI encountered an unexpected error while loading the model. Please try again later. or Couldn't
retrieve the data model. Please contact the dashboard owner to make sure the data sources and model
exist and are accessible.

We weren't able to access your data because the data source wasn't reachable. This could happen if the data
source was removed, renamed, moved, offline, or permissions have changed. Check that the source is still in the
location we are pointing to and you still have permission to access it. If that isn't the issue, the source may be slow.
Try again later during a time when the load on the source is smaller. If it is an on-premises source, the data source
owner may be able to provide more information.

You don’t have permission to view this tile or open the workbook.

Please contact the dashboard owner to make sure the data sources and model exist and are accessible for your
account.

Data shapes must contain at least one group or calculation that outputs data. Please contact the
dashboard owner.

We don't have any data to display because the query is empty. Try adding some fields from the field list to your
visual and repinning it.

Can't display the data because Power BI can't determine the relationship between two or more fields.

You are trying to use two or more fields from tables that are not related. You need to remove the unrelated fields
from the visual and then create a relationship between the tables. Once you have done this, you can add the fields
back to the visual. This can be done in Power BI Desktop or Power Pivot for Excel. Learn more

The groups in the primary axis and the secondary axis overlap. Groups in the primary axis can't have
the same keys as groups in the secondary axis.

This is usually a transient issue. This will typically happen when you are moving groups from rows to columns. In
this case, the error should disappear when you finish moving all the groups. If you still see the message, try
switching fields between the rows and columns or the axis legend or removing fields from the visual.

This visual has exceeded the available resources. Try filtering to decrease the amount of data displayed.

Your visual has attempted to query too much data for us to complete the result with the available resources. Try
filtering the visual to reduce the amount of data in the result.

We are not able to identify the following fields: {0}. Please update the visual with fields that exist in the
dataset.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/refresh-troubleshooting-tile-errors.md
http://community.powerbi.com/
https://powerbi.microsoft.com/support/


Contact support

Next steps

The field was likely deleted or renamed. You can remove the broken field from the visual, add a different field, and
repin it.

Couldn't retrieve the data for this visual. Please try again later.

This is usually a transient issue. If you try again later and you still see this message, please contact support.

If you are still having an issue, please contact support to investigate further.

Troubleshooting the on-premises data gateway
Troubleshooting Power BI Personal Gateway
More questions? Try the Power BI Community

https://support.powerbi.com
http://community.powerbi.com/


How to refresh your Xero content pack credentials if
refresh failed
11/15/2017 • 1 min to read • Edit Online

If you use the Xero Power BI content pack, you may have experienced some problems with the content pack’s daily
refresh due to a recent Power BI service incident.

You can see if your content pack refreshed successfully by checking the last refresh status for your Xero dataset as
shown in the screenshot below.

If you do see that refresh failed as shown above, please follow these steps to renew your content pack credentials.

1. Click the ellipsis (...) next to your Xero dataset, then click Schedule refresh. This opens the settings page for
the Xero content pack.

2. In the Settings for Xero page, select Data source credentials > Edit credentials.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-refresh-xero-credentials.md


3. Enter your organization’s name > Next.

4. Sign in with your Xero account.



Next stepsNext steps

5. Now that your credentials are updated, let’s make sure the refresh schedule is set to run daily. Check that by
clicking the ellipsis (...) next to your Xero dataset, then clicking Schedule refresh again.

6. You can also choose to refresh the dataset immediately. Click the ellipsis (...) next to your Xero dataset, then
click Refresh now.

If you are still having refresh issues, please don’t hesitate to reach out to us at http://support.powerbi.com

To learn more about the Xero content pack for Power BI, please visit the Xero content pack help page.

More questions? Try the Power BI Community

http://support.powerbi.com
http://community.powerbi.com/


Get Power BI Desktop
1/25/2018 • 4 min to read • Edit Online

Download Power BI Desktop

Power BI Desktop lets you build advanced queries, models, and reports that visualize data. With Power BI
Desktop, you can build data models, create reports, and share your work by publishing to the Power BI service.
Power BI Desktop is a free download.

You can get Power BI Desktop in two ways, each of which is described in the following sections:

Download directly (an MSI package you download and install on your computer)
Install as an app from the Windows Store

Either approach will get the latest version of Power BI Desktop onto your computer, but there are a few
differences worth noting, which are described in the following sections.

To download the most recent version of Power BI Desktop, you can select the download icon from the upper
right corner of the Power BI service, and select Power BI Desktop.

You can also download the latest version of Power BI Desktop from the following download page:

Power BI Desktop download (both 32- and 64-bit versions).

Regardless of which way you choose to download, once Power BI Desktop is downloaded you're prompted to
run the installation file:

Power BI Desktop is installed as an application, and runs on your desktop.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-get-the-desktop.md
https://powerbi.microsoft.com/desktop
https://powerbi.microsoft.com/desktop


 

NOTENOTE

Install as an app from the Windows Store

Installing the downloaded (MSI) version, and the Windows Store version of Power BI Desktop on the same computer
(sometimes referred to as a side-by-side installation) is not supported.

You can also get Power BI Desktop from the Windows Store, using the following link:

Install Power BI Desktop from the Windows Store

There are a few advantages to getting Power BI Desktop from the Windows Store:

Automatic updates - Windows downloads the latest version automatically in the background as soon as it's
available, so your version will always be up to date.
Smaller downloads - The Windows Store ensures only components that have changed in each update are
downloaded to your machine, resulting in smaller downloads for each update.
Admin priviledge is not required - when you download the MSI directly and install, you must be an
administrator for the installation to complete successfully. When you get Power BI Desktop from the
Windows Store, admin priviledge is not required.
IT roll-out enabled - the Windows Store version can more easily be deployed, or rolled-out, to everyone in
your organization, and can make Power BI Desktop available through the Microsoft Store for Business.
Language detection - the Windows Store version includes all supported languages, and checks which
languages is being used on the computer each time it is launched. This also affects the localization of models
created in Power BI Desktop; for example, built-in date hierarchies will match the language that Power BI

http://aka.ms/pbidesktopstore


NOTENOTE

NOTENOTE

Using Power BI Desktop

Minimum requirements

Desktop was using when the .pbix file was created.

There are a few consideration and limitations for installing Power BI Desktop from the Windows Store, which
include the following:

If you use the SAP connector, you may need to move your SAP driver files to the Windows\System32 folder.

Installing the downloaded (MSI) version, and the Windows Store version of Power BI Desktop on the same computer
(sometimes referred to as a side-by-side installation) is not supported.

The Power BI Report Server version of Power BI Desktop is a separate and different installation from the versions discussed
in this article. For information about the Report Server version of Power BI Desktop, see the Quickstart: Create a Power BI
report for Power BI Report Server article.

When you launch Power BI Desktop, a Welcome screen is displayed.

If this is your first time using Power BI Desktop (if the installation is not an upgrade), you'll be prompted to fill
out a form and answer a few questions, or sign in to the Power BI service before you'll be able to proceed.

From there, you can begin creating data models or reports, then share them with others on the Power BI service.
Check out the More information links at the end of this article for links to guides that can help you get started
using Power BI Desktop.

The following list provides the minimum requirements to run Power BI Desktop:

Windows 7 / Windows Server 2008 R2, or later
.NET 4.5
Internet Explorer 9 or later



Next steps

Memory (RAM): At least 1 GB available, 1.5 GB or more recommended.
Display: At least 1440x900 or 1600x900 (16:9) recommended. Lower resolutions such as 1024x768 or
1280x800 are not recommended, as certain controls (such as closing the startup screen) display beyond those
resolutions.
Windows Display settings: If your display settings are set to change the size of text, apps, and other items to
more than 100%, you may not be able to see certain dialogs that must be closed or responded to in order to
proceed using Power BI Desktop. If you encounter this issue, check your Display settings by going to
Settings > System > Display in Windows, and use the slider to return display settings to 100%.
CPU: 1 gigahertz (GHz) or faster x86- or x64-bit processor recommended.

Once you get Power BI Desktop installed, the following content can help you get up and running quickly:

Getting Started with Power BI Desktop
Query Overview with Power BI Desktop
Data Sources in Power BI Desktop
Connect to Data in Power BI Desktop
Shape and Combine Data with Power BI Desktop
Common Query Tasks in Power BI Desktop



Getting started with Power BI Desktop
12/6/2017 • 18 min to read • Edit Online

How to use this guide

Welcome to the Power BI Desktop Getting Started Guide. This short tour of Power BI Desktop gets you
acquainted with how it works, demonstrates what it can do, and accelerates your ability to build robust data
models — along with amazing reports — that amplify your business intelligence efforts.

Prefer to watch instead of read? Feel free to take a look at our getting started video. And if you want to follow
along with the video with matching sample data, you can download this sample Excel workbook.

Power BI Desktop lets you create a collection of queries, data connections, and reports that can easily be
shared with others. Power BI Desktop integrates proven Microsoft technologies – the powerful Query engine,
data modeling, and visualizations – and works seamlessly with the online Power BI service.

With the combination of Power BI Desktop (where analysts and others can create powerful data
connections, models and reports) and the Power BI service (where Power BI Desktop reports can be shared
so users can view and interact with them), new insights from the world of data are easier to model, build,
share, and extend.

Data analysts will find Power BI Desktop a powerful, flexible, and a highly accessible tool to connect with and
shape the world of data, build robust models, and craft well-structured reports.

You can use this guide in a couple of ways – scan it for a quick overview, or read through each section for a
strong understanding of how Power BI Desktop works.

If you’re in a hurry you can do a visual sweep of this guide in just a couple minutes, and come away with a
good sense of how Power BI Desktop operates, and how to use it. Most of this guide consists of screens that
visually show how Power BI Desktop works.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-getting-started.md
http://go.microsoft.com/fwlink/?LinkID=521962
https://app.powerbi.com/
https://preview.powerbi.com/


NOTENOTE

How Power BI Desktop works

Install and run Power BI Desktop

For a more thorough understanding you can read through each section, perform the steps, and walk away
with your own Power BI Desktop file that’s ready to post onto the Power BI service, and share with others.

There is also a separate and specialized version of Power BI called Power BI Report Server, which is for customers
who need their data and reporting to remain on-premises. For use with that specialized version, there's also a separate
and specialized version of Power BI Desktop called Power BI Desktop for Power BI Report Server, which works
only with the Report Server version of Power BI. This article describes the standard Power BI Desktop.

With Power BI Desktop, you connect to data (usually multiple data sources), shape that data (with queries
that build insightful, compelling data models), and use that model to create reports (which others can
leverage, build upon, and share).

When the steps are completed to your satisfaction – connect, shape, and report – you can save that work in
Power BI Desktop file format, which is the .pbix extension. Power BI Desktop files can be shared like any other
file, but the most compelling way to share Power BI Desktop files is to upload them (share them) on the
Power BI service.

Power BI Desktop centralizes, simplifies, and streamlines what can otherwise be a scattered, disconnected,
and arduous process of designing and creating business intelligence repositories and reports.

Ready to give it a try? Let’s get started.

You can download Power BI Desktop from the Power BI service, by selecting the gear icon, then select
Power BI Desktop.

Power BI Desktop is installed as an application, and runs on your desktop.

https://preview.powerbi.com/


When you run Power BI Desktop, a Welcome screen is displayed.

You can Get Data, see Recent Sources, or Open Other Reports directly from the Welcome screen (from
the links in the left pane). If you close the screen (select the x in the top right corner), the Report view of
Power BI Desktop is displayed.



Connect to data

There are three views in Power BI Desktop: Report view, Data view, and Relationships view. Power BI
Desktop also includes Query Editor, which opens in a separate window. In Query Editor, you can build
queries and transform data, then load that refined data model into Power BI Desktop, and create reports.

The following screen shows the three view icons along the left of Power BI Desktop: Report, Data, and
Relationships, from top to bottom. The currently displayed view is indicated by the yellow bar along the left.
In this case, Report view is currently displayed. You can change views by selecting any of those three icons.

With Power BI Desktop installed you’re ready to connect to data, shape data, and build reports (usually in that
order). In the next few sections, we take a tour through each in turn.

With Power BI Desktop installed, you’re ready to connect to the ever expanding world of data. There are all
sorts of data sources available in the Query window. The following image shows how to connect to data, by
selecting the Home ribbon, then Get Data > More.



For this quick tour, we'll connect to a couple different Web data sources.

Imagine you’re retiring – you want to live where there’s lots of sunshine, preferable taxes, and good health
care – or perhaps you’re a data analyst, and you want that information to help your customers. For example,
perhaps you want to help your sunglasses retailer target sales where the sun shines most frequently.

Either way, the following Web resource has interesting data about those topics, and more:

http://www.bankrate.com/finance/retirement/best-places-retire-how-state-ranks.aspx

Select Get Data > Web and paste the address.

When you select OK, the Query functionality of Power BI Desktop goes to work. Query contacts the Web
resource, and the Navigator window returns what it found on that Web page. In this case, it found a table
(Table 0) and the overall Web Document. We’re interested in the table, so we select it from the list. The
Navigator window displays a preview.

http://www.bankrate.com/finance/retirement/best-places-retire-how-state-ranks.aspx


At this point we can edit the query before loading the table, by selecting Edit from the bottom of the window,
or we can load the table.

When we select Edit, Query Editor launches and a representative view of the table is presented. The Query
Settings pane is displayed (if it’s not, you can select View from the ribbon, then Show > Query Settings to
display the Query Settings pane). Here’s what that looks like.



Shape and combine data

Shape data

For more information about connecting to data, see Connect to Data in Power BI Desktop.

In the next section, we adjust the data so it meets our needs. The process of adjusting connected data is called
shaping data.

Now that we’ve connected to a data source, we need to adjust the data to meet our needs. Sometimes
adjusting means transforming the data – such as renaming columns or tables, changing text to numbers,
removing rows, setting the first row as headers, and so on.

The Query editor in Power BI Desktop makes ample use of right-click menus, in addition to having tasks
available on the ribbon. Most of what you can select in the Transform ribbon is also available by right-
clicking an item (such as a column) and choosing from the menu that appears.

When you shape data in the Query Editor, you’re providing step-by-step instructions (that Query Editor
carries out for you) to adjust the data as Query Editor loads and presents it. The original data source is not
affected; only this particular view of the data is adjusted, or shaped.

The steps you specify (such as rename a table, transform a data type, or delete columns) are recorded by
Query Editor, and each time this query connects to the data source those steps are carried out so that the
data is always shaped the way you specify. This process occurs whenever you use the query in Power BI
Desktop, or for anyone who uses your shared query, such as in the Power BI service. Those steps are
captured, sequentially, in the Query Settings pane under Applied Steps.

The following image shows the Query Settings pane for a query that has been shaped – we’ll go through
each of those steps in the next few paragraphs.

Let’s get back to our retirement data, which we found by connecting to a Web data source, and shape that
data to fit our needs.



For starters, most ratings were brought into Query Editor as whole numbers, but not all of them (one
column contained text and numbers, so it wasn't automatically converted). We need the data to be numbers.
No problem – just right-click the column header, and select Change Type > Whole Number to change the
data type. If we needed to choose more than one column, we could first select a column then hold down
SHIFT, select additional adjacent columns, and then right-click a column header to change all selected
columns. You can also use CTRL to select non-adjacent columns.

You can also change, or transform, those columns from text to header by using the Transform ribbon. Here’s
the Transform ribbon, with an arrow pointing toward the Data Type button, which lets you transform the
current data type to another.



Note that in Query Settings, the Applied Steps reflect the changes that were made. If I want to remove any
step from the shaping process, I simply select that step, and then select the X to the left of the step.

We need to make a few more changes to get the query where we want it:

Remove the first column – we don’t need it, it just includes redundant rows that say “Check out how your
state ranks for retirement” which is an artifact of this being a Web based table

Fix a few Errors – on the Web page, one column had text mixed in with the numbers (some states tied in
one category). That works well in the website, but not for our data analysis. It's easy (in this case) to fix,
and shows some cool features and capabilities of Query Editor and its Applied Steps

Change the Table Name – that Table 0 is not a useful descriptor, but changing it simple



Combine data

Each of these steps is demonstrated in Shape and Combine Data in Power BI Desktop. Feel free to check
out that page, or keep going in this document to see what you would do next. The next section picks up after
the changes above are applied.

That data about various states is interesting, and will be useful for building additional analysis efforts and
queries. But there’s one problem: most data out there uses a two-letter abbreviation for state codes, not the
full name of the state. We need some way to associate state names with their abbreviations.

We’re in luck: there’s another public data source that does just that, but it needs a fair amount of shaping
before we can connect it to our retirement table. Here’s the Web resource for state abbreviations:

http://en.wikipedia.org/wiki/List_of_U.S._state_abbreviations

From the Home ribbon in Query Editor, we select Get Data > Web and type the address, select OK, and the
Navigator window shows what it found on that Web page.

We select Table[edit] because it includes the data we want, but it’s going to take quite a bit of shaping to
pare that table’s data down. Each of these steps is also demonstrated in Shape and Combine Data in
Power BI Desktop. To summarize those steps, here's what we do:

We select Edit, then:

Remove the top two rows – they’re a result of the way that Web page’s table was created, and we don’t
need them.

Remove the bottom 26 rows – they’re all the territories, which we don’t need to include.

Filter out Washington DC – the retirement stats table doesn't include DC, so we'll exclude it from our list.

http://en.wikipedia.org/wiki/List_of_U.S._state_abbreviations


Remove a few unneeded columns – we only need the mapping of state to its official two-letter
abbreviation, so we can remove the other columns.

NOTENOTE

Use the first row as headers – since we removed the top three rows, the current top row is the header
we want.

This is a good time to point out that the sequence of applied steps in Query Editor is important, and can
affect how the data is shaped. It’s also important to consider how one step may impact another subsequent
step; if you remove a step from the Applied Steps, subsequent steps may not behave as originally intended,
because of the impact of the query’s sequence of steps.

Rename the columns, and the table itself – as usual, there are a couple ways to rename a column, you
can choose whichever you prefer.

With the StateCodes table shaped, we can combine these two tables, or queries, into one; since the tables we
now have are a result of the queries we applied to the data, they’re often referred to as queries.

There are two primary ways of combining queries – merging and appending.

When you have one or more columns that you’d like to add to another query, you merge the queries. When
you have additional rows of data that you’d like to add to an existing query, you append the query.

In this case we want to merge queries. To get started, we select the query into which we want the other query
to merge, then select Merge Queries from the Home tab on the ribbon.

The Merge window appears, prompting us to select which table we’d like merged into the selected table, and
then, the matching columns to use for the merge. Select State from the RetirementStats table (query), then
select the StateCodes query (easy in this case, since there’s only one other query – when you connect to
many data sources, there are many queries to choose from). When we select the correct matching columns –
State from RetirementStats, and State Name from StateCodes – the Merge window looks like the following,
and the OK button is enabled.



A NewColumn is created at the end of the query, which is the contents of the table (query) that was merged
with the existing query. All columns from the merged query are condensed into the NewColumn, but you
can select to Expand the table, and include whichever columns you want. To expand the merged table, and
select which columns to include, select the expand icon ( ). The Expand window appears.



NOTENOTE

Build reports

In this case, we only want the State Code column, so we select only that column and then select OK. We clear
the checkbox from Use original column name as prefix because we don’t need or want that; if we leave
that selected, the merged column would be named NewColumn.State Code (the original column name, or
NewColumn, then a dot, then the name of the column being brought into the query).

Want to play around with how to bring in that NewColumn table? You can experiment a bit, and if you don’t like the
results, just delete that step from the Applied Steps list in the Query Settings pane; your query returns to the state
prior to applying that Expand step. It’s like a free do-over, which you can do as many times as you like until the
expand process looks the way you want it.

We now have a single query (table) that combined two data sources, each of which has been shaped to meet
our needs. This query can serve as a basis for lots of additional, interesting data connections – such as
housing cost statistics, demographics, or job opportunities in any state.

For a more complete description of each of these shape and combine data steps, see Shape and Combine
Data in Power BI Desktop.

For now, we have enough data to create a few interesting reports, all within Power BI Desktop. Since this is a
milestone let’s save this Power BI Desktop file – we’ll call it Getting Started with Power BI Desktop. To
apply the changes in Query Editor and load them into Power BI Desktop, select Close & Apply from the
Home ribbon.

Additional changes can be made after the table is loaded, and you can reload a model to apply any changes
you make. But for now this will do. In Power BI Desktop Report view, you can begin to build reports.

The Report view has five main areas:

1. The ribbon, which displays common tasks associated with reports and visualizations
2. The Report view, or canvas, where visualizations are created and arranged
3. The Pages tab area along the bottom, which lets you select or add a report page
4. The Visualizations pane, where you can change visualizations, customize colors or axes, apply filters,

drag fields, and more
5. The Fields pane, where query elements and filters can be dragged onto the Report view, or dragged

to the Filters area of the Visualizations pane



The Visualizations and Fields pane can be collapsed by selecting the small arrow along the edge, providing
more space in the Report view to build cool visualizations. When modifying visualizations, you'll also see
these arrows pointing up or down, which means you can expand or collapse that section, accordingly.

To create a visualization, just drag a field from the Fields list onto the Report view. In this case, let’s drag the
State field from RetirementStats, and see what happens.



Look at that... Power BI Desktop automatically created a map-based visualization, because it recognized that
the State field contained geolocation data.

Notice that in the Visualizations pane, I can select different types of visualizations, and in the area below
those icons, I can drag fields to different areas to apply a Legend, or otherwise modify the visualization.

Let’s fast-forward a bit, and see what the Report view looks like after a handful of visualizations have been
added, as well as a few new Report pages. For more information about reports, see Report View in Power BI
Desktop.



Share your work

The first Report page provides a perspective of the data based on Overall rank. When we select one of the
visualizations, the Fields and Filters pane shows which fields are selected, and the structure of the
visualization (which fields are applied to the Shared Axis, Column Values, and Line Values).

There are six Pages in this Report, each visualizing certain elements of our data.

1. The first page, shown above, shows all states based on Overall rank.
2. The second page focuses on the top ten states based on Overall rank.
3. For the third page, the best 10 states for cost of living (and associated data) are visualized.
4. Weather is the focus of the fourth page, filtered to the 15 sunniest states.
5. On the fifth page, Community well-being is charted and visualized for the top 15 states.
6. Lastly, crime statistics are visualized, showing the best (and well, the last) ten states.

Here’s what the cost of living-focused Report page looks like.

There are all sorts of interesting reports and visualizations you can create.



Now that we have a Power BI Desktop report that’s reasonably complete, we can share it with others on the
Power BI service. There are a few ways to share your work in Power BI Desktop. You can publish to the
Power BI service, you can upload the .pbix file directly from the Power BI service, or you can save the .pbix
file and send it like any other file.

First, let's look at publishing to the Power BI service directly from Power BI Desktop. On the Home ribbon,
select Publish.

You may be prompted to sign in to Power BI.

When you've signed in and the publish process is complete, you see the following dialog.

When you sign in to Power BI, you'll see Power BI Desktop file you just loaded in the Dashboards, Reports,
and Datasets sections of the service.

Another way to share your work is to load it from within the Power BI service. The following link brings up
the Power BI service in a browser:

https://app.powerbi.com

Select Get Data to start the process of loading your Power BI Desktop report.



The Get Data page appears, from which you can select where to get your data from. In this case, we select
Get from the Files box.

The Files view appears. In this case, we select Local File.



When you select the file, Power BI uploads the file.

Once the file is uploaded, you can select the file from the Reports in the left pane of the Power BI service.



The Power BI service displays the first page of the report. Along the bottom of the page, you can select any
tab to display that page of the report.

You can make changes to a report in the Power BI service by selecting Edit Report from the top of the
report canvas.

To save your report, select File > Save As from the service. There are all sorts of interesting visuals you can
create in the Power BI service from your report, which you can pin to a dashboard. To learn about
dashboards in the Power BI service, see Tips for designing a great dashboard.



Once saved, select the Share icon on the main page.

From here, you can send an email to colleagues with whom you’d like to share the dashboard.

For more information about creating, sharing, and modifying dashboards, see Share a dashboard.

There are all sorts of compelling data-related mash-ups and visualizations you can do with Power BI Desktop,



Next steps

and with the Power BI service. Check out the next section for more information.

There are all sorts of things you can do with Power BI Desktop. For more information on its capabilities, check
out the following resources:

Query Overview with Power BI Desktop
Data Sources in Power BI Desktop
Connect to Data in Power BI Desktop
Shape and Combine Data with Power BI Desktop
Common Query Tasks in Power BI Desktop



What's new in the latest Power BI Desktop update?
1/11/2018 • 2 min to read • Edit Online

January 2018 Update (2.54.4970.761 )

ReportingReporting

AnalyticsAnalytics

Data connectivityData connectivity

NOTENOTE

You can now download the latest version of Power BI Desktop. If you're running Windows 10, you can also get
Power BI Desktop from the Windows Store. The monthly versions are the same, regardless of which way you
install Power BI Desktop. See this article for more information.

We're ringing in the new year with a collection of updates to Power BI Desktop, and our new year's resolution is
to keep them coming.

The links beside each update mean the following:

[video] excerpts play in a new browser tab, when the feature is being discussed.
Some features have an [article] that provides more detail.
Most features are explained in the monthly update [blog] post.
Lastly, some features are self-explanatory and don't need and article or video.

You can also watch the Latest Updates video from the beginning, right inside this article, by clicking on the play
icon on the video image found below the list of updates.

The following updates are new to Power BI Desktop this month:

Show and hide pages [video] [blog]
Control data label background color for Cartesian and maps visuals [video] [blog]
Increase the area used for axis labels in charts [video] [blog]
Bar / column padding control [video] [blog]
Show dates as a hierarchy (preview) [video] [blog]
Add an anchor date for a relative date slicer [video] [blog]
Top N selection in Q&A [blog]
Many new custom visuals [video] [blog]

Correlation coefficient quick measure [blog]

Support for Azure Active Directory authentication for Azure SQL Database and Data Warehouse connectors
[video] [blog]

You can also check out all the data sources available to Power BI Desktop; our list is always growing, so check back often.

Want more information about these updates? Take a look at the blog post, where you can get more detailed
information about each of these new features (this is the same blog post references in the list above).

The following video describes and shows each of these updates. You can also see the video from the blog post.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-latest-update.md
https://powerbi.microsoft.com/desktop
https://youtu.be/W8Pp5wuCXJw?t=20s
https://powerbi.microsoft.com/blog/power-bi-desktop-january-2018-feature-summary/#hidePages
https://youtu.be/W8Pp5wuCXJw?t=3m13s
https://powerbi.microsoft.com/blog/power-bi-desktop-january-2018-feature-summary/#dataLabelBackground
https://youtu.be/W8Pp5wuCXJw?t=5m10s
https://powerbi.microsoft.com/blog/power-bi-desktop-january-2018-feature-summary/#axisSize
https://youtu.be/W8Pp5wuCXJw?t=6m40s
https://powerbi.microsoft.com/blog/power-bi-desktop-january-2018-feature-summary/#padding
https://youtu.be/W8Pp5wuCXJw?t=7m41s
https://powerbi.microsoft.com/blog/power-bi-desktop-january-2018-feature-summary/#dateHierarchy
https://youtu.be/W8Pp5wuCXJw?t=9m22s
https://powerbi.microsoft.com/blog/power-bi-desktop-january-2018-feature-summary/#anchorDate
https://powerbi.microsoft.com/blog/power-bi-desktop-january-2018-feature-summary/#topN
https://youtu.be/W8Pp5wuCXJw?t=11m32s
https://powerbi.microsoft.com/blog/power-bi-desktop-january-2018-feature-summary/#customVisuals
https://powerbi.microsoft.com/blog/power-bi-desktop-january-2018-feature-summary/#correlationCoefficient
https://youtu.be/W8Pp5wuCXJw?t=21m42s
https://powerbi.microsoft.com/blog/power-bi-desktop-january-2018-feature-summary/#AADauth
https://powerbi.microsoft.com/blog/power-bi-desktop-january-2018-feature-summary/


NOTENOTE

More videos

Previous months' updates

You might also be interested in learning what's new in the Power BI service, and also check out what's new in the mobile
apps for Power BI.

Like learning about Power BI through videos and other engaging content? Check out the following collection of
video sources and content.

Power BI channel - Power BI on YouTube
Guy in a Cube channel - fresh videos on Power BI features and capabilities
Guided Learning for Power BI - a sequential learning tour of Power BI, in bite-size pieces

Looking for previous months' updates? You can find them in the Power BI Desktop Monthly Updates archive
article.

https://www.youtube.com/user/mspowerbi
https://www.youtube.com/channel/UCFp1vaKzpfvoGai0vE5VJ0w
https://powerbi.microsoft.com/guided-learning/


Power BI Desktop videos
12/6/2017 • 1 min to read • Edit Online

We have a YouTube channel for Power BI!

The following list describes all available videos about Power BI Desktop. Select any of the links below to view the
associated video.

High-level overview of Power BI Desktop, from getting data and building a report to uploading this report to
Power BI so it can be refreshed and shared with other users.

Learn how to build stunning reports using Power BI Desktop.

Understand how to import, reshape and transform data using Query Editor in the Power BI Desktop.



https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-videos.md
http://www.youtube.com/playlist?list=PL1N57mwBHtN2q1WbU5O29rrn_A0lkVv9p
https://www.youtube.com/watch?v=Qgam9M8I0xA
https://www.youtube.com/watch?v=ByIUx-HmQbw
https://www.youtube.com/watch?v=ByIUx-HmQbw


Previous monthly updates to Power BI Desktop
1/11/2018 • 40 min to read • Edit Online

December 2017 Update (2.53.4954.481 )

ReportingReporting

AnalyticsAnalytics

Data connectivityData connectivity

This article describes previous updates to Power BI Desktop. For the most current month's release, check out
Power BI Desktop latest updates.

The following sections describe previous months' updates to Power BI Desktop.

You can always download the latest version of Power BI Desktop. If you're running Windows 10, you can also get
Power BI Desktop from the Windows Store. The monthly versions are the same, regardless of which way you
install Power BI Desktop. See this article for more information.

December brought a Ho-Ho-Whole lot of updates to Power BI Desktop, chock full of features gifts for all business
intelligence minded kids (and adults) to enjoy.

The links beside each update mean the following:

[video] excerpts play in a new browser tab, when the feature is being discussed.
Some features have an [article] that provides more detail.
Most features are explained in the monthly update [blog] post.
Lastly, some features are self-explanatory and don't need and article or video.

You can also watch the Latest Updates video from the beginning, right inside this article, by clicking on the play
icon on the video image found below the list of updates.

The following updates were new to Power BI Desktop in December:

Q&A for report creation [video] [blog]
Cross-highlighting for bookmarks [video] [blog]
More bookmark flexibility [video] [blog]
Field properties pane and field descriptions[video] [blog]
Scatter visual from x- and y-axis groupings [video] [blog]
High density sampling for maps based on latitude and longitude [video] [blog]
Responsive slicers [video] [blog]
Recently released custom visuals [video] [blog]

Drill filters other visuals [video] [blog]

Adobe Analytics connector [video] [blog]
HDInsight Interactive Query connector [video] [blog]
Data.World connector [video] [blog]
SAP BW connector improvements [video] [blog]
IBM Netezza connector now generally available [video] [blog]

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-latest-update-archive.md
https://powerbi.microsoft.com/desktop
https://youtu.be/ZPU8B-1BxjI?t=8s
https://powerbi.microsoft.com/blog/power-bi-desktop-december-feature-summary/#QandA
https://youtu.be/ZPU8B-1BxjI?t=4m18s
https://powerbi.microsoft.com/blog/power-bi-desktop-december-feature-summary/#bookmarkCrossHighlighting
https://youtu.be/ZPU8B-1BxjI?t=4m18s
https://powerbi.microsoft.com/blog/power-bi-desktop-december-feature-summary/#bookmarkFlexibility
https://youtu.be/ZPU8B-1BxjI?t=13m19s
https://powerbi.microsoft.com/blog/power-bi-desktop-december-feature-summary/#fieldPropertiesPane
https://youtu.be/ZPU8B-1BxjI?t=15m12s
https://powerbi.microsoft.com/blog/power-bi-desktop-december-feature-summary/#scatterChart
https://youtu.be/ZPU8B-1BxjI?t=17m3s
https://powerbi.microsoft.com/blog/power-bi-desktop-december-feature-summary/#highDensityMaps
https://youtu.be/sI3yRjdnJ7w?t=20m9s
https://powerbi.microsoft.com/blog/power-bi-desktop-december-feature-summary/#responsive
https://youtu.be/ZPU8B-1BxjI?t=18m25s
https://powerbi.microsoft.com/blog/power-bi-desktop-december-feature-summary/#customVisuals
https://youtu.be/ZPU8B-1BxjI?t=28m53s
https://powerbi.microsoft.com/blog/power-bi-desktop-december-feature-summary/#drillFiltersOtherVisuals
https://youtu.be/ZPU8B-1BxjI?t=30m35s
https://powerbi.microsoft.com/blog/power-bi-desktop-december-feature-summary/#AdobeAnalytics
https://youtu.be/ZPU8B-1BxjI?t=31m13s
https://powerbi.microsoft.com/blog/power-bi-desktop-december-feature-summary/#HDInsightInteractiveQuery
https://youtu.be/sI3yRjdnJ7w?t=28m9s
https://powerbi.microsoft.com/blog/power-bi-desktop-december-feature-summary/#Data.World
https://youtu.be/sI3yRjdnJ7w?t=28m9s
https://powerbi.microsoft.com/blog/power-bi-desktop-december-feature-summary/#SAPBW
https://youtu.be/sI3yRjdnJ7w?t=28m9s
https://powerbi.microsoft.com/blog/power-bi-desktop-december-feature-summary/#IBMNetezza


NOTENOTE

NOTENOTE

November 2017 Update (2.52.4921.202)

ReportingReporting

You can also check out all the data sources available to Power BI Desktop; our list is always growing, so check back often.

Want more information about these updates? Take a look at the blog post, where you can get more detailed
information about each of these new features (this is the same blog post references in the list above).

The following video describes and shows each of these updates. You can also see the video from the blog post.

You might also be interested in learning what's new in the Power BI service, and also check out what's new in the mobile
apps for Power BI.

November brought a whole harvest worth of updates to Power BI Desktop.

The links beside each update mean the following:

[video] excerpts play in a new browser tab, when the feature is being discussed.
Some features have an [article] that provides more detail.
Most features are explained in the monthly update [blog] post.
Lastly, some features are self-explanatory and don't need and article or video.

You can also watch the Latest Updates video from the beginning, right inside this article, by clicking on the play
icon on the video image found below the list of updates.

The following updates were new to Power BI Desktop in November:

Rule-based conditional formatting for Table and Matrix visuals [video] [blog]
Cell alignment for Table and Matrix visuals [video] [blog]
Control visual ordering through the selection pane [video] [blog]
Lock objects on your report [video] [blog]
Esri Plus Subscription is available for ArcGIS Maps for Power BI [video] [blog]
Report options for slow data sources [video] [blog]
Filtering performance improvements [video] [blog]
Recently released custom visuals [video] [blog]

https://powerbi.microsoft.com/blog/power-bi-desktop-december-feature-summary/
https://youtu.be/sI3yRjdnJ7w?t=55s
https://powerbi.microsoft.com/blog/power-bi-desktop-november-2017-feature-summary/#conditionalFormatting
https://youtu.be/sI3yRjdnJ7w?t=4m16s
https://powerbi.microsoft.com/blog/power-bi-desktop-november-2017-feature-summary/#alignment
https://youtu.be/sI3yRjdnJ7w?t=6m21s
https://powerbi.microsoft.com/blog/power-bi-desktop-november-2017-feature-summary/#selectionPane
https://youtu.be/sI3yRjdnJ7w?t=9m2s
https://powerbi.microsoft.com/blog/power-bi-desktop-november-2017-feature-summary/#lock
https://youtu.be/sI3yRjdnJ7w?t=10m31s
https://powerbi.microsoft.com/blog/power-bi-desktop-november-2017-feature-summary/#esriPlus
https://youtu.be/sI3yRjdnJ7w?t=16m11s
https://powerbi.microsoft.com/blog/power-bi-desktop-november-2017-feature-summary/#slowDataSource
https://youtu.be/sI3yRjdnJ7w?t=20m9s
https://powerbi.microsoft.com/blog/power-bi-desktop-november-2017-feature-summary/#filtering
https://youtu.be/sI3yRjdnJ7w?t=20m50s
https://powerbi.microsoft.com/blog/power-bi-desktop-november-2017-feature-summary/#customVisuals
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October 2017 Update (2.51.4885.543)

Reporting:Reporting:

Cell-level formatting for multidimensional AS models for multi-row card [video] [blog]

Impala connector - support for Windows Authentication [video] [blog]

Query editing - Add Column from Example improvements [video] [blog]

You can also check out all the data sources available to Power BI Desktop; our list is always growing, so check back often.

Want more information about these updates? Take a look at the blog post, where you can get more detailed
information about each of these new features (this is the same blog post references in the list above).

The following video describes and shows each of these updates. You can also see the video from the blog post.

You might also be interested in learning what's new in the Power BI service, and also check out what's new in the mobile
apps for Power BI.

October brought a frighteningly compelling group of useful updates to Power BI Desktop.

The links beside each update mean the following:

[video] excerpts play in a new browser tab, when the feature is being discussed.
Some features have an [article] that provides more detail.
Most features are explained in the monthly update [blog] post.
Lastly, some features are self-explanatory and don't need and article or video.

You can also watch the Latest Updates video from the beginning, right inside this article, by clicking on the play
icon on the video image found below the list of updates.

The following updates are new to Power BI Desktop this month:

Bookmarking (preview) [video] [blog] [article]

https://youtu.be/sI3yRjdnJ7w?t=27m25s
https://powerbi.microsoft.com/blog/power-bi-desktop-november-2017-feature-summary/#cellLevelFormatting
https://youtu.be/sI3yRjdnJ7w?t=28m9s
https://powerbi.microsoft.com/blog/power-bi-desktop-november-2017-feature-summary/#impala
https://youtu.be/sI3yRjdnJ7w?t=28m34s
https://powerbi.microsoft.com/blog/power-bi-desktop-november-2017-feature-summary/#addColumnFromExamples
https://powerbi.microsoft.com/blog/power-bi-desktop-november-2017-feature-summary
https://youtu.be/jksjtR8GnBE?t=1m47s
https://powerbi.microsoft.com/blog/power-bi-desktop-october-2017-feature-summary/#bookmarking
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Other:Other:

NOTENOTE
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September 2017 Update (2.50.4859.502)

Report View:Report View:

Selection pane and visual display controls [video] [blog] [article]
Bookmark links for shapes and images [video] [blog] [article]
Spotlight [video] [blog] [article]
Scatter and Bubble markers [video] [blog] [article]
Increase the number of data points displayed in Scatter visuals [video] [blog]

Quick measures for SSAS live connections [video] [blog] [article]
Sales from new customers quick measure [video] [blog] [article]
Cell-level formatting for multi-dimensional Analysis Services (AS) models [video] [blog]

Vertica connector (beta) [video] [blog] [article]
SAP BW connector - support for additional member properties [video] [blog]

Get Power BI Desktop from the Windows Store [video] [blog] [article]
Improved access to help content [video] [blog]

You can also check out all the data sources available to Power BI Desktop; our list is always growing, so check back often.

Want more information about these updates? Take a look at the blog post, where you can get more detailed
information about each of these new features (this is the same blog post references in the list above).

The following video describes and shows each of these updates. You can also see the video from the blog post.

You might also be interested in learning what's new in the Power BI service, and also check out what's new in the mobile
apps for Power BI.

The following updates are new to Power BI Desktop in September:

Drillthrough to another report page [video] [blog] [article]

https://youtu.be/jksjtR8GnBE?t=7m26s
https://powerbi.microsoft.com/blog/power-bi-desktop-october-2017-feature-summary/#selectionPane
https://youtu.be/jksjtR8GnBE?t=8m54s
https://powerbi.microsoft.com/blog/power-bi-desktop-october-2017-feature-summary/#links
https://youtu.be/jksjtR8GnBE?t=5m39s
https://powerbi.microsoft.com/blog/power-bi-desktop-october-2017-feature-summary/#spotlight
https://youtu.be/jksjtR8GnBE?t=17m20s
https://powerbi.microsoft.com/blog/power-bi-desktop-october-2017-feature-summary/#markers
https://youtu.be/jksjtR8GnBE?t=19m51s
https://powerbi.microsoft.com/blog/power-bi-desktop-october-2017-feature-summary/#dataVolume
https://youtu.be/jksjtR8GnBE?t=22m35s
https://powerbi.microsoft.com/blog/power-bi-desktop-october-2017-feature-summary/#liveConnectQuickMeasures
https://youtu.be/jksjtR8GnBE?t=23m16s
https://powerbi.microsoft.com/blog/power-bi-desktop-october-2017-feature-summary/#newCustomers
https://youtu.be/jksjtR8GnBE?t=25m28s
https://powerbi.microsoft.com/blog/power-bi-desktop-october-2017-feature-summary/#cellLevelFormatting
https://youtu.be/jksjtR8GnBE?t=25m55s
https://powerbi.microsoft.com/blog/power-bi-desktop-october-2017-feature-summary/#vertica
https://youtu.be/jksjtR8GnBE?t=26m39s
https://powerbi.microsoft.com/blog/power-bi-desktop-october-2017-feature-summary/#sapBW
https://youtu.be/jksjtR8GnBE?t=27m12s
https://powerbi.microsoft.com/blog/power-bi-desktop-october-2017-feature-summary/#windowsStore
https://youtu.be/jksjtR8GnBE?t=28m42s
https://powerbi.microsoft.com/blog/power-bi-desktop-october-2017-feature-summary/#help
https://powerbi.microsoft.com/blog/power-bi-desktop-october-2017-feature-summary
https://youtu.be/moTQJlnClJw?t=19s
https://powerbi.microsoft.com/blog/power-bi-desktop-september-2017-feature-summary/#drillthrough


Data Connectivity:Data Connectivity:
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August 2017 Update (2.49.4831.222)

Report View:Report View:

Ribbon chart [video] [blog] [article]
Insights about Explain the increase / Explain the decrease [video] [blog] [article]
Theming preview update - chart style controls [video] [blog] [article]
Accessibility improvements [video] [blog] [article]

High density scatter chart sampling [video] [blog] [article]
Gridline style control [video] [blog] [article]
New custom visuals [video] [blog]

Accessible See data [video] [blog] [article]
Keyboard shortcut helper dialog [video] [blog] [article]

Calendar by Tallan [video] [blog]
Enlighten Aquarium [video] [blog]
Visio visual (preview) [video] [blog]
Impact bubble chart [video] [blog]

Azure Consumption Insights connector [video] [blog] [article]
Improvements to the Dynamics 365 for Financials connector [video] [blog]

You can also check out all the data sources available to Power BI Desktop; our list is always growing, so check back often.

Want more information about these updates? Take a look at the blog post, where you can get more detailed
information about each of these new features (this is the same blog post references in the list above).

The following video describes and shows each of these updates. You can also see the video from the blog post.

You might also be interested in learning what's new in the Power BI service, and also check out what's new in the mobile
apps for Power BI.

The following updates were new to Power BI Desktop in August:

Show values on rows for matrix [video] [blog]

https://youtu.be/moTQJlnClJw?t=8m57s
https://powerbi.microsoft.com/blog/power-bi-desktop-september-2017-feature-summary/#ribbon
https://youtu.be/moTQJlnClJw?t=13m37s
https://powerbi.microsoft.com/blog/power-bi-desktop-september-2017-feature-summary/#insights
https://youtu.be/moTQJlnClJw?t=19m25s
https://powerbi.microsoft.com/blog/power-bi-desktop-september-2017-feature-summary/#theming
https://youtu.be/moTQJlnClJw?t=27m25s
https://powerbi.microsoft.com/blog/power-bi-desktop-september-2017-feature-summary/#accessibility
https://youtu.be/moTQJlnClJw?t=29m40s
https://powerbi.microsoft.com/blog/power-bi-desktop-september-2017-feature-summary/#accessibleData
https://youtu.be/moTQJlnClJw?t=28m50s
https://powerbi.microsoft.com/blog/power-bi-desktop-september-2017-feature-summary/#shortcuts
https://youtu.be/moTQJlnClJw?t=30m22s
https://powerbi.microsoft.com/blog/power-bi-desktop-september-2017-feature-summary/#highDensityScatter
https://youtu.be/moTQJlnClJw?t=33m53s
https://powerbi.microsoft.com/blog/power-bi-desktop-september-2017-feature-summary/#gridlines
https://youtu.be/moTQJlnClJw?t=36m4s
https://powerbi.microsoft.com/blog/power-bi-desktop-september-2017-feature-summary/#communityVisuals
https://youtu.be/moTQJlnClJw?t=36m26s
https://powerbi.microsoft.com/blog/power-bi-desktop-september-2017-feature-summary/#calendarByTallan
https://youtu.be/moTQJlnClJw?t=38m11s
https://powerbi.microsoft.com/blog/power-bi-desktop-september-2017-feature-summary/#enlightenAquarium
https://youtu.be/moTQJlnClJw?t=40m15s
https://powerbi.microsoft.com/blog/power-bi-desktop-september-2017-feature-summary/#visio
https://youtu.be/moTQJlnClJw?t=42m25s
https://powerbi.microsoft.com/blog/power-bi-desktop-september-2017-feature-summary/#impactBubbleChart
https://youtu.be/moTQJlnClJw?t=44m57s
https://powerbi.microsoft.com/blog/power-bi-desktop-september-2017-feature-summary/#azureConsumptionInsights
https://youtu.be/moTQJlnClJw?t=45m39s
https://powerbi.microsoft.com/blog/power-bi-desktop-september-2017-feature-summary/#dynamics365ForFinancials
https://powerbi.microsoft.com/blog/power-bi-desktop-september-2017-feature-summary
https://youtu.be/ND8U0yXroaQ?t=39s
https://powerbi.microsoft.com/blog/power-bi-desktop-august-2017-feature-summary/#valuesOnRows
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July 2017 Update (2.48.4792.321)

Color scales on font colors for table and matrix [video] [blog]
Custom subtotal settings per level of matrix [video] [blog]
Line styles and legend options [video] [blog]
Scatter chart performance improvements [video] [blog]
New custom visuals [video] [blog]

Dot Plot by MAQ Software [video] [blog]
Power KPI [video] [blog]
Funnel plot [video] [blog]
Beyondsoft Calendar [video] [blog]

What if parameters [video] [blog]
New scatter chart analytics features [video] [blog]

New quick measure: weighted average [video] [blog]

Symmetry shading [video] [blog]
Ratio lines [video] [blog]

Live connect to the Power BI service is generally available [video] [blog]
Google BigQuery connector (beta) [video] [blog]

You can also check out all the data sources available to Power BI Desktop; our list is always growing, so check back often.

Want more information about these updates? Take a look at the blog post, where you can get more detailed
information about each of these new features (this is the same blog post references in the list above).

The following video describes and shows each of these updates. You can also see the video from the blog post.

You might also be interested in learning what's new in the Power BI service, and also check out what's new in the mobile
apps for Power BI.

The following updates were new to Power BI Desktop in July:

https://youtu.be/ND8U0yXroaQ?t=2m8s
https://powerbi.microsoft.com/blog/power-bi-desktop-august-2017-feature-summary/#fontColorScales
https://youtu.be/ND8U0yXroaQ?t=4m29s
https://powerbi.microsoft.com/blog/power-bi-desktop-august-2017-feature-summary/#customSubtotal
https://youtu.be/ND8U0yXroaQ?t=6m54s
https://powerbi.microsoft.com/blog/power-bi-desktop-august-2017-feature-summary/#lineStyles
https://youtu.be/ND8U0yXroaQ?t=13m59s
https://powerbi.microsoft.com/blog/power-bi-desktop-august-2017-feature-summary/#scatterChartPerformance
https://youtu.be/ND8U0yXroaQ?t=14m32s
https://powerbi.microsoft.com/blog/power-bi-desktop-august-2017-feature-summary/#customVisuals
https://youtu.be/ND8U0yXroaQ?t=14m45s
https://powerbi.microsoft.com/blog/power-bi-desktop-august-2017-feature-summary/#dotPlot
https://youtu.be/ND8U0yXroaQ?t=19m11s
https://powerbi.microsoft.com/blog/power-bi-desktop-august-2017-feature-summary/#powerKPI
https://youtu.be/ND8U0yXroaQ?t=21m55s
https://powerbi.microsoft.com/blog/power-bi-desktop-august-2017-feature-summary/#funnelPlot
https://youtu.be/ND8U0yXroaQ?t=23m23s
https://powerbi.microsoft.com/blog/power-bi-desktop-august-2017-feature-summary/#beyondsoftCalendar
https://youtu.be/ND8U0yXroaQ?t=24m51s
https://powerbi.microsoft.com/blog/power-bi-desktop-august-2017-feature-summary/#whatIf
https://youtu.be/ND8U0yXroaQ?t=32m21s
https://powerbi.microsoft.com/blog/power-bi-desktop-august-2017-feature-summary/#scatterChartAnalytics
https://youtu.be/ND8U0yXroaQ?t=32m40s
https://powerbi.microsoft.com/blog/power-bi-desktop-august-2017-feature-summary/#symmetryShading
https://youtu.be/ND8U0yXroaQ?t=35m3s
https://powerbi.microsoft.com/blog/power-bi-desktop-august-2017-feature-summary/#ratioLine
https://youtu.be/ND8U0yXroaQ?t=36m54s
https://powerbi.microsoft.com/blog/power-bi-desktop-august-2017-feature-summary/#weightedAverage
https://youtu.be/ND8U0yXroaQ?t=41m15s
https://powerbi.microsoft.com/blog/power-bi-desktop-august-2017-feature-summary/#liveConnect
https://youtu.be/ND8U0yXroaQ?t=44m15s
https://powerbi.microsoft.com/blog/power-bi-desktop-august-2017-feature-summary/#GoogleBigQuery
https://powerbi.microsoft.com/blog/power-bi-desktop-august-2017-feature-summary
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New table & matrix visuals are now generally available [video] [blog]
Renaming fields in visuals [video] [blog]
Custom visuals store integration [video] [blog]
Relative date filters [video] [blog]
Responsive layout for visuals (preview) [video] [blog]
New waterfall chart option - breakdown [video] [blog]
Custom visual updates [video] [blog]

Drilldown Choropleth [video] [blog]
Drilldown Cartogram [video] [blog]
Drilldown Player [video] [blog]
Certified custom visuals [blog]

Quick measures from the community [video] [blog]

Bidirectional cross filtering for DirectQuery is now generally available [video] [blog]

Star rating [video] [blog]
Concatenated list of values [video] [blog]

Snowflake connector general availability [video] [blog]

Add Column from Examples enhancements [video] [blog]

You can also check out all the data sources available to Power BI Desktop; our list is always growing, so check back often.

Want more information about these updates? Take a look at the blog post, where you can get more detailed
information about each of these new features (this is the same blog post references in the list above).

The following video describes and shows each of these updates. You can also see the video from the blog post.

You might also be interested in learning what's new in the Power BI service, and also check out what's new in the mobile
apps for Power BI.

https://youtu.be/4X96ow7FnSY?t=1m27s
https://powerbi.microsoft.com/blog/power-bi-desktop-july-feature-summary-2/#tableAndMatrix
https://youtu.be/4X96ow7FnSY?t=6m3s
https://powerbi.microsoft.com/blog/power-bi-desktop-july-feature-summary-2/#rename
https://youtu.be/4X96ow7FnSY?t=8m7s
https://powerbi.microsoft.com/blog/power-bi-desktop-july-feature-summary-2/#customVisualsStore
https://youtu.be/4X96ow7FnSY?t=10m46s
https://powerbi.microsoft.com/blog/power-bi-desktop-july-feature-summary-2/#relativeDateFilter
https://youtu.be/4X96ow7FnSY?t=12m14s
https://powerbi.microsoft.com/blog/power-bi-desktop-july-feature-summary-2/#responsiveVisuals
https://youtu.be/4X96ow7FnSY?t=14m29s
https://powerbi.microsoft.com/blog/power-bi-desktop-july-feature-summary-2/#waterfall
https://youtu.be/4X96ow7FnSY?t=17m34s
https://powerbi.microsoft.com/blog/power-bi-desktop-july-feature-summary-2/#customVisuals
https://youtu.be/4X96ow7FnSY?t=18m11s
https://powerbi.microsoft.com/blog/power-bi-desktop-july-feature-summary-2/#drilldownChoropleth
https://youtu.be/4X96ow7FnSY?t=19m14s
https://powerbi.microsoft.com/blog/power-bi-desktop-july-feature-summary-2/#drilldownCartogram
https://youtu.be/4X96ow7FnSY?t=20m17s
https://powerbi.microsoft.com/blog/power-bi-desktop-july-feature-summary-2/#drilldownPlayer
https://powerbi.microsoft.com/blog/power-bi-desktop-july-feature-summary-2/#certifiedCustomVisuals
https://youtu.be/4X96ow7FnSY?t=22m6s
https://powerbi.microsoft.com/blog/power-bi-desktop-july-feature-summary-2/#quickMeasures
https://youtu.be/4X96ow7FnSY?t=22m53s
https://powerbi.microsoft.com/blog/power-bi-desktop-july-feature-summary-2/#starRating
https://youtu.be/4X96ow7FnSY?t=24m43s
https://powerbi.microsoft.com/blog/power-bi-desktop-july-feature-summary-2/#concatenate
https://youtu.be/4X96ow7FnSY?t=26m54s
https://powerbi.microsoft.com/blog/power-bi-desktop-july-feature-summary-2/#bidirectional
https://youtu.be/4X96ow7FnSY?t=27m24s
https://powerbi.microsoft.com/blog/power-bi-desktop-july-feature-summary-2/#snowflake
https://youtu.be/4X96ow7FnSY?t=27m54s
https://powerbi.microsoft.com/blog/power-bi-desktop-july-feature-summary-2/#addColumnFromExamples
https://powerbi.microsoft.com/blog/power-bi-desktop-july-feature-summary-2


June 2017 Update (2.47.4766.542)
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The following updates were new to Power BI Desktop in June:

Data bars for new table and matrix visuals (Preview) [video] [blog]
Markers on line, area, and combo visuals (Preview) [video] [blog]
Visual font family setting [video] [blog]
Horizontal image slicer [video] [blog]
Combo chart formatting updates [video] [blog]
Bing maps improvements [video] [article] [blog]
High density line sampling [video] [article] [blog]
Accessible reports [video] [article] [blog]

Custom Data Connectors support [video] [blog]
Power BI service Live Connect to on-premises and push streaming datasets [video] [blog]
Impala connector is now generally available [video] [blog]
Amazon Redshift connector is now generally available [video] [blog]
SAP BW connector - DirectQuery support [video] [blog]
IBM Netezza connector (beta) [video] [blog]

Add Column from Examples enhancements [video] [article] [blog]

You can also check out all the data sources available to Power BI Desktop; our list is always growing, so check back often.

Want more information about these updates? Take a look at the blog post, where you can get more detailed
information about each of these new features (this is the same blog post referenced in the list above).

The following video describes and shows each of these updates. You can also see the video from the blog post.

You might also be interested in learning what's new in the Power BI service, and also check out what's new in the mobile
apps for Power BI.

https://youtu.be/YlNVE5dgcSI?t=1m17s
https://powerbi.microsoft.com/blog/power-bi-desktop-june-feature-summary/#dataBars
https://youtu.be/YlNVE5dgcSI?t=4m4s
https://powerbi.microsoft.com/blog/power-bi-desktop-june-feature-summary/#markers
https://youtu.be/YlNVE5dgcSI?t=6m59s
https://powerbi.microsoft.com/blog/power-bi-desktop-june-feature-summary/#fonts
https://youtu.be/YlNVE5dgcSI?t=8m42s
https://powerbi.microsoft.com/blog/power-bi-desktop-june-feature-summary/#imageSlicer
https://youtu.be/YlNVE5dgcSI?t=9m58s
https://powerbi.microsoft.com/blog/power-bi-desktop-june-feature-summary/#comboChart
https://youtu.be/YlNVE5dgcSI?t=11m47s
https://powerbi.microsoft.com/blog/power-bi-desktop-june-feature-summary/#maps
https://youtu.be/YlNVE5dgcSI?t=16m53s
https://powerbi.microsoft.com/blog/power-bi-desktop-june-feature-summary/#highDensityLine
https://youtu.be/YlNVE5dgcSI?t=19m23s
https://powerbi.microsoft.com/blog/power-bi-desktop-june-feature-summary/#accessibility
https://youtu.be/YlNVE5dgcSI?t=25m53s
https://powerbi.microsoft.com/blog/power-bi-desktop-june-feature-summary/#customConnectors
https://youtu.be/YlNVE5dgcSI?t=26m42s
https://powerbi.microsoft.com/blog/power-bi-desktop-june-feature-summary/#liveConnect
https://youtu.be/YlNVE5dgcSI?t=27m20s
https://powerbi.microsoft.com/blog/power-bi-desktop-june-feature-summary/#impala
https://youtu.be/YlNVE5dgcSI?t=27m20s
https://powerbi.microsoft.com/blog/power-bi-desktop-june-feature-summary/#redshift
https://youtu.be/YlNVE5dgcSI?t=27m45s
https://powerbi.microsoft.com/blog/power-bi-desktop-june-feature-summary/#sapBW
https://youtu.be/YlNVE5dgcSI?t=28m15s
https://powerbi.microsoft.com/blog/power-bi-desktop-june-feature-summary/#netezza
https://youtu.be/YlNVE5dgcSI?t=28m38s
https://powerbi.microsoft.com/blog/power-bi-desktop-june-feature-summary/#addColumn
https://powerbi.microsoft.com/blog/power-bi-desktop-june-feature-summary
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The following updates were new to Power BI Desktop in May:

Relative date slicer (Preview) [video] [blog]
New table visual (Preview) [video] [blog]
Combo chart data label enhancements [video] [blog]
More URL support in table and matrix visuals [video] [blog]
mailto links in textbox [video] [blog]

Report level measures for live connections to Analysis Services tabular models and Power BI service datasets
[video] [blog]
Two new quick measures (Preview) [video] [blog]
Bin by count [video] [blog]

Combine files - ability to reference First File as example [video] [blog]
New data connectors:

Dynamics 365 for Customer Insights [video] [blog]

Two new transforms:
Extract text before/after/between delimiters [video] [blog]
Unpivot only selected columns [video] [blog]

You can also check out all the data sources available to Power BI Desktop; our list is always growing, so check back often.

Want more information about these updates? Take a look at the blog post, where you can get more detailed
information about each of these new features (this is the same blog post referenced in the list above).

The following video describes and shows each of these updates. You can also see the video from the blog post.

https://youtu.be/CKISVNHcHVA?t=8m5s
https://powerbi.microsoft.com/blog/power-bi-desktop-may-feature-summary/#relativeDateSlicer
https://youtu.be/CKISVNHcHVA?t=20s
https://powerbi.microsoft.com/blog/power-bi-desktop-may-feature-summary/#table
https://youtu.be/CKISVNHcHVA?t=5m49s
https://powerbi.microsoft.com/blog/power-bi-desktop-may-feature-summary/#comboChart
https://youtu.be/CKISVNHcHVA?t=3m8s
https://powerbi.microsoft.com/blog/power-bi-desktop-may-feature-summary/#urlTables
https://youtu.be/CKISVNHcHVA?t=11m34s
https://powerbi.microsoft.com/blog/power-bi-desktop-may-feature-summary/#mailtoTextbox
https://youtu.be/CKISVNHcHVA?t=12m48s
https://powerbi.microsoft.com/blog/power-bi-desktop-may-feature-summary/#reportLevelMeasures
https://youtu.be/CKISVNHcHVA?t=15m39s
https://powerbi.microsoft.com/blog/power-bi-desktop-may-feature-summary/#quickMeasures
https://youtu.be/CKISVNHcHVA?t=18m22s
https://powerbi.microsoft.com/blog/power-bi-desktop-may-feature-summary/#binByCount
https://youtu.be/CKISVNHcHVA?t=21m30s
https://powerbi.microsoft.com/blog/power-bi-desktop-may-feature-summary/#combineFiles
https://youtu.be/CKISVNHcHVA?t=21m2s
https://powerbi.microsoft.com/blog/power-bi-desktop-may-feature-summary/#customerInsights
https://youtu.be/CKISVNHcHVA?t=22m52s
https://powerbi.microsoft.com/blog/power-bi-desktop-may-feature-summary/#extractText
https://youtu.be/CKISVNHcHVA?t=24m42s
https://powerbi.microsoft.com/blog/power-bi-desktop-may-feature-summary/#unpivot
https://powerbi.microsoft.com/blog/power-bi-desktop-may-feature-summary/
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April 2017 Update (2.45.4704.442)
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You might also be interested in learning what's new in the Power BI service, and also check out what's new in the mobile
apps for Power BI.

The following updates were new to Power BI Desktop in April 2017:

Rename axis titles [video] [blog]
New matrix visual enhancements: column sorting, column resizing, and word wrap (Preview) [video] [article]
[blog]

Quick measures [video] [blog] [in-depth blog] [article]
Show value as [video] [blog]
Q&A in Spanish (Preview) [video] [blog]

Connect to datasets in the Power BI service (Preview) [video] [article] [blog]
New or enhanced data connectors:

Redshift Connector: beta support, and Publish to Power BI service [video] [blog]
SAP HANA and BW: enhancements to parameter input experience [video] [blog]

Add Column from Example [video] [article] [blog] [another blog]
Split column (by delimiter/number of characters) into rows [video] [blog]
Group by: basic mode [video] [blog]
Go to column [video] [blog]

You can also check out all the data sources available to Power BI Desktop; our list is always growing, so check back often.

Want more information about these updates? Take a look at the blog post, where you can get more detailed
information about each of these new features (this is the same blog post referenced in the list above).

The following video describes and shows each of these updates. You can also see the video from the blog post.

https://youtu.be/AWMaIaI8G2Y?t=25s
https://powerbi.microsoft.com/blog/power-bi-desktop-april-feature-summary/#renameAxisTitles
https://youtu.be/AWMaIaI8G2Y?t=1m32s
https://powerbi.microsoft.com/blog/power-bi-desktop-april-feature-summary/#matrix
https://youtu.be/AWMaIaI8G2Y?t=3m43s
https://powerbi.microsoft.com/blog/power-bi-desktop-april-feature-summary/#quickMeasures
https://powerbi.microsoft.com/blog/quick-measures-preview/
https://youtu.be/AWMaIaI8G2Y?t=3m43s
https://powerbi.microsoft.com/blog/power-bi-desktop-april-feature-summary/#quickMeasures
https://youtu.be/AWMaIaI8G2Y?t=10m31s
https://powerbi.microsoft.com/blog/power-bi-desktop-april-feature-summary/#QandA
https://youtu.be/AWMaIaI8G2Y?t=12m39s
https://powerbi.microsoft.com/blog/power-bi-desktop-april-feature-summary/#powerBIservice
https://youtu.be/AWMaIaI8G2Y?t=14m44s
https://powerbi.microsoft.com/blog/power-bi-desktop-april-feature-summary/#redshift
https://youtu.be/AWMaIaI8G2Y?t=15m17s
https://powerbi.microsoft.com/blog/power-bi-desktop-april-feature-summary/#SAP
https://youtu.be/-ykbVW9wQfw
https://powerbi.microsoft.com/blog/power-bi-desktop-april-feature-summary/#addColumnByExample
https://powerbi.microsoft.com/blog/a-sneak-preview-of-the-new-add-column-from-examples-data-transformation/
https://youtu.be/AWMaIaI8G2Y?t=16m39s
https://powerbi.microsoft.com/blog/power-bi-desktop-april-feature-summary/#splitColumnIntoRows
https://youtu.be/AWMaIaI8G2Y?t=17m51s
https://powerbi.microsoft.com/blog/power-bi-desktop-april-feature-summary/#basicGroupBy
https://youtu.be/AWMaIaI8G2Y?t=18m20s
https://powerbi.microsoft.com/blog/power-bi-desktop-april-feature-summary/#goToColumn
https://powerbi.microsoft.com/blog/power-bi-desktop-april-feature-summary/
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March 2017 Update (2.44.4675.422)

Report View:Report View:

Analytics:Analytics:

Data Connectivity:Data Connectivity:

Query Editing improvementsQuery Editing improvements

NOTENOTE

You might also be interested in learning what's new in the Power BI service, and also check out what's new in the mobile
apps for Power BI.

The following updates were new to Power BI Desktop in March 2017:

New matrix visual (Preview) [video] [article] [blog]
Numeric range slicer (Preview) [video] [article] [blog]
Data labels on pie and donut visuals - percent of total [video] [blog]
Cross-highlight using multiple series [video] [blog]
Textbox - ability to choose font color [video] [blog]
Report theming (Preview) [video] [article] [blog]

Clustering - now generally available [video] [blog]

New or enhanced data connectors [video]:
Azure Analysis Services database (Beta) [blog]
Azure Data Lake Store - now generally available [blog]
DB2 connector - option to specify package collection [video] [blog]
Combine binaries - specify a sample file to use [video] [blog]

Split column by delimiter - automatic detection of delimiter character [video] [blog]

You can also check out all the data sources available to Power BI Desktop; our list is always growing, so check back often.

Want more information about these updates? Take a look at the blog post, where you can get more detailed
information about each of these new features (this is the same blog post referenced in the list above).

The following video describes and shows each of these updates. You can also see the video from the blog post.

https://youtu.be/CaRTON3lJqw?t=18s
https://powerbi.microsoft.com/blog/power-bi-desktop-march-feature-summary/#matrix
https://youtu.be/CaRTON3lJqw?t=8m20s
https://powerbi.microsoft.com/blog/power-bi-desktop-march-feature-summary/#rangeSlicer
https://youtu.be/CaRTON3lJqw?t=10m52s
https://powerbi.microsoft.com/blog/power-bi-desktop-march-feature-summary/#dataLabels
https://youtu.be/CaRTON3lJqw?t=11m57s
https://powerbi.microsoft.com/blog/power-bi-desktop-march-feature-summary/#crossHighlight
https://youtu.be/CaRTON3lJqw?t=13m17s
https://powerbi.microsoft.com/blog/power-bi-desktop-march-feature-summary/#textbox
https://youtu.be/CaRTON3lJqw?t=15m8s
https://powerbi.microsoft.com/blog/power-bi-desktop-march-feature-summary/#theme
https://youtu.be/CaRTON3lJqw?t=19m21s
https://powerbi.microsoft.com/blog/power-bi-desktop-march-feature-summary/#clustering
https://youtu.be/CaRTON3lJqw?t=21m14s
https://powerbi.microsoft.com/blog/power-bi-desktop-march-feature-summary/#azureAnalysisServices
https://powerbi.microsoft.com/blog/power-bi-desktop-march-feature-summary/#azureDataLakeStore
https://youtu.be/CaRTON3lJqw?t=22m
https://powerbi.microsoft.com/blog/power-bi-desktop-march-feature-summary/#db2
https://youtu.be/CaRTON3lJqw?t=22m41s
https://powerbi.microsoft.com/blog/power-bi-desktop-march-feature-summary/#combineBinaries
https://youtu.be/CaRTON3lJqw?t=23m56s
https://powerbi.microsoft.com/blog/power-bi-desktop-march-feature-summary/#splitColumn
https://powerbi.microsoft.com/blog/power-bi-desktop-march-feature-summary/
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February 2017 Update (2.43.4647.541)
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You might also be interested in learning what's new in the Power BI service, and also check out what's new in the mobile
apps for Power BI.

The following updates were new to Power BI Desktop in February:

Word wrap on matrix row headers [video] [blog]
X- and Y-axis font size control [video] [blog]
Cartesian chart minimum category width [video] [blog]
Line chart line thickness and join type controls [video] [blog]

Two new Quick Calcs: Percent of row total, and percent of column total [video] [blog]

New or enhanced data connectors [video]:
ODBC and OLE DB connectors - support for Select related tables [blog]
Enhanced Folder connector - support for combining binaries from the Preview dialog [video] [blog]
Unified Text and CSV connectors [video] [blog]
New - PowerApps Common Data Service connector [blog]

Quickly change a column's data type and locale with the new Using locale option in the Column headers type
menu [video] [blog]
Easily insert steps into existing queries, using the new Insert Step After option [video] [blog]

Solutions Templates and Partner Showcase quick access [video] [blog]

You can also check out all the data sources available to Power BI Desktop; our list is always growing, so check back often.

Want more information about these updates? Take a look at the blog post, where you can get more detailed

https://youtu.be/mn75-LOPxMA?t=21s
https://powerbi.microsoft.com/blog/power-bi-desktop-february-feature-summary/#wordWrap
https://youtu.be/mn75-LOPxMA?t=2m3s
https://powerbi.microsoft.com/blog/power-bi-desktop-february-feature-summary/#fontSize
https://youtu.be/mn75-LOPxMA?t=4m
https://powerbi.microsoft.com/blog/power-bi-desktop-february-feature-summary/#categoryWidth
https://youtu.be/mn75-LOPxMA?t=5m55s
https://powerbi.microsoft.com/blog/power-bi-desktop-february-feature-summary/#lineThickness
https://youtu.be/mn75-LOPxMA?t=7m46s
https://powerbi.microsoft.com/blog/power-bi-desktop-february-feature-summary/#quickCalcs
https://youtu.be/mn75-LOPxMA?t=9m23s
https://powerbi.microsoft.com/blog/power-bi-desktop-february-feature-summary/#relatedTables
https://youtu.be/mn75-LOPxMA?t=10m1s
https://powerbi.microsoft.com/blog/power-bi-desktop-february-feature-summary/#folder
https://youtu.be/mn75-LOPxMA?t=11m9s
https://powerbi.microsoft.com/blog/power-bi-desktop-february-feature-summary/#textConnector
https://powerbi.microsoft.com/blog/power-bi-desktop-february-feature-summary/#cds
https://youtu.be/mn75-LOPxMA?t=11m42s
https://powerbi.microsoft.com/blog/power-bi-desktop-february-feature-summary/#columnType
https://youtu.be/mn75-LOPxMA?t=12m36s
https://powerbi.microsoft.com/blog/power-bi-desktop-february-feature-summary/#stepsPane
https://youtu.be/mn75-LOPxMA?t=13m33s
https://powerbi.microsoft.com/blog/power-bi-desktop-february-feature-summary/#resources
https://powerbi.microsoft.com/blog/power-bi-desktop-february-feature-summary/
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January 2017 Update (2.42.4611.482)
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information about each of these new features (this is the same blog post referenced in the list above).

The following video describes and shows each of these updates. You can also see the video from the blog post.

You might also be interested in learning what's new in the Power BI service, and also check out what's new in the mobile
apps for Power BI.

The following updates are new to Power BI Desktop in January:

Table and matrix conditional formatting improvement - blank formatting [video] [blog]
New aggregations for string and dateTime columns [video] [blog]
Table header word wrap [video] [blog]
General Availability (GA) of Phone reports [video] [blog]

New or enhanced data connectors [video]:
Visual Studio Team Services connector (Beta) [video] [blog]
Enhanced SQL Server connector - support for SQL Failover option [video] [blog]

New transform: extract values from a nested list [video] [blog]

You can also check out all the data sources available to Power BI Desktop; our list is always growing, so check back often.

Want more information about these updates? Take a look at the blog post, where you can get more detailed
information about each of these new features (this is the same blog post referenced in the list above).

The following video describes and shows each of these updates. You can also see the video from the blog post.

https://youtu.be/C1-f0T8vZ7M?t=37s
https://powerbi.microsoft.com/blog/power-bi-desktop-january-feature-summary/#conditionalFormatting
https://youtu.be/C1-f0T8vZ7M?t=2m50s
https://powerbi.microsoft.com/blog/power-bi-desktop-january-feature-summary/#aggregations
https://youtu.be/C1-f0T8vZ7M?t=6m38s
https://powerbi.microsoft.com/blog/power-bi-desktop-january-feature-summary/#wordWrap
https://youtu.be/C1-f0T8vZ7M?t=7m53s
https://powerbi.microsoft.com/blog/power-bi-desktop-january-feature-summary/#phoneReports
https://youtu.be/C1-f0T8vZ7M?t=8m47s
https://youtu.be/C1-f0T8vZ7M?t=8m47s
https://powerbi.microsoft.com/blog/power-bi-desktop-january-feature-summary/#visualStudioTeamServices
https://youtu.be/C1-f0T8vZ7M?t=9m28s
https://powerbi.microsoft.com/blog/power-bi-desktop-january-feature-summary/#SQLFailover
https://youtu.be/C1-f0T8vZ7M?t=10m19s
https://powerbi.microsoft.com/blog/power-bi-desktop-january-feature-summary/#extractValues
https://powerbi.microsoft.com/blog/power-bi-desktop-january-feature-summary/
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November 2016 Update (2.41.4581.301)
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You might also be interested in learning what's new in the Power BI service, and also check out what's new in the mobile
apps for Power BI.

The following updates were new to Power BI Desktop in November:

Hierarchical axis [video] [blog]
Axis label and title color control [video] [blog]
Matrix conditional formatting [video] [blog]
Table and matrix column formatting [video] [blog]
Drop-down slicer [video] [blog]
Mobile reports scrolling [video] [blog]

Clustering (preview) [video] [blog]
Forecasting (now in the Power BI service) [blog]
Groups (now on the ribbon) [video] [blog]

New data connectors [video]:
Spark DirectQuery [video] [blog]
OData connector improvements [video] [blog]
Enhanced combine binaries experience [video] [blog]
Azure Analysis Services [video] [blog]

Improved function authoring experience [video] [blog]
Support for percentage data type [video] [blog]
Added Maximize and Restore buttons in Navigator and Query Dependencies [video] [blog]

You can also check out all the data sources available to Power BI Desktop; our list is always growing, so check back often.

https://youtu.be/kERJ_WOLuLk?t=36s
https://powerbi.microsoft.com/blog/power-bi-desktop-november-feature-summary/#hierarchicalAxis
https://youtu.be/kERJ_WOLuLk?t=1m56s
https://powerbi.microsoft.com/blog/power-bi-desktop-november-feature-summary/#axisColor
https://youtu.be/kERJ_WOLuLk?t=2m56s
https://powerbi.microsoft.com/blog/power-bi-desktop-november-feature-summary/#matrixConditionalFormatting
https://youtu.be/kERJ_WOLuLk?t=4m21s
https://powerbi.microsoft.com/blog/power-bi-desktop-november-feature-summary/#columnFormatting
https://youtu.be/kERJ_WOLuLk?t=5m54s
https://powerbi.microsoft.com/blog/power-bi-desktop-november-feature-summary/#dropdownSlicer
https://youtu.be/kERJ_WOLuLk?t=7m7s
https://powerbi.microsoft.com/blog/power-bi-desktop-november-feature-summary/#mobileReports
https://youtu.be/kERJ_WOLuLk?t=8m52s
https://powerbi.microsoft.com/blog/power-bi-desktop-november-feature-summary/#clustering
https://powerbi.microsoft.com/blog/power-bi-desktop-november-feature-summary/#forecasting
https://youtu.be/kERJ_WOLuLk?t=13m29s
https://powerbi.microsoft.com/blog/power-bi-desktop-november-feature-summary/#groups
https://youtu.be/kERJ_WOLuLk?t=14m10s
https://youtu.be/kERJ_WOLuLk?t=14m12s
https://powerbi.microsoft.com/blog/power-bi-desktop-november-feature-summary/#spark
https://youtu.be/kERJ_WOLuLk?t=15m44s
https://powerbi.microsoft.com/blog/power-bi-desktop-november-feature-summary/#oData
https://youtu.be/kERJ_WOLuLk?t=15m44s
https://powerbi.microsoft.com/blog/power-bi-desktop-november-feature-summary/#combineBinaries
https://youtu.be/kERJ_WOLuLk?t=17m3s
https://powerbi.microsoft.com/blog/power-bi-desktop-november-feature-summary/#azureAnalysisServices
https://youtu.be/kERJ_WOLuLk?t=18m3s
https://powerbi.microsoft.com/blog/power-bi-desktop-november-feature-summary/#functionAuthoring
https://youtu.be/kERJ_WOLuLk?t=18m36s
https://powerbi.microsoft.com/blog/power-bi-desktop-november-feature-summary/#percentage
https://youtu.be/kERJ_WOLuLk?t=19m16s
https://powerbi.microsoft.com/blog/power-bi-desktop-november-feature-summary/#maximize
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October 2016 Update (2.40.4554.361)
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Want more information about these updates? Take a look at the blog post, where you can get more detailed
information about each of these new features (this is the same blog post referenced in the list above).

The following video describes and shows each of these updates. You can also see the video from the blog post.

You might also be interested in learning what's new in the Power BI service, and also check out what's new in the mobile
apps for Power BI.

The following updates were new to Power BI Desktop in October:

Improved date axis range formatting [video]
Date slicer [blog] [video]
Report gridlines and snap to grid (Preview) [article] [blog] [video]
Data label improvements [blog] [video]
Map formatting options [blog] [video]
Improved date axis range formatting [blog]

Grouping [blog] [video]
Binning [blog] [video]
Top-N filter [blog] [video]
Include/exclude data points [blog] [video]
R-powered custom visuals[blog]

New data connectors [video]:
Microsoft Dynamics 365 for Financials (Beta) [blog]
OLE DB [blog]
Mixpanel [blog]

Support for table parameters in the Invoke Function dialog [blog] [video]

https://powerbi.microsoft.com/blog/power-bi-desktop-november-feature-summary/
https://youtu.be/UXEYSvgvMaQ?t=26s
https://powerbi.microsoft.com/blog/power-bi-desktop-october-feature-summary/preview/#dateSlicer
https://youtu.be/UXEYSvgvMaQ?t=2m9s
https://powerbi.microsoft.com/blog/power-bi-desktop-october-feature-summary/preview/#snapToGrid
https://youtu.be/UXEYSvgvMaQ?t=4m3s
https://powerbi.microsoft.com/blog/power-bi-desktop-october-feature-summary/preview/#dateLabels
https://youtu.be/UXEYSvgvMaQ?t=5m30s
https://powerbi.microsoft.com/blog/power-bi-desktop-october-feature-summary/preview/#mapFormatting
https://youtu.be/UXEYSvgvMaQ?t=7m22s
https://powerbi.microsoft.com/blog/power-bi-desktop-october-feature-summary/preview/#dateAxisRange
https://powerbi.microsoft.com/blog/power-bi-desktop-october-feature-summary/preview/#grouping
https://youtu.be/UXEYSvgvMaQ?t=9m42s
https://powerbi.microsoft.com/blog/power-bi-desktop-october-feature-summary/preview/#binning
https://youtu.be/UXEYSvgvMaQ?t=12m17s
https://powerbi.microsoft.com/blog/power-bi-desktop-october-feature-summary/preview/#topN
https://youtu.be/UXEYSvgvMaQ?t=13m55s
https://powerbi.microsoft.com/blog/power-bi-desktop-october-feature-summary/preview/#includeExclude
https://youtu.be/UXEYSvgvMaQ?t=15m36s
https://powerbi.microsoft.com/blog/power-bi-desktop-october-feature-summary/preview/#rCustomVisuals
https://youtu.be/UXEYSvgvMaQ?t=17m30s
https://powerbi.microsoft.com/blog/power-bi-desktop-october-feature-summary/preview/#dynamics365Financials
https://powerbi.microsoft.com/blog/power-bi-desktop-october-feature-summary/preview/#oledb
https://powerbi.microsoft.com/blog/power-bi-desktop-october-feature-summary/preview/#mixpanel
https://powerbi.microsoft.com/blog/power-bi-desktop-october-feature-summary/preview/#invokeFunction
https://youtu.be/UXEYSvgvMaQ?t=18m12s
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September 2016 Update (2.39.4526.362)
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Diagnostics information in the About dialog [blog] [video]

You can also check out all the data sources available to Power BI Desktop; our list is always growing, so check back often.

Want more information about these updates? Take a look at the blog post, where you can get more detailed
information about each of these new features (this is the same blog post referenced in the list above).

The following video describes and shows each of these updates. You can also see the video from the blog post.

You might also be interested in learning what's new in the Power BI service, and also check out what's new in the mobile
apps for Power BI.

The following updates were new to Power BI Desktop in September:

ArcGIS Maps for Power BI (Preview) [blog] [video]
Mobile report layout (Preview) [blog] [video]
Updated drill behavior [article] [blog] [video]

Forecasting (Preview) [article] [blog] [video]
Use your own R IDE [blog] [video]

New data connectors:

Improvements to existing connectors:

Snowflake connector DirectQuery support [blog]
ProjectPlace connector [article] [blog]

Oracle connector - improved Navigator previews performance [blog]
OData connector - support for Select Related Tables option [blog]
SAP Business Warehouse and SAP HANA connectors - enhancements to parameter input interface
[article] [blog]

https://powerbi.microsoft.com/blog/power-bi-desktop-october-feature-summary/preview/#diagnostics
https://youtu.be/UXEYSvgvMaQ?t=19m16s
https://powerbi.microsoft.com/blog/power-bi-desktop-october-feature-summary/
https://powerbi.microsoft.com/blog/power-bi-desktop-september-feature-summary/
https://youtu.be/pcUr6E8g_KI?t=2m8s
https://powerbi.microsoft.com/blog/power-bi-desktop-september-feature-summary/
https://youtu.be/pcUr6E8g_KI?t=3m59s
https://powerbi.microsoft.com/blog/power-bi-desktop-september-feature-summary/
https://youtu.be/pcUr6E8g_KI?t=5m6s
https://powerbi.microsoft.com/blog/power-bi-desktop-september-feature-summary/
https://youtu.be/pcUr6E8g_KI?t=6m6s
https://powerbi.microsoft.com/blog/power-bi-desktop-september-feature-summary/
https://youtu.be/pcUr6E8g_KI?t=6m56s
https://powerbi.microsoft.com/blog/power-bi-desktop-september-feature-summary/
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August 2016 Update (2.37.4464.321)

Web connector - support for specifying HTTP request headers within the dialog [blog] [video]

Query Dependencies view [blog] [video]
Show Errors experience [blog]
Query Editor ribbon support for scalar values [blog]
Add function invocation column [blog]
Expand & Aggregate columns - support for Load More values [blog]
New transform - convert Table Column to a list [blog]
Keyboarding - support for smart typing in drop-down menus [blog]

In-product links to the Power BI Community [blog] [video]

You can also check out all the data sources available to Power BI Desktop; our list is always growing, so check back often.

Want more information about these updates? Take a look at the blog post, where you can get more detailed
information about each of these new features (this is the same blog post referenced in the list above).

The following video describes and shows each of these updates. You can also see the video from the blog post.

You might also be interested in learning what's new in the Power BI service, and also check out what's new in the mobile
apps for Power BI.

August introduced a full harvest of new features for Power BI Desktop:

[video] excerpts play in a new browser tab, when the feature is being discussed.
Some features have an [article] that provides more detail.
Most features are explained in the monthly update [blog] post.
Lastly, some features are self-explanatory and don't need and article or video.

You can also watch the Latest Updates video from the beginning, right inside this article, by clicking on the play
icon on the video image found below the list of updates.

https://powerbi.microsoft.com/blog/power-bi-desktop-september-feature-summary/
https://youtu.be/pcUr6E8g_KI?t=8m5s
https://powerbi.microsoft.com/blog/power-bi-desktop-september-feature-summary/
https://youtu.be/pcUr6E8g_KI?t=8m37s
https://powerbi.microsoft.com/blog/power-bi-desktop-september-feature-summary/
https://powerbi.microsoft.com/blog/power-bi-desktop-september-feature-summary/
https://powerbi.microsoft.com/blog/power-bi-desktop-september-feature-summary/
https://powerbi.microsoft.com/blog/power-bi-desktop-september-feature-summary/
https://powerbi.microsoft.com/blog/power-bi-desktop-september-feature-summary/
https://powerbi.microsoft.com/blog/power-bi-desktop-september-feature-summary/
https://powerbi.microsoft.com/blog/power-bi-desktop-september-feature-summary/
https://youtu.be/0VvG7Eqoke8?t=16m9s
https://powerbi.microsoft.com/blog/power-bi-desktop-september-feature-summary/
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The following updates are new to Power BI Desktop this month:

Drill-down (or back up) on line charts [blog] [video]
Continuous axis for the Date axis [blog] [video]
General availability of Inline Hierarchies [article] [blog] [video]
Predefined matrix styles (similar to table formatting in Excel) [blog] [video]
Reorder fields, in charts and tooltips [blog] [video]
Color formatting for KPI visuals [blog] [video]

The all-new Analytics pane [article] [blog] [video]
Dynamic reference lines [blog] [video]

New data connectors:

Improvements to existing connectors:
Snowflake connector (Preview) [blog]

Impala connector - DirectQuery support [article] [blog]
Web connector - Web page previews [blog] [video]
General availability for the SAP Business Warehouse connector [article] [blog]

Option to Merge/Append as New Query [blog] [video]

Auto-recover Desktop files [blog] [video]

You can also check out all the data sources available to Power BI Desktop; our list is always growing, so check back often.

Want more information about these updates? Take a look at the blog post, where you can get more detailed
information about each of these new features (this is the same blog post referenced in the list above).

The following video describes and shows each of these updates. You can also see the video from the blog post.

https://powerbi.microsoft.com/blog/power-bi-desktop-august-feature-summary/
https://youtu.be/0VvG7Eqoke8?t=3m1s
https://powerbi.microsoft.com/blog/power-bi-desktop-august-feature-summary/
https://youtu.be/0VvG7Eqoke8?t=3m48s
https://powerbi.microsoft.com/blog/power-bi-desktop-august-feature-summary/
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https://powerbi.microsoft.com/blog/power-bi-desktop-august-feature-summary/
https://youtu.be/0VvG7Eqoke8?t=6m23s
https://powerbi.microsoft.com/blog/power-bi-desktop-august-feature-summary/
https://youtu.be/0VvG7Eqoke8?t=7m9s
https://powerbi.microsoft.com/blog/power-bi-desktop-august-feature-summary/
https://youtu.be/0VvG7Eqoke8?t=8m22s
https://powerbi.microsoft.com/blog/power-bi-desktop-august-feature-summary/
https://youtu.be/0VvG7Eqoke8?t=9m40s
https://powerbi.microsoft.com/blog/power-bi-desktop-august-feature-summary/
https://powerbi.microsoft.com/blog/power-bi-desktop-august-feature-summary/
https://powerbi.microsoft.com/blog/power-bi-desktop-august-feature-summary/
https://youtu.be/0VvG7Eqoke8?t=12m28s
https://powerbi.microsoft.com/blog/power-bi-desktop-august-feature-summary/
https://powerbi.microsoft.com/blog/power-bi-desktop-august-feature-summary/
https://youtu.be/0VvG7Eqoke8?t=14m24s
https://powerbi.microsoft.com/blog/power-bi-desktop-august-feature-summary/
https://youtu.be/0VvG7Eqoke8?t=16m9s
https://powerbi.microsoft.com/blog/power-bi-desktop-july-feature-summary/
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July 2016 Update (2.37.4464.321)
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NOTENOTE

You might also be interested in learning what's new in the Power BI service, and also check out what's new in the mobile
apps for Power BI.

You can always download the latest version of Power BI Desktop.

July brought another great collection of new features and highly anticipated data connectors to Power BI Desktop.
The following enhancements were new to Power BI Desktop in July:

Predefined table styles [blog] [video]
Shape Maps update - use custom maps [article] [blog] [video]

New data connectors:

Improvements to existing connectors:

Amazon Redshift [article] [blog]
Impala [article] [blog]

Web connector - support for specifying a connection timeout [blog]
CSV and Text - support for fixed-width delimited files [blog]
Improvements and changes to the SAP Business Warehouse connector [article] [blog]

Use R script in Query Editor [article] [blog]
Query parameter enhancements:

Overwrite existing user-defined functions [blog]
List query output as allowed values for a parameter [blog]

You can also check out all the data sources available to Power BI Desktop; our list is always growing, so check back often.

Want more information about these updates? Take a look at the blog post, where you can get more detailed
information about each of these features (this is the same blog post referenced in the list above).

The following video describes and shows each of these updates. You can also see the video from the blog post.

https://powerbi.microsoft.com/desktop
https://powerbi.microsoft.com/blog/power-bi-desktop-july-feature-summary/
https://youtu.be/g8ccfjffWmw?t=1m25s
https://powerbi.microsoft.com/blog/power-bi-desktop-july-feature-summary/
https://youtu.be/g8ccfjffWmw?t=2m21s
https://powerbi.microsoft.com/blog/power-bi-desktop-july-feature-summary/
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June 2016 Update (2.36.4434.362)

Report View:Report View:

Data Access:Data Access:

Data Connectors:Data Connectors:

Data Connectors:Data Connectors:

You might also be interested in learning what's new in the Power BI service, and also check out what's new in the mobile
apps for Power BI.

You can always download the latest version of Power BI Desktop.

June provided a shining collection of interesting updates for Power BI Desktop.

New visual - Shape Maps [video] [article]
Searchable slicers [video] [blog]
Configurable line chart labels [video] [blog]
New sign-in entry points [video] [blog]

Row Level Security [blog] [article]

New data connector: [blog]

Enhanced SAP BW and HANA connectors: [blog]

Enhanced OData connector - imports Open Type columns [blog]
Enhanced Access DB connector - button to Select Related Tables in Navigator dialog [blog]

Azure Enterprise

Allow multi-select of values for Variables/Parameters
Support for Hierarchies in SAP BW

Templates - option to Load or Edit [blog]
Query parameter enhancements: [blog]

Option to generate Step Names in English [blog]
Descriptions for Query Steps [video] [blog]
New Data Transformations: [blog]

Option to always allow Parameter specification
Create new parameter directly in context

Extract Week Day and Month Name from a DateTime column

https://powerbi.microsoft.com/desktop
https://youtu.be/sZsL2l6oS4A?t=3m9s
https://youtu.be/sZsL2l6oS4A?t=6m25s
https://powerbi.microsoft.com/blog/power-bi-desktop-june-update/
https://youtu.be/sZsL2l6oS4A?t=7m21s
https://powerbi.microsoft.com/blog/power-bi-desktop-june-update/
https://youtu.be/sZsL2l6oS4A?t=2m30s
https://powerbi.microsoft.com/blog/power-bi-desktop-june-update/
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May 2016 Update (2.35.4399.381)

Report View:Report View:

AnalyticsAnalytics

Data Connectivity:Data Connectivity:

Merging dates and Times into a DateTime column
Extract Time.Start/End of Hour/Minute/Second

You can also check out all the data sources available to Power BI Desktop; our list is always growing, so check back often.

Want more information about these updates? Take a look at the blog post, where you can get more detailed
information about each of these new features.

The following video describes and shows each of these updates. You can also see the video from the blog post.

You might also be interested in learning what's new in the Power BI service, and also check out what's new in the mobile
apps for Power BI.

You can always download the latest version of Power BI Desktop.

May brought another large collection of compelling updates for Power BI Desktop:

Customizable tooltips [video] [article]
Conditional formatting in tables [video] [article]
Publish to Pyramid server [blog]
Scrolling loads more data in charts [video] [blog]
Keyboard nudging for visuals [blog]

Quick Calcs - % of grand total [blog]

New data connectors: [blog]
Informix
comScore Digital Analytix
Troux
Planview Enterprise

https://powerbi.microsoft.com/blog/power-bi-desktop-june-update/
https://powerbi.microsoft.com/desktop
https://youtu.be/KnDs4amt9-c?t=172
https://youtu.be/KnDs4amt9-c?t=313
https://powerbi.microsoft.com/blog/power-bi-desktop-may-update-feature-summary/
https://youtu.be/KnDs4amt9-c?t=426
https://powerbi.microsoft.com/blog/power-bi-desktop-may-update-feature-summary/
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April 2016 Update (2.34.4372.322)

Report View:Report View:

Improved DB2 connector [blog]
Text/CSV connector exposes editable settings in preview dialog [blog]
Improved relational database connectors with Display Schema information
Data Source Settings enhancements [blog]
Advanced Filter Rows dialog mode [blog]
Inline Input controls for Function invocation within Query Editor [blog]
Query Parameters: [blog]

Ability to Save As a Power BI Template [blog]
Support for reordering Query Steps using drag-and-drop [blog]
Date picker support in Conditional Columns dialog input Date fields [blog]
New context menu entry to create new queries from the Queries pane [blog]

Ability to convert queries to parameters (and vice versa)
Support for URL parameterization and multi-part URLs in Web connector
Support for parameterization in Conditional Columns dialog

You can also check out all the data sources available to Power BI Desktop; our list is always growing, so check back often.

Want more information about these updates? Take a look at the blog post, where you can get more detailed
information about each of these new features.

The following video describes and shows each of these updates. You can also see the video from the blog post.

You might also be interested in learning what's new in the Power BI service, and also check out what's new in the mobile
apps for Power BI.

You can always download the latest version of Power BI Desktop.

In April, we showered our great Power BI customers with another collection of compelling updates for Power BI
Desktop. The following enhancements are new to Power BI Desktop this month:

Additional styles on a table, matrix, and multi-row card

https://powerbi.microsoft.com/blog/power-bi-desktop-may-update-feature-summary/
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Trend lines on single visuals
New drill action – See Records
Map auto-zoom during drill/filter
In-line hierarchy labels for expanded view (Preview - see the article)

Modelling operations are no longer blocked while visuals are refreshing
Time Intelligence with built-in date hierarchy fields (Preview)
Data model synonyms

Query Parameters
Power BI Template files
New Online Services category in Get Data dialog
New Connectors:

Conditional Columns
DirectQuery – Specify DirectQuery vs. Import mode in data source dialogs
Column type indicator in Query Editor preview column headers
Reorder Queries and Query Groups using Drag & Drop gestures
Query Management menu in the ribbon

SharePoint Folder
Webtrends
SparkPost
tyGraph

You can also check out all the data sources available to Power BI Desktop; our list is always growing, so check back often.

Want more information about these updates? Take a look at the blog post, where you can get more detailed
information about each of these new features.

The following video describes and shows each of these updates. You can also see the video from the blog post.

https://powerbi.microsoft.com/blog/power-bi-desktop-april-update-feature-summary/
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March 2016 Update (2.33.4337.281)

Report View:Report View:

Data Modeling:Data Modeling:

Data Connectivity:Data Connectivity:

You might also be interested in learning what's new in the Power BI service, and also check out what's new in the mobile
apps for Power BI.

You can now download the latest version of Power BI Desktop.

March brings all sorts of renewal and freshness, including another round of Power BI Desktop additions. The
following enhancements are new to Power BI Desktop this month:

Publish reports to a Group Space in the Power BI service
Reports with KPI trends now respect Do Not Summarize model settings from SSAS MD
Data Point warnings are now non-intrusive

You can now change the data type of a column when using DirectQuery mode
Ability to assume Referential Integrity on relationships (for those imported, and created) in DirectQuery
DirectQuery for Oracle and Teradata is now part of Power BI Desktop (no long a preview feature)

A new SAP BW Connector (preview feature)
Support for Command Timeout in the user interface (UI)
There's a setting available to disable Privacy Level prompts at the machine level (including a registry key)
Query Group Management enhancements:

New Transformations:

Support for whitespace and line feeds in Query Editor preview
Include hints for sample input values in the Change Type with Locale dialog
Enhancements to the Navigator window:

Load: Auto-step to disambiguate conflicting column names (case-insensitive comparison)
You can now rename queries directly from the Queries pane

Expand/Collapse All
Retain Query Group expansion state

Remove Blanks using the Column Filter menu
Convert Duration values to Years
Keep Duplicates

Add schema information to navigation hierarchy for ODBC sources
Ability to disable preview from Navigator
Technical name support

Want more information about these updates? Take a look at the blog post, where you can get more detailed
information about each of these new features.

The following video describes and shows each of these updates. You can also see the video from the blog post.

https://powerbi.microsoft.com/desktop
https://powerbi.microsoft.com/blog/power-bi-desktop-march-update-feature-summary/
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February 2016 Update (2.32.4307.362)
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You might also be interested in learning what's new in the Power BI service, and also check out what's new in the mobile
apps for Power BI.

You can now download the latest version of Power BI Desktop.

We're leaping ahead with more updates this month! February brings 29 days to the month (it's a leap year), and
with it, 29 improvements to this monthly update of Power BI Desktop. The following enhancements are new to
Power BI Desktop this month:

See Data Behind a Visual (including Export Data to CSV)
Map improvements – plot map with latitude/longitude only
KPI consumption release support (including navigation hierarchy support and KPI trend for SSAS MD)
SSAS Exploration Mode: Support for Display folders in the Fields pane
Ribbon layout improvements: Contextual ribbon tab for Report Tools
New KPI visual
Get reports opened to the same page that was visible when they were saved
Edit Query option in table context menu in the Fields pane (Report & Data views)
Duplicate Page from the ribbon

Ability to define hierarchies
Performance Improvement: Table & Column rename optimizations

DirectQuery support for Oracle and Teradata databases
DirectQuery – support for creating Calculated Columns
Support for publishing Analysis Services Live reports
JSON File connector
SQL Sentry connector
Support for jagged CSV files
Exchange Connector – OAuth support
SharePoint List Connector – URL validation

https://powerbi.microsoft.com/desktop
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January 2016 Update (2.31.4280.361)

Report View:Report View:

Data Connectivity:Data Connectivity:

Database Connectors – ability to disable Navigation Columns in Query previews (Performance optimization)
Web Connector – fine-grained scoping of Credentials
Enter Data dialog UX enhancements
SAP HANA – Support for single sign-on with Windows Authentication (Power BI Desktop only)
SAP HANA – Support for Field labels
Alphabetical sort of columns in Choose Columns builder
Improved performance of renaming/removing/reordering columns
Virtualized Preview in Query Editor
Visual indicator for unloaded queries in Query Editor
1-click Percentage transform

Want more information about these updates? Take a look at the blog post, where you can get more detailed
information about each of these new features.

The following video describes and shows each of these updates. You can also see the video from the blog post.

You might also be interested in learning what's new in the Power BI service, and also check out what's new in the mobile
apps for Power BI.

You can now download the latest version of Power BI Desktop.

Ring in the new year with another collection of improvements and enhancements to Power BI Desktop. The
following enhancements are new to Power BI Desktop this month:

Add borders to a visual
Add an image background to a visual

DirectQuery: you can now create measures when using DirectQuery mode
You can now refresh data for individual tables from the Field List (in Report view and Data view), rather than
(and in addition to) just being able to refresh all from the ribbon
General Availability (GA) for SQL Server Analysis Services Multidimensional models Exploration mode (no
longer a preview feature)
Enhancements to hierarchy support

https://powerbi.microsoft.com/blog/power-bi-update-lots-of-new-authoring-features-and-a-new-power-bi-desktop-update/
https://powerbi.microsoft.com/desktop
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December 2015 Update (2.30.4246.181)

Report Authoring:Report Authoring:

General Availability (GA) for the SAP HANA connector (no longer a preview feature)
Ability to append multiple tables within a single Append operation
Option to disable data previews to download in the background (performance optimization)

Support for Internet Explorer 9 (IE9) browser
Performance improvements for report rendering, cross-highlighting, and otherwise
Improvements to R integration in Power BI Desktop

Want more information about these updates? Take a look at the blog post, where you can get more detailed
information about each of these new features.

The following video describes and shows each of these updates. You can also see the video from the blog post.

December is a month for giving, and the Power BI team is following suit with more updates, features, and more
functionality in this month's Power BI Desktop update. The following enhancements are new to Power BI Desktop
this month:

Formatting Pane and Ribbon:

Format data labels per category services
Change the number of decimal places shown in visuals
Change text size in visuals
Ability to layout visuals accurately: alignment, distribute, size, position
Set styles across multiple visuals through Format Painter
Optimized Home ribbon layout

Enhancements to Visualizations:

Visual cue for sort state in Table visual
New visual: Stacked Area chart
Smart tooltips for Area and Line charts on hover
Ability to create reference line/region for a Cartesian visual
Improved data labels for Pie and Scatter charts

R Visuals integration in Power BI Desktop (Preview feature)

Suggested table-to-table relationships when trying to create visuals involving two tables which are not

http://blogs.msdn.com/b/powerbi/archive/2016/01/28/power-bi-updates-this-week-new-report-authoring-capabilities.aspx
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November 2015 Update (2.29.4217.221)

Report Authoring:Report Authoring:

related

Relationships View
Zooming slider
Fit Zoom to screen
Reset layout
Ability to zoom in CTRL+(mouse selection range)

SSAS Multidimensional support - hierarchies support
Stripe Connector
Smartsheet Connector
Enter Data: paste or enter data to create a table
DirectQuery improvements: support for all data types of T-SQL and SAP HANA, resulting in performance
improvements
ODBC Connector: support for selecting User/System DSNs
CSV Connector: ability to specify Column Delimiter in the Source dialog

Want more information about these updates? Take a look at the blog post, where you can get more detailed
information about each of these new features.

The following video describes and shows each of these updates. You can also see the video from the blog post.

You can now download the latest version of Power BI Desktop.

Another month, another big collection of new features and improvements for Power BI Desktop. Improvements
range from new data connectors to new modeling capabilities. Here are 26 new features and improvements:

Play Axis for Scatter Chart
Horizontal Slicers
Slicer Selection Behaviors (single vs. multi-select)
Control Z-order
Background Colors for Slides
Interactions between Visuals – Subview (tile by)
Duplicate Pages
Support for KPIs and Images in Tables, Matrices and Cards

http://blogs.msdn.com/b/powerbi/archive/2015/12/16/more-power-bi-feature-updates-power-bi-desktop-december-update-and-new-power-bi-service-features.aspx
https://powerbi.microsoft.com/desktop
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Data Connectivity:Data Connectivity:

Data Transformations:Data Transformations:

Other Improvements:Other Improvements:

October 2015 Update (2.28.4190.122)

Report Authoring:Report Authoring:

Better Tooltips on Area Charts & Line Charts
Ability to change Text size in Cards & Tables/Matrix
Improved tooltips and labels in Field Well and Formatting panes
Ability to see Categories with no data
Improved Default Sort behaviors for visuals
Ability to control Axis Scale display units
Visuals Refresh Optimizations when applying basic modeling operations

Basic Automatic Date Features

SSAS Multidimensional support
SAP Hana
R Script
DirectQuery for SQL Server, Azure SQL Database and Azure SQL Data Warehouse
Azure Data Lake
Marketo

Improved Function Invocation experience
Option to set Credentials at Server vs. Database level
Add Prefix/Suffix to a Text column

New Documentation Website, now also including localized content

Want more information about these updates? Take a look at the blog post, where you can get more detailed
information about each of these new features.

The following video describes and shows each of these updates. You can also see the video from the blog post.

October brings another large collection of updates to Power BI Desktop:

Custom Visualizations
Insert Visual from the Ribbon
Improved Default Sorting

http://blogs.msdn.com/b/powerbi/archive/2015/11/20/announcing-the-power-bi-desktop-november-update.aspx
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Other Improvements:Other Improvements:

September 2015 Update (2.27.4163.351)

Report AuthoringReport Authoring

Tooltips & Data Labels on Funnel Charts
Slicer Improvements:

Additional Formatting Options for Gauges
Data Point Label layout improvements
KPI Consumption (Preview Feature)

Ability to Sort items
Ability to change Font Size

Semi-Select support for DAX formulas in Data view

Azure Document DB connector
Mailchimp connector
DirectQuery for SQL Server and Azure SQL Database (Preview Feature)

Filter by “not earliest/latest date”
Filter by “is in previous N minutes/hours/seconds”
Copy/Paste Queries between Power BI Desktop and Excel
Support for Special Characters in Split Column
Refresh Previews in Merge Queries dialog
Monospaced font for Query Editor Preview

Refresh Single Table (vs. All) from Report & Data Views
Option to enable Preview features
In-Product Ratings experience

You can view a video of all these updates, too.

For more information, check out the blog announcement that describes more details about each update.

The following massive collection of 44 features has been added to this update:

Report-level filters
Drill Up/Down for column and scatter charts

http://blogs.msdn.com/b/powerbi/archive/2015/10/20/custom-visualizations-support-and-22-other-features-in-the-power-bi-desktop-october-update.aspx


Data ModelingData Modeling

Data ConnectivityData Connectivity

Data Transformations and Query Editor ImprovementsData Transformations and Query Editor Improvements

New Page Size and Page View options
Support for inserting Shapes in the Report canvas
Fields pane improvements

Search Box to make it easier to find fields by name
“Expand/Collapse All” to improve navigation when there are multiple tables in the Fields pane
Field well cardinality support, drag-replace for buckets with 1 item
Additional Data Labels formatting options
Chart Cartesian Axis Improvements:

X-Axis label direction (horizontal / diagonal)
Support for Logarithmic & Linear scales for values in Y-axis
Display Text for hyperlinks in text boxes
Improvements to existing visualizations: Table, Matrix, Slicer, Scatter Chart, Single Cards, Combo
Charts and Gauges
Support for displaying Color Saturation values in tooltips
Ability to resize images and apply additional formatting options

Calculated Tables.
Relationships view:

Data view:

Field Summarization:

Create relationships via drag/drop between two tables in the diagram.
Delete relationships in relationship view by selecting and hitting the Delete key.
Rename/delete tables and columns

Copy Table contents to clipboard.

Support for additional operations in the Fields pane: median, standard deviation, and variance
Default summarization: Users can now customize the default summarization operation for any given field
in their model

Support for on-premises Spark distributions
Support for SharePoint lists from non-English sites
Exchange connector - Enhanced support, now allowing connections to multiple mailboxes
Excel Workbook Connector – Automatic Column Type detection when importing .XLS files
“Select Related Tables” option when connecting to database sources
Enhanced Active Directory connector credentials, allowing alternate Windows Credentials
Improved Function Invocation experience when loading functions from a data source (such as a database)
“Import Excel Workbook Contents” feature released last month now also supports external connections to
Analysis Services tabular models
New option to “Delete All” entries in the Data Source Settings dialog
Option to “Enable Relationship Import during Refresh operations”

Copy to clipboard (available for cells/columns/tables)
Filter date columns by earliest/latest date (dynamic filter)
Extract min/max date/time value from a column
Replace Values - Provision for specifying special characters
“Detect Column Types” option to trigger type detection on demand



August 2015 Update (2.26.4128.403)

“Refresh All Previews” to refresh all Query Editor previews with a single click
Performance Improvements:

Choose Columns dialog: Faster user experience for dealing with wide tables
Auto-filter & Expand/Aggregate popups: Faster for large number of values/fields

The following video covers these features in more detail.

For more information about this update, check out the blog announcement that describes more details about each
update.

The following features have been added to this update:

Overall Improvements:

Import Excel Power BI artifacts (Data Model, Queries, Power View) into a new Power BI Desktop file

HDInsight Spark connector

Azure SQL Data Warehouse connector

Support for custom MDX/DAQ queries when importing data from SSAS

Live Analysis Services Connections: ability to change the database from Edit Queries dialog

Navigator dialog improvements:

Resizable Navigator dialog

Ability to multi-select items in Navigator (CTRL+click, SHIFT+click, etc)

Query Editor improvements:

Query Group creation/deletion improvements (multi-select, etc.)

Ability to Split Query (i.e. refactor common base steps into a new query)

Query Icons to reflect type of query in Queries navigator pane

Data Modeling improvements:

Resizing of columns in Data View

Moving Measures from one table to another

Take a look at the following video for more details about this update:

http://blogs.msdn.com/b/powerbi/archive/2015/09/23/44-new-features-in-the-power-bi-desktop-september-update.aspx


July 2015 Update (2.25.4095.554)

May 2015 Update (2.23.4036.161)

The following features have been added in this update:

New Data Connectors: appFigures, Quickbooks Online, Zendesk, Github, Twilio and SweetIQ.

New Transformations: Extract First/Last/Range of characters from a Text Column; Option to specify Join
Type in the Merge Queries dialog; Ability to customize Quote Style in Split Column by Delimiter dialog.

Report Authoring Improvements: New visualizations (Area Chart, Waterfall, Donut & Matrix); New visual
formatting and customization options (labels, titles, background, legend, colors, etc.); Insert Textbox and
Picture in your report; Support for hyperlinks in reports and report tables; Undo/Redo actions.

Direct Report Exploration over Analysis Services Tabular Models.

Data Modeling: New Data View & Relationships views.

Publish reports to PowerBI.com, directly from Power BI Desktop.

Support for opening Recent Files in Start Page and "File -> Open" menu.

Support for Exchange UPN Credentials in the Exchange connector.

In addition to all these new features, we’re also making Power BI Desktop available in 42 different languages.
Get the full list of languages and install the one you want from our official download page.

Take a look at the following video for more details:

The following features have been added in this update:

Modeling Features

https://www.microsoft.com/download/details.aspx?id=45331


April 2015 Update (2.22.4009.122)

Calculated Columns

Data Categorization

Sort By Another Column

Improved DAX Formula Editor: Function Help and Prototype

Get Data & Query

New ODBC Tables connector (Beta)

Improved to the Excel Workbook connector: better column type inference and faster load for data
previews

New Text Column Filters - Does Not Begin With and Does Not End With

Enhanced Privacy Levels dialog

Take a look at the following video for details:

You can now download the latest version of Power BI Desktop.

The following features have been added in this update:

Modeling Features

Initial support for DAX Measures

New DAX functions

Data Types & Formatting options in Report view

Rename & Delete fields in Report view

Get Data & Query

OData V4 support

Support for Custom ADFS Authentication Services

Updated Facebook connector due to Facebook API changes

Unified Options dialog

Option to disable Native Database query prompts

https://powerbi.microsoft.com/desktop


March 2015 Update (2.21.3975.261)

Support for Fixed Decimal Number type

Alternate Windows Credentials

Remove Blank Rows

Median Operation available for Group By and Aggregate Column

Convert DateTimeZone value to Local Time

Performance Improvements

Faster load of medium & large datasets by about 20%

Improved time to open an existing PBIX file by about 50%

You can watch the following video for details:

The following features have been added in this update:

Google Analytics connector

Additional operators for date filtering in Query view

Automatic Model Relationship Detection

Enhanced Add Relationship dialog

Report Pages Re-ordering (drag & drop)

~40-50% Performance Improvement filling database tables without filters/transforms

Lots of bug fixes

You can watch the following video for more details:



February 2015 Update (2.20.3945.102)
The following features have been added or improved in this update:

Performance improvements
Dynamics CRM Online connector > [!NOTE] > Currently, only URLs within the crm.microsoft.com domain are
accepted by this dialog. This does not include non-production tenants. We’ll fix this issue in our March update.
The temporary workaround is to connect to this feed using “From OData”.*
Navigator Dialog improvements

New Transformations

Field List improvements

Report Pages Navigation - Keyboarding support
Lots of bug fixes

Better preview experience for multi-dimensional sources (Analysis Services and SAP BusinessObjects)
Show Selected Items option
Improved Search capabilities in the Navigator tree

Age and Subtract operations for Date/Time columns
Aggregate Columns: Option to disable new columns’ prefix

Expand/Collapse tables
Hide/Unhide fields
Optimized layout (spacing, margins, and fonts)

January 2015 Update (2.19.3923.101)

This month we've made a number of improvements and bug fixes under the covers. Please try out the new version
and continue to send us feedback if you find any issues!



Data sources in Power BI Desktop
1/25/2018 • 4 min to read • Edit Online

With Power BI Desktop, you can connect to data from many different sources. A full list of available data
sources is at the bottom of this page.

To connect to data, select Get Data from the Home ribbon. Selecting the down arrow, or the Get Data
text on the button, shows the Most Common data types menu shown in the following image.

Selecting More… from the Most Common menu displays the Get Data window. You can also bring up
the Get Data window (and bypass the Most Common menu) by selecting the Get Data icon button
directly.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-data-sources.md


  

NOTENOTE

Data Sources

The Power BI team is continually expanding the data sources available to Power BI Desktop and the Power BI
service. As such, you'll often see early versions of work-in-progress data sources marked as Beta or Preview. Any
data source marked as Beta or Preview has limited support and functionality, and should not be used in production
environments.

Data types are organized in the following categories:

All
File
Database
Azure
Online Services
Other

The All category includes all data connection types from all categories.

The File category provides the following data connections:

Excel
Text/CSV
XML
JSON
Folder



NOTENOTE

SharePoint Folder

The following image shows the Get Data window for File.

In previous versions of Power BI Desktop, CSV and Text were separate data connection types. Those data
connectors have been combined into CSV/Text.

The Database category provides the following data connections:

SQL Server Database
Access Database
SQL Server Analysis Services Database
Oracle Database
IBM DB2 Database
IBM Informix database (Beta)
IBM Netezza (Beta)
MySQL Database
PostgreSQL Database
Sybase Database
Teradata Database
SAP HANA Database
SAP Business Warehouse server



NOTENOTE

Amazon Redshift
Impala
Google BigQuery (Beta)
Snowflake

Some database connectors require that you enable them by selecting File > Options and settings > Options then
selecting Preview Features and enabling the connector. If you don't see some of the connectors mentioned above
and want to use them, check your Preview Features settings. Also note that any data source marked as Beta or
Preview has limited support and functionality, and should not be used in production environments.

The following image shows the Get Data window for Database.

The Azure category provides the following data connections:

Azure SQL Database
Azure SQL Data Warehouse
Azure Analysis Services database (Beta)
Azure Blob Storage
Azure Table Storage
Azure Cosmos DB (Beta)
Azure Data Lake Store
Azure HDInsight (HDFS)



Azure HDInsight Spark (Beta)

The following image shows the Get Data window for Azure.

The Online Services category provides the following data connections:

Power BI service
SharePoint Online List
Microsoft Exchange Online
Dynamics 365 (online)
Dynamics 365 for Financials (Beta)
Common Data Service (Beta)
Microsoft Azure Consumption Insights (Beta)
Visual Studio Team Services (Beta)
Salesforce Objects
Salesforce Reports
Google Analytics
appFigures (Beta)
comScore Digital Analytix (Beta)
Dynamics 365 for Customer Insights (Beta)
Facebook
GitHub (Beta)
Kusto (Beta)
MailChimp (Beta)



Mixpanel (Beta)
Planview Enterprise (Beta)
Projectplace (Beta)
QuickBooks Online (Beta)
Smartsheet
SparkPost (Beta)
SQL Sentry (Beta)
Stripe (Beta)
SweetIQ (Beta)
Troux (Beta)
Twilio (Beta)
tyGraph (Beta)
Webtrends (Beta)
Zendesk (Beta)

The following image shows the Get Data window for Online Services.

The Other category provides the following data connections:

Vertica (Beta)
Web
SharePoint List
OData Feed



NOTENOTE

Connecting to a Data Source

Active Directory
Microsoft Exchange
Hadoop File (HDFS)
Spark (Beta)
R Script
ODBC
OLE DB
Blank Query

The following image shows the Get Data window for Other.

At this time, it's not possible to connect to custom data sources secured using Azure Active Directory.

To connect to a data source, select the data source from the Get Data window and select Connect. In the
following image, Web is selected from the Other data connection category.



A connection window is displayed, specific to the type of data connection. If credentials are required, you’ll
be prompted to provide them. The following image shows a URL being entered to connect to a Web data
source.

When the URL or resource connection information is entered, select OK. Power BI Desktop makes the
connection to the data source, and presents the available data sources in the Navigator.



Next steps

You can either load the data by selecting the Load button at the bottom of the Navigator pane, or edit the
query before loading data by selecting the Edit button.

That’s all there is to connecting to data sources in Power BI Desktop! Try connecting to data from our
growing list of data sources, and check back often - we continue to add to this list all the time.

There are all sorts of things you can do with Power BI Desktop. For more information on its capabilities,
check out the following resources:

Getting Started with Power BI Desktop
Query Overview with Power BI Desktop
Data Types in Power BI Desktop
Shape and Combine Data with Power BI Desktop
Common Query Tasks in Power BI Desktop



Connect to data in Power BI Desktop
12/6/2017 • 2 min to read • Edit Online

With Power BI Desktop you can easily connect to the ever expanding world of data. If you don’t have Power BI
Desktop, you can download and install it.

There are all sorts of data sources available in Power BI Desktop. The following image shows how to connect to
data, by selecting the File ribbon, then Get Data > More.

For this example, we'll connect to a Web data source.

Imagine you’re retiring – you want to live where there’s lots of sunshine, preferable taxes, and good health care.
Or… perhaps you’re a data analyst, and you want that information to help your customers – as in, help your
raincoat manufacturing client target sales where it rains a lot.

Either way, you find a Web resource that has interesting data about those topics, and more:

http://www.bankrate.com/finance/retirement/best-places-retire-how-state-ranks.aspx

You select Get Data > Web and type the address.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-connect-to-data.md
http://go.microsoft.com/fwlink/?LinkID=521662
http://www.bankrate.com/finance/retirement/best-places-retire-how-state-ranks.aspx


When you select OK, the Query functionality of Power BI Desktop goes to work. Power BI Desktop contacts the
Web resource, and the Navigator window returns the results of what it found on that Web page. In this case, it
found a table (Table 0) and the overall Document. We’re interested in the table, so we select it from the list. The
Navigator window displays a preview.

At this point we can edit the query before loading the table, by selecting Edit from the bottom of the window, or
we can load the table.

If we select Edit, the table is loaded and Query Editor is launched. The Query Settings pane is displayed (if it’s
not, you can select View from the ribbon, then Show > Query Settings to display the Query Settings pane).
Here’s what that looks like.



All those scores are text rather than numbers, and we need them to be numbers. No problem – just right-click
the column header, and select Change Type > Whole Number to change them. To choose more than one
column, first select a column then hold down SHIFT, select additional adjacent columns, and then right-click a
column header to change all selected columns. Use CTRL to choose columns that are not adjacent.



In Query Settings, the Applied Steps will reflect any changes that were made. As you make additional changes
to the data, Query Editor will record those changes in the Applied Steps section, which you can adjust, revisit,
rearrange, or delete as necessary.

Additional changes to the table can still be made after it’s loaded, but for now this will do. When we're done we
select Close & Apply from the Home ribbon, and Power BI Desktop applies our changes and closes Query
Editor.

With the data model loaded, in Report view in Power BI Desktop, we can begin creating visualizations by
dragging fields onto the canvas.



Next stepsNext steps

Of course, this is a simple model with a single data connection; most Power BI Desktop reports will have
connections to different data sources, shaped to meet your needs, with relationships that produce a rich data
model.

There are all sorts of things you can do with Power BI Desktop. For more information on its capabilities, check
out the following resources:

Getting Started with Power BI Desktop
Query Overview with Power BI Desktop
Data Sources in Power BI Desktop
Shape and Combine Data with Power BI Desktop
Common Query Tasks in Power BI Desktop

Want to give us feedback? Great – use the Send Feedback menu item in Power BI Desktop. We look forward to
hearing from you!





Connect to datasets in the Power BI service from
Power BI Desktop
1/25/2018 • 7 min to read • Edit Online

Using a Power BI service live connection for report lifecycle
management

Create a dataset everyone can use, then share itCreate a dataset everyone can use, then share it

You can establish a live connection to a shared dataset in the Power BI service, and create many different reports
from the same dataset. This means you can create your perfect data model in Power BI Desktop, publish it to the
Power BI service, then you and others can create multiple different reports (in separate .pbix files) from that same,
common data model. This features is called Power BI service Live connection.

There are all sorts of benefits of this feature, including best practices, which we’ll discuss during this article. There
are also a few considerations and limitations, so please make sure you read through those - they're found at the
end of this article.

One challenge with the popularity of Power BI is the proliferation of reports, dashboards, and their underlying data
models. Here's why: it's easy to create compelling reports in Power BI Desktop, then share (publish) those reports
in the Power BI service, and to create great dashboards from those datasets. Since so many people were doing so,
often using the same (or nearly the same) datasets, knowing which report was based on which dataset - and how
fresh each dataset might be - became a challenge. The Power BI service Live Connection addresses that
challenge, and makes creating, sharing, and expanding upon common-dataset reports and dashboards easier and
consistent.

Let's say Anna (a business analyst) is on your team, and she's great at creating good data models (often called
datasets). With Anna's expertise, she can create a dataset and report, and then share that report in the Power BI
service.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-report-lifecycle-datasets.md


Connect to a Power BI service dataset using a live connectionConnect to a Power BI service dataset using a live connection

Everyone loves her report, and her dataset, and that's where the trouble would begin - everyone on her team
would attempt to create their own version of that dataset, then share their own reports with the team. All of the
sudden there was a multitude of reports (from different datasets) in your team's workspace in the Power BI
service. Which was the most recent? Were the datasets the same, or only almost? What were the differences? With
the Power BI service Live Connection feature, all that can change for the better. In the next section, we see how
others can use Anna's published dataset for their own reports, and enable everyone to use the same solid, vetted,
published dataset to build their unique reports.

Once Anna creates her report (and creates the dataset it's based upon), she publishes it to the Power BI service, it
shows up in her team's workspace in the Power BI service. Now it's available for everyone in her workspace to see
and use.

Other members of her workspace can now establish a live connection to Anna's shared data model (using the
Power BI service live connection feature), and create their own unique reports, from her original dataset.

In the following image, you see how Anna creates one Power BI Desktop report, and publishes it (which includes
its data model) to the Power BI service. Then others in her workspace can connect to her data model using the
Power BI service live connection, and create their own unique reports based on her dataset.



NOTENOTE

Step-by-step for using the Power BI service live connection

Publish a Power BI report and datasetPublish a Power BI report and dataset

Datasets are only shared in one workspace. To establish a Power BI service live connection, the dataset to which you connect
must be in a shared workspace of which you are a member.

Now that we know how useful the Power BI service live connection is, and how you can use it as a best practice
approach to report lifecycle management, let's walk through the steps that get us from Anna's great report (and
dataset) to a shared dataset that teammates in her Power BI workspace can use.

The first step in managing the report lifecycle using a Power BI service live connection is to have a report (and
dataset) that teammates want to use. So Anna must first publish her report from Power BI Destkop. She does
this by selecting Publish from the Home ribbon in Power BI Desktop.

If she isn't signed in to her Power BI service account, she's prompted to do so.

From there, she can choose the workspace destination to which the report and dataset will be published.
Remember, only members who have access to the workspace where a report is published can access its dataset
using a Power BI service live connection.



Establish a Power BI service live connection to the published datasetEstablish a Power BI service live connection to the published dataset

The publishing process begins, and Power BI Desktop shows the progress.

Once complete, Power BI Desktop shows you success, and provides a couple links to get you to the report itself in
the Power BI service, and a link to get Quick Insights on the report.

Next, let's see how other teammates who have access to the workspace where the report (and dataset) were
published can connect to the dataset and build our own reports.

To establish a connection to the published report, and create your own report based on the published dataset,
select Get Data from the Home ribbon in Power BI Desktop, and select Power BI service. You can also select it
from Get Data > Online Services > Power BI service.



If you're not signed in to Power BI, you'll be prompted to do so. Once logged in, you're presented with a window
that shows which workspaces you're a member of, and you can select which workspace contains the dataset to
which you want to establish a Power BI service live connection.

The number in brackets beside the workspace shows how many shared datasets are available in that workgroup,
and selecting the triangle to the left expands the workspace, allowing you to select the shared dataset.



NOTENOTE

Limitations and considerations

There are a few items to note from the previous Power BI service live connection window:

You can search for a shared dataset, but the search results are limited to the expanded items, and won't include
any workspaces that you have not expanded.
You can expand more than one workspace to expand your search.

When you select Load from the window, you establish a live connection to the selected dataset, which means the
data you see (the fields, and their values) are loaded into Power BI Desktop in real time.

Now you (and others) can create and share custom reports and share them, all from the same dataset. This is a
great way to have one knowledgeable person create a well-formed dataset (such as what Anna does), and allow
many teammates use that shared dataset to create their own reports.

When you create reports based on dataset using a live connection to the Power BI service, you can only publish that report
to the same Power BI service workspace that contains the dataset being used.

When using the Power BI service live connection, there are a few limitations and considerations to keep in
mind.

Read-only members of a workspace cannot connect to datasets from Power BI Desktop.
Only users who are part of the same Power BI service workspace can connect to a published dataset using the



Power BI service live connection. Users can (and often do) belong to more than one workspace.
Since this is a live connection, left-navigation and modeling are disabled, similar to the behavior when
connected to SQL Server Analysis Services.
Since this is a live connection, RLS (row- and role-level security), OneDrive for Business, and other such
connection behaviors are enforced, just as they are when connected to SQL Server Analysis Services.
When selecting which dataset to connect to in the Power BI service, the search box only applies to workspaces
that have been expanded.
If you modify the original shared .pbix file, the dataset and report that is shared in the Power BI service is
overwritten.
You cannot replace the originally shared report. Attempts to do so result in a warning that prompts you to
rename the file, and publish.
If you delete the shared dataset in the Power BI service, then other Power BI Desktop (.pbix files) will no
longer work properly or display their visuals.
For Content Packs, you must first create a copy of a content pack before using it as a basis for sharing a .pbix
report and dataset to the Power BI service.
For Content Packs from My Organization, once copied, you cannot replace the report created on the service
and/or a report created as part of copying a Content Pack with a live connection. Attempts to do so result in a
warning that prompts you to rename the file, and publish. In this situation, you can only replace published live
connected reports.
When you create a report based on dataset using a live connection to the Power BI service, you can only
publish that report to the same Power BI service workspace that contains the dataset being used.
Deleting a shared dataset in the Power BI service means you can no longer access that dataset from Power BI
Desktop.



Import Excel workbooks into Power BI Desktop
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How do I import an Excel workbook?

With Power BI Desktop, you can easily import Excel workbooks that contain Power Query queries, Power Pivot
models and Power View worksheets into Power BI Desktop. Reports and visualizations are automatically created
based on the Excel workbook, and once imported, you can continue to improve and refine those reports using
Power BI Desktop, using the existing features and new features released with each Power BI Desktop monthly
update.

In the future we plan to provide additional communication between Excel and Power BI Desktop (such as
import/export); this current ability to import workbooks into Power BI Desktop lets existing Excel users get started
with Power BI Desktop.

To import a workbook, from Power BI Desktop select File -> Import -> Excel Workbook Contents.

A window appears, letting you select the workbook to import. There is currently no limitation on the size or
number of objects in the workbook, but larger workbooks take longer for Power BI Desktop to analyze and import.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-import-excel-workbooks.md


NOTENOTE
To load or import Excel files from shared OneDrive for Business folders or from Office 365 group folders, use the URL of
the Excel file, and input it into the Web data source in Power BI Desktop. There are a few steps you need to follow to
properly format the OneDrive for Business URL, so check out Use OneDrive for Business links in Power BI Desktop for
more information and the correct series of steps.

Once a workbook is selected, Power BI Desktop analyzes the workbook and converts it into a Power BI Desktop file
(.pbix). Note that this is a one-time event; once the Power BI Desktop file is created with these steps, the Power BI
Desktop file has no dependence on the original Excel workbook, and can be modified or changed (and saved, and
shared) without affecting the original workbook.

Once the import is finished, a Summary page is displayed that describes the items that were converted, and also
lists any items that were not able to be imported.

When you select Close, the report is loaded in Power BI Desktop. The following image shows Power BI Desktop
after an Excel workbook was imported: Power BI Desktop automatically loaded the report based on the workbook
contents.



Which workbook elements are imported?

OBJECT IN EXCEL WORKBOOK FINAL RESULT IN POWER BI DESKTOP FILE

Power Query queries All Power Query queries from Excel are converted to queries in
Power BI Desktop. If there were Query Groups defined in the
Excel Workbook, the same organization will be replicated in
Power BI Desktop. All queries are loaded unless they were set
to “Only Create Connection” in Excel. The Load behavior can
be customized from the Properties dialog in the Home tab
of Query Editor in Power BI Desktop.

Power Pivot External Data Connections All Power Pivot External Data Connections will be converted to
queries in Power BI Desktop.

Linked Tables or Current Workbook tables If there is a worksheet table in Excel linked to the Data Model,
or linked to a query (by using From Table or the
Excel.CurrentWorkbook() function in M), the following options
are presented 1. Import the table to the Power BI Desktop file.
This is a one-time snapshot of the data, after which you
cannot edit the data in the table in Power BI Desktop. There is
a size limitation of 1 million characters (total, combining all
column headers and cells) for tables created using this option.
2. Keep a connection to the original workbook. Alternatively,
you can keep a connection to the original Excel Workbook and
Power BI Desktop retrieves the latest content in this table
with each refresh, just like any other query created against an
Excel workbook in Power BI Desktop.

Now that the workbook is imported, you can continue working on the report – such as creating new visualizations,
adding data, or creating new report pages – using any of the features and capabilities included in Power BI
Desktop.

Power BI Desktop can import the following elements, commonly referred to as objects, in Excel.



Data Model Calculated Columns, Measures, Data Categories
and Relationships

These Data Model objects are converted to the equivalent
objects in Power BI Desktop. Note that there are certain Data
Categories that are not available in Power BI Desktop yet,
such as Image. In these cases, the Data Category information
will be reset for the columns in question.

Power View Worksheets A new report page is created for each Power View worksheet
in Excel. The name and order of these report pages match the
original Excel workbook.

OBJECT IN EXCEL WORKBOOK FINAL RESULT IN POWER BI DESKTOP FILE

Are there any limitations to importing a workbook?
There are a few limitations to importing a workbook into Power BI Desktop, which are the following:

1. External Connections to Analysis Services Tabular Models: In Excel 2013, it is possible to create a
connection to SQL Server Analysis Services Tabular models and create Power View reports on top of these
models without the need to import the data. This type of connection is currently not supported as part of
importing Excel Workbooks into Power BI Desktop, but will be available in an upcoming update. In the
meantime, you must recreate these external connections in Power BI Desktop.

2. KPIs: This type of Data Model object is currently not supported in Power BI Desktop. As such, KPIs are skipped
as part of importing an Excel workbook into Power BI Desktop.

3. Hierarchies: This type of Data Model object is currently not supported in Power BI Desktop. As such,
hierarchies are skipped as part of importing an Excel Workbook into Power BI Desktop.

4. Binary data columns: This type of Data Model column is currently not supported in Power BI Desktop. Binary
Data columns are removed from the resulting table in Power BI Desktop.

5. Unsupported Power View elements: There are a few features in Power View that are not yet available in
Power BI Desktop, such as Themes or certain types of visualizations (Scatter Chart with Play Axis, Drill-Down
behaviors, etc.). These unsupported visualizations result in Unsupported Visualization messages on their
corresponding locations in the Power BI Desktop report, which you can delete or reconfigure as needed.

6. Named Ranges using From Table in Power Query, or using Excel.CurrentWorkbook in M: Importing this
named range data into Power BI Desktop is not currently supported, but it is a planned update for Power BI
Desktop. Currently, these named ranges are loaded into Power BI Desktop as a connection to the external Excel
workbook.

7. PowerPivot to SSRS: PowerPivot external connections to SQL Server Reporting Services (SSRS) are not
currently supported, since that data source is not currently available in Power BI Desktop.



Connect to data using generic interfaces in Power BI
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Power BI Desktop data interfaces

You can connect to a multitude of different data sources in Power BI Desktop, using built-in data connectors that
range from Access databases to Zendesk resources, as shown in the Get Data window. You can also connect to
all sorts of other data sources, which even further expands your connectivity options, by using the generic
interfaces (such as ODBC or REST APIs) built into Power BI Desktop.

Power BI Desktop includes an ever-growing collection of data connectors that are built to connect to a specific
data source. For example, the SharePoint List data connector provides specific fields and supporting information
during the connection sequence that are designed for SharePoint Lists, which is the case with other data sources
found in the window that appears when you select Get Data > More... (shown in the previous image).

In addition, Power BI Desktop lets you connect to data sources that aren't specifically identified in the Get Data
lists, by using one of the following generic data interfaces:

ODBC
OLE DB

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-connect-using-generic-interfaces.md


Data sources accessible through ODBC

POWER BI DESKTOP GENERIC CONNECTOR EXTERNAL DATA SOURCE LINK FOR MORE INFORMATION

ODBC Cassandra Cassandra ODBC driver

ODBC Couchbase DB Couchbase and Power BI

ODBC DynamoDB DynamoDB ODBC driver

ODBC Google BigQuery BigQuery ODBC driver

ODBC Hbase Hbase ODBC driver

OData
REST APIs
R Scripts

By providing the appropriate parameters in the connection windows that these generic interfaces provide, the
world of data sources you can access and use in Power BI Desktop grows significantly.

In the following sections, you can find lists of data sources that can be accessed by these generic interfaces.

Can't find the data source you wanted to use with Power BI Desktop? Please let us know so we can add it to our
list of ideas and requests.

The ODBC connector in Power BI Desktop lets you import data from any third-party ODBC driver simply by
specifying a Data Source Name (DSN) or a connection string. As an option, you can also specify a SQL statement
to execute against the ODBC driver.

The following list details a few examples of data sources to which Power BI Desktop can connect by using the
generic ODBC interface.

https://ideas.powerbi.com/
http://www.simba.com/drivers/cassandra-odbc-jdbc/
https://powerbi.microsoft.com/en-us/blog/visualizing-data-from-couchbase-server-v4-using-power-bi/
http://www.simba.com/drivers/dynamodb-odbc-jdbc/
http://www.simba.com/drivers/bigquery-odbc-jdbc/
http://www.simba.com/drivers/hbase-odbc-jdbc/


ODBC Hive Hive ODBC driver

ODBC IBM Netezza IBM Netezza information

ODBC Presto Presto ODBC driver

ODBC Project Online Project Online article

ODBC Progress OpenEdge Progress OpenEdge ODBC driver blog
post
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Data sources accessible through OLE DB

POWER BI DESKTOP GENERIC CONNECTOR EXTERNAL DATA SOURCE LINK FOR MORE INFORMATION

OLE DB SAS OLE DB SAS provider for OLE DB

OLE DB Sybase OLE DB Sybase provider for OLE DB

Data sources accessible through OData

The OLE DB connector in Power BI Desktop lets you import data from any third-party OLE DB driver simply by
specifying a connection string. As an option, you can also specify a SQL statement to execute against the OLE DB
driver.

The following list details a few examples of the data sources to which Power BI Desktop can connect by using the
generic OLE DB interface.

The OData connector in Power BI Desktop lets you import data from any OData URL simply by typing in or
pasting the OData URL. You can add multiple URL parts by typing or pasting those links in the text boxes provided

http://www.simba.com/drivers/hive-odbc-jdbc/
https://www.ibm.com/support/knowledgecenter/SSULQD_7.2.1/com.ibm.nz.datacon.doc/c_datacon_plg_overview.html
http://www.simba.com/drivers/presto-odbc-jdbc/
https://na01.safelinks.protection.outlook.com/?url=https%3A%2F%2Fwww.progress.com%2Fblogs%2Fconnect-microsoft-power-bi-to-openedge-via-odbc-driver&data=02%7C01%7CMatt.Masson%40microsoft.com%7C5e63742e6c454308b58a08d4034b5923%7C72f988bf86f141af91ab2d7cd011db47%7C1%7C0%7C636137069555329811&sdata=gSu2Rq3vZ0uBVOgjaXxd8Y3uBf%2B8DidX6PG33jwAduY%3D&reserved=0
https://support.sas.com/downloads/package.htm?pid=648
http://infocenter.sybase.com/help/index.jsp?topic=/com.sybase.infocenter.dc35888.1550/doc/html/jon1256941734395.html
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OData Coming soon Check back soon for OData data
sources

Data sources accessible through REST APIs

in the OData Feed window.

The following list details a few examples of the data sources to which Power BI Desktop can connect by using the
generic OData interface.

You can connect to data sources using the REST APIs and thereby use data from all sorts of data sources that
support REST.

The following list details a few examples of the data sources to which Power BI Desktop can connect by using the
generic REST APIs interface.
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REST APIs Couchbase DB Couchbase REST API information

Data sources accessible through R Script

POWER BI DESKTOP GENERIC CONNECTOR EXTERNAL DATA SOURCE LINK FOR MORE INFORMATION

R Script SAS Files R script guidance from CRAN

R Script SPSS Files R script guidance from CRAN

R Script R Statistical Files R script guidance from CRAN

Next steps

You can use R scripts to access data sources, and use that data in Power BI Desktop.

The following list details a few examples of the data sources to which Power BI Desktop can connect by using the
generic R scripts interface.

There are all sorts of data sources you can connect to using Power BI Desktop. For more information on data
sources, check out the following resources:

Getting Started with Power BI Desktop
Data Sources in Power BI Desktop
Shape and Combine Data with Power BI Desktop
Connect to Excel workbooks in Power BI Desktop
Enter data directly into Power BI Desktop

https://powerbi.microsoft.com/en-us/blog/visualizing-data-from-couchbase-server-v4-using-power-bi/
https://cran.r-project.org/doc/manuals/R-data.html
https://cran.r-project.org/doc/manuals/R-data.html
https://cran.r-project.org/doc/manuals/R-data.html
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Determining which version of Power BI Desktop is installed

Installing the Oracle client

Connect to an Oracle database

In order to connect to an Oracle database with Power BI Desktop, the correct Oracle client software must be
installed on the computer running Power BI Desktop. Which Oracle client software you use depends on which
version of Power BI Desktop you have installed - the 32-bit version or the 64-bit version.

Supported versions: Oracle 9 and later, Oracle client software 8.1.7 and later.

To determine which version of Power BI Desktop is installed, select File > About then check the Version: line. In
the following image, a 64-bit version of Power BI Desktop is installed:

For 32-bit versions of Power BI Desktop, use the following link to download and install the 32-bit Oracle client:

32-bit Oracle Data Access Components (ODAC) with Oracle Developer Tools for Visual Studio (12.1.0.2.4)

For 64-bit versions of Power BI Desktop, use the following link to download and install the 64-bit Oracle client:

64-bit ODAC 12c Release 4 (12.1.0.2.4) for Windows x64

Once the matching Oracle client driver is installed, you can connect to an Oracle database. Take the following steps
to make the connection.

1. From the Get Data window, select Database > Oracle Database

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-connect-oracle-database.md
http://www.oracle.com/technetwork/topics/dotnet/utilsoft-086879.html
http://www.oracle.com/technetwork/database/windows/downloads/index-090165.html


2. In the Oracle Database dialog that appears, provide the name of the server, and select Connect. If a SID is
required, you can specify that using the format: ServerName/SID.

3. If you want to import data using a native database query, you can put your query in the SQL Statement box,
available by expanding the Advanced options section of the Oracle Database dialog.



4. Once your Oracle database information is entered into the Oracle Database dialog (including any optional
information such as a SID or a native database query), select OK to connect.

5. If the Oracle database requires database user credentials, input those credentials in the dialog when prompted.
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Install R

Run R scripts

Prepare an R scriptPrepare an R script

Run your R script and import dataRun your R script and import data

You can run R scripts directly in Power BI Desktop, and import the resulting datasets into a Power BI Desktop
data model.

To run R scripts in Power BI Desktop, you need to install R on your local machine. You can download and install R
for free from many locations, including the Revolution Open download page, and the CRAN Repository. The
current release of R scripting in Power BI Desktop supports Unicode characters as well as spaces (empty
characters) in the installation path.

With just a few steps in Power BI Desktop you can run R scripts and create a data model, from which you can
create reports, and share them on the Power BI service. R scripting in Power BI Desktop now supports number
formats that contain decimals (.) and commas (,).

To run an R script in Power BI Desktop, create the script in your local R development environment, and make sure
it runs successfully.

To run the script in Power BI Desktop, make sure the script runs successfully in a new and unmodified workspace.
This means that all packages and dependencies must be explicitly loaded and run. You can use source() to run
dependent scripts.

When preparing and running an R script in Power BI Desktop, there are a few limitations:

Only data frames are imported, so make sure the data you want to import to Power BI is represented in a data
frame
Columns that are typed as Complex and Vector are not imported, and are replaced with error values in the
created table.
Values that are N/A are translated to NULL values in Power BI Desktop
Any R script that runs longer than 30 minutes times out
Interactive calls in the R script, such as waiting for user input, halts the script’s execution
When setting the working directory within the R script, you must define a full path to the working directory,
rather than a relative path

1. In Power BI Desktop, the R Script data connector is found in Get Data. To run your R Script, select Get Data
> More..., then select Other > R Script as shown in the following image.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-r-scripts.md
https://mran.revolutionanalytics.com/download/
https://cran.r-project.org/bin/windows/base/


2. If R is installed on your local machine, the latest installed version is selected as your R engine. Simply copy
your script into the script window and select OK.

3. If R is not installed, is not identified, or if there are multiple installations on your local machine, expand R
Installation Settings to display installation options, or to select which installation you want to run the R
script.



RefreshRefresh

4. Select OK to run the R Script. When the script runs successfully, you can then choose the resulting data frames
to add to the Power BI model.

If R is installed is not identified, you can explicitly provide its location in the text box provided when you
expand R Installation Settings. In the above image, the path C:\Program Files\R\R-3.2.0 is explicitly
provided in the text box.

R installation settings are centrally located in the R Scripting section of the Options dialog. To specify your R
installation settings, select File > Options and settings and then Options > R Scripting. If multiple
installations of R are available, a drop-down menu appears that allows you to select which installation to
use.



Next steps

You can refresh an R script in Power BI Desktop. When you refresh an R script, Power BI Desktop runs the R script
again in the Power BI Desktop environment.

Take a look at the following additional information about R in Power BI.

Create R Visuals in Power BI Desktop
Use an external R IDE with Power BI
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Installing R

Using R in Query Editor

You can use R, a programming language widely used by statisticians, data scientists, and data analysts, in the
Power BI Desktop Query Editor. This integration of R into Query Editor lets you perform data cleansing using R,
and perform advanced data shaping and analytics in datasets, including completion of missing data, predictions,
and clustering, just to name a few. R is a powerful language, and can be used in Query Editor to prepare your data
model and create reports.

To use R in Power BI Desktop's Query Editor, you need to install R on your local machine. You can download and
install R for free from many locations, including the Revolution Open download page, and the CRAN Repository.

To show how to use R in Query Editor, we'll use an example from a stock market dataset, based on a .CSV file that
you can download from here and follow along. The steps for this example are the following:

1. First, load your data into Power BI Desktop. In this example we'll load the EuStockMarkets_NA.csv file.
Select Get Data > CSV from the Home ribbon in Power BI Desktop.

2. Select the file and select Open, and the CSV is displayed in the CSV file dialog.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-r-in-query-editor.md
https://mran.revolutionanalytics.com/download/
https://cran.r-project.org/bin/windows/base/
http://download.microsoft.com/download/F/8/A/F8AA9DC9-8545-4AAE-9305-27AD1D01DC03/EuStockMarkets_NA.csv


3. Once the data is loaded, you'll see it in the Fields pane in Power BI Desktop.

4. Open Query Editor by selecting Edit Queries from the Home tab in Power BI Desktop.



library(mice)
tempData <- mice(dataset,m=1,maxit=50,meth='pmm',seed=100)
completedData <- complete(tempData,1)
output <- dataset
output$completedValues <- completedData$"SMI missing values"

NOTENOTE

5. In the Transform tab, select Run R Script and the Run R Script editor appears (shown in the next step).
Notice that rows 15 and 20 suffer from missing data, as do other rows you can't see in the following image.
The steps below show how R can (and will) complete those rows for you.

6. For this example, we'll enter the following script code:

You'll need to have the mice library installed in your R environment for the previous script code to work properly. To
install mice, run the following in your R installation: | > install.packages('mice')

When put into the Run R Script dialog, the code looks like the following:



7. When we select OK, Query Editor displays a warning about data privacy.

8. For the R scripts to work properly in the Power BI service, all data sources need to be set to public. For more
information about privacy settings and their implications, see Privacy Levels.

Once we do so, we see a new column in the Fields well called completedValues. Notice there are a few
missing data elements, such as on row 15 and 18. We'll see how R handles that in the next section.

With just five lines of R script, Query Editor filled in the missing values with a predictive model.



Creating visuals from R script data

NOTENOTE

Limitations

Now we can create a visual to see how the R script code using the mice library completed the missing values, as
shown in the following image.

Once that visual is complete, and any other visuals we might want to create using Power BI Desktop, we can save
the Power BI Desktop file (which saves as a .pbix file) and then use the data model, including the R scripts that are
part of it, in the Power BI service.

Want to see a completed .pbix file with these steps completed? You're in luck - you can download the completed Power BI
Desktop file used in these examples right here.

Once you've uploaded the .pbix file to the Power BI service, a couple more steps are necessary to enable data
refresh (in the service) and to enable visuals to be updated in the service (the data needs access to R for visuals to
be updated). The additional steps are the following:

Enable scheduled refresh for the dataset - to enable scheduled refresh for the workbook that contains your
dataset with R scripts, see Configuring scheduled refresh, which also includes information about Personal
Gateway.
Install the Personal Gateway - you need a Personal Gateway installed on the machine where the file is
located, and where R is installed; the Power BI service must access that workbook and re-render any updated
visuals. You can get more information on how to install and configure Personal Gateway.

There are some limitations to queries that include R scripts created in Query Editor:

All R data source settings must be set to Public, and all other steps in a query created in Query Editor must
also be public. To get to data source settings, in Power BI Desktop select File > Options and settings >
Data source settings.

http://download.microsoft.com/download/F/8/A/F8AA9DC9-8545-4AAE-9305-27AD1D01DC03/Complete Values with R in PQ.pbix


To enable scheduled refresh of your R visuals or dataset, you need to enable Scheduled refresh and have a
Personal Gateway installed on the computer that houses the workbook and the R installation. For more
information on both, see the previous section in this article, which provides links to learn more about each.

From the Data Source Settings dialog, select the the data source(s) and then select Edit Permissions...
and ensure that the Privacy Level is set to Public.

There are all sorts of things you can do with R and custom queries, so explore and shape your data just the way



you want it to appear.
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Enable an external R IDE

RequirementsRequirements

With Power BI Desktop, you can use your external R IDE (Integrated Development Environment) to create and
refine R scripts, then use those scripts in Power BI.

Previously, you had to use the R script editor in Power BI Desktop to create and run R scripts. With this release,
you can launch your external R IDE from Power BI Desktop and have your data automatically imported and
displayed in the R IDE. From there, you can modify the script in that external R IDE, then paste it back into Power
BI Desktop to create Power BI visuals and reports.

Beginning with the September 2016 release of Power BI Desktop (version 2.39.4526.362), you can specify which
R IDE you would like to use, and have it launch automatically from within Power BI Desktop.

To use this feature, you need to install an R IDE on your local computer. Power BI Desktop does not include,
deploy or install the R engine, so you must separately install R on your local computer. You can choose which R
IDE to use, with the following options:

You can install your favorite R IDE, many of which are available for free, such as the Revolution Open download
page, and the CRAN Repository.
Power BI Desktop also supports R Studio and Visual Studio 2015 with R Tools for Visual Studio editors.
You can also install a different R IDE and have Power BI Desktop launch that R IDE by doing one of the

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-r-ide.md
https://mran.revolutionanalytics.com/download/
https://cran.r-project.org/bin/windows/base/
https://www.rstudio.com/
https://beta.visualstudio.com/vs/rtvs/


Launch an R IDE from Power BI Desktop

following:

You can associate .R files with the external IDE you want Power BI Desktop to launch.
You can specify the .exe that Power BI Desktop should launch by selecting Other from the R Script
Options section of the Options dialog. You can bring up the Options dialog by going to File >
Options and settings > Options.

If you have multiple R IDEs installed, you can specify which will be launched by selecting it from the Detected R
IDEs drop-down in the Options dialog.

By default, Power BI Desktop will launch R Studio as the external R IDE if it's installed on your local computer; if
R Studio is not installed and you have Visual Studio 2015 with R Tools for Visual Studio, that will be launched
instead. If neither of those R IDEs is installed, the application associated with .R files is launched.

And if no .R file association exists, it's possible to specify a path to a custom IDE in the Browse to your preferred R
IDE section of the Options dialog. You can also launch a different R IDE by selecting the Settings gear icon beside
the Launch R IDE arrow icon, in Power BI Desktop.

To launch an R IDE from Power BI Desktop, take the following steps.

1. Load data into Power BI Desktop.
2. Select some fields from the Fields pane that you want to work with. If you haven't enabled script visuals yet,

you'll be prompted to do so.



3. When script visuals are enabled, you can select an R visual from the Visualizations pane, which creates a
blank R visual that's ready to display the results of your script. The R script editor pane also appears.

4. Now you can select the fields you want to use in your R script. When you select a field, the R script editor
field automatically creates script code based on the field or fields you select. You can either create (or paste)
your R script directly in the R script editor pane, your you can leave it empty.



NOTENOTE
The default aggregation type for R visuals is do not summarize.

5. You can now launch your R IDE directly from Power BI Desktop. Select the Launch R IDE button, found on
the right side of the R script editor title bar, as shown below.

6. Your specified R IDE is launched by Power BI Desktop, as shown in the following image (in this image,
RStudio is the default R IDE).



Known limitationsKnown limitations

Next steps

NOTENOTE

7. Any script you created in the R script editor pane of Power BI Desktop appears starting in line 4 in your R
IDE. At this point you can create your R script in the R IDE. Once your R script is complete in your R IDE, you
need to copy and paste it back into the R script editor pane in Power BI Desktop, excluding the first three
lines of the script that Power BI Desktop automatically generated. Do not copy the first three lines of script
back into Power BI Desktop, those lines were only used to import your data to your R IDE from Power BI
Desktop.

Power BI Desktop adds the first three lines of the script so it can import your data from Power BI Desktop once
you run the script.

Launching an R IDE directly from Power BI Desktop has a few limitations:

Automatically exporting your script from your R IDE into Power BI Desktop is not supported.
R Client editor (RGui.exe) is not supported, because the editor itself does not support opening files.

Take a look at the following additional information about R in Power BI.

Running R Scripts in Power BI Desktop
Create Power BI visuals using R
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Request support for a new R package

Requirements and Limitations of R packages

R packages that are supported in Power BI

PACKAGE VERSION LINK

abc 2.1 https://cran.r-
project.org/web/packages/abc/index.ht
ml

abc.data 1 https://cran.r-
project.org/web/packages/abc.data/inde
x.html

acepack 1.3-3.3 https://cran.r-
project.org/web/packages/acepack/inde
x.html

You can use the powerful R programming language to create visuals in the Power BI service. Many R packages are
supported in the Power BI service (and more are being supported all the time), and some packages are not.

The following sections provide an alphabetical table of which R packages are supported in Power BI, and which are
not. For more information about R in Power BI, see the R visuals article.

Supported R packages for the Power BI service are found in the following section, titled Supported Packages. If
you would like to request support of an R package not found in that list, you can send an email with your request
to the R in Power BI Feedback Team.

There are a handful of requirements and limitations for R packages:

The Power BI service, for the most part, supports R packages with free and open-source software licenses such
as GPL-2, GPL-3, MIT+, and so on.
The Power BI service supports packages published in CRAN. The service does not support private or custom R
packages. We encourage users to make their private packages available on CRAN prior to requesting the
package be available in the Power BI service.

For security and privacy reasons, we currently don't support R packages that provide client-server queries over
the World-Wide Web (such as RgoogleMaps) in the service. Networking is blocked for such attempts. See the
following section for a list of supported and unsupported R packages.
The approval process for including a new R package has a tree of dependencies; some dependencies required
to be installed in the service cannot be supported.

For Power BI Desktop has two variations for R packages:

For R visuals, you can install any package, including custom R packages
For Custom R visuals, only public CRAN packages are supported for auto-installation of the packages

The following table shows which packages are supported in the Power BI service.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-r-packages-support.md
https://www.r-project.org/
mailto:rinpbifb@microsoft.com
https://cran.r-project.org/web/packages/abc/index.html
https://cran.r-project.org/web/packages/abc.data/index.html
https://cran.r-project.org/web/packages/acepack/index.html


actuar 1.2-0 https://cran.r-
project.org/web/packages/actuar/index.
html

ade4 1.7-4 https://cran.r-
project.org/web/packages/ade4/index.h
tml

AdMit 2.0.1 https://cran.r-
project.org/web/packages/AdMit/index.
html

andrews 1 https://cran.r-
project.org/web/packages/andrews/inde
x.html

aod 1.3 https://cran.r-
project.org/web/packages/aod/index.ht
ml

apcluster 1.4.3 https://cran.r-
project.org/web/packages/apcluster/ind
ex.html

ape 3.4 https://cran.r-
project.org/web/packages/ape/index.ht
ml

aplpack 1.3.0 https://cran.r-
project.org/web/packages/aplpack/inde
x.html

approximator 1.2-6 https://cran.r-
project.org/web/packages/approximator
/index.html

arm 1.8-6 https://cran.r-
project.org/web/packages/arm/index.ht
ml

arules 1.4-0 https://cran.r-
project.org/web/packages/arules/index.
html

arulesViz 1.1-0 https://cran.r-
project.org/web/packages/arulesViz/ind
ex.html

assertthat 0.1 https://cran.r-
project.org/web/packages/assertthat/in
dex.html

BACCO 2.0-9 https://cran.r-
project.org/web/packages/BACCO/inde
x.html

PACKAGE VERSION LINK

https://cran.r-project.org/web/packages/actuar/index.html
https://cran.r-project.org/web/packages/ade4/index.html
https://cran.r-project.org/web/packages/AdMit/index.html
https://cran.r-project.org/web/packages/andrews/index.html
https://cran.r-project.org/web/packages/aod/index.html
https://cran.r-project.org/web/packages/apcluster/index.html
https://cran.r-project.org/web/packages/ape/index.html
https://cran.r-project.org/web/packages/aplpack/index.html
https://cran.r-project.org/web/packages/approximator/index.html
https://cran.r-project.org/web/packages/arm/index.html
https://cran.r-project.org/web/packages/arules/index.html
https://cran.r-project.org/web/packages/arulesViz/index.html
https://cran.r-project.org/web/packages/assertthat/index.html
https://cran.r-project.org/web/packages/BACCO/index.html


BaM 0.99 https://cran.r-
project.org/web/packages/BaM/index.ht
ml

BAS 1.1.0 https://cran.r-
project.org/web/packages/BAS/index.ht
ml

base64enc 0.1-3 https://cran.r-
project.org/web/packages/base64enc/in
dex.html

bayesm 3.0-2 https://cran.r-
project.org/web/packages/bayesm/inde
x.html

bayesQR 2.2 https://cran.r-
project.org/web/packages/bayesQR/ind
ex.html

bayesSurv 2.6 https://cran.r-
project.org/web/packages/bayesSurv/in
dex.html

BayesTree 0.3-1.3 https://cran.r-
project.org/web/packages/BayesTree/in
dex.html

BayHaz 0.1-3 https://cran.r-
project.org/web/packages/BayHaz/index
.html

bbemkr 2 https://cran.r-
project.org/web/packages/bbemkr/inde
x.html

BCBCSF 1.0-1 https://cran.r-
project.org/web/packages/BCBCSF/inde
x.html

BCE 2.1 https://cran.r-
project.org/web/packages/BCE/index.ht
ml

bclust 1.5 https://cran.r-
project.org/web/packages/bclust/index.
html

BenfordTests 1.2.0 https://cran.r-
project.org/web/packages/BenfordTests
/index.html

bisoreg 1.4 https://cran.r-
project.org/web/packages/bisoreg/index
.html

PACKAGE VERSION LINK

https://cran.r-project.org/web/packages/BaM/index.html
https://cran.r-project.org/web/packages/BAS/index.html
https://cran.r-project.org/web/packages/base64enc/index.html
https://cran.r-project.org/web/packages/bayesm/index.html
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bit 1.1-12 https://cran.r-
project.org/web/packages/bit/index.htm
l

bit64 0.9-5 https://cran.r-
project.org/web/packages/bit64/index.h
tml

bitops 1.0-6 https://cran.r-
project.org/web/packages/bitops/index.
html

BMA 3.18.6 https://cran.r-
project.org/web/packages/BMA/index.h
tml

Bmix 0.6 https://cran.r-
project.org/web/packages/Bmix/index.ht
ml

bnlearn 3.9 https://cran.r-
project.org/web/packages/bnlearn/inde
x.html

boa 1.1.8-1 https://cran.r-
project.org/web/packages/boa/index.ht
ml

boot 1.3-18 https://cran.r-
project.org/web/packages/boot/index.ht
ml

bootstrap 2015.2 https://cran.r-
project.org/web/packages/bootstrap/in
dex.html

bqtl 1.0-32 https://cran.r-
project.org/web/packages/bqtl/index.ht
ml

BradleyTerry2 1.0-6 https://cran.r-
project.org/web/packages/BradleyTerry
2/index.html

brew 1.0-6 https://cran.r-
project.org/web/packages/brew/index.h
tml

brglm 0.5-9 https://cran.r-
project.org/web/packages/brglm/index.
html

bspec 1.5 https://cran.r-
project.org/web/packages/bspec/index.
html
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bspmma 0.1-1 https://cran.r-
project.org/web/packages/bspmma/ind
ex.html

BVS 4.12.1 https://cran.r-
project.org/web/packages/BVS/index.ht
ml

C50 0.1.0-24 https://cran.r-
project.org/web/packages/C50/index.ht
ml

calibrator 1.2-6 https://cran.r-
project.org/web/packages/calibrator/ind
ex.html

car 2.1-2 https://cran.r-
project.org/web/packages/car/index.ht
ml

caret 6.0-64 https://cran.r-
project.org/web/packages/caret/index.h
tml

catnet 1.14.8 https://cran.r-
project.org/web/packages/catnet/index.
html

caTools 1.17.1 https://cran.r-
project.org/web/packages/caTools/index
.html

cclust 0.6-20 https://cran.r-
project.org/web/packages/cclust/index.h
tml

class 7.3-14 https://cran.r-
project.org/web/packages/class/index.ht
ml

clue 0.3-51 https://cran.r-
project.org/web/packages/clue/index.ht
ml

cluster 2.0.3 https://cran.r-
project.org/web/packages/cluster/index.
html

coda 0.18-1 https://cran.r-
project.org/web/packages/coda/index.ht
ml

coin 1.1-2 https://cran.r-
project.org/web/packages/coin/index.ht
ml
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CORElearn 1.47.1 https://cran.r-
project.org/web/packages/CORElearn/in
dex.html

corpcor 1.6.8 https://cran.r-
project.org/web/packages/corpcor/inde
x.html

corrplot 0.73 https://cran.r-
project.org/web/packages/corrplot/inde
x.html

crayon 1.3.1 https://cran.r-
project.org/web/packages/crayon/index.
html

cslogistic 0.1-3 https://cran.r-
project.org/web/packages/cslogistic/ind
ex.html

cubature 1.1-2 https://cran.r-
project.org/web/packages/cubature/ind
ex.html

cvTools 0.3.2 https://cran.r-
project.org/web/packages/cvTools/index
.html

data.table 1.9.6 https://cran.r-
project.org/web/packages/data.table/in
dex.html

Data.tree 0.7.0 https://cran.r-
project.org/web/packages/data.tree/ind
ex.html

date 1.2-34 https://cran.r-
project.org/web/packages/date/index.ht
ml

dbscan 0.9-7 https://cran.r-
project.org/web/packages/dbscan/index
.html

deal 1.2-37 https://cran.r-
project.org/web/packages/deal/index.ht
ml

deepnet 0.2 https://cran.r-
project.org/web/packages/deepnet/inde
x.html

deldir 0.1-12 https://cran.r-
project.org/web/packages/deldir/index.h
tml
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dendextend 1.1.8 https://cran.r-
project.org/web/packages/dendextend/i
ndex.html

DEoptimR 1.0-4 https://cran.r-
project.org/web/packages/DEoptimR/in
dex.html

deSolve 1.13 https://cran.r-
project.org/web/packages/deSolve/inde
x.html

DiagrammeR 0.8.2 https://cran.r-
project.org/web/packages/DiagrammeR
/index.html

dichromat 2.0-0 https://cran.r-
project.org/web/packages/dichromat/in
dex.html

digest 0.6.9 https://cran.r-
project.org/web/packages/digest/index.
html

dlm 1.1-4 https://cran.r-
project.org/web/packages/dlm/index.ht
ml

DMwR 0.4.1 https://cran.r-
project.org/web/packages/DMwR/index.
html

dplyr 0.4.3 https://cran.r-
project.org/web/packages/dplyr/index.h
tml

DPpackage 1.1-6 https://cran.r-
project.org/web/packages/DPpackage/i
ndex.html

dse 2015.12-1 https://cran.r-
project.org/web/packages/dse/index.ht
ml

DT 0.2 https://cran.r-
project.org/web/packages/DT/index.htm
l

dtw 1.18-1 https://cran.r-
project.org/web/packages/dtw/index.ht
ml

e1071 1.6-7 https://cran.r-
project.org/web/packages/e1071/index.
html
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earth 4.4.4 https://cran.r-
project.org/web/packages/earth/index.h
tml

EbayesThresh 1.3.2 https://cran.r-
project.org/web/packages/EbayesThres
h/index.html

ebdbNet 1.2.3 https://cran.r-
project.org/web/packages/ebdbNet/ind
ex.html

ellipse 0.3-8 https://cran.r-
project.org/web/packages/ellipse/index.
html

emulator 1.2-15 https://cran.r-
project.org/web/packages/emulator/ind
ex.html

ensembleBMA 5.1.2 https://cran.r-
project.org/web/packages/ensembleBM
A/index.html

entropy 1.2.1 https://cran.r-
project.org/web/packages/entropy/inde
x.html

EvalEst 2015.4-2 https://cran.r-
project.org/web/packages/EvalEst/index.
html

evaluate 0.8.3 https://cran.r-
project.org/web/packages/evaluate/inde
x.html

evdbayes 1.1-1 https://cran.r-
project.org/web/packages/evdbayes/ind
ex.html

exactLoglinTest 1.4.2 https://cran.r-
project.org/web/packages/exactLoglinTe
st/index.html

expm 0.999-0 https://cran.r-
project.org/web/packages/expm/index.h
tml

extremevalues 2.3.2 https://cran.r-
project.org/web/packages/extremevalue
s/index.html

FactoMineR 1.32 https://cran.r-
project.org/web/packages/FactoMineR/i
ndex.html
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factorQR 0.1-4 https://cran.r-
project.org/web/packages/factorQR/ind
ex.html

faoutlier 0.6.1 https://cran.r-
project.org/web/packages/faoutlier/inde
x.html

fBasics 3011.87 https://cran.r-
project.org/web/packages/fBasics/index.
html

fields 8.3-6 https://cran.r-
project.org/web/packages/fields/index.h
tml

filehash 2.3 https://cran.r-
project.org/web/packages/filehash/inde
x.html

fitdistrplus 1.0-6 https://cran.r-
project.org/web/packages/fitdistrplus/in
dex.html

flashClust 1.01-2 https://cran.r-
project.org/web/packages/flashClust/in
dex.html

FME 1.3.2 https://cran.r-
project.org/web/packages/FME/index.ht
ml

fmsb 0.5.2 https://cran.r-
project.org/web/packages/fmsb/index.h
tml

foreach 1.4.3 https://cran.r-
project.org/web/packages/foreach/index
.html

forecast 7 https://cran.r-
project.org/web/packages/forecast/inde
x.html

forecastHybrid 0.3.0 https://cran.r-
project.org/web/packages/forecastHybri
d/index.html

Formula 1.2-1 https://cran.r-
project.org/web/packages/Formula/inde
x.html

fracdiff 1.4-2 https://cran.r-
project.org/web/packages/fracdiff/index.
html
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fTrading 3010.78 https://cran.r-
project.org/web/packages/fTrading/inde
x.html

futile.logger 1.4.3 https://cran.r-
project.org/web/packages/futile.logger/i
ndex.html

gam 1.12 https://cran.r-
project.org/web/packages/gam/index.ht
ml

gamlr 1.13-3 https://cran.r-
project.org/web/packages/gamlr/index.
html

gclus 1.3.1 https://cran.r-
project.org/web/packages/gclus/index.h
tml

gdata 2.17.0 https://cran.r-
project.org/web/packages/gdata/index.
html

gee 4.13-19 https://cran.r-
project.org/web/packages/gee/index.ht
ml

genetics 1.3.8.1 https://cran.r-
project.org/web/packages/genetics/inde
x.html

geoRglm 0.9-8 https://cran.r-
project.org/web/packages/geoRglm/ind
ex.html

geosphere 1.5-1 https://cran.r-
project.org/web/packages/geosphere/in
dex.html

ggdendro 0.1-18 https://cran.r-
project.org/web/packages/ggdendro/in
dex.html

ggmap 2.6.1 https://cran.r-
project.org/web/packages/ggmap/index
.html

ggmcmc 0.8 https://cran.r-
project.org/web/packages/ggmcmc/ind
ex.html

ggplot2 2.1.0 https://cran.r-
project.org/web/packages/ggplot2/inde
x.html
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ggrepel 0.5 https://cran.r-
project.org/web/packages/ggrepel/inde
x.html

ggthemes 3.0.2 https://cran.r-
project.org/web/packages/ggthemes/in
dex.html

glmmBUGS 2.3 https://cran.r-
project.org/web/packages/glmmBUGS/i
ndex.html

glmnet 2.0-5 https://cran.r-
project.org/web/packages/glmnet/index
.html

gmodels 2.16.2 https://cran.r-
project.org/web/packages/gmodels/ind
ex.html

gmp 0.5-12 https://cran.r-
project.org/web/packages/gmp/index.ht
ml

gnm 1.0-8 https://cran.r-
project.org/web/packages/gnm/index.ht
ml

GPArotation 2014.11-1 https://cran.r-
project.org/web/packages/GPArotation/
index.html

gridBase 0.4-7 https://cran.r-
project.org/web/packages/gridBase/ind
ex.html

gridExtra 2.2.1 https://cran.r-
project.org/web/packages/gridExtra/ind
ex.html

growcurves 0.2.4.0 https://cran.r-
project.org/web/packages/growcurves/i
ndex.html

grpreg 2.8-1 https://cran.r-
project.org/web/packages/grpreg/index.
html

gss 2.1-5 https://cran.r-
project.org/web/packages/gss/index.ht
ml

gsubfn 0.6-6 https://cran.r-
project.org/web/packages/gsubfn/index.
html
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gtable 0.2.0 https://cran.r-
project.org/web/packages/gtable/index.
html

ggtern 2.2.0 https://cran.r-
project.org/web/packages/ggtern/index.
html

gtools 3.5.0 https://cran.r-
project.org/web/packages/gtools/index.
html

haplo.stats 1.7.6 https://cran.r-
project.org/web/packages/haplo.stats/in
dex.html

hash 2.2.6 https://cran.r-
project.org/web/packages/hash/index.ht
ml

hbsae 1 https://cran.r-
project.org/web/packages/hbsae/index.
html

hdrcde 3.1 https://cran.r-
project.org/web/packages/hdrcde/index.
html

heavy 0.3 https://cran.r-
project.org/web/packages/heavy/index.
html

HH 3.1-25 https://cran.r-
project.org/web/packages/HH/index.ht
ml

HI 0.4 https://cran.r-
project.org/web/packages/HI/index.html

Highcharter 0.5.0 https://cran.r-
project.org/web/packages/highcharter/i
ndex.html

Hmisc 3.17-3 https://cran.r-
project.org/web/packages/Hmisc/index.
html

HSAUR 1.3-7 https://cran.r-
project.org/web/packages/HSAUR/index
.html

ifultools 2.0-1 https://cran.r-
project.org/web/packages/ifultools/inde
x.html
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intervals 0.15.1 https://cran.r-
project.org/web/packages/intervals/inde
x.html

ipred 0.9-5 https://cran.r-
project.org/web/packages/ipred/index.h
tml

irlba 2.0.0 https://cran.r-
project.org/web/packages/irlba/index.ht
ml

irr 0.84 https://cran.r-
project.org/web/packages/irr/index.html

iterators 1.0.8 https://cran.r-
project.org/web/packages/iterators/inde
x.html

jpeg 0.1-8 https://cran.r-
project.org/web/packages/jpeg/index.ht
ml

kernlab 0.9-24 https://cran.r-
project.org/web/packages/kernlab/index
.html

KernSmooth 2.23-15 https://cran.r-
project.org/web/packages/KernSmooth/
index.html

KFKSDS 1.6 https://cran.r-
project.org/web/packages/KFKSDS/inde
x.html

kinship2 1.6.4 https://cran.r-
project.org/web/packages/kinship2/inde
x.html

kknn 1.3.1 https://cran.r-
project.org/web/packages/kknn/index.h
tml

klaR 0.6-12 https://cran.r-
project.org/web/packages/klaR/index.ht
ml

knitr 1.12.3 https://cran.r-
project.org/web/packages/knitr/index.ht
ml

labeling 0.3 https://cran.r-
project.org/web/packages/labeling/inde
x.html
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https://cran.r-project.org/web/packages/jpeg/index.html
https://cran.r-project.org/web/packages/kernlab/index.html
https://cran.r-project.org/web/packages/KernSmooth/index.html
https://cran.r-project.org/web/packages/KFKSDS/index.html
https://cran.r-project.org/web/packages/kinship2/index.html
https://cran.r-project.org/web/packages/kknn/index.html
https://cran.r-project.org/web/packages/klaR/index.html
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lars 1.2 https://cran.r-
project.org/web/packages/lars/index.ht
ml

lattice 0.20-33 https://cran.r-
project.org/web/packages/lattice/index.
html

latticeExtra 0.6-28 https://cran.r-
project.org/web/packages/latticeExtra/in
dex.html

lava 1.4.1 https://cran.r-
project.org/web/packages/lava/index.ht
ml

lavaan 0.5-20 https://cran.r-
project.org/web/packages/lavaan/index.
html

lazyeval 0.1.10 https://cran.r-
project.org/web/packages/lazyeval/inde
x.html

leaps 2.9 https://cran.r-
project.org/web/packages/leaps/index.h
tml

LearnBayes 2.15 https://cran.r-
project.org/web/packages/LearnBayes/i
ndex.html

LiblineaR 1.94-2 https://cran.r-
project.org/web/packages/LiblineaR/ind
ex.html

LICORS 0.2.0 https://cran.r-
project.org/web/packages/LICORS/inde
x.html

limSolve 1.5.5.1 https://cran.r-
project.org/web/packages/limSolve/inde
x.html

lme4 1.1-11 https://cran.r-
project.org/web/packages/lme4/index.h
tml

lmm 1 https://cran.r-
project.org/web/packages/lmm/index.ht
ml

lmtest 0.9-34 https://cran.r-
project.org/web/packages/lmtest/index.
html
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locfit 1.5-9.1 https://cran.r-
project.org/web/packages/locfit/index.ht
ml

locpol 0.6-0 https://cran.r-
project.org/web/packages/locpol/index.
html

LogicReg 1.5.8 https://cran.r-
project.org/web/packages/LogicReg/ind
ex.html

lsa 0.73.1 https://cran.r-
project.org/web/packages/lsa/index.htm
l

lubridate 1.5.0 https://cran.r-
project.org/web/packages/lubridate/ind
ex.html

magic 1.5-6 https://cran.r-
project.org/web/packages/magic/index.
html

magrittr 1.5 https://cran.r-
project.org/web/packages/magrittr/inde
x.html

mapdata 2.2-6 https://cran.r-
project.org/web/packages/mapdata/ind
ex.html

mapproj 1.2-4 https://cran.r-
project.org/web/packages/mapproj/inde
x.html

maps 3.1.0 https://cran.r-
project.org/web/packages/maps/index.h
tml

maptree 1.4-7 https://cran.r-
project.org/web/packages/maptree/inde
x.html

MASS 7.3-45 https://cran.r-
project.org/web/packages/MASS/index.
html

MasterBayes 2.52 https://cran.r-
project.org/web/packages/MasterBayes
/index.html

Matrix 1.2-4 https://cran.r-
project.org/web/packages/Matrix/index.
html
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matrixcalc 1.0-3 https://cran.r-
project.org/web/packages/matrixcalc/in
dex.html

MatrixModels 0.4-1 https://cran.r-
project.org/web/packages/MatrixModel
s/index.html

maxent 1.3.3.1 https://cran.r-
project.org/web/packages/maxent/index
.html

maxLik 1.3-4 https://cran.r-
project.org/web/packages/maxLik/index.
html

mboost 2.6-0 https://cran.r-
project.org/web/packages/mboost/inde
x.html

mda 0.4-8 https://cran.r-
project.org/web/packages/mda/index.ht
ml

memoise 1.0.0 https://cran.r-
project.org/web/packages/memoise/ind
ex.html

mi 1 https://cran.r-
project.org/web/packages/mi/index.htm
l

mice 2.25 https://cran.r-
project.org/web/packages/mice/index.ht
ml

microbenchmark 1.4-2.1 https://cran.r-
project.org/web/packages/microbench
mark/index.html

mime 0.4 https://cran.r-
project.org/web/packages/mime/index.h
tml

misc3d 0.8-4 https://cran.r-
project.org/web/packages/misc3d/index
.html

miscTools 0.6-16 https://cran.r-
project.org/web/packages/miscTools/in
dex.html

mitools 2.3 https://cran.r-
project.org/web/packages/mitools/index
.html
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mixtools 1.0.4 https://cran.r-
project.org/web/packages/mixtools/inde
x.html

mlbench 2.1-1 https://cran.r-
project.org/web/packages/mlbench/ind
ex.html

mnormt 1.5-4 https://cran.r-
project.org/web/packages/mnormt/inde
x.html

MNP 2.6-4 https://cran.r-
project.org/web/packages/MNP/index.h
tml

modeltools 0.2-21 https://cran.r-
project.org/web/packages/modeltools/i
ndex.html

mombf 1.6.1 https://cran.r-
project.org/web/packages/mombf/index
.html

monomvn 1.9-6 https://cran.r-
project.org/web/packages/monomvn/in
dex.html

MSBVAR 0.9-2 https://cran.r-
project.org/web/packages/MSBVAR/ind
ex.html

msm 1.6.1 https://cran.r-
project.org/web/packages/msm/index.h
tml

multcomp 1.4-4 https://cran.r-
project.org/web/packages/multcomp/in
dex.html

munsell 0.4.3 https://cran.r-
project.org/web/packages/munsell/inde
x.html

mvtnorm 1.0-5 https://cran.r-
project.org/web/packages/mvtnorm/ind
ex.html

NbClust 3 https://cran.r-
project.org/web/packages/NbClust/inde
x.html

ncvreg 3.5-1 https://cran.r-
project.org/web/packages/ncvreg/index.
html
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networkD3 0.2.13 https://cran.r-
project.org/web/packages/networkD3/i
ndex.html

neuralnet 1.33 https://cran.r-
project.org/web/packages/neuralnet/ind
ex.html

nlme 3.1-126 https://cran.r-
project.org/web/packages/nlme/index.h
tml

nloptr 1.0.4 https://cran.r-
project.org/web/packages/nloptr/index.
html

NLP 0.1-9 https://cran.r-
project.org/web/packages/NLP/index.ht
ml

NMF 0.20.6 https://cran.r-
project.org/web/packages/NMF/index.h
tml

nnet 7.3-12 https://cran.r-
project.org/web/packages/nnet/index.ht
ml

nnls 1.4 https://cran.r-
project.org/web/packages/nnls/index.ht
ml

nortest 1.0-4 https://cran.r-
project.org/web/packages/nortest/index
.html

numbers 0.6-1 https://cran.r-
project.org/web/packages/numbers/ind
ex.html

numDeriv 2014.2-1 https://cran.r-
project.org/web/packages/numDeriv/in
dex.html

OutlierDC 0.3-0 https://cran.r-
project.org/web/packages/OutlierDC/in
dex.html

pacbpred 0.92.2 https://cran.r-
project.org/web/packages/pacbpred/ind
ex.html

party 1.0-25 https://cran.r-
project.org/web/packages/party/index.h
tml
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partykit 1.0-5 https://cran.r-
project.org/web/packages/partykit/inde
x.html

PAWL 0.5 https://cran.r-
project.org/web/packages/PAWL/index.
html

pbivnorm 0.6.0 https://cran.r-
project.org/web/packages/pbivnorm/in
dex.html

pcaPP 1.9-60 https://cran.r-
project.org/web/packages/pcaPP/index.
html

pdc 1.0.3 https://cran.r-
project.org/web/packages/pdc/index.ht
ml

PerformanceAnalytics 1.4.3541 https://cran.r-
project.org/web/packages/Performance
Analytics/index.html

Plotly 4.5.6 https://cran.r-
project.org/web/packages/plotly/index.h
tml

plotmo 3.1.4 https://cran.r-
project.org/web/packages/plotmo/index
.html

plotrix 3.6-1 https://cran.r-
project.org/web/packages/plotrix/index.
html

pls 2.5-0 https://cran.r-
project.org/web/packages/pls/index.htm
l

plyr 1.8.3 https://cran.r-
project.org/web/packages/plyr/index.ht
ml

png 0.1-7 https://cran.r-
project.org/web/packages/png/index.ht
ml

polynom 1.3-8 https://cran.r-
project.org/web/packages/polynom/ind
ex.html

predmixcor 1.1-1 https://cran.r-
project.org/web/packages/predmixcor/i
ndex.html
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PresenceAbsence 1.1.9 https://cran.r-
project.org/web/packages/PresenceAbs
ence/index.html

profdpm 3.3 https://cran.r-
project.org/web/packages/profdpm/ind
ex.html

proto 0.3-10 https://cran.r-
project.org/web/packages/proto/index.h
tml

proxy 0.4-15 https://cran.r-
project.org/web/packages/proxy/index.h
tml

pryr 0.1.2 https://cran.r-
project.org/web/packages/pryr/index.ht
ml

pscl 1.4.9 https://cran.r-
project.org/web/packages/pscl/index.ht
ml

psych 1.5.8 https://cran.r-
project.org/web/packages/psych/index.
html

qap 0.1-0 https://cran.r-
project.org/web/packages/qap/index.ht
ml

qdapRegex 0.6.0 https://cran.r-
project.org/web/packages/qdapRegex/i
ndex.html

qcc 2.6 https://cran.r-
project.org/web/packages/qcc/index.ht
ml

quadprog 1.5-5 https://cran.r-
project.org/web/packages/quadprog/in
dex.html

quantreg 5.21 https://cran.r-
project.org/web/packages/quantreg/ind
ex.html

qvcalc 0.9-0 https://cran.r-
project.org/web/packages/qvcalc/index.
html

R.oo 1.20.0 https://cran.r-
project.org/web/packages/R.oo/index.ht
ml
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ramps 0.6-13 https://cran.r-
project.org/web/packages/ramps/index.
html

RandomFieldsUtils 0.0.14 https://cran.r-
project.org/web/packages/RandomField
sUtils/index.html

Rblpapi 0.3.5 https://cran.r-
project.org/web/packages/Rblpapi/index
.html

RColorBrewer 1.1-2 https://cran.r-
project.org/web/packages/RColorBrewe
r/index.html

Rcpp 0.12.3 https://cran.r-
project.org/web/packages/Rcpp/index.h
tml

RcppArmadillo 0.6.600.4.0 https://cran.r-
project.org/web/packages/RcppArmadill
o/index.html

RcppEigen 0.3.2.8.1 https://cran.r-
project.org/web/packages/RcppEigen/in
dex.html

redmonder 0.2.0 https://cran.r-
project.org/web/packages/Redmonder/i
ndex.html

registry 0.3 https://cran.r-
project.org/web/packages/registry/inde
x.html

relimp 1.0-5 https://cran.r-
project.org/web/packages/relimp/index.
html

reshape 0.8.5 https://cran.r-
project.org/web/packages/reshape/inde
x.html

reshape2 1.4.1 https://cran.r-
project.org/web/packages/reshape2/ind
ex.html

RGraphics 2.0-14 https://cran.r-
project.org/web/packages/RGraphics/in
dex.html

rjson 0.2.15 https://cran.r-
project.org/web/packages/rjson/index.h
tml
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RJSONIO 1.3-0 https://cran.r-
project.org/web/packages/RJSONIO/ind
ex.html

Rmpfr 0.6-0 https://cran.r-
project.org/web/packages/Rmpfr/index.
html

rms 4.4-2 https://cran.r-
project.org/web/packages/rms/index.ht
ml

robustbase 0.92-5 https://cran.r-
project.org/web/packages/robustbase/i
ndex.html

ROCR 1.0-7 https://cran.r-
project.org/web/packages/ROCR/index.
html

rpart.plot 1.5.3 https://cran.r-
project.org/web/packages/rpart.plot/ind
ex.html

rrcov 1.3-11 https://cran.r-
project.org/web/packages/rrcov/index.h
tml

rscproxy 2.0-5 https://cran.r-
project.org/web/packages/rscproxy/inde
x.html

RSGHB 1.1.2 https://cran.r-
project.org/web/packages/RSGHB/index
.html

RTextTools 1.4.2 https://cran.r-
project.org/web/packages/RTextTools/in
dex.html

rworldmap 1.3-6 https://cran.r-
project.org/web/packages/rworldmap/in
dex.html

SampleSizeMeans 1.1 https://cran.r-
project.org/web/packages/SampleSizeM
eans/index.html

SampleSizeProportions 1 https://cran.r-
project.org/web/packages/SampleSizePr
oportions/index.html

sbgcop 0.975 https://cran.r-
project.org/web/packages/sbgcop/index
.html
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scales 0.4.0 https://cran.r-
project.org/web/packages/scales/index.
html

scatterplot3d 0.3-36 https://cran.r-
project.org/web/packages/scatterplot3d
/index.html

sciplot 1.1-0 https://cran.r-
project.org/web/packages/sciplot/index.
html

segmented 0.5-1.4 https://cran.r-
project.org/web/packages/segmented/i
ndex.html

seriation 1.2-0 https://cran.r-
project.org/web/packages/seriation/ind
ex.html

setRNG 2013.9-1 https://cran.r-
project.org/web/packages/setRNG/inde
x.html

sfsmisc 1.1-0 https://cran.r-
project.org/web/packages/sfsmisc/index
.html

SIS 0.7-6 https://cran.r-
project.org/web/packages/SIS/index.ht
ml

SixSigma 0.9-3 https://cran.r-
project.org/web/packages/SixSigma/ind
ex.html

skmeans 0.2-8 https://cran.r-
project.org/web/packages/skmeans/ind
ex.html

slam 0.1-32 https://cran.r-
project.org/web/packages/slam/index.ht
ml

smoothSurv 1.6 https://cran.r-
project.org/web/packages/smoothSurv/i
ndex.html

sna 2.3-2 https://cran.r-
project.org/web/packages/sna/index.ht
ml

snow 0.4-1 https://cran.r-
project.org/web/packages/snow/index.h
tml
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https://cran.r-project.org/web/packages/seriation/index.html
https://cran.r-project.org/web/packages/setRNG/index.html
https://cran.r-project.org/web/packages/sfsmisc/index.html
https://cran.r-project.org/web/packages/SIS/index.html
https://cran.r-project.org/web/packages/SixSigma/index.html
https://cran.r-project.org/web/packages/skmeans/index.html
https://cran.r-project.org/web/packages/slam/index.html
https://cran.r-project.org/web/packages/smoothSurv/index.html
https://cran.r-project.org/web/packages/sna/index.html
https://cran.r-project.org/web/packages/snow/index.html


SnowballC 0.5.1 https://cran.r-
project.org/web/packages/SnowballC/in
dex.html

snowFT 1.4-0 https://cran.r-
project.org/web/packages/snowFT/inde
x.html

sp 1.2-2 https://cran.r-
project.org/web/packages/sp/index.html

spacetime 1.1-5 https://cran.r-
project.org/web/packages/spacetime/in
dex.html

spam 1.3-0 https://cran.r-
project.org/web/packages/spam/index.h
tml

SparseM 1.7 https://cran.r-
project.org/web/packages/SparseM/ind
ex.html

spatial 7.3-11 https://cran.r-
project.org/web/packages/spatial/index.
html

spBayes 0.3-9 https://cran.r-
project.org/web/packages/spBayes/inde
x.html

spikeslab 1.1.5 https://cran.r-
project.org/web/packages/spikeslab/ind
ex.html

splancs 2.01-38 https://cran.r-
project.org/web/packages/splancs/index
.html

spls 2.2-1 https://cran.r-
project.org/web/packages/spls/index.ht
ml

spTimer 2.0-1 https://cran.r-
project.org/web/packages/spTimer/inde
x.html

sqldf 0.4-10 https://cran.r-
project.org/web/packages/sqldf/index.ht
ml

sROC 0.1-2 https://cran.r-
project.org/web/packages/sROC/index.h
tml

PACKAGE VERSION LINK

https://cran.r-project.org/web/packages/SnowballC/index.html
https://cran.r-project.org/web/packages/snowFT/index.html
https://cran.r-project.org/web/packages/sp/index.html
https://cran.r-project.org/web/packages/spacetime/index.html
https://cran.r-project.org/web/packages/spam/index.html
https://cran.r-project.org/web/packages/SparseM/index.html
https://cran.r-project.org/web/packages/spatial/index.html
https://cran.r-project.org/web/packages/spBayes/index.html
https://cran.r-project.org/web/packages/spikeslab/index.html
https://cran.r-project.org/web/packages/splancs/index.html
https://cran.r-project.org/web/packages/spls/index.html
https://cran.r-project.org/web/packages/spTimer/index.html
https://cran.r-project.org/web/packages/sqldf/index.html
https://cran.r-project.org/web/packages/sROC/index.html


stabledist 0.7-0 https://cran.r-
project.org/web/packages/stabledist/ind
ex.html

stabs 0.5-1 https://cran.r-
project.org/web/packages/stabs/index.h
tml

stepPlr 0.92 https://cran.r-
project.org/web/packages/stepPlr/index.
html

stringdist 0.9.4.1 https://cran.r-
project.org/web/packages/stringdist/ind
ex.html

stringr 1.0.0 https://cran.r-
project.org/web/packages/stringr/index.
html

stsm 1.7 https://cran.r-
project.org/web/packages/stsm/index.ht
ml

stsm.class 1.3 https://cran.r-
project.org/web/packages/stsm.class/in
dex.html

survival 2.38-3 https://cran.r-
project.org/web/packages/survival/inde
x.html

tau 0.0-18 https://cran.r-
project.org/web/packages/tau/index.ht
ml

tcltk2 1.2-11 https://cran.r-
project.org/web/packages/tcltk2/index.h
tml

tensorA 0.36 https://cran.r-
project.org/web/packages/tensorA/inde
x.html

textcat 1.0-4 https://cran.r-
project.org/web/packages/textcat/index.
html

textir 2.0-4 https://cran.r-
project.org/web/packages/textir/index.h
tml

tfplot 2015.12-1 https://cran.r-
project.org/web/packages/tfplot/index.h
tml

PACKAGE VERSION LINK

https://cran.r-project.org/web/packages/stabledist/index.html
https://cran.r-project.org/web/packages/stabs/index.html
https://cran.r-project.org/web/packages/stepPlr/index.html
https://cran.r-project.org/web/packages/stringdist/index.html
https://cran.r-project.org/web/packages/stringr/index.html
https://cran.r-project.org/web/packages/stsm/index.html
https://cran.r-project.org/web/packages/stsm.class/index.html
https://cran.r-project.org/web/packages/survival/index.html
https://cran.r-project.org/web/packages/tau/index.html
https://cran.r-project.org/web/packages/tcltk2/index.html
https://cran.r-project.org/web/packages/tensorA/index.html
https://cran.r-project.org/web/packages/textcat/index.html
https://cran.r-project.org/web/packages/textir/index.html
https://cran.r-project.org/web/packages/tfplot/index.html


TH.data 1.0-7 https://cran.r-
project.org/web/packages/TH.data/inde
x.html

tidyr 0.4.1 https://cran.r-
project.org/web/packages/tidyr/index.ht
ml

timeDate 3012.1 https://cran.r-
project.org/web/packages/timeDate/ind
ex.html

timeSeries 3022.101.2 https://cran.r-
project.org/web/packages/timeSeries/in
dex.html

timevis 0.4 https://cran.r-
project.org/web/packages/timevis/index
.html

tm 0.6-2 https://cran.r-
project.org/web/packages/tm/index.htm
l

topicmodels 0.2-3 https://cran.r-
project.org/web/packages/topicmodels/i
ndex.html

tree 1.0-37 https://cran.r-
project.org/web/packages/tree/index.ht
ml

Treemap 2.4-2 https://cran.r-
project.org/web/packages/treemap/inde
x.html

tseries 0.10-34 https://cran.r-
project.org/web/packages/tseries/index.
html

tsfa 2014.10-1 https://cran.r-
project.org/web/packages/tsfa/index.ht
ml

tsoutliers 0.6 https://cran.r-
project.org/web/packages/tsoutliers/ind
ex.html

TSP 1.1-4 https://cran.r-
project.org/web/packages/TSP/index.ht
ml

vcd 1.4-1 https://cran.r-
project.org/web/packages/vcd/index.ht
ml

PACKAGE VERSION LINK

https://cran.r-project.org/web/packages/TH.data/index.html
https://cran.r-project.org/web/packages/tidyr/index.html
https://cran.r-project.org/web/packages/timeDate/index.html
https://cran.r-project.org/web/packages/timeSeries/index.html
https://cran.r-project.org/web/packages/timevis/index.html
https://cran.r-project.org/web/packages/tm/index.html
https://cran.r-project.org/web/packages/topicmodels/index.html
https://cran.r-project.org/web/packages/tree/index.html
https://cran.r-project.org/web/packages/treemap/index.html
https://cran.r-project.org/web/packages/tseries/index.html
https://cran.r-project.org/web/packages/tsfa/index.html
https://cran.r-project.org/web/packages/tsoutliers/index.html
https://cran.r-project.org/web/packages/TSP/index.html
https://cran.r-project.org/web/packages/vcd/index.html


VennDiagram 1.6.17 https://cran.r-
project.org/web/packages/VennDiagra
m/index.html

VGAM 1.0-1 https://cran.r-
project.org/web/packages/VGAM/index.
html

VIM 4.4.1 https://cran.r-
project.org/web/packages/VIM/index.ht
ml

whisker 0.3-2 https://cran.r-
project.org/web/packages/whisker/inde
x.html

wordcloud 2.5 https://cran.r-
project.org/web/packages/wordcloud/in
dex.html

xgboost 0.4-3 https://cran.r-
project.org/web/packages/xgboost/inde
x.html

XML 3.98-1.4 https://cran.r-
project.org/web/packages/XML/index.ht
ml

xts 0.9-7 https://cran.r-
project.org/web/packages/xts/index.htm
l

yaml 2.1.13 https://cran.r-
project.org/web/packages/yaml/index.ht
ml

zipfR 0.6-6 https://cran.r-
project.org/web/packages/zipfR/index.ht
ml

zoo 1.7-12 https://cran.r-
project.org/web/packages/zoo/index.ht
ml

PACKAGE VERSION LINK

R scripts that are not supported in Power BI

PACKAGE REQUEST DATE REASON

RgoogleMaps 10/05/2016 Networking is blocked

mailR 10/03/2016 Networking is blocked

The following table shows which packages are not supported in the Power BI service.

https://cran.r-project.org/web/packages/VennDiagram/index.html
https://cran.r-project.org/web/packages/VGAM/index.html
https://cran.r-project.org/web/packages/VIM/index.html
https://cran.r-project.org/web/packages/whisker/index.html
https://cran.r-project.org/web/packages/wordcloud/index.html
https://cran.r-project.org/web/packages/xgboost/index.html
https://cran.r-project.org/web/packages/XML/index.html
https://cran.r-project.org/web/packages/xts/index.html
https://cran.r-project.org/web/packages/yaml/index.html
https://cran.r-project.org/web/packages/zipfR/index.html
https://cran.r-project.org/web/packages/zoo/index.html


RevoScaleR 8/30/2016 ships only with Microsoft R Server

PACKAGE REQUEST DATE REASON

Next steps
For more information about R in Power BI, take a look at the following articles:

Creating R visuals in the Power BI service
Create Power BI visuals using R
Running R scripts in Power BI Desktop
Using R in Query Editor



Data types in Power BI Desktop
12/6/2017 • 9 min to read • Edit Online

Determine and specify a column’s data type

This article describes data types supported in Power BI Desktop and Data Analysis Expressions (DAX). 

When you load data into Power BI Desktop, it will attempt to convert the data type of the source column into a data
type that better supports more efficient storage, calculations, and data visualization. For example, if a column of
values you import from Excel has no fractional values, Power BI Desktop will convert the entire column of data to a
Whole Number data type, which is better suited for storing integers.

This is important because some DAX functions have special data type requirements. While in many cases DAX will
implicitly convert a data type for you, there are some cases where it will not. For instance, if a DAX function
requires a Date data type and the data type for your column is Text, the DAX function will not work correctly. So, it’s
both important and useful to get the correct data type for a column. Implicit conversions are described later in this
article.

In Power BI Desktop, you can determine and specify a column’s data type in the Query Editor, or in Data View or
Report View:

Data types in Query Editor

Data types in Data View or Report View

The Data Type drop down in Query Editor has two data types not currently present in Data or Report View:
Date/Time/Timezone and Duration. When a column with these data types are loaded into the model and

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-data-types.md


Number typesNumber types

Date/time typesDate/time types

Text typeText type

True/false typeTrue/false type

viewed in Data or Report view, a column with a Date/Time/Timezone data type will be converted into a Date/Time,
and a column with a Duration data type is converted into a Decimal Number.

Power BI Desktop supports three number types:

Decimal Number – Represents a 64 bit (eight-byte) floating point number. It’s the most common number type
and corresponds to numbers as you usually think of them. Although designed to handle numbers with fractional
values, it also handles whole numbers. The Decimal Number type can handle negative values from -1.79E +308
through -2.23E -308, 0, and positive values from 2.23E -308 through 1.79E + 308. For example, numbers like 34,
34.01, and 34.000367063 are valid decimal numbers. The largest value that can be represented in a Decimal
Number type is 15 digits long. The decimal separator can occur anywhere in the number. The Decimal Number
type corresponds to how Excel stores its numbers.

Fixed Decimal Number – Has a fixed location for the decimal separator. The decimal separator always has four
digits to its right and allows for 19 digits of significance. The largest value it can represent is
922,337,203,685,477.5807 (positive or negative). The Fixed Decimal Number type is useful in cases where
rounding might introduce errors. When you work with many numbers that have small fractional values they can
sometimes accumulate and force a number to be just slightly off. Since the values past the four digits to the right
of decimal separator are truncated, the Fixed Decimal type can help you avoid these kinds of errors. If you’re
familiar with SQL Server, this data type corresponds to SQL Server’s Decimal (19,4), or the Currency Data type in
Power Pivot.

Whole Number – Represents a 64 bit (eight-byte) integer value. Because it’s an integer, it has no digits to the
right of the decimal place. It allows for 19 digits; positive or negative whole numbers between -
9,223,372,036,854,775,808 (-2^63) and 9,223,372,036,854,775,807 (2^63-1). It can represent the largest possible
number of the various numeric data types. As with the Fixed Decimal type, the Whole Number type can be useful in
cases where you need to control rounding.

Power BI Desktop supports five Date/Time data types in Query View and three in the Report View and model. Both
Date/Time/Timezone and Duration are converted during load into the model.

Date/Time – Represents both a date and time value. Underneath the covers, the Date/Time value is stored as a
Decimal Number Type. So you can actually convert between the two. The time portion of a date is stored as a
fraction to whole multiples of 1/300 seconds (3.33ms). Dates between years 1900 and 9999 are supported.

Date – Represents just a Date (no time portion). When converted into the model, a Date is the same as a Date/Time
value with zero for the fractional value.

Time – Represents just Time (no Date portion). When converted into the model, a Time value is the same as a
Date/Time value with no digits to the left of the decimal place.

Date/Time/Timezone – Represents a UTC Date/Time. Currently, it’s converted into Date/Time when loaded into
the model.

Duration – Represents a length of time. It’s converted into a Decimal Number Type when loaded into the model.
As a Decimal Number type it can be added or subtracted from a Date/Time field with correct results. As a Decimal
Number type, you can easily use it in visualizations that show magnitude.

Text - A Unicode character data string. Can be strings, numbers or dates represented in a text format. Maximum
string length is 268,435,456 Unicode characters (256 mega characters) or 536,870,912 bytes.

True/False – A Boolean value of either a True or False.



Blanks/nulls typeBlanks/nulls type

Table data typeTable data type

Implicit and explicit data type conversion in DAX formulas

Table of implicit data conversionsTable of implicit data conversions

NOTENOTE

OPERATOR(+) INTEGER CURRENCY REAL DATE/TIME

INTEGER INTEGER CURRENCY REAL Date/time

CURRENCY CURRENCY CURRENCY REAL Date/time

REAL REAL REAL REAL Date/time

Date/time Date/time Date/time Date/time Date/time

Blank - Is a data type in DAX that represents and replaces SQL nulls. You can create a blank by using the BLANK
function, and test for blanks by using the ISBLANK logical function.

DAX uses a table data type in many functions, such as aggregations and time intelligence calculations. Some
functions require a reference to a table; other functions return a table that can then be used as input to other
functions. In some functions that require a table as input, you can specify an expression that evaluates to a table;
for some functions, a reference to a base table is required. For information about the requirements of specific
functions, see DAX Function Reference.

Each DAX function has specific requirements as to the types of data that are used as inputs and outputs. For
example, some functions require integers for some arguments and dates for others; other functions require text or
tables.

If the data in the column you specify as an argument is incompatible with the data type required by the function,
DAX in many cases will return an error. However, wherever possible DAX will attempt to implicitly convert the data
to the required data type. For example:

You can type a date as a string, and DAX will parse the string and attempt to cast it as one of the Windows date
and time formats.
You can add TRUE + 1 and get the result 2, because TRUE is implicitly converted to the number 1 and the
operation 1+1 is performed.
If you add values in two columns, and one value happens to be represented as text ("12") and the other as a
number (12), DAX implicitly converts the string to a number and then does the addition for a numeric result.
The following expression returns 44: = "22" + 22.
If you attempt to concatenate two numbers, Excel will present them as strings and then concatenate. The
following expression returns "1234": = 12 & 34.

The type of conversion that is performed is determined by the operator, which casts the values it requires before
performing the requested operation. These tables list the operators, and indicate the conversion that is performed
on each data type in the column when it is paired with the data type in the intersecting row.

Text data types are not included in these tables. When a number is represented as in a text format, in some cases Power BI
will attempt to determine the number type and represent it as a number.

Addition (+)

http://msdn.microsoft.com/library/ee634820.aspx
https://msdn.microsoft.com/library/ee634204.aspx
https://msdn.microsoft.com/library/ee634396.aspx


OPERATOR(-) INTEGER CURRENCY REAL DATE/TIME

INTEGER INTEGER CURRENCY REAL REAL

CURRENCY CURRENCY CURRENCY REAL REAL

REAL REAL REAL REAL REAL

Date/time Date/time Date/time Date/time Date/time

NOTENOTE

OPERATOR(*) INTEGER CURRENCY REAL DATE/TIME

INTEGER INTEGER CURRENCY REAL INTEGER

CURRENCY CURRENCY REAL CURRENCY CURRENCY

REAL REAL CURRENCY REAL REAL

OPERATOR(/)
(ROW/COLUMN) INTEGER CURRENCY REAL DATE/TIME

INTEGER REAL CURRENCY REAL REAL

CURRENCY CURRENCY REAL CURRENCY REAL

REAL REAL REAL REAL REAL

Date/time REAL REAL REAL REAL

For example, if a real number is used in an addition operation in combination with currency data, both values are
converted to REAL, and the result is returned as REAL.

Subtraction (-)

In the following table the row header is the minuend (left side) and the column header is the subtrahend (right
side).

For example, if a date is used in a subtraction operation with any other data type, both values are converted to
dates, and the return value is also a date.

Data models also support the unary operator, - (negative), but this operator does not change the data type of the operand.

Multiplication(*)

For example, if an integer is combined with a real number in a multiplication operation, both numbers are
converted to real numbers, and the return value is also REAL.

Division (/)

In the following table, the row header is the numerator and the column header is the denominator.

For example, if an integer is combined with a currency value in a division operation, both values are converted to
real numbers, and the result is also a real number.



Comparison operatorsComparison operators

COMPARISON
OPERATOR INTEGER CURRENCY REAL DATE/TIME

INTEGER INTEGER CURRENCY REAL REAL

CURRENCY CURRENCY CURRENCY REAL REAL

REAL REAL REAL REAL REAL

Date/time REAL REAL REAL Date/Time

Handling blanks, empty strings, and zero valuesHandling blanks, empty strings, and zero values

EXPRESSION DAX EXCEL

BLANK + BLANK BLANK 0(zero)

BLANK + 5 5 5

BLANK * 5 BLANK 0(zero)

5/BLANK Infinity Error

0/BLANK NaN Error

BLANK/BLANK BLANK Error

FALSE OR BLANK FALSE FALSE

FALSE AND BLANK FALSE FALSE

TRUE OR BLANK TRUE TRUE

In comparison expressions, Boolean values are considered greater than string values and string values are
considered greater than numeric or date/time values; numbers and date/time values are considered to have the
same rank. No implicit conversions are performed for Boolean or string values; BLANK or a blank value is
converted to 0/""/false depending on the data type of the other compared value.

The following DAX expressions illustrate this behavior:

=IF(FALSE()>"true","Expression is true", "Expression is false"), returns "Expression is true"

=IF("12">12,"Expression is true", "Expression is false"), returns "Expression is true".

=IF("12"=12,"Expression is true", "Expression is false"), returns "Expression is false"

Conversions are performed implicitly for numeric or date/time types as described in the following table:

In DAX, a null, blank value, empty cell, or a missing value are all represented by the same new value type, a BLANK.
You can also generate blanks by using the BLANK function, or test for blanks by using the ISBLANK function.

How blanks are handled in operations such as addition or concatenation depends on the individual function. The
following table summarizes the differences between DAX and Microsoft Excel formulas, in the way that blanks are
handled.



TRUE AND BLANK FALSE TRUE

BLANK OR BLANK BLANK Error

BLANK AND BLANK BLANK Error

EXPRESSION DAX EXCEL



Enter data directly into Power BI Desktop
12/6/2017 • 1 min to read • Edit Online

With Power BI Desktop, you can enter data directly and use that data in your reports and visualizations. For
example, you can copy portions of a workbook or web page, then paste it into Power BI Desktop.

To enter data directly, select Enter Data from the Home ribbon.

Power BI Desktop may attempt to make minor transformations on the data, if appropriate, just like it does when
you load data from any source. For example, in the following case it promoted the first row of data to headers.

If you want to shape the data you entered (or pasted), you can select the Edit button to bring up Query Editor,
where you can shape and transform the data before bringing it into Power BI Desktop. Or you can select the Load
button to import the data as it appears.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-enter-data-directly-into-desktop.md


Next stepsNext steps

When you select Load, Power BI Desktop creates a new table from your data, and makes it available in the Fields
pane. In the following image, Power BI Desktop shows my new table, called Table1 by default, and the two fields
within that table that were created.

And that’s it – it’s that easy to enter data into Power BI Desktop.

You’re now ready to use the data in Power BI Desktop to create visuals, reports, or interact with any other data
you might want to connect with and import, such as Excel workbooks, databases, or any other data source.

There are all sorts of data you can connect to using Power BI Desktop. For more information on data sources,
check out the following resources:

Getting Started with Power BI Desktop
Data Sources in Power BI Desktop
Shape and Combine Data with Power BI Desktop
Connect to Excel workbooks in Power BI Desktop
Connect to CSV files in Power BI Desktop



Connect to Excel in Power BI Desktop
12/6/2017 • 1 min to read • Edit Online

Connecting to an Excel workbook from Power BI Desktop is straightforward, and this article walks you through
the steps.

In Power BI Desktop, select Get Data > Excel from the Home ribbon.

Select your workbook from the Open dialog that appears. 

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-connect-excel.md


Power BI Desktop presents the tables on other data elements from the workbook in the Navigator window.
When you select a table in the left pane, a preview of the data appears in the right pane.

You can select the Load button to import the data, or if you want to edit the data using Query Editor before
bringing it into Power BI Desktop, select the Edit button.

When you load the data, Power BI Desktop displays the Load window and displays the activity associated with
loading the data.

When complete, Power BI Desktop displays the tables and fields it imported from your Excel workbook in the
Fields pane, on the right side of the Desktop.



Next stepsNext steps

And that’s it!

You’re now ready to use the imported data from your Excel workbook in Power BI Desktop to create visuals,
reports, or interact with any other data you might want to connect with and import, such as other Excel
workbooks, databases, or any other data source.

There are all sorts of data you can connect to using Power BI Desktop. For more information on data sources,
check out the following resources:

Getting Started with Power BI Desktop
Data Sources in Power BI Desktop
Shape and Combine Data with Power BI Desktop
Connect to CSV files in Power BI Desktop
Enter data directly into Power BI Desktop



Connect to SSAS Multidimensional Models in Power
BI Desktop
1/25/2018 • 4 min to read • Edit Online

Capabilities and features of SSAS MD

Tabular metadata of multidimensional modelsTabular metadata of multidimensional models

With Power BI Desktop, you can access SSAS Multidimensional models, commonly referred to as SSAS MD.

To connect to an SSAS MD database, select Get Data > Database > SQL Server Analysis Services Database as
shown in the following image.

SSAS Multidimensional models in Live connection mode are supported in both the Power BI service and in
Power BI Desktop. You can also publish and upload reports that use SSAS Multidimensional models in Live
mode to the Power BI service.

The following sections describe features and capabilities of Power BI and SSAS MD connections.

The following table shows the correspondence between multidimensional objects and the tabular metadata that's
returned to Power BI Desktop. Power BI queries the model for tabular metadata, and based on the returned
metadata, runs appropriate DAX queries against Analysis Services when you create a visualization such as a table,
matrix, chart or slicer.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-ssas-multidimensional.md


BISM-MULTIDIMENTIONAL OBJECT TABULAR METADATA

Cube Model

Cube dimension Table

Dimension attributes (Keys), Name) Columns

Measure group Table

Measure Measure

Measures without associated Measure Group Within table called Measures

Measure group -> Cube dimension relationship Relationship

Perspective Perspective

KPI KPI

User/Parent-Child hierarchies Hierarchies

Measures, measure groups and KPIsMeasures, measure groups and KPIs

Dimension attribute typeDimension attribute type

Parent-child hierarchiesParent-child hierarchies

Dimension calculated membersDimension calculated members

Measure groups in a multidimensional cube are exposed in Power BI as tables with the ∑ sign beside them in the
Fields pane. Calculated measures that don't have an associated measure group are grouped under a special table
called Measures in the tabular metadata.

In a multidimensional model, you can define a set of measures or KPIs in a cube to be located within a Display
folder, which can help simplify complex models. Power BI recognizes Display folders in tabular metadata, and
shows measures and KPIs within the Display folders. KPIs in multidimensional databases support Value, Goal,
Status Graphic and Trend Graphic.

Multidimensional models also support associating dimension attributes with specific dimension attribute types.
For example, a Geography dimension where the City, State-Province, Country and Postal Code dimension
attributes have appropriate geography types associated with them are exposed in the tabular metadata. Power BI
recognizes the metadata, enabling you to create map visualizations. You'll recognize these associations by the map
icon next to element in the Field pane in Power BI.

Power BI can also render images when you provide a field containing URLs (Uniform Resource Locator) of the
images. You can specify these fields as ImageURL type in SQL Server Data Tools (or subsequently in Power BI), and
its type information is provided to Power BI in the tabular metadata. Power BI can then retrieve those images from
the URL, and display them in visuals.

Multidimensional models support Parent-child hierarchies, which are presented as a hierarchy in the tabular
metadata. Each level of the Parent-child hierarchy is exposed as a hidden column in the tabular metadata. The key
attribute of the Parent-child dimension is not exposed in the tabular metadata.

Multidimensional models support creation of various types of calculated members. The two most common types
of calculated members are the following:



SecuritySecurity

Limitations of SSAS Multidimensional Models in Power BI Desktop

Supported Features of SSAS MD in Power BI Desktop

Calculated members on attribute hierarchies and not sibling of All

Calculated members on user hierarchies

Multidimensional model expose calculated members on attribute hierarchies as values of a column. There are a
few additional options and constraints while exposing this type of calculated member:

Dimension attribute can have an optional UnknownMember

An attribute containing calculated members cannot be the key attribute of the dimension, unless it is the only
attribute of the dimension
An attribute containing calculated members cannot be a parent-child attribute

The calculated members of user hierarchies are not exposed in Power BI. Rather, you will be able to connect to a
cube containing calculated members on user hierarchies, but you won't be able to see calculated members if they
do not meet the constraints mentioned in the previous bulleted list.

Multidimensional models support dimension and cell level security by way of Roles. When you connect to a cube
with Power BI, you are authenticated and evaluated for appropriate permissions. When a user has dimension
security applied, the respective dimension members are not seen by the user in Power BI. However, when a user
has a cell security permission defined, where certain cells are restricted, then that user cannot connect to the cube
using Power BI.

There are certain limitations to using SSAS MD:

Servers must be running SQL Server 2012 SP1 CU4 or later versions of Analysis Services for the Power BI
Desktop SSAS MD connector to work properly
Actions and Named Sets are not exposed to Power BI, but you can still connect to cubes that also contain
Actions or Named sets and create visuals and reports.

The following features of SSAS MD are supported in Power BI Desktop:

Consumption of the following elements are supported in this release of SSAS MD (you can get more
information about these features):

Display folders
KPI Trends
Default Members
Dimension Attributes
Dimension Calculated Members (must be a single real member when the dimension has more than one
attribute, it cannot be the key attribute of the dimension unless it is the only attribute, and it cannot be a
parent-child attribute)
Dimension Attribute types
Hierarchies
Measures (with or without Measure groups)
Measures as Variant
KPIs
ImageUrls
Dimension security

https://msdn.microsoft.com/library/jj969574.aspx


Connect to CSV files in Power BI Desktop
12/6/2017 • 1 min to read • Edit Online

Connecting to a comma-separated value (CSV) file from Power BI Desktop is a lot like connecting to an Excel
workbook. Both are easy, and this article steps you through how to connect to any CSV file to which you have
access.

To start with, from Power BI Desktop select Get Data > CSV from the Home ribbon.

Select your CSV file from the Open dialog that appears.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-connect-csv.md


When you select Open, Power BI Desktop accesses the file and determines certain file attributes, such as the file
origin, delimiter type, and how many rows should be used to detect the data types in the file.

These file attributes and options are shown in the drop-down selections at the top of the CSV import dialog
window, shown below. You can change any of these detected settings manually, by choosing another option from
any of the drop-down selectors.

When you’re satisfied with the selections, you can select Load to import the file into Power BI Desktop, or you can
select Edit to open Query Editor and further shape or transform the data before importing it.

Once you load the data into Power BI Desktop, you see the table and its columns (which are presented as Fields in
Power BI Desktop) in the Fields pane, along the right of the Report view in Power BI Desktop.



Next stepsNext steps

That’s all you have to do – the data from your CSV file is now in Power BI Desktop.

You can use that data in Power BI Desktop to create visuals, reports, or interact with any other data you might
want to connect with and import, such as Excel workbooks, databases, or any other data source.

There are all sorts of data you can connect to using Power BI Desktop. For more information on data sources,
check out the following resources:

Getting Started with Power BI Desktop
Data Sources in Power BI Desktop
Shape and Combine Data with Power BI Desktop
Connect to Excel workbooks in Power BI Desktop
Enter data directly into Power BI Desktop



Connect to an Impala database in Power BI Desktop
12/6/2017 • 1 min to read • Edit Online

Connect to an Impala database

In Power BI Desktop, you can connect to an Impala database and use the underlying data just like any other data
source in Power BI Desktop.

To connect to an Impala database select Get Data from the Home ribbon in Power BI Desktop. Select Database
from the categories on the left, and you see Impala.

In the Impala window that appears, type or paste the name of your Impala server into the box, and select OK.
Note that you can choose to Import data directly into Power BI, or you can use DirectQuery. You can learn more
about using DirectQuery.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-connect-impala.md


NOTENOTE

When prompted, put in your username and password, or connect anonymously - either is supported.

Once you put in your username and password for a particular Impala server, Power BI Desktop uses those same credentials
in subsequent connection attempts. You can modify those credentials by going to File > Options and settings > Data
source settings.

Once you successfully connect, a Navigator window appears and displays the data available on the server, from
which you can select one or multiple elements to import and use in Power BI Desktop.



Considerations and Limitations

Next steps

There are a few limits and considerations to keep in mind with the Impala connector:

Future plans include enabling refresh support using the Power BI Gateway.

There are all sorts of data you can connect to using Power BI Desktop. For more information on data sources,
check out the following resources:

Getting Started with Power BI Desktop
Data Sources in Power BI Desktop
Shape and Combine Data with Power BI Desktop
Connect to Excel workbooks in Power BI Desktop
Enter data directly into Power BI Desktop



Connect to OData feeds in Power BI Desktop
12/6/2017 • 1 min to read • Edit Online

In Power BI Desktop, you can connect to an OData feed and use the underlying data just like any other data source
in Power BI Desktop.

To connect to an OData feed, select Get Data > OData Feed from the Home ribbon in Power BI Desktop.

In the OData Feed window that appears, type or paste your OData feed URL into the box, and select OK.

Power BI Desktop connects to the OData feed, and displays the available tables and other data elements in the
Navigator window. When you select an element, the right pane of the Navigator window displays a preview of
the data. You can select as many tables as you want to import. The Navigator window shows a preview of the
currently selected table.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-connect-odata.md


You can choose the Edit button, which launches Query Editor, where you can shape and transform the data from
the OData feed before importing it into Power BI Desktop. Or you can select the Load button, and import all of the
data elements you selected in the left pane.

When we select Load, Power BI Desktop imports the selected items, and displays a Load window of the import
progress.

Once complete, Power BI Desktop makes the selected tables and other data elements available in the Fields pane,
found on the right side of the Reports view in Power BI Desktop.



Next stepsNext steps

And that’s it!

You’re now ready to use the imported data from the OData feed in Power BI Desktop to create visuals, reports, or
interact with any other data you might want to connect with and import, such as other Excel workbooks, databases,
or any other data source.

There are all sorts of data you can connect to using Power BI Desktop. For more information on data sources, check
out the following resources:

Getting Started with Power BI Desktop
Data Sources in Power BI Desktop
Shape and Combine Data with Power BI Desktop
Connect to Excel workbooks in Power BI Desktop
Enter data directly into Power BI Desktop



Connect to Amazon Redshift in Power BI Desktop
12/6/2017 • 1 min to read • Edit Online

Connect to an Amazon Redshift database

In Power BI Desktop, you can connect to an Amazon Redshift database and use the underlying data just like any
other data source in Power BI Desktop.

To connect to an Amazon Redshift database select Get Data from the Home ribbon in Power BI Desktop. Select
Database from the categories on the left, and you see Amazon Redshift.

In the Amazon Redshift window that appears, type or paste the name of your Amazon Redshift server and
database into the box. As part of the Server field, users can specify a ort in the following format: ServerURL:Port

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-connect-redshift.md


When prompted, put in your username and password.

Once you successfully connect, a Navigator window appears and displays the data available on the server, from
which you can select one or multiple elements to import and use in Power BI Desktop.

Once you make selections from the Navigator window, you can either Load or Edit the data.

If you choose to Load data, you'll prompted wither to use Import or DirectQuery mode to load the data. For



Next steps

more information, check out this article that explains DirectQuery.
If you select to Edit the data, Query Editor appears where you can apply all sorts of transformations and filters
to the data, many of which are applied to the underlying Amazon Redshift database itself (if supported).

There are all sorts of data you can connect to using Power BI Desktop. For more information on data sources, check
out the following resources:

Getting Started with Power BI Desktop
Data Sources in Power BI Desktop
Shape and Combine Data with Power BI Desktop
Connect to Excel workbooks in Power BI Desktop
Enter data directly into Power BI Desktop



Connect to a web page from Power BI Desktop
12/6/2017 • 1 min to read • Edit Online

You can connect to a web page, and import its data into Power BI Desktop, to use in your visuals and in your data
models.

In Power BI Desktop, select Get Data > Web from the Home ribbon.

A dialog appears, asking for the URL of the web page from which you want to import data.

Once you’ve typed in (or pasted) the URL, select OK. Power BI Desktop connects to that page, then presents the
page’s available data in the Navigator window. When you select one of the available data elements, such as a table
of the entire page, the Navigator window displays a preview of that data on the right side of the window.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-connect-to-web.md


You can choose the Edit button, which launches Query Editor, where you can shape and transform the data on
that Web page before importing it into Power BI Desktop. Or you can select the Load button, and import all of the
data elements you selected in the left pane.

When we select Load, Power BI Desktop imports the selected items, and makes them available in the Fields pane,
found on the right side of the Reports view in Power BI Desktop.



Next stepsNext steps

That’s all there is to connecting to a web page and bringing its data into Power BI Desktop.

From there, you can drag those fields onto the Report canvas and create all the visualizations you want. You can
also work this the data from that Web page just like you would any other data – you can shape it, you can create
relationships between it and other data sources in your model, and otherwise do what you’d like to create just the
Power BI report you want.

To see connecting to a Web page in more depth and action, take a look at the Power BI Desktop Getting Started
Guide.

There are all sorts of data you can connect to using Power BI Desktop. For more information on data sources, check
out the following resources:

Data Sources in Power BI Desktop
Shape and Combine Data with Power BI Desktop
Connect to Excel workbooks in Power BI Desktop
Connect to CSV files in Power BI Desktop
Enter data directly into Power BI Desktop



Connect to Snowflake in Power BI Desktop
1/25/2018 • 1 min to read • Edit Online

NOTENOTE

Connect to a Snowflake computing warehouse

In Power BI Desktop, you can connect to a Snowflake computing warehouse and use the underlying data just like
any other data source in Power BI Desktop.

You also must install the Snowflake ODBC driver on computers that use the Snowflake connector, using the architecture
that matches the installation of Power BI Desktop, either 32-bit or 64-bit. Just follow the following link and download the
appropriate Snowflake ODBC driver.

To connect to a Snowflake computing warehouse select Get Data from the Home ribbon in Power BI Desktop.
Select Database from the categories on the left, and you see Snowflake.

In the Snowflake window that appears, type or paste the name of your Snowflake computing warehouse into the
box and select OK. Note that you can choose to Import data directly into Power BI, or you can use DirectQuery.
You can learn more about using DirectQuery.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-connect-snowflake.md
http://go.microsoft.com/fwlink/?LinkID=823762


NOTENOTE

When prompted, put in your username and password.

Once you put in your username and password for a particular Snowflake server, Power BI Desktop uses those same
credentials in subsequent connection attempts. You can modify those credentials by going to File > Options and settings >
Data source settings.

Once you successfully connect, a Navigator window appears and displays the data available on the server, from
which you can select one or multiple elements to import and use in Power BI Desktop.



Next steps

You can Load the selected table, which brings the entire table into Power BI Desktop, or you can Edit the query,
which opens Query Editor so you can filter and refine the set of data you want to use, and then load that refined
set of data into Power BI Desktop.

There are all sorts of data you can connect to using Power BI Desktop. For more information on data sources, check
out the following resources:

Getting Started with Power BI Desktop
Data Sources in Power BI Desktop
Shape and Combine Data with Power BI Desktop
Connect to Excel workbooks in Power BI Desktop
Enter data directly into Power BI Desktop



Connect to Azure Consumption Insights in Power BI
Desktop (Beta)
12/6/2017 • 7 min to read • Edit Online

Connect to Azure Consumption Insights

With the Azure Consumption Insights connector, you can use Power BI Desktop to connect to Azure and get in-
depth data and information about your organization's Azure services usage. You can also create measures, custom
columns, and visuals to report and share about your organization's Azure usage. This release of the Azure
Consumption and Insights connector is in Beta, and is subject to change.

In this article you learn how to connect using the Azure Consumption Insights connector and get the data you
need, how to migrate from using the Azure Enterprise Connector, and you'll find a mapping of usage details
columns available in the ACI (Azure Consumption Insights) API.

To successfully connect using the Azure Consumption Insights connector, you need to have access to the
Enterprise features within the Azure portal.

To connect to using the Azure Consumption Insights connector, select Get Data from the Home ribbon in
Power BI Desktop. Select Online Services from the categories on the left, and you see Microsoft Azure
Consumption Insights (Beta). Select Connect.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-connect-azure-consumption-insights.md


In the dialog that appears, provide your Enrollment Number.

You can get your enrollment number from the Azure Enterprise Portal, in the location shown in the
following image.

https://ea.azure.com


This version of the connector only supports enterprise enrollments from https://ea.azure.com. China
enrollments are not currently supported.

Next, provide your Access key to connect.

Your Access key for enrollment can be found on the Azure Enterprise Portal.

Once you provide your Access key and select Connect, a Navigator window appears and shows the four tables
available to you: Summary, Usage, PriceSheet, and MarketPlace. You can select a checkbox beside any table to see a

https://ea.azure.com
https://ea.azure.com


NOTENOTE

preview. You can select one or more tables by checking the box beside their name, then select Load.

The Summary and *PriceSheet tables are only available for the enrollment-level API Key. Also, the data in these tables has, by
default, the current month's data for Usage and PriceSheet. The Summary and MarketPlace tables are not constrained to the
current month.

When you select Load the data is loaded into Power BI Desktop.

Once the data you selected is loaded, the tables and fields you selected can be seen in the Fields pane.



Using Azure Consumption Insights

= MicrosoftAzureConsumptionInsights.Contents

To use the Azure Consumption Insights connector, you need to have access to the Enterprise features within the
Azure portal.

Once you successfully load data using the Azure Consumption Insights connector, you can create your own
custom measures and columns using Query Editor, and you can create visuals, reports, and dashboards that you
can share in the Power BI service.

Azure also includes a collection of sample custom queries that you can retrieve using a blank query. To do so, in the
Home ribbon of Power BI Desktop, select the drop down arrow in Get Data and then select Blank Query. You
can also do this in Query Editor by right-clicking in the Queries pane along the left, and selecting New Query >
Blank Query from the menu that appears.

In the Formula bar type the following:

A collection of samples appear, as shown in the following image.



Migrating from the Azure Enterprise Connector

Step 1: Connect to Azure using the new connectorStep 1: Connect to Azure using the new connector

Step 2: Use the Advanced Editor to create a queryStep 2: Use the Advanced Editor to create a query

let    
    enrollmentNumber = "100",
    optionalParameters = [ numberOfMonth = 6, dataType="DetailCharges" ],
    data = MicrosoftAzureConsumptionInsights.Contents(enrollmentNumber, optionalParameters)   
in     
    data

When working with reports and creating queries, use the following:

To define the number of months starting from the current date, use noOfMonths

To define a period of months in a historical time window, use startBillingDataWindow and
endBillingDataWindow

Do not use noOfMonths together with startBillingDataWindow or endBillingDataWindow

Use a value between one and 36 to represent the number of months, from the current date, you want to
import. We recommend getting no more than 12 months of data to avoid thresholds with import
constraints and the volume of data allowed for queries in Power BI.

Some customers created visuals using the Azure Enterprise Connector (Beta), which will eventually be
discontinued, and is being replaced by the Azure Consumption Insights connector. The Azure Consumption
Insights connector has features and enhancements that include the following:

Additional data sources available for Balance Summary and Marketplace Purchases

New and advanced parameters, such as startBillingDataWindow and endBillingDataWindow

Better performance and responsiveness

To help customers transition to the newer Azure Consumption Insights connector, and to preserve the work
they've done in creating custom dashboards or reports, the following steps show how to move to the new
connector.

The first step is to connect using the Azure Consumption Insights connector, which was described earlier in this
article in detail. In this step, select Get Data > Blank Query from the Home ribbon in Power BI Desktop.

In Query Editor, select Advanced Editor from the Query section of the Home ribbon. In the Advanced Editor
window that appears, enter the following query.



Step 3: Move measures and custom columns to the new reportStep 3: Move measures and custom columns to the new report

Step 4: Re-link tables that had relationshipsStep 4: Re-link tables that had relationships

Of course, you'll need to replace the value of enrollmentNumber with your own enrollment number, which you can
get from the Azure Enterprise Portal. The numberOfMonth parameter is how many months of data you want going
back, from the current data. Use zero (0) for the current month.

Once you select Done in the Advanced Editor window, the preview refreshes and you'll see data from the secified
month range in the table. Select Close & Apply and return.

Next you'll need to move any custom columns or measures you created into the new details table. Here are the
steps.

1. Open Notepad (or another text editor).

3. Rename Query1 to the original details table name.
4. Create new measures and custom columns in your table by right-clicking on your table, and choosing New

Measure, then cut and paste your store measures and columns until they're all done.

2. Select the measure you want to move, and copy the text from the Formula field, and place it in Notepad.

Many dashboards have additional tables that are used for lookup or filtering, such date tables or tables used for
custom projects. Reestablishing those relationships resolves most remaining issues. Here's how to do it.

In the Modeling tab in Power BI Desktop, select Manage Relationships to bring up a window that lets
you manage relationships within the model. Re-link your tables, as needed.

https://ea.azure.com


Step 5: Verify your visuals, and adjust field formatting as neededStep 5: Verify your visuals, and adjust field formatting as needed

Using the Azure Consumption and Insights (ACI) API to get
consumption data

Mapping names and usage details between the portal, the connector, and the APIMapping names and usage details between the portal, the connector, and the API

ACI CONNECTOR /
CONTENTPACK COLUMNNAME ACI API COLUMN NAME EA COLUMN NAME

OBSOLETE / PRESENT FOR
BACKWARD COMPATIBLITY

AccountName accountName Account Name No

AccountId accountId Yes

AcccountOwnerId accountOwnerEmail AccountOwnerId No

AdditionalInfo additionalInfo AdditionalInfo No

Once you get this far, most of your original visuals, tables, and drill-downs should be working as expected.
However, there may be some minor tweaks necessary for formatting, to get things looking just how you want
them. Take a bit of time to look over each of your dashboards and visuals, to ensure they look how you want them.

Azure also provides the Azure Consumption and Insights (ACI) API. You can create your own custom solutions
to gathering, reporting, and visualizing Azure consumption information using the ACI API.

The columns and names of details in the Azure Portal are similar in the API and the connector, but they're not
always identical. To help clarify, the following table provides a mapping between the API, the connector, and
columns you see in the Azure Portal. Also indicated is whether the column is obsolete. For more information and
definitions of these terms, take a look at the Azure billing data dictionary.

https://azure.microsoft.com/blog/announcing-general-availability-of-consumption-and-charge-apis-for-enterprise-azure-customers/
https://docs.microsoft.com/azure/billing/billing-enterprise-api-usage-detail


AdditionalInfold Yes

Consumed Quantity consumedQuantity Consumed Quantity No

Consumed Service consumedService Consumed Service No

ConsumedServiceId consumedServiceId Yes

Cost cost ExtendedCost No

Cost Center costCenter Cost Center No

Date date Date No

Day Day No

DepartmentName departmentName Department Name No

DepartmentID departmentId Yes

Instance ID Yes

InstanceId instanceId Instance ID No

Location Yes

Meter Category meterCategory Meter Category No

Meter ID Yes

Meter Name meterName Meter Name No

Meter Region meterRegion Meter Region No

Meter Sub-Category meterSubCategory Meter Sub-Category No

MeterId meterId Meter ID No

Month Month No

Product product Product No

ProductId productId Yes

Resource Group resourceGroup Resource Group No

Resource Location resourceLocation Resource Location No

ResourceGroupId Yes

ACI CONNECTOR /
CONTENTPACK COLUMNNAME ACI API COLUMN NAME EA COLUMN NAME

OBSOLETE / PRESENT FOR
BACKWARD COMPATIBLITY



ResourceLocationId resourceLocationId Yes

ResourceRate resourceRate ResourceRate No

ServiceAdministratorId serviceAdministratorId ServiceAdministratorId No

ServiceInfo1 serviceInfo1 ServiceInfo1 No

ServiceInfo1Id Yes

ServiceInfo2 serviceInfo2 ServiceInfo2 No

ServiceInfo2Id Yes

Store Service Identifier storeServiceIdentifier Store Service Identifier No

StoreServiceIdentifierId Yes

Subscription Name subscriptionName Subscription Name No

Tags tags Tags No

TagsId Yes

Unit Of Measure unitOfMeasure Unit Of Measure No

Year Year No

SubscriptionId subscriptionId SubscriptionId Yes

SubscriptionGuid subscriptionGuid SubscriptionGuid No

ACI CONNECTOR /
CONTENTPACK COLUMNNAME ACI API COLUMN NAME EA COLUMN NAME

OBSOLETE / PRESENT FOR
BACKWARD COMPATIBLITY

Next steps
There are all sorts of data you can connect to using Power BI Desktop. For more information on data sources, check
out the following resources:

Getting Started with Power BI Desktop
Data Sources in Power BI Desktop
Shape and Combine Data with Power BI Desktop
Connect to Excel workbooks in Power BI Desktop
Enter data directly into Power BI Desktop



Use SAP HANA in Power BI Desktop
12/6/2017 • 1 min to read • Edit Online

With Power BI Desktop, you can now access SAP HANA databases. To use SAP HANA, the SAP HANA ODBC
driver must be installed on the local client computer in order for the Power BI Desktop SAP HANA data connection
to work properly. You can download the SAP HANA ODBC driver from the SAP Software Download Center. From
there, search for the SAP HANA CLIENT for Windows computers. Since the SAP Software Download Center
changes its structure frequently, more specific guidance for navigating that site is not available.

To connect to a SAP HANA database, select Get Data > Database > SAP HANA Database as shown in the
following image.

When connecting to a SAP HANA database, specify the server name and the port in the format server:port - the
following image shows an example with a server named ServerXYZ and port 30015.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-sap-hana.md
https://support.sap.com/swdc


Supported features for SAP HANASupported features for SAP HANA

Installing the SAP HANA ODBC driverInstalling the SAP HANA ODBC driver

Limitations of SAP HANALimitations of SAP HANA

In this release SAP HANA in DirectQuery mode is supported in Power BI Desktop and the Power BI Service, and
you can publish and upload reports that use SAP HANA in DirectQuery mode to the Power BI service. You can also
publish and upload reports to the Power BI Service when not using SAP HANA in DirectQuery mode.

This release has many capabilities for SAP HANA, as shown in the following list:

The Power BI connector for SAP HANA uses the SAP ODBC driver, to provide the best use experience
SAP HANA supports both DirectQuery and Import options
Power BI supports HANA information models ( such as Analytic and Calc views) and has optimized navigation
With SAP HANA you can also use the direct SQL feature to connect to Row and Column Tables
Includes Optimized Navigation for HANA Models
Power BI supports SAP HANA Variables and Input parameters

There are also a few limitations to using SAP HANA, shown below:

NVARCHAR strings are truncated to maximum length of 4000 Unicode characters
SMALLDECIMAL is not supported
VARBINARY is not supported
Valid Dates are between 1899/12/30 and 9999/12/31



Using Analysis Services Tabular data in Power BI
Desktop
1/25/2018 • 4 min to read • Edit Online

To connect to a Tabular model

With Power BI Desktop, there are two ways you can connect to and get data from your SQL Server Analysis
Services Tabular models: Explore by using a live connection or Select items and import into Power BI Desktop.

Let’s take a closer look.

Explore by using a live connection – When using a live connection, items in your Tabular model or perspective,
like tables, columns, and measures appear in your Power BI Desktop Fields list. You can use Power BI Desktop’s
advanced visualization and report tools to explore your Tabular model in new, highly interactive ways.

When connecting live, no data from the Tabular model is imported into Power BI Desktop. Each time you interact
with a visualization, Power BI Desktop queries the Tabular model and calculates the results you see. You’re always
looking at the latest data. Keep in-mind, Tabular models are highly secure. Items that appear in Power BI Desktop
depend on your permissions for the Tabular model you’re connected to.

When you’ve created dynamic reports in Power BI Desktop, you can share them by publishing to your Power BI site.
When you publish a Power BI Desktop file with a live connection to a Tabular model to your Power BI site, an on-
premises data gateway must be installed and configured by an administrator. To learn more, see On-premises data
gateway.

Select items and import into Power BI Desktop – When you connect with this option, you can select items like
tables, columns, and measures in your Tabular model or perspective and load them into a Power BI Desktop model.
You can use Power BI Desktop’s advanced Query Editor to further shape what you want. You can use Power BI
Desktop’s modeling features to further model the data. No live connection between Power BI Desktop and the
Tabular model is maintained. You can then explore your Power BI Desktop model offline or publish to your Power
BI site.

1. In Power BI Desktop, on the Home tab, click Get Data.

2. Click SQL Server Analysis Services Database, then click Connect.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-analysis-services-tabular-data.md


4. This step depends on the connection mode you selected:

3. Enter the Server name and select a connection mode.

If you’re connecting live, in Navigator, select a Tabular model or perspective.



Frequently Asked Questions

If you chose Select items and get data, in Navigator, select a Tabular model or perspective. You can further select
only particular tables or columns to load. To shape your data before loading, click Edit to open Query Editor.
When you’re ready, click Load to import the data into Power BI Desktop.

Question: Do I need an on-premises data gateway?

Answer: It depends. If you use Power BI Desktop to connect live to a Tabular model, but have no intention on
publishing to your Power BI site, you do not need a gateway. On the other hand, if you do intend on publishing to
your Power BI site, a data gateway is necessary to ensure secure communication between the Power BI service and
your on-premises Analysis Services server. Be sure to talk to your Analysis Services server administrator before
installing a data gateway.

If you choose select items and get data, you’re importing Tabular model data right into your Power BI Desktop file,
so no gateway is necessary.

Question: What’s the difference between connecting live to a Tabular model from the Power BI service versus
connecting live from Power BI Desktop?

Answer: When connecting live to a Tabular model from your site in the Power BI service to an Analysis Services
database on-premises in your organization, an on-premises data gateway is required to secure communications
between them. When connecting live to a Tabular model from Power BI Desktop, a gateway is not required because
both Power BI Desktop and the Analysis Services server you’re connecting to are both running on-premises in your
organization. However, if you publish your Power BI Desktop file to your Power BI site, a gateway is required.

Question: If I created a live connection, can I connect to another data source in the same Power BI Desktop file?



To change the server name after initial connection

Answer: No. You cannot explore live data and connect to another type of data source in the same file. If you’ve
already imported data or connected to a different data source in a Power BI Desktop file, you’ll need to create a new
file to explore live.

Question: If I created a live connection, can I edit the model or query in Power BI Desktop?

Answer: You can create report level measures in the Power BI Desktop, but all other query and modelling features
are disabled when exploring live data.

Question: If I created a live connection, is it secure?

Answer: Yes. Your current Windows credentials are used to connect to the Analysis Services server. You cannot use
Basic or stored credentials in either the Power BI service or Power BI Desktop when exploring live.

Question: In Navigator, I see a model and a perspective. What’s the difference?

Answer: A perspective is a particular view of a Tabular model. It might include only particular tables, columns, or
measures depending on a unique data analysis need. A Tabular model always contains at least one perspective,
which could include everything in the model. If you’re unsure which you should select, check with your
administrator.

Once you create a Power BI Desktop file with an explore live connection, there might be some cases where you
want to switch the connection to a different server. For example, if you created your Power BI Desktop file when
connecting to a development server, and before publishing to the Power BI service, you want to switch the
connection to production server.

1. Select Edit Queries from the Ribbon.

2. Enter the new server name.
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Supported Data Sources

How to Connect using DirectQuery

With Power BI Desktop, when you connect to your data source, it is always possible to import a copy of the
data into the Power BI Desktop. For some data sources, an alternative approach is available: connect directly to
the data source using DirectQuery.

For a full listing of data sources that support DirectQuery, see Data sources supported by DirectQuery.

When you use Get Data to connect to a data source supported by DirectQuery, the connection window lets you
select how you want to connect.

The differences between selecting Import and DirectQuery are the following:

Import – the selected tables and columns are imported into Power BI Desktop. As you create or interact with a
visualization, Power BI Desktop uses the imported data. You must refresh the data, which imports the full data
set again, to see any changes that occurred to the underlying data since the initial import or the most recent
refresh.

DirectQuery – no data is imported or copied into Power BI Desktop. For relational sources, the selected tables
and columns appear in the Fields list. For multi-dimensional sources like SAP Business Warehouse, the
dimensions and measures of the selected cube appear in the Fields list. As you create or interact with a
visualization, Power BI Desktop queries the underlying data source, which means you’re always viewing current
data.

Many data modeling and data transformations are available when using DirectQuery, though with some
limitations. When creating or interacting with a visualization, the underlying source must be queried and the time
necessary to refresh the visualization is dependent on the performance of the underlying data source. When the
data necessary to service the request has recently been requested, Power BI Desktop uses recent data to reduce
the time required to display the visualization. Selecting Refresh from the Home ribbon will ensure all
visualizations are refreshed with current data.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-use-directquery.md


Benefits of using DirectQuery

Limitations of DirectQuery

Important considerations when using DirectQuery

The Power BI and DirectQuery article describes DirectQuery in detail. Also, see the following sections for more
information about benefits, limitations, and important considerations when using DirectQuery.

There are a few benefits to using DirectQuery:

DirectQuery lets you build visualizations over very large datasets, where it otherwise would be unfeasible to
first import all of the data with pre-aggregation
Underlying data changes can require a refresh of data, and for some reports, the need to display current data
can require large data transfers, making re-importing data unfeasible. By contrast, DirectQuery reports
always use current data
The 1 GB dataset limitation does not apply to DirectQuery

There are currently a few limitations to using DirectQuery:

All tables must come from a single database
If the Query Editor query is overly complex, an error will occur. To remedy the error you must either delete
the problematic step in Query Editor, or Import the data instead of using DirectQuery. For multi-
dimensional sources like SAP Business Warehouse, there is no Query Editor
Relationship filtering is limited to a single direction, rather than both directions (though it is possible to
enable cross filtering in both directions for DirectQuery as a Preview feature). For multi-dimensional sources
like SAP Business Warehouse, there are no relationships defined in the model
Time intelligence capabilities are not available in DirectQuery. For example, special treatment of date
columns (year, quarter, month, day, so on) are not supported in DirectQuery mode.
By default, limitations are placed on DAX expressions allowed in measures; see the following paragraph (after
this bulleted list) for more information
There is a 1 million row limit for returning data when using DirectQuery. This does not affect aggregations
or calculations used to create the dataset returned using DirectQuery, only the rows returned. For example,
you can aggregate 10 million rows with your query that runs on the data source, and accurately return the
results of that aggregation to Power BI using DirectQuery as long as the data returned to Power BI is less
than 1 million rows. If more than 1 million rows would be returned from DirectQuery, Power BI returns an
error.

To ensure that queries sent to the underlying data source have acceptable performance, limitations are imposed
on measures by default. Advanced users can choose to bypass this limitation by selecting File > Options and
then Settings > Options and settings > DirectQuery, then selecting the option Allow unrestricted measures in
DirectQuery mode. When that option is selected, any DAX expression that is valid for a measure can be used.
Users must be aware, however, that some expressions that perform very well when the data is imported may
result in very slow queries to the backend source when in DirectQuery mode.

The following three points should be taken into consideration when using DirectQuery:

Performance and load - All DirectQuery requests are sent to the source database, so the time required
to refresh a visual is dependent on how long that back-end source takes to respond with the results from
the query (or queries). The recommended response time (with requested data being returned) for using
DirectQuery for visuals is five seconds or less, with a maximum recommended results response time of
30 seconds. Any longer, and the experience of a user consuming the report becomes unacceptably poor.
In addition, once a report is published to the Power BI service, any query that takes longer than a few



Publish to the Power BI service

The resultset of a query to external data source has exceeded
the maximum allowed size of '1000000' rows.

Security - All users who consume a published report connect to the back-end data source using the
credentials entered after publication to the Power BI service. This is the same situation as data that is
imported: all users see the same data, irrespective of any security rules defined in the backend source.
Customers who want per-user security implement with DirectQuery sources and use RLS. Learn more about
RLS.
Supported features - Not all features in Power BI Desktop are supported in DirectQuery mode, or have
some limitations. In addition, there are some capabilities in the Power BI service (such as Quick Insights) that
are not available for datasets using DirectQuery. As such, the limitation of such features when using
DirectQuery should be taken into consideration when determining whether to use DirectQuery.

minutes will timeout, and the user will receive an error.

Load on the source database should also be considered, based on the number of Power BI users who will
consume the published report. Using Row Level Security (RLS) can have a significant impact as well; a
non-RLS dashboard tile shared by multiple users results in a single query to the database, but using RLS
on a dashboard tile usually means the refresh of a tile requires one query per user, thus significantly
increasing load on the source database and potentially impacting performance.

Power BI creates queries that are as efficient as possible. Under certain situations however, the generated
query may not be efficient enough to avoid refresh that would fail. One example of this situation is when a
generated query would retrieve an excessively large number of rows (more than 1 million) from the back-
end data source, in which case the following error occurs:

This situation can occur with a simple chart that includes a very high cardinality column, with the
aggregation option set to Don’t Summarize. The visual needs to only have columns with a cardinality
below 1 million, or must have appropriate filters applied.

Reports created using DirectQuery can be published to the Power BI Service.

If the data source used does not need the on-premises data gateway (Azure SQL Database, Azure SQL Data
Warehouse, or Redshift), credentials must be provided before the published report will be displayed in the
Power BI Service.

You can provide credentials by selecting the Settings gear icon in Power BI, then select Settings.



Next steps

Power BI displays the Settings window. From there, select the Datasets tab and choose the dataset that uses
DirectQuery, and select Edit credentials.

Until credentials are supplied, opening a published report or exploring a dataset created with a DirectQuery
connection to such data sources results in an error.

For data sources other than Azure SQL Database, Azure SQL Data Warehouse and Redshift that use
DirectQuery, an on-premises data gateway must be installed and the data source must be registered to
establish a data connection. You can learn more about on-premises data gateway.

For more information about DirectQuery, check out the following resources:

DirectQuery in Power BI
Data sources supported by DirectQuery

http://go.microsoft.com/fwlink/p/?LinkID=627094


DirectQuery and SAP BW
DirectQuery and SAP HANA
On-premises data gateway
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Power BI connectivity modes

You can connect to all sorts of different data sources when using Power BI Desktop or the Power BI service,
and you can make those data connections in different ways. You can either import data to Power BI, which is the
most common way to get data, or you can connect directly to data in its original source repository, which is
known as DirectQuery. This article describes DirectQuery and its capabilities, including the following topics:

Different connectivity options for DirectQuery
Guidance for when you should consider using DirectQuery rather than import
Drawbacks of using DirectQuery
Best practice for using DirectQuery

In short, the best practice for using import versus DirectQuery is the following:

You should import data to Power BI wherever possible. This takes advantage of the high performance query
engine of Power BI, and provides a highly interactive and fully featured experience over your data.
If your goals can't be met by importing data, then consider using DirectQuery. For example, if the data is
changing frequently and reports must reflect the latest data, DirectQuery may be best. However, using
DirectQuery is generally only be feasible when the underlying data source can provide interactive queries (less
than 5 seconds) for the typical aggregate query, and is able to handle the query load that will be generated.
Additionally, the list of limitations that accompany use of DirectQuery should be considered carefully, to ensure
your goals can still be met.

The set of capabilities offered by Power BI for both connectivity modes – import and DirectQuery - will evolve
over time. This will include providing more flexibility when using imported data, such that import can be used in
more cases, as well as eliminating some of the drawbacks of using DirectQuery. Regardless of improvements,
when using DirectQuery the performance of the underlying data source will always remain a major consideration.
If that underlying data source is slow, then using DirectQuery for that source it will remain unfeasible.

This topic covers DirectQuery with Power BI, and not SQL Server Analysis Services. DirectQuery is also a feature of
SQL Server Analysis Services, and many of the details described below apply to its use, there are also important
differences. For information about using DirectQuery with SQL Server Analysis Services, see the whitepaper that
details DirectQuery in SQL Server Analysis Services 2016.

This article focuses on the recommended workflow for DirectQuery, where the report is created in Power BI
Desktop, but also covers connecting directly in the Power BI service.

Power BI connects to a very large number of varied data sources, encompassing:

Online services (Salesforce, Dynamics 365, others)
Databases (SQL Server, Access, Amazon Redshift, others)
Simple files (Excel, JSON, others)
Other data sources (Spark, Web sites, Microsoft Exchange, others)

For these sources, it's usually possible to import the data to Power BI. For some it is also possible to connect using
DirectQuery. The exact set of sources that support DirectQuery is described in the Data Sources supported by
DirectQuery article. More sources will be DirectQuery enabled in the future, focusing primarily on sources that can
be expected to deliver good interactive query performance.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-directquery-about.md
http://download.microsoft.com/download/F/6/F/F6FBC1FC-F956-49A1-80CD-2941C3B6E417/DirectQuery in Analysis Services - Whitepaper.pdf


Import connectionsImport connections

DirectQuery connectionsDirectQuery connections

SQL Server Analysis Services is a special case. When connecting to SQL Server Analysis Services, you can
choose to import the data, or use a live connection. Using a live connection is similar to DirectQuery, in that no
data is imported, and the underlying data source is always queried to refresh a visual, but a live connection is
different in many other regards, so a different term (live versus DirectQuery) is used.

These three options for connecting to data – import, DirectQuery, and live connection – are explained in detail
in the following sections.

When using Get Data in Power BI Desktop to connect to a data source like SQL Server, and you choose Import,
the behavior of that connection is as follows:

During the initial Get Data experience, the set of tables selected each define a query that will return a set of
data (those queries can be edited prior to loading the data, for example to apply filters, or aggregate the data,
or join different tables).
Upon load, all of the data defined by those queries will be imported into the Power BI cache.
Upon building a visual within Power BI Desktop, the imported data will be queried. The Power BI store
ensures the query will be very fast, hence all changes to the visual will be reflected immediately.
Any changes to the underlying data will not be reflected in any visuals. It is necessary to Refresh, whereupon
the data will be re-imported.
Upon publishing the report (the .pbix file) to the Power BI service, a dataset is created and uploaded to the
Power BI service. The imported data is included with that dataset. It is then possible to set up scheduled refresh
of that data, for example, to re-import the data every day. Depending upon the location of the original data
source, it might be necessary to configure an on-premises data gateway.
When opening an existing report in the Power BI service, or authoring a new report, the imported data is
queried again, ensuring interactivity.
Visuals, or entire report pages, can be pinned as dashboard tiles. The tiles will be automatically refreshed
whenever the underlying dataset is refreshed.

When using Get Data in Power BI Desktop to connect to a data source, and you choose DirectQuery, the
behavior of that connection is as follows:

During the initial Get Data experience, the source is selected. For relational sources, this means a set of tables
are selected and each still define a query that logically returns a set of data. For multidimensional sources like
SAP BW, only the source is selected.
However, upon load, no data will actually be imported into the Power BI store. Instead, upon building a visual
within Power BI Desktop, queries will be sent to the underlying data source to retrieve the necessary data.
The time then taken to refresh the visual will depend on the performance of the underlying data source.
Any changes to the underlying data will not be immediately reflected in any existing visuals. It is still necessary
to Refresh, whereupon the necessary queries will be resent for each visual, and the visual updated as
necessary.
Upon publishing the report to the Power BI service, it will again result in a Dataset in the Power BI service, just
as for import. However, no data is included with that dataset.
When opening an existing report in the Power BI service, or authoring a new one, the underlying data source
is again queried to retrieve the necessary data. Depending upon the location of the original data source, it
might be necessary to configure an on-premises data gateway, just as is needed for Import mode if the data is
refreshed.
Visuals, or entire report pages, can be pinned as Dashboard tiles. To ensure that opening a dashboard will be
fast, the tiles are automatically refreshed on a schedule (for example, every hour). The frequency of this refresh
can be controlled, to reflect how frequently the data is changing, and how important it is to see the very latest
data. Thus, when opening a dashboard, the tiles will reflect the data as of the time of the last refresh, and not



Live connectionsLive connections

When is DirectQuery useful?

LIMITATION DESCRIPTION

Data is changing frequently, and near ‘real-time’ reporting is
needed

Models with Imported data can be refreshed at most once
per hour. Hence, if the data is continually changing, and it is
necessary for reports to show the latest data, then using
Import with scheduled refresh might simply not meet those
needs. Note also that it is also possible to stream data directly
into Power BI, though there a limits on the data volumes
supported for this case. 

Using DirectQuery, by contrast, means that opening or
refreshing a report or dashboard will always show the latest
data in the source. Additionally, the dashboard tiles can be
updated more frequently (as often as every 15 mins).

necessarily the very latest changes made to the underlying source. An open dashboard can always be
Refreshed to ensure it is up-to-date.

When connecting to SQL Server Analysis Services (SSAS), there is an option to either import data from, or
connect live to, the selected data model. If you select import, then you define a query against that external SSAS
source, and the data is imported as normal. If you select to connect live then there is no query defined, and the
entire external model is shown in the field list. If you select DirectQuery, as visuals are built, queries are sent to
the external SSAS source. However, unlike DirectQuery, there is no sense in which a new model is being created;
in other words, it's not possible to define new calculated columns, hierarchies, relationships, and so on. Instead
you are simply connecting directly to the external SSAS model.

The situation described in the previous paragraph applies to connecting to the following sources as well, except
that there is no option to import the data:

Power BI datasets (for example, when connecting to a Power BI dataset that has previously been created and
published to the service, to author a new report over it)
Common Data Services

The behavior of reports over SSAS, upon publishing to the Power BI service, is similar to DirectQuery reports in
the following ways:

When opening an existing report in the Power BI service or authoring a new report, the underlying SSAS
source is queried (possibly requiring an on-premises data gateway)
Dashboard tiles are automatically refreshed on a schedule (such as every hour, or whatever frequency is
defined)

However, there are also important differences, including that for live connections the identity of the user opening
the report will always be passed to the underlying SSAS source.

With these comparisons out of the way, let's focus solely on DirectQuery for the rest of this article.

The following table describes scenarios where connecting with DirectQuery could be especially useful, including
cases where leaving the data in the original source would be considered beneficial. The description includes a
discussion about whether the specified scenario is available in Power BI.



Data is very large If the data is very large, then it certainly would not be feasible
to import it all. DirectQuery, by contrast, requires no large
transfer of data, as it is queried in place. 

However, large data might also imply that the performance of
the queries against that underlying source are too slow (as
discussed in Implications of using DirectQuery section, later
in this article). And of course it is not always necessary to
import the full detailed data. Instead the data can be pre-
aggregated during import (and Query Editor makes it easy
to do exactly this). In the extreme it would be possible to
import exactly the aggregate data needed for each visual. So
while DirectQuery is the simplest approach to large data, you
should always keep in mind that importing aggregate data
might offer a solution if the underlying source is too slow.

Security rules are defined in the underlying source When the data is imported, Power BI will connect to the data
source using the current users credentials (from Power BI
Desktop), or the credentials defined as part of configuring
scheduled refresh (from the Power BI service). Thus, in
publishing and sharing such a report, care must be taken to
only share with users allowed to see the same data, or to
define Row Level Security as part of the dataset. 

Ideally, because DirectQuery always queries the underlying
source, this would allow any security in that underlying source
to be applied. However, today Power BI will always connect to
the underlying source using the same credentials as would be
used for Import. 

Thus, until Power BI allows for the identity of the report
consumer to pass through to the underlying source,
DirectQuery offers no advantages with regard to data source
security.

Data sovereignty restrictions apply Some organizations have policies around data sovereignty,
meaning that data cannot leave the organization premises. A
solution based on import would clearly present issues. By
contrast, with DirectQuery that data remains in the
underlying source. 

However, it should be noted that even with DirectQuery,
some caches of data at the visual level are retained in the
Power BI service (due to scheduled refresh of tiles).

LIMITATION DESCRIPTION



Underlying data source is an OLAP source, containing
measures

If the underlying data source contains *measures *(such as
SAP HANA or SAP Business Warehouse) then importing the
data brings other issues. It means that the data imported is at
a particular level of aggregation, as defined by the query. For
example, measure TotalSales by Class, Year, and City. Then if a
visual is built asking for data at a higher level aggregate (such
as TotalSales by Year) it is further aggregating the aggregate
value. This is fine for additive measures (such as Sum, Min)
but it's an issue for non-additive (such as Average,
DistinctCount). 

To make it easy to get the correct aggregate data (as needed
for the particular visual) directly from the source, it would be
necessary to send queries per visual, as in DirectQuery. 

When connecting to SAP Business Warehouse (BW), choosing
DirectQuery allows for this treatment of measures. Support
for SAP BW is covered further in DirectQuery and SAP BW. 

However, currently DirectQuery over SAP HANA treats it the
same as a relational source, and hence provides similar
behavior to import. This is covered further in DirectQuery and
SAP HANA.

LIMITATION DESCRIPTION

Implications of using DirectQuery

Performance and load on the underlying sourcePerformance and load on the underlying source

So in summary, given the current capabilities of DirectQuery in Power BI, the scenarios where it offers benefits are
the following:

Data is changing frequently, and near ‘real-time’ reporting is needed
Handling very large data, without the need to pre-aggregate
Data sovereignty restrictions apply
The source is a multi dimensional source containing measures (such as SAP BW)

Note that the details in the previous list relate to the use of Power BI alone. There is always the option of instead
using an external SQL Server Analysis Services (or Azure Analysis Services) model to import data, and then using
Power BI to connect to that model. While that approach would require additional skills, it does provide greater
flexibility. For example, much larger volumes of data can be imported, and there is no restriction on how
frequently the data can be refreshed.

Use of DirectQuery does have potentially negative implications, as detailed in this section. Some of those
limitations are slightly different depending upon the exact source that is being used. This will be called out where
applicable, and separate topics cover those sources that are substantially different.

When using DirectQuery, the overall experience depends very much on the performance of the underlying data
source. If refreshing each visual (for example, after changing a slicer value) takes a few seconds (<5s) then the
experience would be reasonable, yet might still feel sluggish compared to the immediate response we are used to
when importing the data to Power BI. If instead the slowness of the source means that individual visuals take
longer than that (tens of seconds), then the experience becomes extremely poor, possibly even to the point of
queries timing out.

Along with the performance of the underlying source, careful consideration should be paid to the load that will be
placed upon it (that of course then often impacts the performance). As discussed further below, each user that
opens a shared report, and each dashboard tile that is periodically refreshed, will be sending at least one query



Limited to a single sourceLimited to a single source

Limited data transformationsLimited data transformations

Modelling limitationsModelling limitations

per visual to the underlying source. This fact requires that the source be able to handle such a query load, while
still maintaining reasonable performance.

When importing data, it is possible to combine data from multiple sources into a single model, for example, to
easily join some data from a corporate SQL Server database with some local data maintained in an Excel file. This
is not possible when using DirectQuery. When selecting DirectQuery for a source, it will then only be possible to
use data from that single source (such as a single SQL Server database).

Similarly, there are limitations in the data transformations that can be applied within Query Editor. With
imported data, a sophisticated set of transformations can easily be applied to clean and re-shape the data before
using it to create visuals (such as parsing JSON documents, or pivoting data from a column to a row orientated
form). Those transformations are more limited in DirectQuery. First, when connecting to an OLAP source like SAP
Business Warehouse, no transformations can be defined at all, and the entire external ‘model’ is taken from the
source. For relational sources like SQL Server, it is still possible to define a set of transformations per query, but
those transformations are limited, for performance reasons. Any such transformation will need to be applied on
every query to the underlying source, rather than once on data refresh, so they are limited to those
transformations that can reasonably be translated into a single native query. If you use a transformation that is
too complex, then you will receive an error that either it must be deleted, or the model switched to Import mode.

Additionally, the query that results from the Get Data dialog or Query Editor will be used in a subselect within
the queries generated and sent to retrieve the necessary data for a visual. Thus the query defined in Query Editor
must be valid within this context. In particular this means it is not possible to use a query using Common Table
Expressions, nor that invokes Stored Procedures.

The term modelling in this context means the act of refining and enriching the raw data, as part of authoring a
report using it. Examples include:

Defining relationships between tables
Adding new calculations (calculated columns and measures)
Renaming and hiding columns and measures
Defining hierarchies
Defining the formatting, default summarization and sort order for a column
Grouping or clustering values

When using DirectQuery, many of these model enrichments can still be made, and certainly there is still the
principle that the raw data is being enriched, so as to improve later consumption. However, there some modeling
capabilities are not available, or are limited, when using DirectQuery. The limitations are generally applied to avoid
performance issues. The set of limitations that are common to all DirectQuery sources are listed in the following
bulleted list. Additional limitations might apply to individual sources, as described in Data source specific details
found near the end of this article.

No Built in-date hierarchy: When importing data, then by default every date/datetime column will also have
a built-in date hierarchy available by default. For example, if importing a table of sales orders including a
column OrderDate, then upon using OrderDate in a visual, it will be possible to choose the appropriate level
(Year, Month, Day) to use. This built-in date hierarchy is not available when using DirectQuery mode. Note
however that if there is Date table available in the underlying source (as is common in many data warehouses)
then the DAX Time Intelligence functions can be used as normal.
Limitations in calculated columns: Calculated columns are limited to being intra-row, as in, they can only
refer to values of other columns of the same table, without the use of any aggregate functions. Additionally, the
DAX scalar functions (such as LEFT()) that are allowed will be limited to those which can simply be pushed to
the underlying source, hence will vary depending upon the exact capabilities of the source. Functions that are



not supported will not be listed in autocomplete when authoring the DAX for a calculated column, and would
result in an error if used.
No support for parent-child DAX functions: When in DirectQuery model, it is not possible to use the family
of DAX PATH() functions, that generally handle Parent-Child structures (such as chart of accounts, or employee
hierarchies).

Calculated tables are not supported: The ability to define a calculated table using a DAX expression is not
supported in DirectQuery mode.

Limitations (by default) for measures: By default, the DAX functions and expressions that can be used in
measures is restricted. Again, autocomplete will restrict the functions listed, and an error will occur if an
invalid function or expression is used. The reason is simply to ensure that, by default, measures are
restricted to simple measures that are unlikely by themselves cause any performance issues. Advanced
users can choose to bypass this limitation by selecting File > Options and then Settings > Options >
DirectQuery, then selecting the option Allow unrestricted measures in DirectQuery mode. When that
option is selected, any DAX expression that is valid for a measure can be used. Users must be aware,
however, that some expressions that perform well when the data is imported may result in very slow
queries to the backend source when in DirectQuery mode.

For example, by default:

SalesAmount = SUMX(Web_Sales, [ws_sales_price]* [ws_quantity])

AverageItemSalesAmount = AVERAGEX('Item', [SalesAmount])

It would be possible to author a measure that simply summed the sales amount:

It would not be possible to author a measure that then averaged that SalesAmount over all of
the Items:

The reason is that such a measure could result in poor performance if there were a very large
number of items.

Relationship filtering is limited to a single direction: When using DirectQuery, it is not possible to set
the Cross Filter direction on a relationship to “Both”. For example, with the three tables below, it would not
be possible to build a visual showing each Customer[Gender], and the number of Product[Category]
bought by each. Use of such bi-directional filtering is described in this detailed whitepaper (the paper
presents examples in the context of SQL Server Analysis Services, but the fundamental points apply equally
to Power BI).

Again, the limitation is imposed due to the performance implications. One particularly important
application of this is when defining Row Level Security as part of the report, as a common pattern is to
have a many-many relationship between the users and the entities they are allowed access to, and use of
bi-directional filtering is necessary to enforce this. However, use of bi-directional filtering for DirectQuery
models should be used judiciously, with careful attention paid to any detrimental impact on performance.

http://download.microsoft.com/download/2/7/8/2782DF95-3E0D-40CD-BFC8-749A2882E109/Bidirectional cross-filtering in Analysis Services 2016 and Power BI.docx


Reporting limitationsReporting limitations

SecuritySecurity

Behavior in the Power BI serviceBehavior in the Power BI service

Reports – opening, interacting with, editingReports – opening, interacting with, editing

No Clustering: When using DirectQuery, it is not possible to use the Clustering capability, to automatically
find groups

Almost all reporting capabilities are supported for DirectQuery models. As such, so long as the underlying source
offers a suitable level of performance, the same set of visualizations can be used. However, there are some
important limitations in some of the other capabilities offered in the Power BI service after a report is published,
as described in the following bullets:

Quick Insights is not supported: Power BI Quick Insights searches different subsets of your dataset while
applying a set of sophisticated algorithms to discover potentially-interesting insights. Given the need for very
high performance queries, this capability is not available on datasets using DirectQuery.
Q&A is not supported: Power BI Q&A enables you to explore your data using intuitive, natural language
capabilities and receive answers in the form of charts and graphs. However, it is currently not supported on
datasets using DirectQuery.
Using Explore in Excel will likely result in poorer performance: It is possible to explore your data by
using the “Explore in Excel” capability on a dataset. This will allow Pivot Tables and Pivot Charts to be created in
Excel. While this capability is supported on datasets using DirectQuery, the performance is generally slower
than creating visuals in Power BI, and therefore if the use of Excel is important for your scenarios, this should
be accounted for in your decision to use DirectQuery.

As discussed earlier in this article, a report using DirectQuery will always use the same fixed credentials to
connect to the underlying data source, after publish to the Power BI service. Again, note this refers specifically to
DirectQuery, not to live connections to SQL Server Analysis Services, which is different in this respect. Hence
immediately after publish of a DirectQuery report, it is necessary to configure the credentials of the user that will
be used. Until this is done, opening the report on the Power BI service would result in an error.

Once the user credentials are provided, then those credentials will be used, irrespective of the user who opens the
report. In this regard it is exactly like imported data, in that every user will see the same data, unless Row Level
Security has been defined as part of the report. Hence the same attention must be paid to sharing the report, if
there are any security rules defined in the underlying source.

This section describes the behavior of a DirectQuery report in the Power BI service, primarily so as to be able to
understand the degree of load that will be placed on the back end data source, given the number of users that the
report and dashboard will be shared with, the complexity of the report, and whether Row Level Security has been
defined in the report.

When a report is opened, then all the visuals on the currently visible page will refresh. Each visual will generally
require at least one query to the underlying data source. Some visuals might require more than one query (for
example, if it showed aggregate values from two different fact tables, or contained a more complex measure, or
contained totals of a non-additive measure like Count Distinct). Moving to a new page will result in those visuals
being refreshed, resulting in a new set of queries to the underlying source.

Every user interaction on the report might result in visuals being refreshed. For example, selecting a different
value on a slicer will require sending a new set of queries to refresh all of the effected visuals. The same is true for
clicking on a visual to cross-highlight other visuals, or changing a filter.

Similarly of course, editing a new report with require queries to be sent for each step on the path to produce the
final desired visual.

There is some caching of results, so that the refresh of a visual will be instantaneous if the exact same results have
recently been obtained. Such caches are not shared across users, if there is any Row Level Security defined as part
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of the report.

Individual visuals, or entire pages, can be pinned to dashboard as tiles. Tiles based on DirectQuery datasets are
then refreshed automatically according to a schedule, resulting in queries being sent to the backend data source.
By default, this occurs every hour, but can be configured as part of Dataset settings to be between weekly, and
every 15 minutes.

If no Row Level Security is defined in the model, this means that each tile would be refreshed once, and the results
shared across all users. If Row Level Security is defined, then there can be a large multiplier effect – each tile
requires separate queries per user to be sent to the underlying source.

Hence a dashboard with ten tiles, shared with 100 users, created on a dataset using DirectQuery with Row Level
Security, and configured to refresh every 15 minutes, would result in at least 1000 queries being sent every 15
minutes to the back end source.

Hence careful consideration must be paid to the use of Row Level Security, and the configuring of the refresh
schedule.

A timeout of four minutes is applied to individual queries in the Power BI service, and queries taking longer than
that will simply fail. As stressed earlier, it is recommended that DirectQuery be used for sources that provide near
interactive query performance, so this limit is intended to prevent issues from overly long execution times.

Some other general implications of using DirectQuery are the following:

Refresh in Power BI Desktop is needed to reflect any metadata changes: After a report is published,
Refresh will simply refresh the visuals in the report. If the schema of the underlying source has changed, then
those changes are not automatically applied to change the available fields in the field list. Thus if tables or
columns have been removed from the underlying source, it might result in query failure upon refresh. Opening
the report in Power BI Desktop, and choosing Refresh, will update the fields in the model to reflect the changes.

If data is changing, it is necessary to Refresh to ensure the latest data is shown: Given the use of
caches, there is no guarantee that the visual is always showing the latest data. For example, a visual might
show the transactions in the last day. Then due to a slicer being changed, it might refresh to show the
transactions for the last two days, including some very recent, newly arrived transactions. Returning the
slicer to its original value would result in it again showing the cached value previously obtained, that would
not include the newly arrived transaction seen before.

Selecting Refresh will clear any caches, and refresh all the visuals on the page to show the latest data.

If data is changing, there is no guarantee of consistency between visuals: Different visuals, whether
on the same page or on different pages, might be refreshed at different times. Thus if the data in the
underlying source is changing, there is no guarantee that each visual will be showing the data at the exact
same point of time. Indeed, given that sometimes more than one query is required for a single visual (for
example, to obtain the details and the totals) then consistency even within a single visual is not guaranteed.
To guarantee this would require the overhead of refreshing all visuals whenever any visual refreshed, in
tandem with the use of costly features like Snapshot Isolation in the underlying data source.

This issue can be mitigated to a large extent by again selecting Refresh, to will refresh all of the visuals on
the page. And it should be noted that even if using Import mode, there is a similar problem of guaranteeing
consistency if importing data from more than one table.

Limit of one million rows returned on any query: There is a fixed limit of one million rows placed on
the number of rows that can be returned in any single query to the underlying source. This generally has
no practical implications, and visuals themselves aren’t going to display that many points. However, the
limit can occur in cases where Power BI is not fully optimizing the queries sent, and there is some
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Cannot change from import to DirectQuery mode: Note that while it's generally possible to switch a
model from DirectQuery mode to use import mode, this means all the necessary data must be imported. It is
also not possible to switch back (primarily due to the set of features not supported in DirectQuery mode).
DirectQuery models over multidimensional sources like SAP BW also cannot be switched from DirectQuery to
import, due to the completely different treatment of external measures.

intermediate result being requested that exceeds the limit. It can also occur whilst building a visual, on the
path to a more reasonable final state. For example, including Customer and TotalSalesQuantity would hit
this limit if there were more than 1m customers, until some filter were applied.

The error that would be returned would be “The resultset of a query to external data source has exceeded
the maximum allowed size of '1000000' rows.”

All sources are supported from Power BI Desktop. Some sources are also available directly from within the
Power BI service. For example, it is possible for a business user to use Power BI to connect to their data in
Salesforce, and immediately get a dashboard, without use of Power BI Desktop.

Only two of the DirectQuery enabled-sources are available directly in the service:

Spark
Azure SQL Data Warehouse

However, it is strongly recommended that any use of DirectQuery over those two sources start within Power BI
Desktop. The reason is that when the connection is initially made in the Power BI service, many key limitations
will apply, meaning that while the start point was easy (starting in the Power BI service), there are limitations on
enhancing the resulting report any further (for example, it's not possible then to create any calculations, or use
many analytical features, or even refresh the metadata to reflect any changes to the underlying schema).

If you're going to use DirectQuery, then this section provides you with some high level guidance on how to
ensure success. The guidance in this section is derived from the implications of using DirectQuery that have been
described in this article.

It is strongly recommended to validate that simple visuals will be able to refresh in a reasonable time. This should
be within 5 seconds to have a reasonable interactive experience. Certainly if visuals are taking longer than 30
seconds, then it's highly likely that further issues will occur following publication of the report, which will make
the solution unworkable.

If queries are slow, then the first point of investigation is to examine the queries being sent to the underlying
source, and the reason for the query performance being observed. This topic doesn't cover the wide range of
database optimization best practices across the full set of potential underlying sources, but it does apply to the
standard database practices that apply to most situations:

Relationships based on integer columns generally perform better than joins on columns of other data types
The appropriate indexes should be created, which generally means the use of column store indexes in those
sources that support them (for example, SQL Server).
Any necessary statistics in the source should be updated

When defining the model, consider doing the following:

Avoid complex queries in Query Editor. The query that's defined in the Query Editor will be translated into



a single SQL query, that will then be included in the subselect of every query sent to that table. If that query is
complex, it might result in performance issues on ever query sent. The actual SQL query for a set of steps can
be obtained by selecting the last step in Query Editor, and choosing View Native Query from the context menu.
Keep measures simple. At least initially, it is recommended to limit measures to simple aggregates. Then if
those perform in a satisfactory manner, more complex measures can be defined, but paying attention to the
performance for each.
Avoid relationships on calculated columns. This is particularly relevant to databases where it is necessary
to perform multi-column joins. Power BI today does not allow a relationship to be based on multiple columns
as the FK/PK. The common workaround is to concatenate the columns together using a calculated column, and
base the join on that. While this workaround is reasonable for imported data, in the case of DirectQuery it
results in a join on an expression, that commonly prevents use of any indexes, and leads to poor performance.
The only workaround is to actually materialize the multiple columns into a single column in the underlying
database.
Avoid relationships on uniqueidentifier columns. Power BI does not natively support a datatype of
uniqueidentifier. Hence defining a relationship between columns of type uniqueidentifier column will result in
a query with a join involving a Cast. Again, this commonly leads to poor performance. Until this case is
specifically optimized, the only workaround is to materialize columns of an alternative type in the underlying
database.

ProductKey_PK   (Destination of a relationship, hidden)
ProductKey (= [ProductKey_PK],   visible)
ProductName
...

Examine all uses of calculated columns and data type changes. Use of these capabilities are not
necessarily harmful, they result in the queries sent to the underlying source containing expressions rather than
simple references to columns, that again might result in indexes not being used.
Avoid use of the (preview) bi-directional cross filtering on relationships.
Experiment with setting Assume referential integrity. The Assume Referential Integrity setting on
relationships enables queries to use INNER JOIN statements rather than OUTER JOIN. This generally improves
query performance, though it does depend on the specifics of the data source.

Hide the to column on relationships. The to column on relationships (commonly the primary key on the
to table) should be hidden, so that it does not appear in the field list, and therefore cannot be used in
visuals. Often the columns on which relationships are based are in fact system columns (for example,
surrogate keys in a data warehouse) and hiding such columns is good practice anyway. If the column does
have meaning, then introduce a calculated column that is visible, and that has a simple expression of being
equal to the primary key. For example:

The reason for doing this is simply to avoid a performance issue that can occur otherwise if a visual
includes the primary key column.

Do not use the relative data filtering in Query Editor. It's possible to define relative date filtering in
Query Editor. For example, to filter to the rows where the date is in the last 14 days.
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However, this will be translated into a filter based on the fixed date, as at the time the query was authored.
This can be seen from viewing the native query.

This is almost certainly not what was wanted. To ensure the filter is applied based upon the date as at the
time the report is executed then instead apply the filter in the report as a Report Filter. Currently this would
be done by creating a calculated column calculating the number of days ago (using the DAX DATE()
function), and then using that calculated column in a filter.

When creating a report using a DirectQuery connection, adhere to the following guidance:

Apply filters first: Always apply any applicable filters at the start of building a visual. For example, rather than
drag in the TotalSalesAmount, and ProductName, then filter to a particular year, apply the filter on Year at the
very start. This is because each step of building a visual will send a query, and whilst it is possible to then make
another change before the first query has completed, this still leaves unnecessary load on the underlying
source. By applying filters early, it generally makes those intermediate queries less costly. Also, failing to apply
filters early can result in hitting the 1m row limit above.
Limit the number of visuals on a page: When a page is opened (or some page level slicer or filter changed)
then all of the visuals on a page are refreshed. There is also a limit on the number of queries that are sent in
parallel, hence as the number of visuals increases, some of the visuals will be refreshed in a serial manner,
increasing the time taken to refresh the entire page. For this reason it's recommended to limit the number of
visuals on a single page, and instead have more, simpler pages.
Consider switching off interaction between visuals: By default, visualizations on a report page can be
used to cross-filter and cross-highlight the other visualizations on the page. For example, having selected
“1999” on the pie chart, the column chart is cross highlighted to show the sales by category for “1999”.



Consider sharing the report only: There are different ways of sharing content after publishing to the Power
BI service. In the case of DirectQuery, it's advisable to only considering sharing the finished report, rather than
allow other users to author new reports (and potentially encounter performance issues for the particular
visuals that they build).

However, this interaction can be controlled as described in this article. In DirectQuery such cross-filtering
and cross-highlighting requires queries to be sent to the underlying source, so the interaction should be
switched off if the time taken to respond to users' selections would be unreasonably long.

In addition to the above list of suggestions, note that each of the following reporting capabilities can cause
performance issues:

Measure filters: Visuals containing measures (or aggregates of columns) can contain filters in those
measures. For example, the visual below shows SalesAmount by Category, but only including those
Categories with more than 20M of sales.

This will result in two queries being sent to the underlying source:

The first query will retrieve the Categories meeting the condition (Sales > 20M)
The second query will then retrieve the necessary data for the visual, including the Categories that met
the condition in the WHJERE clause.

This generally performs just fine if there are hundreds or thousands of categories, as in this example.
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TopN filters: Advanced filters can be defined to filter on only the Top (or Bottom) N values ranked by some
measure, for example, to only include the Top 10 Categories in the visual above. This will again result in two
queries being sent to the underlying source. However, the first query will return all categories from the
underlying source, and then the TopN are determined based on the returned results. Depending on the
cardinality of the column involved, this can lead to performance issues (or query failures due to the 1m row
limit).
Median: Generally, any aggregation (Sum, Count Distinct, so on) is pushed to the underlying source. However,
this is not true for Median, as this aggregate is generally not supported by the underlying source. In such cases,
the detail data is retrieved from the underlying source, and the Median calculated from the returned results.
This is reasonable when the median is to be calculated over a relatively small number of results, but
performance issues (or query failures due to the 1m row limit) will occur if the cardinality is large. For example,
Median Country Population might be reasonable, but Median Sales Price might not be.
Advanced text filters (‘contains’ and similar): When filtering on a text column, the advanced filtering
allows filters like ‘contains’ and ‘begins with’ and so on. These filters can certainly result in degraded
performance for some data sources. In particular, the default ‘contains’ filter should not be used if what is
really required is an exact match (‘is’ or ‘is not’). Although the results might be the same, depending on the
actual data, the performance might be drastically different due to the use of indexes.
Multi select slicers: By default, slicers only allow a single selection to be made. Allowing multi selection in
filters can cause some performance issues, because as the user selects a set of items in the slicer (for example,
the ten products they are interested in), then each new selection will result in queries being sent to the backend
source. Whilst the user can select the next item prior to the query completing, this does result in extra load on
the underlying source.

Performance can degrade if the number of categories is much larger (and indeed, the query will fail if there
were more than a million categories meeting the condition, due to the one million row limit discussed
earlier).

This section describes how to diagnose performance issues, or how to get more detailed information to allow the
reports to be optimized.

It's strongly recommended that any diagnosis of performance issues starts in Power BI Desktop, rather than in
the Power BI service. It's commonly the case that performance issues are simply based on the level of
performance of the underlying source, and these are more easily identified and diagnosed in the much more
isolated environment of Power BI Desktop, and initially eliminates certain components (such as the Power BI
gateway). Only if the performance issues are found to not be present with Power BI Desktop should investigation
focus on the specifics of the report in the Power BI service.

Similarly, it is recommended to first try to isolate any issues to an individual visual, rather than many visuals on a
page.

So, let's say those steps (in the previous paragraphs in this section) have been taken - we now have a single visual
on a page in Power BI Desktop that is still sluggish. To determine the queries that are sent to the underlying
source by Power BI Desktop, it's possible to view traces/diagnostic information that might be emitted by that
source. Such traces might also contain useful information about the details of how the query was executed, and
how it can be improved.

Further, even in the absence of such traces from the source, it's possible to view the queries sent by Power BI,
along with their execution times, as described next.

By default, Power BI Desktop logs events during a given session to a trace file called FlightRecorderCurrent.trc.

For some DirectQuery sources, this log includes all queries sent to the underlying data source (the remaining
DirectQuery sources will be included in the future). The sources that send queries to the log are the following:



\<User>\AppData\Local\Microsoft\Power BI Desktop\AnalysisServicesWorkspaces

\<User>\AppData\Local\Microsoft\Power BI Desktop\Traces

SQL Server
Azure SQL Database
Azure SQL Data warehouse
Oracle
Teradata
SAP HANA

The trace file can be found in the AppData folder for the current user:

Here's an easy way to get to this folder: In Power BI Desktop select File > Options and settings > Options, and
then select Diagnostics. The following dialog window appears:

When you select the Open traces folder link, under Diagnostic Options, the following folder opens:

Navigating to that folder's parent folder displays the folder containing AnalysisServicesWorkspaces, which will
contain one workspace subfolder for every open instance of Power BI Desktop. These subfolders are named with
an integer suffix, such as AnalysisServicesWorkspace2058279583.

Inside that folder is a \Data subfolder that contains the trace file FlightRecorderCurrent.trc for the current Power
BI session. The corresponding workspace folder is deleted when the associated Power BI Desktop session ends.

The trace files can be read using the SQL Server Profiler tool, which is available as a free download as part of
SQL Server Management Studio. You can get that from this location.

https://msdn.microsoft.com/library/mt238290.aspx


Once you download and install SQL Server Management Studio, run SQL Server Profiler.

To open the trace file, take the following steps:

1. In SQL Server Profiler, select File > Open > Trace file

  C:\Users\<user>\AppData\Local\Microsoft\Power BI 
Desktop\AnalysisServicesWorkspaces\AnalysisServicesWorkspace2058279583\Data

3. Open FilghtRecorderCurrent.trc

2. Enter the path to the trace file for the currently open Power BI session, such as:

All events from the current session are displayed. An annotated example is shown below, which highlights groups
of events. Each group has the following:

A Query Begin and Query End event, which represent the start and end of a DAX query generated by the UI (for
example, from a visual, or from populating a list of values in the filter UI)
One or more pairs of DirectQuery Begin and DirectQuery End events, which represent a query sent to the
underlying data source, as part of evaluating the DAX query.

Note that multiple DAX queries can be executed in parallel, so events from different groups can be interleaved.
The value of the ActivityID can be used to determine which events belong to the same group.
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Other columns of interest are the following:

TextData: The textual detail of the event. For “Query Begin/End” events this will be the DAX query. For
“DirectQuery Begin/End” events this will be the SQL query sent to the underlying source. The TextData for the
currently selected event is also displayed in the region at the bottom.
EndTime: When the event completed.
Duration: The duration, in milliseconds, taken to execute the DAX or SQL query.
Error: Indicates if an error occurred (in which case the event is also displayed in red).

Note that in the image above, some of the less interesting columns have narrowed, to allow the interesting
columns to be seen more easily.

The recommended approach to capturing a trace to help diagnose a potential performance issue is the following:

Open a single Power BI Desktop session (to avoid the confusion of multiple workspace folders)
Perform the set of actions of interest in Power BI Desktop. Include a few additional actions beyond that, to
ensure that the events of interest are flushed into the trace file.
Open SQL Server Profiler and examine the trace, as described earlier. Remember that the trace file will be
deleted upon closing Power BI Desktop. Also, further actions in Power BI Desktop will not immediately
appear – the trace file should be closed and re-opened to see the new events.
Keep individual sessions reasonably small (ten seconds of actions, not hundreds) to make it easier to interpret
the trace file (and because there is a limit on the size of the trace file, thus for very long sessions there is a
chance of early events being dropped).

The general format of queries created and sent by Power BI Desktop use subselects for each of the tables
referenced, where the subselect is as defined by the query defined in Query Editor. For example, assume the
following TPC-DS tables in SQL Server:



Consider the following query:

That query results in the following visual:



Refreshing that visual will result in the SQL query shown below the next paragraph. As you can tell, there are three
subselects for Web Sales, Item, and Date_dim, that each return all the columns on the respective table, even
though only four columns are actually referenced by the visual. These queries in the subselects (they're shaded)
are exactly the result of the queries defined in Query editor. Use of subselects in this manner has not been found
to impact performance, for the data sources so far supported for DirectQuery. Data sources like SQL Server simply
optimize away the references to the other columns.

One reason Power BI employs this pattern is because the SQL query used can be provided directly by the analyst,
so it's used "as provided", without an attempt to rewrite it.





Next steps
This article describes aspects of DirectQuery that are common across all data sources. There are certain details
that are specific to individual sources. See the following topics covering specific sources:

DirectQuery and SAP HANA
DirectQuery and SAP BW

For more information about DirectQuery, check out the following resources:

Data Sources supported by DirectQuery



Data sources supported by DirectQuery in Power BI
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On-premises gateway requirements

SOURCE GATEWAY REQUIRED?

SQL Server Yes

Azure SQL Database No

Azure SQL Data Warehouse No

SAP HANA Yes

Power BI Desktop and the Power BI service have many data sources to which you can connect and get access
to data. This article describes which data sources for Power BI support the connection method known as
DirectQuery. For more information about DirectQuery, see DirectQuery in Power BI.

The following data sources support DirectQuery in Power BI:

Amazon Redshift
Azure HDInsight Spark (Beta)
Azure SQL Database
Azure SQL Data Warehouse
Google BigQuery (Beta)
IBM Netezza (Beta)
Impala (version 2.x)
Oracle Database (version 12 and above)
SAP Business Warehouse (Beta)
SAP HANA
Snowflake
Spark (Beta) (version 0.9 and above)
SQL Server
Teradata Database
Vertica (Beta)

Data sources that are have (Beta) or (Preview) after their name are subject to change, and are not supported for
production use. They might also not be supported after publishing a report to the Power BI service, which
means that that opening a published report or exploring the dataset can result in an error.

The only difference between (Beta) and (Preview) data sources is that (Preview) sources must be enabled as a
Preview feature before they become available for use. To enable a (Preview) data connector, in Power BI
Desktop go to File > Options and Settings, and then Settings > Options > Preview features.

The following table specifies whether an on-premises data gateway is required to connect to the specified data
source, after publishing a report to the Power BI service.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-directquery-data-sources.md


Oracle Database Yes

Teradata Database Yes

Amazon Redshift No

Impala (version 2.x) Yes

Snowflake (Preview) Not yet supported in the Power BI service

Spark (beta), version 0.9 and later Not yet supported in the Power BI service

Azure HDInsight Spark (Beta) Not yet supported in the Power BI service

IBM Netezza (Beta) Not yet supported in the Power BI service

SAP Buisness Warehouse (Beta) Not yet supported in the Power BI service

SOURCE GATEWAY REQUIRED?

Next steps
For more information about DirectQuery, check out the following resources:

DirectQuery in Power BI
DirectQuery and SAP HANA
DirectQuery and SAP BW
On-premises data gateway



DirectQuery for Oracle and Teradata Databases
1/25/2018 • 1 min to read • Edit Online

Please see DirectQuery Data Sources for information about data sources and DirectQuery.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-directquery-for-oracle-teradata.md
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Additional Modelling Restrictions

Additional Visualization Restrictions

You can connect to SAP Business Warehouse (BW) data sources directly using DirectQuery. Given the
OLAP/multidimensional nature of SAP BW, there are many important differences between DirectQuery over SAP
BW versus relational sources like SQL Server. These differences are summarized as follows:

In DirectQuery over relational sources there are a set of queries (as defined in the Get Data or Query Editor
dialog) that logically define the data that is available in the field list. This is not the case when connecting to an
OLAP source such as SAP BW. Instead, when connecting to the SAP server using Get Data, just the Infocube or
BEx Query is selected. Then all the Key Figures and dimensions of the selected Infocube/BEx Query will be
available in the field list.
Similarly, there is no Query Editor when connecting to SAP BW. The data source settings (for example, server
name) can be changed by selecting Edit Queries > Data source settings. The settings for any Variables can
be changed by selecting Edit Queries > Edit Variables.
Given the unique nature of OLAP sources, there are additional restrictions (for both modelling and
visualizations) that apply, in addition to the normal restrictions imposed for DirectQuery. These restrictions are
described later in this article.

In addition, it is extremely important to understand that there are many features of SAP BW that are not
supported in Power BI, and that because of the nature of the public interface to SAP BW, there are important cases
where the results seen through Power BI will not match those seen when using an SAP tool. These limitations are
described later in this article. These limitations and behavior differences should be carefully reviewed, to ensure
that the results seen through Power BI, as returned by the SAP public interface, are interpreted correctly.

The primary additional modelling restrictions when connecting to SAP BW using DirectQuery in Power BI are the
following:

No support for calculated columns: The ability to create calculated columns is disabled. This also means
that Grouping and Clustering, which create calculated columns, are not available.
Additional limitations for measures: There are additional limitations imposed on the DAX expressions that
can be used in measures, to reflect the level of support offered by SAP BW.
No support for defining relationships: The relationships are inherent in the external SAP source, and
additional relationships cannot be defined in the model.
No Data View: The Data View normally displays the detail level data in the tables. Given the nature of OLAP
sources like SAP BW, this view is not available over SAP BW.
Column and measure details are fixed: The list of columns and measures seen in the field list are fixed by
the underlying source, and cannot be modified. For example, it is not possible to delete a column, nor change
its datatype (it can, however, be renamed).
Additional limitations in DAX: There are additional limitations on the DAX that can be used in measure
definitions, to reflect limitations in the source. For example, it is not possible to use an aggregate function over
a table.

The primary additional restrictions in visualizations when connecting to SAP BW using DirectQuery in Power BI
are the following:

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-directquery-sap-bw.md


Support for SAP BW features

FEATURE DESCRIPTION

Local calculations Local calculations defined in a BEX Query will change the
numbers as displayed through tools like Bex Analyzer.
However, they are not reflected in the numbers returned
from SAP, through the public MDX interface. 

As such, the numbers seen in a Power BI visual will not
necessarily match those for a corresponding visual in an
SAP tool.

For example, when connecting to a query cube from a BEx
query that sets the aggregation to be Cumulated (i.e. running
sum), Power BI would get back the base numbers, ignoring
that setting. An analyst could certainly then apply a running
sum calculation locally in Power BI, but would need to
exercise caution in how the numbers are interpreted if this is
not done.

Aggregations In some cases (particularly when dealing with multiple
currencies), the aggregate numbers returned by the SAP
public interface do not match those shown by SAP tools. 

As such, the numbers seen in a Power BI visual will not
necessarily match those for a corresponding visual in an
SAP tool. 

For example, totals over different currencies would show as
"*" in Bex Analyzer, but the total would get returned by the
SAP public interface, without any information that such an
aggregate number is meaningless. Thus the number
(aggregating, say, $, EUR, and AUD) would get displayed by
Power BI.

Currency formatting Any currency formatting (for example, $2,300 or 4000 AUD)
is not reflected in Power BI.

Units of measure Units of measure (for example, 230 KG) are not reflected in
Power BI.

No aggregation of columns: It is not possible to change the aggregation for a column on a visual; ;it is
always Do Not Summarize

Measure filtering is disabled: Measure filtering is disabled to reflect the support offered by SAP BW.
Multi-select and include/exclude: The ability to multi-select data points on a visual is disabled if the points
represent values from more than one column. For example, given a bar chart showing Sales by Country, with
Category on the Legend, it would not be possible to select the point for (USA, Bikes) and (France, Clothes).
Similarly, it would not be possible to select the point for (USA, Bikes) and exclude it from the visual. Both
limitations are imposed to reflect the support offered by SAP BW.

The following table lists all SAP BW features that are not fully supported, or will behave differently when using
Power BI.



Key versus text (short, medium, long) For an SAP BW characteristic like CostCenter, the field list will
show a single column Cost Center. Using that column will
display the default text. By showing hidden fields, it will also
be possible to see the unique name column (that returns the
unique name assigned by SP BW, and is the basis of
uniqueness).

The key and other text fields are not available.

Multiple hierarchies of a characteristic In SAP, a characteristic can have multiple hierarchies. Then in
tools like BEx Analyzer, when a characteristic is included in a
query, the user can select the hierarchy to use. 

In Power BI, the various hierarchies can be seen in the field
list as different hierarchies on the same dimension. However,
selecting multiple levels from two different hierarchies on the
same dimension will result in empty data being returned by
SAP.

Treatment of ragged hierarchies

Scaling factor/reverse sign In SAP a key figure can have a scaling factor (for example,
1000) defined as a formatting option, meaning that all display
will be scaled by that factor. 

It can similarly have a property set that reverses the sign. Use
of such a key figure in Power BI (in a visual, or as part of a
calculation) will result in the unscaled number being used
(and the sign is not reversed). The underlying scaling factor is
not available. In Power BI visuals, the scale units shown on
the axis (K,M,B) can be controlled as part of the visual
formatting.

Hierarchies where levels appear/disappear dynamically Initially when connecting to SAP BW, the information on the
levels of a hierarchy will be retrieved, resulting in a set of
fields in the field list. This is cached, and if the set of levels
changes, then the set of fields do not change until Refresh is
invoked. 

This is only possible in Power BI Desktop. Such Refresh to
reflect changes to the levels cannot be invoked in the Power
BI service after Publish.

FEATURE DESCRIPTION



Default filter A BEX query can include Default Filters, which will be applied
automatically by SAP Bex Analyzer. These are not exposed,
and hence the equivalent usage in Power BI will not apply the
same filters by default.

Hidden Key figures A BEX query can control visibility of Key Figures, and those
that are hidden will not appear in SAP BEx Analyzer. This is
not reflected through the public API, and hence such hidden
key figures will still appear in the field list. However, they can
then be hidden within Power BI.

Numeric formatting Any numeric formatting (number of decimal positions,
decimal point etc.) will not automatically be reflected in Power
BI. However, it is possible to then control such formatting
within Power BI.

Hierarchy versioning SAP BW allows different versions of a hierarchy to be
maintained, for example, the cost center hierarchy in 2007
versus 2008. Only the latest version will be available in Power
BI, as information on versions is not exposed by the public
API.

Time dependent hirarchies When using Power BI, time dependent hierarchies are
evaluated at the current date.

Currency conversion SAP BW supports currency conversion, based on rates held in
the cube. Such capabilities are not exposed by the public API,
and are therefore not available in Power BI.

Sort Order The sort order (by Text, or by Key) for a characteristic can be
defined in SAP. This sort order is not reflected in Power BI. For
example, months might appear as “April”, “Aug”, and so on. 

It is not possible to change this sort order in Power BI.

Technical names In Get Data, the characteristic/measure names (descriptions)
and technical names can both be seen. The field list will
contain just the characteristic/measure names (descriptions).

Attributes It is not possible to access the attributes of a characteristic
within Power BI.

End user language setting The locale used to connect to SAP BW is set as part of the
connection details, and does not reflect the locale of the final
report consumer.

Text Variables SAP BW allows field names to contain placeholders for
variables (for example, "$YEAR$ Actuals") that would then get
replaced by the selected value. For example, the field appears
as "2016 Actuals" in BEX tools, if the year 2016 were selected
for the variable. 

The column name in Power BI will not be changed depending
on the variable value, and therefore would appear as "$YEAR$
Actuals". However, the column name can then be changed in
Power BI.

FEATURE DESCRIPTION



Limitations and considerations

LIMITATION DESCRIPTION

No Refresh The Refresh button is disabled, and visuals/metadata cannot
be refreshed.

Next steps

The following table lists limitations of the beta release of the SAP BW connector.

For more information about DirectQuery, check out the following resources:

DirectQuery in Power BI
Data Sources supported by DirectQuery
DirectQuery and SAP HANA



DirectQuery and SAP HANA
1/25/2018 • 4 min to read • Edit Online

You can connect to SAP HANA data sources directly using DirectQuery.

When using SAP HANA it is important to understand some aspects of how connections to it are treated, to
ensure that:

The results are as expected, when the SAP HANA view contains non-additive measures (for example, distinct
counts, or averages, rather than simple sums)
The resulting queries are efficient

It's useful to start by taking a moment to clarify the behavior of a relational source such as SQL Server, when the
query defined in Get Data or Query Editor performs an aggregation. In the example that follows, a query
defined in Query Editor returns the average price by ProductID.

If the data is being imported into Power BI (versus using DirectQuery), the following would result:

The data is imported at the level of aggregation defined by the query created in Query Editor. For example,
average price by product. This results in a table with the two columns ProductID and AveragePrice that can be
used in visuals.
In a visual, any subsequent aggregation (such as Sum, Average, Min, others) is performed over that imported
data. For example, including AveragePrice on a visual will use the Sum aggregate by default, and would return
the sum over the AveragePrice for each ProductID – which in this case would be 13.67. The same applies to
any alternative aggregate function (such as Min, Average, so on) used on the visual. For example, Average of

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-directquery-sap-hana.md


AveragePrice returns the average of 6.66, 4 and 3, which equates to 4.56, and not the average of Price on the 6
records in the underlying table, which is 5.17.

If DirectQuery is being used instead of Import, the same semantics apply and the results would be exactly the
same:

Given the same query, logically exactly the same data is presented to the reporting layer – even though the
data is not actually imported.
In a visual, any subsequent aggregation (Sum, Average, Min, others) is again performed over that logical table
from the query. And again, a visual containing Average of AveragePrice returns the same 4.56.

So now let's consider SAP HANA. Power BI can work with both Analytic Views and Calculation Views in SAP
HANA, both of which can contain measures. Yet today the approach for SAP HANA follows the same principles as
described previously: the query defined in Get Data or Query Editor will determine the data available, and then
any subsequent aggregation in a visual is over that data, and the same applies for both Import and DirectQuery.

However, given the nature of HANA, the query defined in the initial Get Data dialog or Query Editor is always an
aggregate query, and generally will include measures where the actual aggregation that will be used is defined by
the HANA view.

The equivalent of the SQL Server example above is that there is a HANA view containing ID, ProductID,
DepotID, and measures including AveragePrice, defined in the view as Average of Price.

If, in the Get Data experience, the selections made were for ProductID and the AveragePrice measure, then that
is defining a query over the view, requesting that aggregate data (in the example above, for simplicity pseudo-
SQL is used that doesn’t match the exact syntax of HANA SQL). Then any further aggregations defined in a visual



Next stepsNext steps

are further aggregating the results of such a query. Again, as described above for SQL Server, this applies both
for the Import and DirectQuery case. Note that in the DirectQuery case, the query from Get Data or Query Editor
will be used in a subselect within a single query sent to HANA, and thus it is not actually the case that all the data
would be read in, prior to aggregating further.

This gives rise to the following important considerations when using DirectQuery over HANA:

Attention must be paid to any further aggregation performed in visuals, whenever the measure in HANA is
non-additive (for example, not a simple Sum, Min, or Max).
In Get Data or Query Editor, only the required columns should be included to retrieve the necessary data,
reflecting the fact that the result will be a query, that must be a reasonable query that can be sent to HANA. For
example, if dozens of columns were selected, with the thought that they might be needed on subsequent
visuals, then even for DirectQuery a simple visual will mean the aggregate query used in the subselect will
contain those dozens of columns, which will generally perform very poorly.

Let's look at an example. In the following example, selecting five columns (CalendarQuarter, Color, LastName,
ProductLine, SalesOrderNumber) in the Get Data dialog, along with the measure OrderQuantity, will mean that
later creating a simple visual containing the Min OrderQuantity will result in the following SQL query to HANA.
The shaded portion is the subselect, containing the query from Get Data / Query Editor. If this subselect gives a
very high cardinality result, then it is likely the resulting HANA performance will be poor.

Because of this, it is recommended that the items selected in Get Data or Query Editor should be limited to
those items that are needed, while still resulting in a reasonable query for HANA.

For more information about DirectQuery, check out the following resources:

DirectQuery in Power BI
Data sources supported by DirectQuery
DirectQuery and SAP BW
On-premises data gateway



Assume referential integrity settings in Power BI
Desktop
1/25/2018 • 2 min to read • Edit Online

Requirements for using Assume referential integrity

Example of using Assume referential integrity

When connecting to a data source using DirectQuery, you can use the Assume Referential Integrity selection to
enable running more efficient queries against your data source. This feature has a few requirements of the
underlying data, and it is only available when using DirectQuery.

Setting Assume referential integrity enables queries on the data source to use INNER JOIN statements rather
than OUTER JOIN, which improves query efficiency.

This is an advanced setting, and is only enabled when connecting to data using DirectQuery. The following
requirements are necessary for Assume referential integrity to work properly:

Data in the From column in the relationship is never Null or blank

For each value in the From column, there is a corresponding value in the To column

In this context, the From column is the Many in a One-to-Many relationship, or it is the column in the first table in a
One-to-One relationship.

The following example demonstrates how Assume referential integrity behaves when used in data connections.
The example connects to a data source that includes an Orders table, a Products table, and a Depots table.

1. In the following image that shows the Orders table and the Products table, note that referential integrity

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-assume-referential-integrity.md


Setting Assume referential integrity

exists between Orders[ProductID] and Products[ProductID]. The [ProductID] column in the Orders table
is never Null, and every value also appears in the Products table. As such, Assume Referential Integrity
should be set to get more efficient queries (using this setting does not change the values shown in visuals).

2. In the next image, notice that no referential integirty exists between Orders[DepotID] and
Depots[DepotID], because the DepotID is Null for some Orders. As such, Assume Referential Integrity
should not be set.

3. Finally, no referential integrity between Orders[CustomerID] and Customers[CustID] in the following
tables; the CustomerID contains some values (in this case, CustX) that do not exist in the Customers table. As
such, Assume Referential Integrity should not be set.

To enable this feature, select the checkbox next to Assume Referential Integrity as shown in the following image.



What happens if you incorrectly set Assume referential integrity?

Next steps

When selected, the setting is validated against the data to ensure there are no Null or mismatched rows. However,
for cases with a very large number of values, the validation is not a guarantee that there are no referential integrity
issues.

In addition, the validation occurs at the time of editing the relationship, and does not reflect any subsequent
changes to the data.

If you set Assume Referential Integrity when there are referential integrity issues in the data will not result in
errors. However, it will result in apparent inconsistencies in the data. For example, in the case of the relationship to
the Depots table described above, it would result in the following:

A visual showing the total Order Qty would show a value of 40
A visual showing the total Order Qty by Depot City would show a total value of only 30, because it would not
include Order ID 1, where DepotID is Null.

Learn more about DirectQuery

Get more information about Relationships in Power BI

Learn more about Relationship View in Power BI Desktop.



Tutorial: Dynamic row level security with Analysis
services tabular model
11/22/2017 • 8 min to read • Edit Online

Task 1: Create the user security table and define data relationship

This tutorial demonstrates the steps necessary to implement row level security within your Analysis Services
Tabular Model, and shows how to use it in in a Power BI report. The steps in this tutorial are designed to let you
follow along and learn the steps necessary by completing on a sample dataset.

During this tutorial, the following steps are described in detail, helping you understand what you need to do to
implement dynamic row level security with Analysis Services tabular model:

Create a new security table in the AdventureworksDW2012 database
Build the tabular model with necessary fact and dimension tables
Define the roles and permissions for the users
Deploy the model to an Analysis Services tabular instance
Use Power BI Desktop to build a report that displays the data corresponding to the user accessing the report
Deploy the report to Power BI service
Create a new dashboard based on the report, and finally,
Share the dashboard with your coworkers

To follow the steps in this tutorial you need the AdventureworksDW2012 database, which you can download
here.

There are many published articles describing how to define row level dynamic security with SQL Server Analysis
Services (SSAS) tabular model. For our sample we follow this article. The following steps walk you through the
first task in this tutorial.

1. For our sample, we're using AdventureworksDW2012 relational database. In that database, create the
DimUserSecurity table, as shown in the following image. For this sample, we're using SQL Server
Management Studio (SSMS) to create the table.

2. Once the table is created and saved, we need to create the relationship between the DimUserSecurity
table's SalesTerritoryID column and DimSalesTerritory table's SalesTerritoryKey column, as shown in
the following image. This can be done from SSMS by right-clicking on the DimUserSecurity table, and
selecting Edit.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-tutorial-row-level-security-onprem-ssas-tabular.md
http://msftdbprodsamples.codeplex.com/releases/view/55330
https://msdn.microsoft.com/library/hh479759.aspx


Task 2: Create the tabular model with facts and dimension tables

**select b.SalesTerritoryCountry, b.SalesTerritoryRegion, a.EmployeeKey, a.FirstName, a.LastName, 
a.UserName from [dbo].[DimUserSecurity] as a join  [dbo].[DimSalesTerritory] as b on a.
[SalesTerritoryKey] = b.[SalesTerritoryKey]**

5. Notice that the above image shows information such as which user is responsible for which sales region. That
data is displayed because of the relationship that we created in Step 2. Also, note that the user Jon Doe is part
of the Australia sales region. We’ll revisit John Doe in upcoming steps and tasks.

3. Save the table, then add few rows of user information in to the table by again right clicking on the
DimUserSecurity table and then selecting Edit top 200 rows. Once you’ve added those users, the rows of
the DimUserSecurity table look like they do in the following image:

We’ll come back to these users in upcoming tasks.

4. Next we do an inner join with the DimSalesTerritory table, which shows the region details associated with
the user. The following code performs the inner join, and the image that follows shows how the table
appears once the inner join is successful.

1. Once your relational data warehouse is in place, it’s time to define your tabular model. The model can be created
using SQL Server Data Tools (SSDT). To get more information about how to define a tabular model, please



refer this article.

3. Once you’ve imported the necessary tables, you need to define a role called SalesTerritoryUsers with Read
permission. This can be achieved by clicking on the Model menu in SQL Server Data Tools, and then clicking
Roles. In the Role Manager dialog box, click New.

2. Import all the necessary tables in to the model as shown below.

4. Under Members tab in the Role Manager, add the users that we defined in the DimUserSecurity table in
Task 1 - step 3.

https://msdn.microsoft.com/library/hh231689.aspx


=DimSalesTerritory[SalesTerritoryKey]=LOOKUPVALUE(DimUserSecurity[SalesTerritoryID], 
DimUserSecurity[UserName], USERNAME(), DimUserSecurity[SalesTerritoryID], 
DimSalesTerritory[SalesTerritoryKey])

=FALSE()

9. This formula specifies that all columns resolve to the false Boolean condition; therefore, no columns for the
DimUserSecurity table can be queried.

10. Now we need to process and deploy the model. You can refer this article for assistance in deploying the model.

5. Next, add the proper functions for both DimSalesTerritory and DimUserSecurity tables, as shown below
under Row Filters tab.

6. In this step, we use the LOOKUPVALUE function to return values for a column in which the Windows user
name is the same as the user name returned by the USERNAME function. Queries can then be restricted
where the values returned by LOOKUPVALUE match values in the same or related table. In the DAX Filter
column, type the following formula:

7. In this formula, the LOOKUPVALUE function returns all values for the DimUserSecurity[SalesTerritoryID]
column, where the DimUserSecurity[UserName] is the same as the current logged on Windows user
name, and DimUserSecurity[SalesTerritoryID] is the same as the
DimSalesTerritory[SalesTerritoryKey].

The set of Sales SalesTerritoryKey's returned by LOOKUPVALUE is then used to restrict the rows shown in
the DimSalesTerritory. Only rows where the SalesTerritoryKey for the row is in the set of IDs returned by
the LOOKUPVALUE function are displayed.

8. For the DimUserSecurity table, in the DAX Filter column, type the following formula.

https://msdn.microsoft.com/library/hh231693.aspx


Task 3: Adding Data Sources within your on-premises data gateway

Task 4: Creating report based on analysis services tabular model using
Power BI desktop

1. Once your tabular model is deployed and ready for consumption, you need to add a data source connection to
your on-premises Analysis Services tabular server with in your Power BI portal.

2. To allow the Power BI service access your on-premises analysis service, you need to have an on-premises
data gateway installed and configured in your environment.

4. With the previous step complete, the gateway is configured and ready interact with your on-premises Analysis
Services data source.

3. Once the gateway is correctly configured, you need to create a data source connection for your Analysis
Services tabular instance. This article will help you with adding data source within the Power BI portal.

1. Launch Power BI Desktop and select Get Data > Database.
2. From the list of data sources, select the SQL Server Analysis Services Database and select connect.



3. Fill in your Analysis Services tabular instance details and select Connect Live. Select OK. With Power BI,
dynamic security works only with Live connection.

4. You'll see that the model that was deployed in the Analysis Services instance. Select the respective model
and select OK.



Task 5: Creating and sharing a dashboard

5. Power BI Desktop now displays all the available fields, to the right of the canvas in the Fields pane.
6. In the Fields pane on the right, select the SalesAmount measure from FactInternetSales table and

SalesTerritoryRegion dimension from SalesTerritory table.

8. Once your report is ready, you can directly publish it to the Power BI portal. From the Home ribbon in Power BI
Desktop, select Publish.

7. We’ll keep this report simple, so right now we won’t add any more columns. To have more meaningful
representation of the data, we'll change the visualization to Donut chart.

1. You’ve created the report and clicked Publish in Power BI Desktop, so the report is published to the
Power BI service. Now that it’s in the service, our model security scenario can be demonstrated by using the
example we created in the previous steps.

In his role, Sales Manager - Sumit can see data from all the different sales regions. So he creates this report
(the report created in the previous task steps) and publishes it to the Power BI service.

Once he publishes the report, he creates a dashboard in the Power BI service called TabularDynamicSec
based on that report. In the following image, notice that the sales Manager (Sumit) is able to see the data
corresponding to all the sales region.



2. Now Sumit shares the dashboard with his colleague, Jon Doe, who is responsible for sales in Australia
region.

3. When Jon Doe logs in to the Power BI service and views the shared dashboard that Sumit created, Jon Doe
should see only the sales from his region for which he is responsible. So Jon Doe logs in, accesses the
dashboard that Sumit shared with him, and Jon Doe sees only the sales from the Australia region.



Task 6: Understanding what happens behind the scenes

4. Congratulations! The dynamic row level security that was defined in the on-premises Analysis Services tabular
model has been successfully reflected and observed in the Power BI service. Power BI uses the
effectiveusername property to send the current Power BI user credential to the on-premises data source to
run the queries.

1. This task assumes you're familiar with SQL Profiler, since you need to capture a SQL Server profiler trace on
your on-premises SSAS tabular instance.

<PropertyList><Catalog>DefinedSalesTabular</Catalog><Timeout>600</Timeout><Content>SchemaData</Content>
<Format>Tabular</Format><AxisFormat>TupleFormat</AxisFormat><BeginRange>-1</BeginRange><EndRange>-
1</EndRange><ShowHiddenCubes>false</ShowHiddenCubes><VisualMode>0</VisualMode>
<DbpropMsmdFlattened2>true</DbpropMsmdFlattened2><SspropInitAppName>PowerBI</SspropInitAppName>
<SecuredCellValue>0</SecuredCellValue><ImpactAnalysis>false</ImpactAnalysis>
<SQLQueryMode>Calculated</SQLQueryMode><ClientProcessID>6408</ClientProcessID><Cube>Model</Cube>
<ReturnCellProperties>true</ReturnCellProperties><CommitTimeout>0</CommitTimeout>
<ForceCommitTimeout>0</ForceCommitTimeout><ExecutionMode>Execute</ExecutionMode>
<RealTimeOlap>false</RealTimeOlap><MdxMissingMemberMode>Default</MdxMissingMemberMode>
<DisablePrefetchFacts>false</DisablePrefetchFacts><UpdateIsolationLevel>2</UpdateIsolationLevel>
<DbpropMsmdOptimizeResponse>0</DbpropMsmdOptimizeResponse><ResponseEncoding>Default</ResponseEncoding>
<DirectQueryMode>Default</DirectQueryMode><DbpropMsmdActivityID>4ea2a372-dd2f-4edd-a8ca-
1b909b4165b5</DbpropMsmdActivityID><DbpropMsmdRequestID>2313cf77-b881-015d-e6da-
eda9846d42db</DbpropMsmdRequestID><LocaleIdentifier>1033</LocaleIdentifier>
<EffectiveUserName>jondoe@moonneo.com</EffectiveUserName></PropertyList>

3. Based on the effective user name request, Analysis Services converts the request to the actual moonneo\jondoe
credential after querying the local Active Directory. Once Analysis Services gets the actual credential from
Active Directory, then based on the access the user has permissions for on the data, Analysis Services returns
the only the data for which he or she has permission.

2. The session gets initialized as soon as the user (Jon Doe, in this case) accesses the dashboard in the Power BI
service. You can see that the salesterritoryusers role takes an immediate effect with the effective user name
as jondoe@moonneo.com

4. If more activity occurs with the dashboard, for example, if Jon Doe goes from the dashboard to the
underlying report, with SQL Profiler you would see a specific query coming back to the Analysis Services
tabular model as a DAX query.



Considerations

EVALUATE
  ROW(
    "SumEmployeeKey", CALCULATE(SUM(Employee[EmployeeKey]))
  )

<PropertyList xmlns="urn:schemas-microsoft-com:xml-analysis">``
          <Catalog>DefinedSalesTabular</Catalog>
          <Cube>Model</Cube>
          <SspropInitAppName>PowerBI</SspropInitAppName>
          <EffectiveUserName>jondoe@moonneo.com</EffectiveUserName>
          <LocaleIdentifier>1033</LocaleIdentifier>
          <ClientProcessID>6408</ClientProcessID>
          <Format>Tabular</Format>
          <Content>SchemaData</Content>
          <Timeout>600</Timeout>
          <DbpropMsmdRequestID>8510d758-f07b-a025-8fb3-a0540189ff79</DbpropMsmdRequestID>
          <DbPropMsmdActivityID>f2dbe8a3-ef51-4d70-a879-5f02a502b2c3</DbPropMsmdActivityID>
          <ReturnCellProperties>true</ReturnCellProperties>
          <DbpropMsmdFlattened2>true</DbpropMsmdFlattened2>
          <DbpropMsmdActivityID>f2dbe8a3-ef51-4d70-a879-5f02a502b2c3</DbpropMsmdActivityID>
        </PropertyList>

5. You can also see below the DAX query that is getting executed to populate the data for the report.

There are a few considerations to keep in mind when working with row level security, SSAS and Power BI.

1. On-premises row level security with Power BI is only available with Live Connection.
2. Any changes in the data after processing the model would be immediately available for the users who are

accessing the report is based on live connection from the Power BI service.



DirectQuery for Oracle and Teradata Databases
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Please see DirectQuery Data Sources for information about data sources and DirectQuery.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-directquery-for-oracle-teradata.md


Use the SAP BW Connector in Power BI Desktop
12/6/2017 • 4 min to read • Edit Online

Installation of SAP BW Connector

SAP BW Connector features

With Power BI Desktop, you can access SAP BusinessWarehouse (BW) data.

To use the SAP BW Connector, go through the following installation steps:

1. Install the SAP NetWeaver library on your local machine. You can get the SAP Netweaver library from
your SAP administrator, or directly from the SAP Software Download Center. Since the SAP Software
Download Center changes its structure frequently, more specific guidance for navigating that site is not
available. The SAP NetWeaver library is usually included also in the SAP Client Tools installation.

You may be able to search for SAP Note #1025361 to get the download location for the most recent
version. Make sure the architecture for the SAP NetWeaver library (32-bit or 64-bit) matches your Power
BI Desktop installation, then install all files included in the SAP NetWeaver RFC SDK according to the SAP
Note.

2. The Get Data dialog includes an entry for SAP Business Warehouse Server in the Database category.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-sap-bw-connector.md
https://support.sap.com/swdc


The SAP BW Connector preview in Power BI Desktop lets users import data from their SAP Business
Warehouse Server cubes. You can also use DirectQuery with the SAP BW Connector. You must specify a Server,
System Number and Client ID to establish the connection.

You can also specify two additional Advanced options: Language code, and a custom MDX statement to run
against the specified server.

If no MDX statement was specified you are presented with the Navigator window, which displays the list of cubes
available in the server, the option to drill down and select items from the available cubes, including dimensions
and measures. Power BI exposes queries and cubes exposed by the BW Open Analysis Interface OLAP BAPIs.

When you select one or more items from the server, a preview of the output table is created, based on their
selection.

https://help.sap.com/saphelp_nw70/helpdata/en/d9/ed8c3c59021315e10000000a114084/content.htm


The Navigator window also provides a few Display Options that allow you to do the following:

Display Only Selected Items versus All Items (default view): This option is useful for verifying the final set
of items selected. An alternative approach to viewing this is to select the Column Names in the Preview area.
Enable Data Previews (default behavior): You can also control whether data previews should be displayed
in this dialog. Disabling data previews reduces the amount of server calls, since it no longer requests data for
the previews.
Technical Names: SAP BW supports the notion of technical names for objects within a cube. Technical names
allow a cube owner to expose user friendly names for cube objects, as opposed to only exposing the physical
names for those objects in the cube.

After selecting all necessary objects in the Navigator, you can decide what to do next, by selecting one of the



Troubleshooting

following buttons on the bottom of the Navigator window:

Selecting Load triggers loading the entire set of rows for the output table into the Power BI Desktop data
model, then takes you to Report view where you can begin visualizing the data or making further
modifications using the Data or Relationships views.
Selecting Edit brings up Query Editor, where you can perform additional data transformation and filtering
steps before the entire set of rows is brought into the Power BI Desktop data model.

In addition to importing data from SAP BW cubes, remember that you can also import data from a wide range of
other data sources in Power BI Desktop, and then you can combine them into a single report. This presents all
sorts of interesting scenarios for reporting and analytics on top of SAP BW data.

This section provides troubleshooting situations (and solutions) for working with this preview version of the SAP
BW connector.

‘ ‘ (space) = Decimal point is comma: N.NNN,NN
'X' = Decimal point is period: N,NNN.NN
'Y' = Decimal point is N NNN NNN,NN

You are not authorized to display users in group TI:
    <item>
        <TYPE>E</TYPE>
        <ID>01</ID>
        <NUMBER>512</NUMBER>
        <MESSAGE>You are not authorized to display users in group TI</MESSAGE>
        <LOG_NO/>
        <LOG_MSG_NO>000000</LOG_MSG_NO>
        <MESSAGE_V1>TI</MESSAGE_V1>
        <MESSAGE_V2/>
        <MESSAGE_V3/>
        <MESSAGE_V4/>
        <PARAMETER/>
        <ROW>0</ROW>
        <FIELD>BNAME</FIELD>
        <SYSTEM>CLNTPW1400</SYSTEM>
    </item>

1. Numeric data from SAP BW returns decimal points instead of commas. For example, 1,000,000 is returned
as 1.000.000.

SAP BW returns decimal data with either a , (comma) or a . (dot) as the decimal separator. To specify which
of those SAP BW should use for the decimal separator, the driver used by Power BI Desktop makes a call
to BAPI_USER_GET_DETAIL. This call returns a structure called DEFAULTS, which has a field called DCPFM
that stores Decimal Format Notation. It takes one of the following three values:

Customers who have reported this issue found that the call to BAPI_USER_GET_DETAIL is failing for a
particular user (the user who is showing the incorrect data), with an error message similar to the following:

To solve this error, users must ask their SAP admin to grant the SAPBW user being used in Power BI the
right to execute BAPI_USER_GET_DETAIL. It’s also worth verifying that the user has the required DCPFM
value, as described earlier in this troubleshooting solution.

2. Connectivity for SAP BEx queries

You can perform BEx queries in Power BI Desktop by enabling a specific property, as shown in the
following image:





Use OneDrive for Business links in Power BI Desktop
12/6/2017 • 2 min to read • Edit Online

Get a link from Excel, starting in the browser

Many people have Excel workbooks stored on their OneDrive for Business drive that would be great for use with
Power BI Desktop. With Power BI Desktop, you can use online links for Excel files stored in OneDrive for
Business to create reports and visuals. You can use a OneDrive for Business group account, or your individual
OneDrive for Business account.

Getting an online link from OneDrive for Business does require a few specific steps. The following sections
explain those steps, which let you share the file link among groups, across different machines, and with your
coworkers.

NOTENOTE

1. Navigate to your OneDrive for Business location using a browser. Right-click the file you want to use, and
select Open in Excel.

Your browser interface might not look exactly like the following image. There are many ways to select Open in Excel
for files in your OneDrive for Business browser interface. You can use any option that allows you to open the file in
Excel.

2. In Excel, select File > Info and select the link above the Protect Workbook button. Select Copy link to
clipboard (your version might say Copy path to clipboard).

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-use-onedrive-business-links.md


Use the link in Power BI Desktop
In Power BI Desktop, you can use the link you just copied to the clipboard. Take the following steps:

1. In Power BI Desktop, select Get Data > Web.

2. Paste the link into the From Web dialog (do not select OK yet).



NOTENOTE

3. Notice the ?web=1 string at the end of the link - you must remove that portion of the Web URL string before
selecting OK, in order for Power BI Desktop to properly navigate to your file.

4. If Power BI Desktop prompts you for credentials, choose either Windows (for on-premises SharePoint
sites) or Organizational Account (for Office 365 or OneDrive for Business sites).

A Navigator window appears, allowing you to select from the list of tables, sheets, and ranges found in the Excel
workbook. From there, you can use the OneDrive for Business file just like any other Excel file, and create reports
and use it in datasets like you would with any other data source.

To use OneDrive for Business file as a data source in the Power BI service, with Service Refresh enabled for that file, make
sure you select OAuth2 as the Authentication method when configuring your refresh settings. Otherwise you may
encounter an error (such as Failed to update data source credentials) when you attempt to connect or to refresh. Selecting
OAuth2 as the authentication method remedies that credentials error.
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DATA SOURCE PROVIDER

MINIMUM
PROVIDER
VERSION

MINIMUM DATA
SOURCE VERSION

SUPPORTED DATA
SOURCE OBJECTS DOWNLOAD LINK

SQL Server ADO.net (built
into .Net
Framework)

.Net Framework
3.5 (only)

SQL Server
2005+

Tables/Views,
Scalar functions,
Table functions

Included in .NET
Framework 3.5 or
above

Access Microsoft Access
Database Engine
(ACE)

ACE 2010 SP1 No restriction Tables/Views Download link

Excel (.xls files
only) (see note 1)

Microsoft Access
Database Engine
(ACE)

ACE 2010 SP1 No restriction Tables, Sheets Download link

Oracle (see note
2)

ODP.NET ODAC 11.2
Release 5
(11.2.0.3.20)

9.x+ Tables/Views Download link

System.Data.Orac
leClient (Built in
.Net Framework)

.NET Framework
3.5

9.x+ Tables/Views Included in .NET
Framework 3.5 or
above

IBM DB2 ADO.Net client
from IBM (part of
the IBM data
server driver
package)

10.1 9.1+ Tables/Views Download link

MySQL Connector/Net 6.6.5 5.1 Tables/Views,
Scalar functions

Download link

PostgreSQL NPGSQL
ADO.NET
provider

2.0.12 7.4 Tables/Views Download link

Teradata .NET Data
Provider for
Teradata

14+ 12+ Tables/Views Download link

SAP Sybase SQL
Anywhere

iAnywhere.Data.S
QLAnywhere for
.NET 3.5

16+ 16+ Tables/Views Download link

For each data provider, Power BI supports a specific provider version on objects. For more information about data
sources available to Power BI, see Data Sources. The following table describes these requirements.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-data-source-prerequisites.md
http://go.microsoft.com/fwlink/?linkid=285987&clcid=0x409
http://go.microsoft.com/fwlink/?linkid=285987&clcid=0x409
http://go.microsoft.com/fwlink/?linkid=272376&clcid=0x409
http://go.microsoft.com/fwlink/?linkid=274911&clcid=0x409
http://go.microsoft.com/fwlink/?linkid=278885&clcid=0x409
http://go.microsoft.com/fwlink/?linkid=282716&clcid=0x409
http://go.microsoft.com/fwlink/?linkid=278886&clcid=0x409
http://go.microsoft.com/fwlink/?linkid=324846


NOTENOTE

NOTENOTE

Excel files that have an .xlsx extension do not require a separate provider installation.

The Oracle providers also require Oracle client software (version 8.1.7+).
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Enabling bidirectional cross-filtering for DirectQueryEnabling bidirectional cross-filtering for DirectQuery

When filtering tables to create the appropriate view of data, report creators (and data modelers) face challenges
when determining how filtering is applied to a report; the filter context of a table was held on one side of the
relationship, but not the other, often requiring complex DAX formulas to get the desired results.

With bidirectional cross-filtering, report creators (and data modelers) now have more control over how filters are
applied when working with related tables, enabling those filters to be applied on both sides of a table relationship.
This is accomplished by having the filter context propagated to a second related table on the other side of a table
relationship.

A detailed whitepaper is available that explains bidirectional cross-filtering in Power BI Desktop (the whitepaper
also covers SQL Server Analysis Services 2016, both have the same behavior).

Download the Bidirectional cross-filtering for Power BI Desktop whitepaper

To enable cross-filtering, in the Edit Relationship dialog for a relationship, the following must be selected:

The Cross filter direction must be set to Both
The Apply security filter in both directions must also be selected

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-bidirectional-filtering.md
http://download.microsoft.com/download/2/7/8/2782DF95-3E0D-40CD-BFC8-749A2882E109/Bidirectional cross-filtering in Analysis Services 2016 and Power BI.docx
http://download.microsoft.com/download/2/7/8/2782DF95-3E0D-40CD-BFC8-749A2882E109/Bidirectional cross-filtering in Analysis Services 2016 and Power BI.docx


NOTENOTE
When creating cross filtering DAX formulas in Power BI Desktop, use UserPrincipalName (which is often the same as a user's
login, such as joe@contoso.com) instead of UserName. As such, you may need to create a related table that maps
UserName (or EmployeeID, for example) to UserPrincipleName.

For more information, and for examples of how bidirectional cross-filtering works, check out the whitepaper
mentioned earlier in this article.

http://download.microsoft.com/download/2/7/8/2782DF95-3E0D-40CD-BFC8-749A2882E109/Bidirectional cross-filtering in Analysis Services 2016 and Power BI.docx
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In Power BI Desktop, privacy levels specify an isolation level that defines the degree that one data source will be
isolated from other data sources. Although a restrictive isolation level blocks information from being exchanged
between data sources, it may reduce functionality and impact performance.

The Privacy Levels setting, found in File > Options and settings > Options and then Current File > Privacy
determines whether Power BI Desktop uses your Privacy Level settings while combining data. This dialog includes
a link to Power BI Desktop documentation about Privacy Levels and Privacy Levels (this article).

The Privacy settings dialog for each data source is found File > Options and settings > Data source settings.
Select the data source, then select Edit. The Data Source Settings dialog appears, from which you can select the
appropriate privacy level from the drop-down menu at the bottom of the dialog, as shown in the following image.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-privacy-levels.md


C a u t i o nC a u t i o n

Configure a privacy level

SETTING DESCRIPTION EXAMPLE DATA SOURCES

Private data source A Private data source contains
sensitive or confidential information,
and the visibility of the data source may
be restricted to authorized users. A
private data source is completely
isolated from other data sources.

Facebook data, a text file containing
stock awards, or a workbook containing
employee review information.

Organizational data source An Organizational data source limits
the visibility of a data source to a
trusted group of people. An
Organizational data source is isolated
from all Public data sources, but is
visible to other Organizational data
sources.

A Microsoft Word document on an
intranet SharePoint site with
permissions enabled for a trusted
group.

Public data source A Public data source gives everyone
visibility to the data contained in the
data source. Only files, internet data
sources or workbook data can be
marked Public.

Free data from the Microsoft Azure
Marketplace, data from a Wikipedia
page, or a local file containing data
copied from a public web page

Configure privacy level settings

You should configure a data source containing highly sensitive or confidential data as Private.

With privacy level settings, you can specify an isolation level that defines the degree that one data source must be
isolated from other data sources.



C a u t i o nC a u t i o n

Configure Privacy Levels

SETTING DESCRIPTION

Combine data according to your Privacy Level settings
for each source (on, and the default setting)

Privacy level settings are used to determine the level of
isolation between data sources when combining data.

Ignore the Privacy levels and potentially improve
performance (off)

Privacy levels are not considered when combining data,
however; performance and functionality of the data may
increase.

C a u t i o nC a u t i o n

The Privacy settings dialog for each data source is found File > Options and settings > Data source settings.

To configure a data source privacy level, select the data source, then select Edit. The Data Source Settings dialog
appears, from which you can select the appropriate privacy level from the drop-down menu at the bottom of the
dialog, as shown in the following image.

You should configure a data source containing highly sensitive or confidential data as Private.

Privacy Levels is a setting that is set to Combine data according to your Privacy Level settings for each
source by default, which means that Privacy Levels is not enabled.

Security Note: Enabling Privacy Levels by selecting Ignore the Privacy levels and potentially improve
performance in the Privacy Levels dialog could expose sensitive or confidential data to an unauthorized
person. Do not enable Privacy Levels unless you are confident that the data source does not contain sensitive
or confidential data.

The Ignore the Privacy levels and potentially improve performance does not work in the Power BI service. As
such, Power BI Desktop reports with this setting enabled, which are then published to the Power BI service, do not



reflect this behavior when used in the service.

Configure Privacy Levels

In Power BI Desktop or in Query Editor, select File > Options and settings > Options and then Current File >
Privacy.

a. When Combine data according to your Privacy Level settings for each source is selected, data will be
combined according to your Privacy Levels setting. Merging data across Privacy isolation zones will result in some
data buffering.

b. When Ignore the Privacy levels and potentially improve performance is selected, the data will be
combined ignoring your Privacy Levels which could reveal sensitive or confidential data to an unauthorized user.
The setting may improve performance and functionality.

Security Note: Selecting Ignore the Privacy levels and potentially improve performance may improve
performance; however, Power BI Desktop cannot ensure the privacy of data merged into the Power BI Desktop
file.
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The Facebook connector in Power BI Desktop relies on the Facebook Graph API. As such, features and availability
may vary over time.

You can see a tutorial about the Facebook Connector for Power BI Desktop.

Facebook expired v1.0 of its Graph API on April 30  2015. Power BI uses the Graph API behind the scenes for the
Facebook connector, allowing you to connect to your data and analyze it.

th

Queries that were built before April 30  2015 may no longer work or return less data. Subsequent to April 30
2015, Power BI leverages v2.2 in all calls to the Facebook API. If your query was built prior to April 30, 2015 and
you have not used it since, you’ll likely need to authenticate again, to approve the new set of permissions that we’ll
ask for.

th th

Although we attempt to release updates in accordance with any changes, the API may change in a way that affects
the results of the queries we generate. In some cases, certain queries may no longer be supported. Due to this
dependency we cannot guarantee the results of your queries when using this connector.

More details on the change in the Facebook API are available here.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-facebook-connector.md
https://developers.facebook.com/docs/apps/changelog#v2_0
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NOTENOTE
The Google Analytics content pack and the connector in Power BI Desktop rely on the Google Analytics Core Reporting API.
As such, features and availability may vary over time.

You can connect to Google Analytics data using the Google Analytics connector. To connect, follow these steps:

1. In Power BI Desktop, select Get Data from the Home ribbon tab.
2. In the Get Data window, select Other from the categories in the left pane.
3. Select Google Analytics from the selections in the right pane.
4. At the bottom of the window, select Connect.

You're prompted with a dialog that explains that the connector is a Third-Party Service, and warns about how
features and availability may change over time, and other clarifications.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-google-analytics-connector.md


When you select Continue, you're prompted to sign in to Google Analytics.

When you enter your credentials, you're prompted that Power BI would like to have offline access. This is how you
use Power BI Desktop to access your Google Analytics data.

Once you accept, Power BI Desktop shows that you're currently signed in.

Select Connect, and your Google Analytics data is connected to Power BI Desktop, and loads the data.



Changes to the API
Although we attempt to release updates in accordance with any changes, the API may change in a way that affects
the results of the queries we generate. In some cases, certain queries may no longer be supported. Due to this
dependency we cannot guarantee the results of your queries when using this connector.

More details on changes to the Google Analytics API can be found in their changelog.

https://developers.google.com/analytics/devguides/changelog
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Step 1: Download Power BI DesktopStep 1: Download Power BI Desktop

Step 2: Connect to Project Online with ODataStep 2: Connect to Project Online with OData

You can connect to data in Project Online through Power BI Desktop.

1. Download Power BI Desktop, then run the installer to get Power BI Desktop on your computer.

1. Open Power BI Desktop.
2. On the Welcome screen, select Get Data.
3. Choose OData feed  and select Connect.
4. Enter the address for your OData feed in the URL box, and then click OK.

If the address for your Project Web App site resembles https://<tenantname>.sharepoint.com/sites/pwa, the
address you’ll enter for your OData Feed is
https://<tenantname>.sharepoint.com/sites/pwa/_api/Projectdata.

For our example, we’re using https://contoso.sharepoint.com/sites/pwa/default.aspx

5. Power BI Desktop will prompt you to authenticate with your Office 365 account. Select Organizational
account and then enter your credentials.

From here, you can choose which tables you would like to connect to and build a query. Want an idea of how to get
started? The following blog post shows how to build a burndown chart from your Project Online data. The blog
post refers to using Power Query to connect to Project Online, but this applies to Power BI Desktop as well.

Creating burndown charts for Project using Power Pivot and Power Query

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-project-online-connect-to-data.md
http://go.microsoft.com/fwlink/?LinkID=521662
https://contoso.sharepoint.com/sites/pwa/default.aspx
http://blogs.office.com/2014/03/24/creating-burndown-charts-for-project-using-power-pivot-and-power-query/
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The Query Editor

With Power BI Desktop you can connect to the world of data, create compelling and foundational reports, and
share your efforts with others – who can then build on your work, and expand their business intelligence efforts.

Power BI Desktop has three views:

Report view – where you use queries you create to build compelling visualizations, arranged as you want
them to appear, and with multiple pages, that you can share with others
Data view – see the data in your report in data model format, where you can add measures, create new
columns, and manage relationships
Relationships view – get a graphical representation of the relationships that have been established in your
data model, and manage or modify them as needed.

These views are accessed by selecting one of the three icons along the left side of Power BI Desktop. In the
following image, Report view is selected, indicated by the yellow band beside the icon.

Power BI Desktop also comes with Query Editor, where you can connect to one or many data sources, shape and
transform the data to meet your needs, then load that model into Power BI Desktop.

This document provides an overview of the work with data in the Query Editor. There's more to learn, of course,
so at the end of this document you’ll find links to detailed guidance about supported data types, connecting to
data, shaping data, creating relationships, and how to get started.

But first, let’s see get acquainted with Query Editor.

To get to Query Editor, select Edit Queries from the Home tab of Power BI Desktop.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-query-overview.md


With no data connections, Query Editor appears as a blank pane, ready for data.

Once a query is loaded, Query Editor view becomes more interesting. If we connect to the following Web data
source, Query Editor loads information about the data, which you can then begin to shape.

http://www.bankrate.com/finance/retirement/best-places-retire-how-state-ranks.aspx

Here’s how Query Editor appears once a data connection is established:

1. In the ribbon, many buttons are now active to interact with the data in the query
2. In the left pane, queries are listed and available for selection, viewing, and shaping
3. In the center pane, data from the selected query is displayed and available for shaping
4. The Query Settings window appears, listing the query’s properties and applied steps

http://www.bankrate.com/finance/retirement/best-places-retire-how-state-ranks.aspx


The query ribbon

We’ll look at each of these four areas – the ribbon, the queries pane, the data view, and the Query Settings pane –
in the following sections.

The ribbon in Query Editor consists of four tabs – Home, Transform, Add Column, and View.

The Home tab contains the common query tasks, including the first step in any query, which is Get Data. The
following image shows the Home ribbon.

To connect to data and begin the query building process, select the Get Data button. A menu appears, providing
the most common data sources.



For more information about available data sources, see Data Sources. For information about connecting to data,
including examples and steps, see Connect to Data.

The Transform tab provides access to common data transformation tasks, such as adding or removing columns,
changing data types, splitting columns, and other data-driven tasks. The following image shows the Transform
tab.

For more information about transforming data, including examples, see Combine and Shape Data.

The Add Column tab provides additional tasks associated with adding a column, formatting column data, and
adding custom columns. The following image shows the Add Column tab.

The View tab on the ribbon is used to toggle whether certain panes or windows are displayed. It’s also used to
display the Advanced Editor. The following image shows the View tab.

It’s useful to know that many of the tasks available from the ribbon are also available by right-clicking a column,



The left pane

The center (data) pane

or other data, in the center pane.

The left pane displays the number of active queries, as well as the name of the query. When you select a query
from the left pane, its data is displayed in the center pane, where you can shape and transform the data to meet
your needs. The following image shows the left pane with multiple queries.

In the center pane, or Data pane, date from the selected query is displayed. This is where much of the work of the
Query view is accomplished.

In the following image, the Web data connection established earlier is displayed, the Overall score column is
selected, and its header is right-clicked to show the available menu items. Notice that many of these right-click
menu items are the same as buttons in the ribbon tabs.



The query settings pane

When you select a right-click menu item (or a ribbon button), Query applies the step to the data, and saves it as
part of the query itself. The steps are recorded in the Query Settings pane in sequential order, as described in the
next section.

The Query Settings pane is where all steps associated with a query are displayed. For example, in the following
image, the Applied Steps section of the Query Settings pane reflects the fact that we just changed the type of
the Overall score column.



As additional shaping steps are applied to the query, they are captured in the Applied Steps section.

It’s important to know that the underlying data is not changed; rather, Query Editor adjusts and shapes its view of
the data, and any interaction with the underlying data occurs based on Query Editor’s shaped and modified view
of that data.

In the Query Settings pane, you can rename steps, delete steps, or reorder the steps as you see fit. To do so,
right-click the step in the Applied Steps section, and choose from the menu that appears. All query steps are
carried out in the order they appear in the Applied Steps pane.



The Advanced Editor

Saving your work

If you want to see the code that Query Editor is creating with each step, or want to create your own shaping code,
you can use the Advanced Editor. To launch the advanced editor, select View from the ribbon, then select
Advanced Editor. A window appears, showing the existing query code.

You can directly edit the code in the Advanced Editor window. To close the window, select the Done or Cancel
button.

When your query is where you want it, you can have Query Editor apply the changes to the data model into
Power BI Desktop, and close Query Editor. To do that, select Close & Apply from Query Editor's File menu.



As progress is made, Power BI Desktop provides a dialog to display its status.

Once you have your query where you want it, or if you just want to make sure your work is saved, Power BI
Desktop can save your work in the form of a .pbix file.

To save your work, select File > Save (or File > Save As), as shown in the following image.



Next steps
There are all sorts of things you can do with Power BI Desktop. For more information on its capabilities, check out
the following resources:

Getting Started with Power BI Desktop
Data Sources in Power BI Desktop
Connect to Data in Power BI Desktop
Shape and Combine Data with Power BI Desktop
Common Query Tasks in Power BI Desktop
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Shape and combine data in Power BI Desktop

Shape data

-- title: Shape and combine data in Power BI Desktop description: Shape and combine data in Power BI
Desktop services: powerbi documentationcenter: '' author: davidiseminger manager: kfile backup: '' editor: ''
tags: '' qualityfocus: no qualitydate: ''

ms.service: powerbi ms.devlang: NA ms.topic: article ms.tgt_pltfrm: NA ms.workload: powerbi ms.date:
01/30/2018 ms.author: davidi

With Power BI Desktop, you can connect to many different types of data sources, then shape the data to
meet your needs. Shaping data means transforming the data – such as renaming columns or tables, changing
text to numbers, removing rows, setting the first row as headers, and so on. Combining data means
connecting to two or more data sources, shaping them as needed, then consolidating them into one useful
query.

This document demonstrates how to shape a query using Power BI Desktop, highlighting some of the most
common tasks. The query used here is described in more detail, including how to create the query from
scratch, in Getting Started with Power BI Desktop.

It’s useful to know that the Query Editor in Power BI Desktop makes ample use of right-click menus, as well
as the ribbon. Most of what you can select in the Transform ribbon is also available by right-clicking an item
(such as a column) and choosing from the menu that appears.

When you shape data in the Query Editor, you’re providing step-by-step instructions (that Query Editor
carries out for you) to adjust the data as Query Editor loads and presents it. The original data source is not
affected; only this particular view of the data is adjusted, or shaped.

The steps you specify (such as rename a table, transform a data type, or delete columns) are recorded by
Query Editor, and each time this query connects to the data source those steps are carried out so that the data
is always shaped the way you specify. This process occurs whenever you use the Query Editor feature of
Power BI Desktop, or for anyone who uses your shared query, such as on the Power BI service. Those steps
are captured, sequentially, in the Query Settings pane under Applied Steps.

The following image shows the Query Settings pane for a query that has been shaped – we’ll go through
each of those steps in the next few paragraphs.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-shape-and-combine-data.md


Using the retirement data from Getting Started with Power BI Desktop, which we found by connecting to a
Web data source, let’s shape that data to fit our needs.

For starters, one column's scores were not automatically transformed from text to numbers when Query
Editor loaded the table, and we need them to be numbers. No problem – just right-click the column header,
and select Change Type > Whole Number to change them. To choose more than one column, first select a
column then hold down SHIFT, select additional adjacent columns, and then right-click a column header to
change all selected columns. You can also use the CTRL key to choose non-adjacent columns.

https://powerbi.uservoice.com/knowledgebase/articles/471664


You can also transform those columns from text to header from the Transform ribbon. Here’s the Transform
ribbon, with an arrow pointing toward the Data Type button, which lets you transform the current data type
to another.

Note that in Query Settings, the Applied Steps reflect any shaping steps applied to the data. If I want to
remove any step from the shaping process, I simply select the X to the left of the step. In the following image,
Applied Steps reflects the steps so far: connecting to the website (Source); selecting the table (Navigation);
and while loading the table, Query Editor automatically changed text-based number columns from Text to
Whole Number (Changed Type). One column of rankings was not automatically changed to a number-based
type, and we'll find out why in the next few paragraphs.

Before we can work with this query, we need to make a few changes to get its data where we want it:

Remove the first column – we don’t need it, it just includes redundant rows that say “Check out how your
state ranks for retirement” which is an artifact of this data source being a Web-based table
Fix a few Errors – one of the columns, Health care quality, contains a few ties in states' rankings, which
was noted on the website by having the text (tie) after their numbers. That works well on the website, but it
requires that we transform the column from text to data manually. It's easy to fix this using Power BI
Desktop, and doing so demonstrates a cool feature of Applied Steps in Query
Change the Table Name – that Table 0 is not a useful descriptor, but changing it simple

To remove the first column, simply select the column and choose the Home tab from the ribbon, then
Remove Columns as shown in the following figure.



Next we need to address the text column, and transform it into numbers. At first it seems straightforward, that
we can just change the type of the Health care quality column from text to number (such as Whole Number,
or Decimal Number). But when we change the type from Text to Whole Number, then look through the
values in that column, we find that Query Editor reports a few errors.

There are a few ways to get more information about each error. You can select the cell (without clicking on the
word Error), or click the word Error directly. If you select the cell without clicking directly on the word Error,
Query Editor displays the error information on the bottom of the window.



If you click the word Error directly, Query creates an Applied Step in the Query Settings pane and displays
information about the error.

To get back to the Query Editor, you have to remove that step by selecting the X next to it.

When we select the most recent Applied Step, we see the error just described, as shown in the following
image.



Since Query Editor records steps sequentially, we can select the step prior to changing the type, in Applied
Steps, and see what the value of that cell is prior to the transformation, as shown in the following image.

Okay, now we can fix those values, and then change the type. Since Query Editor records the steps
sequentially, yet independently of each other, you can move each Applied Step up or down in the sequence.
Just right-click any step, and Query Editor provides a menu that lets you do the following: Rename, Delete,
Delete Until End (remove the current step, and all subsequent steps too), Move Up, or Move Down.



In addition, you can select an Applied Step anywhere in the list, and continue shaping the data at that point
in the sequence. Query Editor will automatically insert a new step directly after the currently selected Applied
Step. Let's give that a try.

First, we select the Applied Step prior to changing the type of the Health care quality column. Then we
replace the values that have the text "(tie)" in the cell so that only the number remains. Right-click the cell that
contains "35 (tie)" and select Replace Values... from the menu that appears. Note which Applied Step is
currently selected (the step prior to changing the type).

Since we're inserting a step, Query Editor warns us about the danger of doing so - subsequent steps could
cause the query to break. We need to be careful, and thoughtful! Since this is a tutorial, and we're highlighting
a really cool feature of Query Editor to demonstrate how you can create, delete, insert, and reorder steps, we'll
push ahead and select Insert.



NOTENOTE

There are three ties, so we replace the values for each. When you create a new Applied Step, Query Editor
names it based on the action - in this case, Replaced Value. When you have more than one step with the
same name in your query, Query Editor adds a number (in sequence) to each subsequent Applied Step to
differentiate between them.

The following screen shows the three Replaced Value steps in Query Settings, but it also shows something
else that's even more interesting: since we removed each instance of the text "(tie)" from the Health care
quality column, the Changed Type step now completes with no errors.

You can also Remove Errors (using the ribbon or the right-click menu), which removes any rows that have errors. In
this case it would’ve removed all the states that had "(tie)" from our data, and we didn’t want to do that – we like all
the states, and want to keep them in the table.

Okay that was a little involved, but it was a good example of how powerful and versatile Query Editor can be.

Lastly, we want to change the name of that table to something descriptive. When we get to creating reports,
it’s especially useful to have descriptive table names, especially when we connect to multiple data sources,
and they’re all listed in the Fields pane of the Report view.

Changing the table name is easy: in the Query Settings pane, under Properties, simply type in the new
name of the table, as shown in the following image, and hit Enter. Let’s call this table RetirementStats.



Combine data

Okay, we’ve shaped that data to the extent we need to. Next let’s connect to another data source, and combine
data.

That data about various states is interesting, and will be useful for building additional analysis efforts and
queries. But there’s one problem: most data out there uses a two-letter abbreviation for state codes, not the
full name of the state. We need some way to associate state names with their abbreviations.

We’re in luck: there’s another public data source that does just that, but it needs a fair amount of shaping
before we can connect it to our retirement table. Here’s the Web resource for state abbreviations:

http://en.wikipedia.org/wiki/List_of_U.S._state_abbreviations

From the Home ribbon in Query Editor, we select New Source > Web and type the address, select OK, and
the Navigator shows what it found on that Web page.

http://en.wikipedia.org/wiki/List_of_U.S._state_abbreviations


TIPTIP

We select Table[edit] because that includes the data we want, but it’s going to take quite a bit of shaping to
pare that table’s data down to what we want.

Is there a faster or easier way to accomplish the steps below? Yes, we could create a relationship between the two
tables, and shape the data based on that relationship. The following steps are still good to learn for working with
tables, just know that relationships can help you quickly use data from multiple tables.

To get this data into shape, we take the following steps:

Remove the top two rows – they’re a result of the way that Web page’s table was created, and we don’t
need them. From the Home ribbon, select Reduce Rows > Remove Rows > Remove Top Rows.



The Remove Top Rows window appears, letting you specify how many rows you want to remove.

Remove the bottom 26 rows – they’re all the territories, which we don’t need to include. From the Home
ribbon, select Reduce Rows > Remove Rows > Remove Bottom Rows.

Since the RetirementStats table doesn't have information for Washington DC, we need to filter it from our
list. Select the drop-down arrow beside the Region Status column, then clear the checkbox beside Federal
district.



Remove a few unneeded columns – we only need the mapping of state to its official two-letter
abbreviation, so we can remove the following columns: Column2, Column3, and then Column5 through
Column10. First select Column2, then hold down the CTRL key and select the other columns to be
removed (this lets you select multiple, non-contiguous columns). From the Home tab on the ribbon, select
Remove Columns > Remove Columns.

Use the first row as headers – since we removed the top three rows, the current top row is the header we
want. You can select Use First Row As Headers from the Home tab, or from the Transform tab in the
ribbon.



NOTENOTE

NOTENOTE

This is a good time to point out that the sequence of applied steps in Query Editor is important, and can affect how the
data is shaped. It’s also important to consider how one step may impact another subsequent step; if you remove a step
from the Applied Steps, subsequent steps may not behave as originally intended, because of the impact of the query’s
sequence of steps.

When you resize the Query Editor window to make the width smaller, some ribbon items are condensed to make the
best use of visible space. When you increase the width of the Query Editor window, the ribbon items expand to make
the most use of the increased ribbon area.

Rename the columns, and the table itself – as usual, there are a few ways to rename a column; first select
the column, then either select Rename from the Transform tab on the ribbon, or right-click and select
Rename… from the menu that appears. The following image has arrows pointing to both options; you
only need to choose one.



Let’s rename them to State Name and State Code. To rename the table, just type the name into the Name box
in the Query Settings pane. Let’s call this table StateCodes.

Now that we’ve shaped the StateCodes table the way we want, let’s combine these two tables, or queries, into
one; since the tables we now have are a result of the queries we applied to the data, they’re often referred to
as queries.

There are two primary ways of combining queries – merging and appending.

When you have one or more columns that you’d like to add to another query, you merge the queries. When
you have additional rows of data that you’d like to add to an existing query, you append the query.

In this case we want to merge queries. To get started, from the left pane of Query Editor we select the query
into which we want the other query to merge, which in this case is RetirementStats. Then select Combine >
Merge Queries from the Home tab on the ribbon.



You may be prompted to set the privacy levels, to ensure the data is combined without including or
transferring data you didn't want transferred.

Next the Merge window appears, prompting us to select which table we’d like merged into the selected table,
and then, the matching columns to use for the merge. Select State from the RetirementStats table (query),
then select the StateCodes query (easy in this case, since there’s only one other query – when you connect to
many data sources, there are many queries to choose from). When we select the correct matching columns –
State from RetirementStats, and State Name from StateCodes – the Merge window looks like the following,
and the OK button is enabled.



A NewColumn is created at the end of the query, which is the contents of the table (query) that was merged
with the existing query. All columns from the merged query are condensed into the NewColumn, but you
can select to Expand the table, and include whichever columns you want.

To Expand the merged table, and select which columns to include, select the expand icon ( ). The Expand
window appears.



NOTENOTE

In this case, we only want the State Code column, so we select only that column and then select OK. We clear
the checkbox from Use original column name as prefix because we don’t need or want that; if we leave that
selected, the merged column would be named NewColumn.State Code (the original column name, or
NewColumn, then a dot, then the name of the column being brought into the query).

Want to play around with how to bring in that NewColumn table? You can experiment a bit, and if you don’t like the
results, just delete that step from the Applied Steps list in the Query Settings pane; your query returns to the state
prior to applying that Expand step. It’s like a free do-over, which you can do as many times as you like until the
expand process looks the way you want it.

We now have a single query (table) that combined two data sources, each of which has been shaped to meet
our needs. This query can serve as a basis for lots of additional, interesting data connections – such as
housing cost statistics, demographics, or job opportunities in any state.

To apply changes and close Query Editor, select Close & Apply from the Home ribbon tab. The transformed
dataset appears in Power BI Desktop, ready to be used for creating reports.



Next steps
There are all sorts of things you can do with Power BI Desktop. For more information on its capabilities, check
out the following resources:

Getting Started with Power BI Desktop
Query Overview with Power BI Desktop
Data Sources in Power BI Desktop
Connect to Data in Power BI Desktop
Common Query Tasks in Power BI Desktop



Common query tasks in Power BI Desktop
1/30/2018 • 8 min to read • Edit Online

Connect to data

When working in the Query Editor window of Power BI Desktop, there are a handful of commonly used tasks.
This document demonstrates those common tasks, and provides links for additional information.

The common query tasks demonstrated here are the following:

Connect to data
Shape and combine data
Group rows
Pivot columns
Create custom columns
Query formulas

We’ll use a few data connections to complete these tasks. The data is available for you to download or connect
to, in case you want to step through these tasks yourself.

The first data connection is an Excel workbook. The other is a Web resource (which is also used in other Power BI
Desktop help content) which can be accessed from here:

http://www.bankrate.com/finance/retirement/best-places-retire-how-state-ranks.aspx

The steps necessary to connect to both of those data sources is where the common Query tasks begin.

To connect to data in Power BI Desktop, select the Get Data button from the Home tab on the ribbon. Power BI
Desktop presents a menu with the most common data sources. For a complete list of data sources to which
Power BI Desktop can connect, select the More... button at the bottom of the menu. For more information, see
Data Sources in Power BI Desktop.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-common-query-tasks.md
http://www.bankrate.com/finance/retirement/best-places-retire-how-state-ranks.aspx
https://powerbi.uservoice.com/knowledgebase/articles/471643


To start with, select Excel and navigate to the workbook, then select it. Query inspects the workbook, then
presents the data it found in the Navigator window.



You can select Edit to adjust, or shape, the data before loading it into Power BI Desktop. Editing a query before
loading is especially useful when working with large data sets that you intend to pare down before loading. We
want to do that, so we select Edit.

Connecting to different types of data is just as easy. We also want to connect to a Web resource. Select Get Data
> More... and then select Other > Web.

The From Web window appears, where you can type in the URL of the Web page.

Select OK, and like before, Power BI Desktop inspects the workbook and presents the data it finds in the
Navigator window.

Other data connections are similar. If authentication is required to make a data connection, Power BI Desktop
prompts you for the appropriate credentials.

For a step-by-step demonstration of connecting to data in Power BI Desktop, see Connect to Data in Power BI

https://powerbi.uservoice.com/knowledgebase/articles/471635


Shape and combine data

Desktop.

You can easily shape and combine data with Query Editor. This section includes a few examples of how you can
shape data. For a more complete demonstration of shaping and combining data, see Shape and Combine Data
with Power BI Desktop.

In the previous section we connected to two sets of data – an Excel workbook, and a Web resource. Once loaded
in Query Editor we see the following, with the query from the Web page selected (from the available queries
listed in the Queries pane, on the left side of the Query Editor window).

When you shape data, you transform a data source into the form and format that meets your needs. In this case,
we don’t need that first column, titled Header, so we’ll remove it.

In Query Editor, many commands can be found in the ribbon, and in a context-sensitive right-click menu. For
example, when I right-click on the Header column, the menu that appears lets me remove the column. I could
also select the column and then select the Remove Columns button from the ribbon.

https://powerbi.uservoice.com/knowledgebase/articles/471644


Group rows

There are many other ways I could shape the data in this query; I could remove any number of rows from the
top, or from the bottom; I could add columns, split columns, replace values, and perform other shaping tasks to
direct Query Editor to get the data how I want it.

In Query Editor, you can group the values in multiple rows into a single value. This can be useful when
summarizing the number of products offered, the total sales, or the count of students.

In this example, we group rows in an education enrollment data set. The data is from an Excel workbook, and has
been shaped in Query Editor to get just the columns we need, renamed the table, and performed a few other
transforms.

Let’s find out how many Agencies (this includes school districts, and other education agencies such as regional
service districts, and so on) each state has. We select the State Abbr column then select the Group By button in
the Transform tab or the Home tab of the ribbon (Group By is available in both tabs).



The Group By… window appears. When Query Editor groups rows, it creates a new column into which it places
the Group By results. You can adjust the Group By operation in the following ways:

1. Group by – this is the column to be grouped; Query Editor chooses the selected column, but you can change
that in this window to any column in the table.

2. New column name – Query Editor suggests a name for the new column, based on the operation it applies to
the column being grouped, but you can name the new column anything you want.

3. Operation – here you specify the operation that Query Editor applies.
4. The +/- signs – you can perform aggregation operations (Group By actions) on multiple columns, and

perform multiple aggregations, all within the Group By window, and all in one operation. Query Editor
creates a new column (based on your selections in this window) that operate on multiple columns. Select
the + button to add more columns or aggregations to a Group By operation. You can remove a column
or aggregation by selecting the – icon, so go ahead and try it, and see what it looks like.

When we select OK, Query performs the Group By operation, and returns the results. Whew, look at that – Ohio,
Texas, Illinois, and California each have over a thousand agencies!



Pivot columns

And with Query Editor, you can always remove the last shaping operation by selecting the X next to the step just
completed. So go ahead and experiment, redo the step if you don’t like the results, until Query Editor shapes
your data just the way you want it.

With Power BI Desktop, you can pivot columns, and create a table that contains aggregated values for each
unique value in a column. For example, if you need to know how many different products you have in each
product category, you can quickly create a table the does precisely that.

Let’s look at an example. The following Products table has been shaped to only show each unique product (by
name), and which category each product falls under. To create a new table that shows a count of products for
each category (based on the CategoryName column), select the column, then select Pivot Column from the
Transform tab on the ribbon.



The Pivot Column window appears, letting you know which column’s values will be used to create new
columns (1), and when you expand Advanced option (2), you can select the function that will be applied to the
aggregated values (3).

When you select OK, Query displays the table according to the transform instructions provided in the Pivot
Column window.



Create custom columns
In Query Editor you can create custom formulas that operate on multiple columns in your table, then place the
results of such formulas into a new (custom) column. Query Editor makes it easy to create custom columns.

In Query Editor, select Add Custom Column from the Add Column tab on the ribbon.

The following window appears. In the following example, we create a custom column called Percent ELL that
calculates the percentage of total students that are English Language Learners (ELL).



Query formulas

Like any other applied step in Query Editor, if the new custom column doesn’t provide the data you’re looking
for, you can simply delete the step from the Applied Steps section of the Query Settings pane by selecting the
X next to the Added Custom step.

You can edit the steps that Query Editor generates, and you can create custom formulas to get precise control
over connecting to and shaping your data. Whenever Query Editor performs an action on data, the formula
associated with the action is displayed in the Formula Bar. To view the Formula Bar, select the checkbox next to
Formula Bar in the View tab of the ribbon.



Query Editor keeps all applied steps for each query as text that you can view or modify. You can view or modify
the text for any query using the Advanced Editor, which is displayed when you select Advanced Editor from
the View tab of the ribbon.

Here's a look at the Advanced Editor, with the query steps associated with the USA_StudentEnrollment query
displayed. These steps are created in the Power Query Formula Language, often referred to as M. For
information, see Learn about Power Query formulas. To view the language specification itself, download the
Microsoft Power Query for Excel Formula Language Specification.

https://support.office.com/article/Learn-about-Power-Query-formulas-6bc50988-022b-4799-a709-f8aafdee2b2f?ui=en-US&rs=en-US&ad=US
http://go.microsoft.com/fwlink/?linkid=320633


Power BI Desktop provides an extensive set of formula categories. For more information, and a complete
reference of all Query Editor formulas, visit Power Query Formula Categories.

The formula categories for Query Editor are the following:

Number

Text

Logical
Date
Time
DateTime
DateTimeZone
Duration
Record

Constants
Information
Conversion and formatting
Format
Rounding
Operations
Random
Trigonometry
Bytes

Information
Text comparisons
Extraction
Modification
Membership
Transformations

Information
Transformations

https://support.office.com/en-in/article/Power-Query-formula-categories-125024ec-873c-47b9-bdfd-b437f8716819


Next steps

List

Table

Values
Arithmetic operations
Parameter Types
Metadata
Accessing data
URI
Binary formats

Binary
Lines
Expression
Function
Error
Comparer
Splitter
Combiner
Replacer
Type

Selection
Serialization

Information
Selection
Transformation
Membership
Set operations
Ordering
Averages
Addition
Numerics
Generators

Table construction
Conversions
Information
Row operations
Column operations
Membership

Reading numbers

There are all sorts of things you can do with Power BI Desktop. For more information on its capabilities, check
out the following resources:

Getting Started with Power BI Desktop
Query Overview with Power BI Desktop
Data Sources in Power BI Desktop
Connect to Data in Power BI Desktop



Shape and Combine Data with Power BI Desktop



Shape Maps in Power BI Desktop (Preview)
1/17/2018 • 9 min to read • Edit Online

Creating Shape Maps

In Power BI Desktop, you create a Shape Map visual to show relative comparisons of regions on a map by
applying different colors to different regions. In contrast to the Map visual, Shape Map cannot show precise
geographical locations of data points on a map; instead, its main purpose is to show relative comparisons of
regions on a map by coloring them differently.

Shape Map visuals are based on ESRI/TopoJSON maps which have the compelling ability to use custom maps
that you can create, such as geographical, seating arrangements, floor plans, and others. The ability to use custom
maps is not available in this Preview release of Shape Map.

You can test the Shape Map control with the maps that are shipping with this Preview release, or you can use
your own custom map as long as it meets the requirements outlined in the following section called Use Custom
Maps.

The Shape Map visual is in Preview, and must be enabled in Power BI Desktop. To enabled Shape Map, select
File > Options and Settings > Options > Preview Features, then select the Shape Map checkbox. You'll need
to restart Power BI Desktop after you make the selection.

Once Shape Map is enabled, click the Shape Map control from the Visualizations pane.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-shape-map.md


Power BI Desktop creates an empty Shape Map visual design canvas.

Take the following steps to create a Shape Map:

NOTENOTE

1. In the Fields pane, drag a data field that has the region names (or abbreviations) onto the Location bucket,
and a data measure field into the Values bucket (you won't see a map yet).

See the section titled Getting Map Data, below, for information on how to quickly get map data to test Shape
Map.



NOTENOTE

2. In the Format settings pane, expand Shape, and select from the Standard Maps drop-down to show your
data. At this point the rendering appears, as shown in the following image.

In the Region Keys section at the end of this article is a collection of tables that have map regions keys you can use
to test the Shape Map visual.

3. You can then modify the map projection and zooming settings, as well as the colors of data points, from the
Format settings pane. You can also modify zoom settings. For example, you can change colors, set
maximums and minimums, and so on.



Use custom maps

4. You can also add a category data column to the Legend bucket, and classify the map regions based on
categories.

You can use custom maps with Shape Map as long as they are in the TopoJSON format. If your map is in another
format, you can use online tools such as Map Shaper to convert your shapefiles or your GeoJSON maps into the
TopoJSON format.

To use your TopoJSON map file, add a ShapeMap visual to your report and add some data to the Location and
Values buckets. Then, in the Visualizations pane with the Format section selected (the paintbrush icon, shown as
(1) in the following image), expand the Shape section and select + Add Map.

http://mapshaper.org/


Getting map data
To quickly get data into a model so you can test Shape Map, you can copy one of the tables at the end of this
article, then select Enter Data from the Home ribbon.

You can then paste the table into Power BI Desktop. The top row is automatically identified as a header.



NOTENOTE

Preview behavior and requirements

Region keys

You can enter a new column simply by typing a new column name (in the blank column to the right), then add
values in each cell, just like you can do in Excel. When finished, select Load and the table is added to the data
model for Power BI Desktop.

When working with countries or regions, use the three-letter abbreviation to ensure that geocoding works properly in map
visualizations. Do not use two-letter abbreviations, as some countries or regions may not be properly recognized.

If you only have two-letter abbreviations, check out this external blog post for steps on how to associate your two-letter
country/region abbreviations with three-letter country/region abbreviations.

There are a few considerations and requirements for this Preview release of Shape Map:

The Shape Map visual is in Preview, and must be enabled in Power BI Desktop. To enabled Shape Map, select
File > Options and Settings > Options > Preview Features, then select the Shape Map checkbox.
Currently, you must also have the Values bucket set in order for the Legend classification to work properly
The final release version of Shape Map will have a user interface that shows the map keys of the currently
selected map (there is no date set for final release, and Shape Map is still in Preview); in this Preview release,
you can reference the map region keys in the tables found in the following Region Keys section of this article.
The Shape Map visual will plot up to a maximum of 1,000 data points.

Use the following Region Keys in this Preview release to test Shape Map.

https://blog.ailon.org/how-to-display-2-letter-country-data-on-a-power-bi-map-85fc738497d6#.yudauacxp


Australia: StatesAustralia: States

ID ABBR ISO NAME POSTAL

au-wa WA AU-WA Western Australia WA

au-vic Vic AU-VIC Victoria VIC

au-tas Tas AU-TAS Tasmania TAS

au-sa SA AU-SA South Australia SA

au-qld Qld AU-QLD Queensland QLD

au-nt NT AU-NT Northern Territory NT

au-nsw NSW AU-NSW New South Wales NSW

au-act ACT AU-ACT Australian Capital
Territory

ACT

Austria: StatesAustria: States

ID ISO NAME NAME-EN POSTAL

at-wi AT-9 Wien Vienna WI

at-vo AT-8 Vorarlberg Vorarlberg VO

at-tr AT-7 Tirol Tyrol TR

at-st AT-6 Steiermark Styria ST

at-sz AT-5 Salzburg Salzburg SZ

at-oo AT-4 Oberösterreich Upper Austria OO

at-no AT-3 Niederösterreich Lower Austria NO

at-ka AT-2 Kärnten Carinthia KA

at-bu AT-1 Burgenland Burgenland BU

Brazil: StatesBrazil: States

ID

Tocantins

Pernambuco

Goias



Sergipe

Sao Paulo

Santa Catarina

Roraima

Rondonia

Rio Grande do Sul

Rio Grande do Norte

Rio de Janeiro

Piaui

Parana

Paraiba

Para

Minas Gerais

Mato Grosso

Maranhao

Mato Grosso do Sul

Distrito Federal

Ceara

Espirito Santo

Bahia

Amazonas

Amapa

Alagoas

Acre

Litigated Zone 1

ID



Litigated Zone 2

Litigated Zone 3

Litigated Zone 4

ID

Canada: ProvincesCanada: Provinces

ID ISO NAME POSTAL

ca-nu CA-NU Nunavut NU

ca-nt CA-NT Northwest Territories NT

ca-yt CA-YT Yukon YT

ca-sk CA-SK Saskatchewan SK

ca-qc CA-QC Quebec QC

ca-pe CA-PE Prince Edward Island PE

ca-on CA-ON Ontario ON

ca-ns CA-NS Nova Scotia NS

ca-nl CA-NL Newfoundland and Labrador NL

ca-nb CA-NB New Brunswick NB

ca-mb CA-MB Manitoba MB

ca-bc CA-BC British Columbia BC

ca-ab CA-AB Alberta AB

France: RegionsFrance: Regions

ID NAME NAME-EN

Alsace Alsace Alsace

Rhone-Alpes Rhône-Alpes Rhone-Alpes

Provence-Alpes-Cote d'Azur Provence-Alpes-Côte d'Azur Provence-Alpes-Cote d'Azur

Poitou-Charentes Poitou-Charentes Poitou-Charentes

Picardie Picardie Picardy

Pays de la Loire Pays de la Loire Pays de la Loire



Nord-Pas-de-Calais Nord-Pas-de-Calais Nord-Pas-de-Calais

Midi-Pyrenees Midi-Pyrénées Midi-Pyrenees

Lorraine Lorraine Lorraine

Limousin Limousin Limousin

Languedoc-Roussillon Languedoc-Roussillon Languedoc-Roussillon

Ile-del-France Île-de-France Ile-de-France

Haute-Normandie Haute-Normandie Upper Normandy

Franche-Comte Franche-Comté Franche-Comte

Corse Corse Corsica

Champagne-Ardenne Champagne-Ardenne Champagne-Ardenne

Centre-Val de Loire Centre-Val de Loire Centre-Val de Loire

Bretagne Bretagne Brittany

Bourgogne Bourgogne Burgundy

Basse-Normandie Basse-Normandie Lower Normandy

Auvergne Auvergne Auvergne

Aquitaine Aquitaine Aquitaine

ID NAME NAME-EN

Germany: StatesGermany: States

ID ISO NAME NAME-EN POSTAL

de-be DE-BE Berlin Berlin BE

de-th DE-TH Thüringen Thuringia TH

de-st DE-ST Sachsen-Anhalt Saxony-Anhalt ST

de-sn DE-SN Sachsen Saxony SN

de-mv DE-MV Mecklenburg-
Vorpommern

Mecklenburg-
Vorpommern

MV

de-bb DE-BB Brandenburg Brandenburg BB

de-sh DE-SH Schleswig-Holstein Schleswig-Holstein SH



de-sl DE-SL Saarland Saarland SL

de-rp DE-RP Rheinland-Pfalz Rhineland-Palatinate RP

de-nw DE-NW Nordrhein-Westfalen North Rhine-
Westphalia

NW

de-ni DE-NI Niedersachsen Lower Saxony NI

de-he DE-HE Hessen Hesse HE

de-hh DE-HH Hamburg Hamburg HH

de-hb DE-HB Bremen Bremen HB

de-by DE-BY Bayern Bavaria BY

de-bw DE-BW Baden-Württemberg Baden-Wurttemberg BW

ID ISO NAME NAME-EN POSTAL

Ireland: CountiesIreland: Counties

ID

Wicklow

Wexford

Westmeath

Waterford

Sligo

Tipperary

Roscommon

Offaly

Monaghan

Meath

Mayo

Louth

Longford

Limerick



Leitrim

Laoighis

Kilkenny

Kildare

Kerry

Galway

Dublin

Donegal

Cork

Clare

Cavan

Carlow

ID

Italy: RegionsItaly: Regions

ID ISO NAME NAME-EN POSTAL

it-vn IT-34 Veneto Veneto VN

it-vd IT-23 Valle d'Aosta Aosta Valley VD

it-um IT-55 Umbria Umbria UM

it-tt IT-32 Trentino-Alto Adige Trentino-South Tyrol TT

it-tc IT-52 Toscana Tuscany TC

it-sc IT-82 Sicilia Sicily SC

it-sd IT-88 Sardegna Sardinia SD

it-pm IT-21 Piemonte Piedmont PM

it-ml IT-67 Molise Molise ML

it-mh IT-57 Marche Marche MH

it-lm IT-25 Lombardia Lombardy LM



it-lg IT-42 Liguria Liguria LG

it-lz IT-62 Lazio Lazio LZ

it-fv IT-36 Friuli-Venezia Giulia Friuli-Venezia Giulia FV

it-er IT-45 Emilia-Romagna Emilia-Romagna ER

it-cm IT-72 Campania Campania CM

it-lb IT-78 Calabria Calabria LB

it-bc IT-77 Basilicata Basilicata BC

it-pu IT-75 Apulia Puglia PU

it-ab IT-65 Abruzzo Abruzzo AB

ID ISO NAME NAME-EN POSTAL

Mexico: StatesMexico: States

ID ABREVIATURA ISO NAME NAME-EN POSTAL

mx-zac Zac. MX-ZAC Zacatecas Zacatecas ZA

mx-yuc Yuc. MX-YUC Yucatán Yucatan YU

mx-ver Ver. MX-VER Veracruz Veracruz VE

mx-tla Tlax. MX-TLA Tlaxcala Tlaxcala TL

mx-tam Tamps. MX-TAM Tamaulipas Tamaulipas TM

mx-tab Tab. MX-TAB Tabasco Tabasco TB

mx-son Son. MX-SON Sonora Sonora SO

mx-sin Sin. MX-SIN Sinaloa Sinaloa SI

mx-slp S.L.P. MX-SLP San Luis Potosí San Luis Potosi SL

mx-roo Q.R. MX-ROO Quintana Roo Quintana Roo QR

mx-que Qro. MX-QUE Querétaro Queretaro QE

mx-pue Pue. MX-PUE Puebla Puebla PU

mx-oax Oax. MX-OAX Oaxaca Oaxaca OA

mx-nle N.L. MX-NLE Nuevo León Nuevo Leon NL



mx-nay Nay. MX-NAY Nayarit Nayarit NA

mx-mor Mor. MX-MOR Morelos Morelos MR

mx-mic Mich. MX-MIC Michoacán Michoacan MC

mx-mex Méx. MX-MEX Estado de México Mexico State MX

mx-jal Jal. MX-JAL Jalisco Jalisco JA

mx-hid Hgo. MX-HID Hidalgo Hidalgo HI

mx-gro Gro. MX-GRO Guerrero Guerrero GR

mx-gua Gto. MX-GUA Guanajuato Guanajuato GT

mx-dur Dgo. MX-DUR Durango Durango DU

mx-dif Col. MX-DIF Ciudad de
México

Mexico City DF

mx-col Coah. MX-COL Colima Colima CL

mx-coa Chis. MX-COA Coahuila Coahuila CA

mx-chh Chih. MX-CHH Chihuahua Chihuahua CH

mx-chp CDMX. MX-CHP Chiapas Chiapas CP

mx-cam Camp. MX-CAM Campeche Campeche CM

mx-bcs B.C.S. MX-BCS Baja California
Sur

Baja California
Sur

BS

mx-bcn B.C. MX-BCN Baja California Baja California BN

mx-agu Ags. MX-AGU Aguascalientes Aguascalientes AG

ID ABREVIATURA ISO NAME NAME-EN POSTAL

Netherlands: ProvincesNetherlands: Provinces

ID ISO NAME NAME-EN

nl-zh NL-ZH Zuid-Holland South Holland

nl-ze NL-ZE Zeeland Zeeland

nl-ut NL-UT Utrecht Utrecht

nl-ov NL-OV Overijssel Overijssel

nl-nh NL-NH Noord-Holland North Holland



nl-nb NL-NB Noord-Brabant North Brabant

nl-li NL-LI Limburg Limburg

nl-gr NL-GR Groningen Groningen

nl-ge NL-GE Gelderland Gelderland

nl-fr NL-FR Fryslân Friesland

nl-fl NL-FL Flevoland Flevoland

nl-dr NL-DR Drenthe Drenthe

ID ISO NAME NAME-EN

UK: CountriesUK: Countries

ID ISO NAME

gb-wls GB-WLS Wales

gb-sct GB-SCT Scotland

gb-nir GB-NIR Northern Ireland

gb-eng GB-ENG England

USA: StatesUSA: States

ID NAME POSTAL

us-mi Michigan MI

us-ak Alaska AK

us-hi Hawaii HI

us-fl Florida FL

us-la Louisiana LA

us-ar Arkansas AR

us-sc South Carolina SC

us-ga Georgia GA

us-ms Mississippi MS

us-al Alabama AL

us-nm New Mexico NM



us-tx Texas TX

us-tn Tennessee TN

us-nc North Carolina NC

us-ok Oklahoma OK

us-az Arizona AZ

us-mo Missouri MO

us-va Virginia VA

us-ks Kansas KS

us-ky Kentucky KY

us-co Colorado CO

us-md Maryland MD

us-wv West Virginia WV

us-de Delaware DE

us-dc District of Columbia DC

us-il Illinois IL

us-oh Ohio OH

us-ca California CA

us-ut Utah UT

us-nv Nevada NV

us-in Indiana IN

us-nj New Jersey NJ

us-ri Rhode Island RI

us-ct Connecticut CT

us-pa Pennsylvania PA

us-ny New York NY

ID NAME POSTAL



us-ne Nebraska NE

us-ma Massachusetts MA

us-ia Iowa IA

us-nh New Hampshire NH

us-or Oregon OR

us-mn Minnesota MN

us-vt Vermont VT

us-id Idaho ID

us-wi Wisconsin WI

us-wy Wyoming WY

us-sd South Dakota SD

us-nd North Dakota ND

us-me Maine ME

us-mt Montana MT

us-wa Washington WA

ID NAME POSTAL



Combine binaries in Power BI Desktop
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Previous combine binaries behavior

One powerful approach to importing data into Power BI Desktop is to combine multiple files, which have the
same schema, into a single logical table. With the November 2016 release of Power BI Desktop (and subsequent
releases), this convenient and popular approach has been made more convenient and more expansive, as described
in this article.

To start the process of combining binaries from the same folder, select Get Data > File > Folder.

Prior to the November 2016 release of Power BI Desktop, you could combine certain file types with the combine
binaries transform, but there were limitations:

Transformations were not considered for each individual file before the files were combined into a single table.
As such, you often had to combine files, then filter out header values by filtering rows as part of the edit process.
The Combine binaries transform only worked for text or CSV files, and didn't work on other supported file
formats such as Excel workbooks, JSON files, and others.

Customers asked for more intuitive operation of the combine binaries operation, so the transform was enhanced.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-combine-binaries.md


Current combine binaries behavior
Power BI Desktop now handles the combine binaries more effectively. You start by selecting combine binaries,
either from the Home ribbon tab in Query Editor, or from the column itself.

The combine binaries transform now behaves as follows:

The combine binaries transform analyzes each input file, and determines the correct file format to use, such as
text or Excel workbook or JSON file.
The transform allows you to select a specific object from the first file, for example, an Excel workbook, to
extract.

The combine binaries then automatically does the following:

Creates an example query that performs all the required extraction steps in a single file.
Creates a function query that parameterizes the file/binary input to the exemplar query. The exemplar
query and the function query are linked, so that changes to the exemplar query are reflected in the
function query.
Applies the function query to the original query with input binaries (for example, the Folder query) so
it applies the function query for binary inputs on each row, then expands the resulting data extraction
as top-level columns.



Next steps

With the new behavior of combine binaries, you can easily combine all binaries within a given folder as long as
they have the same file type and structure (as in, the same columns).

In addition, you can easily apply additional transformation or extraction steps by modifying the automatically
created exemplar query, without having to worry about modifying or creating additional function query steps; any
changes to the exemplar query are automatically generated in the linked function query.

There are all sorts of data you can connect to using Power BI Desktop. For more information on data sources, check
out the following resources:

Getting Started with Power BI Desktop
Data Sources in Power BI Desktop
Shape and Combine Data with Power BI Desktop
Connect to CSV files in Power BI Desktop
Enter data directly into Power BI Desktop



Data View in Power BI Desktop
12/6/2017 • 1 min to read • Edit Online

Data View helps you inspect, explore, and understand data in your Power BI Desktop model. It's different from
how you view tables, columns, and data in Query Editor. With Data View, you’re looking at your data after it has
been loaded into the model.

When you’re modeling your data, sometimes you want to see what’s actually in a table or column without creating
a visual on the report canvas, often right down to the row level. This is especially true when you’re creating
measures and calculated columns, or you need to identify a data type or data category.

Let’s take a closer look.

1. Data View icon – Click to enter Data View.

2. Data Grid – Shows the selected table and all columns and rows in it. Columns hidden from Report View are
greyed out. You can right-click on a column for options.

3. Modeling ribbon – Manage relationships, create calculations, change data type, format, data category for a
column.

4. Formula bar – Enter DAX formulas for Measures and Calculated columns.

5. Search – Search for a table or column in your model.

6. Fields list – Select a table or column to view in the data grid.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-data-view.md


Relationship View in Power BI Desktop
12/6/2017 • 1 min to read • Edit Online

Relationship View shows all of the tables, columns, and relationships in your model. This can be especially
helpful when your model has complex relationships between many tables.

Let’s take a look.

A. Relationship View icon – Click to show your model in Relationship View

B. Relationship – You can hover your cursor over a relationship to show the columns used. Double-click on a
relationship to open it in the Edit Relationship dialog box.

In the figure above, you can see the Stores table has a StoreKey column that’s related to the Sales table, which also
has a StoreKey column. We see it’s a Many to One (*:1) relationship, and the icon in the middle of the line shows

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-relationship-view.md


the Cross filter direction set to Both. The arrow on the icon shows the direction of the filter context flow.

To learn more about relationships, see Create and manage relationships in Power BI Desktop.



Create and manage relationships in Power BI
Desktop
12/6/2017 • 15 min to read • Edit Online

Autodetect during load

Create a relationship by using Autodetect

Create a relationship manually

When you import multiple tables, chances are you’re going to do some analysis using data from all those tables.
Relationships between those tables are necessary in order to accurately calculate results and display the correct
information in your reports. Power BI Desktop makes creating those relationships easy. In-fact, in most cases you
won’t have to do anything, the Autodetect feature can do it for you. However, in some cases you might have to
create relationships yourself, or you might need to make some changes to a relationship. Either way, it’s important
to understand relationships in Power BI Desktop and how to create and edit them.

If you query two or more tables at the same time, when the data is loaded, Power BI Desktop will attempt to find
and create relationships for you. Cardinality, Cross filter direction, and Active properties are automatically set.
Power BI Desktop looks at column names in the tables you are querying to determine if there are any potential
relationships. If there are, those relationships are created automatically. If Power BI Desktop cannot determine with
a high-level of confidence there is a match, it will not automatically create the relationship. You can still use the
Manage Relationships dialog to create or edit relationships.

On the Home tab, click Manage Relationships > AutoDetect.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-create-and-manage-relationships.md


Edit a relationship

Configure advanced options

Cardinality

1. On the Home tab, click Manage Relationships > New.
2. In the Create Relationship dialog, in the first table drop-down list, select a table, and then select the column

you want to use in the relationship.
3. In the to second table drop-down list, select the other table you want in the relationship, then select the other

column you want to use, and then click OK.

By default, Power BI Desktop will automatically configure the Cardinality (direction), Cross filter direction, and
Active properties for your new relationship; however, you can change these if necessary in Advanced options. To
learn more, see the Understanding advanced options section later in this article.

1. On the Home tab, click Manage Relationships.
2. In the Manage Relationships dialog, select the relationship, then click Edit.

When you create or edit a relationship, you can configure advanced options. By default, advanced options are
automatically configured based on a best guess. This can be different for each relationship based on the data in
the columns.

Many to One (*:1) - This is the most common, default type. This means the column in one table can have more
than one instance of a value, and the other related table, often know as the Lookup table, has only one instance of
a value.

One to One (1:1) - This means the column in one table has only one instance of a particular value, and the other



Cross filter direction

Make this relationship active

Understanding relationships

TIPTIP

related table has only one instance of a particular value.

See the Understanding advanced options section later in this article for more details about when to change
cardinality.

Both - This is the most common, default direction. This means for filtering purposes, both tables are treated as if
they're a single table. This works well with a single table that has a number of lookup tables that surround it. An
example is a Sales actuals table with a lookup table for department. This is often called a Star schema
configuration (a central table with several Lookup tables.) However, if you have two or more tables that also have
lookup tables (with some in common) then you wouldn't want to use the Both setting. To continue the previous
example, in this case, you also have a budget sales table that records target budget for each department. And, the
department table is connected to both the sales and the budget table. Avoid the Both setting for this kind of
configuration.

Single - This means that filtering choices in connected tables work on the table where values are being
aggregated. If you import a Power Pivot in Excel 2013 or earlier data model, all relationships will have a single
direction.

See the Understanding advanced options section later in this article for more details about when to change cross
filter direction.

When checked, this means the relationship serves as the active, default relationship. In cases where there are more
than one relationship between two tables, the active relationship provides a way for Power BI Desktop to
automatically create visualizations that include both tables.

See the Understanding advanced options section later in this article for more details about when to make a
particular relationship active.

Once you have connected two tables together with a relationship, you can work with the data in both tables as if
they were a single table, freeing you from having to worry about relationship details, or flattening those tables into
a single table before importing them. In many situations, Power BI Desktop can automatically create relationships
for you, so creating those relationships yourself might not even be needed. However, if Power BI Desktop can’t
determine with a high-degree of certainty that a relationship between two tables should exist, it will not
automatically create the relationship . In that case, you will need to create the relationship.

Let’s do a little tutorial, to better show you how relationships work in Power BI Desktop.

You can complete this lesson yourself. Copy the ProjectHours table below into an Excel worksheet, select all of the cells, click
INSERT > Table. In the Create Table dialog, just click OK. Then in Table Name, type ProjectHours. Do the same for the
CompanyProject table. You can then import the data by using Get Data in Power BI Desktop. Select your workbook and
tables as a data source.

This first table, ProjectHours, is a record of work tickets that record the number of hours a person has worked on a
particular project.

ProjectHours



TICKET SUBMITTEDBY HOURS PROJECT DATESUBMIT

1001 Brewer, Alan 22 Blue 1/1/2013

1002 Brewer, Alan 26 Red 2/1/2013

1003 Ito, Shu 34 Yellow 12/4/2012

1004 Brewer, Alan 13 Orange 1/2/2012

1005 Bowen, Eli 29 Purple 10/1/2013

1006 Bento, Nuno 35 Green 2/1/2013

1007 Hamilton, David 10 Yellow 10/1/2013

1008 Han, Mu 28 Orange 1/2/2012

1009 Ito, Shu 22 Purple 2/1/2013

1010 Bowen, Eli 28 Green 10/1/2013

1011 Bowen, Eli 9 Blue 10/15/2013

PROJNAME PRIORITY

Blue A

Red B

Green C

Yellow C

Purple B

Orange C

This second table, CompanyProject, is a list of projects with an assigned priority, A, B, or C.

CompanyProject

Notice that each table has a project column. Each are named slightly different, but the values look like they’re the
same. That’s important, and we’ll get back to it in a little bit.

Now that we have our two tables imported into a model, let’s create a report. The first thing we want to get is the
number of hours submitted by project priority, so we select Priority and Hours from Fields.



To create the new relationshipTo create the new relationship

If we look at our table in the Report canvas, you’ll see the number of hours is 256.00 for each project, and it’s also
the total. Clearly this isn’t correct. Why? It’s because we can’t calculate a sum total of values from one table (Hours
in the Project table), sliced by values in another table (Priority in the CompanyProject table) without a relationship
between these two tables.

So, let’s create a relationship between these two tables.

Remember those columns we saw in both tables with a project name, but with values that look alike? We’re going
to use these two columns to create a relationship between our tables.

Why these columns? Well, if we look at the Project column in the ProjectHours table, we see values like Blue, Red,
Yellow, Orange, and so on. In fact, we see several rows that have the same value. In-effect, we have many color
values for Project.

If we look at the ProjName column in the CompanyProject table, we see there’s only one of each of the color
values for project. Each color value in this table is unique, and that’s important, because we can create a
relationship between these two tables. In this case, a many-to-one relationship. In a many-to-one relationship, at
least one column in one of the tables must contain unique values. There are some advanced options for some
relationships, and we’ll look at those later, but for now, let’s create a relationship between the Project columns in
each of our two tables.

1. Click Manage Relationships.
2. In Manage Relationships, click New. This opens the Create Relationship dialog, where we can select the

tables, columns, and any advanced settings we want for our relationship.
3. In the first table, select ProjectHours, then select the Project column. This is the many side of our relationship.
4. In the second table, select CompanyProject, then select the ProjName column. This is the one side of our

relationship.
5. Go ahead and click OK in both the Create Relationship dialog and the Manage Relationships dialog.



In the interest of full disclosure, you really just created this relationship the hard way. You could've just clicked on
the Autodetect button in the Manage Relationships dialog. In-fact, Autodetect would have already done it for you
when you loaded the data if both columns had the same name. But, what’s the challenge in that?

Now, let’s look at the table in our Report canvas again.

Now that looks a whole lot better, doesn’t it?

When we sum up hours by Priority, Power BI Desktop will look for every instance of the unique color values in the
CompanyProject lookup table, and then look for every instance of each of those values in the CompanyProject
table, and calculate a sum total for each unique value.



Understanding advanced options

Future updates to the data require a different cardinality

APPROVED PROJECTS BUDGETALLOCATION ALLOCATIONDATE

Blue 40,000 12/1/2012

Red 100,000 12/1/2012

Green 50,000 12/1/2012

PROJECT PRIORITY

Blue A

Red B

Green C

Yellow C

Purple B

Orange C

That was pretty easy, in-fact, with Autodetect, you might not even have to do this much.

When a relationship is created, either with Autodetect or one you create manually, Power BI Desktop will
automatically configure advanced options based on the data in your tables. You can configure advanced
relationship properties by expanding Advanced options in the Create/Edit relationship dialog.

As we said, these are usually set automatically and you won’t need to mess with them; however, there are several
situations where you might want to configure advanced options yourself.

Normally, Power BI Desktop can automatically determine the best cardinality for the relationship. If you do need to
override the automatic setting, because you know the data will change in the future, you can select it in the
Cardinality control. Let’s look at an example where we need to select a different cardinality.

The CompanyProjectPriority table below is a list of all company projects and their priority. The ProjectBudget table
is the set of projects for which budget has been approved.

ProjectBudget

CompanyProjectPriority

If we create a relationship between the Project column in the CompanyProjectPriority table and ApprovedProjects



PROJECT PRIORITY BUDGETALLOCATION ALLOCATIONDATE

Blue A 40,000 12/1/2012

Red B 100,000 12/1/2012

Green C 50,000 12/1/2012

Yellow C

Purple B

Orange C

column in the ProjectBudget table, like this:

Cardinality is automatically set to One-to-One (1:1), and cross filtering to be Both (as shown). This is because to
Power BI Desktop, the best combination of the two tables really looks like this:

There is a one-to-one relationship between our two tables because there are no repeating values in the combined
table’s Project column. The Project column is unique, because each value occurs only once, so, the rows from the
two tables can be combined directly without any duplication.



APPROVED PROJECTS BUDGETALLOCATION ALLOCATIONDATE

Blue 40,000 12/1/2012

Red 100,000 12/1/2012

Green 50,000 12/1/2012

Blue 80,000 6/1/2013

Red 90,000 6/1/2013

PROJECT PRIORITY BUDGETALLOCATION ALLOCATIONDATE

Blue A 40,000 12/1/2012

Red B 100,000 12/1/2012

Green C 50,000 12/1/2012

Yellow C

Purple B

Orange C

Blue A 80000 6/1/2013

Red B 90000 6/1/2013

Adjusting cross filter direction for a complex set of tables of
relationships

But, let’s say you know the data will change the next time you refresh it. A refreshed version of the ProjectBudget
table now has additional rows for Blue and Red:

ProjectBudget

This means the best combination of the two tables now really looks like this:

In this new combined table, the Project column has repeating values. The two original tables won’t have a one-to-
one relationship once the table is refreshed. In this case, because we know those future updates will cause the
Project column to have duplicates, we want to set the Cardinality to be Many-to-One (*:1), with the Many on the
ProjectBudget side and the One on the CompanyProject side.

For most relationships, the cross filter direction is set to ‘Both’. There are, however, some more uncommon
circumstances where you might need to set this different from the default, like if you’re importing a model from
an older version of Power Pivot, where every relationship is set to a single direction.

The Both setting enables Power BI Desktop to treat all aspects of connected tables as if they are a single table.
There are some situations, however, where Power BI Desktop cannot set a relationship’s cross filter direction to
‘Both’ and also keep an unambiguous set of defaults available for reporting purposes. If a relationship cross filter
direction isn't set to Both, then it’s usually because it would create ambiguity. If the default cross filter setting isn’t
working for you, try setting it to a particular table or Both.



Single direction cross filtering works for many situations. In fact, if you’ve imported a model from Power Pivot in
Excel 2013 or earlier, all of the relationships will be set to single direction. Single direction means that filtering
choices in connected tables work on the table where aggregation work is happening. Sometimes, understanding
cross filtering can be a little difficult, so let’s look at an example.

With single direction cross filtering, if you create a report that summarizes the project hours and then you can
choose to summarize (or filter) by CompanyProject, Priority or CompanyEmployee, City. If however, you want to
count the number of employee per projects (a less common question), it won’t work. You’ll get a column of values
that are all the same. In the example below, both relationships cross filtering direction is set to a single direction –
towards the ProjectHours table:

Filter specification will flow from CompanyProject to CompanyEmployee (as shown in the image below) but, it
won’t flow up to CompanyEmployee. However, if you set the cross filtering direction to Both it will work. The Both
setting allows the filter specification to flow up to Employee.



With the cross filtering direction set to Both, our report now appears correct:

Cross filtering both directions works well for a pattern of table relationships that look like the pattern above. This
is most commonly called a star schema, like this:

Cross filtering direction does not work well with a more general pattern often found in databases, like in this
diagram:



Wrong active relationship

TICKET OPENEDBY SUBMITTEDBY HOURS PROJECT DATESUBMIT

1001 Perham, Tom Brewer, Alan 22 Blue 1/1/2013

1002 Roman, Daniel Brewer, Alan 26 Red 2/1/2013

1003 Roth, Daniel Ito, Shu 34 Yellow 12/4/2012

If you have a table pattern like this, with loops, then cross filtering can create an ambiguous set of relationships.
For instance, if you sum up a field from TableX and then choose to filter by a field on TableY, then it’s not clear
how the filter should travel, through the top table or the bottom table. A common example for this kind of pattern
is TableX to be a Sales table with actuals data and for TableY to be budget data. Then, the tables in the middle are
lookup tables that both tables use, such as Division or Region.

Just like with active/inactive relationships, Power BI Desktop won’t allow a relationship to be set as Both if it will
create ambiguity in reports. There are several different ways you can deal with this, here are the two most
common:

Delete or mark relationships as inactive to reduce ambiguity. Then you might be able to set a relationship cross
filtering as Both.
Bring in a table twice (with a different name the second time) to eliminate loops. This makes the pattern of
relationships like a star schema. With a star schema all of the relationships can be set to Both.

When Power BI Desktop automatically creates relationships, it sometimes encounters more than one relationship
between two tables. When this happens only one of the relationships is set to be active. The active relationship
serves as the default relationship so that when you choose fields from two different tables, Power BI Desktop can
automatically create a visualization for you. However, in some cases the automatically selected relationship can be
wrong. You can use the Manage Relationships dialog to set a relationship as active or inactive, or you can set the
active relationship in the Edit relationship dialog.

To ensure there’s a default relationship, Power BI Desktop only allows a single active relationship between two
tables at a given time. So, you must first set the current relationship as inactive and then set the relationship you
want to be active.

Let’s look at an example. This first table is ProjectTickets, and the next table is EmployeeRole.

ProjectTickets



1004 Perham, Tom Brewer, Alan 13 Orange 1/2/2012

1005 Roman, Daniel Bowen, Eli 29 Purple 10/1/2013

1006 Roth, Daniel Bento, Nuno 35 Green 2/1/2013

1007 Roth, Daniel Hamilton, David 10 Yellow 10/1/2013

1008 Perham, Tom Han, Mu 28 Orange 1/2/2012

1009 Roman, Daniel Ito, Shu 22 Purple 2/1/2013

1010 Roth, Daniel Bowen, Eli 28 Green 10/1/2013

1011 Perham, Tom Bowen, Eli 9 Blue 10/15/2013

TICKET OPENEDBY SUBMITTEDBY HOURS PROJECT DATESUBMIT

EMPLOYEE ROLE

Bento, Nuno Project Manager

Bowen, Eli Project Lead

Brewer, Alan Project Manager

Hamilton, David Project Lead

Han, Mu Project Lead

Ito, Shu Project Lead

Perham, Tom Project Sponsor

Roman, Daniel Project Sponsor

Roth, Daniel Project Sponsor

EmployeeRole

There are actually two relationships here. One is between SubmittedBy in the ProjectTickets table and Employee in
the EmployeeRole table, and the other is between OpenedBy in the ProjectTickets table and Employee in the
EmployeeRole table.



If we add both relationships to the model (OpenedBy first), then the Manage Relationships dialog will show that
OpenedBy is active:

Now, if we create a report that uses Role and Employee fields from EmployeeRole, and the Hours field from
ProjectTickets in a table visualization in the Report canvas, we’ll see only project sponsors because they’re the only
ones that opened a project ticket.

We can change the active relationship and get SubmittedBy instead of OpenedBy. In Manage Relationships, we
uncheck the ProjectTickets(OpenedBy) to EmployeeRole(Employee) relationship, and then we check the Project



See all of your relationships in Relationship View

Tickets(SubmittedBy) to EmployeeRole(Employee) relationship.

Sometimes your model has multiple tables and complex relationships between them. Relationship View in Power
BI Desktop shows all of the relationships in your model, their direction, and cardinality in an easy to understand
and customizable diagram. To learn more, see Relationship View in Power BI Desktop.
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What is DAX?

Why is DAX so important?

Prerequisites

Let's begin!

SyntaxSyntax

This article is for users new to Power BI Desktop. It’s meant to give you a quick and easy introduction on how you
can use Data Analysis Expressions (DAX) to solve a number of basic calculation and data analysis problems. We’ll
go over some conceptual information, a series of tasks you can complete, and a few quizzes to test what you’ve
learned. After completing this article, you should have a good understanding of the most important fundamental
concepts in DAX.

DAX is a collection of functions, operators, and constants that can be used in a formula, or expression, to calculate
and return one or more values. Stated more simply, DAX helps you create new information from data already in
your model.

It’s quite easy to create a new Power BI Desktop file and import some data into it. You can even create reports that
show valuable insights without using any DAX formulas at all. But, what if you need to analyze growth percentage
across product categories and for different date ranges? Or, you need calculate year-over-year growth compared
to market trends? DAX formulas provide this capability and many other important capabilities as well. Learning
how to create effective DAX formulas will help you get the most out of your data. When you get the information
you need, you can begin to solve real business problems that affect your bottom line. This is the power in Power BI,
and DAX will help you get there.

You might already be familiar with creating formulas in Microsoft Excel. That knowledge will be helpful in
understanding DAX, but even if you have no experience with Excel formulas, the concepts described here will help
you get started creating DAX formulas and solving real-world BI problems right away.

We’re going to focus on understanding DAX formulas used in calculations, more specifically, in measures and
calculated columns. You should already be familiar with Power BI Desktop, importing data, adding fields to a
report, and you should also be familiar with fundamental concepts of Measures and Calculated columns.

Example Workbook

The best way to learn DAX is to create some basic formulas, use it with some actual data, and see the results for
yourself. The examples and tasks here use the Contoso Sales Sample for Power BI Desktop Preview file. This is the
same sample file used in the Tutorial: Create your own measures in Power BI Desktop article. You can download it
here.

We will frame our understanding of DAX around three fundamental concepts: Syntax, Functions, and Context. Of
course, there are other important concepts in DAX, but understanding these three concepts will provide the best
foundation on which to build your DAX skills.

Before you create your own formulas, let’s take a look at DAX formula syntax. Syntax includes the various elements
that make up a formula, or more simply, how the formula is written. For example, let’s look at a simple DAX

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-quickstart-learn-dax-basics.md
http://download.microsoft.com/download/4/6/A/46AB5E74-50F6-4761-8EDB-5AE077FD603C/Contoso Sales for Power BI Designer.zip


NOTENOTE

formula for a measure.

This formula includes the following syntax elements:

A. The measure name Total Sales.

B. The equals sign operator (=) indicates the beginning of the formula. When calculated, it will return a result.

C. The DAX function SUM adds up all of the numbers in the Sales[SalesAmount] column. You’ll learn more about
functions later.

D. Parenthesis () surround an expression containing one or more arguments. All functions require at least one
argument. An argument passes a value to a function.

E. The referenced table Sales.

F. The referenced column [SalesAmount] in the Sales table. With this argument, the SUM function knows on
which column to aggregate a SUM.

When trying to understand a DAX formula, it is often helpful to break down each of the elements into a language
you think and speak every day. For example, you can read this formula as:

For the measure named Total Sales, calculate (=) the SUM of values in the [SalesAmount ] column in the Sales
table.

When added to a report, this measure calculates and returns values by summing up sales amounts for each of the
other fields we include, for example, Cell Phones in the USA.

You might be thinking ‘Isn’t this measure doing the same thing as if I were to just add the SalesAmount field to my
report?’ Well, yes. But, there’s a good reason to create our own measure that sums up values from the
SalesAmount field: We can use it as an argument in other formulas. This may seem a little confusing now, but as
your DAX formula skills grow, knowing this will make your formulas and your model more efficient. In-fact, you’ll
see the Total Sales measure showing up as an argument in other formulas later on.

Let’s go over a few more things about this formula. In particular, we introduced a function, SUM. Functions are
pre-written formulas that make it easier to do complex calculations and manipulations with numbers, dates, time,
text, and more. You will learn more about functions later.

You also see the column [SalesAmount] was preceded by the table Sales in which the column belongs. This is
known as a fully qualified column name in that it includes the column name preceded by the table name. Columns
referenced in the same table do not require the table name be included in the formula. This can make long
formulas that reference many columns shorter and easier to read. However, it's good practice to include the table
name in your measure formulas, even when in the same table.

If a table name contains spaces, reserved keywords, or disallowed characters, you’ll need to enclose the table name in single
quotation marks. You’ll also need to enclose table names in quotation marks if the name contains any characters outside the
ANSI alphanumeric character range, regardless of whether your locale supports the character set or not.

https://msdn.microsoft.com/library/ee634387.aspx


Task: Create a measure formulaTask: Create a measure formula

It’s important your formulas have the correct syntax. In most cases, if the syntax is not correct, a syntax error will
be returned. In other cases, the syntax may be correct, but the values returned might not be what you are
expecting. The DAX editor in Power BI Desktop includes suggestions; a feature used to create syntactically correct
formulas by helping you select the correct elements.

Let’s create a simple formula. This task will help you further understand formula syntax and how the suggestions
feature in the formula bar can help you.

To complete this task, you’ll need to open the Contoso Sales Sample Power BI Desktop file.

1. In Report view, in the field list, right-click on the Sales table, and then click New Measure.

2. In the formula bar, replace Measure by typing a new measure name, Previous Quarter Sales.

3. After the equals sign, type SUM followed by an opening parenthesis.

Rather than type a column name to sum up right away, we’re going to enter another function, to filter the
data we want to sum up.

4. Between the parentheses, type CALCULATE, followed by an opening parenthesis.

You’ll use the CALCULATE function to filter the amounts we want to sum by an argument we pass to the
CALCULATE function. This is what’s referred to as nesting functions. The CALCULATE function has at least
two arguments. The first is the expression to be evaluated, and second, a filter.

5. Between the parenthesis () for the CALCULATE function, type Sales[SalesAmount]. This is the first
expression argument for our CALCULATE function.

6. Type a comma (,) to specify the first filter, then type PREVIOUSQUARTER followed by an opening
parenthesis..

You’ll use the PREVIOUSQUARTER time intelligence function to filter our SUM results by the previous
quarter.

7. Between the parenthesis () for the PREVIOUSQUARTER function, type Calendar[DateKey].

The PREVIOUSQUARTER function has one argument, a column containing a contiguous range of dates. >

8. Make sure both the arguments being passed to the PREVIOUSQUARTER function and the CALCULATE
function are closed by two closing parentheses )).

Your formula should now look like this:

Previous Quarter Sales = CALCULATE(SUM(Sales[SalesAmount]),
PREVIOUSQUARTER(Calendar[DateKey]))

9. Click the checkmark  in the formula bar or press Enter to validate the formula and add it to the model.

You did it! You just created a measure using DAX, and not an easy one at that. What this formula will do is
calculate the total sales for the previous quarter, depending on the filters applied in a report. For example, if we put
SalesAmount and our new Previous Quarter Sales measure in a chart, and then added Year and QuarterOfYear as
Slicers, we’d get something like this:
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You were just introduced to several important aspects of DAX formulas. First, this formula included two functions.
Notice PREVIOUSQUARTER, a time intelligence, function is nested as an argument passed to CALCULATE, a filter
function. DAX formulas can contain up to 64 nested functions. It’s unlikely a formula would ever contain so many
nested functions. In fact, such a formula would be very difficult to create and debug, and it probably wouldn’t be
very fast either.

In this formula, you also used filters. Filters narrow down what will be calculated. In this case, you selected one
filter as an argument, which is actually the result of another function. You will learn more about filters later.

Finally, you used the CALCULATE function. This is one of the most powerful functions in DAX. As you author
models and create more complex formulas, you will likely use this function many times. Discussing the
CALCULATE function is outside the scope of this article, but as your knowledge of DAX grows, pay special attention
to this one.

2. What always surrounds a column name in a DAX formula?

1. What does this button on the formula bar do?

Answers are provided at the end of this article.

Functions are predefined formulas that perform calculations by using specific values, called arguments, in a
particular order or structure. Arguments can be other functions, another formula, expression, column references,
numbers, text, logical values such as TRUE or FALSE, or constants.

DAX includes the following categories of functions: Date and Time, Time Intelligence,Information,
Logical,Mathematical, Statistical, Text, Parent/Child and Other functions. If you’re familiar with functions in Excel
formulas, many of the functions in DAX will appear similar to you; however, DAX functions are unique in the
following ways:

A DAX function always references a complete column or a table. If you want to use only particular values from a
table or column, you can add filters to the formula.
If you need to customize calculations on a row-by-row basis, DAX provides functions that let you use the
current row value or a related value as a kind of argument, to perform calculations that vary by context. You will
learn more about context later.
DAX includes many functions that return a table rather than a value. The table is not displayed, but is used to
provide input to other functions. For example, you can retrieve a table and then count the distinct values in it, or
calculate dynamic sums across filtered tables or columns.

https://msdn.microsoft.com/library/ee634385.aspx
https://msdn.microsoft.com/library/ee634825.aspx
https://msdn.microsoft.com/library/ee634786.aspx
https://msdn.microsoft.com/library/ee634763.aspx
https://msdn.microsoft.com/library/ee634552.aspx
https://msdn.microsoft.com/library/ee634552.aspx
https://msdn.microsoft.com/library/ee634365.aspx
https://msdn.microsoft.com/library/ee634365.aspx
https://msdn.microsoft.com/library/ee634241.aspx
https://msdn.microsoft.com/library/ee634822.aspx
https://msdn.microsoft.com/library/ee634938.aspx
https://msdn.microsoft.com/library/mt150102.aspx
https://msdn.microsoft.com/library/mt150101.aspx
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ContextContext

DAX includes a variety of time intelligence functions. These functions let you define or select date ranges, and
perform dynamic calculations based on them. For example, you can compare sums across parallel periods.
Excel has a very popular function, VLOOKUP. DAX functions don’t take a cell or cell range as a reference like
VLOOKUP does in Excel. DAX functions take a column or a table as a reference. Keep in-mind, in Power BI
Desktop, you’re working with a relational data model. Looking up values in another table is really quite
easy, and in most cases you don’t need to create any formula at all.

As you can see, functions in DAX can help you create very powerful formulas. We really only touched on the
basics of functions. As your DAX skills grow, you'll create formulas using many different functions. One of
the best places to learn details about each of DAX functions is in the DAX Function Reference.

1. What does a function always reference?
2. Can a formula contain more than one function?
3. What category of functions would you use to concatenate two text strings into one string?

Answers are provided at the end of this article.

Context is one of the most important DAX concepts to understand. There are two types of context in DAX; row
context and filter context. We’ll first look at row context.

Row context

Row context is most easily thought of as the current row. It applies whenever a formula has a function that applies
filters to identify a single row in a table. The function will inherently apply a row context for each row of the table
over which it is filtering. This type of row context most often applies to measures.

Filter context

Filter context is a little more difficult to understand than row context. You can most easily think of filter context as:
One or more filters applied in a calculation that determines a result or value.

Filter context doesn’t exist in-place of row context; rather, it applies in addition to row context. For example, to
further narrow down the values to include in a calculation, you can apply a filter context which not only specifies
the row context, but also specifies only a particular value (filter) in that row context.

Filter context is easily seen in your reports. For example, when you add TotalCost to a visualization, and then add
Year and Region, you are defining a filter context that selects a subset of data based on a given year and region.

Why is filter context so important to DAX? Because while filter context can most easily be applied by adding fields
to a visualization, filter context can also be applied in a DAX formula by defining a filter using functions such as
ALL, RELATED, FILTER, CALCULATE, by relationships, and by other measures and columns. For example, let’s look
at the following formula in a measure named Store Sales:

To better understand this formula, we can break it down, much like with other formulas.

This formula includes the following syntax elements:

A. The measure name Store Sales.

https://msdn.microsoft.com/library/ee634396.aspx
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B. The equals sign operator (=) indicates the beginning of the formula.

C. The CALCULATE function evaluates an expression, as an argument, in a context that is modified by the specified
filters.

D. Parenthesis () surround an expression containing one or more arguments.

E. A measure [Total Sales] in the same table as an expression. The Total Sales measure has the formula:
=SUM(Sales[SalesAmount]).

F. A comma (,) separates the first expression argument from the filter argument.

G. The fully qualified referenced column, Channel[ChannelName]. This is our row context. Each row in this
column specifies a channel: Store, Online, etc.

H. The particular value, Store as a filter. This is our filter context.

This formula ensures only sales values defined by the Total Sales measure are calculated only for rows in the
Channel[ChannelName] column with the value “Store”, as a filter.

As you can imagine, being able to define filter context within a formula has immense and powerful capabilities.
Being able to reference only a particular value in a related table is just one such example. Don’t worry if you do not
completely understand context right away. As you create your own formulas, you will better understand context
and why it’s so important in DAX.

1. What are the two types of context?
2. What is filter context?
3. What is row context?

Answers are provided at the end of this article.

Now that you have a basic understanding of the most important concepts in DAX, you can begin creating DAX
formulas for measures on your own. DAX can indeed be a little tricky to learn, but there are many resources
available to you. After reading through this article and experimenting with a few of your own formulas, you can
learn more about other DAX concepts and formulas that can help you solve your own business problems. There
are many DAX resources available to you; most important is the Data Analysis Expressions (DAX) Reference.

DAX has been around for several years in other Microsoft BI tools such as Power Pivot and Analysis Services
Tabular models, so there’s a lot of great information out there. You can find more information in books,
whitepapers, and blogs from both Microsoft and leading BI professionals. The DAX Resource Center Wiki on
TechNet is also a great place to start.

Syntax:

1. Validates and enters the measure into the model.
2. Brackets [].

Functions:

1. A table and a column.
2. Yes. A formula can contain up to 64 nested functions.
3. Text functions.

Context:

https://msdn.microsoft.com/library/gg413422.aspx
http://social.technet.microsoft.com/wiki/contents/articles/dax-resource-center.aspx
https://msdn.microsoft.com/library/ee634938.aspx


1. Row context and filter context.
2. One or more filters in a calculation that determines a single value.
3. The current row.
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In Power BI Desktop, you can specify the Data Category for a column so Power BI Desktop knows how it should
treat its values when in a visualization.

When Power BI Desktop imports data, not only does it get the data itself, it also gets information such as the table
and column names, whether it’s a primary key, etc. With that information, Power BI Desktop makes some
assumptions about how to give you a good default experience when creating a visualization.

Here’s an example: When Power BI Desktop detects a column has numeric values, you’ll probably want to
aggregate it in some way, so it’s placed in the Values area. Or, for a column with date time values, it assumes you’ll
probably use it as a time hierarchy axis on a line chart.

But, there are some cases that are a bit more challenging, like geography. Consider the following table from an
Excel worksheet:

Should Power BI Desktop treat the codes in the GeoCode column as an abbreviation for a Country or a US State?
It’s not clear because a code like this can mean either one. For instance, AL can mean Alabama or Albania, AR can
mean Arkansas or Argentina, or CA can mean California or Canada. It makes a difference when we go to chart our
GeoCode field on a map. Should Power BI Desktop show a picture of the world with countries highlighted or a
picture of the United States with states highlighted? You can specify a Data Category for data just like this. Data
categorization further refines the information Power BI Desktop can use to provide the best visualizations.

To specify a Data Category

1. In Report View or Data View, in the Fields list, select the field you want to be sorted by a different
categorization.

2. On the ribbon, in the Data Tools Modeling tab, click on the Data Category: drop down list. This shows the
list of possible data categories you can choose for your column. Some selections might be disabled if they
won’t work with the current data type of your column. For example, if a column is a binary data type, Power BI
Desktop won’t let you choose geographic data categories.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-data-categorization.md


And that’s it! Any behavior that normally accrues to a visual will now work automatically.

You might also be interested in learning about geographic filtering for Power BI mobile apps.



 

Tag barcodes in Power BI Desktop for the mobile
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Supported barcode formats

In Power BI Desktop, you can categorize data in a column, so Power BI Desktop knows how to treat values in
visuals in a report. You can also categorize a column as Barcode. When you or your colleagues scan a barcode on
a product with the Power BI app on the iPhone, you see any report that includes that barcode. When you open the
report in the mobile app, Power BI automatically filters the report to data related to that barcode.

1. In Power BI Desktop, switch to Data View.
2. Select a column with barcode data. See the list of supported barcode formats below.

4. In Report view, add this field to the visuals you want filtered by the barcode.
5. Save the report and publish it to the Power BI service.

3. On the Modeling tab, select Data Category > Barcode.

Now when you open the scanner on the Power BI app for iPhone and scan a barcode, you see this report in the list
of reports. When you open the report, its visuals are filtered by the product barcode you scanned.

These are the barcodes Power BI recognizes if you can tag them in a Power BI report:

UPCECode
Code39Code
A39Mod43Code
EAN13Code
EAN8Code
93Code
128Code
PDF417Code
Interleaved2of5Code
ITF14Code

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-mobile-barcodes.md


Next steps
Scan a barcode from the Power BI app on your iPhone
Issue with scanning barcodes on an iPhone
Data categorization in Power BI Desktop
Questions? Try asking the Power BI Community

http://community.powerbi.com/
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NOTENOTE

Identify geographic data in your report

In Power BI Desktop, you can categorize geographical data for a column, so Power BI Desktop knows how to treat
values in visuals in a report. As an added benefit, when you or your colleagues view that report in the Power BI
mobile apps, Power BI automatically provides geographical filters that match where you are.

For example, say you're a sales manager traveling to meet customers, and you'd like to quickly filter the total sales
and revenue for the specific customer you're planning to visit. You want to break out the data for your current
location, whether by state, city, or an actual address. Later, if you have time left, you'd like to visit other customers
located nearby. You can filter the report by your location to find those customers.

You can only filter by location in the mobile app if the geographic names in the report are in English – for example, "New
York City" or "Germany".

1. In Power BI Desktop, switch to Data View .
2. Select a column with geographic data — for example, a City column.

3. On the Modeling tab, select Data Category, then the correct category — in this example, City.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-mobile-geofiltering.md


Create visuals with your geographic data

NOTENOTE

4. Continue setting geographic data categories for any other fields in the model.

You can set multiple columns for each data category in a model, but if you do the model can't filter for geography in
the Power BI mobile app. To use geographic filtering in the mobile apps, set only one column for each data category
— for example, only one City column, one State or Province column, and one Country column.

1. Switch to Report view , and create visuals that use the geographic fields in your data.

In this example, the model also contains a calculated column that brings city and state together in one
column. Read about creating calculated columns in Power BI Desktop.



View the report in Power BI mobile app

Next steps

2. Publish the report to the Power BI service.

1. Open the report in any of the Power BI mobile apps.
2. If you're in a geographic location with data in the report, you can filter it automatically to your location.

Read more about filtering a report by location in the Power BI mobile apps.

Data categorization in Power BI Desktop
Questions? Try asking the Power BI Community

http://community.powerbi.com/
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Let’s look at an example

With calculated columns, you can add new data to a table already in your model. But instead of querying and
loading values into your new column from a data source, you create a Data Analysis Expressions (DAX) formula
that defines the column’s values. In Power BI Desktop, calculated columns are created by using the New Column
feature in Report View.

Unlike custom columns created as part of a query by using Add Custom Column in Query Editor, calculated
columns created in Report View or Data View are based on data you’ve already loaded into the model. For
example, you might choose to concatenate values from two different columns in two different but related tables ,
perform addition, or extract sub-strings.

Calculated columns you create appear in the Fields list just like any other field, but they’ll have a special icon
showing its values are the result of a formula. You can name your columns whatever you want, and add them to a
report visualization just like other fields.

Calculated columns calculate results by using Data Analysis Expressions (DAX), a formula language meant to work
with relational data like in Power BI Desktop. DAX includes a library of over 200 functions, operators, and
constructs, providing immense flexibility in creating formulas to calculate results for just about any data analysis
need. To learn more about DAX, see the Learn more section at the end of this article.

DAX formulas are similar to Excel formulas. In fact, DAX has many of the same functions as Excel. DAX functions,
however, are meant to work over data interactively sliced or filtered in a report, like in Power BI Desktop. Unlike
Excel, where you can have a different formula for each row in a table, when you create a DAX formula for a new
column, it will calculate a result for every row in the table. Column values are recalculated as necessary, like when
the underlying data is refreshed and values have changed.

Jeff is a shipping manager at Contoso. He wants to create a report showing the number of shipments to different
cities. He has a Geography table with separate fields for city and state. But, Jeff wants his reports to show City, State
as a single value on the same row. Right now, Jeff’s Geography table doesn’t have the field he wants.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-calculated-columns.md
https://msdn.microsoft.com/library/gg413422.aspx
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But with a calculated column, Jeff can simply put together, or concatenate, the cities from the City column with the
states from the State column.

Jeff right clicks on the Geography table and then clicks New Column. He then enters the following DAX formula
into the formula bar:

This formula simply creates a new column named CityState, and for each row in the Geography table, it takes
values from the City column, adds a comma and a space, and then concatenates values from the State column.

Now Jeff has the field he wants.

He can add it to his report canvas along with the number of shipments. Very quickly and with minimal effort, Jeff
now has a City, State field. He can add to just about any type of visualization. Jeff even sees that when he creates a
map visualization, Power BI Desktop even knows how to read the City, State values in his new column.

We’ve only provided a quick introduction to calculated columns here. Be sure to see the Create calculated columns
in Power BI Desktop tutorial, where you can download a sample file and get step-by-step lessons on how to create
more columns.

To learn more about DAX, see DAX basics in Power BI Desktop.

To learn more about columns you create as part of a query, see the Create custom columns section in Common
query tasks in Power BI Desktop.
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Let’s look at an example

With calculated tables, you can add a new table to the model. But instead of querying and loading values into your
new table's columns from a data source, you create a Data Analysis Expressions (DAX) formula that defines the
table’s values. In Power BI Desktop, calculated tables are created by using the New Table feature in Report View or
Data View.

Most of the time, you import data into your model from an external data source. However, calculated tables provide
certain advantages. Calculated tables are generally best for intermediate calculations and data you want stored as
part of the model rather than calculated on the fly or as part of a query.

Unlike tables created as part of a query, calculated tables created in Report View or Data View are based on data
you’ve already loaded into the model. For example, you might choose to union or cross join two tables.

Just like normal tables, calculated tables can have relationships with other tables. The columns in your calculated
table have data types, formatting, and can belong to a data category. You can name your columns whatever you
want, and add them to a report visualization just like other fields. Calculated tables are re-calculated if any of the
tables it pulls data from are refreshed or updated in any way.

Calculated tables calculate results by using Data Analysis Expressions (DAX), a formula language meant to work
with relational data like in Power BI Desktop. DAX includes a library of over 200 functions, operators, and
constructs, providing immense flexibility in creating formulas to calculate results for just about any data analysis
need.

Jeff, a project manager at Contoso, has a table with employees on the in Northwest and another table with
employees in the Southwest. Jeff wants to put the two tables together into a single table.

NorthwestEmployees

SoutwestEmployees

Putting these two tables together with a calculated table is quite easy. While Jeff can create a calculated table in
either Report View or Data View, it’s a bit easier to do it in Data View because he can immediately see his new
calculated table.

In Data View, on the Modeling tab, Jeff clicks New Table. A formula bar appears.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-calculated-tables.md
https://msdn.microsoft.com/library/gg413422.aspx


Functions for calculated tables

Jeff then enters the following formula:

A new table named Western Region Employees is created.

Jeff’s new Western Region Employees table appears just like any other table in the Fields list. He can create
relationships to other tables, add calculated columns and measures, and add any of its fields to reports just like any
other table.

Calculated tables can be defined by any DAX expression that returns a table, including a simple reference to another
table. For example:

You can use calculated tables with DAX to solve many analytical problems. We’ve only provided a quick
introduction to calculated tables here. As you start working with calculated tables, here are some of the more
common DAX table functions you might find useful:

<TABLE> DISTINCT VALUES CROSSJOIN UNION NATURALINNERJOIN NATURALLEFTOUTERJOIN INTERSECT
CALENDAR CALENDARAUTO

See the DAX Function Reference for these and other table returning DAX functions.

https://msdn.microsoft.com/ee634396.aspx
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Understanding measures

NOTENOTE

Data Analysis Expressions

Power BI Desktop helps you create insights into your data with just a few clicks. But sometimes that data just
doesn’t include everything you need to answer some of your most important questions. Measures can help you
get there.

Measures are used in some of the most common data analysis; for example, sums, averages, minimum or
maximum values, counts, or more advanced calculations you create yourself using a DAX formula. The calculated
results of measures are always changing in response to your interaction with your reports, allowing for fast and
dynamic ad-hoc data exploration. Let’s take a closer look.

In Power BI Desktop, measures are created and used in Report View or Data View. Measures you create
yourself appear in the Fields list with a calculator icon. You can name measures whatever you want, and add them
to a new or existing visualization just like any other field.

You might also be interested in quick measures, which are ready-made measures you can select from dialog boxes. They're
a good way to quickly create measures, and also a good way to learn DAX syntax, since their automatically created DAX
formulas are available to review. Check out the article: quick measures.

Measures calculate a result from an expression formula. When you create your own measures, you’ll use the Data
Analysis Expressions (DAX) formula language. DAX includes a library of over 200 functions, operators, and
constructs, providing immense flexibility in creating measures to calculate results for just about any data analysis
need.

DAX formulas are a lot like Excel formulas. DAX even has many of the same functions like DATE, SUM, and LEFT.
But, DAX’s functions are meant to work with relational data like we have in Power BI Desktop.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-measures.md
https://msdn.microsoft.com/library/gg413422.aspx


Let’s look at an example

Projected Sales = SUM('Sales'[Last Years Sales])*1.06

Learn more

Jan is a sales manager at Contoso. She’s been asked to provide reseller sales projections over the next fiscal year.
She decides to base her estimates on last year’s sales amounts, with a six percent annual increase resulting from
various promotions that are scheduled over the next six months.

To report the estimates, she imports last year’s sales data into Power BI Desktop. She finds the SalesAmount field
in the Reseller Sales table. Because the data she imported only contains sales amounts for last year, she renames
the SalesAmount field to Last Years Sales. She then drag Last Years Sales onto the report canvas. It appears in a
chart visualization as single value that is the sum of all reseller sales from last year.

She notices that even though she did not specify a calculation herself, one has been provided automatically.
Power BI Desktop created its own measure by summing up all of the values in Last Years Sales.

But, Jan needs a measure to calculate sales projections for the coming year, which will be based on last year’s
sales multiplied by 1.06 to account for the expected 6 percent increase in business. For this calculation, she’ll
create her own measure. Using the New Measure feature, she creates a new measure, then enters the following
DAX formula:

Jan then drags her new Projected Sales measure into the chart.

Very quickly and with minimal effort, Jan now has a measure to calculate projected sales. She can further analyze
her projections by filtering on specific resellers or by adding other fields to her report.

We’ve only provided you with a quick introduction to measures here, but there’s a lot more to help you learn how
to create your own. Be sure to see the Tutorial: Create your own measures in Power BI Desktop, where you can
download a sample file and get step-by-step lessons on how to create more measures.

To dive a little deeper into DAX, be sure to check out DAX basics in Power BI Desktop. The Data Analysis
Expressions Reference provides detailed articles on each of the functions, syntax, operators, and naming
conventions. DAX has been around for several years in Power Pivot in Excel and SQL Server Analysis Services, so
there are a lot of other great resources available, too. Be sure to check out the DAX Resource Center Wiki, where
influential members of the BI community share their knowledge of DAX.

https://msdn.microsoft.com/library/gg413422.aspx
http://social.technet.microsoft.com/wiki/contents/articles/1088.dax-resource-center.aspx
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With Power BI Desktop, you can import and display KPIs in tables, matrixes, and cards.

Follow these steps to import and display KPIs.

1. Start with an Excel workbook that has a Power Pivot model and KPIs. This exercise uses a workbook named KPIs.
You can also learn how to import workbooks.

2. Open the report and select the Top Performers tab. The Top Performers matrix contains KPIs for three
different sales measures by employee email address.

That's all there is to it. You can use KPIs to highlight important trends, progress, or other important indicators.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-import-and-display-kpis.md


Report View in Power BI Desktop
12/6/2017 • 1 min to read • Edit Online

Let's take a look!

If you’ve been working with Power BI, you know how easy it is to create reports providing dynamic perspectives
and insights into your data. Power BI also has more advanced features in Power BI Desktop. With Power BI
Desktop, you can create advanced queries, mashup data from multiple sources, create relationships between
tables, and more.

Power BI Desktop includes Report View, where you can create any number of report pages with visualizations.
Report View in provides pretty much the same design experience as a report’s Editing View in the Power BI
service. You can move visualizations around, copy and paste, merge, etc.

The difference between them is when using Power BI Desktop, you can work with your queries and model your
data to make sure your data supports the best insights in your reports. You can then save your Power BI Desktop
file wherever you like, whether it's your local drive or to the cloud.

When you first load data in Power BI Desktop, you’ll see Report View with a blank canvas.

You can switch between Report View, Data View, and Relationship View by selecting the icons in the left hand
navigation bar:

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-report-view.md


TIPTIP

Once you’ve added some data, you can add fields to a new visualization in the canvas.

To change the type of visualization, you can select it from the Visualization group in the ribbon or you can right
click and select a different it from the Change visualization type icon.

Be sure to experiment with different visualization types. It’s important your visualization convey information in your data
clearly.

A report will have at least one blank page to start. Pages appear in the navigator pane just to the left of the
canvas. You can add all sorts of visualizations to a page, but it's important not to overdo it. Too many



NOTENOTE

visualizations on a page will make it look busy and difficult to find the right information. You can add new pages
to your report, just click New Page on the ribbon.

To delete a page, click the X on the page's tab at the bottom of the Report View.

Reports and visualizations can’t be pinned to a dashboard from Power BI Desktop. To do that, you’ll need to Publish from
Power BI Desktop to your Power BI site.



Use Q&A in Power BI Desktop for natural language
queries
12/12/2017 • 10 min to read • Edit Online

Add missing relationships

Rename tables and columns

Using common phrases and natural language to ask questions of your data is powerful. Even more powerful is
when your data answers, which is what Q&A in Power BI Desktop lets you do.

To enable Q&A to successfully interpret the large collection of questions it's capable of responding to, Q&A must
make assumptions about the model. If the structure of your model doesn't meet one or more of these assumptions,
you'll need to adjust your model. Those adjustments for Q&A are the same best-practice optimizations for any
model in Power BI, regardless whether you use Q&A.

In the following sections, we describe how to adjust your model so it works well with Q&A in Power BI.

If your model is missing relationships between tables, neither Power BI reports nor Q&A can interpret how to join
those tables if you ask a questions about them. Relationships are the cornerstone of a good model. For example,
you cannot ask for the “total sales for Seattle customers” if the relationship between the orders table and the
customers table is missing. The following images show you examples of a model that needs work, and a model that
is ready for Q&A.

Needs work

Ready for Q&A

The choice of tables and columns is very important for Q&A. For example, if you have a table named
CustomerSummary that contains a list of your customers, you would need to ask questions like “List the customer
summaries in Chicago” rather than “List the customers in Chicago”.

While Q&A can do some basic word breaking and detection of plurals, Q&A assumes that your table and column
names accurately reflect their content.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-qna-in-reports.md


Fix incorrect data types

Mark year and identifier columns as Don't Summarize

Consider another example. Imagine you have a table named Headcount that contains first and last names and
employee numbers, and you have another table named Employees contains employee numbers, job numbers and
start dates. While this might be understood by people who are familiar with the model, someone else who asks
“count the employees” is going to get a count of the rows from the “Employees” table, which is probably not what
they had in mind, since that’s a count of every job each employee has ever had. It would be much better to rename
those tables to truly reflect what they contain.

Needs work

Ready for Q&A

Imported data can have incorrect data types. In particular, date and number columns that are imported as strings
will not be interpreted by Q&A as dates and numbers. You should make sure you select the correct data type in
your Power BI model.

Power BI aggressively aggregates numeric columns by default, so questions like “total sales by year” can
sometimes result in a grand total of sales alongside a grand total of years. If you have specific columns where you
don't want Power BI to exhibit this behavior, set the Summarize By property on the column to Don’t Summarize.
Be mindful of year, month, day, and ID columns, as those columns are the most frequent problems. Other
columns that aren’t sensible to sum, such as age, could also benefit from setting Summarize By to Don’t
Summarize or to Average. You'll find ths setting in the Modeling tab.



Choose a Data Category for each date and geography column

Choose a Sort By Column for relevant columns

The Data Category provides additional semantic knowledge about the content of a column beyond its data type.
For example, an integer column might be marked as a Zip Code, a string column might be marked as a City,
Country, Region, and so on. This information is used by Q&A in two important ways: For visualization selection and
for language biases.

First, Q&A uses the Data Category information to help make choices about what kind of visual display to use. For
example, it recognizes that columns with date or time Data Categories are typically a good choice for the
horizontal axis of a line chart or the play axis of a bubble chart. And it assumes that results containing columns with
geographical Data Categories may look good on a map.

Second, Q&A makes some educated guesses about how users are likely to talk about date and geography columns,
to help it understand certain types of questions. For example, the “when” in “When was John Smith hired?” is
almost certain to map to a date column, and the “Brown” in “Count customers in Brown” is more likely to be a city
than a hair color.

The Sort By Column property allows sorting on one column to automatically sort by a different column instead.
For example, when you ask “sort customers by shirt size”, you probably want your Shirt Size column to sort by the
underlying size number (XS, S, M, L, XL) rather than alphabetically (L, M, S, XL, XS).



Normalize your model

Create new tables for multi-column entitiesCreate new tables for multi-column entities

Pivot to eliminate property bagsPivot to eliminate property bags

Rest assured that we’re not suggesting you need to reshape your entire model. However, there are certain
structures that are simply so difficult that Q&A isn’t going to handle them well. If you perform some basic
normalization of the structure of your model, the usability of Power BI reports will increase significantly, as will the
accuracy of Q&A results.

The general rule you should follow is this: Each unique “thing” the user talks about should be represented by
exactly one model object (table or column). So if your users talk about customers, there should be one customer
object. And if your users talk about sales, there should be a one sales object. Sounds simple, doesn't it? Depending
on the shape of the data you’re starting with, it can be. There are rich data shaping capabilities available in Query
Editor if you need them, while many of the more straightforward transformations can happen simply using
calculations in the Power BI model.

The following sections contain some common transformations you might need to perform.

If you have multiple columns that act as a single distinct unit within a larger table, those columns should be split
out into their own table. For example, if you have a Contact Name, Contact Title, and Contact Phone column within
your Companies table, a better design would be to have a separate Contacts table to contain the Name, Title, and
Phone and a link back to the Companies table. That makes it significantly easier to ask questions about contacts
independently of questions about companies for which they are the contact, and improves display flexibility.

Needs work

Ready for Q&A

If you have property bags in your model, they should be restructured to have a single column per property.
Property bags, while convenient for managing large numbers of properties, suffer from a number of inherent
limitations that neither Power BI reports nor Q&A are designed to work around.

For example, consider a CustomerDemographics table with CustomerID, Property, and Value columns, where each
row represents a different property of the customer (for examples, age, marital status, city, etc). By overloading the
meaning of the Value column based on the content of the Property column, it becomes impossible for Q&A to



Union to eliminate partitioningUnion to eliminate partitioning

interpret most queries which reference it. A simple question such as “show the age of each customer” might
happen to work, since it could be interpreted as “show the customers and customer demographics where property
is age”. However, the structure of the model simply doesn’t support slightly more complex questions like “average
age of customers in Chicago.” While users who directly author Power BI reports reports can sometimes find clever
ways to get the data they are looking for, Q&A only works when each column has only a single meaning.

Needs work

Ready for Q&A

If you've partitioned your data across multiple table, or have pivoted values across multiple columns, a number of
common operations will be difficult or impossible for your users to achieve. Consider first a typical table
partitioning: a Sales2000-2010 table and a Sales2011-2020 table. If all of your important reports are restricted to a
specific decade, you could probably leave it this way for Power BI reports. However, the flexibility of Q&A will lead
your users to expect answers to questions like “total sales by year.” For this to work, you’ll need to union the data
into a single Power BI model table.

Similarly, consider a typical pivoted value column: a BookTour table containing Author, Book, City1, City2, and City3
columns. With a structure like this, even simple questions like “count books by city” cannot be interpreted correctly.
For this to work, you should create a separate BookTourCities table, which unions the city values into a single
column.

Needs work

Ready for Q&A



Split formatted columnsSplit formatted columns

Create new tables for multi-value columnsCreate new tables for multi-value columns

Denormalize to eliminate inactive relationshipsDenormalize to eliminate inactive relationships

If the source from which you're importing your data contains formatted columns, Power BI reports (and Q&A) will
not reach inside the column to parse its contents. So if you have, for example, a Full Address column that contains
the address, city and country, you should also split it into Address, City and Country columns so your users can
query against them individually.

Needs work

Ready for Q&A

Similarly, if you have any full name columns for a person, you’ll want to add First Name and Last Name columns,
just in case someone wants to ask questions using partial names.

Also a similar situation, if the source from which you're importing your data contains multi-value columns, Power
BI reports (and Q&A) will not reach inside the column to parse out the contents. So if you have, for example, a
Composer column that contains the names of multiple composers for a song, you should split it into multiple rows
in a separate Composers table.

Needs work

Ready for Q&A

The one exception to the “normalization is better” rule occurs when there is more than one path to get from one
table to another. For example, if you have a Flights table with both SourceCityID and DestinationCityID columns,
each of which are related to the Cities table, one of those relationships will have to be marked as inactive. Since



Add synonyms to tables and columnsAdd synonyms to tables and columns

Q&A can only use active relationships, you would be unable to ask questions about either source or destination,
depending on which you chose. If you instead denormalize the city name columns into the Flights table, you’ll be
able to ask questions like: “list the flights for tomorrow with a source city of Seattle and a destination city of San
Francisco.”

Needs work

Ready for Q&A

This step applies specifically to Q&A (and not to Power BI reports in general). Users often have a variety of terms
they use to refer to the same thing, such as total sales, net sales, total net sales. Power BI’s model allows these
synonyms to be added to tables and columns within the model.

This can be a very important step. Even with straightforward table and column names, users of Q&A ask questions
using the vocabulary that first comes to them, and are not choosing from a predefined list of columns. The more
sensible synonyms you can add, the better your users' experience will be with your report. To add Synonyms, in
Relationships view select the Synonyms button in the ribbon, as shown in the following image.



Next steps

The Synonyms field appears on the right side of Power BI Desktop, where you can add your synonyms, as
showin in the following image.

Be careful when adding synonyms, since adding the same synonym to more than one column or table will
introduce ambiguity. Q&A utilizes context where possible to choose between ambiguous synonyms, but not all
questions have sufficient context. For example, when your user asks “count the customers”, if you have three things
with the synonym “customer” in your model, they might not get the answer they are looking for. In these cases,
make sure the primary synonym is unique, as that is what is used in the restatement. It can alert the user to the
ambiguity (for example, a restatement of “show the number of archived customer records”), hinting they might
want to ask it differently.

For more information about features that are in Power BI Desktop, take a look at the following articles:

Use drillthrough in Power BI Desktop
Display a dashboard tile or report visual in Focus mode



Using the Analytics pane in Power BI Desktop
11/15/2017 • 4 min to read • Edit Online

NOTENOTE

Enable Forecasting (Preview)

With the Analytics pane in Power BI Desktop, you can add dynamic reference lines to visuals, and provide focus
for important trends or insights. The Analytics pane is found in the Visualizations area of Power BI Desktop,
beginning with the August 2016 release (version 2.37.4464.321 or later), as shown below.

The Analytics pane only appears when you select a visual on the Power BI Desktop canvas.

In addition, with the September 2016 release of Power BI Desktop (version 2.39.4526.362 or later), you can also
perform forecasting from the Analytics pane. You must enable this preview feature, by going to File > Options
and settings > Options then selecting Preview Features from the left pane. Select the checkbox next to
Forecasting to enable the feature, as shown in the following image. You'll need to restart Power BI Desktop for
your changes to take effect.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-analytics-pane.md


Using the Analytics pane
With the Analytics pane, you can create the following types of dynamic reference lines (not all lines are available
for all visual types):

X-Axis constant line
Y-Axis constant line
Min line
Max line
Average line
Median line
Percentile line

The following sections show how you can use the Analytics pane and dynamic reference lines in your
visualizations.

To view the available dynamic reference lines for a visual, follow these steps:

1. Select or create a visual, then select the Analytics icon from the Visualizations section.



2. Select the down arrow for the type of line you want to create to expand its options. In this case, we'll select
Average Line.

3. To create a new line, select + Add. You can then specify a name for the line by double-clicking the text box,
then typing in your name.



You have all sorts of options for your line, such as selecting its color, transparency, style and position
(relative to the visual's data elements), and whether to include the label. And importantly, you can select
which Measure in the visual you want your line to be based upon by selecting the Measure drop down,
which is automatically populated with data elements from the visual. In this case, we'll select Weather as
the measure, label it Average Weather, and customize a few of the other options as shown below.

4. If you want to have a data label appear, move the Data label slider on. When you do so, you get a whole
host of additional options for your data label, as shown in the following image.



5. Notice the number that appears next to the Average line item in the Analytics pane. That tells you how
many dyanmic lines you currently have on your visual, and of which type. If we add a Max line for Cost of
Living, you can see that the Analytics pane shows that we now also have a Max line dynamic reference
line applied to this visual.



Apply Forecasting

If the visual you've selected can't have dynamic reference lines applied to it (in this case, a Map visual), you'll see
the following when you select the Analytics pane.

There are all sorts of interesting insights you can highlight by creating dynamic reference lines with the Analytics
pane.

We're planning more features and capabilities, including expanding which visuals can have dynamic reference
lines applied to them, so check back often for what's new.

You can use the Forecast feature by selecting a visual, then expanding the Forecast section of the Analytics



Limitations

pane. You can specify many inputs to modify the forecast, such as the Forecast length, the Confidence interval,
and others. The following image shows a basic line visual with forecasting applied, but you can use your
imagination (and play around with the forecasting feature) to see how it can apply to your models.

The ability to use dynamic reference lines is based on the type of visual being used. The following list shows which
dynamic lines are currently available for which visuals:

Full use of dynamic lines are available on the following visuals:

Area chart
Line chart
Scatter chart
Clustered Column chart
Clustered Bar chart

The following visuals can use only a constant line from the Analytics pane:

Stacked Area
Stacked Bar
Stacked Column
100% Stacked Bar
100% Stacked Column

For the following visuals, a trend line is currently the only option:

Non-stacked Line



Next steps

Clustered Column chart

Lastly, non-Cartesian visuals cannot currently apply dynamic lines from the Analytics pane, such as:

Matrix
Pie chart
Donut
Table

There are all sorts of things you can do with Power BI Desktop. For more information on its capabilities, check out
the following resources:

What's New in Power BI Desktop
Download Power BI Desktop
Getting Started with Power BI Desktop
Query Overview with Power BI Desktop
Data Types in Power BI Desktop
Shape and Combine Data with Power BI Desktop
Common Query Tasks in Power BI Desktop



Use insights in Power BI Desktop (Preview)
12/6/2017 • 2 min to read • Edit Online

NOTENOTE

Using insights

You can tell Power BI Desktop to explain increases or decreases in charts, and get fast, automated, insightful
analysis about your data. Simply right-click on a data point, and select Analyze > Explain the decrease (or
increase, if the previous bar was lower), and insight is delivered to you in an easy-to-use window.

The insights feature is contextual, and is based on the immediately previous data point - such as the previous bar,
or column.

This feature is in preview, and is subject to change. The insight feature is enabled and on by default (you don't need to check
a Preview box to enable it) beginning with the September 2017 version of Power BI Desktop.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-insights.md


To use insights, just right-click on any data point in a bar or line visual, and select Analyze > Explain the increase
(or Explain the decrease, since all insights are based on the change from the previous data point).

Power BI Desktop then runs its machine learning algorithms over the data, and populates a window with a visual
and a description that describes which categories most influenced the increase or decrease. By default, insights are
provided as a waterfall visual, as shown in the following image.

By selecting the small icons at the bottom of the waterfall visual, you can choose to have insights display a scatter
chart, stacked column chart, or a ribbon chart.



Considerations and limitations

Next steps

The thumbs up and thumbs down icons at the top of the page are provided so you can provide feedback about the
visual and the feature.

And importantly, the + button at the top of the visual lets you add the selected visual to your report, just as if you
created the visual manually. You can then format or otherwise adjust the added visual just as you would to any
other visual on your report. You can only add a selected insight visual when you're editing a report in Power BI
Desktop.

You can use insights when your report is in reading or editing mode, making it versatile for both analyzing data,
and for creating visuals you can easily add to your reports.

Since insights are based on the change from the previous data point, they aren't available when you select the first
data point in a visual.

The following list is the collection of currently unsupported scenarios for insights:

TopN filters
Include/exclude filters
Measure filters
Non-additive measures and aggregates
Show value as
Filtered measures (it’s the new thing we use for scatter chart in insights)
Categorical columns on X-axis unless it defines a sort by column that is scalar. If using a hierarchy, then every
column in the active hierarchy has to match this condition
Non-numeric measures

In addition, the following model types and data sources are currently not supported for insights:

DirectQuery
Live connect
On-premises Reporting Services
Embedding



For more information about Power BI Desktop, and how to get started, check out the following articles.

Getting Started with Power BI Desktop
Query Overview with Power BI Desktop
Data Sources in Power BI Desktop
Connect to Data in Power BI Desktop
Shape and Combine Data with Power BI Desktop
Common Query Tasks in Power BI Desktop



Use bookmarks to share insights and build stories in
Power BI (Preview)
1/25/2018 • 7 min to read • Edit Online

Enable the bookmarks previewEnable the bookmarks preview

Using bookmarks in Power BI you can capture the currently configured view of a report page, including filtering
and the state of visuals, and later go back to that state by simply selecting that saved bookmark.

You can also create a collection of bookmarks, arrange them in the order you want, and subsequently step through
each bookmark in a presentation to highlight a series of insights, or the story you want to tell with your visuals and
reports.

There are many uses for bookmarking. You can use them to keep track of your own progress in creating reports
(bookmarks are easy to add, delete, and rename), and you can create bookmarks to build a PowerPoint-like
presentation that steps through bookmarks in order, thereby telling a story with your report. There may be other
uses, too, based on how you think bookmarks could best be used.

You can try the new bookmarks feature beginning with the October 2017 release of Power BI Desktop, and for
bookmark-enabled reports, in the Power BI service as well. To enable this preview feature, select File > Options
and Settings > Options > Preview Features, then select the checkbox beside Bookmarks. You'll need to restart
Power BI Desktop after you make the selection.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-bookmarks.md


Using bookmarks

You'll need to restart Power BI Desktop after you make the selection.

To use bookmarks, select the View ribbon, then select the box for Bookmarks Pane.

When you create a bookmark, the following elements are saved with the bookmark:

The current page



Filters
Slicers
Sort order
Drill location
Visibility (of an object, using the Selection pane)
The focus or Spotlight modes of any visible object

Bookmarks do not currently save the cross-highlighting state.

Configure a report page the way you want it to appear in the bookmark. Once your report page and visuals are
arranged how you want them, select Add from the Bookmarks pane to add a bookmark.

Power BI Desktop create a bookmark and gives it a generic name. You can easily rename a bookmark, delete it, or
update a bookmark by selecting the elipses next to the bookmark's name, then selecting an action from the menu
that appears.



Arranging bookmarks

Bookmarks as a slide show

Once you have a bookmark, you can display it by simply clicking on the bookmark in the Bookmarks pane.

As you create bookmarks, you might find that the order in which you create them isn't necessarily the same order
you'd like to present them to your audience. No problem, you can easily rearrange the order of bookmarks.

In the Bookmarks pane, simply drag-and-drop bookmars to change their order, as shown in the following image.
The yellow bar between bookmarks designates where the dragged bookmark will be placed.

The order of your bookmarks can become important when you use the View feature of bookmarks, as described in
the next section.

When you have a collection of bookmarks you would like to present, in order, you can select View from the
Bookmarks pane to begin a slideshow.

When in View mode, there are a few features to notice:

1. The name of the bookmark appears in the bookmark title bar, which appears at the bottom of the canvas.
2. The bookmark title bar has arrows that let you move to the next or previous bookmark
3. You can exit View mode by selecting Exit from the Bookmarks pane, or by selecting the X found in the

bookmark title bar.



  Visibility - using the Selection pane

When you're in View mode, you can close the Bookmarks pane (by clicking the X on that pane) to provide more
space for your presentation. And while in View mode, all visuals are interactive and available for cross-
highlighting, just as they would otherwise be when interacting with them.

With the release of bookmarks, the new Selection pane is also introduced. The Selection pane provides a list of
all objects on the current page, and allows you to select the object and specify whether a given object is visible.

You can select an object using the Selection pane. Also, you can toggle whether the object is currently visible by
clicking the eye icon to the right of the visual.



  Bookmarks for shapes and images

When a bookmark is added, the visible status of each object is also saved based on its setting in the Selection
pane.

It's important to note that slicers continue to filter a report page, regardless of whether they are visible. As such,
you can create many different bookmarks, with different slicer settings, and make a single report page appear very
different (and highlight different insights) in various bookmarks.

You can also link shapes and images to bookmarks. With this feature, when you click on an object, it will show the
bookmark associated with that object.

To assign a bookmark to an object, select the object, then select Link from the Format Shape pane, as shown in
the following image.



  Using Spotlight

Once you turn the Link slider to On you can select whether the object is a link, or a bookmark. If you select
bookmark, you can then select which of your bookmarks the object is linked to.

There are all sorts of interesting things you can do with object-linked bookmarking. You can create a visual table of
contents on your report page, or you can provide different views (such as visual types) of the same information,
just by clicking on an object.

When you are in editing mode you can use ctrl+click to follow the link, and when not in edit mode, simply click the
object to follow the link.

Another feature released with bookmarks is Spotlight. With Spotlight you can draw attention to a specific chart,
for example, when presenting your bookmarks in View mode.

Let's compare Spotlight to focus mode to see how they differ.

1. In focus mode, you can have one visual fill the entire canvas by selecting the focus mode icon.
2. Using Spotlight, you can hightlight one visual in its original size, by making all other visuals on the page fade

to near transparency.



When the visual in the previous image has its focus icon clicked, the page looks like the following:

In contrast, when Spotlight is selected from the visual's elipses menu, the page looks like what you seen here:



Bookmarks in the Power BI service

If either mode is selected when a bookmark is added, that mode (focus or Spotlight) is retained in the bookmark.

When you publish a report to the Power BI service with at least one bookmark, you can view and interact with
those bookmarks in the Power BI service. For each report you publish, you must have at least one bookmark
created in the report, before you publish, for the bookmark feature to be available in the Power BI service.

When bookmarks are available in a report, you can select View > Selection pane or View > Bookmarks pane to
show each of those panes.

In the Power BI service the Bookmarks pane operates just as it does in Power BI Desktop, including the ability
to select View to show your bookmarks in order, like a slide show.

Note that you must use the gray bookmark title bar to navigate through the bookmarks, and not the black arrows
(the black arrows move you through report pages, not bookmarks).



Limitations and considerations

Next steps

In this preview release of the bookmarks, there are a few limitations and considerations to keep in mind.

Custom visuals do not work with bookmarking if they are the source of the filter. If you're using custom visuals
to filter elements on a page (for example, the chiclet slicer) and return to that page using a bookmark, the page
may be filtered but the custom visual won't be updated to show how the page is being filtered.
Cross-highlighting status for a report pane is not saved when you create a bookmark.
If you add a visual on a report page after creating a bookmark, the visual will be displayed in its default state.
This also means that if you introduce a slicer into a page where you previously created bookmarks, the slicer
will behave in its default state.
Moving around visuals after a bookmark has been created will be reflected in the bookmark.
You must have at least one bookmark in your report, when you publish it to the Power BI service, in order for
bookmarks to be available in the service. This is a requirement for each report you publish.
Since bookmarks are currently a Preview feature, they're not yet available in Power BI Desktop for Report
Server.

For more information about features that are similar or interact with bookmarks, take a look at the following
articles:

Use drillthrough in Power BI Desktop
Display a dashboard tile or report visual in Focus mode



Use Report Themes in Power BI Desktop (Preview)
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Enable Report Themes in PreviewEnable Report Themes in Preview

With Report Themes you can apply a color theme to your entire report, such as corporate colors, seasonal
coloring, or any other color theme you might want to apply a report. When you apply a Report Theme, all visuals
in your report use the colors from your selected theme (a few exceptions apply, described later in this article).

Applying a Report Theme requires a JSON file, using a basic structure, which you can then import into Power BI
Desktop and apply to your report. The JSON file structure, and the process of importing (it's just a few button
clicks) are quick and easy.

Beginning with the September 2017 release of Power BI Desktop, you can define even more report theme
elements using a JSON file, and customize (and standardize) nearly all elements using the JSON file that you can
manually adjust in the Formatting pane. The goal with the September 2017 release (and later) is to enable full
control over how your reports look and feel, to a granular level.

You can try the new Report Themes feature beginning with the March 2017 release of Power BI Desktop. To
enable this preview feature, select File > Options and Settings > Options > Preview Features, then select the
checkbox beside Custom Report Themes. You'll need to restart Power BI Desktop after you make the selection.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-report-themes.md


How Report Themes work
To apply a Report Theme to a Power BI Desktop report, select Switch Theme button from the Home ribbon, then
select Import Theme from the drop-down.

A window appears that lets you navigate to the location of the JSON theme file. Power BI Desktop looks for .JSON
files, which is the Power BI Report Theme File type. In the following image, a handful of holiday theme files are
available. We'll choose a holiday theme that happens in March.



Structure of a Report Theme JSON file

When the theme file is successfully loaded, Power BI Desktop lets you know.

Now that we've imported a theme file, let's take a look at the simple and straightforward JSON file structure.

The basic JSON file selected in the previous section (the St Patricks Day.json file), when opened in an editor, looks
like the following.

That JSON file has the following required lines:

name - this is the theme name, which is the only required field
dataColors - A list of hexcode color codes to use for data in Power BI Desktop visuals. The list can contain as
many or as few colors as desired
background, foreground and tableAccent - These values are colors that should be used in table and matrix
visuals. How these colors are used depends on the specific table or matrix style applied. The table and matrix
visuals apply these styles by default.

To apply a style to a table or matrix visual, select the visual and in the Visualizations pane select the Format
section, then expand Matrix style and select a style from the Style drop-down.



{
    "name": "St Patricks Day",
    "dataColors": ["#568410", "#3A6108", "#70A322", "#915203", "#D79A12", "#bb7711", "#114400", "#aacc66"],
    "background":"#FFFFFF",
    "foreground": "#3A6108",
    "tableAccent": "#568410"
}

How Report Theme colors stick to your reports

For easy cut-and-paste to create your own JSON file, here's the text of the St Patricks Day.json file:

From there you can enter your own color hexcode for your selected colors.

Beginning with the September 2017 release of Power BI Desktop, the JSON file can be much more elaborate. In
the JSON file, you only define the formatting that you want to affect, and anything not specified in your JSON file
simply reverts to the Power BI default settings.

The advantages of creating a JSON file are many. For example, you can specify that all charts use a font size of 12,
or that certain visuals use a particular font family, or turn off data labels for specific chart types.

With the ability to use a granular JSON file, you can create a theme file that standardizes your charts and reports,
making it easy for your organization reports to be consistent.

For information about the format of the detailed JSON file, see the Report theme JSON file format section at the
end of this article.

When you publish your report to the Power BI service, your Report Theme colors stay with it.

In addition, the Data colors section of the Format panel reflect your Report Theme. For example, after applying
the multitude of green and brown colors from the St. Patrick's Day theme, when we select a visual and go to



Situations when Report Theme colors won't stick to your reportsSituations when Report Theme colors won't stick to your reports

Format > Data colors we see the following.

See all that green? That's because those colors were part of the Report Theme we imported and applied.

If you apply a custom color set (or individual color) to a particular data point in a visual, applying a Report Theme
will not override that customized data point color.

In addition, if you've manually set a data point's color using the Theme colors section of the color palette, that (or
those) colors will not be updated when you apply a new Report Theme. To get your default colors back (so they'll
update when you apply a new Report Theme), you can select Revert to default in the Theme colors palette.



Report Theme files you can use right now

Also, many Custom Visuals will not apply Report Themes.

Want to get started with Report Themes? Great! Here are a handful of ready-made Report Theme JSON files that
you can download and import into your Power BI Desktop report, along with an image of that Report Theme
applied to the report used in this article.

The theme used in the blog post that announced the first release of Report Themes, called waveform.json.

The theme that's more visually impaired friendly than the default color theme, called ColorblindSafe-
Longer.json.

https://go.microsoft.com/fwlink/?linkid=843924
https://powerbi.microsoft.com/blog/power-bi-desktop-march-feature-summary/
https://go.microsoft.com/fwlink/?linkid=843924
https://go.microsoft.com/fwlink/?linkid=843923
https://go.microsoft.com/fwlink/?linkid=843923


A whole bunch of Power View themes wrapped in a zip file, including one called Apothecary.json shown below.

Lastly, here's one that is love-ly (the Valentine's Day theme) and sure to get your attention.

https://go.microsoft.com/fwlink/?linkid=843925
https://go.microsoft.com/fwlink/?linkid=843925


{
    "name": "Valentine's Day",
    "dataColors": ["#990011", "#cc1144", "#ee7799", "#eebbcc", "#cc4477", "#cc5555", "#882222", "#A30E33"],
    "background":"#FFFFFF",
    "foreground": "#ee7799",
    "tableAccent": "#990011"
}

Report theme JSON file format

Rather than a download, here's the code for the Valentine's day JSON file:

Report Themes can make your Power BI Desktop reports a colorful reflection of you, your organization, or even
the current season or holiday. Enjoy them, they're easy!

Here are a few more report themes you can use as starting points, too:

Sunflower-twilight
Plum
Autumn
High contrast

The basic JSON file has five required lines:

name - this is the theme name, which is the only required field
dataColors - A list of hexcode color codes to use for data in Power BI Desktop visuals. The list can contain as
many or as few colors as desired
background, foreground and tableAccent - These values are colors that should be used in table and matrix
visuals. How these colors are used depends on the specific table or matrix style applied. The table and matrix
visuals apply these styles by default.

To create an extended format JSON file, with more detailed and granular control over formatting, you need to add
a visualStyles section to the JSON file, and nest formatting specifics in that section. The format of the
visualStyles section looks like the following:

https://community.powerbi.com/t5/Themes-Gallery/Sunflower-Twilight/m-p/140749
https://community.powerbi.com/t5/Themes-Gallery/Plum/m-p/140711
https://community.powerbi.com/t5/Themes-Gallery/Autumn/m-p/140746
https://community.powerbi.com/t5/Themes-Gallery/Color-Blind-Friendly/m-p/140597


visualStyles: {
    visualName: {
        styleName: {
            cardName: [{
                propertyName: propertyValue
            }]
        }
    }
}

NOTENOTE

JSON file element definitionsJSON file element definitions

“datetime’2011-10-05T14:48:00.000Z’”

VISUALNAME

areaChart

barChart

basicShape

card

clusteredBarChart

clusteredColumnChart

columnChart

comboChart

donutChart

filledMap

For the visualName and cardName sections, you can list a specific visual and cardName, or you can use an
asterisk ("") if you want that setting to apply to all visuals or all cards that contain a property for a specific visual.
You can use the asterisk ("") when you want to apply a setting globally in your report, such as a font size or specific
font family that should be used throughout all visuals in your report.

You only need to specify the formatting elements you want to affect. Any formatting elements that are not included in the
JSON file simply revert to their default values and settings.

The tables in this section define visual names (visualName), card names (cardName), and the enumerations
necessary to create your JSON file.

When using dateTime, the date must be an ISO date in single quotes, with datetime at the beginning, like the
following:

Booleans are either true or false. Strings must be in double quotes, as in "this is a string".



funnel

gauge

hundredPercentStackedBarChart

hundredPercentStackedColumnChart

image

kpi

lineChart

lineClusteredColumnComboChart

lineStackedColumnComboChart

map

multiRowCard

pieChart

pivotTable

ribbonChart

scatterChart

shapeMap

slicer

stackedAreaChart

tableEx

treemap

waterfallChart

VISUALNAME

CARDNAME

axis: Gauge axis

breakdown: Breakdown

The following table defines cardName values. The first value in each cell is the JSON file term, the second value is
the name of the card as seen in the Power BI Desktop user interface.



bubbles: Bubbles

calloutValue: Callout Value

card: Card

cardTitle: Card Title

categoryAxis: X-Axis

categoryLabels: Category labels

columnFormatting: Field formatting

columnHeaders: Column headers

dataLabels: Data labels

fill: Fill

fillPoint: Fill point

forecast: Forecast

general: General

goals: Goals

grid: Grid

header: Header

imageScaling: Scaling

indicator: Indicator

items: Items

labels: Data labels

legend: Legend

lineStyles: Shapes

mapControls: Map controls

mapStyles: Map styles

numericInputStyle: Numeric inputs

CARDNAME



percentBarLabel: Conversion Rate Label

plotArea: Plot Area

plotAreaShading: Symmetry shading

ratioLine: Ratio line

referenceLine: Constant Line

ribbonChart: Ribbons

rotation: Rotation

rowHeaders: Row headers

selection: Selection Controls

sentimentColors: Sentiment colors

shape: Shape

slider: Slider

status: Color coding

subTotals: Subtotals

target: Target

total: Grand total

trend: Trend Line

trendline: Trend axis

valueAxis: Y-Axis

values: Values

wordWrap: Word wrap

xAxisReferenceLine: X-Axis Constant Line

y1AxisReferenceLine: Constant Line

zoom: Zoom

CARDNAME

Properties within each cardProperties within each card
The following section defines the properties within each card.



"general":
    "responsive": {
      "type": [
        "bool"
      ],
      "displayName": [
        "(Preview) Responsive"
      ],
      "description": [
        "The visual will adapt to size changes"
      ]
    }
    "legend": {
    "show": {
      "type": [
        "bool"
      ],
      "displayName": [
        "Show"
      ]
    },
    "position": {
      "type": [
        "enumeration"
      ],
      "displayName": [
        "Position"
      ],
      "description": [
        "Select the location for the legend"
      ]
    },
    "showTitle": {
      "type": [
        "bool"
      ],
      "displayName": [
        "Title"
      ],
      "description": [
        "Display a title for legend symbols"
      ]
    },
    "labelColor": {
      "type": [
        "fill"
      ],
      "displayName": [
        "Color"
      ]
    },
    "fontFamily": {
      "type": [
        "formatting"
      ],
      "displayName": [
        "Font family"
      ]
    },
    "fontSize": {
      "type": [
        "formatting"
      ],
      "displayName": [
        "Text Size"
      ]
    }
  },



"categoryAxis": {
    "show": {
      "type": [
        "bool"
      ],
      "displayName": [
        "Show"
      ]
    },
    "axisScale": {
      "type": [
        "enumeration"
      ],
      "displayName": [
        "Scale type"
      ]
    },
    "start": {
      "type": [
        "numeric",
        "dateTime"
      ],
      "displayName": [
        "Start"
      ],
      "description": [
        "Enter a starting value (optional)"
      ]
    },
    "end": {
      "type": [
        "numeric",
        "dateTime"
      ],
      "displayName": [
        "End"
      ],
      "description": [
        "Enter an ending value (optional)"
      ]
    },
    "axisType": {
      "type": [
        "enumeration"
      ],
      "displayName": [
        "Type"
      ]
    },
    "showAxisTitle": {
      "type": [
        "bool"
      ],
      "displayName": [
        "Title"
      ],
      "description": [
        "Title for the X-axis",
        "Title for the Y-axis"
      ]
    },
    "axisStyle": {
      "type": [
        "enumeration"
      ],
      "displayName": [
        "Style"
      ]
    },



    "labelColor": {
      "type": [
        "fill"
      ],
      "displayName": [
        "Color"
      ]
    },
    "fontFamily": {
      "type": [
        "formatting"
      ],
      "displayName": [
        "Font family"
      ]
    },
    "fontSize": {
      "type": [
        "formatting"
      ],
      "displayName": [
        "Text Size"
      ]
    },
    "labelDisplayUnits": {
      "type": [
        "formatting"
      ],
      "displayName": [
        "Display units"
      ],
      "description": [
        "Select the units (millions, billions, etc.)"
      ]
    },
    "labelPrecision": {
      "type": [
        "numeric"
      ],
      "displayName": [
        "Value decimal places"
      ],
      "description": [
        "Select the number of decimal places to display for the values"
      ]
    },
    "concatenateLabels": {
      "type": [
        "bool"
      ],
      "displayName": [
        "Concatenate labels"
      ],
      "description": [
        "Always concatenate levels of the hierarchy instead of drawing the hierarchy."
      ]
    },
    "preferredCategoryWidth": {
      "type": [
        "numeric"
      ],
      "displayName": [
        "Minimum category width"
      ]
    },
    "titleColor": {
      "type": [
        "fill"
      ],



      ],
      "displayName": [
        "Title color"
      ]
    },
    "titleFontFamily": {
      "type": [
        "formatting"
      ],
      "displayName": [
        "Font family"
      ]
    },
    "titleFontSize": {
      "type": [
        "formatting"
      ],
      "displayName": [
        "Title text size"
      ]
    },
    "position": {
      "type": [
        "enumeration"
      ],
      "displayName": [
        "Position"
      ],
      "description": [
        "Select left or right"
      ]
    },
    "color": {
      "type": [
        "fill"
      ],
      "displayName": [
        "Color"
      ],
      "description": [
        "Select color for data labels"
      ]
    },
    "duration": {
      "type": [
        "numeric"
      ]
    }
  },
"valueAxis": {
    "show": {
      "type": [
        "bool"
      ],
      "displayName": [
        "Show"
      ]
    },
    "position": {
      "type": [
        "enumeration"
      ],
      "displayName": [
        "Position"
      ],
      "description": [
        "Select left or right"
      ]
    },
    "axisScale": {



    "axisScale": {
      "type": [
        "enumeration"
      ],
      "displayName": [
        "Scale type"
      ]
    },
    "start": {
      "type": [
        "numeric",
        "dateTime"
      ],
      "displayName": [
        "Start"
      ],
      "description": [
        "Enter a starting value (optional)"
      ]
    },
    "end": {
      "type": [
        "numeric",
        "dateTime"
      ],
      "displayName": [
        "End"
      ],
      "description": [
        "Enter an ending value (optional)"
      ]
    },
    "showAxisTitle": {
      "type": [
        "bool"
      ],
      "displayName": [
        "Title"
      ],
      "description": [
        "Title for the Y-axis",
        "Title for the X-axis"
      ]
    },
    "axisStyle": {
      "type": [
        "enumeration"
      ],
      "displayName": [
        "Style"
      ]
    },
    "labelColor": {
      "type": [
        "fill"
      ],
      "displayName": [
        "Color"
      ]
    },
    "fontFamily": {
      "type": [
        "formatting"
      ],
      "displayName": [
        "Font family"
      ]
    },
    "fontSize": {
      "type": [



      "type": [
        "formatting"
      ],
      "displayName": [
        "Text Size"
      ]
    },
    "labelDisplayUnits": {
      "type": [
        "formatting"
      ],
      "displayName": [
        "Display units"
      ],
      "description": [
        "Select the units (millions, billions, etc.)"
      ]
    },
    "labelPrecision": {
      "type": [
        "numeric"
      ],
      "displayName": [
        "Value decimal places"
      ],
      "description": [
        "Select the number of decimal places to display for the values"
      ]
    },
    "titleColor": {
      "type": [
        "fill"
      ],
      "displayName": [
        "Title color"
      ]
    },
    "titleFontFamily": {
      "type": [
        "formatting"
      ],
      "displayName": [
        "Font family"
      ]
    },
    "titleFontSize": {
      "type": [
        "formatting"
      ],
      "displayName": [
        "Title text size"
      ]
    },
    "axisLabel": {
      "type": [
        "none"
      ],
      "displayName": [
        "Y-Axis (Column)"
      ]
    },
    "secShow": {
      "type": [
        "bool"
      ],
      "displayName": [
        "Show secondary"
      ]
    },
    "alignZeros": {



    "alignZeros": {
      "type": [
        "bool"
      ],
      "displayName": [
        "Align zeros"
      ],
      "description": [
        "Align the zero tick marks for both value axes"
      ]
    },
    "secAxisLabel": {
      "type": [
        "none"
      ],
      "displayName": [
        "Y-Axis (Line)"
      ]
    },
    "secPosition": {
      "type": [
        "enumeration"
      ],
      "displayName": [
        "Position"
      ],
      "description": [
        "Select left or right"
      ]
    },
    "secAxisScale": {
      "type": [
        "enumeration"
      ],
      "displayName": [
        "Scale type"
      ]
    },
    "secStart": {
      "type": [
        "numeric"
      ],
      "displayName": [
        "Start"
      ],
      "description": [
        "Enter a starting value (optional)"
      ]
    },
    "secEnd": {
      "type": [
        "numeric"
      ],
      "displayName": [
        "End"
      ],
      "description": [
        "Enter an ending value (optional)"
      ]
    },
    "secShowAxisTitle": {
      "type": [
        "bool"
      ],
      "displayName": [
        "Title"
      ],
      "description": [
        "Title for the Y-axis"



      ]
    },
    "secAxisStyle": {
      "type": [
        "enumeration"
      ],
      "displayName": [
        "Style"
      ]
    },
    "secLabelColor": {
      "type": [
        "fill"
      ],
      "displayName": [
        "Color"
      ]
    },
    "secFontFamily": {
      "type": [
        "formatting"
      ],
      "displayName": [
        "Font family"
      ]
    },
    "secFontSize": {
      "type": [
        "formatting"
      ],
      "displayName": [
        "Text Size"
      ]
    },
    "secLabelDisplayUnits": {
      "type": [
        "formatting"
      ],
      "displayName": [
        "Display units"
      ],
      "description": [
        "Select the units (millions, billions, etc.)"
      ]
    },
    "secLabelPrecision": {
      "type": [
        "numeric"
      ],
      "displayName": [
        "Value decimal places"
      ],
      "description": [
        "Select the number of decimal places to display for the values"
      ]
    },
    "secTitleColor": {
      "type": [
        "fill"
      ],
      "displayName": [
        "Title color"
      ]
    },
    "secTitleFontFamily": {
      "type": [
        "formatting"
      ],
      "displayName": [



        "Font family"
      ]
    },
    "secTitleFontSize": {
      "type": [
        "formatting"
      ],
      "displayName": [
        "Title text size"
      ]
    }
  },
"dataPoint": {
    "defaultColor": {
      "type": [
        "fill"
      ],
      "displayName": [
        "Default color",
        "Default Column Color"
      ]
    },
    "fill": {
      "type": [
        "fill"
      ],
      "displayName": [
        "Fill"
      ]
    },
    "defaultCategoryColor": {
      "type": [
        "fill"
      ],
      "displayName": [
        "Default color",
        "Default Column Color"
      ]
    },
    "showAllDataPoints": {
      "type": [
        "bool"
      ],
      "displayName": [
        "Show all"
      ]
    }
  },
"labels": {
    "show": {
      "type": [
        "bool"
      ],
      "displayName": [
        "Show"
      ]
    },
    "showSeries": {
      "type": [
        "bool"
      ],
      "displayName": [
        "Show"
      ]
    },
    "color": {
      "type": [
        "fill"
      ],



      ],
      "displayName": [
        "Color"
      ],
      "description": [
        "Select color for data labels"
      ]
    },
    "labelDisplayUnits": {
      "type": [
        "formatting"
      ],
      "displayName": [
        "Display units"
      ],
      "description": [
        "Select the units (millions, billions, etc.)"
      ]
    },
    "labelPrecision": {
      "type": [
        "numeric"
      ],
      "displayName": [
        "Value decimal places"
      ],
      "description": [
        "Select the number of decimal places to display for the values"
      ]
    },
    "showAll": {
      "type": [
        "bool"
      ],
      "displayName": [
        "Customize series"
      ]
    },
    "fontSize": {
      "type": [
        "formatting"
      ],
      "displayName": [
        "Text Size"
      ]
    },
    "fontFamily": {
      "type": [
        "formatting"
      ],
      "displayName": [
        "Font family"
      ]
    },
    "labelDensity": {
      "type": [
        "formatting"
      ],
      "displayName": [
        "Label density"
      ]
    },
    "labelOrientation": {
      "type": [
        "enumeration"
      ],
      "displayName": [
        "Orientation"
      ]
    },



    },
    "labelPosition": {
      "type": [
        "enumeration"
      ],
      "displayName": [
        "Position"
      ]
    },
    "percentageLabelPrecision": {
      "type": [
        "numeric"
      ],
      "displayName": [
        "% decimal places"
      ],
      "description": [
        "Select the number of decimal places to display for the percentages"
      ]
    },
    "labelStyle": {
      "type": [
        "enumeration"
      ],
      "displayName": [
        "Label style"
      ]
    }
  },
"lineStyles": {
    "strokeWidth": {
      "type": [
        "numeric"
      ],
      "displayName": [
        "Stroke width"
      ]
    },
    "strokeLineJoin": {
      "type": [
        "enumeration"
      ],
      "displayName": [
        "Join type"
      ]
    },
    "lineStyle": {
      "type": [
        "enumeration"
      ],
      "displayName": [
        "Line style"
      ]
    },
    "showMarker": {
      "type": [
        "bool"
      ],
      "displayName": [
        "Show marker"
      ]
    },
    "markerShape": {
      "type": [
        "enumeration"
      ],
      "displayName": [
        "Marker shape"
      ]
    },



    },
    "markerSize": {
      "type": [
        "numeric"
      ],
      "displayName": [
        "Marker size"
      ]
    },
    "markerColor": {
      "type": [
        "fill"
      ],
      "displayName": [
        "Marker color"
      ]
    },
    "showSeries": {
      "type": [
        "bool"
      ],
      "displayName": [
        "Customize series",
        "Show"
      ]
    },
    "shadeArea": {
      "type": [
        "bool"
      ],
      "displayName": [
        "Shade area"
      ]
    }
  },
"plotArea": {
    "transparency": {
      "type": [
        "numeric"
      ],
      "displayName": [
        "Transparency"
      ],
      "description": [
        "Set transparency for background color"
      ]
    }
  },
"trend": {
    "show": {
      "type": [
        "bool"
      ],
      "displayName": [
        "Show"
      ]
    },
    "displayName": {
      "type": [
        "text"
      ],
      "displayName": [
        "Name"
      ],
      "description": [
        "Set trend line name"
      ]
    },
    "lineColor": {
      "type": [



      "type": [
        "fill"
      ],
      "displayName": [
        "Color"
      ],
      "description": [
        "Set trend line color"
      ]
    },
    "transparency": {
      "type": [
        "numeric"
      ],
      "displayName": [
        "Transparency"
      ],
      "description": [
        "Set transparency for trend line color"
      ]
    },
    "style": {
      "type": [
        "enumeration"
      ],
      "displayName": [
        "Style"
      ],
      "description": [
        "Set trend line style"
      ]
    },
    "combineSeries": {
      "type": [
        "bool"
      ],
      "displayName": [
        "Combine Series"
      ],
      "description": [
        "Show one trend line per series or combine"
      ]
    }
  },
  "y1AxisReferenceLine": {
    "show": {
      "type": [
        "bool"
      ],
      "displayName": [
        "Show"
      ]
    },
    "value": {
      "type": [
        "numeric"
      ],
      "displayName": [
        "Value"
      ],
      "description": [
        "Set reference line numeric value "
      ]
    },
    "lineColor": {
      "type": [
        "fill"
      ],
      "displayName": [
        "Color"



        "Color"
      ],
      "description": [
        "Set reference line color"
      ]
    },
    "transparency": {
      "type": [
        "numeric"
      ],
      "displayName": [
        "Transparency"
      ],
      "description": [
        "Set transparency for reference line color"
      ]
    },
    "style": {
      "type": [
        "enumeration"
      ],
      "displayName": [
        "Line style"
      ]
    },
    "position": {
      "type": [
        "enumeration"
      ],
      "displayName": [
        "Position"
      ],
      "description": [
        "Arrange relative to chart data points"
      ]
    },
    "dataLabelShow": {
      "type": [
        "bool"
      ],
      "displayName": [
        "Data label"
      ],
      "description": [
        "Display a data label for the reference line"
      ]
    },
    "dataLabelColor": {
      "type": [
        "fill"
      ],
      "displayName": [
        "Color"
      ],
      "description": [
        "Set the reference line data label color"
      ]
    },
    "dataLabelDecimalPoints": {
      "type": [
        "numeric"
      ],
      "displayName": [
        "Decimal Places"
      ]
    },
    "dataLabelHorizontalPosition": {
      "type": [
        "enumeration"



      ],
      "displayName": [
        "Horizontal Position"
      ],
      "description": [
        "Set the horizontal position for the reference line data label"
      ]
    },
    "dataLabelVerticalPosition": {
      "type": [
        "enumeration"
      ],
      "displayName": [
        "Vertical Position"
      ],
      "description": [
        "Set the vertical position for the reference line data label"
      ]
    },
    "dataLabelDisplayUnits": {
      "type": [
        "formatting"
      ],
      "displayName": [
        "Display units"
      ],
      "description": [
        "Select the units (millions, billions, etc.)"
      ]
    }
  },
"referenceLine": {
    "show": {
      "type": [
        "bool"
      ],
      "displayName": [
        "Show"
      ]
    },
    "displayName": {
      "type": [
        "text"
      ],
      "displayName": [
        "Name"
      ],
      "description": [
        "Set reference line name"
      ]
    },
    "value": {
      "type": [
        "numeric"
      ],
      "displayName": [
        "Value"
      ],
      "description": [
        "Set reference line numeric value "
      ]
    },
    "lineColor": {
      "type": [
        "fill"
      ],
      "displayName": [
        "Color"
      ],



      ],
      "description": [
        "Set reference line color"
      ]
    },
    "transparency": {
      "type": [
        "numeric"
      ],
      "displayName": [
        "Transparency"
      ],
      "description": [
        "Set transparency for reference line color"
      ]
    },
    "style": {
      "type": [
        "enumeration"
      ],
      "displayName": [
        "Line style"
      ]
    },
    "position": {
      "type": [
        "enumeration"
      ],
      "displayName": [
        "Position"
      ],
      "description": [
        "Arrange relative to chart data points"
      ]
    },
    "dataLabelShow": {
      "type": [
        "bool"
      ],
      "displayName": [
        "Data label"
      ],
      "description": [
        "Display a data label for the reference line"
      ]
    },
    "dataLabelColor": {
      "type": [
        "fill"
      ],
      "displayName": [
        "Color"
      ],
      "description": [
        "Set the reference line data label color"
      ]
    },
    "dataLabelDecimalPoints": {
      "type": [
        "numeric"
      ],
      "displayName": [
        "Decimal Places"
      ]
    },
    "dataLabelHorizontalPosition": {
      "type": [
        "enumeration"
      ],
      "displayName": [



      "displayName": [
        "Horizontal Position"
      ],
      "description": [
        "Set the horizontal position for the reference line data label"
      ]
    },
    "dataLabelVerticalPosition": {
      "type": [
        "enumeration"
      ],
      "displayName": [
        "Vertical Position"
      ],
      "description": [
        "Set the vertical position for the reference line data label"
      ]
    },
    "dataLabelDisplayUnits": {
      "type": [
        "formatting"
      ],
      "displayName": [
        "Display units"
      ],
      "description": [
        "Select the units (millions, billions, etc.)"
      ]
    }
  },
"line": {
    "lineColor": {
      "type": [
        "fill"
      ],
      "displayName": [
        "Line color"
      ]
    },
    "transparency": {
      "type": [
        "numeric"
      ],
      "displayName": [
        "Transparency"
      ],
      "description": [
        "Set transparency for background color"
      ]
    },
    "weight": {
      "type": [
        "numeric"
      ],
      "displayName": [
        "Weight"
      ]
    },
    "roundEdge": {
      "type": [
        "numeric"
      ],
      "displayName": [
        "Round edges"
      ]
    }
  },
"fill": {
    "show": {
      "type": [



      "type": [
        "bool"
      ],
      "displayName": [
        "Show"
      ]
    },
    "fillColor": {
      "type": [
        "fill"
      ],
      "displayName": [
        "Fill color"
      ]
    },
    "transparency": {
      "type": [
        "numeric"
      ],
      "displayName": [
        "Transparency"
      ],
      "description": [
        "Set transparency for background color"
      ]
    }
  },
"rotation": {
    "angle": {
      "type": [
        "numeric"
      ],
      "displayName": [
        "Rotation"
      ]
    }
  },
"categoryLabels": {
    "show": {
      "type": [
        "bool"
      ],
      "displayName": [
        "Show"
      ]
    },
    "color": {
      "type": [
        "fill"
      ],
      "displayName": [
        "Color"
      ],
      "description": [
        "Select color for data labels"
      ]
    },
    "fontSize": {
      "type": [
        "formatting"
      ],
      "displayName": [
        "Text Size"
      ]
    },
    "fontFamily": {
      "type": [
        "formatting"
      ],
      "displayName": [



      "displayName": [
        "Font family"
      ]
    }
  },
"wordWrap": {
    "show": {
      "type": [
        "bool"
      ],
      "displayName": [
        "Show"
      ]
    }
  },
"dataLabels": {
    "color": {
      "type": [
        "fill"
      ],
      "displayName": [
        "Color"
      ],
      "description": [
        "Select color for data labels"
      ]
    },
    "fontSize": {
      "type": [
        "formatting"
      ],
      "displayName": [
        "Text Size"
      ]
    },
    "fontFamily": {
      "type": [
        "formatting"
      ],
      "displayName": [
        "Font family"
      ]
    }
  },
"cardTitle": {
    "color": {
      "type": [
        "fill"
      ],
      "displayName": [
        "Color"
      ],
      "description": [
        "Select color for data labels"
      ]
    },
    "fontSize": {
      "type": [
        "formatting"
      ],
      "displayName": [
        "Text Size"
      ]
    },
    "fontFamily": {
      "type": [
        "formatting"
      ],
      "displayName": [
        "Font family"



        "Font family"
      ]
    }
  },
"card": {
    "outline": {
      "type": [
        "enumeration"
      ],
      "displayName": [
        "Outline"
      ]
    },
    "outlineColor": {
      "type": [
        "fill"
      ],
      "displayName": [
        "Outline color"
      ],
      "description": [
        "Color of the outline"
      ]
    },
    "outlineWeight": {
      "type": [
        "numeric"
      ],
      "displayName": [
        "Outline weight"
      ],
      "description": [
        "Thickness of the outline in pixels"
      ]
    },
    "barShow": {
      "type": [
        "bool"
      ],
      "displayName": [
        "Show bar"
      ],
      "description": [
        "Display a bar to the left side of the card as an accent"
      ]
    },
    "barColor": {
      "type": [
        "fill"
      ],
      "displayName": [
        "Bar color"
      ]
    },
    "barWeight": {
      "type": [
        "numeric"
      ],
      "displayName": [
        "Bar thickness"
      ],
      "description": [
        "Thickness of the bar in pixels"
      ]
    },
    "cardPadding": {
      "type": [
        "numeric"
      ],



      "displayName": [
        "Padding"
      ],
      "description": [
        "Background"
      ]
    },
    "cardBackground": {
      "type": [
        "fill"
      ],
      "displayName": [
        "Background"
      ]
    }
  },
"percentBarLabel": {
    "show": {
      "type": [
        "bool"
      ],
      "displayName": [
        "Show"
      ]
    },
    "color": {
      "type": [
        "fill"
      ],
      "displayName": [
        "Color"
      ],
      "description": [
        "Select color for data labels"
      ]
    },
    "fontSize": {
      "type": [
        "formatting"
      ],
      "displayName": [
        "Text Size"
      ]
    },
    "fontFamily": {
      "type": [
        "formatting"
      ],
      "displayName": [
        "Font family"
      ]
    }
  },
"axis": {
    "min": {
      "type": [
        "numeric"
      ],
      "displayName": [
        "Min"
      ]
    },
    "max": {
      "type": [
        "numeric"
      ],
      "displayName": [
        "Max"
      ]



    },
    "target": {
      "type": [
        "numeric"
      ],
      "displayName": [
        "Target"
      ]
    }
  },
"target": {
    "show": {
      "type": [
        "bool"
      ],
      "displayName": [
        "Show"
      ]
    },
    "color": {
      "type": [
        "fill"
      ],
      "displayName": [
        "Color"
      ],
      "description": [
        "Select color for data labels"
      ]
    },
    "labelDisplayUnits": {
      "type": [
        "formatting"
      ],
      "displayName": [
        "Display units"
      ],
      "description": [
        "Select the units (millions, billions, etc.)"
      ]
    },
    "labelPrecision": {
      "type": [
        "numeric"
      ],
      "displayName": [
        "Value decimal places"
      ],
      "description": [
        "Select the number of decimal places to display for the values"
      ]
    },
    "fontSize": {
      "type": [
        "formatting"
      ],
      "displayName": [
        "Text Size"
      ]
    },
    "fontFamily": {
      "type": [
        "formatting"
      ],
      "displayName": [
        "Font family"
      ]
    }
  },



  },
"calloutValue": {
    "show": {
      "type": [
        "bool"
      ],
      "displayName": [
        "Show"
      ]
    },
    "color": {
      "type": [
        "fill"
      ],
      "displayName": [
        "Color"
      ],
      "description": [
        "Select color for data labels"
      ]
    },
    "labelDisplayUnits": {
      "type": [
        "formatting"
      ],
      "displayName": [
        "Display units"
      ],
      "description": [
        "Select the units (millions, billions, etc.)"
      ]
    },
    "labelPrecision": {
      "type": [
        "numeric"
      ],
      "displayName": [
        "Value decimal places"
      ],
      "description": [
        "Select the number of decimal places to display for the values"
      ]
    }
  },
"forecast": {
    "show": {
      "type": [
        "bool"
      ],
      "displayName": [
        "Show"
      ]
    },
    "displayName": {
      "type": [
        "text"
      ],
      "displayName": [
        "Name"
      ],
      "description": [
        "Set forecast name"
      ]
    },
    "confidenceBandStyle": {
      "type": [
        "enumeration"
      ],
      "displayName": [
        "Confidence band style"



        "Confidence band style"
      ],
      "description": [
        "Set forecast confidence band style"
      ]
    },
    "lineColor": {
      "type": [
        "fill"
      ],
      "displayName": [
        "Color"
      ],
      "description": [
        "Set forecast line color"
      ]
    },
    "transparency": {
      "type": [
        "numeric"
      ],
      "displayName": [
        "Transparency"
      ],
      "description": [
        "Set transparency for background color"
      ]
    },
    "style": {
      "type": [
        "enumeration"
      ],
      "displayName": [
        "Line style"
      ]
    },
    "transform": {
      "type": [
        "queryTransform"
      ]
    }
  },
"bubbles": {
    "bubbleSize": {
      "type": [
        "formatting"
      ],
      "displayName": [
        "Size"
      ]
    }
  },
"mapControls": {
    "autoZoom": {
      "type": [
        "bool"
      ],
      "displayName": [
        "Auto zoom"
      ]
    },
    "zoomLevel": {
      "type": [
        "numeric"
      ]
    },
    "centerLatitude": {
      "type": [
        "numeric"
      ]



      ]
    },
    "centerLongitude": {
      "type": [
        "numeric"
      ]
    }
  },
"mapStyles": {
    "mapTheme": {
      "type": [
        "enumeration"
      ],
      "displayName": [
        "Theme"
      ]
    }
  },
"shape": {
    "map": {
      "type": [
        "geoJson"
      ]
    },
    "projectionEnum": {
      "type": [
        "enumeration"
      ],
      "displayName": [
        "Projection"
      ],
      "description": [
        "Projection"
      ]
    }
  },
"zoom": {
    "autoZoom": {
      "type": [
        "bool"
      ],
      "displayName": [
        "Auto zoom"
      ],
      "description": [
        "Zoom in on shapes with available data"
      ]
    },
    "selectionZoom": {
      "type": [
        "bool"
      ],
      "displayName": [
        "Selection zoom"
      ],
      "description": [
        "Zoom in on selected shapes"
      ]
    },
    "manualZoom": {
      "type": [
        "bool"
      ],
      "displayName": [
        "Manual zoom"
      ],
      "description": [
        "Allow user to zoom and pan"
      ]
    }



    }
  },
"xAxisReferenceLine": {
    "show": {
      "type": [
        "bool"
      ],
      "displayName": [
        "Show"
      ]
    },
    "value": {
      "type": [
        "numeric"
      ],
      "displayName": [
        "Value"
      ],
      "description": [
        "Set reference line numeric value "
      ]
    },
    "lineColor": {
      "type": [
        "fill"
      ],
      "displayName": [
        "Color"
      ],
      "description": [
        "Set reference line color"
      ]
    },
    "transparency": {
      "type": [
        "numeric"
      ],
      "displayName": [
        "Transparency"
      ],
      "description": [
        "Set transparency for reference line color"
      ]
    },
    "style": {
      "type": [
        "enumeration"
      ],
      "displayName": [
        "Line style"
      ]
    },
    "position": {
      "type": [
        "enumeration"
      ],
      "displayName": [
        "Position"
      ],
      "description": [
        "Arrange relative to chart data points"
      ]
    },
    "dataLabelShow": {
      "type": [
        "bool"
      ],
      "displayName": [
        "Data label"



      ],
      "description": [
        "Display a data label for the reference line"
      ]
    },
    "dataLabelColor": {
      "type": [
        "fill"
      ],
      "displayName": [
        "Color"
      ],
      "description": [
        "Set the reference line data label color"
      ]
    },
    "dataLabelDecimalPoints": {
      "type": [
        "numeric"
      ],
      "displayName": [
        "Decimal Places"
      ]
    },
    "dataLabelHorizontalPosition": {
      "type": [
        "enumeration"
      ],
      "displayName": [
        "Horizontal Position"
      ],
      "description": [
        "Set the horizontal position for the reference line data label"
      ]
    },
    "dataLabelVerticalPosition": {
      "type": [
        "enumeration"
      ],
      "displayName": [
        "Vertical Position"
      ],
      "description": [
        "Set the vertical position for the reference line data label"
      ]
    },
    "dataLabelDisplayUnits": {
      "type": [
        "formatting"
      ],
      "displayName": [
        "Display units"
      ],
      "description": [
        "Select the units (millions, billions, etc.)"
      ]
    }
  },
"fillPoint": {
    "show": {
      "type": [
        "bool"
      ],
      "displayName": [
        "Show"
      ]
    }
  },
"colorByCategory": {



    "show": {
      "type": [
        "bool"
      ],
      "displayName": [
        "Show"
      ]
    }
  },
"plotAreaShading": {
    "show": {
      "type": [
        "bool"
      ],
      "displayName": [
        "Show"
      ]
    },
    "upperShadingColor": {
      "type": [
        "fill"
      ],
      "displayName": [
        "Upper shading"
      ],
      "description": [
        "Shading color of the upper region"
      ]
    },
    "lowerShadingColor": {
      "type": [
        "fill"
      ],
      "displayName": [
        "Lower shading"
      ],
      "description": [
        "Shading color of the lower region"
      ]
    },
    "transparency": {
      "type": [
        "numeric"
      ],
      "displayName": [
        "Transparency"
      ],
      "description": [
        "Set transparency for background color"
      ]
    }
  },
"ratioLine": {
    "show": {
      "type": [
        "bool"
      ],
      "displayName": [
        "Show"
      ]
    },
    "lineColor": {
      "type": [
        "fill"
      ],
      "displayName": [
        "Color"
      ],
      "description": [



      "description": [
        "Set reference line color"
      ]
    },
    "transparency": {
      "type": [
        "numeric"
      ],
      "displayName": [
        "Transparency"
      ],
      "description": [
        "Set transparency for line color"
      ]
    },
    "style": {
      "type": [
        "enumeration"
      ],
      "displayName": [
        "Line style"
      ]
    }
  },
"grid": {
    "outlineColor": {
      "type": [
        "fill"
      ],
      "displayName": [
        "Outline color"
      ],
      "description": [
        "Color of the outline"
      ]
    },
    "outlineWeight": {
      "type": [
        "numeric"
      ],
      "displayName": [
        "Outline weight"
      ],
      "description": [
        "Thickness of the outline in pixels"
      ]
    },
    "gridVertical": {
      "type": [
        "bool"
      ],
      "displayName": [
        "Vert grid"
      ],
      "description": [
        "Show/Hide the vertical gridlines"
      ]
    },
    "gridVerticalColor": {
      "type": [
        "fill"
      ],
      "displayName": [
        "Vert grid color"
      ],
      "description": [
        "Color for the vertical gridlines"
      ]
    },
    "gridVerticalWeight": {



    "gridVerticalWeight": {
      "type": [
        "numeric"
      ],
      "displayName": [
        "Vert grid thickness"
      ],
      "description": [
        "Thickness of the vertical gridlines in pixels"
      ]
    },
    "gridHorizontal": {
      "type": [
        "bool"
      ],
      "displayName": [
        "Horiz grid"
      ],
      "description": [
        "Show/Hide the horizontal gridlines"
      ]
    },
    "gridHorizontalColor": {
      "type": [
        "fill"
      ],
      "displayName": [
        "Horiz grid color"
      ],
      "description": [
        "Color for the horizontal gridlines"
      ]
    },
    "gridHorizontalWeight": {
      "type": [
        "numeric"
      ],
      "displayName": [
        "Horiz grid thickness"
      ],
      "description": [
        "Thickness of the horizontal gridlines in pixels"
      ]
    },
    "rowPadding": {
      "type": [
        "numeric"
      ],
      "displayName": [
        "Row padding"
      ],
      "description": [
        "Padding in pixels applied to top and bottom of every row"
      ]
    },
    "imageHeight": {
      "type": [
        "numeric"
      ],
      "displayName": [
        "Image height"
      ],
      "description": [
        "The height of images in pixels"
      ]
    },
    "textSize": {
      "type": [
        "numeric"
      ],



      ],
      "displayName": [
        "Text Size"
      ]
    }
  },
"columnHeaders": {
    "outline": {
      "type": [
        "enumeration"
      ],
      "displayName": [
        "Outline"
      ]
    },
    "fontColor": {
      "type": [
        "fill"
      ],
      "displayName": [
        "Font color"
      ],
      "description": [
        "Font color of the cells"
      ]
    },
    "backColor": {
      "type": [
        "fill"
      ],
      "displayName": [
        "Background color"
      ],
      "description": [
        "Background color of the cells"
      ]
    },
    "wordWrap": {
      "type": [
        "bool"
      ],
      "displayName": [
        "Word wrap"
      ]
    },
    "fontFamily": {
      "type": [
        "formatting"
      ],
      "displayName": [
        "Font family"
      ]
    },
    "fontSize": {
      "type": [
        "formatting"
      ],
      "displayName": [
        "Text Size"
      ]
    },
    "autoSizeColumnWidth": {
      "type": [
        "bool"
      ],
      "displayName": [
        "Auto-size column width"
      ]
    },
    "urlIcon": {



    "urlIcon": {
      "type": [
        "bool"
      ],
      "displayName": [
        "URL icon"
      ],
      "description": [
        "Show an icon instead of the full URL"
      ]
    }
  },
"values": {
    "outline": {
      "type": [
        "enumeration"
      ],
      "displayName": [
        "Outline"
      ]
    },
    "backColor": {
      "type": [
        "fill"
      ],
      "displayName": [
        "Color scales"
      ]
    },
    "fontColorPrimary": {
      "type": [
        "fill"
      ],
      "displayName": [
        "Font color"
      ],
      "description": [
        "Font color of the odd rows"
      ]
    },
    "backColorPrimary": {
      "type": [
        "fill"
      ],
      "displayName": [
        "Background color"
      ],
      "description": [
        "Background color of the odd rows"
      ]
    },
    "fontColorSecondary": {
      "type": [
        "fill"
      ],
      "displayName": [
        "Alternate font color"
      ],
      "description": [
        "Font color of the even rows"
      ]
    },
    "backColorSecondary": {
      "type": [
        "fill"
      ],
      "displayName": [
        "Alternate background color"
      ],
      "description": [



      "description": [
        "Background color of the even rows"
      ]
    },
    "urlIcon": {
      "type": [
        "bool"
      ],
      "displayName": [
        "URL icon"
      ],
      "description": [
        "Show an icon instead of the full URL"
      ]
    },
    "fontFamily": {
      "type": [
        "formatting"
      ],
      "displayName": [
        "Font family"
      ]
    },
    "fontSize": {
      "type": [
        "formatting"
      ],
      "displayName": [
        "Text Size"
      ]
    },
    "wordWrap": {
      "type": [
        "bool"
      ],
      "displayName": [
        "Word wrap"
      ]
    },
    "bandedRowHeaders": {
      "type": [
        "bool"
      ],
      "displayName": [
        "Banded row style"
      ],
      "description": [
        "Apply banded row style to the last level of the row group headers, using the colors of the values."
      ]
    },
    "valuesOnRow": {
      "type": [
        "bool"
      ],
      "displayName": [
        "Show on rows"
      ],
      "description": [
        "Show values in row groups rather than columns"
      ]
    }
  },
"total": {
    "outline": {
      "type": [
        "enumeration"
      ],
      "displayName": [
        "Outline"



      ]
    },
    "fontColor": {
      "type": [
        "fill"
      ],
      "displayName": [
        "Font color"
      ],
      "description": [
        "Font color of the cells"
      ]
    },
    "backColor": {
      "type": [
        "fill"
      ],
      "displayName": [
        "Background color"
      ],
      "description": [
        "Background color of the cells"
      ]
    },
    "applyToHeaders": {
      "type": [
        "bool"
      ],
      "displayName": [
        "Apply to labels"
      ]
    },
    "totals": {
      "type": [
        "bool"
      ],
      "displayName": [
        "Totals"
      ]
    },
    "fontFamily": {
      "type": [
        "formatting"
      ],
      "displayName": [
        "Font family"
      ]
    },
    "fontSize": {
      "type": [
        "formatting"
      ],
      "displayName": [
        "Text Size"
      ]
    }
  },
"columnFormatting": {
    "fontColor": {
      "type": [
        "fill"
      ],
      "displayName": [
        "Font color"
      ],
      "description": [
        "Font color of the cells"
      ]
    },



    },
    "backColor": {
      "type": [
        "fill"
      ],
      "displayName": [
        "Background color"
      ],
      "description": [
        "Background color of the cells"
      ]
    },
    "styleHeader": {
      "type": [
        "bool"
      ],
      "displayName": [
        "Color header"
      ]
    },
    "styleValues": {
      "type": [
        "bool"
      ],
      "displayName": [
        "Color values"
      ]
    },
    "styleTotal": {
      "type": [
        "bool"
      ],
      "displayName": [
        "Color total"
      ]
    },
    "styleSubtotals": {
      "type": [
        "bool"
      ],
      "displayName": [
        "Color subtotals"
      ]
    }
  },
"rowHeaders": {
    "outline": {
      "type": [
        "enumeration"
      ],
      "displayName": [
        "Outline"
      ]
    },
    "fontColor": {
      "type": [
        "fill"
      ],
      "displayName": [
        "Font color"
      ],
      "description": [
        "Font color of the cells"
      ]
    },
    "backColor": {
      "type": [
        "fill"
      ],
      "displayName": [



      "displayName": [
        "Background color"
      ],
      "description": [
        "Background color of the cells"
      ]
    },
    "wordWrap": {
      "type": [
        "bool"
      ],
      "displayName": [
        "Word wrap"
      ]
    },
    "fontFamily": {
      "type": [
        "formatting"
      ],
      "displayName": [
        "Font family"
      ]
    },
    "fontSize": {
      "type": [
        "formatting"
      ],
      "displayName": [
        "Text Size"
      ]
    },
    "stepped": {
      "type": [
        "bool"
      ],
      "displayName": [
        "Stepped layout"
      ],
      "description": [
        "Render row headers with stepped layout"
      ]
    },
    "steppedLayoutIndentation": {
      "type": [
        "numeric"
      ],
      "displayName": [
        "Stepped layout indentation"
      ],
      "description": [
        "Set the indentation, in pixels, applied to row headers"
      ]
    },
    "urlIcon": {
      "type": [
        "bool"
      ],
      "displayName": [
        "URL icon"
      ],
      "description": [
        "Show an icon instead of the full URL"
      ]
    }
  },
"subTotals": {
    "outline": {
      "type": [
        "enumeration"
      ],



      ],
      "displayName": [
        "Outline"
      ]
    },
    "fontColor": {
      "type": [
        "fill"
      ],
      "displayName": [
        "Font color"
      ],
      "description": [
        "Font color of the cells"
      ]
    },
    "backColor": {
      "type": [
        "fill"
      ],
      "displayName": [
        "Background color"
      ],
      "description": [
        "Background color of the cells"
      ]
    },
    "fontFamily": {
      "type": [
        "formatting"
      ],
      "displayName": [
        "Font family"
      ]
    },
    "fontSize": {
      "type": [
        "formatting"
      ],
      "displayName": [
        "Text Size"
      ]
    },
    "rowSubtotals": {
      "type": [
        "bool"
      ],
      "displayName": [
        "Total row"
      ]
    },
    "columnSubtotals": {
      "type": [
        "bool"
      ],
      "displayName": [
        "Total column"
      ]
    },
    "applyToHeaders": {
      "type": [
        "bool"
      ],
      "displayName": [
        "Apply to labels"
      ]
    }
  },
"selection": {
    "selectAllCheckboxEnabled": {



    "selectAllCheckboxEnabled": {
      "type": [
        "bool"
      ],
      "displayName": [
        "Select All"
      ]
    },
    "singleSelect": {
      "type": [
        "bool"
      ],
      "displayName": [
        "Single Select"
      ]
    }
  },
"header": {
    "show": {
      "type": [
        "bool"
      ],
      "displayName": [
        "Show"
      ]
    },
    "fontColor": {
      "type": [
        "fill"
      ],
      "displayName": [
        "Font color"
      ],
      "description": [
        "Font color of the cells"
      ]
    },
    "background": {
      "type": [
        "fill"
      ],
      "displayName": [
        "Background"
      ]
    },
    "outline": {
      "type": [
        "enumeration"
      ],
      "displayName": [
        "Outline"
      ]
    },
    "textSize": {
      "type": [
        "numeric"
      ],
      "displayName": [
        "Text Size"
      ]
    },
    "fontFamily": {
      "type": [
        "formatting"
      ],
      "displayName": [
        "Font family"
      ]
    }
  },



  },
"items": {
    "fontColor": {
      "type": [
        "fill"
      ],
      "displayName": [
        "Font color"
      ],
      "description": [
        "Font color of the cells"
      ]
    },
    "background": {
      "type": [
        "fill"
      ],
      "displayName": [
        "Background"
      ]
    },
    "outline": {
      "type": [
        "enumeration"
      ],
      "displayName": [
        "Outline"
      ]
    },
    "textSize": {
      "type": [
        "numeric"
      ],
      "displayName": [
        "Text Size"
      ]
    },
    "fontFamily": {
      "type": [
        "formatting"
      ],
      "displayName": [
        "Font family"
      ]
    }
  },
"numericInputStyle": {
    "fontColor": {
      "type": [
        "fill"
      ],
      "displayName": [
        "Font color"
      ],
      "description": [
        "Font color of the cells"
      ]
    },
    "textSize": {
      "type": [
        "numeric"
      ],
      "displayName": [
        "Text Size"
      ]
    },
    "fontFamily": {
      "type": [
        "formatting"



      ],
      "displayName": [
        "Font family"
      ]
    },
    "background": {
      "type": [
        "fill"
      ],
      "displayName": [
        "Background"
      ]
    }
  },
"slider": {
    "show": {
      "type": [
        "bool"
      ],
      "displayName": [
        "Show"
      ]
    },
    "color": {
      "type": [
        "fill"
      ],
      "displayName": [
        "Color"
      ]
    }
  },
"dateRange": {
    "includeToday": {
      "type": [
        "bool"
      ],
      "displayName": [
        "Include today"
      ]
    }
  },
"sentimentColors": {
    "increaseFill": {
      "type": [
        "fill"
      ],
      "displayName": [
        "Increase"
      ]
    },
    "decreaseFill": {
      "type": [
        "fill"
      ],
      "displayName": [
        "Decrease"
      ]
    },
    "totalFill": {
      "type": [
        "fill"
      ],
      "displayName": [
        "Total"
      ]
    },
    "otherFill": {
      "type": [



        "fill"
      ],
      "displayName": [
        "Other"
      ]
    }
  },
"breakdown": {
    "maxBreakdowns": {
      "type": [
        "integer"
      ],
      "displayName": [
        "Max breakdowns"
      ],
      "description": [
        "The number of individual breakdowns to show (rest grouped into Other)"
      ]
    }
  },
"indicator": {
    "indicatorDisplayUnits": {
      "type": [
        "formatting"
      ],
      "displayName": [
        "Display units"
      ],
      "description": [
        "Select the units (millions, billions, etc.)"
      ]
    },
    "indicatorPrecision": {
      "type": [
        "numeric"
      ],
      "displayName": [
        "Value decimal places"
      ],
      "description": [
        "Select the number of decimal places to display for the values"
      ]
    },
    "kpiFormat": {
      "type": [
        "text"
      ],
      "displayName": [
        "Format"
      ]
    }
  },
"trendline": {
    "show": {
      "type": [
        "bool"
      ],
      "displayName": [
        "Show"
      ]
    }
  },
"goals": {
    "showGoal": {
      "type": [
        "bool"
      ],
      "displayName": [
        "Goal"



        "Goal"
      ]
    },
    "showDistance": {
      "type": [
        "bool"
      ],
      "displayName": [
        "Distance"
      ]
    }
  },
"status": {
    "direction": {
      "type": [
        "enumeration"
      ],
      "displayName": [
        "Direction"
      ]
    },
    "goodColor": {
      "type": [
        "fill"
      ],
      "displayName": [
        "Good Color"
      ]
    },
    "neutralColor": {
      "type": [
        "fill"
      ],
      "displayName": [
        "Neutral Color"
      ]
    },
    "badColor": {
      "type": [
        "fill"
      ],
      "displayName": [
        "Bad Color"
      ]
    }
  }
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{
    "legend": {
        "position": [
            {
                "value": "Top",
                "displayName": "Top"
            },
            {
                "value": "Bottom",
                "displayName": "Bottom"
            },
            {
                "value": "Left",
                "displayName": "Left"
            },
            {
                "value": "Right",
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                "displayName": "Right"
            },
            {
                "value": "TopCenter",
                "displayName": "Top Center"
            },
            {
                "value": "BottomCenter",
                "displayName": "Bottom Center"
            },
            {
                "value": "LeftCenter",
                "displayName": "Left Center"
            },
            {
                "value": "RightCenter",
                "displayName": "Right center"
            }
        ],
        "legendMarkerRendering": [
            {
                "value": "markerOnly",
                "displayName": "Markers only"
            },
            {
                "value": "lineAndMarker",
                "displayName": "Line and markers"
            },
            {
                "value": "lineOnly",
                "displayName": "Line only"
            }
        ]
    },
    "categoryAxis": {
        "axisScale": [
            {
                "value": "linear",
                "displayName": "Linear"
            },
            {
                "value": "log",
                "displayName": "Log"
            }
        ],
        "axisType": [
            {
                "value": "Scalar",
                "displayName": "Continuous"
            },
            {
                "value": "Categorical",
                "displayName": "Categorical"
            }
        ],
        "axisStyle": [
            {
                "value": "showTitleOnly",
                "displayName": "Show title only"
            },
            {
                "value": "showUnitOnly",
                "displayName": "Show unit only"
            },
            {
                "value": "showBoth",
                "displayName": "Show both"
            }
        ],



        "gridlineStyle": [
            {
                "value": "dashed",
                "displayName": "Dashed"
            },
            {
                "value": "solid",
                "displayName": "Solid"
            },
            {
                "value": "dotted",
                "displayName": "Dotted"
            }
        ],
        "position": [
            {
                "value": "Left",
                "displayName": "Left"
            },
            {
                "value": "Right",
                "displayName": "Right"
            }
        ]
    },
    "valueAxis": {
        "position": [
            {
                "value": "Left",
                "displayName": "Left"
            },
            {
                "value": "Right",
                "displayName": "Right"
            }
        ],
        "axisScale": [
            {
                "value": "linear",
                "displayName": "Linear"
            },
            {
                "value": "log",
                "displayName": "Log"
            }
        ],
        "axisStyle": [
            {
                "value": "showTitleOnly",
                "displayName": "Show title only"
            },
            {
                "value": "showUnitOnly",
                "displayName": "Show unit only"
            },
            {
                "value": "showBoth",
                "displayName": "Show both"
            }
        ],
        "gridlineStyle": [
            {
                "value": "dashed",
                "displayName": "Dashed"
            },
            {
                "value": "solid",
                "displayName": "Solid"
            },



            },
            {
                "value": "dotted",
                "displayName": "Dotted"
            }
        ],
        "secPosition": [
            {
                "value": "Left",
                "displayName": "Left"
            },
            {
                "value": "Right",
                "displayName": "Right"
            }
        ],
        "secAxisScale": [
            {
                "value": "linear",
                "displayName": "Linear"
            },
            {
                "value": "log",
                "displayName": "Log"
            }
        ],
        "secAxisStyle": [
            {
                "value": "showTitleOnly",
                "displayName": "Show title only"
            },
            {
                "value": "showUnitOnly",
                "displayName": "Show unit only"
            },
            {
                "value": "showBoth",
                "displayName": "Show both"
            }
        ]
    },
    "lineStyles": {
        "strokeLineJoin": [
            {
                "value": "miter",
                "displayName": "Miter"
            },
            {
                "value": "round",
                "displayName": "Round"
            },
            {
                "value": "bevel",
                "displayName": "Bevel"
            }
        ],
        "lineStyle": [
            {
                "value": "dashed",
                "displayName": "Dashed"
            },
            {
                "value": "solid",
                "displayName": "Solid"
            },
            {
                "value": "dotted",
                "displayName": "Dotted"
            }
        ],



        ],
        "markerShape": [
            {
                "value": "circle",
                "displayName": "●"
            },
            {
                "value": "square",
                "displayName": "■"
            },
            {
                "value": "diamond",
                "displayName": "◆"
            },
            {
                "value": "triangle",
                "displayName": "▲"
            },
            {
                "value": "x",
                "displayName": "☓"
            },
            {
                "value": "shortDash",
                "displayName": " -"
            },
            {
                "value": "longDash",
                "displayName": "—"
            },
            {
                "value": "plus",
                "displayName": "+"
            }
        ]
    },
    "trend": {
        "style": [
            {
                "value": "dashed",
                "displayName": "Dashed"
            },
            {
                "value": "solid",
                "displayName": "Solid"
            },
            {
                "value": "dotted",
                "displayName": "Dotted"
        }
    ]
},
"y1AxisReferenceLine": {
    "style": [
        {
            "value": "dashed",
            "displayName": "Dashed"
        },
        {
            "value": "solid",
            "displayName": "Solid"
        },
        {
            "value": "dotted",
            "displayName": "Dotted"
        }
    ],
    "position": [
        {
            "value": "back",



            "value": "back",
            "displayName": "Behind"
        },
        {
            "value": "front",
            "displayName": "In Front"
        }
    ],
    "dataLabelText": [
        {
            "value": "Value",
            "displayName": "Value"
        },
        {
            "value": "Name",
            "displayName": "Name"
        },
        {
            "value": "ValueAndName",
            "displayName": "Name and Value"
        }
    ],
    "dataLabelHorizontalPosition": [
        {
            "value": "left",
            "displayName": "Left"
        },
        {
            "value": "right",
            "displayName": "Right"
        }
    ],
    "dataLabelVerticalPosition": [
        {
            "value": "above",
            "displayName": "Above"
        },
        {
            "value": "under",
            "displayName": "Under"
        }
    ]
},
"referenceLine": {
    "style": [
        {
            "value": "dashed",
            "displayName": "Dashed"
        },
        {
            "value": "solid",
            "displayName": "Solid"
        },
        {
            "value": "dotted",
            "displayName": "Dotted"
        }
    ],
    "position": [
        {
            "value": "back",
            "displayName": "Behind"
        },
        {
            "value": "front",
            "displayName": "In Front"
        }
    ],
    "dataLabelText": [
  {



  {
    "value": "Value",
    "displayName": "Value"
  },
  {
    "value": "Name",
    "displayName": "Name"
  },
  {
    "value": "ValueAndName",
    "displayName": "Name and Value"
  }
],
"dataLabelHorizontalPosition": [
  {
    "value": "left",
    "displayName": "Left"
  },
  {
    "value": "right",
    "displayName": "Right"
  }
],
"dataLabelVerticalPosition": [
  {
    "value": "above",
    "displayName": "Above"
  },
  {
    "value": "under",
    "displayName": "Under"
  }
]
},
"labels": {
"labelOrientation": [
  {
    "value": "vertical",
    "displayName": "Vertical"
  },
  {
    "value": "horizontal",
    "displayName": "Horizontal"
  }
],
"labelPosition": [
  {
    "value": "Auto",
    "displayName": "Auto"
  },
  {
    "value": "InsideEnd",
    "displayName": "Inside End"
  },
  {
    "value": "OutsideEnd",
    "displayName": "Outside End"
  },
  {
    "value": "InsideCenter",
    "displayName": "Inside Center"
  },
  {
    "value": "InsideBase",
    "displayName": "Inside Base"
  }
],
"labelStyle": [
  {
    "value": "Category",



    "value": "Category",
    "displayName": "Category"
  },
  {
    "value": "Data",
    "displayName": "Data value"
  },
  {
    "value": "Percent of total",
    "displayName": "Percent of total"
  },
  {
    "value": "Both",
    "displayName": "Category, data value"
  },
  {
    "value": "Category, percent of total",
    "displayName": "Category, percent of total"
  },
  {
    "value": "Data value, percent of total",
    "displayName": "Data value, percent of total"
  },
  {
    "value": "Category, data value, percent of total",
    "displayName": "All detail labels"
  }
 ]
},
"card": {
    "outline": [
      {
        "value": "None",
        "displayName": "None"
      },
      {
        "value": "BottomOnly",
        "displayName": "Bottom only"
      },
      {
        "value": "TopOnly",
        "displayName": "Top only"
      },
      {
        "value": "LeftOnly",
        "displayName": "Left only"
      },
      {
        "value": "RightOnly",
        "displayName": "Right only"
      },
      {
        "value": "TopBottom",
        "displayName": "Top + bottom"
      },
      {
        "value": "LeftRight",
        "displayName": "Left + right"
      },
      {
        "value": "Frame",
        "displayName": "Frame"
      }
     ]
},
"imageScaling": {
    "imageScalingType": [
      {
        "value": "Normal",



        "displayName": "Normal"
      },
      {
        "value": "Fit",
        "displayName": "Fit"
      },
      {
        "value": "Fill",
        "displayName": "Fill"
      }
    ]
},
"forecast": {
    "confidenceBandStyle": [
      {
        "value": "fill",
        "displayName": "Fill"
      },
      {
        "value": "line",
        "displayName": "Line"
      },
      {
        "value": "none",
        "displayName": "None"
      }
    ],
    "style": [
      {
        "value": "dashed",
        "displayName": "Dashed"
      },
      {
        "value": "solid",
        "displayName": "Solid"
      },
      {
        "value": "dotted",
        "displayName": "Dotted"
      }
    ]
    },
    "mapStyles": {
    "mapTheme": [
      {
        "value": "aerial",
        "displayName": "Aerial"
      },
      {
        "value": "canvasDark",
        "displayName": "Dark"
      },
      {
        "value": "canvasLight",
        "displayName": "Light"
      },
      {
        "value": "grayscale",
        "displayName": "Grayscale"
      },
      {
        "value": "road",
        "displayName": "Road"
      }
    ]
},
"shape": {
    "projectionEnum": [
      {



      {
        "value": "albersUsa",
        "displayName": "Albers USA"
      },
      {
        "value": "equirectangular",
        "displayName": "Equirectangular"
      },
      {
        "value": "mercator",
        "displayName": "Mercator"
      },
      {
        "value": "orthographic",
        "displayName": "Orthographic"
      }
    ]
    },
    "xAxisReferenceLine": {
    "style": [
      {
        "value": "dashed",
        "displayName": "Dashed"
      },
      {
        "value": "solid",
        "displayName": "Solid"
      },
      {
        "value": "dotted",
        "displayName": "Dotted"
      }
    ],
    "position": [
      {
        "value": "back",
        "displayName": "Behind"
      },
      {
        "value": "front",
        "displayName": "In Front"
      }
    ],
    "dataLabelText": [
      {
        "value": "Value",
        "displayName": "Value"
      },
      {
        "value": "Name",
        "displayName": "Name"
      },
      {
        "value": "ValueAndName",
        "displayName": "Name and Value"
      }
    ],
    "dataLabelHorizontalPosition": [
      {
        "value": "left",
        "displayName": "Left"
      },
      {
        "value": "right",
        "displayName": "Right"
      }
    ],
    "dataLabelVerticalPosition": [
      {
        "value": "above",



        "value": "above",
        "displayName": "Above"
      },
      {
        "value": "under",
        "displayName": "Under"
      }
    ]
    },
    "ratioLine": {
    "style": [
      {
        "value": "dashed",
        "displayName": "Dashed"
      },
      {
        "value": "solid",
        "displayName": "Solid"
      },
      {
        "value": "dotted",
        "displayName": "Dotted"
      }
    ]
    },
    "columnHeaders": {
    "outline": [
      {
        "value": "None",
        "displayName": "None"
      },
      {
        "value": "BottomOnly",
        "displayName": "Bottom only"
      },
      {
        "value": "TopOnly",
        "displayName": "Top only"
      },
      {
        "value": "LeftOnly",
        "displayName": "Left only"
      },
      {
        "value": "RightOnly",
        "displayName": "Right only"
      },
      {
        "value": "TopBottom",
        "displayName": "Top + bottom"
      },
      {
        "value": "LeftRight",
        "displayName": "Left + right"
      },
      {
        "value": "Frame",
        "displayName": "Frame"
      }
    ]
    },
    "values": {
    "outline": [
      {
        "value": "None",
        "displayName": "None"
      },
      {
        "value": "BottomOnly",
        "displayName": "Bottom only"



        "displayName": "Bottom only"
      },
      {
        "value": "TopOnly",
        "displayName": "Top only"
      },
      {
        "value": "LeftOnly",
        "displayName": "Left only"
      },
      {
        "value": "RightOnly",
        "displayName": "Right only"
      },
      {
        "value": "TopBottom",
        "displayName": "Top + bottom"
      },
      {
        "value": "LeftRight",
        "displayName": "Left + right"
      },
      {
        "value": "Frame",
        "displayName": "Frame"
      }
    ]
    },
    "total": {
    "outline": [
      {
        "value": "None",
        "displayName": "None"
      },
      {
        "value": "BottomOnly",
        "displayName": "Bottom only"
      },
      {
        "value": "TopOnly",
        "displayName": "Top only"
      },
      {
        "value": "LeftOnly",
        "displayName": "Left only"
      },
      {
        "value": "RightOnly",
        "displayName": "Right only"
      },
      {
        "value": "TopBottom",
        "displayName": "Top + bottom"
      },
      {
        "value": "LeftRight",
        "displayName": "Left + right"
      },
      {
        "value": "Frame",
        "displayName": "Frame"
      }
    ]
    },
    "rowHeaders": {
    "outline": [
      {
        "value": "None",
        "displayName": "None"
      },



      },
      {
        "value": "BottomOnly",
        "displayName": "Bottom only"
      },
      {
        "value": "TopOnly",
        "displayName": "Top only"
      },
      {
        "value": "LeftOnly",
        "displayName": "Left only"
      },
      {
        "value": "RightOnly",
        "displayName": "Right only"
      },
      {
        "value": "TopBottom",
        "displayName": "Top + bottom"
      },
      {
        "value": "LeftRight",
        "displayName": "Left + right"
      },
      {
        "value": "Frame",
        "displayName": "Frame"
      }
    ]
    },
    "subTotals": {
    "outline": [
      {
        "value": "None",
        "displayName": "None"
      },
      {
        "value": "BottomOnly",
        "displayName": "Bottom only"
      },
      {
        "value": "TopOnly",
        "displayName": "Top only"
      },
      {
        "value": "LeftOnly",
        "displayName": "Left only"
      },
      {
        "value": "RightOnly",
        "displayName": "Right only"
      },
      {
        "value": "TopBottom",
        "displayName": "Top + bottom"
      },
      {
        "value": "LeftRight",
        "displayName": "Left + right"
      },
      {
        "value": "Frame",
        "displayName": "Frame"
      }
    ],
    "rowSubtotalsPosition": [
      {
        "value": "Top",
        "displayName": "Top"



        "displayName": "Top"
      },
      {
        "value": "Bottom",
        "displayName": "Bottom"
      }
    ]
    },
    "general": {
    "orientation": [
      {
        "value": "vertical",
        "displayName": "Vertical"
      },
      {
        "value": "horizontal",
        "displayName": "Horizontal"
      }
    ]
    },
    "data": {
    "relativeRange": [
      {
        "value": "Last",
        "displayName": "Last"
      },
      {
        "value": "Next",
        "displayName": "Next"
      },
      {
        "value": "This",
        "displayName": "This"
      }
    ],
    "relativePeriod": [
      {
        "value": "None",
        "displayName": "Select"
      },
      {
        "value": "Days",
        "displayName": "Days"
      },
      {
        "value": "Weeks",
        "displayName": "Weeks"
      },
      {
        "value": "Calendar Weeks",
        "displayName": "Weeks (Calendar)"
      },
      {
        "value": "Months",
        "displayName": "Months"
      },
      {
        "value": "Calendar Months",
        "displayName": "Months (Calendar)"
      },
      {
        "value": "Years",
        "displayName": "Years"
      },
      {
        "value": "Calendar Years",
        "displayName": "Years (Calendar)"
      }
    ],



    "mode": [
      {
        "value": "Between",
        "displayName": "Between"
      },
      {
        "value": "Before",
        "displayName": "Before"
      },
      {
        "value": "After",
        "displayName": "After"
      },
      {
        "value": "Basic",
        "displayName": "List"
      },
      {
        "value": "Dropdown",
        "displayName": "Dropdown"
      },
      {
        "value": "Relative",
        "displayName": "Relative"
      },
      {
        "value": "Single",
        "displayName": "Single Value"
      }
    ]
    },
    "header": {
    "outline": [
      {
        "value": "None",
        "displayName": "None"
      },
      {
        "value": "BottomOnly",
        "displayName": "Bottom only"
      },
      {
        "value": "TopOnly",
        "displayName": "Top only"
      },
      {
        "value": "LeftOnly",
        "displayName": "Left only"
      },
      {
        "value": "RightOnly",
        "displayName": "Right only"
      },
      {
        "value": "TopBottom",
        "displayName": "Top + bottom"
      },
      {
        "value": "LeftRight",
        "displayName": "Left + right"
      },
      {
        "value": "Frame",
        "displayName": "Frame"
      }
    ]
    },
    "items": {
    "outline": [



      {
        "value": "None",
        "displayName": "None"
      },
      {
        "value": "BottomOnly",
        "displayName": "Bottom only"
      },
      {
        "value": "TopOnly",
        "displayName": "Top only"
      },
      {
        "value": "LeftOnly",
        "displayName": "Left only"
      },
      {
        "value": "RightOnly",
        "displayName": "Right only"
      },
      {
        "value": "TopBottom",
        "displayName": "Top + bottom"
      },
      {
        "value": "LeftRight",
        "displayName": "Left + right"
      },
      {
        "value": "Frame",
        "displayName": "Frame"
      }
    ]
    },
    "status": {
    "direction": [
      {
        "value": "Positive",
        "displayName": "High is good"
      },
      {
        "value": "Negative",
        "displayName": "Low is good"
      }
     ]
   }
}
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Enable the Quick measures previewEnable the Quick measures preview

Starting with the April 2017 release of Power BI Desktop, you can use Quick measures to quickly and easily
perform common, powerful calculations. A Quick measure runs a set of DAX commands behind the scenes (you
don’t have to write the DAX – it’s done for you) based input you provide in a dialog box, then presents the results
for you to use in your report. Best of all, you can see the DAX that’s executed by the Quick measure, and jump-start
or expand your own DAX knowledge.

You create Quick measures by right-clicking a field in the Fields well, then selecting Quick measures from the
menu that appears. You can also right-click any value in the Values pane of an existing visual (such as the Values
field in a Bar chart visual). There are many available categories of calculations, and ways to modify each
calculation to fit your needs.

You can try the new Quick measures feature beginning with the April 2017 release of Power BI Desktop. To
enable this preview feature, select File > Options and Settings > Options > Preview Features, then select the
checkbox beside Quick measures. You'll need to restart Power BI Desktop after you make the selection.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-quick-measures.md


Using Quick measures

You'll need to restart Power BI Desktop after you make the selection.

To create a Quick measure, right-click on a field (any field) in the Fields well in Power BI Desktop and select
Quick measure from the menu that appears.



Modeling must be available on the dataset currently loaded in order for Quick measures to be available. As such,
live connections (such as a connection to a Power BI service dataset) will not display the Quick measures menu
item when the Fields list is right-clicked, with the exception of SSAS live connections.

When using SQL Server Analysis Services (SSAS) live connections, some Quick measures are available. Power BI
Desktop displays only the collection of Quick measures that are supported for the version of SSAS to which the
connection is made. So if you are connected to a SSAS live data source, and you do not see certain Quick
measures in the list, it's because the SSAS version to which you are connected does not support the DAX measure
used to implement that Quick measure.

When selected from the right-click menu, the following Quick measures window appears, allowing you to select
the calculation you want, and the fields against which you want to calculation to be run.



When you select the drop-down menu, you're presented with the long list of available Quick measures.



There are five distinct groups of Quick measure calculation types, each with a collection of calculations. Those
groups and calculations are the following:

Aggregate within a category

Filters and baselines

Time intelligence

Average within category
Variance within category
Max within category
Min within category
Weighted average per category

Filtered measure
Difference from baseline
Percentage difference from baseline
Totals from new categories

Year-to-date total
Quarter-to-date total
Month-to-date total
Year over year change
Quarter over quarter change



Example of Quick measures

Totals

Mathematical operations

Text

Month-over-month change
Rolling average

Running total
Total for category (filters applied)
Total for category (filters not applied)

Addition
Subtraction
Multiplication
Division
Percentage difference

Star rating
Concatenated list of values

We anticipate adding to these calculations, and want to hear from you about which Quick measures you'd like to
see, and if you have ideas (including underlying DAX formulas) for Quick measures that you'd like to submit for
consideration. More on that at the end of this article.

Let's take a look at an example of these Quick measures in action.

The following Matrix visual shows a table of sales for various electronics products. It's a basic table that includes
the total for each category.

When we right-click the Values field well and select Quick measures, we can select Average within category as
the Calculation, then select Sum of SalesAmount as the Base value, then specify SalesAmount by dragging that
field from the Fields box on the right pane, into the Category section on the left.



When we select OK, we see a few interesting things occur, as shown in the image following this list:

1. The Matrix visual now has a new column that shows our calculation (in this case, Average SalesAmount within
SalesAmount).

2. A new measure has been created and is available in the Fields well, and it's highlighted (Power BI puts a
yellow box is around it). This measure is available to any other visual in the report, not just the visual for which
it was originally created.

3. The DAX formula that was created for the Quick measure is displayed in the Formula bar.

To start with the first item, notice that the Quick measure was applied to the visual. There's a new column and
associated value, both of which are based on the Quick measure that was created.



Learn DAX using Quick measures

Second, the Quick measure shows up in the Fields well of the data model, and can be used like any other field in
the model, for any other visual. In the following image, a quick bar chart visual was created by using the new field
created by the Quick measure.

Let's head to the next section to discuss that third item, DAX formulas.

Another great advantage of the Quick measures feature is that it directly shows you the DAX formula that was
created to implement the measure. In the following image, we've selected the measure that was created by the
Quick measure (it's now in the Fields well, so we just have to click it). When we do so, the Formula bar appears,
showing the DAX formula that Power BI created to implement the measure.



Limitations and considerations

This is nice by itself, since it shows you the formula behind the measure. But more importantly, perhaps, it lets you
use Quick measures to see how the underlying DAX formulas should be created.

Imagine you need to do a year-over-year calculation, but you're not quite sure how to structure the DAX formula
(or, you have no idea where to start!). Instead of banging your head on the desk, you could create a Quick
measure using the Year over year change calculation, and see what happens. As in, create the Quick measure
and see how it appears in your visual, see how the DAX formula worked, then make changes either directly to the
DAX, or create another measure, until the calculations meet your needs or expectations.

It's like having a quick teacher that immediately responds to your what-if questions by a few clicks. You can always
delete those measures from your model if you don't like them - that's as easy as right-clicking the measure and
selecting delete.

And once you do have the measure perfected, you can rename it however you'd like, using the same right-click
menu.



WARNINGWARNING

Time intelligence and Quick measuresTime intelligence and Quick measures

Additional information and examplesAdditional information and examples

In this preview release of the Quick measures, there are a few limitations and considerations to keep in mind.

Quick measures are only available if you can modify the model, which isn't the case when you're working
with DirectQuery or most Live connections (SSAS live connections are supported, as previously explained).
The measure that's added to the Fields well can be used with any visual in the report.
You can always see the DAX associated with a Quick measure by selecting the created measure in the Fields
well, then looking at the formula in the Formula bar.

Quick measures currently only generate DAX statements with commas for argument separators. If your version of Power BI
Desktop is localized to a language that uses commas as decimal separators, quick measures will not operate properly.

Beginning with the October 2017 update to Power BI Desktop, you can use your own custom date tables with
time intelligence Quick measures. If your data model has a custom date table, you can use the primary date
column in that table for time intelligence quick measures. You must ensure that when the model was built, that
primary date column in that table was marked as a Date table, as described in this article.

We anticipate providing examples and guidance for each of the Quick measures calculations, so please check
back soon for updates on that focused article.

Since this is a Preview feature, we're especially interested in your feedback and your ideas.

Have an idea for a Quick measure that isn't already provided? Great! Check out this page and submit your ideas
(and DAX formula) for the Quick measure you'd like to see in Power BI Desktop, and we'll consider adding it to
the provided list of Quick measures in a future release.

https://docs.microsoft.com/sql/analysis-services/tabular-models/specify-mark-as-date-table-for-use-with-time-intelligence-ssas-tabular
https://go.microsoft.com/fwlink/?linkid=842906
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Creating a What if parameter

Starting with the August 2017 release of Power BI Desktop, you can create What if variables for your reports,
interact with the variable as a slicer, and thereby visualize and quantify different key values in your reports.

The What if parameter is found on the Modeling tab in Power BI Desktop. When you do so, a dialog appears
where you can configure the parameter.

To create a What if parameter, select the What if button from the Modeling tab in Power BI Desktop. In the
following image, we've created a parameter called Discount percentage and set its data type to Decimal number.
The Minimum value is zero, the Maximum is 0.50 (fifty percent). We've also set the Increment to 0.05, or five
percent. That's how much the parameter will adjust when interacted with in a report.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-what-if.md


NOTENOTE
For decimal numbers, make sure you precede it with a zero, as in 0.50 versus just .50 in that box. Otherwise the number
won't validate and the OK button will not be selectable.

For your convenience, the Add slicer to this page checkbox automatically puts a slicer with your What if
parameter onto the current report page.

In addition to creating the parameter, creating a What if parameter also creates a measure, which you can use to
visualize the current value of the What if parameter.



Using a What if parameter

It's important and useful to note that once you create a What if parameter, both the parameter and the measure
become part of your model. So they're available throughout the report, and can be used on other report pages. And
since they're part of the model, you can delete the slicer from the report page, and if you want it back, just grab the
What if parameter from the Fields list and drag it onto the canvas (then change the visual to a slicer) to easily get
the What if parameter back into your report.

Let's create a simple example of using a What if parameter. We created the What if parameter in the previous
section, now we'll put it to use by creating a new measure whose value adjusts with the slider. To accomplish this,
we create a new measure.



The new measure is simply going to be the total sales amount, with the discount rate applied. You can create
complex and interesting measures, of course, that let the consumers of your reports visualize the variable of your
What if parameter. For example, you could create a report that let sales people see their compensation if they meet
certain sales goals or percentages, or see the affect of increased sales to deeper discounts.

Once we type the measure formula into the formula bar, and name it Sales after Discount, we see its result:

Then we create a column visual with OrderDate on the on the axis, and both SalesAmount and the just-created
measure Sales after Discount as the values.

Then, as we move the slider, we see that the Sales after Discount column reflects the discounted sales amount.



And that's all there is to it. You can use What if parameters in all sorts of situations, to enable the consumers of
reports to interact with different scenarios that you create in your reports.



Use drillthrough in Power BI Desktop
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Using drillthrough

With drillthrough in Power BI Desktop, you can create a page in your report that focuses on a specific entity -
such as a supplier, or customer, or manufacturer. With that focused report page, users can right-click on a data
point in other report pages, and drillthrough to the focused page to get details that are filtered to that context.

To use drillthrough, create a report page that has visuals you'd like to see about the type of entity for which you'll
provide drillthrough. For example, if you're interested in providing drillthrough for manufacturers, you might
create a drillthrough page with visuals that show total sales, total units shipped, sales by category, sales by region,
and so on. That way, when you drillthrough to that page, the visuals will be specific to the manufacturer you
clicked on and selected to drillthrough about.

Then on that drillthrough page, in the Fields section of Visualizations pane, drag the field you want to
drillthrough about into the Drillthrough filters well.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-drillthrough.md


When you add a field to the Drillthrough filters well, Power BI Desktop automatically creates a back button
visual. That visual becomes a button in published reports, and lets users who are consuming your report in the
Power BI service easily get back to the report page from which they came (the page from which they selected to
drillthrough).

Since the back button is an image, you can replace the image of that visual with any image you want, and it will
still operate properly as the button to get report consumers back to their original page. To use your own image for
a back button just place an image visual on the drillthrough page, then select the visual, and put the Back button
slider to on. That makes your image function as a back button.



NOTENOTE

When your drillthrough page is complete, when users right-click on a data point in your report that uses the field
you put into the Drillthrough filters well on your drillthrough page, a context menu appears, letting the users
drillthrough to that page.

When they choose to drillthrough, the page is filtered to show information about the data point from which they
right-clicked. For example, if they right-clicked on a data point about Contoso (a manufacturer), and selected to
drillthough, the drillthrough page they were taken to would be filtered to Contoso.

Only the field that is in the Drillthrough filters well gets passed through to the drillthrough report page. No other
contextual information is passed.

And that's all there is to using drillthrough in your reports. It's a great way to get an expanded view on the entity
information you select for your drillthrough filter.



Use a relative date slicer and filter in Power BI
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Using the relative date range slicer

With the relative date slicer or relative date filter, you can apply time-based filters to any date column in your
data model. For example, you can use the relative date slicer to show only sales data that's happened within the
last thirty days (or month, or calendar months, and so on). And when you refresh the data, the relative time period
automatically applies the appropriate relative date constraint.

You can use the relative date slicer just like any other slicer. Simply create a slicer visual for your report, and then
select a date value for the Field value. In the following image, the OrderDate field is selected.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-slicer-filter-date-range.md


Select the carat in the upper-right corner of the relative date slicer and a menu appears.

For the relative date slicer, select Relative.

You then can select the settings. For the first drop-down in the relative date slicer, you can select from the following
choices:

Last
Next
This

These selections are shown in the following image.



The next (middle) setting in the relative date slicer allows you to type in a number, to define the relative date range.

The third setting allows you to select the date measurement, and you can select from the following choices:

Days
Weeks
Weeks (Calendar)
Months
Months (Calendar)
Years
Years (Calendar)

These selections are shown in the following image.

If you select Months from that list, and input 2 in the middle setting. The following would happen: if today is July
20th, the data included in visuals constrained by the slicer would show data for the previous two months, starting
on May 20th and going through July 20th (today's date).

In comparison, if you selected Months (Calendar), the visuals constrained would show data from May 1st through
June 30th (the last two complete calendar months).



Using the relative date range filter
You can also create a relative date range filter for your report page, or your entire report. To do so, simply drag a
date field into the Page level filters or the Report level filters areas in the Field pane, as shown in the following
image.

Once there, you can modify the relative date range in similar fashion to how the relative date slicer is customized.
Select Relative date filtering from the Filter Type drop down.

Once Relative date filtering is selected, you see three sections to modify, including a middle numeric box, just like



Limitations and considerations

the slicer.

And that's all there is to using these relative date constraints in your reports.

The following limitations and considerations currently apply to the relative date range slicer and filter.

Data models in Power BI do not include time zone information. The models can store times, but there's no
indication of the time zone they're in.
The slicer and filter are always based on the time in UTC, so if you configure a filter in a report and send it to a
colleague in a different time zone, you'll both see the same data. However, if you aren't in the UTC time zone
you might see data for a different time offset than you expect.
Data captured in a local time zone can be converted to UTC using the Query Editor.



Accessibility in Power BI Desktop reports
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NOTENOTE

Consuming a Power BI Desktop report with a keyboard or screen
reader

Power BI Desktop has features that enable people with disabilities to more easily consume and interact with
Power BI Desktop reports. These features include the ability to consume a report using the keyboard or a screen
reader, tabbing to focus on various objects on a page, and thoughtful use of markers in visualizations.

These accessibility features are available with the June 2017 Power BI Desktop and later releases. Additional accessibility
functionality is planned for future releases as well.

Beginning with the September 2017 release of Power BI Desktop, you can press the ? key to show a window that
describes the accessibility keyboard shortcuts available in Power BI Desktop.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-accessibility.md


With the accessibility enhancements, you can consume a Power BI Desktop report with a keyboard or a screen
reader with the following techniques:

You can switch focus between the report page tabs, or objects on a given report page, using Ctrl+F6.

When focus is on report page tabs, use the Tab or Arrow keys to move focus from one report page to the next.
The title of the report page, and whether it is currently selected, is read out by the screen reader. To load the
report page currently under focus, use the Enter or Space key.
When focus is on a loaded report page, use the Tab key to shift focus to each object on the page, which
includes all textboxes, images, shapes, and charts. The screen reader reads the type of object, and a description
of that object that's provided by its author.

You can press Alt+Shift+F10 to move focus to a visual menu.

You can press Alt+Shift+F11 to present an accessible version of the See data window.



Tips for creating accessible reports

These accessibility additions were created to let users fully consume Power BI Desktop reports using a screen
reader and keyboard navigation.

The following tips can help you create Power BI Desktop reports that are more accessible.

For Line, Area, and Combo visuals, as well as for Scatter and Bubble visuals, turn markers on, and use a
different Marker shape for each line.

To turn Markers on, select the Format section in the Visualizations pane, expand the Shapes section,
then scroll down to find the Markers toggle and turn it to On.
Then, select the name of each line (or area, if using an Area chart) from the drop-down box in that
Shapes section. Below the drop-down, you can then adjust many aspects of the marker used for the
selected line, including its shape, color, and size.



As a follow on to the previous bullet, don't rely on color to convey information. Using shapes on lines (markers,
as described in the previous bullets) is helpful.
Select a theme that is high contrast and color blind friendly from the theme gallery, and import it using the
Theming preview feature.

Using a different Marker shape for each line makes it easier for report consumers to differentiate lines
(or areas) from each other.

For every object on a report, provide Alt Text. Doing so ensures that consumers of your report understand
what you are trying to communicate with a visual, even if they cannot see the visual, image, shape, or
textbox. You can provide Alt Text for any object on a Power BI Desktop report by selecting the object (such
as a visual, shape, etc.) and in the Visualizations pane, select the Format section, expand General, then
scroll to the bottom and fill in the Alt Text textbox.



Considerations and limitations

Next steps

Make sure your reports have sufficient contrast between text and any background colors.
Use text sizes and fonts that are easily readable. Small text size, or fonts that might be difficult to read, are
unhelpful for accessibility.
Include a title, axis labels, and data labels in all visuals.

There are a few known issues and limitations to the accessibility features, described in the following list:

JAWS is supported in reports that are viewed in the Power BI service, including any embedded reports. JAWS
is also supported in Power BI Desktop, however you must open the screen reader before opening any Power
BI Desktop files, in order for screen reading to work properly.

Use Report Themes in Power BI Desktop (Preview)
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Using groupingUsing grouping

When Power BI Desktop creates visuals, it aggregates your data into chunks (or groups) based on values found
in the underlying data. Often that's fine, but there may be times when you want to refine how those chunks are
presented. For example, you might want to place three categories of products in one larger category (one group).
Or you might want to see sales figures put into bin-sizes of 1,000,000 dollars, instead of evenly-divided 923,983
dollars.

In Power BI Desktop, you can group data points to help you more clearly view, analyze, and explore data and
trends in your visuals. You can also define the bin size, often called binning, to put values into equally sized
groups that better enable you to visualized data in ways that are meaningful.

To use grouping, select two or more elements on a visual by using CTRL+CLICK to multi-select elements. Then
right-click one of the multi-select elements, and select Group from the menu that appears.

Once created, the group is added to the Legend bucket for the visual, and also appears in the Fields list.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-grouping-and-binning.md


Once you have a group, you can easily edit the members of that group by right-clicking the field from the Legend
bucket or from the Fields list, and selecting Edit Groups.

In the Groups window that appears you can create new groups, or modify existing groups. You can also rename
any group by double-clicking on the Group title in the Groups and members box, and typing a new name.

There are all sorts of things you can do with groups in this window. You can add items from the Ungrouped
values list into a new group, or into one of the existing groups. To create a new group, select two or more items
(using CTRL+click) from the Ungrouped values box and then click the Group button below that box.



NOTENOTE

Using binningUsing binning

You can add an ungrouped value into an existing group: just select the Ungrouped value, then select the existing
group to which you want to add it, and click the Group button. To remove an item from a group, select it from the
Groups and members box and then click Ungroup. You can also select whether ungrouped categories should be
placed into the Other group, or should remain ungrouped.

You can create groups for any field in the Fields well, without having to multi-select from an existing visual. Just right-click
the field, and select Group from the menu that appears.

You can set the bin size for numerical and time fields in Power BI Desktop. You can use binning to right-size the
data that Power BI Desktop displays.

To apply a bin size, right-click a Field and select Groups.



From the Groups window, set the Bin size to the size you want.

When you select OK, you'll notice that a new field appears in the Fields pane with (bins) appended. You can then
drag that field onto the canvas to use the bin size in a visual.



To see binning in action, take a look at this video.

And that's all there is to using grouping and binning to ensure the visuals in your reports show your data just the
way you want them to.

https://www.youtube.com/watch?v=BRvdZSfO0DY
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Create a ribbon chart

You can use ribbon charts in Power BI to visualize data, and quickly determine which category of data has the
highest rank (largest value). Ribbon charts are effective at showing rank change, with the highest rang (value)
always displayed on top for each time period. Ribbon charts are available in Power BI Desktop starting with the
September 2017 release, and in subsequent updates to the Power BI service.

To create a ribbon chart, select ribbon chart from the Visualizations panel.

Ribbon charts connect a category of data over the visualized time continuum using ribbons, thereby enabling you
to see how a given category ranks throughout the span of the chart's x-axis (usually the timeline).

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-ribbon-charts.md


Format a ribbon chart

Next steps

When you create a ribbon chart, you have formatting options available in the Format section of the
Visualizations pane. The formatting options for ribbon charts are similar to those for a stacked column chart, with
additional formatting options that are specific to the ribbons.

These formatting options for ribbon charts let you adjust the following:

Spacing lets you adjust how much space appears between ribbons. The number is the percentage of the
column's maximum height.
Match series color allows you to match the color of the ribbons with the series color. When off, ribbons are
gray.
Transparency specifies how transparent the ribbons are, with the default set to 30.
Border lets you place a dark border on the top and bottom of the ribbons. By default, borders are off.

For more information about Power BI Desktop, and how to get started, check out the following articles.

Getting Started with Power BI Desktop
Query Overview with Power BI Desktop
Data Sources in Power BI Desktop
Connect to Data in Power BI Desktop
Shape and Combine Data with Power BI Desktop
Common Query Tasks in Power BI Desktop
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NOTENOTE

Using drill-down with the Matrix visual

Drill-down on row headersDrill-down on row headers

With the Matrix visual, you can create matrix visuals (sometimes also referred to as tables) in Power BI Desktop
reports, and cross-highlight elements within the matrix with other visuals. In addition, you can select rows,
columns, and even individual cells and cross-highlight. Lastly, to make better use of layout space, the matrix visual
supports a stepped layout.

There are many features associated with the matrix, and we'll go through them in the following sections of this
article.

Beginning with the July 2017 release of Power BI Desktop, matrix and table visuals reflect styling (including colors) from the
applied Report Theme. These may not be the colors you expect for your matrix visual, which you can change in your
Report Theme configuration. See Use Report Themes in Power BI Desktop for more information about themes.

With the Matrix visual, you can do all sorts of interesting drill-down activities that weren't available before. This
includes the ability to drill-down using rows, columns, and even into individual sections and cells. Let's take a look
at how each of these work.

In the Visualizations pane, when you add multiple fields to the Rows section of the Fields well, you enable drill-
down on the rows of the matrix visual. This is similar to creating a hierarchy, which then allows you to drill-down
(and then back up) through that hierarchy, and analyze the data at each level.

In the following image, the Rows section contains Category and SubCategory, creating a grouping (or hierarchy) in
the rows that we can drill through.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-matrix-visual.md


When the visual has grouping created in the Rows section, the visual itself displays the drill and expand icons in
the top-left corner of the visual.

Similar to the drill and expand behavior in other visuals, selecting those buttons lets us drill-down (or back up)
through the hierarchy. In this case we can drill down from Category to SubCategory, as shown in the following
image, where the drill-down one level icon (the pitchfork) has been selected.



In addition to using those icons, you can right-click on any of those row headers, and drill down by selecting from
the menu that appears.

Notice there are a few options from the menu that appears, which generates different results:

Selecting Drill Down expands the matrix for that row level, excluding all other row headings except the row
header that was right-clicked. In the following image, Computers was right-clicked, and Drill Down was selected.
Notice that other top-level rows no longer appear in the matrix. This is a useful feature, and becomes especially
cool when we get to the cross-highlighting section.



Drill-down on column headersDrill-down on column headers

We can click the Drill up icon to get back to the previous top-level view. If we then select Show Next Level from
the right-click menu, we get an alphabetical listing of all the next-level items (in this case, the SubCategory field),
without the higher-level hierarchy categorization.

When we click on the Drill up icon in the upper-left corner to have the matrix show all top-level categories, then
right-click again and select Expand to next level, we see the following:

You can also use the Include and Exclude menu items to keep (or remove, respectively) the right-clicked row
(and any subcategories) from the matrix.

Similar to the ability to drill-down on Rows, you can also drill-down on Columns. In the following image, you can



see that there are two fields in the Columns field well, creating a hierarchy similar to what we used for the rows
earlier in this article. In the Columns field well, we have Class and Color.

In the Matrix visual, when we right-click a column, we see the option to drill-down. In the following image, we
right-click on Deluxe and select Drill Down.

When Drill Down is selected, the next level of the column hierarchy for Deluxe is displayed, which in this case is
Color.



NOTENOTE

Stepped layout with matrix visuals

The rest of the right-click menu items work on Columns in the same way they do for rows (see the previous
section, Drill-down on row headers). You can Show Next Level, Expand to next level, and Include or
Exclude your columns just as you can with rows.

The icons drill-down and drill-up icons in the upper left of the matrix visual only apply to rows. In order to drill-down on
columns, you must use the right-click menu.

The Matrix visual automatically indents subcategories in a hierarchy beneath each parent, which is called a
stepped layout.

In the original version of the matrix visual, subcategories were shown in an entirely different column, taking up
much more space in the visual. The following image shows the table in original matrix visual; notice the
subcategories in a completely separate column.

In the following image, you see a Matrix visual, with stepped layout in action. Notice the category Computers has
its subcategories (Computers Accessories, Desktops, Laptops, Monitors, and so on) slightly indented, providing a
cleaner and much more condensed visual.



Subtotals with matrix visuals

You can easily adjust the stepped layout settings. With the Matrix visual selected, in the Format section (the
paint roller icon) of the Visualizations pane, expand the Row headers section. In there are two options: the
Stepped layout toggle (which turns it off or on), and the Stepped layout indentation (specifies the indentation
amount, in pixels).

If you turn off Stepped layout, the subcategories are shown in another column rather than indented beneath the
parent category.

You can turn subtotals on or off in matrix visuals, for both rows and columns. In the following image, you can see
that the row subtotals are set to on.



Cross-highlighting with matrix visuals

In the Format section of the Visualizations pane, expand the Subtotals card and turn the Row subtotals slider
to Off. When you do so, the subtotals are not shown.

The same process applies for column subtotals.

With the Matrix visual, any elements in the matrix can be selected as the basis for cross-highlighting. Select a
column in a Matrix and that column is highlighted, as are any other visuals on the report page. This has been a
common feature of other visuals and the selection of a data point, and now the Matrix visual can participate.

In addition, using CTRL+Click also works for cross-highlighting. For example, in the following image a collection of
subcategories were selected from the Matrix visual. Notice how items that weren't selected from the visual are
grayed out, and how the other visuals on the page reflect the selections made in the Matrix visual.



Shading and font colors with matrix visuals
With the Matrix visual, you can apply conditional formatting (colors and shading) to the background of cells
within the matrix, and you can apply conditional formatting to the text and values themselves.

To apply conditional formatting, you can do either of the following when a matrix visual is selected:

In the Fields pane, right-click the Field, and select Conditional formatting from the menu.

Or, in the Format pane, expand the Conditional formatting card and for either Background color scales
or Font color scales, turn the slider to On. Turning either on displays a link for Advanced controls, which
allows you to customize the colors and values for the color formatting.



Limitations and considerations

Either approach achieves the same result. Selecting Advanced controls displays the following dialog, which lets you
make adjustments:

In this release of the Matrix visual, there are a few limitations and considerations to keep in mind.



Drill on columns can only be done by using the right-click menu, and there's currently no indication on the
visual that you can drill into row or column groups
You can only expand all items in a level at once, rather than expanding one category at a time
See Records may appear on a menu when right-clicking a column headers, but it is not operational
There currently is no Grand total row
Turning off the subtotal row in stepped layout doesn't have any effect
Column headers may be truncated if inner groups have shorter text than the outer group
Changing the stepped layout indentation shouldn't indent the outermost row group's indent

We're always eager to hear your thoughts. We're currently conducting a survey on this Matrix visual, so if you
have a few minutes, please take the survey.

https://www.instant.ly/s/PYXT1


Create Power BI visuals using R
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Install R

Enable R visuals

Create R visuals in Power BI Desktop

With Power BI Desktop, you can use R to visualize your data.

Power BI Desktop does not include, deploy or install the R engine. To run R scripts in Power BI Desktop, you
must separately install R on your local computer. You can download and install R for free from many locations,
including the Revolution Open download page, and the CRAN Repository. The current release of R scripting in
Power BI Desktop supports Unicode characters as well as spaces (empty characters) in the installation path.

To enable R visuals, select File > Options and settings > Options and in the Options page that appears, make
sure your local R installation is specified in the R Scripting section of the Options window, as shown in the
following image. In the following image, the path local installation of R is C:\Program Files\R\R-3.2.0 and that
path is explicitly provided in the text box. Make sure the path it displays properly reflects the local R installation
you want Power BI Desktop to use.

Once you specify your R installation, you’re ready to begin creating R visuals.

1. Select the R Visual icon in the Visualization pane, as shown in the following image, to add an R visual.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-r-visuals.md
https://mran.revolutionanalytics.com/download/
https://cran.r-project.org/bin/windows/base/


NOTENOTE

2. When you add an R visual to a report, Power BI Desktop does the following:

A placeholder R visual image appears on the report canvas.

The R script editor appears along the bottom of the center pane.

3. Next, add fields you want to consume in your R script to the Values section in the Fields well, just as you
would with any other Power BI Desktop visual. Only fields that have been added to the Fields well are
available to your R script, and you can add new fields, or remove unneeded fields from the Fields well
while working on your R script in the Power BI Desktop R script editor. Power BI Desktop
automatically detects which fields you have added or removed.

The default aggregation type for R visuals is do not summarize.

4. Now you can use the data you selected to create a plot. As you select fields, the R script editor generates
supporting R script binding code based on your selections in the gray section along the top of the editor
pane. As you select or remove additional fields, supporting code in the R script editor is automatically
generated or removed accordingly.

In the example shown in the following image, three fields were selected: hp, gear, and drat. As a result of
those selections, the R script editor generated the following binding code:

A dataframe called dataset was created

The default aggregation is do not summarize

Similar to table visuals, fields are grouped and duplicate rows only appear once

That dataframe is comprised of the different fields selected by the user



TIPTIP
In certain cases you may not want automatic grouping to occur, or you may want all rows to appear, including
duplicates. In that case you can add an index field to your dataset which causes all rows to be considered unique,
and prevents grouping.

The generated dataframe is called dataset, and selected columns can be accessed by their respective
names. For example, the gear field can be accessed by writing dataset$gear in your R script. For fields with
spaces or special characters, use single quotes.

5. With the dataframe automatically generated by the fields you selected, you’re ready to write R script that
results in plotting to the R default device. When the script is complete, select Run from the R script editor
title bar (Run is on the right side of the title bar).

When Run is selected, Power BI Desktop identifies the plot and present it on the canvas. Since the process
is executed on your local R installation, make sure required packages are installed.

Power BI Desktop replots the visual when any of the following events occur:

Run is selected from the R script editor title bar
Whenever a data change occurs, due to data refresh, filtering, or highlighting

The following image shows an example of the correlation plot code, and plots the correlations between attributes
of different types of cars.

To get a larger view of the visualizations, you can minimize the R script editor. And of course, like other visuals in
Power BI Desktop, you can cross filter the correlation plot by selecting only sport cars in the donut visual (the



corrplot(M, method = "color",  tl.cex=0.6, tl.srt = 45, tl.col = "black")

corrplot(M, method = "circle", tl.cex=0.6, tl.srt = 45, tl.col = "black", type= "upper", order="hclust")

round visual on the right, in the above example image).

You can also modify the R script to customize the visual, and take advantage of the power of R by adding
parameters to the plotting command.

The original plotting command was the following:

With a few changes in the R script, the command is now the following:

As a result, the R visual now plots circles, only considers at the upper half, and reorders the matrix to cluster
correlated attributes, as shown in the following image.

When executing a R script that results in an error, the R visual is not plotted and an error message is displayed on
the canvas. For details on the error, select See details from the R visual error on the canvas.



Known limitations

Next steps

R scripts security: R visuals are created from R scripts, which could contain code with security or privacy
risks. When attempting to view or interact with an R visual the first time, a user is presented with a security
warning message. Only enable R visuals if you trust the author and source, or after you review and
understand the R script.

R visuals in Power BI Desktop has a few limitations:

Data size limitations – data used by the R visual for plotting is limited to 150,000 rows. If more than 150,000
rows are selected, only the top 150,000 rows are used and a message is displayed on the image.
Calculation time limitation – if an R visual calculation exceeds 5 minutes the execution times out, resulting in
an error.
Relationships – as with other Power BI Desktop visuals, if data fields from different tables with no defined
relationship between them are selected, an error occurs.
R visuals are refreshed upon data updates, filtering, and highlighting. However, the image itself is not
interactive and cannot be the source of cross-filtering.
R visuals respond to highlighting other visuals, but you cannot click on elements in the R visual in order to
cross filter other elements.
Only plots that are plotted to the R default display device are displayed correctly on the canvas. Avoid explicitly
using a different R display device.
In this release, RRO installations are not automatically identified by the 32-bit version of Power BI Desktop, so
you must manually provide the path to the R installation directory in Options and settings > Options > R
Scripting.

Take a look at the following additional information about R in Power BI.

Running R Scripts in Power BI Desktop
Use an external R IDE with Power BI



Use R-powered custom visuals in Power BI
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Use R custom visuals

Get custom visuals from AppSourceGet custom visuals from AppSource

In Power BI Desktop and the Power BI service, you can use R-powered custom visuals without any knowledge of
R, and without any R scripting. This enables you to harness the analytic and visual power of R visuals, and R scripts,
without learning R or doing any programming yourself.

To use R-powered custom visuals, you first select and download the R custom visual you're interested in using
from the AppSource gallery of custom visuals for Power BI.

The following sections describe how to select, load, and use R-powered visuals in Power BI Desktop.

To use R-powered custom visuals, you need to download each visual from the custom visuals library, then you
can use the visual like any other type of visual in Power BI Desktop. There are two ways to get custom visuals -
you can download them from the online AppSource site, or you browse and get them from within Power BI
Desktop.

Here are the steps to browse and select visuals from the online AppSource site:

1. Navigate to the Power BI visuals library, found at https://appsource.microsoft.com. Select the Power BI apps
checkbox under Refine by product, then select the See all link.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-r-powered-custom-visuals.md
https://appsource.microsoft.com/marketplace/apps?product=power-bi-visuals&page=1
https://appsource.microsoft.com/marketplace/apps?product=power-bi-visuals&page=1
https://appsource.microsoft.com/


2. Select Power BI visuals from the list of Add-ins in the left pane.



NOTENOTE

1. Select the visual you're interested in using from the gallery, and you're taken to a page that describes the
visual. Select the Get it now button to download.

For authoring in Power BI Desktop, you need to have R installed on your local machine. But when users want to
view an R-powered visual in the Power BI service they do not need R installed locally.



You do not need to install R to use R-powered custom visuals in the Power BI service, however, if you want
to use R-powered custom visuals in Power BI Desktop you must install R on the local machine. You can
download R from the following locations:

CRAN
MRO

2. Once the visual is downloaded (which is like downloading any file from your browser), go to Power BI
Desktop and right-click the ellipsis (the ...) in the Visualizations pane, and select Import from file.

https://cran.r-project.org/
https://mran.microsoft.com/


3. You're cautioned about importing a custom visuals, as shown in the following image:

4. Navigate to where the visual file was saved, then select the file. Power BI Desktop custom visualizations
have the .pbiviz extension.

5. When you return to Power BI Desktop, you can see the new visual type in the Visualizations pane.



6. When you import the new visual (or open a report that contains a R-powered custom visual), Power BI
Desktop installs the required R packages.

From there, you can add data to the visual just as you would any other Power BI Desktop visual. When complete,
you can see your finished visual on the canvas. In the following visual, the Forecasting R-powered visual was used
with United Nations (UN) birth rate projections (the visual on the left).



Get custom visuals from within Get custom visuals from within Power BI DesktopPower BI Desktop

Like any other Power BI Desktop visual, you can publish this report with its R-powered visuals to the Power BI
service and share it with others.

Check the library often, since new visuals are being added all the time.

You can also get custom visuals from within Power BI Desktop. In Power BI Desktop right-click the ellipsis (the
...) in the Visualizations pane, and select Import from store.



Contribute R-powered custom visuals

Troubleshoot R-powered custom visuals

Missing or outdated R packagesMissing or outdated R packages

When you do so, the Power BI Custom Visuals dialog appears, where you can scroll through the available custom
visuals and select what you would like. You can search by name, select a catagory, or just scroll through the
available visuals. When you're ready, just select Add to add the custom visual to Power BI Desktop.

If you create your own R visuals for use in your reports, you can share those visual with the world by contributing
your custom visual to the custom visuals gallery. Contributions are made through GitHub, and the process is
outlined in the following location:

Contributing to the R-powered custom visuals gallery

R-powered custom visuals have certain dependencies that must be met for the visuals to work properly. When R-
powered custom visuals don't run or load properly, the problem is usually one of the following:

The R engine is missing
Errors in the R script on which the visual is based
R packages are missing or out of date

The following section describes troubleshooting steps you can take to help address trouble you run into.

When attempting to install an R-powered custom visual, you can run into errors when there are missing or
outdated R packages; this is usually due to one of the following reasons:

The R installation is incompatible with the R package,
A firewall, anti-virus software, or proxy settings are preventing R from connecting to the Internet
The Internet connection is slow, or there's an Internet connection problem

https://github.com/Microsoft/PowerBI-visuals#building-r-powered-custom-visual-corrplot


The Power BI team is actively working on mitigating these issues before they reach you, and the next Power BI
Desktop will incorporate updates to address these problems. Until then, you can take one or more of the following
steps to mitigate the issues:

1. Remove the custom visual, then install it again. This initiates a re-installation of the R packages.

> source(“C:/Users/david/Downloads/ScriptInstallPackagesForForecastWithWorkarounds.R”)    

c:\Program Files\R\R-3.3.x\bin\x64\Rterm.exe (for CRAN-R)
c:\Program Files\R\R-3.3.x\bin\x64\Rgui.exe (for CRAN-R)
c:\Program Files\R\R-3.3.x\bin\R.exe (for CRAN-R)
c:\Program Files\Microsoft\MRO-3.3.x\bin\R.exe (for MRO)
c:\Program Files\Microsoft\MRO-3.3.x\bin\x64\Rgui.exe (for MRO)
c:\Program Files\RStudio\bin\rstudio.exe (for RStudio)

2. If your installation of R is not current, upgrade your R installation, then remove/re-install the custom visual
as described in the previous step.

Supported R versions are listed in the description of each R-powered custom visual, as shown in the
following image. 

> [!NOTE] > You can keep the original R installation, and only associate Power BI Desktop with the
current version you install. Go to File > Options and settings > Options > R scripting.

3. Install R packages manually, using any R console. The steps for this approach are the following:

a. Download the R-powered visual installation script, and save that file to a local drive.

b. From the R console, run the following:

Typical default installation locations are the following:

4. If the previous steps don't work, try the following:

a. Use R Studio and follow the step outlined in 3.b. above (run the script line from the R console).

b. If the previous step doesn't work, change Tools > Global Options > Packages in R Studio, and enable
the checkbox for Use Internet Explorer library/proxy for HTTP, then repeat step 3.b. from the above



Next steps

steps.

Take a look at the following additional information about R in Power BI.

Power BI custom visuals gallery
Running R Scripts in Power BI Desktop
Create R visuals in Power BI Desktop
Use an external R IDE with Power BI

https://app.powerbi.com/visuals/
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Enabling gridlines and snap-to-gridEnabling gridlines and snap-to-grid

The Power BI Desktop report canvas provides gridlines that let you neatly align visuals on a report page, and also
provides snap-to-grid functionality so visuals in your reports look clean, aligned, and evenly spaced.

In Power BI Desktop you can also adjust the z-order (bring forward, send backward) of objects on a report, as
well as align or evenly distribute selected visuals on the canvas.

To enable gridlines and snap-to-grid, select the View ribbon, then enable the checkboxes for Show gridlines and
Snap objects to grid. You can select one or both boxes; they operate independently.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-gridlines-snap-to-grid.md


NOTENOTE

Using gridlinesUsing gridlines

If Show gridlines and Snap objects to grid are disabled, connect to any data source and they become enabled.

Gridlines are visual guides that let you see whether two or more visuals are properly aligned. When you're trying
to determine whether two (or more) visuals are aligned horizontally or vertically, you use the gridlines to visually
determine whether their borders align.

You can use CTRL+Click to select more than one visual at a time, which displays all selected visuals' borders, easily
letting you see whether the visuals are properly aligned.



Using gridlines inside visualsUsing gridlines inside visuals

In Power BI there are also gridlines inside visuals, which provide visual guides for comparing data points and
values. Beginning with the September 2017 release of Power BI Desktop, you can now manage the gridlines
within visuals using the X-Axis or Y-Axis card (as appropriate based on visual type), found in the Format section
of the Visualizations pane. You can manage the following elements of gridlines within a visual:

Turn gridlines on or off
Change the color of gridlines
Adjust the stroke (the width) of gridlines
Select the line style of the gridlines in the visual, such as solid, dashed, or dotted

Modifying certain elements of gridlines can be especially useful in reports where dark backgrounds are used for
visuals. The following image shows the Gridlines section in the X-Axis card.



Using snap-to-gridUsing snap-to-grid
When you enable Snap objects to grid, all visuals on the Power BI Desktop canvas that you move (or resize) are
automatically aligned to the nearest grid axis, making it much easier to ensure two or more visuals align to the
same horizontal or vertical location or size.



Using z-order, align, and distributeUsing z-order, align, and distribute

And that's all there is to using gridlines and snap-to-grid to easily ensure the visuals in your reports are neatly
aligned.

You can also manage the front-to-back order of visuals in a report, often referred to as the z-order of elements.
This allows you to overlap visuals in any way you want, then adjust the front-to-back order of each visual. This
ordering is done using the Bring Forward and Send Backward buttons, found in the Arrange section of Format
ribbon, which appears as soon as you select on or more visuals on the page (and is not available if no visual is
selected).



The Format ribbon also allows you to align your visuals in many different ways. This allows you to ensure your
visuals appear on the page in the alignment that you believe looks and works best.

When one visual is selected, using the Align button aligns that visual to the edge (or center) of the report canvas,
as shown in the following image.



When two or more visuals are selected, they are aligned together and use the existing aligned boundary of the
visuals for alignment. For example, with two visuals selected and the Align Left button selected, the visuals will
align to the left-most boundary of all selected visuals.

You can also distribute your visuals evenly across the report canvas, either vertically or horizontally. Just use the
Distribute button from the Format ribbon.

With a few selections from these gridlines, alignment, and distribution tools, your reports will look just how you
want them.



High density line sampling in Power BI
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NOTENOTE

How high density line sampling works

Beginning with the June 2017 release of the Power BI Desktop and updates to the Power BI service, a new
sampling algorithm is available that improves visuals that sample high density data. For example, you might create
a line chart from your retail stores’ sales results, each store having more than ten thousand sales receipts each
year. A line chart of such sales information would sample data (select a meaningful representation of that data, to
illustrate how sales varies over time) from the data for each store, and create a multi-series line chart that thereby
represents underlying data. This is common practice in visualizing high density data, and Power BI Desktop has
improved its sampling of high density data, the details of which are described in this article.

The high density sampling algorithm described in this article applies to, and is available in, both Power BI Desktop and
the Power BI service.

Previously, Power BI selected a collection of sample data points in the full range of underlying data in a
deterministic fashion. For example, for high density data on a visual spanning one calendar year, there might be
350 sample data points displayed in the visual, each of which was selected to ensure the full range of data (the
overall series of underlying data) was represented in the visual. To help understand how this happens, imagine we
were plotting stock price over a one-year period, and selected 365 data points to create a line chart visual (that's
one data point for each day).

In that situation, there are many values for a stock price within each day. Of course there is a daily high and low,
but those could occur at any time during the day when the stock market is open. For high density line sampling, if
the underlying data sample was taken at 10:30am and 12:00pm each day, you would get a representative snapshot
of the underlying data (the price at 10:30am and 12:00pm), but it might not capture the actual high and low of the
stock price for that representative data point (that day). In that situation – and others – the sampling is
representative of the underlying data, but it doesn’t always capture important points, which in this case would be
daily stock price highs and lows.

By definition, high density data is sampled to enable visualizations that can be created reasonably quickly, are
responsive to interactivity (too many data points on a visual can bog it down, and can detract from the visibility of
trends). How such data is sampled, to provide the best visualization experience, is what drives the creation of the

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-high-density-sampling.md


How the new line sampling algorithm works

Minimum and maximum values for high density line visualsMinimum and maximum values for high density line visuals

Evaluating representative data points for high density line visualsEvaluating representative data points for high density line visuals

Tooltips and high density line sampling

sampling algorithm. In Power BI Desktop, the algorithm has been improved to provide the best combination of
responsiveness, representation, and clear preservation of important points in each time slice.

The new algorithm for high density line sampling is available for line chart and area chart visuals with a continuous
x axis.

For a high density visual, Power BI intelligently slices your data into high resolution chunks, and then picks
important points to represent each chunk. That process of slicing high resolution data is specifically tuned to
ensure that the resulting chart is visually indistinguishable from rendering all of the underlying data points, but
much faster and more interactive.

For any given visualization, the following visual limitations apply:

3,500 is the maximum number data points displayed on the visual, regardless of the number of underlying data
points or series. As such, if you have 10 series with 350 data points each, the visual has reached its maximum
overall data points limit. If you have one series, it may have up to 3,500 data points if the new algorithm deems
that the best sampling for the underlying data.
There is a maximum of 60 series for any visual. If you have more than 60 series, break up the data and create
multiple visuals with 60 or less series each. It's good practice to use a slicer to show only segments of the data
(only certain series). For example, if you're displaying all subcategories in the legend, you could use a slicer to
filter by the overall category on the same report page.

These parameters ensure that visuals in Power BI Desktop render very quickly, and are responsive to interaction
with users, and do not result in undue computational overhead on the computer rendering the visual.

When the number of underlying data points exceeds the data points that can be represented in the visual (exceeds
3,500), a process called binning begins, which chunks the underlying data into groups called bins, and then
iteratively refines those bins.

The algorithm creates as many bins as possible to create the greatest granularity for the visual. Within each bin, the
algorithm finds the minimum and maximum data value, to ensure that important and significant values (for
example, outliers) are captured and displayed in the visual. Based on the results of the binning and subsequent
evaluation of the data by Power BI, the minimum resolution for the x axis for the visual is determined – to ensure
maximum granularity for the visual.

As mentioned previously, the minimum granularity for each series is 350 points, the maximum is 3,500.

Each bin is represented by two data points, which become the bin's representative data points in the visual. The
data points are simply the high and low value for that bin, and by selecting the high and low, the binning process
ensures any important high value, or significant low value, is captured and rendered in the visual.

If that sounds like a lot of analysis to ensure the occasional outlier is captured, and is properly displayed in the
visual, then you are correct – and that’s exactly the reason behind the new algorithm and binning process.

It’s important to note that this binning process, which results in the minimum and maximum value in a given bin
being captured and displayed in the visual, may affect how tooltips display data when you hover over data points.
To explain how and why this occurs, let’s revisit our example about stock prices from earlier in this article.

Let’s say you’re creating a visual based on stock price, and you're comparing two different stocks, both of which
are using High Density Sampling. The underlying data for each series has lots of data points (maybe you capture



How to turn on high density line sampling

the stock price each second of the day). The high density line sampling algorithm with perform binning for each
series independently of the other.

Now let's say the first stock jumps up in price at 12:02, then quickly comes back down ten seconds later – that’s an
important data point. When binning occurs for that stock, the high at 12:02 will be a representative data point for
that bin.

But for the second stock, 12:02 was neither a high nor a low in the bin that included that time - maybe the high and
low for the bin that includes 12:02 occurred three minutes later. In that situation, when the line chart is created and
you hover over 12:02, you will see a value in the tooltip for the first stock (because it jumped at 12:02 and that
value was selected as that bin's high data point), but you will not see any value in the tooltip at 12:02 for the
second stock. That's because the second stock had neither a high, nor a low, for the bin that included 12:02. So
there's no data to show for the second stock at 12:02, and thus, no tooltip data is displayed.

This situation will happen frequently with tooltips. The high and low values for a given bin might not match
perfectly with the evenly scaled x-axis value points, and as such the tooltip will not display the value.

By default, the new algorithm is turned on. To change this setting, go to the Formatting pane, in the General card,
and along the bottom you see a toggle slider called High Density Sampling. To turn it off, slide it to Off.



Considerations and limitations

Next steps

The new algorithm for high density line sampling is an important improvement to Power BI, but there are a few
considerations you need to know when working with high density values and data.

Because of increased granularity and the binning process, Tooltips may only show a value if the representative
data is aligned with your cursor. See the section earlier in this article on Tooltips for more information.

When an underlying data set has more than 60 series (the maximum number of series, as described earlier), the
new algorithm orders the series alphabetically, and eliminates series beyond the 60th alphabetically-ordered
series.
If the values in the data are not of type numeric or date/time, Power BI will not use the new algorithm, and will
revert to the previous (non-High Density Sampling) algorithm.
The Show items with no data setting is not supported with the new algorithm.
The new algorithm is not supported when using a live connection to a model hosted in SQL Server Analysis
Services (version 2016 or earlier). It is supported in models hosted in Power BI or Azure Analysis Services.

When the size of an overall data source is too big, the new algorithm eliminates series (legend elements) to
accommodate the data import maximum constraint.

In this situation, the new algorithm orders legend series alphabetically, and starts down the list of legend
elements in alphabetical order, until the data import maximum is reached, and does not import
additional series.

For information about high density sampling in scatter charts, see the following article.

High Density Sampling in Power BI scatter charts



High density sampling in Power BI scatter charts
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NOTENOTE

How high density scatter charts work

Beginning with the September 2017 release of the Power BI Desktop and updates to the Power BI service, a
new sampling algorithm is available that improves how scatter charts represent high density data.

For example, you might create a scatter chart from your organization's sales activity, each store having tens of
thousands of data points each year. A scatter chart of such information would sample data (select a meaningful
representation of that data, to illustrate how sales occurred over time) from the available data, and create a scatter
chart that represents the underlying data. This is common practice in high density scatter charts, and Power BI has
improved its sampling of high density data, the details of which are described in this article.

The high density sampling algorithm described in this article applies to, and is available in, scatter charts in both Power BI
Desktop and the Power BI service.

Previously, Power BI selected a collection of sample data points in the full range of underlying data in a
deterministic fashion to create a scatter chart. Specifically, Power BI would select the first and last rows of data in
the scatter chart series, then would divide the remaining rows evenly so that 3,500 data points total would be
plotted on the scatter chart. For example, if the sample had 35,000 rows, then the first and last rows would be
selected for plotting, then every tenth row would also be plotted (35,000 / 10 = every tenth row = 3,500 data
points). Also previously, null values or points that could not be plotted (such as text values) in data series weren't
shown, and thus were not considered when generating the visual. And with such sampling, the perceived density
of the scatter chart was also based on the representative data points, and thus the implied visual density was a
circumstance of the sampled points, and not the full collection of the underlying data.

When you enable High Density Sampling, Power BI implements an algorithm that eliminates overlapping points,
and ensures that the points on the visual can be reached when interacting with the visual. It also ensures that all
points in data set are represented in the visual, providing context to the meaning of selected points, rather than just
plotting a representative sample.

By definition, high density data is sampled to enable visualizations that can be created reasonably quickly, and are

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-high-density-scatter-charts.md


NOTENOTE

How the new scatter chart sampling algorithm works

NOTENOTE

When the standard algorithm for scatter charts is usedWhen the standard algorithm for scatter charts is used

responsive to interactivity (too many data points on a visual can bog it down, and can detract from the visibility of
trends). How such data is sampled, to provide the best visualization experience and ensure all data is represented,
is what drives the creation of the sampling algorithm. In Power BI, the algorithm has been improved to provide the
best combination of responsiveness, representation, and clear preservation of important points in the overall data
set.

Scatter charts using the high density sampling algorithm are best plotted on square visuals, as with all scatter charts.

The new algorithm for High Density Sampling for scatter charts employs methods that capture and represent
the underlying data more effectively, and eliminate overlapping points. It does this by starting with a small radius
for each data point (the visual circle size for a given point on the visualization). It then increases the radius of all
data points; when two (or more) data points overlap, a single circle (of the increased radius size) represents those
overlapped data points. The algorithm continues to increase the radius of data points, until that radius value results
in a reasonable number of data points - 3,500 - being displayed in the scatter chart.

The methods in this algorithm ensure that outliers are represented in the resulting visual. The algorithm respects
scale when determining overlap, too, such that exponential scales are visualized with fidelity to the underlying
visualized points.

The algorithm also preserves the overall shape of the scatter chart.

When using the High Density Sampling algorithm for scatter charts, accurate distribution of the data is the goal, and
implied visual density is not the goal. For example, you might see a scatter chart with lots of circles that overlap (density) in a
certain area, and imagine many data points must be clustered there; since the High Density Sampling algorithm can use
one circle to represent many data points, such implied visual density (or "clustering") will not show up. To get more detail in a
given area, you can use slicers to zoom in.

In addition, data points that cannot be plotted (such as nulls or text values) are ignored, so another value that can
be plotted is selected, further ensuring the true shape of the scatter chart is maintained.

There are circumstances under which High Density Sampling cannot be applied to a scatter chart, and the
original algorithm is used. Those circumstances are the following:

If you right-click on Details, then select Show items with no data from the menu that appears, the scatter
chart will revert to the original algorithm.



How to turn on high density sampling for a scatter chart

Any values in the Play axis will result in the scatter chart reverting to the original algorithm.
If both X and Y axes are missing on a scatter chart, the chart reverts to the original algorithm.
Using a Ratio line in the Analytics pane results in the chart reverting to the original algorithm.

To turn on High Density Sampling, select a scatter chart and then go to the Formatting pane, and expand the
General card. Near the bottom of that card, a toggle slider called High Density Sampling is available. To turn it
on, slide it to On.



NOTENOTE

NOTENOTE

Considerations and limitations

Next steps

Once the slider is turned on, Power BI will attempt to use the High Density Sampling algorithm whenever possible. When
the algorithm cannot be used (for example, you place a value in the Play axis), the slider stays in the On position even
though the chart has reverted to the standard algorithm. If you then remove a value from the Play axis (or conditions
change to enable use of the high density sampling algorithm), since the slider is on the chart will automatically use high
density sampling for that chart.

Data points are grouped and/or selected by the index. Having a legend does not affect sampling for the algorithm, it only
affects the ordering of the visual.

The high density sampling algorithm is an important improvement to Power BI, but there are a few considerations
you need to know when working with high density values and scatter charts.

The High Density Sampling algorithm only works with live connections to Power BI service-based models,
imported models, or DirectQuery.

For more information about high density sampling in other charts, see the following article.



High density line sampling in Power BI



Add a column from an example in Power BI Desktop
11/22/2017 • 4 min to read • Edit Online

Use Query Editor to add a new column from examples

Starting with the April 2017 release of Power BI Desktop, you can add new columns of data to your model using
Query Editor by simply providing one or more sample values for your new column. You can create a new column
example from a current selection, or from providing input based on all (or selected) columns in a given table.

This approach helps you quickly and easily create new columns, and is great for the following situations:

You know the data result you want in your new column, but you're not sure which transformation (or collection
of transformations) will get you there.
You already know which transformations you need, but you're not sure where to click or select in the UI to
make them happen.
You know all about the transformations you need using a Custom Column expression in M, but one (or more)
of those expressions aren't available to click or add in the UI.

Using the add column from example feature is easy and straightforward. In the next few sections, we see just
how easy it is.

To create a new column from an example, launch Query Editor. You can do this by selecting Edit Queries from
the Home ribbon in Power BI Desktop.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-add-column-from-example.md


The Add Column From Examples pane

In this article, we'll use data from the following Wikipedia article (it's a link, so you can click it to get the data for
yourself and follow along):

List of states and territories of the United States

Once Query Editor is launched and you have some data loaded, you can get started adding a column from
examples. To add a new column, in Query Editor select the Add Column tab on the ribbon and select Column
from Examples. If you choose the drop-down, you can select either From All Columns (the default, if you just
select the button instead of the drop-down) or select From Selection. In this article, we'll walk through selecting
From All Columns.

Once you make a selection to add a new column from examples, a new pane appears that shows the columns in
the current table (you may need to scroll to see them all). The new Column1 is also shown to the right, which is
the column that Power BI Desktop will create based on your examples. Below the new Column1 header are
blank cells, where you can type in your examples that Power BI uses to create rules and transformations to match
your example.

Notice too that this is an Applied Step in the Query Settings pane. As always, Query Editor will record your

https://wikipedia.org/wiki/List_of_states_and_territories_of_the_United_States


transformation steps and apply them to the query, in order.

This is called the Add Columns From Examples pane, and it consists of four primary areas:

1. The Command bar which includes a brief description of the feature, or the transformation.
2. The Send Feedback option to help Power BI improve this feature.
3. The OK and Cancel buttons, which lets you commit your transformations and add the column, or cancel.
4. The new column area, where you can type your sample values in any of the rows (to provide Power BI with

your example), relating to other columns in that row.

As you type your example in the new column, Power BI gives you a preview of how the column it's creating will
appear, based on the transformations it detects. For example, we typed Alabama in the first row, corresponding to
the Alabama value in the first column of the table. As soon as we hit Enter Power BI fills in the column based on
that value.

But then we went to the row that included Massachusetts[E] and deleted that last [E] portion (because we didn't
want it) and Power BI detected the change, and used the example to create a transformation. Notice the
explanation of the transform in the upper middle pane.



See Add Column from Examples in action

Considerations and limitations

As you continue to provide examples, Query Editor adds to the transformations. When you're satisfied, you can
select OK to commit your changes.

Want to see this working? The following video shows this feature being put to use, using the data source provided
earlier in this example. Take a look, and follow along for yourself!

There are many transformations that are available when using Add column from Examples, but not every
transformation is included. The following list provides all the transformations that are supported.

Reference

Reference to a specific column (including trim, clean, and case transformations)
Text transformations

Combine (supports combination of literal strings and entire column values)
Replace
Length
Extract

First Characters
Last Characters



NOTENOTE

Range
Text before Delimiter
Text after Delimiter
Text between Delimiters
Length

The following supported text transformations are available beginning with the November 2017 release of
Power BI Desktop:

Remove Characters
Keep Characters

All Text transformations take into account the potential need to trim, clean, or apply a case transformation to the column
value.

Date transformations

Day
Day of Week
Day of Week Name
Day of Year
Month
Month Name
Quarter of Year
Week of Month
Week of Year
Year
Age
Start of Year
End of Year
Start of Month
End of Month
Start of Quarter
Days in Month
End of Quarter
Start of Week
End of Week
Day of Month
Start of Day
End of Day

Time transformations

Hour
Minute
Second
To Local Time



NOTENOTE
All Date and Time transformations take into account the potential need to convert the column value to Date or Time or
DateTime.

Number transformations

Absolute Value
Arccosine
Arcsine
Arctangent
Convert to Number
Cosine
Cube
Divide
Exponent
Factorial
Integer Divide
Is Even
Is Odd
Ln
Base-10 Logarithm
Modulo
Multiply
Round Down
Round Up
Sign
Sin
Square Root
Square
Subtract
Sum
Tangent

The following supported number transformation is available beginning with the November 2017 release
of Power BI Desktop:

Bucketing/Ranges
General

Conditional Column



Add a custom column in Power BI Desktop
1/25/2018 • 2 min to read • Edit Online

Use Query Editor to add a new custom column

You can easily add a new custom column of data to your model using Query Editor in Power BI Desktop. You
can create and rename your custom column using easy buttons to create M formulas that define your custom
column. The M formula has a comprehensive function reference content set.

Creating a custom column is another Applied Step to the query you create in Query Editor, which means it can
be changed, moved earlier or later, or modified at any time.

To create a new custom column, launch Query Editor. You can do this by selecting Edit Queries from the Home
ribbon in Power BI Desktop.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-add-custom-column.md
https://msdn.microsoft.com/library/mt270235.aspx
https://msdn.microsoft.com/library/mt779182.aspx


The Add Custom Column window

Once Query Editor is launched and you have some data loaded, you can add a custom column by selecting the
Add Column tab on the ribbon, and then selecting Custom Column.

When you do so, the Add Custom Column window appears, which we discuss in the following section.

In the Add Custom Column window, you see the list of available fields in the pane on the right, the name of your
custom column on the top (you can rename it just by typing a new name in that text box), and the M formula that
you create (or write) based on inserting fields from the right, adding operators, and otherwise building the formula
on which your new custom column will be defined.

https://msdn.microsoft.com/library/mt779182.aspx


Create formulas for your custom column
You can select a field from the Available columns: list on the right, and select << Insert to add them to the
custom column formula. You can simply double-click on a column in the list to add it, too.

As you type the formula and build your column, in the bottom of the window you'll see an indicator telling you, in
real time (as you type) whether any syntax errors are detected. If all is good, you'll see a green checkmark.

But if you have some sort of error in your syntax, you get a yellow warning icon, along with the error detected, and
a link that puts the cursor (in your formula) where the error is detected.



Using the Advanced Editor for Custom Columns

When you select OK, your custom column is added to the model, and the Added Custom step is added to your
query's Applied Steps.

If you double-click the Added Custom step in the Applied Steps pane, the Add Custom Column window
appears again, with the custom column formula you created already loaded, and ready for you to modify if
necessary.

You can also create a custom column (and modify any step of your query, for that matter) using the Advanced
Editor. In Query Editor select the View tab and then select Advanced Editor to display the Advanced Editor.



Next steps

The Advanced Editor gives you full control over your query.

There are other ways to create a custom column, including creating a column based on examples you provide to
Query Editor. See the following article for more information on creating custom columns from examples:

Add a column from an example in Power BI Desktop
Introduction to M formula language
M function reference

https://msdn.microsoft.com/library/mt270235.aspx
https://msdn.microsoft.com/library/mt779182.aspx


Optimize a Power BI visual for any size
11/9/2017 • 1 min to read • Edit Online

Turn on responsiveness in Power BI Desktop

You can set the visuals in your dashboard or report to be responsive, to change dynamically to display the
maximum amount of data and insight, no matter the screen size.

As a visual changes size, Power BI prioritizes the data view, for example removing padding and moving the legend
to the top of the visual automatically, so the visual remains informative even as it gets smaller. Responsiveness is
especially useful in visuals in the Power BI mobile app on phones.

You can turn on responsiveness for any visual with X and Y axes, and slicers.

1. In Power BI Desktop, on the View tab, make sure you're in Desktop Layout.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-create-responsive-visuals.md


Turn on responsiveness in the Power BI service

2. Select a visual, and in the Visualizations pane select the Format section.
3. Expand General > slide Responsive to On.

Now when you create a report optimized for the phone and add this visual, it will resize gracefully.

You turn on responsiveness for a visual in a report in the Power BI service. You need to be able to edit the report.

1. In a report in the Power BI service (https://powerbi.com), select Edit Report.
2. Select a visual, and in the Visualizations pane select the Format section.
3. Expand General > slide Responsive to On.

https://powerbi.com


Next steps

Now when you create a phone view of a dashboard and add this visual, it will resize gracefully.

Create reports optimized for the Power BI phone apps
Create a phone view of a dashboard in Power BI
View Power BI reports optimized for your phone
More questions? Try asking the Power BI Community

http://community.powerbi.com/


Use inline hierarchy labels in Power BI Desktop
12/6/2017 • 2 min to read • Edit Online

How inline hierarchy labels work

Using the built-in Expand All feature (without sorting by hierarchy labels)Using the built-in Expand All feature (without sorting by hierarchy labels)

Power BI Desktop supports the use of inline hierarchy labels, which is the first of two features intended to
enhance hierarchical drilling. The second feature, which is currently in development, is the ability to use nested
hierarchy labels (stay tuned for that - our updates happen frequently).

With inline hierarchy labels, you can see hierarchy labels as you expand visuals using the Expand All feature. One
great benefit to seeing these hierarchy labels is that you can also choose to sort by these different hierarchy labels
as you expand your hierarchical data.

Before we see inline hierarchy labels in action, let's review how the default Expand All feature behavior. Doing so
will help us understand (and appreciate) how useful inline hierarchy labels can be.

The following image shows a bar chart visual for annual sales. When you right-click, you can choose Expand All.

Once Expand All is selected, the visual expands the date hierarchy from Year to Quarter, as shown in the
following image.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-inline-hierarchy-labels.md


Using inline hierarchy labelsUsing inline hierarchy labels

Notice that the Year and Quarter labels are shown inline together... this labeling scheme continues as you Expand
All down to the bottom of the hierarchy.

This is how the built-in Date hierarchy, associated with fields that have a date/time data type, behaves. Let's head
to the next section, and see how the new inline hierarchy labels feature is different.

Now let's look at a different chart - using data that has informal hierarchies. In the following visual, we have a bar
chart with Sales Amount, using Color as the axis. In this data, Color and Class form an informal hierarchy. From
here, you can again select Expand All to drill down into the hierarchy.

Selecting Expand All shows the next level with the inline display of hierarchy labels. By default, inline hierarchies
are sorted by the measure value – in this case, SalesAmount. With inline hierarchy labels enabled, you can choose
to sort this data by the hierarchy too, by selecting the ellipses in the upper right corner (the ...), then selecting Sort
By > Color Class as shown in the following image.



NOTENOTE

Troubleshooting

Once Color Class is selected, the data is sorted based on the informal hierarchy selection, as shown in the
following image.

The inline hierarchy label feature doesn't yet allow for the built-in time hierarchy to be sorted by value; it's only sorted by
hierarchy order.

It's possible for your visuals to get stuck in an expanded inline hierarchy level state. In some cases, you might find
that some of your visuals are stuck in the mode where they were expanded, in which case drilling up doesn't work.
This can happen if you happened to take the following steps (the fix for this is below these steps):

Steps that might get your visuals stuck in an expanded state:

1. You enable the inline hierarchy label feature
2. You create some visuals with hierarchies
3. Then you Expand All and save your file
4. You then disable the inline hierarchy label feature, and restart Power BI Desktop
5. Then you re-open your file

If you happen to take those steps, and your visuals are stuck in expanded mode, you can do the following to
troubleshoot them:

1. Re-enable the inline hierarchy label feature, then restart Power BI Desktop



2. Re-open your file, and drill back up to top of your affected visual(s)
3. Save your file
4. Disable the inline hierarchy label feature, then restart Power BI Desktop
5. Re-open your file

Alternatively, you can just delete your visual and recreate it.



Use the numeric range slicer in Power BI Desktop
1/25/2018 • 2 min to read • Edit Online

Using the numeric range slicer

With the numeric range slicer, you can apply all sorts of filters to any numeric column in your data model. You
can choose to filter between numbers, less than or equal to a number, or more than or equal to a number.
While this may sound straightforward, it's a very powerful way to filter your data.

You can use the numeric range slicer just like any other slicer. Simply create a slicer visual for your report, and
then select a numeric value for the Field value. In the following image, the UnitPrice field is selected.

Select the carat in the upper-right corner of the numeric range slicer and a menu appears.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-slicer-numeric-range.md


For the numeric range, you can select from the following three selections:

Between
Less than or equal to
Greater than or equal to

When you select Between from the menu, a slider appears and you can filter for numeric values that fall between
the numbers. In addition to using the slider bar itself, you can click in either box and type in the values. This is
convenient when you want to slice on specific whole numbers, yet the granularity of moving the slicer bar makes it
difficult to land exactly on that number.

In the following image, the report page is filtered for UnitPrice values that range between 500 and 1500.

When we select Less than or equal to, the left (lower value) handle of the slider bar disappears, and we can adjust
only the upper bound of the slider bar. In the following image, we set the slider bar to 497.17.



Limitations and considerations

Lastly, if we select Greater than or equal to, then the right (highest value) slider bar handle disappears, and we
can adjust the lower value, as seen in the following image. Now only items with a UnitPrice greater than or equal to
750.56 are displayed in the visuals on the report page.

The following limitations and considerations currently apply to the numeric range slicer

The numeric range slicer currently filters every underlying row in the data, not any aggregated value. For
example, if a Sales Amount field is used, each transaction based on Sales Amount would be filtered upon, not
the sum of Sales Amount for each data point of a visual.
It does not currently work with Measures
Currently the numeric range slicer is only available in Power BI Desktop. If a report that uses the numeric



range slicer is published to the Power BI service, the filter will still be applied but it will appear as a list slicer.



Create a responsive slicer you can resize in Power BI
(Preview)
12/9/2017 • 2 min to read • Edit Online

Create a slicer

Responsive slicers resize to fit any space on your report. With responsive slicers, you can resize them to different
sizes and shapes, from horizontal to square to vertical, and the values in the slicer rearrange themselves as you do.
In Power BI Desktop and in the Power BI service, you can make horizontal slicers and date/range slicers responsive.
Date/range slicers also have improved touch areas so it’s easier to change them with a fingertip. You can make
responsive slicers as small or as large as you want; they also resize automatically to fit well on reports in the Power
BI service and also in the Power BI mobile apps.

The first step to creating a dynamic slicer is to create a basic slicer.

1. Select the Slicer icon  in the Visualizations pane.
2. Drag the field you want to filter on to Field.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/power-bi-slicer-filter-responsive.md


Convert to a horizontal slicer

Make it responsive and experiment with it

1. With the slicer selected, in the Visualizations pane select the Format tab.
2. Expand the General section, then for Orientation, select Horizontal.

3. You'll probably want to make it wider, to show more values.



Add it to a phone report layout

This step is easy.

1. Right under Orientation in the General section of the Format tab, slide Responsive (Preview) to On.

2. Now you can play with it. Drag the corners to make it short, tall, wide, and narrow. If you make it small
enough, it becomes just a filter icon.

In Power BI Desktop, you can create a phone layout for each page of a report. If a page has a phone layout, it
displays on a mobile phone in portrait view. Otherwise, you need to view it in landscape view.

1. On the View menu, select Phone Layout.

2. Drag all the visuals you want in the phone report to the grid. When you drag the responsive slicer, make it
the size you want -- in this case, just a filter icon.



Make a time or range slicer responsive

Next steps

Read more about creating reports optimized for the Power BI mobile apps.

You can follow the same steps to make a tile or range slicer responsive. After you set Responsive to On, you notice
a few things:

Visuals optimize the order of input boxes depending on the size allowed on the canvas.
Data-element display is optimized to make the slicer as usable as possible, based on the size it’s allowed on the
canvas.
New round handlebars on the sliders optimize touch interactions.
When a visual becomes too small to be useful, it becomes an icon representing the visual type in its place. To
interact with it, just double-tap to open it in focus mode. This saves valuable space on the report page without
losing the functionality.

Tutorial: Slicers in the Power BI service
More questions? Try asking the Power BI Community

http://community.powerbi.com/


Use Power BI service or Power BI Desktop to create
a custom Answer Page for Cortana
12/20/2017 • 3 min to read • Edit Online

IMPORTANTIMPORTANT

Before you begin

Use the full capabilities of Power BI to create special report pages, called Cortana answer pages (and sometimes
called "Cortana answer cards") designed specifically to answer Cortana questions.

If you are trying out the Cortana and Power BI dashboard preview, you can skip the rest of this article. There are no
setup requirements for Cortana to be able to search your Power BI dashboards.

We have 4 documents that guide you through setting up and using Cortana for Power BI. If you haven't already,
we recommend that you start by reading article 1. And article 2 is especially important because it describes
some steps you'll need to take before you can begin using Cortana answer pages.

Article 1 Learn how Cortana and Power BI work together

Article 2: For searching Power BI reports: Enable the Cortana - Power BI - Windows integration

Article 3: This article

Article 4: Troubleshoot issues

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-cortana-answer-cards.md


Create a Cortana answer page designed specifically for Cortana
A Cortana answer page in a report is sized specifically for Cortana so that Cortana can display it in-screen as an
answer to a question. To create an answer page for Cortana:

1. We recommend starting with a blank report page.

3. Create a visual or a set of visuals that you want to appear in Cortana in response to a particular question (or
set of questions).

2. In the Visualizations pane, select the paint roller icon and choose Page Size > Type > Cortana.

4. Ensure that all visuals fit within the page borders. Optionally, modify display settings, data labels, colors,
and backgrounds.

5. Name the page and add alternate names. Cortana uses these names when it searches for results. In the
Visualizations pane, select the paintbrush icon and choose Page Information. Enable Q&A for this
visual by moving the slider to On.



TIPTIP

NOTENOTE

To improve results, avoid using words that are also column names.

6. Optionally, if your report has page level filters, you may want to set Require single selection. Cortana
will only display this report as an answer if one, and only one, of the filter items is specified in the
question. Require single selection can be found at the bottom of the Filters pane.

You don't have to set Require single selection to ask Cortana to display a report with page level filters. For
example “show sales for Charlotte Lindseys” will display the answer page regardless of the Require Single Selection
setting.

For example, if you ask Cortana:

"show sales by store name," this answer page will not appear because you did not include any of the
items in the required page level filter.
"show sales for Cary Lindseys and Charlotte Lindseys," this answer page will not appear because you
specified more than one item from the required page level filter.
"show sales for Charlotte Lindseys," this answer page will display.

= "show sales" this answer page will not appear because you didn't include any of the items in the



IMPORTANTIMPORTANT

How does Cortana order the results?

NOTENOTE

Next steps

required page level filter.

Before your Cortana answer page can be accessed by Cortana, you will need to Enable the dataset for Cortana.

Results with high scoring answers (such as a complete match of a specified page name) will appear first as a
best match in Cortana. Multiple best matches can appear if there are multiple Cortana answer pages in Power BI.
Medium or lower scoring answers, such as answers not based on the name of an answer page or a question
with words not understood by Power BI, are listed as links below best matches in Cortana.

When a new dataset or custom Cortana answer page is added to Power BI and enabled for Cortana it can take up to 30
minutes for results to begin appearing in Cortana. Logging in and out of Windows 10, or otherwise restarting the Cortana
process in Windows 10, will allow new content to appear immediately.

Using Cortana with Power BI

Still can't get Cortana to work with Power BI? Try the Cortana troubleshooter.

More questions? Try the Power BI Community

http://community.powerbi.com/


Row-level security (RLS) with Power BI Desktop
1/30/2018 • 5 min to read • Edit Online

IMPORTANTIMPORTANT

Define roles and rules within Power BI Desktop

Row-level security (RLS) with Power BI Desktop can be used to restrict data access for given users. Filters restrict
data at the row level. You can define filters within roles.

You can now configure RLS for data models imported into Power BI with Power BI Desktop. You can also configure
RLS on datasets that are using DirectQuery, such as SQL Server. Previously, you were only able to implement RLS
within on-premises Analysis Services models outside of Power BI. For Analysis Services live connections, you
configure Row-level security on the on-premises model. The security option will not show up for live connection
datasets.

If you defined roles/rules within the Power BI service, you will need to recreate those roles within Power BI Desktop and
publish the report to the service.

Learn more about options for RLS within the Power BI Service.

You can define roles and rules within Power BI Desktop. When you publish to Power BI, it will also publish the role
definitions.

To define security roles, you can do the following.

NOTENOTE

2. Select the Modeling tab.

1. Import data into your Power BI Desktop report, or configure a DirectQuery connection.

You cannot define roles within Power BI Desktop for Analysis Services live connections. You will need to do that
within the Analysis Services model.

3. Select Manage Roles.

4. Select Create.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-rls.md


Validating the role within Power BI Desktop

5. Provide a name for the role.
6. Select the table that you want to apply a DAX rule.

NOTENOTE

9. Select Save.

7. Enter the DAX expressions. This expression should return a true or false. For example: [Entity ID] = “Value”.

You can use username() within this expression. Be aware that username() will have the format of DOMAIN\username
within Power BI Desktop. Within the Power BI service, it will be in the format of the user's UPN. Alternatively, you can
use userprincipalname() which will always return the user in the format of their user principal name.

8. After you have created the DAX expression, you can select the check above the expression box to validate
the expression.

You cannot assign users to a role within Power BI Desktop. This is done within the Power BI service. You can enable
dynamic security within Power BI Desktop by making use of the username() or userprincipalname() DAX functions
and having the proper relationships configured.

After you have created your role, you can test the results of the role within Power BI Desktop. To do this, select
View As Roles.

The View as roles dialog allows you to change the view of what you are seeing for that specific user or role. You
will see the roles you have created.



NOTENOTE

Limitations

Known issues

You select the role you created and then select OK to apply that role to what you are viewing. The reports will only
render the data relevant for that role.

You can also select Other user and supply a given user. It is best to supply the User Principal Name (UPN) as that is
what the Power BI service will use. Select OK and the reports will render based on what that user can see.

Within Power BI Desktop, this will only display different results if you are using dynamic security based on your DAX
expressions.

Here is a list of the current limitations for row-level security on cloud models.

If you previously had roles/rules defined within the Power BI service, you will need to recreate them within
Power BI Desktop.
You can define RLS only on the datasets created using Power BI Desktop client. If you want to enable RLS for
datasets created with Excel, you will need to convert your files into PBIX files first. Learn more
Only ETL, and DirectQuery connections are supported. Live connections to Analysis Services are handled in the
on-premises model.
Q&A and Cortana is not supported with RLS at this time. You will not see the Q&A input box for dashboards if
all models have RLS configured. This is on the roadmap, but a timeline is not available.
External sharing is not currently supported with datasets that use RLS.
For any given model, the maximum number of Azure AD principals (i.e. individual users or security groups) that
can be assigned to security roles is 1,000. To assign large numbers of users to roles, be sure to assign security
groups, rather than individual users.

There is a known issue where you will receive an error message when trying to publish from Power BI Desktop if it
was previously published. The scenario is as follows.

1. Anna has a dataset that is publised to the Power BI service and has configured RLS.
2. Anna updates the report in Power BI Desktop and re-publishes.
3. Anna will receive an error.

Workaround: Re-publish the Power BI Desktop file from the Power BI service until this issue is resolved. You can



FAQ

Next steps

do that by select Get Data > Files.

Question: What if I had previously created roles/rules for a dataset in the Power BI service? Will they still work if I
do nothing?
Answer: No. Visuals will not render properly. You will have to re-create the roles/rules within Power BI Desktop
and then published to the Power BI service.

Question: Can I creates these roles for Analysis Services data sources?
Answer: You can if you imported the data into Power BI Desktop. If you are using a live connection, you will not be
able to configure RLS within the Power BI service. This is defined within the Analysis Services model on-premises.

Question: Can I use RLS to limit the columns or measures accessible by my users?
Answer: No. If a user has access to a particular row of data, they can see all the columns of data for that row.

Question: Does RLS allow me to hide detailed data but give access to data summarized in visuals?
Answer: No, you secure individual rows of data but users can always see either the details or summarized data.

Row-level security (RLS) with the Power BI service

More questions? Try asking the Power BI Community

http://community.powerbi.com/


Customizing Tooltips in Power BI Desktop
12/6/2017 • 1 min to read • Edit Online

How to customize tooltips

Tooltips are an elegant way of providing more contextual information and detail to data points on a visual. The
following image shows a tooltip applied to a chart in Power BI Desktop.

When a visualization is created, the default tooltip displays the data point's value and category. There are many
instances when being able to customize the tooltip information would be useful, and would provide additional
context and information for users viewing the visual. Custom tooltips enable you to specify additional data points
that display as part of the tooltip.

To create a customized tooltip, in the Fields well of the Visualizations pane, simply drag a field into the Tooltips
bucket, shown in the following image. In the following image, four fields have been placed into the Tooltips
bucket.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-custom-tooltips.md


Customizing tooltips with aggregation or Quick Calcs

Once Tooltips are added to the field well, hovering over a data point on the visualization shows the values for those
fields in the tooltip.



You can further customize a tooltip by selecting an aggregation function or a Quick Calc by selecting the arrow
beside the field in the Tooltips bucket, and selecting from the available options.

There are many ways to customize Tooltips, using any field available in your dataset, to convey quick information
and insights to users viewing your dashboards or reports.



Conditional formatting in tables
12/6/2017 • 1 min to read • Edit Online

With conditional formatting for tables, you can specify customized cell background colors based on cell values,
including using gradient colors. To access conditional formatting, in the Fields well of the Visualizations pane in
Power BI Desktop, select the down-arrow beside the value in the Values well that you want to format (or right-click
the field). You can only manage conditional formatting for fields in the Values area of the Fields well.

In the dialog that appears, you can configure the color, as well as the Minimum and Maximum values. If you select
the Diverging box, you can configure an optional Center value as well.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-conditional-table-formatting.md


When applied to a table, the customized formatting applied using the steps outlined above overrides any custom
table styles applied to the conditionally formatted cells.

To remove conditional formatting from a visualization, just right-click the field again, and select Remove
Conditional Formatting.





Sort by column in Power BI Desktop
12/6/2017 • 5 min to read • Edit Online

More depth, and an example

In Power BI Desktop and the Power BI service, you can change how a visual looks by sorting it by different data
fields. By changing how you sort a visual, you can highlight the information you want to convey, and ensure the
visual reflects whatever trend (or emphasis) you want to convey.

Whether you're using numeric data (such as sales figures) or text data (such as state names), you can sort your
visualizations however you want, and make them look like you want them to. Power BI provides lots of flexibility
for sorting, and quick menus for you to use. On any visual, select the ellipses menu (...) and then Sort By, then
select the field by which you want to sort, as shown in the following image.

Let's take an example that has more depth, and see how it works in Power BI Desktop.

The following visualization list the top 15 states in terms of weather (most sunny days, ranked from 1 to 50, with 1
having the most sunny days). Here's the visualization as it looks before we do any sorting.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-sort-by-column.md


Selecting which column to use for sorting

The visual is currently sorted by Cost of living - we can tell that by matching the color of the descending bars to
the legend, but there's a better way to determine the current sort column: the Sort by dialog, available from the
ellipses menu (...) in the upper right corner of the visual. When we select the ellipses, we see the following:

There are a couple items to notice in the menu that appears when you select the ellipses:

The yellow bar next to Cost of living, and the fact that Cost of living is in bold
The little icon beside the words Sort By, which shows Z/A (Z above A) and a down arrow.

We'll look at each of those independently in the next two sections.

You noticed the yellow bar beside Cost of living in the Sort By menu, which indicated that the visual was using
the Cost of living column to sort the visual. Sorting by another column is easy - just select the ellipses to show the
Sort by menu, then select another column. It's that easy.

In the following image, we selected Community well-being as the column by which we want to sort. That column
happens to be one of the lines on the visual, rather than one of the bars. Here's what it looks like after we select
Community well-being.

Notice how the visual has changed. The values now are ordered from highest "Community well-being" value (in
this case RI for Rhode Island) for those states included in this visual, down to AZ (for Arizona) which has the lowest
value. Remember that the overall chart still only includes the 15 states with the most sunny days - we've just
ordered them based on another column included in the visual.



Selecting the sort order - smallest to largest, largest to smallest

But what if we want to sort ascending, instead of descending? The next section shows just how easy that is.

When we take a closer look at the Sort By menu from the previous image, we see that the icon next to Sort By
shows Z/A (Z above A). Take a look:

When Z/A is displayed, it means the visual is being sorted by the selected column in order of greatest value to
smallest value. Want to change that? No problem - just tap or click that Z/A icon, and it changes the sort order to
A/Z and sorts the visual (based on the selected column) from smallest to greatest value.

Here's our same visual, this time after tapping the Z/A icon on the Sort By menu to change its ordering. Notice
that AZ (Arizona) is now the first state listed, and RI (Rhode Island) is the last - the opposite sorting from before.

You can sort by any column included in the visual - we could easily select Weather as the column by which we
want to sort, and select Z/A from the Sort By menu, to show the states with the most sun first (highest value -
Weather equates to days of sunshine in this data model), and still retain the other columns in the visual however
they happen to apply to that state. Here's a look at the visual with those settings.



Sort using the Sort by Column button
There's another way to sort your data, and that's by using the Sort by Column button in the Modeling ribbon.

This approach to sorting requires that you select a column from the Fields pane, and then select the Sort by
Column button to choose how (by which column) you want to sort your visual. You have to select the column
(field) you want to sort from the Fields pane in order to enable the Sort by Column button - otherwise the button
is inactive.

Let's look at a common example: you have data from each day of the week, and you want to sort it based on
chronological order. The following steps show you how.

1. First, notice that when the visual is selected but no column is selected in the Fields pane, the Sort by
Column button is inactive (grayed out).



2. When we select the column by which we want to sort, in the Fields pane, the Sort by Column button
becomes active.

3. Now, with the visual selected, we can select Day of Week, instead of the default (Name of Day), and the
visual now sorts in the order we want: by the day of the week.



Getting back to default column for sorting

And that's it. Remember that you must select a column in the Fields pane for the Sort by Column button to
become active.

You can sort by any column you'd like, but there may be times when you want the visual to return to its default
sorting column. No problem. For a visual that has a sort column selected (a selected sort column has a yellow bar
beside it in the Sort By menu, as we learned), simply open the Sort By menu and select that column again, and the
visualization returns to its default sort column.

For example, here's our previous chart:

When we go back to the menu and select Weather again, the visual defaults to being ordered alphabetically by
State Code, as shown in the following image.



With so many options for sorting your visuals, creating just the chart or image you want is easy.



Create reports optimized for the Power BI phone
apps
12/9/2017 • 4 min to read • Edit Online

Lay out a report page for the phone in Power BI Desktop

When you create a report in Power BI Desktop, you can improve the experience of using it in the mobile apps on
phones by creating a version of the report specifically for the phone. You adapt your report for the phone by
rearranging and resizing visuals, maybe not including all of them, for an optimal experience. Plus you can create
responsive visuals and responsive slicers that resize well for viewing on a phone. Also, if you add filters to your
report, those filters show up automatically in the phone report. Your report readers can see them and filter the
report with them.

After you create a report in Power BI Desktop, you can optimize it for phones.

1. In Power BI Desktop, select Report View in the left navigation bar.

2. On the View tab, select Phone Layout.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-create-phone-report.md


NOTENOTE

You see a blank phone canvas. All of the visuals on the original report page are listed in the Visualizations
pane on the right.

3. To add a visual to the phone layout, drag it from the Visualizations pane to the phone canvas.

Phone reports use a grid layout. As you drag visuals to the mobile canvas, they snap to that grid.

You can add some or all the master report page visuals to the phone report page. You can add each visual
only once.

4. You can resize your visuals on the grid, as you would for tiles on dashboards and mobile dashboards.

The phone report grid scales across phones of different sizes, so your report will look as good on small- and on
large-screen phones.



 Optimize a visual for any size
You can set the visuals in your dashboard or report to be responsive, to change dynamically to display the
maximum amount of data and insight, no matter the screen size.

As a visual changes size, Power BI prioritizes the data view, for example removing padding and moving the
legend to the top of the visual automatically, so the visual remains informative even as it gets smaller.



Considerations when creating phone report layouts

Remove a visual from the phone layout

You choose whether to turn on responsiveness for each visual. Read more about optimizing visuals.

For reports with multiple pages, you can optimize all the pages or only a few.
If you've defined a background color for a report page, the phone report will have the same background color.
You can’t modify formatting settings for just the phone. Formatting is consistent between master and mobile
layouts. For example, font sizes will be the same.
To change a visual, such as changing its formatting, dataset, filters, or any other attribute, return to the regular
report authoring mode.
Power BI provides default titles and page names for phone reports in the mobile app. If you’ve created text
visuals for titles and page names in your report, consider not adding them to your phone reports.

To remove a visual, click the X in the top-right of the visual on the phone canvas, or select it and press
Delete.

Removing the visual here only removes it from the phone layout canvas. The visual and the original report
aren't affected.



 Enhance slicers to to work well in phone reports

Publish a phone report

View optimized and unoptimized reports on a phone

Slicers offer on-canvas filtering of report data. When designing slicers in the regular report authoring mode, you
can modify some slicer settings to make them more usable in phone reports:

Decide if report readers can select only one or more than one item.
Put a box around the slicer to make the report easier to scan.
Make the slicer vertical, horizontal, or responsive.

If you make the slicer responsive, as you change its size and shape it shows more or fewer options. It can be tall,
short, wide, or narrow. If you make it small enough, it becomes just a filter icon on the report page.

Read more about creating responsive slicers.

To publish the phone version of a report, you publish the main report from Power BI Desktop to the Power
BI service, and the phone version publishes at the same time.

Read more about sharing and permissions in Power BI.

In the mobile apps on phones, Power BI automatically detects optimized and unoptimized phone reports. If a
phone-optimized report exists, the Power BI phone app automatically opens the report in phone report mode.



Next steps

If a phone-optimized report doesn’t exist, the report opens in the unoptimized, landscape view.

When in a phone report, changing the phone’s orientation to landscape will open the report in the unoptimized
view with the original report layout, whether the report is optimized or not.

If you only optimize some pages, readers will see a message in portrait view, indicating the report is available in
landscape.

Report readers can turn their phones sideways to see the page in landscape mode. Read more about interacting
with Power BI reports optimized for your phone.

Create a phone view of a dashboard in Power BI
View Power BI reports optimized for your phone
Create responsive visuals optimized for any size
More questions? Try asking the Power BI Community

http://community.powerbi.com/


Publish from Power BI Desktop
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NOTENOTE

To publish a Power BI Desktop dataset and reports

Re-publish or replace a dataset published from Power BI Desktop

When you publish a Power BI Desktop file to the Power BI service, the data in the model and any reports you
created in Report view are published to your Power BI workspace. You’ll see a new dataset with the same name,
and any reports in your Workspace navigator.

Publishing from Power BI Desktop has the same effect as using Get Data in Power BI to connect to and upload
a Power BI Desktop file.

Any changes you make in to the report Power BI, for example, add, delete, or change visualizations in reports, will not be
saved to the original Power BI Desktop file.

1. In Power BI Desktop > File > Publish > Publish to Power BI or click Publish on the ribbon.

2. Sign in to Power BI.

When complete, you'll get a link to open your report in your Power BI site.

When you publish a Power BI Desktop file, the dataset and any reports you created in Power BI Desktop are
uploaded to your Power BI site. When you re-publish your Power BI Desktop file, the dataset in your Power BI
site will be replaced with the updated dataset from the Power BI Desktop file.

This is all pretty straight forward, but there are a few things you should know:

If you already have two or more datasets in Power BI with the same name as the Power BI Desktop file,
publish could fail. Make sure you have only one dataset in Power BI with the same name. You can also rename
the file and publish, creating a new dataset with same name as the file.
If you rename or delete a column or measure, any visualizations you already have in Power BI with that field
could be broken.
Power BI ignores some format changes of existing columns. For example, if you change a column’s format
from 0.25 to 25%.
If you have a refresh schedule configured for your existing dataset in Power BI and you add new data sources

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-upload-desktop-files.md


to your file and then re-publish, you’ll have to sign into them in Manage Data Sources prior to the next
scheduled refresh.



Use See Data and See Records in Power BI Desktop
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Using See Data in Power BI Desktop

In Power BI Desktop you can drill into the details of any visual, and see a textual representation of the data or
individual data elements for a selected visual. These features are sometimes referred to as click-through, or drill-
through or drill-through to details.

You can use See Records to view the underlying rows for one selected data element from a visual, or use See
Data to view a textual version of the values used in the visual. There are some limitations to using See Data and
See Records, which are discussed at the end of this article.

The See Data button is located in the Data / Drill tab in the Visual Tools section of the ribbon.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-see-data-see-records.md


NOTENOTE

You can also See Data by right-clicking on a visual, then selecting See Data from the menu that appears.

You must be hovering over a data point in the visual in order for the right-click menu to be available.

When you select See Data, Power BI Desktop focuses on the visual and data you selected and dedicates the
canvas space to displaying the visual and the textual representation of the data. The visual is displayed on the top



half of the canvas, and the data is shown on the bottom half, as shown in the following image. This is the horizontal
view.

You can also switch to a vertical view (or back to horizontal view), by selecting the icon in the upper right corner.

To get back to the report, select < Back to Report in the upper left corner of the canvas.



Using See Records in Power BI Desktop

NOTENOTE

You can also focus on one data element in a visual, and drill into the data behind it. Once a visual is selected there
are two ways to use See Records; you can enable the See Records toggle button in the Data / Drill ribbon and
then click on a data element, or you can right-click on a data element and select See Records from the menu that
appears.

If the selected visual does not support See Records then the button on the ribbon is grayed out.

Once See Records is selected, Power BI Desktop focuses on that individual data element and dedicates the
canvas area to displaying the data for that element, as shown in the following image.



Limitations

Next steps

To get back to the report, select the Back to Report button in the upper left corner of the canvas.

There are a few limitations to consider when using See Data or See Records:

Only the following visual types are supported:

You can't use See Records when your visual uses a calculated measure
You can't use See Records when connected to a live multidimensional (MD) model

Bar
Column
Map
Tree Map
Filled Map
Pie
Donut
Funnel

There are all sorts of report formatting and data management features in Power BI Desktop. Check out the
following resources for a few examples:

Use grouping and binning in Power BI Desktop
Use gridlines, snap-to-grid, z-order, alignment and distribution in Power BI Desktop reports



Analyzing Web page data using Power BI Desktop
(tutorial)
12/6/2017 • 6 min to read • Edit Online

Task 1: Connect to a web data source

In this tutorial, you learn how to import a table of data from a Web page and create a report to visualize this data.
As part of this process, you navigate across tables available on a web page, and apply data transformation steps to
bring the table into a new shape.

In this article:

Task 1: Connect to a web data source
Task 2: Shape data in the Query view

Task 3: Create visualizations using the Report view

Step 1: Remove Other Columns to only display columns of interest
Step 2: Replace Values to clean up values in a selected column
Step 3: Filter values in a column
Step 4: Rename a column
Step 5: Filter null values in a column
Step 6: Rename a query
Query Steps created

Step 1: Load the query to your report
Step 2: Create a Map visualization

In task 1, you import a Tournament Summary table from the UEFA European Football Championship Wikipedia
page at the following location: http://en.wikipedia.org/wiki/UEFA_European_Football_Championship

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-tutorial-importing-and-analyzing-data-from-a-web-page.md


Add a Wikipedia page data sourceAdd a Wikipedia page data source



1. In the Getting Started dialog or in the Home ribbon tab, select Get Data.
2. This brings up the Get Data dialog, where you can pick from a wide range of data sources to import data into

Power BI Desktop. We will select Web which is available under the All or Other group.
3. In the Web Content dialog box, in the URL text box, paste the Wikipedia URL

(http://en.wikipedia.org/wiki/UEFA_European_Football_Championship).
4. Click OK.

After establishing a connection to the web page, you see a list of tables available on this Wikipedia page in the
Navigator dialog. You can single-click on each of these tables to preview the data.

In the Navigator left-pane, select the Results[edit] table for the Tournament Summary results, or select the
Results[edit] table and select Edit. This will allow us to reshape this table before loading it to the Report, since the
data is not in the shape that we need for our analysis.



This will land a preview of the table in the Query view, where we can apply a set of transformation steps to clean up
the data.



Task 2: Shape data in the subject table
Now that you have the subject table selected for your data query, you learn how to perform various data shaping
and cleansing steps.

Step 1: Remove Other Columns to only display columns of interest

In this step, you remove all columns except Year and Final Winners.

1. In the Query Preview grid, select the Year and Final Winners columns (use CTRL + Click).
2. Right-click a column header in the Query Preview grid, and click Remove Other Columns to remove the

unselected columns. Note that this operation is also available in the Home ribbon tab, in the Manage Columns
group.

Step 2: Replace Values to clean up values in a selected column

In this step, you replace the Details suffix in the Year column. Note that this suffix is on a new line so it is not visible
in the table preview. However, if you click in one of the cells with a numeric value in the Year column, you will see
the full value in the detailed view.



1. Select the Year column.
2. In the Query view ribbon, click Replace Values under the Home tab or right-click the Year column, and click

Replace Values to replace Details with empty text.
3. In the Replace Values dialog box, type Details in the Value to Find text box and leave the Replace With text

box empty.
4. Click OK.

Step 3: Filter values in a column

In this step, you filter the Year column to display rows that do not contain “Year”.

1. Click the filter drop down arrow on the Year column.
2. In the Filter drop-down, clear the Year option.
3. Click OK.



Step 4: Rename a column

Now that we have cleaned up the data in the Year column, we are going to work on the Final Winner column.

Since we are only looking at the list of winners, we can rename this column to Country.

1. Select the Final Winner column in the Query preview.
2. In the Query view ribbon, under the Transform tab and Any Column group, you will find Rename.
3. This will make the column name editable. We will rename this column to Country.

Step 5: Filter out null values in a column

We also need to filter out null values in the Country column. In order to do this, we could use the filter menu as we
saw in Step 3, or alternatively we can:

1. Right-click on one of the cells in the Country column that contain a null value.
2. Select Text Filters -> Does not Equal in the context menu.
3. This creates a new filter step to remove rows with null values in the Country column.

Step 6: Name a query

In this step, you name your final query Euro Cup Winners.

1. In the Query Settings pane, in the Name text box, enter Euro Cup Winners.



Task 3: Create visualizations using the Report view
Now that we have converted the data into the shape that we need for our analysis, we can load the resulting table
into our Report and create a few visualizations.

Step 1: Load the query to your report

In order to load the query results to Power BI Desktop and create a report, we select Close & Load from the Home
ribbon.

This will trigger evaluation of the query and load of the table output to the Report. In Power BI Desktop, select the
Report icon to see Power BI Desktop in Report view.



You can see the resulting table fields in the Fields pane at the right of the Report view.

Step 2: Create a Map visualization

In order to create a visualization, we can drag fields from the Field list and drop them in the Report canvas.

1. Drag the Country field and drop it in the Report canvas. This will create a new visualization in the Report
canvas. In this case, since we have a list of countries, it will create a Map visualization.



2. We can easily change the type of visualization by clicking on a different icon in the Visualization pane.

3. We are going to stay with the Map visualization type to Map, We can also resize the visualization by
dragging from one of the corners of the visualization up to the desired size.



4. Note that currently all the points in the map have the same size. We want to change this so that countries
with more Euro Cup tournaments won are represented with a larger point in the map. In order to do thiso,
we can drag the Year field in the Fields list to the Values box in the lower half of the Fields pane.

As you can see, it is very easy to customize visualizations in your report, in order to present the data in the way that
you want. Power BI Desktop provides a seamless end-to-end experience from getting data from a wide range of
data sources and shaping it to meet your analysis needs to visualizing this data in rich and interactive ways. Once
your report is ready, you can upload it to Power BI and create dashboards based on it, which you can share with
other Power BI users.



Where else can I get more information?

This concludes the Importing Data from the Web tutorial. You can download the completed Power BI Desktop
file here.

Read other Power BI Desktop tutorials
Watch Power BI Desktop videos
Visit the Power BI Forum
Read the Power BI Blog

http://download.microsoft.com/download/1/4/E/14EDED28-6C58-4055-A65C-23B4DA81C4DE/Analyzing_Data_From_The_Web.pbix
http://go.microsoft.com/fwlink/?LinkID=521937
http://go.microsoft.com/fwlink/?LinkID=519322
http://go.microsoft.com/fwlink/?LinkID=519326
http://go.microsoft.com/fwlink/?LinkID=519327
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Task 1: Get product data from an Excel workbook

Step 1: Connect to an Excel workbookStep 1: Connect to an Excel workbook

With Power BI Desktop, you can connect to all sorts of different data sources, then combine and shape them in
ways that facilitate making interesting, compelling data analysis and visualizations. In this tutorial, you'll learn how
to combine data from two data sources.

It's common to have data spread across multiple data sources, such as product information in one database, and
sales information in another. The techniques you'll learn in this document include an Excel workbook and an OData
feed, but these techniques can be applied to other data sources too, like SQL Server queries, CSV files, or any data
source in Power BI Desktop.

In this tutorial, you import data from Excel (it includes product information) and from an OData feed (which
contains orders data). You'll perform transformation and aggregation steps, and combine data from both sources
to produce a Total Sales per Product and Year report that includes interactive visualizations.

Here's what the final report will look like:

To follow the steps in this tutorial you need the Products workbook, which you can download: clickhere to
downloadProducts.xlsx.

In the Save As dialog box, name the file Products.xlsx.

In this task, you import products from the Products.xlsx file into Power BI Desktop.

1. Launch Power BI Desktop.
2. From the Home ribbon, select Get Data. Excel is one of the Most Common data connections, so you can

select it directly from the Get Data menu.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-tutorial-analyzing-sales-data-from-excel-and-an-odata-feed.md
http://download.microsoft.com/download/1/4/E/14EDED28-6C58-4055-A65C-23B4DA81C4DE/Products.xlsx
http://download.microsoft.com/download/1/4/E/14EDED28-6C58-4055-A65C-23B4DA81C4DE/Products.xlsx
http://download.microsoft.com/download/1/4/E/14EDED28-6C58-4055-A65C-23B4DA81C4DE/Products.xlsx
http://download.microsoft.com/download/1/4/E/14EDED28-6C58-4055-A65C-23B4DA81C4DE/Products.xlsx
http://download.microsoft.com/download/1/4/E/14EDED28-6C58-4055-A65C-23B4DA81C4DE/Products.xlsx


Step 2: Remove other columns to only display columns of interestStep 2: Remove other columns to only display columns of interest

3. If you select the Get Data button directly, you can also select FIle > Excel and select Connect.
4. In the Open File dialog box, select the Products.xlsx file.
5. In the Navigator pane, select the Products table and then select Edit.



Step 3: Change the data type of the UnitsInStock columnStep 3: Change the data type of the UnitsInStock column

In this step you remove all columns except ProductID, ProductName, UnitsInStock, and QuantityPerUnit. In
Power BI Desktop, there are often a few ways to accomplish the same task. For example, many buttons in the
ribbon can also be achieved by using the right-click menu on a column or a cell.

Power BI Desktop includes Query Editor, which is where you shape and transform your data connections. Query
Editor opens automatically when you select Edit from Navigator. You can also open the Query Editor by selecting
Edit Queries from the Home ribbon in Power BI Desktop. The following steps are performed in Query Editor.

1. In Query Editor, select the ProductID, ProductName, QuantityPerUnit, and UnitsInStock columns (use
Ctrl+Click to select more than one column, or Shift+Click to select columns that are beside each other).

2. Select Remove Columns > Remove Other Columns from the ribbon, or right-click on a column header and
click Remove Other Columns.

When Query Editor connects to data, it reviews each field and to determine the best data type. For the Excel
workbook, products in stock will always be a whole number, so in this step you confirm the UnitsInStock column’s
datatype is Whole Number.

1. Select the UnitsInStock column.
2. Select the Data Type drop-down button in the Home ribbon.
3. If not already a Whole Number, select Whole Number for data type from the drop down (the Data Type:

button also displays the data type for the current selection).



Power BI Desktop steps createdPower BI Desktop steps created

TASK QUERY STEP FORMULA

Connect to an Excel workbook Source Source{[Name="Products"]}[Data]

Promote the first row to table column
headers

FirstRowAsHeader Table.PromoteHeaders 
(Products)

Remove other columns to only display
columns of interest

RemovedOtherColumns Table.SelectColumns 
(FirstRowAsHeader,{"ProductID",
"ProductName", "QuantityPerUnit",
"UnitsInStock"})

Change datatype Changed Type Table.TransformColumnTypes(#"Remove
d Other Columns",{{"UnitsInStock",
Int64.Type}})

Task 2: Import order data from an OData feed

Step 1: Connect to an OData feedStep 1: Connect to an OData feed

As you perform query activities in Query Editor, query steps are created and listed in the Query Settings pane, in
the Applied Steps list. Each query step has a corresponding formula, also known as the "M" language. For more
information about the “M” formula language, see Learn about Power BI formulas.

In this task, you'll bring in order data. This step represents connecting to a sales system. You import data into Power
BI Desktop from the sample Northwind OData feed at the following URL, which you can copy (and then paste) in
the steps below: http://services.odata.org/V3/Northwind/Northwind.svc/

1. From the Home ribbon tab in Query Editor, select Get Data.
2. Browse to the OData Feed data source.
3. In the OData Feed dialog box, paste the URL for the Northwind OData feed.
4. Select OK.
5. In the Navigator pane, select the Orders table, and then select Edit.

https://support.office.com/Article/Learn-about-Power-Query-formulas-6bc50988-022b-4799-a709-f8aafdee2b2f
https://support.office.com/Article/TablePromoteHeaders-b8eaeb95-042a-42e1-9164-6d3c646acadc
https://support.office.com/Article/TableSelectColumns-20bb9e28-9fd3-4cd2-a21b-97972c82ec22
http://services.odata.org/V3/Northwind/Northwind.svc/


NOTENOTE

Step 2: Expand the Order_Details tableStep 2: Expand the Order_Details table

You can click a table name, without selecting the checkbox, to see a preview.

The Orders table contains a reference to a Details table, which contains the individual products that were included
in each Order. When you connect to data sources with multiples tables (such as a relational database) you can use
these references to build up your query.

In this step, you expand the Order_Details table that is related to the Orders table, to combine the ProductID,
UnitPrice, and Quantity columns from Order_Details into the Orders table. This is a representation of the data in
these tables:

The Expand operation combines columns from a related table into a subject table. When the query runs, rows from



Step 3: Remove other columns to only display columns of interestStep 3: Remove other columns to only display columns of interest

Step 4: Calculate the line total for each Order_Details rowStep 4: Calculate the line total for each Order_Details row

the related table (Order_Details) are combined into rows from the subject table (Orders).

After you expand the Order_Details table, three new columns and additional rows are added to the Orders table,
one for each row in the nested or related table.

1. In the Query View, scroll to the Order_Details column.
2. In the Order_Details column, select the expand icon ( ).
3. In the Expand drop-down:

a. Select (Select All Columns) to clear all columns.
b. Select ProductID, UnitPrice, and Quantity.
c. Click OK. 

In this step you remove all columns except OrderDate, ShipCity, ShipCountry, Order_Details.ProductID,
Order_Details.UnitPrice, and Order_Details.Quantity columns. In the previous task, you used Remove Other
Columns. For this task, you remove selected columns.

1. In the Query View, select all columns by completing a. and b.:

2. Now that only the columns we want to remove are selected, right-click on any selected column header and click
Remove Columns.

a. Click the first column (OrderID).
b. Shift+Click the last column (Shipper).
c. Now that all columns are selected, use Ctrl+Click to unselect the following columns: OrderDate,

ShipCity, ShipCountry, Order_Details.ProductID, Order_Details.UnitPrice, and
Order_Details.Quantity.

Power BI Desktop lets you to create calculations based on the columns you are importing, so you can enrich the
data that you connect to. In this step, you create a Custom Column to calculate the line total for each
Order_Details row.

Calculate the line total for each Order_Details row:



Step 5: Set the datatype of the LineTotal fieldStep 5: Set the datatype of the LineTotal field

2. In the Add Custom Column dialog box, in the Custom Column Formula textbox, enter
[Order_Details.UnitPrice] * [Order_Details.Quantity].

4. Click OK.

1. In the Add Column ribbon tab, click Add Custom Column.

3. In the New column name textbox, enter LineTotal.

1. Right click the LineTotal column.
2. Select Change Type and choose Decimal Number.



Step 6: Rename and reorder columns in the queryStep 6: Rename and reorder columns in the query
In this step you finish making the model easy to work with when creating reports, by renaming the final columns
and changing their order.

2. Remove the Order_Details. prefix from the Order_Details.ProductID, Order_Details.UnitPrice and
Order_Details.Quantity columns, by double-clicking on each column header, and then deleting that text from

1. In Query Editor, drag the LineTotal column to the left, after ShipCountry.



Power BI Desktop steps createdPower BI Desktop steps created

TASK QUERY STEP FORMULA

Connect to an OData feed Source Source{[Name="Orders"]}[Data]

Expand the Order_Details table Expand Order_Details Table.ExpandTableColumn 
(Orders, "Order_Details", {"ProductID",
"UnitPrice", "Quantity"},
{"Order_Details.ProductID",
"Order_Details.UnitPrice",
"Order_Details.Quantity"})

Remove other columns to only display
columns of interest

RemovedColumns Table.RemoveColumns 
(#"Expand Order_Details",{"OrderID",
"CustomerID", "EmployeeID",
"RequiredDate", "ShippedDate",
"ShipVia", "Freight", "ShipName",
"ShipAddress", "ShipCity", "ShipRegion",
"ShipPostalCode", "ShipCountry",
"Customer", "Employee", "Shipper"})

Calculate the line total for each
Order_Details row

InsertedColumn Table.AddColumn 
(RemovedColumns, "Custom", each
[Order_Details.UnitPrice] *
[Order_Details.Quantity])

Task 3: Combine the Products and Total Sales queries

Step 1: Confirm the relationship between Products and Total SalesStep 1: Confirm the relationship between Products and Total Sales

the column name.

As you perform query activities in Query Editor, query steps are created and listed in the Query Settings pane, in
the Applied Steps list. Each query step has a corresponding Power Query formula, also known as the "M"
language. For more information about this formula language, see Learn about Power BI formulas.

Power BI Desktop does not require you to combine queries to report on them. Instead, you can create
Relationships between datasets. These relationships can be created on any column that is common to your
datasets. For more information see Create and manage relationships.

In this tutorial, we have Orders and Products data that share a common 'ProductID' field, so we need to ensure
there's a relationship between them in the model we're using with Power BI Desktop. Simply specify in Power BI
Desktop that the columns from each table are related (i.e. columns that have the same values). Power BI Desktop
works out the direction and cardinality of the relationship for you. In some cases, it will even detect the
relationships automatically.

In this task, you confirm that a relationship is established in Power BI Desktop between the Products and Total
Sales queries.

1. First, we need to load the model that we created in Query Editor into Power BI Desktop. From the Home
ribbon of Query Editor, select Close & Load.

https://support.office.com/Article/Learn-about-Power-Query-formulas-6bc50988-022b-4799-a709-f8aafdee2b2f
https://support.office.com/Article/TableExpandTableColumn-54903f25-75a2-4a44-a9a3-52a9d895ee98
https://support.office.com/Article/TableRemoveColumns-6265190e-2f58-4300-85b8-df88fc1a67d3
https://support.office.com/Article/TableAddColumn-6c64d0a5-9654-4d15-bfb6-9cc380aaf3c0


2. Power BI Desktop loads the data from the two queries.

3. Once the data is loaded, select the Manage Relationships button Home ribbon.

4. Select the New… button



5. When we attempt to create the relationship, we see that one already exists! As shown in the Create
Relationship dialog (by the shaded columns), the ProductsID fields in each query already have an
established relationship.



6. Select Cancel, and then select Relationship view in Power BI Desktop.

7. We see the following, which visualizes the relationship between the queries.



9. No need to make any changes, so we'll just select Cancel to close the Edit Relationship dialog.

8. When you double-click the arrow on the line that connects the to queries, an Edit Relationship dialog
appears.



Task 4: Build visuals using your data

Step 1: Create charts showing Units in Stock by Product and Total Sales by YearStep 1: Create charts showing Units in Stock by Product and Total Sales by Year

Power BI Desktop lets you create a variety of visualizations to gain insights from your data. You can build reports
with multiple pages and each page can have multiple visuals. You can interact with your visualizations to help
analyze and understand your data. For more information about editing reports, see Edit a Report.

In this task, you create a report based on the data previously loaded. You use the Fields pane to select the columns
from which you create the visualizations.

Drag UnitsInStock from the Field pane (the Fields pane is along the right of the screen) onto a blank space on the
canvas. A Table visualization is created. Next, drag ProductName to the Axis box, found in the bottom half of the
Visualizations pane. Then we then select Sort By > UnitsInStock using the skittles in the top right corer of the
visualization.

Drag OrderDate to the canvas beneath the first chart, then drag LineTotal (again, from the Fields pane) onto the
visual, then select Line Chart. The following visualization is created.



Next, drag ShipCountry to a space on the canvas in the top right. Because you selected a geographic field, a map
was created automatically. Now drag LineTotal to the Values field; the circles on the map for each country are
now relative in size to the LineTotal for orders shipped to that country.



Step 2: Interact with your report visuals to analyze furtherStep 2: Interact with your report visuals to analyze further

Complete Sales Analysis Report

Next steps

Power BI Desktop lets you interact with visuals that cross-highlight and filter each other to uncover further trends.
For more detail see Filtering and Highlighting in Reports

1. Click on the light blue circle centered in Canada. Note how the other visuals are filtered to show Stock
(ShipCountry) and Total Orders (LineTotal) just for Canada.

After you perform all these steps, you will have a Sales Report that combines data from Products.xlsx file and
Northwind OData feed. The report shows visuals that help analyze sales information from different countries. You
can download a completed Power BI Desktop file for this tutorial here.

Read other Power BI Desktop tutorials
Watch Power BI Desktop videos
Visit the Power BI Forum
Read the Power BI Blog

http://download.microsoft.com/download/1/4/E/14EDED28-6C58-4055-A65C-23B4DA81C4DE/Analyzing_Sales_Data.pbix
http://go.microsoft.com/fwlink/?LinkID=521937
http://go.microsoft.com/fwlink/?LinkID=519322
http://go.microsoft.com/fwlink/?LinkID=519326
http://go.microsoft.com/fwlink/?LinkID=519327


Tutorial: Create your own measures in Power BI
Desktop
12/6/2017 • 12 min to read • Edit Online

What are these measures all about?

Some of the most powerful data analysis solutions in Power BI Desktop can be created by using measures.
Measures help us by performing calculations on our data as we interact with our reports. This tutorial will guide
you through understanding and creating some of your own basic measures in Power BI Desktop.

This article is intended for Power BI users already familiar with using Power BI Desktop to create more advanced
models. You should already be familiar with using Get Data and Query Editor to import data, working with
multiple related tables, and adding fields to the Report Canvas. If you’re new to Power BI Desktop, be sure to check
out Getting Started with Power BI Desktop.

To complete the steps in this tutorial, you’ll need to download the Contoso Sales Sample for Power BI Desktop file.
It already includes online sales data from the fictitious company, Contoso, Inc. Because data in the file was
imported from a database, you won’t be able to connect to the datasource or view it in Query Editor. When you
have the file on your own computer, go ahead and open it in Power BI Desktop.

Measures are most often created for us automatically, like when we select the checkbox next to the SalesAmount
field from the Sales table in the field list, or drag SalesAmount onto the Report canvas.

A new chart visualization appears, like this:

What we get is a Column chart showing a sum total amount of sales values from the SalesAmount field. Our

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-tutorial-create-measures.md
http://download.microsoft.com/download/4/6/A/46AB5E74-50F6-4761-8EDB-5AE077FD603C/Contoso Sales Sample for Power BI Desktop.zip


SalesAmount field is really just a column named SalesAmount in the Sales table we already imported.

The SalesAmount column contains over two million of rows of sales values. You might be wondering why you
don’t see a table with rows of all those values. Well, Power BI Desktop knows that all of the values in SalesAmount
are of a numeric datatype, and you’ll probably want to aggregate them in some way, whether it be adding them
up, averaging, counting, etc..

Whenever you see a field in the Fields list with a sigma icon , it means the field is numeric, and its values can be
aggregated. In this case, when we select SalesAmount, Power BI Desktop creates its own measure and the sum of
all sales amounts is calculated and displayed in our chart.

Sum is the default aggregation when we select a field with a numeric datatype, but we can change to a different
type of aggregation quite easily.

In the Value area, if we click the down arrow next to SalesAmount, we can then select Average.

Our visualization changes to an average of all sales values in the SalesAmount field.

We can change the type of aggregation depending on the result we want, but not all types of aggregation apply to
just any numeric datatype. For example, for our SalesAmount field, Sum and Average make sense. Minimum and
Maximum have their place as well. But, Count won’t really make much sense for our SalesAmount field because
while its values are numeric, they’re really currency.

Understanding aggregations is fundamental to understanding measures, because every measure will perform
some type of aggregation. We’ll see more examples of using a Sum aggregation a little later, when you create
some of your own measures.

Values calculated from measures are always changing in response to our interactions with our report. For
example, if we drag the RegionCountryName field from the Geography table to our chart, sales amounts for
each country are averaged and displayed.



Let’s create our own measure

Net salesNet sales

When the result of a measure changes because of an interaction with our report, we are affecting our measure’s
context. In fact, every time you interact with your report, you are changing the context in which a measure
calculates and displays its results.

In most cases, Power BI does its thing and calculates and returns values according to the fields we’ve added and
the types of aggregation we choose. But in other cases, you might have to create your own measures to perform
more complex, unique calculations.

With Power BI Desktop, you create your own measures with the Data Analysis Expressions (DAX) formula
language. DAX formulas are very similar to Excel formulas. In fact, DAX uses many of the same functions,
operators, and syntax as Excel formulas. However, DAX’s functions are designed to work with relational data and
perform more dynamic calculations as we interact with our reports.

There are over 200 DAX functions that do everything from simple aggregations like Sum and Average to more
complex statistical and filtering functions. We’re not going to go into too much detail on the DAX language here,
but there are many resources to help you learn more. After you've gone through this tutorial, be sure to see DAX
basics in Power BI Desktop.

When we create our own measures, they’re added to the Fields list for the table we want. This is known as a model
measure, and it will remain in our table as a field. Some of the great advantages of model measures are that we
can name them what we want, making them more identifiable. We can also use them as an argument in other DAX
expressions, and we can create measures that perform complex calculations very quickly.

Let’s say we want to analyze our net sales. If we look at our Sales table in the field list, we see that there's no field
named NetSales. But, we have the building blocks to create our own measure to calculate net sales.

We need a measure to subtract discounts and returns from sales amounts. Because we want our measure to
calculate a result for whatever context we have in our visualization, in-effect, we need to subtract the sum of
DiscountAmount and ReturnAmount from sum of SalesAmount. This might seem a little confusing at the moment;
don’t worry, it will be more clear in a little bit.

1. Right click, or click the down arrow on the Sales table in the field list, and then click New Measure. This will
make sure our new measure is saved in the Sales table, where it will be easier to find.



TIPTIP
You can also create a new measure by clicking on the New Measure button in the ribbon on Power BI Desktop’s
Home tab.

When you create a measure from the ribbon, the measure could be created in any of the tables. While a measure
doesn’t have to belong in a particular table, it will be easier to find if you create them in a table most logical to you. If
you want it to be in a particular table, click the table first, to make it active. Then click New Measure. In our case,
we’re going to create our first measure in the Sales table.

The formula bar appears along the top of the Report Canvas. This is where we can rename our measure and
enter a DAX formula.

Let’s give our new measure a name. By default a new measure is simply named Measure. If we don’t
rename it, when we create another, it will be named Measure 2, Measure 3, and so on. We want our
measures to be more identifiable, so let’s name our new measure Net Sales.

2. Highlight Measure in the formula bar, and then type Net Sales.



TIPTIP

Now we can begin entering our formula.

3. After the equals sign type an S. You’ll see a dropdown suggestion list appear with all of the DAX functions
beginning with the letter S. The more we type, the more the suggestion list is scaled closer to the function
we need. Select SUM by scrolling down, and then press Enter.

After we press Enter, an opening parenthesis appears along with another suggestion list of all of the
available columns we can pass to the SUM function.

An expression always appears between an opening and closing parenthesis. In this case, our expression is
going to contain a single argument to pass to the SUM function; a column to sum up. We can narrow down
our list of columns by typing the first letters of what we want. In this case, we want the SalesAmount
column, so when we begin typing salesam, our list gets smaller, and we are shown two items we can select.
They’re actually the same column. One just shows [SalesAmount], because we’re creating our measure in
the same table the SalesAmount column is in. The other, we see the table name preceding the column
name.

In general, it’s good practice to enter the fully qualified name of a column. It will make your formulas easier
to read.

4. Select Sales[SalesAmount], and then type a closing parenthesis.

Syntax errors are most often caused by a missing or misplaced closing parenthesis.



Let’s add our new measure to a reportLet’s add our new measure to a report

Now we want to subtract our other two columns.

5. After the closing parenthesis for our first expression, type a space, and then a minus operator (-), followed
by another space. Then enter another SUM function with the Sales[DiscountAmount] column as its
argument.

We’re starting to run out of space for our formula. No problem.

6. Click the down chevron on the right side of the formula bar.

Now we have more space. We can enter new parts to our formula on a new line by pressing Alt-Enter. We
can also move things over by using Tab.

Now we can add the final part of our formula.

7. Add another minus operator followed by another SUM function and the Sales[ReturnAmount] column as
its argument.

Our formula now looks ready.

8. Press Enter or click the checkmark in the formula bar to complete. The formula is validated and added to the
field list in the Sales table.

Now we can add our Net Sales measure to the report canvas, and net sales will be calculated for whatever other
fields we add to the report. Let’s look at net sales by country.

1. Drag the Net Sales measure from the Sales table onto the Report canvas.

2. Now drag the RegionCountryName field from the Geography table into the chart.



Let’s add some more data.

3. Drag the SalesAmount field into the chart, to see the difference between net sales and sales amount.

We now really have two measures in our chart. SalesAmount, which was summed up automatically, and the
Net Sales measure we created. In each case, the results were calculated in context of another field we have
in the chart, the countries in RegionCountryName.

Let’s add a Slicer, so we can further break down our net sales and sales amounts by calendar year.

4. Click a blank area next to the chart, then in Visualizations, click on the Table visualization.



This creates a blank table visualization in the Report canvas.

5. Drag the Year field from the Calendar table into the new blank table.

Because Year is a numeric field, Power BI Desktop summed up its values and gave us a chart. But, that
doesn’t do us much good as a Slicer.

6. In Values, click the down arrow next to Year, and then click Do Not Summarize.

Now we can change the Year field in the table visualization into a Slicer.

a. In Visualizations, click the Slicer visualization.



Let’s create another measure

Net sales per unitNet sales per unit

Now we have Year as a Slicer. We can select any individual or group of years and our report’s
visualizations will all be sliced accordingly.

7. Go ahead and click on 2013. You’ll see the chart change. Our Net Sales and SalesAmount measures are re-
calculated, showing new results just for 2013. Here again, we’ve changed the context in which our measures
calculate and display results.

Now that you know how to create your own measures, let’s create a another.

What if we want to find out which products with the most sales per unit sold is?

Well, we can create another measure. In this case, we want to divide net sales by the quantity of units sold. In-
effect, we want to divide the result of our Net Sales measure by the sum of Sales[SalesQuantity].

1. Create a new measure named Net Sales per Unit in either the Sales or Products table.

In this measure, we’re going to use the Net Sales measure we created earlier. With DAX, we can reference
other measures in our formula.

2. Begin typing Net Sales. The suggestion list will show what we can add. Select [Net Sales].

You can also reference another measure by just typing an opening bracket ([). The suggestion list will show
us only the measures we can add to our formula.

3. Right after [Net Sales], enter a space, then a divide operator (/), then enter a SUM function, then type
Quantity. The suggestion list shows all of the columns with Quantity in the name. Select
Sales[SalesQuantity]. The formula should now look like this:

Net Sales per Unit = [Net Sales] / SUM(Sales[SalesQuantity])

Pretty cool, huh? Entering DAX formulas is really quite easy when we use the DAX Editor’s search and



suggestion functionality. Now, let’s see what we get with our new Net Sales per Unit measure.

4. Drag the Net Sales per Unit measure onto a blank area in the report canvas.

Not very interesting is it? Don’t worry.

5. Change the chart visualization type to Tree Map.

6. Now drag the ProductCategory field from the ProductCategory table down into the Group area.

That’s some good info, but what if we want to look at net sales by product?

7. Remove the ProductCategory field, and then drag the ProductName field from the Product table down



What we’ve learned

Next steps

into the Group area instead.

Ok, now we're just playing, but you have to admit, that's just cool! Of course, we can filter this tree map
down any number of ways, but that's out of scope for this tutorial.

Measures give us a lot of power in getting the insights we want from our data. We’ve learned how to create
measures by using the formula bar. We can name measures whatever makes most sense, and the suggestion lists
make it easy to find and select the right element to add to our formulas. We’ve also been introduced to context,
where the result of calculations in measures change according to other fields, or by other expressions in your
measure formula.

If you want to take a deeper dive into DAX formulas, and create some more advanced measures, see DAX basics in
Power BI Desktop. This article focuses on fundamental concepts in DAX, such as syntax, functions, and a more
thorough understanding of context.

Be sure to add the Data Analysis Expressions (DAX) Reference to your favorites. This is where you'll find detailed
info on DAX syntax, operators, and the over 200 DAX functions.

https://msdn.microsoft.com/library/gg413422.aspx


Tutorial: Create calculated columns in Power BI
Desktop
12/6/2017 • 8 min to read • Edit Online

Let’s create a calculated column

Sometimes the data you’re analyzing just doesn’t contain a particular field you need to get the results you’re after.
This is where calculated columns come in. Calculated columns use Data Analysis Expressions (DAX) formulas to
define a column’s values. Those values can be just about anything, whether it be putting together text values from
a couple of different columns elsewhere in the model, or calculating a numeric value from other values. For
example, let’s say your data has a City and State columns (as fields in the Fields list), but you want a single
Location field that has both as a single value, like Miami, FL. This is precisely what calculated columns are for.

Calculated columns are similar to measures in that both are based on a DAX formula, but they differ in how they
are used. Measures are most often used in the Values area of a visualization, to calculate results based on other
fields you have on a row in a table, or in an Axis, Legend, or Group area of a visualization. Calculated columns on
the other hand are used when you want the column’s results on that row in the table, or in the Axis, Legend, or
Group area.

This tutorial will guide you through understanding and creating some of your own calculated columns in Power BI
Desktop. It’s intended for Power BI users already familiar with using Power BI Desktop to create more advanced
models. You should already be familiar with using Query to import data, working with multiple related tables, and
adding fields to the Report Canvas. If you’re new to Power BI Desktop, be sure to check out Getting Started with
Power BI Desktop.

To complete the steps in this tutorial, you’ll need to download the Contoso Sales Sample for Power BI Desktop file.
This is the same sample file used for the Create your own measures in Power BI Desktop tutorial. It already
includes sales data from the fictitious company, Contoso, Inc. Because data in the file was imported from a
database, you won’t be able to connect to the datasource or view it in Query Editor. When you have the file on
your own computer, go ahead and open it in Power BI Desktop.

Let’s say we want to display product categories together with product subcategories in a single value on rows, like
Cell phones – Accessories, Cell phones – Smart phones & PDAs, and so on. In Report View or Data View (we're
using Report View here), If we look at our product tables in the Fields list, we see there’s no field that gives is what
we want. We do, however, have a ProductCategory field and a ProductSubcategory field, each in their own tables.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-tutorial-create-calculated-columns.md
http://download.microsoft.com/download/4/6/A/46AB5E74-50F6-4761-8EDB-5AE077FD603C/Contoso Sales Sample for Power BI Desktop.zip


To create a ProductFullCategory columnTo create a ProductFullCategory column

We’ll create a new calculated column to combine values from these two column into new values for our new
column. Interestingly enough, we need to combine data from two different tables into a single column. Because
we’re going to use DAX to create our new column, we can leverage the full power of the model we already have,
including the relationships between different tables that already exist.

1. Right click, or click the down arrow on the ProductSubcategory table in the Fields list, and then click New
Column. This will make sure our new column is added to the ProductSubcategory table.

The formula bar appears along the top of the Report canvas or Data grid. This is where we can rename our
column and enter a DAX formula.

By default a new calculated column is simply named Column. If we don’t rename it, when we create
another, it will be named Column 2, Column 3, and so on. We want our columns to be more identifiable, so
we’ll give our new column a new name.

2. Since the Column name is already highlighted in the formula bar, just type ProductFullCategory.

Now we can begin entering our formula. We want the values in our new column to start with the
ProductCategory name from the ProductCategory table. Because this column is in a different, but related
table, we’re going to use the RELATED function to help us get it.

3. After the equals sign, type R. You’ll see a dropdown suggestion list appear with all of the DAX functions
beginning with the letter R. The more we type, the more the suggestion list is scaled closer to the function
we need. Next to the function you’ll see a description of the function. Select RELATED by scrolling down,

https://msdn.microsoft.com/library/ee634202.aspx


TIPTIP

TIPTIP

and then pressing Enter.

An opening parenthesis appears along with another suggestion list of all of the available columns we can
pass to the RELATED function. A description and details on what parameters are expected is also shown.

An expression always appears between an opening and closing parenthesis. In this case, our expression is
going to contain a single argument passed to the RELATED function; a related column to return values from.
The list of columns is automatically narrowed down to show only the columns that are related. In this case,
we want the ProductCategory column in the ProductCategory table.

Select ProductCategory[ProductCategory], and then type a closing parenthesis.

Syntax errors are most often caused by a missing or misplaced closing parenthesis. But often Power BI Desktop will
add it if you forget.

4. We want to add a dash symbol to separate each value, so after the closing parenthesis of the first
expression, type a space, ampersand (&), quote, space, dash (-), another space, a closing quote, and then
another ampersand. Your formula should now look like this:

ProductFullCategory = RELATED(ProductCategory[ProductCategory]) & " - " &

Click the down chevron on the right side of the formula bar to expand the formula editor. Click Alt & Enter to move
down a line, and Tab to move things over.

5. Finally, enter another opening bracket and then select the [ProductSubcategory] column to finish the
formula. Your formula should look like this:

You’ll notice we didn’t use another RELATED function in the second expression calling the



Let’s add our new column to a report

Let’s create another

ProductSubcategory column. This is because this column is already in the same table we’re creating our
new column in. We can enter [ProductCategory] with the table name (fully qualified) or without (non-
qualified).

6. Complete the formula by pressing Enter or clicking on the checkmark in the formula bar. The formula is
validated and added to the field list in the ProductSubcategory table.

You’ll notice calculated columns get a special icon in the field list. This shows they contain a formula. They’ll
only appear like this in Power BI Desktop. In the PowerBI service (your Power BI site), there’s no way to
change a formula, so a calculated column field doesn’t have an icon.

Now we can add our new ProductFullCategory column to the report canvas. Let’s look at SalesAmount by
ProductFullCategory.

Drag the ProductFullCategory column from the ProductSubcategory table onto the Report canvas, and then
drag the SalesAmount field from the Sales table into the chart.

Now that you know how to create a calculated column, let’s create another.

The Contoso Sales Sample for Power BI Desktop model contains sales data for both active and inactive stores. We
want to make it really clear that data shown for inactive stores is identified as such. In-effect, we want a field
named Active StoreName. To do this, we’ll create another column. In this case, when a store is inactive, we want
our new Active StoreName column (as a field) to show the store’s name as “Inactive”, but show the store’s real
name when it’s an active store.

Fortunately, our Stores table has a column named Status, with a value of On for active stores, and Off for inactive
stores. We can test values for each row in the Status column to create new values in our new column.



To create an Active StoreName columnTo create an Active StoreName column
1. Create a new calculated column named Active StoreName in the Stores table.

For this column, our DAX formula is going to check each stores status. If a stores status is On, our formula
will return the stores name. If it’s Off, it will have the name, “Inactive”. To do this, we’ll use the logical IF
function to test the stores status and return a particular value if the result is true or false.

2. Begin typing IF. The suggestion list will show what we can add. Select IF.

The first argument for IF is a logical test. We want to test whether or not a store has a status of “On”.

3. Type an opening bracket [ , which allows us to select columns from the Stores table. Select [Status].

4. Right after [Status], type ="On", then enter a comma (,) to enter the second argument. The tooltip
suggests we need to add the value for when the result is true.

5. If the store is On, we want to show the store’s name. Type an opening bracket [ and select the
[StoreName] column, and then type another comma so we can enter our third argument.

6. We need to add a value for when the result is false, in this case we want the value to be “Inactive”.

7. Complete the formula by pressing Enter or clicking on the checkmark in the formula bar. The formula is
validated and added to the field list in the Stores table.

Just like any other field, we can use our new Active StoreName column in visualizations. In this chart, stores
with a status of On are shown individually by name, but stores with a status of Off are grouped together
and shown as Inactive.

https://msdn.microsoft.com/library/ee634824.aspx


What we’ve learned

Next steps

Calculated columns can enrich our data, providing easier insights. We've learned how to create calculated columns
by using the formula bar, how to use the suggestions list, and how to best name our new columns.

If you want to take a deeper dive into DAX formulas, and create calculated columns with more advanced DAX
formulas, see DAX Basics in Power BI Desktop. This article focuses on fundamental concepts in DAX, such as syntax,
functions, and a more thorough understanding of context.

Be sure to add the Data Analysis Expressions (DAX) Reference to your favorites. This is where you'll find detailed
info on DAX syntax, operators, and the over 200 DAX functions.

https://msdn.microsoft.com/library/gg413422.aspx


Tutorial: Facebook analytics using Power BI Desktop
12/6/2017 • 9 min to read • Edit Online

Task 1: Connect to a Facebook page

In this tutorial you learn how to import and visualize data from Facebook. During the tutorial you'll learn how to
connect to a specific Facebook page (the Power BI page), apply data transformation steps, and create some
visualizations.

Here are the steps you'll take:

Task 1: Connect to a Facebook Page
Task 2: Create visualizations using the Report view

Step 1: Create a Treemap visualization
Task 3: Shape data in the Query view

Step 1: Split the date-time column into two
Step 2: Add an aggregate value from a related table

Task 4: Create additional visualizations using the Report view

Step 1: Load the query to your report
Step 2: Create a Line chart and a Bar chart

In this task you import data from the Microsoft Power BI Facebooksite (here's the URL:
https://www.facebook.com/microsoftbi ).

Anyone can connect to that page, and follow these steps - no special credentials (other than your own Facebook
account, which you use in this step) are required.

1. In the Getting Started dialog or in the Home ribbon tab, select Get Data.
2. The Get Data dialog appears, letting you select from all sorts of data sources. Select Facebook from the

Other group.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-tutorial-facebook-analytics.md
https://www.facebook.com/microsoftbi
https://www.facebook.com/microsoftbi


When you select Connect, a dialog appears to alert you to the risks of using a third-party service.

3. When you select Continue, the Facebook dialog box appears where you can paste the page name
(microsoftbi) into the Username text box. Select Posts from the Connection drop down.



4. Click OK.
5. When prompted for credentials, sign in using your Facebook account and allow Power BI access through

your account.

After establishing a connection to the page, you will see the data being loaded in the model.

From there, Query Editor displays the data. Query Editor is part of Power BI Desktop, but loads in a separate
window, and is where you perform all your transformations on your data connections.



When your data is how you want it, you can load it into Power BI Desktop. Select Load & Close from the Home
ribbon.

You'll see a dialog that displays the progress of loading the data into the Power BI Desktop data model.



Task 2: Create visualizations using the Report view

Once loaded, you’ll be taken to the Report view where the columns from the table are listed in the Field list on the
right.

Now that you have landed the data from the page, you can quickly and easily gain insights about your data, using
visualizations.

Step 1: Create a Treemap visualization

Creating a visualization is easy, we just drag a field from the Field list and drop it on the Report canvas.

Drag the type field onto the Report canvas. Power BI Desktop creates a new visualization in the Report canvas.
Next, drag type from Fields (the same field you just dragged onto the Report canvas) onto the Value area to
create a Bar visualization.



We can easily change the type of visualization by selecting a different icon from the Visualization pane. Let's
change the type to a Treemap by selecting its icon from Visualizations, as shown in the following image.



Next, let's add a legend, then change the color of a data point. Select the Format icon in the Visualizations pane;
the Format icon looks like a paintbrush.

When you select the down arrow next to Legend, the section expands to show how to customize the legend for the
selected visualization. In this case, we made the following selections:

moved the Legend slider to On so a legend would appear



selected Right from the Legend Position drop-down
moved the Title slider to On as well, so a title for the legend will appear
typed in type for the title of the legend

In the following image, those settings are already made and reflected in the visualization.

Next, let's change the color of one of the data points. The link data point should be blue, so it's closer to the
common color for hyperlinks.

Select the arrow next to Data Colors to expand that section. The data points are shown, with selection arrows
beside each color that allows us to select a different color for each data point.



When you click on the color box down arrow beside any data point, a color selection dialog appears, letting you
choose your color. In this case, we'll choose light blue.

That's better. In the following image, you can see how the color is applied to the data point in the visualization, and
that the legend is also automatically updated, as is its color in the Data Colors section.



Task 3: Shape data in the table
Now that you have imported the table selected and you start to visualize it, you may notice you need to perform
various data shaping and cleansing steps in order to get the most out of your data.

Step 1: Split the date-time column into two

In this step, you will split the created_time column to get both the date and time values. Whenever you're in
Power BI Desktop and you want to modify an existing query, you need to launch Query Editor. To do that, select
Edit Queries from the Home tab.

1. In the Query Editor grid, scroll to the right until you find the created_time column
2. Right-click a column header in the Query Preview grid, and click Split Column > By Delimiter to split the

columns. Chose Custom in the delimiter drop down and enter “T” Note that this operation is also available
in the Home ribbon tab, in the Manage Columns group.



3. Rename the created columns to created_date and created_time respectively.
4. Select the new column, created_time, **** and in the Query view ribbon, navigate to the Add Column tab

and select Time>Hour under the From Date & Time group. This will add a new column that is only the
hour component of the time.



5. Change the type of the new Hour column to Whole Number, by navigating to the Home tab and selecting
the Data Type drop down or by right-clicking the column and selecting Transform>Whole Number.

Step 2: Add an aggregate value from a related table

In this step, you add the count of shares from the nested value so that you can use it in the visualizations.

1. Continue scrolling to the right until you see the shares column. The nested value indicates that we need to do
another transform in order to get the actual values.

2. In the top right of the column header, select the  icon to open the Expand/Aggregate builder. Select
count and hit OK. This will add the count of the shares for each row in our table.



Query steps createdQuery steps created

3. Finally, change the type of the new shares column to Whole Number. With the column selected, the type can
be changed by right-clicking the column and selecting Transform>Whole Number or **** by navigating to
the Home tab and selecting the Data Type drop down or.

After the data loads, rename the column to shares by double clicking on the column name, right clicking the
column or in the Query view ribbon, select Rename under the Transform tab and Any Column group.

As you perform transformations in the Query view, query steps are created and listed in the Query Settings pane,
in the APPLIED STEPS list. Each query step has a corresponding Query formula, also known as the "M" language.



TASK QUERY STEP FORMULA

Connect to a Facebook source Source Facebook.Graph
("https://graph.facebook.com/microsoft
bi/posts";)

Split Columns to get the values you
need

Split Column by Delimiter Table.SplitColumn
(Source,"created_time",Splitter.SplitTextB
yDelimiter("T"),{"created_time.1",
"created_time.2"})

Change Type of the new columns
(automatic step)

Changed Type Table.TransformColumnTypes (#"Split
Column by Delimiter",{{"created_time.1",
type date}, {"created_time.2", type
time}})

Rename **a column** Renamed Columns Table.RenameColumns (#"Changed
Type",{{"created_time.1", "created_date"},
{"created_time.2", "created_time"}})

Insert **a column** Inserted Hour Table.AddColumn (#"Renamed
Columns", "Hour", each
Time.Hour([created_time]), type
number)

**Change Type ** Changed Type1 Table.TransformColumnTypes
(#"Inserted Hour",{{"Hour", type text}})

https://graph.facebook.com/microsoftbi/posts&quot


Expand **values in a nested table** Expand shares Table.ExpandRecordColumn (#"Changed
Type1", "shares", {"count"},
{"shares.count"})

Rename **the column** Renamed Columns1 Table.RenameColumns (#" Expand
shares",{{"shares.count", "shares"}})

Change Type Changed Type2 Table.TransformColumnTypes
(#"Renamed Columns1",{{"shares",
Int64.Type}})

TASK QUERY STEP FORMULA

Task 4: Create additional visualizations using the Report view
Now that we have converted the data into the shape that we need for the rest of our analysis, we can load the
resulting table into our Report and create additional visualizations.

Step 1: Load the query to your report

In order to load the query results to the report, we need to select Load & Close from Query Editor. This will load
our changes into Power BI Desktop, and close Query Editor.

In Power BI Desktop, we need to make sure we're in Report view. Select the top icon from the left bar in Power BI
Desktop.

Step 2: Create a Line chart and a Bar chart

In order to create a visualization, we can drag fields from the Field list and drop them in the Report canvas.

1. Drag the shares field onto the Report canvas, which creates a bar chart. Then drag created_date onto the
chart, and Power BI Desktop changes the visualization to a Line Chart.



2. Next, drag the shares field and drop it in the Report canvas. Now drag the Hour field into the Axis section
under the Field List.

3. We can easily change the type of visualization by clicking on a different icon in the Visualization pane. The
arrow in the image below points to the Bar Chart icon.



4. Change the visualization type to Bar Chart.
5. The Bar Chart is created, but the axis isn't what we want - we want it sorted in the other direction (from high to

low). Select the down arrow next to Y-Axis to expand that section. We need to change the type of axis from
Continuous to Categorical, so it'll sort how we want it (the image below shows the axis before we make the
selection - check out the subsequent image for how we want it to look).

That's better. And now we have three visualizations on this page, which we can size as we want to fill up the report
page.



Where else can I get more information?Where else can I get more information?

As you can see, it's easy to customize visualizations in your report, so you can present the data in the way that you
want. Power BI Desktop provides a seamless end-to-end experience from getting data from a wide range of data
sources and shaping it to meet your analysis needs to visualizing this data in rich and interactive ways. Once your
report is ready, you can upload it to Power BI and create dashboards based on it, which you can share with other
Power BI users.

You can download the end result of this tutorial here

Read other Power BI Desktop tutorials
Watch Power BI Desktop videos
Visit the Power BI Forum
Read the Power BI Blog

http://download.microsoft.com/download/1/4/E/14EDED28-6C58-4055-A65C-23B4DA81C4DE/FacebookAnalytics.pbix
http://go.microsoft.com/fwlink/?LinkID=521937
http://go.microsoft.com/fwlink/?LinkID=519322
http://go.microsoft.com/fwlink/?LinkID=519326
http://go.microsoft.com/fwlink/?LinkID=519327


Power BI Desktop Send a Smile Privacy Statement
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At Microsoft, we are working hard to protect your privacy, while delivering products that bring you the
performance, power, and convenience you want. This Privacy Statement explains many of the data collection and
use practices of Microsoft Power BI Desktop Feedback Send a Smile. It doesn’t apply to other online or offline
Microsoft sites, products, or services.

Except as otherwise described in this statement, Send a Smile doesn’t send personal information to Microsoft.
Information that is sent to Microsoft isn’t shared outside of Microsoft and its controlled subsidiaries and affiliates
without your permission.

Send a Smile to Power BI Desktop allows you to send an email address with your feedback. This email address is
used to contact you if Microsoft needs further information or clarification on your request. You don’t have to
register your email address with Microsoft to use Send a Smile.

Send a Smile to Power BI Desktop allows you to send feedback to Microsoft and, if you want, include screenshots
showing the specific compliment or concern you have. Although Send a Smile doesn’t intentionally collect
personally identifiable information, it is possible that such information might be captured in the feedback or
screenshots you provide. Microsoft doesn’t use this information to identify you.

Send a Smile automatically collects some information about your system configuration, standard computer
information, and basic information about how you use Microsoft products. This information is sent when you
choose to send feedback.

Send a Smile generally collects information about:

System configuration, such as the operating system version and architecture that you use (32-bit vs. 64-bit).
Standard computer information, such as the Power BI Desktop, Internet Explorer version and CLR version that
you are using.
Power BI Desktop program usage, such as File Package Info (Document Locale, Fast Combine Enabled/Disabled
state), Enabled and Disabled Preview Features, DirectQuery vs. Import mode, current Working Set and Peak
Virtual Memory used in the current session.

The personal information we collect from you is used by Microsoft and its controlled subsidiaries and affiliates to
provide the services or carry out the transactions you requested or authorized, and it might also be used to request
additional information on:

Feedback you provide about the product or service you are using
To provide critical updates and notifications regarding the software
To improve the product or service, for example, bug and survey form inquiries

Except as described in this statement, personal information you provide isn’t transferred to third parties without
your consent. We occasionally hire other companies to provide limited services on our behalf, such as:

Packaging, sending and delivering purchases, and other mailings
Answering customer questions about products or services
Processing event registration
Performing statistical analysis of our services

We only provide those companies with the personal information they need to deliver the service, and they are
prohibited from using that information for any other purpose.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-send-smile-privacy-statement.md


Security of your information

Changes to this Privacy Statement

Microsoft might access or disclose information about you, including the content of your communications, to:

Comply with the law or respond to lawful requests or legal process
Protect the rights or property of Microsoft or our customers, including the enforcement of our agreements or
policies governing your use of the services
Act on a good faith belief that such access or disclosure is necessary to protect the personal safety of Microsoft
employees, customers, or the public

Information collected by or sent to Microsoft by Send a Smile might be stored and processed in the United States
or any other country in which Microsoft or its affiliates, subsidiaries, or service providers maintain facilities.
Microsoft abides by the Safe Harbor Framework as set forth by the United States Department of Commerce
regarding the collection, use, and retention of data from the European Union.

Microsoft is committed to helping protect the security of your personal information. We use a variety of security
technologies and procedures to help protect your personal information from unauthorized access, use, or
disclosure.

Microsoft might occasionally update this Privacy Statement. The last updated date at the top of the Privacy
Statement is updated with every revision. We encourage you to periodically review this Privacy Statement to be
informed of how Microsoft is helping to protect your information.



Resolve issues importing Access and .XLS files in
Power BI Desktop
1/25/2018 • 3 min to read • Edit Online

Situation 1: No Access Database Engine InstalledSituation 1: No Access Database Engine Installed

NOTENOTE

Situation 2: The Access Database Engine bit version (32-bit or 64-bit) is different from your Power BI DesktopSituation 2: The Access Database Engine bit version (32-bit or 64-bit) is different from your Power BI Desktop
bit versionbit version

In Power BI Desktop, both Access databases and early versions of Excel workbooks (.XLS files of type Excel
2007-2003) use the Access Database Engine. There are three common situations that can prevent the Access
Database Engine from working properly:

When the Power BI Desktop error message indicates the Access Database Engine in not installed, you must install
the Access Database Engine version, either 32-bit or 64-bit, that matches your Power BI Desktop version. You can
install the Access Database Engine from this location.

If the installed Access Database Engine bit version is different from your Microsoft Office installation's bit version, Office
applications will not be able to use the Access Database Engine.

This situation often occurs when the installed version of Microsoft Office is 32-bit, and the version of Power BI
Desktop installed is 64-bit. The opposite can occur as well, and the bit-version mismatch with occur in either case (if
you're using an Office 365 subscription, see Situation 3 for a different issue and resolution). Any of the following
solutions can remedy this bit-version mismatch error:

1. Change the version of Power BI Desktop to match the bit-version of your Microsoft Office installation. To
change the bit-version of Power BI Desktop, uninstall Power BI Desktop, and then install the version of
Power BI Desktop that matches your Office installation. To select a version of Power BI Desktop, on the
download page for desktop select Advanced download options.

On the download page that appears, choose your language and then select the Download button. ON the
screen that appears, select the checkbox beside PBIDesktop.msi for the 32-bit version, or
PBIDesktop_x64.msi for the 64-bit version. In the following screen, the 64-bit version is selected.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-access-database-errors.md
http://www.microsoft.com/en-us/download/details.aspx?id=13255


Situation 3: Trouble using Access or .XLS files with an Office 365 subscriptionSituation 3: Trouble using Access or .XLS files with an Office 365 subscription

Other situations that cause import issuesOther situations that cause import issues

NOTENOTE

2. Change the version of Microsoft Office to match the bit-version of your Power BI Desktop installation. To change
the bit-version of Microsoft Office, uninstall Office, and then install the version of Office that matches your
Power BI Desktop installation.

3. If the error occurred when attempting to open an .XLS file (an Excel 2007-2003 workbook), you can avoid using
the Access Database Engine by opening the .XLS file in Excel, and saving it as an XLSX file.

c:\users\joe\downloads\AccessDatabaseEngine.exe /passive

c:\users\joe\downloads\AccessDatabaseEngine_x64.exe /passive

When using the 32-bit version of Power BI Desktop, when creating very large data models you might experience out-
of-memory issues.

4. If the previous three solutions are not feasible, it is possible to install both versions of the Access Database
Engine, but this is not a recommended workaround. Installing both versions will resolve this issue for Power
Query for Excel and Power BI Desktop, but will introduce errors and issues for any application that
automatically (by default) uses the bit-version of the Access Database Engine that was installed first. To
install both bit-versions of the Access Database Engine, download both versions, then run each of them
using the /passive switch. For example:

If you are using an Office 365 subscription, whether Office 2013 or Office 2016, the Access Database Engine
provider is registered in a virtual registry location that is only accessible to Office processes. As a result, the Mashup
Engine (which is responsible for running non-Office 365 Excel and Power BI Desktop) which is not an Office
process, cannot use the Access Database Engine provider.

To remedy this situation, you can download and install the Access Database Engine redistributable that matches the
bit version of your Power BI Desktop installation (see earlier sections for more information about bit-versions).

Download link: Access Database Engine download.

We strive to cover as many issues that occur with Access or .XLS files as possible. If you encounter an issue that
isn't covered in this article, please submit a question about the issue to Power BI Support. We regularly look at
issues that may be affecting many customers, and include them in our articles.

http://www.microsoft.com/en-us/download/details.aspx?id=13255
http://www.microsoft.com/en-us/download/details.aspx?id=13255
https://powerbi.microsoft.com/support/


Resolve Issues when Power BI Desktop will not launch
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Resolve issues with the on-premises data gateway and Power BI
Desktop

Resolution 1: Install the latest version of Power BI on-premises data gatewayResolution 1: Install the latest version of Power BI on-premises data gateway

Resolution 2: Uninstall or stop the Power BI on-premises data gateway Windows serviceResolution 2: Uninstall or stop the Power BI on-premises data gateway Windows service

Resolution 3: Run Power BI Desktop with administrator privilegeResolution 3: Run Power BI Desktop with administrator privilege

Help with other issues when launching Power BI Desktop

In Power BI Desktop, users who installed and are running previous versions of the Power BI on-premises data
gateway can be blocked from launching Power BI Desktop, due to administrative policy restrictions that the Power
BI on-premises gateway placed on named pipes on the local machine.

There are three options to resolve the issue associated with the on-premises data gateway, and enable Power BI
Desktop to launch:

The latest version of the Power BI on-premises data gateway does not place named pipe restrictions on the local
machine, and allows Power BI Desktop to launch properly. If you need to continue using Power BI on-premises data
gateway, this is the recommended resolution. You can download the latest version of Power BI on-premises data
gateway from this location. Note that the link is a direct download link to the installation executable.

If you no longer need the Power BI on-premises data gateway, you can uninstall it, or you can stop the Power BI on-
premises data gateway Windows service, which removes the policy restriction, and allows Power BI Desktop to
launch.

Alternatively, you can successfully launch Power BI Desktop as administrator, which also allows Power BI Desktop
to successfully launch. It is still recommended that you install the latest version of Power BI on-premises data
gateway, as described earlier in this article.

We strive to cover as many issues that occur with Power BI Desktop as possible. We regularly look at issues that
may be affecting many customers, and include them in our articles.

If the issue with launching Power BI Desktop is not associated with the on-premises data gateway, or when the
previous resolutions don't work, you can submit a support incident to Power BI support
(https://support.powerbi.com) to help identify and solve your issue.

For other issues you may encounter in the future with Power BI Desktop (we hope there are none, or very few), it
is helpful to turn on tracing and gather log files, to better isolate and identify the issue. To turn on tracing, select
File > Options and settings > Options and then select Diagnostics, then check Enable tracing under
Diagnostic Options. We realize that Power BI Desktop must be running to set this option, which is more helpful
for future issues associated with launching Power BI Desktop.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/desktop-error-launching-desktop.md
https://go.microsoft.com/fwlink/?LinkId=698863
https://support.powerbi.com
https://support.powerbi.com


Take Power BI anywhere in mobile apps for your
mobile device
1/5/2018 • 2 min to read • Edit Online

See what's new in the Power BI mobile apps

The Power BI mobile apps
DEVICE HIGHLIGHTS

Your iPhone goes everywhere with you, and the Power BI
mobile app for the iPhone goes everywhere your iPhone
goes. Besides viewing your Power BI reports in a special
phone layout view, you can add Power BI to your Apple
Watch, and ask questions with the Q&A virtual analyst. Get
started with the Power BI mobile app for the iPhone.

On the iPad, the Power BI mobile app displays dashboards
and reports the way they were designed for the Power BI
service. Plus you can view your Power BI Report Server and
Reporting Services KPIs and reports right on your iPad. You
can set data alerts in the Power BI mobile app to notify you
when data in a dashboard changes beyond limits you set. Get
started with the Power BI mobile app for iPads.

You view your Power BI dashboards and reports in the Power BI service (https://powerbi.com), and your on-
premises Power BI reports on Power BI Report Server. Now you can connect to your on-premises and cloud data
from the Power BI mobile apps. Try viewing and interacting with your Power BI dashboards and reports on your
mobile device — be it iOS (iPad, iPhone, iPod Touch, or Apple Watch), Android phone or tablet, or Windows 10
device.

Read the Microsoft Power BI blog for new features in the mobile apps.
See the list of what's new in the Power BI mobile apps.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/mobile-apps-for-mobile-devices.md
https://powerbi.com
https://powerbi.microsoft.com/blog/tag/mobile/


The Power BI mobile app for the Android phone brings
Power BI to your pocket, with up-to-date, touch-enabled
mobile access to your business information. You can filter a
report by your geographic location. You can even scan a QR
code with your Android phone and go straight to a Power BI
dashboard or report. Get started with the Power BI mobile
app for Android phones.

This mobile app runs on a number of different Android
tablets, bringing you up-to-date, touch-enabled mobile
access to your business information. On the Android tablet,
the Power BI mobile app displays dashboards and reports the
way they were designed for the Power BI service. You can
mark your favorite dashboards and reports, so you can get to
them quickly, along with your favorite Power BI Report Server
and Reporting Services KPIs and reports. Get started with the
Power BI mobile app for Android tablets.

The Power BI mobile app for Windows 10 runs on any
Windows 10 device, including Windows 10 phones. Along
with all the features of the other mobile apps, the Power BI
mobile app for Windows 10 offers some special functionality.
For example, you can pin a Power BI tile or dashboard to the
Windows 10 Start screen from the Power BI mobile app. Plus
you can run Power BI in presentation mode on Surface Hub
and in the Power BI mobile app for Windows 10. Get started
with the Power BI mobile app for Windows 10 devices.

DEVICE HIGHLIGHTS

Enterprise support for the Power BI mobile apps

Next steps

Organizations can use Microsoft Intune to manage devices and applications, including Power BI mobile apps for
Android and iOS.

Microsoft Intune lets organizations control items like requiring an access pin, controlling how data is handled by
the application, and even encrypting application data when the app isn't in use.

Read more about configuring Power BI mobile apps for Android and iOS with Microsoft Intune.

Power BI free vs. Pro licenses
Questions? Try asking the Power BI Community

http://community.powerbi.com/


 

 

Find your dashboards, reports, and apps in the
Power BI mobile apps
1/5/2018 • 2 min to read • Edit Online

iPhones iPads Android phones Android tablets Windows 10 devices

1 Favorites

2 Report servers

Applies to:

Your dashboards, reports, and apps are stored in different locations in the Power BI mobile apps, depending on
where they came from. This article explains what you'll find where. Plus you can always search for anything you
have in Power BI.

1. Favorites
2. Report servers (optional)
3. Apps
4. Shared with me
5. Workspaces

Collect the dashboards and apps you view most often by tagging them as favorites. Read more about favorites in
the Power BI mobile apps.

You may have connections to one or more on-premises Power BI Report Server or SQL Server Reporting Services
servers. If you do, the KPIs, Power BI reports, and paginated reports on the server show up here. If you've made
any of them favorites on the server, they also show up in your Favorites list. Read more about viewing on-

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/mobile-apps-find-content-mobile-devices.md


 

 

3 Apps

Get an app on a mobile deviceGet an app on a mobile device

4 Shared with me

premises KPIs and reports in the Power BI mobile apps.

An app is a collection of dashboards and reports purpose-built by your organization to deliver key metrics for
faster and easier data-driven decisions. In the Power BI service (https://powerbi.com), apps are easy to discover
and install. After you install them, you can view them from any device.

With apps you automatically get all the updates the author makes, and the author also controls how often the data
is scheduled to refresh. You don't need to worry about keeping up-to-date with the author’s changes.

You can get back to the app content list by tapping the breadcrumb arrow to the right of the app name.

Read more about apps in the Power BI service.

In the Power BI mobile apps, you can view all the apps you've already installed. An app owner can send you a
direct link to an app. When you click the link, the app downloads to your account and opens in the Power BI mobile
app.

In the Power BI service, you can go to Microsoft AppSource to search for other apps, but not from the Power BI
mobile apps.

https://powerbi.com


 

 

5 Workspaces

Search

Here you'll find dashboards that colleagues have shared with you. You can filter by the owner of the dashboard or
search to find what you're looking for. For shared content you visit frequently, you can favorite it right from
Shared with me by tapping the ellipsis (...).

Also called App workspaces, these are staging environments in the Power BI service (https://powerbi.com) where
you can collaborate with colleagues to create a collection of dashboards and reports. Then you distribute the
collection as an app.

In the mobile apps, you can view and interact with content in any workspace where you're a member or an admin.
You can't publish apps from workspaces in the mobile apps.

Read more about apps in the Power BI service.

You can always search for your Power BI contents, from the Favorites, Apps, Shared with me, or Workspaces
pages. The search results will show you all the dashboards, reports, and apps from every location that match your
search.

https://powerbi.com


Next steps
Get started with Power BI
Questions? Try asking the Power BI Community

http://community.powerbi.com/


What's new in the mobile apps for Power BI
1/17/2018 • 19 min to read • Edit Online

December 2017
Improved security managementImproved security management

Improved permission managementImproved permission management

Auto-installed appsAuto-installed apps

November 2017
iPhone X optimizationiPhone X optimization

October 2017
Filters for phone reports in AndroidFilters for phone reports in Android

For related "What's New" information, see:

Power BI team blog for the mobile apps
What's new in Power BI Desktop
What's new in the Power BI service

We’ve added support for conditional access (CA) and Microsoft Intune mobile device management (MDM)
on Android devices, to better secure your organization’s data. It's already available on iOS.

We’ve made some changes that allow for more precise management of user permissions for datasets,
dashboards, and reports.

You don't need to install some of the apps in Power BI at all. Power BI app creators in your organization can
create apps that contain a collection of dashboards and reports. Then they can publish the app and set it to
install automatically in the Power BI service and the Power BI mobile apps. When an app is set to install for
you, it automatically appears in your Apps menu:

We’ve optimized the app layout for iPhone X, so you can explore your data in style on every device.

If you create a report with phone-optimized pages in Power BI Desktop, and the report has filters, you can
now apply those filters in the phone report on your Android. Read more about filters for Power BI reports

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/mobile-whats-new-in-the-mobile-apps.md
https://powerbi.microsoft.com/blog/tag/mobile/


Show data in reportsShow data in reports

Previous months
September 2017September 2017
Filters for phone reports in iPhonesFilters for phone reports in iPhones

August 2017August 2017
iOS proxy settings supportiOS proxy settings support

July 2017July 2017

iOS devicesiOS devices

Responsive visualsResponsive visuals

June 2107June 2107
All devicesAll devices

May 2017May 2017
All devicesAll devices

iOS and Android devicesiOS and Android devices

April 2017April 2017

on Android.

You can now switch visuals in your reports to a table view to see the numbers behind the data. To access
this feature, tap "Show data" from the visual's ... menu on your report or the new icon on the expanded
visual's action menu.

If you create a report with phone-optimized pages in Power BI Desktop, and the report has filters, you can
now apply those filters in the phone report on your iPhone. Read more about filters for Power BI reports on
iPhones.

You can now set proxy settings in the Power BI iOS mobile app. This means that Power BI will now work
with VPN connections on your mobile device, allowing more users and organizations to securely leverage
the power of Power BI on the go.

Read the mobile apps feature summary for July 2017

New Q&A experience on iOS (Preview) Instead of just receiving an answer to your question, you can
now use natural language to get scoped insights. IEven if you're not sure what you're looking for, Q&A
proactively surfaces insights relevant to your data. The new Q&A experience on mobile, developed in
collaboration with the Microsoft Research team, showcases powerful technologies within our product. Try
the tutorial, Ask questions about your data in the iOS mobile apps.

Responsive visual for phone reports and dashboards You can set the visuals in your dashboard or
report to be responsive, to change dynamically to display the maximum amount of data and insight, no
matter the screen size. Read the blog about responsive visuals.

Make apps favorites You can already make a dashboard a favorite. Recently, Power BI added apps, and
now you can make apps favorites, too.

New menu: Shared with me Go to Shared with me in the mobile app menu to see all the content that's
been shared with you.

New menu: Apps An app is a collection of dashboards and reports built by your organization to deliver
key metrics for faster and easier data-driven decisions.

Read more about how your Power BI content is organized.

Power BI Report Server preview Create and publish Power BI reports on premises. Then view and
interact with them in your iOS or Android mobile device.

https://powerbi.microsoft.com/blog/filters-coming-for-phone-reports-on-ios/
https://powerbi.microsoft.com/blog/power-bi-service-and-mobile-july-feature-summary/#ios-preview
https://powerbi.microsoft.com/blog/power-bi-desktop-july-feature-summary-2/#responsiveVisuals


All devicesAll devices

iOS devicesiOS devices

March 2017March 2017

All devicesAll devices

iOS devicesiOS devices

Android devicesAndroid devices

February 2017February 2017
All devicesAll devices

iOS devicesiOS devices

Read the mobile apps feature summary for April 2017

Background color for phone reports When you define a background color for a report in Power BI
Desktop, the phone report will have the same background color. More about optimizing report pages for
phones.

Develop mobile-friendly custom visuals Read this Developer guide for tips on creating custom visuals
that look good and work well on mobile devices.

Talk to your data: ask questions by speaking Now you can ask questions of your data with Q&A by
talking rather than typing.

Read the mobile apps feature summary for March 2017.

Slicer interactions

We've improved touch interaction for time slicers.

Ask questions of your data with Q&A - and give us feedback Try asking questions of your data with
Q&A, and then give us a smiley or frowny face to let us know how we did.

Use 3D touch for common actions Deep-press the Power BI app icon on the home screen of your iPhone
6s or later to access notifications, search, and recently used dashboards.

Support for right-to-left languages Power BI mobile apps now support right-to-left languages. In this
context, "right-to-left languages" refers to Hebrew and Arabic writing systems, which are written from right
to left and require contextual shaping. See the list of Supported languages in the Power BI mobile apps.

Connect to more than one SSRS server

Now you can have connections to up to five SQL Server Reporting Services (SSRS) servers at the same
time.

Request access to dashboards

If you scan a QR code for a dashboard that you don't have access to, now you can submit a request for
access right from the mobile app.

Scrolling made easier

Now you can scroll in bar and column charts in a report by touching the chart itself, rather than touching
the scroll bar on the side.

Ask questions of your data with a preview of Q&A

With Q&A, you ask questions about your data in your own words, and Power BI provides the answers. Q&A
is already in the Power BI service on http://powerbi.com. Now it's also available in the mobile app on your
iPhone or iPad.

Connect to more than one SSRS server

Now you can have connections to up to five SQL Server Reporting Services (SSRS) servers at the same

https://powerbi.microsoft.com/blog/power-bi-mobile-apps-feature-summary-march-april-2017/
https://github.com/Microsoft/PowerBI-visuals/blob/master/Tutorial/MobileGuideline.md
https://powerbi.microsoft.com/blog/power-bi-mobile-apps-feature-summary-march-2017/
http://powerbi.com


Android tabletsAndroid tablets

iOS and Android devicesiOS and Android devices

January 2017January 2017

All devicesAll devices

iOSiOS

AndroidAndroid

December 2016December 2016

All devicesAll devices

iOS devicesiOS devices

time.

The Power BI mobile app for Android tablets is now available globally. Get started with the Power BI on
your Android tablet.

New menu for dashboard tiles Navigate to the underlying report, expand the tile, or manage an alert, all
directly from a menu on the tile on a dashboard.

This menu is new for iOS, Android phones in landscape mode, and Android tablets. It was already in
Windows and Android phones in portrait modes.

Read the January 2017 mobile apps blog feature summary.

Load more than 100 rows in tables and matrices Now, if you have a large table or matrix on your
dashboard or report, we show as much data as possible in the tile. Then in focus mode, you can scroll down
to load additional rows.

Phone report - general availability Power BI phone reports are now generally available. In Power BI
Desktop, you can tailor a portrait view of an existing report for mobile viewers. Learn more about authoring
phone reports in Power BI Desktop and the report experience on phones.

SSRS Authentication using Active Directory Federation Services (ADFS) Preview Now you can sign
in to on-premises SQL Server Reporting Services servers from your mobile device with your organizational
account. Read more about using OAuth to connect to SSRS servers.

SSRS Authentication using Active Directory Federation Services (ADFS) Preview Now you can sign
in to on-premises SQL Server Reporting Services servers from your mobile device with your organizational
account. Read more about using OAuth to connect to SSRS servers.

New and improved: Annotate and share insights quickly Sharing and annotating are now fully
functional on Android devices. The improved menu makes it easier and quicker to annotate and share
insights, and you can also share an annotated report or directly from the Power BI app.

Read the December 2016 mobile apps blog feature summary.

Offline background refresh

To make sure you can access your latest data while offline, we perform a refresh in the background of the
app so your business information is up to date, even if you haven’t accessed it for a while. To make sure
certain dashboards are always up to date, just mark them as favorites. Learn more about offline capabilities
in the Power BI mobile apps.

Annotate and share

Now you can annotate and share a tile, report, or visualization from the Power BI mobile app for iOS.

On the iPhone
On the iPad

Request access to dashboards

https://powerbi.microsoft.com/blog/power-bi-mobile-apps-feature-summary-january-2017
https://powerbi.microsoft.com/blog/power-bi-mobile-apps-feature-summary-december-2016


iPhoneiPhone

AndroidAndroid

November 2016November 2016

Android tabletsAndroid tablets

Android devicesAndroid devices

iOS devicesiOS devices

Windows devicesWindows devices

September/October 2016September/October 2016

All devicesAll devices

iOS on iPhonesiOS on iPhones

If you scan a QR code for a dashboard that you don't have access to, now you can submit a request for
access right from the mobile app.

Custom URL on image tile

If an image tile has a custom URL defined by the dashboard owner, when you tap the tile you go directly to
that URL without opening the tile in focus mode.

Apple watch improvements

You can now refresh Apple Watch data directly from the Watch app. In the dashboard index page, deep
press to refresh your data. (The Power BI mobile app must be running in the background on your iPhone
for this to work).

Custom URL on image tile

If an image tile has a custom URL defined by the dashboard owner, when you tap the tile you go directly to
that URL without opening the tile in focus mode. Also, dashboard tiles containing predefined custom URLs
can now redirect readers to reports within the app.

Read the November 2016 Power BI mobile apps feature summary.

Power BI mobile app for Android tablets Yes, the preview is here.

Experience Power BI on your Android tablet
Explore Reporting Services mobile reports and KPIs on your Android tablet

Preview: Intune Mobile Application Management Power BI support for Microsoft Intune Mobile
Application Manager (MAM) is now in preview for Power BI Pro users on Android devices.

Favorites Tag your favorite dashboards on your Android device, and see all your favorite Power BI
dashboards and Reporting Services mobile reports and KPIs collected in one convenient location.

Links URLs in tiles and visualizations are now clickable, and open in a browser.

Center a map to focus on data near you in your location

Read the October 2016 Power BI mobile apps feature summary.

Favorites as landing page If you’ve marked any of your dashboards as favorites, then your landing page
will be your Favorites entry.

Improved navigation The main navigation has a new look, and groups navigation has moved to the
groups catalog.

Report and dashboard performance improvements Improved the experience of loading reports and
dashboards in the Power BI mobile apps

Enhanced alert notifications Notifications for your data-driven alerts now contain more information on
what triggered the alert and why.

https://powerbi.microsoft.com/blog/power-bi-mobile-apps-feature-summary-november-2016/
https://powerbi.microsoft.com/blog/power-bi-mobile-apps-feature-summary-october-2016/


Android phonesAndroid phones

Windows 10 phonesWindows 10 phones

August 2016August 2016
All phonesAll phones

iOS on iPhones and iPadsiOS on iPhones and iPads

Windows 10 devicesWindows 10 devices

July 2016July 2016
All phonesAll phones

Android phonesAndroid phones

Apple Watch refresh improvements The Apple Watch mobile app has been improved for Watch OS3

Added manual tile refresh You can now manually refresh your dashboard tiles. For tiles based on
DirectQuery, this will retrieve the latest data from the dataset.

Geographic filtering On your Windows 10 phone you can now filter your report based on your current
location, and see only the data you need.

SandDance visualization This custom visualization is now available on the Surface Hub

Favorites View your favorite dashboards from all Power BI mobile apps, and manage the list of favorites
from the Power BI mobile apps for iOS and Windows 10 devices. Read more about favorites in the Power BI
mobile apps.

Dashboard data classification See the data classifications that dashboard owners have assigned their
dashboards. Read more about classifying dashboards.

Data-driven alerts Get notified by an alert when your data changes in pre-set ways for KPI, gauge, and
card tiles. Learn more about:

Alerts on the Power BI app for Android phones.
Alerts on the Power BI apps for iOS.
Alerts on the Power BI app for Windows 10 devices.

Tiles full-screen in focus mode on iPad When you tap a tile on your iPad, the tile will now open full-
screen in focus mode, taking advantage of the entire iPad screen size.

Manually refresh tiles Manually refresh your tiles by opening the dashboard in the Power BI mobile app
for iOS and pulling down from the top of the screen.

Support for Intune MAM Added support for Microsoft Intune mobile application management (MAM)
capabilities.

Read more about Microsoft Intune on Power BI mobile apps.

Full-screen and presentation modes Display reports in presentation mode on Surface Hub, and display
dashboards, reports, and tiles in full-screen mode on Windows 10 devices.

In the Power BI service you can now create a view of a dashboard specifically for phones in portrait mode.

Favorites tab Access all your favorite dashboards from a single location.

Improved security management Select a risk classification for the business data presented in a specific
dashboard.

Improved warning and banners We’ve improved warnings and banners for the mobile app.

QR codes for report pages A QR code generated in the service will link to a specific page rather than the
entire report.

Improved alerts Data-driven alerts are now formatted based on your device’s locale.



iOS on iPhones and iPadsiOS on iPhones and iPads

Windows 10 devicesWindows 10 devices

June 2016June 2016

QR codes now display in augmented reality (iOS)QR codes now display in augmented reality (iOS)

Filter data with barcodes (iPhone)Filter data with barcodes (iPhone)

SQL Server 2016 Reporting Services mobile reportsSQL Server 2016 Reporting Services mobile reports

Notification centerNotification center

May 2016May 2016
iOS devices and Android phonesiOS devices and Android phones

April 2016April 2016

All appsAll apps

Android mobile appAndroid mobile app

Improved security management Select a risk classification for the business data presented in a specific
dashboard.

Mobile insights View summary data (max, min, and all) on clustered column chart tiles.

Improved manual refresh You can now manually refresh your dashboard tiles. For tiles based on Direct
Query, this retrieves the latest data from the data model.

Improved warning and banners We’ve improved warnings and banners for the mobile app.

QR codes for report pages A QR code generated in the service will link to a specific page rather than the
entire report.

General improvements We’ve improved error messages for tiles in the mobile app.

Improved security management Select a risk classification for the business data presented in a specific
dashboard.

Improved warning and banners We’ve improved warnings and banners for the mobile app.

See the June Power BI mobile apps blog post for more details.

Now when you scan a QR code generated by the Power BI service, the tile renders in augmented reality.

More about connecting to data in the real world.

Now you can scan barcodes printed on products or shelves at your store to display related Power BI reports
filtered by the scanned value.

More about filtering your data with barcodes.

Now you can drill through from a Reporting Services KPI or a mobile report to another mobile report or to
any custom URL.

The notification center in your Power BI mobile app shows new data or dashboards that are shared with
you, or changes to groups you belong to.

QR codes are now available for reports, too. Scan the code with your Power BI app to go directly to a
related report, with no navigation or search needed.
Improved data management for SQL Server 2016 Reporting Services: Reduced load times and data
consumption on your device.
SQL Server 2016 themed mobile reports: See themes for mobile reports on your device.
Geofiltering: Filter reports by your current location.

See the April Power BI Mobile Apps blog for more details.

Select more than one option in a report slicer.

https://powerbi.microsoft.com/blog/power-bi-mobile-apps-update-june-2016/
https://powerbi.microsoft.com/blog/power-bi-mobile-apps-update-april-2016/


Power BI app for Windows 10 devicesPower BI app for Windows 10 devices

March 2016March 2016

iPhone mobile appiPhone mobile app

Android mobile appAndroid mobile app

Power BI app for Windows 10 devicesPower BI app for Windows 10 devices

February 2016February 2016
AndroidAndroid

Power BI app for Windows 10 devicesPower BI app for Windows 10 devices

SQL Server 2016 Reporting Services mobile reports now on Android phones.
Report gallery Open your reports directly in the report gallery.
NTLM authentication support for mobile reports in SQL Server 2016 Reporting Services.

Presentation mode Display Power BI dashboards and reports in presentation mode from the Power BI
app.
SQL Server 2016 Reporting Services mobile reports now on Windows 10 devices.
See data tooltips when you hover your mouse over a dashboard tile.

Read the Power BI Mobile Apps blog for March 2016.

Apple Watch View your Power BI tiles and KPIs on your Apple Watch.

iOS 9.0 and later To accommodate the best possible experience and new features for Power BI, we are
now supporting only devices running iOS 9.0 and later.

Global search Added a new “recently viewed” list and global search so you can find the data you need
quickly.

Report gallery Open your reports directly in the report gallery.

Fresh data offline New background refresh automatically updates your cached data when you’re online,
so you have the freshest data even when you're offline.

Bing and R tiles Open Bing and R tiles in focus mode.

SQL Server 2016 mobile reports and KPIs View SQL Server 2016 mobile reports and KPIs, and navigate
between SSRS folders.

View reports Open reports from tiles on your dashboards.

Fresh data offline New background refresh automatically updates your cached data when you’re online,
so you have the freshest data even when you're offline.

Quick access Access your dashboards, reports, and groups quickly with a new “recently viewed” list and
global search so you can find the data you need.

Bing and R tiles Open Bing and R tiles in focus mode.

More live tiles on your Start screen Pin KPIs and row cards to your Start screen as live tiles, so you can
see all of your critical metrics at a glance.

Pinch to zoom Use pinch-to-zoom on your tablet to examine dashboards in greater detail.

Notifications Get notified when your datasets, reports, and dashboards update with new data.

Report gallery Open your reports directly in the report gallery.

View dashboards in landscape mode on Android phones.

View dashboards in landscape mode in Windows 10 phones.

https://powerbi.microsoft.com/blog/power-bi-mobile-apps-update-march-2016/


January 2016January 2016

December 2015December 2015

SQL Server 2016 Reporting Services mobile reports in iOSSQL Server 2016 Reporting Services mobile reports in iOS

Power BI app for Windows 10 phonesPower BI app for Windows 10 phones

Other additionsOther additions

November 2015November 2015

All Power BI mobile appsAll Power BI mobile apps

iOS and Android mobile appsiOS and Android mobile apps

View reports on your Windows 10 phone.

Faster time to insights on your Windows 10 mobile dashboards: Share a tile snapshot or open a report
directly from the dashboard.

All of the January improvements are already in the new Power BI app for Windows 10 phones, released in
December 2015. Now they're rolling out to the other Power BI apps for mobile devices. Read the blog post
about these improvements.

Real-time data support Dashboards refresh in real time, so you don't need to refresh them manually.

Offline indicators When you don't have signal, you see an offline indicator at the top of your dashboard.

Access cached data Cached data no longer expires, so you have access to your cached data indefinitely
while offline.

R tiles and web widgets View these new tile types in dashboards on your mobile device.

Bing dashboards In the Power BI service, you can now create dashboards with Bing search results, and
view them on your mobile device.

Report pages pinned as tiles to dashboards Now that you can pin a whole report page to a dashboard
in the Power BI service, you can view report pages in the Power BI app on your iPhone or on your Android
phone.

The Power BI team ended 2015 strong, with several major additions and updates.

Now you can view your SQL Server mobile reports in the Power BI app on your iOS device, be it iPad or
iPhone. Read more:

SQL 16 SSRS on Power BI app for iOS blog post
View SQL Server mobile reports and KPIs in the iPhone and iPad apps documentation

The new Power BI app for Windows 10 phones is optimized for touch and mobile productivity. Explore
dashboards and reports, invite colleagues to view data, and share insights over email to engage your team.
Plus you can pin Power BI dashboards to your Windows phone Start screen.

Read the Power BI app for Windows 10 phones blog post.
Get started with the Power BI app for Windows 10 phones.

Read the Power BI mobile apps December blog post for more details.

Receive notifications when a colleague shares a dashboard with you. (iOS)
View entire pinned report pages in your dashboards. (iOS and Android)
Scan a QR code and go directly to a relevant tile on your Android phone.

Read the November 2015 Power BI mobile blog post.

A new welcome experience.
Improved chart data capacity.

http://blogs.msdn.com/b/powerbi/archive/2015/12/30/sql-16-ssrs-on-power-bi-app-for-ios.aspx
http://blogs.msdn.com/b/powerbi/archive/2015/12/30/announcing-the-power-bi-app-for-windows-10-mobile.aspx
http://blogs.msdn.com/b/powerbi/archive/2015/12/30/power-bi-mobile-apps-update-_2d00_-december-2015.aspx
http://blogs.msdn.com/b/powerbi/archive/2015/12/08/bridge-the-gap-between-your-physical-world-and-your-bi-using-qr-codes.aspx
http://blogs.msdn.com/b/powerbi/archive/2015/11/24/power-bi-mobile-apps-update-_2d00_-november-2015.aspx


iPhone mobile appiPhone mobile app

The Power BI app for Windows devicesThe Power BI app for Windows devices

October 2015October 2015

All Power BI mobile appsAll Power BI mobile apps

iPhoneiPhone

Enterprises can now configure Power BI mobile apps for iOS and Android with Microsoft Intune to
manage devices and applications.

Add a picture tile to a dashboard directly from your iPhone.
Create QR codes in the Power BI service, then scan them from your iPhone to open the Power BI app to
a specific tile.

Link directly from a tile to a specific URL.

Read the mid-October Power BI mobile blog post.

Line charts with a percentage-based Y-axis now calculate the visual range according to your actual data.
The graph now starts from the lowest data point in the chart, instead of from a default value.
Line, column, and bar charts can now have data labels.

Stay up to date with your groups' newest dashboards -- receive notifications on your iPhone each
time a team member adds a dashboard to one of your groups.

http://blogs.msdn.com/b/powerbi/archive/2015/10/21/power-bi-mobile-mid-october-updates-are-here.aspx


September 2015September 2015

AndroidAndroid

iOS (iPhone and iPad)iOS (iPhone and iPad)

WindowsWindows

You can now view dashboards horizontally, just by turning your phone. Read more about landscape
mode in the iPhone app.

Improvements in the Power BI mobile apps -- Android, iOS (iPhone and iPad), and Windows. Read the mid-
September Power BI mobile blog post.

Support for group workspaces: Collaborate with colleagues in group workspaces.
Support for non-authenticated users: For the few scenarios when users fail or can’t sign in to the app, we
added a fast, convenient way to contact support and send feedback.
Improved user experience when accessing dashboards using role-based security.
Improved data formatting of charts and alignment of all dashboard tiles.

New & improved navigation: New drawer navigation maximizes screen real estate and improves
navigation throughout the app.
Group workspaces: Collaborate with colleagues in group workspaces.
Authentication process upgrade Quality, performance, and functionality improvements enhance the app
authentication process, including support for SSO (Single Sign-On).
Improved data representation of line chart tiles to better compress the x-axis.
Improved user experience when using with role-based security.
Touch-optimized improvements for matrix chart tiles: Now you can easily scroll through your matrix
data and view all its data easily and intuitively.
Improved data formatting of charts and alignments of dashboard tiles.
Removal of iOS 7 support: To maintain highest security standards for Power BI, we will no longer
support iOS 7 installed devices. iOS 8 and above is required.
Send feedback and rating added in app: Added in-app capability to send feedback and provide ratings so
that we can increase the community’s influence on our roadmap and promote issues easily and directly
from the app.

Improved map tile rendering in in-focus mode to maximize screen real estate.
Improved user experience when accessing dashboards using role-based security.
A new capability allows you to browse back and forth through dashboard tiles exploring them directly in
in-focus mode without the need to return to the dashboard to select the next tile.
Additional stability and performance improvements.

http://blogs.msdn.com/b/powerbi/archive/2015/11/02/enjoy-the-landscape-with-the-power-bi-iphone-app.aspx
http://blogs.msdn.com/b/powerbi/archive/2015/09/23/power-bi-mobile-mid-september-updates-are-here.aspx


Explore your data on the Power BI mobile app for
iOS devices
11/9/2017 • 1 min to read • Edit Online

Power BI mobile app for iPhone, Apple Watch, and iPod Touch

Power BI mobile app for iPad

Get started with Power BI

The Microsoft Power BI app for iOS delivers the mobile BI experience on iPad, iPhone, Apple Watch, and iPod
Touch. The apps provide live, touch-enabled mobile access to your important business information, so you can
view and interact with your organization's Power BI dashboards and reports, and Reporting Services mobile
reports and KPIs, from anywhere. Explore the data in your dashboards, and share them with your colleagues in
email or text messages.

Go to Power BI (https://powerbi.com) to sign up for the Power BI service.

See what's new in the Power BI mobile apps.

Your iPhone goes everywhere with you, and the Power BI mobile app for the iPhone and the iPod Touch goes
everywhere your iPhone goes. Besides viewing your Power BI dashboards and reports, you can also add Power BI
to your Apple Watch, and annotate and share a tile, report, or visualization. You can even scan a QR code with your
iPhone and go straight to a Power BI dashboard or report.

Download the Power BI app for iOS on an iPhone, Apple Watch, or iPod Touch and get started.

On your iPad, the Power BI mobile app displays dashboards and reports the way they were designed for the Power
BI service. You can set data alerts in the Power BI mobile app to notify you when data in a dashboard changes
beyond limits you set. If you have SQL Server Reporting Services, you can you can view your KPIs and mobile
reports right on your iPad. Plus you can filter a report by your geographic location.

Download the Power BI app for iOS on an iPad, and get started.

Start by getting your data from sources as varied as Excel spreadsheets, SQL Server Analysis Services, Salesforce,

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/mobile-ios-ipad-iphone-apps.md
https://powerbi.com
http://go.microsoft.com/fwlink/?LinkId=522062
http://go.microsoft.com/fwlink/?LinkId=522062


Next steps

and GitHub. Then bring your data together by creating dashboards and reports in Power BI.

Now experience your data in the Power BI apps for iOS.

Questions? Try asking the Power BI Community

http://community.powerbi.com/


View on-premises report server reports and KPIs in
the Power BI mobile apps
12/19/2017 • 3 min to read • Edit Online

iPhones iPads Android phones Android tablets

First things first

Explore samples in the mobile apps without a server connection

Applies to:

The Power BI mobile apps deliver live, touch-enabled mobile access to your on-premises business information
in Power BI Report Server and SQL Server 2016 Reporting Services (SSRS).

The mobile apps are where you view Power BI content, not where you create it.

You and other report creators in your organization create Power BI reports with Power BI Desktop, then
publish them to the Power BI Report Server web portal.
You create KPIs right in the web portal, organize them in folders, and mark your favorites so you can find
them easily.
You create Reporting Services mobile reports with SQL Server 2016 Enterprise Edition Mobile Report
Publisher and publish them to the Reporting Services web portal.

Then in the Power BI mobile apps, connect to up to five report servers to view the Power BI reports and KPIs,
organized in folders or collected as favorites.

Even if you don't have access to a Reporting Services web portal, you can still explore the features of Reporting
Services mobile reports and KPIs.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/mobile-app-ssrs-kpis-mobile-on-premises-reports.md
https://docs.microsoft.com/sql/reporting-services/working-with-kpis-in-reporting-services
https://docs.microsoft.com/sql/reporting-services/mobile-reports/create-mobile-reports-with-sql-server-mobile-report-publisher
https://docs.microsoft.com/sql/reporting-services/web-portal-ssrs-native-mode


Connect to an on-premises server

1. Tap the global navigation button  in the upper-left corner, then tap the gear icon in the upper right 

.
2. Tap Reporting Services samples, then browse to interact with the sample KPIs and mobile reports.

You can view on-premises Power BI reports, Reporting Services mobile reports, and KPIs in the Power BI mobile
apps.

1. On your mobile device, open the Power BI app.
2. If you haven't signed in to Power BI yet, tap Report Server.

If you've already signed in to the Power BI app, tap the global navigation button , then tap the gear

icon  in the upper-right.

3. Tap Connect to server.



5. (Optional) Under Advanced options, you can give the server a friendly name, if you'd like.

The mobile app needs to access the server in some way. There are a few ways to do that:

Being on the same network/using VPN is the easiest way.
It's possible to use a Web Application Proxy to connect from outside the organization. See Using
OAuth to connect to Reporting Services for details.
Open a connection (port) in the firewall.

4. Fill in the server address and your user name and password. Use this format for the server address:

http://<servername>/reports

OR

https://<servername>/reports

Include http or https in front of the connection string.

6. Now you see the server in the left navigation bar--in this example, called "power bi report server."



View Power BI reports and KPIs in the Power BI app
Power BI reports, Reporting Services mobile reports, and KPIs are displayed in the same folders they're in on the
Reporting Services web portal.

Tap a Power BI report . It opens in landscape mode, and you can interact with it in the Power BI app.

In Power BI Desktop, report owners can optimize a report for the Power BI mobile apps. On your mobile

phone, optimized reports have a special icon, , and layout.

Tap a KPI to see it in focus mode.



View your favorite KPIs and reports
You can mark KPIs and reports as favorites on the web portal, and then view them in one convenient folder on
your mobile device, along with your Power BI favorite dashboards.

Tap Favorites.

Your favorite KPIs and reports from the web portal are all on this page, along with Power BI dashboards
in the Power BI service:



Remove a connection to a report server

Next steps

1. At the bottom of the left navigation bar, tap Settings.
2. Tap the server name you don't want to be connected to.
3. Tap Remove Server.

Get started with Power BI
Questions? Try asking the Power BI Community

http://community.powerbi.com/


 

View dashboards and reports in the Power BI mobile
apps
1/17/2018 • 7 min to read • Edit Online

iPhones iPads Android phones Android tablets Windows 10 devices

Create dashboards in the Power BI service (https://powerbi.com)

View dashboards on your iPhone

Applies to:

Dashboards are a portal to your company's life cycle and processes. A dashboard is an overview, a single place to
monitor the current state of the business.

You don't create dashboards in the mobile apps.

To see dashboards and reports on your mobile device, you need to create or connect to them in a Web browser.

1. Go to the Power BI service (https://www.powerbi.com) and sign up for an account.
2. Create your own Power BI dashboards and report, or connect to existing Power BI apps for a variety of services,

such as Microsoft Dynamics CRM and Adobe Analyics.

Here's a Power BI dashboard in the Power BI service:

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/mobile-apps-view-dashboard.md
https://powerbi.com
https://www.powerbi.com


TIPTIP

1. Open the Power BI app on your iPhone and sign in.

Need to download the iPhone app from the Apple App Store?

2. Tap a dashboard to open it.

The yellow stars  show which dashboards are favorites.

The notation below each dashboard name (in this case, "MBI")  shows how the data in each
dashboard is classified. Read more about data classification in Power BI.

By default, Power BI dashboards look a little different on your iPhone. All the tiles appear the same size, and
they're arranged one after another from top to bottom.

If you're the dashboard owner, in the Power BI service you can create a view of the dashboard specifically for phones
in portrait mode.

Or just turn your phone sideways to view the dashboard in landscape mode on your phone.

http://go.microsoft.com/fwlink/?LinkId=522062


 

View dashboards in landscape mode in your iPhoneView dashboards in landscape mode in your iPhone

View dashboards on your iPad

3. Swipe up and down to see all the tiles in the dashboard. You can:

Tap a tile to open it in focus mode and interact with it.

Tap the star  to make it a favorite.

Tap Invite  to invite a colleague to view your dashboard.
Sync the dashboard with your Apple Watch.

4. To get back to the list of dashboards, tap the arrow next to the dashboard title, then tap My Workspace.

Just turn your phone sideways to view dashboards in landscape mode. The dashboard layout changes from a
series of tiles to a view of the whole dashboard—you see all of the dashboard’s tiles just as they are in the Power
BI service.

You can use the “pinch” gesture to zoom in and out on different areas of your dashboard, pan to navigate it. And
you can still tap a tile to open the tile in focus mode and interact with your data.

1. Open the Power BI app.

Need to download the iPad app from the Apple App Store first?

http://go.microsoft.com/fwlink/?LinkId=522062


   View dashboards on your Android phone

2. Tap Dashboards at the top of the app.

The yellow stars  show which dashboards are favorites.

The notation below each dashboard name (in this case, "MBI")  shows how the data in each
dashboard is classified. Read more about data classification in Power BI.

3. You can share a dashboard from your workspace. Tap the ellipsis (...) in the lower-right corner of the
dashboard tile, and tap Invite Others.

4. You can also tap a dashboard to open it and see the tiles in that dashboard. While on the dashboard you
can interact with it:

Tap a tile to interact with the tile.
Open the reports behind the tiles.
Invite others to view the dashboard.
Annotate and share a snapshot of a tile.

5. To go back to My Workspace, tap the name of the dashboard in the upper-left corner, then tap My
Workspace.



Power BI dashboards look a little different on your Android phone. All the tiles appear the same width, and 
they're arranged one after another from top to bottom.

![Dashboard portrait view](media/mobile-apps-view-dashboard/pbi_andr_dash.png)

 Or just turn your phone sideways to view them in landscape mode on your phone.

> [AZURE.TIP] If you're the dashboard owner, in the Power BI service you can [create a view of the dashboard 
specifically for phones](service-create-dashboard-mobile-phone-view.md) in portrait mode. 

View dashboards in landscape mode on your Android phoneView dashboards in landscape mode on your Android phone

1. Open the Power BI app on your Android phone and sign in.

Need to download the Android app first?

2. Tap a dashboard to open it.

Yellow stars  show which dashboards are favorites.

A notation below a dashboard name (in this case, "MBI")  shows how the data in each
dashboard is classified. Read more about data classification in Power BI.

2. Swipe up and down to see all the tiles in the dashboard.
3. To go back to the dashboards home page, tap the dashboard name to open the breadcrumb trail, then tap My

Workspace.

1. While on the dashboard, you can tap the vertical ellipsis (...) next to the name to invite a colleague, refresh,
or get information about the dashboard:

You can also view dashboards in landscape mode, just by turning your phone. The dashboard layout changes

http://go.microsoft.com/fwlink/?LinkID=544867


 View dashboards on your Android tablet

from a series of tiles to a view of the whole dashboard — you see all of the dashboard’s tiles laid out as they are in
the Power BI service.

You can use the “pinch” gesture to zoom in and out on different areas of your dashboard, pan to navigate it. And
you can still tap a tile to open the tile in focus mode and interact with your data.

1. Open the Power BI app on your Android tablet and sign in.

Need to download the Android app first?

2. Tap a dashboard to open it.

The yellow stars  show which dashboards are favorites.

The notation below each dashboard name (in this case, "MBI")  shows how the data in each
dashboard is classified. Read more about data classification in Power BI.

3. While on the dashboard, you can tap the vertical ellipsis (...) next to the name to invite a colleague, refresh,
or get information about the dashboard:

http://go.microsoft.com/fwlink/?LinkID=544867


   View dashboards on your Windows 10 device

4. Swipe up and down to see all the tiles in the dashboard.

You can use the “pinch” gesture to zoom in and out on different areas of your dashboard, pan to navigate
it. And you can still tap a tile to open the tile in focus mode and interact with your data.

5. To go back to the dashboards home page, tap the dashboard name to open the breadcrumb trail, then tap
My Workspace:

You can use the “pinch” gesture to zoom in and out on different areas of your dashboard, pan to navigate
it. And you can still tap a tile to open the tile in focus mode and interact with your data.

1. Open the Power BI app on your Windows 10 device and sign in.

Need to download the app first?

2. Tap a dashboard to open it.

http://go.microsoft.com/fwlink/?LinkID=526478


TIPTIP

The black stars show which dashboards are favorites.
The notation below each dashboard name (in this example, MBI) shows how the data in each dashboard
is classified. Read more about data classification in Power BI.

Power BI dashboards look a little different on your Windows 10 phone. All the tiles appear the same width,
and they're arranged one after another from top to bottom.

You can also turn your phone sideways to view dashboards in landscape mode on your phone.

If you're the dashboard owner, in the Power BI service you can create a view of the dashboard specifically for phones
in portrait mode.

3. In the dashboard, you can:

Tap a tile to open and interact with it.

Tap the Full Screen icon  to present your Power BI dashboard without borders or menus, like Slide
Show view in PowerPoint.

Tap the Invite icon  to share your dashboard with a colleague.



View dashboards in landscape mode on your Windows 10 phoneView dashboards in landscape mode on your Windows 10 phone

Create a phone view of a dashboard in the Power BI service

Tap the star  to make the dashboard a favorite.
Tap the Pin to Start icon to pin the dashboard to your Windows Start screen.

4. To go back to the dashboards home page, tap the dashboard name to open the breadcrumb trail, then tap
My Workspace:

You can also view dashboards in landscape mode, just by turning your phone. The dashboard layout changes
from a series of tiles to a view of the whole dashboard — you see all of the dashboard’s tiles laid out as they are in
the Power BI service.

You can use the “pinch” gesture to zoom in and out on different areas of your dashboard, pan to navigate it. And
you can still tap a tile to open the tile in focus mode and interact with your data.

If you're the dashboard owner, in the Power BI service you can create a view of the dashboard specifically for
phones in portrait mode.



Next steps

Read more about creating a phone view of a dashboard.

Download the Android app from Google play
Get started with the Android app for Power BI
Get started with Power BI
Questions? Try asking the Power BI Community

http://go.microsoft.com/fwlink/?LinkID=544867
http://community.powerbi.com/


 

Explore reports in the Power BI mobile apps
1/26/2018 • 3 min to read • Edit Online

iPhones iPads Android phones Android tablets Windows 10 devices

Open a Power BI report in the mobile app

View reports optimized for phones

Applies to:

A Power BI report is an interactive view of your data, with visuals representing different findings and insights
from that data. Viewing reports in the Power BI mobile apps is the third step in a three-step process.

1. Create reports in Power BI Desktop. You can even optimize a report for phones in Power BI Desktop.
2. Publish those reports to the Power BI service (https://powerbi.com) or Power BI Report Server.
3. Then interact with those reports in the Power BI mobile apps.

Power BI reports are stored in different places in the mobile app, depending on where you got them. They can be
in Apps, Shared with me, Workspaces (including My Workspace), or on a report server. Sometimes you go
through a related dashboard to get to a report, and sometimes they're listed.

In a dashboard, tap the ellipsis (...) in the upper-right corner of a tile > Open report.

Not all tiles have the option to open in a report. For example, tiles created by asking a question in the Q&A
box don't open reports when you tap them.

On a phone, the report opens in landscape mode, unless it's optimized for viewing on a phone.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/mobile-reports-in-the-mobile-apps.md
https://powerbi.com


Use slicers to filter a report page

Power BI report authors can create a report layout specifically optimized for phones. Report pages optimized for
phones have added functionality: for example, you can drill down and sort in visuals in focus mode, and you can
access the filters the report author added to the report page. In a list of reports, an optimized report has a special

icon :

When you view that report on a phone, it opens in portrait view.

A report may have a mix of pages that are and aren't optimized for phones. If so, when you flip through the
report the view will switch from portrait to landscape for each page.

Read more about reports optimized for phone view.

When designing a report in Power BI Desktop or the Power BI service, consider adding slicers to a report page.
You and your colleagues can use the slicers to filter the page in a browser and in the mobile apps. When you view
the report on a phone, you can see and interact with the slicers in landscape mode and in a page optimized for
the phone's portrait mode.



Cross-filter and highlight a Power BI report page

Sort a visual on an iPad or a tablet

When you select a value in a slicer on the report page, it filters the other visuals on the page.

In this illustration, the slicer is filtering the column chart to show only July values.

When you select a value in a visual, it doesn't filter the other visuals. It highlights the related values in the other
visuals.

Tap a value in a visual.

Tapping the Large column in one visual highlights related values in the other visuals.

Tap the chart, tap the ellipsis (...) and tap the field name.



Drill down and up in a visual on an iPad or a tablet

NOTENOTE

To reverse the sort order, tap the ellipsis (...) again, then tap the same field name again.

If a report author has added this capability to a visual, on an iPad or a tablet you can drill down in a visual to see
the values that make up one part of it. You add drill down to a visual in Power BI Desktop or the Power BI service.

Currently, drill-down doesn't work on maps in the iPad or tablet.

Tap a visual. If it has up and down arrows in the upper corners , then you can drill down. To
drill down on one value, tap the arrow in the upper-right corner, then tap a value in the visual — in this
case, the dark-blue FD-04 bubble.

To drill back up, tap the up arrow in the upper-left corner.



Go back to My Workspace

Next steps

Tap the arrow next to the report name > tap My Workspace.

View and interact with Power BI reports optimized for your phone
Create a version of a report optimized for phones
Questions? Try asking the Power BI Community

http://community.powerbi.com/


Explore tiles in the Power BI mobile apps
11/9/2017 • 4 min to read • Edit Online

iPhones iPads Android phones Android tablets Windows 10 devices

Tiles in the iOS apps

NOTENOTE

Applies to:

Tiles are live snapshots of your data, pinned to a dashboard. Their values change as the data changes. You add
tiles to a dashboard in the Power BI service.

Then in the Power BI mobile apps, you open tiles in focus mode and interact with them. You can open tiles with
all kinds of visuals, including tiles based on Bing and R.

You can create picture tiles with your iPhone app and save them to your dashboards.

1. Open a dashboard in the mobile app for iOS.
2. Tap a tile. It opens in focus mode, where it's easier to view and explore the tile data. In focus mode you

can:

In a line, bar, or column chart, tap to view the values for specific parts of the visualization.

For example, in this line chart, the selected values are for **This Year Sales* and Last Year Sales in
August.*

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/mobile-tiles-in-the-mobile-apps.md


4. Tap the share icon  to annotate and share a tile with others.
5. Add an alert to the tile. If the values go above or below targets, Power BI will notify you.

In a pie chart, tap a slice of the pie to show the value of the slice at the top of the pie.

3. In a map, tap the Center Map icon  to center the map to your current location.

6. Sometimes the dashboard creator has added a link to a tile. If so, it has a link icon  when it's in
focus mode:



Tiles in the mobile app for Android phones and tablets

7. Open the report  that the tile is based on.

Links can go to other Power BI dashboards or to an external URL. You can tap the link to open it inside
the Power BI app. If it's an external site, Power BI asks you to allow it.

After you open the link in the Power BI app, you can copy the link and open it in a browser window
instead.

8. To leave tile focus mode, tap the tile name, then tap the dashboard name or My Workspace.

1. Open a dashboard in the Power BI mobile app.
2. Tap a tile to open it in focus mode, where it's easier to view and explore the tile data.



Tiles in the Windows 10 mobile app

4. Tap the arrow in the upper-left corner to close the tile and return to the dashboard.

In focus mode, you can:

Tap the chart to move the bar in a line, bar, column, or bubble chart, to view the values for a specific
point in the visualization.

Tap the Share snapshot icon  to annotate and share the tile with others.

Tap the Open report icon  to view the report in the mobile app.
3. Sometimes the dashboard creator has added a link to a tile. If so, when you tap the vertical ellipsis (...)

you see Open link :

Links can go to other Power BI dashboards or to an external URL. You can tap the link to open it inside
the Power BI app. If it's an external site, Power BI asks you to allow it.

After you open the link in the Power BI app, you can copy the link and open it in a browser window
instead.

1. Open a dashboard in the Power BI mobile app for Windows 10.



2. Tap the vertical ellipsis on the tile. From here, you can:

Share a snapshot of the tile.

Tap Open Report  to view the underlying report.

Open the link, if it has a link. Links can go to Power BI dashboards or to an external URL.

3. Tap Expand Tile . It opens in focus mode, where it's easier to view and explore the tile data. In this
mode you can:

Spin a pie chart to show the values of the slice at the top of the pie.

Tap the chart to move the bar in a line, bar, column, or bubble chart, to view the values for a specific point
in the visualization.

https://docs.microsoft.com/en-us/power-bi/mobile-share-tile-windows-10-phone-app


NOTENOTE

4. Tap the back arrow or the back button to close the tile and return to the dashboard.

In this bar chart, the values for the **Decor* bar are shown at the top of the chart.*

Tap the Full screen icon  to open the tile in full-screen mode, without the navigation and menu
bars.

You can also view dashboards and reports in full-screen mode in the Power BI mobile app for Windows 10.

In a map, tap the Center Map icon  to center the map to your current location.

Tap the Share Snapshot icon  to share a tile with others.

Tap the Open Report icon  to view the report that the tile is based on.

https://docs.microsoft.com/en-us/power-bi/mobile-share-tile-windows-10-phone-app


Next steps
Get started with Power BI
Questions? Try asking the Power BI Community

http://community.powerbi.com/


Share a dashboard from the Power BI mobile apps
1/30/2018 • 5 min to read • Edit Online

iPhones iPads Android phones Android tablets Windows 10 devices

Share a dashboard from your iPhone

Applies to:

With a Power BI Pro license, you can invite colleagues to view your dashboards by sharing links from the Power
BI mobile apps. The people you share dashboards with need to be the same email domain as you and have a
Power BI Pro license, too, or the content needs to be in a Premium capacity.

From the Power BI mobile apps for iOS and Android, you can also annotate and share a snapshot of a tile, report,
or visual with anyone.

2. Tap Invite a colleague.
3. Type names, separated by commas, and a message to accompany your dashboard invitation.

1. In the actions bar at the bottom of the dashboard, tap the share icon .

4. To allow resharing, leave Allow recipients to share this dashboard selected.

Resharing allows your colleagues to forward the email invitation to others in your organization, either
through the web or the mobile apps.

5. Tap Send in the upper-right corner.

Your colleagues get an email invitation with a direct link to the dashboard. The invitation expires after one
month. When they open it, in a browser or in the Power BI mobile app, it's added to the Shared with me
section of their Power BI account.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/mobile-share-dashboard-from-the-mobile-apps.md


Unshare a dashboard from your iPhoneUnshare a dashboard from your iPhone

Share a dashboard from your iPad

Read more notes about sharing dashboards with colleagues.

You can only unshare a dashboard if you're the dashboard owner.

1. In the actions bar at the bottom of the dashboard, tap the share icon .

4. To unshare, tap the red circle next to a name and tap Delete.

2. Tap Invite a colleague.

You see the list of colleagues with whom you've shared this dashboard, with these phrases:

Can View: They can view the dashboard but not share it.
Can View & Invite: They can view the dashboard and share it with other colleagues.

3. Tap Edit.

1. Tap the Share icon  icon in the upper-right corner of your dashboard.
2. Tap Invite a colleague, then type email addresses and a message to accompany your dashboard invitation.

NOTENOTE

3. To allow resharing, leave Allow recipients to share this dashboard selected.

Resharing allows your coworkers to forward the email invitation to others in your organization, either through the
web or the mobile apps.

4. Tap Send in the upper-right corner.

Your colleagues get an email invitation with a direct link to the dashboard. The invitation expires after one
month. When they open it, in a browser or in the Power BI mobile app, it's added to the Shared with me
section of their Power BI account



Unshare a dashboard from your iPadUnshare a dashboard from your iPad

Share a dashboard from your Android device

Read more notes about sharing dashboards with colleagues.

You can only unshare a dashboard if you're the dashboard owner.

2. Tap Edit.
3. To unshare, tap the red circle next to a name and tap Delete.

1. Tap the Share icon  in the upper-right corner of your dashboard.

You see the list of colleagues with whom you've shared this dashboard. Below their names are these
words:

Pending: They haven't viewed the dashboard yet.
Can View: They can view the dashboard but not share it.
Can View & Invite: They can view the dashboard and share it with other colleagues.

NOTENOTE

1. On the dashboards home page, tap the ellipsis (...) and tap Invite a colleague.

2. Or, in the upper-right corner of a dashboard, tap the invite icon .

If you're the owner of the dashboard, you see the list of colleagues with whom you've shared this
dashboard, with these notes:

Can view: They have viewed the dashboard but can't share it.

Can view & invite: They have viewed the dashboard and can share it with other colleagues.

3. Type email addresses, and a message to accompany your dashboard invitation. Otherwise Power BI sends
a default message.

4. To allow resharing, leave Allow recipients to share this dashboard selected.

Resharing allows your coworkers to forward the email invitation to others in your organization, either through the
browser or the mobile apps.

5. Tap the Send icon  in the upper-right corner to send the mail.



Unshare a dashboard from your Android deviceUnshare a dashboard from your Android device

Share a dashboard from your Windows 10 device

Your colleagues get an email invitation with a direct link to the dashboard. The invitation expires after one
month. When they open it, in a browser or in the Power BI mobile app, it's added to the Shared with me
section of their Power BI account

Read more notes about sharing dashboards with colleagues.

Only the dashboard owner can unshare a dashboard.

2. To stop sharing the dashboard with a colleague, tap the X next to a name > Remove.

1. In the upper-right corner of your dashboard, tap the invite icon .

You see the list of colleagues with whom you've shared this dashboard.

1. In a dashboard, tap the Invite icon .

Or on the dashboards home page, right-click or press and hold, and tap Invite.

If you're the owner of the dashboard, you see the list of colleagues with whom you've shared this
dashboard, with these notes:

Read only: They have viewed the dashboard but can't share it.

Read and reshare: They have viewed the dashboard and can share it with other colleagues.

2. Type email addresses, and a message to accompany your dashboard invitation. Otherwise Power BI sends
a default message.



Next steps

NOTENOTE

3. To allow resharing, leave Allow recipients to share this dashboard selected.

Resharing allows your coworkers to share this dashboard with others in your organization, either through the
browser or the mobile apps.

4. Tap the Send icon .

Your colleagues get an email invitation with a direct link to the dashboard. The invitation expires after one
month. When they open it, in a browser or in the Power BI mobile app, it's added to the Shared with me
section of their Power BI account

Read more notes about sharing dashboards with colleagues.

Annotate & share a snapshot of a tile, report, or visual in the mobile apps
Share a dashboard in Power BI
Questions? Try asking the Power BI Community

http://community.powerbi.com/


Make favorite dashboards, apps, and on-premises
reports in the Power BI mobile apps
11/9/2017 • 2 min to read • Edit Online
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View your favorite Power BI dashboards and apps, and on-premises
reports and KPIs

Applies to:

On the Favorites page in the mobile apps, you see your favorite Power BI dashboards and apps, together with
favorite on-premises Power BI Report Server and Reporting Services KPIs and mobile reports. When you make a
dashboard or an app a favorite in the Power BI mobile apps, you see it on your Favorites page the Power BI
service (https://powerbi.com) and all of your mobile devices.

You can also make Power BI dashboards and apps favorites in the Power BI service. Then you see them on the
Favorites page in the mobile app.

You can mark KPIs and reports as favorites on a Power BI Report Server or Reporting Services web portal, and
then view them in one convenient folder on your mobile device, along with your Power BI favorite dashboards.

Tap the top navigation menu , then tap Favorites.

You see all your favorites together on this page:

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/mobile-apps-favorites.md
https://powerbi.com


Make an app a favorite
1. In the list of apps in the mobile app, tap the ellipsis (...) next to the app > Favorite.

Now it's listed with your other favorite dashboards and apps.



Make a dashboard a favorite in the iOS and Windows 10 mobile apps
You can make a Power BI dashboard or an app a favorite from the list of dashboards or from the dashboard
itself.

In the list of dashboards in the mobile app, tap the empty star next to the dashboard name . The star

turns yellow .

On the dashboard, tap the empty star in the ribbon at the top . The star turns yellow .



Make a dashboard a favorite in the Android mobile apps
You can make a dashboard a favorite from the list of dashboards or from the dashboard itself.

In the list of dashboards in the mobile app, tap the vertical ellipsis (...) next to the dashboard name, then

tap Favorite. You see a yellow star next to the name .

On the dashboard, tap the empty star in the ribbon at the top . The star turns dark gray .



Make favorite Power BI Report Server and Reporting Services reports
and KPIs

Next steps

You can view your favorite Power BI Report Server and Reporting Services reports and KPIs in the Power BI
mobile apps, but you can't make them favorites in the mobile apps. You tag them as favorites in the web portal.

Favorite dashboards in the Power BI service
Questions? Try asking the Power BI Community

http://community.powerbi.com/


Get data from the real world with the Power BI
mobile apps
11/9/2017 • 1 min to read • Edit Online

QR codes for tiles

QR codes for reports

Barcodes

Power BI mobile apps can connect the real world directly to related BI information, in a number of different ways.

Create a QR code for a tile in a dashboard, and put the QR code anywhere you want. When your colleagues scan
the code with their iPhones or Android phones, they see the tile you've associated with that QR code — on an
iPhone, they see the tile in augmented reality.

More about:

Creating a QR code for a tile in Power BI
Scanning a Power BI QR code from your mobile device

Create a QR code for a report. When your colleagues scan the code with their iPhones (Android phones are
coming soon), they see the report you've associated with that QR code.

More about creating a QR code for a report in Power BI

Tag barcode data in your report so your colleagues can scan a barcode on a product and go straight to that report,
filtered for that product.

More about:

Tagging barcode data in a report
Scanning a barcode from the Power BI app on your iPhone

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/mobile-apps-data-in-real-world-context.md


Filter by location

Next steps

Categorize geographical data in a report in Power BI Desktop. Then your colleagues view that report in the Power
BI mobile app for iOS, Power BI automatically provides geographical filters that match where they are.

More about filtering by location.

Create a QR code for a tile in Power BI
Create a QR code for a report in Power BI



Scan a Power BI QR code from your mobile device
11/9/2017 • 2 min to read • Edit Online

iPhones Android phones Android tablets

NOTENOTE

Scan a Power BI QR code on your iPhone with the Power BI scanner

Applies to:

QR codes in Power BI can connect any item in the real world directly to related BI information — no navigation
or search needed.

Say a colleague has created a QR code in the Power BI service for a report or for a tile in a dashboard, shared the
dashboard or report with you, and placed the QR code in a key location — for example, in an email or on a
specific item.

You can scan the QR code for immediate access to the relevant tile or report, right from your phone, using either
the scanner in the Power BI app, or any other scanner installed on your phone.

If your colleague hasn't shared the dashboard or report with you, you can request access directly from the mobile app.

1. In the Power BI mobile app open the global navigation menu  in the upper left.

3. If your camera is not enabled, you need to approve the Power BI app to use the camera. This is a one-time
approval.

2. Scroll down to Scanner and select it.

4. Point the scanner at the Power BI QR code.

5. The tile or report appears to hover over the background in augmented reality.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/mobile-apps-qr-code.md


Scan a QR code from an external scanner on your iPhoneScan a QR code from an external scanner on your iPhone

Scan a Power BI QR code on your Android device with the Power BI
scanner

6. Tap the report or the tile to open it in focus mode, or go back to the scanner.

1. From any scanner installed on your phone, point the scanner to the relevant Power BI QR code for immediate
access to the tile or report.

2. If you don’t have the Power BI app installed, you are redirected to the Apple App Store to download it on your
iPhone.

1. In the Power BI mobile app open the global navigation button  in the upper left.

3. If your camera isn't enabled, you need to approve the Power BI app to use the camera. This is a one-time
approval.

2. Scroll down to QR Scanner and select it.

4. Point the scanner at the Power BI QR code.

5. The tile or report opens automatically in Power BI.

http://go.microsoft.com/fwlink/?LinkId=522062


Scan a QR code from an external scanner on your Android deviceScan a QR code from an external scanner on your Android device

Next steps

1. From any scanner installed on your Android device, point the scanner to the relevant Power BI QR code for
immediate access to the tile or report.

2. If you don’t have the Power BI app installed, you are redirected to Google Play to download it.

Connect to Power BI data from the real world with the mobile apps
Create a QR code for a tile in the Power BI service
Create a QR code for a report in the Power BI service
Questions? Try asking the Power BI Community

http://go.microsoft.com/fwlink/?LinkID=544867
http://community.powerbi.com/


Get notifications in the Power BI mobile apps
1/17/2018 • 1 min to read • Edit Online

iPhones iPads Android phones Android tablets Windows 10 devices

NOTENOTE

View notifications on your mobile device

Applies to:

Notifications bring information related to your Power BI experience right to you, in the Power BI service or on your
mobile device. When you open Notifications, you see a sequential feed of messages about alerts you've set, new
dashboards that have been shared with you, changes to your group workspace, information about Power BI events
and meetings, and more.

On an iOS device, the first time you sign in to the updated version of the Power BI apps, you see a message asking if you'd
like Power BI to send notifications. You can also configure how Power BI notifies you in Settings for your device.

1. When you receive notifications on your mobile device, by default Power BI makes a sound and shows a
notification banner.

Or on an iPad:

You can change how Power BI notifies you.

2. If you've received notifications, when you sign in to Power BI on your mobile device you see a yellow dot on
global navigation button  (Android) or on the Notifications icon.

3. Select the Notifications icon  (Windows 10).

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/mobile-apps-notification-center.md
https://powerbi.microsoft.com/mobile/


 Change or turn off notifications on your mobile device

4. To dismiss a notification, tap and hold it and select Dismiss.

Notifications are displayed with the most recent on top and unread messages highlighted. Notifications are
retained for 90 days unless you delete them or reach the maximum limit of 100.

You can change how Power BI notifies you.

2. In the list of apps, select Power BI.

1. On an iOS device, go to Settings > Notifications.

On an Android phone, go to Notification Settings.

On a Windows device, in Settings go to System > Notifications & actions.

3. Here you can turn notifications off completely or choose which notifications you want.

On an iPhone

On an Android phone



Next steps

On a Windows 10 device

Data alerts in Power BI service
Set data alerts in the iPhone app (Power BI for iOS)
Set data alerts in the Power BI mobile app for Windows 10
Download the latest version of the Power BI apps for mobile devices

https://powerbi.microsoft.com/mobile/


Annotate and share a tile, report, or visual in Power
BI mobile apps
11/9/2017 • 2 min to read • Edit Online

iPhones iPads Android phones Android tablets

Applies to:

You can annotate and share a snapshot of a tile, report, or visual from the Power BI mobile app for iOS and
Android devices. Your recipients see it exactly as it was when you sent the mail, plus a link. You can send
snapshots of tiles to anyone — not just colleagues in the same email domain. You can add annotations — lines,
text, or stamps — before you share it.

A report with annotations

The mail with the snapshot of the tile, report, or visual also includes a link to the actual object on the Power BI
service (https://powerbi.com). You recipients can click the link and go straight to that tile, report, or visual, if you
and they have Power BI Pro licenses, or the content is in a Premium capacity, and you've already shared the item
with them.

You can share a tile from the Power BI mobile app for Windows 10 devices, too, but not annotate it.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/mobile-annotate-and-share-a-tile-from-the-mobile-apps.md
https://powerbi.com
https://docs.microsoft.com/en-us/power-bi/mobile-share-tile-windows-10-phone-app


   

Open a tile for annotating

Open a report for annotating

Open a visual for annotating

Annotate and share the tile, report, or visual

1. Tap the tile to open it in focus mode.

2. Tap the annotate icon  in the upper-right corner of the tile.
3. You're ready to annotate and share the tile.

1. Open a report.

2. Tap the annotate icon  in the upper-right corner of the report.
3. You're ready to annotate and share the report.

2. Tap the annotate icon  in the upper-right corner of the visual.
3. You're ready to annotate and share the visual.

1. In a report, tap a visual, then tap the expand icon to open it in focus mode.

2. After annotating, tap Share in the upper-right corner.

1. Here's how you annotate:

The annotation bar in iPhones and iPads

The annotation bar in Android devices

To draw lines of different colors and thicknesses, tap the squiggly-line icon, choose a width and color,
and draw.
To type comments, tap the AA, choose the text size and color, and type.
To paste stamps (like emoticons) on the tile, tap the smiley face, choose a color, and tap where you
want them.

3. Open your mail app, type the recipients' names, and modify the message, if you want.



Next steps

4. Tap Send.

The mail has an image, and a link to the specific tile, report, or visual.

Share a dashboard from the Power BI mobile apps
Questions? Try asking the Power BI Community

http://community.powerbi.com/


Set data alerts in the Power BI mobile apps
12/19/2017 • 5 min to read • Edit Online

iPhones iPads Android phones Android tablets Windows 10 devices

WARNINGWARNING

Data alerts on an iPhone or iPad
Set an alert on an iPhone or iPadSet an alert on an iPhone or iPad

Applies to:

You can set alerts on dashboards in the Power BI mobile apps and in the Power BI service. Alerts notify you
when data in a tile changes beyond limits you set. Alerts work for tiles featuring a single number, such as cards
and gauges, but not with streaming data. You can set data alerts on your mobile device and see them in the
Power BI service, and vice versa. Only you can see the data alerts you set, even if you share a dashboard or a
snapshot of a tile.

You can set alerts on tiles if you have a Power BI Pro license, or if you have a free Power BI license and the
shared dashboard is in a Premium capacity.

Data-driven alert notifications provide information about your data. If your device gets stolen, we recommend going to
the Power BI service to turn off all data-driven alert rules.

Learn more about managing data alerts in the Power BI service.

2. Tap the bell icon  to add an alert.

1. Tap a number or gauge tile in a dashboard to open it in focus mode.

3. Tap Add alert rule.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/mobile-set-data-alerts-in-the-mobile-apps.md


Manage alerts on your iPhone or iPadManage alerts on your iPhone or iPad

NOTENOTE

6. You can change the alert title, too.
7. Tap Save.

4. Choose to receive alerts above or below a value, then set the value.

5. Decide whether to receive hourly or daily alerts, and whether to also receive an email when you get the
alert.

You don't receive alerts every hour or every day unless the data has actually refreshed in that time.

8. A single tile can have alerts for values both above and below thresholds. In Manage alerts, tap Add
alert rule.

You can manage individual alerts on your mobile device or manage all your alerts in the Power BI service.



Data alerts on an Android device
Set an alert on an Android deviceSet an alert on an Android device

2. Tap the bell icon .

1. In a dashboard, tap a number or gauge tile that has an alert.

3. Tap the name of the alert to edit it, tap the slider to turn off email alerts, or tap the garbage can to delete
the alert.

1. In a Power BI dashboard, tap a number or gauge tile to open it.

2. Tap the bell icon  to add an alert.

3. Tap the plus icon (+).



Manage alerts on an Android deviceManage alerts on an Android device

5. Tap Done.

NOTENOTE

7. You can change the alert title, too.
8. Tap Save.

4. Choose to receive alerts above or below a value, and type the value.

6. Decide whether to receive hourly or daily alerts, and whether to also receive an email when you get the
alert.

You don't receive alerts every hour or every day unless the data has actually refreshed in that time.

You can manage individual alerts in the Power BI mobile app or manage all your alerts in the Power BI service.

1. In a dashboard, tap a card or gauge tile that has an alert.

2. Tap the solid bell icon .
3. Tap the alert to change a value or turn it off.



Data alerts on a Windows device
Set data alerts on a Windows deviceSet data alerts on a Windows device

4. Tap the plus icon (+) to add another alert to the same tile.

5. To delete the alert altogether, tap the garbage can icon .

1. Tap a number or gauge tile in a dashboard to open it.

2. Tap the bell icon  to add an alert.

3. Tap the plus icon (+).



NOTENOTE

6. You can change the alert title, too.
7. Tap the check mark.

4. Choose to receive alerts above or below a value, and type the value.

5. Decide whether to receive hourly or daily alerts, and whether to also receive an email when you get the
alert.

You don't receive alerts every hour or every day unless the data has actually refreshed in that time.

8. A single tile can have alerts for values both above and below thresholds. In Manage alerts, tap the plus
sign (+).



Manage alerts on a Windows deviceManage alerts on a Windows device

Receiving alerts

You can manage individual alerts in the Power BI mobile app or manage all your alerts in the Power BI service.

1. In a dashboard, tap a card or gauge tile that has an alert.

4. To delete the alert altogether, right-click or tap and hold > Delete.

2. Tap the bell icon .

3. Tap the alert to change a value or turn it off.

You receive alerts in the Power BI Notification Center on your mobile device or in the Power BI service, along
with notifications about new dashboards that someone has shared with you.

Data sources are often set to refresh daily, although some refresh more often. When the data in the dashboard
is refreshed, if the data being tracked reaches one of the thresholds you've set, several things will happen.



NOTENOTE

Tips and troubleshooting

Next steps

3. Power BI adds a message to your Notification center and adds a new alert icon to the applicable tile .

1. Power BI checks to see if it's been more than an hour or more than 24 hours (depending on the option
you selected) since the last alert was sent.

As long as the data is past the threshold, you'll get an alert every hour or every 24 hours.

2. If you've set the alert to send you an email, you'll find something like this in your Inbox.

4. Tap the global navigation button  to open your Notification center and see the alert details.

Alerts only work on data that is refreshed. When data refreshes, Power BI looks to see if an alert is set for that data. If
the data has reached an alert threshold, an alert is triggered.

Alerts currently aren't supported for Bing tiles or card tiles with date/time measures.
Alerts only work with numeric data.
Alerts only work on data that is refreshed. They don't work on static data.
Alerts don't work with tiles that contain streaming data.

Manage your alerts in the Power BI service
Power BI Mobile Notification Center
Questions? Try asking the Power BI Community

http://community.powerbi.com/


Filter a report by geographic location in the Power BI
mobile apps
11/9/2017 • 1 min to read • Edit Online

iPhones iPads Android phones Android tablets Windows 10 phones

NOTENOTE

Filter your report by your geographic location

Applies to:

When you look at a Power BI report on your mobile device, do you see a little pushpin icon in the upper-right
corner? If so, then you can filter that report based on your geographic location.

You can only filter by location if the geographic names in the report are in English–for example, "New York City" or
"Germany". Windows 10 tablets and PCs don't support geographic filtering, but Windows 10 phones do.

1. Open a report in the Power BI mobile app on your mobile device.
2. If the report has geographic data, you see a message asking to allow Power BI to access your location. Click

Allow, the tap Allow again.

3. Tap the push pin . You can filter on city, state/province, or country/region, depending on the data in the
report. The filter only lists options that match your current location.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/mobile-apps-geographic-filtering.md


Why don't I see location tags on a report?

Next stepsNext steps

All three of these conditions need to be true, for you to see location tags.

The person who created the report in Power BI Desktop categorized geographical data for at least one column,
such as City, State, or Country/Region.
You are in one of the locations that has data in that column.
You're using one of these mobile devices:

iOS (iPad, iPhone, iPod).
Android phone or tablet.
Windows 10 phone (other Windows 10 devices such as PCs and tablets don't support geographic
filtering).

Read more about setting up geographic filtering in Power BI Desktop.

Connect to Power BI data from the real world with the mobile apps
Data categorization in Power BI Desktop
Questions? Try asking the Power BI Community

http://community.powerbi.com/


Ask questions about your data with the Q&A virtual
analyst in iOS apps - Power BI
1/19/2018 • 3 min to read • Edit Online

iPhones iPads

Download the samples

Applies to:

The easiest way to learn about your data is to ask questions about it in your own words. In this tutorial, try asking
questions and viewing featured insights about sample data with the Q&A virtual analyst.

In the Microsoft Power BI mobile app on your iPad, iPhone, and iPod Touch, the Q&A virtual analyst is a
conversational BI experience that enhances the previous version of Q&A in iOS. The Q&A virtual analyst still
accesses underlying Q&A data in the Power BI service (https://powerbi.com). You can still type or say a question,
and it also delivers data insights in context.

The first step in the tutorial is to download the Retail Analysis and Opportunity Analysis samples in the Power BI
service.

In your workspace on the Power BI service (https://powerbi.com):

Select Get Data > Samples > Opportunity Analysis Sample > Connect.
After the Opportunity Analysis Sample finishes downloading, select Get Data > Samples > Retail
Analysis Sample > Connect.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/mobile-apps-ios-qna.md
https://powerbi.com
https://powerbi.com


Try featured insights
1. On your iPhone or iPad, open the Power BI app and navigate to the Opportunity Analysis Sample dashboard.

2. Tap the Q&A virtual analyst icon  from the action menu at the bottom of the page (at the top of the
page on an iPad).

The Power BI Q&A virtual analyst offers some suggestions to get started.



3. Tap featured insights.

The Q&A virtual analyst suggests some insights.

4. Scroll to the right and tap Insight 2.



The Q&A virtual analyst displays Insight 2.

5. Tap the chart to open it in focus mode.



Try asking questions on your iPhone or iPad

6. Tap the arrow in the upper-left corner to go back to the Q&A virtual analyst experience.

1. On your iPhone or iPad, open the Power BI app and navigate to the Retail Analysis Sample dashboard.

2. Tap the Q&A virtual analyst icon  from the action menu at the bottom of the page (at the top of the page
on an iPad). The Q&A virtual analyst offers some suggestions to get started.

3. Type show, tap sales from the suggestion list > Send .



5. Tap as from the keywords, tap the column chart icon , then tap Send .

4. Tap by from the keywords, then tap item from the suggestion list > Send .

6. Long-tap the resulting chart, then tap Expand.



7. Tap the arrow in the upper-left corner to go back to the Q&A virtual analyst chat window.
8. Tap the X at the right of the text box to delete the text and start over.

The chart opens in focus mode in the app.

9. Try a new question: Tap top from the keywords, tap sale by avg $/unit ly > Send .



10. Choose by from the keywords, tap time from the suggestion list at the top > Send .

11. Type as, pick the line chart icon  from the suggestion list > Send .



Try saying your questions
You can now ask questions about your data in the Power BI mobile app by speaking instead of typing.

1. Tap the Q&A virtual analyst icon  from the action menu at the bottom of the page (at the top of the page
on an iPad).

2. Tap the microphone icon .

3. When the microphone icon is active, start speaking. For example, say "average unit price by time", then tap



Questions about privacy when using speech-to-text?Questions about privacy when using speech-to-text?

Help and feedback

Enhance your Q&A virtual analyst results

How to ask questionsHow to ask questions

Send .

See the Speech Recognition section of What's New in iOS in the Apple iOS Developer Guides.

Need help? Just say "Hi" or "Help", and you'll get assistance with starting a new question.
Care to provide feedback on the results? Long-tap a chart or other result, then tap the smiley or frowny
face.

Your feedback is anonymous, and helps us improve our answers to questions.

You can improve the results you and your customers get when they use the Q&A virtual analyst on a dataset,
either by asking more targeted questions or by enhancing the dataset.

Follow these tips for asking questions in Q&A in the Power BI service or the Q&A virtual analyst in your iOS

https://go.microsoft.com/fwlink/?linkid=845624


How to enhance the datasetHow to enhance the dataset

Next steps

mobile app.

Enhance the dataset in Power BI Desktop or in the Power BI service to make your data work well with Q&A
and the Q&A virtual analyst.

Q&A in the Power BI service
Questions? Check the Mobile apps section of the Power BI Community

https://go.microsoft.com/fwlink/?linkid=839277


Create a link to a specific location in the Power BI
mobile apps
11/9/2017 • 2 min to read • Edit Online

Open the Power BI mobile app

mspbi://app/

Open to a specific dashboard

mspbi://app/OpenDashboard?DashboardObjectId=<36-character-dashboard-id>

Open to a specific tile in focus

mspbi://app/OpenTile?DashboardObjectId=<36-character-dashboard-id>&TileObjectId=<36-character-tile-id>

You can create and use a uniform resource identifier (URI) to link to a specific location (a deep link) within the
Power BI mobile apps on all the mobile platforms: iOS, Android devices, and Windows 10.

URI links can point directly to dashboards, tiles, and reports.

The destination of the deep link determines the format of the URI. Follow these steps to create deep links to
different locations.

Use this URI to open the Power BI mobile app on any device:

This URI opens the Power BI mobile app to a specific dashboard:

To find the 36-character dashboard object id, navigate to the specific dashboard in the Power BI service
(https://powerbi.com). For example, see the highlighted section of this URL:

https://powerbi.com/groups/me/dashboards/**61b7e871-cb98-48ed-bddc-6572c921e270**

If the dashboard is in a group other than My Workspace, add &GroupObjectId=<36-character-group-id>  either before
or after the dashboard ID. For example,

mspbi://app/OpenDashboard?DashboardObjectId=e684af3a-9e7f-44ee-b679-
b9a1c59b5d60&GroupObjectId=8cc900cc-7339-467f-8900-fec82d748248

Note the ampersand (&) between the two.

This URI opens a specific tile in focus in the Power BI mobile app:

To find the 36-character dashboard and tile object IDs, navigate to the specific dashboard in the Power BI service
(https://powerbi.com) and open the tile in focus mode. For example, see the highlighted sections of this URL:

https://powerbi.com/groups/me/dashboards/**3784f99f-b460-4d5e-b86c-b6d8f7ec54b7**/tiles/**565f9740-
5131-4648-87f2-f79c4cf9c5f5**/infocus

For this tile, the URI would be:

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/mobile-apps-deep-link-specific-location.md
https://powerbi.com
https://powerbi.com/groups/me/dashboards/**61b7e871-cb98-48ed-bddc-6572c921e270**
https://powerbi.com
https://powerbi.com/groups/me/dashboards/**3784f99f-b460-4d5e-b86c-b6d8f7ec54b7**/tiles/**565f9740-5131-4648-87f2-f79c4cf9c5f5**/infocus


mspbi://app/OpenTile?DashboardObjectId=3784f99f-b460-4d5e-b86c-b6d8f7ec54b7&TileObjectId=565f9740-5131-4648-
87f2-f79c4cf9c5f5

Open to a specific report

mspbi://app/OpenReport?ReportObjectId=<36-character-report-id>

Open to a specific report page

mspbi://app/OpenReport?ReportObjectId=<36-character-report-id>&reportPage=ReportSection<number>

Open in full-screen mode

mspbi://app/OpenReport?ReportObjectId=<36-character-report-id>**&openFullScreen=true**

Add context (optional)

Next steps

Note the ampersand (&) between the two.

If the dashboard is in a group other than My Workspace, add &GroupObjectId=<36-character-group-id>

This URI opens a specific report in the Power BI mobile app:

To find the 36-character report object id, navigate to the specific report in the Power BI service
(https://powerbi.com). For example, see the highlighted section of this URL:

https://powerbi.com/groups/me/reports/**df9f0e94-31df-450b-b97f-4461a7e4d300**

This URI opens a specific report page in the Power BI mobile app:

The report page is called "ReportSection" followed by a number. Again, open the report in the Power BI service
(https://powerbi.com) and navigate to the specific report page.

For example, see the highlighted section of this URL:

https://powerbi.com/groups/me/reports/df9f0e94-31df-450b-b97f-4461a7e4d300/**ReportSection11**

Add the parameter in bold to open to a specific report in full-screen mode:

For example:

mspbi://app/OpenReport?ReportObjectId=500217de-50f0-4af1-b345-b81027224033&openFullScreen=true

You can also add context in the string. Then if you need to contact us, we can use that context to filter our data to
your app. Add &context=<app-name>  to the link

For example, see the highlighted section of this URL:

https://powerbi.com/groups/me/reports/df9f0e94-31df-450b-b97f-4461a7e4d300/**&context=SlackDeepLink**

Your feedback helps us decide what to implement in the future, so don’t forget to vote for other features you'd like
to see in Power BI mobile apps.

https://powerbi.com
https://powerbi.com/groups/me/reports/**df9f0e94-31df-450b-b97f-4461a7e4d300**
https://powerbi.com
https://powerbi.com/groups/me/reports/df9f0e94-31df-450b-b97f-4461a7e4d300/**ReportSection11**
https://powerbi.com/groups/me/reports/df9f0e94-31df-450b-b97f-4461a7e4d300/**&context=SlackDeepLink**


Power BI apps for mobile devices
Follow @MSPowerBI on Twitter
Join the conversation at the Power BI Community
Get started with Power BI

http://community.powerbi.com/


View your data offline in the Power BI mobile apps
1/17/2018 • 2 min to read • Edit Online

iPhones iPads Android phones Android tablets Windows 10 devices

Data access while you're offline

Background data refresh

Applies to:

One advantage of viewing Power BI in a mobile app rather than in a mobile browser is that you can see your data
even when you're not connected to a network.

By default, Power BI refreshes the data frequently so you get up-to-date answers to your business questions any
time, even while commuting or roaming.

While you're offline, you can access and interact with dashboards you've accessed previously from the mobile app.

You also have read-only access to any Power BI reports you've accessed previously from the mobile app. You can
see the full report, but not filter, cross-filter, sort, or use slicers on it.

Background refresh updates your favorite dashboards, plus dashboards and reports you've viewed in the last two
weeks, with the data on the Power BI service (not the data source). If you're connected to wi-fi, background refresh
updates every 2 hours. Otherwise, if you’re on a 3G network, Power BI updates the content every 24 hours.

You can turn off background refresh, for example to avoid network usage. Check the settings on your device.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/mobile-apps-offline-data.md


NOTENOTE

Offline indicators

Limitations

Next steps

If you use the Power BI mobile app on an iOS device and your organization has configured Microsoft Intune MAM, then
background data refresh is turned off. The next time you enter the app, Power BI refreshes the data from the Power BI
service on the web.

Read more about configuring Power BI mobile apps with Microsoft Intune.

Power BI provides clear indicators when you go in and out of offline mode, as well as indicators for missing
dashboards, reports, and tiles that aren't available offline.

When you're offline with Power BI on your mobile device, you may encounter these limitations:

Power BI can cache up to 250 MB of data offline.
Some tile types require an active server connection, so they aren't available offline — for example, Bing map
tiles and some custom tiles.
Whole Excel workbooks in Power BI aren't available offline.
You can see Reporting Services mobile reports and KPIs offline, if you have viewed them while connected. They
don't refresh in the background. They refresh every time you open them.

Your feedback helps us decide what to implement in the future, so don’t forget to vote for other features you'd like
to see in Power BI mobile apps.

Power BI apps for mobile devices
Follow @MSPowerBI on Twitter
Join the conversation at the Power BI Community
Get started with Power BI

http://community.powerbi.com/


View Power BI reports optimized for your phone
1/5/2018 • 3 min to read • Edit Online

iPhones Android phones

Applies to:

When you create a Power BI report in Power BI Desktop, you can also create a version of that report optimized
for viewing in the Power BI app on a phone.

Then, when you open a Power BI report on a phone, Power BI detects if the report has been optimized for phones
and automatically opens the optimized report in portrait view.

If a phone-optimized report doesn’t exist, the report still opens, but in the non-optimized landscape views. Even
in a phone-optimized report, if you turn your phone sideways, the report opens in the non-optimized view with
the original report layout. If only some pages are optimized, you see a message in portrait view, indicating the
report is available in landscape.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/mobile-apps-view-phone-report.md


  Filter the report page on a phone

All the other features of Power BI reports still work in phone-optimized reports. Read more about what you can
do in:

Reports on iPhones.
Reports on Android phones.

If a phone-optimized report has filters defined, when you view the report on a phone you can use those filters.

1. Tap the filter icon  at the bottom of the page.
2. Use basic or advanced filtering to see the results you're interested in.



Cross-highlight visuals

Select visuals

Open visuals in focus mode

Cross highlighting visuals in phone reports works the same as it does in the Power BI service and in reports on
phones in landscape view: When you select data in one visual, it highlights related data in the other visuals on
that page.

Read more about filtering and highlighting in Power BI.

In phone reports when you select a visual, the phone report highlights that visual and focuses on it, neutralizing
canvas gestures.

With the visual selected, you can do things like scroll within the visual. To de-select a visual, just touch anywhere
outside the visual area.

Phone reports also offer a focus mode, so you can get a bigger view of a single visual and explore it and the



 Drill down in a visual

report.

In a phone report, tap the ellipsis (...) in the upper-right corner of a visual > Expand to focus mode.

What you do in focus mode carries over to the report canvas and vice versa, for a seamless exploration
experience. For example, if you highlight a value in a visual, then return to the whole report, the report as a whole
will be filtered to the value you highlighted in the visual.

Some actions are only possible in focus mode, due to screen size constraints:

Drill down into the information displayed in a visual. Read more about drilling down and up in a phone
report, below.
Sort the values in the visual.
Revert: Clear exploration steps you've taken on a visual and revert to the definition set when the report
was created.

To clear all exploration from a visual, tap the ellipsis (...) > Revert.

Revert is available at the report level, clear all exploration from all visuals, or at the visual level, clearing all
exploration from the specific visual selected.

If hierarchy levels are defined in a visual, you can drill down into the detailed information displayed in a visual,
then back up. You add drill-down to a visual either in the Power BI service or in Power BI Desktop. Drill-down
only works in phone-optimized Power BI reports when you view them on a phone.

1. In a report on a phone, tap the ellipsis (...) in the upper-right corner > Expand to focus mode.

In this example, the bars show the values for states.

2. Tap the explore icon  in the lower-left.



3. Tap Show next level or Expand to next level.

Now the bars show the values for cities.

4. If you tap the arrow in the upper-left corner, you return to the phone report with the values still expanded



Next steps

to the lower level.

5. To go back up to the original level, tap the ellipsis (...) again > Revert.

Create reports optimized for the Power BI phone apps
Create a phone view of a dashboard in Power BI
Create responsive visuals optimized for any size
More questions? Try asking the Power BI Community

http://community.powerbi.com/


      

Configure mobile apps with Microsoft Intune
1/30/2018 • 6 min to read • Edit Online

General mobile device management configuration

NOTENOTE

Step 1: Get the url for the application

iOSiOS

Microsoft Intune enables organizations to manage devices and applications. The Power BI mobile applications, for
iOS and Android, integrate with Intune to allow you to manage the application on your devices, and to control
security. Through configuration policies, you can control items like requiring an access pin, controlling how data
is handled by the application and even encrypting application data when the app is not in use.

This article is not meant as full configuration guide for Microsoft Intune. If you are just now integrating with
Intune, there are a few things you will want to make sure you have setup. Learn more

Microsoft Intune can co-exist with Mobile Device Management (MDM) within Office 365. Learn more

This article assumes that Intune is configured properly and you have devices enrolled with Intune. If you are co-
existing with MDM, the device will show enrolled within MDM, but is available to manage within Intune.

After your organization has configured Microsoft Intune MAM, if you use the Power BI mobile app on an iOS or Android
device, then background data refresh is turned off. The next time you enter the app, Power BI refreshes the data from the
Power BI service on the web.

Before we create the application within Intune, we need to get the urls for the apps. For iOS, we will get this from
iTunes. For Android, you can get it from the Power BI mobile page.

Save the url, as you will need it when we create the application.

To get the app url for iOS, we will need to get it from iTunes.

1. Open iTunes.
2. Search for Power BI.
3. You should see Microsoft Power BI listed under iPhone Apps and iPad Apps. You can use either, as you

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-admin-mobile-intune.md
https://technet.microsoft.com/library/jj676587.aspx
https://blogs.technet.microsoft.com/configmgrdogs/2016/01/04/microsoft-intune-co-existence-with-mdm-for-office-365/


      

https://itunes.apple.com/us/app/microsoft-power-bi/id929738808?mt=8

AndroidAndroid

https://play.google.com/store/apps/details?id=com.microsoft.powerbim

Step 2: Create a mobile application management policy

will get the same url.
4. Select the Get drop down and select Copy Link.

It should look similar to the following.

You can get the url to Google Play from the Power BI mobile page. Clicking on the Download from Google Play
icon will take you to the app page. You can copy the URL from the browser address bar. It should look similar to
the following.

The mobile application management policy allows you to enforce items like an access pin. You can create one
within the Intune portal.

You can create the application, or the policy first. The order in which they are added doesn't matter. They will just
need to both exist for the deploy step.

2. Select Add....

1. Select Policy > Configuration Policies.

https://powerbi.microsoft.com/mobile/


Step 3: Create the application

iOSiOS

NOTENOTE

3. Under Software you can select Mobile Application Management for either Android or iOS. To get started
quickly, you can select Create a policy with the recommended settings, or you can create a custom policy.

4. Edit the policy to configure the restrictions you want on the application.

The application is a reference, or package, that is saved into Intune for deployment. We will need to create an
application and reference the app url that we got from either Google Play or iTunes.

You can create the application, or the policy first. The order in which they are added doesn't matter. They will just
need to both exist for the deploy step.

1. Go to the Intune portal and select Apps from the left menu.
2. Select Add App. This will launch the Add Software application.

1. Select Managed iOS App from the App Store from the drop down.

3. Provide a Publisher, Name and Description. You can optionally provide an Icon. The Category is for the
Company Portal app. Once you are done, select Next.

4. You can decide if you want the publish the app as Any (default), iPad or iPhone. By default it will show Any
and will work for both device types. The Power BI app is the same url for both iPhone and iPad. Select Next.

5. Select Upload.

2. Enter the app url, that we got from Step 1, and select Next.

You may not see it show up in the app list until you refresh the page. You can click on Overview and back to Apps to get
the page to reload.



AndroidAndroid

NOTENOTE

Step 4: Deploy the application

1. Select External Link from the drop down.

3. Provide a Publisher, Name and Description. You can optionally provide an Icon. The Category is for the
Company Portal app. Once you are done, select Next.

4. Select Upload.

2. Enter the app url, that we got from Step 1, and select Next.

You may not see it show up in the app list until you refresh the page. You can click on Overview and back to Apps to get
the page to reload.



iOSiOS

AndroidAndroid

After you have added the application, you will need to deploy it so that it is available to your end users. This is the
step where you will bind the policy you created with the app.

2. In the Select Groups screen, you can choose which groups you want to deploy this app to. Select Next.

5. In the VPN Profile screen, you can select a policy if you have one for your organization. It defaults to None.
Select Next.

6. In the Mobile App Configuration screen, you can select an App Configuration Policy if you created one. It
defaults to None. This is not required. Select Finish.

1. On the apps screen, select the app you created. Then select the Manage Deployment... link.

3. In the Deployment Action screen, you can choose how you want to deploy this app. Selecting Available
Install, or Required Install, will make the app available in the Company Portal for users to install on-
demand. After you are done making your selection, select Next.

4. In the Mobile App Management screen, you can select the Mobile App Management policy that we
created in Step 2. It will default to the policy you made, if that is the only iOS policy available. Select Next.

After you have deployed the app, it should show Yes for deployed, in the apps page.

1. On the apps screen, select the app you created. Then select the Manage Deployment... link.



Step 5: Install the application on a device

2. In the Select Groups screen, you can choose which groups you want to deploy this app to. Select Next.
3. In the Deployment Action screen, you can choose how you want to deploy this app. Selecting Available

Install, or Required Install, will make the app available in the Company Portal for users to install on-
demand. After you are done making your selection, select Next.

4. In the Mobile App Management screen, you can select the Mobile App Management policy that we
created in Step 2. It will default to the policy you made, if that is the only Android policy available. Select
Finish.

After you have deployed the app, it should show Yes for deployed, in the apps page.

You will install the application through the Company Portal app. If you haven't installed the Company Portal, you
can get it through the app store on either iOS or Android platforms. You will sign into the Company Portal with
your organizational login.

1. Open the Company Portal app.
2. If you don't see the Power BI app listed as a featured app, select Company Apps.



3. Select the Power BI app that you deployed.

4. Select Install.

5. If you are on iOS, it will push the app to you. Select Install on the push dialog.



Next steps

After it is installed, you will see that it is Managed by your company. If you enabled access with a pin, in the
policy, you will see the following.

Configure and deploy mobile application management policies in the Microsoft Intune console
Power BI apps for mobile devices

More questions? Try asking the Power BI Community

https://technet.microsoft.com/library/dn878026.aspx
http://community.powerbi.com/


Using OAuth to connect to Reporting Services
1/30/2018 • 7 min to read • Edit Online

Requirements

Domain Name Services (DNS) configuration

https://reports.contoso.com

Learn how to configure your environment to support OAuth authentication with the Power BI mobile app in order
to connect to Reporting Services 2016 or later.

In the past, the Power BI mobile app only supported basic authentication, over HTTPS, to Reporting Services in
order to display Mobile Reports or KPIs. Many organizations do not allow this type of configuration due to security
concerns. With an update to the Power BI mobile app, you can now use OAuth to connect to Reporting Services.
Windows Server 2016 provides some improvements to the Web Application Proxy role to allow this type of
authentication.

Windows Server 2016 is required for the Web Application Proxy (WAP) and Active Directory Federation Services
(ADFS) servers. You do not need to have a Windows 2016 functional level domain.

You will need to determine what the public URL will be that the Power BI mobile app will connect to. For example,
it may look similar to the following.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/mobile-oauth-ssrs.md


https://fs.contoso.com

Certificates

Reporting Services configuration

Service Principal Name (SPN)Service Principal Name (SPN)

Enabling negotiate authenticationEnabling negotiate authentication

<AuthenticationTypes>  
    <RSWindowsNegotiate />  
    <RSWindowsKerberos />  
    <RSWindowsNTLM />  
</AuthenticationTypes>

Active Directory Federation Services (ADFS) Configuration

Create an application groupCreate an application group

You will need to point your DNS record for reports to the public IP address of the Web Application Proxy (WAP)
server. You will also need to configure a public DNS record for your ADFS server. For example, you may have
configured the ADFS server with the following URL.

You will need to point your DNS record for fs to the public IP address of the Web Application Proxy (WAP) server
as it will be published as part of the WAP application.

You will need to configure certificates for both the WAP application and the ADFS server. Both of these certificates
must be part of a valid certificate authority that your mobile devices recognize.

There isn’t much to configure on the Reporting Services side. We just need to make sure that we have a valid
Service Principal Name (SPN) to enable the proper Kerberos authentication to occur and that the Reporting
Services server is enabled for negotiate authentication.

The SPN is a unique identifier for a service that uses Kerberos authentication. You will need to make sure you have
a proper HTTP SPN present for your report server.

For information on how to configure the proper Service Principal Name (SPN) for your report server, see Register
a Service Principal Name (SPN) for a Report Server.

To enable a report server to use Kerberos authentication, you will need to configure the Authentication Type of the
report server to be RSWindowsNegotiate. This is done within the rsreportserver.config file.

For more information, see Modify a Reporting Services Configuration File and Configure Windows Authentication
on a Report Server.

You will need to configure ADFS on a Windows 2016 server within your environment. This can be done through
the Server Manager and selecting Add Roles and Features under Manage. For more information, see Active
Directory Federation Services.

Within the AD FS Management screen, you will want to create an application group for Reporting Services which
will include information for the Power BI Mobile apps.

You can create the application group with the following steps.

1. Within the AD FS Management app, right click Application Groups and select Add Application Group…

https://msdn.microsoft.com/library/cc281382.aspx
https://msdn.microsoft.com/library/bb630448.aspx
https://msdn.microsoft.com/library/cc281253.aspx
https://technet.microsoft.com/windows-server-docs/identity/active-directory-federation-services


3. Select Next.
4. Provide a name for the application you are adding.
5. While the Client ID will be auto generated for your, enter in 484d54fc-b481-4eee-9505-0258a1913020 for

both iOS and Android.

7. Select Next.

2. Within the Add Application Group Wizard, provide a name for the application group and select Native
application accessing a web API.

6. You will want to add the following Redirect URLs:

Entries for Power BI Mobile – iOS:
msauth://code/mspbi-adal://com.microsoft.powerbimobile
msauth://code/mspbi-adalms://com.microsoft.powerbimobilems
mspbi-adal://com.microsoft.powerbimobile
mspbi-adalms://com.microsoft.powerbimobilems

Android Apps only need the following:
urn:ietf:wg:oauth:2.0:oob

8. Supply the URL for your Report Server. This is the external URL that will hit your Web Application Proxy. It
should be in the following format.



NOTENOTE

9. Select Next.

11. Select Next.
12. Select Next.
13. Select Next.
14. Select Close.

This URL is case sensitive!

https:///reports

10. Choose the Access Control Policy that fits your organization’s needs.

When completed, you should see the properties of your application group look similar to the following.



Web Application Proxy (WAP) Configuration

Constrained delegation configurationConstrained delegation configuration

You will want to enable the Web Application Proxy (Role) Windows role on a server in your environment. This
must be on a Windows 2016 server. For more information, see Web Application Proxy in Windows Server 2016
and Publishing Applications using AD FS Preauthentication.

In order to transition from OAuth authentication to Windows authentication, we need to use constrained
delegation with protocol transitioning. This is part of the Kerberos configuration. We already defined the Reporting
Services SPN within the Reporting Services configuration.

We need to configure constrained delegation on the WAP Server machine account within Active Directory. You
may need to work with a domain administrator if you don’t have rights to Active Directory.

To configure constrained delegation, you will want to do the following.

1. On a machine that has the Active Directory tools installed, launch Active Directory Users and Computers.
2. Find the machine account for your WAP server. By default, this will be in the computers container.
3. Right click the WAP server and go to Properties.
4. Select the Delegation tab.
5. Select Trust this computer for delegation to specified services only and then Use any

authentication protocol.

https://technet.microsoft.com/windows-server-docs/identity/web-application-proxy/web-application-proxy-windows-server
https://technet.microsoft.com/windows-server-docs/identity/web-application-proxy/publishing-applications-using-ad-fs-preauthentication#a-namebkmk14apublish-an-application-that-uses-oauth2-such-as-a-windows-store-app


7. Select Users or Computers…
8. Enter the service account that you are using for Reporting Services. This is the account you added the SPN to

within the Reporting Services configuration.

NOTENOTE

This sets up constrained delegation for this WAP Server machine account. We then need to specify the
services that this machine is allowed to delegate to.

6. Select Add… under the services box.

9. Select the SPN for Reporting Services and then select OK.

You may only see the NetBIOS SPN. It will actually select both the NetBIOS and FQDN SPNs if they both exist.

10. The result should look similar to the following when the Expanded checkbox is checked.



Add WAP ApplicationAdd WAP Application

Add-WebApplicationProxyApplication -Name "Contoso Reports" -ExternalPreauthentication ADFS -ExternalUrl 
https://reports.contoso.com/reports/ -ExternalCertificateThumbprint "0ff79c75a725e6f67e3e2db55bdb103efc9acb12" 
-BackendServerUrl http://ContosoSSRS/reports/ -ADFSRelyingPartyName "Reporting Services - Web API" -
BackendServerAuthenticationSPN "http/ContosoSSRS.contoso.com" -UseOAuthAuthentication

PARAMETER COMMENTS

ADFSRelyingPartyName This is the Web API name that you created as part of the
Application Group within ADFS.

ExternalCertificateThumbprint This is the certificate to use for the external users. It is
important that this certificate be valid on mobile devices and
come from a trusted certificate authority.

BackendServerUrl This is the URL to the Report Server from the WAP server. If
the WAP server is in a DMZ, you may need to use a fully
qualified domain name. Make sure you can hit this URL from
the web browser on the WAP server.

BackendServerAuthenticationSPN This is the SPN you created as part of the Reporting Services
configuration.

Setting Integrated Authentication for the WAP ApplicationSetting Integrated Authentication for the WAP Application

Get-WebApplicationProxyApplication “Contoso Reports” | fl

11. Select OK.

While you can publish applications within the Report Access Management Console, we will want to create the
application via PowerShell. Here is the command to add the application.

After you add the WAP Application, you will need to set the BackendServerAuthenticationMode to use
IntegratedWindowsAuthentication. In order to set this, you need the ID from the WAP Application.



Set-WebApplicationProxyApplication -id 30198C7F-DDE4-0D82-E654-D369A47B1EE5 -BackendServerAuthenticationMode 
IntegratedWindowsAuthentication

Connecting with the Power BI Mobile App

Run the following command to set the BackendServerAuthenticationMode using the ID of the WAP Application.

Within the Power BI mobile app, you will want to connect to your Reporting Services instance. To do that, supply
the External URL for your WAP Application.



When you select Connect, you will be directed to your ADFS login page. Enter valid credentials for your domain.



After you select Sign in, you will see the elements from your Reporting Services server.



Multi-factor authentication

Troubleshooting

You can enable multi-factor authentication to enable additional security for your environment. To learn more, see
Configure AD FS 2016 and Azure MFA.

You receive the error Failed to login to SSRS server. Please verify server configuration.

https://technet.microsoft.com/windows-server-docs/identity/ad-fs/operations/configure-ad-fs-2016-and-azure-mfa


Next steps

You can set up Fiddler to act as a proxy for your mobile devices to see how far the request made it. To enable a
Fiddler proxy for your phone device, you will need to setup the CertMaker for iOS and Android on the machine
running Fiddler. This is an add-on from Telerik for Fiddler.

If the sign in works successfully when using Fiddler, you may have a certificate issue with either the WAP
application or the ADFS server. You can use a tool such as Microsoft Message Analyzer to verify if the certificates
are valid.

Register a Service Principal Name (SPN) for a Report Server
Modify a Reporting Services Configuration File
Configure Windows Authentication on a Report Server
Active Directory Federation Services
Web Application Proxy in Windows Server 2016
Publishing Applications using AD FS Preauthentication
Configure AD FS 2016 and Azure MFA
More questions? Try the Power BI Community

http://www.telerik.com/fiddler
http://www.telerik.com/fiddler/add-ons
https://www.microsoft.com/download/details.aspx?id=44226
https://msdn.microsoft.com/library/cc281382.aspx
https://msdn.microsoft.com/library/bb630448.aspx
https://msdn.microsoft.com/library/cc281253.aspx
https://technet.microsoft.com/windows-server-docs/identity/active-directory-federation-services
https://technet.microsoft.com/windows-server-docs/identity/web-application-proxy/web-application-proxy-windows-server
https://technet.microsoft.com/windows-server-docs/identity/web-application-proxy/publishing-applications-using-ad-fs-preauthentication#a-namebkmk14apublish-an-application-that-uses-oauth2-such-as-a-windows-store-app
https://technet.microsoft.com/windows-server-docs/identity/ad-fs/operations/configure-ad-fs-2016-and-azure-mfa
http://community.powerbi.com/


Supported languages in the Power BI mobile apps
1/17/2018 • 1 min to read • Edit Online

Notes

The Power Bi mobile apps currently support these languages:

Arabic (iOS only)
Catalan - català
Chinese (Simplified) - 中文(简体)
Chinese (Traditional) - 中文(繁體)
Croatian - hrvatski
Czech - čeština
Danish - dansk
Dutch - Nederlands
English - English
Finnish - suomi
French - français
German - Deutsch
Greek - Ελληνικά
Hebrew (iOS only)
Hindi - िहंदी
Hungarian - magyar
Indonesian - Bahasa Indonesia
Italian - italiano
Japanese - 日本語
Korean - 한국어
Malay - Bahasa Melayu
Norwegian (Bokmål) - norsk (bokmål)
Polish - Polski
Portuguese (Brazil) - Português
Portuguese (Portugal) - português
Romanian - română
Russian - Русский
Slovak - slovenčina
Spanish - español
Swedish - svenska
Thai - ไทย
Turkish - Türkçe
Ukrainian - українська
Vietnamese - Tiếng Việt

Power BI uses the language that corresponds with the locale of the mobile device. You can't set a different
language.
Notifications are in English only. For example, if someone shares a dashboard with you, the notification will be

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/mobile-apps-supported-languages.md


Next steps

in English.

Supported languages and countries/regions for Power BI
Questions? Try asking the Power BI Community.
Still have an issue? Please visit the Power BI support page.

http://community.powerbi.com/
https://powerbi.microsoft.com/support/


Get started with the Power BI mobile app on an iPad
1/26/2018 • 4 min to read • Edit Online

Download the iOS app for the iPad

NOTENOTE

Sign up for the Power BI service

Get started with the Power BI app

The Microsoft Power BI for iOS on the iPad delivers the mobile BI experience for Power BI, Power BI Report Server,
and Reporting Services. View and interact with your company dashboards on premises and in the cloud from
anywhere, with live, touch-enabled mobile access. Explore the data in dashboards, and share with your colleagues
in email or text messages.

You create Power BI reports in Power BI Desktop, and publish them:

Publish them to the Power BI service, and create dashboards.
Publish them on-premises to Power BI Report Server.

Then in the Power BI app for the iPad, you interact with your dashboards and reports, whether on-premises or in
the cloud.

Find out what's new in the Power Bi mobile apps.

Download the iPad app from the Apple App Store.

Your iPad needs to be running at least iOS 10.

Go to Power BI (https://powerbi.com) to sign up for the service, if you haven't already. It's free.

1. In the iPad, open the Power BI app.
2. To view your Power BI dashboards and reports, tap Power BI. Sign in with the same credentials as your

Power BI account on the web.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/mobile-ipad-app-get-started.md
http://go.microsoft.com/fwlink/?LinkId=522062
https://powerbi.com


Try the Power BI and Reporting Services samples

Power BI samplesPower BI samples

Reporting Services mobile report samplesReporting Services mobile report samples

To view your Reporting Services mobile reports and KPIs, tap SQL Server Reporting Services. Sign in with
your SQL Server Reporting Services credentials.

When you're in the app, just tap the global navigation button  in the upper-left corner to go between
the two services.

Even without signing up, you can play with the Power BI and Reporting Services samples. After you download the
app, you can view the samples or get started. Go back to the samples whenever you want from the dashboards
home page.

You can view and interact with the Power BI dashboard samples, but there are a few things you can't do with
them. You can't open the reports behind the dashboards, share the samples with others, or make them your
favorites.

1. Tap the global navigation button  in the upper-left corner, then tap the Settings icon .

NOTENOTE

2. Tap Power BI samples, then pick a role and explore the sample dashboard for that role.

Not all features are available in the samples. For example, you can't view the sample reports that underlie the
dashboards.

1. Tap the global navigation button  in the upper-left corner, then tap the Settings icon .
2. Tap Reporting Services samples, then open either the Retail Reports or the Sales Reports folder to

explore their KPIs and mobile reports.



Find your content in the Power BI mobile apps

Search for a dashboard or report

Your dashboards and reports are stored in different locations in the Power BI mobile apps, depending on where
they came from. Read about finding your content in the mobile apps. Plus you can always search for anything you
have in the Power BI mobile apps.

Tap the magnifying glass in the upper-right corner , then type the term to find.



View your favorite dashboards, KPIs, and reports

By default it searches all dashboards and reports, but you can search just one or the other.

On the Favorites page in the mobile apps, you see all of your favorite Power BI dashboards, together with Power BI
Report Server and Reporting Services KPIs and reports. When you make a dashboard a favorite in the Power BI
mobile app, you can access it from all of your devices, including the Power BI service in your browser.

Tap Favorites.

Your Power BI favorites and your favorites from the report server web portal are all on this page.



Enterprise support for the Power BI mobile apps

NOTENOTE

Next steps

Power BI dashboards and reportsPower BI dashboards and reports

Read more about favorites in the Power BI mobile apps.

Organizations can use Microsoft Intune to manage devices and applications, including the Power BI mobile apps
for Android and iOS.

Microsoft Intune lets organizations control items like requiring an access pin, controlling how data is handled by
the application, and even encrypting application data when the app isn't in use.

If you use the Power BI mobile app on your iPad and your organization has configured Microsoft Intune MAM, then
background data refresh is turned off. The next time you enter the app, Power BI refreshes the data from the Power BI
service on the web.

Read more about configuring Power BI mobile apps with Microsoft Intune.

Here are some other things you can do in the iPad app with dashboards and reports in Power BI, and reports and
KPIs in the Power BI Report Server or Reporting Services web portal.

View your apps.
View your Power BI dashboards.
Ask questions of your data in your own words with Q&A
Scan a Power BI QR code to open a related dashboard tile or report.
Set data alerts to get notifications when your data changes.
View notifications about updates to your Power BI account, such as dashboards that colleagues share with
you.



Reports and KPIs on the report server web portalsReports and KPIs on the report server web portals

See alsoSee also

View reports and KPIs on the web portal in the Power BI mobile app for iOS devices.
Create KPIs on the web portal.
Create reports in Power BI Desktop and publish them on the Power BI Report Server web portal

Get started with Power BI
Questions? Try asking the Power BI Community

https://docs.microsoft.com/sql/reporting-services/working-with-kpis-in-reporting-services
http://community.powerbi.com/


Get started with the Power BI mobile app on an
iPhone or iPod Touch
1/26/2018 • 4 min to read • Edit Online

Download the app

NOTENOTE

Sign up for the Power BI service

The Microsoft Power BI for iOS app on the iPhone or iPod Touch delivers the mobile BI experience for Power BI,
Power BI Report Server, and Reporting Services. View and interact with your company dashboards on premises
and in the cloud from anywhere, with live, touch-enabled mobile access. Explore the data in dashboards, and
share with your colleagues in email or text messages. And keep up to date with your most timely data on your
Apple Watch.

You create Power BI reports in Power BI Desktop, and publish them:

Publish them to the Power BI service, and create dashboards.
Publish them on-premises to Power BI Report Server.

Then in the Power BI app for the iPhone, you interact with your dashboards and reports, whether on-premises or
in the cloud.

Find out what's new in the Power Bi mobile apps.

Download the iOS app from the Apple App Store to your iPhone or iPod Touch.

You can run the Power BI for iOS app on iPhone 5 and above, with iOS 10 or later. You can also run it on an iPod Touch
with iOS 10 or later.

Go to Power BI (https://powerbi.com) for the service, if you haven't already. It's free.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/mobile-iphone-app-get-started.md
http://go.microsoft.com/fwlink/?LinkId=522062
https://powerbi.com


Get started with the Power BI app

Try the Power BI and Reporting Services samples

Power BI samplesPower BI samples

1. In the iPhone, open the Power BI app.
2. To view your Power BI dashboards, tap Power BI.

To view your Reporting Services mobile reports and KPIs, tap SQL Server Reporting Services.

When you're in the app, just tap the global navigation button  in the upper-left corner to go
between the two.

Even without signing up, you can play with the Power BI and Reporting Services samples. After you download the
app, you can view the samples or get started. Go back to the samples whenever you want from the global
navigation.

You can view and interact with the Power BI dashboard samples, but there are a few things you can't do with
them. You can't open the reports behind the dashboards, share the samples with others, or make them your
favorites.

1. Tap the global navigation button  in the upper-left corner.

2. Tap the gear icon in the upper-right , then tap Power BI samples.
3. Pick a role and explore the sample dashboard for that role.



Reporting Services mobile report samplesReporting Services mobile report samples

Find your content in the Power BI mobile apps

View your favorite dashboards, KPIs, and reports

NOTENOTE
Not all features are available in the samples. For example, you can't view the sample reports that underlie the
dashboards.

1. Tap the global navigation button  in the upper-left corner.

2. Tap the gear icon in the upper-right , then tap Reporting Services samples.
3. Open either the Retail Reports or the Sales Reports folder to explore their KPIs and mobile reports.

Your dashboards and reports are stored in different locations in the Power BI mobile apps, depending on where
they came from. Read about finding your content in the mobile apps. Plus you can always search for anything
you have in the Power BI mobile apps.

Read more about finding your content in the mobile apps.

On the Favorites page in the mobile apps, you see all of your favorite Power BI dashboards, together with Power
BI Report Server and Reporting Services KPIs and reports. When you make a dashboard a favorite in the Power BI
mobile app, you can access it from all of your devices, including the Power BI service in your browser.



Enterprise support for the Power BI mobile apps

NOTENOTE

Tap Favorites.

You see all your favorites together on this page:

1. Dashboards on the Power BI service
2. KPIs on Power BI Report Server
3. Power BI reports on Power BI Report Server

Read more about favorites in the Power BI mobile apps.

Organizations can use Microsoft Intune to manage devices and applications, including the Power BI mobile apps
for Android and iOS.

Microsoft Intune lets organizations control items like requiring an access pin, controlling how data is handled by
the application, and even encrypting application data when the app isn't in use.

If you use the Power BI mobile app on your iPhone and your organization has configured Microsoft Intune MAM, then
background data refresh is turned off. The next time you enter the app, Power BI refreshes the data from the Power BI
service on the web.

Read more about configuring Power BI mobile apps with Microsoft Intune.



Next steps

Power BI dashboards and reportsPower BI dashboards and reports

Reports and KPIs on the report server web portalsReports and KPIs on the report server web portals

See alsoSee also

Here are some other things you can do in the iPhone app with dashboards and reports in Power BI, and reports
and KPIs in the Power BI Report Server or Reporting Services web portal.

View your apps.
View your Power BI dashboards.
Ask questions of your data in your own words with Q&A
View your Power BI tiles on your Apple Watch.
Set data alerts for your data.
Share Power BI dashboards.
Annotate and share a tile, report, or visualization.
Scan a Power BI QR code to open a related dashboard tile or report.
Create picture tiles with your iPhone app.
View notifications about updates to your Power BI account, such as dashboards that colleagues share with
you.

View reports and KPIs on the web portal in the Power BI mobile app for iOS devices.
Create KPIs on the web portal.
Create reports in Power BI Desktop and publish them on the Power BI Report Server web portal

Get started with Power BI
Questions? Try asking the Power BI Community

https://docs.microsoft.com/sql/reporting-services/working-with-kpis-in-reporting-services
http://community.powerbi.com/


Explore your data in the Power BI mobile app on
your Apple Watch
11/15/2017 • 2 min to read • Edit Online

Install the Apple Watch app

Use the Power BI app on the Apple Watch

With the Power BI Apple Watch app, you can view KPIs and card tiles from your Power BI dashboards, right on
your watch. KPIs and card tiles are best suited to providing a heartbeat measure on the small screen. You can
refresh a dashboard from your iPhone or from the Watch itself.

The Power BI Apple Watch app is bundled with the Power BI for iOS app, so when you download the Power BI app
to your iPhone from the Apple App Store, you're automatically also downloading the Power BI Watch app. The
Apple guide explains how to install Apple Watch applications.

Get to the Power BI Apple Watch app either from the watch's springboard, or by clicking the Power BI widget (if
configured) directly from the watch face.

The Power BI Apple Watch app consists of two parts.

The index screen allows a quick overview of all KPI and card tiles from the synced dashboard.

The in-focus tile: Click a tile on the index screen for an in-depth view of a specific tile.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/mobile-apple-watch.md
http://go.microsoft.com/fwlink/?LinkId=522062
https://support.apple.com/en-us/HT204784


Refresh a dashboard from your Apple Watch

NOTENOTE

Refresh a dashboard on your Apple Watch from your iPhone

TIPTIP

Set a custom Power BI widget

Add a Power BI widget to your watch faceAdd a Power BI widget to your watch face

Change the text on the widgetChange the text on the widget

You can refresh a synced dashboard directly from your watch.

While in the dashboard view on the watch app, deep press your screen and select refresh.

Your watch app will now sync your dashboard with data from the Power BI service.

The watch app communicates with Power BI via Power BI mobile app on the iPhone. Therefore, the Power BI app must be
running on your iPhone, at least in the background, for the dashboard on the watch app to refresh.

You can also refresh a dashboard that's on your Apple Watch from your iPhone.

1. In Power BI on your iPhone, open the dashboard you want to sync with the Apple Watch.
2. Select the ellipsis (...) > Sync with Watch.

Power BI shows an indicator that the dashboard is synced with the watch.

You can only sync one dashboard at a time with the watch.

To view tiles from multiple dashboards on your watch, create a new dashboard in the Power BI service, and pin all the
relevant tiles to it.

You can also display a specific Power BI tile directly on the Apple Watch face, so it's visible and accessible at all
times.

The Power BI Apple Watch widget updates close to the time your data updates, keeping your needed information
always up to date.

See Customize your Apple Watch face in the Apple Guide.

Given the small space on the Apple Watch face, the Power BI Apple Watch app lets you change the title of the
widget to fit the small space.

https://support.apple.com/en-us/HT205536


NOTENOTE

Next steps

On your iPhone, go to the Apple Watch control app, select Power BI, navigate to the widget name field, and
type a new name.

If you don't change the name, the Power BI widget will shorten the name to the number of characters that fit the small
space on the watch face.

Your feedback will help us decide what to implement in the future, so please don’t forget to vote for other
features that you would like to see in Power BI mobile apps.

Download the Power BI iPhone mobile app
Follow @MSPowerBI on Twitter
Join the conversation at the Power BI Community

http://go.microsoft.com/fwlink/?LinkId=522062
https://twitter.com/MSPowerBI
http://community.powerbi.com/


Scan a barcode with your iPhone from the Power BI
mobile app
11/9/2017 • 2 min to read • Edit Online

Scan a barcode with the Power BI scanner

Filter by other barcodes while in a report

Scan barcodes in the real world to go directly to filtered BI information in the Power BI mobile app.

Say a colleague has tagged a barcode field in a report Power BI Desktop and shared the report with you.

When you scan a product barcode with the scanner in the Power BI app on your iPhone, you see the report (or list
of reports) with that barcode. You can open that report on your iPhone, filtered to that barcode.

1. In the Power BI mobile app open the main navigation menu  in the upper left.

3. If your camera is not enabled, you need to approve the Power BI app to use the camera. This is a one-time
approval.

5. Tap the report name to open it on your iPhone, automatically filtered to that barcode.

2. Scroll down to Scanner and select it.

4. Point the scanner at a barcode on a product.

You see a list of reports associated with that barcode.

While looking at a report filtered by a barcode on your iPhone, you may want to filter the same report by a
different barcode.

If the barcode icon has a filter , the filter is active and report Is already filtered by a barcode.
If the icon doesn’t contain a filter , the filter isn't active and the report isn’t filtered by a barcode.

Either way, tap the icon to open a small menu with a floating scanner.

Focus the scanner on the new item to change the filter of the report to a different barcode value.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/mobile-apps-scan-barcode-iphone.md


  Issues with scanning a barcode

“Couldn’t filter report...”“Couldn’t filter report...”

All/some of the visuals in the report don’t contain any valueAll/some of the visuals in the report don’t contain any value

“Looks like you don’t have any reports that can be filtered by barcodes.”“Looks like you don’t have any reports that can be filtered by barcodes.”

“Couldn’t filter report - Looks like this barcode doesn't exist in the report data.”“Couldn’t filter report - Looks like this barcode doesn't exist in the report data.”

Next steps

Select Clear barcode filter to go back to the unfiltered report.
Select Filter by recent barcodes to change the report filter to one of the barcodes you've scanned within the
current session.

Here are some messages you may see when you scan a barcode on a product.

The report you choose to filter is based on a data model that does not include this barcode value. For example, the
product "mineral water" isn't included in the report.

The barcode value you scanned exists in your model but all/Some of the visuals on your report don’t contain this
value and therefore filtering will return an empty state. Try looking into other report pages or edit your reports in
Power BI desktop to contain this value

This means you don’t have any barcode-enabled reports. The barcode scanner can only filter reports that have a
column marked as Barcode.

Make sure you or the report owner has tagged a column as Barcode in Power BI Desktop. Learn more about
tagging a barcode field in Power BI Desktop

The report you chose to filter is based on a data model that doesn't include this barcode value. For example, the
product "mineral water" isn't included in the report. You can scan a different product, choose a different report (if
more than one report is available), or view the report unfiltered.

Tag a barcode field in Power BI Desktop
Dashboard tiles in Power BI
Dashboards in Power BI



Get started with the Power BI mobile app on Android
phones
11/9/2017 • 5 min to read • Edit Online

First things first

The Android app for Microsoft Power BI delivers the mobile BI experience for Power BI, Power BI Report Server,
and Reporting Services. View and interact with your company dashboards on premises and in the cloud from
anywhere, with live, touch-enabled mobile access. Explore the data in dashboards, and share with your colleagues
in email or text messages.

You create Power BI reports in Power BI Desktop, and publish them:

Publish them to the Power BI service, and create dashboards.
Publish them on-premises to Power BI Report Server.

Then in the Power BI app for Android phones, you interact with your dashboards and reports, whether on-
premises or in the cloud.

Find out what's new in the Power Bi mobile apps.

Get the app Get the Power BI for Android app from Google Play.

Power BI can run on a number of different Android phones. Your phone needs to be running the Android

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/mobile-android-app-get-started.md
http://go.microsoft.com/fwlink/?LinkID=544867


 

Sign up for the Power BI service on the web

Get started with the Power BI app on your phone

Try the Power BI and Reporting Services samples

Power BI samplesPower BI samples

Start when you open the app Even without signing up or signing in, after you open the app you can flip
through the sign-in pages for a quick overview of things you can do with the Power BI app on your Android
phone. Tap Skip to view and explore the samples, and get hands-on experience with the app. You can go back
to the samples whenever you want from the dashboards home page.
Find out what's new in the Power Bi mobile apps.

5.0 operating system, or later. To check on your phone, go to Settings > About device > Android
version.

If you haven't signed up yet, go to the Power BI service (http://powerbi.com/) to sign up for your own account for
creating and storing dashboards and reports, and bringing your data together. Then sign in to Power BI from your
Android phone to see your own dashboards from anywhere.

1. In the Power BI service, tap Sign up to create a Power BI account.
2. Start creating your own dashboards and reports.

IMPORTANTIMPORTANT

1. On your Android phone, from the start screen open the Power BI for Android app.

2. To view your Power BI dashboards and reports, tap Power BI.

If you get a message that Power BI can't sign you in, see "Could not authenticate because your corporate SSL
certificate is untrusted" for details on how to resolve the issue.

To view your Power BI Report Server and Reporting Services reports and KPIs, tap Report Server.

Even without signing up, you can play with the Power BI and Reporting Services samples. After you download the
app, you can view the samples or get started. Go back to the samples whenever you want from the dashboards
home page.

http://powerbi.com/
http://go.microsoft.com/fwlink/?LinkID=513879


Reporting Services mobile report samplesReporting Services mobile report samples

You can view and interact with the Power BI dashboard samples, but there are a few things you can't do with them.
You can't open the reports behind the dashboards, share the samples with others, or make them your favorites.

1. Tap the global navigation button  in the upper-left corner.
2. Tap Settings > Discover our samples, then pick a role and explore the sample dashboard for that role.

1. Tap the global navigation button  in the upper-left corner.
2. Tap Reporting Services samples, then open either the Retail Reports or the Sales Reports folder to

explore their KPIs and mobile reports.



Search for a dashboard or report

Find your content in the Power BI mobile apps

Tap the magnifying glass in the upper-right corner , then type the term to find.

By default it searches all dashboards and reports, but you can search just one or the other.

Your dashboards and reports are stored in different locations in the Power BI mobile apps, depending on where
they came from. Read about finding your content in the mobile apps. Plus you can always search for anything you
have in the Power BI mobile apps.



View your favorite dashboards, KPIs, and reports
On the Favorites page in the mobile apps, you see all of your favorite Power BI dashboards, together with Power BI
Report Server and Reporting Services KPIs and reports. When you make a dashboard a favorite in the Power BI
mobile app, you can access it from all of your devices, including the Power BI service in your browser.

Tap Favorites.

Your Power BI favorites and your favorites from the Power BI Report Server and Reporting Services web
portal are all on this page.

Read more about favorites in the Power BI mobile apps.



Enterprise support for the Power BI mobile apps

NOTENOTE

Next steps

Power BI dashboards and reportsPower BI dashboards and reports

Reports and KPIs on the Power BI Report Server and Reporting Services web portalsReports and KPIs on the Power BI Report Server and Reporting Services web portals

See alsoSee also

Organizations can use Microsoft Intune to manage devices and applications, including the Power BI mobile apps
for Android and iOS.

Microsoft Intune lets organizations control items like requiring an access pin, controlling how data is handled by
the application, and even encrypting application data when the app isn't in use.

If you use the Power BI mobile app on your Android device and your organization has configured Microsoft Intune MAM,
then background data refresh is turned off. The next time you enter the app, Power BI refreshes the data from the Power BI
service on the web.

Read more about configuring Power BI mobile apps for Android with Microsoft Intune.

Here are some other things you can do in the Android phone app for Power BI with dashboards and reports in
Power BI, and reports and KPIs in the Power BI Report Server or Reporting Services web portal.

View your apps.
View your dashboards.
Explore the tiles on your dashboards.
Open Power BI reports.
View your apps.
Annotate and share tiles.
Share dashboards.
Scan a Power BI QR code to open a related dashboard tile or report.
View notifications about updates to your Power BI account, such as dashboards that colleagues share with you.

View reports and KPIs on the web portal in the Power BI mobile app for Android devices.
Create KPIs on the web portal.
Create reports in Power BI Desktop and publish them on the Power BI Report Server web portal

Download the Android app from the Android app store.
Get started with Power BI
Questions? Try asking the Power BI Community

https://docs.microsoft.com/sql/reporting-services/working-with-kpis-in-reporting-services
http://go.microsoft.com/fwlink/?LinkID=544867
http://community.powerbi.com/


Error: "Corporate SSL certificate is untrusted" -
Power BI
11/9/2017 • 1 min to read • Edit Online

On Android 7 or later

On Android 6 and earlier

Time-zone settings

Custom authentication server

Next steps

When signing in to the Android mobile app for Microsoft Power BI, you may see the message, “Could not
authenticate because your corporate SSL certificate is untrusted by this device. Please contact your company IT
admin.”

What you need to do usually depends on the operating system on your Android device, but there are a couple of
other issues that may cause this error.

Look for an update for an app named Chrome, and install the update.

Your device may need a updated version of System Webview. It may be installed on your device, and you may just
need to click Update.

If System Webview isn't installed on your device:

1. On your Android device, close Power BI.
2. Open the Google Play Store and search for System Webview by Google Inc.
3. Install it.
4. Restart the Power BI app and sign in.

Time-zone settings on your device may be wrong.

Go to Settings > System > Date and time to check them.

If you're using a custom authentication server, the SSL certificate in the corporate authentication server may not be
valid. Please contact your organization's IT admin to help you.

Download the Android app from the Android app store.
Questions? Try asking the Power BI Community

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/mobile-android-app-error-corporate-ssl-account-is-untrusted.md
http://go.microsoft.com/fwlink/?LinkID=544867
http://community.powerbi.com/


Get started with the Power BI mobile app on Android
tablets
11/15/2017 • 5 min to read • Edit Online

First things first

Sign up for the Power BI service on the web

The Power BI mobile app for Android tablets delivers the mobile BI experience for Power BI, Power BI Report
Server, and Reporting Services. View and interact with your company dashboards on premises and in the cloud
from anywhere, with live, touch-enabled mobile access. Explore the data in dashboards, and share with your
colleagues in email or text messages.

You create Power BI reports in Power BI Desktop, and publish them:

Publish them to the Power BI service, and create dashboards.
Publish them on-premises to Power BI Report Server.

Then in the Power BI app for Android tablets, you interact with your dashboards and reports, whether on-premises
or in the cloud. Find out what's new in the Power Bi mobile apps.

NOTENOTE

Start when you open the app Even without signing up or signing in, after you open the app you can flip
through the sign-in pages for a quick overview of things you can do with the Power BI app on your Android
tablet. Tap Skip to view and explore the samples, and get hands-on experience with the app. You can go back
to the samples whenever you want from the dashboards home page.
Find out what's new in the Power Bi mobile apps.

Get the app Get the Power BI for Android app from Google Play.

Power BI can run on a number of different Android tablets. Your tablet needs to be running the Android 5.0
operating system, or later. To check on your tablet, go to Settings > About device > Android version.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/mobile-android-tablet-app-get-started.md
http://go.microsoft.com/fwlink/?LinkID=544867


 

Get started with the Power BI app on your tablet

Try the Power BI and Reporting Services samples

Power BI samplesPower BI samples

If you haven't signed up yet, go to the Power BI service (http://powerbi.com/) to sign up for your own account for
creating and storing dashboards and reports, and bringing your data together. Then sign in to Power BI from your
Android tablet to see your own dashboards from anywhere.

1. In the Power BI service, tap Sign up to create a Power BI account.
2. Start creating your own dashboards and reports.

IMPORTANTIMPORTANT

1. On your Android tablet, from the start screen open the Power BI for Android app.

2. To view your Power BI dashboards and reports, tap Power BI.

If you get a message that Power BI can't sign you in, see "Could not authenticate because your corporate SSL
certificate is untrusted" for details on how to resolve the issue.

To view your on-premises Power BI Report Server and Reporting Services reports and KPIs, tap Report
Server.

Give your report server sign-in information to view Power BI Report Server and Reporting Services reports
and KPIs in the Android tablet app for Power BI.

Even without signing up, you can play with the Power BI and Reporting Services samples. After you download the
app, you can view the samples or get started. Go back to the samples whenever you want from the dashboards
home page.

You can view and interact with the Power BI dashboard samples, but there are a few things you can't do with
them. You can't open the reports behind the dashboards, share the samples with others, or make them your
favorites.

1. Tap the global navigation button  in the upper-left corner.
2. Tap Settings > Discover our samples, then pick a role and explore the sample dashboard for that role.

http://powerbi.com/
http://go.microsoft.com/fwlink/?LinkID=513879


Reporting Services mobile report samplesReporting Services mobile report samples

Search for a dashboard or report

1. Tap the global navigation button  in the upper-left corner.
2. Tap Reporting Services samples, then open either the Retail Reports or the Sales Reports folder to

explore their KPIs and mobile reports.

Tap the magnifying glass in the upper-right corner , then type the term to find.



  

Find your content in the Power BI mobile apps

View your favorite dashboards, KPIs, and reports

By default it searches all dashboards and reports, but you can search just one or the other.

Your dashboards and reports are stored in different locations in the Power BI mobile apps, depending on where
they came from. Read about finding your content in the mobile apps. Plus you can always search for anything you
have in the Power BI mobile apps.

On the Favorites page in the mobile apps, you can view all of your favorite Power BI dashboards, together with
KPIs and reports on the Power BI Report Server or Reporting Services web portal. When you make a dashboard a
favorite in the Power BI mobile app, you can access it from all of your devices, including the Power BI service in
your browser.

Tap Favorites.



Enterprise support for the Power BI mobile apps

NOTENOTE

Next steps

Your Power BI favorites and your favorites from the Power BI Report Server and Reporting Services web
portal are all on this page.

Read more about favorites in the Power BI mobile apps.

Organizations can use Microsoft Intune to manage devices and applications, including the Power BI mobile apps
for Android and iOS.

Microsoft Intune lets organizations control items like requiring an access pin, controlling how data is handled by
the application, and even encrypting application data when the app isn't in use.

If you use the Power BI mobile app on your Android device and your organization has configured Microsoft Intune MAM,
then background data refresh is turned off. The next time you enter the app, Power BI refreshes the data from the Power BI
service on the web.

Read more about configuring Power BI mobile apps for Android with Microsoft Intune.

Here are some other things you can do in the Android tablet app for Power BI with dashboards and reports in



Power BI dashboards and reportsPower BI dashboards and reports

Reports and KPIs on the Power BI Report Server and Reporting Services web portalsReports and KPIs on the Power BI Report Server and Reporting Services web portals

See alsoSee also

Power BI, and reports and KPIs in the Power BI Report Server or Reporting Services web portal.

View your apps.
View your dashboards.
Annotate and share tiles.
Share dashboards.
Scan a Power BI QR code to open a related dashboard tile or report.
View notifications about updates to your Power BI account, such as dashboards that colleagues share with you.

View reports and KPIs on the web portal in the Power BI mobile app for Android devices.
Create KPIs on the web portal.
Create reports in Power BI Desktop and publish them on the Power BI Report Server web portal

Download the Android app from the Android app store.
Get started with Power BI
Questions? Try asking the Power BI Community

https://docs.microsoft.com/sql/reporting-services/working-with-kpis-in-reporting-services
http://go.microsoft.com/fwlink/?LinkID=544867
http://community.powerbi.com/


Get started with the Power BI mobile app for
Windows 10
12/7/2017 • 3 min to read • Edit Online

First things first

Sign up for the Power BI service on the web

Get started with the Power BI app

The Power BI mobile app for Windows 10 brings Power BI to your tablet or phone, with up-to-date, touch-enabled
mobile access to your business information. View and interact with your company dashboards from anywhere —
right on your Windows Start screen.

You create dashboards and reports in the Power BI service with your data.

Then interact with your dashboards and reports, explore the data, and share them, all from the Power BI mobile
app for Windows 10.

Get the Power BI mobile app for Windows 10 from the Windows Store.

Your device needs to be running Windows 10. The app can run on devices with at least 3 GB RAM and 8 GB
internal storage.

Find out what's new in the Power Bi mobile apps.

If you haven't signed up yet, go to the Power BI service to sign up for your own account for creating and storing
dashboards and reports, and bringing your data together. Then sign in to Power BI from your Windows 10 device
to see your own dashboards from anywhere.

1. In the Power BI service, tap Sign up to create a Power BI account.
2. Start creating your own dashboards and reports.

1. On the Start screen of your Windows 10 device, open the Power BI app.

2. To view your Power BI dashboards and reports, tap Power BI. Sign in with the same credentials as your
Power BI account on the web.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/mobile-windows-10-phone-app-get-started.md
http://go.microsoft.com/fwlink/?LinkID=526478
http://powerbi.com/
http://go.microsoft.com/fwlink/?LinkID=513879


Try the Power BI and Reporting Services samples

Power BI samplesPower BI samples

3. Tap Start exploring to view your own dashboards.

To view your Reporting Services mobile reports and KPIs, tap SQL Server 2016 Reporting Services. Sign
in with your SQL Server Reporting Services credentials.

Even without signing up, you can play with the Power BI and Reporting Services samples. After you download the
app, you can view the samples or get started. Go back to the samples whenever you want from the dashboards
home page.

You can view and interact with the Power BI dashboard samples, but there are a few things you can't do with
them. You can't open the reports behind the dashboards, share the samples with others, or make them your
favorites.

1. Tap the global navigation button  in the upper-left corner.

2. Tap Settings icon , tap your name, then tap View samples.

3. Pick a role and explore the sample dashboard for that role.



Reporting Services mobile report samplesReporting Services mobile report samples

Search for dashboards, reports, and apps

1. Tap the global navigation button  in the upper-left corner.

2. Tap Settings icon , right-click or tap and hold Connect to server, then tap View samples.

3. Open the Retail Reports or Sales Reports folder to explore their KPIs and mobile reports.

Find your dashboards, reports, and apps quickly by typing in the search box, always at the top of the app.

1. Tap the search icon in the upper-right corner.



Find your content in the Power BI mobile apps

Power BI displays your most recent dashboards, reports, and apps.

2. As you start typing, Power BI displays all relevant results.

Your dashboards and reports are stored in different locations in the Power BI mobile apps, depending on where
they came from. Read about finding your content in the mobile apps. Plus you can always search for anything you
have in the Power BI mobile apps.



View your favorite dashboards, KPIs, and reports
You can view all of your favorite Power BI dashboards, together with Reporting Services KPIs and mobile reports,
on the Favorites page in the mobile apps. When you make a dashboard a favorite in the Power BI mobile app, you
can access it from all of your devices, including the Power BI service in your browser.

Tap Favorites.

Your Power BI favorites and your favorites from the Reporting Services web portal are all on this page.



Next steps

Power BI dashboards and reportsPower BI dashboards and reports

Reporting Services mobile reports and KPIsReporting Services mobile reports and KPIs

Next steps

Read more about favorites in the Power BI mobile apps.

Here are some other things you can do in the Power BI app for Windows 10 devices with dashboards and reports
in Power BI, and Reporting Services mobile reports and KPIs in the Reporting Services web portal

View your apps.
View your dashboards.
Pin Power BI tiles and dashboards to your device's Start screen as live tiles.
Share tiles.
Share dashboards.

View Reporting Services mobile reports and KPIs in the Power BI app for Windows 10 devices.
Create KPIs on the Reporting Services web portal.
Create your own mobile reports with the SQL Server Mobile Report Publisher, and publish them to the
Reporting Services web portal.

Download the Power BI app from the Windows Store
Get started with Power BI
Questions? Try asking the Power BI Community

https://docs.microsoft.com/en-us/power-bi/mobile-share-tile-windows-10-phone-app
https://msdn.microsoft.com/library/mt683632.aspx
https://msdn.microsoft.com/library/mt652547.aspx
http://go.microsoft.com/fwlink/?LinkID=526478
http://community.powerbi.com/


View Reporting Services (SSRS) mobile reports and
KPIs in the Windows 10 Power BI mobile app
11/15/2017 • 2 min to read • Edit Online

First things first

NOTENOTE

Explore samples without a SQL Server 2016 Reporting Services server

The Power BI mobile app for Windows 10 offers live, touch-enabled mobile access to your important on-premises
business information in SQL Server 2016 Reporting Services.

Create Reporting Services mobile reports with SQL Server 2016 Enterprise Edition Mobile Report Publisher and
publish them to the Reporting Services web portal. Create KPIs right in the web portal. Organize them in folders
and mark your favorites, so you can find them easily.

Then in the Power BI mobile app for Windows 10, view the mobile reports and KPIs, organized in folders or
collected as favorites.

Your device needs to be running Windows 10. The app works best on devices with at least 1 GB RAM and 8 GB internal
storage.

Even if you don't have access to a Reporting Services web portal, you can still explore the features of Reporting
Services mobile reports.

1. In your Windows 10 device, open the Power BI app.

2. Tap the global navigation button  in the upper-left corner.

3. Tap Settings icon , right-click or tap and hold Connect to server, then tap View samples.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/mobile-app-windows-10-ssrs-kpis-mobile-reports.md
https://msdn.microsoft.com/library/mt652547.aspx
https://msdn.microsoft.com/library/mt637133.aspx


Connect to a Reporting Services report server

4. Open the Retail Reports or Sales Reports folder to explore their KPIs and mobile reports.

Browse the samples to interact with KPIs and mobile reports.

1. At the bottom of the left navigation bar, tap Settings 
2. Tap Connect to server.

NOTENOTE

3. Fill in the server address and your user name and password. Use this format for the server address:

http://<servername>/reports  OR https://<servername>/reports

Include http or https at the beginning of the connection string.

Tap Advanced option to give the server a name, if you'd like.

4. Tap the check mark to connect.

Now you see the server in the left navigation bar.



View Reporting Services KPIs and mobile reports in the Power BI app

TIPTIP

Tap the global navigation button  anytime to go between your Reporting Services mobile reports and your
dashboards in the Power BI service.

Reporting Services KPIs and mobile reports are displayed in the same folders they're in on the Reporting Services
web portal.

Tap a KPI to see it in focus mode.



View your favorite KPIs and reports

Tap a mobile report to open and interact with it in the Power BI app.

You can mark KPIs and mobile reports as favorites on your Reporting Services web portal, and then view them in
one convenient folder on your Windows 10 device, along with your Power BI favorite dashboards and reports.

Tap Favorites.

Your favorites from the web portal are all on this page.



Remove a connection to a report server

Create Reporting Services mobile reports and KPIs

Next steps

Read more about favorites in the Power BI mobile apps.

You can only be connected to one report server at a time from your Power BI mobile app. If you want to connect to
a different server, you need to disconnect from the current one.

1. At the bottom of the left navigation bar, tap Settings .
2. Tap and hold the server name you don't want to be connected to.
3. Tap Remove server.

You don't create Reporting Services KPIs and mobile reports in the Power BI mobile app. You create them in SQL
Server Mobile Report Publisher and a SQL Server 2016 Reporting Services web portal.

Create your own Reporting Services mobile reports, and publish them to a Reporting Services web portal.
Create KPIs on a Reporting Services web portal

Get started with the Power BI mobile app for Windows 10
Get started with Power BI
Questions? Try asking the Power BI Community

https://msdn.microsoft.com/library/mt652547.aspx
https://msdn.microsoft.com/library/mt683632.aspx
http://community.powerbi.com/


Pin a dashboard to your Windows 10 Start screen
from the Power BI mobile app
1/26/2018 • 1 min to read • Edit Online

Pin a dashboard to your Start screen as a live tile

You can pin Power BI dashboards to the Windows Start screen from the Power BI mobile app for Windows 10.
They become live tiles. When you tap the tile on the Start screen, the dashboard opens in the Power BI mobile app
for Windows 10.

1. Open a dashboard.

2. Tap Pin to Start .

Go to your device Start screen to see the live tile.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/mobile-pin-dashboard-start-screen-windows-10-phone-app.md


Next steps
Download the Power BI mobile app for Windows 10 from the Windows Store
Get started with the Power BI mobile app for Windows 10
Get started with Power BI
Questions? Try asking the Power BI Community

http://go.microsoft.com/fwlink/?LinkID=526478
http://community.powerbi.com/


View reports in presentation mode on Surface Hub
and Windows 10 - Power BI
11/9/2017 • 2 min to read • Edit Online

NOTENOTE

Display dashboards, reports, and tiles in full-screen mode

You can display reports in presentation mode on Surface Hub, and display dashboards, reports, and tiles in full-
screen mode on Windows 10 devices.

Presentation and full-screen modes are useful for displaying Power BI at a meeting or conference, or on a
dedicated projector in an office, or even just for maximizing space on a small screen.

In full-screen mode in the Power BI mobile app, all the "chrome" such as the navigation and menu bars is removed,
except the page tabs and filter pane in reports.

When you display a report in presentation mode on Surface Hub, you can draw on the pages with different colors
of ink and navigate between the pages of the report.

You can also display dashboards and reports in full-screen mode from the Power BI service on the web.

Presentation mode is different from focus mode for tiles.

1. In the Power BI mobile app on a dashboard, report, or tile, tap the Full screen icon  to go to full-screen
mode.

2. In presentation mode, you can filter a report, or search for other dashboards and reports.

Expand the Filters pane to set or remove filters.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/mobile-windows-10-app-presentation-mode.md


Turn on presentation mode for Surface Hub

3. To exit full-screen mode, tap the icon with two inward-facing arrows  on the toolbar, or swipe down from
the top and tap the two inward-facing arrows .

Tap the search icon  to look for other dashboards.

Presentation mode is on by default in Surface Hub, but if it's turned off, you can turn it back on.

1. Tap the Settings icon  at the bottom of the left navigation bar.
2. Tap Options, then slide Enable Microsoft Surface Hub presentation mode to On.



Display and draw on reports on Surface Hub

2. On devices that support writing with a pen, you can start writing immediately.

4. Tap the eraser or the undo arrow to remove some or all of the ink.
5. Tap the circular arrow to refresh the report content.

7. To exit full-screen mode, swipe down from the top and tap the two inward-facing arrows .

1. In a report, tap the Full screen icon  to go to Surface Hub presentation mode.

You see a collapsible action bar on both sides of the screen.

To open it, swipe in or tap the handle.
To close it, swipe out or tap the X at the top.

3. To change the ink color, tap the pen in the left or right action bar.

6. Tap the sideways arrows to go to other pages in the report.



Next steps
Display dashboards and reports in full-screen mode from the Power BI service
Questions? Try asking the Power BI Community

http://community.powerbi.com/


What can developers do with Power BI?
1/30/2018 • 1 min to read • Edit Online

Embedding

Custom visuals

Power BI offers a wide range of options for developers. This ranges from embedding to custom visuals and
streaming datasets.

The Power BI service and Power BI Embedded in Azure are coming together to offer a single API for embedding
your dashboards and reports. This means you will have one API surface, a consistent set of capabilities and access
to the latest Power BI features – such as dashboards, gateways and app workspaces – when embedding your
content. For more information, see Embedding with Power BI.

Custom visuals allow you to create your own visuals for use within Power BI reports. Custom visuals are written in
TypeScript which is a superset of JavaScript that supports some advanced features and early access to ES6/ES7
functionality. Visual styling is handled using cascading styles sheets (css). For your convinence, we use the Less pre-
compiler which supports some advanced features such as nesting, variables, mixins, conditions, loops, etc. If you
don't want to use any of those features, you can just write plain css in the less file.

For more information about how to develop and publish a custom visual, see Publish custom visuals to the Office
store.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/developer/what-can-you-do.md
https://docs.microsoft.com/en-us/power-bi/developer/office-store


Push data into Power BI

Next steps

You can use the Power BI API to push data into a dataset. This allows you to add a row to a table within a dataset.
The new data can then be reflected in tiles on a dashboard and within visuals within your report.

For more information, see Push data into a dashboard

Embedding with Power BI
How to migrate Power BI Embedded workspace collection content to Power BI
JavaScript API Git repo
Power BI C# Git repo
Publish custom visuals to the Office store
Power BI Visuals Git repo
JavaScript embed sample
Power BI Premium whitepaper
More questions? Try the Power BI Community

https://github.com/Microsoft/PowerBI-JavaScript
https://github.com/Microsoft/PowerBI-CSharp
https://docs.microsoft.com/en-us/power-bi/developer/office-store
https://github.com/Microsoft/PowerBI-visuals
https://microsoft.github.io/PowerBI-JavaScript/demo/
https://aka.ms/pbipremiumwhitepaper
http://community.powerbi.com/


What can developers do with Power BI?
1/30/2018 • 1 min to read • Edit Online

TO DO THIS GO HERE

Embed dashboards, reports and tiles for Power BI users and
Non-Power BI users (app owns data)

How to embed your Power BI dashboards, reports and tiles

Extend an existing business workflow to push key data into a
Power BI dashboard.

Push data into a dashboard

Import a Power BI Desktop file Import PBIX File

Authenticate to Power BI. Authenticate to Power BI

Create a custom visual. Use developer tools to create custom visuals

NOTENOTE

Power BI Developer Samples

GitHub repositories

Developer tools

Power BI displays dashboards that are interactive, and can be created and updated from many different data
sources in real time. Using any programming language that supports REST calls, you can create apps that integrate
with a Power BI dashboard in real-time. You can also integrate Power BI tiles and reports into apps.

Developers can also build their own data visualizations that can be used in interactive reports and dashboards.

Here are some of the things you can do with the Power BI APIs.

The Power BI APIs still refer to app workspaces as groups. Any references to groups mean that you are working with app
workspaces.

The Power BI Developer samples include items for embedding dashboards, reports and tiles.

Power BI Developer samples

Samples within App Owns Data are for embedding with non-Power BI users.
Samples within User Owns Data are for embedding with Power BI users.

.NET SDK
JavaScript API
Custom Visuals

The following are tools you can use to aid in your development of Power BI items.

JavaScript embed sample

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/developer/overview-of-power-bi-rest-api.md
https://msdn.microsoft.com/library/mt243837.aspx
https://github.com/Microsoft/PowerBI-Developer-Samples
https://github.com/Microsoft/PowerBI-CSharp
https://github.com/Microsoft/PowerBI-JavaScript
https://github.com/Microsoft/PowerBI-visuals
https://microsoft.github.io/PowerBI-JavaScript/demo


Next steps
Push data into a dataset
Getting started with custom visuals developer tools Power BI REST API reference

More questions? Try asking the Power BI Community

https://msdn.microsoft.com/library/mt147898.aspx
http://community.powerbi.com/


Embedding with Power BI
1/30/2018 • 3 min to read • Edit Online

A single API

Embedding for your organization

Embedding for your customers

Power BI offers APIs for embedding your dashboards and reports into applications. The Power BI APIs offer a
consistent set of capabilities and access to the latest Power BI features – such as dashboards, gateways and app
workspaces – when embedding content.

There are two main scenarios when embedding Power BI content. Embedding for users in your organization (who
have licenses for Power BI) and embedding for your users and customers without requiring them to have Power
BI licenses. The Power BI REST API allows for both scenarios.

For customers and users without Power BI licenses, you can embed dashboards and reports into your custom
application, using the same API to either service your organization or your customers. Your customers see the
data that is managed by the application. And for Power BI users in your organization, they'll have the additional
options to view their own data directly in Power BI or in the context of the embedded application. You can take full
advantage of the JavaScript and REST APIs for your embedding needs.

To view a sample of how embedding works, see the JavaScript embed sample.

Embedding for your organization allows you to extend the Power BI service. This requires that users of your
application sign into the Power BI service when they want to view their content. Once someone in your
organization signs in, they will only have access to dashboards and reports that they own or that have been
shared with them in the Power BI service.

Examples of embedding for your organization include internal web application, the SharePoint Online web part
and Microsoft Teams integration.

For embedding for your organization, see the following:

Integrate a dashboard into an app
Integrate a tile into an app
Integrate a report into an app

Self-service capabilities, such as edit, save and more, are available through the JavaScript API when embedding for
Power BI users.

Embedding for your customers provides the ability to embed dashboards and reports to users who don't have an
account for Power BI. Your customers don't need to know anything about Power BI. At least one Power BI Pro
account is needed to create an embedded application. The Power BI Pro account acts as a master account for your
application. Think of this as a proxy account. The Power BI Pro account also allows you to generate embed tokens
that provide access to dashboards and reports within the Power BI service that are owned/managed by your
application.

An example of embedding for your customers is an ISV application being sold to other companies.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/developer/embedding.md
https://microsoft.github.io/PowerBI-JavaScript/demo/
https://github.com/Microsoft/PowerBI-JavaScript


IMPORTANTIMPORTANT

Next steps

To embed dashboards, reports and tiles, you would use the same APIs that you would use for embedding for your
organization.

While embedding has a dependency on the Power BI service, there is not a dependency on Power BI for your customers.
They do not need to sign up for Power BI to view the embedded content in your application.

When you are ready to move to production, your app workspace must be assigned to a capacity. Power BI
Embedded, within Microsoft Azure, offers capacity to use with your applications.

For details on how to embed, see How to embed your Power BI dashboards, reports and tiles.

If you were using the Power BI Workspace Collections service within Azure, see Migrate content from the Power BI
Workspace Collections Azure service for information on how to migrate your content over.

How to embed your Power BI dashboards, reports and tiles
How to migrate Power BI Embedded workspace collection content to Power BI
Power BI Premium - what is it?
JavaScript API Git repo
Power BI C# Git repo
JavaScript embed sample
Embedded analytics capacity planning whitepaper
Power BI Premium whitepaper

https://github.com/Microsoft/PowerBI-JavaScript
https://github.com/Microsoft/PowerBI-CSharp
https://microsoft.github.io/PowerBI-JavaScript/demo/
https://aka.ms/pbiewhitepaper
https://aka.ms/pbipremiumwhitepaper


More questions? Try asking the Power BI Community

http://community.powerbi.com/


  

  

Embed your Power BI dashboards, reports and tiles
1/30/2018 • 9 min to read • Edit Online

NOTENOTE

Step 1: Setup your embedded analytics development environment

NOTENOTE

Azure Active Directory tenantAzure Active Directory tenant

Create a Power BI Pro user accountCreate a Power BI Pro user account

Learn about the steps you need to take to embed Power BI content within your application.

Microsoft announced Power BI Premium, a new capacity-based licensing model that increases flexibility for how
users access, share and distribute content. The offering also delivers additional scalability and performance to the
Power BI service. Power BI Embedded was also announced that allows for creating capacity within Microsoft
Azure. Power BI Embedded is focused on your application and your customers.

This article will look at embedding your Power BI content for both your organization and your customers. The
steps are similar between the two scenarios. Callouts will be made when a step is specific to embedding for your
customer.

There are a few steps you have to do with your application to make this possible. We will go through the steps
needed to allow you to create and use embedded content within your application.

The Power BI APIs still refer to app workspaces as groups. Any references to groups mean that you are working with app
workspaces.

Before you start embedding dashboards and reports into your application, you need to make sure your
environment is setup to allow for embedding. As part of the setup, you will need to do the following.

Make sure you have an Azure Active Directory tenant
Create your Power BI Pro account
Register your Azure Active Directory application and permissions

Power BI capacity is not required for development of your application. The developers of the application will need to have a
Power BI Pro license.

You will need an Azure Active Directory (Azure AD) tenant in order to embed items from Power BI. This tenant
must have at least one Power BI Pro user. You will also need to define an Azure AD app within the tenant. You can
make use of an existing Azure AD tenant or create a new one specifically for embedding purposes.

You will need to determine what tenant setup to use if you are embedding for your customers.

Use your existing corporate Power BI tenant?
Use a separate tenant for your application?
Use a separate tenant for each customer?

If you do not want to use an existing tenant, you can decide to create a new tenant for your application, or one for
each customer, see Create an Azure Active Directory tenant or How to get an Azure Active Directory tenant.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/developer/embedding-content.md
https://powerbi.microsoft.com/blog/microsoft-accelerates-modern-bi-adoption-with-power-bi-premium/
https://docs.microsoft.com/azure/active-directory/develop/active-directory-howto-tenant


  

An organization/tenant admin userAn organization/tenant admin user

Accounts for analysts that will create contentAccounts for analysts that will create content

An application An application mastermaster user account for embedding for your customers user account for embedding for your customers

App registration and permissionsApp registration and permissions

Create app workspacesCreate app workspaces

You only need a single Power BI Pro account to embed content. However, you may want to have a few different
users that have specific access to items. Here is a look at possible users to consider within your tenant.

The following accounts will need to exist within your tenant and have a Power BI Pro license assigned to them. A
Power BI Pro license is required to work with app workspaces within Power BI.

It is recommended that your organization/tenant Global Admin user should not be used as account your
application uses if embedding for your customers. This is to minimize access that the application account has
within your tenant. It is recommended that the admin user be an admin of all app workspaces created for the
purpose of embedding.

You may have multiple users that create content for Power BI. You will need a Power BI Pro account for each
analyst that is creating and deploying content to Power BI.

The master account is the account your application will use when embedding content for your customers. The
scenario is typically for ISV applications. The master account is really the only required account you need within
your organization. It can also be used as the admin and analyst account, but it is not recommended. Your
application's backend will store the credentials for this account and use it for acquiring an Azure AD auth token for
use with the Power BI APIs. This account will be used to generate an embed token for the application to use for
your customers.

The master account is just a regular user with a Power BI Pro license that you use with your application. The
account must be an admin of the app workspace that is being used for embedding.

You will need to register your application with Azure AD in order to make REST API calls. For more information,
see Register an Azure AD app to embed Power BI content.

If you are embedding dashboards and reports for your customers, those dashboards and reports have to be
placed within an app workspace. The master account, that was mentioned above, must be an admin of the app
workspace.

1. Start by creating the workspace. Select Workspaces > Create app workspace.

This will be the place to put content that you and your colleagues collaborate on.



2. Give the workspace a name. If the corresponding Workspace ID isn't available, edit it to come up with a
unique ID.

This will be the name of the app, too.

3. You have a few options to set. If you choose Public, anyone in your organization can see what’s in the
workspace. Private, on the other hand, means only members of the workspace can see its contents.

You can't change the Public/Private setting after you've created the group.

4. You can also choose if members can edit or have view-only access.

Only add people to the app workspace so they can edit the content. If they're only going to view the
content, don't add them to the workspace. You can include them when you publish the app.

5. Add email addresses of people you want to have access to the workspace, and select Add. You can’t add
group aliases, just individuals.

6. Decide whether each person is a member or an admin.

Admins can edit the workspace itself, including adding other members. Members can edit the content in
the workspace, unless they have view-only access. Both admins and members can publish the app.

7. Select Save.

Power BI creates the workspace and opens it. It appears in the list of workspaces you’re a member of. Because
you’re an admin, you can select the ellipsis (…) to go back and make changes to it, adding new members or



 

Create and upload your reportsCreate and upload your reports

Step 2: Embed your content

Step 3: Promote your solution to production

Embedding for your organizationEmbedding for your organization

CAPACITY NODE

TOTAL CORES
(BACKEND +
FRONTEND) BACKEND CORES FRONTEND CORES

DIRECTQUERY/LIV
E CONNECTION
LIMITS

MAX PAGE
RENDERS AT PEAK
HOUR

EM3 4 v-cores 2 cores, 10GB
RAM

2 cores 601-1,200

P1 8 v-cores 4 cores, 25GB
RAM

4 cores 30 per second 1,201-2,400

changing their permissions.

You can create your reports and datasets using Power BI Desktop and then publish those reports to an app
workspace. The end user publishing the reports need to have a Power BI Pro license in order to publish to an app
workspace.

Within your application, you will need to authenticate with Power BI. If you are embedding content for your
customers, you will store the credentials for the master account within your application. For more information, see
Authenticate users and get an Azure AD access token for your Power BI app.

Once authenticated, within your application, use the Power BI REST APIs and JavaScript APIs to embed dashboards
and reports into your application.

For embedding for your organization, see the following walkthroughs:

Integrate a dashboard into an app
Integrate a tile into an app
Integrate a report into an app

For embeding with your customers, which is typical for ISVs, see the following:

Integrate a dashboard, tile, or report into your application

When embedding for your customers, an embed token is required. To learn more see, GenerateToken.

Moving to production requires a few extra steps.

If you are embedding for your organization, you only need to let people know how to get to your application.

Free users can consume content that is embedded from an app workspace (group), if that workspace is backed by
capacity. List the Free user as a member of app workspace (group), otherwise you receive a 401 unauthorized
error. The following table lists the available Power BI Premium SKUs available within Office 365.

https://msdn.microsoft.com/library/mt784614.aspx


P2 16 v-cores 8 cores, 50GB
RAM

8 cores 60 per second 2,401-4,800

P3 32 v-cores 16 cores, 100GB
RAM

16 cores 120 per second 4,801-9600
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TOTAL CORES
(BACKEND +
FRONTEND) BACKEND CORES FRONTEND CORES

DIRECTQUERY/LIV
E CONNECTION
LIMITS

MAX PAGE
RENDERS AT PEAK
HOUR

NOTENOTE

Embedding for your customersEmbedding for your customers

IMPORTANTIMPORTANT

CAPACITY NODE

TOTAL CORES
(BACKEND +
FRONTEND) BACKEND CORES FRONTEND CORES

DIRECTQUERY/LIV
E CONNECTION
LIMITS

MAX PAGE
RENDERS AT PEAK
HOUR

A1 1 v-cores .5 cores, 3GB
RAM

.5 cores 5 per second 1-300

A2 2 v-cores 1 core, 5GB RAM 1 core 10 per second 301-600

A3 4 v-cores 2 cores, 10GB
RAM

2 cores 15 per second 601-1,200

A4 8 v-cores 4 cores, 25GB
RAM

4 cores 30 per second 1,201-2,400

A5 16 v-cores 8 cores, 50GB
RAM

8 cores 60 per second 2,401-4,800

A6 32 v-cores 16 cores, 100GB
RAM

16 cores 120 per second 4,801-9600

You must be a Global or Billing Admin, within your tenant, in order to purchase Power BI Premium. For information on how
to purchase Power BI Premium, see How to purchase Power BI Premium.

If you are embedding for your customers, do the following.

If you are using a separate tenant for development, then you must make sure your app workspaces, along with
dashboards and reports, are available in your production environment. Make sure that you create the
application in Azure AD for your production tenant and assign the proper app permissions as indicated in Step
1.
Purchase a capacity that fits your needs. You can use the table below to understand which Power BI Embedded
capacity SKU you may need. For more details, see Embedded analytics capacity planning whitepaper. When
you are ready to purchase, you can do so within the Microsoft Azure portal. For details on how to create Power
BI Embedded capacity, see Create Power BI Embedded capacity in the Azure portal.

Because embed tokens are intended for development testing only, the number of embed tokens a Power BI master account
can generate is limited. A capacity must be purchased for production embedding scenarios. There is no limit to embed token
generation when a capacity is purchased.

https://aka.ms/pbiewhitepaper
https://portal.azure.com
https://docs.microsoft.com/azure/power-bi-embedded/create-capacity
https://docs.microsoft.com/power-bi/developer/embedded-faq#technical


Admin settings

Next steps

Edit the app workspace and assign it to a capacity under advanced.

Deploy your updated application to production and begin embedding Power BI dashboards and reports.

Global Admins, or Power BI service administrators, can turn the ability to use the REST APIs, on or off for a tenant.
Power BI admins can set this setting for the entire organization, or for individual security groups. It is enabled for
the entire organization by default. This is done through the Power BI admin portal.

Embedding with Power BI
How to migrate Power BI Embedded workspace collection content to Power BI
Power BI Premium - what is it?
How to purchase Power BI Premium
JavaScript API Git repo
Power BI C# Git repo
JavaScript embed sample
Embedded analytics capacity planning whitepaper
Power BI Premium whitepaper

More questions? Try asking the Power BI Community

https://github.com/Microsoft/PowerBI-JavaScript
https://github.com/Microsoft/PowerBI-CSharp
https://microsoft.github.io/PowerBI-JavaScript/demo/
https://aka.ms/pbiewhitepaper
https://aka.ms/pbipremiumwhitepaper
http://community.powerbi.com/
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IMPORTANTIMPORTANT

Prepare for the migration

Learn how to migrate from Power BI Embedded to the Power BI service and leverage advances for embedding in apps.

Microsoft recently announced Power BI Premium, a new capacity-based licensing model that increases flexibility for how users
access, share and distribute content. The offering also delivers additional scalability and performance to the Power BI service.

With the introduction of Power BI Premium, Power BI Embedded and the Power BI service are converging to advance how
Power BI content is embedded in apps. This means you will have one API surface, a consistent set of capabilities and access to
the latest Power BI features – such as dashboards, gateways and app workspaces – when embedding your content. Moving
forward you’ll be able to start with Power BI Desktop and move to deployment with Power BI Premium, which will be generally
available late in the second quarter of 2017.

The current Power BI Embedded service will continue to be available for a limited time following general availability of the
converged offering: customers under an Enterprise Agreement will have access to through the expiration of their existing
agreements; customers that acquired Power BI Embedded through Direct or CSP channels will enjoy access for one year from
General Availability of Power BI Premium. This article will provide some guidance for migrating from the Azure service to the
Power BI service and what to expect for changes in your application.

While the migration will take a dependency on the Power BI service, there is not a dependency on Power BI for the users of your application
when using an embed token. They do not need to sign up for Power BI to view the embedded content in your application. You can use
this embedding approach to service non-Power BI users.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/developer/migrate-from-powerbi-embedded.md
https://powerbi.microsoft.com/blog/microsoft-accelerates-modern-bi-adoption-with-power-bi-premium/


Accounts within Azure AD

NOTENOTE

App registration and permissions

Register an applicationRegister an application

Create App workspaces (Required)

IMPORTANTIMPORTANT

There are a few things you need to do to prepare for migrating from Power BI Embedded Azure service over to the Power BI
service. You will need a tenant available, along with a user that has a Power BI Pro license.

2. Create a user within this new tenant that will act as your application "master" account. That account needs to sign up for
Power BI and needs to have a Power BI Pro license assigned to it.

1. Make sure you have access to an Azure Active Directory (Azure AD) tenant.

You will need to determine what tenant setup to use.

Use your existing corporate Power BI tenant?
Use a separate tenant for your application?
Use a separate tenant for each customer?

If you decide to create a new tenant for your application, or each customer, see Create an Azure Active Directory
tenant or How to get an Azure Active Directory tenant.

The following accounts will need to exist within your tenant.

These accounts will need to have Power BI Pro licenses in order to use App workspaces.

NOTENOTE

1. A tenant admin user.

It is recommended that this user be a member of all App workspaces created for the purpose of embedding.

2. Accounts for analysts that will create content.

These users should be assigned to App workspaces as needed.

3. An application master user account, or service account.

The applications backend will store the credentials for this account and use it for acquiring an Azure AD token for use
with the Power BI REST APIs. This account will be used to generate the embed token for the application. This account also
needs to be an admin of the App workspaces created for embedding.

This is just a regular user account in your organziation that will be used for the purposes of embedding.

You will need to register an application within Azure AD and grant certain permissions.

You will need to register your application with Azure AD in order to make REST API calls. This includes going to the Azure portal
to apply additional configuration in addition to the Power BI app registration page. For more information, see Register an Azure
AD app to embed Power BI content.

You should register the application using the application master account.

You can take advantage of App workspaces to provide better isoliation if your application is servicing multiple customers.
Dashboards and reports would be isolated between your customers. You could then use a Power BI account per App workspace
to further isolate application experiences between your customers.

You cannot use a personal workspace to take advantage of embedding to non-Power BI users.

https://docs.microsoft.com/azure/active-directory/develop/active-directory-howto-tenant


 

NOTENOTE

Content migration

Report typesReport types

Cached dataset & reportCached dataset & report

DirectQuery dataset & reportDirectQuery dataset & report

Old dataset & reportsOld dataset & reports

Push Dataset & reportPush Dataset & report

You will need a user that has a Pro license in order to create an app workspace within Power BI. The Power BI user that creates
the App workspace will be an admin of that workspace by default.

The application master account needs to be an admin of the workspace.

Migrating your content from your workspace collections to the Power BI service can be done in parallel to your current solution
and doesn’t require any downtime.

A migration tool is available for you to use in order to assist with copying content from Power BI Embedded to the Power BI
service. Especially if you have a lot of content. For more information, see Power BI Embedded migration tool.

Content migration relies mainly on two APIs.

1. Download PBIX - this API can download PBIX files which were uploaded to Power BI after October 2016.
2. Import PBIX - this API uploads any PBIX to Power BI.

For some related code snippets, see Code snippets for migrating content from Power BI Embedded.

There are several types of reports, each requiring a somewhat different migration flow.

Cached datasets refer to PBIX files that had imported data as opposed to a live connection or DirectQuery connection.

Flow

1. Call Download PBIX API from PaaS workspace.
2. Save PBIX.
3. Call Import PBIX to SaaS workspace.

Flow

1. Call GET
https://api.powerbi.com/v1.0/collections/{collection_id}/workspaces/{wid}/datasets/{dataset_id}/Default.GetBoundGatewayDataSources
and save connection string received.

2. Call Download PBIX API from PaaS workspace.
3. Save PBIX.
4. Call Import PBIX to SaaS workspace.
5. Update connection string by calling - POST

https://api.powerbi.com/v1.0/myorg/datasets/{dataset_id}/Default.SetAllConnections
6. Get GW id and datasource id by calling - GET

https://api.powerbi.com/v1.0/myorg/datasets/{dataset_id}/Default.GetBoundGatewayDataSources
7. Update user's credentials by calling - PATCH

https://api.powerbi.com/v1.0/myorg/gateways/{gateway_id}/datasources/{datasource_id}

These are datasets/reports created before October 2016. Download PBIX doesn't support PBIXs which were uploaded before
October 2016

Flow

1. Get PBIX from your development environment (your internal source control).
2. Call Import PBIX to SaaS workspace.

Download PBIX doesn't support Push API datasets. Push API dataset data can't be ported from PaaS to SaaS.

Flow



Create and upload new reports

Rebuild your application

Map your users to a Power BI user

What to do when you are ready for production

After migration

1. Call "Create dataset" API with dataset Json to create dataset in SaaS workspace.
2. Rebuild report for the created dataset*.

It is possible using some workarounds to migrate the push api report from PaaS to SaaS by trying the following.

1. Uploading some dummy PBIX to PaaS workspace.
2. Clone the push api report and bind it to the dummy PBIX from step 1.
3. Download push API report with the dummy PBIX.
4. Upload dummy PBIX to your SaaS workspace.
5. Create push dataset in your SaaS workspace.
6. Rebind report to push api dataset.

In addition to the content you migrated from the Power BI Embedded Azure service, you can create your reports and datasets
using Power BI Desktop and then publish those reports to an app workspace. The end user publishing the reports need to have
a Power BI Pro license in order to publish to an app workspace.

1. You will need to modify your application to use the Power BI REST APIs and the report location inside powerbi.com.
2. Rebuild your AuthN/AuthZ authentication using the master account for your application. You can take advantage of using an

embed token to allow this user to act on behalf of other users.
3. Embed your reports from powerbi.com into your application.

Within your application, you will map users that you manage within the application to a master Power BI credential for the
purposes of your application. The credentials for this Power BI master account will be stored within your application and be
used to creating embed tokens.

When you are ready to move to production, you will need to do the following.

If you are using a separate tenant for development, then you will need to make sure your app workspaces, along with
dashboards and reports, are available in your production environment. You will also need to make sure that you created the
application in Azure AD for your production tenant and assigned the proper app permissions as indicated in Step 1.
Purchase a capacity that fits your needs. To better understand how the amount and type of capacity you neeed, see the
Embedded analytics capacity planning whitepaper. You can purchase capacity in Azure.
Edit the App workspace and assign it to a Premium capacity under advanced.

Deploy your updated application to production and begin embedding reports from the Power BI service.

https://msdn.microsoft.com/library/mt784614.aspx
https://aka.ms/pbiewhitepaper
https://portal.azure.com/#create/Microsoft.PowerBIDedicated


Next steps

You should do some cleanup within Azure.

Remove all workspaces off of the deployed solution within the Azure service of Power BI Embedded.
Delete any Workspace Collections that exist within Azure.

Embedding with Power BI
Power BI Embedded migration tool
Code snippets for migrating content from Power BI Embedded
How to embed your Power BI dashboards, reports and tiles
Power BI Premium - what is it?
JavaScript API Git repo
Power BI C# Git repo
JavaScript embed sample
Embedded analytics capacity planning whitepaper
Power BI Premium whitepaper

More questions? Try asking the Power BI Community

https://github.com/Microsoft/PowerBI-JavaScript
https://github.com/Microsoft/PowerBI-CSharp
https://microsoft.github.io/PowerBI-JavaScript/demo/
https://aka.ms/pbiewhitepaper
https://aka.ms/pbipremiumwhitepaper
http://community.powerbi.com/


Integrate a dashboard into an app for your
organization
1/30/2018 • 7 min to read • Edit Online

NOTENOTE

Download the sample

Step 1 - register an app in Azure AD

Learn how to integrate, or embed, a dashboard into a web app using REST API calls along with the Power BI
JavaScript API when embedding for your organization.

To get started with this walkthrough, you need a Power BI account. If you don't have an account, you can sign up
for a free Power BI account, or you can create your own Azure Active Directory tenant for testing purposes.

Looking to embed a dashboard for your customers, using an embedtoken, instead? See, Integrate a dashboard, tile, or
report into your application for your customers.

To integrate a dashboard into a web app, you use the Power BI REST API, or the Power BI C# SDK, and an Azure
Active Directory (AD) authorization access token to get a dashboard. Then, you load the dashboard using the
same access token. The Power BI API provides programmatic access to certain Power BI resources. For more
information, see Overview of Power BI REST API and the Power BI JavaScript API.

This article shows the code used in the integrate-dashboard-web-app on GitHub. To follow along with this
walkthrough, you can download the sample.

You will need to register your application with Azure AD in order to make REST API calls. For more information,
see Register an Azure AD app to embed Power BI content.

If you downloaded the Integrate a dashboard sample, you use the Client ID and Client Secret you get, after
registration, so that the sample can authenticate to Azure AD. To configure the sample, change the Client ID and
Client Secret in the cloud.config file.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/developer/integrate-dashboard.md
https://msdn.microsoft.com/library/dn877544.aspx
https://github.com/Microsoft/PowerBI-JavaScript
https://github.com/Microsoft/PowerBI-Developer-Samples/tree/master/User Owns Data/integrate-dashboard-web-app
https://github.com/Microsoft/PowerBI-Developer-Samples/tree/master/User Owns Data/integrate-dashboard-web-app


Step 2 - get an access token from Azure AD

Step 3 - get a dashboard

Get dashboards using an access tokenGet dashboards using an access token

Get dashboards with the REST APIGet dashboards with the REST API

Within your application, you will first need to get an access token, from Azure AD, before you can make calls to
the Power BI REST API. For more information, see Authenticate users and get an Azure AD access token for your
Power BI app.

To get a Power BI dashboard, you use the Get Dashboards operation which gets a list of Power BI dashboards.
From the list of dashboards, you can get a dashboard id.

With the access token you retrieved in step 2, you can call the Get Dashboards operation. The Get Dashboards
operation returns a list of dashboards. You can get a single dashboard from the list of dashboards. Below is a
complete C# method to get a dashboard.

To make the REST API call, you must include an Authorization header in the format of Bearer {access token}.

Default.aspx.cs

https://msdn.microsoft.com/library/mt465739.aspx
https://msdn.microsoft.com/library/mt465739.aspx
https://msdn.microsoft.com/library/mt465739.aspx


protected void getDashboardsButton_Click(object sender, EventArgs e)
{
    string responseContent = string.Empty;

    //Configure dashboards request
    System.Net.WebRequest request = System.Net.WebRequest.Create(String.Format("{0}dashboards", baseUri)) as 
System.Net.HttpWebRequest;
    request.Method = "GET";
    request.ContentLength = 0;
    request.Headers.Add("Authorization", String.Format("Bearer {0}", authResult.AccessToken));

    //Get dashboards response from request.GetResponse()
    using (var response = request.GetResponse() as System.Net.HttpWebResponse)
    {
        //Get reader from response stream
        using (var reader = new System.IO.StreamReader(response.GetResponseStream()))
        {
            responseContent = reader.ReadToEnd();

            //Deserialize JSON string
            PBIDashboards PBIDashboards = JsonConvert.DeserializeObject<PBIDashboards>(responseContent);

            if (PBIDashboards != null)
            {
                var gridViewDashboards = PBIDashboards.value.Select(dashboard => new {
                    Id = dashboard.id,
                    DisplayName = dashboard.displayName,
                    EmbedUrl = dashboard.embedUrl
                });

                this.GridView1.DataSource = gridViewDashboards;
                this.GridView1.DataBind();
            }
        }
    }
}

//Power BI Dashboards used to deserialize the Get Dashboards response.
public class PBIDashboards
{
    public PBIDashboard[] value { get; set; }
}
public class PBIDashboard
{
    public string id { get; set; }
    public string displayName { get; set; }
    public string embedUrl { get; set; }
    public bool isReadOnly { get; set; }
}

Get dashboards using the .NET SDKGet dashboards using the .NET SDK

You can use the .NET SDK to retrieve a list of dashbaords instead of calling the REST API directly.



using Microsoft.IdentityModel.Clients.ActiveDirectory;
using Microsoft.PowerBI.Api.V2;
using Microsoft.PowerBI.Api.V2.Models;

var tokenCredentials = new TokenCredentials(<ACCESS TOKEN>, "Bearer");

// Create a Power BI Client object. It will be used to call Power BI APIs.
using (var client = new PowerBIClient(new Uri(ApiUrl), tokenCredentials))
{
    // Get a list of dashboards your "My Workspace"
    ODataResponseListDashboard dashboards = client.Dashboards.GetDashboards();

    // Get a list of dashboards from a group (app workspace)
    ODataResponseListDashboard dashboards = client.Dashboards.GetDashboardsInGroup(groupId);

    Dashboard dashboard = dashboards.Value.FirstOrDefault();

    var embedUrl = dashboard.EmbedUrl
}

Step 4 - load a dashboard using JavaScript

<!-- Embed Dashboard-->
<div> 
    <asp:Panel ID="PanelEmbed" runat="server" Visible="true">
        <div>
            <div><b class="step">Step 3</b>: Embed a dashboard</div>

            <div>Enter an embed url for a dashboard from Step 2 (starts with https://):</div>
            <input type="text" id="tb_EmbedURL" style="width: 1024px;" />
            <br />
            <input type="button" id="bEmbedDashboardAction" value="Embed Dashboard" />
        </div>

        <div id="dashboardContainer"></div>
    </asp:Panel>
</div>

You can use JavaScript to load a dashboard into a div element on your web page.

Default.aspx

Site.master



window.onload = function () {
    // client side click to embed a selected dashboard.
    var el = document.getElementById("bEmbedDashboardAction");
    if (el.addEventListener) {
        el.addEventListener("click", updateEmbedDashboard, false);
    } else {
        el.attachEvent('onclick', updateEmbedDashboard);
    }

    // handle server side post backs, optimize for reload scenarios
    // show embedded dashboard if all fields were filled in.
    var accessTokenElement = document.getElementById('MainContent_accessTokenTextbox');
    if (accessTokenElement !== null) {
        var accessToken = accessTokenElement.value;
        if (accessToken !== "")
            updateEmbedDashboard();
    }
};

// update embed dashboard
function updateEmbedDashboard() {

    // check if the embed url was selected
    var embedUrl = document.getElementById('tb_EmbedURL').value;
    if (embedUrl === "")
        return;

    // get the access token.
    accessToken = document.getElementById('MainContent_accessTokenTextbox').value;

    // Embed configuration used to describe the what and how to embed.
    // This object is used when calling powerbi.embed.
    // You can find more information at https://github.com/Microsoft/PowerBI-JavaScript/wiki/Embed-
Configuration-Details.
    var config = {
        type: 'dashboard',
        accessToken: accessToken,
        embedUrl: embedUrl
    };

    // Grab the reference to the div HTML element that will host the dashboard.
    var dashboardContainer = document.getElementById('dashboardContainer');

    // Embed the dashboard and display it within the div container.
    var dashboard = powerbi.embed(dashboardContainer, config);

    // dashboard.on will add an event handler which prints to Log window.
    dashboard.on("tileClicked", function (event) {
        var logView = document.getElementById('logView');
        logView.innerHTML = logView.innerHTML + "Tile Clicked<br/>";
        logView.innerHTML = logView.innerHTML + JSON.stringify(event.detail, null, "  ") + "<br/>";
        logView.innerHTML = logView.innerHTML + "---------<br/>";
    });

    // dashboard.on will add an event handler which prints to Log window.
    dashboard.on("error", function (event) {
        var logView = document.getElementById('logView');
        logView.innerHTML = logView.innerHTML + "Error<br/>";
        logView.innerHTML = logView.innerHTML + JSON.stringify(event.detail, null, "  ") + "<br/>";
        logView.innerHTML = logView.innerHTML + "---------<br/>";
    });
}

If you downloaded and ran the Integrate a dashboard sample, the sample will look similar to below.

https://github.com/Microsoft/PowerBI-Developer-Samples/tree/master/User Owns Data/integrate-dashboard-web-app


Tile clicked events

// dashboard.on will add an event handler which prints to Log window.
dashboard.on("tileClicked", function (event) {
    var logView = document.getElementById('logView');
    logView.innerHTML = logView.innerHTML + "Tile Clicked<br/>";
    logView.innerHTML = logView.innerHTML + JSON.stringify(event.detail, null, "  ") + "<br/>";
    logView.innerHTML = logView.innerHTML + "---------<br/>";
});

// dashboard.on will add an event handler which prints to Log window.
dashboard.on("error", function (event) {
    var logView = document.getElementById('logView');
    logView.innerHTML = logView.innerHTML + "Error<br/>";
    logView.innerHTML = logView.innerHTML + JSON.stringify(event.detail, null, "  ") + "<br/>";
    logView.innerHTML = logView.innerHTML + "---------<br/>";
});

Tile Clicked
{ "event": "TileClick", "reportEmbedUrl": "", "navigationUrl": "https://app.powerbi.com/dashboards/fcff76f9-
15ff-4a8e-8242-275ac9c25b90/qna?q=count%20of%20new%20hires%20from%20July%202014%20to%20December%202014", 
"tileId": "0e99b45c-9b53-4920-b239-cee7d37d2369" }
---------
Tile Clicked
{ "event": "TileClick", "reportEmbedUrl": "https://app.powerbi.com/reportEmbed?reportId=ab199308-80b1-4626-
9823-43a84623bd9c", "navigationUrl": "https://app.powerbi.com/reports/ab199308-80b1-4626-9823-
43a84623bd9c/ReportSection1", "tileId": "ffc30447-674a-4511-944f-79e182d719de", "pageName": "ReportSection1" }
---------

Working with groups (app workspaces)

In the sample above, you may have noticed that you can handle events when the tile is clicked on the dashboard.
For more information about events, see Handling Events within the JavaScript API.

If you downloaded and ran the Integrate a dashboard sample, clicking on a tile will output text below the
dashboard. The text will look similar to the following. This would allow you to log that a tile was clicked, and then
navigate the user to the appropriate location.

For embedding a dashboard from a group (app workspace), you will want to get the list of all available dashboards
within a group using the following REST API call. To find more information about this REST API call, see Get

https://github.com/Microsoft/PowerBI-JavaScript/wiki/Handling-Events
https://github.com/Microsoft/PowerBI-Developer-Samples/tree/master/PowerBI.com Integrate/integrate-dashboard-web-app
https://msdn.microsoft.com/library/mt465739.aspx


https://api.powerbi.com/v1.0/myorg/groups/{groupId}/dashboards

https://app.powerbi.com/dashboardEmbed?dashboardId={dashboardId}&groupId={groupId}

Limitations

Next steps

Dashboards. You will need to have permission in the group for the request to return results.

The above API returns the list of the available dashboards. Each dashboard has an EmbedUrl property which is
already constructed to support group embedding.

The end users who access the embedded dashboards must have a Power BI account and have access to the
dashboard. Either they own the dashboard or the dashboard was shared with the user.
Currently Q&A is not supported in embedded dashboards.
As a temporary limitation, when sharing a dashboard with security groups, user have to first access the
dashboards in PowerBI.com before they can see it embedded.

A sample application is available on GitHub for you to review. The above examples are based on that sample. For
more information, see integrate-dashboard-web-app.

More information is available for the JavaScript API, see Power BI JavaScript API.

More questions? Try asking the Power BI Community

https://github.com/Microsoft/PowerBI-Developer-Samples/tree/master/User Owns Data/integrate-dashboard-web-app
https://github.com/Microsoft/PowerBI-JavaScript
http://community.powerbi.com/
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NOTENOTE

Download the sample

Step 1 - register an app in Azure AD

Learn how to integrate, or embed, a tile into a web app using REST API calls along with the Power BI JavaScript API
when embedding for your organization.

To get started with this walkthrough, you need a Power BI account. If you don't have an account, you can sign up
for a free Power BI account, or you can create your own Azure Active Directory tenant for testing purposes.

Looking to embed a tile for your customers, using an embedtoken, instead? See, Integrate a dashboard, tile, or report into
your application for your customers.

To integrate a tile into a web app, you use the Power BI REST API, or the Power BI C# SDK, and an Azure Active
Directory (AD) authorization access token to get a tile. Then, you load the tile using the same access token. The
Power BI API provides programmatic access to certain Power BI resources. For more information, see Overview
of Power BI REST API and the Power BI JavaScript API.

This article shows the code used in the integrate-tile-web-app on GitHub. To follow along with this walkthrough,
you can download the sample.

You will need to register your application with Azure AD in order to make REST API calls. For more information, see
Register an Azure AD app to embed Power BI content.

If you downloaded the integrate-tile-web-app, you use the Client ID and Client Secret you get, after registration,
so that the sample can authenticate to Azure AD. To configure the sample, change the Client ID and Client Secret
in the cloud.config file.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/developer/integrate-tile.md
https://msdn.microsoft.com/library/dn877544.aspx
https://github.com/Microsoft/PowerBI-JavaScript
https://github.com/Microsoft/PowerBI-Developer-Samples/tree/master/User Owns Data/integrate-tile-web-app
https://github.com/Microsoft/PowerBI-Developer-Samples/tree/master/User Owns Data/integrate-tile-web-app


Step 2 - get an access token from Azure AD

Step 3 - get a tile

Get tiles using an access tokenGet tiles using an access token

Get tiles with the REST APIGet tiles with the REST API

Within your application, you will first need to get an access token, from Azure AD, before you can make calls to
the Power BI REST API. For more information, see Authenticate users and get an Azure AD access token for your
Power BI app.

To get a Power BI tile, you use the Get Tiles operation which gets a list of Power BI tiles from a given dashboard.
From the list of tiles, you can get a tile id and embed URL.

A dashboard ID will need to be retrieved first before you can get the tile. For information on how to retrieve a
dashbaord, see Integrate a dashboard into an app (user owns data).

With the access token you retrieved in step 2, you can call the Get Tiles operation. The Get Tiles operation returns
a list of tiles. You can get a single tile from the list of tiles. Below is a complete C# method to get a tile.

To make the REST API call, you must include an Authorization header in the format of Bearer {access token}.

Default.aspx.cs

https://msdn.microsoft.com/library/mt465741.aspx
https://msdn.microsoft.com/library/mt465741.aspx
https://msdn.microsoft.com/library/mt465741.aspx


using Newtonsoft.Json;

//Get a tile from a dashboard. In this sample, you get the first tile.
protected void GetTile(string dashboardId, int index)
{
    //Configure tiles request
    System.Net.WebRequest request = System.Net.WebRequest.Create(
        String.Format("{0}Dashboards/{1}/Tiles",
        baseUri,
        dashboardId)) as System.Net.HttpWebRequest;

    request.Method = "GET";
    request.ContentLength = 0;
    request.Headers.Add("Authorization", String.Format("Bearer {0}", accessToken.Value));

    //Get tiles response from request.GetResponse()
    using (var response = request.GetResponse() as System.Net.HttpWebResponse)
    {
        //Get reader from response stream
        using (var reader = new System.IO.StreamReader(response.GetResponseStream()))
        {
            //Deserialize JSON string
            PBITiles tiles = JsonConvert.DeserializeObject<PBITiles>(reader.ReadToEnd());

            //Sample assumes at least one Dashboard with one Tile.
            //You could write an app that lists all tiles in a dashboard
            if (tiles.value.Length > 0)
                tileEmbedUrl.Text = tiles.value[index].embedUrl;
        }
    }
}

//Power BI Tiles used to deserialize the Get Tiles response.
public class PBITiles
{
    public PBITile[] value { get; set; }
}
public class PBITile
{
    public string id { get; set; }
    public string title { get; set; }
    public string embedUrl { get; set; }
}

Get tiles using the .NET SDKGet tiles using the .NET SDK

You can use the .NET SDK to retrieve a list of dashbaords instead of calling the REST API directly.



using Microsoft.IdentityModel.Clients.ActiveDirectory;
using Microsoft.PowerBI.Api.V2;
using Microsoft.PowerBI.Api.V2.Models;

var tokenCredentials = new TokenCredentials(<ACCESS TOKEN>, "Bearer");

// Create a Power BI Client object. It will be used to call Power BI APIs.
using (var client = new PowerBIClient(new Uri(ApiUrl), tokenCredentials))
{
    // Get a list of dashboards your "My Workspace"
    ODataResponseListDashboard tiles = client.Dashboards.GetDashboards();

    // Get a list of dashboards from a group (app workspace)
    ODataResponseListDashboard dashboards = client.Dashboards.GetDashboardsInGroup(groupId);

    Dashboard dashboard = dashboards.Value.FirstOrDefault();

    // Get the first tile from the above dashbaord
    ODataResponseListTile tiles = client.Dashboards.GetTiles(dashboard.Id);

    Tile tile = tiles.Value.FirstOrDefault();
}

Step 4 - load a tile using JavaScript

<!-- Embed Tile-->
<div> 
    <asp:Panel ID="PanelEmbed" runat="server" Visible="true">
        <div>
            <div><b class="step">Step 3</b>: Embed a tile</div>

            <div>Enter an embed url for a tile from Step 2 (starts with https://):</div>
            <input type="text" id="tb_EmbedURL" style="width: 1024px;" />
            <br />
            <input type="button" id="bEmbedTileAction" value="Embed Tile" />
        </div>

        <div id="tileContainer"></div>
    </asp:Panel>
</div>

You can use JavaScript to load a tile into a div element on your web page.

Default.aspx

Site.master



window.onload = function () {
    // client side click to embed a selected tile.
    var el = document.getElementById("bEmbedTileAction");
    if (el.addEventListener) {
        el.addEventListener("click", updateEmbedTile, false);
    } else {
        el.attachEvent('onclick', updateEmbedTile);
    }

    // handle server side post backs, optimize for reload scenarios
    // show embedded tile if all fields were filled in.
    var accessTokenElement = document.getElementById('MainContent_accessTokenTextbox');
    if (accessTokenElement !== null) {
        var accessToken = accessTokenElement.value;
        if (accessToken !== "")
            updateEmbedTile();
    }
};

// update embed tile
function updateEmbedTile() {

    // check if the embed url was selected
    var embedUrl = document.getElementById('tb_EmbedURL').value;
    if (embedUrl === "")
        return;

    // get the access token.
    accessToken = document.getElementById('MainContent_accessTokenTextbox').value;

    // Embed configuration used to describe the what and how to embed.
    // This object is used when calling powerbi.embed.
    // You can find more information at https://github.com/Microsoft/PowerBI-JavaScript/wiki/Embed-
Configuration-Details.
    var config = {
        type: 'tile',
        accessToken: accessToken,
        embedUrl: embedUrl
    };

    // Grab the reference to the div HTML element that will host the tile.
    var tileContainer = document.getElementById('tileContainer');

    // Embed the tile and display it within the div container.
    var tile = powerbi.embed(tileContainer, config);

    // tile.on will add an event handler which prints to Log window.
    tile.on("error", function (event) {
        var logView = document.getElementById('logView');
        logView.innerHTML = logView.innerHTML + "Error<br/>";
        logView.innerHTML = logView.innerHTML + JSON.stringify(event.detail, null, "  ") + "<br/>";
        logView.innerHTML = logView.innerHTML + "---------<br/>";
    });
}

If you downloaded and ran the integrate-tile-web-app, the sample will look similar to below.

https://github.com/Microsoft/PowerBI-Developer-Samples/tree/master/User Owns Data/integrate-tile-web-app


Working with groups (app workspaces)

https://api.powerbi.com/v1.0/myorg/groups/{groupId}/dashboards/{dashboard_id}/tiles

https://app.powerbi.com/embed?dashboardId={dashboard_id}&tileId={tile_id}&groupId={group_id}

Next steps

For embedding a tile from a group (app workspace), you will want to get the list of all available tiles within a
group's dashboard using the following REST API call. To find more information about this REST API call, see Get
Tiles. You will need to have permission in the group for the request to return results.

The above API returns the list of the available tiles. Each tile has an EmbedUrl property which is already constructed
to support group embedding.

Tile Embed on PowerBI-JavaScript Wiki

Power BI JavaScript API.

integrate-tile-web-app sample on GitHub.

More questions? Try asking the Power BI Community

https://msdn.microsoft.com/library/mt465741.aspx
https://github.com/Microsoft/PowerBI-JavaScript/wiki/Tile-Embed
https://github.com/Microsoft/PowerBI-JavaScript
https://github.com/Microsoft/PowerBI-Developer-Samples/tree/master/User Owns Data/integrate-tile-web-app
http://community.powerbi.com/
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NOTENOTE

Download the sample

Step 1 - register an app in Azure AD

Learn how to integrate, or embed, a report into a web app using REST API calls along with the Power BI JavaScript
API when embedding for your organization.

To get started with this walkthrough, you need a Power BI account. If you don't have an account, you can sign up
for a free Power BI account, or you can create your own Azure Active Directory tenant for testing purposes.

Looking to embed a report for your customers, using an embedtoken, instead? See, Integrate a dashboard, tile, or report
into your application for your customers.

To integrate a report into a web app, you use the Power BI REST API, or the Power BI C# SDK, and an Azure Active
Directory (AD) authorization access token to get a report. Then, you load the report using the same access token.
The Power BI API provides programmatic access to certain Power BI resources. For more information, see
Overview of Power BI REST API and the Power BI JavaScript API.

This article shows the code used in the integrate-report-web-app on GitHub. To follow along with this
walkthrough, you can download the sample.

You will need to register your application with Azure AD in order to make REST API calls. For more information,
see Register an Azure AD app to embed Power BI content.

If you downloaded the integrate-report-web-app, you use the Client ID and Client Secret you get, after

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/developer/integrate-report.md
https://msdn.microsoft.com/library/dn877544.aspx
https://github.com/Microsoft/PowerBI-JavaScript
https://github.com/Microsoft/PowerBI-Developer-Samples/tree/master/User Owns Data/integrate-report-web-app
https://github.com/Microsoft/PowerBI-Developer-Samples/tree/master/User Owns Data/integrate-report-web-app


Step 2 - get an access token from Azure AD

Step 3 - get a report

Get reports using an access tokenGet reports using an access token

Get reports with the REST APIGet reports with the REST API

registration, so that the sample can authenticate to Azure AD. To configure the sample, change the Client ID and
Client Secret in the cloud.config file.

Within your application, you will first need to get an access token, from Azure AD, before you can make calls to
the Power BI REST API. For more information, see Authenticate users and get an Azure AD access token for your
Power BI app.

To get a Power BI report, you use the Get Reports operation which gets a list of Power BI reports. From the list of
reports, you can get a report id.

With the access token you retrieved in step 2, you can call the Get Reports operation. The Get Reports operation
returns a list of reports. You can get a single report from the list of reports. Below is a complete C# method to get
a report.

To make the REST API call, you must include an Authorization header in the format of Bearer {access token}.

Default.aspx.cs

https://msdn.microsoft.com/library/mt634543.aspx
https://msdn.microsoft.com/library/mt634543.aspx
https://msdn.microsoft.com/library/mt634543.aspx


using Newtonsoft.Json;

//Get a Report. In this sample, you get the first Report.
protected void GetReport(int index)
{
    //Configure Reports request
    System.Net.WebRequest request = System.Net.WebRequest.Create(
        String.Format("{0}/Reports",
        baseUri)) as System.Net.HttpWebRequest;

    request.Method = "GET";
    request.ContentLength = 0;
    request.Headers.Add("Authorization", String.Format("Bearer {0}", accessToken.Value));

    //Get Reports response from request.GetResponse()
    using (var response = request.GetResponse() as System.Net.HttpWebResponse)
    {
        //Get reader from response stream
        using (var reader = new System.IO.StreamReader(response.GetResponseStream()))
        {
            //Deserialize JSON string
            PBIReports Reports = JsonConvert.DeserializeObject<PBIReports>(reader.ReadToEnd());

            //Sample assumes at least one Report.
            //You could write an app that lists all Reports
            if (Reports.value.Length > 0)
            {
                var report = Reports.value[index];

                txtEmbedUrl.Text = report.embedUrl;
                txtReportId.Text = report.id;
                txtReportName.Text = report.name;
            }
        }
    }
}

//Power BI Reports used to deserialize the Get Reports response.
public class PBIReports
{
    public PBIReport[] value { get; set; }
}
public class PBIReport
{
    public string id { get; set; }
    public string name { get; set; }
    public string webUrl { get; set; }
    public string embedUrl { get; set; }
}

Get reports using the .NET SDKGet reports using the .NET SDK

You can use the .NET SDK to retrieve a list of reports instead of calling the REST API directly.



using Microsoft.IdentityModel.Clients.ActiveDirectory;
using Microsoft.PowerBI.Api.V2;
using Microsoft.PowerBI.Api.V2.Models;

var tokenCredentials = new TokenCredentials(<ACCESS TOKEN>, "Bearer");

// Create a Power BI Client object. It will be used to call Power BI APIs.
using (var client = new PowerBIClient(new Uri(ApiUrl), tokenCredentials))
{
    // Get the first report all reports in that workspace
    ODataResponseListReport reports = client.Reports.GetReports();

    Report report = reports.Value.FirstOrDefault();

    var embedUrl = report.EmbedUrl;
}

Step 4 - load a report using JavaScript

<!-- Embed Report-->
<div> 
    <asp:Panel ID="PanelEmbed" runat="server" Visible="true">
        <div>
            <div><b class="step">Step 3</b>: Embed a report</div>

            <div>Enter an embed url for a report from Step 2 (starts with https://):</div>
            <input type="text" id="tb_EmbedURL" style="width: 1024px;" />
            <br />
            <input type="button" id="bEmbedReportAction" value="Embed Report" />
        </div>

        <div id="reportContainer"></div>
    </asp:Panel>
</div>

You can use JavaScript to load a report into a div element on your web page.

Default.aspx

Site.master



window.onload = function () {
    // client side click to embed a selected report.
    var el = document.getElementById("bEmbedReportAction");
    if (el.addEventListener) {
        el.addEventListener("click", updateEmbedReporte, false);
    } else {
        el.attachEvent('onclick', updateEmbedReport);
    }

    // handle server side post backs, optimize for reload scenarios
    // show embedded report if all fields were filled in.
    var accessTokenElement = document.getElementById('MainContent_accessTokenTextbox');
    if (accessTokenElement !== null) {
        var accessToken = accessTokenElement.value;
        if (accessToken !== "")
            updateEmbedReport();
    }
};

// update embed report
function updateEmbedReport() {

    // check if the embed url was selected
    var embedUrl = document.getElementById('tb_EmbedURL').value;
    if (embedUrl === "")
        return;

    // get the access token.
    accessToken = document.getElementById('MainContent_accessTokenTextbox').value;

    // Embed configuration used to describe the what and how to embed.
    // This object is used when calling powerbi.embed.
    // You can find more information at https://github.com/Microsoft/PowerBI-JavaScript/wiki/Embed-
Configuration-Details.
    var config = {
        type: 'report',
        accessToken: accessToken,
        embedUrl: embedUrl
    };

    // Grab the reference to the div HTML element that will host the report.
    var reportContainer = document.getElementById('reportContainer');

    // Embed the report and display it within the div container.
    var report = powerbi.embed(reportContainer, config);

    // report.on will add an event handler which prints to Log window.
    report.on("error", function (event) {
        var logView = document.getElementById('logView');
        logView.innerHTML = logView.innerHTML + "Error<br/>";
        logView.innerHTML = logView.innerHTML + JSON.stringify(event.detail, null, "  ") + "<br/>";
        logView.innerHTML = logView.innerHTML + "---------<br/>";
    });
}

If you downloaded and ran the integrate-report-web-app, the sample will look similar to below.

https://github.com/Microsoft/PowerBI-Developer-Samples/tree/master/User Owns Data/integrate-report-web-app


Working with groups (app workspaces)

https://api.powerbi.com/v1.0/myorg/groups/{group_id}/reports

https://app.powerbi.com/reportEmbed?reportId={report_id}&groupId={group_id}

Next steps

For embedding a report from a group (app workspace), you will want to get the list of all available reports within a
group's dashboard using the following REST API call. To find more information about this REST API call, see Get
Reports. You will need to have permission in the group for the request to return results.

The above API returns the list of the available reports. Each report has an EmbedUrl property which is already
constructed to support group embedding.

A sample application is available on GitHub for you to review. For more information, see integrate-report-web-
app.

More information is available for the JavaScript API, see Power BI JavaScript API.

More questions? Try asking the Power BI Community

https://msdn.microsoft.com/library/mt634543.aspx
https://github.com/Microsoft/PowerBI-Developer-Samples/tree/master/User Owns Data/integrate-report-web-app
https://github.com/Microsoft/PowerBI-JavaScript
http://community.powerbi.com/


Embed a Power BI dashboard, tile, or report into
your application
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NOTENOTE

Download the sample

Step 1 - register an app in Azure AD

Learn how to integrate, or embed, a dashboard, tile or report, into a web app using the Power BI .NET SDK along
with the Power BI JavaScript API when embedding for your customers. This is typically the ISV scenario.

To get started with this walkthrough, you need a Power BI Pro account. If you don't have an account, you can
sign up for a free Power BI account and then sign up for a Power BI Pro trial, or you can create your own Azure
Active Directory tenant for testing purposes.

Looking to embed a dashboard for your organization instead? See, Integrate a dashboard into an app for your
organization.

To integrate a dashboard into a web app, you use the Power BI API, and an Azure Active Directory (AD)
authorization access token to get a dashboard. Then, you load the dashboard using an embed token. The Power
BI API provides programmatic access to certain Power BI resources. For more information, see Overview of
Power BI REST API, Power BI .NET SDK and the Power BI JavaScript API.

This article shows the code used in the Embedding for your organization sample on GitHub. To follow along with
this walkthrough, you can download the sample.

You will need to register your application with Azure AD in order to make REST API calls. For more information,
see Register an Azure AD app to embed Power BI content.

If you downloaded the Embedding for your organization sample, you use the Client ID you get, after registration,
so that the sample can authenticate to Azure AD. To configure the sample, change the clientId in the web.config

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/developer/embed-sample-for-customers.md
https://msdn.microsoft.com/library/dn877544.aspx
https://github.com/Microsoft/PowerBI-CSharp
https://github.com/Microsoft/PowerBI-JavaScript
https://github.com/Microsoft/PowerBI-Developer-Samples/tree/master/App Owns Data
https://github.com/Microsoft/PowerBI-Developer-Samples/tree/master/App Owns Data


Step 2 - get an access token from Azure AD

Step 3 - get a content item

Create the Power BI Client with your access tokenCreate the Power BI Client with your access token

using Microsoft.IdentityModel.Clients.ActiveDirectory;
using Microsoft.Rest;
using Microsoft.PowerBI.Api.V2;

var tokenCredentials = new TokenCredentials(authenticationResult.AccessToken, "Bearer");

// Create a Power BI Client object. It will be used to call Power BI APIs.
using (var client = new PowerBIClient(new Uri(ApiUrl), tokenCredentials))
{
    // Your code to embed items.
}

Get the content item you want to embedGet the content item you want to embed

using Microsoft.PowerBI.Api.V2;
using Microsoft.PowerBI.Api.V2.Models;

// You will need to provide the GroupID where the dashboard resides.
ODataResponseListDashboard dashboards = client.Dashboards.GetDashboardsInGroup(GroupId);

// Get the first report in the group.
Dashboard dashboard = dashboards.Value.FirstOrDefault();

file.

Within your application, you will first need to get an access token, from Azure AD, before you can make calls to
the Power BI REST API. For more information, see Authenticate users and get an Azure AD access token for your
Power BI app.

You can see examples of this within each content item task in Controllers\HomeController.cs.

To embed your Power BI content, you will need to do a couple of things to make sure it embeds correctly. While
all of these steps can be done with the REST API directly, the sample application, and the examples here, are made
with the .NET SDK.

With your access token, you will want to create your Power BI client object which will allow you to interact with
the Power BI APIs. This is done by wrapping the AccessToken with a Microsoft.Rest.TokenCredentials object.

Use the Power BI client object to retrieve a reference to the item you want to embed. You can embed dashboards,
tiles or reports. Here is an example of how to retrieve the first dashboard, tile or report from a given workspace.

A sample of this is available within Controllers\HomeController.cs of the App Owns Data sample.

Dashboards

Tile

https://github.com/Microsoft/PowerBI-Developer-Samples/tree/master/App Owns Data


using Microsoft.PowerBI.Api.V2;
using Microsoft.PowerBI.Api.V2.Models;

// To retrieve the tile, you first need to retrieve the dashboard.

// You will need to provide the GroupID where the dashboard resides.
ODataResponseListDashboard dashboards = client.Dashboards.GetDashboardsInGroup(GroupId);

// Get the first report in the group.
Dashboard dashboard = dashboards.Value.FirstOrDefault();

// Get a list of tiles from a specific dashboard
ODataResponseListTile tiles = client.Dashboards.GetTilesInGroup(GroupId, dashboard.Id);

// Get the first tile in the group.
Tile tile = tiles.Value.FirstOrDefault();

using Microsoft.PowerBI.Api.V2;
using Microsoft.PowerBI.Api.V2.Models;

// You will need to provide the GroupID where the dashboard resides.
ODataResponseListReport reports = client.Reports.GetReportsInGroupAsync(GroupId);

// Get the first report in the group.
Report report = reports.Value.FirstOrDefault();

Create the embed tokenCreate the embed token

IMPORTANTIMPORTANT

Report

An embed token needs to be generated which can be used from the JavaScript API. The embed token will be
specific to the item you are embedding. This means that any time you embed a piece of Power BI content, you
need to create a new embed token for it. For more information, including which accessLevel to use, see
GenerateToken API.

Because embed tokens are intended for development testing only, the number of embed tokens a Power BI master account
can generate is limited. A capacity must be purchased for production embedding scenarios. There is no limit to embed
token generation when a capacity is purchased.

A sample of this is available within Controllers\HomeController.cs of the Embedding for your organization
sample.

This assumes a class is created for EmbedConfig and TileEmbedConfig. A sample of these are available within
Models\EmbedConfig.cs and Models\TileEmbedConfig.cs.

Dashboard

https://msdn.microsoft.com/library/mt784614.aspx
https://docs.microsoft.com/power-bi/developer/embedded-faq#technical
https://github.com/Microsoft/PowerBI-Developer-Samples/tree/master/App Owns Data


using Microsoft.PowerBI.Api.V2;
using Microsoft.PowerBI.Api.V2.Models;

// Generate Embed Token.
var generateTokenRequestParameters = new GenerateTokenRequest(accessLevel: "view");
EmbedToken tokenResponse = client.Dashboards.GenerateTokenInGroup(GroupId, dashboard.Id, 
generateTokenRequestParameters);

// Generate Embed Configuration.
var embedConfig = new EmbedConfig()
{
    EmbedToken = tokenResponse,
    EmbedUrl = dashboard.EmbedUrl,
    Id = dashboard.Id
};

using Microsoft.PowerBI.Api.V2;
using Microsoft.PowerBI.Api.V2.Models;

// Generate Embed Token for a tile.
var generateTokenRequestParameters = new GenerateTokenRequest(accessLevel: "view");
EmbedToken tokenResponse = client.Tiles.GenerateTokenInGroup(GroupId, dashboard.Id, tile.Id, 
generateTokenRequestParameters);

// Generate Embed Configuration.
var embedConfig = new TileEmbedConfig()
{
    EmbedToken = tokenResponse,
    EmbedUrl = tile.EmbedUrl,
    Id = tile.Id,
    dashboardId = dashboard.Id
};

using Microsoft.PowerBI.Api.V2;
using Microsoft.PowerBI.Api.V2.Models;

// Generate Embed Token.
var generateTokenRequestParameters = new GenerateTokenRequest(accessLevel: "view");
EmbedToken tokenResponse = client.Reports.GenerateTokenInGroup(GroupId, report.Id, 
generateTokenRequestParameters);

// Generate Embed Configuration.
var embedConfig = new EmbedConfig()
{
    EmbedToken = tokenResponse,
    EmbedUrl = report.EmbedUrl,
    Id = report.Id
};

Step 4 - load an item using JavaScript

Tile

Report

You can use JavaScript to load a dashboard into a div element on your web page. The sample uses an
EmbedConfig/TileEmbedConfig model along with views for a dashboard, tile or report. For a full sample of using
the JavaScript API, you can use the Microsoft Power BI Embedded Sample.

An application sample of this is available within the Embedding for your organization sample.

https://microsoft.github.io/PowerBI-JavaScript/demo
https://github.com/Microsoft/PowerBI-Developer-Samples/tree/master/App Owns Data


<script src="~/scripts/powerbi.js"></script>
<div id="dashboardContainer"></div>
<script>
    // Read embed application token from Model
    var accessToken = "@Model.EmbedToken.Token";

    // Read embed URL from Model
    var embedUrl = "@Html.Raw(Model.EmbedUrl)";

    // Read dashboard Id from Model
    var embedDashboardId = "@Model.Id";

    // Get models. models contains enums that can be used.
    var models = window['powerbi-client'].models;

    // Embed configuration used to describe the what and how to embed.
    // This object is used when calling powerbi.embed.
    // This also includes settings and options such as filters.
    // You can find more information at https://github.com/Microsoft/PowerBI-JavaScript/wiki/Embed-
Configuration-Details.
    var config = {
        type: 'dashboard',
        tokenType: models.TokenType.Embed,
        accessToken: accessToken,
        embedUrl: embedUrl,
        id: embedDashboardId
    };

    // Get a reference to the embedded dashboard HTML element
    var dashboardContainer = $('#dashboardContainer')[0];

    // Embed the dashboard and display it within the div container.
    var dashboard = powerbi.embed(dashboardContainer, config);
</script>

Views\Home\EmbedDashboard.cshtml

Views\Home\EmbedTile.cshtml



<script src="~/scripts/powerbi.js"></script>
<div id="tileContainer"></div>
<script>
    // Read embed application token from Model
    var accessToken = "@Model.EmbedToken.Token";

    // Read embed URL from Model
    var embedUrl = "@Html.Raw(Model.EmbedUrl)";

    // Read tile Id from Model
    var embedTileId = "@Model.Id";

    // Read dashboard Id from Model
    var embedDashboardeId = "@Model.dashboardId";

    // Get models. models contains enums that can be used.
    var models = window['powerbi-client'].models;

    // Embed configuration used to describe the what and how to embed.
    // This object is used when calling powerbi.embed.
    // This also includes settings and options such as filters.
    // You can find more information at https://github.com/Microsoft/PowerBI-JavaScript/wiki/Embed-
Configuration-Details.
    var config = {
        type: 'tile',
        tokenType: models.TokenType.Embed,
        accessToken: accessToken,
        embedUrl: embedUrl,
        id: embedTileId,
        dashboardId: embedDashboardeId
    };

    // Get a reference to the embedded tile HTML element
    var tileContainer = $('#tileContainer')[0];

    // Embed the tile and display it within the div container.
    var tile = powerbi.embed(tileContainer, config);
</script>

Views\Home\EmbedReport.cshtml



<script src="~/scripts/powerbi.js"></script>
<div id="reportContainer"></div>
<script>
    // Read embed application token from Model
    var accessToken = "@Model.EmbedToken.Token";

    // Read embed URL from Model
    var embedUrl = "@Html.Raw(Model.EmbedUrl)";

    // Read report Id from Model
    var embedReportId = "@Model.Id";

    // Get models. models contains enums that can be used.
    var models = window['powerbi-client'].models;

    // Embed configuration used to describe the what and how to embed.
    // This object is used when calling powerbi.embed.
    // This also includes settings and options such as filters.
    // You can find more information at https://github.com/Microsoft/PowerBI-JavaScript/wiki/Embed-
Configuration-Details.
    var config = {
        type: 'report',
        tokenType: models.TokenType.Embed,
        accessToken: accessToken,
        embedUrl: embedUrl,
        id: embedReportId,
        permissions: models.Permissions.All,
        settings: {
            filterPaneEnabled: true,
            navContentPaneEnabled: true
        }
    };

    // Get a reference to the embedded report HTML element
    var reportContainer = $('#reportContainer')[0];

    // Embed the report and display it within the div container.
    var report = powerbi.embed(reportContainer, config);
</script>

Next steps
A sample application is available on GitHub for you to review. The above examples are based on that sample. For
more information, see Embedding for your organization sample.

More information is available for the JavaScript API, see Power BI JavaScript API.

More questions? Try asking the Power BI Community

https://github.com/Microsoft/PowerBI-Developer-Samples/tree/master/App Owns Data
https://github.com/Microsoft/PowerBI-JavaScript
http://community.powerbi.com/
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var embedConfig = {
    ...
    settings: {
            layoutType: models.LayoutType.Custom
    customLayout: {...}
    }
};

Object Definition
interface ICustomLayout {
  pageSize?: IPageSize;
  displayOption?: DisplayOption;
  pagesLayout?: PagesLayout;
}

enum PageSizeType {
  Widescreen,
  Standard,
  Cortana,
  Letter,
  Custom
}
interface IPageSize {
  type: PageSizeType;
}
interface ICustomPageSize extends IPageSize {
  width?: number;
  height?: number;
}

enum DisplayOption {
  FitToPage,
  FitToWidth,
  ActualSize
}

Pages layout

Use custom layout to embed a report with different layout than in an original report. Defining a new layout varies
between defining only a page size, controlling visual sizes, or position and visibility.

To define a custom layout, define a custom layout object and pass it into the settings object in embed configuration.
In addition, set LayoutType to Custom. To learn more, see Embed Configuration Details.

pageSize : Use page size to control the canvas area size (i.e. report white area).
displayOptions : Possible values are: FitToWidth, FitToPage or ActualSize. It controls how to scale the canvas to

fit into the iframe.
pagesLayout : Controls the layout for each visual. see PagesLayout for more details.

Defining a pages layout object is basically defining a layout for each page, and for each page, you define a layout
for each visual. PageLayout is optional. If you don't define a layout for a page, the default layout (which is saved in

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/developer/embedded-custom-layout.md
https://github.com/Microsoft/PowerBI-JavaScript/wiki/Embed-Configuration-Details


type PagesLayout = { [key: string]: IPageLayout; };

interface IPageLayout {
  visualsLayout: { [key: string]: IVisualLayout; };
}

Visual layout

interface IVisualLayout {
  x?: number;
  y?: number;
  z?: number;
  width?: number;
  height?: number;
  displayState?: IVisualContainerDisplayState;
}

interface IVisualContainerDisplayState {
  mode: VisualContainerDisplayMode;
}

enum VisualContainerDisplayMode {
  Visible,
  Hidden
}

Update layout

Code example

the report) will be applied.

pagesLayout is a map from page name to PageLayout object. Definition:

PageLayout contains a visual layout map, which maps each visual name to a visual layout object:

To define a visual layout, pass a new position and size and a new visibility state.

x,y,z : Defines the new position of the visual.
width , height: Defines the new size of the visual.
displayState : Defines the visibility of the visual.

You can use updateSettings method to update the report layout any time while the report is loaded. See Update
Settings.

https://github.com/Microsoft/PowerBI-JavaScript/wiki/Update-Settings


// Get models. models contains enums that can be used.
var models = window['powerbi-client'].models;

var embedConfiguration = {
    type: 'report',
    id: '5dac7a4a-4452-46b3-99f6-a25915e0fe55',
    embedUrl: 'https://app.powerbi.com/reportEmbed',
    tokenType: models.TokenType.Embed,
    accessToken: 'H4...rf',
    settings: {
            layoutType: models.LayoutType.Custom
        customLayout: {
            pageSize: {
                type: models.PageSizeType.Custom,
                width: 1600,
                height: 1200
            },
            displayOption: models.DisplayOption.ActualSize,
            pagesLayout: {
                "ReportSection1" : {
                    visualsLayout: {
                        "VisualContainer1": {
                            x: 1,
                            y: 1,
                            z: 1,
                            width: 400,
                            height: 300,
                            displayState: {
                                mode: models.VisualContainerDisplayMode.Visible
                            }
                        },
                        "VisualContainer2": {
                            displayState: {
                                mode: models.VisualContainerDisplayMode.Hidden
                            }
                        },
                    }
                }
            }
        }
    }
};

// Get a reference to the embedded report HTML element
var embedContainer = document.getElementById('embedContainer');

// Embed the report and display it within the div container.
var report = powerbi.embed(embedContainer, embedConfiguration);

See also
Embed your Power BI dashboards, reports and tiles
Ask the Power BI Community

https://community.powerbi.com/
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Create an Azure Active Directory tenant

Learn how to create a new Azure Active Directory (Azure AD) tenant for use with your custom application using
the Power BI REST APIs.

A tenant is representative of an organization within Azure Active Directory. It is a dedicated instance of the Azure
AD service that an organization receives and owns when it signs up for a Microsoft cloud service such as Azure,
Microsoft Intune, or Office 365. Each Azure AD tenant is distinct and separate from other Azure AD tenants.

Once you have an Azure AD tenant, you can define an application and assign permissions so your application can
make use of the Power BI REST APIs.

Your organization may already have an Azure AD tenant that you can use for your application. You can make use
of that tenant for your application needs or you can create a new tenant specifically for your application. This
article looks at how to create a new tenant.

In order to integrate Power BI into your custom application, you need to define an application within Azure AD.
To do that, you need a directory within Azure AD. This is your tenant. If you organization doesn't have a tenant
yet, because they aren't using Power BI or Office 365, you will need to create one. You may also need to create
one if you don't want your application mixing with your organization's tenant. This allows you to keep things
isolated.

Or, you may just want to create a tenant for testing purposes.

To create a new Azure AD tenant, do the following.

1. Browse to the Azure portal and sign in with an account that has an Azure subscription.
2. Select the plus icon (+) and search for Azure Active Directory.

3. Select Azure Active Directory in the search results.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/developer/create-an-azure-active-directory-tenant.md
https://docs.microsoft.com/azure/active-directory/develop/active-directory-howto-tenant
https://portal.azure.com


Create some users in your Azure Active Directory tenant

4. Select Create.

NOTENOTE

6. After your directory creation is complete, select the information box to manage your new directory.

5. Provide a name for the organization along with the initial domain name. Then select Create. This will
create your directory.

Your initial domain will be part of onmicrosoft.com. You can add other domain names later. The directory, of a
tenant, can have multiple domains assigned to it.

Your directory is now created. Next we will want to add a user to the tenant.

Now that we have a directory, let's create at least two users. One that will be a Global Admin for the tenant and
another that will be our master user for embedding. Think of this as a service account.

1. Within the Azure portal, make sure we are on the Azure Active Directory fly out.



3. Select All users and then select + New user.

If you are not, select the Azure Active Directory icon from the left services bar.

2. Under Manage, select Users and groups.

4. Provide a name and username for this user. This will be your Global Admin for the tenant. You will also
want to change the Directory role to Global administrator. You can also show the temporary password.
When you are done, select Create.

5. You will want to do the same thing again for a regular user in your tenant. This could also be used for
your master embedding account. This time, for Directory role, we will leave it as User. Be sure to make
note of the password. Then select Create.



Next steps

NOTENOTE

6. Sign up for Power BI with your user account that you created in step 5. You can do that by going to
powerbi.com and selecting Try free under Power BI - Cloud collaboration and sharing.

When you sign up, you will be prompted to try Power BI Pro free for 60 days. You can opt into that to
become a pro user. Now you can also start developing an embedded solution if that is what you are
looking for.

Make sure you sign up with the email address you gave the user account.

Now that you have an Azure AD tenant, you can use this tenant to test items within Power BI, and/or you can
move forward to embed Power BI dashboards and reports in your application. For more information on how to
embed items, see How to embed your Power BI dashboards, reports and tiles.

What is an Azure AD directory?
How to get an Azure Active Directory tenant

More questions? Try asking the Power BI Community

https://powerbi.microsoft.com/get-started/
https://docs.microsoft.com/azure/active-directory/active-directory-whatis
https://docs.microsoft.com/azure/active-directory/develop/active-directory-howto-tenant
http://community.powerbi.com/
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IMPORTANTIMPORTANT

Register with the Power BI App Registration Tool

Learn how to register an application within Azure Active Directory (Azure AD) for use with embedding Power BI
content.

You register your application with Azure AD to allow your application access to the Power BI REST APIs. This will
allow you to establish an identity for your application and specify permissions to Power BI REST resources.

Before you register a Power BI app you need an Azure Active Directory tenant and an organizational user. If you haven't
signed up for Power BI with a user in your tenant, the app registration will not complete successfully.

There are two ways to register your application. The first is with the Power BI App Registration Tool or you can do
it directly within the Azure portal. The Power BI App Registration Tool is the easiest option since there are just a
few fields to fill in. If you want to make changes to your app, use the Azure portal.

You need to register your application in Azure Active Directory to establish an identity for your application and
specify permissions to Power BI REST resources. When you register an application, such as a console app or a
web site, you receive an identifier which is used by the application to identify themselves to the users that they
are requesting permissions from.

Here's how to register your application with the Power BI App Registration Tool:

1. Go to dev.powerbi.com/apps.
2. Select Sign in with your existing account.
3. Provide an App Name.
4. The App type selection will depend on the type of application you are using.

Use Server-side Web app for web apps or web APIs.
Use Native app for apps that run on client devices. You will also choose *Native app if you are
embedding content for your customers regardless of what the actual application is. Even for web
applications.***

5. Enter a value for Redirect URL and Home Page URL. Any valid URL will work.

Home Page URL is only available if you choose Server-side Web app for the applciation type.

For the embedding for your customers and integrate-dashboard-web-app samples, the redirect URL will
be http://localhost:13526/redirect . For the report and tile sample, the redirect URL will be 
http://localhost:13526/ .

6. Choose the APIs that this application will have access to. For more information about Power BI access
permissions, see Power BI Permissions.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/developer/register-app.md
https://dev.powerbi.com/apps/
https://dev.powerbi.com/apps
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Register with the Azure portal

7. Select Register App.

You will then be provided with a Client ID. If you selected Server-side Web app, you will also receive a
Client Secret. The Client ID can be retrieved from the Azure portal, at a later time, if needed. If you lose
the Client Secret, you will need to create a new one within the Azure portal.

You can now use the registered application as part of your custom application to interact with the Power BI
service.

If you are embedding content for your customers, you will need to configure additional permissions within the Azure portal.
For more information, see Apply permissions to your application.

Your other option for registering your application is to do so directly in the Azure portal. To register your
application, follow these steps.

1. Accept the Microsoft Power BI API Terms.
2. Sign into the Azure portal.
3. Choose your Azure AD tenant by selecting your account in the top right corner of the page.
4. In the left-hand navigation pane, choose More Services, select App Registrations under Security +

Identity and select New application registration.

5. Follow the prompts and create a new application.

For Web Applications, provide the Sign-On URL, which is the base URL of your app, where users can
sign in e.g http://localhost:13526.
For Native Applications, provide a Redirect URI, which Azure AD uses to return token responses. Enter a
value specific to your application, .e.g http://myapplication/redirect

For more information about how to register applications in Azure Active Directory, see Integrating applications
with Azure Active Directory

https://powerbi.microsoft.com/api-terms
https://portal.azure.com
http://localhost:13526
http://myapplication/redirect
https://docs.microsoft.com/azure/active-directory/develop/active-directory-integrating-applications


How to get the client id

Apply permissions to your application within Azure AD

IMPORTANTIMPORTANT

Using the Azure AD portalUsing the Azure AD portal

When you register an application, you receive a Client ID. The Client ID is used by the application to identify
themselves to the users that they are requesting permissions from.

Here's how to get a client id:

1. Sign into the Azure portal.
2. Choose your Azure AD tenant by selecting your account in the top right corner of the page.
3. In the left-hand navigation pane, choose More Services and select App Registrations.
4. Select the application that you want to retrieve the client id for.
5. You will see Application ID listed as a GUID. This is the client id for the application.

This section only applies to applications that are embedding content for your organization.

You will need to enable additional permissions to your application in addition to what was provided in app
registration page. You can accomplish this through the Azure AD portal, or programmatically.

You will want to be logged in with either the master account, used for embedding, or a Global admin account.

1. Browse to App registrations within the Azure portal and select the app that you are using for embedding.

2. Select Required permissions under API Access.

https://portal.azure.com
https://portal.azure.com/#blade/Microsoft_AAD_IAM/ApplicationsListBlade
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3. Select Windows Azure Active Directory and then make sure Access the directory as the signed-in
user is selected. Select Save.

4. Within Required permissions, select Power BI Service (Power BI).

If you created the app directly in the Azure AD portal, Power BI Service (Power BI) may not be present. If it is
not, select + Add and then 1 Select and API. Select Power BI Service in the API list and select Select. If Power
BI Service (Power BI) is not available within + Add, sign up for Power BI with at least one user.

5. Select all permissions under Delegated Permissions. You will need to select them one by one in order to
save the selections. Select Save when done.



Applying permissions programmaticallyApplying permissions programmatically

6. Within Required permissions, select Grant Permissions.

The Grant Permissions action is needed for the master account to avoid being prompted for consent by
Azure AD. If the account performing this action is a Global Admin, you will grant permissions to all users
within your organization for this application. If the account performing this action is the master account
and is not a Global Admin, you will grant permissions only to the master account for this application.

2. Check for a service principal with you app client id as appId property.

Post https://graph.microsoft.com/beta/servicePrincipals
Authorization: Bearer ey..qw
Content-Type: application/json
{
"accountEnabled" : true,
"appId" : "{App_Client_ID}",
"displayName" : "{App_DisplayName}"
}

1. You will need to get the existing service principals (users) within your tenant. For information on how to do
that, see Get servicePrincipal.

You can call the Get servicePrincipal api without {id} and it will get you all of the service principals within
the tenant.

3. Create a new service plan if missing for your app.

4. Grant App Permission to PowerBI API

https://developer.microsoft.com/en-us/graph/docs/api-reference/beta/api/serviceprincipal_get


Next steps

Post https://graph.microsoft.com/beta/OAuth2PermissionGrants
Authorization: Bearer ey..qw
Content-Type: application/json
{ 
"clientId":"{Service_Plan_ID}",
"consentType":"AllPrincipals",
"resourceId":"c78b2585-1df6-41de-95f7-dc5aeb7dc98e",
"scope":"Dataset.ReadWrite.All Dashboard.Read.All Report.Read.All Group.Read Group.Read.All 
Content.Create Metadata.View_Any Dataset.Read.All Data.Alter_Any",
"expiryTime":"2018-03-29T14:35:32.4943409+03:00",
"startTime":"2017-03-29T14:35:32.4933413+03:00"
}

Post https://graph.microsoft.com/beta/OAuth2PermissionGrants
Authorization: Bearer ey..qw
Content-Type: application/json
{ 
"clientId":"{Service_Plan_ID}",
"consentType":"AllPrincipals",
"resourceId":"61e57743-d5cf-41ba-bd1a-2b381390a3f1",
"scope":"User.Read Directory.AccessAsUser.All",
"expiryTime":"2018-03-29T14:35:32.4943409+03:00",
"startTime":"2017-03-29T14:35:32.4933413+03:00"
}

5. Grant App Permission to AAD

The value for consentType will depend on the user performing the request. You can supply either
AllPrincipals or Principal. AllPrincipals can only be used by an administrator to grant permission to all
users. Principal is used to grant permission to a specific user.

The permission grant is needed for the master account to avoid being prompted for consent by Azure AD.

If you are using an existing tenant, and not interested in granting permissions on behalf of all tenant users,
you can grant permissions to a specific user by replacing the value of contentType to Principal.

Now that you have registered your application within Azure AD, you will need to authenticate users within your
application. Have a look at Authenticate users and get an Azure AD access token for your Power BI app to learn
more.

More questions? Try asking the Power BI Community

http://community.powerbi.com/


Authenticate users and get an Azure AD access
token for your Power BI app
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Access token for Power BI users (user owns data)

Get an authorization code from Azure ADGet an authorization code from Azure AD

var @params = new NameValueCollection
{
    //Azure AD will return an authorization code. 
    //See the Redirect class to see how "code" is used to AcquireTokenByAuthorizationCode
    {"response_type", "code"},

    //Client ID is used by the application to identify themselves to the users that they are requesting 
permissions from. 
    //You get the client id when you register your Azure app.
    {"client_id", Properties.Settings.Default.ClientID},

    //Resource uri to the Power BI resource to be authorized
    // https://analysis.windows.net/powerbi/api
    {"resource", Properties.Settings.Default.PowerBiAPI},

    //After user authenticates, Azure AD will redirect back to the web app
    {"redirect_uri", "http://localhost:13526/Redirect"}
};

Learn how you can authenticate users within your Power BI application and retrieve an access token to use with
the REST API.

Before you can call the Power BI REST API, you need to get an Azure Active Directory (Azure AD) authentication
access token (access token). An access token is used to allow your app access to Power BI dashboards, tiles
and reports. To learn more about Azure Active Directory access token flow, see Azure AD Authorization Code
Grant Flow.

Depending on how you are embedding content, the access token will be retrieved differently. Two different
approaches are used within this article.

This example is for when your users will manually log into Azure AD with their organziation login. This is used
when embedding content for Power BI users that will access content they have access to within the Power BI
service.

The first step to get an access token is to get an authorization code from Azure AD. To do this, you construct a
query string with the following properties, and redirect to Azure AD.

Authorization code query string

After you construct a query string, you redirect to Azure AD to get an authorization code. Below is a complete
C# method to construct an authorization code query string, and redirect to Azure AD. After you have the
authorization code, you get an access token using the authorization code.

Within redirect.aspx.cs, AuthenticationContext.AcquireTokenByAuthorizationCode will then be called to generate
the token.

Get authorization code

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/developer/get-azuread-access-token.md
https://msdn.microsoft.com/library/azure/dn645542.aspx
https://msdn.microsoft.com/library/azure/dn479531.aspx


protected void signInButton_Click(object sender, EventArgs e)
{
    //Create a query string
    //Create a sign-in NameValueCollection for query string
    var @params = new NameValueCollection
    {
        //Azure AD will return an authorization code. 
        //See the Redirect class to see how "code" is used to AcquireTokenByAuthorizationCode
        {"response_type", "code"},

        //Client ID is used by the application to identify themselves to the users that they are requesting 
permissions from. 
        //You get the client id when you register your Azure app.
        {"client_id", Properties.Settings.Default.ClientID},

        //Resource uri to the Power BI resource to be authorized
        // https://analysis.windows.net/powerbi/api
        {"resource", Properties.Settings.Default.PowerBiAPI},

        //After user authenticates, Azure AD will redirect back to the web app
        {"redirect_uri", "http://localhost:13526/Redirect"}
    };

    //Create sign-in query string
    var queryString = HttpUtility.ParseQueryString(string.Empty);
    queryString.Add(@params);

    //Redirect authority
    //Authority Uri is an Azure resource that takes a client id to get an Access token
    // AADAuthorityUri = https://login.windows.net/common/oauth2/authorize/
    string authorityUri = Properties.Settings.Default.AADAuthorityUri;
    var authUri = String.Format("{0}?{1}", authorityUri, queryString);
    Response.Redirect(authUri);
}

Get an access token from authorization codeGet an access token from authorization code

Install-Package Microsoft.IdentityModel.Clients.ActiveDirectory

You should now have an authorization code from Azure AD. Once Azure AD redirects back to your web app with
an authorization code, you use the authorization code to get an access token. Below is a C# sample that you
could use in your redirect page and the Page_Load event for your default.aspx page.

The Microsoft.IdentityModel.Clients.ActiveDirectory namespace can be retrieved from the Active Directory
Authentication Library NuGet package.

Redirect.aspx.cs

https://www.nuget.org/packages/Microsoft.IdentityModel.Clients.ActiveDirectory/


using Microsoft.IdentityModel.Clients.ActiveDirectory;

protected void Page_Load(object sender, EventArgs e)
{
    //Redirect uri must match the redirect_uri used when requesting Authorization code.
    string redirectUri = String.Format("{0}Redirect", Properties.Settings.Default.RedirectUrl);
    string authorityUri = Properties.Settings.Default.AADAuthorityUri;

    // Get the auth code
    string code = Request.Params.GetValues(0)[0];

    // Get auth token from auth code
    TokenCache TC = new TokenCache();

    AuthenticationContext AC = new AuthenticationContext(authorityUri, TC);
    ClientCredential cc = new ClientCredential
        (Properties.Settings.Default.ClientID,
        Properties.Settings.Default.ClientSecret);

    AuthenticationResult AR = AC.AcquireTokenByAuthorizationCode(code, new Uri(redirectUri), cc);

    //Set Session "authResult" index string to the AuthenticationResult
    Session[_Default.authResultString] = AR;

    //Redirect back to Default.aspx
    Response.Redirect("/Default.aspx");
}

using Microsoft.IdentityModel.Clients.ActiveDirectory;

protected void Page_Load(object sender, EventArgs e)
{

    //Test for AuthenticationResult
    if (Session[authResultString] != null)
    {
        //Get the authentication result from the session
        authResult = (AuthenticationResult)Session[authResultString];

        //Show Power BI Panel
        signInStatus.Visible = true;
        signInButton.Visible = false;

        //Set user and token from authentication result
        userLabel.Text = authResult.UserInfo.DisplayableId;
        accessTokenTextbox.Text = authResult.AccessToken;
    }
}

Access token for non-Power BI users (app owns data)

Default.aspx

This approach is typically used for ISV type applications where the app owns access to the data. Users will not
necessarily be Power BI users and the application controls authentication and access for the end users.

For this approach, you will use a single master account that is a Power BI Pro user. The credentials for this account
are stored with the application. The application will authenticate against Azure AD with those stored credentials.
The example code shown below comes from the App owns data sample

HomeController.cs

https://github.com/guyinacube/PowerBI-Developer-Samples/tree/master/App Owns Data


using Microsoft.IdentityModel.Clients.ActiveDirectory;

// Create a user password cradentials.
var credential = new UserPasswordCredential(Username, Password);

// Authenticate using created credentials
var authenticationContext = new AuthenticationContext(AuthorityUrl);
var authenticationResult = await authenticationContext.AcquireTokenAsync(ResourceUrl, ClientId, credential);

if (authenticationResult == null)
{
    return View(new EmbedConfig()
    {
        ErrorMessage = "Authentication Failed."
    });
}

var tokenCredentials = new TokenCredentials(authenticationResult.AccessToken, "Bearer");

Next steps

For information on how to use await, see await (C# Reference)

Now that you have the access token, you can call the Power BI REST API to embed content. For information on
how to embed your content, see How to embed your Power BI dashboards, reports and tiles.

More questions? Try asking the Power BI Community

https://docs.microsoft.com/dotnet/csharp/language-reference/keywords/await
http://community.powerbi.com/
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Permission scopes

DISPLAY NAME DESCRIPTION SCOPE VALUE

View all Datasets The app can view all datasets for the
signed in user and datasets that the
user has access to.

Dataset.Read.All

Read and Write all Datasets The app can view and write to all
datasets for the signed in user and
datasets that the user has access to.

Dataset.ReadWrite.All

Add data to a user's dataset (preview) Gives an app access to add or delete a
user's dataset rows. This permission
does not grant the app access to the
user's data.

Data.Alter_Any

Create content (preview) App can automatically create content
and datasets for a user.

Content.Create

View users Groups The app can view all groups that the
signed in user belongs to.

Group.Read

View all Groups The app can view all groups that the
signed in user belongs to.

Group.Read.All

View all Dashboards (preview) The app can view all dashboards for the
signed in user and dashboards that the
user has access to.

Dashboard.Read.All

View all Reports (preview) The app can view all reports for the
signed in user and reports that the user
has access to. The app can also see the
data within the reports as well as its
structure.

Report.Read.All

Read and write all Reports The app can view and write to all the
reports for the signed in user and any
reports that the user has access to. This
does not provide rights to create a new
report.

Report.ReadWrite.All

Power BI permissions give an application the ability to take certain actions on a user's behalf. All permissions must
be approved by a user in order to be valid.

An application can request permissions when it first attempts to log in to a user's page by passing in the requested
permissions in the scope parameter of the call. If the permissions are granted, an access token will be returned to
the app which can be used on future API calls. The access can only be used by a specific application.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/developer/power-bi-permissions.md
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Requesting Permissions

The Power BI APIs still refer to app workspaces as groups. Any references to groups mean that you are working with app
workspaces.

While you can call the API to authenticate with a username and password, in order to take actions on behalf of
another user, they will need to request permissions that the user then approves and then send the resulting access
token on all future calls. For this process, we will follow the standard OAuth 2.0 protocol. While the actual
implementation may vary, the OAuth flow for Power BI has the following elements:

Login UI - This is a UI that the developer can evoke to request permissions. It would require the user to log in if
not already. The user would also need to approve the permissions that the application is requesting. The login
window will post back either an access code or an error message to a redirect URL that is supplied.

Authorization Code - Authorization Codes are returned to web applications after login via URL parameters in
the redirect URL. Since they are in parameters there is some security risk. Web applications will have to
exchange the authorization code for an Authorization Token
Authorization Token - Are used to authenticate API calls on another user's behalf. They will be scoped to a
specific application. Tokens have a set lifespan and when they expire they will need to be refreshed.
Refresh Token - When tokens expire there will be a process of refreshing them.

A standard redirect URL should be supplied by Power BI for use by native applications.

More questions? Try asking the Power BI Community

http://oauth.net/2/
http://community.powerbi.com/
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Row level security (RLS) can be used to restrict user access to data within dashboards, tiles, reports, and datasets.
Multiple, different users can work with those same artifacts all while seeing different data. Embedding supports
RLS.

If you're embedding for non-Power BI users (app owns data), which is typically an ISV scenario, then this article is
for you! You will need to configure the embed token to account for the user and role. Read on to learn how to do
this.

If you are embedding to Power BI users (user owns data), within your organization, RLS works the same as it does
within the Power BI service directly. There is nothing more you need to do in your application. For more
information see, Row-Level security (RLS) with Power BI.

To take advantage of RLS, it’s important you understand three main concepts; Users, Roles, and Rules. Let’s take a
closer look at each:

Users – End-users viewing the artifact (dashboard, tile, report, or dataset). In Power BI Embedded, users are
identified by the username property in an embed token.

Roles – Users belong to roles. A role is a container for rules and can be named something like Sales Manager or
Sales Rep. You create roles within Power BI Desktop. For more information, see Row-level security (RLS) with
Power BI Desktop.

Rules – Roles have rules, and those rules are the actual filters that are going to be applied to the data. This could
be as simple as “Country = USA” or something much more dynamic. For the rest of this article, we’ll provide an
example of authoring RLS, and then consuming that within an embedded application. Our example uses the Retail
Analysis Sample PBIX file.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/developer/embedded-row-level-security.md
http://go.microsoft.com/fwlink/?LinkID=780547


Adding roles with Power BI Desktop
Our Retail Analysis sample shows sales for all the stores in a retail chain. Without RLS, no matter which district
manager signs in and views the report, they’ll see the same data. Senior management has determined each district
manager should only see the sales for the stores they manage, and to do this, we can use RLS.

RLS is authored in Power BI Desktop. When the dataset and report are opened, we can switch to diagram view to
see the schema:

Here are a few things to notice with this schema:

All measures, like Total Sales, are stored in the Sales fact table.
There are four additional related dimension tables: Item, Time, Store, and District.
The arrows on the relationship lines indicate which way filters can flow from one table to another. For example,
if a filter is placed on Time[Date], in the current schema it would only filter down values in the Sales table. No
other tables would be affected by this filter since all the arrows on the relationship lines point to the sales table
and not away.
The District table indicates who the manager is for each district:

Based on this schema, if we apply a filter to the District Manager column in the District table, and if that filter
matches the user viewing the report, that filter will also filter down the Store and Sales tables to only show data
for that district manager.

Here's how:

1. On the Modeling tab, select Manage Roles.



Applying user and role to an embed token

2. Create a new role called Manager.

3. In the District table, enter the following DAX expression: [District Manager] = USERNAME().

4. To make sure the rules are working, on the Modeling tab, select View as Roles, and then select both the
Manager role you just created, along with Other user. Enter Andrew Ma for the user.

The reports will now show data as if you were signed in as Andrew Ma.

Applying the filter, the way we did here, will filter down all records in the District, Store, and Sales tables.
However, because of the filter direction on the relationships between Sales and Time, Sales and Item, and Item
and Time tables will not be filtered down. To learn more about bidirectional cross-filtering, download the
Bidirectional cross-filtering in SQL Server Analysis Services 2016 and Power BI Desktop whitepaper.

Now that you have your Power BI Desktop roles configured, there is some work needed in your application to take
advantage of the roles.

Users are authenticated and authorized by your application and embed tokens are used to grant that user access to
a specific Power BI Embedded report. Power BI Embedded doesn’t have any specific information on who your user
is. For RLS to work, you’ll need to pass some additional context as part of your embed token in the form of
identities. This is done by way GenerateToken API.

The GenerateToken API accepts a list of identities with indication of the relevant datasets. For RLS to work, you will
need to pass the following as part of the identity.

username (mandatory) – This is a string that can be used to help identify the user when applying RLS rules.
Only a single user can be listed.
roles (mandatory) – A string containing the roles to select when applying Row Level Security rules. If passing
more than one role, they should be passed as a string array.
dataset (mandatory) – The dataset that is applicable for the artifact you are embedding.

http://download.microsoft.com/download/2/7/8/2782DF95-3E0D-40CD-BFC8-749A2882E109/Bidirectional cross-filtering in Analysis Services 2016 and Power BI.docx
https://msdn.microsoft.com/library/mt784614.aspx
https://msdn.microsoft.com/library/mt784614.aspx


// Generate Embed Token.
var generateTokenRequestParameters = new GenerateTokenRequest(accessLevel: "view");

var tokenResponse = await client.Reports.GenerateTokenInGroupAsync(GroupId, report.Id, 
generateTokenRequestParameters);

var generateTokenRequestParameters = new GenerateTokenRequest("View", null, identities: new 
List<EffectiveIdentity> { new EffectiveIdentity(username: "username", roles: new List<string> { "roleA", 
"roleB" }, datasets: new List<string> { "datasetId" }) });

var tokenResponse = await client.Reports.GenerateTokenInGroupAsync("groupId", "reportId", 
generateTokenRequestParameters);

{
    "accessLevel": "View",
    "identities": [
        {
            "username": "EffectiveIdentity",
            "roles": [ "Role1", "Role2" ],
            "datasets": [ "fe0a1aeb-f6a4-4b27-a2d3-b5df3bb28bdc" ]
        }
    ]
}

Working with Analysis Services live connections

You can create the embed token by using the GenerateTokenInGroup method on PowerBIClient.Reports.

For example, you could change the PowerBIEmbedded_AppOwnsData sample. Home\HomeController.cs line 76
and 77 could be updated from:

to

If you are calling the REST API, the updated API now accepts an additional JSON array, named identities,
containing a user name, list of string roles and list of string datasets, e.g.:

Now, with all the pieces together, when someone logs into your application to view this artifact, they’ll only be able
to see the data that they are allowed to see, as defined by our row-level security.

Row-level security can be used with Analysis Services live connections for on-premises servers. There are a few
specific concepts that you should understand when using this type of connection.

The effective identity that is provided for the username property must be a Windows user with permissions on the
Analysis Services server.

On-premises data gateway configuration

An on-premises data gateway is used when working with Analysis Services live connections. When generating an
embed token, with an identity listed, the master account needs to be listed as an admin of the gateway. If the
master account is not listed, the row-level security will not be applied property to the data. A non-admin of the
gateway can provide roles, but must specify its own username for the effective identity.

Use of roles

Roles can be provded with the identity in an embed token. If no role is provided, the username that was provided
will be used to resolve the associated roles.

https://github.com/Microsoft/PowerBI-Developer-Samples/tree/master/App Owns Data


Considerations and limitations
Assignment of users to roles within the Power BI service does not affect RLS when using an embed token.
While the Power BI service will not apply RLS setting to admins or members with edit permissions, when you
supply an identity with an embed token, it will be applied to the data.
Analysis Services live connections are supported for on-premises servers.
Azure Analysis Services live connections support filtering by roles, but not dynamic by username.
If the underlying dataset doesn’t require RLS, the GenerateToken request must not contain an effective identity.
If the underlying dataset is a cloud model (cached model or DirectQuery), the effective identity must include at
least one role, otherwise role assignment will not occur.
A list of identities enables multiple identity tokens for dashboard embedding. For all others artifacts, the list
contains a single identity.

More questions? Try asking the Power BI Community

https://community.powerbi.com/


Q&A in Power BI Embedded
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// Embed configuration used to describe the what and how to embed.
// This object is used when calling powerbi.embed within the JavaScript API.
// You can find more information at https://github.com/Microsoft/PowerBI-JavaScript/wiki/Embed-Configuration-
Details.
var config= {
    type: 'qna',
    tokenType:   models.TokenType.Embed | models.TokenType.Aad,
    accessToken: access token value,
    embedUrl:    https://app.powerbi.com/qnaEmbed (groupId to be appended as query parameter if required),
    datasetIds:  array of requested data set ids (at the moment we support only one dataset),
    viewMode:    models.QnAMode.Interactive | models.QnAMode.ResultOnly,
    question:    optional parameter for Explore mode (QnAMode.Interactive) and mandatory for Render Result 
mode (QnAMode.ResultOnly)
};

// Get a reference to the embedded QNA HTML element
var qnaContainer = $('#qnaContainer')[0];

// Embed the QNA and display it within the div container.
var qna = powerbi.embed(qnaContainer, config);

Set question

Power BI Embedded offers you a way to incorporate Q&A into an application and allow your users to ask
questions using natural language and receive immediate answers in the form of visuals like charts or graphs.

There are two modes for embedding Q&A within your application: interactive and result only. Interactive
mode allows you to type in questions and have them displayed within the visual. If you have a saved question, or a
set question you want to display, you can use the result only mode by populating the question in your embed
config.

Here is a look at what the JavaScript code will look like.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/developer/qanda.md


// Get a reference to the embedded Q&A HTML element
var qnaContainer = $('#qnaContainer')[0];

// Get a reference to the embedded Q&A.
qna = powerbi.get(qnaContainer);

qna.setQuestion("This year sales")
    .then(function (result) {
        …….
    })
    .catch(function (errors) {
        …….
    });

Visual rendered event

// Get a reference to the embedded Q&A HTML element
var qnaContainer = $('#qnaContainer')[0];

// Get a reference to the embedded Q&A.
qna = powerbi.get(qnaContainer);

// qna.off removes a given event listener if it exists.
qna.off("visualRendered");

// qna.on will add an event listener.
qna.on("visualRendered", function(event) {
     …….
});

Embed token

Next steps

If you used result mode with a set question, you can inject additional questions into the frame and have them
immediately answered replacing the previous result. A new visual is rendered matching the new question.

One example of this usage would be a frequently asked question list. The user could go through the questions and
have them answered within the same embedded part.

Code snippet for JS SDK usage:

For interactive mode, the application can be notified with a data changed event each time the rendered visual
changes to target the updated input query as it is being typed.

Listening to the visualRendered event allows you to save questions for use later.

Code snippet for JS SDK usage:

Create an embed token off of a dataset to start a Q&A part. For more information, see Generate token for Q&A.

To give Q&A embedding a try, check out the JavaScript embed sample.

More questions? Try asking the Power BI Community

https://msdn.microsoft.com/library/mt784614.aspx#qanda
https://microsoft.github.io/PowerBI-JavaScript/demo/
http://community.powerbi.com/


Power BI Embedded migration tool
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Limitations

Download

Migration Plans

Start with a new migration planStart with a new migration plan

This migration tool can be used to copy your reports from the Power BI Embedded Azure service (PaaS) to the
Power BI service (SaaS).

Migrating your content from your workspace collections to the Power BI service can be done in parallel to your
current solution and doesn’t require any downtime.

Pushed datasets cannot be downloaded and will need to be recreated using the Power BI REST APIs for the
Power BI service.
PBIX files imported before November 26, 2016 will not be downloadable.

You can download the migration tool sample from GitHub. You can either download a zip of the repository, or you
can clone it locally. Once downloaded, you can open powerbi-migration-sample.sln within Visual Studio to build
and run the migration tool.

Your migration plan is just metadata that catalogs the content within Power BI Embedded and how you want to
publish them to the Power BI service.

A migration plan is the metadata of the items available in Power BI Embedded that you then want to move over to
the Power BI service. The migration plan is stored as an XML file.

You will want to start by creating a new migration plan. To create a new migration plan, do the following.

2. In the Select Power BI Embedded Resource Group dialog, you will want to select the Environment
dropdown and select prod.

IMPORTANTIMPORTANT

1. Select File > New Migration Plan.

3. You will be prompted to sign in. You will use your Azure subscription login.

This is not your Office 365 organization account that you sign into Power BI with.

4. Select the Azure subscription which stores your Power BI Embedded workspace collections.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/developer/migrate-tool.md
https://github.com/Microsoft/powerbi-migration-sample


Save your migration planSave your migration plan

Open an existing migration planOpen an existing migration plan

NOTENOTE

7. When Analyze is complete, it will prompt you to save your migration plan.

5. Below the subscription list, select the Resource Group that contains your workspace collections and select
Select.

6. Select Analyze. This will get an inventory of the items within your Azure subscription for you to begin your
plan.

The analyze process could take several minutes depending on the number of Workspace collections and how much
content exists in the workspace collection.

At this point, you have connected your migration plan to your Azure subscription. Read below to understand the
flow of how to work with your migration plan. This includes Analyze & Plan Migration, Download, Create Groups
and Upload.

You can save your migration plan for use later. This will create an XML file that contained all the information in
your migration plan.

To save your migration plan, do the following.

2. Give your file a name or use the generated file name and select Save.

1. Select File > Save Migration Plan.

You can open a saved migration plan to continue working on your migration.



Step 1: Analyze & Plan Migration

PaaS TopologyPaaS Topology

ReportsReports

To open your existing migration plan, do the following.

2. Select your migration file and select Open.

1. Select File > Open Existing Migration Plan.

The Analyze & Plan Migration tab gives you a view of what is currently in your Azure subscription’s resource
group.

We will look at the SampleResourceGroup as an example.

This is a listing of your Resource Group > Workspace collections > Workspaces. The resource group and
workspace collections will show a friendly name. The workspaces will show a GUID.

The items in the list will also display a color and a number in the format of (#/#). This indicates the number of
reports that can be downloaded. A black color means that all reports can be downloaded.

A red color means that some reports cannot be downloaded. The left number will indicate the total number of
reports that can be downloaded. The number on the right indicates the total number of reports within the
grouping.

You can select an item within the PaaS topology to display the reports in the reports section.

The reports section will list out the reports available and indicates whether it can be downloaded or not.



Target structureTarget structure

Download PlanDownload Plan

NOTENOTE

Upload PlanUpload Plan

NOTENOTE

The Target structure is where you tell the tool where things will be downloaded to and how to upload them.

A path will automatically be created for you. You can change this path if you wish. If you do change the path, you
will need to select Update paths.

This does not actually perform the download. This is only specifying the structure of where the reports will be downloaded
to.

Here you can specify a prefix to be used for the App Workspaces that will be created within the Power BI service.
After the prefix will be the GUID for the workspace that existed in Azure.

This does not actually create the groups within the Power BI service. This only defines the naming structure for the groups.

If you change the prefix, you will need to select Generate Upload Plan.

You can right click on a group and choose to rename the group within the Upload plan directly, if desired.



NOTENOTE

Step 2: Download

The name of the group must not contain spaces or invalid characters.

On the Download tab, you will see the list of reports and associated metadata. You can see what the export status
is along with the previous export status.

You have two options.

Select specific reports and select Download Selected
Select Download All.

For a successful download, you will see a status of Done and it will reflect that the PBIX file exists.

After the download is completed, select the Create Groups tab.



Step 3: Create Groups

Step 4: Upload

After you have downloaded the reports that are available, you can go to the Create Groups tab. This tab will
create the app workspaces within the Power BI service based on the migration plan that you created. It will create
the app workspace with the name you provided on the Upload tab within Analyze & Plan Migration.

To create the app workspaces, you can select either Create Selected Groups or Create All Missing Groups.

When you select either of these options, you will be prompted to sign in. You will want to use your credentials for
the Power BI service that you want to create the app workspaces on.

This will create the app workspace within the Power BI service. This does not upload the reports to the app
workspace.

You can verify that the app workspace was created by signing into Power BI and validating that the workspace
exists. You will notice that nothing is in the workspace.

After the workspace is created, you can move onto the Upload tab.

On the Upload tab, this will upload the reports to the Power BI service. You will see a list of the reports that we
downloaded on the Download tab along with the target group name based on your migration plan.



Duplicate report namesDuplicate report names

You can upload selected reports, or you could upload all the reports. You can also reset the upload status to re-
upload items.

You also have the option of selecting what to do if a report with the same name exists. You can choose between
Abort, Ignore and Overwrite.

If you have a report that has the same name, but you know it is a different report, you will need to change the
TargetName of the report. You can change the name by manually editing the migration plan XML.

You will need to close the migration tool to make the change and then re-open the tool and the migration plan.

In the above example, one of the cloned reports failed indicating a report with the same name existed. If we go
look at the migration plan XML, we will see the following.



<ReportMigrationData>
    <PaaSWorkspaceCollectionName>SampleWorkspaceCollection</PaaSWorkspaceCollectionName>
    <PaaSWorkspaceId>4c04147b-d8fc-478b-8dcb-bcf687149823</PaaSWorkspaceId>
    <PaaSReportId>525a8328-b8cc-4f0d-b2cb-c3a9b4ba2efe</PaaSReportId>
    <PaaSReportLastImportTime>1/3/2017 2:10:19 PM</PaaSReportLastImportTime>
    <PaaSReportName>cloned</PaaSReportName>
    <IsPushDataset>false</IsPushDataset>
    <IsBoundToOldDataset>false</IsBoundToOldDataset>
    <PbixPath>C:\MigrationData\SampleResourceGroup\SampleWorkspaceCollection\4c04147b-d8fc-478b-8dcb-
bcf687149823\cloned-525a8328-b8cc-4f0d-b2cb-c3a9b4ba2efe.pbix</PbixPath>
    <ExportState>Done</ExportState>
    <LastExportStatus>OK</LastExportStatus>
    <SaaSTargetGroupName>SampleMigrate</SaaSTargetGroupName>
    <SaaSTargetGroupId>6da6f072-0135-4e6c-bc92-0886d8aeb79d</SaaSTargetGroupId>
    <SaaSTargetReportName>cloned</SaaSTargetReportName>
    <SaaSImportState>Failed</SaaSImportState>
    <SaaSImportError>Report with the same name already exists</SaaSImportError>
</ReportMigrationData>

<SaaSTargetReportName>cloned2</SaaSTargetReportName>

Upload a local PBIX fileUpload a local PBIX file

<PbixPath>[Full Path to PBIX file]</PbixPath>

DirectQuery reportsDirectQuery reports

For the failed item, we can change the name of the SaaSTargetReportName.

We can then re-open the plan, in the migration tool, and upload the failed report.

Going back to Power BI, we can see that the reports and datasets have been uploaded in the app workspace.

 

You can upload a local version of a Power BI Desktop file. You will have to close the tool, edit the XML and put the
full path to your local PBIX in the PbixPath property.

After you have edited the xml, re-open the plan within the migration tool and upload the report.

 

You will need to update to update the connection string for DirectQuery reports. This can be done within
powerbi.com, or you can programmatically query the connection string from Power BI Embedded (Paas). For an
example, see Extract DirectQuery connection string from PaaS report.

You can then update the connection string for the dataset within the Power BI service (Saas) and set the credentials



Embedding

Next steps

for the data source. You can look at the following examples to see how to do this.

Update DirectQuery connection string is SaaS workspace
Set DirectQuery credentials in SaaS workspace

Now that your reports have been migrated from the Power BI Embedded Azure service to the Power BI service,
you can now update your application and begin embedding the reports in this app workspace.

For more information, see How to migrate Power BI Embedded workspace collection content to Power BI.

Embedding with Power BI
How to migrate Power BI Embedded workspace collection content to Power BI
Power BI Premium - what is it?
JavaScript API Git repo
Power BI C# Git repo
JavaScript embed sample
Power BI Premium whitepaper

More questions? Try asking the Power BI Community

https://github.com/Microsoft/PowerBI-JavaScript
https://github.com/Microsoft/PowerBI-CSharp
https://microsoft.github.io/PowerBI-JavaScript/demo/
https://aka.ms/pbipremiumwhitepaper
http://community.powerbi.com/


Code snippets for migrating content from Power BI
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using Microsoft.IdentityModel.Clients.ActiveDirectory;
using Microsoft.PowerBI.Api.V1;
using Microsoft.PowerBI.Api.V1.Models;
using Microsoft.PowerBI.Api.V2;
using Microsoft.PowerBI.Api.V2.Models;
using Microsoft.Rest;
using Microsoft.Rest.Serialization;
using Newtonsoft.Json;
using Newtonsoft.Json.Linq;
using System;
using System.Collections.Generic;
using System.IO;
using System.Linq;
using System.Net;
using System.Net.Http;
using System.Net.Http.Headers;
using System.Text;
using System.Threading.Tasks;

Export report from PaaS workspace

Here are some code snippets of basic operations needed for content migration. For related flows for certain report
types, see How to migrate Power BI Embedded workspace collection content to Power BI.

A migration tool is available for you to use in order to assist with copying content from Power BI Embedded
(PaaS) to the Power BI service (SaaS). Especially if you have a lot of content. For more information, see Power BI
Embedded migration tool.

The code below are examples using C# and the Power BI .NET SDK.

Make sure you are using the following namespaces to execute the code snippets below.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/developer/migrate-code-snippets.md
https://www.nuget.org/profiles/powerbi


  

  

    // Create a token credentials with "AppKey" type
    var credentials = new TokenCredentials(<myAppKey==>, "AppKey");

    // Instantiate your Power BI client passing in the required credentials
    var client = new PowerBIClient(credentials);

    client.BaseUri = new Uri("https://api.powerbi.com");

    var response = client.Reports.ExportReportWithHttpMessagesAsync(<myWorkspaceCollectionName>, 
<myWorkspaceId>, <myReportId>);

    if (response.Result.Response.StatusCode == HttpStatusCode.OK)
    {
        var stream = response.Result.Response.Content.ReadAsStreamAsync();

        using (FileStream fileStream = File.Create(@"C:\Migration\myfile.pbix"))
        {
            stream.Result.CopyTo(fileStream);
            fileStream.Close();
        }
    }

Import report to SaaS workspace
    AuthenticationContext authContext = new 
AuthenticationContext("https://login.windows.net/common/oauth2/authorize");
    var PBISaaSAuthResult = authContext.AcquireToken("https://analysis.windows.net/powerbi/api", <myClientId>, 
new Uri("urn:ietf:wg:oauth:2.0:oob"), PromptBehavior.Always);
    var credentials = new TokenCredentials(PBISaaSAuthResult.AccessToken);
    var client = new PowerBIClient(new Uri($"{"https://api.powerbi.com"}"), credentials);
    using (var file = File.Open(@"C:\Migration\myfile.pbix", FileMode.Open))
    {
        client.Imports.PostImportWithFileInGroup(<mySaaSWorkspaceId>, file, "importedreport", "Abort");
        while (true) ;
    }

Extract DirectQuery connection string from PaaS report

    // Extract connection string from PaaS - DirectQuery report
    // Create a token credentials with "AppKey" type
    var credentials = new TokenCredentials(<myAppKey==>, "AppKey");

    // Instantiate your Power BI client passing in the required credentials
    var client = new PowerBIClient(credentials);

    client.BaseUri = new Uri("https://api.powerbi.com");

    var reports = client.Reports.GetReports(<myWorkspaceCollectionName>, <myWorkspaceId>);

    Report report = reports.Value.FirstOrDefault(r => string.Equals(r.Id, <myReportId, 
StringComparison.OrdinalIgnoreCase));

    var datasource = client.Datasets.GetDatasources(<myWorkspaceCollectionName>, <myWorkspaceId>, 
report.DatasetId);

Update DirectQuery connection string is SaaS workspace

This is for updating the PBIX after migrating to SaaS.



  

    public class ConnectionString
    {
        [JsonProperty(PropertyName = "connectionString")]
        public string connection { get; set; }
    }

    AuthenticationContext authContext = new 
AuthenticationContext("https://login.windows.net/common/oauth2/authorize");
    var PBISaaSAuthResult = authContext.AcquireToken("https://analysis.windows.net/powerbi/api",<myclient_id>, 
new Uri("urn:ietf:wg:oauth:2.0:oob"), PromptBehavior.Always);
    var credentials = new TokenCredentials(PBISaaSAuthResult.AccessToken);
    var client = new PowerBIClient(new Uri($"{"https://api.powerbi.com"}"), credentials);

    ConnectionString connection = new ConnectionString() { connection = "data source = <server_name>; initial 
catalog = <db_name>; persist security info = True; encrypt = True; trustservercertificate = False" };

    client.Datasets.SetAllConnectionsInGroup(<myWorkspaceId>, <dataset_id>, connection);

Set DirectQuery credentials in SaaS workspace

    public class ConnectionString
    {
        [JsonProperty(PropertyName = "connectionString")]
        public string connection { get; set; }
    }

    public class BasicCreds
    {
        [JsonProperty(PropertyName = "username")]
        public string user { get; set; }

        [JsonProperty(PropertyName = "password")]
        public string pwd { get; set; }
    }

    var basicCreds = new BasicCreds() { user = <sqldb_username>, pwd = <sqldb_password> };
    var body = new SetCredsRequestBody() { credentialType = "Basic", basicCreds = basicCreds };

    var url = string.Format("https://api.powerbi.com/v1.0/myorg/gateways/{0}/datasources/{1}", <gateway_id>, 
<datasource_id>);
    var request = new HttpRequestMessage(new HttpMethod("PATCH"), url);
    // Set authorization header from you acquired Azure AD token
    AuthenticationContext authContext = new 
AuthenticationContext("https://login.windows.net/common/oauth2/authorize");
    var PBISaaSAuthResult = authContext.AcquireToken("https://analysis.windows.net/powerbi/api", 
<myclient_id>, new Uri("urn:ietf:wg:oauth:2.0:oob"), PromptBehavior.Always);

    request.Headers.Authorization = new AuthenticationHeaderValue("Bearer", PBISaaSAuthResult.AccessToken);

    request.Content = new StringContent(JsonConvert.SerializeObject(body), Encoding.UTF8, "application/json");

    HttpClient simpleClient = new HttpClient();
    var response = await simpleClient.SendAsync(request);

Push dataset & report

In this snippet, we are using unencrypted credentials for simplicity, sending encrypted credentials is supported as
well.

You will need to rebuild the report for the created dataset.

In this snippet, we assume that the pushable dataset is already in an app workspace within the SaaS environment.



For information about the push API, see Push data into a Power BI dataset.



    var credentials = new TokenCredentials(<Your WSC access key>, "AppKey");

    // Instantiate your Power BI client passing in the required credentials
    var client = new Microsoft.PowerBI.Api.V1.PowerBIClient(credentials);
    client.BaseUri = new Uri("https://api.powerbi.com");

    // step 1 -> create dummy dataset at PaaS worksapce
    var fileStream = File.OpenRead(<Path to your dummy dataset>);
    var import = client.Imports.PostImportWithFileAsync(<Your WSC NAME>, <Your workspace ID>, fileStream, 
"dummyDataset");
    while (import.Result.ImportState != "Succeeded" && import.Result.ImportState != "Failed")
    {
        import = client.Imports.GetImportByIdAsync(<Your WSC NAME>, <Your workspace ID>, import.Result.Id);
        Thread.Sleep(1000);
    }
    var dummyDatasetID = import.Result.Datasets[0].Id;

    // step 2 -> clone the pushable dataset and rebind to dummy dataset
    var cloneInfo = new Microsoft.PowerBI.Api.V1.Models.CloneReportRequest("pushableReportClone",null, 
dummyDatasetID);
    var clone = client.Reports.CloneReportAsync(<Your WSC NAME>, <Your workspace ID>, <Your pushable report 
ID>, cloneInfo);
    var pushableReportCloneID = clone.Result.Id;

    // step 3 -> Download the push API clone report with the dummy dataset
    var response = client.Reports.ExportReportWithHttpMessagesAsync(<Your WSC NAME>, <Your workspace ID>, 
pushableReportCloneID);
    if (response.Result.Response.StatusCode == HttpStatusCode.OK)
    {
        var stream = response.Result.Response.Content.ReadAsStreamAsync();
        using (fileStream = File.Create(@"C:\Migration\PushAPIReport.pbix"))
        {
            stream.Result.CopyTo(fileStream);
            fileStream.Close();
        }
    }

    // step 4 -> Upload dummy PBIX to SaaS workspace
    AuthenticationContext authContext = new 
AuthenticationContext("https://login.windows.net/common/oauth2/authorize");
    var PBISaaSAuthResult = authContext.AcquireToken("https://analysis.windows.net/powerbi/api", <Your client 
ID>, new Uri("urn:ietf:wg:oauth:2.0:oob"), PromptBehavior.Always);
    var credentialsSaaS = new TokenCredentials(PBISaaSAuthResult.AccessToken);
    var clientSaaS = new Microsoft.PowerBI.Api.V2.PowerBIClient(new Uri($"{"https://api.powerbi.com"}"), 
credentialsSaaS);
    using (var file = File.Open(@"C:\Migration\PushAPIReport.pbix", FileMode.Open))
    {

        var importSaaS = clientSaaS.Imports.PostImportWithFileAsyncInGroup(<Your GroupID>, file, 
"importedreport1", "Abort");
        while (importSaaS.Result.ImportState != "Succeeded" && importSaaS.Result.ImportState != "Failed")
        {
            importSaaS = clientSaaS.Imports.GetImportByIdAsync(importSaaS.Result.Id);
            Thread.Sleep(1000);
        }
        var importedreport1ID = importSaaS.Result.Reports[0].Id;

        // step 5 -> Rebind report to "real" push api dataset
        var rebindInfoSaaS = new Microsoft.PowerBI.Api.V2.Models.RebindReportRequest(<Your pushable dataset  
ID at power bi>);
        var rebindSaaS = clientSaaS.Reports.RebindReportInGroupWithHttpMessagesAsync(<Your GroupID>, 
importedreport1ID, rebindInfoSaaS);

    }



Next steps
Power BI Embedded migration tool
Embedding with Power BI
How to migrate Power BI Embedded workspace collection content to Power BI
How to embed your Power BI dashboards, reports and tiles
Power BI Premium - what is it?
JavaScript API Git repo
Power BI C# Git repo
JavaScript embed sample
Power BI Premium whitepaper

More questions? Try asking the Power BI Community

https://github.com/Microsoft/PowerBI-JavaScript
https://github.com/Microsoft/PowerBI-CSharp
https://microsoft.github.io/PowerBI-JavaScript/demo/
https://aka.ms/pbipremiumwhitepaper
http://community.powerbi.com/
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Tools for troubleshooting
Fiddler TraceFiddler Trace

F12 in Browser for front end debuggingF12 in Browser for front end debugging

Extracting error details from Power BI responseExtracting error details from Power BI response

public static string GetExceptionText(this HttpOperationException exc)
{
    var errorText = string.Format("Request: {0}\r\nStatus: {1} ({2})\r\nResponse: {3}",
    exc.Request.Content, exc.Response.StatusCode, (int)exc.Response.StatusCode, exc.Response.Content);
    if (exc.Response.Headers.ContainsKey("RequestId"))
    {
        var requestId = exc.Response.Headers["RequestId"].FirstOrDefault();
        errorText += string.Format("\r\nRequestId: {0}", requestId);
    }

    return errorText;
}

This article discusses some common issues you may encounter when embedding content from Power BI.

Fiddler is a free tool from Telerik that monitors HTTP traffic. You can see the back and forth with the Power BI APIs
from the client machine. This may show errors and other related information.

F12 will launch the developer window within your browser. This provides the ability to look at network traffic and
other information.

This code snippet shows how to extract the error details from HTTP exception:

We recommend logging the request ids (and error details for troubleshooting). Please provide the request id when
approaching Microsoft support.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/developer/embedded-troubleshoot.md
http://www.telerik.com/fiddler


App registration

REST API

    GET https://wabi-us-north-central-redirect.analysis.windows.net/metadata/cluster HTTP/1.1
    Host: wabi-us-north-central-redirect.analysis.windows.net
    ...
    Authorization: Bearer eyJ0eXAiOi...
    ...

    HTTP/1.1 403 Forbidden
    ...

    {"error":{"code":"TokenExpired","message":"Access token has expired, resubmit with a new access token"}}

App registration failure

Error messages within the Azure portal or the Power BI app registration page will mention insufficient privileges. In
order to register an application, you must be an admin in the Azure AD tenant or application registrations must be
enabled for non-admin users.

Power BI Service does not appear in Azure portal when registering a new App

At least one user must be signed up for Power BI. If you do not see Power BI Service listed within the API list, no
user is signed up for Power BI.

API call returning 401

A fiddler capture may be required to investigate further. The required permission scope may be missing for the
registered application within Azure AD. Verify the required scope is present within the app registration for Azure
AD within the Azure portal.

API call returning 403

A fiddler capture may be required to investigate further. There could be several reason for a 403 error.

The Azure AD auth token expired.
The authenticated user is not a member of the group (app workspace).
The authenticated user is not an admin of the group (app workspace).
The authorization header may not be listed correctly. Make sure there are no typos.

The backend of the application may need to refresh the auth token before calling GenerateToken.

Generate token fails when providing effective identity

GenerateToken can fail, with effective identity supplied, for a few different reasons.

Dataset does not support effective identity
Username was not provided
Role was not provided
DatasetId was not provided
User doesn't have the correct permissions

To verify which it is, try the following.

Execute the get dataset. Is the property IsEffectiveIdentityRequired true?
Username is mandatory for any EffectiveIdentity.
If IsEffectiveIdentityRolesRequired is true, Role is required.

https://msdn.microsoft.com/library/mt784653.aspx


Data sources

Content rendering

DatasetId is mandatory for any EffectiveIdentity.
For Analysis Services, the master user has to be a gateway admin.

ISV wants to have different credentials for the same data source

A data source can have a single set of credentials for one master user. If you need to use different credentials,
create additional master users. Then, assign the different credentials in each of the master users context, and embed
using the Azure AD token of that user.

Rendering, or consumption, of embedded content fails or times out

Make sure the embed token did not expire. Make sure you are checking the embed token expiration and refreshing
it. For more information, see Refresh token using JavaScript SDK.

Report or dashboard does not load

If the user is unable to see the report or dashboard, make sure the report or dashboard loads correctly within
powerbi.com. The report or dashboard will not work within your application if it doesn't load within powerbi.com.

Report or dashboard is performing slowly

Open the file from Power BI Desktop, or within powerbi.com, and verify that performance is acceptable to rule out
issues with your application or the embedding apis.

For answers to frequently asked questions, see the Power BI Embedded FAQ.

More questions? Try the Power BI Community

https://github.com/Microsoft/PowerBI-JavaScript/wiki/Refresh-token-using-JavaScript-SDK-example
http://community.powerbi.com/
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General
What is Power BI Embedded?What is Power BI Embedded?

Who is the target audience for Power BI Embedded?Who is the target audience for Power BI Embedded?

How is Power BI Embedded different from Power BI the service?How is Power BI Embedded different from Power BI the service?

What is the difference between Power BI Premium and Power BI Embedded?What is the difference between Power BI Premium and Power BI Embedded?

What is the Microsoft recommendation for when a customer should buy Power BI Premium vs Power BIWhat is the Microsoft recommendation for when a customer should buy Power BI Premium vs Power BI
Embedded?Embedded?

If you have other questions, try asking the Power BI Community.
Still have an issue? Please visit the Power BI support page.

Microsoft Power BI Embedded allows application developers to embed stunning, fully interactive reports,
dashboards and tiles into applications without the time and expense of building their own data visualizations and
controls from the ground-up.

Developers and software companies making their own applications referred to as independent software vendors
(ISVs).

Power BI Embedded is intended for ISVs or developers who are building applications and want to embed visuals
into those applications to help their customers make decisions without building an analytics’ solution from the
ground up. Embedded analytics enables business users to access the business data and perform queries to
generate insights using this data within the application.

Power BI, on the other hand, is a software-as-a-service analytics solution that gives organizations a single view of
their most critical business data.

Power BI Premium is capacity geared toward enterprises, who want a complete BI solution that provides a single
view of its organization, partners, customers, and suppliers. Power BI Premium helps your organization make
decisions. Power BI Premium is a SaaS product and comes with the ability for users to consume content through
the Power BI portal, mobile app, and through internally developed apps.

Power BI Embedded is for ISVs or developers who are building applications and want to embed visuals into those
applications. Power BI Embedded helps your customers make decisions because Power BI Embedded is for
application developers, customers of that application can consume content stored on Power BI Embedded capacity,
including anyone inside or outside the organization. Power BI Embedded capacity content cannot be shared
through one-click publish to Web or one-click publish to SharePoint, and it does not support SSRS reports.

The recommendation of Microsoft is that enterprises buy Power BI Premium, an enterprise-grade, self-service
cloud BI solution, and ISVs buy Power BI Embedded, cloud-powered embedded analytics components. However,
there are no restrictions on which product a customer can buy.

There may be some cases where an ISV (typically large) wants to use a P SKU to get the additional benefits of the
pre-packaged Power BI service within their organization as well as embed in their applications. And of course,
some Enterprises may decide to use A SKUs in Azure if they are only interested in building line of business
applications and embedding analytics into them and are not interested in using the pre-packaged Power BI service.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/developer/embedded-faq.md
http://community.powerbi.com/
https://powerbi.microsoft.com/support/


How many embed tokens can I create?How many embed tokens can I create?

When will Power BI Embedded be available in Azure?When will Power BI Embedded be available in Azure?

Technical
What is the difference between the A SKUs in Azure and EM SKUs in Office 365?What is the difference between the A SKUs in Azure and EM SKUs in Office 365?

FEATURE
POWER BI EMBEDDED
(A SKUS)

POWER BI PREMIUM CAPACITY
(EM SKUS)

Embed artifacts from a Power BI App
workspaces

Azure capacity Office 365 capacity

Power BI license required to consume
reports

No Yes

Consume Power BI reports in an
Embedded application

Yes Yes

Consume Power BI reports in
SharePoint

No Yes

Consume Power BI reports in Teams No Yes

Power BI now offers three SKUs for embedding: A SKUs, EM SKUs and P SKUs. Which one should I purchasePower BI now offers three SKUs for embedding: A SKUs, EM SKUs and P SKUs. Which one should I purchase
for my scenario?for my scenario?

A SKU (POWER BI EMBEDDED) EM SKU (POWER BI PREMIUM) P SKU (POWER BI PREMIUM)

Purchase Azure portal Office Office

Use cases * Embed content in your
own application

* Embed content in your
own application
* Share content with Power
BI FREE users outside
PowerBI.com and embed in
other SaaS applications
(SharePoint, Teams)

* Embed content in your
own application
* Share content with Power
BI FREE users outside
PowerBI.com and embed in
other SaaS applications
(SharePoint, Teams)
* Share content with Power
BI FREE users through
PowerBI.com

Billing Hourly Monthly Monthly

Embed tokens with PRO license are intended for development and dev testing, so the number of embed tokens a
Power BI master account can generate is limited. You must purchase a capacity for embedding in a production
environment. There is no limit to how many embed tokens you can generate when a capacity is purchased.

Power BI Embedded is now available.

PowerBI.com is an enterprise solution that includes many capabilities like social collaboration, email subscription,
etc. in a Software as a Service offering

Power BI Embedded is a set of APIs available for developers to create an embedded analytics solution in a Platform
as a Service offering. For the Embedded analytics scenario, PowerBI.com should be used to help ISVs and
developers manage their embedded analytics solution content and tenant level settings.

Here is a partial list of differences you may use with each.

https://docs.microsoft.com/power-bi/developer/embedded-faq#technical


Commitment No commitment Yearly Monthly/Yearly

Differentiation Full elasticity- can scale up/
down, pause/ resume
resources in Azure portal or
through API

Can be used to embed
content in SharePoint Online
and Microsoft Teams

Combine embedding in
applications and use the
Power BI Service in the same
capacity

A SKU (POWER BI EMBEDDED) EM SKU (POWER BI PREMIUM) P SKU (POWER BI PREMIUM)

What are the prerequisites to create a PBIE capacity in Azure?What are the prerequisites to create a PBIE capacity in Azure?

How can I monitor capacity consumption?How can I monitor capacity consumption?

Will my capacity scale automatically to adjust to the consumption of my app?Will my capacity scale automatically to adjust to the consumption of my app?

What is the authentication model for Power BI Embedded?What is the authentication model for Power BI Embedded?

How is Power BI Embedded different from other Azure services?How is Power BI Embedded different from other Azure services?

What deploy regions are supported?What deploy regions are supported?

Licensing
How do I purchase Power BI Embedded?How do I purchase Power BI Embedded?

How Power BI Embedded be metered?How Power BI Embedded be metered?

How does the usage of Power BI Embedded show up on my bill?How does the usage of Power BI Embedded show up on my bill?

You need to sign in to your organizational directory (MSA accounts are not supported).
You need to have a Power BI tenant, i.e., at least one user in your directory has signed up to Power BI.
You need to have an Azure subscription in your organizational directory.

Monitoring through Azure is on the near-term roadmap. The Azure resource, Power BI Embedded, will include
monitoring KPIs that will show health, and usage.

While there is no automated scaling now, all the APIs are available to scale at any time.

Power BI Embedded will continue to use Azure AD for authentication of the master user (a designated Power BI Pro
licensed user), authenticating the application inside Power BI.

The authentication and authorization of the application users will be implemented by the ISV, the ISV can
implement their own authentication for their applications.

If you already have an Azure AD tenant, you can use your existing directory, or you can create a new Azure AD
tenant for your embedded application content security.

The ISV/developer must have a Power BI account before the purchase of Power BI Embedded in Azure. Your Power
BI Embedded deploy region is determined by your Power BI account. Manage your Power BI Embedded resource in
Azure to:

Scale up/down
Add capacity admins
Pause/resume of service

Use PowerBI.com to assign/un-assign workspaces to your Power BI Embedded capacity.

Australia Southeast, Brazil South, Canada Central, East US 2, India West, Japan East, North Central US, North
Europe, South Central US, Southeast Asia, UK South, West Europe, West US, and West US 2.

Power BI Embedded is available through Azure.

Power BI Embedded will have an hourly meter.



What happens if I already purchased Power BI Premium and now I want some of the benefits of Power BIWhat happens if I already purchased Power BI Premium and now I want some of the benefits of Power BI
Embedded in Azure?Embedded in Azure?

Do I still have to buy Power BI Premium to get access to Power BI Embedded?Do I still have to buy Power BI Premium to get access to Power BI Embedded?

Who needs a Power BI Pro license for Power BI Embedded and why?Who needs a Power BI Pro license for Power BI Embedded and why?

Can I get started for free?Can I get started for free?

Can I get a trial experience for Power BI Embedded in Azure?Can I get a trial experience for Power BI Embedded in Azure?

What’s the purchase commitment for Power BI Embedded?What’s the purchase commitment for Power BI Embedded?

Where is Power BI Embedded available? US Government? Germany? China? What is the timing?Where is Power BI Embedded available? US Government? Germany? China? What is the timing?

Is Power BI Embedded available for non-profits and educational?Is Power BI Embedded available for non-profits and educational?

Power BI Embedded bills on a predictable hourly rate based on the type of node(s) deployed. Note that as long as
your resource is active, you will be billed even if there is no usage. To stop being billed you need to actively pause
your resource. Pausing can be done through Azure or through ARM APIs.

Customers will continue to pay for any existing Power BI Premium purchases until the end of their current
agreement term and then may switch their Power BI Premium purchases as necessary at that point.

No, Power BI Embedded includes the Azure based capacity that you need to deploy and distribute your solution to
customers.

It is required that any analyst that needs to add reports to a Power BI workspace, any developer that requires use of
the REST APIs, any tenant admin that needs to manage the Power BI tenant and capacity will need a Power BI Pro
license.

Because Power BI Embedded allows use of the Power BI portal for managing and validating embedded content, the
Power BI Pro license is required to authenticate the App inside PowerBI.com to get access to the reports in the right
repositories.

Yes, you can use your Azure credits for Power BI Embedded.

Since Power BI Embedded is a part of Azure it is possible to use the service with the $200 credit received when
signing up for Azure.

Customers may change their usage on an hourly basis. There is no monthly or annual commitment for the Power
BI Embedded service.

Power BI Embedded will be available in Azure commercial clouds at GA. Sovereign cloud availability will be added
in the future.

Non-profit and educational entities can purchase Azure. There is no special pricing for these types of customers in
Azure.

More questions? Try the Power BI Community

https://azure.microsoft.com/free/
https://azure.microsoft.com/free/
http://community.powerbi.com/


 

Use developer tools to create custom visuals
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NOTENOTE

Requirements

Install NodeJS and the Power BI tools

Custom visuals allow you to meet your users' needs and match your app's design. Learn how to create a custom
visual for Power BI using the developer tools.

You can use this document to get up and running. For more in-depth information, see the reference information within the
Power BI Visuals git repo.

NodeJS 4.0+ Required (5.0 or later recommended) Download NodeJS

In order to create a custom visual, you will need to install NodeJS. NodeJS is required to run the command line
tools.

1. Download and install NodeJS. Version 4.0 or later is required but it is recommended to have 5.0 or later.

 npm install -g powerbi-visuals-tools

 pbiviz

2. Install the command line tools. Run the following command from a command prompt.

3. You can confirm that the tools are installed by running the following command without any parameters.

You should see the help output.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-custom-visuals-getting-started-with-developer-tools.md
https://github.com/Microsoft/PowerBI-visuals
https://nodejs.org
https://nodejs.org


Server Certificate setupServer Certificate setup

NOTENOTE

pbiviz --install-cert

      +syyso+/
 oms/+osyhdhyso/
 ym/       /+oshddhys+/
 ym/              /+oyhddhyo+/
 ym/                     /osyhdho
 ym/                           sm+
 ym/               yddy        om+
 ym/         shho /mmmm/       om+
  /    oys/ +mmmm /mmmm/       om+
 oso  ommmh +mmmm /mmmm/       om+
ymmmy smmmh +mmmm /mmmm/       om+
ymmmy smmmh +mmmm /mmmm/       om+
ymmmy smmmh +mmmm /mmmm/       om+
+dmd+ smmmh +mmmm /mmmm/       om+
      /hmdo +mmmm /mmmm/ /so+//ym/
            /dmmh /mmmm/ /osyhhy/
              //   dmmd
                    ++

    PowerBI Custom Visual Tool

 Usage: pbiviz [options] [command]

 Commands:

 new [name]        Create a new visual
 info              Display info about the current visual
 start             Start the current visual
 package           Package the current visual into a pbiviz file
 update [version]  Updates the api definitions and schemas in the current visual. Changes the version 
if specified
 help [cmd]        display help for [cmd]

 Options:

 -h, --help      output usage information
 -V, --version   output the version number
 --install-cert  Install localhost certificate
 

<a name"ssl-setup">

To enable a live preview of your visual, a trusted https server is needed. Before you can start, you will need to
install an SSL certificate which will allow visual assets to load in your web browser.

This is a one-time setup for your developer workstation.

To add a certificate, run the following command.

Windows OS

1. Select Install Certificate....



3. Select Place all certificate in the following store and select Browse....

2. Select Current User and then select Next.

4. Select Trusted Root Certification Authorities and then select OK. Select Next.



7. Close any browsers that you have open.

5. Select Finish.

6. Select Yes on the security warning dialog.



NOTENOTE
If the certificate is not recognized, you may need to restart your computer.

OSX

1. If the lock in the upper left is locked, select it to unlock. Search for localhost and double click on the
certificate.

2. Select Always Trust and close the window.

3. Enter your username and password. Select Update Settings.



 

NOTENOTE

Enable live preview of developer visual

4. Close any browsers that you have open.

If the certificate is not recognized, you may need to restart your computer.

To enable a live preview of your custom visual, follow these steps. This allows the visual to be used within the
Power BI service when editing reports.

1. Browse and sign into app.powerbi.com.
2. Select the gear icon and then select Settings.

3. Select Developer and then select Enable developer visual for testing.

4. Select the Developer Visual in the Visualization pane.

https://app.powerbi.com


 Create a new visual

pbiviz new My Visual name

Testing your visual in Power BI

Running your visualRunning your visual

NOTENOTE

5. Select the visual in the report canvas. You can bind data in the same way you do other visuals.

This requires that you have run pbiviz start  from the visual folder on your development machine. For more
information on creating your visual, see Create a new visual in this article.

You can now begin developing your visual.

You can create a new visual project by running the following command.

You can replace My Visual Name with the name you want to give the visual. This can be changed later by
modifying the name  and displayName  fields within the generated pbiviz.json  file.

This command will create a new folder in the direct where the command was run. It will generate a basic starter
template for your visual. Once the command completes, you can open the directory and use your favorite editor
to start working on your new visual.

You can test your visual within the Power BI service within reports and dashboards.

   

You can run your visual by doing the following.

1. Open a prompt.
2. Change your directory to be your visual folder. This is the folder that contains the pbiviz.json  file.

pbiviz start

3. Run the following command.

If you are in the wrong location, you will see an error similar to the following.



    error  LOAD ERROR Error: pbiviz.json not found. You must be in the root of a visual project to run this 
command.
        at e (C:\Users\[user]\AppData\Roaming\npm\node_modules\powerbi-visuals-
tools\lib\VisualPackage.js:67:35)
        at Function.loadVisualPackage (C:\Users\[user]\AppData\Roaming\npm\node_modules\powerbi-visuals-
tools\lib\VisualPackage.js:62:16)
        at Object.<anonymous> (C:\Users\[user]\AppData\Roaming\npm\node_modules\powerbi-visuals-
tools\bin\pbiviz-start.js:43:15)
        at Module._compile (module.js:556:32)
        at Object.Module._extensions..js (module.js:565:10)
        at Module.load (module.js:473:32)
        at tryModuleLoad (module.js:432:12)
        at Function.Module._load (module.js:424:3)
        at Module.runMain (module.js:590:10)
        at run (bootstrap_node.js:394:7)

Viewing your visual in Power BIViewing your visual in Power BI

NOTENOTE

TOOLBAR ITEM DESCRIPTION

Refresh visual Manually refresh the visual if auto reload is disabled.

Toggle auto reload When turned on, the visual will automatically update every
time you save your visual file.

Show dataview Shows the visual's underlying data view for debugging

Get help Documentation within GitHub

To view your visual in a report, go to that report and select the visual within the Visualizations pane.

You must run the pbiviz start  command before doing this as discribed in the Running your visual section.

You will then see the starter template for the visual.



Send feedback Let us know if there is anyway we can improve the
experience! (Requires GitHub account)

TOOLBAR ITEM DESCRIPTION

Package your visual for use in Power BI Desktop and distribution

Updating the visuals API version

Updating your existing API versionUpdating your existing API version

#Update your version of pbiviz
npm install -g powerbi-visuals-tools

#Run update from the root of your visual project, where pbiviz.json is located
pbiviz update

Upgrading to a different API versionUpgrading to a different API version

#Update your version of pbiviz
npm install -g powerbi-visuals-tools

#Run update from the root of your visual project, where pbiviz.json is located
pbiviz update 1.2.0

Before you can load your visual into Power BI Desktop, or share it with the community in the Power BI Visual
gallery, you'll need to generate a pbiviz  file.

You can package your visual by doing the following.

1. Open a prompt.
2. Change your directory to be your visual folder. This is the folder that contains the pbiviz.json  file.

pbiviz package

3. Run the following command.

This command will create a pbiviz  in the dist/  directory of your visual project. If there is already a pbiviz  file
present, it will be overwritten.

When you create a visual using pbiviz new , a copy of the appropriate API type definitions and json schemas are
copied into your visual's directory. You can use the pbiviz update  command to update these files if needed. This
can be useful if we release a fix for a past API version or if you want to update to the latest API version.

If we release an update to an existing API, you can get the latest version by doing the following.

This will download the latest tools from npm which include the updated type definitions and schemas. Using 
pbiviz update  will overwrite the apiVersion  property in your pbiviz.json fiel with the latest version.

You can update to a different API version by using the same steps as mentioned above. You can explicitly specify
the API version you want to use.

This would update yoru visual to API version 1.2.0. You can replace 1.2.0  with whatever version your wanting to
use.

https://powerbi.microsoft.com/desktop/
https://visuals.powerbi.com


WARNINGWARNING

Inside the visual project

File structureFile structure

ITEM DESCRIPTION

assets/ Used to store visual assets (icon, screenshots, etc).

dist/ When you run pbiviz package , the pbiviz file will be
generated here.

src/ Typescript code for your visual.

style/ Less styles for your visual.

.gitignore Tells git to ignore files that shouldn't be tracked in the
repository.

capabilities.json Used to define the capabilities of your visual.

package.json Used by npm to manage modules.

pbiviz.json Main configuration file.

tsconfig.json Typescript compiler settings. Learn more about tsconfig.json.

pbiviz.jsonpbiviz.json

The default API version used by the tools will always be the stable version of the API. Any versions later than the default API
version are unstable and subject to change. They may have unexpected behaviors and behave differently between the
Power BI service and Power BI Desktop. For the current stable API version, see the change log. For more information about
pre-release versions, see the roadmap.

Your visual project is the folder that gets created when you run the pbiviz new  command.

This file is the main configuration file for your visual. It contains metadata, as well as information about your files,
needed to build your visual.

https://github.com/Microsoft/PowerBI-visuals/blob/master/ChangeLog.md
https://github.com/Microsoft/PowerBI-visuals/blob/master/Roadmap/README.md
https://github.com/Microsoft/PowerBI-visuals/blob/master/Capabilities/Capabilities.md
https://www.npmjs.com/
https://www.typescriptlang.org/docs/handbook/tsconfig-json.html


{
    "visual": {
        "name": "myVisual", // internal visual name (should not contain spaces)
        "displayName": "My Visual!", // visual name displayed to user (used in gallery)
        "guid": "PBI_CV_xxxxxxx", // a unique id for this visual MUST BE UNIQUE
        "visualClassName": "Visual" // the entry class for your visual
        "version": "1.0.0", // visual version. Should be semantic version (increment if you update the 
visual)
        "description": "", // description used in gallery
        "supportUrl": "", // url to where users can get support for this visual
        "gitHubUrl": "" // url to the source in github (if applicable)
    },
    "apiVersion": "1.0.0", //API version this visual was created with
    "author": {
        "name": "", // your name
        "email": "" // your e-mail
    },
    "assets": {
        "icon": "assets/icon.png" // relative path to your icon file (20x20 png)
    },
    "style": "style/visual.less", // relative path to your less file
    "capabilities": "capabilities.json" // relative path to your capabilities definition 
}

Visual source (TypeScript)Visual source (TypeScript)

Visual style (Less)Visual style (Less)

Debugging

Submit your visual to AppSource

Troubleshooting

Visual code should be written in TypeScript, which is a superset of JavaScript that support more advanced
features and early access to ES6/ES7 functionality.

All TypeScript files should be stored in the src/  directory and added to the files  array in tsconfig.json . This
allows the TypeScript compiler to load them and in what order.

When your visual is built, all of the TypeScript will be compiled into a single JavaScript file. This allows you to
reference exported elements from other files without needing to manually require  them as long as both files are
listed in the tsconfig.

You can create as many files and classes as you need to create your visual.

Learn more about TypeScript.

Visual styling is handled using cascading style sheets (CSS). For your convience, we use the Less pre-compiler
which supports some advanced features such as nesting, variables, mixins, conditions, loops, etc. If you don't want
to use any of these features, you can just write plain CSS in the Less file.

All Less files should be stored in the style/  directory. The file specified under the style  field within your 
pbiviz.json  file will be loaded. Any additional files should be loaded using @import .

Learn more about Less.

For tips about debugging your custom visual, see the debugging guide.

You can list your visual for others to use but submitting it to AppSource. For more information on this process,
see publish custom visuals to AppSource.

http://www.typescriptlang.org/
http://lesscss.org/
https://github.com/Microsoft/PowerBI-visuals/blob/master/tools/debugging.md
https://docs.microsoft.com/en-us/power-bi/developer/office-store


NOTENOTE

Next steps

Pbiviz command not found (or similar errors)

If you run pbiviz  in your terminal / command line, you should see the help screen. If not, it is not installed
correctly. Make sure you have at least the 4.0 version of NodeJS installed.

For more information, see Install NodeJS and the Power BI tools...

Cannot find the debug visual in the Visualizations tab

The debug visual looks like a prompt icon within the Visualizations tab.

If you don't see it, make sure you have enabled it within the Power BI settings.

The debug visual is currently only available in the Power BI service and not in Power BI Desktop or the mobile app. The
packaged visual will still work everywhere.

For more information, see Enable live preview of developer visual...

Can't contact visual server

Run the visual server with the command pbiviz start  in your terminal / command line from the root of your
visual project. If the server is running, it is likely that your SSL vertificates weren't installed correctly.

For more information, see Running your visual or Server certificate setup.

Visualizations in Power BI
Custom Visualizations in Power BI
Publish custom visuals to the Office store
TypeScript
Less CSS

More questions? Try asking the Power BI Community

https://docs.microsoft.com/en-us/power-bi/developer/office-store
http://www.typescriptlang.org/
http://lesscss.org/
http://community.powerbi.com/


Review custom visuals for security and privacy
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Enable a custom visual

Considerations before you enable a custom visual

Before you enable a custom visual, you should review that visual for security and privacy to make sure if will fit
your organization's standards.

 A custom visual in the report is disabled until you choose Enable custom visuals as shown below.

 

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/service-custom-visuals-review-for-security-and-privacy.md


WARNINGWARNING

Security best practices for IT Professionals to enable a custom visual

WARNINGWARNING

Custom visual file contents

FILE DESCRIPTION

./package.json A manifest file that indicates which files to load for the custom
visual.

./resources Contains the CSS, TypeScript, and JavaScript used by the
custom visual.

./resources/<name> <name> is the name of the custom visual.

A custom visual could contain code with security or privacy risks; therefore, a custom visual in the report is disabled until you
choose Enable custom visuals. Here are some considerations to decide whether to enable a custom visual:

1. Ensure you trust the author and the source of the custom visuals used in the report
2. If you are unsure what to do, you should reach out to your IT team to weigh in on whether you should enable

custom visuals for reports you view.
3. If someone shares a report with you that contains a custom visual, even if they're a close co-worker, do not feel

obligated to enable the custom visual. It's okay to step back and consider whether it is essential to the task at
hand. It's always okay to ask someone to provide you a report without custom visuals if you don't feel confident
about the custom visual.

 

A custom visual could contain code with security or privacy risks; therefore, a custom visual in the report is disabled until you
choose Enable custom visuals. There are several best practices you can follow to evaluate a custom visual for security and
privacy.

1. Implement a vetting process for custom visuals within the organization. Vetted custom visuals would be shared
with internal users through an internal website, such as a SharePoint document library or OneNote document.

2. Provide guidance for business users on appropriate use of custom visuals and an email group for business
users to send security and privacy questions to.

3. Evaluate the JavaScript code in the custom visual pbiviz file.

To evaluate the JavaScript code in a custom visual

A custom visual uses JavaScript and can therefore contain security or privacy risks. If you receive a custom visual or
a pbix file with a custom visual from an unknown source, you may want to look at the JavaScript to see if it is safe.

To evaluate the JavaScript code in a custom visual, extract the custom visual code. Here’s how to extract the code:

1. Save the .pbiviz file to a folder.
2. Rename the file to a .zip file.
3. Extract the zip file to a local folder.

The following are the contents of a pbiviz file:



./resources/<name>.css The css resource file for the custom visual.

./resources/<name>.js The code that executes when a user clicks Enable custom
visuals or after a user Imports a custom visual. Warning
JavaScript code could contain security or privacy risks.

./resources/<name>.ts The JavaScript source code for the visual in TypeScript format.
Warning JavaScript or TypeScript code could contain security
or privacy risks.

./resources/<name>.png The icon shown to the user for the visual.

FILE DESCRIPTION

Best practices to evaluate the JavaScript or TypeScript code

Best practices to evaluate JavaScript codeBest practices to evaluate JavaScript code

Threats to look for in JavaScript codeThreats to look for in JavaScript code

Next steps

After you extract the pbiviz file, you can evaluate the code. Here are some best practices and threats to look for.

JavaScript or TypeScript code could contain security or privacy risks. Here are some best practices and threats to
look for.

Always evaluate the .js file contents. This is the code that actually runs. It could be that the contents of the .ts file
don't compile to the .js file included in the custom visual.
Always evaluate the .ts file contents. You can load the .ts file into the Developer Tools, export the visual and
compare the resulting .js file in the newly create .pbiviz file to the original .js file contained in the visual
Check that the icon for the custom visual does not resemble too closely other visuals the user is familiar with.
Always evaluate the visual in a test account that has minimal privileges and does not have access to any
sensitive data. Ideally the test account would be a local account with no sign-in information to services other
than Power BI.

Check network activity when the visual is being used in both edit and view mode. Ensure you're satisfied with
the requests that are being made. You should not see requests to resources outside the Power BI domain unless
the visual author has communicated this ahead of time.
Any data you see leaving the Power BI domain should match your expectations for what 'normal' use would be.
For example - if the visual implements a video player that uses an iFrame to view a video from another site,
some information should travel in the IFrame requests to render the video correctly. However, if you see the
entire data set being sent across the wire, you might investigate further if this is required and desired.
Check if personally identifiable data is being sent or stored by the custom visual.
Check if the custom visual is trying to access local machine resources such as writing files to disk or accessing
cookies.
Check if the custom visual has what appears to be obfuscated code or code without a clear purpose.
Save copies of each visual you reviewed in the past.
If you are reviewing an update to a visual you previously reviewed, ensure to check for changes. Always apply
equal rigor to updates as you did the first time you received the visual for review
If you find something suspicious or unclear, please reach out to us we're here to help.

Visualizations in Power BI
Custom Visualizations in Power BI



Publish custom visuals to the Office store
Getting started with custom visuals developer tools
How to certify a custom visual
Video: Creating custom visualizations for Power BI with Sachin Patney and Nico Cristache

More questions? Try asking the Power BI Community

https://docs.microsoft.com/en-us/power-bi/developer/office-store
https://www.youtube.com/watch?v=kULc2VbwjCc
http://community.powerbi.com/


Getting a custom visual certified
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What is meant by certified?

Certification requirements

Process for submitting a custom visual for Certification

Removal of Power BI Certified custom visuals

List of custom visuals that have been certified
LINK TO APPSOURCE LINK TO VIDEO

Association rules

A certified custom visual is one that has met a set of code requirements and has passed strict security tests. Once
a custom visual has been certified, it can be exported to PowerPoint and will display in the emails received when a
user subscribes to report pages. Of course, it can also be used like standard custom visuals, added to Power BI
service and Power BI Desktop reports and viewed in Power BI mobile and embedded.

Are you a Web developer and interested in creating your own visualizations and adding them to Microsoft
AppSource? See Get started with Developer Tools to learn how.

Microsoft AppSource approved
Custom visual is written with Versioned API 1.2 or higher
Code repository available for review (e.g., Visual Code available to us through GitHub)
Uses only public reviewable OSS components
Does not access external services or resources

TIP: We recommend that you use EsLint with default security ruleset, to pre-validate your code before
submission.

To submit a custom visual for certification:

2. The Custom Visuals team at Microsoft will notify you when your custom visual is certified and added to the
Certified list (below), or rejected with a report of the issues that need to be fixed. It is the developer’s
responsibility to maintain an open line of communication with Microsoft and to update their Certified visuals
as needed.

1. Send an email to Power BI Custom Visuals Support (pbicvsupport@microsoft.com). In the email, include
the following information:

Title: Visual Certification Request
Link to GitHub repository where the visual source code is hosted
Adhere to the requirements (see above)
Pass the code and security review

Microsoft, at its discretion, may remove a visual from the Certified list.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/power-bi-custom-visuals-certified.md
https://appsource.microsoft.com
https://appsource.microsoft.com/en-us/product/power-bi-visuals/WA104380815


Aster plot

BciCalendar (Beyondsoft Calendar)

Bowtie chart by MAQ Software Video

Box and Whisker

Brick chart by MAQ Software

Bubble chart by Akvelon

Bullet Chart Video1 Video2

Bullet Chart by OKViz Video

Calendar by Tallan

Candlestick by OKViz

Chiclet slicer Video

Chord chart Video

Circular gauge by MAQ Software

Cylindrical gauge

Dial gauge Video

Donut chart (Ring chart) by MAQ Software Video

Dot Plot by MAQ Software

Dot Plot by OKViz Video

Dot Plot by Microsoft

Drill down donut chart by ZoomCharts

Drilldown Cartogram

Drilldown Choropleth

Drilldown column chart by ZoomCharts

Drilldown column chart for time-based data by ZoomCharts

Drilldown Donut chart by ZoomCharts

LINK TO APPSOURCE LINK TO VIDEO

https://appsource.microsoft.com/product/power-bi-visuals/WA104380759?src=office&tab=Overview
https://appsource.microsoft.com/en-us/product/power-bi-visuals/WA104381096?src=office&tab=Overview
https://appsource.microsoft.com/product/power-bi-visuals/WA104380838?src=office&tab=Overview
https://youtu.be/So5xKMSpVJI
https://appsource.microsoft.com/product/power-bi-visuals/WA104380831?src=office&tab=Overview
https://appsource.microsoft.com/en-us/product/power-bi-visuals/WA104380836
https://appsource.microsoft.com/en-us/product/power-bi-visuals/WA104381340?src=office
https://store.office.com/app.aspx?assetid=WA104380755
https://youtu.be/AOlsFYkfkcw
https://youtu.be/AQvd2FhRyCI
https://store.office.com/bullet-chart-by-okviz-WA104380953.aspx
https://youtu.be/mtvUNl9bMjA
https://appsource.microsoft.com/product/power-bi-visuals/WA104381146?src=office&tab=Overview
https://appsource.microsoft.com/en-us/product/power-bi-visuals/WA104380952
https://store.office.com/chiclet-slicer-WA104380756.aspx
https://youtu.be/iYOkJ1APueY
https://appsource.microsoft.com/product/power-bi-visuals/WA104380761?src=office&tab=Overview
https://youtu.be/AQvd2FhRyCI
https://appsource.microsoft.com/product/power-bi-visuals/WA104380837?tab=Overview
https://appsource.microsoft.com/product/power-bi-visuals/WA104380874
https://appsource.microsoft.com/product/power-bi-visuals/WA104381184
https://youtu.be/AOlsFYkfkcw
https://appsource.microsoft.com/product/power-bi-visuals/WA104380824?tab=Overview
https://youtu.be/pDToHDFHnq8
https://appsource.microsoft.com/en-us/product/power-bi-visuals/WA104381101
https://appsource.microsoft.com/product/power-bi-visuals/WA104381101?src=office&tab=Overview
https://youtu.be/4lskRgcpFJY
https://appsource.microsoft.com/en-us/product/power-bi-visuals/WA104380760?src=office
https://appsource.microsoft.com/product/power-bi-visuals/WA104380858
https://appsource.microsoft.com/en-us/product/power-bi-visuals/WA104381045?src=office
https://appsource.microsoft.com/en-us/product/power-bi-visuals/WA104381044?src=office
https://appsource.microsoft.com/en-us/product/power-bi-visuals/WA104380881?src=office
https://appsource.microsoft.com/en-us/product/power-bi-visuals/WA104380881
https://appsource.microsoft.com/en-us/product/power-bi-visuals/WA104380858


 Funnel with source

Dual KPI Video

Enhanced scatter

Enlighten Aquarium

Enlighten Bubble stack

Enlighten Slicer

Enlighten Stack Shuffle

Enlighten waffle chart

Enlighten World Flags

Force-Directed Graph Video

Forecasting TBATS

Hierarachy chart by Akvelon

Histogram

Horizotal Funnel Video

Image Timeline

Infographic Designer

KPI Indicator

KPI Ticker by MAQ Software

LineDot chart

Linear gauge by MAQ Software Video

Mekko chart Video

Play Axis (Dynamic Slicer)

Power KPI Video

Pulse chart

Radar chart

Ring chart (Donut chart) by MAQSoftware Video

LINK TO APPSOURCE LINK TO VIDEO

https://store.office.com/dual-kpi-WA104380774.aspx
https://youtu.be/821o0-eVBXo?list=PL1N57mwBHtN1vIjfvuBIzZllrmKo-Vz6x
https://appsource.microsoft.com/en-us/product/power-bi-visuals/WA104380762
https://appsource.microsoft.com/product/power-bi-visuals/WA104381112?src=office&tab=Overview
https://appsource.microsoft.com/en-us/product/power-bi-visuals/WA104380868
https://appsource.microsoft.com/en-us/product/power-bi-visuals/WA104380960?tab=Overview
https://appsource.microsoft.com/en-us/product/power-bi-visuals/WA104380849
https://appsource.microsoft.com/en-us/product/power-bi-visuals/WA104380850
https://appsource.microsoft.com/en-us/product/power-bi-visuals/WA104380923
https://appsource.microsoft.com/en-us/product/power-bi-visuals/WA104380764
https://youtu.be/YsTa7uyJ4sg
https://appsource.microsoft.com/en-us/product/power-bi-visuals/WA104381326?src=office
https://appsource.microsoft.com/en-us/product/power-bi-visuals/WA104381333?src=office
https://store.office.com/histogram-chart-WA104380776.aspx
https://appsource.microsoft.com/product/power-bi-visuals/WA104380846
https://youtu.be/SudZei68PPo
https://appsource.microsoft.com/en-us/product/power-bi-visuals/WA104381254
https://appsource.microsoft.com/en-us/product/power-bi-visuals/WA104380898?src=office
https://store.office.com/kpi-indicator-WA104380832.aspx
https://appsource.microsoft.com/en-us/product/power-bi-visuals/WA104380946
https://appsource.microsoft.com/en-us/product/power-bi-visuals/WA104380766?src=office
https://appsource.microsoft.com/product/power-bi-visuals/WA104380821?src=office&tab=Overview
https://youtu.be/AOlsFYkfkcw
https://appsource.microsoft.com/product/power-bi-visuals/WA104380785?src=office&tab=Overview
https://youtu.be/90FLCKpgicA
https://store.office.com/play-axis-dynamic-slicer-WA104380981.aspx
https://appsource.microsoft.com/product/power-bi-visuals/WA104381083
https://youtu.be/IvfIP3E6-1Q
https://appsource.microsoft.com/en-us/product/power-bi-visuals/WA104381006
https://store.office.com/radar-chart-WA104380771.aspx
https://appsource.microsoft.com/en-us/product/power-bi-visuals/WA104380824?src=office&tab=Overview
https://youtu.be/pDToHDFHnq8


Rotating chart by MAQ Software

Sankey chart Video

Scroller Video

Smart Filter by SQLBI Video

Sparkline by OKViz Video

Stream graph

Sunburst

Table Heatmap

Tachometer Video

Text wrapper

Thermometer Video

Time series decomposition

Timeline slicer Video

Tornado chart Video

Ultimate Variance chart by Klaus Birringer

Ultimate Waterfall free

VitaraCharts - MicroChart

Waffle chart Video

Word Cloud Video

LINK TO APPSOURCE LINK TO VIDEO

Next steps
Getting started with custom visuals developer tools (Preview)
Microsoft's custom visual playlist on YouTube
Visualizations in Power BI
Custom Visualizations in Power BI
Publish custom visuals to Microsoft AppSource
More questions? Try the Power BI Community

https://appsource.microsoft.com/en-us/product/power-bi-visuals/WA104381007?src=office
https://store.office.com/app.aspx?assetid=WA104380777.aspx
https://youtu.be/WWP9wVUHGaA
https://store.office.com/scroller-WA104381018.aspx
https://youtu.be/uhRFQF2cGSY
https://store.office.com/smart-filter-by-okviz-WA104380859.aspx
https://youtu.be/gcJsDDRQq28
https://appsource.microsoft.com/product/power-bi-visuals/WA104380910?src=office&tab=Overview
https://youtu.be/0m3Vnvso9tY
https://appsource.microsoft.com/en-us/product/power-bi-visuals/WA104380772?tab=Overview
https://appsource.microsoft.com/product/power-bi-visuals/WA104380767?src=office&tab=Overview
https://store.office.com/table-heatmap-WA104380818.aspx
https://store.office.com/tachometer-WA104380937.aspx?
https://www.youtube.com/watch?v=C3OXdETbS9o
https://appsource.microsoft.com/product/power-bi-visuals/WA104380826
https://appsource.microsoft.com/product/power-bi-visuals/WA104380847?src=office&tab=Overview
https://youtu.be/SPX9mgrAdBc
https://appsource.microsoft.com/product/power-bi-visuals/WA104380897
https://store.office.com/timeline-slicer-WA104380786.aspx
https://youtu.be/ozMtZ4_NZ10
https://store.office.com/tornado-chart-WA104380768.aspx
https://youtu.be/AQvd2FhRyCI
https://appsource.microsoft.com/en-us/product/power-bi-visuals/WA104381140?src=office
https://appsource.microsoft.com/en-us/product/power-bi-visuals/WA104380956
https://appsource.microsoft.com/en-us/product/power-bi-visuals/WA104381165
https://appsource.microsoft.com/product/power-bi-visuals/WA104381049?src=office&tab=Overview
https://youtu.be/1vRqYUsm3Vk
https://store.office.com/word-cloud-WA104380752.aspx?
https://www.youtube.com/watch?v=AblTenl9fqo
https://www.youtube.com/playlist?list=PL1N57mwBHtN1vIjfvuBIzZllrmKo-Vz6x
https://docs.microsoft.com/en-us/power-bi/developer/office-store
http://community.powerbi.com/


Push data into a Power BI dataset
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Steps to push data into a dataset

Power BI API operations to push data

{"name": "dataset_name", "tables":
    [{"name": "", "columns":
        [{ "name": "column_name1", "dataType": "data_type"},
         { "name": "column_name2", "dataType": "data_type"},
         { ... }
        ]
      }
    ]
}

With the Power BI API, you can push data into a Power BI dataset. For example, you want to extend an existing
business workflow to push key data into your dataset. In this case, you want to push a Sales Marketing dataset
which has a Product table into a dataset.

Before you get started pushing data into a dataset, you need an Azure Active Directory (Azure AD) and a Power
BI account.

Step 1: Register an app with Azure AD
Step 2: Get an authentication access token
Step 3: Create a dataset in Power BI
Step 4: Get a dataset to add rows into a Power BI table
Step 5: Add rows to a Power BI table

The next section is a general discussion of Power BI API operations that push data.

With the Power BI REST API, you can push data sources to Power BI. When an app adds rows to a dataset, tiles
on the dashboard are updated automatically with the updated data. To push data, you use the Create Dataset
operation along with the Add Rows operation. To find a dataset, you use the Get Datasets operation. For any of
these operations, you can pass a group id to work with a group. Use the Get Groups operation to get a list of
group id's.

Here are the operations to push data into a dataset:

Create Dataset
Get Datasets
Add Rows
Get Groups

You create a dataset in Power BI by passing a JavaScript Object Notation (JSON) string to the Power BI service.
To learn more about JSON, see Introducing JSON.

The JSON string for a dataset has the following format:

Power BI Dataset JSON object

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/developer/walkthrough-push-data.md
https://msdn.microsoft.com/library/mt203562.aspx
https://msdn.microsoft.com/library/mt203561.aspx
https://msdn.microsoft.com/library/mt203567.aspx
https://msdn.microsoft.com/library/mt243842.aspx
https://msdn.microsoft.com/library/mt203562.aspx
https://msdn.microsoft.com/library/mt203567.aspx
https://msdn.microsoft.com/library/mt203561.aspx
https://msdn.microsoft.com/library/mt243842.aspx
http://json.org/


{
    "name": "SalesMarketing",
    "tables": [
        {
            "name": "Product",
            "columns": [
            {
                "name": "ProductID",
                "dataType": "int"
            },
            {
                "name": "Manufacturer",
                "dataType": "string"
            },
            {
                "name": "Category",
                "dataType": "string"
            },
            {
                "name": "Segment",
                "dataType": "string"
            },
            {
                "name": "Product",
                "dataType": "string"
            },
            {
                "name": "IsCompete",
                "dataType": "bool"
            }
            ]
        }
    ]
}

Power BI table data types
DATA TYPE RESTRICTIONS

Int64 Int64.MaxValue and Int64.MinValue not allowed.

Double Double.MaxValue and Double.MinValue values not allowed.
NaN not supported.+Infinity and -Infinity not supported in
some functions (e.g. Min, Max).

Boolean None

Datetime During data loading we quantize values with day fractions to
whole multiples of 1/300 seconds (3.33ms).

String Currently allows up to 128K characters.

So, for our Sales Marketing dataset example, you would pass a JSON string such as the example below. In this
example, SalesMarketing is the name of the dataset, and Product is the name of the table. After you define the
table, you define the table schema. For the SalesMarketing dataset, the table schema has these columns:
ProductID, Manufacturer, Category, Segment, Product, and IsCompete.

Example dataset object JSON

For a Power BI table schema, you can use the following data types.



Learn more about pushing data into Power BI

Next steps

To get started pushing data into a dataset, see Step 1: Register an app with Azure AD in the left navigation pane.

Next Step >

Sign up for Power BI
Create Dataset
Get Datasets
Add Rows
Get Groups
Introducing JSON
Overview of Power BI REST API
More questions? Try the Power BI Community

https://msdn.microsoft.com/library/mt203562.aspx
https://msdn.microsoft.com/library/mt203567.aspx
https://msdn.microsoft.com/library/mt203561.aspx
https://msdn.microsoft.com/library/mt243842.aspx
http://json.org/
http://community.powerbi.com/
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Register an app in Azure AD

This article is part of a step-by-step walkthrough to push data into a dataset.

The first step to push data into a Power BI dataset is to register your app in Azure AD. You need to do this first so
that you have a Client ID that identifies your app in Azure AD. Without a Client ID, Azure AD cannot authenticate
your app.

NOTE: Before you register an app for Power BI, you need to Sign up for Power BI.

Here are the steps to register an app in Azure AD.

1. Go to dev.powerbi.com/apps.
2. Click Sign in with your existing account, and sign into your Power BI account.
3. Enter an App Name such as "Sample push data app".
4. For App Type, choose Native app.
5. Enter a Redirect URL, such as https://login.live.com/oauth20_desktop.srf. For a Native client app, a

redirect uri gives Azure AD more details on the specific application that it will authenticate. The standard Uri
for a client app is https://login.live.com/oauth20_desktop.srf.

6. For Choose APIs to access, choose Read and Write All Datasets. For all Power BI app permissions, see
Power BI Permissions.

7. Click Register app, and save the Client ID that was generated. A Client ID identifies the app in Azure AD.

Here's how your Register an Application for Power BI page should look:

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/developer/walkthrough-push-data-register-app-with-azure-ad.md
https://login.live.com/oauth20_desktop.srf
https://login.live.com/oauth20_desktop.srf


Next steps

The next step shows you how to get an authentication access token.

Next Step >

Sign up for Power BI
Get an authentication access token
Walkthrough: Push data into a dataset
Register an application
Overview of Power BI REST API

More questions? Try asking the Power BI Community

http://community.powerbi.com/
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Get an authentication access token

This article is part of a step-by-step walkthrough to push data into a dataset.

In step 1 of Push data into a dataset, Register the app with Azure AD, you registered a client app in Azure AD. In
this step, you get an authentication access token. Power BI apps are integrated with Azure AD to provide secure
sign in and authorization for your app. You use a token to authenticate to Azure AD and gain access to Power BI
resources.

Here's how to get an authentication access token.

NOTE: Before you get started, make sure you have followed the previous steps in the push data into a dataset
walkthrough.

1. In Visual Studio 2015, create a Console Application project.

3. Add the code below into class Program {...}.
4. Replace "{ClientID}", with the Client ID you got when you registered the app. See Register the app with Azure

AD.
5. After installing the Microsoft.IdentityModel.Clients.ActiveDirectory package, add using

Microsoft.IdentityModel.Clients.ActiveDirectory; to Program.cs.
6. Run the Console App, and login to your Power BI account. You should see a token string in the Console

Window.

2. Install the Azure AD Authentication Library for .NET NuGet package. To get an authentication security
token in a .NET app, you use this package. Here's how to install the package:

a. In Visual Studio 2015, choose Tools > NuGet Package Manager > Package Manager Console.

b. In Package Manager Console, enter Install-Package Microsoft.IdentityModel.Clients.ActiveDirectory -
Version 2.21.301221612.

Sample code to get authentication security token

Add this code to Program {...}.

private static string token = string.Empty;

static void Main(string[] args)
{
}

A token variable to call operations:

In static void Main(string[] args):

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/developer/walkthrough-push-data-get-token.md
https://www.nuget.org/packages/Microsoft.IdentityModel.Clients.ActiveDirectory/


       #region Get an authentication access token
       private static string GetToken()
       {
           // TODO: Install-Package Microsoft.IdentityModel.Clients.ActiveDirectory -Version 2.21.301221612
           // and add using Microsoft.IdentityModel.Clients.ActiveDirectory

           //The client id that Azure AD created when you registered your client app.
           string clientID = "{Client_ID}";

           //RedirectUri you used when you register your app.
           //For a client app, a redirect uri gives Azure AD more details on the application that it will 
authenticate.
           // You can use this redirect uri for your client app
           string redirectUri = "https://login.live.com/oauth20_desktop.srf";

           //Resource Uri for Power BI API
           string resourceUri = "https://analysis.windows.net/powerbi/api";

           //OAuth2 authority Uri
           string authorityUri = "https://login.windows.net/common/oauth2/authorize";

           //Get access token:
           // To call a Power BI REST operation, create an instance of AuthenticationContext and call 
AcquireToken
           // AuthenticationContext is part of the Active Directory Authentication Library NuGet package
           // To install the Active Directory Authentication Library NuGet package in Visual Studio,
           //  run "Install-Package Microsoft.IdentityModel.Clients.ActiveDirectory" from the nuget Package 
Manager Console.

           // AcquireToken will acquire an Azure access token
           // Call AcquireToken to get an Azure token from Azure Active Directory token issuance endpoint
           AuthenticationContext authContext = new AuthenticationContext(authorityUri);
           string token = authContext.AcquireToken(resourceUri, clientID, new Uri(redirectUri)).AccessToken;

           Console.WriteLine(token);
           Console.ReadLine();

           return token;
       }

       #endregion

Complete code listing

static void Main(string[] args)
{
  //Get an authentication access token
  token = GetToken();
}

Add a GetToken() method:

After you get an authentication token, you can call any Power BI operation. The next step shows you how to call
the Create Dataset operation to create a dataset to push data into a dashboard.

The next step shows you how to create a dataset in Power BI.

Below is the complete code listing.

 

https://msdn.microsoft.com/library/mt203562.aspx


using System;
using Microsoft.IdentityModel.Clients.ActiveDirectory;

namespace walkthrough_push_data
{
    class Program
    {
        private static string token = string.Empty;

        static void Main(string[] args)
        {

            //Get an authentication access token
            token = GetToken();

        }

        #region Get an authentication access token
        private static string GetToken()
        {
            // TODO: Install-Package Microsoft.IdentityModel.Clients.ActiveDirectory -Version 2.21.301221612
            // and add using Microsoft.IdentityModel.Clients.ActiveDirectory

            //The client id that Azure AD created when you registered your client app.
            string clientID = "{Client_ID}";

            //RedirectUri you used when you register your app.
            //For a client app, a redirect uri gives Azure AD more details on the application that it will 
authenticate.
            // You can use this redirect uri for your client app
            string redirectUri = "https://login.live.com/oauth20_desktop.srf";

            //Resource Uri for Power BI API
            string resourceUri = "https://analysis.windows.net/powerbi/api";

            //OAuth2 authority Uri
            string authorityUri = "https://login.windows.net/common/oauth2/authorize";

            //Get access token:
            // To call a Power BI REST operation, create an instance of AuthenticationContext and call 
AcquireToken
            // AuthenticationContext is part of the Active Directory Authentication Library NuGet package
            // To install the Active Directory Authentication Library NuGet package in Visual Studio,
            //  run "Install-Package Microsoft.IdentityModel.Clients.ActiveDirectory" from the nuget Package 
Manager Console.

            // AcquireToken will acquire an Azure access token
            // Call AcquireToken to get an Azure token from Azure Active Directory token issuance endpoint
            AuthenticationContext authContext = new AuthenticationContext(authorityUri);
            string token = authContext.AcquireToken(resourceUri, clientID, new Uri(redirectUri)).AccessToken;

            Console.WriteLine(token);
            Console.ReadLine();

            return token;
        }

        #endregion

    }
}

Next steps

Next Step >



Create a dataset in Power BI
Register an app with Azure AD
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Step 3: Create a dataset in Power BI
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Create a dataset in Power BI

NOTENOTE

This article is part of a step-by-step walkthrough to push data into a dataset.

In step 2 of Push data into a dataset, Get an authentication access token, you got a token to authenticate to Azure
AD. In this step, you use the token to call the Create Dataset operation.

To make a call to a REST resource, you use a url that locates the resource, and you send a JavaScript Object
Notation (JSON) string, which describes the dataset, to the Power BI service resource. A REST resource identifies
the part of the Power BI service you want to work with. To push data into the dataset, the target resource is a
Dataset. The URL that identifies a dataset is https://api.PowerBI.com/v1.0/myorg/datasets. If you are pushing data
within a group, the url is https://api.PowerBI.com/v1.0/myorg/groups/{group_id}/datasets.

To authenticate a Power BI REST operation, you add the token you got in Get an authentication access token to a
request header:

When you call the Create Dataset operation, a new dataset is created.

Here's how to create a dataset in Power BI.

Before you get started, make sure you have followed the previous steps in the push data into a dataset walkthrough.

1. In the Console Application project you created in Step 2 - Get an authentication access token, add using
System.Net;, and using System.IO; to Program.cs.

2. In Program.cs, add the code below.
3. Run the Console App, and login to your Power BI account. You should see Dataset Created in the Console

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/developer/walkthrough-push-data-create-dataset.md
https://msdn.microsoft.com/library/mt203562.aspx
https://api.powerbi.com/v1.0/myorg/datasets
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Window. Also, you can login to Power BI to see the new dataset.

Sample push data into a dataset

Add this code into Program.cs.

static void Main(string[] args)
{
    //Get an authentication access token
    token = GetToken();

    //Create a dataset in Power BI
    CreateDataset();
}

In static void Main(string[] args):

Add a CreateDataset() method:



Complete code listing
using System;
using Microsoft.IdentityModel.Clients.ActiveDirectory;
using System.Net;
using System.IO;

namespace walkthrough_push_data
{
    class Program
    {
        private static string token = string.Empty;

        static void Main(string[] args)

#region Create a dataset in Power BI
private static void CreateDataset()
{
    //TODO: Add using System.Net and using System.IO

    string powerBIDatasetsApiUrl = "https://api.powerbi.com/v1.0/myorg/datasets";
    //POST web request to create a dataset.
    //To create a Dataset in a group, use the Groups uri: 
https://api.PowerBI.com/v1.0/myorg/groups/{group_id}/datasets
    HttpWebRequest request = System.Net.WebRequest.Create(powerBIDatasetsApiUrl) as 
System.Net.HttpWebRequest;
    request.KeepAlive = true;
    request.Method = "POST";
    request.ContentLength = 0;
    request.ContentType = "application/json";

    //Add token to the request header
    request.Headers.Add("Authorization", String.Format("Bearer {0}", token));

    //Create dataset JSON for POST request
    string datasetJson = "{\"name\": \"SalesMarketing\", \"tables\": " +
        "[{\"name\": \"Product\", \"columns\": " +
        "[{ \"name\": \"ProductID\", \"dataType\": \"Int64\"}, " +
        "{ \"name\": \"Name\", \"dataType\": \"string\"}, " +
        "{ \"name\": \"Category\", \"dataType\": \"string\"}," +
        "{ \"name\": \"IsCompete\", \"dataType\": \"bool\"}," +
        "{ \"name\": \"ManufacturedOn\", \"dataType\": \"DateTime\"}" +
        "]}]}";

    //POST web request
    byte[] byteArray = System.Text.Encoding.UTF8.GetBytes(datasetJson);
    request.ContentLength = byteArray.Length;

    //Write JSON byte[] into a Stream
    using (Stream writer = request.GetRequestStream())
    {
        writer.Write(byteArray, 0, byteArray.Length);

        var response = (HttpWebResponse)request.GetResponse();

        Console.WriteLine(string.Format("Dataset {0}", response.StatusCode.ToString()));

        Console.ReadLine();
    }
}
#endregion

The next step shows you how to get a dataset to add rows into a Power BI table.

Below is the complete code listing.

 



        static void Main(string[] args)
        {

            //Get an authentication access token
            token = GetToken();

            //Create a dataset in Power BI
            CreateDataset();

        }

        #region Get an authentication access token
        private static string GetToken()
        {
            // TODO: Install-Package Microsoft.IdentityModel.Clients.ActiveDirectory -Version 2.21.301221612
            // and add using Microsoft.IdentityModel.Clients.ActiveDirectory

            //The client id that Azure AD created when you registered your client app.
            string clientID = "{Client_ID}";

            //RedirectUri you used when you register your app.
            //For a client app, a redirect uri gives Azure AD more details on the application that it will 
authenticate.
            // You can use this redirect uri for your client app
            string redirectUri = "https://login.live.com/oauth20_desktop.srf";

            //Resource Uri for Power BI API
            string resourceUri = "https://analysis.windows.net/powerbi/api";

            //OAuth2 authority Uri
            string authorityUri = "https://login.windows.net/common/oauth2/authorize";

            //Get access token:
            // To call a Power BI REST operation, create an instance of AuthenticationContext and call 
AcquireToken
            // AuthenticationContext is part of the Active Directory Authentication Library NuGet package
            // To install the Active Directory Authentication Library NuGet package in Visual Studio,
            //  run "Install-Package Microsoft.IdentityModel.Clients.ActiveDirectory" from the nuget Package 
Manager Console.

            // AcquireToken will acquire an Azure access token
            // Call AcquireToken to get an Azure token from Azure Active Directory token issuance endpoint
            AuthenticationContext authContext = new AuthenticationContext(authorityUri);
            string token = authContext.AcquireToken(resourceUri, clientID, new Uri(redirectUri)).AccessToken;

            Console.WriteLine(token);
            Console.ReadLine();

            return token;
        }

        #endregion

        #region Create a dataset in Power BI
        private static void CreateDataset()
        {
            //TODO: Add using System.Net and using System.IO

            string powerBIDatasetsApiUrl = "https://api.powerbi.com/v1.0/myorg/datasets";
            //POST web request to create a dataset.
            //To create a Dataset in a group, use the Groups uri: 
https://api.PowerBI.com/v1.0/myorg/groups/{group_id}/datasets
            HttpWebRequest request = System.Net.WebRequest.Create(powerBIDatasetsApiUrl) as 
System.Net.HttpWebRequest;
            request.KeepAlive = true;
            request.Method = "POST";
            request.ContentLength = 0;
            request.ContentType = "application/json";



            //Add token to the request header
            request.Headers.Add("Authorization", String.Format("Bearer {0}", token));

            //Create dataset JSON for POST request
            string datasetJson = "{\"name\": \"SalesMarketing\", \"tables\": " +
                "[{\"name\": \"Product\", \"columns\": " +
                "[{ \"name\": \"ProductID\", \"dataType\": \"Int64\"}, " +
                "{ \"name\": \"Name\", \"dataType\": \"string\"}, " +
                "{ \"name\": \"Category\", \"dataType\": \"string\"}," +
                "{ \"name\": \"IsCompete\", \"dataType\": \"bool\"}," +
                "{ \"name\": \"ManufacturedOn\", \"dataType\": \"DateTime\"}" +
                "]}]}";

            //POST web request
            byte[] byteArray = System.Text.Encoding.UTF8.GetBytes(datasetJson);
            request.ContentLength = byteArray.Length;

            //Write JSON byte[] into a Stream
            using (Stream writer = request.GetRequestStream())
            {
                writer.Write(byteArray, 0, byteArray.Length);

                var response = (HttpWebResponse)request.GetResponse();

                Console.WriteLine(string.Format("Dataset {0}", response.StatusCode.ToString()));

                Console.ReadLine();
            }
        }
        #endregion
    }
}

Next steps
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Get a Power BI dataset

This article is part of a step-by-step walkthrough to push data into a dataset.

In step 3 of Push data into a dataset, Create a dataset in Power BI, you called the Create Dataset operation to
create a dataset in Power BI. In this step, you use the Get Datasets operation and Newtonsoft.Json to get a dataset
id. You use the dataset id in step 4 to add rows to a dataset.

To push data into a Power BI dataset, you need to reference the table in the dataset. To reference a table in a
dataset, you first need to get a Dataset ID. You get a Dataset ID using the Get Dataset operation. The Get
Dataset operation returns a JSON string containing a list of all datasets in Power BI. The recommended way to
deserialize a JSON string is with Newtonsoft.Json.

Here's how you get a dataset.

NOTE: Before you get started, make sure you have followed the previous steps in the push data into a dataset
walkthrough.

2. After the package is installed, add using Newtonsoft.Json; to Program.cs.
3. In Program.cs, add the code below to get a Dataset ID.
4. Run the Console App, and login to your Power BI account. You should see Dataset ID: followed by an id in the

Console Window.

1. In the Console Application project you created in Step 2: Walkthrough to push data, Get an authentication
access token, install the Newtonsoft.Json NuGet package. Here's how to install the package:

a. In Visual Studio 2015, choose Tools > NuGet Package Manager > Package Manager Console.

b. In Package Manager Console, enter Install-Package Newtonsoft.Json.

Sample get a dataset

Add this code into Program.cs.

static void Main(string[] args)
{

  //Get an authentication access token
  token = GetToken();

  //Create a dataset in Power BI
  CreateDataset();

  //Get a dataset to add rows into a Power BI table
  string datasetId = GetDataset();
}

In static void Main(string[] args):

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/developer/walkthrough-push-data-get-datasets.md
https://msdn.microsoft.com/library/mt203562.aspx
https://msdn.microsoft.com/library/mt203567.aspx
https://msdn.microsoft.com/library/mt203567.aspx
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Complete code listing
using System;
using Microsoft.IdentityModel.Clients.ActiveDirectory;
using System.Net;
using System.IO;
using Newtonsoft.Json;

namespace walkthrough_push_data
{
    class Program
    {
        private static string token = string.Empty;

        static void Main(string[] args)
        {

  #region Get a dataset to add rows into a Power BI table
  private static string GetDataset()
  {
      string powerBIDatasetsApiUrl = "https://api.powerbi.com/v1.0/myorg/datasets";
      //POST web request to create a dataset.
      //To create a Dataset in a group, use the Groups uri: 
https://api.PowerBI.com/v1.0/myorg/groups/{group_id}/datasets
      HttpWebRequest request = System.Net.WebRequest.Create(powerBIDatasetsApiUrl) as 
System.Net.HttpWebRequest;
      request.KeepAlive = true;
      request.Method = "GET";
      request.ContentLength = 0;
      request.ContentType = "application/json";

      //Add token to the request header
      request.Headers.Add("Authorization", String.Format("Bearer {0}", token));

      string datasetId = string.Empty;
      //Get HttpWebResponse from GET request
      using (HttpWebResponse httpResponse = request.GetResponse() as System.Net.HttpWebResponse)
      {
          //Get StreamReader that holds the response stream
          using (StreamReader reader = new System.IO.StreamReader(httpResponse.GetResponseStream()))
          {
              string responseContent = reader.ReadToEnd();

              //TODO: Install NuGet Newtonsoft.Json package: Install-Package Newtonsoft.Json
              //and add using Newtonsoft.Json
              var results = JsonConvert.DeserializeObject<dynamic>(responseContent);

              //Get the first id
              datasetId = results["value"][0]["id"];

              Console.WriteLine(String.Format("Dataset ID: {0}", datasetId));
              Console.ReadLine();

              return datasetId;
          }
      }
  }
  #endregion

Add a GetDatset() method:

The next step shows you how to add rows to a Power BI table.

Below is the complete code listing.

 



            //Get an authentication access token
            token = GetToken();

            //Create a dataset in Power BI
            CreateDataset();

            //Get a dataset to add rows into a Power BI table
            string datasetId = GetDataset();

        }

        #region Get an authentication access token
        private static string GetToken()
        {
            // TODO: Install-Package Microsoft.IdentityModel.Clients.ActiveDirectory -Version 2.21.301221612
            // and add using Microsoft.IdentityModel.Clients.ActiveDirectory

            //The client id that Azure AD created when you registered your client app.
            string clientID = "{Client_ID}";

            //RedirectUri you used when you register your app.
            //For a client app, a redirect uri gives Azure AD more details on the application that it will 
authenticate.
            // You can use this redirect uri for your client app
            string redirectUri = "https://login.live.com/oauth20_desktop.srf";

            //Resource Uri for Power BI API
            string resourceUri = "https://analysis.windows.net/powerbi/api";

            //OAuth2 authority Uri
            string authorityUri = "https://login.windows.net/common/oauth2/authorize";

            //Get access token:
            // To call a Power BI REST operation, create an instance of AuthenticationContext and call 
AcquireToken
            // AuthenticationContext is part of the Active Directory Authentication Library NuGet package
            // To install the Active Directory Authentication Library NuGet package in Visual Studio,
            //  run "Install-Package Microsoft.IdentityModel.Clients.ActiveDirectory" from the nuget Package 
Manager Console.

            // AcquireToken will acquire an Azure access token
            // Call AcquireToken to get an Azure token from Azure Active Directory token issuance endpoint
            AuthenticationContext authContext = new AuthenticationContext(authorityUri);
            string token = authContext.AcquireToken(resourceUri, clientID, new Uri(redirectUri)).AccessToken;

            Console.WriteLine(token);
            Console.ReadLine();

            return token;
        }

        #endregion

        #region Create a dataset in Power BI
        private static void CreateDataset()
        {
            //TODO: Add using System.Net and using System.IO

            string powerBIDatasetsApiUrl = "https://api.powerbi.com/v1.0/myorg/datasets";
            //POST web request to create a dataset.
            //To create a Dataset in a group, use the Groups uri: 
https://api.PowerBI.com/v1.0/myorg/groups/{group_id}/datasets
            HttpWebRequest request = System.Net.WebRequest.Create(powerBIDatasetsApiUrl) as 
System.Net.HttpWebRequest;
            request.KeepAlive = true;
            request.Method = "POST";
            request.ContentLength = 0;
            request.ContentType = "application/json";



            //Add token to the request header
            request.Headers.Add("Authorization", String.Format("Bearer {0}", token));

            //Create dataset JSON for POST request
            string datasetJson = "{\"name\": \"SalesMarketing\", \"tables\": " +
                "[{\"name\": \"Product\", \"columns\": " +
                "[{ \"name\": \"ProductID\", \"dataType\": \"Int64\"}, " +
                "{ \"name\": \"Name\", \"dataType\": \"string\"}, " +
                "{ \"name\": \"Category\", \"dataType\": \"string\"}," +
                "{ \"name\": \"IsCompete\", \"dataType\": \"bool\"}," +
                "{ \"name\": \"ManufacturedOn\", \"dataType\": \"DateTime\"}" +
                "]}]}";

            //POST web request
            byte[] byteArray = System.Text.Encoding.UTF8.GetBytes(datasetJson);
            request.ContentLength = byteArray.Length;

            //Write JSON byte[] into a Stream
            using (Stream writer = request.GetRequestStream())
            {
                writer.Write(byteArray, 0, byteArray.Length);

                var response = (HttpWebResponse)request.GetResponse();

                Console.WriteLine(string.Format("Dataset {0}", response.StatusCode.ToString()));

                Console.ReadLine();
            }
        }
        #endregion

        #region Get a dataset to add rows into a Power BI table
        private static string GetDataset()
        {
            string powerBIDatasetsApiUrl = "https://api.powerbi.com/v1.0/myorg/datasets";
            //POST web request to create a dataset.
            //To create a Dataset in a group, use the Groups uri: 
https://api.PowerBI.com/v1.0/myorg/groups/{group_id}/datasets
            HttpWebRequest request = System.Net.WebRequest.Create(powerBIDatasetsApiUrl) as 
System.Net.HttpWebRequest;
            request.KeepAlive = true;
            request.Method = "GET";
            request.ContentLength = 0;
            request.ContentType = "application/json";

            //Add token to the request header
            request.Headers.Add("Authorization", String.Format("Bearer {0}", token));

            string datasetId = string.Empty;
            //Get HttpWebResponse from GET request
            using (HttpWebResponse httpResponse = request.GetResponse() as System.Net.HttpWebResponse)
            {
                //Get StreamReader that holds the response stream
                using (StreamReader reader = new System.IO.StreamReader(httpResponse.GetResponseStream()))
                {
                    string responseContent = reader.ReadToEnd();

                    //TODO: Install NuGet Newtonsoft.Json package: Install-Package Newtonsoft.Json
                    //and add using Newtonsoft.Json
                    var results = JsonConvert.DeserializeObject<dynamic>(responseContent);

                    //Get the first id
                    datasetId = results["value"][0]["id"];

                    Console.WriteLine(String.Format("Dataset ID: {0}", datasetId));
                    Console.ReadLine();

                    return datasetId;
                }



                }
            }
        }
        #endregion
    }
}

Next steps
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Add rows to a Power BI table

NOTENOTE

This article is part of a step-by-step walkthrough to push data into a dataset.

In step 4 of Push data into a dataset, Get a dataset to add rows into a Power BI table, you used the Get Datasets
operation and Newtonsoft.Json to get a dataset id. In this step, you use the dataset id with the Add Rows operation
to add rows to a Power BI dataset.

When you call the Add Rows operation, you add rows to a dataset.

Here's how to add rows to a dataset using the Power BI API.

Before you get started, make sure you have followed the previous steps in the push data into a dataset walkthrough.

1. In the Console Application project you created in Step 2: Walkthrough to push data, Get an authentication
access token, add the code below.

2. Run the Console App, and login to your Power BI account. You should see Rows Added in the Console
Window. You can also login to Power BI to see the rows added to the dataset.

Sample push data into a dataset

Add this code into Program.cs.

In static void Main(string[] args):

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/developer/walkthrough-push-data-add-rows.md
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 static void Main(string[] args)
 {

     //Get an authentication access token
     token = GetToken();

     //Create a dataset in Power BI
     CreateDataset();

     //Get a dataset to add rows into a Power BI table
     string datasetId = GetDataset();

     //Add rows to a Power BI table
     AddRows(datasetId, "Product");
 }     

Add an AddRows() method:



    #region Add rows to a Power BI table
    private static void AddRows(string datasetId, string tableName)
    {
        string powerBIApiAddRowsUrl = 
String.Format("https://api.powerbi.com/v1.0/myorg/datasets/{0}/tables/{1}/rows", datasetId, tableName);

        //POST web request to add rows.
        //To add rows to a dataset in a group, use the Groups uri: 
https://api.powerbi.com/v1.0/myorg/groups/{group_id}/datasets/{dataset_id}/tables/{table_name}/rows
        //Change request method to "POST"
        HttpWebRequest request = System.Net.WebRequest.Create(powerBIApiAddRowsUrl) as 
System.Net.HttpWebRequest;
        request.KeepAlive = true;
        request.Method = "POST";
        request.ContentLength = 0;
        request.ContentType = "application/json";

        //Add token to the request header
        request.Headers.Add("Authorization", String.Format("Bearer {0}", token));

        //JSON content for product row
        string rowsJson = "{\"rows\":" +
            "[{\"ProductID\":1,\"Name\":\"Adjustable 
Race\",\"Category\":\"Components\",\"IsCompete\":true,\"ManufacturedOn\":\"07/30/2014\"}," +
            "{\"ProductID\":2,\"Name\":\"LL 
Crankarm\",\"Category\":\"Components\",\"IsCompete\":true,\"ManufacturedOn\":\"07/30/2014\"}," +
            "{\"ProductID\":3,\"Name\":\"HL Mountain Frame - 
Silver\",\"Category\":\"Bikes\",\"IsCompete\":true,\"ManufacturedOn\":\"07/30/2014\"}]}";

        //POST web request
        byte[] byteArray = System.Text.Encoding.UTF8.GetBytes(rowsJson);
        request.ContentLength = byteArray.Length;

        //Write JSON byte[] into a Stream
        using (Stream writer = request.GetRequestStream())
        {
            writer.Write(byteArray, 0, byteArray.Length);

            var response = (HttpWebResponse)request.GetResponse();

            Console.WriteLine("Rows Added");

            Console.ReadLine();
        }
    }

    #endregion

Complete code listing
using System;
using Microsoft.IdentityModel.Clients.ActiveDirectory;
using System.Net;
using System.IO;
using Newtonsoft.Json;

namespace walkthrough_push_data
{
    class Program
    {
        private static string token = string.Empty;

        static void Main(string[] args)

Below is the complete code listing.

 



        {

            //Get an authentication access token
            token = GetToken();

            //Create a dataset in Power BI
            CreateDataset();

            //Get a dataset to add rows into a Power BI table
            string datasetId = GetDataset();

            //Add rows to a Power BI table
            AddRows(datasetId, "Product");

        }

        #region Get an authentication access token
        private static string GetToken()
        {
            // TODO: Install-Package Microsoft.IdentityModel.Clients.ActiveDirectory -Version 2.21.301221612
            // and add using Microsoft.IdentityModel.Clients.ActiveDirectory

            //The client id that Azure AD created when you registered your client app.
            string clientID = "{Client_ID}";

            //RedirectUri you used when you register your app.
            //For a client app, a redirect uri gives Azure AD more details on the application that it will 
authenticate.
            // You can use this redirect uri for your client app
            string redirectUri = "https://login.live.com/oauth20_desktop.srf";

            //Resource Uri for Power BI API
            string resourceUri = "https://analysis.windows.net/powerbi/api";

            //OAuth2 authority Uri
            string authorityUri = "https://login.windows.net/common/oauth2/authorize";

            //Get access token:
            // To call a Power BI REST operation, create an instance of AuthenticationContext and call 
AcquireToken
            // AuthenticationContext is part of the Active Directory Authentication Library NuGet package
            // To install the Active Directory Authentication Library NuGet package in Visual Studio,
            //  run "Install-Package Microsoft.IdentityModel.Clients.ActiveDirectory" from the nuget Package 
Manager Console.

            // AcquireToken will acquire an Azure access token
            // Call AcquireToken to get an Azure token from Azure Active Directory token issuance endpoint
            AuthenticationContext authContext = new AuthenticationContext(authorityUri);
            string token = authContext.AcquireToken(resourceUri, clientID, new Uri(redirectUri)).AccessToken;

            Console.WriteLine(token);
            Console.ReadLine();

            return token;
        }

        #endregion

        #region Create a dataset in a Power BI
        private static void CreateDataset()
        {
            //TODO: Add using System.Net and using System.IO

            string powerBIDatasetsApiUrl = "https://api.powerbi.com/v1.0/myorg/datasets";
            //POST web request to create a dataset.
            //To create a Dataset in a group, use the Groups uri: 
https://api.PowerBI.com/v1.0/myorg/groups/{group_id}/datasets
            HttpWebRequest request = System.Net.WebRequest.Create(powerBIDatasetsApiUrl) as 
System.Net.HttpWebRequest;



            request.KeepAlive = true;
            request.Method = "POST";
            request.ContentLength = 0;
            request.ContentType = "application/json";

            //Add token to the request header
            request.Headers.Add("Authorization", String.Format("Bearer {0}", token));

            //Create dataset JSON for POST request
            string datasetJson = "{\"name\": \"SalesMarketing\", \"tables\": " +
                "[{\"name\": \"Product\", \"columns\": " +
                "[{ \"name\": \"ProductID\", \"dataType\": \"Int64\"}, " +
                "{ \"name\": \"Name\", \"dataType\": \"string\"}, " +
                "{ \"name\": \"Category\", \"dataType\": \"string\"}," +
                "{ \"name\": \"IsCompete\", \"dataType\": \"bool\"}," +
                "{ \"name\": \"ManufacturedOn\", \"dataType\": \"DateTime\"}" +
                "]}]}";

            //POST web request
            byte[] byteArray = System.Text.Encoding.UTF8.GetBytes(datasetJson);
            request.ContentLength = byteArray.Length;

            //Write JSON byte[] into a Stream
            using (Stream writer = request.GetRequestStream())
            {
                writer.Write(byteArray, 0, byteArray.Length);

                var response = (HttpWebResponse)request.GetResponse();

                Console.WriteLine(string.Format("Dataset {0}", response.StatusCode.ToString()));

                Console.ReadLine();
            }
        }
        #endregion

        #region Get a dataset to add rows into a Power BI table
        private static string GetDataset()
        {
            string powerBIDatasetsApiUrl = "https://api.powerbi.com/v1.0/myorg/datasets";
            //POST web request to create a dataset.
            //To create a Dataset in a group, use the Groups uri: 
https://api.PowerBI.com/v1.0/myorg/groups/{group_id}/datasets
            HttpWebRequest request = System.Net.WebRequest.Create(powerBIDatasetsApiUrl) as 
System.Net.HttpWebRequest;
            request.KeepAlive = true;
            request.Method = "GET";
            request.ContentLength = 0;
            request.ContentType = "application/json";

            //Add token to the request header
            request.Headers.Add("Authorization", String.Format("Bearer {0}", token));

            string datasetId = string.Empty;
            //Get HttpWebResponse from GET request
            using (HttpWebResponse httpResponse = request.GetResponse() as System.Net.HttpWebResponse)
            {
                //Get StreamReader that holds the response stream
                using (StreamReader reader = new System.IO.StreamReader(httpResponse.GetResponseStream()))
                {
                    string responseContent = reader.ReadToEnd();

                    //TODO: Install NuGet Newtonsoft.Json package: Install-Package Newtonsoft.Json
                    //and add using Newtonsoft.Json
                    var results = JsonConvert.DeserializeObject<dynamic>(responseContent);

                    //Get the first id
                    datasetId = results["value"][0]["id"];



                    Console.WriteLine(String.Format("Dataset ID: {0}", datasetId));
                    Console.ReadLine();

                    return datasetId;
                }
            }
        }
        #endregion

        #region Add rows to a Power BI table
        private static void AddRows(string datasetId, string tableName)
        {
            string powerBIApiAddRowsUrl = 
String.Format("https://api.powerbi.com/v1.0/myorg/datasets/{0}/tables/{1}/rows", datasetId, tableName);

            //POST web request to add rows.
            //To add rows to a dataset in a group, use the Groups uri: 
https://api.powerbi.com/v1.0/myorg/groups/{group_id}/datasets/{dataset_id}/tables/{table_name}/rows
            //Change request method to "POST"
            HttpWebRequest request = System.Net.WebRequest.Create(powerBIApiAddRowsUrl) as 
System.Net.HttpWebRequest;
            request.KeepAlive = true;
            request.Method = "POST";
            request.ContentLength = 0;
            request.ContentType = "application/json";

            //Add token to the request header
            request.Headers.Add("Authorization", String.Format("Bearer {0}", token));

            //JSON content for product row
            string rowsJson = "{\"rows\":" +
                "[{\"ProductID\":1,\"Name\":\"Adjustable 
Race\",\"Category\":\"Components\",\"IsCompete\":true,\"ManufacturedOn\":\"07/30/2014\"}," +
                "{\"ProductID\":2,\"Name\":\"LL 
Crankarm\",\"Category\":\"Components\",\"IsCompete\":true,\"ManufacturedOn\":\"07/30/2014\"}," +
                "{\"ProductID\":3,\"Name\":\"HL Mountain Frame - 
Silver\",\"Category\":\"Bikes\",\"IsCompete\":true,\"ManufacturedOn\":\"07/30/2014\"}]}";

            //POST web request
            byte[] byteArray = System.Text.Encoding.UTF8.GetBytes(rowsJson);
            request.ContentLength = byteArray.Length;

            //Write JSON byte[] into a Stream
            using (Stream writer = request.GetRequestStream())
            {
                writer.Write(byteArray, 0, byteArray.Length);

                var response = (HttpWebResponse)request.GetResponse();

                Console.WriteLine("Rows Added");

                Console.ReadLine();
            }
        }

        #endregion
    }
}

Next steps
Add Rows
Push data into a Power BI Dashboard
Overview of Power BI REST API
Power BI REST API reference

https://msdn.microsoft.com/library/mt203561.aspx
https://msdn.microsoft.com/library/mt147898.aspx


More questions? Try the Power BI Community

http://community.powerbi.com/
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Push data to dataset code
  using System;
  using Microsoft.IdentityModel.Clients.ActiveDirectory;
  using System.Net;
  using System.IO;
  using Newtonsoft.Json;

  namespace walkthrough_push_data
  {
      class Program
      {
          private static string token = string.Empty;

          static void Main(string[] args)
          {

              //Get an authentication access token
              token = GetToken();

              //Create a dataset in Power BI
              CreateDataset();

              //Get a dataset to add rows into a Power BI table
              string datasetId = GetDataset();

              //Add rows to a Power BI table
              AddRows(datasetId, "Product");

          }

          #region Get an authentication access token
          private static string GetToken()
          {
              // TODO: Install-Package Microsoft.IdentityModel.Clients.ActiveDirectory -Version 2.21.301221612
              // and add using Microsoft.IdentityModel.Clients.ActiveDirectory

              //The client id that Azure AD created when you registered your client app.
              string clientID = "{Client_ID}";

              //RedirectUri you used when you register your app.
              //For a client app, a redirect uri gives Azure AD more details on the application that it will 
authenticate.
              // You can use this redirect uri for your client app
              string redirectUri = "https://login.live.com/oauth20_desktop.srf";

              //Resource Uri for Power BI API
              string resourceUri = "https://analysis.windows.net/powerbi/api";

              //OAuth2 authority Uri
              string authorityUri = "https://login.windows.net/common/oauth2/authorize";

              //Get access token:

This article is part of a step-by-step walkthrough to push data into a dataset.

After you follow Steps 2 to 5 in Push data into a dataset, your complete source code should look like the
following.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/developer/walkthrough-push-data-complete-code.md


              //Get access token:
              // To call a Power BI REST operation, create an instance of AuthenticationContext and call 
AcquireToken
              // AuthenticationContext is part of the Active Directory Authentication Library NuGet package
              // To install the Active Directory Authentication Library NuGet package in Visual Studio,
              //  run "Install-Package Microsoft.IdentityModel.Clients.ActiveDirectory" from the nuget Package 
Manager Console.

              // AcquireToken will acquire an Azure access token
              // Call AcquireToken to get an Azure token from Azure Active Directory token issuance endpoint
              AuthenticationContext authContext = new AuthenticationContext(authorityUri);
              string token = authContext.AcquireToken(resourceUri, clientID, new Uri(redirectUri)).AccessToken;

              Console.WriteLine(token);
              Console.ReadLine();

              return token;
          }

          #endregion

          #region Create a dataset in Power BI
          private static void CreateDataset()
          {
              //TODO: Add using System.Net and using System.IO

              string powerBIDatasetsApiUrl = "https://api.powerbi.com/v1.0/myorg/datasets";
              //POST web request to create a dataset.
              //To create a Dataset in a group, use the Groups uri: 
https://api.PowerBI.com/v1.0/myorg/groups/{group_id}/datasets
              HttpWebRequest request = System.Net.WebRequest.Create(powerBIDatasetsApiUrl) as 
System.Net.HttpWebRequest;
              request.KeepAlive = true;
              request.Method = "POST";
              request.ContentLength = 0;
              request.ContentType = "application/json";

              //Add token to the request header
              request.Headers.Add("Authorization", String.Format("Bearer {0}", token));

              //Create dataset JSON for POST request
              string datasetJson = "{\"name\": \"SalesMarketing\", \"tables\": " +
                  "[{\"name\": \"Product\", \"columns\": " +
                  "[{ \"name\": \"ProductID\", \"dataType\": \"Int64\"}, " +
                  "{ \"name\": \"Name\", \"dataType\": \"string\"}, " +
                  "{ \"name\": \"Category\", \"dataType\": \"string\"}," +
                  "{ \"name\": \"IsCompete\", \"dataType\": \"bool\"}," +
                  "{ \"name\": \"ManufacturedOn\", \"dataType\": \"DateTime\"}" +
                  "]}]}";

              //POST web request
              byte[] byteArray = System.Text.Encoding.UTF8.GetBytes(datasetJson);
              request.ContentLength = byteArray.Length;

              //Write JSON byte[] into a Stream
              using (Stream writer = request.GetRequestStream())
              {
                  writer.Write(byteArray, 0, byteArray.Length);

                  var response = (HttpWebResponse)request.GetResponse();

                  Console.WriteLine(string.Format("Dataset {0}", response.StatusCode.ToString()));

                  Console.ReadLine();
              }
          }
          #endregion

          #region Get a dataset to add rows into a Power BI table
          private static string GetDataset()



          private static string GetDataset()
          {
              string powerBIDatasetsApiUrl = "https://api.powerbi.com/v1.0/myorg/datasets";
              //POST web request to create a dataset.
              //To create a Dataset in a group, use the Groups uri: 
https://api.PowerBI.com/v1.0/myorg/groups/{group_id}/datasets
              HttpWebRequest request = System.Net.WebRequest.Create(powerBIDatasetsApiUrl) as 
System.Net.HttpWebRequest;
              request.KeepAlive = true;
              request.Method = "GET";
              request.ContentLength = 0;
              request.ContentType = "application/json";

              //Add token to the request header
              request.Headers.Add("Authorization", String.Format("Bearer {0}", token));

              string datasetId = string.Empty;
              //Get HttpWebResponse from GET request
              using (HttpWebResponse httpResponse = request.GetResponse() as System.Net.HttpWebResponse)
              {
                  //Get StreamReader that holds the response stream
                  using (StreamReader reader = new System.IO.StreamReader(httpResponse.GetResponseStream()))
                  {
                      string responseContent = reader.ReadToEnd();

                      //TODO: Install NuGet Newtonsoft.Json package: Install-Package Newtonsoft.Json
                      //and add using Newtonsoft.Json
                      var results = JsonConvert.DeserializeObject<dynamic>(responseContent);

                      //Get the first id
                      datasetId = results["value"][0]["id"];

                      Console.WriteLine(String.Format("Dataset ID: {0}", datasetId));
                      Console.ReadLine();

                      return datasetId;
                  }
              }
          }
          #endregion

          #region Add rows to a Power BI table
          private static void AddRows(string datasetId, string tableName)
          {
              string powerBIApiAddRowsUrl = 
String.Format("https://api.powerbi.com/v1.0/myorg/datasets/{0}/tables/{1}/rows", datasetId, tableName);

              //POST web request to add rows.
              //To add rows to a dataset in a group, use the Groups uri: 
https://api.powerbi.com/v1.0/myorg/groups/{group_id}/datasets/{dataset_id}/tables/{table_name}/rows
              //Change request method to "POST"
              HttpWebRequest request = System.Net.WebRequest.Create(powerBIApiAddRowsUrl) as 
System.Net.HttpWebRequest;
              request.KeepAlive = true;
              request.Method = "POST";
              request.ContentLength = 0;
              request.ContentType = "application/json";

              //Add token to the request header
              request.Headers.Add("Authorization", String.Format("Bearer {0}", token));

              //JSON content for product row
              string rowsJson = "{\"rows\":" +
                  "[{\"ProductID\":1,\"Name\":\"Adjustable 
Race\",\"Category\":\"Components\",\"IsCompete\":true,\"ManufacturedOn\":\"07/30/2014\"}," +
                  "{\"ProductID\":2,\"Name\":\"LL 
Crankarm\",\"Category\":\"Components\",\"IsCompete\":true,\"ManufacturedOn\":\"07/30/2014\"}," +
                  "{\"ProductID\":3,\"Name\":\"HL Mountain Frame - 
Silver\",\"Category\":\"Bikes\",\"IsCompete\":true,\"ManufacturedOn\":\"07/30/2014\"}]}";



              //POST web request
              byte[] byteArray = System.Text.Encoding.UTF8.GetBytes(rowsJson);
              request.ContentLength = byteArray.Length;

              //Write JSON byte[] into a Stream
              using (Stream writer = request.GetRequestStream())
              {
                  writer.Write(byteArray, 0, byteArray.Length);

                  var response = (HttpWebResponse)request.GetResponse();

                  Console.WriteLine("Rows Added");

                  Console.ReadLine();
              }
          }

          #endregion
      }
  }

Next steps
Push data into a Power BI dataset
Walkthrough - Push data into a Power BI dataset
Register an app with Azure AD
Get an authentication access token
Create a dataset in Power BI
Get a dataset to add rows into a Power BI table
Add rows to a Power BI table
Power BI REST API reference
Overview of Power BI REST API

More questions? Try the Power BI Community

https://msdn.microsoft.com/library/mt147898.aspx
http://community.powerbi.com/
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Overview

Requirements

Business scenario

A content pack is a set of out-of-box content allowing users to immediately gain insights from a source. A content
pack is typically focused on a specific business scenario providing insights for a role, domain, or workflow.

ISVs can build template content packs that allow customers to connect and instantiate with their own accounts. As
domain experts, they can unlock the data in a way that is easily consumable by a business users. The content packs
offer adhoc monitoring and analysis to your customers without investing heavily in reporting infrastructure.

These ISV built template content packs can be submitted to the Power BI team to become publicly available in the
Power BI content pack gallery (app.powerbi.com/getdata/services) and on Microsoft AppSource
(appsource.microsoft.com). An example of the public content pack experience can be found here.

The general process to develop and submit an template content pack involves multiple steps.

1. Review the requirements and make sure you meet them
2. Build content in the Power BI Desktop
3. Create a dashboard in PowerBI.com
4. Test the content pack yourself within your organization
5. Submit the content to Power BI for publishing

 

To build and submit a content pack to be published in the PowerBI service and AppSource, you must meet the
following requirements:

You have a SaaS application used by business users.
Your SaaS application has user data that can be visualized in Power BI.
Your SaaS application has an API that is accessible through public internet. Ideally the API is a REST based API or
an OData feed. Power BI content packs support multiple authentication types like Basic Authentication, OAuth
2.0 and API Key.
Your SaaS application is approved for publishing a content pack. Submit your request to
pbiservicesapps@microsoft.com. We will review each submission on relevance and expected usage.
Signed partner agreement. You will do that in the submission step.

Please review the authoring section for more details on the technical requirements.

Content packs provide insights and metrics focused on a specific business scenario. Understanding your audience
and the benefit they'll receive from the content pack will help ensure your users are successfully with the content
you provide.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/developer/service-content-pack-overview.md


TipsTips

Frequently asked questions

Support

Next step

Identify your audience and the task they're trying to accomplish
Focus on a certain time period (last 90 days) or the last N results
Only import the tables/columns related to your scenario
Consider offering more than one content pack for separate unique scenarios

Can I build a Power BI Service content pack for a third-party SaaS application that I don’t own?

No, we currently require signing a partner agreement with the owner of the SaaS application prior to publishing
the content pack in the service.

I don’t have a public developer API for my service. Can I still build a Power BI service content pack that
pulls the data directly from the data storage?

No, Power BI service content packs require a developer API that is accessible through public Internet.

What kind of APIs are supported by service content packs and what authentication types can they work
with?

Power BI service content packs support any REST API or OData feed. Power BI can work with multiple
authentication types including Basic Authentication, OAuth2.0 and Web API Key. More details on the technical
requirements in the Authoring article.

I have more questions about service Content Packs. How can I contact you?

Feel free to email us your questions at pbiservicesapps@microsoft.com

For support during development, please use https://powerbi.microsoft.com/support. This is actively monitored and
managed. Customer incidents quickly find their way to the appropriate team.

Authoring

https://powerbi.microsoft.com/support
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Queries

Connect to your APIConnect to your API

NOTENOTE

Consider the sourceConsider the source

Schema enforcementSchema enforcement

Authoring a template content pack uses the Power BI Desktop and PowerBI.com. There are four components to
your content pack:

Queries allow you to connect and transform the data, as well as define parameters
Data model to create relationships, measures, and Q&A improvements
Report pages include visuals and filters to provide insights into your data
Dashboard and tiles offer an overview of the insights included

You may be familiar with each piece as existing Power BI features. When building a content pack, there are
additional things to consider for each aspect, see each section below for more details.

    

For template content packs, queries developed in the Power BI Desktop are used to connect to your data source
and import data. These queries are required to return a consistent schema and are supported for Scheduled Data
refresh (direct query is not supported).

Template content packs only support one data source per content pack so define your queries carefully. A single
data source is defined as a source that requires the same authentication. You can make multiple API calls in
different queries if all the calls are to the same API endpoint and use the same authentication. Power BI content
packs do not support multiple sources that require different authentications.

To get started, you will need to connect to your API from Power BI Desktop to start building your queries.

You can use the Data Connectors that are available out of the box in Power BI Desktop to connect to your API. You
can use the Web Data Connector (Get Data -> Web) to connect to your Rest API or the OData connector (Get Data -
> OData feed) to connect to your OData feed. Please note that these connectors will work out of the box only if
your API supports Basic Authentication.

If your API uses any other authentication types, like OAuth 2.0 or Web API Key, then you will need to develop your own
Data Connector to allow Power BI Desktop to successfully connects and authenticates to your API. For details on how to
develop your own Data Connector for your Content Pack, check the Data Connectors documentation here.

The queries define the data that will be included in the data model. Depending on the size of your system, these
queries should also include filters to ensure your customers are dealing with a manageable size that fits your
business scenario.

Power BI content packs can execute multiple queries in parallel and for multiple users concurrently. Plan ahead
your throttling and concurrency strategy and ask us how to make your content pack fault tolerant.

Ensure your queries are resilient to changes in your system, changes in schema on refresh can break the model. If
the source could return null/missing schema result for some queries, consider returning an empty table or throw a
custom error messages that is meaningful to your user.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/developer/template-content-pack-authoring.md
https://powerbi.microsoft.com/blog/deep-dive-into-query-parameters-and-power-bi-templates/
https://docs.microsoft.com/en-us/power-bi/service-dashboard-create
https://aka.ms/DataConnectors


ParametersParameters
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Additional query tipsAdditional query tips

Data Model

NOTENOTE

Q&AQ&A

Additional data model tipsAdditional data model tips

Reports

NOTENOTE

Additional report tipsAdditional report tips

Parameters in Power BI Desktop allow your users to provide input values that customize the data retrieved by the
user. Think of the parameters upfront to avoid rework after investing time to build detailed queries or reports.

Template content packs only support text parameters currently. Other parameter types can be used during development but
during the testing portion all values provided by the users will be literal.

Ensure all columns are typed appropriately
Columns have informative names (see Q&A)
For shared logic, consider using functions or queries
Privacy levels are not currently supported in the service - if you get a prompt about privacy levels, you may
need to re-write the query to use relative paths

A well-defined data model will ensure your customers can easily and intuitively interact with the content pack.
Create the data model in the Power BI Desktop.

Much of the basic modelling (typing, column names) should be done in the queries.

The modelling will also affect how well Q&A can provide results for your customers. Ensure you add synonyms to
commonly used columns and that your columns are properly named in the queries.

All value columns have formatting applied >[!NOTE] >Types should be applied in the query.
All measures have formatting applied
Default Summarization is set. Especially "Do Not Summarize", when applicable (for unique values for example)
Data Category has been set, when applicable
Relationships are set, as necessary

The report pages offer additional insight into the data included in your content pack. Use the pages of the reports
to answer the key business questions your content pack is trying to address. Create the report using the Power BI
Desktop.

Only one report may be included in a content pack, take advantage of the different pages to call out particular sections of
your scenario.

Use more than one visual per page for cross-filtering
Align the visuals carefully (no overlapping)
Page is set to "4:3" or "16:9" mode for layout

https://powerbi.microsoft.com/blog/deep-dive-into-query-parameters-and-power-bi-templates/


Dashboard

NOTENOTE

Additional dashboard tipsAdditional dashboard tips

Summary of restrictions

SUPPORTED NOT SUPPORTED

Datasets built in PBI Desktop Datasets from other content packs or inputs such as Excel
files

Data source supported for cloud Scheduled Data refresh Direct query or on-prem connecitivty is not supported

Queries returning consistent schema or errors where
appropriate

Dynamic or custom schemas

One data source per dataset Multiple data sources such as mashups or URLs that are
detected as mutliple data sources

Parameters of type text Other parameter types (such as date) or "list allowed of
values"

One dashboard, report and dataset Multiple dashboards, reports or datasets

Next step

All of the aggregations presented make numeric sense (averages, unique values)
Slicing produces rational results
Logo is present on at least the top report
Elements are in the client's color scheme to the extent possible

    

The dashboard is the main point of interaction with your content pack for your customers. It should include an
overview of the content included, especially the important metrics for your business scenario.

To create a dashboard for your template content pack, simply upload your PBIX through Get Data > Files or
publish directly from the Power BI Desktop.

Template content packs currently require a single report and dataset per content pack. Do not pin content from multiple
reports/datasets onto the dashboard used in the content pack.

Maintain the same theme when pinning so that the tiles on your dashboard are consistent
Pin a logo to the theme so consumers know where the pack is from
Suggested layout to work with most screen resolutions is 5-6 small tiles wide
All dashboard tiles should have appropriate titles/subtitles
Consider groupings in the dashboard for different scenarios, either vertically or horizontally

  

As listed in the above sections, currently the template content packs have a set of restrictions:

Content Pack Testing and Submission
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1/30/2018 • 3 min to read • Edit Online

NOTENOTE

Testing Scheduled Data Refresh

Additional refresh tipsAdditional refresh tips

There are multiple ways to test your content pack before submitting it for publishing.

If your content pack uses a custom Data Connector that you developed, you will not be able to test the data refresh or the
template content pack as described below. If that is the case, please proceed to submit your content pack and the Power BI
team will work with you on testing your content pack.

Template content packs leverage Refresh in PowerBI.com to instantiate a content pack with the customer's data
when they connect. Prior to the content pack being publicly available, you can test this flow with the Desktop file
you've created.

After uploading the file, select the "…" next to the dataset and select Schedule Refresh. Configure credentials for the
source. Make sure that your dataset refreshes successfully, try both "Refresh Now" and "Scheduled Refresh". If
your refresh hits any failures, check the error message and validate your queries and your end system.

Only one data source should be detected when you try to schedule refresh
Test connection should indicate that your user will be able to load the content pack. If that's not the case, ensure
your queries handle the additional error cases.
Refresh should complete in a reasonable time, ~5mins is suggested

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/developer/template-content-pack-testing.md
https://aka.ms/DataConnectors


Testing Templates

NOTENOTE

  

A template content pack is similar to existing solutions except that it does not include the actual data in the dataset.
Instead, when a user consumes or instantiates a template, they are prompted for parameters and credentials in
order to connect. Once connected, they'll see their own data in the dashboard, report and datasets.

After a user instantiates the content pack they have access to the dataset settings including scheduled refresh, any
RLS settings on the dataset are not published with the content pack.

Template content packs can only include 1 dashboard, 1 report and 1 dataset. Please see the list of restrictions in the
authoring page.

To enable template creation for your tenant, please work with your Power BI admin to enable the feature switch
below.

Once enabled, you'll see a checkbox at the bottom of "Create content pack", allowing you to publish a template
content pack to your organization.

https://app.powerbi.com/groups/me/publish-content/


NamingNaming

Additional template tipsAdditional template tips

Submission

Before submissionBefore submission

We suggest naming your dashboard, report and dataset consistently across your content pack. These names are
hardcoded and will be the same for all users, so using your product/scenario name can make it easier for your
customers to locate.

Ensure the parameters you specified in the queries are meaningful to your end users
Consider how long your end user will be waiting for scheduled refresh to complete

     

The submission process through Microsoft AppSource will allow you to publish your template content pack in the
service content packs gallery in PowerBI.com as well as list your content pack in Microsoft AppSource.

Review the authoring tips for each of the artifacts within the content pack
Test and connect with various accounts and data conditions. (Skip this step if you developed your own custom
Data Connector)

https://appsource.microsoft.com/en-us/partners/list-an-app
http://appsource.microsoft.com
https://aka.ms/DataConnectors


SubmissionSubmission

UpdatesUpdates

Review all visuals, look carefully for misspelled items
Ensure the content pack responds well to Q&A, we suggest testing at least 30 varied questions across the data
model. (Skip this step if you developed your own custom Data Connector)

Once ready to submit, visit the Apps submission page on AppSource and submit your information. Please make
sure to select Power BI from the available list of products

The Power BI team will review your submission and will reach out to you to ensure all the artifacts meets the
submission requirements. In addition to being complete, we'll also validate the quality of the dashboard and
reports provided ensuring they meet the business scenario described in the application.

Updating your content pack follows a similar flow to the original submission.

https://aka.ms/DataConnectors
https://appsource.microsoft.com/en-us/partners/list-an-app
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Connect

This section highlights a typical experience for a user connecting to an ISV content pack.

Try the connection experience yourself by connecting to a released content pack at
https://app.powerbi.com/getdata/services (such as the GitHub content pack described below).

To get started, a user browses the content pack gallery and selects a content pack to connect to. The content pack
entry provides a name, an icon and a descriptive text providing more information to the user.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/developer/template-content-pack-experience.md
https://app.powerbi.com/getdata/services
https://app.powerbi.com/getdata/services/github


Parameters

Credentials

Once selected, the user will be prompted to provide parameters (if requried). The parameters dialog is provided
declaratively by the author during the creation of the content pack.

Currently the parameters UI is very basic – there is no way to enumerate drop down lists and data input validation
is constrained to regex.

After parameters, the user will be prompted to login. If the source supports multiple types of authentication, the
user will choose the appropriate option. If the source requires OAuth, then the service’s login UI will pop up when
the user presses Sign In. Otherwise, the user can enter their credentials in the provided dialog.



Instantiation
When login succeeds, the artifacts included in the content pack - model, reports, and dashboard - appear in the
navigation bar. These artifacts are added to each users’ account. The data load asynchronously to populate the
dataset (model). The user is then able to consume the dashboard, reports, and model.

By default a daily refresh schedule is configured for the user, which will re-evaluate the queries in the model. The
credentials provided to the user must allow them to refresh the data without being present.



Exploration and Monitoring
Once the content pack is hydrated into the users’ account, they can explore and monitor the data/insights.

Typically this includes:

Viewing and customizing the dashboard.
Viewing and customizing the report.
Using natural language to ask questions of the data
Using the exploration canvas to explore the data in the data model

Consideration should be made for providing natural language modelling (synonyms) and understandable model
schema to enable better exploration experiences.
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Power BI is a cloud-based service that you can use to build custom dashboard applications. The Power BI REST API
is a REST-based API that provides programmatic access to Dashboard resources such as Datasets, Tables, and
Rows in Power BI.

The Power BI REST API has the following operations:

Dataset operations: Get and create Datasets.
Table operations: Get Tables and update Table schema.
Row operations: Add Rows and Delete Rows.
Group operations: Get Groups.

To learn more about the Power BI REST API, see Overview of Power BI REST API.

More questions? Try asking the Power BI Community

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/developer/rest-api-reference.md
https://msdn.microsoft.com/library/dn877544.aspx
http://community.powerbi.com/


Get started with Power BI Report Server
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Create, deploy, and manage reports

What's new in Power BI Report ServerWhat's new in Power BI Report Server

Web portal

Create, deploy, and manage Power BI, mobile and paginated reports on premises with the range of ready-to-use
tools and services that Power BI Report Server provides.

Power BI Report Server is a solution that customers deploy on their own premises for creating, publishing, and
managing reports, then delivering them to the right users in different ways, whether that’s viewing them in web
browser, on their mobile device, or as an email in their in-box.

Power BI Report Server offers a suite of products:

A modern web portal you can view in any modern browser. In the web portal, you can organize and display
reports and KPIs. You can also store Excel workbooks on the portal.
Power BI reports, created with Power BI Desktop, that you can view within the web portal in your own
environment.
Paginated reports so you can create modern-looking reports, with tools for creating them.
Mobile reports with a responsive layout that adapts to different devices and the different ways you hold them.

Read on for more about each.

These sources will keep you up-to-date on new features in Power BI Report Server.

What's New in Power BI Report Server
Microsoft Power BI Blog
SQL Server Reporting Services Team Blog
The Guy in a Cube YouTube channel

For end users of Power BI Report Server, the front door is a modern web portal you can view in any modern
browser. You can access all your reports and KPIs in the new portal.

You can apply your own custom branding to your web portal. And you can create KPIs right in the web portal.
KPIs can surface key business metrics at a glance in the browser, without having to open a report.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/report-server/get-started.md
https://powerbi.microsoft.com/blog/
https://blogs.msdn.microsoft.com/sqlrsteamblog/
https://aka.ms/guyinacube
https://docs.microsoft.com/sql/reporting-services/branding-the-web-portal


Power BI reports

Paginated reports

The content on the web portal is organized by type: Power BI reports, mobile reports, paginated reports and KPIs,
plus Excel workbooks, shared datasets, and shared data sources to use as building blocks for your reports. You
can store and manage them securely here, in the traditional folder hierarchy. You can tag your favorites, and you
can manage the content if you have that role.

And you can schedule report processing, access reports on demand, and subscribe to published reports in the
new web portal.

More about the Web portal.

A Power BI report is a multi-perspective view into a dataset, with visualizations that represent different findings
and insights from that dataset. A report can have a single visualization or pages full of visualizations. Depending
on your job role, you may be someone who creates reports and/or you may be someone who consumes or uses
reports.

Reports are based on a single dataset. The visualizations in a report each represent a nugget of information. And
the visualizations aren't static; you can add and remove data, change visualization types, and apply filters and
slicers as you dig into the data to discover insights and look for answers. Like a dashboard, but more-so, a report
is highly interactive and highly customizable and the visualizations update as the underlying data changes.

Paginated reports are paginated document-style reports, in which the more data you have, the more rows in the
tables, and the more pages the report would have. That’s great for generating fixed-layout, pixel-perfect

https://docs.microsoft.com/sql/reporting-services/web-portal-ssrs-native-mode


Report Server programming features

Next steps

documents optimized for printing, such as PDF and Word files.

You can create modern-looking reports using Report Builder or Report Designer in SQL Server Data Tools
(SSDT).

Take advantage of Power BI Report Server programming features so you can extend and customize your
reporting functionality, with APIs to integrate or extend data and report processing in custom applications.

More Report Server developer documentation.

User handbook
Administrator handbook
Quickstart: Install Power BI Report Server
Install Report Builder
Download SQL Server Data Tools (SSDT)

More questions? Try asking the Power BI Community

https://docs.microsoft.com/sql/reporting-services/report-builder/report-builder-in-sql-server-2016
https://docs.microsoft.com/sql/reporting-services/tools/reporting-services-in-sql-server-data-tools-ssdt
https://docs.microsoft.com/sql/reporting-services/reporting-services-developer-documentation
https://docs.microsoft.com/sql/reporting-services/install-windows/install-report-builder
http://go.microsoft.com/fwlink/?LinkID=616714
https://community.powerbi.com/
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October 2017 release
Power BI report data sourcesPower BI report data sources

Scheduled data refresh for imported dataScheduled data refresh for imported data

Editing Power BI reports from the serverEditing Power BI reports from the server

Large file upload/downloadLarge file upload/download

Accessing shared datasets as OData feedsAccessing shared datasets as OData feeds

Scale-outScale-out

Learn about what's new in Power BI Report Server. This covers the major feature areas and is updated as new
items are released.

To download Power BI Report Server, and Power BI Desktop optimized for Power BI Report Server, go to On-
premises reporting with Power BI Report Server.

 For the current release notes, see Power BI Report Server - Release notes.

For related "What's New" information, see:

What's new in the Power BI service
What's new in Power BI Desktop
What's new in the mobile apps for Power BI
Power BI team blog

Power BI reports in Power BI Report Server can connect to a variety of data sources. You can import data and
schedule data refresh, or query it directly using DirectQuery or a live connection to SQL Server Analysis Services.
See the list of data sources that support scheduled refresh and those that support DirectQuery in "Power BI report
data sources in Power BI Report Server".

In Power BI Report Server, you can set up scheduled data refresh to keep data up to date in Power BI reports with
an embedded model rather than a live connection or DirectQuery. With an embedded model you import the data,
so it's disconnected from the original data source. It needs to be updated to keep the data fresh, and scheduled
refresh is the way to do that. Read more about "scheduled refresh for Power BI reports in Power BI Report Server".

You can open and edit Power BI report (.pbix) files from the server, but you get back the original file you uploaded.
This means if the data has been refreshed by the server, the data won’t be refreshed when you first open
the file. You need to manually refresh it locally to see the change.

You can upload files up to 2 GB in size, though by default this limit is set to 1 GB in the Report Server settings in
SQL Server Management Studio (SSMS). These files are stored in the database just as they are for SharePoint, and
no special configuration for the SQL Server catalog is required.

You can access shared datasets from Power BI Desktop with an OData feed. For more information, see Accessing
shared datasets as OData feeds in Power BI Report Server.

This release supports scale-out. Use a load-balancer and set server affinity for the best experience. Note that the
scenario is not yet optimized for scale-out, so you'll see models potentially replicated across multiple nodes. The
scenario will work without the Network Load Balancer and sticky sessions. However, you'll not only see an over-
use of memory across nodes as the model is loaded N times, but performance will slow in between connections as

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/report-server/whats-new.md
https://powerbi.microsoft.com/report-server/
https://powerbi.microsoft.com/blog/


Administrator settingsAdministrator settings

<Configuration>
  <Service>
    <PollingInterval>10</PollingInterval>
    <IsDataModelRefreshService>false</IsDataModelRefreshService>
    <MaxQueueThreads>0</MaxQueueThreads>
  </Service>
</Configuration>

Developer APIDeveloper API

SQL Server Analysis Services (SSAS) and the Power BI Report Server memory footprintSQL Server Analysis Services (SSAS) and the Power BI Report Server memory footprint

Viewing and interacting with Excel workbooksViewing and interacting with Excel workbooks

Support for new table and matrix visualsSupport for new table and matrix visuals

the model is streamed as it hits a new node in between requests.

Administrators can set the following properties in SSMS Advanced Properties for the server farm:

EnableCustomVisuals: True/False
EnablePowerBIReportEmbeddedModels: True/False
EnablePowerBIReportExportData: True/False
MaxFileSizeMb: Default is now 1000
ModelCleanupCycleMinutes: How often it checks to evict models from memory
ModelExpirationMinutes: How long until model expires and is evicted, based on last time used
ScheduleRefreshTimeoutMinutes: How long data refresh can take for a model. By default, this is two hours.
There is no hard upper limit.

Config file rsreportserver.config

The developer API (REST API) introduced for SSRS 2017 has been extended for Power BI Report Server to work
with both Excel files and .pbix files. One potential use case is to programmatically download files from the server,
refresh them, and then republish them. This is the only way to refresh Excel workbooks with PowerPivot models,
for example.

Note that there is a new separate API for large files, which will be updated in the Power BI Report Server version of
Swagger.

Power BI Report Server now hosts SQL Server Analysis Services (SSAS) internally. This isn't specific to scheduled
refresh. Hosting SSAS can greatly expand the report server memory footprint. The AS.ini configuration file is
available on the server nodes, so if you're familiar with SSAS, you may want to update the settings, including
maximum memory limit and disk caching etc. See Server properties in Analysis Services for details.

Excel and Power BI contain a portfolio of tools that is unique in the industry. Together, they enable business
analysts to more easily gather, shape, analyze, and visually explore their data. In addition to viewing Power BI
reports in the web portal, business users can now do the same with Excel workbooks in Power BI Report Server,
giving them a single location to publish and view their self-service Microsoft BI content.

We’ve published a walkthrough of how to add Office Online Server (OOS) to your Power BI Report Server preview
environment. Customers with a Volume Licensing account can download OOS from the Volume License Servicing
Center at no cost and will have view-only functionality. Once configured, users can view and interact with Excel
workbooks that:

Have no external data source dependencies
Have a live connection to an external SQL Server Analysis Services data source
Have a PowerPivot data model

https://docs.microsoft.com/sql/analysis-services/server-properties/server-properties-in-analysis-services


June 2017

May 2017

Next steps

Power BI Report Server now supports the new Power BI table and matrix visuals. To create reports with these
visuals, you will need an updated Power BI Desktop release for the October 2017 release. It can't be installed side-
by-side with the Power BI Desktop (June 2017) release. For the latest version of Power BI Desktop, on the Power BI
Report Server download page, select Advanced download options.

Power BI Report Server made generally available (GA).

Power BI Report Server Preview made available
Ability to publish Power BI reports on-premises

Enhanced collaboration in reports with comments

Suppport for custom visuals
Support for Analysis Services live connections only with more data sources to come.
Power BI Mobile app updated to display Power BI reports hosted in Power BI Report Server

Power BI Report Server release notes
User handbook
Administrator handbook
Quickstart: Install Power BI Report Server
Install Report Builder
Download SQL Server Data Tools (SSDT)

More questions? Try asking the Power BI Community

https://powerbi.microsoft.com/report-server/
https://docs.microsoft.com/sql/reporting-services/install-windows/install-report-builder
http://go.microsoft.com/fwlink/?LinkID=616714
https://community.powerbi.com/
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October 2017

June 2017

May 2017

This topic describes limitations and issues with Power BI Report Server.

To download Power BI Report Server, and Power BI Desktop optimized for Power BI Report Server, go to On-
premises reporting with Power BI Report Server.

Support for imported data in Power BI reports
Ability to view excel workbooks within the web portal. This is done by configuring Office Online Server.
Support for the new Power BI table and matrix visuals.
REST API support

No new items for June 2017.

Power BI reports must be created with Power BI Desktop optimized for Power BI Report Server in order to
work with Power BI Report Server. You can download Power BI Desktop from the download link at the top of
this page.
Power BI Reports only support live connections to Analysis Services (tabular or multidimensional).
No support for R visuals.

Issue and customer impact: If you have both SQL Server Reporting Services and Power BI Report Server on the
same machine and uninstall one of them, you will no longer be able to connect to the remaining report server
with Report Server Configuration Manager.

Workaround To work around this issue, you must perform the following operations after uninstalling one of the
servers.

1. Launch a command prompt in Administrator mode.

3. Then go to the next folder. This will either be SSRS or PBIRS depending on what is remaining.
4. Go to the WMI folder.

regsvr32 /i ReportingServicesWMIProvider.dll

2. Go to the directory where the remaining report server is installed.

Default location for Power BI Report Server: C:\Program Files\Microsoft Power BI Report Server

Default location for SQL Server Reporting Services: C:\Program Files\Microsoft SQL Server Reporting
Services

5. Run the following command:

You can ignore the following error, if you see it.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/report-server/release-notes.md
https://powerbi.microsoft.com/report-server/


Next steps

The module "ReportingServicesWMIProvider.dll" was loaded but the entry-point DLLInstall was not found. 
Make sure that "ReportingServicesWMIProvider.dll" is a valid DLL or OCX file and then try again.

What's new in Power BI Report Server
User handbook
Administrator handbook
Quickstart: Install Power BI Report Server
Install Report Builder
Download SQL Server Data Tools (SSDT)

More questions? Try asking the Power BI Community

https://docs.microsoft.com/sql/reporting-services/install-windows/install-report-builder
http://go.microsoft.com/fwlink/?LinkID=616714
https://community.powerbi.com/
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October 2017

This change log is for Power BI Report Server and lists new items along with bug fixes for each released build.

For detailed information about new features, see What's new in Power BI Report Server.

Power BI Report Server

Version 1.1.6582.41691 (Build 14.0.600.442), Released: January 10, 2018

Security Updates
Bug Fixes

Fix for Model.GetParameters returning 400
Fix for setting shared data set to existing Paginated Reports (RDL)
Fix for ExecutionNotFoundException when exporting report with different parameter values
to PDF

Version 1.1.6551.5155 (Build 14.0.600.438), Released: December 11, 2017

Bug Fixes
Failure to save data after refreshing for certain Power BI Desktop reports.

Version 1.1.6530.30789 (Build 14.0.600.437), Released: November 17, 2017

Bug Fixes
Fix for Basic Authentication Scenarios
Fix for weekdays were not selectable on schedule page for Subscriptions, Cache Refresh
Plans and History Snapshots on Portal
For Paginated Reports (RDL), fix for having expressions in Textbox with CanGrow property
set to false is resulting in values not showing colors and fonts not being proper
For Power BI Reports (PBIX), fix for adding Legends to line chart renders an empty visual

Version 1.1.6514.9163 (Build 14.0.600.434), Released: November 1, 2017

Bug Fixes
Fix for upload reliability problems for PBIX reports over 500MB
Fix for data loading issue for PBIX reports over 1GB

Version 1.1.6513.3500 (Build 14.0.600.433), Released: October 31, 2017

Features
Embedded Data Model Support
Excel Workbook Viewing (with Office Online Server integration enabled)
Scheduled Data Refresh (PBIX)
Direct Query Support
Large File Support (up to 2 GB)
Public REST API
Shared Dataset support in Power BI Desktop (via oData)
URL Parameter Support for PBIX files
Accessibility improvements

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/report-server/changelog.md


June 2017

Next steps

Power BI Desktop (optimized for Power BI Report Server)

Version: 2.51.4885.2501 (October 2017), Released: January 10, 2018

Security Updates
Version: 2.51.4885.1423 (October 2017), Released: November 17, 2017

Bug Fixes
Fix for 32-bit Power BI Desktop failing to run on x86 OS
For Power BI Reports (PBIX), fix to show x-axis gridlines
Other minor bug fixes

Version: 2.51.4885.1041 (October 2017), Released: October 31, 2017

Features
Contains changes required for connection with Power BI Report Server (October 2017)

Power BI Report Server

Build 14.0.600.309, Released: January 10, 2018

Security Updates
Build 14.0.600.305, Released: September 19, 2017

Bug Fixes
Update to the latest Bing Maps Web Control

Build 14.0.600.301, Released: July 11, 2017

Bug Fixes
The {{UserId}} tag resolves to the stored credentials instead of the user executing the report
in Power BI Reports
Some images fail to render in Power BI Report Server reports
Unable to change the name of a Power BI Report in the Power BI Report Server
Unable to load Custom Visuals in the Power BI mobile application (it requires reinstall of the
mobile app to clear up the local cache)

Build 14.0.600.271,Released: June 12, 2017

Power BI Report Server initial release
Power BI Desktop (optimized for Power BI Report Server)

Version: 2.47.4766.4901 (June 2017), Released: January 10, 2018

Security Updates

User handbook
Administrator handbook
Quickstart: Install Power BI Report Server
Install Report Builder
Download SQL Server Data Tools (SSDT)

More questions? Try asking the Power BI Community

https://msdn.microsoft.com/library/mt712542.aspx
https://docs.microsoft.com/sql/reporting-services/install-windows/install-report-builder
http://go.microsoft.com/fwlink/?LinkID=616714
https://community.powerbi.com/
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Version history
VERSION AVAILABILITY DATE SUPPORT END DATE

October 2017 October 31, 2017 October 31, 2018

June 2017 June 12, 2017 June 12, 2018

Next steps

Power BI Report Server will be released a few times per year. Security and critical updates will be available until the
next release becomes generally available (GA). After the next release, the previous release will continue to receive
security updates for the remainder of the 12 month release lifespan.

This support policy allows us to deliver innovation to customers at a rapid rate while providing flexibility for
customers to adopt the innovation at their pace.

Security and Critical Updates servicing phase - When running the latest current version of Power BI Report
Server, you will receive both Security and Critical updates.
Security Updates (Only) servicing phase - After a new version is released, support for older versions will
reduce to Security updates only for the remainder of the twelve (12) month support lifecycle (shown in
figure 1).

To download Power BI Report Server, and Power BI Desktop optimized for Power BI Report Server, go to On-
premises reporting with Power BI Report Server.

For the current release notes, see Power BI Report Server - Release notes.

What's new in Power BI Report Server
Power BI Report Server release notes
User handbook
Administrator handbook
Quickstart: Install Power BI Report Server

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/report-server/support-timeline.md
https://powerbi.microsoft.com/report-server/


More questions? Try asking the Power BI Community

https://community.powerbi.com/
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Web portal

Welcome to the user handbook for Power BI Report Server, an on-premises location for storing and managing
your Power BI, mobile, and paginated reports.

Power BI Report Server is also a set of products and experiences that work together to bring your data to life:

A web portal you can view in any modern browser. In the web portal, reports and KPIs are organized and
displayed in folders, and you can mark them as favorites. You can also store Excel workbooks there.
Power BI reports created with Power BI Desktop, which you view within the web portal or in the Power BI
mobile apps.
Paginated reports, modern-looking, fixed-layout documents optimized for printing, with tools for creating
them.

Read on for more about each.

The front door of Power BI Report Server is a modern web portal you can view in any modern browser. You can
access all your reports and KPIs in the new portal.

The web portal may feature your organization's custom branding and display KPIs right in the web portal. KPIs
can surface key business metrics at a glance in the browser, so you don't have to open a report.

The content on the web portal is organized into folders, and within each folder, it's organized by type: Power BI

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/report-server/user-handbook-overview.md


 

 

Power BI reports

Paginated reports

reports, mobile reports, paginated reports, and KPIs, plus Excel workbooks. You can tag your favorite reports and
KPIs. They're all collected in the Favorites folder so you can find them fast.

A Power BI report is a multi-perspective view into a dataset, with visualizations that represent different findings
and insights from that dataset. A report can have a single visualization or pages full of visualizations. Depending
on your role, you may be someone who creates reports and/or you may be someone who views and interacts
with reports.

Reports are based on a single dataset. The visualizations in a report each represent a nugget of information. And
the visualizations aren't static: Like a dashboard but more so, a report is interactive and customizable, and the
visualizations update as the underlying data changes.

If you're a report creator you can add and remove data, add or rearrange visualizations, or change
visualization types.
If you're a report viewer, you can sort and apply filters and slicers as you dig into the data to discover insights
and look for answers.

You create Power BI reports with a special edition of Power BI Desktop. Download Microsoft Power BI Desktop
(Optimized for Power BI Report Server - October 2017 GA).

Paginated reports are document-style reports, in which the more data you have, the more rows in the tables, and
the more pages the report has. They make great fixed-layout, pixel-perfect documents optimized for printing,

https://go.microsoft.com/fwlink/?linkid=837581


Next steps

such as PDF and Word files.

You create these paginated reports with Report Builder or Report Designer in SQL Server Data Tools (SSDT).

Install Power BI Desktop optimized for Power BI Report Server
Quickstart: Paginated reports
Quickstart: Power BI reports

More questions? Try asking the Power BI Community

https://docs.microsoft.com/sql/reporting-services/report-builder/report-builder-in-sql-server-2016
https://docs.microsoft.com/sql/reporting-services/tools/reporting-services-in-sql-server-data-tools-ssdt
https://community.powerbi.com/


Navigating the Power BI Report Server web portal
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Web portal tasks

The Power BI Report Server web portal is an on-premises location for viewing, storing and managing your Power
BI, mobile, and paginated reports, and KPIs.

You can view the web portal in any modern browser. In the web portal, reports and KPIs are organized in folders,
and you can mark them as favorites. You can also store Excel workbooks there. From the web portal, you can
launch the tools you need to create reports:

Power BI reports created with Power BI Desktop: View them in the web portal and the Power BI mobile apps.
Paginated reports created in Report Builder: Modern-looking, fixed-layout documents optimized for printing.
KPIs created right in the web portal.

In the web portal you can browse the report server folders or search for specific reports. You can view a report, its
general properties and past copies of the report that are captured in report history. Depending on your
permissions, you might also be able to subscribe to reports for delivery to your e-mail inbox or a shared folder on
the file system.

You can use the web portal for a number of tasks, including these:

View, search, print, and subscribe to reports.
Create, secure, and maintain the folder hierarchy to organize items on the server.
Configure report execution properties, report history, and report parameters.
Create shared schedules and shared data sources to make schedules and data source connections more
manageable.
Create data-driven subscriptions to roll out reports to a large recipient list.
Create linked reports to reuse and re-purpose an existing report in different ways.
Download and open common tools such as Power BI Desktop (Report Server), Report Builder, and Mobile

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/report-server/getting-around.md


Web portal roles and permissions

Start the web portal

Create and edit Power BI Desktop reports (.pbix files)

Create a Power BI Desktop reportCreate a Power BI Desktop report

Report Publisher.
Create KPIs.
Send feedback or make feature requests.
Branding the web portal
Working with KPIs
Working with shared datasets

The web portal is a web application that runs in a browser. When you start the web portal, the pages, links, and
options you see vary based on the permissions you have on the report server. If you're assigned to a role with full
permissions, you have access to the complete set of application menus and pages for managing a report server. If
you're assigned to a role with permissions to view and run reports, you only see the menus and pages you need for
those activities. You can have different role assignments for different report servers, or even for the various reports
and folders on a single report server.

1. Open your web browser.

See this list of supported web browsers and versions.

2. In the address bar, type the web portal URL.

By default, the URL is http://[ComputerName]/reports.

The report server might be configured to use a specific port. For example,
http://[ComputerName]:80/reports or http://[ComputerName]:8080/reports

You see that the web portal groups items into these categories:

KPIs
Mobile reports
Paginated reports
Power BI Desktop reports
Excel workbooks
Datasets
Data sources
Resources

You can view, upload, create, organize, and manage permissions for Power BI Desktop reports in the web portal.

1. Select New > Power BI Report.

https://docs.microsoft.com/sql/reporting-services/working-with-kpis-in-reporting-services
https://docs.microsoft.com/sql/reporting-services/branding-the-web-portal
https://docs.microsoft.com/sql/reporting-services/working-with-kpis-in-reporting-services
https://docs.microsoft.com/sql/reporting-services/work-with-shared-datasets-web-portal


Edit an existing Power BI Desktop reportEdit an existing Power BI Desktop report

Create and edit paginated reports (.rdl files)

Create a paginated reportCreate a paginated report

2. Create your Power BI report. See Quickstart: Power BI reports for details.
3. Upload your report to the report server.

The Power BI Desktop app opens.

2. Make your changes and save... [how?]

1. Select the ellipsis (...) in the upper-right corner of the report tile > Edit in Power BI Desktop.

The Power BI Desktop app opens.

You can view, upload, create, organize, and manage permissions for paginated reports in the web portal.

1. Select New > Paginated Report.



Edit an existing paginated reportEdit an existing paginated report

Upload and organize Excel workbooks

Manage items in the web portal

2. Create your paginated report. See Quickstart: Paginated reports for details.
3. Upload your report to the report server.

The Report Builder app opens.

2. Make your changes and save.

1. Select the ellipsis (...) in the upper-right corner of the report tile > Edit in Report Builder.

The Report Builder app opens.

You can upload, organize, and manage permissions for Power BI Desktop reports and Excel workbooks. They will be
grouped together within the web portal.

The workbooks are stored within Power BI Report Server, similar to other resource files. Selecting one of the
workbooks downloads it locally to your desktop. You can save changes you’ve made by uploading it to the report
server again.

Power BI Report Server offers detailed control of the items you store on the web portal. For example, you can set up
subscriptions, caching, snapshots, and security on individual paginated reports.

1. Select the ellipsis (...) in the upper-right corner of an item, then select Manage.



  Tag your favorite reports and KPIs

3. Select Apply.

2. Choose the property or other feature you want to set.

Read more about working with subscriptions in the web portal.

You can tag the reports and KPIs that you want to be favorites. They're easier to find because they're all gathered in
a single Favorites folder, both in the web portal and in the Power BI mobile apps.

1. Select the ellipsis (…) in the upper-right corner of the KPI or report that you want to make a favorite, and
select Add to Favorites.

https://docs.microsoft.com/sql/reporting-services/working-with-subscriptions-web-portal


Hide or view items in the web portal

Hide an itemHide an item

2. Select Favorites on the web portal ribbon to see it along with your other favorites on the Favorites page in
the web portal.

Now in the Power BI mobile apps you see these favorites along with your favorite dashboards from the
Power BI service.

You can hide items in the web portal, and you can choose to view hidden items.

1. Select the ellipsis (...) in the upper-right corner of an item, then select Manage.



View hidden itemsView hidden items

3. Select Apply.

2. Select Hide this item.

1. Select Tiles (or List) in the upper-right corner > Show hidden items.

The items appear. They're grayed, but you can still open and edit them.



Search for items

Move or delete items in List view

Next steps

You can enter a search team, and you will see everything you can access. The results are categorized into KPIs,
reports, datasets, and other items. You can then interact with the results and add them to your favorites.

By default, the web portal displays its contents in Tile view.

You can switch to List view, where it's easy to move or delete multiple items at a time.

2. Select the items, then select Move or Delete.

1. Select Tiles > List.

User handbook
Quickstart: Paginated reports
Quickstart: Power BI reports

More questions? Try asking the Power BI Community

https://community.powerbi.com/


Quickstart: Create a Power BI report for Power BI
Report Server
12/19/2017 • 3 min to read • Edit Online

Step 1: Install Power BI Desktop optimized for Power BI Report
Server

You can store and manage Power BI reports on premises in the Power BI Report Server web portal, just as you
can store Power BI reports in the cloud in the Power BI service (https://powerbi.com). You create and edit
reports in Power BI Desktop, and publish them to the web portal. Then report readers in your organization can
view them in a browser or in a Power BI mobile app on a mobile device.

Here are four quick steps to get you started.

If you've already created Power BI reports in Power BI Desktop, then you're almost ready to create Power BI
reports for Power BI Report Server. We recommend installing the version of Power BI Desktop optimized for
Power BI Report Server so you know the server and the app are always in sync. You can have both versions of
Power BI Desktop on the same computer.

1. In the report server web portal, select the Download arrow > Power BI Desktop.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/report-server/quickstart-create-powerbi-report.md
https://powerbi.com


Or you can go directly to Microsoft Power BI Desktop (Optimized for Power BI Report Server - October
2017) in the Microsoft Download Center.

2. In the Download Center page, select Download.

3. Depending on your computer, select:

PBIDesktopRS.msi (the 32-bit version) or

PBIDesktopRS_x64.msi (the 64-bit version).

4. After you download the installer, run the Power BI Desktop (October 2017) Setup Wizard.

5. At the end of the installation, check Start Power BI Desktop now.

It starts automatically and you're ready to go. You can tell you have the right version because "Power BI
Desktop (October 2017)" is in the title bar.

6. If you're not familiar with Power BI Desktop, consider watching the videos on the welcome screen.

https://go.microsoft.com/fwlink/?linkid=861076


Step 2: Select a data source

Step 3: Design your report

You can connect to a variety of data sources. Read more about connecting to data sources.

1. From the welcome screen, select Get Data.

Or on the Home tab, select Get Data.

2. Select your data source -- in this example, Analysis Services.

3. Fill in Server, and optionally, Database. Make sure Connect live is selected > OK.

4. Choose the report server where you'll save your reports.

Here's the fun part: You get to create visuals that illustrate your data.

For example, you could create a funnel chart of customers and group values by yearly income.



Step 4: Save your report to the report server

1. In Visualizations, select Funnel chart.
2. Drag the field to be counted to the Values well. If it's not a numeric field, Power BI Desktop automatically

makes it a Count of the value.
3. Drag the field to group on to the Group well.

Read much more about designing a Power BI report.

When your report is ready, you save it to the Power BI Report Server you chose in Step 2.

1. On the File menu, select Save as > Power BI Report Server.

2. Now you can view it in the web portal.



Considerations and limitations

In a browserIn a browser

In the Power BI mobile appsIn the Power BI mobile apps

Reports in Power BI Report Server and in the Power BI service (http://powerbi.com) act almost exactly the
same, but a few features are different.

Power BI Report Server reports support all visualizations, including:

Custom visuals

Power BI Report Server reports don’t support:

R visuals
ArcGIS maps
Breadcrumbs
Power BI Desktop preview features

Power BI Report Server reports support all the basic functionality in the Power BI mobile apps, including:

Phone report layout: You can optimize a report for the Power BI mobile apps. On your mobile phone,

optimized reports have a special icon, , and layout.

http://powerbi.com


Next steps
Power BI DesktopPower BI Desktop

Power BI Report ServerPower BI Report Server

Power BI Report Server reports don’t support these features in the Power BI mobile apps:

R visuals
ArcGIS maps
Custom visuals
Breadcrumbs
Geofiltering or bar codes

There are so many great resources for creating reports in Power BI Desktop. These links are a good starting
point.

Get started with Power BI Desktop
Guided learning: Getting started with Power BI Desktop

Install Power BI Desktop optimized for Power BI Report Server
Power BI Report Server user handbook

More questions? Try asking the Power BI Community

file:///W:/soyp-o-7bf22bb1/powerbi-docs/.tmp/guided-learning/gettingdata.yml#step-2
https://community.powerbi.com/


Quickstart: Create a paginated report for Power BI
Report Server
11/9/2017 • 3 min to read • Edit Online

Step 1: Install and start Report Builder

As the name suggests, paginated reports can run to many pages. They're laid out in a fixed format and offer
precise customization. Paginated reports are .rdl files.

You can store and manage paginated reports in the Power BI Report Server web portal, just as you can in the SQL
Server Reporting Services (SSRS) web portal. You create and edit them in Report Builder or Report Designer in
SQL Server Data Tools (SSDT), then publish them to either web portal. Then report readers in your organization
can view them in a browser or in a Power BI mobile app on their mobile device.

If you've already created paginated reports in Report Builder or Report Designer, then you're ready to create
paginated reports for Power BI Report Server. If not, here are some quick steps to get you started.

You may already have installed Report Builder to create reports for an SSRS server. You can use the same version
or Report Builder to create reports for Power BI Report Server. If you haven't installed it, the process is easy.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/report-server/quickstart-create-paginated-report.md


Step 2: Go through the Chart wizard

1. In the Power BI Report Server web portal, select New > Paginated Report.

If you don't have Report Builder installed already, it leads you through the installation process now.

2. After it's installed, Report Builder opens to the New Report or Dataset screen.

3. Select the wizard for the kind of report you want to create:

Table or matrix
Chart
Map
Blank

4. Let's start with the Chart wizard.

The Chart wizard walks you the steps of creating a basic chart in a report. From there, you can customize
your report in almost unlimited ways.

The Chart wizard walks you through the basic steps of creating a visualization in a report.

Paginated reports can connect to a wide variety of data sources, from Microsoft SQL Server and Microsoft Azure
SQL Database to Oracle, Hyperion, and many more. Read about data sources supported by paginated reports.

In the first page in the Chart wizard, Choose a dataset, you can create a dataset or choose a shared dataset on a
server. Datasets return report data from a query on an external data source.

1. Select Browse > select a shared dataset on a server > Open > Next.



Need to create a dataset? See Create a shared or embedded dataset.

2. Choose a chart type -- in this case, a bar chart.

3. Arrange the fields by dragging them to the Categories, Series, and Values boxes.

https://docs.microsoft.com/sql/reporting-services/report-data/create-a-shared-dataset-or-embedded-dataset-report-builder-and-ssrs


Step 3: Design your report

4. Select Next > Finish.

Now you're in Report Design view. Notice the data is placeholder data, not your data.

To view your data, select Run.



Step 4: Save your report to the report server

To go back to Design view, select Design.

You can modify the chart you just created, changing the layout, values, legend... really just about anything.

And you can add all sorts of other visualizations: gauges, tables, matrixes, tables, maps, and more. You can add
headers and footers for multiple pages. See the Report Builder tutorials to try them for yourself.

When your report is ready, save it to Power BI Report Server.

1. On the File menu, select Save as, and save it to the report server.

https://docs.microsoft.com/sql/reporting-services/report-builder-tutorials


Next steps

2. Now you can view it in the browser.

There are many great resources for designing reports in Report Builder and in Report Designer in SQL Server Data
Tools. The Report Builder tutorials are a good place to start.

Report Builder tutorials
Power BI Report Server user handbook

More questions? Try asking the Power BI Community

https://docs.microsoft.com/sql/reporting-services/report-builder-tutorials
https://community.powerbi.com/


Power BI report scheduled refresh in Power BI Report
Server
1/30/2018 • 3 min to read • Edit Online

How this works

Analysis ServicesAnalysis Services

Scheduled refresh for Power BI reports allows the data for a report to stay up to date.

Scheduled refresh is specific to Power BI reports with an embedded model. Meaning you imported data into the
report instead of using a live connection or DirectQuery. When importing your data, it is disconnected from the
original data source and needs to be updated to keep data fresh. Scheduled refresh is the way to keep your data up
to date.

Scheduled refresh is configured within the management section of a report. For more information on how to
configure scheduled refresh, see How to configure Power BI report scheduled refresh.

Several components are involved when using scheduled refresh for your Power BI reports.

SQL Server Agent as a timer to generate scheduled events.
Scheduled jobs are added to a queue of events and notifications in the report server database. In a scale-out
deployment, the queue is shared across all of the report servers in the deployment.
All report processing that occurs as a result of a schedule event is performed as a background process.
The data model is loaded within an Analysis Services instance.
For some data sources, the Power Query mashup engine is used to connect to data sources and transform the
data. Other data sources may be connected to directly from an Analysis Services service used to host the data
models for Power BI Report Server.
New data is loaded into the data model within Analysis Services.
Analysis Services processes the data and executes any needed calculations.

Power BI Report Server maintains an event queue for all scheduled operations. It polls the queue at regular
intervals to check for new events. By default, the queue is scanned at 10 second intervals. You can change the
interval by modifying the PollingInterval, IsNotificationService, and IsEventService configuration settings in
the RSReportServer.config file. IsDataModelRefreshService can also be used to set whether a report server
process scheduled events.

Rendering a Power BI report, as well as performing a scheduled refresh, requires loading the Power BI report's data

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/report-server/scheduled-refresh.md


Considerations and limitations
When scheduled refresh can't be usedWhen scheduled refresh can't be used

Memory limitsMemory limits

Authentication and KerberosAuthentication and Kerberos

Next steps

model in Analysis Services. An Analysis Services process will be running with Power BI Report Server.

Not all Power BI Reports can have a scheduled refresh plan created on them. The following is a list of Power BI
Reports that you Can't create a scheduled refresh plan.

Your report contains one or more Analysis Services data sources, which use a live connection.
Your report contains one or more data sources, which use DirectQuery.
Your report does not contain any data source. For example, data is manually entered via Enter Data or a report
contains only static content like images, text, etc.

In addition to the above list, there are specific scenarios with data sources in import mode, for which you cannot
created refresh plans.

If a File or Folder data source is used and the file path is a local path (e.g. C:\Users\user\Documents), then a
refresh plan cannot be created. The path must be a path the report server can connect to like a network share.
For example, \myshare\Documents.
If data source can be connected using only OAuth (e.g. Facebook, Google Analytics, Salesforce, etc.), then cache
refresh plan cannot be created. At the moment, RS does not support OAuth authentication for any data source
whether it is for paginated, mobile or Power BI reports.

Traditional workload for a report server has been similar to a web application. The ability to load reports with
imported data or DirectQuery, and the ability to perform scheduled refresh, rely on an Analysis Services instance
being hosted alongside of the report server. As a result, this could result is unexpected memory pressure on the
server. Plan your server deployment accordingly knowning that Analysis Services may be consuming memory
alongside the report server.

For information on how to monitor an Analysis Services instance, see Monitor an Analysis Services Instance.

For information about memory settings within Analysis Services, see Memory Properties.

If your data source is set to use Windows credentials, Kerberos constrained delegation may need to be configured
in order to work. For more information, see Configure Windows authentication on the report server.

Configure scheduled refresh on a Power BI report.

More questions? Try asking the Power BI Community

https://docs.microsoft.com/sql/analysis-services/instances/monitor-an-analysis-services-instance
https://docs.microsoft.com/sql/analysis-services/server-properties/memory-properties
https://docs.microsoft.com/sql/reporting-services/security/configure-windows-authentication-on-the-report-server
https://community.powerbi.com/


Power BI report data sources in Power BI Report
Server
1/30/2018 • 2 min to read • Edit Online

IMPORTANTIMPORTANT

List of supported data sources

DATA SOURCE CACHED DATA SCHEDULED REFRESH LIVE/DIRECTQUERY

SQL Server Database Yes Yes Yes

SQL Server Analysis Services Yes Yes Yes

Azure SQL Database Yes Yes Yes

Azure SQL Data Warehouse Yes Yes Yes

Excel Yes Yes No

Access Database Yes Yes No

Active Directory Yes Yes No

Amazon Redshift Yes No No

Azure Blob Storage Yes Yes No

Azure Data Lake Store Yes No No

Azure HDInsight (HDFS) Yes Yes No

Azure HDInsight (Spark) Yes Yes No

Azure Table Storage Yes Yes No

Dynamics 365 (online) Yes No No

Power BI reports can connect to different data sources. Depending on how data is used, different data sources are
available. Data can be imported or data can be queried directly using DirectQuery or a live connection to SQL
Server Analysis Services.

These data sources are specific to Power BI reports used within Power BI Report Server. For information about data
sources supported with paginated reports, see Data Sources Supported by Reporting Services.

All data sources in a Power BI Desktop report must be supported to configure scheduled refresh.

Other data sources may work even though they aren't on the supported list.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/report-server/data-sources.md
https://docs.microsoft.com/sql/reporting-services/report-data/data-sources-supported-by-reporting-services-ssrs


Facebook Yes No No

Folder Yes Yes No

Google Analytics Yes No No

Hadoop File (HDFS) Yes No No

IBM DB2 Database Yes Yes No

Impala Yes No No

JSON Yes Yes No

Microsoft Exchange Yes No No

Microsoft Exchange Online Yes No No

MySQL Database Yes Yes No

OData Feed Yes Yes No

ODBC Yes Yes No

OLE DB Yes Yes No

Oracle Database Yes Yes Yes

PostgreSQL Database Yes Yes No

Power BI service No No No

R Script Yes No No

Salesforce Objects Yes No No

Salesforce Reports Yes No No

SAP Business Warehouse
server

Yes Yes Yes

SAP HANA Database Yes Yes Yes

SharePoint Folder (on-
premises)

Yes Yes No

SharePoint List (on-
premises)

Yes Yes No

SharePoint Online List Yes No No

DATA SOURCE CACHED DATA SCHEDULED REFRESH LIVE/DIRECTQUERY



Snowflake Yes No No

Sybase Database Yes Yes No

Teradata Database Yes Yes Yes

Text/CSV Yes Yes No

Web Yes Yes No

XML Yes Yes No

appFigures (Beta) Yes No No

Azure Analysis Services
database (Beta)

Yes No No

Azure Cosmos DB (Beta) Yes No No

Azure HDInsight Spark
(Beta)

Yes No No

Common Data Service (Beta) Yes No No

comScore Digital Analytix
(Beta)

Yes No No

Dynamics 365 for Customer
Insights (Beta)

Yes No No

Dynamics 365 for Financials
(Beta)

Yes No No

GitHub (Beta) Yes No No

Google BigQuery (Beta) Yes No No

IBM Informix database (Beta) Yes No No

IBM Netezza (Beta) Yes No No

Kusto (Beta) Yes No No

MailChimp (Beta) Yes No No

Microsoft Azure
Consumption Insights (Beta)

Yes No No

Mixpanel (Beta) Yes No No

Planview Enterprise (Beta) Yes No No

DATA SOURCE CACHED DATA SCHEDULED REFRESH LIVE/DIRECTQUERY



Projectplace (Beta) Yes No No

QuickBooks Online (Beta) Yes No No

Smartsheet Yes No No

Spark (Beta) Yes No No

SparkPost (Beta) Yes No No

SQL Sentry (Beta) Yes No No

Stripe (Beta) Yes No No

SweetIQ (Beta) Yes No No

Troux (Beta) Yes No No

Twilio (Beta) Yes No No

tyGraph (Beta) Yes No No

Vertica (Beta) Yes No No

Visual Studio Team Services
(Beta)

Yes No No

Webtrends (Beta) Yes No No

Zendesk (Beta) Yes No No

DATA SOURCE CACHED DATA SCHEDULED REFRESH LIVE/DIRECTQUERY

IMPORTANTIMPORTANT

Next steps

Row-level security configured at the data source should work for certain DirectQuery (SQL Server, Azure SQL Database,
Oracle and Teradata) and live connections assuming Kerberos is configured properly in your environment.

Now that your data source is picked out, create a report using data from that data source.

More questions? Try asking the Power BI Community

https://community.powerbi.com/


Connecting to data sources
1/30/2018 • 1 min to read • Edit Online

Power BI Reports

Other reports

Next steps

Learn about what data sources you can connect to within Power BI Report Server.

Power BI reports can work with data that is imported or using an Analysis Services live connection along with
DirectQuery. The October 2017 release includes support for connections other than Analyssi Services live
connections. This includes imported data. You can download the October 2017 release over at powerbi.com.

For information about what data soruces are supported, see Power BI report data sources in Power BI Report
Server.

Other report types support the same data sources that are present in SQL Server Reporting Services. For more
information, see Data sources supported by Reporting Services.

User handbook
Quickstart: Paginated reports
Quickstart: Power BI reports

More questions? Try asking the Power BI Community

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/report-server/connect-data-sources.md
https://powerbi.microsoft.com/report-server/
https://docs.microsoft.com/sql/reporting-services/report-data/data-sources-supported-by-reporting-services-ssrs
https://community.powerbi.com/


Accessing shared datasets as OData feeds in Power BI
Report Server
1/30/2018 • 1 min to read • Edit Online

You can access shared datasets from Power BI Desktop with an OData feed.

1. With the OData feed URL, you connect to the OData source.

2. After you bring the data into Power BI Desktop, you can modify it in the Query Editor.

3. Now you can use the data in designing reports.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/report-server/access-dataset-odata.md


Be sure to use Advanced Options so you can turn on Open Type Columns and format the columns accordingly in
Power Query to meet your needs.

Read more about connecting to OData feeds in Power BI Desktop.

More questions? Try asking the Power BI Community

https://community.powerbi.com/


How to configure Power BI report scheduled refresh
1/30/2018 • 2 min to read • Edit Online

Configure data source credentials

To refresh data in your Power BI report, a scheduled refresh plan must be created. This is done within the Manage
area of a Power BI report.

Prior to creating a schedule data refresh plan, you need to set the credentials for each data source used in your
Power BI report.

2. In the left menu, select the Data sources tab.

1. In the web portal, right-click on the Power BI report and select Manage.

3. For each data source that appears, choose the type of authentication to use when connecting to that data
source. Enter the appropriate credentials.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/report-server/configure-scheduled-refresh.md


Creating a Schedule Refresh Plan
Follow these steps to create a scheduled refresh plan.

2. In the left menu, select the Scheduled refresh tab.

1. In the web portal, right-click on the Power BI report and select Manage.

3. On the Scheduled refresh page, select New scheduled refresh plan.



Modifying a Schedule Refresh Plan

4. On the New Scheduled Refresh Plan page, enter a description and set a schedule for when you want your
data model to be refreshed.

5. Select Create scheduled refresh plan when done.

Modifying a scheduled refresh plan is similar to creating one.

1. In the web portal, right-click on the Power BI report and select Manage.



2. In the left menu, select the Scheduled refresh tab.

4. On the Edit Scheduled Refresh Plan page, enter a description and set a schedule for when you want your
data model to be refreshed.

3. On the Scheduled refresh page, select Edit beside the refresh plan you want to manage.

5. Select Apply when done.



Viewing the status of Schedule Refresh Plan

Next steps

View the status of a schedule refresh plan in the web portal.

2. In the left menu, select the Scheduled refresh tab.

STATUS DESCRIPTION

New Scheduled Refresh Plan The plan has been created but has not ran.

Refreshing The refresh process has started.

Streaming model to Analysis Server Copying the model from the report server catalog
database to the hosted Analysis Services instance.

Refreshing data Refreshing the data within the model.

Removing credentials from the model Removed the credentials used to connect to the data
source from the model.

Saving model to the catalog Refreshing of data is complete and the refreshed model is
being saved back to the report server catalog database.

Completed: Data Refresh Refresh is done.

Error: An error occurred during refresh and is displayed.

1. In the web portal, right-click on the Power BI report and select Manage.

3. On the Scheduled refresh page, the right most column displays the status of a plan.

The web page must be refreshed to see the current status. The status will not change automatically.

To learn more about creating and modifying schedules, see Create, modify, and delete schedules.

https://docs.microsoft.com/sql/reporting-services/subscriptions/create-modify-and-delete-schedules


For information on how to troubleshoot scheduled refresh, see Troubleshoot scheduled refresh in Power BI Report
Server.

More questions? Try asking the Power BI Community

https://community.powerbi.com/


Add comments to a report in a report server
11/9/2017 • 1 min to read • Edit Online

Add or view comments

You can add comments to reports, including Power BI reports, within the web portal of a report server. The
comments live with the report, and anyone with the right permissions can see the comments for the report. See the
Permssions section below for details.

1. Open a paginated or Power BI report on a report server.
2. In the upper-right corner, select Comments.

In the Comments pane, you can see any existing comments.

3. Write your comment, then select Post Comment.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/report-server/add-comments.md


 Permissions

Next steps

TIPTIP

Your comment shows in the pane on the web portal, along with any previous comments. They don't appear
with the report on in the Power BI mobile apps.

Did you know? You can annotate Power BI reports in the Power BI mobile apps and share the annotated reports with
others.

Depending on your permissions, you can:

Not see comments.
See all comments, and post, edit, and delete your own.
See all comments; post, edit, and delete your own; and delete other people’s.

Power BI Report Server user handbook

More questions? Try asking the Power BI Community

https://community.powerbi.com/


Quickstart: Embed a Power BI report using an iFrame
and URL parameters
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URL parameter

http://myserver/reports/powerbi/Sales?rs:embed=true

iFrame

<iframe width="800" height="600" src="http://myserver/reports/powerbi/Sales?rs:embed=true" frameborder="0" 
allowFullScreen="true"></iframe>

URL filter

Example: Filter on a fieldExample: Filter on a field

https://report-server/reports/power-bi/Retail-Analysis-Sample

You can embed any report by using an iFrame in your application.

For any URL to a report, you can add a querystring parameter of ?rs:Embed=true .

For example:

This will work on all report types within Power BI Report Server.

Once you have your URL, you can create an iFrame within a web page, to host the report.

For example:

You can add a query string parameter to the URL to filter the data that's returned in the Power BI report.

The syntax is straightforward; start with the report URL, add a question mark, then this filter syntax.

URL?filter=Table/Field eq 'value'

Keep these considerations in mind:

Table and Field names are case sensitive; value isn't.
You can filter a report with fields that are hidden from report view.
Value has to be enclosed with single quotes.
Field type has to be string.
Table and field names can't have spaces.

Take for example the Retail Analysis sample. Say this is the URL to the report on the report server in a folder called
"power-bi":

You see the map visualization in the Retail Analysis sample shows stores in North Carolina and other states.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/report-server/quickstart-embed.md


NC is the value for North Carolina stored in the Territory field of the Store table. So to filter the report to show
data only for stores in North Carolina, append the following to the URL:

?filter=Store/Territory eq 'NC'

Now the report is filtered for North Carolina; all the visualizations on the report page show data for only North
Carolina.



Create a DAX formula to filter on multiple valuesCreate a DAX formula to filter on multiple values

https://report-server/reports/power-bi/Retail-Analysis-Sample?filter=Store/TerritoryChain eq 'NC-Lindseys'

Next steps

Another way to filter on multiple fields is by creating a calculated column in Power BI Desktop that concatenates
two fields to a single value. Then you can filter on that value.

For example, the Retail Analysis sample has two fields: Territory and Chain. In Power BI Desktop, you can create a
calculated column (Field) called TerritoryChain. Remember that the Field name can't have any spaces. Here is the
DAX formula for that column.

TerritoryChain = [Territory] & "-" & [Chain]

Publish the report to the Power BI Report Server, then use the URL query string to filter to display data for only
Lindseys stores in NC.

Quickstart: Create a Power BI report for Power BI Report Server
Quickstart: Create a paginated report for Power BI Report Server

More questions? Try asking the Power BI Community

https://community.powerbi.com/


Troubleshoot scheduled refresh in Power BI Report
Server
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Common issues

Driver related problemsDriver related problems

Memory pressureMemory pressure

Kerberos configurationKerberos configuration

Known issues

Configuration settings

This article discusses resources available to troubleshoot issues with scheduled refresh in Power BI Report Server.

As issues come up, this article will be updated with information to help you.

The following are the more common issues you will hit when trying to schedule refresh for a report.

Connecting to different data sources may require 3rd party drivers that need to be installed in order to connect
successfuly. Not only would you need to install them on the machine you are using Power BI Desktop on, but you
will also need to make sure the driver is installed on the report server.

The driver may also come in both 32bit and 64bit. Make sure to install the 64bit driver as Power BI Report Server is
64bit.

Please refer to the manufacturer for details on how to install and configure 3rd party drivers.

Memory pressure can occur when reports require more memory to process and render. Schedule refresh on
reports may demand a significant amount of memory on the machine. Especially for larger reports. Memory
pressure can result in report failures as well as a potential crash of the report server itself.

If you are encountering memory pressure consistently, it may be worth looking at a scaled out deployment of the
report server in order to spread the load of resources. You can also define that a given report server is used for
data refresh with the IsDataModelRefreshService  setting within rsreportserver.config. With this setting, you could
define one or more servers to be the front end server to handle on demand reports, and have another set of
servers to only be used for scheduled refresh.

For information on how to monitor an Analysis Services instance, see Monitor an Analysis Services Instance.

For information about memory settings within Analysis Services, see Memory Properties.

Connecting to a data source with windows credentials may require configuring Kerberos constrained delegation to
make a successful connection. For more information about how to configure Kerberos constrained delegation, see
Configure Kerberos to use Power BI reports.

Information about known issues will be listed here when they become available.

The following settings can be used to affect scheduled refresh. Settings set within SQL Server Management Studio
(SSMS) apply to all report servers within a scale-out deployment. Settings configured within rsreportserver.config
are for the specific server they are set on.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/report-server/scheduled-refresh-troubleshoot.md
https://docs.microsoft.com/sql/analysis-services/instances/monitor-an-analysis-services-instance
https://docs.microsoft.com/sql/analysis-services/server-properties/memory-properties


SETTING DESCRIPTION

EnablePowerBIReportEmbeddedModels Enables or disables the ability to use imported data within
your reports. Valid values are True or False.

MaxFileSizeMb Maximum file size for uploaded reports. Default is 1000 MB (1
GB). Maximum value is 2000 MB (2 GB).

ModelCleanupCycleMinutes Defines how often the model is checked to evict it from
memory. Default is 15 minutes.

ModelExpirationMinutes Defines how long until the model expires based on the last
time used and is evicted. Default is 60 minutes.

ScheduleRefreshTimeoutMinutes Defines how long the data refresh can take for a mode.
Default is 120 minutes. There is no upper limit.

<Configuration>
    <Service>
        <PollingInterval>10</PollingInterval>
        <IsDataModelRefreshService>false</IsDataModelRefreshService>
        <MaxQueueThreads>0</MaxQueueThreads>
    </Service>
</Configuration>

Tools for troubleshooting
Logs relevant for scheduled refresh of Power BI reportsLogs relevant for scheduled refresh of Power BI reports

C:\Program Files\Microsoft Power BI Report Server\PBIRS\LogFiles\RSPowerBI_*.log

2017-10-20 02:00:09.5188|ERROR|744|Error Processing Data Model Refresh: SessionId: e960c25e-ddd4-4763-aa78-
0e5dceb53472, Status: Error Model can not be refreshed because not all the data sources are embedded, 
Exception Microsoft.PowerBI.ReportServer.AsServer.InvalidDataSourceException: Model can not be refreshed 
because not all the data sources are embedde
   at 
Microsoft.PowerBI.ReportServer.WebHost.EventHandler.AnalysisServicesDataRefresh.CanModelRefresh(IEnumerable`1 
dataSources)
   at Microsoft.PowerBI.ReportServer.WebHost.EventHandler.DataRefreshScope.<>c__DisplayClass7.
<ExecuteActionWithLogging>b__5()
   at Microsoft.PowerBI.ReportServer.WebHost.EventHandler.DataRefreshScope.
<ExecuteFuncWithLogging>d__1`1.MoveNext()

Settings within SSMS:

Settings within rsreportserver.config:

The log files which hold information about scheduled refresh are the RSPowerBI_ logs. They are located in the
LogFiles folder of your report server installation location.

Error condition

Successful refresh



2017-10-25 15:23:41.9370|INFO|6|Handling event with data: TimeEntered: 10/25/2017 8:23:41 PM, Type: Event, 
SessionId: 46d398db-0b1f-49d8-b7bd-c5461c07ec7a, EventType: DataModelRefresh
2017-10-25 15:23:41.9370|INFO|6|Processing Data Model Refresh: SessionId: 46d398db-0b1f-49d8-b7bd-
c5461c07ec7a, Status: Starting Data Refresh.
2017-10-25 15:23:41.9370|INFO|6|Processing Data Model Refresh: SessionId: 46d398db-0b1f-49d8-b7bd-
c5461c07ec7a, Status: Starting Retrieving PBIX AsDatabaseInfo.
2017-10-25 15:23:42.7134|INFO|6|Processing Data Model Refresh: SessionId: 46d398db-0b1f-49d8-b7bd-
c5461c07ec7a, Status: Starting Verifying all the data sources are embedded.
2017-10-25 15:23:42.7134|INFO|6|Processing Data Model Refresh: SessionId: 46d398db-0b1f-49d8-b7bd-
c5461c07ec7a, Status: Starting Verifying connection strings are valid.
2017-10-25 15:23:42.7134|INFO|6|Processing Data Model Refresh: SessionId: 46d398db-0b1f-49d8-b7bd-
c5461c07ec7a, Status: Starting Streaming model to Analysis Server.
2017-10-25 15:23:42.7603|INFO|6|Processing Data Model Refresh: SessionId: 46d398db-0b1f-49d8-b7bd-
c5461c07ec7a, Status: Starting Refreshing the model.
2017-10-25 15:23:51.5258|INFO|6|Processing Data Model Refresh: SessionId: 46d398db-0b1f-49d8-b7bd-
c5461c07ec7a, Status: Starting Removing credentials from the model.
2017-10-25 15:23:51.6508|INFO|6|Processing Data Model Refresh: SessionId: 46d398db-0b1f-49d8-b7bd-
c5461c07ec7a, Status: Starting Saving model to the catalog.

2017-10-20 08:22:01.5595|INFO|302|Processing Data Model Refresh: SessionId: 22cd9ec3-b21a-4eb1-81ae-
15fac8d379ea, Status: Starting Refreshing the model.
2017-10-20 08:22:02.3758|ERROR|302|Error Processing Data Model Refresh: SessionId: 22cd9ec3-b21a-4eb1-81ae-
15fac8d379ea, Status: Error Failed to refresh the model, Exception 
Microsoft.AnalysisServices.OperationException: Failed to save modifications to the server. Error returned: 
'The credentials provided for the SQL source are invalid. (Source at rosecatalog;reportserver.). The exception 
was raised by the IDbCommand interface.
'.
   at Microsoft.AnalysisServices.Tabular.Model.SaveChanges(SaveOptions saveOptions)
   at Microsoft.PowerBI.ReportServer.AsServer.TOMWrapper.RefreshModel(Database database)
   at Microsoft.PowerBI.ReportServer.AsServer.AnalysisServicesServer.RefreshDatabase(String databaseName, 
IEnumerable`1 dataSources)
   at 
Microsoft.PowerBI.ReportServer.WebHost.EventHandler.AnalysisServicesDataRefresh.RefreshDatabase(AsDatabaseInfo 
asDatabaseInfo)
   at Microsoft.PowerBI.ReportServer.WebHost.EventHandler.DataRefreshScope.<>c__DisplayClass7.
<ExecuteActionWithLogging>b__5()
   at Microsoft.PowerBI.ReportServer.WebHost.EventHandler.DataRefreshScope.
<ExecuteFuncWithLogging>d__1`1.MoveNext()
2017-10-20 08:22:02.4588|ERROR|302|Error Processing Data Model Refresh: SessionId: 22cd9ec3-b21a-4eb1-81ae-
15fac8d379ea, Status: Error Failed Data Refresh, Exception Microsoft.AnalysisServices.OperationException: 
Failed to save modifications to the server. Error returned: 'The credentials provided for the SQL source are 
invalid. (Source at rosecatalog;reportserver.). The exception was raised by the IDbCommand interface.
'.
   at Microsoft.PowerBI.ReportServer.WebHost.EventHandler.DataRefreshScope.ExecuteActionWithLogging(Action 
methodToExecute, String description, String localizedDescription, String messageInFailure, RefreshInfo 
refreshInfo, DataAccessors dataAccessors, ReportEventType operation, Int64 size, Boolean isDataRetrieval, 
Boolean showInExecutionLog)
   at Microsoft.PowerBI.ReportServer.WebHost.EventHandler.AnalysisServicesDataRefresh.RefreshData(RefreshInfo 
refreshInfo)
   at Microsoft.PowerBI.ReportServer.WebHost.EventHandler.DataRefreshScope.<>c__DisplayClass7.
<ExecuteActionWithLogging>b__5()
   at Microsoft.PowerBI.ReportServer.WebHost.EventHandler.DataRefreshScope.
<ExecuteFuncWithLogging>d__1`1.MoveNext()

Enabling Verbose LoggingEnabling Verbose Logging

Incorrect Credentials

Enabling verbose logging, in Power BI Report Server, is the same as it is for SQL Server Reporting Services.

1. Open <install directory>\PBIRS\ReportServer\bin\ReportingServicesService.exe.config .
2. Under <system.diagnostics> , change DefaultTraceSwitch to 4.
3. Under <RStrace> , change Components to all:4.



ExecutionLogExecutionLog

Analysis Services

IMPORTANTIMPORTANT

Install locationInstall location

Configuring Analysis Services settings (msmdsrv.ini)Configuring Analysis Services settings (msmdsrv.ini)

Whenever a Power BI report is rendered, or a schedule refresh plan is executed, new entries are added to the
Execution Log in the database. These entries are available in the ExecutionLog3 view within the report server
catalog database.

Execution log entries for Power BI reports differ from entries for other report types.

TimeRendering columns is always 0. Rendering of Power BI reports happens in the browser, not in the server.
There are 2 Request Types and subsequent item actions:

Interactive: whenever a report is being viewed.

Refresh Cache: whenever a schedule refresh plan has been executed.

ASModelStream: when the data model is streamed to Analysis Services from the catalog.
ConceptualSchema: when user clicks on viewing the report.
QueryData: whenever data is being requested from client.

ASModelStream: whenever the data model is streamed to Analysis Services from the catalog.
DataRefresh: whenever data is being refreshed from one or more data sources.
SaveToCatalog: whenever the data model is being saved back to the catalog.

There may be times you want to modify Analysis Services for diagnositing issues, or adjust memory limits.

These settings will be reset any time you upgrade the report server. Be sure to keep a copy of your changes and reapply
them if needed.

The default location for Power BI Report Server, and Analysis Services is the following.

C:\Program Files\Microsoft Power BI Report Server\PBIRS\ASEngine

In the <install directory>\PBIRS\ASEngine  directory, you will find the msmdsrv.ini file, which you can use to control
different settings of Analysis Services. When you open this file, you will immediately realize that this file doesn't
have all the settings you would expect in the msmdsrv.ini file.

This is because the actual Analysis Services process that is run by Power BI Report Server is launched in 
<install directory>\PBIRS\ASEngine\workspaces . In that folder, you will see the full msmdsrv.ini file you are used to.

It is important not to modify the file within the workspaces folder as it is rewritten whenever the Analysis Services
process launches. If you want to control a setting, please do this by modifying msmdsrv.ini in the 
<install directory>\PBIRS\ASEngine  directory.

The following settings are reset when ever the Analysis Services process is launched. Any changes you make to
these will be ignored.

ConfigurationSettings\PrivateProcess
ConfigurationSettings\DataDir
ConfigurationSettings\LogDir
ConfigurationSettings\TempDir
ConfigurationSettings\BackupDir
ConfigurationSettings\AllowedBrowsingFolders
ConfigurationSettings\CrashReportsFolder



Profiling the local Analysis Services processProfiling the local Analysis Services process

Lock Pages In Memory Windows privilege

ConfigurationSettings\ExtensionDir
ConfigurationSettings\Port
ConfigurationSettings\DeploymentMode
ConfigurationSettings\ServerLocation
ConfigurationSettings\TMCompatabilitySKU
ConfigurationSettings\FlightRecorder\TraceDefinitionFile

A SQL Profiler trace can be run on the local Analysis Services process for diagnostic purposes. To connect to the
local Analysis Services instance, do the following.

SQL Server Profiler Trace is included with the SQL Server Management Studio (SSMS) download.

1. Start SQL Server Profiler as an administrator.
2. Select the New Trace button.
3. In the Connect to server dialog, select Analysis Services and enter localhost:5132 for the server name.
4. In the Trace properties dialog, select the events you want to capture and select Run.

If you find that you are unable to render a Power BI report, assigning the Lock pages in memory privilege to the
services account running Power BI Report server may help. For more information about how to configure Lock
pages in memory, see Windows privileges assigned to the Analysis Services service account.

More questions? Try asking the Power BI Community

https://docs.microsoft.com/sql/ssms/download-sql-server-management-studio-ssms
https://docs.microsoft.com/sql/analysis-services/instances/configure-service-accounts-analysis-services#bkmk_winpriv
https://community.powerbi.com/
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Installing and migration

InstallingInstalling

MigrationMigration

Welcome to the administrator handbook for Power BI Report Server, an on-premises location for storing and
managing your Power BI, mobile, and paginated reports.

This handbook will help you understand concepts on planning, deploying and managing your Power BI Report
Server.

You will need to install Power BI Report Server to start using it. We have information that will allow you to
handle this task.

Before you start to install, upgrade or migrate to Power BI Report Server, take a look at the system requirements
for the report server.

If you are deploying a new Power BI Report Server, you use the following documents to help you. A quickstart is
available to jump right in. Or, you can look at the install document for full details.

Quickstart: Install Power BI Report Server
Install Power BI Report Server

There is no in place upgrade for SQL Server Reporting Services. If you have an existing SQL Server Reporting
Services instance that you want to make a Power BI Report Server, you will need to migrate it. There are other
reasons that you may want to perform a migration as well. Review the migration document for more details.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/report-server/admin-handbook-overview.md


Configuring your report server

Security

Next steps

Migrate a report server installation

You have many options when configuing your report server. Will you use SSL? Are you configuring an email
server? Do you want to intergrate with the Power BI service to pin visualizations?

The majority of your configuration will occur within the Report Server Configuration Manager. Check out the
configuration manager documentation for more details.

Security and protection are important to every organization. You can learn about authentication, authorization,
roles and permissions over in the security documentation.

Quickstart: Install Power BI Report Server
How to find your report server product key
Install Power BI Desktop optimized for Power BI Report Server
Install Report Builder
Download SQL Server Data Tools (SSDT)

More questions? Try asking the Power BI Community

https://docs.microsoft.com/sql/reporting-services/install-windows/reporting-services-configuration-manager-native-mode
https://docs.microsoft.com/sql/reporting-services/security/reporting-services-security-and-protection
https://docs.microsoft.com/sql/reporting-services/install-windows/install-report-builder
http://go.microsoft.com/fwlink/?LinkID=616714
https://community.powerbi.com/


Hardware and software requirements for installing
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Processor, Memory, and Operating System Requirements
COMPONENT REQUIREMENT

.NET Framework 4.6

You can manually install the .NET Framework from Microsoft
.NET Framework 4.6 (Web Installer) for Windows.

For more information, recommendations, and guidance about
the .NET Framework 4.6 see .NET Framework Deployment
Guide for Developers.

Windows 8.1, and Windows Server 2012 R2 require
KB2919355 before installing .NET Framework 4.6.

Hard Disk Power BI Report Server requires a minimum of 1 GB of
available hard-disk space.

Addition space will be required on the database server that is
hosting the report server database.

Memory Minimum: 1 GB

Recommended: At least 4 GB

Processor speed Minimum: x64 Processor: 1.4 GHz

Recommended: 2.0 GHz or faster

Processor type x64 Processor: AMD Opteron, AMD Athlon 64, Intel Xeon
with Intel EM64T support, Intel Pentium IV with EM64T
support

Here you will find the minimum hardware and software requirements to install and run Power BI Report Server.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/report-server/system-requirements.md
http://support.microsoft.com/kb/3045560
http://msdn.microsoft.com/library/ee942965(v=vs.110).aspx
http://support.microsoft.com/kb/2919355


Operating system Windows Server 2016 Datacenter

Windows Server 2016 Standard

Windows Server 2012 R2 Datacenter

Windows Server 2012 R2 Standard

Windows Server 2012 R2 Essentials

Windows Server 2012 R2 Foundation

Windows Server 2012 Datacenter

Windows Server 2012 Standard

Windows Server 2012 Essentials

Windows Server 2012 Foundation

Windows 10 Home

Windows 10 Professional

Windows 10 Enterprise

Windows 8.1

Windows 8.1 Pro

Windows 8.1 Enterprise

Windows 8

Windows 8 Pro

Windows 8 Enterprise

COMPONENT REQUIREMENT

NOTENOTE

Database server version requirements

Installation of Power BI Report Server is supported on x64 processors only.

SQL Server is used to host the report server databases. The SQL Server Database Engine instance can be a local or
remote instance. The following are the supported versions of SQL Server Database Engine that can be used to host
the report server databases:

SQL Server 2017
SQL Server 2016
SQL Server 2014
SQL Server 2012
SQL Server 2008 R2
SQL Server 2008

Creating the report server database on a remote computer requires that you configure the connection to use a



Considerations

Read-only domain controller (RODC)

Power BI reports and Analysis Services live connections

SERVER VERSION REQUIRED SKU

2012 SP1 CU4 or later Business Intelligence and Enterprise SKU

2014 Business Intelligence and Enterprise SKU

2016 and later Standard SKU or higher

Next steps

domain user account or a service account that has network access. If you decide to use a remote SQL Server
instance, consider carefully which credentials the report server should use to connect to the SQL Server instance.
For more information, see Configure a Report Server Database Connection.

Power BI Report Server will install default values to configure the core settings required to make a report server
operational. It has the following requirements:

A SQL Server Database Engine must be available after setup and before you configure the database for the
report server. The Database Engine instance hosts the report server database that Reporting Services
Configuration Manager will create. The Database Engine is not required for the actual setup experience.
The user account used to run Setup must be a member of the local Administrators group.
The user account used for Reporting Services Configuration Manager must have permission to access and
create databases on the Database Engine instance that hosts the report server databases.
Setup must be able to use the default values to reserve the URLs that provide access to the report server and
the web portal. These values are port 80, a strong wildcard, and the virtual directory names in the format
ReportServer and Reports.

While the report server can be installed in an environment that has a Read-Only Domain Controller (RODC),
Reporting Services needs access to a Read-Write Domain Controller to function properly. If Reporting Services
only has access to a RODC, you may encounter errors when trying to administer the service.

You can use a live connection against tabular or multidimensional instances. Your Analysis Services server has to
me the proper version and edition to work properly.

User handbook
Administrator handbook
Quickstart: Install Power BI Report Server
Install Report Builder
Download SQL Server Data Tools (SSDT)

More questions? Try asking the Power BI Community

https://docs.microsoft.com/sql/reporting-services/install-windows/configure-a-report-server-database-connection-ssrs-configuration-manager
https://docs.microsoft.com/sql/reporting-services/install-windows/install-report-builder
http://go.microsoft.com/fwlink/?LinkID=616714
https://community.powerbi.com/
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Purchased Power BI Premium

Learn how you can find your Power BI Report Server product key to install your server in a production
environment.

You downloaded Power BI Report Server, and you have a SQL Server Enterprise Software Assurance agreement.
Or, you purchased Power BI Premium. You want to install the server in a production environment, but you need a
product key in order to do that. Where is the product key?

The product key will be in one of two places depending on what you purchased.

If you have purchased Power BI Premium, within the Capacity settings tab of the Power BI admin portal, you will
have access to your Power BI Report Server product key. This will only be available for Global Admins or users
assigned the Power BI service administrator role.

Selecting Power BI Report Server key will display a dialog contain your product key. You can copy it and use it
with the installation.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/report-server/find-product-key.md


Purchased Software Assurance agreeemnt

NOTENOTE

Next steps

If you have a SQL Server Enterprise SA agreement, you can get your product key from the Volume Licensing
Service Center. Look under the latest service pack, for the latest version of SQL Server. If you don't see it there, look
under the RTM release of the latest SQL Server version.

You need to look under the download section. Not the keys section.

Quickstart: Install Power BI Report Server
Install Power BI Desktop optimized for Power BI Report Server
Install Report Builder
Download SQL Server Data Tools (SSDT)

More questions? Try asking the Power BI Community

https://www.microsoft.com/Licensing/servicecenter/
https://docs.microsoft.com/sql/reporting-services/install-windows/install-report-builder
http://go.microsoft.com/fwlink/?LinkID=616714
https://community.powerbi.com/


Quickstart: Install Power BI Report Server
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Before you begin

Step 1: Download

Installing Power BI Report Server itself is very quick. From downloading, to installing and configuring, you
should be up and running within a few minutes.

This is a quick look at how to install a report server if you just want to get up and running with a new server. For
more detailed information on installing a report server, see Install Power BI Report Server.

Download 

To download Power BI Report Server, go to On-premises reporting with Power BI Report Server.

Go to the Microsoft Download Center to download Microsoft Power BI Desktop (Optimized for Power BI Report
Server - October 2017).

 For the current release notes, see Power BI Report Server - Release notes.

Before you install Power BI Report Server, it is recommended that you review the Hardware and Software
Requirements for installing Power BI Report Server.

Download the installation files, for Power BI Report Server, locally. To download Power BI Report Server, go to
the Microsoft download center.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/report-server/quickstart-install-report-server.md
https://powerbi.microsoft.com/report-server/
https://go.microsoft.com/fwlink/?linkid=861076
https://go.microsoft.com/fwlink/?linkid=839351


Step 2: Run installer

Step 3: Configure the server

Run the PowerBIReportServer.exe file that you downloaded and step through the installation screens. You will
have the opportunity to select the the installation path as well as select the edition you want to install. You can
choose between an evaluation that expires within 180 days, a developer edition or to provide a product key.

After you are done installing, you will run the configuration manager to finish setting up your server. You will
need to create a ReportServer catalog database as well as confirm the web portal and web service URLs.



Step 4: Browse to web portal

Next steps

Now that you are configured, you should be able to open a browser to the web portal of your server. By default,
this will be http://localhost/reports . You will also be able to browse using the machine name instead of using
localhost by default, assuming you are not being blocked by any type of firewall.

Administrator handbook
How to find your report server product key
Install Power BI Report Server
Install Power BI Desktop optimized for Power BI Report Server
Browser support for Power BI Report Server

More questions? Try asking the Power BI Community

https://community.powerbi.com/


 

Install Power BI Report Server
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Before you begin

Power BI Report Server product keyPower BI Report Server product key
Power BI PremiumPower BI Premium

Learn how to install Power BI Report Server.

Download 

To download Power BI Report Server, go to On-premises reporting with Power BI Report Server.

Go to the Microsoft Download Center to download Microsoft Power BI Desktop (Optimized for Power BI Report
Server - October 2017).

 For the current release notes, see Power BI Report Server - Release notes.

Before you install Power BI Report Server, it is recommended that you review the Hardware and Software
Requirements for installing Power BI Report Server.

If you have purchased Power BI Premium, within the Premium settings tab of the Power BI admin portal, you
will have access to your Power BI Report Server product key. This will only be available for Global Admins or users
assigned the Power BI service administrator role.

Selecting Power BI Report Server key will display a dialog contain your product key. You can copy it and use it

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/report-server/install-report-server.md
https://powerbi.microsoft.com/report-server/
https://go.microsoft.com/fwlink/?linkid=861076


SQL Server Enterprise Software Assurance (SA)SQL Server Enterprise Software Assurance (SA)

Install your report server

NOTENOTE

with the installation.

If you have a SQL Server Enterprise SA agreement, you can get your product key from the Volume Licensing
Service Center.

Installing Power BI Report Server is straight forward. There are only a few steps to install the files.

You do not need a SQL Server Database Engine server available at the time of install. You will need one to configure
Reporting Services after install.

1. Find the location of PowerBIReportServer.exe and launch the installer.
2. Select Install Power BI Report Server.

3. Choose an edition to install and then select Next.

https://www.microsoft.com/Licensing/servicecenter/


You can choose either Evaluation or Developer edition from the drop down.

Otherwise, you can enter a product key for the server that you acquired from either the Power BI service or
the Volume License Service Center. For more information about how to get your product key, see the
Before you begin section.

4. Read and agree to the license terms and conditions and then select Next.



NOTENOTE

5. You need to have a Database Engine available to store the report server database. Select Next to install the
report server only.

6. Specify the install location for the report server. Select Install to continue.

The default path is C:\Program Files\Microsoft Power BI Report Server.

7. After a successful setup, select Configure Report Server to launch the Reporting Services Configuration
Manager.



Configuration your report server

Creating a database on a different serverCreating a database on a different server

Windows Service

After you select Configure Report Server in the setup, you will be presented with Reporting Services
Configuration Manager. For more information, see Reporting Services Configuration Manager.

You need to create a report server database to complete the initial configuration of Reporting Services. A SQL
Server Database server is required to complete this step.

If you are creating the report server database on a database server on a different machine, you need to change the
service account for the report server to a credential that is recognized on the database server.

By default, the report server uses the virtual service account. If you try to create a database on a different server,
you may receive the following error on the Applying connection rights step.

System.Data.SqlClient.SqlException (0x80131904): Windows NT user or group '(null)' not found. Check the name
again.

To work around the error, you can change the service account to either Network Service or a domain account.
Changing the service account to Network Service applies rights in the context of the machine account for the
report server.

For more information, see Configure the report server service account.

A windows service is created as part of the installation. It is displayed as Power BI Report Server. The service

https://docs.microsoft.com/sql/reporting-services/install-windows/reporting-services-configuration-manager-native-mode
https://docs.microsoft.com/sql/reporting-services/install-windows/ssrs-report-server-create-a-report-server-database
https://docs.microsoft.com/sql/reporting-services/install-windows/configure-the-report-server-service-account-ssrs-configuration-manager


Default URL reservations

PART DESCRIPTION

Prefix The default prefix is HTTP. If you previously installed a Secure
Sockets Layer (SSL) certificate, Setup tries to create URL
reservations that use the HTTPS prefix.

Host name The default host name is a strong wildcard (+). It specifies
that the report server accepts any HTTP request on the
designated port for any host name that resolves to the
computer, including http://<computername>/reportserver ,
http://localhost/reportserver , or 
http://<IPAddress>/reportserver.

Port The default port is 80. If you use any port other than port 80,
you have to explicitly add it to the URL when you open web
portal in a browser window.

Virtual directory By default, virtual directories are created in the format of
ReportServer for the Report Server Web service and Reports
for the web portal. For the Report Server Web service, the
default virtual directory is reportserver. For the web portal,
the default virtual directory is reports.

Firewall

name is PowerBIReportServer.

URL reservations are composed of a prefix, host name, port, and virtual directory:

An example of the complete URL string might be as follows:

http://+:80/reportserver , provides access to the report server.
http://+:80/reports , provides access to the web portal.

If you are accessing the report server from a remote machine, you want to make sure you have configured any
firewall rules if there is a firewall present.

You need to open up the TCP port that you have configured for your Web Service URL and Web Portal URL. By



Additional configuration

Next steps

default, these are configured on TCP port 80.

To configure integration with the Power BI service so you can pin report items to a Power BI dashboard, see
Integrate with the Power BI service.
To configure email for subscriptions processing, see E-Mail settings and E-Mail delivery in a report server.
To configure the web portal so you can access it on a report computer to view and manage reports, see
Configure a firewall for report server access and Configure a report server for remote administration.

Administrator handbook
How to find your report server product key
Install Power BI Desktop optimized for Power BI Report Server
Verify a reporting services installation
Configure the report server service account
Configure report server URLs
Configure a report server database connection
Initialize a report server
Configure SSL connections on a report server
Configure windows service accounts and permissions
Browser support for Power BI Report Server

More questions? Try asking the Power BI Community

https://docs.microsoft.com/sql/reporting-services/install-windows/power-bi-report-server-integration-configuration-manager
https://docs.microsoft.com/sql/reporting-services/install-windows/e-mail-settings-reporting-services-native-mode-configuration-manager
https://docs.microsoft.com/sql/reporting-services/subscriptions/e-mail-delivery-in-reporting-services
https://docs.microsoft.com/sql/reporting-services/report-server/configure-a-firewall-for-report-server-access
https://docs.microsoft.com/sql/reporting-services/report-server/configure-a-report-server-for-remote-administration
https://docs.microsoft.com/sql/reporting-services/install-windows/verify-a-reporting-services-installation
https://docs.microsoft.com/sql/reporting-services/install-windows/configure-the-report-server-service-account-ssrs-configuration-manager
https://docs.microsoft.com/sql/reporting-services/install-windows/configure-report-server-urls-ssrs-configuration-manager
https://docs.microsoft.com/sql/reporting-services/install-windows/configure-a-report-server-database-connection-ssrs-configuration-manager
https://docs.microsoft.com/sql/reporting-services/install-windows/ssrs-encryption-keys-initialize-a-report-server
https://docs.microsoft.com/sql/reporting-services/security/configure-ssl-connections-on-a-native-mode-report-server
https://docs.microsoft.com/sql/database-engine/configure-windows/configure-windows-service-accounts-and-permissions
https://community.powerbi.com/


Install Power BI Desktop optimized for Power BI
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NOTENOTE

Download and install Power BI Desktop

Learn how to install Power BI Desktop optimized for Power BI Report Server.

To create Power BI reports for Power BI Report Server, you need to download and install Power BI Desktop
optimized for Power BI Report Server. This release is different from the Power BI Desktop used with the Power BI
service. For example, the version of Power BI Desktop for the Power BI service includes preview features that
aren't available in the Power BI Report Server version until after they're released. Using this release makes sure
that the report server can interact with a known version of the reports and model.

You can install Power BI Desktop and Power BI Desktop optimized for Power BI Report Server side by side on the same
computer.

The easiest way to be sure you have the most up-to-date version of Power BI Desktop optimized for Power BI
Report Server is to start from the web portal of your report server.

1. In the report server web portal, select the Download arrow > Power BI Desktop.

Or you can go directly to Microsoft Power BI Desktop (Optimized for Power BI Report Server - October
2017) in the Microsoft Download Center.

2. In the Download Center page, select Download.

3. Depending on your computer, select:

PBIDesktopRS.msi (the 32-bit version) or

PBIDesktopRS_x64.msi (the 64-bit version).

4. After you download the installer, run the Power BI Desktop (October 2017) Setup Wizard.

5. At the end of the installation, check Start Power BI Desktop now.

It starts automatically and you're ready to go.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/report-server/install-powerbi-desktop.md
https://go.microsoft.com/fwlink/?linkid=861076


Verify you are using the correct version

File extension association

Considerations and limitations

In a browserIn a browser

In the Power BI mobile appsIn the Power BI mobile apps

You can verify that you are using the correct Power BI Desktop by looking at the launch screen or title bar within
Power BI Desktop. The title bar indicates the release month and year of the release.

The Power BI Desktop version for the Power BI service doesn't have the month and year in the title bar.

If you installed both Power BI Desktop and Power BI Desktop optimized for Power BI Report Server on the same
machine, the last install of Power BI Desktop will have the file association with .pbix. This means that when you
double click on a pbix file, it will launch the Power BI Desktop that was last installed.

If you had Power BI Desktop and then installed Power BI Desktop optimized for Power BI Report Server, all pbix
files will open in Power BI Desktop optimized for Power BI Report Server by default. If you would rather Power BI
Desktop be the default to launch when opening a pbix file, reinstall Power BI Desktop from the Power BI service.

You can always open the version of Power BI Desktop you want to use first. And then open the file from within
Power BI Desktop.

Editing a Power BI report from within Power BI Report Server, or creating a new Power BI report from the web
portal, will always open the correct version of Power BI Destop.

Reports in Power BI Report Server and in the Power BI service (http://powerbi.com) act almost exactly the same,
but a few features are different.

Power BI Report Server reports support all visualizations, including:

Custom visuals

Power BI Report Server reports don’t support:

R visuals
ArcGIS maps
Breadcrumbs
Power BI Desktop preview features

Power BI Report Server reports support all the basic functionality in the Power BI mobile apps, including:

Phone report layout: You can optimize a report for the Power BI mobile apps. On your mobile phone,

optimized reports have a special icon, , and layout.

http://powerbi.com


Next steps

Power BI Report Server reports don’t support these features in the Power BI mobile apps:

R visuals
ArcGIS maps
Custom visuals
Breadcrumbs
Geofiltering or bar codes

Now that you have Power BI Desktop installed, you can start creating Power BI reports.

Quickstart: Create a Power BI report for Power BI Report Server
Get started with Power BI Desktop
Guided learning: Getting started with Power BI Desktop
User handbook overview, Power BI Report Server

More questions? Try asking the Power BI Community

file:///W:/soyp-o-7bf22bb1/powerbi-docs/.tmp/guided-learning/gettingdata.yml#step-2
https://community.powerbi.com/


Upgrade Power BI Report Server
1/30/2018 • 2 min to read • Edit Online

Before you begin

Backing up the encryption keysBacking up the encryption keys

Backing up the report server databasesBacking up the report server databases

Backing up the configuration filesBacking up the configuration files

Learn how to upgrade Power BI Report Server.

Download 

To download Power BI Report Server, and Power BI Desktop optimized for Power BI Report Server, go to On-
premises reporting with Power BI Report Server.

 For the current release notes, see Power BI Report Server - Release notes.

Before you upgrade a report server, it is recommended that you perform the following steps to back up your report
server.

You should backup the encryption keys when you configure a report server installation for the first time. You
should also backup the keys any time you change the identity of the service accounts or rename the computer. For
more information, see Back Up and Restore Reporting Services Encryption Keys.

Because a report server is a stateless server, all application data is stored in the reportserver and
reportservertempdb databases that run on a SQL Server Database Engine instance. You can backup the
reportserver and reportservertempdb databases using one of the supported methods for backing up SQL Server
databases. Recommendations that are specific to the report server databases include the following:

Use the full recovery model to backup the reportserver database.
Use the simple recovery model to backup the reportservertempdb database.
You can use different backup schedules for each database. The only reason to backup the reportservertempdb
is to avoid having to recreate it if there is a hardware failure. In the event of hardware failure, it is not necessary
to recover the data in reportservertempdb, but you do need the table structure. If you lose
reportservertempdb, the only way to get it back is to recreate the report server database. If you recreate the
reportservertempdb, it is important that it have the same name as the primary report server database.

For more information about backup and recovery of SQL Server relational databases, see Back Up and Restore of
SQL Server Databases.

Power BI Report Server uses configuration files to store application settings. You should backup the files when you
first configure the server and after you deploy any custom extensions. Files to back up include:

config.json
RSHostingService.exe.config
Rsreportserver.config
Rssvrpolicy.config
Reportingservicesservice.exe.config
Web.config for the Report Server ASP.NET applications
Machine.config for ASP.NET

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/report-server/upgrade.md
https://powerbi.microsoft.com/report-server/
https://docs.microsoft.com/sql/reporting-services/install-windows/ssrs-encryption-keys-back-up-and-restore-encryption-keys
https://docs.microsoft.com/sql/relational-databases/backup-restore/back-up-and-restore-of-sql-server-databases


Upgrade the report server
Upgrading Power BI Report Server is straight forward. There are only a few steps to install the files.

1. Find the location of PowerBIReportServer.exe and launch the installer.
2. Select Upgrade Power BI Report Server.

3. Read and agree to the license terms and conditions and then select Upgrade.

4. After a successful upgrade, you can select Configure Report Server to launch the Reporting Services
Configuration Manager, or select Close to exit the installer.



Upgrade Power BI Desktop

Next steps

After the report server is upgrade, you will want to make sure that any Power BI report authors upgrade to the
version of Power BI Desktop optimized for Power BI Report Server that matches the server.

Administrator handbook
Install Power BI Desktop optimized for Power BI Report Server
Verify a reporting services installation
Configure the report server service account
Configure report server URLs
Configure a report server database connection
Initialize a report server
Configure SSL connections on a report server
Configure windows service accounts and permissions
Browser support for Power BI Report Server

More questions? Try asking the Power BI Community

https://docs.microsoft.com/sql/reporting-services/install-windows/verify-a-reporting-services-installation
https://docs.microsoft.com/sql/reporting-services/install-windows/configure-the-report-server-service-account-ssrs-configuration-manager
https://docs.microsoft.com/sql/reporting-services/install-windows/configure-report-server-urls-ssrs-configuration-manager
https://docs.microsoft.com/sql/reporting-services/install-windows/configure-a-report-server-database-connection-ssrs-configuration-manager
https://docs.microsoft.com/sql/reporting-services/install-windows/ssrs-encryption-keys-initialize-a-report-server
https://docs.microsoft.com/sql/reporting-services/security/configure-ssl-connections-on-a-native-mode-report-server
https://docs.microsoft.com/sql/database-engine/configure-windows/configure-windows-service-accounts-and-permissions
https://community.powerbi.com/


Migrate a report server installation
1/30/2018 • 2 min to read • Edit Online

Migrating to Power BI Report Server from SSRS (Native mode)

NOTENOTE

Learn how to migrate your exising SQL Server Reporting Services (SSRS) instance to an instance of Power BI
Report Server.

Migration is defined as moving application data files to a new Power BI Report Server instance. The following are
common reasons why you might migrate your installation:

NOTENOTE

You have a large scale deployment or update requirements
You are changing the hardware or topology of your installation
You encounter an issue that blocks upgrade

You are wanting to move from SQL Server Reporting Services to Power BI Report Server

There is not an inplace upgrade from SQL Server Reporting Services to Power BI Report Server. A migration is
necessary.

Migrating from an SSRS (Native mode) instance to Power BI Report Server consists of a few steps.

SQL Server 2008 Reporting Services and later are supported for migration.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/report-server/migrate-report-server.md


NOTENOTE

Migration to Power BI Report Server from SSRS (SharePoint-integrated
mode)

NOTENOTE

Sample scriptSample script

Backup database, application and configuration files
Back up the encryption key
Clone your report server database hosting your reports
Install Power BI Report Server. If you are using the same hardware, you can install Power BI Report Server on
the same server as the SSRS instance. For more information on installing Power BI Report Server, see Install
Power BI Report Server.

The instance name for the Power BI Report Server will be PBIRS.

Configure the report server using Report Server Configuration Manager and connect to the cloned database.
Perform any cleanup needed for the SSRS (Native mode) instance

Migrating from an SSRS (SharePoint-integrated mode) to Power BI Report Server is not as straight forward as
native mode. While these steps will provide some guidance, you may have other files and assets within SharePoint
that will need to be managed outside of these steps.

You will need to migrate the specific report server content from SharePoint to your Power BI Report Server. This
assumes you have already installed Power BI Report Server somehwere in your environment. For more
information on installing Power BI Report Server, see Install Power BI Report Server.

If you want to copy the report server content from your SharePoint environment to Power BI Report Server, you
will need to use tools such as rs.exe to copy the content. Below is a sample of what the script would be to copy
report server content from SharePoint to Power BI Report Server.

The sample script should work against SharePoint 2010 and later and SQL Server 2008 Reporting Services and later.



Sample Script
rs.exe
-i ssrs_migration.rss -e Mgmt2010
-s http://SourceServer/_vti_bin/reportserver
-v st="sites/bi" -v f="Shared Documents“
-u Domain\User1 -p Password
-v ts=http://TargetServer/reportserver
-v tu="Domain\User" -v tp="Password"

Migrateing from one Power BI Report Server to another

NOTENOTE

Next steps

Migrating from one Power BI Reprot Server is the same process as migrating from SSRS (Native-mode).

Backup database, application and configuration files
Back up the encryption key
Clone your report server database hosting your reports
Install Power BI Report Server. You cannot install Power BI Report Server on the same server as the one you are
migrating from. For more information on installing Power BI Report Server, see Install Power BI Report Server.

The instance name for the Power BI Report Server will be PBIRS.

Configure the report server using Report Server Configuration Manager and connect to the cloned database.
Perform any cleanup needed for the old Power BI Report Server installation.

Administrator handbook
Quickstart: Install Power BI Report Server
Script with the rs.exe Utility and the Web Service

https://docs.microsoft.com/sql/reporting-services/tools/script-with-the-rs-exe-utility-and-the-web-service


More questions? Try asking the Power BI Community

https://community.powerbi.com/


Browser support for Power BI Report Server
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Browser requirements for the web portal

Browser requirements for the Report Viewer web control (2015)

Learn about what browser versions are supported for managing and viewing Power BI Report Server and the
Report Viewer Controls.

The following is the current list of browsers supported for the web portal.

Microsoft Windows
Windows 7, 8.1, 10; Windows Server 2008 R2, 2012, 2012 R2

Microsoft Edge (+)
Microsoft Internet Explorer 11
Google Chrome (+)
Mozilla Firefox (+)

Apple OS X
OS X 10.9-10.11

Apple Safari (+)
Google Chrome (+)
Mozilla Firefox (+)

Apple iOS
iPhone and iPad with iOS 10

Apple Safari (+)

Google Android
Phones and tablets with Android 4.4 (KitKat) or later

Google Chrome (+)

(+) Latest publicly released version

The following is the current list of browsers supported with the Report Viewer web control. The report viewer
supports viewing reports from the web portal.

Microsoft Windows
Windows 7, 8.1, 10; Windows Server 2008 R2, 2012, 2012 R2

Microsoft Edge (+)
Microsoft Internet Explorer 11
Google Chrome (+)
Mozilla Firefox (+)

Apple OS X
OS X 10.9-10.11

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/report-server/browser-support.md


Authentication requirementsAuthentication requirements

BROWSER TYPE SUPPORTS BROWSER DEFAULT SERVER DEFAULT

Microsoft Edge (+) Negotiate, Kerberos, NTLM,
Basic

Negotiate Yes. The default
authentication settings work
with Edge.

Microsoft Internet
Explorer

Negotiate, Kerberos, NTLM,
Basic

Negotiate Yes. The default
authentication settings work
with Internet Explorer.

Google Chrome(+) Negotiate, NTLM, Basic Negotiate Yes. The default
authentication settings work
with Chrome.

Mozilla Firefox(+) NTLM, Basic NTLM Yes. The default
authentication settings work
with Firefox.

Apple Safari(+) NTLM, Basic Basic Yes. The default
authentication settings work
with Safari.

Script requirements for viewing reportsScript requirements for viewing reports

Your browser does not support scripts or has been configured to not allow scripts to run. Click here to view 
this report without scripts

NOTENOTE

Browser support for Report Viewer web server controls in Visual
Studio

Apple Safari (+)

(+) Latest publicly released version

Browsers support specific authentication schemes that must be handled by the report server in order for the client
request to succeed. The following table identifies the default authentication types supported by each browser
running on a Windows operating system.

(+) Latest publicly released version

To use the report viewer, configure your browser to run scripts.

If scripting is not enabled, you will see an error message similar to the following when you open a report:

If you choose to view the report without script support, the report is rendered in HTML without report viewer
capabilities such as the report toolbar and the document map.

The report toolbar is part of the HTML Viewer component. By default the toolbar appears at the top of every report that is
rendered in a browser window. The report viewer provides features include the ability to search the report for information,
scroll to a specific page, and adjust the page size for viewing purposes. For more information about the report toolbar or
HTML Viewer, see HTML Viewer and the Report Toolbar.

The Report Viewer Web server control is used to embed report functionality in an ASP.NET web application. For

https://docs.microsoft.com/sql/reporting-services/html-viewer-and-the-report-toolbar


Next steps

more information on how to get the Report Viewer Control, see Integrating Reporting Services Using Report
Viewer Controls - Get Started.

Use a browser that has script support enabled. If the browser cannot run scripts, you cannot view the report.

Microsoft Windows
Windows 7, 8.1, 10; Windows Server 2008 R2, 2012, 2012 R2

Microsoft Edge (+)
Microsoft Internet Explorer 11
Google Chrome (+)
Mozilla Firefox (+)

(+) Latest publicly released version

Administrator handbook
Quickstart: Install Power BI Report Server
Install Report Builder
Download SQL Server Data Tools (SSDT)

More questions? Try asking the Power BI Community

https://docs.microsoft.com/sql/reporting-services/application-integration/integrating-reporting-services-using-reportviewer-controls-get-started
https://docs.microsoft.com/sql/reporting-services/install-windows/install-report-builder
http://go.microsoft.com/fwlink/?LinkID=616714
https://community.powerbi.com/


Configure Kerberos to use Power BI reports
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Error running report

Something went wrong.

We couldn’t run the report because we couldn’t connect to its data source. The report or data source might not 
be configured correctly. 

We couldn’t connect to the Analysis Services server. The server forcibly closed the connection. To connect as 
the user viewing the report, your organization must have configured Kerberos constrained delegation.

Learn how to configure your report server for Kerberos authentication to data sources used within your Power BI
reports for a distributed environment.

Power BI Report Server includes the ability to host Power BI reports. Many data sources are supported by your
report server. While this article focuses specificly on SQL Server Analysis Services, you can use the concepts and
apply that to other data sources such as SQL Server.

You can install Power BI Report Server, SQL Server and Analysis Services on a single machine and everything
should work without additional configuration. This is great for a test environment. You may hit errors if you have
these services installed on separate machines which is called a distributed environment. In this environment, you
are required to use Kerberos authentication. There is configuration required to implement this.

Specifically, you will need to configure constrained delegation. You may have Kerberos configured in your
environment but it may not be configured for constrained delegation.

If your report server is not configured properly, you may receive the following error.

Within Technical details, you will see the following message.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/report-server/configure-kerberos-powerbi-reports.md


Configuring Kerberos constrained delegation

NOTENOTE

Authentication type within Report Server configuration

<AuthenticationTypes>
    <RSWindowsNegotiate/>
    <RSWindowsNTLM/>
</AuthenticationTypes>

SPNs for the report server service account

There are several items that need to be configured in order for Kerberos constrained delegation to work. This
includes Service Principal Names (SPN) and delegation settings on service accounts.

In order to configure SPNs and delegation settings, you need to be a domain administrator.

We will need to configure, or validate, the following.

1. Authentication type within Report Server config.
2. SPNs for the report server service account.
3. SPNs for the Analysis Services service.
4. SPNs for the SQL Browser service on the Analysis Services machine. This is for named instances only.
5. Delegation settings on the report server service account.

We need to configure the authentication type for the report server to allow for Kerberos constrained delegation.
This is done within the rsreportserver.config file. The default location for this file is 
C:\Program Files\Microsoft Power BI Report Server\PBIRS\ReportServer .

Within the rsreportserver.config file, you will want to fine the Authentication/AuthenticationTypes section.

We want to make sure that RSWindowsNegotiate is listed and the first in the list of authentication types. It should
look similar to the following.

If you had to change the configuration file, you will want to stop and start the report server to make sure the
changes take effect.

For more information, see Configure Windows Authentication on the Report Server.

Next, we need to make sure that the report server has valid SPNs available. This is based on the service account

https://docs.microsoft.com/sql/reporting-services/security/configure-windows-authentication-on-the-report-server


Virtual Service Account or Network ServiceVirtual Service Account or Network Service

Domain user accountDomain user account

NOTENOTE

<Service>/<Host>:<port>

NOTENOTE

SPN TYPE SPN

Fully Qualified Domain Name (FQDN) HTTP/ContosoRS.contoso.com

NetBIOS HTTP/ContosoRS

Location of SPNLocation of SPN

Using SetSPN to add the SPNUsing SetSPN to add the SPN

that is configured for the report server.

If your report server is configured for the Virtual Service Account or Network Service account, you should not have
to do anything. These are in the context of the machine account. The machine account will have HOST SPNs by
default. These will cover the HTTP service and will be used by the report server.

If you are using a virtual server name, one that is not same as the machine account, the HOST entries will not cover
you and you will need to manually add the SPNs for the virtual server host name.

If your report server is configured to use a domain user account, you will have to manually create HTTP SPNs on
that account. This can be done using the setspn tool that comes with Windows.

You will need domain admin rights in order to create the SPN.

It is recommended to create two SPNs. One with the NetBIOS name and the other with the fully qualified domain
name (FQDN). The SPN will be in the following format.

Power BI Report Server will use a Service of HTTP. For HTTP SPNs you will not list a port. The service we are
interested in here is HTTP. The host of the SPN will be the name you use in a URL. Typically, this is the machine
name. If you are behind a load balancer, this may be a virtual name.

You can verify the URL by either looking at what you enter into the address bar of the browser, or you can look in the Report
Server Configuration Manager on the Web Portal URL tab.

If your machine name is ContosoRS, your SPNs would be the following.

So, where do you put the SPN? The SPN will be placed on whatever you are using for your service account. If you
are using Virtual Service Account or Network Service, this will be the machine account. Although we mentioned
before you should only need to do this for a virtual URL. If you are using a domain user for the report server
service account, then you will place the SPN on that domain user account.

For example, if we are using the Network Service account and our machine name is ContosoRS, we would place the
SPN on ContosoRS.

If we are using a domain user account of RSService, we would place the SPN on RSService.

We can use the SetSPN tool to add the SPN. We will follow the same example as above with the Machine account



  Setspn -a HTTP/contosoreports.contoso.com ContosoRS
  Setspn -a HTTP/contosoreports ContosoRS

  Setspn -a HTTP/ContosoRS.contoso.com RSService
  Setspn -a HTTP/ContosoRS RSService

SPNs for the Analysis Services service

TYPE FORMAT

Default instance MSOLAPSvc.3/ContosoAS.contoso.com
MSOLAPSvc.3/ContosoAS

Named instance MSOLAPSvc.3/ContosoAS.contoso.com:INSTANCENAME
MSOLAPSvc.3/ContosoAS:INSTANCENAME

Using SetSPN to add the SPNUsing SetSPN to add the SPN

Setspn -a MSOLAPSvc.3/ContosoAS.contoso.com ContosoAS
Setspn -a MSOLAPSvc.3/ContosoAS ContosoAS

Setspn -a MSOLAPSvc.3/ContosoAS.contoso.com OLAPService
Setspn -a MSOLAPSvc.3/ContosoAS OLAPService

SPNs for the SQL Browser service

and the domain user account.

Placing the SPN on a machine account, for both the FQDN and NetBIOS SPN, would look similar to the following if
we were using a virtual URL of contosoreports.

Placing the SPN on a domain user account, for both the FQDN and NetBIOS SPN, would look similar to the
following if you were using the machine name for the host of the SPN.

The SPNs for Analysis Services are similar to what we did with Power BI Report Server. The format of the SPN is a
little different if you have a named instance.

For Analysis Services, we use a Service of MSOLAPSvc.3. We will specify the instance name for the port location on
the SPN. The host part of the SPN will either be the machine name, or the Cluster virtual name.

An example of an Analysis Services SPN would look like the following.

Placement of the SPN is also similar to what was mentioned with Power BI Report Server. It is based on the service
account. If you are using Local System or Network Service, you will be in the context of the machine account. If you
are using a domain user account for the Analysis Services instance, you will place the SPN on the domain user
account.

We can use the SetSPN tool to add the SPN. For this example, the machine name will be ContosoAS.

Placing the SPN on a machine account, for both the FQDN and NetBIOS SPN, would look similar to the following.

Placing the SPN on a domain user account, for both the FQDN and NetBIOS SPN, would look similar to the
following.



MSOLAPDisco.3/ContosoAS.contoso.com
MSOLAPDisco.3/ContosoAS

Using SetSPN to add the SPNUsing SetSPN to add the SPN

Setspn -a MSOLAPDisco.3/ContosoAS.contoso.com ContosoAS
Setspn -a MSOLAPDisco.3/ContosoAS ContosoAS

Delegation settings on the report server service account

If you have an Analysis Services named instance, you also need to make sure you have an SPN for the browser
service. This is unique to Analysis Services.

The SPNs for SQL Browser are similar to what we did with Power BI Report Server.

For SQL Browser, we use a Service of MSOLAPDisco.3. We will specify the instance name for the port location on
the SPN. The host part of the SPN will either be the machine name, or the Cluster virtual name. You do not have to
specify anything for the instance name or port.

An example of an Analysis Services SPN would look like the following.

Placement of the SPN is also similar to what was mentioned with Power BI Report Server. The difference here is
that SQL Browser always runs under the Local System account. This means that the SPNs will always go on the
machine account.

We can use the SetSPN tool to add the SPN. For this example, the machine name will be ContosoAS.

Placing the SPN on the machine account, for both the FQDN and NetBIOS SPN, would look similar to the following.

For more information, see An SPN for the SQL Server Browser service is required.

The last part that we have to configure are the delegation settings on the report server service account. There are
different tools you can use to perform these steps. For the purposes of this document, we will stick with Active
Directory Users and Computers.

You will need to start by going to the properties of the report server service account within Active Directory Users
and Computers. This will either be the machine account, if you used Virtual Service Account or Network Service, or
it will be a domain user account.

We will want to configure constrained delegation with protocol transiting. With constrained delegation, you need
to be explicit with which services we want to delegate to. We will go and add both the Analysis Services service
SPN and the SQL Browser SPN to the list that Power BI Report Server can delegate to.

1. Right click on the report server service account and select Properties.
2. Select the Delegation tab.
3. Select Trust this computer for delegation to specified services only.
4. Select Use any authentication protocol.
5. Under the Services to which this account can present delegated credentials: select Add.
6. In the new dialog, select Users or Computers.
7. Enter the service account for the Analysis Services service and select Ok.
8. Select the SPN that you created. It will begin with MSOLAPSvc.3 . If you added both the FQDN and the NetBIOS

SPN, it will select both. You may only see one.
9. Select OK. You should see the SPN in the list now.

10. Optionally, you can select Expanded to show both the FQDN and NetBIOS SPN in the list.
11. Select Add again. We will add the SQL Browser SPN now.

https://support.microsoft.com/kb/950599


Running a Power BI Report

Next steps

12. In the new dialog, select Users or Computers.
13. Enter the Machine name for the machine the SQL Browser service is on and select Ok.
14. Select the SPN that you created. It will begin with MSOLAPDisco.3 . If you added both the FQDN and the NetBIOS

SPN, it will select both. You may only see one.

16. Select Ok.
17. Reboot the Power BI Report Server.

15. Select Ok. The dialog should look similar to the following if you checked Expanded.

After all of the above configuration is in place, your report should display properly.

While this configuration should work in most cases, with Kerberos, there can be different configuration depending
on your environment. If the report will still not load, you will want to reach out to your domain administrator to
investigate further or contact support.

Administrator handbook
Quickstart: Install Power BI Report Server

More questions? Try asking the Power BI Community

https://community.powerbi.com/
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Executive summary

WORKLOAD 8 CORE/32 GB RAM 16 CORE/64 GB RAM

Power BI Report Heavy (>60%) 1,000 users 3,000 users

Paginated (RDL) Report Heavy
(>60%)

2,000 users 3,200 users

Test methodology

Power BI Report Server topologyPower BI Report Server topology

Power BI Report Server is a self-service BI and enterprise reporting solution that customers can deploy on their
premises, behind their firewall. It combines the interactive report capability of Power BI Desktop with the on-
premises server platform of SQL Server Reporting Services. With heavy and growing usage of analytics and
reporting within enterprises, budgeting the hardware infrastructure and software licenses required to scale to an
enterprise user base can be a challenge. This paper aims to offer guidance on capacity planning for Power BI Report
Server by sharing results of numerous load test executions of various workloads against a report server. While
organizations’ reports, queries, and usage patterns vary widely, the results presented in this paper, along with the
actual tests used and a detailed description of how they were executed, serve as a reference point for anyone in the
early-stage planning process of deploying Power BI Report Server.

We executed two different types of workloads against Power BI Report Server; each workload consisted of
rendering different types of reports as well as performing various web portal operations.

In “Power BI Report Heavy” workload, the most frequently executed operation (i.e. the operation executed 60%
of the time) was rendering Power BI reports.
In “Paginated Report Heavy” workload, the most frequently executed operation was rendering paginated
reports.

Under a four-server topology of Power BI Report Server and the expectation that no more than 5% of users will
access a report server at any one time, the following table describes the maximum number of users Power BI
Report Server can handle with at least 99% reliability.

In each run, the most overwhelmed resource was CPU. Due to this, increasing the number of cores to Power BI
Report Server would yield a higher gain in the reliability of the system than increasing the amount of memory or
hard-disk space.

The testing topology used was based on Microsoft Azure Virtual Machines instead of vendor-specific physical
hardware. All machines were hosted in US regions. This reflects the general trend of hardware virtualization both
on premises and in the public cloud.

The Power BI Report Server deployment consisted of the following virtual machines:

Active Directory Domain Controller: this was needed by SQL Server Database Engine, SQL Server Analysis
Services, and Power BI Report Server to securely authenticate all requests.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/report-server/capacity-planning.md


TestsTests

WorkloadsWorkloads

ACTIVITY
POWER BI REPORT HEAVY, FREQUENCY OF
OCCURRENCE

PAGINATED REPORT HEAVY, FREQUENCY
OF OCCURRENCE

Rendering Power BI reports 60% 10%

SQL Server Database Engine and SQL Server Analysis Services: this was where we stored all the databases for
the reports to consume when we rendered them.
Power BI Report Server
Power BI Report Server Database. The report server database is hosted on a different machine than Power BI
Report Server so that it does not need to compete with SQL Server Database Engine for memory, CPU, network,
and disk resources.

See Appendix 1.1 Power BI Report Server Topology and Appendix 1.2 Power BI Report Server Virtual Machine
Configuration for a thorough configuration of each virtual machine used in the topology.

The tests used in the load test runs are publicly available in a GitHub project called Reporting Services LoadTest
(See https://github.com/Microsoft/Reporting-Services-LoadTest). This tool allows users to study the performance,
reliability, scalability and recoverability characteristics of SQL Server Reporting Services and Power BI Report
Server. This project consists of four groups of test cases:

Tests simulating rendering Power BI reports,
Tests simulating rendering mobile reports,
Tests simulating rendering small and large paginated reports, and
Tests simulating performing various types of web portal operations.

All tests were written to perform an end-to-end operation (such as rendering a report, creating a new data source,
etc.). They accomplish this by making one or more web requests to the report server (via APIs). In the real world, a
user may need to perform a few intermediate operations to complete one of these end-to-end operations. For
example, to render a report a user will need to go to the web portal, navigate to the folder where the report is, then
click the report to render it. While tests don’t perform all the operations needed to accomplish an end-to-end task,
they still impose most of the load that Power BI Report Server would experience . You can learn more about the
different types of reports used as well as the variety of operations performed by exploring the GitHub project.

There are 2 workload profiles used in testing: Power BI Report Heavy and Paginated Report Heavy. The table below
describes the distribution of requests executed against the Report Server.

https://github.com/Microsoft/Reporting-Services-LoadTest


Rendering paginated (RDL) reports 30% 60%

Rendering mobile reports 5% 20%

Web portal operations 5% 10%

ACTIVITY
POWER BI REPORT HEAVY, FREQUENCY OF
OCCURRENCE

PAGINATED REPORT HEAVY, FREQUENCY
OF OCCURRENCE

User loadUser load

Results
Concurrent user capacityConcurrent user capacity

WORKLOAD 8 CORE/32 GB 16 CORE/64 GB

Power BI Report Heavy 50 concurrent users 150 concurrent users

Paginated Report Heavy 100 concurrent users 160 concurrent users

Total user capacityTotal user capacity

WORKLOAD 8 CORE/32 GB 16 CORE/64 GB

Power BI Report Heavy 1,000 users 3,000 users

Paginated Report Heavy 2,000 users 3,200 users

View resultsView results

WORKLOAD 8 CORE/32 GB 16 CORE/64 GB

Power BI Report Heavy View - 8 core View - 16 core

Paginated Report Heavy View - 8 core View - 16 core

For each test run, tests were executed based on the frequency specified in one of the two workloads. Tests started
with 20 concurrent user requests to the report server. The user load was then gradually increased until reliability
dropped below the 99% target.

As stated earlier, tests started with 20 concurrent users making requests to the report server. The number of
concurrent users was then gradually increased until 1% of all requests were failing. The results in the following
table tell us the number of concurrent user requests that the server would be able to handle under peak load with a
failure rate of less than 1%.

At Microsoft, we have a production deployment of Power BI Report Server that several teams used. When we
analyze actual usage of this environment, we observe that the number of concurrent users at any given time (even
during daily peak load) doesn’t tend to exceed 5% of the total user base. Using this 5% concurrency ratio as a
benchmark, we extrapolated the total user base Power BI Report Server could handle with 99% reliability.

Select a report to view the results of the load test.

https://msit.powerbi.com/view?r=eyJrIjoiMDhhNGY4NGQtNGRhYy00Yzk4LTk2MzAtYzFlNWI5NjBkMGFiIiwidCI6IjcyZjk4OGJmLTg2ZjEtNDFhZi05MWFiLTJkN2NkMDExZGI0NyIsImMiOjV9
https://msit.powerbi.com/view?r=eyJrIjoiNDBiODk1OGUtYTAyOC00MzVhLThmZmYtNzVjNTFjNzMwYzkwIiwidCI6IjcyZjk4OGJmLTg2ZjEtNDFhZi05MWFiLTJkN2NkMDExZGI0NyIsImMiOjV9
https://msit.powerbi.com/view?r=eyJrIjoiNDFiZWYzMTktZGIxNS00MzcwLThjODQtMmJkMGRiZWEzNjhlIiwidCI6IjcyZjk4OGJmLTg2ZjEtNDFhZi05MWFiLTJkN2NkMDExZGI0NyIsImMiOjV9
https://msit.powerbi.com/view?r=eyJrIjoiOTU0YjJkYTgtNDg4Yy00NzlhLWIwMGYtMzg4YWI2MjNmOTZjIiwidCI6IjcyZjk4OGJmLTg2ZjEtNDFhZi05MWFiLTJkN2NkMDExZGI0NyIsImMiOjV9




Summary

Appendix
1 Topology1 Topology

VIRTUAL MACHINE TYPE PROCESSOR MEMORY AZURE VM SIZE

Active Directory Domain
Controller

2 Cores 7 GB Standard_DS2_v2

SQL Server Database
Engine and Analysis
Services

16 Cores 56 GB Standard_DS5_v2

Report Server Database 16 Cores 56 GB Standard_DS5_v2

For each load test run, CPU was the most overwhelmed resource at the point of peak load on the Power BI Report
Server machine. Due to this, the first resource that should be increased is the number of cores. Alternately, you can
consider scaling out by adding more servers hosting Power BI Report Server in your topology.

The results presented in this paper were derived from executing a specific set of reports consuming a specific set of
data, repeated in a specific way. It’s a useful reference point, but keep in mind that your usage will depend on your
reports, queries, usage patterns and deployment of your Power BI Report Server.

1.1 Power BI Report Server Topology

To focus solely on Power BI Report Server behavior under different configurations, the VM configuration for each
type of machine (except for the machine hosting Power BI Report Server) was fixed. Each machine was provisioned
according to the second-generation (v2) D Series machines with Premium Storage Disks. You can find detailed
information about each VM size under the “General Purpose” section on https://azure.microsoft.com/en-
us/pricing/details/virtual-machines/windows/.

1.2 Power BI Report Server Virtual Machine Configuration

Different configurations of processor and memory were used for the Virtual Machine hosting Power BI Report
Server. Unlike the other VMs, this machine was provisioned according to the third-generation (v3) D Series
Machines with Premium Storage Disks. You can find detailed information about this VM size under the “General
Purpose” section on https://azure.microsoft.com/en-us/pricing/details/virtual-machines/windows/.

https://azure.microsoft.com/en-us/pricing/details/virtual-machines/windows/
https://azure.microsoft.com/en-us/pricing/details/virtual-machines/windows/


VIRTUAL MACHINE PROCESSOR MEMORY AZURE VM SIZE

Power BI Report Server
(Small)

8 Cores 32 GB Standard_D8S_v3

Power BI Report Server
(Large)

16 Cores 64 GB vStandard_D16S_v3

2 Run the LoadTest tool2 Run the LoadTest tool
If you’d like to run the Reporting Services LoadTest tool against your or a Microsoft Azure deployment of Power BI
Report Server, follow these steps.

1. Clone the Reporting Services LoadTest project from GitHub (https://github.com/Microsoft/Reporting-Services-
LoadTest).

2. In the project directory, you will find a solution file called RSLoadTests.sln. Open this file in Visual Studio 2015
or later.

3. Determine whether you want to run this tool against your deployment of Power BI Report Server or against a
deployment of Power BI Report Server in Microsoft Azure. If you are going to run it against your own
deployment, go to step 5.

4. Follow the instructions listed on https://github.com/Microsoft/Reporting-Services-LoadTest#create-a-sql-
server-reporting-services-load-environment-in-azure to create a Power BI Report Server environment in Azure.

5. Once you finish deploying the environment, follow the instructions listed on
https://github.com/Microsoft/Reporting-Services-LoadTest#load-test-execution to run the tests.

More questions? Try asking the Power BI Community

https://github.com/Microsoft/Reporting-Services-LoadTest
https://github.com/Microsoft/Reporting-Services-LoadTest#create-a-sql-server-reporting-services-load-environment-in-azure
https://github.com/Microsoft/Reporting-Services-LoadTest#load-test-execution
https://community.powerbi.com/
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NOTENOTE

Prepare server to run Office Online Server

Install prerequisite software for Office Online ServerInstall prerequisite software for Office Online Server

In addition to viewing Power BI reports in the web portal, business users can now do the same with Excel
workbooks in Power BI Report Server, giving them a single location to publish and view their self-service Microsoft
BI content.

This is a preview feature included in the August 2017 preview release. For more information, see What's new in Power BI
Report Server.

This is accomplished by making use of Office Online Server (OOS).

Perform these procedures on the server that will run Office Online Server. This server must be Windows Server
2012 R2 or Windows Server 2016. Windows Server 2016 requires Office Online Server April 2017 or later.

Add-WindowsFeature Web-Server,Web-Mgmt-Tools,Web-Mgmt-Console,Web-WebServer,Web-Common-Http,Web-Default-
Doc,Web-Static-Content,Web-Performance,Web-Stat-Compression,Web-Dyn-Compression,Web-Security,Web-
Filtering,Web-Windows-Auth,Web-App-Dev,Web-Net-Ext45,Web-Asp-Net45,Web-ISAPI-Ext,Web-ISAPI-Filter,Web-
Includes,InkandHandwritingServices,NET-Framework-Features,NET-Framework-Core,NET-HTTP-Activation,NET-
Non-HTTP-Activ,NET-WCF-HTTP-Activation45,Windows-Identity-Foundation,Server-Media-Foundation

1. Open the Windows PowerShell prompt as an administrator and run this command to install the required
roles and services.

Windows Server 2012 R2:

Windows Server 2016:

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/report-server/excel-oos.md
https://technet.microsoft.com/library/jj219437(v=office.16).aspx


Install Office Online ServerInstall Office Online Server

Install language packs for Office Web Apps Server (optional)Install language packs for Office Web Apps Server (optional)

Deploy Office Online Server
Create the Office Online Server farm (HTTPS)Create the Office Online Server farm (HTTPS)

New-OfficeWebAppsFarm -InternalUrl "https://server.contoso.com" -ExternalUrl "https://wacweb01.contoso.com" -
CertificateName "OfficeWebApps Certificate"

Add-WindowsFeature Web-Server,Web-Mgmt-Tools,Web-Mgmt-Console,Web-WebServer,Web-Common-Http,Web-Default-
Doc,Web-Static-Content,Web-Performance,Web-Stat-Compression,Web-Dyn-Compression,Web-Security,Web-
Filtering,Web-Windows-Auth,Web-App-Dev,Web-Net-Ext45,Web-Asp-Net45,Web-ISAPI-Ext,Web-ISAPI-Filter,Web-
Includes,NET-Framework-Features,NET-Framework-45-Features,NET-Framework-Core,NET-Framework-45-Core,NET-
HTTP-Activation,NET-Non-HTTP-Activ,NET-WCF-HTTP-Activation45,Windows-Identity-Foundation,Server-Media-
Foundation

If prompted, restart the server.

2. Install the following software:

.NET Framework 4.5.2
Visual C++ Redistributable Packages for Visual Studio 2013
Visual C++ Redistributable for Visual Studio 2015
Microsoft.IdentityModel.Extention.dll

If you plan to use any Excel Online features that utilize external data access (such as Power Pivot), note that Office
Online Server must reside in the same Active Directory forest as its users as well as any external data sources that
you plan to access using Windows-based authentication.

1. Download Office Online Server from the Volume Licensing Service Center (VLSC). The download is located
under those Office products on the VLSC portal. For development purposes, you can download OOS from
MSDN subscriber downloads.

2. Run Setup.exe.
3. On the Read the Microsoft Software License Terms page, select I accept the terms of this agreement and

select Continue.

5. When Setup finishes installing Office Online Server, select Close.

4. On the Choose a file location page, select the folder where you want the Office Online Server files to be
installed (for example,C:\Program Files\Microsoft Office Web Apps) and select Install Now. If the folder you
specified doesn’t exist, Setup creates it for you.

We recommend that you install Office Online Server on the system drive.

Office Online Server Language Packs let users view web-based Office files in multiple languages.

To install the language packs, follow these steps.

1. Download the Office Online Server Language Packs from the Microsoft Download Center.
2. Run wacserverlanguagepack.exe.
3. In the Office Online Server Language Pack Wizard, on the Read the Microsoft Software License Terms page,

select I accept the terms of this agreement and select Continue.
4. When Setup finishes installing Office Online Server, select Close.

Use the New-OfficeWebAppsFarm command to create a new Office Online Server farm that consists of a single
server, as shown in the following example.

https://go.microsoft.com/fwlink/p/?LinkId=510096
https://www.microsoft.com/download/details.aspx?id=40784
https://go.microsoft.com/fwlink/p/?LinkId=620071
https://go.microsoft.com/fwlink/p/?LinkId=620072
http://go.microsoft.com/fwlink/p/?LinkId=256561
http://go.microsoft.com/fwlink/p/?LinkId=798136


Create the Office Online Server farm (HTTP)Create the Office Online Server farm (HTTP)

New-OfficeWebAppsFarm -InternalURL "http://servername" -AllowHttp

Verify that the Office Online Server farm was created successfullyVerify that the Office Online Server farm was created successfully

<InternalUrl>/hosting/discovery

<?xml version="1.0" encoding="utf-8" ?> 
- <wopi-discovery>
- <net-zone name="internal-http">
- <app name="Excel" favIconUrl="<InternalUrl>/x/_layouts/images/FavIcon_Excel.ico" checkLicense="true">
<action name="view" ext="ods" default="true" urlsrc="<InternalUrl>/x/_layouts/xlviewerinternal.aspx?
<ui=UI_LLCC&><rs=DC_LLCC&>" /> 
<action name="view" ext="xls" default="true" urlsrc="<InternalUrl>/x/_layouts/xlviewerinternal.aspx?
<ui=UI_LLCC&><rs=DC_LLCC&>" /> 
<action name="view" ext="xlsb" default="true" urlsrc="<InternalUrl>/x/_layouts/xlviewerinternal.aspx?
<ui=UI_LLCC&><rs=DC_LLCC&>" /> 
<action name="view" ext="xlsm" default="true" urlsrc="<InternalUrl>/x/_layouts/xlviewerinternal.aspx?
<ui=UI_LLCC&><rs=DC_LLCC&>" /> 

Configure Excel workbook maximum sizeConfigure Excel workbook maximum size

Set-OfficeWebAppsFarm -ExcelWorkbookSizeMax 100

Using EffectiveUserName with Analysis Services

Parameters

–InternalURL is the fully qualified domain name (FQDN) of the server that runs Office Online Server, such as
http://servername.contoso.com.
–ExternalURL is the FQDN that can be accessed on the Internet.
–CertificateName is the friendly name of the certificate.

Use the New-OfficeWebAppsFarm command to create a new Office Online Server farm that consists of a single
server, as shown in the following example.

Parameters

–InternalURL is the name of the server that runs Office Online Server, such as http://servername.
–AllowHttp configures the farm to use HTTP.

After the farm is created, details about the farm are displayed in the Windows PowerShell prompt. To verify that
Office Online Server is installed and configured correctly, use a web browser to access the Office Online Server
discovery URL, as shown in the following example. The discovery URL is the InternalUrl parameter you specified
when you configured your Office Online Server farm, followed by /hosting/discovery, for example:

If Office Online Server works as expected, you should see a Web Application Open Platform Interface Protocol
(WOPI)-discovery XML file in your web browser. The first few lines of that file should resemble the following
example:

The maximum file size for all files in Power BI Report Server is 100 MB. To stay in sync with that, you need to
manually set this in OOS.

To allow for live connections to Analysis Services, for connections within an Excel workbook that make use of
EffectiveUserName. For OOS to make use of EffectiveUserName, you will need to add the machine account of the

http://servername.contoso.com
http://servername


Set-OfficeWebAppsFarm -ExcelUseEffectiveUserName:$true
Set-OfficeWebAppsFarm -ExcelAllowExternalData:$true
Set-OfficeWebAppsFarm -ExcelWarnOnDataRefresh:$false

Configure a Power Pivot instance for data models

New-OfficeWebAppsExcelBIServer -ServerId <server_name>\POWERPIVOT

Set-OfficeWebAppsFarm -ExcelAllowExternalData:$true

Firewall considerationsFirewall considerations

Configure Power BI Report Server to use the OOS Server

OOS server as an administrator for the Analysis Services instance. Management Studio for SQL Server 2016 or
later is needed to do this.

Only embedded Analysis Services connections are currently supported within an Excel workbook. The user's
account will need to have permission to connect to Analysis Services as the ability to proxy the user is not available.

Run the following PowerShell commands on the OOS Server.

Installing an Analysis Services Power Pivot mode instance lets you work with Excel workbooks that are using Power
Pivot. Make sure that the instance name is POWERPIVOT. Add the machine account of the OOS server as an
administrator, for the Analysis Services Power Pivot mode instance. Management Studio for SQL Server 2016 or
later is needed to do this.

For OOS to use the Power Pivot mode instance, run the following command.

If you did not already allow external data, from the Analysis Services step above, run the following command.

To avoid firewall issues, you may need to open the ports 2382 and 2383. You can also add the msmdsrv.exe, for the
Power Pivot instance, as an application firewall wall policy.

On the General page of Site settings, enter the OOS discovery url. The OOS discovery url is the InternalUrl, used
when deploying the OOS server, followed by /hosting/discovery. For example, 
http://servername/hosting/discovery , for HTTP. And, https://server.contoso.com/hosting/discovery  for HTTPS.

To get to Site settings, select the gear icon in the upper right and select Site settings.

Only a user with the System Administrator role will see the Office Onlien Server discovery url setting.



Limitations and considerations

Next steps

After you enter the discovery url, and select Apply, selecting an Excel workbook, within the web portal, should
display the workbook within the web portal.

The ability to view Excel workbooks within Power BI Report Server is currently in preview.
You will have read only capability with workbooks.

Administrator handbook
Quickstart: Install Power BI Report Server
Install Report Builder
Download SQL Server Data Tools (SSDT)

More questions? Try asking the Power BI Community

https://docs.microsoft.com/sql/reporting-services/install-windows/install-report-builder
http://go.microsoft.com/fwlink/?LinkID=616714
https://community.powerbi.com/
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Embedding

Report Viewer ControlReport Viewer Control

APIs

Welcome to the developer handbook for Power BI Report Server, an on-premises location for storing and
managing your Power BI, mobile, and paginated reports.

This handbook will highlight options you have, as a developer, to work with Power BI Report Server.

For any report within Power BI Report Server, you can embed within an iFrame by adding the querystring
parameter ?rs:Embed=true  to the URL. This works with Power BI reports as well as other report types.

For paginated reports, you can take advantage of the Report Viewer Control. This allows you to place the control
within a .NET windows or web application. For more information, see Get started with the Report Viewer Control.

You have several API options for interacting with Power BI Report Server. This includes the following.

REST APIs
URL Access
WMI Provider

You can also use the open source PowerShell untilies to manage your report server.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/report-server/developer-handbook-overview.md
https://docs.microsoft.com/sql/reporting-services/application-integration/integrating-reporting-services-using-reportviewer-controls-get-started
https://docs.microsoft.com/sql/reporting-services/url-access-ssrs
https://docs.microsoft.com/sql/reporting-services/wmi-provider-library-reference/reporting-services-wmi-provider-library-reference-ssrs
https://github.com/Microsoft/ReportingServicesTools


NOTENOTE

Custom extensions

Next steps

The PowerShell utilities do not currently support Power BI Desktop files (.pbix).

The Extension Library is a set of classes, interfaces, and value types that are included in Power BI Report Server. This
library provides access to system functionality and is designed to be the foundation on which Microsoft .NET
Framework applications can be used to extend Power BI Report Server components.

There are several types of extensions you can build.

Data processing extensions
Delivery extensions
Rendering extensions for paginated reports
Security extensions

To learn more, see Extension library.

Get started with the Report Viewer Control
Building Applications Using the Web Service and the .NET Framework
URL Access
Extension library
WMI Provider

More questions? Try asking the Power BI Community

https://docs.microsoft.com/sql/reporting-services/extensions/reporting-services-extension-library
https://docs.microsoft.com/sql/reporting-services/application-integration/integrating-reporting-services-using-reportviewer-controls-get-started
https://docs.microsoft.com/sql/reporting-services/report-server-web-service/net-framework/building-applications-using-the-web-service-and-the-net-framework
https://docs.microsoft.com/sql/reporting-services/url-access-ssrs
https://docs.microsoft.com/sql/reporting-services/extensions/reporting-services-extension-library
https://docs.microsoft.com/sql/reporting-services/wmi-provider-library-reference/reporting-services-wmi-provider-library-reference-ssrs
https://community.powerbi.com/
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URL parameter

http://myserver/reports/powerbi/Sales?rs:embed=true

iFrame

<iframe width="800" height="600" src="http://myserver/reports/powerbi/Sales?rs:embed=true" frameborder="0" 
allowFullScreen="true"></iframe>

URL filter

Example: Filter on a fieldExample: Filter on a field

https://report-server/reports/power-bi/Retail-Analysis-Sample

You can embed any report by using an iFrame in your application.

For any URL to a report, you can add a querystring parameter of ?rs:Embed=true .

For example:

This will work on all report types within Power BI Report Server.

Once you have your URL, you can create an iFrame within a web page, to host the report.

For example:

You can add a query string parameter to the URL to filter the data that's returned in the Power BI report.

The syntax is straightforward; start with the report URL, add a question mark, then this filter syntax.

URL?filter=Table/Field eq 'value'

Keep these considerations in mind:

Table and Field names are case sensitive; value isn't.
You can filter a report with fields that are hidden from report view.
Value has to be enclosed with single quotes.
Field type has to be string.
Table and field names can't have spaces.

Take for example the Retail Analysis sample. Say this is the URL to the report on the report server in a folder called
"power-bi":

You see the map visualization in the Retail Analysis sample shows stores in North Carolina and other states.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/report-server/quickstart-embed.md


NC is the value for North Carolina stored in the Territory field of the Store table. So to filter the report to show
data only for stores in North Carolina, append the following to the URL:

?filter=Store/Territory eq 'NC'

Now the report is filtered for North Carolina; all the visualizations on the report page show data for only North
Carolina.



Create a DAX formula to filter on multiple valuesCreate a DAX formula to filter on multiple values

https://report-server/reports/power-bi/Retail-Analysis-Sample?filter=Store/TerritoryChain eq 'NC-Lindseys'

Next steps

Another way to filter on multiple fields is by creating a calculated column in Power BI Desktop that concatenates
two fields to a single value. Then you can filter on that value.

For example, the Retail Analysis sample has two fields: Territory and Chain. In Power BI Desktop, you can create a
calculated column (Field) called TerritoryChain. Remember that the Field name can't have any spaces. Here is the
DAX formula for that column.

TerritoryChain = [Territory] & "-" & [Chain]

Publish the report to the Power BI Report Server, then use the URL query string to filter to display data for only
Lindseys stores in NC.

Quickstart: Create a Power BI report for Power BI Report Server
Quickstart: Create a paginated report for Power BI Report Server

More questions? Try asking the Power BI Community

https://community.powerbi.com/
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Components of a REST API request/response

Power BI Report Server support Representational State Transfer (REST) APIs. The REST APIs are service endpoints
that support a set of HTTP operations (methods), which provide create, retrieve, update, or delete access for
resources within a report server.

The REST API provides programmatic access to the objects in a Power BI Report Server catalog. Examples of objects
are folders, reports, KPIs, data sources, datasets, refresh plans, subscriptions, and more. Using the REST API, you
can, for example, navigate the folder hierarchy, discover the contents of a folder, or download a report definition.
You can also create, update, and delete objects. Examples of working with objects are upload a report, execute a
refresh plan, delete a folder, and so on.

A REST API request/response pair can be separated into five components:

Optional HTTP request message body fields, to support the URI and HTTP operation. For example, POST
operations contain MIME-encoded objects that are passed as complex parameters. For POST or PUT operations,
the MIME-encoding type for the body should be specified in the Content-type  request header as well. Some
services require you to use a specific MIME type, such as application/json .

The request URI, which consists of: {URI-scheme} :// {URI-host} / {resource-path} ? {query-string} .
Although the request URI is included in the request message header, we call it out separately here because
most languages or frameworks require you to pass it separately from the request message.

URI scheme: Indicates the protocol used to transmit the request. For example, http  or https .
URI host: Specifies the domain name or IP address of the server where the REST service endpoint is
hosted, such as myserver.contoso.com .
Resource path: Specifies the resource or resource collection, which may include multiple segments used
by the service in determining the selection of those resources. For example: 
CatalogItems(01234567-89ab-cdef-0123-456789abcdef)/Properties  can be used to get the specified

properties for the CatalogItem.
Query string (optional): Provides additional simple parameters, such as the API version or resource
selection criteria.

HTTP request message header fields:

A required HTTP method (also known as an operation or verb), which tells the service what type of
operation you are requesting. Reporting Services REST APIs support DELETE, GET, HEAD, PUT, POST, and
PATCH methods.
Optional additional header fields, as required by the specified URI and HTTP method.

HTTP response message header fields:

An HTTP status code, ranging from 2xx success codes to 4xx or 5xx error codes. Alternatively, a service-
defined status code may be returned, as indicated in the API documentation.
Optional additional header fields, as required to support the request's response, such as a Content-type

response header.
Optional HTTP response message body fields:

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/report-server/rest-api.md
https://www.w3.org/Protocols/rfc2616/rfc2616-sec9.html
http://www.w3.org/Protocols/HTTP/HTRESP.html


API documentation

Testing API calls

Next steps

MIME-encoded response objects are returned in the HTTP response body, such as a response from a GET
method that is returning data. Typically, these objects are returned in a structured format such as JSON
or XML, as indicated by the Content-type  response header.

A modern REST API calls for modern API documentation. The REST API is built on the OpenAPI specification (a.k.a.
the swagger specification) and documentation is available on SwaggerHub. Beyond documenting the API,
SwaggerHub helps generate a client library in the language of choice – JavaScript, TypeScript, C#, Java, Python,
Ruby, and more.

A tool for testing HTTP request/response messages is Fiddler. Fiddler is a free web debugging proxy that can
intercept your REST requests, making it easy to diagnose the HTTP request/ response messages.

Review the available APIs over on SwaggerHub.

Samples are available on GitHub. The sample includes an HTML5 app built on TypeScript, React, and webpack
along with a PowerShell example.

More questions? Try asking the Power BI Community

https://app.swaggerhub.com/apis/microsoft-rs/PBIRS/2.0
http://www.telerik.com/fiddler
https://app.swaggerhub.com/apis/microsoft-rs/PBIRS/2.0
https://github.com/Microsoft/Reporting-Services
https://community.powerbi.com/
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We have a YouTube channel for Power BI! You can visit our channel and, if you're new to Power BI a good place to
start is the Analyze and Visualize data with Power BI playlist.

Here are a few videos from that playlist to get you started.

Overview of Power BI service and Power BI Desktop.

Collaborating and sharing.

Overview of Power BI mobile

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/videos.md
https://www.youtube.com/user/mspowerbi/videos
https://www.youtube.com/playlist?list=PL1N57mwBHtN0JFoKSR0n-tBkUJHeMP2cP


Watch some of our new uploads

More videos

Next steps

Power BI for developers 

Date slicer
Custom visualizations
Alerts in the Power BI service

Check out the following collection of sources and content for more videos.

Guided Learning for Power BI - a sequential learning tour of Power BI, in bite-size pieces
Guy in a Cube channel - fresh videos on Power BI features and capabilities

Get started with Power BI

More questions? Try asking the Power BI Community

https://youtu.be/V7i82ZZm0vw
https://youtu.be/d-rXAJ3_uAo
https://youtu.be/JbL2-HJ8clE
https://powerbi.microsoft.com/guided-learning/
https://www.youtube.com/channel/UCFp1vaKzpfvoGai0vE5VJ0w
http://community.powerbi.com/
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Featured webinars

Upcoming webinars

On-Demand webinars

Getting StartedGetting Started

Register for our upcoming live webinars or watch our recorded sessions on-demand.

Get started with these popular on-demand webinars

Getting Started with Power BI 
by Miguel Martinez 
Register and watch now

Simply Compelling – Seven Tips to Better Visualization Design 
by Miranda Li 
Watch now

Better Together: 5 Benefits Excel Users Will Get From Using Power BI 
by Carlos Otero and Miguel Martinez 
Register and watch now

Browse the library of Power BI on-demand webinars from our community experts

Register to hear from Power BI experts and participate in live Q&A sessions

Learn to Navigate Your Way Through a Power BI Dashboard in 20 Minutes 
by Miguel Martinez 
February 21st, 10:00AM PST, 1:00PM EST

Have you ever opened a Power BI Dashboard just to think, now what? How do I navigate through this to find the
data that’s important to me? Do you limit your use of filters & slicers for fear of ‘breaking something’? Fear not,
join us to learn how to navigate your way through a Power BI dashboard. We will walk you through common
features used by other managers to drill down to the data you want, when you want it.

Register to watch on February 21st

Attend upcoming webinars from the Power BI community

Watch recorded sessions at any time

How to Design Visually Stunning Power BI Reports 
by Charles Sterling 
Watch now

Transforming A Report From Good to GREAT! 
by Reid Havens 
Watch now

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/webinars.md
https://info.microsoft.com/getting-started-with-power-bi-ondemand.html?Is=Website
https://community.powerbi.com/t5/Webinars-and-Video-Gallery/Simply-Compelling-Seven-Tips-to-Better-Visualization-Design/m-p/173401?Is=Website
https://info.microsoft.com/excel-powerbi-better-together.html?Is=Website
https://community.powerbi.com/t5/Webinars-and-Video-Gallery/bd-p/VideoTipsTricks?filter=webinars&featured=yes&Is=Website
https://info.microsoft.com/powerbi-dashboard-in-20-min.html?Is=Website
https://powerbi.microsoft.com/en-us/blog/tag/community-webinar?Is=Website
https://community.powerbi.com/t5/Webinars-and-Video-Gallery/5-3-17-Webinar-How-to-Design-Visually-Stunning-Power-BI-Reports/m-p/168204?Is=Website
https://community.powerbi.com/t5/Webinars-and-Video-Gallery/Power-BI-Transforming-A-Report-From-Good-to-GREAT/m-p/315119?Is=Website


PartnersPartners

Advanced TopicsAdvanced Topics

See also

Improving Profitability in Healthcare 
by Stephen Cracknell and Stuart Macanliss from US Medical IT 
Register and watch now

Applied Intelligence for Sales & Service 
by Ed Bobrin from Avanade 
Register and watch now

Manufacturers: Your industry is going through a digital transformation - Maintain leadership by
leveraging analytics to maximize profitability 
by Jon Thompson from Blue Margin and Jim Pastor from Elgin Fastener Group 
Register and watch now

How to Implement a Successful Data Governance Strategy That Makes Your Organization More Secure 
by Ajay Anandan 
Register and watch now

Power BI security deep dive 
by Kasper de Jonge 
Watch now

Accelerating modern BI adoption with Power BI Premium 
by Sirui Sun and Miguel Martinez 
Register and watch now

Ask a Partner: Developing Custom Visuals for Power BI 
by Ted Pattison 
Watch now

What's new and exciting in Power BI Report Server 
by Riccardo Muti, Chris Finlan and Chinmay Joshi 
Register and watch now

How Microsoft does Power BI 
by Kirkland Barrett 
Register and watch now

Power BI whitepapers

Microsoft Data Insights Summit 2017 on-demand sessions

Get started with Power BI

Follow @MSPowerBI on Twitter

Subscribe to our YouTube channel

More questions? Try asking the Power BI Community

https://info.microsoft.com/improving-profitability-in-healthcare.html?Is=Website
https://info.microsoft.com/applied-intelligence-for-sales-service.html?Is=Website
https://info.microsoft.com/digital-transformation-in-manufacturing.html?Is=Website
https://info.microsoft.com/powerbi-data-governance-strategy-ondemand.html?Is=Website
https://community.powerbi.com/t5/Webinars-and-Video-Gallery/5-23-2017-Power-BI-security-deep-dive-by-Kasper-de-Jonge/m-p/161476?Is=Website
https://info.microsoft.com/powerbi-premium-webinar-ondemand.html?Is=Website
https://community.powerbi.com/t5/Webinars-and-Video-Gallery/Ask-a-Partner-Developing-Custom-Visuals-for-Power-BI/m-p/150368?Is=Website
https://info.microsoft.com/whats-new-powerbi-report-server.html?Is=Website
https://info.microsoft.com/US-PowerBI-WBNR-FY17-11Nov-29-BIATMIcrosoft274828_01Registration-ForminBody.html?Is=Website
https://community.powerbi.com/t5/Data-Insights-Summit-2017-On/bd-p/DataInsightsSummit2017OnDemand?Is=Website
https://twitter.com/mspowerbi
https://www.youtube.com/mspowerbi
https://community.powerbi.com/
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WHITEPAPER DESCRIPTION

Microsoft Power BI Premium Describes Power BI Premium, both as it exists when launched
and also how it will evolve.

Planning a Power BI Enterprise Deployment This is a technical whitepaper outlining considerations for a
well-performing and secure organizational Power BI
deployment.

Plan capacity for embedded analytics with Power BI Premium This paper provides guidance for the app developer/ISV to
determine the most appropriate capacity for its business.

Distribute Power BI content to external guest users using
Azure Active Directory B2B

This paper outlining how to distribute content to users
outside the organization using the integration of Azure Active
Directory Business-to-business (AAD B2B).

Best design practices for reports and visuals Provides best practices for designing reports in Power BI.

Advanced Analytics with Power BI Describes the advanced analytics capabilities of Power BI,
including predictive analytics, custom visualizations, R
integration, and data analysis expressions.

Bidirectional filtering Explains bidirectional cross-filtering in Power BI Desktop (the
whitepaper also covers SQL Server Analysis Services 2016,
both have the same behavior).

DirectQuery in SQL Server 2016 Analysis Services For SQL Server 2016, DirectQuery was redesigned for
dramatically improved speed and performance, however, it is
also now more complex to understand and implement.

Governance Provides a framework for increasing the return on investment
related to Power BI.

Security Provides a detailed explanation of security within Power BI.

Securing the Tabular BI Semantic Model This paper introduces the security model for tabular BI
semantic and Power BI. You will learn how to create roles,
implement dynamic security, configure impersonation settings,
manage roles, and choose a method for connecting to models
that works in your network security context.

Capacity planning guidance for Power BI Report Server This paper aims to offer guidance on capacity planning for
Power BI Report Server by sharing results of numerous load
test executions of various workloads against a report server.

Power BI Premium Planning and Deployment This paper provides guidance and best practices for planning
and deploying Premium capacity for well-defined workloads.

Whitepapers allow you to explore Power BI topics at a deeper level. Here you can find a list of available
whitepapers for Power BI.

https://github.com/MicrosoftDocs/powerbi-docs-pr/blob/live/powerbi-docs/whitepapers.md
https://aka.ms/pbipremiumwhitepaper
https://aka.ms/pbienterprisedeploy
https://aka.ms/pbiewhitepaper
https://aka.ms/powerbi-b2b-whitepaper
https://info.microsoft.com/advanced-analytics-with-power-bi.html?Is=Website
https://blogs.msdn.microsoft.com/analysisservices/2017/04/06/directquery-in-sql-server-2016-analysis-services-whitepaper/
http://download.microsoft.com/download/D/2/0/D20E1C5F-72EA-4505-9F26-FEF9550EFD44/Securing the Tabular BI Semantic Model.docx
https://aka.ms/Premium-Capacity-Planning-Deployment
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More questions? Try asking the Power BI Community

http://community.powerbi.com/
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